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A LOS ASISTENTES A LOS CURSOS 

las autoridades de la Facultad de Ingeniería, por conducto del jefe de la 

División de Educación Continua, otorgan una constancia de asistencia a 

quienes cumplan con los requisitos establecidos para cada curso. 

El control de asistencia se llevará a cabo a través de la persona que le entregó 

las notas. las inasistencias serán computadas por las autoridades de la 

División, con el fin de entregarle constancia solamente a loa alumnos que 

tengan un mínimo de 80% de asistencias. 

Pedimos a los asistentes recoger su constancia el día de la clausura. Estas se 

retendrán por el periodo de un año, pasado este tiempo la DECFI no se hará 

responsable de este documento. 

Se recomienda a los .asistentes participar activamente con sus ideas y 

experiencias, pues. loa cursos que. of.rece la Diviaióf1. estl!.n . pla.n.~.adC!a para que 

los profesores expongan· una tesis, pero sobre todo, para ·que· coordinen las 

opiniones de todos los interesados, constituyendo verdaderos seminarios. 

Es muy importante que todos los asistentes llenen y entreguen su hoja de 

inscripción al inicio del curso, información que servirá para integrar un 

directorio de asistentes, que se entregará oportunamente. 

Con el objeto de mejorar los servicios que la División de Educación Continua 

ofrece, al final del curso "deberán entregar la evaluación a través de un 

cuestionario diseñado para emitir juicios anónimos. 

Se recomienda llenar dicha evaluación conforme loa profesores impartan sus 

clases, a efecto de no llenar en la última sesión las evaluaciones y con esto 

sean más fehacientes sus apreciaciones. 

Atentamente 

División de Educación Continua. 
Patac1o de Mineria Calle de Tacuba 5 Primer piso Deleg Ci.Jauhtémoc 06000 México, O F APDO. Postal M~2285 
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• PRÓLOGO 

La serie de programas SAP son quizá los programas más conocidos, probados y utilizados en 
el campo de la Ingeniería Estructural, particularmente en el Análisis Estructural, desde las primeras 
versiones SOLIDSAP, SAP 3, SAP IV, etc., hasta la más reciente SAP 2000, han sido utilizadas por 
un gran número de ingenieros en nuestro país y en muchas partes del mundo, cuenta con respaldo y­
soporte técnico al que tiene derecho el usuario autorizado así como a los manuales respectivos.· 

Por lo anterior, desde hace algunos años el Departamento de Estructuras de la División de 
Ingeniería Civil Topográfica y Geodesia del la Facultad de Ingeniería de la UNAM consideró 
conveniente impartir una serie de cursos para enseñar a manejar el programa, para ello el contar con 
un instructivo que permita introducir al usuario de una manera fácil al programa facilitará el objetivo 
anterior, por lo que se sugiere que el lector asista a los cursos que organiza del Departamento de 
Estructuras o la División de Educación Continua de la FI de la UNAM. 

En este instructivo se describen algunos de los principales elementos que intervienen en el 
uso del programa de computadora para Análisis y Diseño Estructural SAP-2000, cuya principal 
utilización será para los alumnos de la materia "Diseño Estructural" de la carrera de Ingeniero Civil 
que se imparte en la Facultad de Ingeniería de la UNAM. 

Se ha procurado realizar este instructivo de una manera sencilla y resumida para que ei 
usuario no emplee demasiado tiempo en leerlo y pueda resolver su problema en lo que respecta al 
Análisis y Diseño de Estructuras utilizando el programa SAP-2000. 

Se recomienda que si algunos de los elementos no son descritos ampliamente se consulten los 
manuales respectivos o la ayuda en línea incluida en el programa y se obserVen los ejemplos que se 
desarrollan al final del instructivo. Se supone que el usuario esta familiarizado con la nomenclatura y 
terminología utilizada en el Análisis y Diseño Estructural y que cuenta con conocimientos básicos de 
computación en lo que respecta a manejo de información (archivos) y ejecución de programas en 
ambiente Windows 95, 98. 

El autor agradece al lng. Miguel Ángel Rodríguez Vega, Jefe del Departamento de 
Estructuras el apoyo para el desarrollo de este tipo de actividadzs, por las facilidades otorgadas para 
la realización de este_trabajo así como la revisión del presente instructivo. 

FERNANDO MONROY MIRAl'iDA 

Cd. Universitaria, Marzo del 2000 

2 
• 



... 

CONTENIDO 
PRÓLOGO 

CAPÍTULO 1 EL PROGRAMA SAP 2000 

1.1 Introducción al programa SAP 2000 

CAPÍTULO 2 RECOMENDACIONES PARA EL USO DEL PROGRAMA 

2.1 Paso l. Tipo de estructura 

2.2 Paso 2. Definición de la geometría 

2.3 Paso 3. Definición de las propiedades elásticas de los materiales 

2.4 Paso 4. Definición de las propiedades geométricas de los elementos 

2.5 Paso 5. Definición las características de las fuerzas y de las combinaciones 

2.6 Paso 6. Elección del tipo de análisis y resultados 

· 2. 7 Paso 7. Diseño de elementos 

CAPÍTULO 3 MÓDULOS DEL PROGRAMA DESCRIPCION GENERAL 

3.1 Ejecución del programa, módulos que lo componen 

3.2 Descripción general 

CAPÍTULO 4 OPCIONES PARA LA GENERACIÓN DE LA ESTRUCTURA 

4.1 Introducción 

4.2 Descripción General 

4.3 Generación de la Geometría 

4.4 Definición y asigr.ación de propiedades geométricas 

4.5 DefiniciÓn y Asignación materiales 

4.6 Condiciones de Frontera, tipos de apoyo 

F Mon.roy 3 • 



4. 7 Asignación de Fuerzas y combinaciones 

4.8 Opciones de Análisis y Diseño, selección de resultados 

CAPÍTULO 5 ANÁLISIS DE LA ESTRUCTURA 

5.1 Verificando algunos elementos del proceso de análisis 

CAPÍTULO 6 SELECCIÓN E INTERPRETACION DE RESULTADOS 

6.1 Introducción 

6.2 Ver la estructura deformada 

6.3 Ver los diagramas de elementos mecánicos 

6.4 Ver los resultados de diseño 

6.5 Otras características 

CAPÍTULO 7 OPCIONES ADICIONALES 

7.1 Introducción 

7.2 Ver el archtvc de entrada 

7.3 Ver el archivo de salida 

7.4 Relación con AUTO CAD 

CAPÍTULO 8 EJEMPLOS E INTERPRETACIÓN DE RESULTADOS 

Ejemplo No. 

Ejen;plo No. 2 

Ejemplo No. 3 

Ejemplo No. 4 

Ejemplo No. 5 

CAPÍTULO 9 COMENTARIOS FINALES 

• 



Capttulo 1 

1.1 INTRODUCCIÓN 

EL PROGRAMA 
SAP 2000 

El pr~ru SAP2000 

CAPÍTULO 
I 

En los últimos años, el desarrollo de los equipos y sistemas de computo ha permitido una 
· comunicación mucho más rápida, directa y sencilla entre el usuario y la computadora logrando la 
posibilidad de desarrollar programas que, utilizando las características de las computadoras de hoy en 
día, nos permitan usarlas mas eficientemente y entre otras cosas facilitándonos la posibilidad de 
explorar varias alternativas de solución de problemas estructurales o bien considerar más variables en 
el comportamiento de las estructuras con el objeto ·de lograr un mejor modelo de la estructura. 

Tomando en cuenta lo anterior, SAP 2000 es el resultado de un trabajo desarrollado en los 
Estados Unidos de Norteamérica cuyo principal objetivo fue desarrollar un programa para Análisis y 
Diseño de Estructuras en donde el usuario tenga gran versatilidad en el manejo del mismo a través de 
una interacción directa en la mayor parte de la ejecución de los módulos que componen el programa y 
junto con la sencillez y facilidad de uso son algunas de sus principales características. 

El Sistema SAP 2000 es un programa escrito para computadoras personales IBM o 
compatibles mediante el cual puede realizarse el Análisis y Diseño de Estructuras bajo uno o varios 
sistemas de carga formados por un conjunto de fuerzas estáticas y/o dinámicas aplicadas a la 
estructura. 

SAP 2000 fue desarrollado bajo la hipótesis de que la estructura está formada por barras 
pnsmáticas (aunque también maneja cierto tipo de barras de sección variable) de eje recto, 
considerando también la posibilidad de modelar elementos placa y sólido (Elementos finitos) 

Consta básicamente de una serie de menús (Véase Figura 1) que se despliegan en la pantal!:1 :1! 
inicio del programa y por lo general después de terminada la ejecución de cada una de las opciones, 
con ellas, el usuario puede introducir y/o modificar datos, o bien almacenarlos para su procesamiento 
posterior, analizar la estructura, ver resultados en la pantalla o imprimirlos, ver resultados de diseño, 
etc 
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! __ ·: 
El prcogram¡ SAP2000 

Figura 1.1 SAP 2000, menú principal. 

Una de las principales características del programa es la interacción que se puede establecer 
entre éste y el usuario, y debido al número de opciones que el usuario puede activar, se requiere 
aprender su lenguaje específico para poder utilizarlo, ya que, el usuario puede seleccionar varias 
opciones y la ejecución de cada una de ellas genera otras más, SAP 2000 es ·un programa orientado 
a eventos (seleccionar un elemento con el ratón, elegir una opción, activar/desactivar sucesos, etc.) y 
no siempre solicita textualmente los elementos (datos) que se vayan requiriendo para la 
ejecución completa de ese módulo, por otro lado además es necesario saber las convenciones de 
signos empleadas, los sistemas de referencia utilizados así como algunas recomendaciones para su 
uso, éstas y algunas características más son descritas en los capítulos posteriores. 

En el capítulo 2 se dan las recomendaciones necesarias para facilitar la preparación e 
introduccion de datos, en el capitulo 3 se comentan los módulos que componen el programa, el 
capítulo 4 describe el módulo para crear l:1 estructura, en el capítulo 5 se presenta el módulo de 

análisis, en el capítulo 6 se presentan las opciones para ver resultados del Análisis y Diseño, en el 
capítulo 7 se describen algunas opciones adicionales o complementarias, el capítulo 8 contiene 

algunos ejemplos con la .::orrespoudiente interpretacion de los resultados obtenidos por el programa 
SAP 2000, por último en el capítulo 9 se incluyen algunos comentarios y sugerencias finales. 
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Captlulo 2 Reeomendaaones pan d wo del pr~ SAP2000 

RECOMENDACIONES 
PARA EL USO DEL 

PROGRAMA 

CAPÍTULO 
21 

2.1 INTRODUCCION 

El programa SAP 2000 posee una interfase gráfica como una opción que le permite al usuario 
modelar, analizar, diseñar y desplegar tanto datos como resultados de una estructura, una vez que se 
cuenta con los datos de geometría, propiedades de los materiales de los cuales están hechos los 
elementos estructurales así como las cargas y desde luego un completo y correcto entendimiento del 
problema, se esta en condiciones de utilizar el programa, para ello habrá necesidad de modelar a los 
elementos anteriores, una vez definido el modelo que se utilizará para esos elementos se introducirá 
el modelo completo utilizando por ejemplo la interfase gráfica. 

La estructura idealizada estará formada por: 

• Elementos barra (FRAME) usados para representar a las vigas, columnas, diagonales, etc. 
• Elementos placa (SHELL) usados para representar muros, losas, rampas, etc 
• Elementos sólidos (SOLID) usados para modelar estructuras continuas tridimensionales. 
• Nudos (JOINTS) que representan la conexión entre los elementos barra, placa y sólido. 
• Propiedades fisicas y elásticas de los materiales 
• Apoyos y resortes que representan las restricciones de desplazamiento del nudo. 
• Cargas (concentradas, uniformes, etc ) que representan a las acciones (peso propio, 

viento, sismo, ocupación, etc.). 

2.1 PASO l. Tll'O DE ESTRUCTURA 

SAP 2000 permite manejar a la estructura en un sistema coordenado tridimensional, sm 
embargo, antes de realizar el análisis se pueden seleccionar determinados grados de libertad (ver 
figura 2 1) y así aunque la estructura este referida a un SIStema tridimensional se pueden analizar: 

Marcos y vigas en un plano vertical 
Retículas (en un p!i!!lo horizontal) 

De;;de luego se permite modelar y analizar Armaduras y marcos tridimensionales. 

7 • 



Figura 2.1. Selección de grados de libertad de acuerdo al tipo de estructura 

Para el caso de las estructuras tipo armadura sólo se considerará el efecto axial en el análisis. 

En las estructuras planas se consideran cortante y axial en el plano de la estructura y flexión 
perpendicular a ese plano. 

El tipo retícula permite analizar estructuras con acciOnes perpendiculares a su plano 
considerando flexión en el plano, torsión y cortante 

El caso general lo constituye el tipo marco tridimensional en donde sé consideran flexión y 
cortante en dos direcciones, torsión y axial con seis grados de libertad por nudo, desde luego que se 
pueden liberar extremos de las barras a algún elemento mecánico y suprimir o ligar grados de libertad 
(diafragma rígido por ejemplo). 

2.2 PASO 2. DEFINICIÓN DE LA GEOMETRÍ'\ 

.A..ntes de inicidr la ejecución del programa SAP 2000 es conveniente como segundo paso 
definir completamente la geometría del modelo. La estructura real se idealizará mediante una serie de 
elementos estructurales conectados entre sí, los cuales, de acuerdo a sus características se podrán 
moJelar como elementos barra (trabes, columnas. diagonales), elemer.tos placa (losas, muros) o 
elementos sólidos tridimensionales (elementos contnn:os), es:os elementos estarán unidos en puntos 
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-·comunes (nudos), algunos nudos estarán completamente o parcialmente restringidos (apoyos), en uno 
o varios grados de libertad. 

La definición de los elementos (barra, placa, sólido, etc.) se logra localizando sus nudos 
extremos (incidencias) en un sistema coordenado cartesiano proporcionando las coordenadas de esos 
nudos 

No es necesario numerar en ningún orden a los nudos que forman parte de la estructura ya 
que el programa los numera. Es conveniente localizar nudos en donde se tenga cambio de 
propiedades geométricas o elásticas, recordando que el elemento barra requiere de dos nudos para 
localizarlo, el elemento placa 3 ó 4 y el sólido comunmente 8 nudos. 

Como se verá posteriormente el editor gráfico permite introducir la geometría de la estructura 
de una manera bastante sencilla y directa, ya que con la ayuda del "ratón" (dispositivo tipo puntero o 
mouse) simple y sencillamente por ejemplo haciendo die en las coordenadas de los puntos extremos 
de la barra automáticamente se definen sus incidencias así como las coordenadas de esos nudos. 

2.3 PASO 3. DEFINICIÓN DE LAS PROPIEDADES GEOMÉTRICAS DE LOS 
ELEMENTOS 

SAP 2000 permite manejar una gran variedad de formas predefinidas para la sección 
_transversal de las barras que componen la estructura (ver figura 2.2), como por eJemplo· 

Secciones !, canal, T, ángulos; ángulos dobles, cajón, tubos, etc. 
Secciones rectangulares, Circulares. 
Secciones cualquiera (proporcionando sus propiedades) 
Sección no prismáticas (propiedades variables). 

Figura 2.2. Algums formas para la sección transversal de las barras 

~ . 
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~pan d uso del prqaama. SAP2000 

Una vez elegida la forma de la sección transversal será necesario intrQducir los datos relativos 
a las dimensiones (tamaño) de la forma seleccionada (ver figura 2.3) . 

Figura 2.3. Dimensiones de una forma de sección transversal específica. 

Para los elementos barra prismáticos (general) de una estructura tridimensional se requiere 
proporcionar las siguientes propiedades referidas a ejes locales, centroidales y principales de la barra 
(ver figura 2.4). 

Figur·a 2.4 Características del tipo de sección transversal "general" 
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Cap~tulo 2 R~o~~ PMll d u~n dd pwgn.ma SAi>2000 

Dependiendo del tipo de estructura, en la tabla 2. 1 se muestran las propiedades geométricas 
mínimas que es necesario proporcionar para que el análisis se pueda realizar. 

Tipo de estructura 

TRUSS 
PLANE 
FLOOR 
SPACE 

Propiedad requerida 

AX 
AX, IZó IY 
IX, IZó IY 
AX, IX, IY, IZ 

Tabla 2.1 Prcpiedades geométricas mínimas requeridas. 

El programa SAP 2000 permite asignar las propiedades de los elementos barra de acuerdo a una tabla 
de perfiles de acero estándar (P. ej. tabla AISC, ver figura 2.5) o tomarlas de una tabla definida por 
el usuario. 

Figura 2.5. forma y propiedades geométricas tomadas de una tabla de perfiles. 

JI • 
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Cap¡tulo 2 R~ pan. d uw del prognm.¡ SAP2000 

Para el caso de los elementos placa será necesario proporcionar el espesor de la placa y 
seleccionar el tipo de trabajo de esta ("Shell", "Membrane" o "Plate", ver figura 2.6), para el sólido 
no es necesario proporcionar sólo constantes elásticas. 

Figura 2.6. Datos para los elementos placa. 

2.4 PASO 4. DEFINICIÓN DE LAS PROPIEDADES ELÁSTICAS DE LOS 
MATERIALES 

Para realizar el análisis se requiere tener definidas las constantes del material del cual están o 
estarán hechos los elementos (barra, piar-a, sólido) como son E (Módulo elástico), y v (relación de 
Poisson). Para inclUir el peso propio es necesario proporcionar el peso volumétrico, si se desea 
emplear alguna opción de análisis dii,ámico entonces es necesario proporcionar la masa por unidad de 
longitud (en un modelo de masas distribuidas), masas en los nudos (modelo de masas concentradas), 
si quiere que se considere efectos de temperatura será necesario especificar el coeficiente lineal de 
dilatación térmica (ver figura 2.7). 
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~es pan. d u.so dd proguna SAP2000 

Figura 2. 7. Dátos para las propiedades de un material. 

2.5 PASO 5. TIPOS DE FUERZAS Y COMBINACIONES 

Es necesario tener completamente identificados comunmente los sistemas o conjuntos de 
fuerzas (condiciones de carga) bajo los que se realizará el análisis ( P. ej. peso propio, carga :viva, 
sismo, viento, etc.) y para cada condición de carga las características de las fuerzas (tipo, magnitud, 
dirección, etc.) que forman parte de ese sistema de fuerzas. 

Por ejemplo una condición de carga puede ser la carga muerta que puede estar formada por 
ejemplo por: fuerzas uniformes en algunas barras simulando el peso de los muros divisorios, fuerzas 
concentradas simulando el peso de tanques, etc. 

Otra condición de carga puede ser el sismo, que por ejemplo pudiera ser representado por una 
serie de fuerzas estáticas (sismo est~.tico) aplicadas en determinados nudos. 

Una condición más puede ser la carga viva, idealizada como una fuerza por unidad de área 
actuando en una determinada zona de la estructura (P. ej azotea, entrepiso, escaleras, etc.). 

Los sistemas de ~arga independientes pueden ser utilizados para formar sistemas de carga 
dependientes es decir combina6ones, si lo anterior se desea, es necesario saber de antemano el 
número de combinaciones a incluir en el anáhsis y para cada combinación hs condiciones de carga 
que se incluirán así como su participación respectiva (factor de carga), por ejemplo teniendo como · 
'11arco al Reglamento de Construcciones para el D.F. pensando en una estructura del grupo A, 
localizada en el D F. una combinación es 1.5 de la carga muerta+ 1.5 de la carga viva máxima, por 

. lo que el factor de carga (o de participación) de las condiciones anteriores (i y 2) es 1.5, siendo 1 y 
2 las condicion~s de carga respectivas. 

13 • 



2.6 PASO 6. ELECCIÓN DEL TIPO DE ANÁLISIS Y RESULTADOS 

SAP 2000 permite realizar un análisis elástico lineal de 1 er. orden, también se pueden incluir 
efectos P-1\. o bien un análisis diná:nico, por lo anterior habrá que decidir sobre el tipo de análisis a 
efectuar por el programa. 

En cuanto a los resultados que el programa puede proporcionar, será necesario saber cuales 
se requerirán, por ejemplo: desplazamientos, elementos mecánicos, gráficas y diseño, y de que 
elementos se requieren; por ejemplo: de algunos o de todos los nudos, de algunos o de todas las 
barras, gráficas de la deformada, de algún marco o de toda la estructura, etc., lo anterior se "tendrá 
que definir para una, algunas o todas las condiciones de carga y/o combinaciones. Si el usuario no 
selecciona o define los elementos (nudos, barras, etc.), condiciones y/o combinaciones la impresión la 
realiza para todos los elementos y todos los sistemas de fuerzas existentes. 

2.7 PASO 7. DISEÑO DE ELEMENTOS 

SAP 2000 permite diseñar elementos de acero y concreto por lo que será necesario definir un 
código o especificaciones a utilizar (ACI, AISC, LRFD, ASSTHO, etc.) y proporcionar los valores 
de los parámetros a utilizar (fe, fy, etc.), así como especificar los elementos que se diseñarán y el 
criterio a seguir para su diseño (viga, columna, etc.). 
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C.pdulo 3 

DESCRlPCION 
GENERAL 

CAPÍTULO¡ 
31 

1 

3.1 INTRODUCCION 

Una vez que se ha modelado la estructura (previo al uso del programa), es decir, seleccionada 
la forma de la sección transversal de las barras, definidas las características fisicas y mecánicas de los 
materiales estructurales, especificados los sistemas de fuerzas (definidas cada una de las fuerzas que 
componen a cada sistema o condición de carga y combinaciones) bajo las cuales se analizará el 
modelo estructural, seleccionado el tipo de análisis así como el tipo de resultados, entonces se esta en 
condiciones de introducir los datos antes mencionados utilizando la interface gráfica que ofrece el 
programa con la cual es posible: · 

Manejar (Definir, mover, copiar, borrar) elementos estructurales (barra, placa, etc.). 

Definir Tipos de apoyo (fijo o con grados de libertad, resortes). 

Definir y asignar propiedades geométricas a los elementos barra de acuerdo a una tabla de 
perfiles estándar (AISC por ejemplo) o usar secciones prismáticas (circular, rectangular, Te, 
etc.), también es posible la utilización de secciones no prismáticas o de sección variable. 

Definir el espesor de los elementos placa. 

Definir y asignar propiedades a uno o varios elementos o grupo de elementos (barra, placas), 
las propiedades pueden ser densidad, módulo elástico, relación de Poisson, coeficiente de 
dilatación térmica, etc. Así como definir la posición de la sección dentro de la estructura 
(posición de ejes locales con respecto a los globales). Algunas de las propiedades se tienen 
predefinidas para ciertos materiales (acero y concreto) o se pueden introducir valores 
particulares. 

Es posible seleccionar barr~s para liberarlos de algunos elementos mecánicos en sus extremos. 
también se pueden definir diafragmas rígidos. 

Desde luego se permite introducir fuerzas estáticas aplicadas a los nudos, desplazamiento; 
prescritos eñ ellos, en el caso de barras se puede incluir el peso propio, fuerzas uniformes; 
concentradas, con variación lineal, de presfuerzo y debidas a mcrementos de temperatura, a 
ajustes en la longitud inicial de los elementos y algunas otras. 

Además de las fuerzas de ti¡:;o estáuco, se puede incluir cargas variables (móviles), de acuerdo 
a AASHTO ( HS20, HS 15, H20, HI5, cte.), o al UBC, o bien especifisadas ¡:;or el u'suano 
Una buena variedad de ft;erzas d1námicas (fucrza-Uempo o aceleración-tiempo) pueden 
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incluirse como sistemas de fuerzas, especificadas de acuerdo a sus características dinámicas 
(amplitud y frecuencia), ddi:liendo el lapso de tiempo de actuación· de la fuerza. 

Una vez introducida la geometría, propiedades y fuerzas que actúan sobre la estructura, SAP 
2000 permite la realización del Análisis operando sobre el contenido del archivo que se ha 
seleccionado o definido previamente el cual desde luego debe contener los datos de la estructura en 
estudio, el módulo de análisis interpreta cada una de las ordenes o definiciones indicadas en el archivo 
de datos en el orden en que se encuentran, el contenido del archivo de datos e instrucciones puede 
introducirse manualmente vía algún editor previo a la ejecución de SAP 2000 o bien mediante la 
instrucción Save al estar creando la estructura a través del editor gráfico característico del programa, 
ambas opciones se describirán posteriormente_ 

Después de ejecutada la opción de análisis, SAP 2000 _genera archivos conteniendo los 
resultados de la fase de análisis, si este concluye satisfactoriamente se desplegará la configuración _ 
deformada de la- estructura. Enseguida se podrán seleccionar opciones y elementos para que de ellos 
se muestren en el monitor los ~esultados numéricos y gráficos obtenidos por el programa como 
resultado del análisis. 

3.2 EJECUCIÓN DEL PROGRAMA, MENU DE OPCIONES 

Para iniciar el programa se puede hacer doble clic en el icono del programa o bien desde el 
menú de inicio hacer clic en la carpeta programas SAP 2000 educacional (versión educativa) o SAP 
2000 NonLinear (versión profesional), enseguida se ejecuta el programa presentándose la imagen 
mostrada en la figura 3.1, una vez haciendo clic en la caja OK de la ventana en la parte central ("Tip 
oj the day") desaparece esta dejando lugar a la ventana principal del programa SAP 2000_ 

En el "renglón" superior de esta ventana se encuentra en su extremo izquierdo el nombre del 
orograma (SAP2000) seguido del nombre de archivo en donde se almacenarán los datos o de donde 
han sido tomados, en el extremo derecho se encuentran los iconos de minimizar, restaurar la ventana 
y cerrarla (una forma de finalizar la ejecución del programa es haciendo clic en este icono), debajo de 
lo anterior se localiza la barra de menú conteniendo las opciones que el programa tiene disponibles 
(Eile, I;:dit, View, etc_) las cuales se describirán posteriormente, debajo de esas opciones se 
encuentran una serie de iconos que realizan acciones de 'usO frecuente (seleccionar elementos, 
cambrar alguna opción de presentación, elegir algún tipo de resultado, etc.), se recomiendo al lector 
consultar las tablas que se presentan al final de este trabajo en donde se describe cada uno de esos 
iconos (incluyendo los de la barra flotante que también forma parte de la ventana de SAP 2000). 

Debajo de los iconos está el área de presentación (con fondo negro) en la que se muestra 
gráficamente el modelo de la estructura por analizar así como diversa información en forma de 
ventanas que seran -desplegadas por el programa después de que el usuario seleccione alguna de las 
opcior.es disponibles de SAP 2000. 

Por último, en la parte mferior debajo de la barra flotante de iconos se muestra información 
acerca de las características del área de dibujo (vista o plano de presentación, coordenadas de algún 
nudo, etc.) y un poco a la derecha esta el cuadro de selección de unidades en las que se rntroducirá la 

15 • 



,--

Cap1tul0 3 

información, antes de este cuadro se ·muestra· iiifonnación ·aéei-cá .. a el .. estado que guarda alguna 
instrucción o del programa. 

Oid yo u k.now tho.L. 

Using Set Limtts and Show Selec:tions Only 
options: both from the.View menu. can 
reduce the number of elements that ore 
VISible 011 the screen. 

Figura 3.1 Iniciando el programa SAP 2000 

En la versión 6.1 del programa SAP 2000 se pueden seleccionar varias opciones, las que se 
describen a continuación pueden ser las de uso más frecuente. • 

3.3 El menú file 

EL menú file (ver figura 3.2) permite entre otras opciones manejar la información de alguna 
estructura contenida en un archivo, esa información pudo haberse generado previamente a la 
eJecución del programa o dutante su uso, las opciones de este menú permiten: 

Ncw Moúel Iniciar un problema nuevo. 

Ncw Model from template Iniciar un problema nuevo, selecciOnando una geometric. 
típica de algunas formas estructurales como las mostradas en la 
figura 3.3 

Opcn ... Abrir un archivo existente con datos de alguna estructura. 

ln.o;tn•cUH' pau IJ utili7.aCJ.on dcl pro¡:u.ma ~Al' 1000, Fl UNAM F. Munroy ¡r, • 
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§.ave 

SaveAs 

I!!!port 

];xport 

Print ... 

Guarda los datos de la estructura. 

Guarda los datos de la estructura en otro archivo. 

Permite ingresar los datos de un archivo generado con 
AutoCad, o bien para SAP90. 

Proporciona la flexibilidad de poder enviar los datos de la 
estructura existente a una archivo para SAP2000 con extensión 
.S2K el cual puede ser modificado.· por ciertos procesadores de 
texto (p.ej. WordPad) y poder ser utilizad() nuevamente por 
SAP2000, o bien enviarlos a un archivo .DXF y poder ser 
interpretado por AutoCad por ejemplo. 

Nos permite configurar características de impresión, imprimir el 
contenido del área de dibujo así como una lista de datos y 
resultados. 

Cerrar el programa y regresar a Windows . 

. ,:;:\Mis <to<:i>n,,i,toslc,liioi•pil100\oj,;,llJ':1(,9l;n¡; 
•::\Mts docl"":'é'to<\c'•~o i<p"i{OOI;j''rupllot1;L\ll': .• 

. -c:\!'ks 
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Figura 3.2 Módulos principales del menú file. 

Figura 3.3. Geometrías predefinidas en la opción New Model from Iemplate 

Existen dentro de este menú otras opciones de uso no muy frecuente. Al iniciar SAP 2000 se 
recomienda seleccionar las unidades en las que se van a introducir los datos de la estructura a 
analizar, por ejemplo si estas fueron ton-m (toneladas y metros) los valores de las fuerzas uniformes 
se deben de proporcionar en ton/m, de las inercias en m', para el módulo elástico en ton/m2

, etc., es 
decir los valores deben ser consistentes. 

3.3 El menú ~dit 

EL menú .!;;dit (ver figura 3.4) permite desde introducir y hacer cambios a la geometría del 
modelo hasta suprimir algunos de sus elementos muchas de las opciones contenidas en este menú 
operan en conjunto con las del menú Select (ver siguiente sección), las opciones de este menú 
permiten: 

Cut 

Copy 

Paste 

Delete 

Suprimir los elementos seleccionados, guardándolos en la memona 
temporai. 

Copiár sin borrar los elementos seleccionados a la memoria temporaL 

Insertar los elementos contenidos en la memoria temporal especificando 
nuevas postctones. 

Suprimir los elementos seleccionados. 

I!L~tr\lctlw ¡¡aula ull!u.wwu dd pwgnma 5.4J' ~000, 1! L">JAM 18 • 



Merge Joints 

M ove 

Replica te 

Divide frames 

Join frames 

Change Labels 

Juntar los nudos que tengan una separación menor que un cierto valor- -
(dejando uno solo y suprimiendo los demás es decir los nudos 
duplicados). 

Mueve los nudos seleccionados especificando el incremento en sus 
coordenadas, moviendo también los elementos que estén conectados a 
esos nudos. 

Realiza una copia (réplica) de los elementos selecciohados 
especificando el incremento en las coordenadas de sus nudos extremos. 

Divide a las barras seleccionadas en un número especificado por el 
usuano_ 

Junta varias barras seleccionadas en una sola (operación inversa de 
Divide frames) _ 

Cambia la numeración de los elementos seleccionados (renumera)_ 

iJ! SAPlODD '- {Unlltled} • • - - - - - , - - - - - - - '11!1!;113 

Figura 3.4. Opciones del menú Edit 

3.4 El menú View 

EL menú Y1ew (ver figura 3.5) permite cambiar la presentación del área de dibujo de la 
estructura, algunas opc10nes que resultan de uso cotidiano son 

!nstructJv(> para 1:1 ub.l.!z.ac.t('n del prn¡;r:o..~ua SAP 2000, FJ UNAM F. Monroy 19 • 



Ctpllulo J 

Set !;lements 

Figura 3.5. Opciones del menú View. 

Permite seleccionar la información a ser incluida dentro del área de 
dibujo (numeración de nudos, barras, eJeS, etc.), ver figura 3.6 

F Munroy 20 • 
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Show Grid 

Show Axes 

Figura 3 .6. Opciones de Set Elements. 
·:;::::-: 
-~ 
-~~ 

Permite Activar (mostrar) o desactivar la malla auxiliar para dibujo de 
elementos. 

Dibuja o suprime los ejes globales de la estructura. 

Se deja al lector que pruebe el efecto de las otras opciones, las características de algunas de 
ellas se verán posteriormente en el desarrollo paso a paso de algún ejemplo. 

3.:i El menú Define 

El menú Define (ver figura 3.7) permite especificar propiedades de los materiales 
(Materials .,.), características geométricas como forma, dimensiones, material, etc. para las barras del 
modelo (Frame Sections .. ) y algunas características para los. elementos placa (Shell Sections ... ). 
También permite definir características generales de las condiciones de carga estática como su titulo 
o identificación, el tipo de carga (de acuerdo a su origen) y si se incluirá el peso propio en la 
condición de carga. 

En este menú se podrá seleccionar o introducir un espectro de respuesta así como funciones 
de exCitación para análisis dinámico, también se podrán definir las combinaciones de carga (Load 
Combinations ... ) seleccionando las condiciones de carga que se incluirán en cada combinación con 
sus respectivos factores de carga 

F Mou.rCiy 2! 
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Figura 3.7. Opciones del menú Define. 

3.5 El menú Draw 

Algunas de las opciones del menú Draw (ver figura J .8) permiten dibujar esquemáticamente a 
los elementos barra, placa, etc. con los que se irá construyendo el modelo estructural por analizar, 
algunas opciones de uso frecuente son: 

.!j;dit Grid 

Draw .Erame Element 

Permite adicionar, modificar, suprimir, etc. las líneas que forman 
la malla auxiliar para dibujo de elementos. 

Permite iniciar el dibujo (con la ayuda del ratón) de elementos 
barra, después de seleccionar esta opción se hace clic izquierdo 
del ratón en el nudo donde inicia la barra (en caso de que este 
no halla sido creado se hace clic en sus coordenadas), luego se 
desplaza el puntero (sin arrastrar) hacia el nudo final de la 
barra haciendo clic izquierdo en el nudo con lo que queda 
especificada esa barra (se recomienda utilizar la malla auxiliar 
cambiando la separación de las lineas .de la malla para que 
algunas de las inter>ecciones de esas lineas coincidan con la 
mayoría de los nudos de la estructura), la secuencia de dibujo de 

r M0ruroy 
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Draw Shell Elemen-t 

barras se puede interrumpir con un doble die del.botón derecho 
en cualquier parte del área _el_~-- dibujo (con lo que es posible 
dibujar barras en otras posiciones); para terminar el dibujo de 
barras se hace clic en el icor¡o de puntero de la barra flotante de 
iconos, posteriormente se puede dibujar más barras volviendo a 

-- seleccionar esta opción, lo anterior se puede hacer- tantas veces 
c_qmo se requtera_ 

Permite iniciar el dibujo (con la ayuda del ratón) de elementos 
placa, funciona de manera muy similar a la opción anterior solo 
que en este caso se seleccionaran tres o cuatro nudos 
dependiendo del tipo de elemento ·fiíiito que se quiera dibujar, la 
selección de nudos se hará en sentido horario o antihorario. 

Quick Draw ,Erame Element y Quick Draw Shell Element permiten el dibujo de barras y 
placas respectivamente c-Jn un solo die izquierdo cerca de alguna de las líneas de la malla 
auxiliar (para el caso de barras) y en algún punto dentro de un área delimitada por líneas de la 
malla auxiliar de dibujo (para el dibujo de placas), se deja al lector la práctica con estas 
opciones antes de abordar los ejemplos que se presentan en el capítulo correspondiente. 

Figura 3.8_. Opcionr:s delmenu Draw. 
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3.6 El menú ·§elect . -·~···~- -.·····-···· ·:¿;•. ---: .·:~ : 

Algunas de las opciones del menú Select (ver figura 3. 9) nos pennitirán seleccionar elementos 
ya existentes dentro del modelo, la selección de elementos es necesaria para poder asignar (ver menú 
Assign) algunas características a los mismos, por ejemplo si se seleccionan barras se les·podrá asignar 
secciones, cargas, etc. las siguientes son algunas opciones que resultan de uso· frecuente:'· 

Pointer/Window 

Intersecting Line 

Pennite seleccionar a los elementos que quedan cóntenidos 
dentro de un área rectangular que se define .. haciendo clic 
izquierdo en una de las esquinas del área y arrastrando el 
puntero del ratón hasta la esquina opuesta y soltando el botón 
del ratón en esa esquina, los elementos seleccionados cambian 
su aspecto de línea continua a línea interrumpida (punteada) . 

• 

Con esta opción se seleccionan a aquellos elementos que son 
intersectados por una línea que se define haciendo clic izquierdo 
en uno de los extremos de la misma y arrastrando el puntero del 
ratón hasta el otro extremo de la línea y soltándolo ahí mismo. 

Las otras opciones de Select penniten seleccionar elementos que tienen alguna característica 
en común. 

rg SAPlDllll- !UntiUédl . . " ·· · · · : ' . • • r§r;;;¡EI 

Figura 3.9. Algunas opciones del menú §elect. 
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El menú Select dispone de las mismas opciones para excluir elementos ya seleccionados, lo 
anterior se realiza con la opción Unselect, otra manera de quitar elementos de la selección es 
haciendo die en el icono de flecha de la barra flotante de iconos y luego hacer die en cáaa· Uiió de 
los elementos que han sido previamente seleccionados y que se quieren excluir, inclusive si se hace 
clic en un elemento no seleccionado este se selecciona y viceversa · · 

3. 7 El menú Assign 

Una vez seleccionados algunos elementos (nudos, barras, etc.) podemos asignarles alguna 
característica pr?pia del elemento (restricciones, fuerzas, secciones, etc.), el menú Assign (ver figura 
3. lO) junto con sus opciones nos permitirán realizar esa actividad, enseguida una breve descripción 
de algunas opciones del menú assign. 

Joint 

Joint Static Loads 

Frame 

Frame Sta tic Loads 

Permite asignar a los nudos seleccionados 
apoyos (restraints), asignar el mismo 
(constraints), asignar resortes (springs), etc. 

restricciones o 
desplazamiento 

Con esta opción se asignan a los nudos seleccionados fuerzas 
(Forces) o desplazamientos prescritos (Displacements). 

Permite asignar a las barras seleccionadas propiedades 
(Sections), liberarlas de algún elemento mecánico (Releases), 
especificar sus ejes locales (Local Axes), etc. 

Con esta opción se asignan fuerzas estáticas de gravedad 
(Gravity), puntuales y/o uniformes (Point and Uniform), con 
variac10n lineal (Trapezoidal), efectos de temperatura 
(Temperature), y efectos de presfuerzo (Prestress). 
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Figura 3.10. Algunas opciones del menú Assign. 
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3:8 El menÍí A!!atyzé.- . ..... ¿. .. , ' " .... ;~··- ~·· .;;;;:: ... ;' ,,, •••.• . - - -:- --- ··--

El menú A!!alyze (ver figura 3.11) permite séleccionar algunas opciones de análisis (Set 
Options ... ), o bien se puede solicitar que el programa SAP 2000 realice el análisis (Runj coh los 
resultados desplegados en una ventana normal o bien en una ventana minimizada (Run Minimized), 
se recomienda guardar el archivo de trabajo antes de solicitar el análisis (inclusive guardarlo en disco 
flexible y luego_en el disco duro). 

. ¡ ·,~r, 
t :~-

1
, '> '" 

1 • 

1 . 

' . . 1 
' 

: . : 1 . 
' . • 1 • 

Figura 3.11 Opciones en el menú A!!alyze. 

Las opciones de Set Options ... (ver figura 3.12) permiten seleccionar los grados de libertad 
activos (Available DOFs) dependiendo del tipo de estructura que se analizará, será necesario 
identificar y seleccionar haciendo clic en los cuadros respectivos del área correspondiente (un cuadro 
en blanco significa que ese grado de Ebertad no esta activo), otra rnancra de seleccionar los grados de 
libenad es utilizañdo la opción de seleccionado rápido (Fast OOFs), lo anterior se realiza haciendo 
clic en alguna de las figuras que corresponda a nuestra estructura, la selección inadecuada de los 
grados de libertad puede generar resultados incorrectos o estructura inestable (división entre cero) 
durante la fase de análisis. 
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Figura 3.12. Opciones de Set Options ... del menú A!!alyze. 

Al final de la caja de selección se puede indicar que se realice un Análisis Dinámico (Dynamic 
Analysis), que se incluyan efectos P-6 (Include P-Delta) y que se generen archivos de salida 

(Gener·ate Output), para estas ultimas opciones es conveniente indicar algunos parámetros y 
seleccionar algunas opciones especificas. 

Cuando se selecciona la opción de Análisis (Run), y algunos resultados del proceso se van 
desplegando en la pantalla (ventana) quedando al final algo similar a lo que se muestra en la figura 
3.13. 
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Figura 3.13. Ventana al finalizar el análisis. 

Al hacer clic en el botón OK de la ventana que se muestra al final del análisis, se despliega en 
el área de dibujo la configuración deformada de la estructura para determinada condición de carga, en 
esta parte del programa se podrán seleccionar los resultados del análisis por ejemplo desplazamientos 
de los nudos, reacciones, elementos mecánicos, diagramas de elementos mecánicos, configuraciones 
deformadas, etc. 

3.9 El menú Displav 

Este menú permite solicitarle al programa que muestre la geometría no deformada del modelo 
(Show Undeformed Shape), las cargas en los nudos (Show Loads), en las barras, en los elementos 
placa o no mostrarlas. 

Mediante la opción Show Input Tables (ver f1gura 3.14) se solicita al programa que muestre 
en una ventana conteniendo una !ista con los datos numéricos de la geometría en lo que respecta a 
nudos (coordenadas, restricciones, etc.), barras (incidencias, tipo de sección, etc.) y cargas (en los 
nudos, en las barras y en las placas), produciendo una salida parecida a la de la figura 3. 15, la tabla 
mostrada puede imprimirse o grabarse en un archivo. 

la.stmct¡,,. poli~ l• ul.!4.'-lc.<'" del Pf<'¡.:r.uu~ SAl' 2000, Fl l)}.iA).I 
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Figura 3.14. Opciones del menú Display: 

1 -3.00000 0.00000 0.00000 1 1 1 1 o 1 
2 -3.00000 0.00000 ~.00000 o o o o o o 

-3.00000 0.00000 R.OOOOO O O O ~·O O 

o. 000 .,, 

o.ooo :z~ 
o. 000 :~-:: 

--;>.·e · :.~·-- · ~3.00000- ; o.ooooo 12.00000 o. o o o o o· . o.ooo 
-~.,._ 

~~ ~~~ $1 o o o· o o o 
o o o o o o " -:,. 00000 o. 00000 J.{i. 00000 

6 -3. 00000 o. 00000 20.00000 
7 ·:J.OOOOO 0.00000 24.00000 o o o o o o o. 000 $~ 
S -3.00000 0.00000 '2.B. 00000 o o o o o o o. 000 \~~ 

9 .. J.OOOOO 0.00000 3~.00000 oooooo .o.oooF~ 

-~--"?, •.• ~---~.}"'·~- •.......• 1: .. ~~~-"~-.10 -3.00000 0.00000 36. 00000 
,;, .. .;., .. :·:.·.: ·:: : .. ::~:._..:,,,::. ,,.; ·;.:. :.: . .;;, .;, =-»!.V.<'•''''·"'''·''''''"' : .. .;,;.:.-: .. - ""''·'·""· 

Figura 3.15. Salida típica a partir de Show Inp!.!t tab!es del menú Display. 

Mediante la_opción Show Deformed Shape y después de seleccionar la condición de carga, 
SAP 20~0 muestra la configuración deformada correspondiente (ver figura 3.16). 
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Figura 3.16. Salida típica a partir de Show Deformed Shape del menú Display 

La opción Show Element Forces/Stresses y dependiendo de la selección que se haga SAP 
2000 puede mostrar elementos mecánicos, esfuerzos, reacciones, etc. produciendo una salida similar 
a la que se muestra en la figura 3 17. 

• 
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Capitulo J 

Figura 3.17. Salida obtenida con Show Element Forces/Stresses del menú Display 

3.1 O El menú Design 

EL menú Design (ver figura 3.18) permite seleccionar algunas opciones de diseño, realizar el 
diseño (verificación) de elementos con la posibilidad de optimizar secciones, con la característica de 
producir salidas similares a las mostradas en las figuras 3.19 y 3.20 de entre otras. 
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Figura 3.18. Opciones del menú Design. 
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Figura 3.19. Algunos resultados del menú Design 
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Upttulo 3 

Figura 3.20. Algunos resultados del menú Design. 
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Figura J.21. Algunos resultados del menú Design. 
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3.11 Los menús Options y HeiJY. ·- · '"·::..~·'::Occ·::- cc'c:o ......... . 

El menú Options (ver figura 3.22) permite por así decirlo controlar el tipo y características de 
la información que será mostrada en las diferentes áreas de presentación (colores, número de 
ventanas, etc.). 

En este punto podemos mencionar que una vez que se realiza el análisis SAP 2000 "bloquea" 
al modelo no permitiendo realizarle ninguna modificación por lo que solo es posible manejar los 
resultados (ver valores numéricos, gráficas, imprimirlos, etc.), para desbloquear al modelo y poder 
hacerle cambios se selecciona la opción Lock Model con esto ahora los resultados ya no están 
disponibles para poder tener acceso a ellos una vez realizados los cambios será necesario solicitar 
nuevamente la realización del análisis. 

f.li SAP::.OIIO • ejemplal •• · .. •. .... . • @!l!ilf.3 

Figura 3.21. Opciones en el menú Options y desbloqueo del modelo 

Se deja al lector q:Je pruebe el efecto de las otras opciones del menú Options asi como las del 
menú Help, las características de algunas de ellas se verán posteriormente en el desarrollo de algunos 
ejemplos: 

ln.>(nK!Ivo pan]~ Ulll.J.z.aCIOIIdd progra.UJ SAP ~000. F: UNAM 33 • 



4.1 INTRODUCCIÓN 

GENERACION DE 
LA ESTRUCTURA CAPÍTULO j 

41 

En SAP 2000 la generación de la estructura se entiende como la ubicación con respecto a un 
sistema de coordenadas (global) de los elementos barra, placa y sólido, la asignación de propiedades 
geométricas y elásticas a los elementos ya localizados, la introducción de apoyos, la definición y 
asignación de fuerzas a los nudos, barras y placas, la selección del tipo de análisis y resultados, por 
último, el dimensionamiento o revisión de elementos. 

La forma de iniciar el programa SAP 2000 ha sido descrita. con anterioridad (ver inciso 3.2 
del capitulo anterior), ensegu'.da se recomienda elegir las unidades en que se introducirán los datos 
haciendo clic en la pestaña que se encuentra a la derecha del cuadro de unidades y seleccionándolas 
de la caja que muestra el programa (ver figura 4.1 ). 

!iiSAI\21lll1FI) · / .,· · · ·· · • · ' ' ' . · . . ' • l!!lf;JEJ 

Figura 4.1 Selección de unidades. 
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SAP 2000 ofrece varias alternativas para introducir la topología de la estructura, aqui 
empezaremos por una de las más comunes que es introduciendo elerrientó por elemento, para ello se 
recomienda auxiliarnos de la malla (grid) que el programa nos proporciona por lo que se tendrá que 
ajustar la separación de las líneas que forman esa malla, seleccionemos New Model del menú File, 
enseguida e! programa mostrará un cuadro en dónde se especificaran. las caracterisiicas de la malla 
como el número de espacios en cada dirección así como sll separación los cuales se pueden modificar 
introduciendo valores particulares en los cuadros en fondo blanco haciendo clic en el que se quiera 
modificar (ver figura 4.2) 

Figura 4.2 Ventana para definir las características de la malla auxiliar. 

Una vez que se ha hecho clic en el botón OK el programa muestra la malla resultante en el 
área de dibujo (con fondo negro) dividiéndola en 2 cuadros mostrando en ellos una vista diferente de 
la malla (3D y en el plano X-Y en Z=10.5), también puede observarsP.los ejes coordP.nados globa!~.s 
(ver figura 4.3). 
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Figura 4.3 Imagen típica después de defmir las características de la malla auxiliar. 

Cada una de esas ventanas tiene en su extremo superior derecho los botones de minimizar, 
ventana completa y cerrar, el número y tipo de ventanas a mostrarse en la pantalla puede 
seleccionarse a través de la opción Windows del menú Options. 

De las ventanas· que se muestran, la ventana activa o en la que se muestran los resultados de 
los comandos que se elijan es aquella cuya barra de título está en color (generalmente diferente del 
gns), se activa una ventana haciendo clic en su interior. 

La malla así creada tiene separación constante entre las líneas de una misma dirección, existen 
varias maneras de cambiar la separación entre cada línea de la malla, una de ellas es, después de 
seleccionar una vista en planta hacer dos clics seguidos en una de las líneas de la malla (con el botón 
izquierdo del ratón), enseguidc se mostrará una ventana conteniendo información acerca de la 
posición de esas líneas con la opción de seleccionar la dirección de las líneas de la malla así como 
adrcionar, mover y borrar line;¡s. 

Haciendo -clic en el cuadro en blanco e introduciendo el valor de la nueva posición de la linea 
y después de hacer die en la opción Add grid line se ha introducido una nueva iínea a la malla. Para 
modificar el valor de una línea se selecciona de la caja en gris haciendo clic izquierdo en la línea a 
modificar con lo cual se muestra ~n la caja en blanco y haciendo clic en esa caja se puede cambiar su 
valor, para que el cambio resu:te efectivo después de modificar el valor de la caja en blanco se 
necesita hacer clic en e! botón Move, las dem~s opciones cQmplementan la modificación de !a malla 
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Cap¡tulo 4 

(ver figura 4.4). Desde luego que para que todos los ·cambios produzcan efecto es necesario hácer 
clic en el botón OK . 

Figura 4.4 Modificación de la separación individual entre las líneas de la malla. 

Otra manera para que se muestre el cuadro de la figura 4.4 es seleccionando Edit Grid del 
menú Draw, otro comando que resulta útil es la opción Show Grid del menú View con el cual se 
suprime o activa la aparición de la malla en área de dibujo. 

Los datos de la estructura que se vayan introduciendo son almacenados en memoria volátil 
(RAM) por tal motivo se recomienda que con cierta frecuencia se graben en el disco duro (o en d1sco 
flexible), para ello se puede utilizar la opción S ave o S ave As del menú File, el programa asignará al 
nombre del archivo proporcionado por el usuario la extensión .SDB. 

Ahora podemos introducir todos los elementos que componen a la estructura, a continuación 
se presenta una breve descripción lógica de las opciones de uso común así como de los comandos 
que nos permitirán la generación de la estructura en el orden mencionado al inicio de este capítulo, 
varios de los comandos fueron descritos en el capítulo anterior. 

4.2 DESCRIPCIÓN GENERAL 

La parte del proceso de modelación que consume más recursos (tiempo y esfuerzo) es la que 
concierne a la introducción de elementos (barra, placa, etc.), es por ello que el uso eficiente de lo.> 
comandos del menú Draw y en combinación con algunos otros nos permitirá la generación de la 
topología (forma) de la estructura lo más pronto posible, como recomendaciones generales, se 
pueden mencionar las que se indican en los párrafos siguientes. 
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Procurar iniciar la geometría de la l"..structura a partir de alguna de las predefinidas que trae la 
librería del programa (vigas, marcos, etc.), enseguida realizar los cambios necesarios para ajustar esa 
geometría a la del modelo por analizar (adicionando o borrando algunos elementos, cambiándolos de 
posición, copiándolos, etc.) 

Para la definición de elementos (barra, placa; etc.) auxiliarse de la malla (grid) cambiando la 
separación de las líneas de la malla para que sus intersecciones definan la mayor cantidad de 
coordenadas de los nudos de nuestro modelo procurando que con la nueva separación de lai; líneas de 
la malla los elementos resultantes tengan las características (dimensiones e inclinación) deseadas con 
lo que el usos de las opciones de dibujo rápido de elementos (con un solo clic, en lugar de dos clics) 
traerá algún ahorro y facilidad de creación o modificación del modelo. 

Las características a ser mostradas en la pantalla (numeración, ejes locales, etc.) de los 
elementos que se van adicionando al modelo (nudos, barras, placas, etc.) pueden ser controladas 
mediante la opción Set Elements del menú View (ver figura 4.5). La información mostrada puede ser 
de utilidad, también es conveniente recordar que las características de algún elemento (nudo, barra, 
placa, etc.) pueden desplegarse seleccionándolo ( clic izquierdo) y luego haciendo clic derecho, 
algunos de los elementos en la caj2. mostrada pueden ser modificados (ver figura 4.6). 

Figura 4.5 Selección de información a desplegarse en el área presentación del modelo. 
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Figura 4.6 Características dd elemento barra seleccionado (la información en el cuadro en blanco 
puede ser modificada directamente). 

4.3 GENERACIÓN DE LA GEOMETRÍA 

Una de las maneras de cre¡¡r el archivo de datos o de modificar su contenido, es a través del 
editor gráfico cuyas opciones están contenidas principalmente en el menú Draw (ver figura 4. 7), 
algunas de ellas se describen a continuación. 

Draw Frame Elemcnt permite adicionar un nuevo elemento barra, para ello se hace clic 
primero en el punto extremo de la barra y luego en el opuesto. 

Draw Shell Elcmcnt permite adicionar un nuevo elemento placa, haciendo clic en los puntos 
extremos (vértices) sucesivos del elemento empezando por cualquiera de ellos se define la geometría 
de este elemento. 

Quick Draw Framc element permite adicionar un elemento barra haciendo un solo clic en 
una línea de la malla auxiliar de d!b'.lja que este delimitada por o"tras dos perpendiculares a la primera, 
esas lineas definen los limites del elemento, si se hace clic en cualquier punto de la zona delimitada 
por cuatro lineas de la malla o por cuatro nudos se adicionan dos elementos barra diagonales. 

Quiek Draw Shcll clcmcnt adiciona un nuevo elemento shell haciendo ur. solo die en 
cualquier punto de la zona delimitada por cuatro lineas de la malla. 

Comúnmente al ~eleccionar alguna de l;;s opcione; anteriores la forma del cursor cambia a una 
flecha vertical vacía hacia arriba, para cancelar o terminar la opción se hace clic en el primer icono de 
la barra flotaíJte con Jo que el cursor cambia a flecha inclinada llena. 
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Figura 4. 7 Opciones del menú Draw. 

Con objeto de completa~ el modelo o realizar los cambios que se deseen, una vez que se han 
ubicado elementos, cuando sea posible se recomienda generar algunos otros realizando copias, giros, 
etc. de uno o varios de los que ya se tienen definidos. 

Para tal efecto varias opciones se encuentran en el menú Edit (ver figura 4.8), ,pero para 
poder utilizar algunas de ellas es necesario seleccionar elementos (por ejemplo los que se van a 
copiar), para ello existen disponibles varias formas de seleccionar elementos, la más sencilla es hacer 
die en el elemento a seleccionar (nudo o barra), el' elemento seleccionado se muestra con línea 
discontinua, se puede anular la selección haciendo die en un elemento seleccionado, también se 
pueden seleccionar elementos que queden totalmente contenidos en una ventana rectangular creada 
haciendo die en uno de los vértices de la ventana y arrastrando el ratón hasta el vértice opuesto de la 
misma y soltando ahi, otras opciones de selección se encuentran en la opción Select del menú con el 
mismo nombre, desde luego que las acciones anteriores se pueden aplicar en repetidas ocasiones e 
inclusive combinar varias maneras de seleccionar y excluir (Unselect) elementos para lograr· un 
resultado deseado.-

Hecha la selección de algunos elementos (también puede ser uno o todos) se pueden llevar a 
cabo ciertas acciones con dios dando como resultado posibles cambios a esos elementos y en general 
al modelo o estructura por analizar, cuando el efecto final no es el esperado se recomienda cancelar la 
acción, para ello se hace clic en el icono (Un Do) que esta casi pcr debajo del menú Vicw. 
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Figura 4.8 Opciones del menú Edit. 

Cut y Delete Elimina los elementos seleccionados. 

Copy copia los elementos seleccionados a una memona temporal 
permitiendo ser insertados posteriormente, los elementos que actualmente se encuentran 
seleccionados no se suprimen, cuando se aplica nuevamente la opción Copy a una nueva 
selección, los elementos seleccionados anteriormente (si es que los había) se eliminan de la 
memoria temporal quedando los actualmente seleccionados. 

Paste inserta los elementos que se almacenaron previamente en la memoria temporal mediante 
la opción Copy, al seleccionar esta opción se presenta una ventana en donde se puede 
especificar un incremento a todas las coordenadas de los nudos y a los nudos extremos de los. 
elementos guardados previamente con la opción Copy (ver figura 4.9). 
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Figura 4.9 Opción Paste del menú Edit. 

Move Una vez seleccionados algunos nudos este comando permite cambiar las coordenadas 
de los nudos seleccionados desplazándolos hacia nuevas posiciones obtenidas a partir de sus 
coordenadas actuales y de ia información que el 1usuario proporcione en la ventana que se 
despliega cuando se elige esta opción (ver figura 4.1 O). 
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Figura 4.1 O Información complementaria de la opción M ove del menú Edil. 

Replica te Una de las opciones más poderosas con la que se pueden realizar varios efectos es 
la opción Replicate del menú Edit, dentro de esta opción a su vez se encuentran disponibles 
otras 3, Linear, Radial y Mirror. 

La opción Linear permite realizar varias copias de los elementos seleccionados, esas copias 
se pueden realizar en cualquiera de las direcciones x, y o z, por ejemplo si las copias se 
quieren realizar en dirección x se especifica un valor de x diferente de cero en la caja 
respectiva y cero en las demás (ver figura 4.11), desde ·luego se pueden especificar valores 
diferentes de cero con el efecto correspondiente, la opción Radial permite realizar copias en 
dirección radial (angular) especificando el eje alrededor del cual se van a hacer las copias así 
como el incremento en grados y el número de estas. 
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Figura 4.11 Efecto de Linear en la opción Replica te del menú Edit. 

La opción Mirror permite realizar una copia tipo espejo de los elementos 
seleccionados especificando la posición del espejo mdiante la selección de un plano (xy, yz o 
xz) y la distancia del origen a la posición del espejo (ver figura 4.12), esta opción resulta muy 
útil cuando se tiene una estructura simétrica ya que se introduce una parte de la misma y se 
genera la otra (parte simétrica) mediante la opción Mirror · 
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Figura 4.12 Efecto al selecciJnar Mirror de la opción Replica te en el menú Edil. 
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4.4 DEFINICIÓN Y ASIGNACIÓN·DE-MA TERL(LES . ~ ·. ""'" ::-:e" ;:c.:: .. · 

En el menú Define en la opción Materials se podrán especificar las características de los 
materiales del cual estarán formados los elementos estructurales, en este menú se pueden especificar 
materiales tales como concreto, acere y otros; después de seleccionar .. esta opción aparece el cuadró 
que se muest@.en la figura 4.13, en donde como puede observarse mediante la opción Modify/Show 
Materials, se mostrarán con la posibilioad de modificar algunas caracteristicas del material que 
interviene para el análisis y el diseño de elementos (ver figura 4.14). . -

·~~~~-
•-::;l;;;r---.-. 

Figura 4.13 Ventana para definición de materiales. 
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Figurl! -4.14 Ventana Modili/Show Material de la opción Define Materia1s. 

Add N ew material permite definir un nuevo material, se tendrá que especificar desde el 
nombre (Material N ame), formado por un conjunto de hasta ocho caracteres el cual hará referencia 
a este material, se tendrán que p: O¡JOrcioi1ar por lo menos los datos que se muestran en el cuadro 
análisis Froperly Data, sobre todo el módulo elástico y la relación de Poisson, en el caso de que se 
requiera considerar el peso propio en alguna condición de carga se tendrá que proporcionar el peso 
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por unidad de volumen, ·si se· va a solicitar alguna· opdó~ de iuiálisii(dinámico en donde se quiera 
considerar a la masa de la estructura repartida a lo largo de sus elementos será necesario 
proporcionar el valor de la masa por unidad de volumen, en el caso de que se requiera considerar el 
efecto de temperatura es necesario proporcionar el coeficiente de expansión térmica (ver figura 
4.15). ~ .. . 

Figura 4.15 Opción Add New material de Define Materials 

Se pueden definir varios materiales dependiendo de los que se requieran para especificar" a 
los elementos en la estructura, la opción Materials del menú Define también permitirá eliminar 
algún material de los que se muestran en el cuadro Materials con excepción de los materiales 
Conc y Steel, para ello sólo se hace clic en el nombre del material a eliminar y luego en el botón 
Delete Material. 

4.6 DEFINICION Y ASIGNACION DE PROPIEDADES GEOMETRICAS 

En el menu Define también se encuentra presente la opción para definir características de las 
secciones transversales (Frame Sectíons) de los elementos que están presentes en la estructura por 
analizar. En la ventana correspondiente (ver figura 4.16), se tiene la opción lmport para seleccionar 
las propiedades de una base d~ datos con extensión PRO, la versión educativa del programa 
SAP2000 proporciona los archivos Aisc.Pro, Cisc.Pro y Sections.Pro de los dos primeros se 
pueden seleccionar algunas forma~ cc•munes, esos archivos se encuentran en la carpeta SAP2000e. 

También se pueden defmir !as propiedades a partir de formas comunes mediante la opción 
Add, otras opciones que tambié1, se encuentran disponibles permiten modificar (Modify/Show 
Section) o eliminar alguna propiedad (Dclete Section), 
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Figura 4.16 Opciones en Define Frame Sections del menú Define. 

En la opción Add se tendrá que seleccionar la forma de la sección (rectangular, circular, tee, 
general, etc., ver figura 4.17). 

Figura 4.17 Selección de una forma predeterminada. 

Una vez seleccionada la forma habrá que proporcionar algunas de las dimensiones de la 
misma con la> cuales el programa obti~n~ de manera automática las propiedades geométricas de la 
forma definida (ver figura 4.18) 
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Figura 4.18 Especificación de las dimensiones de la forma de una sección transversal seleccionada. 

El nombre de la sección se puede cambiar modificando el contenido del cuadro en blanco 
(Section Name), este nombre se utilizará para referencias posteriores (asignar est¡¡ sección 
transversal a uno o más elementos del modelo). Las caracteristicas a modificar se presentan en el 
cuadro Dimensions, del cuadro Material se deberá seleccionar el material (los materiales se 
definieron previamente, ver párrafos anteriores) del cual esta o estará formada esa sección 
transversal. Una vez.proporcionadas las dimensiones de la forma de la sección transversal se pueden 
mostrar sus propiedades geométricas (área, momentos de inercia, etc.) seleccionando la opción 
Section Properties del cuadro Properties, se pueden modificar (aumentar o disminuir en cierta 
proporción) algunas de esas propiedades modificando el factor correspondiente a la propiedad que 
se quiera modificar (el factor que se especifica es con respecto a la unidad) para ello habrá que 
seleccionar el botón Modification Factors del cuadro Properties y modificar el contenido del 
cuadro en blanco gue corresponda a la propiedad que se quiere n~odificar. 

Una vez definidas las distintas secciones de los diversos elementos estructurales habrá que 
indicar la sección transversal que corresponda al o a los. elementos estructurales (la forma de la 
estructura ya se ha generado). primero se seleccionan los elementos que tiene una misma sección 
transversal. para ello se puede utilizar algún metodo de selección de la opción Select del menú con 
el m1smo nombre, enseguidc seleccionar Secticns de la opción Frame en el menú Assign, con lo 
que aparece la ventana que se muestra en la figura 4 .16, por último, en esa ventana se tendni que 
seleccionar el nombre de la sección (la cual se definió previamo:nte) del cuadro Frame Sections, 
después de hacer clic en el botón OK se asigna a los elementos seleccionados las características 
especif1cadas en la sección transversal seleccionada. La operación anterior se repetirá tantas veces 
como sea necesario para as1gnar secciones a todos los elementos que componen al modelo . 

.f.6 CONDICIONES DE FRONT!":RA, TIPOS DE APOYO 
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Para especificar los tipos de apoyo o condicicines de· frOnténl de la. elástica de la estructura 
primero se seleccionan aquellos nudos que tengan las mismas restricciones de desplazamiento, esto 
se hace con algunas de las opciones aplicables del ménú Sdect y después seleccionar Restraints de 
la opción Joint del menú Assign (ver figura 4.19), despJegándose la ventana~ue se muestra en la 
figura 4.20, en ella se habrá de indicar el tipo de restricción que tendrán los nudos que se han 
seleccionado previamente, a menos que se modifiquen las direcciones 1, 2 y 3, corresponden a las 
direcciones globales X, Y y Z respectivamente, se puede seleccionar algún tipo de apoyo particular 
de uso común haciendo clic en algunó de ellos en el cuadro Fast Restraints. La operación anterior 
se puede aplicar en repetidas ocasiones para especificar completamente todos los nudos restringidos 
que tiene el modelo. 

--~( ~ 
l ' r~a~·, 

Fig. 4.19 Selección de restricciones. 

Para cambiar las restricciones de algún nudo se requiere seleccionarlo y asignarle las nuevas 
restricciones, si se desea que ese nudo tenga posibilidad de desplazamiento lineal y angular en todas 
las direGciones habra que deja' en blanco todos los cuadros del marco Restrainsts in Local 
Directions o b1en hacer die en el icono con un punto negfo dei marco l''ast Rest.-aints. 
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4.7 ASIGNACION DE FUERZAS Y COMBINACIONES 

Para introducir diversos tipos de fuerza estática al modelo, primero habrá que definir 
condiciones de carga estática, para ello se selecciona la opción Static Load Cases del menú Define 
mostrándose la ventana de la figura 4.20, en ella se puede adicionar una nueva (Add New Load), 
modificar características de una que existe ( Change Load), o suprimir una condición de carga 
(Delete Load), resulta lógico que al menos se debe proporcionar una condición de carga. 

El nombre de la condición se especifica en el cuadro en blanco debajo de Load y si se quiere 
considerar el peso propio en esa condición de carga se debe de proporcionar el valor de 1 en el 
cuadro en blanco debajo de Self Weight Multiplier, una vez que se han introducido los datos 
anteriores se puede seleccionar Adrl ... para definir una nueva condición de carga o bien Change. .. 
para cambiar los datos de la cond•ción de carga seleccionada (con fondo oscuro) por los datos de los 
cuadros en blanco. 

Para modificar el nombre y el multiplicador del peso propio además de introducir el nuevo 
valor en los cuadros en blanco habrá que seleccionar la condición que se quiera modificar haciendo 
clic sobre ella, con lo que el fondo de la condición seleccionada cambia a obscuro y después hacer 
clic en el botón Change Load se realizan los cambios indicados ya que hasta que se ha hecho die 
en este botón quedan registrados esos cambios es decir no basta modificar el contenido de las cajas 
en blanco. 

Define St:lti< LD3d Cose amos 

Fig. 4.20 Definición de condiciones de carga estática. 

Para !a asignación de fuerzas y o momentos a los nudos habrá que seleccionar aquellos nudos 
que tengan las miS-lilas fuerzas y dt!spucs seleccionar Forces de la opción Joint Static Loads en el 
menú Asign (ver figura 4.21) 
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Fig. 4.21 Opción para asignar fuerzas a los nudos previamente seleccionados. 

Enseguida se despliega la veJ<tana mostrada en la figura 4.22, en ella se habrá de seleccionar 
del marco Load Case N ame la condición en que se incluirán las fuerzas que se están especificando 
(por omisión aparece LOAD!), er el cuadro correspondiente a la dirección de la fuerza y o 
momento que actuará sobre los nudos seleccionados se in~roducirán los valores respectivos (en el 
marco Loads), también se encuentran disponibles las opciones: 

Add To Existing Loads (seleccionada por omisión), la cual adicionará a las fuerzas 
existentes en los nudos seleccionados las nt: !vas fuerzas que se están especificando, es 
decir si los nudos ya tenían fuerzas se les adicionarán las nuevas fuerzas cuyos valores se 
han introducido en los cuadros en blanco. 

Replace Exi~ting Loads permitirá eliminar las fuerzas existentes en los nudos 
seleccion~os remplazándolas por las que se están especificando en el marco Loads. 

Delete Existing Loads suprimirá las fuerzas existentes en los nudos seleccionados, 
independientemente de los valores que se están especificando en el marco Loads. 
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Fig. 4.22 Especificación de fuerzas en los nudos. 

Para definir y asignar fuerzas a las barras primero se seleccionan las barras a las cuales se les 
asignarán las mismas fuerzas, después se selecciona el tipo de fuerza (uniforme, concentrada, 
variación lineal, etc.) de la opción Fr"me Static Loads del menú Assign (ver figura 4.23). 

Por ejemplo para cargas puntuales y o uniformes en las barras se muestra la ventana de la 
figura 4.24, en donde se selecciona el nombre de la condición a donde se incluirán las fuerzas que se 
estim especificando, así como el tipo de carga (fuerza o momento) así como la dirección en que 
actuaran y la opción a utilizar (Add ... , Rcplace ... y Dclete ... ). En los cuadros en blanco del marco 
Point Loads se especifica el valor de las cargas concentradas así como la posición de cada una de 
ellas con respecto a la longitud del elemento. es decir si el valor de Distance es 0.5 indica que la 
carga está aplicada a la mitad del demento, en el cuadro en blanco del marco U niform Load se 
proporciona el valor correspondiente a la carga uniforme que actuará sobre el elemento. Pueden 
especificarse simultá_neamente cargas concentradas y uniformes e sólo algún tipo de los anteriores. 
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Fig. 4.23 Op,:ión para introducir fuerzas en las barras. 
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Fig. ~~24 Definición de fuerzas uniformes y/o concentradas en las barras. 

Una vez que se especifican las fuerzas y se hace clic en el botón OK se ejecuta la opción 
seleccionada, en el caso de que esta sea adicionar o remplazar cargas, estas se muestran con sus 
características en el área de dibujo de la pantalla. 

Definidas las condiciones de carga se pueden realizar combinaciones de las anteriores, es 
decir condiciones de cargas dependientes, para ello se selecciona· la opción Load Combinations del 
menú Define mostrándose la ventana de la figura 4.25, con la posibilidad de adicionar, modificar y 
supnmir combinaciones de carga estas opciones se muestran en el marco Combinations las 
combinaciOnes que se tengan definidas hasta el momento 
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Fig. 4.25 Ventana para especificar y modificar combinaciones. 

La opción para adicionar una nueva combinación despliega la ventana que· se muestra en la 
figura 4 .26, ahí se especificará el nombre, tipo y algún titulo para la combinación. Para definir las 
condiciones de carga que participarán en la combinación que se especifica, así como su respectivo 
factor de participación (con relaciór. a la unidad, 1=100%) se selecciona el nombre y se modifica el 
valor en el cuadro en blanco debajo de Scale Factor en el marco Define Combination y después se 
hace clic en cualquiera de los botones Add, Modify, o Dclete. 

~ Oeflru!'COI111binalii(iri . 
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Fig. 4.26 Especificación de las características de IJna combÍnaciór. 
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Cuando se han especificado los datos de la combinación se hace clic en el botón OK. 

Una vez que se han definido combinaciones se puede modificar sus características con la 
opción Modify/Show Combo o bien suprimir alguna combinación con la opción Delete Combo, 
cualquiera de estas opciones se selecciona haciendo clic sobre ella en el marco Combinatioos. Se 
pueden especificar tantas combinaciones como el problema de Análisis lo requiera. 

4.8 OPCIONES DE ANALISIS SELECCIÓN DE RESULTADOS 

Una vez que se han especificado completamente las características geométricas, elásticas, 
condiciones de frontera y 'fuerzas se está en posibilidades de que el programa SAP2000 realice el 
Análisis Estructural del modelo, sin embargo es conveniente especificar algunas opciones de 
Análisis, para ello se selecciona la opción Set Options del menú Analyze, desplegándose la ventana 
que se muestra en la figura 4.27. 
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Figura 4.27 Selecciór. de opciones de Análisis. 

Er. ella se pueden seleccio:-~ar las componentes de desplazamiento independientes o grados 
de libertad que se considerarán para ei análisis, SAP2000 permite anali1.ar estructuras en un espacio 
tridimensional por lo que cada nudo tiene la posibilidad de desplazarse lineal y angularmente en tres 
direcciones ortogonales. es deci~ en gc.:neral posee 6 grados de libertad (a menos que se indique otra 
alternativa). 
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Si la estructura está contenida en un plano es conveniente indicar los grados de libertad que • 
no intervienen en el Análisis con objeto de eliminar la posibilidad de inestabilidad en dirección 
perpendicular al plano de la estructura, disminuyendo además el tiempo de ejecución del Análisis, lo 
anterior se realiza desactivando grados de libertad en el marco Available DOFs o bien permitiendo 
que el programa lo realice dependiendo del tipo de· estructura que se selecciona haciendo clic en 
alguno de los iconos que se muestran en el marco Fast DOFs y que corresponda ·con las 
características de la estructura que se vaya a analizar. 

En la parte inferior de la ventana se muestran las opciones de Análisis Dinámico y efectos P­
Delta, también se pueden seleccionar resultados que han de almacenarse en el archivo de salida 
(nombre.OUT), en el último renglón se muestra en un cuadro en blanco el valor de la memoria 
reservada para la solución del problema, este valor deberá aumentarse ··en caso de que no sea 
suficiente cuando se muestre el mensaje correspondiente durante el proceso de Análisis 

La selección de resultados del Análisis se puede realizar haciendo clic en el cuadro en blanco 
a la izquierda de Generate Output (ver figura 4.27) y después de hacer clic en el botón Select 
Output Options se muestra la ventana de la figura 4.28. 

'·.-·'_;, .. ~)Fr~a~F~r~~:--~-'-
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;!l'i-'l-\< ~-~·~.;; .... ·-·· ·: .. 

Figura 4.28 Selección de combinacione> de carga y tipos de resL•Itados a incluirse en el archivo de 
salida. 
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En ella habrá que indicar los resultados que se incluirán en el archivo de salida haciendo clic 
en los cuadros en blanco y seleccionando para cada uno de esos resultados las condiciones de carga 
de los cuales se requieren los resultados seleccionados, lo anterior se logra haciendo clic en el botón 
Select/Show Loads correspondiente, con lo que se presentará una ventana mostrando las 
condiciones y combinaciones de Anilisis que se han especificado para la estructura por analizar, en 
esa nueva ventana se deberán seleccionar las condiciones de carga para las que se requieren ios 
resultados seleccionados, la condición o combinación de carga seleccionada se muestra con fondo 
oscuro, se puede seleccionar más .de una combinación de carga arrastrando el ratón en el cuadro de 
selección. 

Es necesario que se seleccione al menos una condición o combinación de carga para que· tos 
resultados se encuentren disponibles en el archivo de salida ya que de no hacerlo los resultados no se 
almacenarán (ver figura 4.28). 

'l 
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ANALIS1S -~~· :._~;,..~:.. -~:?:.:.-, '"~ 

CAPITULO 
BE LA=~ , __ _ 
ESTRUCTURA 

--- ~-- ~,.:S - ··--·· 

5.1 ANALISIS DEL MODELO 

Una vez que se han especificado las opciones de Análisis se puede solicitar la ejecución di:! 
mismo, seleccionando la opción Run del menú Analyze con lo que el análisis se efectúa y los 
resultados de esta fase se muestran en la ventana de la figura 5.1, en su extremo derecho se observa 
una barra de desplazamiento vertical que permite ver el contenido de la pantalla, al final de esta se 
muestra el botón OK haciendo clic en él se despliega en la mayoría de los casos la configuración 
deformada de la estructura para la primera condición de carga con lo que se está en posibilidades de 
tener acceso a varias opciones dei menú Display las cuales nos mostrarán de manera gráfica y 
numérica algunos resultados del Análisis (desplazamientos, elementos mecánicos, etc.). 

- : ... · . 

. : : ·-'~ .:.,: ... · _: . ,' -

Figura 5.1 Ventana después de seleccionar la opción Run del menú Analyze 

5.2 VERIFICACION DE ALGUNOS ELEMENTOS DEL PROCESO DE ANALISIS 

Después de· que el Análisis ha concluido se generan una serie de archivos con el mismo 
nombre que el archivo d:: Cutos pero con extensión diferente, algunos de los que se generan y que 
pueden ser de utilidad son: 

El archi·;o ncmbre.LOG (ver figura 5.2), el cual contiene información de la fase de Análisis 
(memoria clisponiblc, número de t:cuaciones de equilibrio formadas, características de la matriz de 
rigideces, balance de errores relativos y diversa iníonnación de salida). 
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El archivo nombre.$2k contiene los datos de la estructura a analizar como son: geometría, 
materiales, secciones, cargas, combinaciones, etc., tal y como se generaron por ejemplo mediante el 
editor gráfico del programa SAP2000, se puede recurrir a este archivo en el caso de que el archivo 
nombre.SDB sufra algún cambio que lo imposibilite para ser procesado por SAP2000. · 
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Figura 5.2 Contenido típico del archivo nombre.LOG 

El archivo nombre.EKO contiene una imagen o resultado del procesamiento de los datos 
contenidos en el archivo nombre.SDB generado mediante el editor gráfico del programa SAP2000, 
este arch1vo (nombre.EKO), contiene textos que indican las características de los datos procesados 
por ejemplo. hay un titulo y encabezado para las coordenadas de los nudos seguido de éstas, es 
dec1r se despliega información respectiva para cada bloque de datos asi como los valores 
respectivos, únicamente se incluyen en este archivo los datos procesados. 

En el caso de que se hayan seleccionado resultados para ser impresos éstos se encuentran en 
el archivo nombre OUT. 

Es conveniente verif1car algunas caractenst1cas particulares del problema que se resolvió, 
por ejemplo que coincida el númer(• <oto! de grados de libertad que la estructura tiene con el número 
de ecuaciones de equilibrio que el programa formó y resolvió, también es conveniente verificar el 
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número de elementos barra, placa, et::. -el programa procesó ... Desde luego es conveniente 
verificar que todos los datos del problema fueron procesados por el módulo de Análisis, para todo lo .. 
anterior se recurre a revisar el contenido de los archivos mencionados en los párrafos anteriores, .. 
para tener acceso al contenido de esos archivos se puede recurrir a varios prograrrias o procesadores 
de texto (por ejemplo Edit, Word Pad, Word, etc.) · 
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6.1 INTRODUCCION 

.... --- - - ~·-· -
·-

SELECCIONE 
INTERPRETACION 
DE RESULTADOS 

.. --::_--:·:., 

CAPÍTULO 
6 

Una vez que el Análisis se ejecuta sin que se hayan generado errores durante el mismo y 
después de hacer clic en el botón OK de la ventana que se muestra en la opción Run del menú 
Analyze, se pueden seleccionar varias opciones del menú Display que nos permitirán ver los 
diversos resultados tanto de manera gráfica como numérica, por ejemplo Show Deformed Shape 
nos mostrará la configuración defJrmada de la estructura para alguna condición de carga, Show 
Element Forces/Stresses nos mostrará el diagrama de elementos mecánicos, como puede verse en 
la figura 6.1, se encuentran disponibles algunas otras opciones para despliegue de resultados. 

Figura 6.1 Opciones en el menú Display 
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6.2 VER LA ESTRUCfURA DEFORMADA 

Para ello como se indicó en el párrafo anterior· se selecciona la opción Show Deform~ 
Shape del menú Display mostrándose la véntana de la figura 6.2, en esa ventana se selecciona del 
marco Load (parte superior de la ventana) la ·condición de carga de la cual se quiere ver la estructura 
deformada; en el marco Scaling se presentan ·dos opciones. para· la esc11la que se utilizará .al 
desplegar la configuración deformada" e~ caso de que se selei:cione Scale Factor··se presentari:e( 
factor de escala que se utilizará· para tal fin, este factor mostrado en la caja en blanco puede ser 
modificado por el usuario, otras do~ opciones se encuentran en el extremo inferior izquierdo de C?S3 
ventana, la primera de ellas es decir Wire Shadow mostrará además de la configuración deformada 
la no deformada, la última opción que es Cubic Curve, en caso de estar activada mostrará la 
configuración deformada ajustando una curva a esa configuración, en caso contrario,sólo se dibujará 
la configuración deformada con lineas rectas. 

Figura 6.2 Selección de panimetros para despliegue de la configuraciór. deformada. 

Una vez mostrada la configuración deformada de la estructura se puede seleccionar algún 
nudo (p. ej. haciendo clic izquierdo) y despues hu.cer clic derecho en el nudo seleccionado con lo 
cual se presentara una ventana conteniendo ei valor de los desplazamientos de ese nudo (ver figura 
6.3) 
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Figura 6.3 Valores del desplazamiento de un nudo seleccionado. 

6.3 VER LOS DIAGRAMAS DE ELEMENTOS MECANICOS 

Como se ha mencionado, SAP2000 permite mostrar gráficamente los valores de algún · 
elemento mecánico para determinada condición de carga, para ello se selecciona Frames de la 
opción Show Element Forces/Stresses en el menú Display presentando la ventana de la figura 6.4. 

En el marco Load se selecciona la condición de carga y en Component se selecciona el tipo 
de elemento mecimico, las opciones en el marco Scaling producen el mismo efecto al caso de la 
configuración deformada, las O¡JClones que se encuentran al finai de la veniana nos permiten 
seleccionar si se desea un diagrama "lleno" y sm despliegue de valores del elemento mecánico o con 
valores en el diag~ama 
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Figura 6.4 Selección de parámetros para despliegue de diagramas de elementos mecánicos. 

Una vez mostrado el diagrama se puede seleccionar algún elemento barra haciendo clic sobre 
él y después de hacer clic derecho sobre el mismo se presenta una ventana mostrando el diagrama 
del elemento seleccionado, asi como el valor del elemento mecánico en una sección transversal 
situada a la distancia que se muestra en el cuadro en blanco (ver figura 6.5), desplazando el puntero 
del ratón a lo largo del eje del elemento dentro de la ventana desplegada se muestra tanto la posición 
de la sección transversal como el valor respectivo del elemento mecánico, el contenido del cuadro 
puede ser modificado por el usuario cesplegándose instantáneamente el valor del elemento mecánico 
que corresponda a la sección cuya posición se especificó en el cuadro en blanco. 
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Figura 6.5 Diagrama de un elemento mecánico de una barra seleccionada. 

6.4 VER LOS RESULTADOS DE DISEÑO 

Algunas opciones de diseño se encuentran disponibles en el menú Design una vez realizado 
el Análisis se pueden tener acceso a ellas. 

Como primer paso se seleccionara el tipo de diseño y características a utilizar, por ejemplo 
en el.caso de diseño de concreto se tendran que especificar algunas características de refuerzo Jo 
cual se deberá de hacer en Modify/Show Section de la opción Define Frame Sections en el menú 
Define, seleccionando en la ventana que se despliega el botón Reinforcement para enseguida 
especif1car el tipo de elemento (columna o viga), la configuración del refuerzo y las características 
de e'te (ver figura 6.6) 
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_l'igura 6.6 Características para diseño de un elemento. 

Como segundo paso se deberá especificar las combinaciones de carga que se utilizarán para 
verificar el diseño activando la que se quiera para ser usada en el diseño, esto se puede hacer en Add 
o Modify/Show Combo en la opción Load Combinations del menú Define (ver figura 6.7). 
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Figura 6. 7 Especificación de combinar:iones de carga para diseño. " 

Una vez realizado el Anális1s, como tercer paso se seleccionarán las combinaciones de 
diseño para ello utiliza la opción Select Design Combos del menú Design (ver figura 6.8). 
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Figura 6.8 Algunas opciones del menú Design. 

Como cuarto paso se selecciona; a la opción Start Design ... del menú Design (ver figura 6.8) 
con lo que se desplegaran algunos resultados del diseño, seleccionado una barra y después de hacer 
clic derecho sobre la misma se muestra una ventana similar a la de la figura 6. 9. 
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Figura 6.9 Resultados de diseño de un elemento seleccionado. 

De ella se puede seleccionar el botón Details mostrándose información más detallada acerca 
de las características de diseño del elemento, se puede mostrar información diversa de la ventana 
arrastrando el mouse (botón izquierdo hacia alguna zona especifica de la ventana, ver figura 6.1 O) 
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Figura 6.10 Detalle de lo~ resultados de diseño de un elemento seleccionado. 

6.4 OTRAS CARACTERISTICAS 

......... 

El despliegue de reacciones puede ser seleccionado mediante Joints de la opción Show 
Elcment... del menú Display mostrándose la ventana de la figura 6.11, en donde se podrá 
seleccionar la condición de carga, después de hacer clic en OK se muestran las reacciones 
correspondientes a la condición de carga seleccionada (ver figura 6.11 ). 
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Figura 6.11 Ventana para la selección de reacciones. 

Están disponibles en el menú Display algunas otras características relacionadas con el 
Análisis Dinámico como el dibujo de formas modales, espectros de respuesta y análisis de la 
respuesta en el tiempo y otras más. 

Los resultados del Análisis se pueden almacenar en un archivo a ~anera de tablas para ello 
se selecciona la opción Set Output Table Mode del menú .Di~play mostrándose una ventana en 
donde se seleccionarán las condiciones de carga de los resultados que se incluirán, después de hacer 
clic en el botón OK se pasa a una ventana con de título Analysis Output Tables (ver figura 6.12) 
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Figura 6.12 Selec_ción de condiciones y para la generación de resultados en forma tabular. 

En esa ventana se podrá seleccionar algún nudo o elemento después de hacer clic derecho en 
un nudo seleccionado, se desplegará una ventana conteniendo tanto los desplazamientos como las 
reacciones del nudo para las condiciones de carga seleccionadas (ver figura 6. 13). 
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Figura 6.13 Ventana de resultados de un nudo seleccionado. 

Si el elemento sobre el que se ha<:e clic es una barra entonces la ventana que se despliega 
contiene los elementos mecániccs de las condiciones de carga seleccionadas (ver figura 6.14). 
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Figura 6.14 Ventana de resultados de una barra seleccionada 

Tanto en la ventana de resultados de nudos como de barras en el extremo superior izquierdo 
de esta se encuentra la opción File, qúe permite el almacenamiento de los resultados contenidos en 
la tabla mostrada en un archivo, para ello despues de hace clic en File, habra que proporcionar en el 
cuadro en blanco el nombre del archivo y hacer clic en el botón guardar (ver figura 6.15). 
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Figura 6.15 Almacenamiento de resultados en un archivo. 
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7.1 INTRODUCCION 

OPCIONES 
ADICIONALES 

--
, 

---,CAPITULO 
7 

SAP2000 posee varias caracteristicas, con algunas de ellas se pueden modelar por ejemplo 
muros y losas mediante elementos Shell, las opciones abarcan desde la definición de materiales 
dibujo de elementos, definición de caracteristicas geométricas del elemento (Shell Sections) así 
como la asignación de las características anteriores además de las fuerzas (uniformes, presión, etc.) a 
este tipo de elementos. La estructura y secuencia es muy parecida a la utilizada para los elementos 
barra, se recomienda consultar la ayuda en linea, los temas relacionados en los manuales o bien ver 
los ejemplos en la carpeta de ejemplos o en el disco. 

En cuanto al elemento finito sólido; este no se puede generar utilizando el editor gráfico de la 
versión estudiantil (versión 6.1 ó 6 13), por lo que su definición y demás características se tendrán 
que realizar mediante una serie de instrucciones que se adicionarán al archivo de datos mediante un 
editor, la misma recomendación hecha en el párrafo anterior es aplicable a este caso. 

Una gran variedad de opciones para Análisis Dinámico está incluida en el programa 
SAP2000, para usar alguna de ellas se recomienda consultar los ejemplos que acompañan al 
presente instructivo o que se enr.uentran en el diskete, o bien los que se encuentran en el manual 
respectivo 

También existe la posibilidad de Análisis de estructuras de puentes obteniendo mediante el 
programa por ejemplo: lineas de influencia, envolventes de elementos mecánicos, etc., lo anterior 
para varias condiciones de carga mcluyendo uno o varios carriles con cargas vehiculares tipo o 
definidas por el usuario, la recomendación del parrafo anterior es igualmente aplicable_ 

Se recomienda consultar al autor ya que se encuentra en proceso un instructivo similar al 
presente para los fines mencionados en los párrafos anteriores. 

7.2 VER EL ARCHIVO DE ENTR<\DA 

Durante una .sesión con el programa SAP2000 las opciones Save y Save as del menú File 
permiten almacena'r en un archivo con extensión SDB los datos de la estructura que se han 
introducido, al archivo así creado sólo se podrá acceder (para fines de este programa) mediante la 
opción Opcu del mismo menu, sin embargo los datos pueden ser almacenados en un archivo ·que 
pueda modificarse y ser rec:or.ocido por el programa SAP2000 -para ello se selecciona 
SAP20QO.S2K de la opción Expon ~n el 111eal. File (ver figura 7.1 ). 
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Figura ?.! __ Almacenamiento de datos para poder realizar cambios al archivo. 

El archivo extensión S2K puede ser modificado con la ayuda de algún editor (por ejemplo 
Edit, WordPad, etc.), el archivo resultante de la modificación deberá ser almacenado sin ningún 
caracter de control especial que se almacene en el mismo archivo, y con la misma extensión, si se 
usan algunos editores o procesadores de palabras se deberá tener especial cuidado de lo anterior, en 
caso de uso de esos procesadores se recomienda hacer varias copias de respaldo con objeto de no 
perder los cambios 'efectuados. · · · · 

Una vez realizados los cambios, el contenido del archivo extensión S2K modificado podrá 
ser procesado por SAP2000, para ello se selecciona SAP2000.S2K de la opción Import en el menú 
File, para ambas opciones (Export e lmport) será necesario proporcionar el nombre del archivo en 
el cuadro en blanco correspondiente de la ventana como la que se muestra en la figura 7.2. 
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Figura 7.2 Ventana en la opción Export SAP2000.S2K. 

7:3 VER EL ARCHIVO DE SALIDA 

--

El contenido del archivo de resultados nombre. OUT indicado mediante Generate Output en 
la opción Analysis Options del menú Analyze se genera después de ejecutar la opción Run del 
menú del mismo nombre, el archivo así generado puede ser consultado mediante cualquier editor o 
procesador de palabras e inclusive por algunas hojas de cálculo, para ello se seleccionará la opción 
abrir (Load u Open) del programa que se vay~ a utilizar con ese fin y especificar el nombre del 
archivo desde luego con extensión OUT (ver figura 7.3). 
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l 

Figura 7.3 Acceso al archivo nombre. OUT mediante el programa WordPad. 

7.4 RELACION CON AUTOCAD 

La geometría de la estructuca puede ser generada por AutoCAD realizando el dibujo de las 
barras (lineas) en una capa (Layer) de nombre Sap_frames (ver figura 7.4). 

La geometría asi generada se debeni exportar a un archivo extensión dxf como se muestra en 
la figura 7.5. 
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Figura 7.4 Geometria generada en AutoCAD. 

Espm Dala· . ·. • · o El. 

Gyardar e~: .. ·J ·~curso sap ~~00 
....:.J m anuo.! lmm 

tB1 e¡emplo 1 

;: 

Figura 7.5 Expo:1ündo la gcometria generada con AutoCAD a un archivo extensión dxf. 
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--
Para recuperar la información de un archivo dxf, se selecciona .dxf de la opción Import en 

el menú File (ver figura 7.6). 

Figura 7.f. Importando datos de un archivo .dxf. 

Desplegándose enseguida la ventana que se muestra en la figura 7. 7, en donde se deberá 
especificar el nombre del archivo cuya extensión es dxf después de hacer clic en abrir se seleccionan 
de la ventana que se muestra en la f1gura 7.8 la dirección global y las unidades 
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Figura 7.7 Ver .. ana para importar datos de un archivo dxf. 
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Figura 7.8 Indicando características de los datos a importar de un archivo dxf. 
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8.1 INTRODUCCION 

EJEMPLOS E 
INTERPRETACION 
DE RESULTADOS 

CAPÍTULO 
8 

Durante la impartición del curso para uso y manejo del programa SAP2000 tanto en la 
División de Ingeniería Civil, Topográfica y Geodésica como en la División de Educación Continúa 
de la Facultad de Ingeniería de la UNAM, se han desarrollado varios ejemplos típicos para el 
análisis de formas estructurales comunes (vigas continuas, marcos, armaduras, etc.) permitiendo al 
asisten,e practicar el uso de los comandos básicos tratados en los capítulos anteriores así como de 
algunos otros que no se han descrito o mencionado en este instructivo, por lo que seria conveniente 
que el lector interesado tuviera la oportunidad de asistir a alguno de esos cursos con objeto de 
despejar algunas dudas, desarrollar una mejor habilidad en el manejo del programa y adquirir una 
mejor comprensión de algunas de las opciones de Análisis así como de sus ventajas y limitaciones. 

A continuación se presentan los listados (datos, resultados numéricos y gráficas) de algunos· 
de los ejemplos que se han desarrollado durante los cursos que ha impartido el autor, los datos y 
resultados de otros más (incluyendo los que se listan a continuación) se encuentran en el disco que 
acomp2i1a al presente instructivo, se sugiere que el interesado los consulte ya sea directamente 
(mediante algún editor) o procese los archivos de datos a través del programa SAP2000. 
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9.1 COMENTARIOS FINALES 

COMENTARIOS 
FINALES 

oc-"'""""._ 

CAPÍTULO 
9 

Después de dar una primera visión hasta cierto punto con poca profundidad en algunos 
aspectos ya que se pretende que el presente instructivo inicie al lector interesado de una manera 
clara, rápida y sencilla en el uso de SAP2000 pero a su vez lo motive para que explore y profundice 
en otras opciones que están disponibles en el programa, los comentarios finales tienen por objeto 
eliminar algunas posibilidades de cncr en los datos proporcionados al programa así como mejorar la 
interpretación de resultados, estos son: · 

Verificar la geometría y características de los materiales, para ello se sugiere almacenar 
los datos en un archivo con extensión S2K y revisarlos con algún editor con objeto de 
detectar posibles errores en las características de los materiales y dimensiones de los 
elementos. 

Verificar las condiciones y combin¡,ciones de carga bajo las cuales se realizará el 
análisis del modelo, lo anterior con objeto de detectar posibles omisiones o duplicidad 
de cargas (por ejemplo peso propio). 

Verificar los grados de libertad y las condiciones de apoyo o restricción de los nudos 
especificiioos en el archivo de datos los cuale> deberán ser acordes con el número de 
ecuaciones que se forman y resuelven. 

Una vez realizado el Análisis se deberán de verificar e interpretar los resultados, el 
equilibrio se deberá satisfacer en todo momento, se recomienda que manualmente se 
verifique éste, por lo menos de manera global (suma de fuerzas externas y reacciones), 
sin. embargo no está por demás verificar el equilibrio de algunos elementos de la 
estructura de manera aislada (nudos y barras), por ejemplo verificando el equilibrio de 
algún entrepiso (suma de cortantes en las columnas de entrepiso con el cortante externo 
en la misma dirección) 

Se deberá verificar la forma de los diagramas de elementos mecánicos la cual tendrá 
que corresponder con el tipo de cargas, por ejemplo, si en una barra existe carga 
uniforme el diagrama de cortantes deberá presentar variación lineal y el de momentos 
variaciOn parabólica. 

La configuración deformada que la estructura presente para alguna condición de carga 
deberá ser consistente con las condiciones de apoyo del modelo analizado así como con 
las características de las fuerzas contenidas en esa condición. 

• 



Cuando sea posible se tratará de relacionar los resultados obtenidos con el programa 
con los que resulten de la aplicación de algún método aproximado, por ejemplo para 
cargas laterales en un marco se puede utilizar alguno de los métodos aproximados como 
el del factor o el de Bowman. 
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Fegura 1·2 PlanhJia con les nombres deJas condiciones de carga estitka 

El primer paso al ingresar las car.2as es definir !as condiciones de carga estática. 
ParJ ello i:1gresc JI m<!nti Define)' scl~:CL·1onc la opnún Static Load Ca:tes 

DEAD puede usarse para l~s cargas venicales por peso propio de las vigas, 
m:~menicndo el indicador Self \\'cighl i\lu.ltlplicr con(! viJIOf 1. SAP1000 agregará 
el peio propio de las vigas 

2. Defina una condición de carga lateral estática llamada EQ para la carga de sismo. 
Asigne: esta carga later:ll como una carga dd tipo QUA K E. Es10 pemútirá al 
programa efectua.r autom~ticamente las combinaciones de carga a ser empleadas po1 
el módulo de diseño del SAP2000. Ademh asigne al pad.metro SelfWeleht 
MuJtipller el \alar cero. 

3. Las cargas vc:nicales mostradas en la Figura 1-1 pueden asignarse a las vigas 
seleccionando todas las vigas utilizando el botón Asslgn Frame: S pan Loads de la 
barra de herramientas flotante. 

4. Las cargas laterales estáticas necesitan ingresarse selecCionando lndividualmenle 
cada nudo y empleando el botón Asslgn Jolnt Loads. 

lmponante: Asegúrese dt qut tsú añadi~ndo las c:argas a la c:ondkl6n dt 
carga corrtsponditnft. · 
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Creación de Diafragmas de Piso 
Crr.u d1afragma$ de paso:; cspcafica.r la m.1:..J dd piso sólo en la dilccciOO X soo t&."Tlicas 
C<1múnmcnte usadas par.~ reducir el tanuiio del prOO!ema Por otto lado, al añadir dilfragnu~ el 
C.Jmportamiento dd modelo !.e as.emeja al de un !'dificio con d1afragrn.1s rig1dns. 

R.cpua l(l) Siguientes pasos para cadA pa~o 

Seleccione todos Jos ~u dos del piso 

Er:tre al rncnü Assl!::n y seleccione 1~ opción Jolnt .•. Conslralnts. 

Seleccione Add Diaphragm del la c.1ja de opciones. 

• E:1 L• plantilla Diapl1ragm Cons:ralnl ingrese un nombre para c:l diafragma del 
¡;rimcr piso En cm: case usaremliS el nombre DIA \. 

t St:iecr:JOne la opción Z·ax1s constralnl. E!ta opctón define un diafragma 
perpcndtcular al ejc-Z. 

• Prestone el botón OK 

l'resmne el botón CK para finalizar 1.1 operación. 

Re<Jua estos pasos para los dem.ás ptsus usando diferentes nombres ~n cada uno 

2 La rrusa de 10Crn Jos p:sos es la misma Luego selecc10oe Wl nudo en catb piso. 

3 Cambie IJ.s ur,id.uks en q..1e se van a mgresar los daJ.os a Ktp-in, puesro que la masa indicadl 
en IJ Figur .l 1-1 está d.lcb en esas umdadcs. 

4 Del mL'1'lU Assi¡:;n sclecc¡one la opciOO Joinl ..• Mas.ses 

Ingrese la masa de cada ptso en la duccC1ón del eje coordenado local 1 (que en éste 
CJSO comcide con la dtrección del EJe Global X). 

1 oJos lo~ demás valores son cero 

:'i Retome lls lllltdadi!.S a Kip-ft. 

Propiedades de los Materiales 

f'or Ultimo. antes de decruar el anáJ1sis de la esnuctura, deberemos verificar que la a!oignación de las 
proptcd.!d::.s de los materiales es la correcta. 

l. lk~e el mroU Define ~leccioue L.!. opciór. Materials. 

2 En la plantilla Mat.eri<tls seleccione S TE EL y presione el botón MODIFY/SHOW 
MATERIAL 

¡:--, 

Ejemplo 1 Pórtico Bidll:nenslonal con Cu11 EstitiCI 
.-.. 

• En ia plantilla Matt:rlal Property Data verifique que la.s propiedades del ~erial 
sean las correctas Rccuerd~ que los valores son reportados en las unidades con la.s 
que s'e 'este tr;JbJJando en este momen10 

Efectuandó el Análisis 
Una vez que los datO!:. han sido ingrbados, es tiempo para carer el nxxlelo y revisar los reSultados. 
l. Gratx: el mcxklo. 

2. Especifique los paráme[!'OS para el análisis seleccionando la opción Analy2e del meml 
Ser Oplions 

• En la plantilla Anatysls Optlons seleccione Plane Frame Analysls para reducir el 
tamaño del problema y por tanto reducir el tiempo de cálculo. 

• Pre~ione el botón OK para aceptar los cambios realizado.s. 

3. Seleccione la opción RWl dd menú Analyze para proceder al análisis la estructura. 

Nota: Una vez: c.:.ncluido tl análisis Ud. podrá revisar los resultados 
completos en la pan/alta antes de presionar el bor6n OK. Esla s•rd su 
primera vuijicació11 para vtr si triste algún problemo. en ti modelo. 

Usando los Resultados 

Verificación de los Resultados 
Una vez que se ha analizado d modelo se debe venficar SI los resultados soo correaos y que NS 
valores son del crden y magnitud a los esperados. 

Verificación del Modelo: 

l. Verifique que el cortante total en la base es igual a la carga latera!IOI.al para la condición 
de carga EQ. 

• St:leccione el grupo de elementos del pórtico que están ubicados en el primer nivel 
así como los nudos en la base de la estructura. 

• Desd~ el menú AS51gn seleccione Group N ames. 

Asigne a este grupo d~ elementos Wl nombre representativo por ejemplo BASE 
SHEAR . 

• Seleccione el botón ADD NEW GROUP NA.\{E y presione el botón OK.. --. 

• En el menú Display seleccione la opc1ón Show Group Jolnl Force Swns y elija el 
grupo pre\'iamcntc creado. 
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• EJemplo 1 PónJco B•dnntnliond con Carr~ EstJtlca 

Observe J.¡ c1cforrnilda de la csttuctura y cree una ílllirnación de la nliSmJ bajo cargas 
~ertH:alcs y bteralcs para asq;•u:usc de que .:::1 :omponamicnto del modelo es el c~pcrado. 

lngrc~e al menú Display y seleccione Show Defonned Shapc y seleccione la 
cond1ción dc carga en la que este u1tct csado. TJmbién selecclone ]J opción Wlre 
Shadow, así podr.i ver la geúmetria nq-Jcformad3 de la cstntctura al mismo tiempo. 
Vea hs F1guras \-3 y 1-4 para las formas deformadas de la c~tnJCIIIIa.llaga clid. 
con el OOtón dcrcclto del mou~c sobu: cualqutcr nudo para ohscn·ar los 
desplazamJemos y rotaciones corresp~·ndicntes. 

Genere una amrru~ción de la deformad <1 presionando el bo!ón START ANIMA TION 
ubicado en la parte inferior de la barrJ de estado (Para esto se necesita que se 
encucncre activa una ven1ana conteniendo la defom1ada de la estructura). La 
animación asf creada pur:de salvarse cuma una archivo •.AVI para verse despu~s 
d<.:sde el menü File. (Vea la Ayuda En-linea bajo el ftem "Exportan A VI file".) 

lnte:1te eS'O: Prtsione los botones +y- ubicadoijunto al botón Anima te 

y ~ea lo que le sucede a 14 dejon11ada de le estroctura. 

• Presione el bmón STOP ANIMA llON cuando haya lenninado de observar la 
animación. 

s, los pn::cedurue:-tos antes d~tos mueso-an que la infoonación ingresad.! aparmta ser carecta, 
pOOcmQ: co.:vnc.cs avanzar hacia proceduniemos rn.is avanzados de revisión de los resultados. 

.. -

¡: 
:¡ 
l: 

¡----, ¡-· r---. 
EJemplo 1 Pórtico Bidimcnsioru.l co¡¡ Carg.a Ea.Jtica 
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Figurt 1-l Delormtda de la E1tructurt para Catgu 
Verticales 

Comportamiento Estructural 

Figure 1-4 O.IOJmadt de la Eltruttun pwe Cargu 
lalertlu 

En muchas ocasioocs &e desea vaüicar si la esuuct1.n &e encuenC'I dentro de dctcnnintdollfmhes 
de CXli11JlO'W11Í<nto, tlles como rangos de esfuerzo espccilieados por algl]n código de disc!o. 
SAP2000 hace lcxlas estas vaificaciooes automáticammte cuando los elemenlos soo Wdados. 
(Las opciones de diseno del SAP200l serán discutidas con ma)'a' detalle en las siguientes 
cjempl'") 

l. Los elementos estructurales pueden disel\arse desde al men~ Dtsf&n y selecdonando la 
opción Start Deslgn/Check or Structure. 

• Los elementos del pórtico moslrarán c:o este momento colores que represenr:an el 
nivel d!!l esfuerzo en cada elemento. Asimismo en IJ pan e inferior de cada elemenlo 
se muestra Wl valor nUmérico representativo del nivel de esfuerzo prc.seme en el 
elemento. Un valor 1 por ejemplo significa 100% esforzado. 
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Para 1ene:- más información sobre el diseño de los elementos en [fe al mentl Deslgn y 
sdcccwnc la opción Display lleslgn lnfo. 

2. Se puede 1amb1én ver la informac16n del dlsef.o de cada elemento, o inclusive asignar 
secciones [fans versales alternativas, haciendo click con el botón derecho del mouse sobre un 
elemento 

• De la veni!Ula que se muestre se puede seleccionar el b«ón DETAil..S para apreciar 
1nfurmación det:lllada de la sección hJjo cada una de las combinaciones de carga 
l!mplcadas en el diseño. 

También se puede rediseñar el elemento des¡:iués de cambiar sus parámetros de 
diseño, longitud efectiva, fac<or K o prop1edades a la sección, presionando el 
botón REDESIGN. 

3. Si se ha selec:ciona.:to una nueva seccit1n la cua.l se quiere utilizar en el dise;,o final de la 
estruc!Ura. únicamente ingrese al menú Dcslgu y seleccione la opción lipdale Analysls 
Seclions pJJa reanalizar la es1ructura con l¡1s r.uevas secciones seleccionadas. 

1\'ot'!: Putth Str nuuario tl uso dtl bot6n Rtfrrsh Window dt la barra tU 
htrramitntas para actuoliUJr In i11jonnaci6n tn la .,tntaruJ actil·a 
lurgo dt habtr tftctuadoJ cambws tn los parámetros de diseño 

Observando e Imprimiendo ResuHados 
A menudo se neces1ta dlspor,o- de una copia impresa de tos rcsuhados de los análisis oblenidos coo 
el SAP20Cl0 EXJstcn diferentes formas de o«enerlos; 

S<: pueden e!egir los resultatios que nos interesan con la opción Genera te Output ubicada en 
la piJJltilla Anaty.>ls OpUons. El OOtón Select Output Optlons que aparece pennilir.1 
seleccionil! cuantos y cuales de los result.ados queremos imprimir Estos resultados son 
:::scritos en un archivo de tex10 con el mismo nombre de nues[fo archivo de datos, pero con la 
e:';tensión 'OLJT. 

2 Los d.uos ingre:>adm asf como la mayor pí\Ile de los resulr.ados generados lambién pueden 
\Cr~c a pJJt1r del n:enti Display. 

3 Dt:sde el menU Flte se pued.:: optar por imprimir~ sea Gráficos, Tablas con los Datos 
logrcsad~s 6 Tablas con Jos Resultados del Aná!tsis y Disetio de elementos. 

Suger~ncia: Si r:rUitn túmtnlos 6 nudos stltccionados al momtnlo dt 
gentrar la imprtsi6n dt resulla•los, únicamtnte u imprimirá la 
ir.formadón co"tspvnditnft a dichos tltmtnlos. Dt lo contrario, la 
impr~sión se cenuará para todt.!S lo.s tltmtnJos y nudos dtl modelo. 

4. El análisi~ efectuado por el SAP2000 generarlos archivos de sahda.. El archn·ofi/eMmt".EKO 
que inclu,c tcxia la información empleada en d análisis; y el archivofilename .OLIT, que 
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contiene los resultados del análisis asf colno los resullados espedfiéiinente seleCdOOi.dOS en 
el menú Anal>:Z.e ... Set Options. · · ··" · ' 

Recuerde: Es un butn lufbüo gtntror 14 salida primtromtnU 11 u.n . 
archl.,o de texto antts dt tnviarlo dirtctamentt a la imprtsom EllD, 
nos pennite revisar prtviament.~ la infonna.ción usando cualquiu 
tditor dt textos, sin ltntr que hactr frtntt a tnormts pilas dt paptL 

Comentarios Finales 
Como habcá. pcd1do observar, SAP2000 es una pcderosa hmainienta paa el anillsis esaucnnJ ~ 
puede usarse en Wla gran \'ariedad de problemas Sin embargo, es muy impatante auc:nda los 
principios de ingeniería solxe los cuales este programa ha sido creado. 

La ma~ de los u-aba )os en ingaüoia se inician ron sencillos antcpl"')UtOS para poa:ericnncñte 
madurar en complejos proyectos de análisis/diseño. Esto hace que sea muy impcrtan1e d«idir desde 
un inicio las herramientas apropiadas de fOfTTlJ tal que no sea necesario cambiar de p-ogramas ala 
mitad de un p-oyccto SA.P2000 trata de satisfacer la mayor p.:ltte de las necesidades que un 
diseñador puede tener dur .ltlt~ el desarrollo de un proyectO. 

Las car.actaísticas que SAP20Cl0 ofrece en el proceso de di~o inctu~: 

• La capacidad d~ disoi¡.¡ ~ueños ó grandes proyectos sin necc.sldad de ap-cnder a usar un 
nuevo progranu 

• La capacidad de diseñar elementos de coocreto y acero m un rrúsmo programa. 

• AJgoritmos de cálculo rápidos que permiten aJ usuario dedicar nta)U tiempo en la r00delad6n 
del problema y optimización d~l diseño de elementos estructurales. 

• La habilidad para modificar y mejccar el diseño fácilme~lte. 

Existen p-OOabiemente tantas formas de mOOelar una estructu:ra como Ingenieros exlstcn. Sin 
embargo, puede encontrar útiles algunas de las siguialtes ideas: 

• Comience COf1 un mOOelo básico de la estructura y b-ate de aumdcrlo Mtes de at\adir má.s 
detalles Será más senctl\o corregir problemas en el sistema estructural adoptado cuando el 
mcddo es atin simple 

• Asegúrese de que la estructura pueda coostruirse y que se compatar! en la man9 en que la 
hemos mcdclado Si no puede ser consouida m esa forma.. es necesJrio en!cnda el efecto del 
pro:l!so constructivo en el comp;xtamieniO final de la esouctura. 

• Documente detalladamente ¡u diseño incluyendo informacit.rl sobre las considendooes 
asumidas, áreas que deban revisarse e incluso sche información que aún es requerida. Pare ello 
use el editor de tex.tos u~r Commrnl!i and Sesslon Log que se mC\Jaltra dmtro 'del menú 
Fl1e. Este editor de 1ex1os incorporado en el programa, le permitirá que dichas anotaciooes y 
comentarios formen parte del mcdelo. 
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E¡cmplo 1 Pórtico Bidlmnuiotu.l con Cu11 Esrltia 

ExpcrimaHC cx:n sistcm;H estructur~les alternativos. SAP2000 ha sido di.sdiado para eFectuar 
dtcul05 numérica;. r.1pid.lmcmc. p::n1titicn.!o utiliur rmyc..- tiempo 01 el mejor;tmiento de 
nucsu .:>s di~ñO'i 

Así cc.mo hay un tiempo asignado para la rc'r1siOO grnaal al final de un p-o)«to, no hay razOO 
ror la que no deba hab::r lUI tiempo p.1fil rcvh:u- el proytcto desde sus lniCJClS 

••• 
1 .-1 1 .. "í ¡--· l r' .r--. 

EJEMPLO 2 

Pórtico Bidimensional con 

Carga de un Espectro de Respuesta 

Descripción 
Este ejemplo es una cootinuaciOO del Ejemplo l. En esta sección rr.::tmwena a:mo tncorpcnr m 
Espectro de Respu..u en el análisis de un ¡ñtieo bidimensiooal.la base pan definir el Especuo de 
Respuesta saá el espectro del c6d.igo UBC94S2 el cual esta incluido m el SAP2000. 

Aspectos Significativos del Modelo y del SAP2000 
• Uso del <XXll!ndo llelp para otuner inSI!Uce!mes sotn: lu qxlmco clel SAP2000. 

• Ina:qxraciOO de una carga p-ovenicnlt de tm Espc:aro de Respuesta.. 

• Adocuar la ..ala del Especuo de R<spuesta pon su wo m el disdlo. 

J 2 SAP2000 Gula de Apreodiujc SAP2000 Oula de Apreac!lr.aJ• Jl 

• 



[¡tmpln 2 J'óruco B•durll'ndon . .d con carg' de un [lpt":ctra de Rnpuesu 

Definiendo el Espectro de Respuesta 
Lln Espectro de Respu~a e~ la m.áxima resp.lesla de un sistema excitado m su base pa- lUla 
función :lcckración-ticmp:J. Est.J. fur1C1Ón S(: n{!"esa en táminos de la frroJcncia narurnl de la 
esJructurJ )'del amCJ'tiguamicniO dd !>istcnu. [ 1 Espectro de Respuesta dd código URC9-1S2 que 
vo~n10s a cmple.ll r-_n este ej.:mplo es suministn.lo coo SAP2()(() y no es necesario ddinirlo pcr 
sep.1rado S1 t·uhies.: la ncccsicbd de dclinir Wl Espccuo de Respuesta d1stinto, se pucJc usar la 
a~udJ u1 Ent:.J para obl:cncr instrucciones que ind1can ¡:uso a p.lSO como efectuar es1a tarea. 

Ayuda En-lir:ea 

Recuerde: Podrd utiliUJr alguno tk Jos mltodos slguientu pilrrl obten u 
wjom1ación sobre-cualquiua a e las funcionts del S:1r2000 

Dd metú llclp selcccicne &:arch (or llelp on. 

2 Cun el pl.~.nttlla lndu: sclecdonada: 

En el Are a 1 escriba 'Define . Ud. vf"ra en el Area 2 una üsta de todos los tópicos 
dtspombles que comiencen con la palabra 'define'. Uno de esos tópicos es 'Define 
Responseo Spcctrum Funr:tioos·, que es el tópico del cual necesitamos obcener a}tJda. 
illgu dcble clid; en la línea con la fr.1se 'Deftne Response Specm.1m Functions' 
p..tra que el programa muestre !.1 información correspondiente. 

3 Altc:llattvamente, seleccione el indicador J· ind para b.Jscar una pa!atra clave en cualesquiera 
de los tópicos disponibles en la Ayud.l En·linea. 

S1 e~ la primera vez que usa la opción Fmd de la Ayuda En·lfnea del SAP2000, 
aparecerá una plantilla denominad.l rind Setup Wb:ard. 

• Presione el botón NEXT para aceptar el cr'ilerio para construir la base de datos de 
búsqueda. 

• Presione el botón FlNlSH para construir la base de datos. 

En el Are.a 1 escriha 'Response Spectrum' 

En el Are a 3 encontrará nuevamente la opción 'Defme Response Spe.ccrum 
Funwcns' la cual puede sdecrionar·.e para obtener la información de ayuda 
correspondiente. 

Nota: s~ pu.~d~ encontrllr mayor infonnaddn sobr~ el uso tk la A.yudll 
En·/Ínea, ~n la docum~ntociótl de Windows. También putd~ ejecutar 
el archi'a ll'l.VIIELP31./li.P ubicado en C:\\VINDO!VS\1/El.P. 

lX:fin.iendo el Espectro de Respuesta 

Si el modelo esta pr01cgido (locked), use el bocón Lock!UnJock Model para remover la 
protección y poder efectuar cambios en el modelo 
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EJemplo 2 Pórtico Bidim::ndon.al coc arg1. do: un Especi:ro de Rctp.u:SU ···. 

2. Ajus1e las unidades a Kip-ft. 

3. Ingrese aJ menú Define y seleccione la opción Response Spectrum Case .. ·"· 

4. Presione el botón ADD NEW SPECfRA en la plantilla Response SpectrL 

.. 5. En la plantilla Response Spectrum Case Data.: 

Especiftque el amortiguamiento asociado al Espectro de Re.spuesta colocando en la 
rasiliJ ll::unpinc el valor, para nuestro caso: 0.05 (5 %) 

Seleccione UDC9~52 para la dlfección Ul, asf como un factor de escala 32.2ft/sec2 

en la ca:;illa Scale Factor. Este factor de escala es usado por el Espccuo de 
Respuc-;ta debido a que el espt!ctro UBC9-tS:!. esta nom1alizado al valor de la 
ace\eril¡;ión de la gravedad g 

• El resto de Jos valores por defecto son aceptables. 

Presione el botón OK para act!ptar Jos cambios hechos en ambaJ plantillas. 

Efectuando el Análisis 
Una vez que se han realizado las m~ilficaciones, es tiempo de analizar el mOOeiO y echJr una 
miradJ illos resuiLJdos del Espectro de R.:spuesta. 

l. Grabe el 1\H.A.Ido. 

2. En el menú Analyze seleccione la opción Set Optlons. 

M.uqu.: la casilla Dynamlc AnaJysls. 

Presione el botón SET DYNAMJC PARAME'IERS y modifique el ntlmero de 
modos de vibración a ser considerados en el ll1li1isis en la opción f"urnber or 
Mode!o. Para nuestro caso 7. El resto de valores por defecto son aceptables. 

Pr~sioue el botón OK en ambas plantillas para aceptar los cambios. 

Nou: Se debe tkcúlir tullntos modos 4e t~ibraclón dden tonsiduarse ~~~ 
~1 análisis para obtentr r~sulllldos adecuados. Para ~llo hay muchos 
criterios ll tomar en cu.ent12, ptro pllra una Ulfllcturll sencillll como 
la que estamos analhando puede consúleraru satisfactorio un 
num~ro de modos igual al numero dt pisos. 

3. Seleccione la opción RWl Mlnlmind del menú Analyze pua analiw la esb'Uaura. 

Nou; lA opción Run Minimi~d es nunamtntt útil cuando 1t titnen mod~IDs 
grandes qut rtquitrtn mayor ti~mpo pllra ltr tlllali:Ados. Esta opción ptrmltt 
al St\P2000 corr~r en un s~gu11do plano, ptnnilitndo continuar trabajtJ.ndo 
con otros programas. Otra tl~ntaja dt ~stll opdón ts qu~ nos brinda un botón 
para cancelar In ejecución d~l análisis tn caso ntc~sario. 
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• EJemplo 2 f>ÓitKO A1dtno::ns10na.l con c.arg..1 de un Especuo de Rcspucsu 

Verificación de los Resultados 
l. Verifique si las forrn..as modales y perfodt-~ de vibración son Jos esperados. 

• Dd menú Display ~eleccione la opc1Jn Show Mode Shape y dija c:l modo en que 
esla interesado Pude tambi~n seleccion.l! la opción \Vire Shudow para \'Cr al 
mismo ti~mpo la forma no-defonn3dJ de la estructura. Observe las Figuríls 2·1 a la 
2-4 y nott' que e! número de modo) período de vibractón correspondiente están 
indicados en el título de la ventana 

Nota: St pueck apreciar los modos dt rlbracldn subsecuentes pruionando 
los botonts + y -,próximos al botón START ANIMATION. 

2. Es útil ver c:l cortante en la ~ase producid;) por el análisis del Especuo de Respuesta. 

Usanjo el grupo BASE SHEAR qu~ fue definido en el Ejemplo 1 observe el 
cor:a.nte en [a base de la cstrunura cl.:bido al Espc:ctro de Respuesta Se puede 
aprcc1ar que este cortante e=s considelahlemente ma)or que el debido a la condición 
de c.:uga e::.tática. 

3 Se pu~de \erificar el desplazarrUento de un nudo debido al Espectro de Respuesta. 

Del menú Display sekccionc. Sh .... w Udonned Shape. 

• En la plantilla Dcformed Snape :.eleccione la condición de carga para el análisis 
espectral 

• Presione el bocón OK. 

• Haga click con el botón derecho del moose sobre un nudo del nivel superior de la 
estructura para ver su correspcndic:nte desplazamiento en la dirección global X. 

4. Verifique !a panicipación de la ma.sa de In estructura para ver si se ha incluido el en la 
solut ión del problema el núm:ro de modCis suficiente. Para ello se debe revisar el archivo 
de IC:.(fO filenamc:.OtJT empleando un c:dira de textos como el WordPad de Wmdows. 

• Minimice el programa SAP2000. 

• lnicir el programa WordPad o cualquier otro ed.itcr de textos. 

• En WadPad abra el archivo fiknam~.otrr. Dcrade filename es el nombrC del 
archivo usado al grabar este ejemplo. 

t Busque la sección tituladA MODAL PARTICIPA TINO MASS RATIOS romo &e 

m•Je.stra en la Figura 2-S. 

• Bajo la collll"Ma CUMULATIVH SUM encootrañ. que los Modos de Vitnción 
1 al 7 incluyen el lOO% de la par1icipaci6n de masa. Lo cual significa que los 7 
modos empleados en el análisis rueron suficiemes. 

1 6 SAPl().)J Gdi de A~tfld.u:ajc 
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EJemplo 2 Pónico Bldim:ns10nal con cu¡a de un Espectro de RupuestA 

liil 'fftfjl QJii.¡¡ IFJ:!:!:ff§ft!! !o! xf Ct Modc 2 P~riod0.4118 sec-.1!81:1 
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Flgur1 2·1 Form1 Mod1! y Periodo d1 Vlbuc:lón 1 FJgura·2·2 Fonu Mod1l 'f Periodo d1 Vlbncl6n 2 

lxi !fttffFIQJi!.!ii•flcl;J MB.: lo! • 1 

Figuro 2-3 Fonna Modal y Periodo da Ylbraa6n l F1g1n 2-4 Fonna Mod~ y P.-lodo do VIbración 4 
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EJemplo 2 Pórtico Bidnn:n!.lon.al con 011rga de un Erpectro de Rupo.~csta 

H C. [J .:., l P -' R T i e r p />. T l "e H A ~ , RATIO S 

1-'.:. .. ¡:: PtP!OO ItiO!V!DtlAL HOO(; t PE:RCt lrr) Clh-!VLATrVt Sl.-~1 t PE:RCEtrr) 

o.h. '" uz "' Ut uz 

1. jBB l~:J 19 CJ~9 0000 o (1000 19.63~9 o .0000 o 0000 
O Hl~]J 12. S 151 o. 0000 O .GODO 91.2120 o.oooo 0.0000 
o 26GI26 4.102] o 0000 ¡¡ 0000 9S.~l44 o .0000 o.oaoq. 
0.176~)9 ' . 1 ~29 0000 o . roo o 97.6]1) 0.0000 0.0000 
O.IJJéi19 1 4 o~ j 0000 o 0000 99.0~SO 0.0000 0.0000 

. 10 1C l7 o .c~n 0000 0000 " 104] o .0000 O. OOQO 
090:'78 o . 29: l 0000 t•OOO lOO .0000 0.0000 0.0000 

Figura B Bloque de Pártlclpadón de JI M a u del archivo de taHdt 

ModifiC'Jndo la Escala del Espectro e~ Respuesta 
AlgunO:) có:ilgos de d.Jsci'io pennitm mOOificar ¡,,escala dct Espectro de Rl:spuesta de t.la.Ilaa que 
el cortante en la base del ¡¡¡¡iJisis ~pectra! sea igual al cortante en la base del anái.Jsis cmph ... -.ndo 
c~rgas sismicas est,jticas 

En este S.Oltido para obtena el nuevo facta de es~a para el Espectro de Respuesta tenemos que: 

Dn·idir el Con ante en la Base producido ror la Carga S(srnica Estática por el Cortante 
en la Base obtenido del Análisis Espc:ccral, y muhiplicar dicho número por 32.2 ft/seg1 

para obtener el nuevo fc~ctm de escala del Especuo de Respuesta. 

2 Subst1tuit el nuevo facwr de ucala en el Especuo de Respuesta. 

3. Efectuar nuevamente el análisis para obtener las nuevaJ fuerzas en los ele.mentos bajo la 
acción dd Espectro de Respuesta escalado 

J¡j SAP2000 Gult de Apreod.iuJe 
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Ejemplo 2 Pórtko BidiiDI'nslonal con carp de Ull Espcetto de RcJpuesta 

._,,.' 

Comentarios Finales 
Un análisis empleando el Espectro de Respuesta intrOOua: un nivel de complejidad ma)tl', que 
requiere que el ingeniero \•critique cuidadosamaue los resultados, y tenga mú)' prC:sente 13.s 
considmciones hechas a1 crC3f el mOOelo. Algunos de los aspectos a coosidaar durante lUI an.flisis 
espectral son: 

Entenda completamente el comportamiento estático del modelo antes de erectUar un 
análisis dinámico. 

• Tena un conocimiento cabal y racional de tos aspectos involucrados al escalar los 
resultados del análisis dinámico para obtener un cona.nte en la base similar al que se 
obtiene al efectuar un análisis por cargas sísmicas estáticas. 

• La ventaja de la mayor rapidez del AnáJí)iS Espectral en comparación con el AniJisls de 
HIStoria en el Tiempo es en muchos casos sustancial. En el diseño, el espectro de 
respuesta puede incluso proveer aun mayores ventajas debido a que no se deben erectuar 
verificacion~..:s para diferentes intervalos de tiempo. Sin embargo, es neceurio tener 
presente las limitaciones del Análisis Espectral frente al mayor refinamiento que se 
obtiene al efectuar l!!l Análisis d: His10ria en el Tiempo. 
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EJEMPLO 3 

Pórtico Bidimensional 

Análisis de Historia en el Tiempo 

Descripción 
Este ejemplo continua el o.nilisis del p6rtlco bid.imensiooal visto en Jos Ejemplos 1 y 2, 
añadJendo en es re caso uno~. carga de sismo e!-pecificada con un acderograma en la base de la 
c:muctura El registro de acc:leraciones a ulililarsc se mues[l'a en la Figura 3-1 y corresponde a 
IJ componente N-S del sismo ocurrido en El Centro en 1940. Las resultados del análisis de 
historia en el liempo 'se u\ilizarán tJU3. generar un Espectro de Respuesta que luego se 
empleará pa;a reanaliz.ar la esttuctura a manera de comparación. 

Aspectos Significativos del Modelo y del SAP20oo' 
R.spu<ru de histeria en d bcrnpo de una CJ<citaám en la base.. 

Gráficas de los resultadce deJ anjijsis de Histeria en d ncmpo. 
• Gráficas d<: un Espectro de Rtspuc.ta a partir do los rcoui..OC. de la Histeria en elllcrnpo. 

lmpataciOO &1 Espectro de respuesta para su uso en el antlisi.s. 

SAMOOO Guú de Apm¡diujc 20 
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Figura 3--1 Acelerograma de •ntrada del Sltmo de El Centro 1140 ( ftfsocl) 

l ;, 
~ ~ 

" 

Definición del Concepto Historia en el Tiempo 

.. : .-. 

El cómino Histeria en el Tiempo define un regiSIJ'O de aoelenciooes dd lencno a dctcrminados 
int.crva.los de tierilpo para una cxcilaciOO sísmica especifica en una du-ecclón deu:múnada. El 
registro es usualmente namalizado y en cmsecuencia necesita nuJ!tiplicarse pcr la a.oeleraciOO de la 
gr>V<dad 6 pcr alg¡ln OlrO ract<r carespoodienJe. 

l. Dc:sde el mcm1 DcOne seleccione Time Hlstory Functlons. 

2. Seleccione el botón ADD FUNCTION FROM Fll.E. 

• Presione el botón Open FUe y seleccione el archivo ELCEN"nO ubleado a1 el 
sutxiirectorlo EXAMPLES del direct<?rio SAP2000. 

• Cambie el nombre de la función a ELCENI"RO para qUe aea Ucll de reconocer. 

• El formato de este archivo es de tres pares de columna.s de datos por rcn¡lón. El 
primer par de datos la primera columna de cada par es el tiempo y la scgurida es la 
aceleración. 

• Ingrese 3 Puntos por Unca. 
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E¡(mplo : Pórtico n1d.omen11oru.l AnJ11ti1 de ll1storia ea d Tiempo 

t Seleccione la opción Time and Functlon Values (en archivo de daros). 

• Presione el botón OK. 

Pres1one el botón OK para acep1ar los datos ingresados. 

J Del menú Dtnne seleccione la opción Time lllstory Cases para definir los parámetros 
csrccifico~ para el anális1s de Jlmoria en el T1l'mpo de nuestro modelo 

SeleCCione el botón ADO NEW HISTORY. 

Para ad1cionar amortiguamiento al sistema presiooe el botón MODIFY/SHOW 
MODAL DAt-.fPING, ingcesc O 05 (5%) para lodos Jos modos y presione: O K. 

I.)grese en el ftcm Nwnber or Output Time Steps t:1 valor 500. 

Ingrese O 02 {sec} en el ftém Output Time Step Sbe.s. Esros parámetros nos darán 
10 S<!gundos del rc=sisrro sísmico para e:! análisis d~: hisloria en clriempo. 

De la Lisia Analys:ls Type seiN.cionc la opción Linear. 

En el área Load Asslgnmtnl : 

• Selecctone ACC DIR 1 parad parámetrC? Load 

• ~eleccione la opción ElCE~O para el parámet;o Funrllon 

• Para el parámetro Scalt Funcllon ingrese la aceleración de la gravedad que 
es de 386 4 inlsec1 si trabaja en Ktp-in o 32.2 ftlsec1 si trabaJa en Kip·ft. 

t Para los parámetros Arrlvull'ime y Angle asigne vaiOf cero. 

t Presione el bol:ón ADD para a1:regar esta carga al modelo, y presione el 
botón OK para aceptar los datos que acaba de ingresar. 

Presione el t.ütón OK en ambas plantillaJ para aceptar las adiciones al modelo. 

De est.a rn.~nen. hemos ingresado toda la infc.-m.adOO que necesitamos para efectuar el Análisis de 
llt'itoria tf' el Ttem~ 

Nota: Por lo gtnual es una buena idea correr el motklo ccuLJ Vt"t que u 
hace UJI cambia ó adición importanJt al modelo. Esto permite 
detectar errores y ahorra tiempo en tl diseño finaL 

1--, 1~ ["'"""' .:· ~ ·,-:- .. r--""' 
·--

EJ~mplo l P6rtko Bidimension.tl An.!luis de ffiti:Orú. eo el TiemPo .. :. 
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Efectuando el Análisis 
l. Grabe d moJel o. 

2. Ajuste Jos parámetros para el análisis seleccionando Analyze del m~!l Set O~d~~:·. 
• Verifique que los parámetros en Dynamlc AnaJ;sls son los .núsmos del Ej~~~io 2. 

3. Seleccione en el menú Analyze la opción Run para analizar la esb'UCIUC1. 

Usando los Resultados 

Verificación de los ResuHados 
Una vez que ha corrido el modelo se deben verificar que los resultados ol:tenidos sean del adm y 
magnirud a lo esp.:rado. 

l. Verifique el Cortante en la Bast producido en el Análisis de Historia en e11i~mpo. 

• Desde el menú Display selec::one la opción Show Time 1-Ustory Traces: 

• De la plantilla Time llistory Display nennltlon presione el lxxón DEFINE 
FUNCTIONS -

• En la plantilla Time lllstory Functlons seleccione Add BaJe Functions y marque 
solamente la opción B"se Shear X. 

t Presione OK para rcgre5ar a la plantilla Time IUslory Display Dennflfon. 

t Ad1cione la función Base Shear X a la lista Ptot Functlons. 

• Presione el botón DISPLAY para ver una gráftca del cortante en la base en la 
dirección globJI X como función del tiempo. Vea la Figura 3-2. 

Nota: TambUn se putdt ttn.trar lo grrijica dtl tot14ntt tn 14 bcut 
.selucionando Add Group Summation Force.s tn lutar tk Add BtUt 
Function.s y stkccionando d grupo de tltmtnloJ BASE SIJEAR 
definido tn ti Ejemplo l. 

2. También se pu!!de verificar el desplazamiento de un nudo ante una excitación de Historia 
en el Tiempo, para ello: 

• Escoja un nudo y desde el meml Display seleccione la opción Show nme 1flstory 
Traces. 
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• E¡empl" J Pór11co Du!Jmem10n;ll An..ih1i1 de Jl¡noria en d T1cmpo 

t Prcs¡one el bo!lSn DEFINE FUNCTIONS de la plantilla Time Jllslory 
Funcliuns Seleccione el nombro: Jd nudo de la liSia y prl!siunc el botón 
~IODfFY/5110\\' T11 FUNCno;; 

• En la plantd!J l1me HJstory Jomt Functioo seleccione OISPL para el parámetro 
Vector Typc }' UX para el parám::uo Ve-ctor Oircclion. 

Presione el b:>tón OK para ac~pta: los camhios. 

• f'res1o11e los botones Ol\. p..ua regresar a la plantilla Time lli!itory Display 
Dc!inition 

• Añada c=l nudo de la lista Llst of Functlon.s a la lista Plot Functlons y remueva de 
esta ül!in1alJ función Bc~sc Shc:.Jr X 

Presione el botón DfSPLAY parJ ~Jer el desplazamiento del nudo con respecto al 
ucmpo Vea FigtHJ ].) 

SI! pu~d~ rambién d~finir una función ncxlal direcram~nt~ en la plantilla Time 
llislor) Display Dcfinition sm hab:r seleccionado pre'>iarytcnte el nudo. 

• En la plallliiiJ Time Hlstory Display Definltlon pre:>ion~ el botón DEflNE 
FIJNC nONS y en la plan!itla Time llistory Functions seleccione :.t opción Add 
Joint D!sps!Forcr(. 

t En la plantilla Time Hlstory Joini Function dlgrese el nombre del nudc (ID). 

t. S:l~ccion~ \'eclor T)'pe y Vector Dlrtcllon. 

t Presione los bocones OK para regresar a la plantilla Time lllstory Display 
lJc:í~tition en donde encor,trará la nueva función nodal en el recuadro List or 
Funclions. 
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Ejemplo J Pónico Didi,mcnsional Aná.Ji,is de Hi$1:~a en d Tic~· 
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Figura 3·2 Cortante en la Basa~ Kips 

Figure 3-3 Hlttorl1 en el Titmpo del Oe1plaumlenlo del Nivel Superior -In 

Creación de un Espectro de Respuesta 
Lo primero que se tiene que h~ en este punto es creac un Espearo de Respoesta a partir de Jos 
resultados del Análisis de Historia en el T1empo Los dalas generados d~ esta foim.l. ~~~ 
imprimirse en archivo de te:~.:to para pOOer ediud.Jrse en un foonato que pueda ser leído pa el 
SAP2000. 
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Gráficas del Espectro de Respuesta 
Sekcc10ne un nudo en la base de la estructura 

2 Del menú D:lsrlay seleccione la opción Show R~poruc Speclrum Curves. Esta opción 
aparece solamente cuando se ha seleccionado un nudo. 

3. En la plantilla Respom:e Spectrum Gtueratlon encontrará el nombre del nudo que fue 
seleccionado 

BaJe el He m nenne asigne el valor X para el parámerro Vector Direction. 

Bajo el ftem Axes selccc!One Peri0ol para el parámetro Ab~cissa y PSA 
(Seudoac'!!eración E~pcrtral) para el parámetro Ordinate. 

• BaJo el ftem Optloru séleccione ArithrnetJc t.anto para Abscissa como para 
1 

¡ 
Ordinate Para el parámetro Ordin:1te asigne el factor de ese<~ la 1/g (g::::32 2 ftlsec1) 

es cic~1r. O 03106 sec1/ft stla~ unidildcs en que se trabaja son kip-ft. 

Nota: El/actor dt escala ts usado para nonntJiiUJr ti Esptclro tk 
Rtsputsta. El ugistro para el análisi:s de historia en el tiempo que se 
urilh.J para generar el Espectro de Respuesta estaba 110nnnlhado a la 
ac..!uaciótl de la grave®J (g) por lo que necesitamos dividir el 
espectro por la misma cantidad para obtener valores nonnaUwdos. 

Bajo el (tem Perlod seleccione parR las frecuencias los parimetros DeCault y 
Structural. Esto~ parámetros son usados en la generación del Espectro de Respuesta, 
la~ frecuencias del tipo Ddault son una serie de frecuencias predetenninadas que 
son tipicamcnte de intcr~s en las esnucturas; las frecuencias dd tipo Structural son 
las frecuencias naturales de la estructura. 

• B11jo el ftem Damplng mantenga el valor del amortiguamiento de 0.05 para el 
parámetro Damplng Value Corno se ha ::~.sumido que la estructura tiene 5% de 
amonigl.lamicnto no será necesano emplear otros valores para el amoniguamiento 
.:icl sis1emJ. 

Prc~1one el brnón DISPLAY cuand11 se halla terminado. 

·L Ahora Ud. podrá apreciar la gráfica del Espectro de Respuesta para el sismo de El 
Centro para un amorliguamicnro de 5% Ver Figura 3-4. 

Figur1 3-4 Espectro de Respuesta del Análisis de Hislotil en 1! Tiempo 

5. En la plantilla Response Spcc::trum Curvts seleccione la opción Print Ttbles to 
File. Esta opción generará un archivo que tiene dos colurMas dt do! tos. La primera 
de ellas es el período, y la segunda es su correspondiente Seudoacelaración (PSA). 

Grabe el archivo con el nombre RS-ELCEN.TXT 

Edición de Tablas. 
El siguiente paso consiste en haceT algunu pequdlas modificaciones al archivo de 1ex10 RS· 
ELCEN T.XT para que tenga un forma!o que pueda ser leído por el SAP2COO. Esto se debe a que 
cuando el archivo original es erado se le agrega infonn:tciál adamtai3 que pemUte al ustWio 
intapretar y enlt.:nder f:kilmente su contenido. Esu inform.1ción Utr.l deb: removerse. 

l. Con un editor de textos como WORDPAD o NOTEPAD abra el archivo RS· 
ELCENTXT. 

• Selecc•one todo el texto que se muestra resaltado en la Figura 3-S y renw~valo. 

• Grabe d archivo RS-ELCEN.TXT como un archivo de texto con el mismo nombre. 

2. Ahora que el archivo tiene tan solo las columnas con los pcrCodos y sus 
correspondientes Scudoacceler:tcioncs, podrá ser lefdo directamente por e~SAP2000 
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1- ••. r·····-.. Pjcrnplo J Pórtico nuJrmcmrora! Al'lil11i~ de llrszon~ en d Trcmpo. 

o .0157 l.l6~7[-01 

o 0-100 l.1139t-Ol 
O.OHS 3.:~1'7(-01 

o.osuo l .2205f>OI 
o .oss .¡ l.lO'JQt-01 
o.o¿o~ l.-1265E-01 
o OC:67 3.7'111[-01 

Frgurt ~-5 Atcnivo de ulide con el Espectro de Rupuer!s generado 

Lectura de los Datos del Espectro 
Ahn·a que se ucnen dalOs en un ronnato que r-1 SAP2()(() puede leer, no::e:sitamos indicar al 
programa la ubicación del archivo así como la forma en que tste contiene la información. 

S1 el modelo esta protegido presione el bo(ón Lockl Unlock Modelen la barra de 
herramientas. Al hacer esto se remueve la protección sobre el modelo y nos pcmtitirá 
rcaluar las modificaciones. 

2. Del mal~ Define selecci«rC Response Spcctnun Funcd005. 

3 En la plantilla Response Spectrum FlD'lctJons presiooc el bctOO Add Functton from Fnc. 

Asigne al espccuo el nombre RSELCEN 

Presione el OOI.ón Ü!J-CD FUe)' seleccione el archivo RS-ELCEN.TXT en Pick FUe. 

Mantenga el parámetro Number or Polnts Ptr Llne en el valor 1 puesto que 
únicamente hay un p.v de datos por renglón para definir el Espectro de Respuesta. 

Stleccione la opción Perlad anc..l Acct:leratlon VaJue-s. 

Prem .. ne d J:..otón OK para cenar las plantillas. 

28 SAP:!OOO Gul.1 de A.prend.iuje 

• 

,--. 

• 
,-. 

Ejemplo 3 P611ico Bidimensional Anihsi1 de Historia ca ci Tiempo: 

4. 

5. 

Del menú Define selea:iooe R.espome S¡>«trum Cases.: 
. ... -·:~ 

En la pl.u1lili.:J Hesponse Spu:trurn presiooe el ba:ón ADD NEW SPECTRA. 

• Asigne al parárnerro Modal Damplng el vaJor 0.05. , 

En el área Input Response Speclra seleccione RSELCE:N Para la -dir~·ión Ul y 
asigne le el factor de escala 32.2 fllsec1• · 

• Los demás valores por defecto son aceptables. 

Presione d botón OK para cerrar las plantillas. 

Efectuando el Análisis 
Una vez que se han hocho las mcrlilicaciones es tiempo de correr el modelo y rc..;sar Jos resultadq¡: 
obtenidos 

l. Grabe el modelo. 

2. Seleccione Run Mlnlmlzed del menú Analyze para analizar la c:strucrura. 
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EJ~mplo) Pór1ico B1dJm~oJional An.il•sil de flilJom. en ti T1empo. 

Revisando los Resultados 
Lo pnm.:ro qu!! <ktx hacene es !.1 rc\isión <k la m.ú..ima deflexión a1 la parte s11pcrior. ~e la 
cstrudura asi tomo el coMJJlle en la hase tanto para el an.ilisis espectral como para el an:ihSIS de 
ll1~toJ 1.1 er. el T1cm¡XJ La comparaciérl de estos result.Jdos nos pcnniurl vo.:r que tan l11én fu11C1~~J 
IJ mclc.:!ologia pro:·riame!lle descrita.. Al final éc esta sección encontrad los resultados del an:ihm 

fXIr CJr¡;Js ~ísnlltJS est.itica~. del anihsis espú."lJ JI y dd anlh~1s de historia en clliempo. 

Oenexi,)(les de acuerdo al Análisis Espectral 

De! mcnU Display S(]CCCJOOe Display Ddonned Shape. 

En l..1 plantiiiJ Defornted ShBpe sekccione la condición de e Jiga para el análisis 
e:~pectral. 

Presione el botón CK. 

2 1 l.1ga r:l1c~ con el botón derecho del mouse sobre un nudo ubicado en el nivel superior 
p:.ua "er su dc5plazami<:nl0 en l<'. dtrccciún del eje global X 

Cortante en la Base en el AnA lisis Espec1nll 

U:-.mdo d :;rupo 3ASE SHCAR que fue creado en el Ejemplo 1, observe los valores del cortante en 
la base oc la esm1e1ura d.:birlo al Anáüsis Espc:rral. 

De flexión) C')rt.anle en la Base en el Análisis de Historia tn el Tiempo 

Usando el m¿todo descrito m la primera parte de esta guía gra.fique la deflex.ión m el nivel 
sup:ria- de la esU1Jctur3. 

2. Ahcra remueva ese nudo de la lista F1oi FlDlctlons y en su lugar grafique la funciOO Base 
Shear X ubicada en Ust oC FWlctions de la plantilla History Disptny Dcfinitions. 

Car2a Lateral EstJtlca. Espectro de Hlstorla en el 

1--- Re~.l!_uesta Tiempo 

Max. Deflexión L6S in s.s in 5.8 in 

Max. Cortante en 72 S Kips 302 Kips 32S Kips 

J!!~se 
l1bl• 3-1 Companc16n de loe RaaullldOI del An'llsl1 de Cargu Lateralll · 
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EJemplo J Póni~o Bidi~nsio~ Ánilislide HISiori~ co !:~Tiempo. 

. ;Jíi_l_:_~{_f_?_i_Í~ 
·: .. -;·· ··. ,,,_'• Comentarios Finales 

.. " 
Como hal:xá pOOtdo <I[KCCJar el Aná.l.Jsis de Historia en el T1empo involucra un map de'~po de 
cómpu1o que el Análisis con Espcrno de Re~-puc.sta Dd:-= observarse sin embargo que 'ambos · 
m~1cxlos de aná11sis trindln rcsul1ados sinuiJic.s En e.sll! scmido es sWl1.lJllc::nle importante que el 
ingeniero cnticnd.1 las vcnl.1Ja5 y limitacimcs de cada métOOo pm pcx:ler utili.z.arlas de la manm 
más atlccuJtL y cfl!ctiva. 
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EJEMPLO 4 

DiSE!ñO en Acero de un 

Pórtico Bidimensional 

Descripción 
Este C:Jcmplú es Wl imrcducciOO al uso de las poderosas herramientas que posee el SAP2000 para el 
diseño de una estructUra una vr.z ooncluido su análisis estrucrural Se dará &!fasis en esta parte a 
módulos de J¡se:lo ro acero empleando cnrno cj..:mplo la estrUctura analizada U\ el Ejemplo l. 

Aspectos Importante del Modelo y del SAP2000 
• Crelción de zonas rfgida.~ otlos elementos. 

Selección AUiomát:ica de grupos 

Cambio de p-opiedad~ 01 elementos 

• Destgnación de clemmtos por gru~ 

InclusiOO dd efecto P-Deh.a en el análisis 

• Vtsualiz.adón de los resultados 

Auto Selección de secciones 
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Ejemplo 4 Diw:ilo co Acao de un Pórtieo Bidlmc'tnlotu.l. · 
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FigLtfl 4-1 P6rtleo Bldimtnllonal a dlsel\ltM 
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E]<':mp\o 4 Oi~l'lo en Acero <Je u o Pórtico BidlmeOJJo!W 

Creando el Modelo en el SAP2000 
Es ~ible: emplear el mcx.Je:lo desarrollado en el E¡emplo 1 efoctuando pequeñas modificaciones. 

Materiales 
J.o prima e que se de:be hacer es especificar las propiedades dl! los mal eriales 

Yw!lquc que [.l.S umdado:s estén en K.Jp-in. 

2 Entr~: .ti mcnü Odinr y S'!lecc,icoe la c'P'.:i6o Mat.t'rlals. 

3 EU¡a, 31UJ. para el pa¡ámetro Material y prcsiooe e:\ OOc:ón MODIFY/SHOW MATERIAL 

.¡ [s¡x~l"ifique el Esfuerzo c1e Auenc1a ajustando el parámetro Sleel Yicld Stress fy en 36 Ksi. 

S. Es~c1fique el Módulo de Elasticu:i.Jd ajuMando e:l parámetro Modulus of EJB..Sllclty E en 
29,500 Ksi 

6. Pres10ne Jos t:o:oo~s OK para aceptar los CJ.Jnbios y cerrar las plantillas 

Cargas 
En d ejemplo 1 se asignó el peso propin de la estructura así como una saie de carg¡u 
cooccncradas y distribuidas a la cond.Jción d.: c.vga DEAD. (Vea Figura 4-2 para la nue:va lista 
Str~tic Loo.ds Case). En este ejemplo asign:11ema> Lma coodiciffi de carga para la carga viva y 
ooa para el peso ¡xopio de los elementos E~ una buena práctica inclUir una coodiciOO de carga 
para el peso prcopio de la estmcrura coo el fin de seguir de cerca el p-oceso de q¡timizaciOO 
estruct\n.l l...a.s cargas son separad.M en carga muerta. carga viva y carga a-ansversal de sismo 
de lJ.l mana a que el SAP2()(() p.1Cd.a gene:nr aulom.á.ticamente las combinaciooes de carga. 

Para el c.a'o de ca.r~a DEAD especifique el valor del multiplicador Self Wel¡:bt 
Muhlpller en cero. 

Ag¡.eg:u una condición de carga para el peso propio y nómbrela SEl.F, asfgnele el 
tipo DEAD como parámetro a Type y ajuste el multiplicador Self Welght 
Multlpller en l. 

• Agregar otra condición de carga est~tica llamada UVE y asfgnele el tipo UVE como 
parámetro a Type. 

2. Añ!Lla las rrusmas cargas ccnt:!pCildiente\ a la carga DEAD a la condición de carga UVE. 
Esto significa que cada viga de: la estructura tiene cargas id61ticas para carga muerta Y viva. 
(Puede: reVJSar el ejemplo 1 para ver las insmuriooes de cano ingresar las una cargas) 
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Ejemplo 4 Diseno en Acero de un Pórtico Bidimcn1ioo.d. 

Figura 4-2 • Condiciones de Carga ENtiea 

Definiendo un Grupo de Auto-Selección 
La opción de: AutQ..Se:lección del SAP2CCO es wu fama mJY efectiva de diset\a: estl'UCl\ns, Al 
definir Wl grupo de secciones denomindL.!o grupo de Auto-Selección, el progrilll'\a puede disdbr 
cada elemen1o del pórtico escogiendo de entre las secciones especi fiadas en ese grupo. Pcr ejemplo 
se puede defin'Lf Wl gru~ de Auto-Selección denominado COLID.fNS con únicamente perfiles 
Wl4, y roo gru~ llamado BEAM ron perfiles W24. El programa de esu m.lllcra diseñari las 
secciones tipo COLUMNS empleando solamente seccione~ Wl4 y la.s secciones tipo BEAM 
empleando únicamaue secciones tipo WH. 

Lo primero que debemos hacer es definir \D1 grupo de Aut~Seleo:i6n que incluya ónlcamc:nte 
secciones tipo columna. Esencialmente lo que estamos haciendo en esta c:upa es darle al p-ognma 
una lista de secciones de entre las cuales puede elegir al momento de diseñar los elementos del 
pórtico El ¡:rognma por su parte seleccionarJ.Ia· sección mas e6ciente de entre ese grupo. 

Una vez se haya concluido el diseño preli.mi.na: es momento de refinarlo, para eUo 1011 JNPOI 
BEAM y COLUMN serán recmplaudos por secciones optimiudas elegidas de entre el grupo de 
AutQ..Selección. Este p-oceso asignará a los elementos secciones que serán empleada~ tanto en el 
análisis como en el di~o. esto hará nwcho más ficil el cambio de secciones que nea:.sitm ser 
modificadas. 

Ncu: La opd6n th AuttJ.oStltctl6n fundo na 1olD 111 p6rd.to1 4t aetro. 

1. Desde el mmú Define y selccciooe la opción F~Wnt Sec:dons. 

2. lmpcrte: a la plantilla Frame Stcdons todas las secciones de a.oero C0111JRndidas entre 
Wl4x61 yW14x283. 

• Seleccione en la caja de dil:logo la opción IMPORT 1/WIDE Fl..ANGE. 
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• E¡~mplo 4 O.scao en Aum de u o Pórtico Dldlmen!ion.ll 

Bu~..¡ue y sdeccione la se.:ción Wl4:d83 

1\l.:uuemcndo presiOnada la tecla SIUJT haga click con el botón izquierdo del mome 
sob'c WJ-b-61 y presione el botón O~~ Esta operación permite seleccionar todas las 
scccwnes cnuc 1..1. sccnón Wiü283 y la sección WJ4x61. 

3 Borre de plantilla Frame Sections C'Jalqwer sca:ión que pudiera estar duplicada. 

Recuerde· No er posibk bo"ar una stcclón qut tstt en uso. De tsttJ 
manera el programa asegura que todos los ekmentos tierren asignada 
secciones existen/es. 

4 Desde la plantilla Frame Section añada lUla sección Auto Stlect. E.sGl sec.dóo se ubicará en la 
pmc inferior de la lista Add. 

C.1rnbic: el nombre en Auto Secllon N ame 11. COLtn.IN. 

• D..: l..t lista Auto Selecllons elija y remueva usando el OOtón Remo ve todas las 
scccior.cs e~ccptuando los pcrfiks \\'14. Esto significa que todos los elementos que 
tengan una sección tipo COLUMN ser .in diseñados empleando alguno de los perfiles 
W 14 de en u e la lista Auto Selcctiom (Vea Figura 4-3). 

F1gur1 4-3 Definiendo al grupo da Auto-Salaeción COlUMN 

S. Siguiendo las instrucciones dadas en los~ 2 al4: 

Impone todas las secciones entre la W24x55 y la W24xl62. 

Asigne un grupo Ce Auto-Selección denominado BEAM con perfiles W24 
ümcamc=r,te 
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• EJcmpla4 Diu:J1a ca Acera de un Pórtico Bidimentlocul. 

6. Ftnalmmte. selecciones todos los elementos verticales del (Xrtia; á;~~· ~;~.~,~~:~:~r, 
COLtTh'C'J. Lu~~o seleccione to::los los elementos horizau.a.les y asfgnde la 
(Vea el eJemplo 1 po.ra las instrucciones de como asignar seccimes a\~ etémcltos. -:-:~r---·,-,. 

Nota: Se puede por supuesto seleccioflllr una seccidn espt(fi&it ~nto'~ ::·: -~: ~-:· 
ti diseño como para el análisis en lugar de tmpltar la oPción tU · !:~·- .: ·:·-~· 
Auto-Selección. Para tilo simplcmenrt se necesita asigna'rtJ lo1 :.·::":··": '· 
elementos del pdrtico una sección dt acero adecuada y diseñar~ ü ·." · · · ,. '· .. · 
acuerdo a lo de re rilo tn el ejtmplo l. Esta sección putdt ser ya Ita 
una sección definida por el usuario o bien una sección elegida tk 
tntre las secciones predeterminadas. 

Efectuando el Análisis 
Una \'CZ que se han in~~sado 1~ datos es tiempo de COCTer el mOOelo y revisar los resultados. 

J. GratA!: el moJdo. 

2. Asigne los p.!Iámeuos para el dtseño enlrando al menú Analyu y seleo:ionando la 
opción Set Options 

• En l.¡ _piJ.ntilla ~r:alysJs Opl~or¡.s seleccione el tipo de análisis Plane Fnine para 
reduclf .:ltama.no de la soluctón y en conso:cuencia reducir el tiempo de anáJisis. 

• Marqu~ I.J opción lnclude P-Delta. 

• Presione el botón SET P-DELTA PARAMETERS para. ajustar los partmetros del 
an~isis. · 

t Asigne a Maxlmwn lteratlons el valor 10. 

t Incluya las condiciones de carga muerta DEAD y SEU, en la combinación p. 
Deltl, ambas con factores de cargn igual a 1. 

t Incluya la condición de cuga LIVEcon un factor de cuga 1. 

N01a: Losjaelorrl de carga tJ empkaru tkbtn ur los corrttporulitnllt a 
las comblnaciont~ dt cargtJ qut 1t uun tn ti diseño d1 la tltnlctura 
y qut produ::can lo1 mthimos ejec1o1 tn la misma. Dtbtn lncluíru 
tJdmz41 ti t]ecto dt úu CtJrgallaJeralts. 

t El rt:sto de valores por defecto es aceptable. 

t Presione los boton~s OK para aceptar los cambios y cernr Ju plantlllu. 

3. Entre al menú Analyze y s~leccione la opción Run p~a analizar la esll\ICturL . 
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Ejemplo 4 DIJCM tn Acao <k U.ll Pórtico 8JdimensloG11 

N ola: Debido a t¡u~ hemos ruignado grupos tÜ ltcclonn J no ucclonu 
especifu:as para nuestro dueño, el SAP2000 elegirá las propiEJ4dn 
de las secciones más convenitntes para genuar la rruJtri: de rígida y 
ejeeluar el anáUsir utructurol Una l'tZ que st ha eftcluado ti primer 
análisis y diseño, u puede imtndr al progranuJ para real1UJT el 
anál.sis con lm proptedndes de IIH stcciones designadns. 

Diseño de Secciones 
Una vez qul! se ha efo;."tuado el anáhsis y r.:visado sus resultados, se pOOrán esta.blectr los 
p.1r.imctros necesarios para el d.Jsctio en acero de la estruct\n'a. 

Selección del Código de Diseño ' ¡ 

' ! 

La mfom1aCH''r1 rcsultarue del aná.ll)lS es ernple.tda para efectuar lDla verificaciOO de las secciooes 
c:npk.mdo un có.:llgo d~ dmño 

l. Desde el menú Opllons seleccione Pnrerences 

~ En la plarllilla Prererences, bajo el ftem Steelseleccione el código de dbeilo que desee 
emp~~li. En estt: caso se emplead el cócltgo AISC-ASD-89. 

Emplee el mismo archivo Section Propcrtles file que fue usado para importar las 
secciOnes de acero. 

Combinaciones de Carga y Diseño 

Figura 4-5 Opcionu en el Menú de llisefto 

Una vez que se ha seleccionado el código a utilizar en el diseño de los elementos se deben verificar 
IM combin:~Clmes <!e carga a empleahc. 
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E)Cmplo <1 Ois.cilo rn Acero dt: un Pónico BidlmeasiondJ. 

L 

2. 

•', '' · '• ,' "', •, '' ·! •-.-:.X0.:1J.~:'~-";.<)"r'-.r;-,• , . •· . ' '• .·,.r .~:-j';.-."i ....... 
Primaamaue, en el manl Desfgn asegúrese que exista la coñb"~Sa1a en el A.em~Stm ~gn. 
Esto le indic.:~ al SAP2000 ql.le dcb: deciuarse un disoio de secciones en ac.üO.'i~~:·;.~;!.i~··.+::. ·'~ . . , . . ; . . .... , -~.::t.···'~¡:,¡:,~-;: .. • r 
En el menú l)cs!gn elija la opciOO &Ject Deslgn ComboS. · · · , .. : . : ·-~· :~ ·-,~~;'~~~;:( ;: ·. 

·. ' '' . ' ' ·:· :\'• .... :~":-)·.~:·;-~; :·!. 
• Revise las combinaciones de carga generadas bajo la lista Deslgn Coti:abQí~:i; · :·;·· :,. 

seleccionando las combinaciooes y presionando el botón SHOW. " ' · · 

• Si -"x;istc=n otras combinaciones de carga que desee Incluir en el di~o. pÜtd~ · 
agregarlas usando para ello la opción Selccl Deslgn Combos del menú Define. 

3. Inicie el D•stilcYRevisión de la es1rue1ura desde el menU Deslgn selecciooando el ftmt 'Start 
Dcsign/Chcck or Stmcturc. 

• Cada uno de los elem~ntos será disei\ado empleando la secdón más eficiente de 
entre las correspondiente a su grupo de Auto-Selección 

• El SAPlOOO mostrará automáticamente el porcentaje del nivel de esfuerzoS existente 
en cad .• elemento con relación al mhimo esfuerzo admisible. ~ 

• Para m.:~yor comodidad el programa asignar6 colores a cada uno de los element~, los 
cuales muestran el nivel de esfuerzo presente en cada miembro usando una escala 
gráfica de colores/esfuerzos ubicada en la pane inferior de la ventana. 

NO( a: Si desea t~erijieQr ti dUeño tú un número tkttrmlnado tú 
'ltm~ntor, podrd rtalitarl.o simplemente con ukcclonar/os 7 l}t:ular 
la opcldn Start !Hslgn!Chuk of Structurt. 

Revisión de los ResuHados y Rediseño 
Una vez deauado el Diseñ~Yisión es tiempo de verificar si los resultados son! ~~os. 
SAP2000 trind.1 al USlW'io una serie de herramientas pm ello. 

l. Haga click con el botón derecho del mouse sobre cualquier elemento para ver los 
resultados de su diseño. El elemento que haya sido seleccionado parpadear6 para su f4dl 
identificación. 

2. En la plamilla Steel Stress Check tnrormatlon encontrar6 una lista de lu 
combinaciones de carga emplt:adas para verificar la sección en varios puntos ato lqo 
del elemento. (Ve.a Figura 4-5) 

• Una de las combinaciooes de carga estart resaltada cuando abra estA plantilla. Esta 
es la combinación que control:~ el diseño del elemento. 

• Junto a cada combinación de carga hay un indicador de la ubicación a lo 11{&0 del 
elemento donde fue efectuada la verificación, seguida pala relación de esfuerzo 
para la Interacción de momento y conante. 
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EJ~mplo ~ D1s.:l'lo en 1\cno de un Pónico Bidi!Jli'Dsional 

SugcrenciJ.: Se puede cambiar el mi mero de puntos a le! largo del 
cl.:mcnto en los cuales lat futr;_ns de sección son reportadas. Para 
elln seleccione Jos rlcnuntos y 41esde ti mtnú Assign tfüa la opci6n 
Framt Output Stgments para cambiar ti número dt segmentos. Es 
nctnario ejecutar nue~amente el análisis del modelo para obten u 
/os rtsulJados 

SeleccJOníllldO cualesquiera de las combinaciones de carga y presionando el botón De taOs se 
mamarán los result.1dos del análisis para ese elemento así como las ecuaciones que gobiernan 
~u d1seño dr acuerdo al c<X!1go emplear1o. (Ver Figura 4-6) 

Al presionu d bocón ReDeslgn se presentará la plantilla Element Overwrlte Asslgnment.s. 
En esta rlanlilla se puede elegir de enue varias opciones: 

N m a: Si u efectúan cÍJmbic;s en la plan# !la Eltment OYtrwn.tt 
Auignmtnt.s empleando ti botón ReDesign, .será necesario prr!slonar 
ti bot6n Refresh Window de la barra de herramientas para ver los 
resultados del diseño actualiz.odos tn ID Jltnlana ac#~a. 

Seleccionar ona sección para ver el cambio en los esfuerzos en el elemento. 

Nota: En el modn A.uto-Stluci6n, uta stccl6n puede emplearse para 
ensambl4r una "u e va r.:at:it de rigidez si se elige ÚJ opcián "Update 
Analytir Se.:rion.s". Esto úldmo st llel'!!rá acabo una ver. que st 
e;uute nuev.Jmenlt el Diseiio/Revi5iÓn. 

Ctas:fi.:ar los elementos po1 tipo M4Jmcnt Rcslstlng Elcmcnl o Brace. 

Sobrescribir los factores de dlseño tales como longitud dectiva y la relación de 
longitud no arriostrada. 

Elija la opción Overwrlte Allowable Stresus para sobrescribir los esfuerzos 
admisibles empleados en el diseño tle la sección. 

Cuando haJia tc:nninado de modificar los parimetros de diseño presione el b:Xóa OK.. 

Nota: Al cambiar la ltifomaci6n ~.la plaratllla RtlHsltrt, <1 SA/'2000 
aulomdticamtntt rtttdculard los lf/utnos tU diseño de acu~rdo a l.a 
nutva lnfoTJnllclón y actuaUzo.rd la irifotm4ci4n tn /JJ p!IJntiUa Stetl 
Stress Checllnformadon. Para mdJ Instrucciones •obre tomo 
actualizar las secdonu parad análisis rejiira.se a la sectl6n "R•· 
AtuJUVJn.dc'~ 

S. Para usar la sección elegidl!. en el Re·Disei'\o en el Jiguientc análisis estrucru:ral, es necesario 
entrar al menú Deslrn y seleccionar la opción Update Analys:ls Sectlom. Esta opción 
reempla.z.a las secciones empleadas inicialmente para formar la matriz de rigide1. de la 
estructura, por las nuevas seccione$ dándmos mayor precisión en los cálculos. 
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Figura 4-5 Verificación de Esfuerzos en fu 1eeclonea da Acero paralu Comblnadonea d1 
Carga Eapeelficadas 
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1. 

l. 

2. 

E~mpto-4 Oi~!lo en Acero de un Pdrtlco Bldimcadocal 

1 ambié'l se pueden obse¡ var los resultado del dis.eño de manera gráfica en la pantalla. Para 
dio ingrr:sc al menú De sien y sc:leccione la opción Display Design lnfo Los resultJdos se 
mostr.uá.'l en forma gráficz en la pane infcria derecha de los dementas del pórtico. 

Nota: úu uccionts tmpúada.s In ti andJisiJ tJtru.cturtd son mostradas tn 
L1 parlt superior ir.quitrda dt cada rltmtnto. Por otra parlt, toda la 
informaci6n corrtsponditnlt at dütño dt los tltmtnlos es mostrada 
tn la partt infttior dtrtcha de Jos mismo J. 

DispbryDniQn Resulls • ,. • ' 

Figurt 4-7 Plantilla de ullda nsultadoa 

Se pueden· Imprimir los resuiLados del diseño ingresando aJ menú FUe y seleccionando la 
opc1ón Prinl Dcsign Tablcs. Para irr.pnm1r los resultados de un número limitado de 
ekmcncos, pn•ncramente selecccónelos y enseguida tfectúe la opción l'rinl Deslgn Tables. 

Edición de las Propiedades de la Sección 
En la F1gura 4-1 poirá observar que las vigas del pórtico tienen cargas conctntradas ubicadas a Jos 
tero;~o del claro. Si asumimos que dichas cargas son tran~mitidas pcr ooos miembros, entooc:es 
p.xlcmos coosiderar que las vigas timen soporte lateral en los puntos de carga. El modelo tal como 
ha s1do creado no toma en cuenta e.st~ t-echo, por lo que las vigas están sobredunensiona.d.J.s. Para 
d1~flar las Vlgas más eticientemaue se deben editar sus p-opiedades de d1scño. 

Seleccione todas las vigas de la esClJctura.. Par! ello puede usar el mcxlo de selección lntusedl.ng 
Llne Sdcct ~lode 

Desde el menú Deslgn escoja la opción ReDefine Element DtSign Data. 

En la plantilla Element Overwrlte As.slgnmenl!i seleccione el ítem Unbraced 
Length RaUo, L22 y asígnele el valor O 33. Esto introduce un sopone lateral a \u 
\ 1ga~ a cad:l !13 dd claro (arriostra miento contra el pandeo en el eje local 1-2), en 
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. · · : · ,. · .. ··:.!.~:.:>~·:;:~:i;:::~:~.,;·~4t~;r~JfH::-~i1-~: ~: 
lugar de la opción por defecto que corresponde a elementos anios~.~o ea los .2;~ ·: 
extremos. (Vea Figura 4-8) -.: ··· .: =:.:: ~;~ •~;.:;~:t.1_~¡-··¡·.';_~.,.,~~t: 

· · . · :,· :;;{'~;f~.!:·.:.·iJ\.-:·;:}.j,.!;·: ;:;:~;;N~'.· 
• Presione el botón OK luego de ingresar la nueva lnformad6n.'EI SAP2000 <• ': ·:. ··:~:· 

automáticamente efectuará el DiscñG'Revisión del modelo'á.Ctü!Üiado.~:<, ';~~ :>: ::J . '. 
3. Podrá apreciar ahora que las dimensiones de las secciones, de laS vi8~~·~ ~·~~: .' · .. :: :~_: 

Sugerencia.· Se putdt conocer el ptso tÚ la tstnJctuNJ ohttnltndo la 1Ümt1 
dt cargas nodales de los tltmentos dtl grupo BASE SHEAR. Esta 11 

una manera rápida de ver si los cambios tfectuados productn utui 
estructura más ejicienJt. Tambiln st puede obttntr. ti peso tDtal dt la 
estructura empilando ti archivo filtname.EI\0. 

Figura 4-8 Plantlllil de 5obre-escritura de par,metros de dl1eño de elemento.s tipo viga 

Re-Analizando 
El primer análisi) empleó ffopiedades de sección aproximadas para geneB la matriz de rigidez ele la 
esClJctura. Es por ello que el m:ooclo se deh:: re:~naJi.z;u- .3. m.ltlCr.!. de Wl prcuso iterativo pau 
aseguramos que el análisis toma en cuenta las propiedades y secciones actual.iz.adas de los 
elemenws. 
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'fi7" 
Una \CZ que se halla tcnmnado de mcxlirrcar las secciones estructurales que se van a 
emplear, ingrese altliCrHl lh·si~n )'clip la opción llpdate Analysis Seclions Luego 
ckctú~ nlt.:v;unenrc e! an.ílr~rs crnpk:mtlo IJs Ultima> proprcdadcs de sección 

l.lc~c J..:Jbo rnrcvJrncrrtc el drscrio de los ekrncnws para ver si hay cambios. 

Una \Cl que se tncucntrc satisfecho con ]as scccroncs cleg¡das, ingrese al menú I>eslgn Y 
clijJ IJ opcrón He place Auto...,¡ Optimal Scctlons. E~ta opción asigna \~s scccJOncs 
ddmitr\a:i )'a :::Jn las ópwnas o bien aquellas seleccionadas por cllr~uano tanto para el 
¡¡r 1 .'ilrsi~ como par.l el diseño, y rc:cmplaza las propiedades de sección preliminares 
tomadJS de= los ptrpos de auto selección DEAM y COI.l.Jh1N. 

Diseño de acuerdo al LRiiD 
(..:• mc!o..lologia empleada pcr el LRFD es esendaÍmente la misma que usa el ASO. Sin emb.vgo ~~ 
rombm:~cioncs de catgJ así como la eet•acionc:s de: verificación de los elementos son efectUadas 
empleando el cédigo LRfD, por lo que los resultados e infoonacién resuiL1nte es disunta. Para 
efectuar el Discf¡o'Revhión de acuerdo a1 códlgo LRFD, es necesario cambiar algunos parámetros 
de entrada.. 

lngre~e los nuevos factores de carga ;-arad análisis P-Delta. 

2 Sdecc10oe de la plantilla Pr~f~rtncts el Código de diseño en am-o AISC-LRFD93. 

J Railseñe las .secciones de acero 

Opciones Avanzalias 

Definición de Grupos de Elementos para el Diseño 
A1gww Vecc::i puede toCO'ltra.ft Wl esta opciOO al discdac elementos en c:sau:.turL• apcrticadas. 
Esta opción pamitc disa1ar todos los elementos de un grupo u.sando únicamente una secciOO. La 
ventaja de este mttodo de disoio es que reduo: el número de sccciooes diferentes a emplearse. Pa­
c:jemplo se pueden agrupar las columnas o las vigas de ~ o lfFS pisos de) pOOic:o dentro de un 
mismo grup.:~ de di solo, pcrmititndcnos u.w una sola sección~ dkho ron junto de elementos. 

l. Rusigne las secdooes del tipo Al.ll0-Selecci6n altll clanm1Cd del pático. 

2. Agrupe: los tlanauos del 3cr piso hacia abejo en un grupo dcnmúnado BOlTOM 

3. Agrupe: los ~lementos entrt: los pisos 3 y S 01 un grupo llamado MIDDLE. 

4. As1gne los ekmaltos restante al grupo TOP. 

4~ SAP2000 Gula de Ap!'eadaa¡e 
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6. En el m.:nú Oc:.ign sek.ccwnl" la ~00 Seled ~gn Group En esta parte se le indica a! 

prog:rarna que se disefle 11n grujXl de elementos empl~do [J. seo:iOO mis. ligo-a que satisfaga 
los requerimientos y esiucnos admisibles en tOOos 1~ elementos. · 

Incluya en la hsta Deslgn Grm1ps los grupos de elementos TOP, MIDO LE y 
DOITOM Al hJ.ccr es tú indicamos que es! os grupos serán diseñados con la sección 
mL efiCiente de las secciones del grupo Auto-Selección. 

Nota: Si 110 hay grupos tn la lüta 11Dtsign Group /ist", Cllda uno dt los 
eltmcntos de 1.4 estructura serán diseñados in&.,idualmentt. 

Cuando presione el botón OK. El SAP2000 automáticamente diseñar! las secciones 
de acero y mostrará Jos resultados en la ventana acti\'a 

7. Compare Jos resultados del diseño anterionnaue efecruado coo el diseño pcr grupos pan ver 
como afectZ este hecho en las secciones seleccionadas. 

Zonas Rígidas 
La estruCtura que hemos venido esrudiando, ha sido analuada y diseñada ronsideraOOo que Jos 
elementef: se e ... tienden romplet..amcrJie dL nudo a nudo. sin tonur 01 cu01tala.s diwatsil.lles propias 
de las secciones transversales de los e!.:mentos. Si bia-~ es cierto que ~S'<~ no r.s Wla mala 
ronsiderad6n, ~1 SAP2000 pomite ~fectwlr análisi$ au11 más p-ecisos m~diante la ln:-roducdón de 
zonas rígidas en el mcxlr.lo. I .as zooas rígidas dCfinen una regiOO 01 la cooexiál enrrc viga y 
columna, en la cual los elementos no sufr01 defamaciooes poc flex.iOO. Se genera as( estncialmcnte 
una zooa rígida 01 la cooexiOO. Esta área puede s-er tan grande oomo el u.uwio especifique, pero 
usualmaue se coosidera igual al peralte del ntim1tro (o una fracción dd mismo) al que se esta 
Jlegmdo en ese nudo 

l. Selecciooe tcdcr.los elementos del p(rtico.. 

2. Del merad Ass:lgn seleo..:iooe la qx::iOO Frame .•• End Ofbet!C. 

En lA plantilla F.nd orrset seleccione la opc:iÓO Update Leartlu From Curnnt 
Connecthity. Esta o¡>eión hace que el programa calcule automáticamente las 
dimensiones de las lonas rígidas a considerarse en cada nudo. 

• lngrese el valor 1 pant RleJd Zone Factor. Esto significa que el lOO% de la 
''longitud potencial" de. zooa rfgida. deber.f considerarse en el an.t.lisis. 

" Presione el bocón OK. 

3. S¡ ,. especifica l! opciln Elemrnt Sbrlnk de la plantiUa S.t Elemcnll, y oe obscna en la 
pantalla aaiva, sr. pcdrá apreciar una s=rie de: Hneas en carla nudo que indican la asignarión de 
zooas tig1das en 1~ elementos. 
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EJemplo -4 Di~~o en Acero de un P~co Bid1~ndo.W 

Recuerde: St necesita restablutr l.a opcl6n End Offsets cada Vtt que lm 
seccionu de Jos l'fcmentos uan modijicadns. 

Nota: Los momentos y cort4ntts '"las vigas y column~ van a ltr 
/Jgtramttllt difuenres en aquellos casos en los que no u toman en 
ettenfa las z:ouas n"gitúu. Esto se ddt a que In Introducción de las 
mismas reduce la longitud flexible dt los tltmentos. 

Comentarios Finales 
L.n ht.íi.UIJJall.l-~ de dLs.ei10 del SAP2000 son muy útiles m el diset'io de estruCtUraS apcrticadas. Sin 
4:mb..1rgo hay algtuJOS punte!!> que se dclxn tener presentes 

AscgUrc:::.c que 10Ja la in'formaclón de diseno sea correcta. Los valores por defecto que 
usa el progr;nru no son necesariamente los correctos (p ej. K y Longitudes no 
Amostradas de los clemcnws). Se puede usar la plantilla Display I>eslgn Rtsull5 para 
ver esta mformactún en los elementos dd pómco De manera conveniente, es posible 
aprccta.r el análisis de IJs secciones al mismo Liempo que la información del diseño. 

2 Venftqu~ que las cornbinaciooes de carga de diseño que el programa ha proporcionado 
sean lls coructa) y adecuadas para cllipo de estructura en particular que se este 
aMJtzando. Sin no lo :::m, Jñ¡.Ja :Js combinaciones de carga que desea utilizar en el 
'~o.icño 

3 VertfLque los resultados del diseño en puntos claves, para asegurarse que los re~ult.ados 
dd dtscño guardan re\aciJn con los resultados esperados. 

4 Verifique. que los facwres de carga en el análisis P-Della son los correctos. 

5. Rcdisclie la estructura toda vez que efectúe cambios en el modelo. Esto pemúte ver si las 
secciones empleadas son aún aceptables. 

6 Emplee grupos de elementos para determinar el peso total de la estructura.. (Revise el 
Ejemplo 1 pJJa tener instrucciones de como efectuar este paso) 

7 Emplee grupos de e\ementr>s en el dis~:ño para reducir el número de )M diferentes 
secciones a utilizarse en la e!>lnlctura. 

8. El archivo fil!!nat1U' .EKO comiene la información del peso total de cada uno de laJ 
secctones (perfiles) empleadas en el dtseño. Esta información nos permite estimar costos 
de una nuncr01 prdiminar. 
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Apéndice A- Descripción ele los Iconos de la Barra de Herramientas . 
Icono Nombre del Cormul Pem1it.: 
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DISCLAIMER 

CONSIDERABLE TIME, EFFORT ANO EXPENSE HA VE GONE INTO THE 
OEVELOPMENT ANO OOCUMENTATION OF SAP2000. THE PROGRAM HAS 
BEEN THOROUGHL Y TESTEO AND USEO. IN USING THE PROGRAM. 
HOWEVER, THE USER ACCEPTS AND UNDERSTANDS THAT NO WARRANTY 
!S EXPRESSEO OR IMPLIEO BY THE OEVELOPERS OR THE DISTRIBUTORS 
ON THE ACCURACY OR THE RELIABILITY OF THE PROGRAM. 

THE USER MUST EXPLICITL Y UNOERST ANO THE ASSUMPTIONS OF THE 
PROGRAM ANO MUST INOEPENDENTL Y VERIFY THE RESUL TS. 



A. Introduction 

This tutorial is quite detailed. lt is intended to introduce and demonstrate many ofthe capabilites 
of SAP2000. Beca use we are trying to demonstrate as many different capabilities as reasonable, 
the example problem is not necessarily created and the results are not necessarily reviewed in the 
most efficient and expedient manner. Often with computer programs, what is efficient for one 
person may not be the best method for the next person. It is assumed that once introduced to the 
SAP2000 capabilities and methods in this tutorial, users will decide which methods work best for 
them in their particular circumstances. Following is an outline ofthis tutorial (see the Table of 
Contents for a more complete outline): 

A. Introduction 

B. Description ofBuilding Model 

C. Tutorial Part 1 - Creating and Analyzing the Basic Model 

D. Tutorial Part 2 - Pushover Analysis 

E. Discussion of Additional Pushover Cases 

Ifyou are not interested in the pushover portian ofthe tutorial, you can skip parts D andE. 

If yo u are only interested in the pushover tutorial, then yo u can read parts A and B, skip part C, 
and then open the already created model (without the pushover data) named Sapwbülc.sdb, 
which is supplied with this tutorial, and start with Step D. 

Note: You must have SAP2000 Version 6.20 or later to readfiles SapwbOic.sdb and 
SapwbO 1 d.sdb. These files are no/ compatible with earlier versions of SAP2000. 

Finally, if yo u are not interested in working through the tutorial at this time, but want to see the 
results of the pushover analysis, then yo u can read parts A and B, skip part C and the frrst five 
steps ofpart D, and then open the already created model (with the pushover data) named 
SapwbOld.sdb, which is supplied with this tutorial. You should then run the linear static and 
dynamic analysis by clicking Run on the Analyze menu. Next select Run Static Pushover from 
the Analysis menu to perform the pushover analysis. The results are now ready for viewing. See 
steps 6, 7 and 8 in part D for information on viewing results. See part E for additional discussion 
ofresults. Note that for real problems (as contrasted with tutorial problems) you should always 
run and review the results ofa basic static analysis (and maybe also dynamic analysis, at leas! for 
mode shapes) to verify that your model is behaving as yo u intend. 

SAP2000 has extensive online help that can help answer many ofyour questions. One ofthe 
most useful ways to access the online help is to press the Fl key on the keyboard from within 
most dialog boxes. Pressing the Fl key will bring up context sensitive help pertaining to the 

SAP2000 Web Tutoriall 1 



dialog box that is open. You may fmd it useful to use this option throughout this tutorial to get 
more information. 

If yo u require further technical assistance conceming this tutorial, or other aspects of SAP2000, 
you can contact CSI byphone at (510) 845-2177, or by e-mail at support@csiberkeley.com. 
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B. Description ofBuilding Model 

The example problem for this tutorial is a steel-frame building two bays wide by two bays deep. 
and two stories high. The plans and elevation in Figure B-1 show the basic dimensions and 
member sizes for the model. The building has a moment frame lateral force-resisting system in 
the X-direction anda braced frame lateral force-resisting system in the Y-direction. All steel is 
Fy = 36 ksi. The second !loor is concrete over metal deck, and is assumed to be a rigid 
diaphragm in the model. The roof deck has no concrete, so it is not modeled as rigid. 
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Figure B-1: Example Building Plans and Braced Frame Elevation 
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Figure B-2 shows perspective views ofthe cornputer rnodel that include joint la beis and frarne 
elernent la beis. Figure B-3 includes plan views ofthe cornputer rnodel with frarne elernent 
labels. Note that the infill bearns are not specifically included in the cornputer rnodel. These 
figures rnay be useful for reference when you are working through the tutorial. 

20 

1 1 14 ' 

z 

Perspective View Showing Joint Labels 

16 

Perspective View Showing Frame Element La beis 

Figure B-2: Views ofCornputer Model Showing Joint and Frarne Elernent Labels 
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Figure B-3: Plan Views ofComputer Model Showing Frame Element Labels 
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The following assumptions are used for dead and live loads: 

Roof: 

Second Floor: 

Perimeter Wall: 

DL =40 psf 
LL = 20 psf 

DL= 80psf 
LL =50 psf 

DL=20 psf 

These loads are assumed to include the self-weight ofthe structural elements. Figure B-4 shows 
the beam span loads that are applied to each beam in the SAP2000 model. 

Roof Beams 39, 40, 51. 52 

0.40 k1fDL 
0.12 k1fLL 

~l l l l l l l l~ 

Roof Beams 41144,42, 47/50, 49 

5.76 k DL 

0.16 k1fDL. 2"88 k LL 

Roof Beams 45, 46 

0.48 klfDL 
0.24 klfLL 

RoofBeams 43,48 

11.52 k DL 
5.76 k LL 

Second Floor Beams 14, 15. 24, 25 

0.72 k1fDL 
0.30k1fLL 

Second Floor Beams 16, 18. 21.23 
11.52 k DL 

0.24 klfDL 7.20 k LL 

Second Floor Beams 19. 20 

0.96 klfDL 
0.60 klfLL 

Second Floor Beams 17, 22 

23.Q4 k DL 
14.40 k LL 

Figure B-4: Beam Soan Loads U sed In SAP2000 Model 
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For this model, all mass is input at the joints. Table B-1 defines the joint masses used in the 
model. The bottom portian of the table defines the mas ses, the top portian of the table defines 
which joints are referred to as the center, comer and edge joints. Note that no mass is assigned 
to joints 22 and 26 at the rooflevel. These are the joints at the top ofthe chevron braces. 

Joint La beis at Center, Edge and Comer Joints 
Leve! Center Joint Edge Joints Comer Joints 
Roof 24 20,23,25,28 19.21,27.29 

Second 14 11,13,15,17 10. 12, 16. 18 

Joint Masses at Center, Edge and Comer Joints (k-sec2 1 ft) 
Leve! Center Joint Edge Joints Comer Joints 
Roof 0.72 0.48 0.30 

Second 1.45 1 0.90 0.55 

Table B-1: Joint Masses Used In Computer Model 

The lateral earthquake loads are assumed to be 17 kips (0.0074ksf) at the roof leve! and 16 kips 
at the second leve! for the X-direction (moment frame direction), and 26 kips (0.0 113 ksf) at the 
rooflevel and 23 kips at.the second leve! for the Y-direction (braced frame direction). These 
forces are assigned as shell static uniform loads at the roof leve! andas joint Ioads at the second 
leve!. The second leve! f9rces are broken down into joint loads as shown in Table B-2. 

Joint Loads at Center, Edge and Comer Joints (k) For Second Leve! 
Earthquake Center Joint Edge Joints Comer Joints 

- Direction 14 11,13,15,17 10, 12, 16, 18 
EQX 2.67 2.00 1.33 
EQY 3.83 2.88 1.92 

Table B-2: Joint Forces U sed In Computer Model For Static Earthquake Loading At Second 
Floor Leve! In X and Y Direction 
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C. Tutorial Part 1 - Creating, Analyzing and Designing the Basic Model 

This tutoría! steps through setting up the model geometry both from a built-in template (step 1 a), 
and from scratch (step 1 b). lt is not necessary todo both ofthese steps, in order to complete the 
tutoría!; one or the other is sufficient. However, it may be helpful to see the process and 
techniques used 'in completing both steps. We recommend that to obtain additional inforrnation 
during the course ofthis tutoría! you refer liberally to the online help available in SAP2000 by 
pressing the Fl key from within almost any dialog box to obtain context-sensitive help. 

Step la: Setting Up the Model Geometrv From a Template 

l. Click the drop down box in the status bar to change the units to kip-ft. .JKlp-tt ::J 

2. From the File· menu select New M o del from Template .••. This displays the Model 
Templates dialog box. 

3. In this dialog box: 

• Click on the S pace Frame template. 
dialog box (see Figure C-1). 

,. 

• In this dialog box: 

, .... ;,'FR .. , .. oo··· :E!E· ;m· ' ..--.+-. . . . . . ·. - ' . . . -- - . ' -- - . . . 

; Fm .1"19'm r'Tí1!l .·• ~. ·f1R\ . .t111l.L .t:t!l!.l . ~ 'Qjj) 

ffffiÍ . ·¡ -·-' .t111l.L . 1 ,...ci'lltill*'o>C 

107 "-.U .

1

; ..._atB.-*'oY 

107' (;,rdr., Sa,.H.vt . 
lfl'lllllh-.,x· · 

i a. wdh llona '1' . 
·;. '. .. 

Figure C-1: Space Frame Dialog Box 

.,' Change the Number of Bays a long X to 2. 
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../ Check the Restraints box if it is not already checked . 

../ Check the Gridlines box if it is not airead y checked . 

../ Accept the remainder ofthe default values . 

../ Click the OK button. 

4. The screen will refresh and display a 3-D anda 2-D (XY Plane@ Z=24) view ofthe model 
in vertical! y tiled adjoining windows. 

f .. ldl Y.- ~ D1- }*:t ~ ~ ~ OIIVl ~ ti• · · 

Dlr#llill ~HLJ~....tl PII'IJBIJBifllll'lll" •• R- ... ·!'lllliill.!.l!J .:.III..;.I.ti .... l,¡¡¡l:-º1 .-, 
SJ X Y PI- @1 Z-24 .. r.JE'J 

Figure C-2: Initial Screen From Space Frame Template 

5. Note that the default restraints provided when the Restraints box is checked in the Space 
Frame dialog box are pinned supports. 

6. Click in the window labeled X-Y Plane @ Z=24 to make sure it is active. Note when the 
window is active, its title bar will be highlighted. 

7. Click the yz 2D View button ~ on the rnain toolbar to change the view toan elevation in 
the YZ plane. Note that the tille ofthe window reads YZ Plane@ X=24. This same title 
also occurs on the left-hand side ofthe status bar at the bottom ofthe SAP2000 window. 

8. Click the rooflevel beam on the left side ofthe elevation to select it. From the Edit menu, 
click Divide Frames ... to display the Divide Selected Frames dialog box. 
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9. Accept the default values in this dialog box and click the OK button. The roofbeam is 
divided into two beams, thus providing a node for the top ofthe chevron brace. 

10. Click the Draw Frame Element button gr~J on the side toolbar, or select Draw Frame 
Element from the Draw menu. The pro is now in Draw Mode. 

Note: Jfyou hold the pointer over a too/bar buttonfor afew seconds, a text box 
including the na me of the button wi/1 appear. 

11. Make sure that the Snap to Joints and Grid Points button .1-+• .:1 on the side too! bar is 
depressed. Place the mouse pointer on the joint labeled "A" in Figure C-3 and click on the 
left mouse button. Note that when the mouse pointer is near the joint, it snaps to the joint, 
anda text box that says "Grid Intersection" appears. This is the effect ofthe Snap to Joints 
and Grid Points feature. 

Note: Other snap options included in SAP2000 include Snap to Midpoints and Ends, 
Snap lo Element lntersections, Snap to Perpendicular, and Snap to Lines and Edges. 
The buttons for these features are located on the si de too/bar just be/ow the Snap to 
Joints and Grid Points button. Note that al/ of the snap features can al so be 
accessed through the Snap To ••• option on the Draw menu. For more informa/ion on 
the snap capabilities of SAP2000, refer to the topic titled Snap Tools in the SAP2000 
on/ine he/p. Click on the Help menu and select the Search for Help on ... option to 
access the online help in SAP2000. 

fill .Edl Y- o-. o,.., jeMd ~ ~ Qllcllw [)ao!. C... ~ , , · 

D 1~1 ~1 ~ _Lj ~ __!.] Pl.eiJIIIJiiJólli!!il ,., .. 1 R i .. INI ~>llllll ihJ .:.1 Íl..:..l;; I..LI~I.QJ 
_.,:·-. _.·· 

j
Fo 

• 
• 
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Figure C-3: Joint Labe1s For Drawing Chevron Brace 
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12. Place the mouse pointer near the joint labeled "B" in Figure C-3 and note that in this case the 
Snap To option text boxjust says "Point" because the joint does not occur ata grid 
intersection. Click on the left mouse button to draw the chevron brace element. 

Note: If yo u wanted to, at this point you couldjust click on point C in Figure C-3 to 
draw the second brace element. lfwe were todo that, the start pointfor the brace 
would be at the top (point B) and the bottom point would be at the bottom (point C). 
Though not necessarily a problem, this would be inconsistent with how we input the 
first brace. In this example we will opt for consistency. 

Note: lf yo u wanted ro, at this point yo u could m ove the m o use pointer into the 3D View 
window. and select the second joint for the next frame element there. Try moving the 
mouse pointer over the 3D View window, but for this example don 't actual(v click ro 
define the secondframe member. 

13. Press the Enter key on the keyboard to stop drawing the second frame member. Note that the 
Draw Frame Element button is still depressed, i.e., the program is still in Draw Mode and 
ready to draw another frame element. 

14. Click on the joint labeled "C" and then the joint labeled "B" in Figure C-3, and then press the 
Enter key on the keyboard to draw the second chevron brace member. 

15. Click the Quick Dráw Frame Element button ,,.1 on the side toolbar. Then click in the 
area labeled "D" in Figure C-3 to enter the X-braces. The model now appears as shown in 
Figure C-4. 

Note: The X-braces could also have been entered using the same technique that was 
· employed for the chevro~ braces. 

Note: Both the Draw Frame Element and the Quick Draw Frame Element options are 
also available on the Draw menu. 

Note: The Quick Draw Frame Element option works two different ways. You can c/ick 
on a grid segment to quickly draw a single frame element between the two adjacent 
perpendicular grid fines. Alternatively, you can click in a space bounded by four grid 
fines to quickly draw a cross braceas was done here. 

16 Click the Down One Gridline button 1 ~·~ on the main toolbar twice to display the YZ 
elevation at X=-24. Note the window title changes to Y-Z Plane@ X=-24. The model 
appears as shown in Figure C-5. 

17. We will use a different method to locate these chevron braces. Click the Snap to Midpoints 
and Ends button ~ to activate this snapping option. Click the Draw Frame Element 
button 'Ion the side toolbar, or select Draw Frame Element from the Draw menu. The 
program IS now in Draw Mode. 
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W SAP2000 IUrohtlcdl 1!1~ I:J 
r- Ec1t ~- D.*- o,_ Sa.ct ~ ~ ~ 0ew1 ll,Dbon. üeiP _ 
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·--:- .. -.· · .. -·•· ·.-: 

Figure C-4: Model After In¡mtting First Set ofBraces 
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Figure C-5: Model Ready To Draw Second Set ofBraces 

SAP2000 Web Tutorial 1 12 



( 

18. Place the mouse pointer on the joint labeled "A" in Figure C-5 and click on the left mouse 
button. 

19. Move the mouse pointer over to the center ofthe beam element at the point labeled "B" in 
Figure C-5. When the Snap To feature text box appears saying "Midpoint" click the left 
mouse button to input the brace element. Then press the Enter key on the keyboard. 

20. Click the Snap to Midpoints and Ends button ~ to deactivate this snapping option. 

21. Click on the joint labeled "C" and then the joint labeled "B" in Figure C-5, and then press the 
Enter key on the keyboard to draw the second chevron brace member. 

22. Click the Quick Draw Frame Element buttonra~~ on the side toolbar. Then click in the 
area labeled "D" in Figure C-5 to enter the X-b . 

23. Click the Pointer button · ~ 1 to exit Draw Mode and enter Select Mode. 

24. Click the roofbeam at the top ofthe braced frame to select it. Also click the joint at the top 
ofthe chevron brace (center ofbraced frame roofbeam) to select it. 

25. From the Edit menu select Divide Frames .•• to display the Divide Selected Frames dialog 
box. 

26. In this dialog box: · ;; 

• Select the Break At Intersections With Selected Frames and Joints option. 

• Click the OK button. 

Note: This completes inputting of the frame element geometry. Now we will input shell 
element geometry. We will use she/1 elements to model the roof diaphragm. We will 
demonstrate three dijferent options for inputting the shell elements. 

27. Click the xy 2D View buttonl~ on the rnain toolbar to change the view toa plan in the 
XY plane. Note that the tille ofthe window reads XY Plane@ Z=24. 

28. Click the Quick Draw Rectangular Shell Element button 01 on the side toolbar (or select 
Quick Draw Rectangular Shell Element from the Draw menu). 

29. Click in the area labeled "A" in Figure C-6 to input the frrst shell element. Note that a quick 
Shell element is drawn by clicking in a grid space, bounded by four grid lines. 

30. Note thatjust the outline ofthe shell element is shown. Sometimes when working with shell 
elements it is easier if yo u can view the shell element filled in. Click the Set Elements 
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buttonl-ª_j on the main toolbar (or select Set Elements ... from the View menu). This 
displays the Set Elements Dialog box. 

31. Check the box labeled Fill Elements and click the OK button to display the shell elements 
tille d. 

32. Click in the area labeled "B" in Figure C-6 to input a second shell element. Note that this 
element will be reshaped in a subsequent step. 

33. Click the Draw Rectangular Shell Element button: lijllon the side toolbar (or select Draw 
Rectangular Shell Element from the Draw menu). ake sure that the Snap to Joints and 
Grid Points button 1-+• .1 on the side too! bar is selected ( depressed). 

m SAP2000 IUnl•llo:tll .. (il El 

fia Ecl ~- Qllh D¡• ~ é1191 ~ ~ O.., gpacn. ij11p _ . . •· 

D liá:l gl ~ .lJ ~...!] PI.IÍI.Siiil~lfilil wl.,l;; 1 ;;'li;-1.~~¡-~~·1 +1:0 1 if:r f:;.,I!-I.L!..i.ii-ºJ ,¡; 

E F 

H A 

G 

e 

B 

D 

. . ·-. ·. ··' ........ . 

Figure C-6: Shell Element Input 

34. Click on the point labeled "C" in Figure C-6 and then click the point labeled "D" to input the 
next shell element. Note that a rectangular Shell element is drawn by clicking to define two 
comers that are diagonal! y opposite of each other. 

35. Click the Draw Quadrilateral Shell Element button; r:} 1 on the side toolbar ( or select 
Draw Quad SheU Element from the Draw menu). 

36. Click on the points labeled "E", "F", "G" and "H" in Figure C-6, in that order, to draw a 
quadrilateral shell element. 
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37. Click on the points labeled "H". "G'', "C and "H" in Figure C-6. in that order. to dra\\" a 
triangular shell element. 

N01e: She/1 elements may be either four-sided. or three-sided. In general.four-sided 
elements are recommended. 

38. Click the Reshaper button -r 1 on the side toolbar (or select Reshape Element from the 
Draw menu). 

39. Click once on the shell element in the lower right-hand comer (drawn in item 29 in the area 
labeled "B" in Figure C-6) to highhght it. Note that member end handles appear on the shell 
element as shown in Figure C-7. 

Jii5AP2000 (U..Uiedl I!!ISEI 

··-. .... 
\ 1 

~/ 

Figure C-7: Reshape Shell Element 

40. Click on the point labeled "A" in Figure C-7, and while holding down lhe left mouse button, 
drag lhe member end handle lo point "B". 

41. Click lhe Refresh Window button P ; on the main loolbar ( or selecl Refresh Window 
from lhe View menu) lo see lhe resulls ofreshaping the element. 

42 .. Click lhe Draw Quadrilateral Shell Element button C7l on lhe side loolbar (or selecl 
Draw Quad Shell Element from the Draw menu). Then click on the points labeled "C", 
"A", "B" and "C" in Figure C-7, in lhat order, lo draw a triangular shell element. 

43. Click the Pointer button J:Ll lo exit Draw Mode and enter Select Mode. 
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44. Now we will retum the shell element view to unfilled elements. Click the Set Elements 
button ~~ on the main toolbar (or select Set Elements ... from the View menu). This 
displays the Set Elements Dialog box. 

45. Uncheck the box labeled Fill Elements and click the OK button to display the shell elements 
not filled. The display should appear as shown in Figure C-8 . 

• SAP200D -IU....u.dl I!!II!ID 
file E~ Y- Qcme 0¡...,. jelod: ~ ~ Q...., DC9 .Qpaano l:itlll 

Dl~lliii~L.UJ~.L..J PIJ8I.I!li.®I.E>Il'lll,..l~l~l"l"'"l ~>il!!l~ ~lrl-1-· H..:.,I.QJ 

-~--------~----- ---------· 

.... r . 

• y 

----· __ ___.l.____,.>:- ~: ... ----

• 

~--·------~ --------·-

Figure C-8: Model With All Geometry Input 

46. From the File menu choose Save and input a new name to save your file. 

Note: Iris a good idea ro save your file afien. 

This completes the input of the model geometry. Now yo u can do one of the following: 

• If yo u started the model from a template, and do not want to try starting the model from 
scratch. then skip to Step 2. 

• lf yo u started the model from a templa te and now want to try starting it from scratch, then 
continue on to Step 1 b. 

• If yo u started the model from scratch, and do not want to try starting the model from a 
template, then skip to Step 2. 
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• If yo u started the model from scratch, and now wantto try starting it from a template, 
then retum to the beginning of Step 1 a. 

• If yo u wantto stop working on the tutorial for now, and close SAP2000, rnake sure that 
you have saved your file as outlined in item 46, and then from the File menu select Exit. 
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Step 1 b: Setting Up the Model Geometrv From Scratch 

This tutorial steps through setting up the model geometry both from a built-in template (step la), 
and from scratch (step 1 b). It is not necessary todo both ofthese steps in order to complete the 
tutorial; one or the other is sufficient. However, each ofthem has sorne unique inforrnation. 

l. Click the drop down box in the status bar to change the units to kip-ft. IKJp-ft ::J 

2. From the File menu select New Model .... This displays the Coordinate System Definition 
dialog box. 

Cmxd~nate Srstem Delln•hon 3. In this dialog box: 

C.lesian C,.raical 

• Select the Cartesian tab. 
S.rat~~m Na.e IGLOB>-'-

1 

Number ol Srid Spacea 

1 X árection 12 
1 

Y ciection 14 ! 

• Set the Number ofGrid S paces in X direction to 2. 

• Set the Number of Grid S paces in Y direction to 4. 

Z ci'eebon 12 
• Set the Number of Grid S paces in Z direction to 2·. 

6rid Spocing 

X cirection 124 • Set the Grid Spacing in the X direction to 24. 
Ychclion 112 
Z árection 1,~ • Set the Grid Spacing in the Y direction to 12. 

• Set the Grid Spacing in the Z direction to 12. 
OK Cancel 

• Click the OK button to accept the grid defmition. 

4. The screen will refresh and display a 3-D anda 2-D (XY Plane@ Z=24) view in vertically­
tiled adjoining windows. 

5. Click in the window labeled X-Y Plane@ Z=24 to rnake sure it is active. Note when the 
window is active, its title bar will be highlighted. 

6. Click the Quick Draw Frame Element button ' ' on the side toolbar ( or select Quick 
Draw Frame Element from the Frame menu). 

Note: lfyou hold the pointer over a too/bar buttonfor afew seconds, a text box 
including the na me of the button wi/1 appear. · 

7. In the window labeled X-Y Plane@ Z=24, to entera beam element click on a grid line. The 
Quick Draw Frame Element too] will then create a beam element on that grid line spanning 
between the closest perpendicular grid lines on either side ofthe point where you clicked. 
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Thus click the ten locations designated by anO in Figure C-9 to draw sorne ofthe rooflevel 
bearns. 

f• ¡cit Y- .Q ... O¡.,. i*:1 ~ ~ ~ D•;:;- ~ ~ 

Di<ii']¡;r] +·l.l.J~j_..J P!~I.~B!Ii>I.É>Ii!'il ,.¡.]a!"l"'l ~,¡¡.,¡~ .:.]I].;;,].'I~!.:.;].Qj 
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Figure C-9: Ouick Drawing RoofLevel Bearns 
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Note: Jf yo u miss slightly when clicking on a grid /in e, the program m ay assume yo u were 
attempting to input two diagonal broces in_ the bay bounded by the grid /in es. Jf this 
happens, simply click the Undo button ~ on the main too/bar twice, or select Undo 
Frame Addfrom the Edit menu twice. 

8. Click the Draw Frame Element butt~n. ,., on the side toolbar. The program is now in 
Draw Mode. 

9. Make sure that the Snap to Joints and Grid Points button 1_-+~ .1 on the side too! bar is 
depressed. Place the mouse pointer on the joint labeled "A" in Figure C-1 O and click on the 
left mouse button. Note that when the mouse pointer is near the joint, it snaps to the joint, 
anda text box that says "Grid Intersection" appears. This is the effect ofthe Snap to Joints 
and Grid Points feature. 

Note: Other snap options included in SAP2000 include Snap to Midpoints and Ends. 
Snap to Element lntersections, Snap to Perpendicular, and Snap to Lines and Edges. 
The buttons for these features are /ocated on the side too/bar just below the Snap to 
Joints and Grid Points button. Note that al/ of the snap features can also be 
accessed through the Snap To ••• option on the Draw menu. For more information on 
the snap capabilities ofSAP2000, refer to the tapie titled Snap Too/sin the SAP2000 
on/ine he/p. C/ick on the Help m en u and select the Search for Help on ••. option to 
access the SAP2000 online he/p. 

lO. Place the mouse pointer near the joint labeled "B" in Figure C-1 O and Click on the left mouse 
button to draw the roofbéam element. 

Note: We cou/dn 't use the Quick Draw Frame Element too/ to draw this beam because 
the beam crosses a grid line. 

11. By default the program is now ready to draw another frame element starting from point "B". 
Press the Enter key on the keyboard to stop from drawing the second frame member at this 
location. 

12. Place the mouse pointer on thejoint labeled "C" in Figure C-10 and click on the left mouse 
button. Click in sequence on joints "D" and "E" and then press the Enter key to draw the 
next two roofbeams. 

13. We will now edit the grid lines so that we can use the Quick Draw Frame Element too! to 
enter the last roofbeam that will span from point "F'' to point "G" in Figure C-1 O. 

14. From the Draw menu select Edit Grid •••. This displays the Modify Grid Lines dialog box. 

15. In this dialog box: 

• Click the Y option in the Direction area .. 
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•. Highlight -12 in the Y Location Jist box and click the Delete Grid Line button. 

• Highlight 12 in the Y Location list box and click the Delete Grid Line button. 

• Click the OK button. 

16. Click the Quick Draw Frame Element button ' ' on the side toolbar ( or select Quick 
Draw Frame Element from the Frame menu). 

17. Click on the grid line between points "F" and "G" in Figure C-10 to enter the last roofbeam. 
The model now appears as shown in Figure C-11. 

m s"P200o run~:.tledl R~EJ 

rm .tdl ~- Qlll'n o,_ s-t éavl ~ D-. o.. JlgQr:n ti~$ 
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., 
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Figure C-11: Model After All RoofLevel Beams Have Been Drawn 

18. Select all ofthe rooflevel frame elements andjoints in the X-Y Plane@ Z=24 by 
"windowing." Todo this: 

• Click the Pointer button JiJ on the side toolbar to a~tivate the Select Mode. 

• Move the pointer above anci to the left ofthe frame elements and joints. 

• Click and hold the left mouse button. 

• 

• While holding, move the pointer below and to the right ofthe frame elements and joints. 
A "rubber-band" window will show the region selected. 

SAP2000 Web Tutoriall 21 

··:-: 
·.,; 



• Release the left mouse button to select all elements in this window. 

19. From the Edit menu, choose Copy. 

20. From the Edit menu, choose Paste. This will display the Paste Coordinates dialog box. 

21. In this dialog box input O for Delta X, O for Delta Y and -12 for Delta Z. 

22. Click the OK button and the geometry for the roof leve! is copied to the second leve l. 

23. Click the Down One Gridline button 1 <7 ., on the main toolbar to display the plan view at 
the second floor leve!, Z=l2. Note the window title changes to X-Y Plane@ Z=12. The 
model now appears as shown in Figure C-12. 
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Figure C-12: Model After All RoofLevel Beams Copied To Second Leve! 

Note: The second leve/ beáms at the braced frames do not need a joint at the center to 
receive a brace. Thus we will delete the center joints. 

24. Click the second leve! bearns labeled "A" and "B" in Figure C-12 to select them. 

25. From the Edit menu select Join Frames to combine these two elements into a single element 
and remo ve unused joints left o ver from the joining process. 
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26. Click anywhere on the combined frame member to select it. Note that the entire member is 
highlighted thus verifying that the members ha ve been joined. 

27. Click the Clear Selection button ~ 1 on the side toolbar ( or select Clear Selection from the 
Select menu) to deselect the beam. 

28. Click the second leve! beams labeled "C" and "D" in Figure C-12 to select them. From the 
Edit menu select Join Frames to combine these two elements into a single element. 

29. Click in the window labeled X-Y Plane@ 2=12 to make sure it is active. Note when the 
window is active, its title bar will be highlighted. 

30. Click the yz 2D View button ~ on the main toolbar to change the view to an elevation in 
the YZ plane. Note that the title ofthe window reads YZ Plane@ X=24. This same title 
also occurs on the left-hand side ofthe status bar at the bottom ofthe SAP2000 window. The 
model appears as shown in Figure C-13. 
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Figure C-13: Y-Z Elevation 

31. Click the Draw Frame Element button ..... 1 on the side toolbar. The program is now in 
Draw Mode. 

32. Make sure that the Snap to Joints and Grid Points button 1 ~+~ .1 on the side tool bar is 
depressed. Place the mouse pointer on the joint labeled "A" in Figure C-13 and click on the 
left mouse button. Note that w)len the mouse pointer is near the joint, it snaps to the joint, 
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and a text box that says "Grid Intersection" appears. This is the effect of the Snap to Joints 
and Grid Points feature. 

33. Place the mouse pointer near the joint labeled "B" in Figure C-13 and note that in this case 
the Snap To option text boxjust says "Point" because the joint does not occur ata grid 
intersection. Click on the left mouse button to draw the chevron brace element. 

Note: If yo u wanted to, at this point yo u could just click on point C in Figure C-12 to 
draw the second brace element. Ifwe were todo that, the start pointfor the brace 
would be at the top (point B) and the bottom point would be at the bottom (point C). 
Though not necessarily a problem, this would be inconsistent with how we input the 
first brace. In this example we will opt for consistency. 

Note: If yo u wanted to, at this point you could m ove the mouse pointer into the 3D View 
window, and select the secondjointfor the nextframe element. Try moving the 
m o use pointer over the 3D View window, but for this example don 't actual(v click to 
define the second frame member. 

34. Press the Enter key on the keyboard to stop drawing the second frame member. Note that the 
Draw Frame Element button is still depressed, i.e., the program is still in Draw Mode and 
ready to draw another frame element. 

35. Click on the joint labeled "C" and then the joint labeled "B" in Figure C-13, and then press 
the Enter key on the keyboard to draw the second chevron brace member: 

36. Click the Quick Draw Frame Element button : ..... , on the side toolbar. Then click in the 
area labeled "D" in Figure C-13 to enterthe X-liraces. 

Note: The Quick Draw Frame Element option works two different ways. You can click 
on a grid segment to quickly draw a quick single frame element between the two 
adjacent perpendicular grid /ines. Altematively, you can click in a space boundedby 
four grid fines to draw a cross braceas was done here._ 

Note: The X-braces could also have been entered using the same technique that was 
employed for the chevron braces. 

Note: Both the Draw Frame Element and the Quick Draw Frame Element options are 
also available on the Draw menu. 

37. Click the Down One Gridline button ~~ on the main toolbar twice to display the 
elevation view at X=-24. Note the window title changes to Y-Z Plane@ X=-24. 

38. Repeat steps 32 through 36 to draw the second set ofbraces. Note that the second set of 
braces occurs on the right-hand side ofthe elevation. The model now appears as shown in 
Figure C-14. 
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Figure C-14: Model After Braces Have Been Drawn 

39. Now we will draw the colurnns. Click the six column grid line locations designated with an 
O in Figure C-14 to define the frrst line of colurnns. 

40. Click the Pointer button !):s 1 to exit Draw Mode and enter Select Mode. Click on the six 
colurnns just entered to select them. 

Note: A message on the /eft-hand side of the status bar at the bottom of the SAP2000 
window tells you how many of each type of element are currently se/ected. 

4 L From the Edit menu, choose Replica te. This will display the Replicate dialog box. 

42. In this dialog box select the Linear tab, input 24 for X, O for Y and O for Z. Input 2 for the 
number.' · 

43. Click the OK button and the geometry for the colurnns will be replicated twice ata 24-foot 
spacmg. 

Note: In addition to linear replica/ion, the Replicate option also allows radial 
replication and mirroring. Refer to the topic replica/e in the online help for more 
information. The online help can be accessed by c/icking on the He/p menu and 
selecting the Searchfor Help on ... option or you can access it by pressing the FJ key 
on the keyboard when the Replica/e dialog box is open. 
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44. Now we will apply the base restraints. Click in the window labeled Y-Z Plane@ X=-24 to 
make sure it is active. Note when the window is active, its title bar will be highlighted. 

45. From the View menu select Set 2D View .... This will display the Set 2D View dialog box. 

46. Make sure the X-Y plan e option button is selected and enterO in the Z = edit box. 

47. Click the OK button, and the window will now display the X-Y Plane@ Z=O. 

48. Select all of the joints in the X-Y Plane @ Z=O by "windowing." To do this: 

• Click the Pointer button · .[ii 1 on the side toolbar left side ofthe screen. 

• M ove the pointer abo ve and to the left of the support joints. 

• . Click and hold the left mouse button. 

• While holding, move the pointer below and to the right ofthe support joints. A "rubber­
band" window will show the region selected. 

• Release the left mouse button to select all elements Uoints) in this window. 

49. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

50. In this dialog box: 

• Click the pinned base fast restraint button l.k.l to set all translational degrees of 
freedom (U 1, U2 and U3) as restrained. 

• Click the OK button 

51. Click in the window labeled 3-D View to rnake sure it is active. 

52. Click the Refresh Window button ~ on the rnain toolbar (or select Refresh Window 
from the View menu) to see the restraints in the 3-D View window. 

53. Click in the plan view window currently labeled Joint Restraints to rnake sure it is active. 

54. Click the Show Undeformed Shape button ,01 to reset the view and to return the window 
label to X-Y Plane@ Z=O. 

55. Click the Up One Gridline button • .0:·1 on the rnain toolbar twice to display the elevation 
view at Z=24. 
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56. To fmish defining the model geometry, complete items 25 through 46 in Step la, i.e .. the 
previous step. When finished, return to this point. 

This completes the input ofthe model geometry from scratch. Now you can do one ofthe 
following: 

• If yo u started the model from scratch. and do not want to try starting the model from a 
template, then go on to Step 2. 

• Ifyou started the model from scratch, and now want to try starting it from a template. 
then return to the beginning ofStep la. 

• Ifyou want to stop working on the tutorial for now, and close SAP2000, rnake sure that 
yo u ha ve saved your file as outlined in item 46 of Step 1 a, and then from the File menu 
select Exit. 
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Step 2: Relabeling Joint, Frame and Shell Elements 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its title bar will be highlighted. 

2. Click the Set Elements button J1811 on the main toolbar ( or select Set Elements ... from the 
View menu). This displays the -?el Elements Dialog box. 

3. In this dialog box: 

• In the Joints area check the Labels box. 

• In the Frames area check the Labels box. 

• In the Shells area check the Labels box. 

• Click the OK button. 

Note: We are lurning on lhe elemenl /a beis so lhal we can see lhe e.ffecl of lhe element 
re/abeling. /1 is nol necessary lo lurn on elemenl labe/s in arder lo re/abe/ lhem. 

4. From the Select menu choose Select, and then All from the submenu. All elements in the 
model (joints, frame elements and shell elements) are selected. 

5. From the Edit menu choose Change Labels to display the Relabel Selected Iterns dialog 
box. 

6. In this dialog box: 
Relabel Selected ltems 

• Press the Fl key to display the context­
sensitive online help for this dialog 
box. 

Changa Labellni~i .. Ji¡tllli~r_:-;----''------::-4:]!i 

• When fmished reading the online help, 
click the "X" in the top right -hand 
comer of the Help window, or select 
Exit from the File menu on the Help 
window to close it. 

• In the Change Label Initialization area 
ofthe dialog box type 1 in the Next 
Number edit boxes for Joint, Frame and 
Shell elements. 
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• Accept the rest ofthe default values in the dialog box. 

• Click the OK button to make the changes. 

Note: It is not typically necessary to renumber the elements. /t is done here to 
illustrate the process, and to make su re al/ tutorial users ha ve the same 
numbering system, whether they started the model from a templare, orfrom 
scratch, sin ce we will refer to joint and frame elements by their /a beis later in this 
tutorial. 

Note: Joint, Frame and Shell element labels can be given alphanumeric prefzxes. 
These prefzxes can be input in the Prefzx edit boxes on the Re/abe/ Selected /tems 
dialog box. 

Note: /t is not necessary to select al/ elements to re/abe/. You could select only afew 
elements, of any type, and re/abe/ only the selected e/ements. 

7. Click the Set Elements buttonll8ll on the main toolbar (or select Set Elements ••. from the 
View menu). This displays the "?el Elements Dialog box. . 

8. In this dialog box: 

• In the Joints area üncheck the Labels box. 

• In the Frames area uncheck the Labels box. 

• In the Shells area uncheck the Labels box. 

• Click the OK button. 

9. Click the Save Model button~on the main toolbar, or select Save from the File menu to 
save the file. 

This completes relabeling the joint, frame and shell elements. 
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Step 3: Defining Material Properties 

In this tutorial we will use default material properties, except that we will not use the self-weight 
and selfmass. In this step we will first review the default material properties (items 1 through 
14) and then we will change the material properties to set the self-weight and self mass to zero 
(iterns I5 through 21). 

l. From the Define menu choose Materiais .••. This displays the Defme Materials dialog box. 

2. Highlight CONC in the Materials area and click the Modify/Show Material button. This 
will display the Material Property Data dialog box. 

Note: To add a new material property, click the Add New Material button. 

3. Note the material properties shown, and notice that they are in units ofkips and feet. 

4. Click the Cancel button to exit the Material Property Data dialog box without making any 
changes. 

5. Click-the Cancel button to exit the Defme Materials dialog box without making any changes. 

6. Click the drop down box in the status bar to change the units to kip-in. IKip-tn ::JI 
7. From the Define menu choose Materiais .... This again displays the Defme Materials dialog 

box. 

8. Highlight CONC in the Materials area, ifit is not already highlighted, and click the 
Modify/Show Material button. This displays the Material Property Data dialog box for the 
material named CON C. 

9. Note the material properties shown, and notice that they are in units ofkips and inches. 

1 O. Click the Cancel button to exit the Define Materials dialog box without making any changes. 

11. Highlight STEEL in the Materials area and click the Modify/Show Material button. This 
will display the Material Property Data dialog box. 

12. Note the material properties shown, and notice that they are in units ofkips and inches. 

13. Click the Cancel button twice to exit the Material Property Data dialog box and the Define 
Materials dialog box without making any changes. 

14. Click the drop down box in the status bar to change the units back to kip-ft. ·¡Kip-11 !f'J' 

15. From the Define menu choose Materials .... This displays the Defme Materials dialog box. 
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16. Highlight CONC in the Materials area and click the Modify/Show Material button. This 
will display the Material Propeny Data dialog box. 

17. In this dialog box: 

• In the Analysis Property Data area type O in the Mass Per Unit Volume edit box. 

• In the Analysis Property Data area type O in the Weight Per Unit Volume edit box. 

• Click the OK button. 

18. Highlight STEEL in the Materials area and click the Modify/Show Material button. This 
will display the Material Property Data dialog box. 

19. In this dialog box: 

• In the Analysis Property Data area type O in the Mass Per Unit Volume edit box. 

• In the Analysis Property Data area type O in the Weight Per Unit Volume edil box. 

• Click the OK button. 

20. Click the OK button to close the Defme Materials dialog box . 
.. , 

21. Click the S ave Model button~ on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the review and definition of material properties. 
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Step 4: Defining Frame Sections 

We will use nine different wide flange sections (W24X62, W24X55, W21 X44, Wl8X40, 
Wl8X35, WJ6X26, WI4Xl32, W8X58 and W8X31) and two different structural tube sections 
(TS5X5Xl/4 and TS4X4Xl/4) for this model. We will use the structural sections data file 
provided with SAP2000. The file is called SECTIONS.PRO and resides in the same directory as 
SAP2000. 

l. From the Define menu choose Frame Sections ..•. This will display the Define Frame 
Sections dialog box. 

2. In this dialog box: 

• Click on the Import drop-down box. 

• Click on Import l!Wide Flange. This will display the Section Property File dialog box. 

• In this dialog box: 

-1' Locate the SECTIONS.PRO data file. lt is typically located in the directory where 
you installed SAP2000. 

-1' Open the SECTIONS.PRO data file by highlighting it and clicking on the Open 
button or by double clicking on the file name. 

-1' This will display a dialog box that includes a scrolling list box showing all the I/wide 
flange sections available in the data file. The title bar ofthis box displays the full 
path to the data file. 

Note: In a SAP2000 session you only have to /acate 
and open the SECTIONS.PRO data file once. You have 
the option to select another data file at any time by 
choosing Preferences in the Options menu and 
se/ecting the Steel tab. 

-1' In the list box: 

" Use the Scroll buttons to locate the W24X62 
frame section. Click once on this section to 
highlight it. 
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Note: Frame sections may be selected one ata time or they may be selected 
in groups as shown in this example. To select multipleframe sections that 
are next to ea eh other, hold down the Shift key and click on the first and 
/ast frame e/ement in the group. To se/ect multiple frame sections that are 
not next to each other, hold down the Ctrl key and c/ick each section you 
want to select, as is done here. 

~ Use the Scroll buttons to locate the W21X44, Wl8X40, Wl8X35, Wl6X26. 
Wl4Xl32, W8X58 and W8X31 frame sections. While holding down the Ctrl key 
on the keyboard, click once on each section to highlight it and add it to the 
selection. 

:.- Click the OK button. This will display the I!Wide Flange Section dialog box 
which shows a schematic view ofthe last selected section (W8X31), section 
dimensions, and STEEL as the default material type. 

-1' Click the OK button. This will close the I/Wide Flange Section dialog box and return 
to the Defme Frame Sections dialog box. Notice that in the dialog box the labels of 
the selected frame elements are added to the default section name (FSEC 1) in the 

· Frame Section area. 

• Click on the Import drop-down box. 

• Click on Import Box!Tube. This will display a scrolling list box showing all the boxltube 
sections available in the data file. 

• In this dialog box: 

-1' Use the Scroll buttons to !acate the TS5X5Xl/4 frame section. Click once on this 
section to highlight it. 

-1' Use the Scroll buttons to locate the TS4X4Xl/4 frame section. While holding down 
the Ctrl key on the keyboard, click once on this section to highlight it and add it to the 
selection. 

-1' Click the OK button. This will display the Box!Tube Section dialog box that shows a 
schematic view ofthe last selected section (TS4X4Xl/4), section dimensions, and 
STEEL as the default material type. 

• Click the OK button. This will close the Box!Tube Section dialog box and return to the 
Define Frame Sections dialog box. Notice that in the dialog box the labels ofthe selected 
frame elements are added to the previously defined frame sections. 

3. Click the OK button to clase the Define Frame Sections dialog box. 

This completes the definition of frame sections. 
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Step 5: Defining Shell Sections 

We will use one shell section property in the model to model the roof diaphragm. We will 
assume the roof diaphragm to be equivalen! toa 1" thick concrete diaphragm. This is nota 
recommended way to approximate a metal deck diaphragm, it is just a simple and expedient 
method to use for this example. 

l. From the Define menu choose SheU Sections .••. This will display the Define Shell Sections 
dialog box. 

2. In this dialog box: 

• Click the Add New Section button. This will display the Shell Sections dialog box. 

• In this dialog box: 

./ Type ROOF in the Section Name edit box . 

./ Accept the default material CON C. 

./ In the thickness area type 0.0833 in both the Membrane and Bending edit boxes . 

./ In the Type area, select the Membrane option. 

Note: In general we recommend using the Shell type optionfor shell elements . 

./ Click the OK button. 

3. Click the OK button to close the Defme Shell Sections dialog box. 

4. Click the Save Model button j ~ 1 on the main toolbar, or select Save from the File menu 
to save the file. . 

This completes the definition of shell sections. 
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Step 6: Assigning Groups 

Groups can be a powerful too! for selecting elements for both assignments and display. In this 
step we will create nine groups, as shown in the table below: 

Group Name 1 Description 
ROOF All rooflevel ioints, frame elements and shell elements 
2ND All second leve! joints, frame elements and shell elements 

COLS All colunm elements 
FRCOLS All moment frame columns 
BRCOLS All braced frame columns 
BRACEI All braces between the frrst and second leve! 
BRACE2 1 All braces between the second leve! and the rooflevel 

FRMGIRD All moment frame girders 
BASE All bottom leve! columns and support joints 

Note: By default the program creates a group named ALL which includes al/ e/ements in 
the model Ooint elements included). 

l. Click in the window labeled X-Y Plane@ 2=24 to make sure it is active. Note when the 
window is active, its tille bar will be highlighted. 

2. Click the Pointer button ·~ on the side toolbar and select all ofthe elements in the X-Y 
Plane@ 2=24 by "windowing." 

Note: To add more joints andlor elements toan already assigned group, first select the 
group, then select more joints andlor elements, and final/y assign them to the group. 
Group assignment always replaces the existing elements in that group. 

3. From the Assign menu choose Group Name .... This will display the Assign Group dialog 
box. 

4. In this dialog box: 

• Type ROOF in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to define a group named ROOF. 

Note: A common error is to forget to click the Add New Group N ame button befo re 
pressing the OK button. 

• Click the OK button to assign the selected elements to the group named ROOF. 

5. Click the Down One Gridline button l.!Jon the main toolbar to display the plan view at 
2=12. Note the window title changes to X-Y Plane@ 2=12. 
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6. Select all ofthe elements in the X-Y Plane@ Z=l2 by "windowing." 

7. From the Assign menu choose Group Name .... This will display the Assign Group dialog 
box. 

8. In this dialog box: 

• Type 2ND in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to defme a group named 2ND. 

• Click the OK button to assign the selected elements to the group named 2ND. 

9. Click on the XJ'. buttonl-~ 1 on the main toolbar to view an elevation in the X-Z plane. Note 
the title ofthe window is probably X-Z Plane@ Y=24; it depends on the sequence ofsteps 
you followed in creating the model. Ifthe window title is not X-Z Plane@ Y=24, click the 
Up One Gridline button ~on the main toolbar or the Down One Gridline button ~ on 
the main toolbar until the title ofthe window is X-Z Plane@ Y=24. 

lO. Click on the six colurnn elements in this view to select them. 

Note: SAP2000 wi/1 display the number and type of elements you have selected on the 
left-hand si de of the status bar at the bottom of the SAP2000 window. 

Note: You can click again on a single selected element to deselect it. I[v¡u want to 
deselect a/1 elements at once, then click the C/ear Selection button ¡¡¡¡¡ on the side 
too/bar, or choose C/ear Se/ection from the Se/ect menu. 

11. Click the Down One Gridline button r~ 1 on the main toolbar to display the elevation at 
Y=O. Note the wmdow title changes to X-Z Plane@ Y=O. 

12. Select the bottom leve! colurnns by intersection. Todo this: 

• Click the Pointer button ~ on the side toolbar. 

• Click the Set Intersecting Line Select Mode button: llllllon the side toolbar. 

• Move the pointer to the left ofthe colurnns you want to select. 

• Click and hold the left mouse button. 

• While holding, move the pointer to the right ofthe members you want to select. A 
"rubber band" will show the intersecting line. 

• Release the left mouse button to select all members that intersect this line. 

SAP2000 Web Tutorial 1 36 



13. Click the Set Intersecting Line Select Mode button again and select the top leve! columns. 

14. Click the Down One Gridline button ~ on the main toolbar to display the elevation at Y=-
24. Note the window title changes to X-Z Plane@ Y=-24. 

15. Use the Intersecting Line mode to select the six column elements in this elevation. There 
should now be a total of 18 frame elements selected. You can confrrm this by looking on the 
left-hand side ofthe status bar at the bottom ofthe SAP2000 window. 

16. From the Assign menu choose Group Name .•.. This will display the Assign Group dialog 
box. 

17. In this dialog box: 

• Type COLS in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to defme a group named COLS. 

• Click the OK button to assign the selected elements to the group named COLS. 

18. Now we will assign the moment frame columns to a group. Click on the left-hand column 
and the center column (4 elements total) to select them. 

19. Click the Up One Gridline button ~ on the main toolbar twice to display the elevation at 
Y=24. Note the window title changes to X-Z Plane@ Y=24. 

20. Click on the right-hand column and the center column ( 4 elements total) to select them. 
There should now be eight frame elements selected. 

21. From the Assign menu choose Group N ame .... This will display the Assign Group dialog 
box. 

22. In this dialog box: 

• Type FRCOLS in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to define a group named FRCOLS. 

•; Click the OK button to assign the selected elements to the group named FRCOLS. 

23. Now we will assign the braced frame columns to a group. Click on the yz button l_cl on the 
main toolbar to view an elevation in the Y-Z plane. Ifnecessary, click the Up One 
Gridline button ~ on the main toolbar until the title ofthe window is Y-Z Plane@ X=24. 

24. Click on the four column elements at the braced frame to select them. 
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25. Click lhe Down One Gridline button~ on lhe main 1oolbar lwice lo display lhe elevalion 
al X=-24. 

26. Click on lhe four column elemenls al lhe braced frame 10 selecl lhem. There should now be 
eighl frame elemenls selecled. 

27. From lhe Assign menu choose Group Name .••. This will display lhe Assign Group dialog 
box. 

28. In lhis dialog box: 

• Type BRCOLS in lhe edil box al lhe lop oflhe Groups area. 

• Click lhe Add New G':'oup N ame button lo defme a group named BRCOLS. 

• Click lhe OK button lo assign lhe selecled elemenls lo lhe group named BRCOLS. 

29. Now we will assign lhe bottom leve! braced frame braces lo a group. Click on lwo bottom 
leve! braces lo selecl lhem: 

30. Click lhe Up One Gridline bullon·:;¡¡:·¡ on lhe main loolbar lwice lo display lhe elevalion al 
X=24. 

31. Click on lwo bottom leve! braces lo selecl lhem. There should now be four frame elemenls 
selecled. 

32. From lhe Assign menu choose Group N ame .... This will display lhe Assign Group dialog 
box. 

33. In lhis dialog box: 

• Type BRACEl in lhe edil boxal lhe lop oflhe Groups area. 

• Click lhe Add New Group N ame bullon lo define a group named BRACE l. 

• Click lhe OK button lo assign lhe selecled elemenls lo lhe group named BRACEI. 

34. Now we will assign lhe lop leve! braced frame braces lo a group. Click on lwo lop leve! 
braces lo selecl lhem. 

35. Click lhe Down One Gridline bullon~ on lhe main loolbar lwice lo display lhe elevalion 
al X=-24. 

36. Click on lwo lop leve! braces lo selecl lhem. There should now be four frame elemenls 
selecled. 
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37. From the Assign menu choose Group N ame .... This will display the Assign Group dialog 
box. 

38. In this dialog box: 

• Type BRACE2 in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to defme a group named BRACE2. 

• Click the OK button to assign the selected elements to the group named BRACE2. 

39. Now we will assign the moment frame girders toa group. Click on the xz button ~ on the 
main toolbar to view an elevation in the X-Z plane. Note the title ofthe window is X-Z 
Plane@ Y=24. 

40. Click on the rooflevel and second leve! beam on the right side ofthis elevation to select 
them. 

41. Click the Down One Gridline button~ on the main toolbar twice to display the elevation " 
at Y=-24. 

42. Click on the rooflevel and second leve! beam on the left side ofthis elevation to select them. 
There should now be· four frame elements selected. 

43. From the Assign menu choose Group N ame ••.. This will display the Assign Group dialog 
box. 

44. In this dialog box: 

• . Type FRMGIRD in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to defme a group named FRMGIRD. 

• Click the OK button to assign the selected elements to the group named FRMGIRD. 

45. Finally we will assign the lower leve! columns, braces and the base joints to a group. This 
group can be used in the Group Joint Force Sum option·(on the Display menu) to displaythe 
base shear. Click the Perspective T\)ggle buttonló'é'l on the main toolbar. A perspective 
view ofthe X-Z elevation is displayed. 

46. Click the Set Intersecting Line Select Mode button l!lill and select all ofthe bottom leve! 
columns. Note that in doing so you will also select the bottom leve! braces. 

47. Click on the xy buttonl_>!_] on the main toolbar to view an elevation in the X-Y plane. Note 
the title ofthe window is X-Y Plane@ Y=l2. 
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48. Click the Down One Gridline button~ on the main toolbar to display the plan at Z=O. 

49. Select all ofthe joints at this leve! by "windowing". There should now be 9 joints and 13 
frame elements selected. 

50. From the Assign menu choose Group Name .... This will ¡jisplay the Assign Group dialog 
box. 

51. In this dialog box: 

• Type BASE in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to define a group named BASE. 

• Click the OK button to assign the selected elements to the group named BASE. 

Note: The BASE group wi/1 be usefulfor determining base shears, overtuming moments. 
total verticalloads. 

52. Click the Save Model button llill on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the assignment of groups. 
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Step 7: Assigning Frame Sections 

Refer to Figure B-1 for the beam, column and brace element sections. 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its tille bar will be highlighted. 

2. Click the Set Elements button 1 I811 on the main toolbar ( or select Set Elements ... from the 
View menu). This displays the ~ Elements Dialog box. 

3. In this dialog box: 

• In the Frames area check the Labels box. 

• In the Shells area check the Hide box. 

• Click the OK button. 

4. Click in'the window labeled X-Y Plane@ Z=O to make sure it is active. Note when the 
window is active, its tille bar will be highlighted. 

5. Click the Up One Gridline buttoni.J on the main toolbar twice to display the roof leve! 
plan at 2=24. 

6. Click the Set Elements button 1 I811 on the main toolbar ( or select Set Elements ... from the 
View menu). This displays the -?el Elements Dialog box. 

7. In this dialog box: 

• In the Frames area check the Labels box. 

• In the Shells area check the Hide box. 

• Click the OK button. 

8. In the window labeled X-Y Plane@ 2=24, click on frame elements 40, 45,46 and 51 to 
select them. 

Note: Yo u can refer to Figures B-2 and B-3, as well as the screen, to identify the frame 
e/ement numbers. 

9. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Defme Frame Sections dialog box. 
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Figure C-15: Frame Element Labels 

lO. In the Frame Sections area click on the Wl6X26 name once to highlight it and then click the 
OK button. This assigns the Wl6X26 property to the selected frame elements. Note the 
other frame elements ha ve the default FSEC l assigned. 

11. Click the Show Undeformed Shape button .O 1 to clear the display_ ofthe assigned sections 
so that you can see the frame element labels agam. 

12. In the plan view, click on frame elements 41, 42, 44, 47, 49 and 50 to select them. 

13. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Define Frame Sections dialog box. 

14. In the Frame Sections area click on the Wl8X35 name once to highlight it and then click the 
OK button. 

15. Click the Show Undeformed Shape button O 1 to clear the display ofthe assigned sections 
so that you can see the frame element labels agam. 

16. In the plan view, click on frame elements 43 and 48 to select them. 

17. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Defme Frame Sections dialog box. 
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18. In the Frame Sections area click on the W21 X44 na me once to highlight it and then click the 
OKbunon. 

19. From the Select menu select Select and then Groups ... from the submenu. This will display 
the Select Groups dialog box. 

20. Click on the group name FRMGIRD once to highlight it and then click the OK button. 

21. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Define Frame Sections dialog box. 

22. In the Frame Sections area click on the W24X55 name once to highlight it and then click the 
OKbutton. 

23. Click the Show Undeformed Shape bunon ·O 1 to clear the display ofthe assigned sections 
so that you can see the frame element labels agam. 

24. Click in the window labeled X-Y Plane @ 2=24 to rnake sure it is active. 

25. Click the Down One Gridline button~ on the rnain toolbar to display the second floor plan 
at 2=12. 

26. From the Select menu select Select and then Labels from the submenu. This will display the 
Select by Labels dialog box. 

27. Click the Element Type drop-down box and select Frame. 

• Click the Element Type drop-down box and select Frame. 

• Type 15 in the Start Label edit box, 24 in the End Label edit box and 9 in the lncrement 
edit box. 

• Click the OK button. 

28. From the Assign menu select Frame and then Sections ••• from the submenu. This will 
display the Defme Frame Sections dialog box. 

29. In the Frame Sections area click on the Wl6X26 name once to highlight it and then click the 
OK button. 

30. In the plan view, click on frame elements 16, 18, 19, 20, 21 and 23 to select them. 

31. From the Assign menu select Frame and then Sections .•• from the submenu. This will 
display the Define Frame Sections dialog box. 
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32. In the Frame Sections area click on the Wl8X40 name once to highlight it and then click the 
OK button. 

33. In the plan view, click on frame elements 17 and 22 to seíect them. 

34. From the Assign menu select Frame and then Sections •.• from the submenu. This will 
display the Defme Frame Sections dialog box. 

35. In the Frame Sections area click on the W24X62 name once to highlight it and then click the 
OK button. 

36. From the Assign menu select Clear Display of Assigns to clear the display of frame assigns 
from the plan view. 

37. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
· active, its title bar will be highlighted. 

38. Click the Set Elements buttonl:181:¡ on the main toolbar (or select Set ElemÍmts ... from the 
View menu). This displays the Set Elements Dialog box. 

39. In this dialog box: 

• In the Frames area uncheck the Labels box. 

• Click the OK button. 

40. From the Select menu select Select and then Groups .•• from the submenu. This will display 
the Select Groups dialog box. 

41. Click on the group name BRACE 1 once to highlight it and then click the OK button. 

42. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Defme Frame Sections dialog box. 

43. In the Frame Sections area click on the TS5X5X114 name once to highlight it and then click 
the OK button. 

44. From the Select menu select Select and then Groups ..• from the submenu. This will display 
the Select Groups dialog box. 

45. Click on the group name BRACE2 once to highlight it and then click the OK button. 

46. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Defme Frame Sections dialog box. 
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47. In the Frame Sections area click on the TS4X4XI/4 name once to highlight it and then click 
the OK button. 

48. From the Select menu select Select and then Groups ... from the submenu. This will display 
the Select Groups dialog box. 

49. Click on the group name FRCOLS once to highlight it and then click the OK button. 

50. From the Assign menu select Frame and then Sections .•. from the submenu. This will 
display the Define Frame Sections dialog box. 

51. In the Frame Sections area click on the W14Xl32 name once to highlight it and then click 
the OK button. 

52. From the Select menu select Select and then Groups •.. from the submenu. This will display 
the Select Groups dialog box. 

53. Click on the group name BRCOLS once to highlight it and then click the OK button. 

54. From the Assign menu select Frame and then Sections ..• from the submenu. This will 
display the Defme Frame Sections dialog box. 

55. In the Frame Sections area click on the W8X58 name once to highlight it and then click the 
OK button. 

56. From the Select menu.select Select and then Groups ••. from the submenu. This will display 
the Select Groups dialog box .. 

57. Click on the group name COLS once to highlight it and then click the OK button. 

58. From the Select menu select Deselect and then Groups ••. from the submenu. This will 
display the Select Groups dialog box. 

59. In this dialog box: 

• Click on the group name FRCOLS once to select (highlight) it. 

• Hold down the Ctrl key on the keyboard and click on the BRCOLS group name once to 
highlight it and add it to the selection. 

• Click the OK button. 

60. From the Assign menu select Frame and then Sections ... from the submenu. This will 
display the Defme Frame Sections dialog box. 
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61. In the Frame Sections area click on the W8X31 name once to highlight it and then click the 
OK button. 

62. From the Assign menu select Clear Display of Assigns to clear the display of frame assigns 
from the 3-D view. 

63. Click the Save Model button ~ on the rnain toolbar, or select Save from the File menu to 
save the file. 

This completes the assignment of frame section properties. 
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Step 8: Assigning Shell Sections 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its title bar will be highlighted. 

2. Click the Set Elements buttonl~ on the main toolbar ( or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. 

3. In this dialog box: 

• In the Shells area uncheck the Hide box. 

• Click the OK button. 

4. Click in the window labeled X-Y Plane@ Z=12 to make sure it is active. Note when the 
window is active, its title bar will be highlighted. 

5. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ..• from the 
View menu). This displays the Set Elements Dialog box. 

6. In this dialog box: 

• In the Shells area uncheck the Hide box. 

• Click the OK button. 

7. Click the Up One Gridline button ~ on the main toolbar to display the rooflevel plan at 
Z=24. 

8. From the Select menu select Select and then Groups ... from the submenu. This will display 
the Select Groups dialog box. 

9. Click on the group name ROOF once to highlight it and then click the OK button. 

1 O. From the Assign menu select Shell and then Sections •.. from the submenu. This will display 
the Define Shell Sections dialog box. 

11. In the Shell Sections area click on the ROOF name once to highlight it and then click the OK 
button. 

12. From the Assign menu select Clear Display of Assigns to clear the display of shell assigns 
from the plan view. 

13. Click the Save Model button ~ on the main toolbar to save the file. 

This completes the assignment of shell section properties. 
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Step 9: Assigning Frame End Releases 

We will release the M3 and M2 moment at the ends ofall non-moment frame girders, and release 
M3, M2 and torsional moment at the ends of all braces. 

l. Click in the window labeled X-Y Plane@ Z=24 to make sore it is active. Note when the 
window is active, its title bar will be highlighted. 

2. From the Select meno select Select and then Groops •.. from the sobmeno. This will display 
the Select Groops dialog box. 

3. Click on the groop name ROOF once to highlight it, then, holding down the Ctrl key, click 
on the Groop Named 2ND to add it to the selection. Click the OK botton. 

4. From the Select meno select Deselect and then Groups .•. from the sobmeno. This will 
display the Select Groops dialog box. 

5. Click on the groop name FRMGIRD once to highlight it and then click the OK botton. 

6. From the Assign meno select Frame and then Releases •.. from the sobmeno. This will 
display the Frame Releases dialog box. 

Note: The end releas es wil/ be applied incorrectly to the roo/ beams at the braced frames as 
a resu/t of this selection. We wi/1 fzx that in items 8 through 18. 

7. In this dialog box: 

• Check the Start and End boxes for Moment M22 (Minor) and Moment M33 (Major). 

• Click the OK button to apply the releases. 

8. Note that releases are applied at the center ofthe braced frame roofbeams. This is not 
corree! since the braced frame roofbeams are continuous over the top ofthe chevron brace. 

9. Click the Set Elements buttonj~ on the main toolbar (or select Set Elements ••. from the 
View meno). This displays the Set Elements Dialog box .. 

10. In this dialog box check the Local Axes box and the Labels box in the Frames area and click 
the OK botton. The local axes arrows appear as shown in Figure C-16. 
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Figure C-16: Frame Element Local Axes Arrows 

Note: The local axes '!rrows are color-coded red, white and blue. The red arrow is always 
local axis 1, the white arrow is always local axis 2, and the blue arrow is always local 
axes 3. In the plan view, local axis 2 is pointing straight up and thus we can not see that 
arrow. 

Note: Por frame elements, local axis 1 always points along the longitudinal axis ofthe 
member from the start jointlo the end joint. Thus we can use the local axes lo te// which 
end is the start end for any frame element. 

11. Click on frame elements 41 and 47 to select them. Note that for these elements, moments 
will be released at the start end only. 

12. From the Assign menu select Frame and then Releases •.. from the submenu. This will 
display the Frame Releases dialog box. 

13. In this dialog box: 

• Check the Start box for Moment M22 (Minor) and Moment M33 (Major). 

• Click the OK button to apply the releases. 

14. Click on frame elements 44 and 50 to select them. Note that for these elements, moments 
will be released at the end joint only. 

SAP2000 Web Tutorial 1 49 



15. From the Assign menu select Frame and then Releases .•. from the submenu. This will 
display the Frame Releases dialog box. 

16. In this dialog box: 

• Check the End box for Moment M22 (Minor) and Moment M33 (Major). 

• Click the OK button to apply the releases. 

17. The member end releases ha ve now been corrected. Click the Set Elements button J~ on 
the main toolbar ( or select Set Elements ... from the View menu). This displays the Set 
Elements Dialog box. 

18. In this dialog box uncheck the Local Axes box and the Labels box in the Frames area and 
click the OK button. 

19. From the Select menu select Select and then Groups ... from the submenu. This will display 
the Select Groups dialog box. 

20. Click on the group name BRACE 1 once to highlight it, then, holding down the Ctrl key, click 
on the Group Named BRACE2 to add it to the selection. Click the OK button. 

21. From the Assign menu select Frame and then Releases ... from the submenu. This will 
display the Frame Releases dialog box. 

22. In this dialog box: 

• Check the Start and End boxes for Moment M22 (Minor), Moment M33 (Major) and the 
Start box for Torsion. 

Note: Yo u can apply a torsional releas e al one end of the frame element or the other, but not 
both simultaneously. If you applied a torsion release to both ends, the frame element 
would be free to spin about its longitudinal axis, and thus the structure would be 
unstable. 

• Click the OK button to apply the releases. 

23. From the Assign menu select Clear Display of Assigns to clear the display offrame releases 
from the plan view. 

24. Click the Save Model button li.ll on the main toolbar, or select S ave from the File menu to 
save the file. 

This completes the assignment of frame element end releases. 
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Step 10: Defining Sta tic Load Cases 

We will defme five static load cases. They are dead load, live load, earthquake in the X­
direction, earthquake in the Y -direction anda load pattem to be used in the pushover analysis. 

l. From the Define menu select Sta tic Load Cases ..•. This will display the Define Static Load 
Case N ames dialog box. 

2. In this dialog box: 

• Type DL in the Load edit box. 

• Select Dead from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Change Load button. 

Note: In this example, if we had wanted the program lo automatically include the self­
weight of the structural members, we would have specijied a non zero weight per unit ·!, 

volume in the Material data, and we would have puta selfweight multiplier of 1 on 
the DL load case only. 

• Type LL in the Load edit box . 

o Select Live from the Type drop-down box. 

• Type O in the Self Weight Multiplier edit box . 

• Click the Add New Load button . 

• Type EQX in the Load edit box . 

• Select Quake from the Type drop-down box . 

• Type O in the SelfWeight Multiplier edit box . 

• Click the Add New Load button . 

• Type EQY in the Load edit box . 

• Select Quake from the Type drop-down box . 

• Type O in the SelfWeight Multiplier edit box . 

• Click the Add New Load button . 
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• Type PUSHPAT in the Load edit box. 

• Select OTHER from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Add New Load button. 

3. Click the OK button. 

4. Click the Save Model button ~ on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the definition of static load cases. 
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Step 11: Assigning Frame Static Loads 

Note that the beam span loading is indicated in Figure B-4. 

l. Click in the window labeled X-Y Plane@ Z=24 to make sure it is active. Note when the 
window is active, its title bar will be highlighted. 

2. Click the Set Elements buttoni--ª.J on the main toolbar ( or select Set Elements ••. from the 
View menu). This displays the Set Elements Dialog box. 

3. In this dialog box check the Labels box in the Frames area, check the Hide box in the Shells 
area and click the OK button. 

4. Click the Perspective Toggle buttonl ó'd'jon the main toolbar. A perspective view ofthe X­
y plan is displayed. 

5. From the View menu select Set Limits .... This displays the Set limits dialog box. 

6. In this dialog box type 23 in the Min edit box in the Set Z-Axis Lirnits area and click the OK 
button to change the limits such that only the roofbeam elements show. 

7. Select roófbeams 39, 40, 51 and 52 by clicking on them. 

8. From the Assign menu select Frame Static Loads .•• and then Point and Uniform .•. from 
the submenu. This will display the Point and Uniform Span Loads dialog box. 

9. In this dialog box: 

• Select DL from the Load Case N ame drop-down box . 

• In the Load Type and Direction area, select the Forces option, and select Global Z from 
the drop-down Direction box. 

• In the Options area, select the Add to Existing Loads option . 

• In the Uniform Load area, type -0.40, or just type -.4 . 

Note: Take careto make sure you enter the minus sign with the load. The load is input in 
the global Z direction, thus the minus sign indicares a downward load. 

• Click the OK button to apply the load. 

1 O. Click the Resto re Previous Selection button ~ j on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

SAPlOOO Web Tutoriall 1 53 



11. From the Assign menu select Frame Static Loads ••. and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

12. In this dialog box: 

• Select LL from the Load Case N ame drop-down box . 

• In the Uniform Load area, type -.12. Don't forget the minus sign . 

• Click the OK button to apply the load . 

13. Select roofbeams 41, 42, 44, 47,49 and 50 by clicking on them. 

14. From the Assign menu select Frame Static Loads ..• and then Point and Uniform .•. from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

15. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Uniform Load area, type -.16. 

• Click the OK button to apply the load. 

Note: The point loadfor beams 41144 and 47150 can either be input as ajoint load, oras a 
beam span load at the end of a beam. We wil/ input itas a beam span load. 

16. Select roofbeams 41 and 47 by clicking on them. 

17. From the Assign menu select Frame Static Loads •.. and then Point and Uniform •.. from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

18. In this dialog box: 

• Select DL from the Load Case N ame 
drop-down box. 

• In the Options area, select the Add to 
Existing Loads option. 

• In the Point Loads area there are four sets 
ofDistance and Load boxes labeled 1 
through 4. In the frrst set ofboxes input 1 
in the Distan ce box and -5.76 in the Load 
box. Make sure the Relative Distance 
From End I option is selected. 

SAP2000 Web Tutoriall 

Pwnt end UnitonJI Span loilldt 

:::J ¡ 
-[~F::an:D:=·~ r,~P~to~Dadt 

· - - r R ep,ace eoatr~g loada 
. , O"""" JG-Z :::J. . r Dolole-_loodo 

~">''''i•,, :"' H :::,•., • '"' 1. •• '• 

~·-. ~~.~--~r_-·. ::·:~-:.· .. ·;_~:.'\:·.::- ::-·- I-":<·;~_-.': :.. . 
. ó;..a ¡;--- ro:;;¡-- ~ ¡;:--
' .. ,~,; ¡.;.::,. ' ~~ ~· ~;. 

·-'·':'----- -···-_·,"l;":r""-"'-·-:··_. ------

r: Rele6ve D~~tan:e lram E~ f"' .Abr:co&te DiaUrlc:e han End-1 . '- " : ... ·: . . - ' 
,._.,o :•"lc .. ct~'···~ '"!'' )'•, .. _.,. •l·,,~· •"'•·;~;·:·"';;':-''';~, .·•: : [u ...... l.oed·:·.- ·•:':'ir· ·¡•·">'''•· .. ·:·.,\ ·-· L---··-
! <<:", fO i!?i: !• -!' DK· ·J f ton.el [ 
"-_ '-. ,...,~:·.~·::"::.:: ----~--~·;.. ... _ .. - ·.; .·. . .. ··. 

54 



• In the Uniform Load area, type O. 

• Click the OK button to apply the load. 

19. Click the Restore Previous Selection button ~ 1 on the side toolbar (or select Get 
Previous Selection from the Select menu). -=.1 

20. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

21. In this d ialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Point Loads area type 1 in the frrst Distance box and -2.88 in the frrst Load box. 

• Click the OK button to apply the load. 

22. Select roofbeams 42 and 49 by clicking on them. 

23. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... ·from 
the submenu. This will.display the Point and Uniform Span Loads dialog box. 

24. In this dialog box: 

• Select DL from the Load Case Name drop-down box. 

• In the Point Loads area type .5 in the first Distance box and -5.76 in the frrst Load box. 

• Click the OK button to apply the load. 

25. Click the Resto re Previous Selection button ~) on the si de toolbar ( or select Get 
Previous Selection from the Select menu). 

26. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

27. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Point Loads area type -2.88 in the first Load box. 

• Click the OK button to apply the load. 
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28. Select roofbeams 45 and 46 by clicking on them. 

29. From the Assign menu select Frame Static Loads •..• and then Point and Uniform .•• from 
the submenu. This will display the Point and Uniforln S pan Loads dialog box. 

30. In this dialog box: 

• Select DL from the Load Case N ame drop·down box. 

• In the Point Loads area type O in the frrst Distance box and O in the frrst Load box. 

• In the Uniform Load area, type -.48. 

• Click the OK button to apply the load. 

Note: Because of the perspective view, you will not see this load after it is applied. To see it, 
c/ick the 3-D View button. 3-d/ To return to the perspective view, click the ~ 2-D View 
button L!J and then c/ick the Perspective Toggle button./~ 

31. Click the Resto re Previous Selection button ~ 1 on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

32. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

33. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Uniform Load area, type -.24. 

• Click the OK button to apply the load. 

34. Select roofbeams 43 and 48 by clicking on them. 

35. From the Assign menu select Frame Sta tic Loads ... and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

36. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type .5 in the first Distance box and -11.52 in the frrst Load box. 

• In the Uniform Load area, type O. 
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• Click the OK button to apply the load. 

3 7. Click the Restore Previous Selection button ~ j on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

38. From the Assign menu select Frame Sta tic Loads •.. and then Point and Uniform ••. from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

39. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the.Point Loads area type -5.76 in the first Load box. 

• Click the OK button to apply the load. 

40. From the View menu select Set Limits .••. This displays the Set limits dialog box. 

41. In this dialog box type 11 in the Min edit box and 13 in the Max edit box in the Set Z-Axis 
Limits area and click the OK button to change the limits such that only the second floor 
beam elements show. 
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Figure C-17: 3-D View With Limits Set To Show Second Leve! 
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42. Click on the 3-D View button J.d 1 to change the view toa three dimensional view. See 
Figure C-17. 

43. Select second leve! beams 14, 15, 24 and 25 by clicking on them. 

44. From the Assign menu select Frame Static Loads __ , and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform Span Loads dialog box. 

45. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type O in the frrst Distance box and O in the frrst Load box. 

• In the Uniform Load area, type -. 72. 

• Click the OK button to apply the load. 

46. Click the Resto re Previous Selection button IE!]j on the side toolbar ( or select Get 
Previous Selection from"the Select menu). 

47. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

48. In this dialog box: 

• Select LL from the Load Case N ame drop-down box . 

• In the Uniform Load area, type -.3 . 

• Click the OK button to apply the load . 

49. Select second level beams 16, 18,21 and 23 by clicking on them. 

50. From the Assign menu select Frame Sta tic Loads ... and then Point and U niform ... from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

51. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type .S in the first Distance box and -11.52 in the frrst Load box. 

• In the Uniform Load area, type -.24. 

• Click the OK button to apply the load. 
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52. Click the Resto re Previo os Selection button @) 1 on the side toolbar (or select Get 
Previous Selection from the Select menu). 

53. From the Assign menu select Frame Static Loads ..• and then Point and Uniform •.. from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

54. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Point Loads area type -7.2 in the first Load box. 

• In the Uniform Load area, type O. 

• Click the OK button to apply the load. 

55. Select second leve! beams 19 and 20 by clicking on them. 

56. From the Assign menu select Frame Sta tic Loads ••. and then Point and Uniform ..• from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

57. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type O in the frrst Distance box and O in the frrst Load box. 

• In the Uniform Load area, type -.96. 

• Click the OK button to apply the load. 

58. Click the Resto re Previous Selection button @) / on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

59. From the Assign menu select Frame Static Loads .•. and then Point and Uniform ••. from 
the submenu. This will display the Point and Uniform Span Loads dialog box. 

60. In this dialog box: 

• Select LL from the Load Case N ame drop-down box . 

• In the Uniform Load area, IYJ!e -0.6 . 

• Click the OK button to apply the load . 
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61. Select second leve! beams 17 and 22 by clicking on them. 

62. From the Assign menu select Frame Static Loads ... and then Point and Uniform ..• from 
the submenu. This will display the Point and Uniform S pan Loads dialog box. 

63. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type 0.5 in the first Distance box and -23.04 in the frrst Load box. 

• In the Uniform Load area, type O. 

• Click the OK button to apply the load. 

64. Click the Resto re Previous Selection button ~ 1 on the si de toolbar ( or select Get 
Previous Selection from the Select menu). 

65. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu. This will display the Point and Uniform Span Loads dialog box. 

66. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Point Loads area type -14.4 in the first Load box. 

• Click the OK button to apply the load. 

67. From the View menu select Set Limits .... This displays the Set limits dialog box. 

68. In this dialog box click the Show All button in the Set Z-Axis Limits area and click the OK 
button to change the limits such that the entire model is displayed. 

69. From the Assign menu select Clear Display of Assigns to clear the display ofbeam span 
loading. Note that the frame element labels remain because they were tumed on using the 
Set Elements command. 

70. Click the xy 2-D View buttonri\Y 1 on the main toolbar to retum toa plan view. 
window tille is X-Y Plane@ Ñ4. 

Note the the 

71. Click the Save Model button !"lill on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the assignment of frame static loads. 
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Step 12: Assigning Shell Static Loads 

The rooflevellateral earthquake loads are assigned as shell static loads. 

l. Click in the window labeled X-Y Plane @ Z=24 to make sure it is active. Note when the 
window is active, its title bar will be highlighted. 

2. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. 

3. In this dialog box uncheck the Hide box in the Shells area and click the OK button. 

4. From the Select menu select Select and then Groups ... from the submenu. This will display 
the Select Groups dialog box. 

5. Click on the group name ROOF once to highlight it then click the OK button. 

6. From the Assign menu select Shell Static Loads ... and then Uniform ... from the submenu. 
This will display the Shell Uniform Loads dialog box. 

7. In this dialog box: 

• Select EQX from the Load Case N ame drop-down box . 

• In the Uniform Load area type .0074 in the Load box and select Global X from the drop­
down Dir box. 

• Select Add To Existing Loads in the Options area . 

• Click the OK button to apply the load . 

8. Click the Resto re Previous Selection button @ 1 on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

9. From the Assign menu select Shell Sta tic Loads ... and then Uniform ... from the submenu. 
This will display the Shell Uniform Loads dialog box. 

lO. In this dialog box: 

• Select EQY from the Load Case N ame drop-down box . 

• In the Uniform Load area type .0113 in the Load box and select Global Y from the drop-
down Dir box. · 

• Click the OK button to apply the load . 
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11. Click the drop down box in the status bar to change the units to lb-ft.jlb-!1 ::J Observe 
that the shellload shown on the screen is now 11.30 instead ofO.Ol. Sometimes it is 
convenient to change units when viewing input loads and output results. 

12. Click the drop down box in the status bar to change the units back to kip-ft. jK1p·ft ::J 

13. From the Assign menu select Clear Display of Assigns to clear the display ofshellloading. 

14. Click the Save Model button lJ!U on the rnain toolbar to save the file. 

This completes the assignment of shell static loads. 
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Step 13: Assigning Joint Static Loads 

The second levellateral earthquake loads (load cases EQX and EQY) are assigned as joint static 
loads. Also the static load pattern to be used in the pushover analysis, PUSHPAT is assigned as 
joint static loads. 

Note the static load patternfor the pushover analysis could be any combina/ion ofjoint, 
frame and shellloading. 

l. Click in the window labeled X-Y Plane@ Z=24 to make sure it is active. Note when the 
window i> active, its tille bar will be highlighted. 

2. Click the Down One Gridline button~ on the main toolbar to display the second floor plan 
at Z=l2. 

3. Click the Set Elements buttonl~ on the main toolbar ( or select Set Elements ••. from the 
View menu). This displays the Set Elements Dialog box. 

4. In this dialog box ímcheck the Labels box in the Frames area, check the Labels box in the 
Joints area and click the OK button. Note we are leaving the Restraints box in thé Joints area 
checked. 

5. Clickjoint 14 to select it. 

6. From the Assign menu select Joint Static Loads ... and then Forces .•• from the submenu. 
This will display the Joint Forces dialog box. 

7. In this dialog box: 

• Select EQX from the Load Case N ame drop-down box . 

• In the Options area, select the Add to Existing Loads option . 

• In the Loads area type 2.67 in the Force Global X edit box . 

• Click the OK button to apply the load . 

8. Click the Resto re Previous Selection button @ 1 on the si de toolbar ( or select Get 
Previous Selection from the Select menu). 

9. From the Assign menu select Joint Static Loads ••• and then Forces ••. from the submenu. 
This will display the Joint Forces dialog box. 

1 O. In this dialog box: 

• Select EQY from the Load Case N ame drop-down box. 
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• In the Loads area type O in the Force Global X edit box. 

• In the Loads area type 3.83 in the Force Global Y edit box. 

• Click the OK button to apply the load. 

11. Click on joints 11, 13, 15 and 17 to select them. 

12. From the Assign menu select Joint Sta tic Loads ... and then Forces ... from the submenu. 
This will display the Joint Forces dialog box. 

13. In this dialog box: 

• Select EQX from the Load Case N ame drop-down box. 

• In the Options area, select the Add to Existing Loads option. 

• In the Loads area type 2 in the Force Global X edit box. 

• In the Loads area type O in the Force Global Y edit box. 

• Click the OK button to apply the load. 

14. Click the Resto re Previous Seiection button @ j on the si de toolbar ( or select Get 
Previous Selection from the Select menu). · 

15. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu. 
This will display the Joint Forces dialog box. 

16. In this dialog box: 

• Select EQY from the Load Case N ame drop-down box. 

• In the Loads area type O in the Force Global X edit box. 

• In the Loads area type 2.88 in the Force Global Y edit box. 

• Click the OK button to apply the load. 

17. Click on joints 1 O, 12, 16 and 18 to select them. 

18. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu. 
This will display the Joint Forces dialog box. 

19. In this dialog box: 
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• Select EQX from the Load Case Name drop-down box. 

• In the Options area, select the Add to Existing Loads option. 

• In the Loads area type 1.33 in the Force Global X edil box. 

• In the Loads area type O in the Force Global Y edit box. 

• Click the OK button to apply the load. 

20. Click the Resto re Previous Selection button [f§ 1 on the side toolbar ( or select Get 
Previous Selection from the Select menu). · 

21. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu. 
This will display the Joint Forces dialog box. 

22. In this dialog box: 

• Select EQY from the Load Case !\ame drop-down box. 

• In the Loads area type O in the Force Global X edit box. 

• In the Loads area type 1.92 in the Force Global Y edit box. 

• Click the OK button to apply the load. 

23. We will now defme the PUSHPAT load pattem that will be used in the pushover analysis. lt 
will be a triangular distribution ofload over the height ofthe building. From the Select menu 
select Select and then Groups ... from the submenu. This will display the Select Groups 
dialog box. 

Note: Our purpose here is to input an inverted triangular loading pattern over the height of 
the building. Thus we will put 1 kip loads at 9 second leve/ joints (9 kips total) and 2 kip 
loads at 9 roof leve/ joints (18 kips total). We could assign the 9 kips at the second leve/ 
and 18 kips at the roof leve/ to the joints on a tributary area basis, or sorne other basis, 
but we will not consider any such refinement in this examp/e. 

24. Click on the group name 2ND and then click the OK button. 

25. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu. 
This will display the Joint Forces dialog box. 

26. In this dialog box: 

• Select PUSHPAT from the Load Case Name drop-down box. 
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• In the Loads area type 1 in the Force Global X edit box. 

• In the Loads area type O in the Force Global Y edit box. 

• Click the OK button to apply the load. 

27. Click the Up One Gridline buttoni.J on the main toolbar to display the rooflevel plan at 
Z=24. 

28. From the Select menu select Select and then Groups ••. from the submenu. This will display 
the Select Groups dialog box. 

29. Click on the group name ROOF and then click the OK button. 

30. Click on joints 22 and 26 to deselect them. 

31. From the Assign menu select Joint Static Loads .•. and then Forces .•• from the submenu. 
This will display the Joint Forces dialog box. 

32. In this dialog box: 

• Select PUSHPAT from the Load Case N ame drop-down box. 

• In the Loads area type 2 in the Force Global X edit box. 

• Click the OK button to apply the load. 

33. From the Assign menu select Clear Display of Assigns to clear the display ofjoint loads. 
Note that the joint element labels remain because they were turned on using the Set Elements 
command. 

34. Click the Save Model button 00 on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the assignment of joint static loads. 
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Step 14: Assigning Joint Masses 

We will addjoint masses consisten! with those shown in Table B-l. 

1. Click in the window labeled X-Y Plane @ Z=24 to make sure it is active. Note when the 
window is active, its tille bar will be highlighted. 

2. Click joint 24 to select it. 

3. From the Assign menu select Joint and then Masses ... from the submenu. This will display 
the Joint Masses dialog box. 

4. In this dialog box: 

• Type • 72 in the Direction 1 edit box in the Mas ses in Local Directions area. 

• Type . 72 in the Direction 2 edit box in the Masses in Local Directions area. 

• In the Options area, select lhe Add to Existing Masses oplion. 

• Click lhe OK button to apply lhe mass. 

Note: If we wanted lo obtain vertical direction mode shapes we should include a Direction 3 
mass as we/1. 

5. Click joints 20, 23, 25 and 28 lo select lhem. 

6. From lhe Assign menu selecl Joint and lhen Masses .•• from lhe submenu. This will display 
lhe Joint Masses dialog box. 

7. In Ibis dialog box: 

• Type .48 in both lhe Direclion 1 edil box and lhe Direclion 2 edil box in lhe Masses in 
Local Direclions area. 

• Click the OK button to apply lhe mass. 

8. Clickjoints 19, 21,27 and 29 to selecl them. 

9. From lhe Assign menu select Joint and lhen Masses ... from lhe submenu. This will display 
the Joinl Masses dialog box. 

1 O. In this dialog box: 

• Type .3 in bolh lhe Direction l edit box and the Direclion 2 edit box in lhe Masses in 
Local Directions area. 
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• Click the OK button to apply the mass . 

11. Click the Down One Gridline button~ on the main toolbar to display the second floor plan 
at 2=12. 

12. Clickjoint 14 to select it. 

13. From the Assign menu select Joint and then Masses ••. from the submenu. This will display 
the Joint Masses dialog box. 

14. In this dialog box: 

• Type 1.45 in both the Direction 1 edit box and the Direction 2 edit box in the Masses in 
Local Directions area. 

• Click the OK button to apply the mass. 

15. Clickjoints 11, 13, 15 and 17 to select them. 

16. From the Assign menu select Joint and then Masses ... from the submenu. This will display 
the Joint Masses dialog box. 

17. In this dialog box: 

• Type .9 in both the Direction 1 edit box and the Direction 2 edit box in the Masses in 
Local Directions area. 

• Click the OK button to apply the mass. 

18. Clickjoints 10, 12, 16 and 18 to select them. 

19. From the Assign menu select Joint and then Masses .•• from the submenu. This will display 
the Joint Masses dialog box. 

20. In this dialog box: 

• Type .55 in both the Direction 1 edit box and the Direction 2 edit box in the Masses in 
Local Directions area. 

• Click the OK button to apply the mass. 

21. From the Assign menu select Clear Display of Assigns to clear the display of joint masses. 
Note that the joint element labels remain because they were tumed on using the Set Elements 
command. 
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22. Click the Set Elements buttonj-ª.J on the main toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. 

23. In this dialog box uncheck the Labels box in the Joints area and click the OK button. This 
will tum off the display of joint la beis. 

24. Click the Save Model button 11111 on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the assignment of joint masses. 

,, 
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Step 15: Assigning Diaphragm Constraints 

We will assign a diaphragm constraint at the second leve! to simulate a rigid diaphragm. 

l. Click in the window labe!ed X-Y Plane@ Z=l2 to make sure it is active. Note when the 
window is active, its title bar will be highlighted. 

2. Select all elements at the second leve! by "windowing". 

3. From the Assign menu choose Joint, and then Constraints ... from the submenu. This will 
display the Constraints dialog box. 

4. In this dialog box: 

• In the Click To area, click the drop-down box and select Add Diaphragm. This will 
display the Diaphragm Constraint dialog box. 

• In this dialog box: 

./ Type 2NDDIA in the Constraint N ame edit box . 

./ Select the Z Axis option in the Constraint Axis area . 

./ Click the OK button. 

• Click the OK button to exit the Constraints dialog box and assign the second floor leve! 
diaphragm constraint. 

Note: The joints change colors indicating the constraint has been assigned. 

5. From the Assign menu select Clear Display of Assigns to clear the display of joint 
constraints. 

6. Click the Save Model button ~ on the main toolbar, or se!ect Save from the File menu to 
save the file. 

This completes the assigning of diaphragm constraints. 
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Step 16: Static and Dvnamic Analvsis (Not Pushover) 

In this step we will set the analysis options for the static and dynamic analysis (not pushover) 
and run the analysis. 

1. From the Analyze menu select Set Options ••.. This will display the Analysis Options dialog 
box. 

2. In this dialog box: 

• Check the Dynamic Analysis check box. 

• Click on the Set Dynamic Parameters button. This will display the Dynainic Analysis 
Parameters dialog box. 

• In this dialog box: 

./ Type 6 in the Number OfModes edit box 

./ In the Type of Analysis area select the Eigenvectors option . 

./ Accept the other default values in the dialog box . 

./ Click the OK button. 

• Check the Generate Output check box. 

Note: The Generate OuÍput option creates output that wi/1 be stored in the *.out file 
where * represents your SAP2000 filename. 

• Click on the Set Output Options button. This will display the Select Output Results 
dialog box. 

• In this dialog box: 

./ Check the Displacements check box 

./ Click on the Select/Show Loads button adjacent to the Displacements check box. 
This displays the Select Output dialog box . 

./ Click on the EQX load case to highlight it. Hold down the control key and click on 
the EQY lo~d case to add it to the selection . 

./ Click the OK button to close the Select Output dialog box . 

./ Click the OK button to close the Select Output Results dialog box. 

• Click the OK button again to exit the Analysis Options dialog box: 
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Note: It is importan/ to note that when displacements or force are specified lo be 
printed in the *.out files using the Genera te Output option. data for each and 
every joint or element is printed. You have no control over this. For larger 
problems this can lead to very large and unwieldy output files. Se e the notes at 
the ends of steps 18 and I 9 for informa/ion on other printing options. 

Note: Ifyou are running a large model, you may want/need to increase the memory 
allocated to SAP2000 abo ve the default 2000 Kb. You can do this in the AnaZvsis options 
dialog box. 

3. Click the Run Analysis button :: ol on the main toolbar. 

Note: You can also click the Analyze menu and select Run or select Run Minimized to run 
the analysis. Run minimized wi/1 peiform the execution in the background, i.e .. it >l'ill 
allow you to minimize SAP2000 while the anaZvsis is being carried out. It also provides 
a Cancel button that allows you to stop a run that is in progress. 

4. A window is opened in which various phases of analysis are progressively reported. When 
the analysis is complete the screen will display as shown in Figure C-18. 
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5. Use the scroll bar to review the analysis messages and check for any error or warning 
messages (there should be none). 

Note: The informa/ion in the scrol/ing analysis window can also be found in the *.logfile, 
where the • represents your filename. 

6. Click the OK button in the Analysis window to clase it. Note that the 3-D window now 
shows the frrst mode shape. 

This completes the static and dynamic analysis. 
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Step 17: Reviewing Mode Shapes 

In this step we will review the mode shapes. 

l. Note that the first mode shape is currently displayed in the 3-D View window. Click on this 
window to make sure it is active. Note when the window is active, its tille bar will be 
highlighted. 

2. Click the Display M o de Shape button 1+1 on the main toolbar, ( or select Show Mode 
S ha pe ... from the Display menu). The Mode Shape dialog box appears. 

3. In this dialog box: 

• Set the mode number to 1 in the Mode Number area. 

• Set the scale factor to 1 in the Scale Factor area. 

• Select (i.e., check) the Wire Shadow and Cubic Curve options in the Options area. 

• Click the OK button to redisplay the first mode. 

4. Click the Start Animation button 1 SlortAnimation 1 , located in the status bar at the bottom 
ofthe SAP2000 window, to animate the mode shape. 

5. Click the Right Arrow buttonl::J, located in the status bar at the bottom ofthe screen, to 
view the next mode shape. 

Note: When viewing mode shapes, the right and left arrow buttons, located in the status 
bar at the bottom of the screen, provide an easy way to view the next (right arrow), or 
previous (left arrow) mode shape. 

6. Using the Right Arrow button, review modes 2 through 6. Note that mode 1 is 
predominantly in the X-direction; we will use this information when creating pushover load 
cases. 

Note: Additional informa/ion on mode shapes including modal periods and frequencies, 
modal participa/ion factors and modal participating mass ratios can be found in the 
*.OUT file. 

7. After viewing mode 6, click the Stop Animation button 1 StopArlmoli:rl f, Iocated in the status 
bar at the bottom ofthe SAP2000 window, to stop the mode shape animation. 

8. Click the Show Undeformed Shape button OJto clearthe display ofmode shapes. 

This completes the review of displaying mode shapes. 
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Step 18: Reviewing Deformed Shapes 

In this step we will demonstrate methods for reviewing the deformed shapes and displacements. 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its title bar will be highlighted. 

2. Click the Display Static Deformed Shape buttonJ A , (or select Show Deformed Shape ... 
from the Display menu). The Deformed Shape dialog box appears. 

3. In this dialog box: 

• Select the EQX Load Case from the Load drop-down box. 

• Select the Auto scaling option in the Scaling area. 

• Check both the Wire Shadow and the Cubic curve boxes in the Options area. 

• Click the OK button to display the deformed "hape. 

4. Click the Start Animation button 1 StortAnimation 1 , located in the status bar at the bottom 
ofthe SAP2000 windo~, to animate the deformed shape. 

5. Click the Stop Animation button 1 !stopAnimetian: 1, located in the status bar at the bottom of 
the SAP2000 window, to stop the deformed shape animation. 

6. Click the Right Arrow button~, located in the status bar at the bottom ofthe screen, to 
view the next deformed shape, based on the EQY static load. 

Note: When viewing deforrned shapes, the right and left arrow buttons, located in the 
status bar at the bottorn of the screen, provide an easy way to view the next (right 
arrow), or previous (left arrow) deforrned shape. You can easily cyc/e through al/ of 
the load cases in this rnanner. 

7. Right click on any joint in the 3-D view to bring up a dialog box with displacements for all 
six degrees offreedom (UX, UY, UZ, RX, RY, RZ) for thatjoint. When done viewing these 
displacements, right click another joint, or left click anywhere to close the dialog box. 

8. From the Display menu select Set Output Table Mode ... to display the Select Output 
dialog box. 

9. All ofthe load cases in the Select Output dialog box should be seleéted (higlighted). Ifthey 
are not, click on each one while holding down the Ctrl key to select them. Click the OK 
button to accept this selection. 

Note: lfwe wanted to, we could select only one, or afew load cases, instead of al/ ofthern. 
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1 O. Right click any joint to gel atable of displacements for the jo in t. Note yo u can print this 
table by selecting Print from its associated File menu. When done viewing this table click 
the "X" in the upper right-hand comer to clase it. 

Note: Yo u can also right click a frame element ora shell element to gel a table offorces for 
that element. 

Note: Yo u can also print joint displacements from the graphic inteiface without 
having tofirst view them in atable. With this method you can control the elementsfor 
which the output is provided (printed). Afier the analysis has been run. select al/ of 
the jointsfor which you want displacement output. (Note that ifyou don 't select any 
elements, then this fea tu re will give yo u output foral/ elements.) Then select Print 
Output Tables .•• from the File menu. Fill in the resulting Print Output Tables dialog 
box, remembering to select the load cases for which you want output, and click the 
OK button. Note that with the Print Output Tables fea tu re yo u have the option of 
printing lo the printer orto afile. Ifyou print lo afile, an ASCII file is created which 
you can review in a text editor or word processor. 

11. Click the Show Undeformed Shape button O lto clear the display of deformed shapes. 

This completes the review of deformed shapes and displacements .. 
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Step 19: Reviewing Forces and Stresses 

In this step we will demonstrate methods for reviewing the forces and stresses in frame and shell 
elements. 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its title bar will be highlighted. 

2. Click the Member Force Diagram for Frames buttonl F 1. (or select Show Element 
Forces/Stresses from the Display menu and then select Frames ... from the submenu). The 
Member Force Diagram for Frames dialog box appears. 

3. In this dialog box: 

• Select the EQX Load Case from the Load drop-down box. 

• Select the Moment 3-3 option in the Componen! area. 

• Select the Auto scaling option in the Scaling area. 

• Check the Fill Diagram box. 

• Click the OK button to display the moment diagrams as filled shapes. 

4. Right click on any element to display a dialog box that allows you to see the moment at any 
point along the element. When done viewing, right click on another element or left click 
anywhere to close the dialog box. 

5. Click the Member Force Diagram for Frames buttonl F 1. again (or select Show Element 
Forces/Stresses from the Display menu and then select Frames ... from the submenu). The 
Member Force Diagram for Frames dialog box appears. 

6. In this dialog box: 

• Uncheck the Fill Diagram box. 

• Check the Show Values on Diagram box. 

• Click the OK button to display the moment diagrams with critica! values shown. 

7. Right click on any element to display a dialog box that allows you to see the moment at any 
point along the element. When done viewing, right click on another element or left click 
anywhere to close the dialog box. 
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8. Click the Element Force/Stress Contours for SheHs button S ! , ( or select Show Element 
Forces/Stresses from the Display menu and then select Shells .•• from the submenu). The 
Element Force Stress/Contours for Shells dialog box appears. 

9. In this dialog box: 

• Select the EQX Load Case from the Load drop-down box. 

• Select the Forces option button. 

• Select the FI2 componen! by checking its box. 

• Accept the rest ofthe default values. 

• Click the OK button to display the shell element forces. 

10. Suppose we nowwant to see the Y-direction force transferred from the roofdiaphragm to 
joints !9, 23, 26 and 27 in static load case EQY. Todo this we will use the Group Joint 
Force Sum feature. Click in the window labeled X-Y Plane@ 2=12 to make sure it is active. 
Note when the window is active, its title bar will be highlighted. 

11. Click the Up One Gridline button ~ on the main toolbar to display the roof leve! plan at 
2=24. 

12. Click the Set Elements buttonj~ on the main toolbar (or select Set Elements ... from the. 
View menu). This displays the Set Elements Dialog box. 

13. In this dialog box check the Labels box in the Joints area, uncheck the Hide box in the Shells 
area if it is checked, check the La beis box in the Shells area and click the OK button. This 
will tum on the display of joint la beis and shelllabels. 

14. Click onjoints 19, 23,26 and 27 and on shells 2, 4 and 6. 

15. From the Assign menu choose Group Name.... This will display the Assign Group dialog 
box. 

16. In this dialog box: 

• Type ROOFSHR in the edit box at the top ofthe Groups area. 

• Click the Add New Group N ame button to defme a group named ROOFSHR. 

• Click the OK button to assign the selected elements to the group named ROOFSHR. 

17. From the Display menu select Set Output Table Mode ... to display the Select Output 
dialog box. 
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18. All ofthe load cases in the Select Output dialog box should be selected (higlighted). Ifthey 
are not, then click on each one while holding down the Ctrl key to select them. Click the OK 
button to accept this selection. 

Note: lf we wanted to, we could select only one, ora few load cases, instead of al/ of them. 

19. From the Display menu select Show Group Joint Force Sums ... to display the Select 
Groups dialog box. 

20. In that dialog box click on the ROOFSHR group to highlight it and click the OK button. 

Note: We could select more than one group at this time if we wanted to. 

21. The group joint force sum for the ROOFSHR group is displayed for each load case. The Y­
direction force transferred from the roof diaphragm to joints I 9, 23, 26 and 27 in static load 
case EQY is the FY force for load EQY. 

Note: We can use groups to define section cuts through she/1 elements (and frame e/ements) 
at any location and then use the GroupJoint Force Sumfeature lo see theforces acting 
at that section cut. Todo this, imagine a section cut through the structure. The section 
cut m ay be through the en tire structure or through a portian of the structure. Se/ect al/ of 
the elements that the section cut pass es through, and select al/ of the joints connected to 
those e/ements on one si de of the section cut. Note yo u must select both the she/1 andlor 
frame e/ements and the joints. Define a group that includes al/ of the selected items. Use 
the Show Group Joint Force Sum option on the Display menu to show the forces at the 
section cut. 

22. We can display the base shear using the BASE group we previously defined. From the 
Display menu select Show Group Joint Force Sums ... to display the Select Groups dialog 
box. In that dialog box click on the BASE group to highlight it and click the OK button. 

23. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. 

24. In this dialog box uncheck the Labels box in the Joints area, uncheck the Labels box in the 
Shells area and click the OK buttori. This will tum offthe display of joint labels and shell 
labels. 

25. We can display output tables of element forces on the screen. 

26. From the Display menu select Set Output Table Mode ... to display the Select Output 
dialog box. 
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27. In the Select Output dialog box click on the EQX Load Caseto highlight it and then hold 
down Ctrl key and click on the EQY Load Case to highlight it. Click the OK button to 
accept this selection. 

28. Right click any frame or shell element to gel atable offorces for that elernent. 

Note: Yo u can also right click a joint to get atable ofjoint displacements. 

Note: Yo u can al so print frame and shell element forces from the graphic interface 
without having to first view them in a table. With this method you can control the 
elements for which the output is provided (printed). After the ana(vsis has been run. 
select al/ oftheframe and!or shell elementsfor which you wantforce output. (Note 
that if yo u don 't select any elements, then this fea tu re wi/1 give yo u output foral/ 
elements.) Then select Print Output Tables .•. from the File m en u. Fi/1 in the 
resulting Print Output Tables dialog box, remembering to select the load cases for 
which you want output, and click the OK button. Note that with the Prinl Output 
Tablesfeature you have the option ofprinting to the printer orto afile. lfyou print 
to afile, an ASCII file is created which yo u can review in a text editor or word 
processor. 

This completes the review of forces and stresses. 
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Step 20: Performing a Steel Design Stress Check 

Now we will perform a steel design stress check. 

l. From the Options menu, click Preferences .•• to display the Preferences dialog box. 

2. In this dialog box: 

• Select the Steel tab. 

• Click the Steel Design Code drop-down box to review the available options. Select the 
AISC-ASD89 option. 

• Click the OK button to close the Preferences dialog box. 

3. Click on the Design menu. Note t!Íat the Steel Design option on the menu is checked 
indicating a steel design will be done. 

Note: Either the Steel Design or Concrete Design option can be checked on the Design 
menu, but not both at the same time. 

4. On the Design menu choose Select Design Combos. The Design Load Combinations 
Selection dialog box is displayed. 

Note: SAP2000 automatical/y crea tes appropriate load combinations for the selected design 
code. F or this model, using AISC-ASD89, these ten default load combinations will 
inc/ude DL, DL + LL, DL + LL + EQX, DL + LL - EQX, DL + LL + EQY, DL + LL -
EQY; DL +EQX, DL- EQX, DL + EQY and DL- EQY. 

5. In this dialog box: 

• 

• 

Click on the DSTL 1 combination in the Design Combos box to highlight it. 

Click the Show button to review the combination . 

Note: Clicking the Remove button when a Design Combo is highlighted will remove that 
combination from the Design Combo box and put it in the List of Combos box. Only 
the design combinations in the Design Combo box are in. the design stress check. 

Note: You can also add your own combinations to the design combinations. To define a 
new load combination, click Load Combinations ... on the Define menu. To add the 
new load combination to the design /ist, highlight the new load combination name, 
that will be in the List of Combos box in the Design Load Combinations Selection 
díalog box, and click the Add button. 

• Review the other combinations in a similar manner. 
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• Press the OK button twice to close a!l dialog boxes. 

6. Click in the window labeled 3-D View to make sure it is active. 

7. Click the Set Elements buttonll!J on the main toolbar (or select Set Elements .•. from the 
View menu). This displays the Set Elements Dialog box. 

8. In this dialog box check the Hide box in the She!ls area and click the OK button. This wi!l 
turn offthe display of shells. 

9. On the Design menu choose Start Design/Check of Structure. The design check ofthe 
structure proceeds. 

10. When the design is complete, the member stress ratios are displayed on the structure as 
shown in Figure C-19. Note that many ofthe beam stress ratios are quite high. This has 
occurred because by default SAP2000 assumes that the beams are unsupported for their fu!l 
length. For simplicity we will assume that the unsupported length for a!l beams is two feet, 
except for the roofbeam at the braced frasme where it is one foot. This makes an unbraced 
length ratio of 0.0833 for a!l beams. We will make this change and rerun the design. 

Note: The assumption that the unsupported length for a/1 beams is 2 feet m ay not be 
rea!istic in a real building. 

111 SAP2000- sopwbOic fi@EJ 

• 

Figure C-19: Initial Member Stress Ratios 
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1 l. From the Select menu select Select and then Groups ... from the submenu. This will display 
the Select Groups dialog box. 

12. Click on the group name ROOF once to highlight it, then, holding down the Ctrl key, click 
on the group named 2ND to add it to the selection. Click the OK button. 

13. On the Design menu choose Redefine Element Design Data. The Element Overwrite 
Assignments dialog box is displayed. 

14. In this dialog box: 

• In the Assignment Options area check the box labeled Unbraced Length Ratio (Minor, 
LTB) and then type .0833 in the Unbraced Length Ratio (Minor, LTB) edit box. 

• Click the OK button to close the Preferences dialog box. 

15. On the Design menu choose Start Design/Check ofStructure. The second design check of 
the structure proceeds. ·, 

16. When the design is complete, the member stress ratios are displayed on the structure as 
shown in Figure C-20. 
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17. Right click on any member to bring up the Steel Stress Check lnformation dialog box for that 
member. This dialog box shows details ofthe interaction ratio for each design load 
combination at each design station along the element. 

18 To get additional detail on any item in this dialog box, highlight the item and click the 
Details button. A detailed form with design information, similar to that shown in Figure C-
21 will appear. Note you can print this form by clicking the associated File menu and 
selecting Print. Click the "X" in the upper right-hand comer ofthis detailed form to close it. 

Note: Jf this form is too big to fully fit on your screen, yo u m ay have to increase your screen 
resolution. Typically, it shou/dfit ifyour resolution is 800 x 600 and you use smallfonts 
or 1024 x 768 and you use largefonts. 

lB Steel Stress Check lnformat1on AISC-ASD89 El 
File .... - -~-- .·' 

STEEL SECTION CHECK Units: __ K.ip-f_t _. 

Frame ID: 1q Station Loe: zq.000 Section ID: wzqX55 
Element fype:: Homent Resistin'g - Classification: Compaet 

L•Zq.000 
A•0.113 i22•0.001 i33•0.0G5 
s22•0.005 s33•0.066 r22•0.11l .. r33•0.7G1 
E•q176000.000 fy•51sq.0o0. 

' 

P-H33-H22 Demand/Capacity Ratio is O.q77 O 000 + 0.q77 + 0.000 

STRESS CHECK FORCES 

Combo DSTL3 

& MOHENTS 
p 

0.000 
H33 

-1~q.323 

H22 
0.000 

AXIAL FORCE & BIAXIAL HOMENT DESIGN (HZ-1) 

Axial 

Hajor Bending 
Minor Bending 

SHEAR DESIGN 

Hajor Shoar 
Minor Shear 

fa 
Stress 
0.000 

fb 
Stress 

2177.078 
0.000 

fv 
Stre~s 

319.208 
o.ooo 

Fa Ft 
Allowable Allowable 

2855.653 311o.q00 

Fb Fo 
Allowablo Allowablo 

3q21 qqo 2160q.658 
3888.000 6711 q. sq1 

FU Str-ess 
Allowablo Ratio 

2073.600 9.115 
2073 600 0.000 

U2 
20.638 

Cm K 
Factor Factor 

1 .000 1 . ooo 
1. ooo 1. ooo 

Figure C-21: Detailed Steel Stress Check Information 
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19. Clicking on the Redesign button will take you to the Element Overwrite Assignments dialog 
box discussed in item 13. 

20. Click the OK button to close the Steel Stress Check Information dialog box. 
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21. Now we will confirm the unbraced length ratios that were used. From the Design menu, 
select Display Design Info .•. to display the Display Design Results dialog box. 

22. In this dialog box: 

• Select the Design Input option. 

• In the design input drop-down box select Unbraced L_ratios. 

• Click the OK button to display the unsupported length ratios. They are displayed as 
Major Unbraced Length Ratio; Minor Unbraced Length Ratio. 

23. Ifyou wanted to print a picture ofthe rnodel with the unbraced length ratios displayed you 
could do so by selecting Print Graphics from the File menu now. 

24. If yo u wanted to print design information to the printer, orto a file, yo u could do so by 
selecting Print Design Tables ... from the File menu and completing the resulting dialog 
box. Note that if yo u select members prior to entering this dialog box, yo u ha ve the option of 
printing output for the selected members only. 

25. Click the Show Undeformed Shape button O !to clear the display ofunsupported length 
ratios. 

26. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elernents Dialog box. 

27. In this dialog box uncheck the Hide box in the Shells area and click the OK button. This will 
tum the display of shells back on. 

The completes the review of performing a steel design stress check. This also completes Part 1 
ofthis tutorial. 
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D. Tutorial Part 2 - Pushover Analvsis 

This portion ofthe tutorial explores the pushover analysis capabilities ofSAP2000. It is 
assumed that yo u ha ve basic knowledge of the pushover concept, and that yo u are familiar with 
the ATC-40 and FEMA-273 documents. 

lfyou did not complete part C ofthe tutorial, and thus create the basic model, then you should 
open the file named SapwbOic.sdb that was supplied with this tutorial. Note that in a typical 
analysis yo u should ha ve, at the very least, run and reviewed the results of a static analysis to 
verify the behavior of your model prior to running a pushover analysis. 

SAP2000 has extensive online help for the pushover analysis. Press FJ from within a pushover 
related dialog box to get context sensitive help related to the dialog box. To see all ofthe help 
items related to pushover analysis, select Search For Help On ••. from the Help menu, select the 
Index Tab, highlight the Pushover index entry and click the Display button. 

Step 1: Defining Hinge Properties (Pushoverl 

In this tutorial we will use the default hinge properties, so it is not necessary to define any new 
properties. In this step we will review the process ofviewing airead y defmed hinge properties, 
and will discuss the process of defming new hinge properties. This step can be· skipped if you do 
not want to review the hinge properties. 

Background: There are three types of hinge properties in SAP2000. They are defau/t 
hinge properties, user-dejined hinge properties and generated hinge properties. Only 
default hinge properties and user-dejined hinge properties can be assigned to frame 
elements. When these hinge properties are assigned lo a frame element, the program 
automatical/y creates a different generated hinge property for each and every• hinge. 

Default hinge properties can not be modified. They also can not be viewed beca use 
the default properties are section dependen!. The default properties can not be fui/y 

· dejined by the program until the section that they apply to is identified. Thus to see 
the effect ofthe default properties, the default property should be assigned to aframe 
element, and then the resu/ting generated hinge property shou/d be viewed. The 
built-in default hinge properties are typical/y based on FEMA-273 and/or ATC-40 
criteria. 

User-dejined hinge properties can be either be based on default properties or they 
can be fui/y user-dejined. When user-dejined properties are based on default 
properties, the hinge properties can not be viewed because, again, the default 
properties are section dependen!. When user-dejined properties are not based on 
default properties, then the properties can be viewed and modified. 

The generated hinge properties are used in the ana/ysis. They can be viewed, but 
they can not be modijied. Generated hinge properties have an automatic naming 
convention of Labe/H#, where La be/ is the frame element /abe/, H stands for hinge, 
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and # represents the hinge number. The program starts with hinge number 1 and 
increments the hinge number by one for ea eh consecutive hinge applied to the frame 
element. For example if aframe element /abe/ is F23, the genáated hinge property 
namefor the second hinge applied to theframe element is F23H2. 

The m a in reason for the differentiation between defined properties (in this co/llext, 
defined means both default and user-defined) and genera red properties is that 
typically the hinge properties are section dependen/. Thus it would be necessary to 
define a different ser ofhinge propertiesfor each dijferentframe section type in the 
model. This could potentially mean that a very large number of hinge properties 
would need to be defined by the user. To simp/ifY this process, the concept of default 
properties is used in SAP2000. When default properties are used, the program 
combines its built-in default criterio with the defined section properties for ea eh 
element to generare the final hinge properties. The net effect of this is that yo u do 
signiflcantly less work defining the hinge properties because you don 't have ro define 
each and every hinge. 

l. From the Define m en u choose Hinge Properties .... This will display the Define Frame 
Hinge Properties dialog box. 

2. Note there are four default hinge properties defined. They are Default-M3, Default-P, 
Default-PMM, and Defáult-V2. Highlight the Default-M3 property. Note that the 
Modify/Show Property button is inactive because yo u can not view or modify default hinge 
properties. 

3. Check the Show Generated Props check box. lfthere were generated hinge properties they 
would now appear in the Defined Hinge props list box. However, since we ha ven 't yet 
assigned any hinge properties, the program hasn 't generated any, and thus non e appear in the 
list box. 

4. Highlight the Default-V2 hinge propertyand click on the Define New Property button. The 
Frame Hinge Property Data dialog box appears. 

Note: When you highlight a property in the Defined Hinge Props area of the Define 
Frame Hinge Properties dialog box, and then c/ick the Define New Property button, 
the new property wi/1 default to being the same as the highlighted property. 

5. Note that the Hinge Type is Shear V2, and that the associated Default check box is checked. 

6. Type USER in the Property N ame edit box. 

7. Click on the Default check box to uncheck it, and then click the Modify/Show For V2 
button. This displays the Frame Hinge Property Data For USER dialog box. 

8. In this dialog box: 
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• In the Force-Displacement spreadsheet and diagram area: 

"' Note that the symmetric check box is checked and that the hinge property force­
displacement diagram is symmetric. In the diagram, the axes are shown in red. The 
horizontal axis is displacement and the vertical axis is force. 

Note: When the symmetric check box is 
checked, the upper portian (points 
B-, C-, D- andE-) ofthe input 
spreadsheet for the hinge force­
disp/acement properties is gray. 
You can not edil these values; they 
are automatically picked up from 
symmetry with points B, C, D andE. 

._' Change the Force/Yield value for point 
e from 1.25 to 1.5 by typing 1.5 into the 
appropriate spreadsheet cell and then 
clicking in any other spreadsheet cell . 

---le 
B 

D 

Displacement 

E 

._' Note the change in shape ofthe force-displacement diagram. The diagram is scaled 
to fit within the plot area. 

"' Note that the Force/Yietd value for point C- has changed al so from -1.25 to -1.5. 

"' Uncheck the symmetric check box by clicking it. Note that points B- through E- are 
no longer gray. Also note that in the Acceptance Criteria area, the Negative column 
is no longer gra y. 

"' Change the Force/Yield value for point C- from -1.5 to -2 and click in another 
spreadsheet cell. Again note the change in shape ofthe force-displacement diagram. 

• In the Scaling area note that the Calculate Yield Force and Calculate Yield Displacement 
check boxes are checked by default. This means that the program will automatically 
calculate these values. We could, for example, overwrite the yield force by unchecking 
the Calculate Yield Force check box and typing in an appropriate value in the Yield 
Moment edit box. For this tutoría! we will accept the default and ha ve the program 
calculate the yield values. 

• In the Acceptance Criteria area we will also accept the default values. Note that since the 
Symmetric box is not checked both Positive and Negative values are input. Ifthe 
Symmetric box was checked, only Positive values would be input (the Negative column 
would be gray and inactive). 

Note: The acceptance criteria are input as the ratio of displacement over yield 
displacement, similar to the force-displacement spreadsheet. 
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• In the Type area select the Force-Displacement option. This controls whether the data in 
the spreadsheet and the acceptance criteria are interpreted by the programas force­
displacement or stress-strain. The stress-strain option is only available for axial and shear 
hinges (uncoupled). 

Note: When the Type option is set to stress-strain, a hinge length must be input. The 
hinge length can be input asan absolute length ora relative length. The relative 
length is relative to the c/ear length of the frame element between rigid end 
offsets. lf the stress-strain option is chosen, the program infernal/y tran~forms the 
data into aforce-displacementformatfor analysis. Theforce is calculated as the 
stress times the frame member axial area ( uA) for axial hinges and the stress 
times theframe member shear area (uA 1) for shear hinges. The displacement is 
calculated as the strain times the hinge length (d). 

• Click the OK button three times to accept the USER hinge property definition. 

• We will now delete the USER hinge property since we are not going to use it. 

• From the Define menu choose Hinge Properties .... This will display the Define Frame 
Hinge Properties dialog box. 

• H ighlight the USER hinge property and click on the Delete Property button. Click the 
Y es button when the program asks ifit is OK to delete Frame Hinge USER from list. 

• Click the OK button to accept the change in hinge properties and exit the Defme Frame 
Hinge Properties diálog box. 

Note: lf yo u c/ick the Cancel button the property wi/1 no/ be deleted. 

This completes the review of defining hinge properties. 
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Step 2: Assigning Hinge Properties (Pushover) 

We will assign Default-PMM hinges to each end ofthe moment frame columns and the braced 
frame columns. We will assign Default-M3 hinges to each end ofthe moment frame beams. We 
will assign Default-P to the center of each brace. 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its title bar will be highlighted. 

2. From the Select menu choose Select, and then Groups ... from the submenu. This will 
display the Select Groups dialog box. 

3. Highlight the group named FRCOLS by clicking on it. 

4. Hold down the CTRL key and highlight the group named BRCOLS by clicking on it to add it 
to the selection. 

5. Click the OK button to select all ofthe elements in the FRCOLS and BRCOLS groups. 

6. From the Assign menu choose Frame, and then Hinges (Pushover) ••• from the submenu. 
This will display the Frame Hinges (Pushover) dialog box. 

7. In this dialog box: 

• 

• 

Select Default-PMM in 
the Hinge Property 
drop-down box. 

Type O in the Relative 
Distance edit box. 

Note: Relative 
distance is 
meas u red from the 
1-end of the be a m, 
and is based on the 
clear length 
between rigid end 
offsets. A "O" 
relative distance 
indica/es the hinge 

Fro.me H1nges (Pushover) 

is at !he 1-end of the beam. A "/" re/ative distance indicates the hinge is at the j­
end of the beam. Hinges may be located anywhere along the length of the beam. 

• Click the Add button to add a PMM hinge at the I-end (relative distance equals O) end of 
the beam. 

SAP2000 Web Tutorial 1 90 



• Type 1 in the Relative Distance edit box. 

• Click the Add button to add a PMM hinge at the J-end (relative distance equals 1) end of 
the beam. 

• Click the OK button to assign the hinge properties. The model now appears as shown in 
Figure D-1. 
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Figure D-1: Model After Assigning Default-PMM Hinges To Columns 

Note: Generated hinge properties have an automatic naming convention of Labe/H#, where 
La be/ is the frame e/ement /abe/, H stands for hinge, and # represents the hinge number. 
The program starts with hinge number 1 and increments the hinge number by one for 
ea eh consecutive hinge applied to the frame e/ement. For example if a frame e/ement 
/abe/ is F23, the generated hinge property name for the second hinge applied to the 
frame element is F23H2. These are the numbers shown on the screen. The ítem in 
parenthesis next to the hinge number is the dif¡ned hinge that the generated properties 
are based on. On the screen the Defau/t-P, Default-V2, Default-V3, and Default-PMM 
are shortened to P. V2, V3 and PMM. 

8. From the Select menu choose Select, and then Groups .•• from the submenu. This will 
display the Select Groups dialog box. 

9. Highlight the group named FRMGIRD by clicking on it and click the OK button. 
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10. From the Assign menu choose Frame, and then Hinges (Pushover) .•• from the submenu. 
This will display the Frame Hinges (Pushover) dialog box. 

11. In this dialog box: 

• Select Default-M3 in the Hinge Propeny drop-down box. 

• Type O in the Relative Distance edit box. 

• Click the Add button. 

• Type 1 in the Relative Distance edil box. 

• Click the Add button. 

• Click the OK button to assign the hinge properties. 

12. From the Select menu choose Select, and then Groups ... from the submenu. This will 
display the Select Groups dialog box. 

13. Highlight the group named BRACE 1 by clicking on it. 

14. Hold down the CTRL key and highlight the group named BRACE2 by clicking on it to add it 
to the selection. 

15. Click the OK button to select all ofthe elements in the BRACEI and BRACE2 groups. 

16. From the Assign menu choose Frame, and then Hinges (Pushover) ... from the submenu. 
This will display the Frame Hinges (Pushover) dialog box. 

17. In this dialog box: 

• Select Default-P in the Hinge Property drop-down box. 

• Type .5 in the Relative Distance edit box. 

• Click the Add button to add a P hinge at the center (relative distance equals 0.5) ofthe 
beam. 

• Click the OK button to assign the hinge properties. 

18. From the Assign menu select Clear Display of Assigns to clear the display ofhinge 
assignments. 
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19. Click the Save Model button ~ on the main toolbar, or se!ect Save from the File menu to 
save the file. · 

This completes the assigning of pushover hinge properties. 

1 
; 
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Step 3: Viewing Generated Hinge Properties (Pushover) 

This section will demonstrate the process to view generated hinge properties. This step can be 
skipped if yo u do not want to view generated hinge properties. 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its title bar will be highlighted. 

2. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. 

3. In this dialog box check the Re! 1 Hinge box in the Frames area and click the OK button. 
This will tum the display ofhinges on. 

4. Note that the hinge at the top ofcolumn element 1 is labeled IH2. (Column element 1 is a 
lower leve! column located at X=-24 ft, Y=-24 ft.) We will view the properties for this PMM 
hinge. 

Note: In the hinge labe/JH2, the 1 indicares the hinge is applied toframe element l. the 
H indica/es it is a pushover hinge, and the 2 indicares it is the second hinge applied to 
thatframe element. This is an automatic naming convention used by the programfor 
generated hinges. 

5. From the Define menu choose Hinge Properties .... This will display the Define Frame 
Hinge Properties dialog box. 

6. Check the Show Generated Props check box. The generated hinge properties now appear in 
the Defined Hinge props list box. 

7. In the Al! Hinge Props area, click on the hinge labeled IH2 to highlight it and then click the 
Modify/Show Property button. This will display the Frame Hinge Property Data dialog 
box. 

8. Note that since this is a default PMM hinge, the P-M2-M3 box is checked, but it is gray and 
inactive. The program also autornatically checks the Axial P, Moment M2 and Moment M3 
boxes. Al! ofthese boxes are gray and inactive since the user can only view generated hinge 
properties not change them. 

9. Click the Modify/Show For PMM button to display the Frame Hinge Property Data For 
IH2 dialog box (see Figure D-2). · 

10. In this dialog box: 

o You can not edit any ofthe values because this is a generated hinge. 

o The spreadsheet is filled with M!Mv and 8/Sv values. 
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Figure D-2: Frarne Hinge Property Data For Generated Pushover Hinge 1 H2 

. o The default hinge properties are syrnrnetric. 

o In the sca!ing area the Yie!d Rotation is fi!!ed in and the Yield Mornent is gray and 
inactive. TheYie!d Rotation was ca!cu!ated by the prograrn based on the associated 
frarne section property. The Yield Moment is inactive beca use this is a PMM hinge and 
there is no single yield moment, there is a yie!d (interaction) surface instead. Ifthis were 
just a moment hinge then there wou!d be a va!ue in the Yie!d Moment box. 

o The acceptance criteria are 9/9y values. 

o Click the Define/Show Interaction button to display the Frame Hinge Interaction 
Surface dia!og box. In this dialog box which is mostly inactive because you are viewing 
a generated hinge property, note: 

../ The U ser Definition option is used . 

../ The Doubly Symmetric About M2 and M3 check box is checked . 

../ Five curves are used to define the interaction surface. 
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Note: The Number of Curves edit box indicates the number of equal(v spaced P-M 
curves that will be used to define the interaction suiface. Ij the Doub(r Symmetric 
About M2 and M3 box is checked, then the curves are equally spaced between O 
and 90 degrees. If the Doubly Symmetric About M2 and M3 box is not checked, 
then the curves are equa/ly spaced between O and 3 60 degrees. 

p 

M2 

Input consecutive 
curves 1n a 
counterclock\Nise 
direcnon, i e , from 
+M2to +M3. 

F~rst curve 1nput 1s P-M2 

Constructlon of 
User-Deflned lnteraction Surfa.ce 

,./ Click the Define/Show Surface button to display the Interaction Surface Definition 
dialog box. 

,./ In this dialog box: 

)> The spreadsheet shows norrnalized values ofaxialload, P, and moment, M. 
There is one P colurnn and five M colurnns corresponding to the number entered 
in the Number of Curves edit box in the previous dialog box. Use the scroll bars 
to see the other M colurnns. 

Note: The axial load is normalized by the maximum axial load value. The 
moments are normalized by the maximum moment valuefor al/ ofthe moment 
curves. Thus the maximum val u e in the spreadsheet for both axial load and 
moment is l. 

)> The diagram shows the P versus M curves. Click in an M colurnn in the 
spreadsheet to see that particular P versus M curve. The M curve at Angle O 
corresponds to +M2 bending. The M curve at Angle 90 corresponds to +M3 
bending. 

)> In the scaling area, the scale factors for both axial load, P, and moment, M, are 
shown. Note that the M scale factor applies to all of the M curves.· 

Note: Sin ce both P and M are normalized to 1, the P and M sea/e factors are the 
maximum val u es of P and M, respective/y. 

11. Click the Cancel button five (5) times to exit all ofthe Hinge Property dialog boxes. 
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12. Click the Set Elements buttoniJ!l on the main toolbar (or select Set Elements •.• from the 
View menu) to display the Set Elements Dialog box. In this dialog box uncheck the Re!/ 
Hinge box in the Frames area and click the OK button to tum offthe display ofhinges. 

This completes the viewing of generated hinge properties. 
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Step 4: Defining Sta tic Pushover Cases 

For this tutorial example we will define six static pushover cases. The first will apply the gravity 
load to the structure, and the other five will apply different distributions oflateralload to the 
structure. 

l. From the Define menu choose Static Pushover Cases ••. .' This will display the Define Static 
Pushover Cases dialog box. 

2. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

3. In this dialog box: 

• Type GRA V in the Pushover Case N ame edit box. 

• In the Options Area select the Push To Load'Level Defined By Pattem option button. 

• 

Note: Typically the Push To Load Leve/ Dejined By Pattern option is used to apply 
gravity load, and the Push To Displacement Of option is used to apply. lateral 
pushes. 

In the Load Pattem do the following: 

v' Select DL from the Load drop-down box. 

v' Type 1 in the Scale Factor edit box. 

v' Click the Add button. 

v' Select LL from the Load drop-down box. 

v' Type 0.25 in the Scale Factor edit box. 

v' Click the Add button. 

• Accept all ofthe other default values. Note that the default Control Joint,joint 19, occurs 
at the roof The dialog box appears as shown in Figure D-3. 

• Click the OK button to complete this pushover case definition. 

Note: There arejive control parameters in the right-hand side ofthe Options area. 
These parameters are used lo control the pushover analysis. For most analyses the 
dif'ault values are su.fficient. 

The Minimum Saved Steps and Maximum Saved Steps provide control over the 
number of points actual/y saved in the pushover ana/ysis. The default val u es are 
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Figure D-3: Static Pushover Case Data Dialog Box 

adequate in most cases. lfthe mínimum number of steps saved is too sma/1, you may 
not have enough points to adequately represen! the pushover curve. lf the mínimum 
and maximum number of saved steps is too large, then the analysis may consume a 
considerable amount of disk space, and it m ay take an excessive amount of time lo 
display results. 

The program automatica/ly determines !he spacing of pushover steps to be saved as 
Jollows. The maximum step /ength is egua/ to total force goal or total displacement 
goal divided by the specified Minimum Saved Steps. The program starts by saving 
steps at this increment. lf a significan! event occurs ata step length /ess than this 
increment, then the program wi/1 save the step too and pickup with the maximum 
incrementfrom there. For example, suppose the Mínimum Saved Steps and 
Maximum Saved Steps are set at 20 and 30 respective/y, and the pushover is to be to 
a displacement of 1 O inches. The maximum increment of saved steps will be 1 O 120 = 

0.5 inches. Thus, data is saved at 0.5, 1, 1.5, 2, 2.5 inches. Suppose that a significan! 
event occurs at 2. 7 inches. Then data is a/so saved at 2. 7 inches, and continues on 
from there being saved at 3.2, 3.7, 4.2, 4.7, 5.2, 5.7, 6.2, 6.7, 7.2, 7.7, 8.2, 8.7, 9.2, 9.7 
and 1 O. O inches. 
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The Maximum Saved Steps controls the number of significant events for which data 
wil/ be saved. The program will always reach the force or displacement goal within 
the specified number of maximum saved steps, however, in doing so it could ha ve to 
s!..ip saving steps at later events. For example, suppose the Minimum Saved Steps is 
set to 20, the Maximum Saved Steps is set to 21, and the pushover is to be to a 
displacement of 1 O in ches. The maximum increment of saved steps wi/1 be 1 O 120 = 
0.5 inches. Thus, data is saved at 0.5, 1, 1.5, 2, 2.5 inches. Suppose that a significan! 
event occurs at 2. 7 inches. Then data is also saved at 2. 7 inches, and continues on 
from there being saved at 3.2 and 3. 7 inches. Suppose another significan! event 
occurs at 3. 9 inches. The program will not save the data at 3.9 in ches beca use if it 
did it would not be able to limit the maximum increment to O. 5 in ches and sti/1 get 
through the fu// pushover in no more than 21 steps. Note that if a second significan! 
event occurred at 4.1 inches rather than 3.9 inches, then the program would be able 
to save the step and sti/1 meet the specified criteria for maximum increment and 
maximum number of steps. 

The Maximum Failed Steps is used, ifnecessary, to declarefailure (i.e., non­
convergence) in a run befo re it reaches the specified force or displacement goal. The 
program may be unable to converge on a step when catastrophic failure occurs in the 
structure. There may also be instances where it is unable to converge on a step due 
to numerical sensitivity in the solution. The Maximum Fai/ed Steps is a cumulative 
counter through the entire analysis. Ifthe Maximum Failed Steps is reached, the 
analysis stops. 

The Event Force Tolerance and the Event Deformation Tolerance are ratios that are 
used to determine when an event actual/y occurs for a hinge. Consider the figure that 
shows the location of 
two hinges on their 
force-displacement 
plots. Hinge 1 has 
reached an event 
location. For hinge 2, 
ifboth the Event Force 
Tolerance and the 
Event Displacement 
Tolerance are met, 
then the hinge is within 
event tolerance and it 
too wi/1 be treated as 
part of the event. In 

D E 

A'-----L-------~ 
Displacement 

thefigure, ifthe Force Tolerance divided by the Yield Force is less than the Event 
Force Tolerance specified in the Static Pushover Case Data, and the Displacement 
Tolerance divided by the horizontal distance from B to C is less than the 
Displacement Event Tolerance specified in the Static Pushover Case Data, then hinge 
2 wi/1 be treated as part ofthe event. When determining the Force Tolerance Ratio, 
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the denominator is always the yieldforce. When determining the Displacement 
Tolerance Ratio, the denominator is the horizonta//ength ofthe portian oftheforce­
displacement curve that the hinge is currently on. In the figure, hinge 2 is on the B-C 
portian of the curve, thus we used the B-C horizontallength in the denominator of the 
Displacement To/erance Ratio. 

4. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

5. In this dialog box: 

• Accept the default Pushover Case N ame, PUSH2. 

• In the Options area, select GRA V from the Start From Previous Pushover drop-down 
box. 

• In the Options area, check the Include P-Delta box if it is not airead y checked. 

• In the Options area, accept the Push to Displacement Ofvalue of0.96 feet. 

Note: The Push To Displacement Of val u e defau/ts to O. 04 times the Z coordina/e of 
the highest joint. in the model. Note that this m ay lead to very large displacements 
ifthe base ofthe model is not at Z=O. You can change this value, ifnecessary, by 
typing a new value in the edit box. 

• Accept all of the other default values in the Options Area. 

• In the Load Pattem do the following: 
·r 

v' Select PUSHPAT from the Load drop-down box. 

v' Type 1 in the Scale Factor edit box. 

v' Click the Add button. 

• Click the OK button to complete this pushover case definition. 

6. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

7. In this dialog box: 

• Accept the default Pushover Case N ame, PUSH3. 

• In the Options area, select GRA V from the Start From Previous Pushover drop-down 
box. 

• In the Options area, check the Include P-Delta box if it is not airead y checked. 
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• Accept all ofthe other default values in the Options Area. 

• In the Load Pattem do the following: 

-1' Select acc dir X from the Load drop-down box. 

-~' Type 1 in the S cale Factor edit box. 

-1' Click the Add button. 

• Click the OK button to complete this pushover case defmition. 

8. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

9. In this dialog box: 

• Accept the default Pushover Case N ame, PUSH4. 

• In the Options Area do the following: 

-~' Type .5 in the Push To Displacement Of edit box. 

-~' Select U2 from the Control Direction drop-down box. 

-1' Select GRA V from the Start From Previous Pushover drop-down box. 

-1' Accept all ofthe other default values in the Options Area. 

• In the Load Pattem do the following: 

-1' Select acc dir Y from the Load drop-down box. 

-1' Type 1 in the Scale Factor edit box. 

-1' Click the Add button. 

• Click the OK button to complete this pushover case definition. 

10. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

11. In this dialog box: 

• Accept the default Pushover Case N ame, PUSH5. 
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• In the Options area, select GRA V from the Start From Previous Pushover drop-down 
box. 

• In the Options area, check the lnclude P-Delta box. 

• Accept all ofthe other default values iri the Options Area. 

• In the Load Pattem do the following: 

v' Select MODE from the Load drop-down box. 

v' Type 1 in the Scale Factor edit box. 

v' Click the Add button. The Select Mode Number dialog box appears. 

v' Type in 1 for the mode number (corresponding to the first mode in the X-direction), 
and click the OK button. 

• Click the OK button to complete this pushover case definition. 

12. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

1 3. In this dialog box: 

• Accept the default Pushover Case N ame, PUSH6. 

• In the Options area, select GRA V from the Start From Previous Pushover drop-down 
box. 

• In the Options area, check the Include P-Delta box. 

• Accept all of the other default values in the Options Area. 

• In the Load Pattem do the following: 

v' Select acc dir X from the Load drop-down box. 

v' Type 1 in the Scale Factor edit box. 

v' Click the Add button. 

v' Select acc dir Y from the Load drop-down box. 

v' Type 1 in the Scale Factor edit box. 

v' Click the Add button. 
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• Click the OK bunon to complete this pushover case definition. 

14. Click the OK button to exit the Defme Static pushover Cases dialog box. 

15. Click the Save Model buttonlliill on the rnain toolbar. 

This completes the defmition of static pushover cases. 
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Step 5: Running the Pushover Analvsis 

l. On the Analyze menu select Run Sta tic Pushover. 

Note: To runa pushover analysis, you mustfirst have pushover hinges and pushover load 
cases defined, at /east a static anazvsis run, and, if steel members 11ith Auto sections, or 
concrete members whose reinforcing is to be designed by the program are included, you 
must have run the design portian ofthe program. 

2. A window is opened in which various phases of analysis are progressively reponed. When 
the analysis is complete the screen will display as shown in Figure D-4. 

Note: Most ofthe information in the scrolling analysis llindow is appended to the *.lag file 
that was created when the original analysis was run. 

Analys1s Complete , 

TIME POR INITIALIZING ANALYSIS 
TIME POR CONTROLLING ANALYSIB 
TIME POR FORMING STIFFNESS MATRIX 
TIME POR SOLVING STIFFNBSS MATRIX 
TIME POR CALCULATING DISPLACEMENTS 
TIME POR CALCULATING APPLIED LOADS 
TIME POR DETERMINING EVENTS 
TIME FOR UPDATING STATE 

TOTAL TIME POR THIS ANALYSIS 

• 
. ' 

• 

= 0.13 
= 0.77 
= o. 93 
= 8. 63 

0.09 
= O.lO 
= 0.07 
= o.so 

----------
ll. 22 

1 • 1 

OK 1. •· ... 

Figure D-4: S creen Message When Pushover Analysis Is Complete 

, ... 

3. Use the scroll bar to review the analysis messages and check for any error or warning 
messages ( there should be none ). 

Note: One of the items you llill see in the scrolling llindow is labeled Analysis Complete. As 
each pushover load case is running you llill see the value continually changing. It is a 
measure of what percent of your force or displacement goal yo u ha ve reached. When the 
Analysis Complete reaches 1, you have reached your goal. Note that the analysis may 
not to reach its goal (i.e., an Analysis complete of 1) because the structure 
catastropically fails ear/ier or because of numerical sensitivities. 

4. Click the OK button in the Analysis window to close it. 

This completes running the pushover analysis. 
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Step 6: Displaving the Pushover Deformed Shape and the Seguence of Pushover Hinge 
Formation · 

l. From the Options menu select Windows and the select One from the submenu. The display 
changes to one window. 

Note:· With this option yo u can select to have from one to four windows on the screen at the 
same time. Each ofthe windows can be showing a complete/y different view. 

2. Click the 3-D View button :~<~J on the main toolbar to show the default 3-D view. 

3. Click the Set Elements buttonl~ on the m~in toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. In this dialog box check the Hide 
box in the Shells area and click the OK button. This will tum off the display of shell 
elements. 

4. Click the Display Sta tic Deformed Shape buttonl A J , or from the Display menu select 
Show Deformed Shape ... to display the Deformed Shape dialog box. 

5. In this dialog box: 

• Select Push2 Static Push·from the Load drop-down box. 

• Select Auto in the Scaling area. 

• Check both the Wire Shadow and the Cubic Curve options in the Options area. 

• Click the OK buttori. 

6. The deformed shape will appear. Note that the title ofthe window includes the information 
"Deformed Shape (PUSH2 - Step 0)". Thus we are currently viewing the deformed shape at 
the start ofthe pushover. Since the PUSH2 pushover was started from the GRA V pushover, 
we are also viewing the deformed shape at the end ofthe GRA V pushover. 

Note: Recall that the PUSH2 pushover load case is the PUSHPAT static load pattern. 

7. Right click on any second leve] or roofleveljoint to see the displacement for thatjoint. The 
displacements will be very small, as is expected when only the gravity load is applied. 

8. Click the Right Arrow button~ located on the right-hand side ofthe status bar at the 
bottom ofthe scn;en to view the deformed shape ofthe next step (Step 1) in the pushover. 

Note: When viewing the pushover deformed shape and sequence of hingeformation, the 
right and left arrow buttons, located in the status bar at the bottom of the screen, 
provide an easy way to view the deformed shape for the next (right arrow), or 
previous (left arrow) pushover step. 
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9. Note that the title ofthe window includes the information "Deformed Shape (PUSH2- Step 
1)", and the building moves slightly in the X-direction. You can again right-click on any 
joint to see its displacement. You can click the Left Arrow button¡::_J to return to Step O of 
the pushover. 

e 

D E 

10. Continue clicking !he Right Arrow button l..::J 
until !he first colored hinges appear. The frrst 
colored hinges should appear in Step 4, as 
illustrated in Figure D-5. The color ofthe hinges 
indicates the state ofthe hinge, i.e, where it is 
along its force displacement curve. The legend for 
the hinge colors is included at the bottom ofthe 
screen. The points B, lO, LS, CP, C, D and E are 
illustrated in !he figure. When hinges frrst appear, 
they are at point B on the force-displacement 
curve. 

AL-----------7 
Displacement 

11 SAP20DO - pu¡:ftO 1 - (Dslormud She.pe (PUSH2- Step "')\ l!lr;l 13 
~n. [~a f.drt y¡aw Qefjna Dzaw Salact 6aa.gn A,ns~yta Q1splay Oa¡¡gn .Qpt¡ons ,tjalp 

Dlo;;lliii..::±:J.t.Jfi" __J Pl.ll[.®l.®l¡;>ll!lJI,. ,. e.. ~><11811~ 0\.a.l+\or\:r\sl•\ 

Rrghl 01ck on arry ¡oll'rtfcr d.splcu:emem \mlues 

Figure D-5: First Pushover Hinge Yielding 
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11. Continue clicking the Right Arrow buttonl::J to step through the sequence ofhinge 
formation in the pushover to the last step. Note how the colors of the hinges change as the 
pushover proceeds. 

Note: To change the color codingfor the hinges, From the Options 
menu, select Co/ors, and then select the Output tab. The color­
codingfor the pushover hinge state is controlled by the co/ors in 
the area labeled Contours. There are ten contour colors; these 
contour colors al so are used in displaying stress contours for shell 
e/ements. A'ssume the color in the top box, next to the /abe/ 

Point Color Box 

"Min ", is designated "Box 1 ", and the color in the bottom box, 
next to the /abe/ "Max", is designated "Box JO". Then the color 
coding for pushover hinge states is as defined in the tab/e. 

B 
JO 
LS 
CP 
e 
D 
E 

Box2 
Box 3 
Box4 
Box 5 
Box 6 
Box 7 
Box 8 

12. At the last pushover step right click one ofthe roofleveljoints to see its displacement. It will 
be about 0.96 feet which is consisten! with the displacement goal for the PUSH2 pushover 
load case. 

13. Click the Start Animation button l' StartAnimation 1, located in the status bar at the bottom 
ofthe SAP2000 window, to animate the deformed shape at the last step. When done viewing 
the animation, click the Stop Animation button.\ !stop An1matio~ 1 

Note: In this instance, the animation is only for the particular load step, not for the 
en tire pushover. The purpose of the imimation is to make the behavior at that 
particular load step more apparent. You can create a video of the en tire pushover 
using the Crea/e Video ... option on the File menu, however, this option will not be 
availab/e in the SAP2000 6.20 Beta version. 

14. Click the Display Sta tic Deformed S ha pe button\ Á 1 , or from the Display menu select 
Show Deformed Shape .•• to display the Deformed Shape dialog box. 

15. In this dialog box: 

• Select Push4 Static Push from the Load drop-down box. Recall this is the uniform 
acceleration in the Y -direction. 

• Click the OK button. 

16. Click the Right Arrow button l::J to step through the entire sequence of hinge formation in 
the pushover. You will note that through the sequence of steps the deformation reverses 
directions severa] times. The reason for this is dicussed in the note below. 

Note: When a hinge reaches point Con its force-displacement curve (se e figure below), 
that hinge mus/ begin lo drop load. Within the program, the way load is dropped 
from a hinge that has reached point e is that the pushover force (base shear) is 
reduced until !he force in that hinge is consisten! with theforce atpoint D. As the 
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e 

D E 

force is dropped, all e/ements un load, and the 
displacement is reduced. Once the yielded hinge 
reaches the Point D force leve/, the pushover 
force (base shear) is again increased and the 
disp/acement begins to increase again. This 
behavior is apparent when displaying the 
deformed shapes and force diagrams (moment, 
shear, etc.) for each step of the pushover, when 
viewing a video created for the pushover, and 
when displaying the force-displacement plot of 
the pushover. 

A~----------------------~ 
Displacement 

17. Click the Show Undeformed Shape button O Jto clear the display of deformed shape for 
the pushover. 

18. Click the Set Elements button !1811 on the rnain toolbar ( or select Set Elements ••• from the 
View menu). This displays the "?ee Elements Dialog box. 

19. In this dialog box: 

• Uncheck the Shrink Elements box in the options area (if it is checked). 

• Click the OK button. 

This completes the review ofthe pushover deformed shape and the sequence ofpushover hinge 
formation. You may want to step through the deformed shapes for the other pushover load cases 
before proceeding on to the next step. 
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Step 7: Displaving Frame Element Forces at Each Step ofthe Pushover 

l. Click the Member Force Diagram for Frames buttonLrJ, or from the Display menu select 
Show Element Forces/Stresses, and then Frames •.. to display the Member Force Diagram 
for Frames dialog box. 

2. In this dial o g box: 

• Se!ect Push2 Static Push from the Load drop-down box. Recall this is the PUSHPAT 
static load pattern. 

• In the Componen! area select the Moment 3-3 option. 

• In the Scaling area select the Auto option. 

• Check the Fill Diagram box. Note ifthe Show Values on Diagram box is checked, you 
will ha ve to uncheck it béfore you can check the Fill Diagram box. 

Note: Theframe elementforcesfor each step ofthe pushover can be displayed either 
with the jilled diagram or with the values shown on the diagram. 

• Click the OK button. The display appears as shown in Figure D-6. 

81 SAP?(IDO- flli"ShOt .. liJEJ 
file fOil y¡ew Oefine 0[!!'111' Salad 6ssrgn A,nalyze jllsplay Oes1g¡ .Qpt¡ons tiBip 

D\~1¡;¡\~L)fi' _ij PI.~IJB!ft>Lsll!lll "'i.O!uiFI..,.I ~~\181\_!.l!J O!AI+fa-lrlsl•l 
El ... omentl•l Dragram (PUSH2- Step O) l!ll!JI!I 

! . 
' 

1 

0~-!· 
• 
• 

Rlghl Oic:kon anyfrem11 Elementlot deii!Jied cilegnzm. 

Figure D-6: Pushover Forces fM3-3) at Step O 
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3. Note that the title ofthe window includes the infonnation "Moment 3-3 Diagram (PUSH2-
Step O)". Thus we are currently viewing the M33 moments at the start ofthe pushover. 
Since the PUSH2 pushover was started from the GRA V pushover, we are also viewing the 
M33 moments at the end ofthe GRA V pushover. 

4. Note you can right click on any frame element for a detailed diagram. When done viewing a 
detailed diagram, right click on another element to view its detailed diagram, or left click 
anywhere to finish viewing detailed diagrams. 

5. Click the Right Arrow button~ located on the right-Iiand side ofthe status bar at the 
bottom ofthe screen to view the M-33 diagram at the next step (Step 1) ofthe pushover. 

Note: When viewing the pushover forces, the right and left arrow buttons, located in the 
status bar at the bottom of the screen, provide an easy way to view the forces for the 
next (right arrow), or previous (left arrow) pushover step. 

6. Continue clicking the Right Arrow button~to step through the moment diagrams for 
each step ofthe pushover. You can right click an element at any step for a detailed diagram. 

7. Click the Show Undeformed S ha pe button O lto clear the display of element forces for the 
pushover. 

This completes the review ofthe frame element forces at each step ofthe pushover. You may 
want to step through the el~ment forces for other force components and for other pushover load 
cases before proceeding on to the next step. 
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Step 8: Displaving Pushover and Capacitv Spectrum Curves 

l. From the Display menu select Show Static Pushover Curve ... to display the Pushover 
Curve dialog box. 

Note: Jf this dialog box does not ful/y fit on your screen then yo u m ay want lo increase the 
resolution ofyour screen. The dialog box should ful/y fit on the screen ifyour resolution 
is 800 x 600 with sma/1 fonts, or 102 4 x 7 68 l<ith large fonts. 

2. If no plot is visible in the plot area, then click the Display button at the bottom ofthe form. 

Note: Jf at any time the plot area display is not visible in the Pushover curve dialog box, 
click the Display button. 

3. For practice, press the Fl key on the keyboard to see context sensitive on-line help pertaining 
to this dialog box. 

4. When finished with the online help click the "X" in the upper right-hand comer ofthe Help 
window to close it, or choose Exit from the File menu on the Help window. 

5. Notice that in the Plot Type area, the Base Shear vs Control Displacement option is selected: · 

Note: The base shear that is plotted in the Base Shear vs Control Displacenient plot is the 
resultan! base shear. The displacement plotted is the displacement in the control 
direction (not resultan!} atthe control joint. 

6. The dialog box currently appears as shown in Figure D-7. Note the following: 

• The Demand Spectrum ·area and the Damping Parameters area are gray and inactive. 
These areas will become active when the Capacity Spectrum option is chosen in the Plot 
Type area. 

• There are four boxes just below the plot area. These boxes are the Cursor Location, the 
Performance Point {V, D), the Performance Point (Sa, Sd), the Performance Point (Teff, 
¡leff). When the Base Shear vs Control Displacement option is chosen in the Plot Type 
area, only the Cursor Location box is active. Place the cursor (mouse pointer) anywhere 
over the plot and the coordinates ofthe pointer will appear in the Cursor Location box. 
The Performance Point boxes are only filled in when the Capacity Spectrum option is 
chosen in the Plot Type area. 

• lf we wanted to in elude sorne notes with any printed graphic output, we could type those 
notes in the Additional Notes For printed Output edit box. 
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• PUSHOVER CURVE- CASE PUSH2 · 
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Figure D-7: Pushover Curve For Pushover Load Case PUSH2 

7. Suppose we want to change the color ofthe base shear versus displacernent curve frorn the 
default green color to blue. Todo this click on the green color box in the Plot Type area to 
open the Color dialog box. 

8. In this dialog box: 

• Click on one ofthe blue colored boxes. 

• Click the OK button to change the color. 

o If necessary, click the Display button to redisplay the plot. 

9. To change the curve color back to the default green, click the Reset Default Colors button. 

1 O. Now we will override the axis labels and range. The axis labels and range will appear on the 
screen and on any graphic output. Click the Override Axis Labels/Range button. The 
Override Axis Labels and Range dialog box appears. 
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11. In this dialog box: 

o In the Horizontal Range area type 2 in the Max edit box. 

o In the Axis Labels area type Control Joint Dispiacement in the Horizontal edit box. 

o In the Axis Labels area type Resultan! Base Shear in the Vertical edit box. 

o Click the OK button to change the axis labels and range. 

12. Now we will reset the default axis labels and range. Click the Override Axis Labels!Range 
button. The Override Axis Labels and Range dialog box appears. 

13. In this dialog box: 

o Click the Reset Defaults button. 

o Click the OK button. 

14. Select PUSH3 from the Static Pushover Case drop-down box. The plot changes to that for 
PUSH3. Recall that PUSH3 is the uniform acceleration in the X-direction.· 

Note: lf at any time you want to check and see the definition of a pushover load case click 
the Done button to clase the Pushover Curve dialog box. Then.from the Define menu 
select Static Pushover Cases •••. and when the Define Static Pushover Cases dialog box 
appears, select the pushover case you are interested in, and click the ModifY/Siww 
Pushover button. 

15. Review the base shear versus control displacement curves for the other pushover load cases. 

16 Select PUSH2 from the Static Pushover Case drop-down box. 

17. Select the Capacity Spectrum option in the Plot Type area. As shown in Figure D-8, the plot 
changes and the Demand Spectrum area and the Damping Parameters area are now active. 

Note: When the capacity spectrum option is chosen, the pushover curve is displayed in 
ADRS (Acceleration-Displacement Response Spectrum) formal. Refer to ATC-40 for a 
discussion of this formal which is essentially a plot of spectral acceleration versus 
spectral displacement. In SAP2000, theforce-displacementpushover curve is converted 
to the ADRSformat by converting the resultan! base shear toa spectral acceleration, Sa, 
and the control displacement in the control direction toa spectral displacement, Sd, 
general/y based on equations 8-1 thru 8-4 in ATC-40. 
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Figure D-8: Capacity spectrum For Pushover Load Case PUSH2 

18. In the Demand Spectrum area note the following: 

• The Seismic Coefficient Ca and the Seismic Coefficient Cv both default to 0.4. Each of 
these values can be changed by typing a new value the appropriate edit box. These 
values control the shape ofthe 5% damped spectrum. Refer to ATC-40, Chapter4, for a 
discussion of, and appropriate values for, Ca and Cv. 

o The Show Family ofDemand Spectra check box is checked indicating that the family of 
demand spectra, with up to four different damping ratios, is shown on the plot. The color 
box adjacent to the Show Family ofDemand Spectra check box is red (by default) 
indicating that the family of demand spectra is shown in red. You can change the color 
by clicking on the color box. 

• There are four edit boxes labeled Damping Ratios. The numbers entered in these boxes 
are 0.05, O. 1, O. 15 and 0.2. These are the default damping ratios for the family of demand 
spectra. You can change any ofthese values by typing a new value in the appropriate 
edit box. The damping values do not ha ve to be input in arder. lf yo u lea ve a Damping 
Ratio box blank, or entera zero (0), then that curve will not be plotted. 
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Note: The damping ratios must be between O and l. A value of5% of critica/ 
damping should be entered as 0.05, not 5. 

• The Show Single Demand Spectrum (Variable Damping) check box is checked indicating 
that the single demand spectrum is shown on the plot. The color box adjacent to the 
Show Family ofDemand Spectra check box is yellow (by default) indicating that the 
single demand spectrum is shown in yellow. You can change the color by clicking on the 
color box. 

Note: The single demand spectrum (variable damping) curve is constructed by doing 
thefollowingfor each point on the ADRS pushover curve: 

J. Draw a radia/fine Radial line has constant period 
through the point Point on single demand spectruffi 
on theADRS (variable damping) associated with 

pushover curve. arbitrary point on pushover curve 

This is a fine of Pushover curve 

constant period. 
S a Demand spectrum ploned at same 

damping leve! as associated with 

2. Calculare the 
arbitrary pomt on pushover curve 

damping Arbitrary point on pushover curve 

associated with the 
point on the curve 

Damping based on area under pushover 
based on the area 
under the curve up 

curve up to arbitrary point 

to that point. 

3. Construct the demand spectrum, plotting it for the same damping leve/ as 
associated with the point on the pushover curve. 

4. The intersection point ofthe radia/fine and the associated demand 
spectrum represents a point on the Single Demand Spectrum (Variable 
Damping) curve. 

This method is similar to the method called Procedure B in Chapter 8 of ATC-40 
except it does not make the simplifying assumption that the post yield stiffness 
remains constant. It is essential/y the method referred to as "exact" in the 
discussion ofthe method called Procedure C in Chapter 8 of ATC-40. 

• The Show Constan! period Lines At check box is checked indicating that up to four 
different constant period lines are shown on the plot. The color box adjacent to the Show 
Constant period Lines At check box is gray (by default) indicating that the constant 
period lines are shown in gray. You can change the color by clicking on the color box. 
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Note: In the ADRS fomzat, /in es of constan! period show up as straight /in es 
radiatingfrom the origin. 

• There are four edit boxes associated with the Show Constan! period Lines At check box. 
The numbers entered in these boxes are 0.5, 1, 1.5 and 2. These are the default periods 
for the lines ofconstant period. You can change any ofthese values by typing a new 
value in the appropriate edit box. The periods do not ha ve to be input in order. If yo u 
ieave a Period box biank, or enter a zero (0), then that line will not be piotted. 

19. In the Damping Parameters area note the following: 

• The lnherent + Additional Damping box defaults to 0.05. This value can be changed by 
typing a new value in the edit box. 

Note: To he/p you understand what value to input in the !nherent + Additional 
Damping box, refer to ATC-40 equation 8-8. The /30 term in this equation is 
automatically included by the SAP2000 analysis method. The 5% inherent viscous 
damping term can be specijied in the !nherent/Additiona/ Damping edil box as 
O. 05. lf there is additional viscous damping provided in the structure, perhaps by 
viscous dampers that are not specifically included in the model, then this damping 
should also be included in the Inherent!Additional Damping edit box. Thus if the 
damping inherent in the structure is assumed to be 5% of critica/ damping, and 
dampers which provide an additional 7% of critica/ damping are assumed to be 
added to the structure (although they are not actual/y in the model), then the 
value input in the Inherent!Additional Damping edil box should be O. 12, since 
0.05 + 0.07 = 0.12. . 

lf dampers modeled with NLLink elements are included in the model, then for the 
pushover analysis, the program treats them as linear e/ements. Their stiffness is 
based on the linear effective stiffness (KE) and the damping is based on the linear 
effective damping coefficient (CE). The program uses the linear effective 
damping coefficient for !he damper, together with the effective period to calcula te 
damping which is internally added to the specified Inherent/Additional Damping 
term. 

• There are four Structurai Behavior Type options: A, B, e and U ser. Structural Behavior 
type B, which shouid be currently seiected, is the default. Structural Behavior Types A, 
B and e, which defme a kappa (K) factor that reduces the assumed damping, are taken 
directly from ATe-40. The User option allows input ofother values ofkappa (K). 

Note: Refer to ATC-40 Section 8.2.2.1. 1 for a discussion of structura/ behavior types. 
The structural behavior type is used lo specify a kappa (K) factor (see Figure 8-15 
in ATC-40) that modifies (reduces) the calculated area ofthe hysteresis /oops lo 
account for assumed pinching ofthe loops. 
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20. The performance point in Sa, Sd coordinates is shown in the Performance Point (Sa, Sd) box 
below the plot. The units for Sa are always g; the curren! units for Sd are feet. Note you 
could also estimate the value ofthe performance point by holding the mouse pointer over the 
performance point (intersection of the ADRS pushover curve and the single demand 
spectrum (variable damping)) and reading the value in the Cursor Location box. 

Note: The location of the m o use pointer is specijied in the Cursor Location box as 
(Horizontal axis location, Vertical Axis location). Thus when looking at the 
Performance Point using the mouse pointer, you will read (Sd, Sa), which is 
switchedfrom how it is specijied in the Performance Point (Sa, Sd) box. 

21. In the Demand Spectrum area, type .6 into the Seismic Coefficient Cv edit box. Click the 
mouse somewhere on the pushover curve dialog box outside ofthe Seismic Coefficient Cv 
edit box to enter the change. Note how both the plot and the Performance Point informal ion 
below the plot change. Note that the performance point in Sa, Sd coordinates changes. 

22. Type .4 into the Seismic Coefficient Cv edit box. Click the mouse on the plot to enter the 
change. 

23. Uncheck the Show Family ofDeniand Spectra box. The family of demand spectra are 
removed from the plot. 

24. Check the Show Family ofDemand Spectra box to show the family of demand spectra again. 

25. In the Damping Ratios edit boxes, type .3 in the last box. Click the mouse on the plot to 
enter the change. Note that the lowest demand spectra got even lower when we increased the 
damping ratio from 0.2 to 0.3. 

26. Type .2 in the last Damping Ratios edit box and click the mouse on the plot to return the 
form to its original state. 

27. In the Darnping Ratios edit boxes, delete the value in the second edit box and click the mouse 
on the plot to enter the change. Note that only three demand spectra now appear on the plot, 
one with 5% damping, one with 15% damping and one with 20% damping. 

28. Type .1 in the second Damping Ratios edit box and click the mouse on the plot to return the 
form to its original state. 

29. Uncheck the Show Single Demand Spectrum (VariableDamping) box. The single demand 
spectrum is removed from the plot. · 

30. Check the Show Single Demand Spectrum (Variable Damping) box to show the single 
demand spectrum again. 

31. Uncheck the Show Constan! Period Lines At box. The constan! period lines are removed 
from the plot. 
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32. Check the Show Constan! Period Lines At box to show the period lines again. 

33. In the fourth (and last) edit box below the Show Constan! Period Lines At check box, type 3. 
Click the mouse on the plot to enter the change. Note that the last period line became flatter. 

34. Type 2 in the fourth edit box below the Show Constan! Period Lines At check box and click 
the mouse on the plot to retum the form to its original state. 

35. In the Damping Parameters area, type .2 in the lnherent + Additional Damping edit box. 
Click the mouse on the plot lo enter the change. The relalive location oflhe single demand 
speclrum (variable damping) curve changes and lhe performance point location changes. 

36. Type 0.05 in the Inherenl + Addilional Damping edil box and click the mouse on the plol to 
relurn lhe form to ils original si ale. 

37. In the Damping Parameters area, click the Slniclural Behavior Type A option and observe 
the change in the relative location ofthe single demand spectrum (variable damping) curve 
and the performance point. 

38. Click the Structural Behavior Type C option again observing the change in the relative 
location ofthe single demand spectrum (variable damping) curve and the performance point. 

39. Click the Structural Behavior.Type- U ser option, and note that the adjacent Modify/Show 
button becomes available. Click the Modify/Show button to display the Override Structural 
Behavior Type dialog box. 

40. In this dialog box: 

• In the Point 1 area type 20 in the Beta 
Sub Zero edit box and type .6 in the 
Kappa Factor edit box. 

• In the Point 2 area type 45 in the Beta 
Sub Zero edit box and type .6 in the 
Kappa Factor edit box. 

• Click the OK button and observe the 
change in the relative location ofthe 

First segment 

Point !J1 

Refer to ATC-40 
Section 8.2.2.1.1 
and Figure 8-!5 

Third segment 

. 2J1 Pomt 

BetaSubZero, Po 

single demand spectrum (variable damping) curve and the performance point. 

41. Click the Structural Behavior Type B option to retum the form to its original state. 

42. From the File menu at the top ofthe Pushover Curve dialog box select Display Tables. A 
table similar to that shown in Figure D-9 appears. 
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JaPUSHOVER CAPACITY/DEMAND COMPARISON El 

Figure D-9: Table For Capacity Spectrum 

43. In this table note the following: 

• Step identifies the step number in the pushover curve. 

• Teffis the effective period at the associated step. 

• Peff is the effective damping at the associated step. 

• Sd(C) and Sa(C) define a point on the ADRS capacity curve for the associated step. 

• Sd(D) and Sa(D) define a point on the single demand spectrum (variable damping) curve 
for the associated step. 

• Alpha is the factor used in converting the base shear to spectral acceleration at the 
associated step. 

• PF*cjl is the factor used in converting the displacement to spectral displacement at the 
associated step. 

• To print this table, click on the File menu at the top ofthe table and select either Print 
Tables, to print to a printer, or Print Tables To File .•. , to print the table to a file. 

44. Click the "X" in the upper right-hand comer ofthe table to close it. 

45. Select the Base Shear vs Control Displacement option in the Plot Type area. 
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46. From the File menu at the top ofthe Pushover Curve dialog box select Display Tables. A 
table similar to that shown in Figure D-1 O appears. 

SI'USHOVEA CURVE El 
Elle 

st.,. DJ..¡llaoeD.mt Ba•e Shear A-B B-:10 IO-LS :LS-CP CP-c C-D ·-· >E TOTAL 

O 4.002E-04 0.0000 .f.B O O o O o o o 48 
__ 1 ___ 0. oto-. ---28.3708 --.8---o--o--o---¡¡--0---o----o--¡a--

2 0.0964 Sti.7417 48 o o o o o o o 48 
3 O .l.4U 95.11.27 48 o o o o o o o 48 

• 0.1856 109. 48ll 40 2 o o o o o o 48 
5 0.23315 1.25. 1036 40 2 o o o o o o 48 

• 0.2398 127.11.46 .. • o o o o o o 48 
1 0.2878 136.8057 .. • o o o o o o 48 
8 0.3358 146.4968 .. • o o o o o o 48 
9 0.3780 154.9516 42 4 2 o o o o o 48 

10 0.4148 158.5392 u .5 2 o o o o o 48 
11 0.4154 158.5750 40 • 2 o o o o o 48 
12 0.4634 1.59. 4686 •o • • o o o o o 48 
13 0.5114, 160.3621 •o • • o o o o o 48 
u O.SS!U ltil. 2551 40 • • o o o o o 48 
15 0.6074 162.1492 •o 2 • o o o o o 48 
16 0.6554 163.0428 40 o 8 o o o o o 48 
17 o. 7034 163.9364 •o o 8 o o o o o 48 
18 o. 7514 164.8299 40 o 8 o o o o o 48 
19 0.7994. 165.7235 •o o 8 o o o o o 48 
20 0.8474 166.6170 •o o 8 o o o o o 48 
21 0.895f 167.5106 •o o • 2 o o o o 48 

Figure D-10: Table For Pushover Curve 

47. In this table note the following: 

• Step identifies the step number in the pushover curve . 

• Displacement and Base Shear define a point on 
the pushover curve for the associated step. e 

B 

• A-B, B-10, 10-LS, LS-CP, CP-C, C-D, D-E, >E "' 10 LS 
" 

all identify the total number of hinges within 
... D "' ¡,¡, 

each ofthese ranges on their associated force-
displacement curves. 

A • TOTAL is the total number ofpushover hinges Displacement 
in the structure. 

• To print this table, click on the File menu at the top ofthe table and select either Print 
Tables, to print to a primer, or Print Tables To File ••. , to print the table to a file. 

48. You can also print graphic plots ofthe pushover curve and/or capacity spectrum curve as 
follows: 
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• Set up the plot on the screen ( either in Base Shear vs Control Displacement, or in 
Capacity Spectrum forma!) as you want to print it. 

• If yo u want to change the axis labels or the axis range, click the Override Axis 
Labels/Range button and make the desired changes. 

• Ifyou want to ha ve additional notes printed on the graphics plot, type those notes in the 
Additional Notes For Printed Output edit box. 

• To print the graphics, select Print Graphics from the File menu at the top ofthe 
Pushover Curve dialog box. 

Note: Another technique that can be used is to crea/e a screen p/ot of the entire 
dialog box which you can then printfrom another program such as Paint, 
Microsoft Word for Windows, or any other program that supports graphics. 

To create the screen plot, press the A ir and Print Screen keys on your keyboard. 
This wil/ senda copy of the active window to the c/ipboard. (Note that ifyou just 
press the Print Screen key, without the Alt key, you wil/ senda picture ofthe 
entire screen ro the clipboard.) Open your other program that supports graphics 
and paste the picture into that program. Usual/y the command ro paste the 
picture is cal/ed Paste, and it can be found on a menu ca/led Edit. Once yo u ha ve 
pasted the picture into afile created in your program that supports graphics, you 
can printfrom there. 

49. Click the "X" in the upper right-hand comer ofthe table to close it. 

50. Click the Done button to close the Pushover Curve dialog box. 

This completes the review of displaying the pushover and capacity spectrum curves. 

SAPlOOO Web Tutoría! 1 122 



E. Final Comments 

This tutorial, together with the SAP2000 online help pro vides extensive documentation of all of 
the pushover analysis features available in SAP2000. lt is intended that you can use this tutorial 
as a continuing reference for SAP2000 pushover analyses. 

As previously noted, you can obtain context-sensitive online help from within any pushover 
dialog box by pressing the Fl key while that dialog box is open. The names of each ofthe basic 
pushover analysis topics covered in the online help are listed below. 

• Nonlinear Static Pushover Analysis 

• Define Frame Hinge Properties 

• Frame Hinge Property Data 

• Frame Hinge Property Data For XXX 

• Frame Hinge Interaction Surface 

• Interaction Surface Definition 

• Define Static Pushover Cases 

• Static Pushover Case Data 

• Assign Frame Hinges (Pusho, er) 

• Pushover Curve 

• Override Axis La beis And Range 

• Override Structural Behavior Type 

The Nonlinear Static Pushover Analysis topic gives an overview ofthe SAP2000 pushover 
analysis capabilities. The other topics pro vide context-sensitive help for dialog boxes ofthe 
same name. 

Finally, it is emphasized that the SAP2000 documentation for the pushover is not intended to, 
and does not, document the pushover analysis method, but rather is intended to document the 
pushover analysis capabilities of SAP2000. For information regarding the pushover analysis 
method you should refer to the ATC-40 and FEMA-273 documents which are referenced below. 

ATC, 1996 
Seismic Eva/uation and Retrojit ofConcrete Buildings, Volume 1, ATC-40 Report, Applied 
Technology Council, Redwood City, California. 

FEMA, 1997 
NEHRP Guide/ines for the Seismic Rehabilitation of Buildings, Developed by the Building 
Seismic Safety Council for the Federal Emergency Management Agency (Report No. FEMA 
273), Washington, D.C. 
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DISCLAIMER 

CONSIDERABLE TIME, EFFORT AND EXPENSE HA VE GONE INTO THE 
DEVELOPMENT AND DOCUMENTATJON OF SAP2000. THE PROGRAM HAS 
BEEN THOROUGHL Y TESTED AND USED. IN USING THE PROGRAM, 
HOWEVER, THE USER ACCEPTS AND UNDERSTANDS THAT NO WARRANTY 
IS EXPRESSED OR IMPL!ED BY THE DEVELOPERS OR THE DISTRIBUTORS 
ON THE ACCURACY OR THE RELIABILITY OF THE PROGRAM. 

THE USER MUST EXPLICITL Y UNDERST AND THE ASSUMPTIONS OF THE 
PROGRAM AND MUST INDEPENDENTL Y VERIFY THE RESUL TS. 
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Introduction 

This is a quick tutorial that introduces sorne ofthe pushover analysis features available in 
SAP2000. For a more detailed pushover analysis tutorial refer to the SAP2000 Web Tutoriall. 
The basic model used in this tutorial, Sapwb02.sdb, is developed from scratch in SAP2000 Web 
Tutorial l. 

SAP2000 has extensive online help for the pushover analysis. Press F 1 from within a pushover 
related dialog box to get context sensitive help related to the dialog box. To see all ofthe help 
items related to pushover analysis, select Search For Help On ... from the Help menu, select the 
Index Tab, highlight the Pushover index entry and click the Display button. 

To begin this tutorial, open the file named Sapweb02.sdb using the Open ... command from the 
File menu. 

Note: It may be helpful to save thefile with a different name so that you retain a copy of 
the origina/file. You can do this by selecting Save As .•. from the File menu. 

Step 1: Assignimi Hinge Properties (Pushover) 

We will assign Default-PMM hinges to each end ofthe moment frame colurnns and the braced 
frame colurnns. We will assign Default-M3 hinges to each end ofthe moment frame beams. We 
will assign Default-P to the center of each brace. 

l. Click in the window labeled 3-D View to make sure it is active. Note when the window is 
active, its tille bar will be highlighted. 

2. From the Select menu choose Select, and then Groups ••• from the submenu. This will 
display the Select Groups dialog box. 

3. Highlight the group named FRCOLS (frame columns) by clicking on it. 

4. Hold down the CTRL key and highlight the group named BRCOLS (braced frame colurnns) 
by clicking on it to add it to the selection. 

5. Click the OK button to select all ofthe 
elements in the FRCOLS and BRCOLS 
groups. 

6. From the Assign menu choose Frame, and 
then Hinges (Pushover) ••. from the submenu. 
This will display the Frame Hinges (Pushover) 
dialog box. 

rrome thn«¡es (Pushover) 
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• Select Default-PMM in the Hinge Property drop-down box. 

• Type O in the Relative Distance edit box. 

Note: Relative distance is measured from the I-end of the frame element, and is based 
on the c/ear /ength between rigid end offsets. A "O" relative distance indicares the 
hinge is al the I-end of the frame element. A "1" re/ative distance indicates the 
hinge is al thej-end oftheframe element. Hinges may be /ocated anywhere along 
the /ength of the frame element. 

• Click the Add button to add a PMM hinge at the I-end (relative distance equals O) end of 
the frame element. 

• Type 1 in the Relative Distance edit box. 

• Click the Add button to add a PMM hinge at the J-end (relative distance equals 1) end of 
the frame element. 

• Click the OK button to assign the hinge properties. The model now appears as shown in 
Figure l. 

IKSAPZOOO- pus.h01 B~D 
file fdrt ~ew Define Drew .5.eJ!td óss¡gn A,oolyre Q¡splay Oes~g~ .Qpbons .t:ielp , . . • • - • . · 

ol!ii:lliii..:±:.L1.lf'i'2l ,jj\.$IJDI.a>l.ell!lll .. H.;¡.r;,.;.¡ ~~lriil +·1 óiAf.¡;(rúls·l;;l·· 
iS 1-n Vlf!W f!lfiij E:J 

) X 
.. 

. .. 

-. ' .. - ' -: ,,·· '• '"'p-' 

· Figure 1: Model After Assigning Default-PMM Hinges To Columns 

8. From the Select menu choose Select, and then Groups ... from the submenu. This will 
display the Select Groups dialog box. 
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9. Highlight the group named FRMGIRD by clicking on it and click the OK button. 

lO. From the Assign menu choose Frame, and then Hinges (Pushover) ... from the submenu. 
This will display the Frame Hinges (Pushover) dialog box. 

ll. In this dialog box: 

o Select Default-M3 in the Hinge Property drop-down box. 

o Type O in the Relative Distance edit box. 

o Click the Add button. 

o Type 1 in the Relative Distance edit box. 

o Click the Add button. 

o Click the OK button to assign the hinge properties. 

12. From the Select menu choose Select, and then Groups ... from the submenu. This will 
display the Select Groups dialog box. 

. 
13. Highlight the group named BRACEl by clicking on it. 

14. Hold down the CTRL'key and highlight the group named BRACE2 by clicking on it to add it 
to the selection. 

15. Click the OK button to select all ofthe elements in the BRACEl and BRACE2 groups. 

16. From the Assign menu choose Frame, and then Hinges (Pushover) ... from the submenu. 
This will display the Frame Hinges (Pushover) dialog box. 

17. In this dialog box: 

o Select Default-P in the Hinge Property drop-down box. 

o Type .5 in the Relative Distance edit box. 

o Click the Add button to add a P hinge at the center (relative distance equals 0.5) ofthe 
beam. 

o Click the OK button to assign the hinge properties. 

18. From the Assign menu select Clear Display of Assigns to clear the display ofhinge 
assignments 
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19. Click the Save Model button ~ on the main toolbar, or select Save from the File menu to 
save the file. 

This completes the assigning of pushover hinge properties. 

Step 2: Defining Static Pushover Cases 

For this tutorial example we will define two static pushover cases. The frrst will apply the 
gravity load to the structure, and the other will apply lateral load to the structure. 

l. From the Define menu choose Sta tic Pushover Cases ..•. This will again display the Define 
Static Pushover Cases dialog box. 

2. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

3. In this dialog box: 

• Type GRA V in the Pushover Case N ame edit box. 

• In the Options Area select the Push To Load Leve! Defmed By Pattem option button. 

• 

Note: Typical/y the Push To Load Leve/ Defined By Pattern option is used to app/y 
gravity load, and the Push To Displacement Of option is used to apply lateral 
pus hes. 

In the Load Pattem do the following: 

.¡' Select DL from the Load drop-down box . 

.¡' Type 1 in the Scale Factor edit box . 

./ Click the Add button . 

.¡' Select LL from the Load drop-down box . 

.¡' Type 0.25 in the Scale Factor edit box . 

.¡' Click the Add button. 

• Accept all ofthe other default values. Note that the default Control Joint, joint 19, occurs 
at the roo( The dialog box appears as shown in Figure 2. 

• Click the OK button to complete this pushover case definition. 
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Figure 2: Static Pushover Case Data Dialog Box 

4. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

5. In this dialog box: 

• Accept the default Pushover Case Name, PUSH2. 

• In the Options area, select GRA V from the Start From Previous Pushover drop-down 
box. 

• In the Options area, check the Include P-Delta box if it is not already checked. 

• Accept all ofthe other default values in the Options Area. 

• In the Load Pattem do the following: 

../ Select PUSHP AT from the Load drop-down box. 

Note: PUSHPAT is a previously defined static load case that applies an inverted 
triangular pattem of/oad over the height ofthe structure. 
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./ Type 1 in the Scale Factor edit box . 

./ Click the Add button. 

• Click the OK button to complete this pushover case defmition. 

6. Click the Add New Pushover button to display the Static Pushover Case Data dialog box. 

7. In this dialog box: 

• Accept the default Pushover Case N ame, PUSH3. 

• In the Options area, select U2 from the Control Direction drop-down box. 

• In the Options area, select GRA V from the Start From Previous Pushover drop-down 
box. 

• In the Options area, check the Include P-Delta box if it is not airead y checked. 

• Accept all of the other default values in the Options Area. 

• In the Load Pattern do the following: 

./ Select acc dir Y from the Load drop-down box. 

Note: The acc dir y load paltern provides a uniform acceleration in the Y 
direction, that is, a latera/load that is proportionalto the mass . 

./ Type 1 in the S cale Factor edit box . 

./ Click the Add button. 

• Click the OK button to complete this pushover case definition. 

8. Click the OK button to exit the Define Static pushover Cases dialog box. 

9. Click the Save Model button rlii!l on the main toolbar. 

This completes the definition of static pushover cases. 

Step 3: Running The Pushover Analvsis 

l. On the Analyze menu select Run Static Pushover. (In SAP2000 Version 6.20 Beta, you will 
need to run the static analysis first using the Run option on the Analyze menu.) 
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Note: To run a pushover ana/ysis, yo u must first have pushover hinges and pushover load 
cases defined, at least a static analysis run, and, if stee/ members with Auto sections, or 
concrete members whose reinforcing is to be designed by the program are included, you 
must ha ve run the design portian of the program. 

2. A window is opened in which various phases of analysis are progressively reported. When 
the analysis is complete the screen will display as shown in Figure 3. 

Annlys1s Complete 

'· 

TIME POR INITIALIZING ANALYSIS 
TIME POR CONTROLLING ANALYSIS 
TIME FOR FORMING STIFFNESS MATRIX 
TIME FOR SOLVING STIFFNESS MATRIX 
TIME POR CALCULATING DISPLACEMENTS 
TIME POR CALCULATING APPLIED LOADS 
TIME POR DETERMINING EVENTS 
TIME POR UPDATING STATE 

TOTAL TIME POR THIS ANALYSIS 

• 

OK 

= O.l3 
= 0.77 
= o. 93 
= 8. 63 
= 0.09 
= O.lO 
= 0.07 

0.50 

----------
= ll.ZZ 

•• : 1 • 1 

:.·, .· 

Figure 3: S creen Message When Pushover Analysis Is Complete 

: ~' 

3. Use the scroll bar to review the analysis messages and check for any error or warning 
messages (there should be none). 

4. Click the OK button in the Analysis window to clase it. 

This completes running the pushover analysis. 

Step 4: Displaving the Pushover Deformed Shape and the Seguence of Pushover Hinge 
Formation 

• 

l. From the Options menu select Windows and the select One, from the submenu. The display 
changes to one window. 

Note: With this option you can select to havefrom one to four windows on the screen at the 
same time. Each of the windows can be showing a complete/y diflerent view. 

2. Click the Show Undeformed Shape button O !to clear the display ofthe frrst mode shape. 
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3. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu). This displays the Set Elements Dialog box. In this dialog box check the Hide 
box in the Shells area and click the OK button. This will tum offthe display of shell 
elements. 

4. Click the Display Static Deformed S ha pe button~, or from the Display menu select 
Show Deformed Shape ... to display the Deformed Shape dialog box. 

5. In this dialog box: 

• Select Push2 Static Push from the Load drop-down box. 

• Select Auto in the Scaling area. 

• Check both the Wire Shadow and the Cubic Curve options in the Options area. 

• Click the OK button. 

6. The deformed shape will appear. Note that the tille ofthe window includes the information 
"Deformed S ha pe (PUSH2- Step O)". Thus we are currently viewing the deformed shape at 
the start ofthe pushover. Since the PUSH2 pushover was started from the GRA V pushover, 
we are also viewing the deformed shape at the end ofthe GRA V pushover. 

7. Right click on any second leve! or roofleveljoint to see the displacement for that joint. The 
displacements will be very small, as is expected when only the gravity load is applied. 

8. Click the Right Arrow buttonl·.;-llocated on the right-hand side ofthe status bar at the 
bottom ofthe screen to view the deformed shape ofthe next step (Step 1) in the pushover. 

Note: When viewing the pushover deformed shape and sequen ce of hinge formation, the 
right and /eft arrow buttons, loca red in the status bar at the bottom of the screen, 
pro vide an easy way lo view the deformed shape for the next (right arrow), or 
previous (/eft arrow) pushover step. 

9. Note that the title ofthe window includes the information "Deformed Shape (PUSH2- Step 
1 )", and the building moves slightly in the X-direction. Yo u can again right-click on any 
joint to see its displacement. You can click the Left Arrow button¡·; 1 to retum to Step O of 
the pushover. · 

IO. Continue clicking the Right Arrow button~ 
until the frrst colored hinges appear. The frrst 
colored hinges should appear in Step 4, as 
illustrated in Figure 4. The color ofthe hinges 
indicates the state ofthe hinge, i.e, where it is 
along its force displacement curve. The legend for 
the hinge colors is included at the bottom ofthe 

e 
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screen. The points B, 10, LS, CP, C. D and E are illustrated in the figure. When hinges frrst 
appear, they are at point B on the force-displacement curve. 

EfSAP"lUUU- pu!lh01 -IUctormcd Shepc WUSH2 -Stcp 41)1 !1913 
](, E~e Edrt Yrew Qeflne Drcw ,Select Aasrgn Anolyre O.rapray Oesrgn Qpbons J::jelp 
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Figure 4: First Pu .. :10ver Hinge Yielding 

11. Continue clicking the Right Arrow button ~ to step through the sequence ofhinge 
formation in the pushover to the last step. Note how the colors ofthe hinges change as the 
pushover proceeds. 

Note: To change the color codingfor the hinges, From the Options 
menu, select Co/ors, and then select the Output tab. The color­
codingfor the pushover hinge state is controlled by the colors in 
the area labeled Contours. There are ten con tour colors; these 
contour colors also are used in displaying stress contours for shell 
e/ements. Assume the color in the top box, next to the /abe/ 
"Min ", is designated "Box 1 ", and the color in the bottom box, 
next to the /abe/ "Max", is designated "Box JO". Then the color 
codingfor pushover hinge states is as defined in the table. 

Point 
B 
JO 
LS 
CP 
e 
D 
E 

Color Box 
Box2 
Box 3 
Box4 
Box 5 
Box 6 
Box 7 
Box 8 

12. Click the Display Static Deformed Shape buttonl.ti.J, or from the Display menu select 
Show Deformed Shape ... to display the Deformed Shape dialog box. 
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13. In this dialog box: 

• Select Push3 Static Push from the Load drop-down box. 

• Click the OK button. 

14. Click the Right Arrow button~ to step through the sequence ofhinge formation 

15. Click the Show Undeformed S ha pe button O lto clear the display of deformed shape for 
the pushover. 

This completes the review ofthe pushover deformed shape and the sequence ofpushover hinge 
formation. 

Step 5: Displaving Frame Element Forces at Each Step ofthe Pushover 

l. Click the Member Force Diagram for Frames buttoniXJ, or from the Display menu select 
Show Element Forces/Stresses, and then Frames ••. to display the Member Force Diagram 
for Frames dialog box. 

2. In this dialog box: 

• Select Push2 Static Push from the Load drop-down box. 

• In the Componen! area select the Moment 3-3 option. 

• In the Scaling area select the Auto option. 

• Check the Fill Diagram box. Note ifthe Show Values on Diagram box is checked, you 
will have to uncheck it before yo u can check the Fill Diagram box. 

Note: The frame element forces for each step of the pushover can be displayed either 
with the filled diagram or with the val u es shown on the diagram. 

• Click the OK button. The display appears as shown in Figure 5. 

3. Click the Right Arrow butto~;:;;ullocated on the right-hand side ofthe status bar atthe 
bottom ofthe screen to view the M-33 diagram at the next step (Step 1) ofthe pushover. 

Note: When viewing the pushover forces, the right and leji arrow buttons, located in the 
status bar at the bottom of the screen, provide an easy way to view the forces for the 
next (right arrow). or previous (left arrow) pushover step. 
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Figure 5: Pushover Forces (M3-3) at Step O 

4. Continue clicking the Right Arrow buttonl::Jto step through the moment diagrams for 
each step ofthe pushover. You can right click an element at any step for a detailed diagram. 

5. In this dialog box: 

• Select Push3 Static Push from the Load drop-down box. 

• In the Component area select the Axial Force option. 

• Click the OK button. 

6. Click the Right Arrow button~ to step through the axial force diagrams for the pushover. 

7. Click the Show Undeformed Shape button O lto clear the display ofelement forces for the 
pushover. 

This completes the review ofthe frame element forces at each step ofthe pushover. 

Step 6: Displaving Pushover and Capacity Spectrum Curves 

J. From the Display menu select Show Static Pushover Curve .•• to display the Pushover 
Curve dialog box. 
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Note: Jfthis dialog box does notfully fit onyour screen then you may want to increase the 
resolution of your screen. The dialog box should fu/ly fit on the screen if your resolution 
is 800 x 600 with small fonts, or 1024 x 768 with large fonts. 

2. Ifno plot is visible in the plot area, then click the Display button at the bottom ofthe fonn. 

Note: Jf at any time the plot area display is not visible in the Pushover curve dialog box, 
c/ick the Display button. 

3. Notice that in the Plot Type area, the Base Shear vs Control Displacement option is selected. 

Note: The base shear that is plotted in the Base Shear vs Control Displacement plot is the 
resultan/ base shear. The displacement plotted is the displacement in the control 
direction (no/ resultan!) at the control joint. 

4. Currently we áre looking at the pushover curve for the PUSH2 pushover load case. The 
dialog box appears as shown in Figure 6. 

PUSHOVER CURVE- CASE PUSH2 
Ella: · . ·.~; 

:,.;·; ~·.-... · .. -~:..-•• >1.· ' • 

. , . 

Figure 6: Pushover Curve For Pushover Load Case PUSH2 
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ll!PUSHOVEA CURVE El 
5Je . ".!;, 

Step Di.apl.aolmi8Dt Ba•e Shear &-B B-IO IO-LS LS-CP CP-C C-D D-E .. :)E TOT&I. ·r.·. 
o 4. 002E-0f. 0.0000 48 o o o o o o o •• 
1 0.04BC 28.3708 48 o o o o o o o 48 
2 0.0964 56.7417 48 o o o o o o o 48 
3 0.1444 85.1127 •• o o o o o o o 48 

• 0.1956 tog,tau •• 2 o o o o o o 48 

' 0.2336 1.2.5 .1036 46 2 o o o o o o 48 

• 0.2398 l.27 .uu .. • o o o o o o 48 
1 0.2878 136.8057 .. • o o o o o o 48 
8 0.3358 146.4968 .. • o o o o o o 48 

• 0.3780 1S4. 9516 42 • 2 o o o o o 48 
10 0.4148 1.58. 5392 41 S 2 o o o o o 48 
ll 0.4154 158.5750 40 • 2 o o o o o 48 
12 0.4634 159.4686 40 • 4 o o o o o 48 
13 o. 511.4 160.3621 40 • • o o o o o 48 
H 0.5594. 161.2551 40 • • o o o o o 48 
15 0.6074 162.1492 40 2 • o o o o o 48 
16 0.6554 163.0428 40 o 8 o o o o o 48 
17 o. 7034 163.9364 40 o 8 o o o o o 48 
18 0.7514 164.8299 40 o 8 o o o o o 48 
10 0.79!U 1.65.7235 40 o 8 o o o o o 48 
20 O. 84H 1.66. 6110 40 o 8 o o o o o 48 
21 0.8954 167.5106 40 o • 2 o o o o 48 .:J 

5. 

6. 

Figure 7: Table For Pushover Curve 

From the File menu at'the top ofthe Pushover Curve dialog box select Display Tables. 
table shown in Figure .7 appears. 

In this table note the following: 

• Step identifies the step number in the pushover curve . 

• Displacement and Base Shear defme a point on 
the pushover curve for the associated step. e 

D 

The 

E 
• A-B, B-IO, IO-LS, LS-CP, CP-C, C-D, D-E, >E 

all identify the total number of hinges within 
each ofthese ranges on their associated force­
displacement curves. 

'-----

• TOTAL is the total number of pushover hinges 
in the structure. 

AL-----------------------~ 
Displacement 

7. Click the "X" in the upper right-hand comer ofthe table to close it. 

8. Select the Capacity Spectrum option in the Plot Type area. As shown in Figure 8, the plot 
changes and the Dernand S pectrum area and the Damping Parameters area are now active. 

9. From the File menu at the top ofthe Pushover Curve dialog box select Display Tables. The 
table shown in Figure 9 appears. 
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PUSHOVER CURVE- CASE PUSH2 

Figure 8: Capacity spectrum For Pushover Load Case PUSH2 

1 

1 
1 
' 1 

.1 

1 

JIIPUSHOVER CAPACITY/DEMAND COMPARISON El 
Ble .· ... _. ~-

Stop. Teff.;. Beff Sd(C) 

O 0.756 0.050 4.002E-04 0.000 0.247 0.529 1.000 1.000 : .... 
-------1·-------o:7-s6---·o·:·o46 -----·o:o39----o~·oa3 -·---o-:25'2-·-o·:·541 _____ ü:955-----¡~·2,6·--

2 0.756 0.049 0.078 0.167 0.249 0.532 0.955 1.241 
3 0.756 0.050 0.116 0.250 -0.24.7 0.530 0.955 1.240 
4 0.156 0.050 0.150 0.321 0.247 0.530 0.955 1.239 
5 0.192 0.083 0.188 0.368 0.226 0.441 0.953 1.241 
6 0.796 0.086 0.193 0.374 0.225 0.435 0.953 1.242 
1 0.839 0.117 0.231 0.403 0.216 0.376 0.952 1.244 
8 o.875 o.136 0.269 0.432 0.215 o·_J44 0.951 1.246 
9 0.902 0.145 0.303 0.457 0.216 0.326 0.950 1.248 

10 0.931 0.161 0.331 0.469 0.215 0.305 0.948 1.252 
11 0.932 0.161 0.332 0.469 0.215 0.305 0.947 1.252 
12 0.976 0.187 0.368 0.474 0.214 0.276 O.!il43 1.260 
13 1.018 0.208 0.404 0.478 0.214 0.254 0.940 1.266 
14 1.058 0.223 0.440 0.493 0.217 0.239 0.936 1.270 
15 1.096 0.233 0.477 0.497 0.221 0.226 0,934 1.274 
16 1.133 0.240 0.513 0.491 0.225 0.215 0.931 1.278 
l.7 l..l.67 0.247 0.549 0.495 0.230 0.207 0.929 l..2Bl. 
l.B l..20l. 0.252 0.586 0.498 0.234 0.3.99 0,927 l..2B3 .:J 

Figure 9: Table For Capacity Spectrum 
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10. Click the "X" in the upper right-hand comer ofthe table to close it. 

11. Select Push3 from the Static Pushover Case drop-down box to view the capacity spectrum for 
the Push3 pushover load case. 

JI. Click the Done button to close the Pushover Curve dialog box. 

This completes the review of displaying the pushover and capacity spectrum curves, and it 
completes this tutorial. lf yo u want further information on the SAP2000 ¡iushover analysis 
features, then refer to the SAP2000 Web Tutoriall and to the online help. 
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SAP2000 PlUS ElEMENTS 
SAP2000 Plus extencls the capabWties of the standard version witb 
unllmlted capadty anc1 adclltional analytlcal capabWtios 

PLANE Element 
• 3 to 9 n<XI.es plane stress or plcme stram element 
• Orthotropic mcrtenal propertJ.es 
• GrCM.ty, therm.al. surtace pressure cmd pressure gradlent looding 

ASOLID Element 
• 3 to 9 nod.es CDCSyinmetric element 
• Orthotrop¡c matertal properb.es 
• GrCIVJ.ty, thermal, surtace Piessure and pressure gradient loadmg 

SOLIO Element 
• Three dimensional 8 nade brick elenlent 
• Amsotrop!C matenal properbes 
• GrCM.ty. thermal, surtace pressure and pressure grad.Jent loa:dlng 

Dynamic Time Hlstory Analysls 
• Ground acceleration excitatton 
• Multlple b:Ise exotation 
• l.o::Jd forcmg tunctons 
• Tra:nsient or steady-stcrte 
• Multlple time hlstory cases 
• Sequenballustory cases 
• Tune hlstory Wmdows AVI file 
• Graptuc dlsplays of ncx:1al cmd element tlrne hlstory records 
• Funcbons vs bme or tunction vs tuncnon dlsplays 
• Generaban of response spectrum curves for any jomt accelercrtion 

component 
• Results can be cornbmed Wlth other Ioads for envelopmg or step by 

step steel and concrete deSlgn 

Bridge Analysls 
• Movmg load analys¡s 
• Generaban of mfluence lmes and torces envelopes 
• AASHTO vehicle lcads 
• User<iebned truck, lane cmd train loa:ds 
• Determmation of mCIXIJTlum cmd rrurumum chsplacements and. reactions 
• Cap:Jble of handmg complex teme geometnes 
• Automatically calculates all possible permutations of traffic loads 
• ProVIdes correspondence between response components 
• Results cxm be combmed. wtth other loods for envelopmg ar 

correspondmg components 1or steel and concrete de51gn 



1 =·=-#' .! 

': · ... 

í- 1 

\--1 r r ., 
-~~ ¡'·::_·:..-. 

~ ~ . . 

i 

: :: ; . .__ ·- : .. ·-::::: : ., ' 

THE STANDARD ELEMENTS 
The 2D and 3D Beam and Truss Element 
• Mulbple non-pnsmabc segments over element length 
• Pomt urutorm and trapezmdalloadmg m any d.J.recbon 
• Temperature cmd thermal grad.lent loa:dlng 
• Prestress loacting 
• Automated end offset evaluaban 
• Moment and shear releases 
• Bwlt-m steel sectJ.ons 

The 3D SheD Element 
• General quadnlateral or tnangular element 
··Orthotropic matenals 
• SIX degrees of treedom per )Olflt 
• Shell, plate or membrane acbon 
• nuck shell opbon 
• Grav1ty, uruform, pressure, temperature and thermal grad.lent loacting 

The Sprtng Element 
• Joint to ground (support) spnng 
1 Glol:al cmd skewed spnngs 
1 Coupled 6x6 user~etmed spring stittness opbon (lor foundabon mo:::l.elmg) 

Analylical OpUons 
• Stcrbc and/or dynanuc response spectrum analys15 
• P<lelta analygs with e1ther stcrbc or dynarruc analysis 
• Blocked acbve column equabon solver 
• Automated fast proflle opllrnizabon 
1 Generallzed JOU1t constramt opbons mcludmg: 

ng¡d bodies, d.laphmgms, rcx:is and welds 
• Apphed force and apphed dJsplacement Icx:rdmg 
• GravJty, pressure and thermalloadmg 
• Elgen analysiS with cm accelerated subsp::1ce Iteration algorttlun 
• Rltz analygs for fast predorrunant mode evaluaban 
• Mulbple response spectrum cases m single run 
• Modal combmabon by the SRSS, the CQC or the GMC (Gupta) methcd. 
• Dlrecbonal combmcrbons by the ABS or the SRSS methcd. 
1 Stcrbc and dynarruc response combmabons and envelopes 

Analys!s Oulput Display Opltons 
• 3D perspecbve graphJcal cilsplays of undeformed and 

detormed structural geometnes 
• Stcrbc delormed shapes and mode shapes 
• Loadmg dlagrams 
• Bend.mg moment and shear force dlagrams 
• Stress contours 
• Arumabon of deformed shapes and mode shapes 
• Arumated stress contours 
• Mulbple wmdows displaymg diHerent p::xrameters 
• lnstantaneous graphlcal and tabulated output detCllls tor 

s¡::ecúlc JOU1t or element Wlth right button click 
• Stabc and dynanuc load combmabons and envelopes 

Steel and Concrete Destgn 
1 Fully mteracbve and graphical steel and concrete trame member des~.gn 
• AISC (ASD and !JlFD). ACI. Brtbsh and Eurocodes 
• Deslgn ter stabc and dynamic !Oads 
• Ouctlle and non~ucble desJ.gn 
• Member-groupmg for deSJgn envelopes 
• Detailed onscreen design in.tormcrtion with nght button click 
• Steel rnember selecbon and opbrruzabon 
1 BlCDCial moment<CO.alload column mteractlon dlagrams 
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SAFE Problem 1 
Irregular Flat Slab 

Concrete Slab Properties 
E = 4000 ksi, Poissons Ralio = 0.2, Unil Weight = 150 pcf 
fe= 4 ksi, fy = 60 ksi 
Assume default cover for reinforcing steel 

Concrete Columns and Wall Properties 
E= 4000 ksi, Poissons Ratio= 0.2, Height =12' 

Slab Uniform Loading 
Dead Load: Slab self weight plus 50 psi superimposed DL 
Live Load: 100 psf typical. 250 psf between column lines 3, 5, E and F 

ToDo 
Review the elastic and cracked slab vertical displacements under 
unfactored DL + LL loading. Review the factored Mxx slab moments (1.4DL 
+ 1. 7LL). Review the calculated X-strip reinforcing for ACI 318-95. 

o 
N 

A 
5' 

D 
12' 8' 10' 10' 

-,' ·-~.. ' . 
; -.·· :.o ..... 

~ ;; - -~- --.- -

F 

crete wall be ow 

hick concret 

18" x 18" co crete col u m 
below, typic 1 

Note: Our intent is that you try this problem on your own first. After yo u have solved it on your 
own, you can step through our solution if desired. If you ha ve problems trying to create the 
model, then follow the steps in our solution. 
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SAFE Problem 1 Solution 

l. Click the drop down box in the status barto change the units to kip-ft. JK!p;t ::J 
2. From the File menu select New Model.. .. This displays the Grid Definition dialog box. 

3. In this dialog box: 

• Click the Edit Grid button to display the Define X Grid dialog box. 

• In this dialog box: 

Jo- In the Display area verify that the X Grid option is selected. 

Jo- In the Display Grid As area verify that the Ordinates option is selected. 

Jo- Fill in the Grid ID and Coordinate spreadsheet columns as shown in Figure 1-1. 

DehneX6rid 

15 

. ~---- -. 

GrJdlD 
A 
B 
e 
D 
E 
F 

- --· .... _____ ':,. ··•·· ·---r---· .. ~:-.. ~. ·~:...· .. • ._: __ ". ~~·-·• ~-~- , .,:,:.-.'"·.:;: 
. .. ·"/'"'1',•·· -

Coordinate • 
u 
5 

17 -------
25 

35::--_...: 

c::::45=:J·· 

Figure 1-1: X Grid Definition 

e Grid Line 1 7-........, 

: r. Primary Une 
;--. _r Secondery Lile 

F7 V~<ible 

¡~:~., ID 

Jo- In the Display select the Y Grid option. Note that the title of the dialog box 
changes to Define Y Grid. 

Jo- Fill in the Grid ID and Coordinate spreadsheet columns as shown in Figure 1-2. 

Jo- Click the OK button to complete the grid defmition. The screen will refresh and 
display two views ofthe model (grid lines at this point) in vertically tiled adjoining 
windows. The left-hand window is a structural !ayer plan view in the X-Y plane 
and the right-hand window is a structurallayer 3-D view. 
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4. 

DefmeY6rid 

fdol y_...,'·. 

Grid ID 
1 
2 
3 
4 
5 

D 
7 

., 
,. ' 
~. ,: 

15 ., 
___ 2_1!_ __ _j·,,:: 

40 .· 

·-------· ;·,!-
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Figure 1-2: Y Grid Definition 

r Grid line 1 s--, 
' :· . r. PJ~yÚ'l! 
· .. r só~Of)' Lne 

¡;¡,,,v..m~o .. . 1 

Cola ; 11 1 

R..;,ÚoDeldCola 

-. -. -

Note: In SAFE information can be viewed on three different /ayers. They are the 
Structural Layer,. X-Design Strip Layer and Y-Design Strip Layer. The Structural 
Layer in eludes informa/ion about slab geometry, loads and boundary conditions. The 
X-Design Strip Layer is used to define the extent of the X-direction design strips. The 
Y-Design Strip Layer is used to define the extent of the Y-direction design strips. You 
can select the /ayer to be shownfrom the View menu. 

Click in the window titled Structural Layer Plan View to rnake sure it IS active. The 
window is active when its title bar is highlighted. 

5. VerifY that the Snap To Points button 1-\• on the side toolbar is depressed thus enabling 
this snapping option. 

Note: You could also verify that the Snap To Points option is active by c/icking the Draw 
menu, selecting Snap To and verif.ving that there is a check mark next to Points on the 
submenu. lf the check mark exists then the option is active. lf the check mark is not 
there, then click points and then check mark will appear indicating that the option is 
now active. This menu item is like a toggle switch. You can c/ick on it to turn it on and 
off The check mark tells you whether it is on (checked) or off (not checked). 

6. Click the Draw· Quadrilateral Area Object button C?l on the side toolbar (or select Draw 
Quadrilateral Area Object from the Draw menu). Note that you are now in Draw mode 
and that the shape ofthe mouse pointer has changed. 

Note: There are two distinct modes in SAFE: Select mode and Draw Mode. Select mode, 
the default mode, is used for assigning properties and loads and for display of 
assignments and results. Draw mode is used to draw geometry. The mouse pointer is 
different depending on which mode you are in. In Se/ect mode the mouse pointer /ooks 
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fike this ~ . In Draw mode the moúse pointer looks fike this fíJ. You can always tell 
which mode you are in by /ooking at the appearance of the mouse pointer. You enter 
draw mode whenever you select one of the drawing tools either on the side too/bar or 
on the Draw menu. Cficking the Pointer button ~ on the side too/bar will switch you 
from the Draw mode back to Se/ect mode. 

Background: SAFE models are made up of area objects, fine objects and point objects. 
Area objects are used to define slabs, uniformly distributed /oads and soil (uniform(v 
distributed) supports. Line objects are used to define beams, fine loads and wall 
supports. Point objects are used to define point loads and column (point) supports. To 
create a SAFE model you draw these three types of objects (area, fine and point) and 
assign appropriate definitions to them. 

7. We will defme the slab (not including the openings that will be addressed la ter) using three 
area objects. Draw the frrst area object by single clicking on grid intersections B-5, F-5 
and E-3 and then double clicking on the fourth and final grid intersection at A-3. 

Note: When you place the pointer near one of the grid intersections a dot will appear on 
the grid intersection with a tille box that says "Grid lntersection ". This indicates that 
you are within the tolerance of the Snap To Point feature and that if you c/ick the 
mouse you will snap to the grid intersection. You can control the tolerance for 
snapping by se/ecting the Options menu, clicking Prejere11ces ... , se/ecting the 
Dimensions Tab and setting the Screen Snap To Tolerance. 

Note: Double clicking on the last grid intersection completes the area object. A rea objects 
can either be three-sided (triang/e) or four-sided (quadrilateral). !fyou double click on 
the third point you will get a three-sided area object. Double clicking on the fourth 
point gives a four-sided area object. Instead of doub/e clicking on the las/ point you 
can single click on the las/ point and then press the Enter key on the keyboard to 
complete the area object. This method works on both three-sided a11d four-sided area 
objects. 

8. Draw a second area object by single clicking on grid intersections A-3, C-3 and C-1 and 
then pressing the Enter key on the keyboard. 

9. . Draw a third area object by single clicking on grid intersections C-3 and D-3 and then 
double clicking on the third and final grid intersection at C-2. 

1 O. Click the Draw Line Object button ...._¡ on the si de toolbar ( or select Draw Line Object 
from the Draw menu). 

11. Draw a line object by clicking on grid intersection C-3 and then double clicking on grid 
intersection D-4 to complete the line object. This line object will be used to defme the wall 
support. 

Note: We cou/d also single click on grid intersection D-4 and then press the Enter key on 
the keyboard to complete the fine object. 
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12. Click the Draw Point Object button ~ on the side toolbar ( or select Draw Point Object 
from the Draw menu). 

13. Draw a point object by double clicking on grid intersection D-5. This point object will be 
used to define a column support. The model appears as shown in Figure 1-3. 

Note: We could also single click on grid intersection D-5 and then press the Enter key on 
the keyboard to complete the point object. 

Note: lt is not necessary to draw point objects for the other five columns because those 
point objects already exist. They were created when the area objects defining the slab 
were drawn. When area objects are drawn, point objects are automatically created at 
the corners of the area object. Similar/y, when fine objects are drawn point objects are 
automatically created at the ends ofthe fine object. 

If you do not define a point object as either a support ora load then the program· wil/ 
ignore that object when the ana(vsis is run. Thus you need no/ worry• about any 
extraneous point objects that may have been created by the program al the corners of 
area objects or ends of fine objects. 

jf.SAFE·IUntllle.dJ I!IQD 
fi. (di! Y- .!l..... 0¡M ~~ 6a9'l ~ .e:-. OMVl ll!Dn ti. ' . . . ·. . 

D '""'"'.±J .LL~L.J PI~I.$IP>IJS!Illll ><H~~~rl ~><! lllli!JI¡;;jl-c!T>JI OIL 1 

1 
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Here 
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Figure 1-3: Model After Step 13 
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14. Now we will draw the slab opening between column lines e and D. elick the Quick Draw 
Rectangular Area Object button c::::J on the side toolbar (or select Quick Draw 
Rectangular Object from the Draw menu). 

15. eJick once in the area between column lines e, D, 4 and 5 that is labeled "elick Here" in 
Figure 1-3. A rectangular area object is created covering the area bounded by column lines 
e, D,4 and 5. 

16. elick the Pointer/Select button ~ 1 to switch from Draw mode to Select mode. 
now appears as shown in Figure--f-4. 

[10 .E.cit Y- .D.IIfn~ 0:1.,. .Seiec:t e,uv, ~ Qrap~Qy 01119'1 .Qp~rn l::!oiD 

D '""'"'' ~i::.Lt.J ~L..J PI.®IJ!!I.®I.SI!!lll ><H&I ~i<llll lilll ¡;;¡k! ili!i O! L 1 

C0 
1 

/i 
1 . 

1 

C::J--'-!'----·1--7-----1----. 
0--.,..._.....-f----r---1---

1 

C0-'-i~-

0--Lx-'>-----

Figure 1-4: Model After Step 16 

The model 

17. Right click once in the area object just drawn using the Quick Draw feature to display the 
Rectangular Slab Information dialog box. 

18. In this dialog box: 

• In the Locate Slab area verify that the By Edges option is selected. 

• In the Ideritification and Location area type 17 in the Xmin edit box. 
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• In lhe Idenlificalion and Loca1ion area lype 23 in lhe Xmax edil box. 

• In lhe Idenlificalion and Localion area lype 28 in lhe Ymin edil box. 

• In lhe Idenlificalion and Location area lype 32 in lhe Ymax edil box. 

• Click lhe OK bunon. The area objecl is resized. 

Note: A/ternatively we could have created additiona/ grid fines and used these grid fines to 
define this area object 

19. Left click lhe resized area objecl lo selecl il. 

20. From lhe Assign menu selecl Opening. This area is now designaled asan opening and lhe 
model appears as shown in Figure 1-5. 

lf. SAFE · (Unlltledl ~~~ 13 
!M ici: ~- Q._ o~ .5.Mtd A"9'' Á()ll)a Qllpily DNV" gpt.;n b:llp 

D/~1101/_~.J..::.UJ~...!l Jll/.®l.elt!>I.E>II!lll .. ,.,.,., ~>l/1!1/li!J/1!!1/:o:IJ!WI 0/L/ 

.... 

(0 (0 
1 1 

! 1 /i 
~~~~ : ! 

~~-~~--- ---+-! 
6)--i 

e--r~­
(::)--Lx---»-----~--

------ ---- ----

Figure 1-5: Model After Step 20 

21. Now we will draw the slab opening between column lines B and C. We will use secondary 
grid lines to assisl us in drawing the opening. 

22. From the Edit menu select Edit Grid ... to display the Defme X Grid dialog box. 
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23. In this dialog box: 

• In the Display area verify that the X Grid option is selected. 

• In the Display Grid As area verify that the Ordinales option is selected. 

• Click in the 7th row of the spreadsheet. 

• In the Grid Line #7 area select the Secondary Line option. 

Note: Secondary grid fines do not have Grid ID bubb/es. We ;vil/ not specify a Grid ID 
for these secondary fines. 

• Type 9 in the Coordinate column ofthe 7th row ofthe spreadsheet. 

• In the Display area select the Y Grid option. 

• Click in the 6th row ofthe spreadsheet. 

• · Verify that the Secondary line option is selected in the Grid Line #6 area. 

• Type 24 in the Coordinate column ofthe 6th row ofthe spreadsheet. 

• Click the OK button. The model now appears as shown in Figure l-6. 

0 
(Av'B-, .. :;_-y 

1 
X 

;! 
/ 

______ ¡ _ __¡ 

Figure l-6: Model After Step 23 
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24. Click the Quick Draw Rectangular Area Object bu non [!] on the side toolbar ( or select 
Quick Draw Rectangular Object from the Draw menu).-

25. Click in the area designated "X" in Figure 1-6 to draw the area object. 

26. Click the Pointer/Select button ~ to switch from Draw mode to Select mode. 

27. Click the new area object to select it. 

28. From the Assign menu select Opening. This area is now designated as an opening. 

29. Click the drop down box in the status bar to change the units to kip-in. \KJp-m 3 Í 
30. Click on the point objects at B-5, D-5, F-5, E-3, C-1 and A-3 to select them. When you 

have selected al! six point objects look at the left-hand side ofthe status bar at the bottom 
ofthe SAFE window and verify that it says "6 Joints selected". 

31. From the Assign menu select Column Supports ... to display the Support Properties dialog 
box. 

32. In this dialog box: 

o Highlight COL! in the Support Props area. 

o Click the Modify/Show Property button to display the Column Support Property Data 
dialog box. " 

o In this dialog box: 

;... In the Define Column By area verify that the Rectangular Properties option ts 
selected. 

;... In the Properties Below Slab area type 4000 in the Modulus ofElasticity edit box. 

;... In the Properties Below Slab verify that Poisson's Ratio is 0.2. 

;... In the Properties Below Slab area type 18 in thc X Dimension edit box. 

;... In the Properties Below Slab area type 18 in the Y Dirnension edit box. 

;... In the Properties Below Slab area type 144 in the Column Height edit box. 

;... Click the OK button twice to exit al! dialog boxes. 

33. Select the line object between grid intersections C-3 and D-4 by clicking on it. 

34. From the Assign menu select Wall Supports ... to display the Support Properties dialog 
box. 
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35. In this dialog box: 

• Highlight W ALLI in the Support Props area. 

• Click the Modify/Show Property button to display the Wall Support Property Data 
dialog box. 

• In this dialog box: 

~ In the Define Wall By area verify that the Dimensions option is selected. 

;.. In the Properties Below Slab area type 4000 in the Modulus ofElasticity edit box. 

;.. In the Properties Below Slab verify that Poisson's Ratio is 0.2. 

;.. In the Properties Below Slab verify that the Thickness is 12. 

;.. In the Properties Below Slab area type 144 in the Column Height edit box. 

~ Click the OK button twice to exit all dialog boxes. 

36. Select the three area objects that define the slab by clicking in each of them. Do not select 
the area objects that define the slab openings. 

37. From the Assign menu select Slab Properties ... to display the Slab Properties dialog box. 

38. In this dialog box: 

• In the Slab Property area highlight the property named SLAB 1 and the click the 
Modify/Show Property button to display the Slab Property Data dialog box. 

• In this dialog box: 

;.. Accept the default Property N ame, SLAB l. 

;.. In the Analysis Property Data area: 

./ Type 4000 in the Modulus ofElasticity edit box . 

./ Verify Poisson's ratio is 0.2. 

Note: We 'will verify the unit weight la ter . 

./ T ype 1 O in the Bending Thickness (X) edit box . 

./ Type 10 in the Bending Thickness (Y) edit box . 

./ Type 1 O in the Twisting Thickness edit box. 
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./' VerifY that the Slab T}Pe option is selected . 

./' VerifY that the Thick Plate check box is checked. 

Note: Checking the Thick Piare check box tells the program to consider slab shear 
deformations in the analysis. Jf this box is no/ checked then slab shear 
deformations are not included in the analysis. 

;.. In the Design Property Data area: 

./' T}Pe 1 O in the Thickness edit box . 

./' Accept the X Cover Top, Y Cover Top, X Cover Bottom and Y Cover Bottom 
default values . 

./' VerifY the Concrete Strength, fe is 4 . 

./' VerifY the Reinforcing Yield Stress, fY is 60 . 

./' VerifY that the No Design check box is not checked. 

:.. Click the OK button twice to assign this slab property. 

39. Click the drop down box in the status bar to change the units to kip-ft: IJ<Jp-ft ::J 
40. From the Define menu select Slab Properties ... to display the Slab Properties dialog box. 

41. I~ ihis dialog box: 

• In the Slab Property area highligh¡ the property named SLAB 1 and the click the 
Modify/Show Property· button to display the Slab Property· Data dialog box. 

• In this dialog box: 

;.. VerifY that the unit weight is 0.15. 

;.. Click the OK button twice to exit all dialog boxes. 

42. From the Define menu select Static Load Cases ... to display the Static Load Case N ames 
dialog box. 

43. In this dialog box: 

• Twe DL in the Load edit box. 

• Twe 3 in the Long Term Deflection Multiplier edit box, if it is not already entered. 

Note: The multiplier on long term deflections is only active for cracked analysis, it is 
not active for normal analysis. The longterm deflection multiplier is intended to 
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account for the effects of creep and shrinkage. A /ongterm dejlection mu/tiplier of 1 
essentially means that the longtemz dejlection is equal to the immediate deflection, 
that is, there is no additiona/ dejlection due to creep and shrinkage for that load 
case. A longterm multiplier of three means that the longterm dejlection is equa/ to 
three times the immediate dejlection, that is, the additiona/ dejlection due to creep 
and shrinkage is equa/ to twice the immediate dejlection for that load case. 

• Click the Modify Load button. 

• T ype LL in the Load edit box. 

• Select Live from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Type 1 in the Long Term Deflection Multiplier edit box. 

• Click the Add New Load button. 

• Click the OK button. 

44. Click the Restore Previous Selection buttonliE!!Ion the main toolbar to again select the three 
area objects that define the slab (not including the area objects that define the slab 
openings). 

45. From the Assign menu select Surface Loads ... to display the Surface Loads dialog box .. 

46. In this dialog box: 

• Verity that the DL load case is selected in the Load Case N ame drop-down box. 

• Type .05 in the Load per Area edit box. 

Note: Since the curren! units are kips andfeet, 0.05 is equivalen! to 50 psf. 

Note: In SAFE, positive verticalloads act downward. 

• Click the OK button to assign the uniform slab load. 

47. Click the Restore Previous Selection buttonliE!!Ion the main toolbar to again select the three 
area objects that defme the slab (not including the area objects that define the slab 
openings). 

48. From the Assign menu select Surface Loads ... to display the Surface Loads dialog box. 

49. In this dialog box: 

• Select the LL load case from the Load Case N ame drop-down box. 
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• Type .1 (equivalen! to lOO psf) in the Load per Area edit box. 

• Click the OK button to assign the uniform slab load. 

50. Click the Show Undeformed Shape button O lto remove the displayed surface loads. 

51. Click the Draw Quadrilateral Area Object button CJ 1 on the side toolbar ( or select Draw 
Quadrilateral Area Object from the Draw menu). 

52. Draw an area object by single clicking on grid intersections E-5 and F-5 and then double 
clicking on grid intersection E-3. 

53. Click the Pointer/Select button JtJ to switch from Draw mode to Select mode. 

54. Click on the just drawn area object to sele~t it. 

55. From the Assign menu select Surface Loads ... to display the Surface Loads dialog box. 

56. In this dialog box: 

• Select the LL load case from the Load Case N ame drop-down box. 

• Type .15 (equivaient to !50 psf) in the toad per Area edit box. 

Note: This area load will be added ro the area load of 0.1 ksf already assigned to give 
a rota/load of0.25 ksf(250psf). 

• Click the OK button to assign the uniform slab load. 

57. Click the Show Undeformed Shape button O lto remove the displayed surface loads. 

58. Click on the two points at the corners of the opening between column lines C and D where 
the point loads are to be assigned (comers nearest column line D) to select them. 

59. From the Assign menu select Point Loads •.• to display the Point Loads dialog box. 

60. In this dialog box: 

• Verif'y that the DL load case is selected in the Load Case N ame drop-down box. 

• In the Loads area type 4 in the Vertical Load edit box. 

• Click the OK button to assign the point loads. 

61. Click the 3D View button J.d 1 on the main toolbar to get a better view of the applied point 
loads. 

62. Click the 2D View button · "l' on the main toolbar to return to a plan view. 
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63. Click the Restore Previous Selection buttoJ IE!)j on the main toolbar to again select the two 
joints again. 

64. From the Assign menu selecl Point Loads ... lo display lhe Point Loads dialog box. 

65. In lhis dialog box: 

• Select the LL load case from lhe Load Case N ame drop-down box. 

• In the Loads area lype 3 in lhe Vertical Load edil box. 

• Click the OK button to assign lhe point loads. 

66. Click lhe Perspective Toggle button 6'ú' [ on the main 1oolbar lo gel a better view of lhe 
applied poinl loads. 

67. Click lhe Perspective Toggle bullon 6'ú' ¡ on lhe main loolbar to retum lo a plan view. 

68. Click lhe Show Undeformed S ha pe button O [lo remove the displayed point loads. 

69. From the Define menu select Load Combinations ... lo display lhe .Load Combinalions 
dialog box. 

70. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box. 

• In this dialog box: 

)>_ Type DISPL (short for displacement) in the Load Combination Name edit box. 

)> Type DL + LL For Displacements in the Title edit box. 

)> In the Case N ame drop-down box verify the DL Load Case is selected. 

)> Verity that 1 is entered in the S cale Factor edit box. 

)> Click the Add button. 

)> Select LL Load Case from the Case N ame drop-down box. 

)> Click the Add button. 

)> Click the OK button twice to exil all dialog boxes. 

71. From the Analyze menu select Set Options to display the Analysis Options dialog box. 

72. In lhis dialog box: 
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• In the Analysis Type area select the Nonnal and Cracked Deflections option. 

• Accept the default maximum mesh dimension of 4 feet. 

Note: To automatica/Jy mesh the model the program first develops a mesh that is 
broken at each grid /ine, at the edge of any area objects, at the ends of each line 
object and at each point object. If the dimension of any elements meshed in this 
manner exceeds the specified maximum mesh dimension then those elements are 
subdivided such that the maximum mesh dimension is no longer exceeded. 

Note: In general, the maximum mesh size should be based on the span length. Ir is 
good practice to have at least four elements in a span, and general/y it is not 
necessary to have more than eight elements in a span. Thus if the typical span 
/ength is less than sixteen feet, it may be advisable to reduce the default maximum 
mesh size to something less than 4 feet. 

Note: The mesh automatica/Jy generated by the program can be viewed by clicking the 
Set Objects buttonl~on the main too/bar (or selecting Set Object Options ... from 
the View menu) to display the Set Objects dialog box, checking the Show Mesh 
check box in the Options area, and clicking the OK button. You can turn off the 
display of the mesh by unchecking this box. 

• Click the OK button. 

73. Click the Run Analysis button -• on the main toolbar (or select Run Analysis from the 
Analyze menu). 

74. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

75. Click in the plan view window to make sure it is active. 

76. Click the Show Sta tic Deformed S ha pe button A! on the main toolbar ( or select Show 
Deformed Shape ... from the Display inenu) to display the Deformed S ha pe dialog box. 

77. In this dialog box: 

• Select DiSPL Combo from the Load drop-down box. 

• In the Display Options area verify thiít the Displacement Contours check box 1s 
checked. 

• In the Display Options area select the Elastic option. 

• Click the OK button to display the deformed shape. 

78. M ove the mouse cursor o ver the slab elements and read the displacement values on the left­
hand side ofthe status bar at the bottom ofthe SAFE window. 
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79. Click the Show Sta tic Deformed Shape button A! on the main toolbar (or select Show 
Deformed Shape from the Display menu) to display the Deformed Shape dialog box. 

80. In this dialog box: 

• Select DISPL Combo .from the Load drop-down box if it is not airead y selected. 

• In the Display Options area verify that the Displacement Contours check box ts 
checked. 

• In the Display Options area select the Long Term Cracked option. 

• Click the OK button to display the deformed shape. 

81. M ove the mouse cursor over the slab elements and read the displacement values on the left­
hand side ofthe status bar at the bottom ofthe SAFE window. 

Note: Cracked long term deflections could be compared 11ith elastic dejlections in side-by­
side windows. 

82. From the Options menu select Preferences ... and then select the Concrete Tab. 

83. In this dialog box: 

• Verify that ACI 318-95 is selected in the Concrete Design Code drop-down box. 

• Verify that in the Reinforcement Reults Units area the Sq-in and Sq-in/ft option is 
selected. 

• Click the OK button. 

84. On the Design menu choose Select Design Combos to display the Design Load 
Combinations Selection dialog box. 

85. In this dialog box: 

• In the Design Combos !ist box click on DCON2 to highlight it and then click the Show 
button. 

• Note that this load combination is defined as 1.4DL + l. 7LL. 

Note: SAFE automatically creares design load combinations based on the selected 
design code and on the static load types. In this case where the defined static load 
types are DEAD and LJVE (see Static Load Cases on the Define menu) and the 
design code is ACJ 318-95, the program automatically creates two load cases. 
They are 1.4DL (DCONJ) and 1.4DL + 1.7LL (DCON2). 

• Click the OK button twice to exit al! dialog boxes. 
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86. On the Design menu select Start Design. 

87. When the design is complete the calculated X-strip reinforcement is displayed in square 
inches for each of the design strips. Note that you can run your cursor over this 
reinforcement and the required reinforcement is displayed on the left-hand side ofthe status 
bar at the bottom of the SAFE window. 

Note: !f you do not specify at least one slab design strip then the program ";¡¡ 
automatically creare a s/ab design strip for each rowlcolumn of the mesh. Since we did 
not crea te any slab design strips in this example, the program automatical~v created the 
design strips shown now and they correspond to the mesh. · 

88. From the Design menu select Display Slab Design Info ... to display the Slab Reinforcing 
dialog box. 

89. In this dialog box: 

• In the Choose Strip Direction area verify that the X Direction Strip option is chosen. 

• In the Reinforcing Display Type select the Show Number ofBars option and then select 
#6 from the associated drop-down box. 

• Click the OK button. 

90. The calculated X-strip reinforcement is now displayed showing the required number of#6 
bars for each of the design strips. Note that you can run your cursor over this 
reinforcement and the required reinforcement in square inches is displayed on the left-hand 
side ofthe status bar at the bottom ofthe SAFE window. 

91. Click the Show Slab Forces buttoni_!Jon the main toolbar (or select Show Slab Forces ... 
from the Display menu) to display the Slab Forces dialog box. 

92. In this dialog box: 

• Select DISPL Combo from the Load drop-down box. 

• V erify that the Mxx option is selected in the componen! are a. 

• Click the OK button. 

93. The X-direction moments are now displayed. Note that you can run your cursor over the 
moment contours and the moment at the cursor location is displayed on the left-hand side 
ofthe status bar at the bottom ofthe SAFE window. 
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SAFE Problem 2 
Combined Footing 

Concrete Footinq Properties 
E= 3600 ksi, Poissons Rat1o = 0.2, Unit Weight = 150 pcf 
fe= 4 ksi, fy = 60 ksi 
X direction top rebar cover = 3" (to rebar centroid) 
Y direction top re bar cover = 2" (to rebar centroid) 
X direction bottom rebar cover = 3.5" (to rebar centroid) 
Y direction bottom rebar cover = 4.5" (to rebar centroid) 
Concrete columns are 18" by 18". 

Soil Properties 
Subgrade Modulus = 200 kcf 

ToDo 
Use the ACI 318-95 code. Run the analysis using !he uplift iteration op!Jon. 
Review !he soil pressure distribu!Jon. Review !he elastic vert1cal footing 
displacements under unfactored DL + LL + EO loading. Review !he factored 
footing moments. Review the calculated footing reinforcing. 

A 
3' 20' 

¡., 

1 
¡., 

PLAN 

P0L=150k P0L=150k fll = 75k fll = 75 k 
PEo = 100 k (down) PEO = -100 k (up) 

1 
ELEVATION 

Note: Our intent is that you try this problem on your own frrst. After you have sol ved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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SAFE Problem 2 Solution 

1. Click the drop down box in the status bar to change the units to kip-ft. IK1p-ft ::J 
2. From the File menu select New Model From Template .... This displays the Slab 

Templates dialog box. 

3. lo ilil; d Iolog 00> 1 11 

• Click on the Combined Footing button ° 0 

dialog box. 
to display the Combined Footing 

• In this dialog box: 

Combined 
Fooling 

:.- Type 3 in the Left Edge Distance, Right Edge Distance, Top Edge Distance and 
Bottom Edge Distance edit boxes ( 4 different edit boxes total). 

:.- In the Spacing area verity that the X option is selected. 

:.- Type 20 in the Spacing edit box. 

:.- For Load 1 type ISO in the PoEAD edit box and type 7S in the PuvE edit box. 

Note: Whenthe combinedfooling is defined in the X-direction (i.e., the X option is 
se/ected in the Spacing area) then Load 1 is the left column /oading and Load 2 
is the right column /oading. When the combined footing is defined in the Y­
direction then Load 1 is the bottom column /oading and Load :! is the top 
column loading. 

:.- For Load 2 type ISO in the PoEAD edit box and type 7S in the PuVE edit box. 

:.- Type 3 in the Footing Thickness edit box. 

:.- Type 200 in the Soil Modulus edit box. 

:.- Type l.S in the Load Size (Square) edit box. Since the units are kips and feet the 
1.5 is equivalen! to 18 inches. The dialog box now appears as shown in Figure 2.1. 

:.- Click the O K button. 

4. From the Define menu select Sta tic Load Cases ... to display the Static Load Case N ames 
dialog box. 

5. In this dialog box: 

• Type EQ in the Load edit box. 
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Figure 2-1: Combined Footing Dialog Box 

• Select QUAKE from the Type drop-down box. 

• Type O in the Self Weight Multiplier edil box. 

• Type 1 in the Long Term Deflection Multip!ier edit box. 

• Click the Add New Load button. 

• Click the OK button. 

6. From the Define menu select Load Combinations ... to display the Load Combinations 
dialog box. 

7. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box. 

• In this dialog box: 

:r Type DISPL (short for displacement) in the Load Combina! ion N ame edit box. 

:r Type DL + LL + EQ For Displacements in the Title edit box. 

;, In the Case N ame drop-down box verify the DL Load Case is selected. 

l' Verify tqat I is entered in the Scale Factor edit box. 

l' Click the Add button. 
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)o. Select LL Load Case from the Case N ame drop-down box. 

-, Click the Add button. 

)o. Select EQ Load Case from the Case N ame drop-down box. 

)o. Click the Add button. 

)o. Click the OK button twice to exit all dialog boxes. 

8. Click on·the point object (joint element) at grid intersection A-1 to select it. When the joint 
is selected look at the left-hand side of the status bar at thé bottom of the SAFE window 
and verify that it says "1 Joints selected". 

9. From the Assign menu select Point Loads ... to display the Point Loads dialog box. 

1 O. In this dialog box: 

• Select the EQ load case from the Load Case N ame drop-down box. 

• In the Loads area type 100 in the Vertical Load edit box. 

Note: In SAFE, positive venicalloads act dOlmward. 

• In the Size ofLoad area type 1.5 in both the X Dimension and Y Dimension edit boxes. 

• Click the OK button to assign this point load. 

11. Click on the point object (joint element) at grid intersection B-1 to select it. 

12. From the Assign menu select Point Loads ... to display the Point Loads dialog box. 

13. In this dialog box: 

• VerifY that the EQ load case is selected in the Load Case N ame drop-down box. 

• In the Loads area type -100 in the Vertical-Load edit box. The minus sign is used 
because this earthquake load is acting up. 

• In the Size of Load are a verifY that both the X Dimension and Y Dimension are 1.5. 

• Click the OK button to assign this point load. 

14. Click the 3D View button 3-d 1 on the main toolbar to get a better view of the applied point 
1oads. · 

15. Click the 2D View button ....'!.. on the main toolbar to return toa plan view. 

16. Click the Show Undeformed Shape button O 1 to remo ve the displayed point loads. 
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17. Right click on the footing to display the Rectangular Slab lnformation dialog box. 

18. In this dialog box: 

o In the Specifications area note that the Slab Property is called FOOTING. This slab 
property was created and applied by the combined footing template. 

o In the Specifications area note that the Support is SOIL. This support property was 
created and applied by the combined footing template. 

o We will check these properties and if necessary modify them to meet our own 
requirements in the following steps. 

o Click the Cancel button to close the dialog box. 

19. Click the drop down box in the status bar to change the units to kip-in. IKirri~ . . 3.! 
20. From the Define menu select Slab Properties ... to display the Slab Properties dialog box. 

21. In this dialog box: 

o In the Slab Property area highlight the property named FOOTING and then click the 
Modify/Show Property button to display the Slab Property Data dialog box. 

o In this dialog box: 

>- In the Analysis Property Data area: 

,/ Verity that the Modulus ofElasticity is 3600. 

,/ Verity Poisson's ratio is 0.2. 

Note: We 11111 verifj• the unit weight later. 

,/ Verity that the Bending Thickness (X), Bending Thickness (Y) and Twisting 
Thickness are all 36. 

Note: These values 11111 a/1 be 36 because we entered the footing thickness in 
the Combined Footing dia/og box in Step 3. 

,/ Verity that the Slab Type option is selected. 

,/ Verity that the Thick Plate check box is checked. 

Note: Checking the Thick Plate check box te//s the program to consider slab shear 
deformations in the ana/ysis. If this box is not checked then s/ab shear 
deformations are not included in the ana/ysis. 

>- In the Design Property Data area: 
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-' Verify that the Thickness is 36. 

-' Type 3 in the X Cover Top (to Centro id) edit box. 

-' Type 2 in the Y Cover Top (to Centro id) edit box. 

-' Type 3.5 in the X Cover Bottom (to Centro id) edit box. 

-' Type 4.5 in the Y Cover Bottom (to Centro id) edit box. 

-' Verify the Concrete Strength, fe is 4. 

-' Verify the Reinforcing Yield Stress, fy is 60. 

-' Verify that the No Design check box is not checked. 

;;- Click the O K button twice. 

22. Click the drop down box in the status bar to change the units to kip-ft. JNp-H ::J 
23. From the Define menu select Slab Properties ... to display the Slab Properties dialog box. 

24. ln this dialog box: 

• In the Slab Property area highlight the property named FOOTING and then click the 
Modify/Show Property button to display the Slab Property Data dialog box. 

• In this dialog box: 

;;- Verify that the unit weight is 0.15. 

;;- Click the OK button twice to exit all dialog boxes. 

25. From the Define menu select Soil Supports ... to display the Support Properties dialog box. 

26. In this dialog box: 

• In the Support Props area highlight the property named SOIL and then click the 
Modify/Show Property button to display the Soil Support Property Data dialog box. 

• In this dialog box: 

;;- Verify that the subgrade modulus is 200. 

Note: This value wi/1 be 200 because we entered the soil sub grade modulus in the 
Combined Footing dialog box in Step 3. 

;;- Click the OK button twice to exit all dialog boxes. 
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27. From the Options menu se!ect Preferences ... and then select the Concrete Tab. 

28. In this dialog box: 

• Verify that ACI 318-95 is selected in the Concrete Design Code drop-down box. 

• Verify that in the Reinforcement Results Units area the Sq-in and Sq-inlft option is 
selected. 

• Click the OK button. 

29. On the Design menu choose Se!ect Design Combos to display the Design Load 
Combinations Selection dialog box. 

30. In this dialog box: 

• In the Design Combos list box click on DCON2 to highlight it and then click the Show 
button. 

' 
• Note that this load combination is defined as 1.4DL + J. 7LL. Also note that the Use 

For Design check box is checked. 

Note: SAFE automatically creates design load combinations based on the selected 
design code and on the static load types. In this case where the defined static load 
types are DEAD and LIVE and QUAKE (see Static Load Cases on the Define 
menu) and the design code is ACI 318-95, the program automatical(v creates six 
load cases. They are 1.4DL (DCONJ) and 1.4DL + 1.7LL (DCON2), 1.05DL + 
1.275LL + 1.4025EQ (DCON3), 1.05DL + 1.275LL- 1.4025EQ (DCON4), 0.9DL 
+ 1.43 EQ (DCON5), and 0.9DL- 1.43 EQ (DCON6). 

lf we wallled lo add an additional design load combination we could define it by 
selecting Load Combinations ... from the Define menu and then clicking the Add 
New Combo button, to display the Load Combination data dialog box. In this 
dialog box we can define the load combination and we can check the Use For 
Design check box if we want the load combina/ion to be used in design. 

• Click the OK button twice to exit all dialog boxes. 

31. From the Analyze menu select Set Options to display the Analysis Options dialog box. 

32. In this dialog box: 

• In the Analysis Type area select the Iterative For Uplift option. 

• Accept the default values in the Uplift Iteration Parameters area. 

Note: The default Convergence Tolerance, 0.001, should provide sujjicient accuracy 
for most problems. The defau/t Maximum Number of Iterations, JO, may no/ 
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provide sufficient accuracy for many problems. Additional iterations may be 
required. These terms are defined in Srep 35. 

o Accept the default maximum mesh dimension of 4 feet. 

Note: To automatical/y mesh the model the program first deve/ops a mesh that is 
broken al each grid fine, al the edge of any area objects, at the ends of each line 
object and al each point object. lf the dimension of any elements meshed in this 
manner exceeds the specijied maximum mesh dimension the!J !hose elements are 
subdivided such thatthe maximum mesh dimension is no longer exceeded. 

Note: In general, the maximum mesh size should be based on the span /ength. lt is 
good practice ro have al leas/ four elements in a span, and general/y it is no/ 
necessary to have more than eight elements in a span. Thus if the typical span 
length is less than sixteen feet, it may be advisable ro reduce the default maximum 
mesh size lo something less than 4 feet. 

Note: The mesh automatically generated by the program can be viewed by clicking the 
Set Objects buttonJ181 [on the main too/bar (or selecting Set Object Options ... from 
the View menu) to display the Set Objects dialog box, checking the Show Mesh 
check box in the Options area, and clicking the OK butron. You can turn off the 
display of the mesh by unchecking this box. 

• Click the OK button. 

33. Click the Run Analysis button _!_ on the main toolbar (or select Run Analysis from the 
Analyze menu). 

34. When the initial analysis is complete check the messages in the Analysis window (there 
should be no warnings or errors) and then click the OK button to close the Analysis 
window. The program will then proceed to do the iterations for uplift. 

35. When the iterations for uplift are complete an Uplift Analysis Status window similar to that 
shown in Figure 2-2 will appear giving information on how well the uplift iterations 
converged. 

!J! Uplift Analy•is Status El 
Cmmo ConErr ConTol Iterations l!axiters 
DISPL 0.0000 0.0010 1 10 , 

·-~~-~·---.. ··-- -----·--··---·-··" -------.... - ...... ___ ------·---·--·--· ------- _________ ., _____ ,._' 
DC!Dfl 0.0000 0.0010 1 10 
DC!Dl2 0.0000 0.0010 1 10 
DC!DI3 0.0000 o. 0010 1 10 
DC!Dl4 0.0000 0.0010 1 lO 
DC!Dl5 0.0610 0.0010 10 10 
DC!DI6 0.0610 o. 0010 lO 10 

Figure 2-2: Uplift Analysis Status Using a Maximum of 1 O Iterations 
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Note: There are five co/umns in the Uplift Analysis Status windo\1' labeled Combo, 
ConErr, CanTo/, lterations and Max/ters respective/y. The data inthis 1dndow is to be 
read in rows. The Combo co/umn identijies the load combina/ion. The ConErr column 
is the convergence error al the end of the uplift iterations. The convergence error is 
dejined as the maximum /ensile stress divided by the average stress where the average 
stress is ProrAL 1 ArorAL·· The CanTo/ column is the user-defined convergence 
to/erance, in other words, the al/owable or acceptable ci:mvergence error. This value is 
dejined by the Convergence To/erance item input in the Uplift Iteration Parameters 
area in the A na~vsis Options dialog box (Ana/yze menu > Set Options). The Ma.xlters 
co/umn is the user-dejined maximum number of iterations performed befare the upli(t 
itera/ion is stopped, even though it has not converged. This value is dejined by the 
Maximum Number of Iterations item input in the Uplift fteration Parameters area in the 
Ana(vsis Options dia/og box (Analyze menu > Set Options). The lterations column 
tel/s how many iterations were actually peiformed for the specified load combination. 
Uplift ana/ysis iterations are peiformed until either the convergence tolerance is 
satisfied, or the specified maximum number of iterations is reached. 

36. The Uplift Analysis Status window indicates that the convergence tolerance has not been 
satisfied for load combinations DCON5 and DCON6. To see the effect of this 
nonconvergence we will view the soil pressures. 

37. Click the "X" in the upper right-hand comer of the Uplift Analysis Status window to clase 
it. 

1 38. Click the Show Joint Reactions button ;¡ 1 on the main toolbar (or select Show Reaction 
Forces ... from the Display menu) to display the Joint Forces dialog box. 

39. In this dialog box: 

• Select DCON5 Combo from the Load drop-down box. 

• In the Type of Load area select the Soil Pressure option. 

• Click the OK button to display the soil pressure diagram. 

40. Run the mouse cursor o ver the soil pressure diagram contour plot and read the values from 
the left-hand side of the status bar at the bottom of the SAFE window. Note that the 
mínimum value is approximately -0.145 ksf(tension). Ifthe iterations had fully converged, 
that is the convergence error had reached zero, then this mínimum value would be O ksf, 
that is, no tension. We will run the analysis again using more iterations to improve this 
convergence. 

41. Click the Lock/Unlock M o del button ~ on the main toolbar to unlock the model. 

42. From the Analyze menu select Set Options to display the Analysis Options dialog box. 

43. In this dialog box: 
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• In the Uplift Iteration Parameters area type 100 in the Maximum Number of Iterations 
edit box. 

• Click the OK button. 

44. Click the Run Analysis button _!_ on the main toolbar ( or select Run Analysis from the 
Analyze menu). 

45. When the initial analysis is complete check the messages in the Analysis window (there 
should be no warnings or errors) and then click the OK button to close the Analysis 
window. The program will then proceed todo the iterations for uplift. 

46. When the iterations for uplift are complete an Uplift Analysis Status window similar to that 
shown in Figure 2-3 will appear giving information on how well the uplift iterations 
converged. 

!J! Uptilt Anal~is Status - · El 
ConErr ConTol Iterations Maxiters 

DISPL O. 0000 O. 0010 1 lOO .................. -····-·· -- ................ _,,, .......... __ -··--··-·····-------- -······---....... ,_ ............... __ , ........... --· ...... : 
DCOIIl O. 0000 O. 0010 1 lOO 
DCOII2 0.0000 0.0010 1 lOO 
DCOII3 0.0000 0.0010 1 lOO 
DCOII~ 0.0000 0.0010 1 lOO 
DCOII5 0.0010 0.0010 63 lOO 
DCOII6 0.0010 0.0010 63 lOO 

Figure 2-2: Uplift Analysis Status Using a Maximum of 100 lterations 

47. Notice that al! load combinations are converged, and that it took 63 iterations for load 
combinations DCON5 and DCON6 to converge. 

48. Click the "X" in the upper right-hand comer of the Uplift Analysis Status window to clase 
it. 

49. Click the Show Joint Reactions button ;s' 1 on the main toolbar (or select Show Reaction 
Forces ... from the Display menu) to display the Joint Forces dialog box. 

50. In this dialog box: 

• Select DCON5 Combo from the Load drop-down box. 

• In the Type ofLoad area select the Soil Pressure option. 

• Click the OK button to display the soil pressure diagram. 

51. Run the mouse cursor over the soil pressure diagram contour plot and read the values from 
the left-hand side of the status bar at the bottom of the SAFE window. Note that the 
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minimum value is approximately -0.002 ksf (tension). This is a very good approximation 
to zero tension. 

52. Click in the plan view window to make sure it is active. 

53. Click the Show Static Deformed Shape button .A· on the main toolbar (or select Show 
Deformed S ha pe ... from the Display menu) to display the Deformed Shape dialog box. 

54. In this dialog box: 

• Select DISPL Combo from the Load drop-down box. 

• In the Display Options area verify that the Displacement Contours check box is 
checked. 

• Click the OK button to display the deformed shape. 

55. M ove the mouse cursor over the slab elements and read the displacement values on the left­
hand side of the status bar at the bottom of the SAFE window. Note that these 
displacements are in feet. 

56. Click the drop down.box in the status bar to change the units to kip-in. IK•p-m ji 
'====="""-' 

57. M ove the mouse cursor over the slab elements and read the displacement values on the left­
hand side of the status bar at the bottom · of the SAFE window. Note that these 
displacements are in inches. 

58. Click the drop down box in the status bar to change the units to kip-ft. _.__IK-'•p-_tt __ ~::J 

59. Click the Show Slab Forces buttonj~_jon the main toolbar (or select Show Slab Forces ... 
from the Display menu) to display the Slab Forces dialog box. 

60. In this dialog box: 

• Select DCON3 Combo from the Load drop-down box. 

• In the Componen! area select the Mxx option. 

• Click the OK button. 

61. The X-direction moments are now displayed. Note that you can run your cursor over the 
moment contours and the moment at the cursor location is displayed on the left-hand side 
ofthe status bar at the bottom ofthe SAFE window. 

62. If you want to view slab force results for other force components or for other load 
combinations then repeat steps 55 through 57. 

63. On the Design menu select Start Design. 
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64. When the design is complete the caiculated X-strip reinforcement is displayed in square 
inches. Note that you can run your cursor over this reinforcement and the required 
reinforcement is displayed on the left-hand side ofthe status bar at the bottom ofthe SAFE 
window. 

Note: lf you do no/ specify al leas/ one slab design strip then the program will 
automatically create a slab design strip for each row!column of the mesh. Since we did 
not crea te any slab design strips in this example, the program automatically created the 
design strips shown now and they correspond ro the mesh. 

65. From the Design menu select Display Slab Design Info ... to display the Slab Reinforcing 
dialog box. 

66. In this dialog box: 

o In the Choose Strip Direction area verify that the X Direction Strip option is chosen. 

o In the Reinforcing Display Type select the Show Number ofBars option and then select 
#6 from the associated drop-down box. 

o Click the OK button. 

67. The caiculated X-strip reinforcement is now displayed showing the required number of#6 
bars. Note that you can run your cursor over this reinforcement and the required 
reinforcement in square inches is displayed on the left-hand side of the status bar at the 
bottom ofthe SAFE window. 

68. From the Design menu select Display Slab Design Info ... to display the Slab Reinforcing 
dialog box. 

69. In this dialog box: 

o In the Choose Strip Direction select the Y Direction Strip option. 

o In the Reinforcing Display Type select the Show Number ofBars option and then select 
#4 from the associated drop-down box. 

o Click the OK button. 

70. The caiculated Y-strip reinforcement is now displayed showing the required number of#4 
bars for each of the design strips. Note that you can run your cursor over this 
reinforcement and the required reinforcement in square inches is displayed on the left-hand 
si de of the status bar at the bottom of the SAFE window. 
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SAFE Problem 3 
One-Way Beam-Siab System With Opening 

Oesign lnformation 
E= 3600 ksi, Poissons Ratio= 0.2. Unit Weight = 150 pcf 
fe= 4 ksi, fy = 60 ksi 
X direction top rebar cover = 2.5" (to rebar centroid) 
Y drrection top rebar cover = 1.5" (to rebar centroid) 
X direction bottom rebar cover = 1.5" (to rebar centroid) 
Y direction bottom rebar cover = 2.5" (to rebar centroid) 
All columns are 12" by 12". 
Column height below is 10 leet. 
All beams are 12" wide by 18" deep (12" deep below slab). 
Design beams as rectanglar beams (no! T-beams). 
Slab is 6" thick. 
Dead load in addition to sell-weight is 35 psi. 
Live load is 100 psi. 

ToDo 
Use the ACI318-95 code. Reviewthe lactored beam moments. 
calculated beam flexura! reinlorcing. 

Review the 

~ 
Dimensions 
are to column 
and beam 
centerlines 

N ¡----,r--;f--

(o 
.,..... 

B 

24' 

6' 6' 6' 6' 

-----, ~-----1 r-----, r-----
' 1 11 1 1 
1 1 11 1 1 
1 1 11 1 1 
1 L-----' ._ _____ ¡ 1 

• • 
• • 
• • 1 1 
1 • 

• • • 1 
• 1 

¡ Op ing ¡ 
• 1 
1 • 
1 • 
• 1 
• 1 

• • 1 • 
1 r------· .------, 1 
1 1 11 1 r 
1 1 11 1 1 
1 1 11 1 1 

-----' ._ _____ J L-----• L-----

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, you can step through our solution if desired. If you ha ve problems trying to create the 
model, then follow the steps in our solution. 
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SAFE Problem 3 Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡KJp-tt ::J 

2. From the File menu select New Model From Template .... This displays the Slab 
Templates dialog box. 

3. In this dialog box: 

• Click on the Ribbed Slab button 

• In this dialog box: 

[illJ] 
[]JJ]J 
Ribbed. S"'b . 

to display the Ribbed Slab dialog box. 

>- In the Along X Direction area verify that 0.5 is entered in the Left Edge Distance 
and Right Edge Distance edit boxes. 

>- In the Along X Direction area type 1 in the Number ofSpans edit box. 

>- In the Along X Direction area verify that 24 is entered in the Spacing edit box. 

>- In the Along Y Direction area verify that 0.5 is entered in the Left Edge Distance 
and Right Edge Distance edit boxes. 

>- In the Along Y Direction area type 1 in the Number of Spans edil box. 

>- In the Along Y Direction area verify that 24 is entered in the Spacing edit box. 

>- Type .S in the S lab Thickness edit box. 

>- Verify that l is entered in the Colurnn Size (square) edit box. 

> Type 10 in the Column Height Below edit box. 

> In the Load area type .035 in the Dead Load (Additional) edit box. Since the units 
are kips and feet, .035 is equivalen! to 35 psf. 

> In the Load area type .1 in the Live Load edit box. Since the units are kips and feet, 
.l is equivalen! to 1 00 psf. 

> Leave the Create Live Load Pattems check box unchecked. 

Note: Checking the Create Live Load Patterns check box causes the program to 
create a/l sorts of automatically generated skip loading patterns Jor the live 
load. These patterns are automatically added to the drif¡ned static load cases 
and are identified with a Load Type ca/led Pattern Live. In addition, these live 
load patterns are included in the load combinations automatically created Jor 
design. 
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:;.. In the Joist area type 6 in the Spacing edit box. 

~ In the Joist area verify that the Y Direction option is selected This means that the 
joists will be defmed parallel to the Y- axis .. 

Note: We will define and assign actual beam/ joist sizes later. 

~ Click the OK button. 

4. From the Edit menu select Edil Grid ... to display the Define X Grid dialog box. 

5. In this dialog box: 

• In the Display area select the Y Grid option. 

• In the Display Grid As area verify that the Ordinales option is selected. 

• Click in the 3rd row ofthe spreadsheet. 

• In the Grid Line #3 area select the Secondary Line option. 

Note: Secondary grid lines do not have Grid ID bubbles. We v.1/lnot specify a Grid ID 
for these seco_ndary /ines. 

• Type 4 in the Coordinate column ofthe 3rd row ofthe spreadsheet. 

• Type 20 in the Coordinate column ofthe 4th row ofthe spreadsheet. 

• Click the OK button. The model now appears as shown in Figure 3-1. 

6. Delete the center joist (beam) by clicking on it to select it and then pressing the Delete key 
on the keyboard. 

7. Verify that the Snap to Points button /-:• on the side toolbar is depressed. Alternatively, 
yo u could click on the Draw menu, select Snap To and verify there is a check rnark next to 
Points on the submenu. 

8. Click the Snap to Intersections button )~ / on the side toolbar. After you click on the 
button it will remain depressed indicating that this snap option is active. Alternatively, you 
could click on the Draw menu, select Snap To and click on Intersections in the submenu to 
activate this snap option. 

Note: The snap options buuons act like toggle switches. You can use them to turn snap 
options on or off lf a snap option bullan appears depressed then that snap option is 
active. C/icking any snap option bu/Ion togg/es it between active(depressed) and 
inactive (not depressed). Similar/y, the snap option items on the Draw menu act like 
toggle switches. lf a snap option on the Snap To submenu has a check mark next to it 
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then that snap option is active. Cficking a snap option on the Snap To submenu toggles 
the state of that option. 

lf. SAFE - J I!!I.QE! 
fie i,cil. Y- Qm. OjM j.a.et Bn91 ~ .Q~ OftV'I .Qpoont l:i., 

D [.;;l~l .. :::l::UJ .. ~.L .. J Pl.ii'lfol.ii>I.SI!!lll .. ¡.¡ ... ¡ ~ lill[2lo::INJI O[L [A[sl 
~ 1( j§ft':o:-!B[if 

.:IJ 

G J 

L 

(~---

--

\ 
\' 

K 

M 

Delete 
this joist 

~----------

Figure 3-l: Model After Step 5 

9. Click the Draw Line Object button -....j on the side toolbar (or select Draw Line Object 
from the Draw menu). 

lO. Draw a line object by clicking on the point labeled J in Figure 3-1 and then double clicking 
on the point labeled K to complete the line object. 

Note: With the Jntersection snap option activated the mouse cursor wi/1 snap to the 
intersection of the beam and grid fine at points J and K. 

Note: We could also single click on the point labeled K and then press the En ter key on the 
keyboard to complete the fine object. 

1 l. Draw a line object by clicking on the point labeled L in Figure 3-1 and then double clicking 
on the point labeled M to complete the line object. The model now appears as shown in 
Figure 3-2. 
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Figure 3-2: Model After Step 1 1 
' 

12. Click the Snap to Intersections button )~ 1 on the side too1bar to deactivate this snap 
option. 

13. Click the Snap to Middle and Ends button !•l on the side toolbar to activate this snap 
option. 

14. Run the mouse cursor along the beam near the point labeled O in Figure 3-2 until the cursor 
snaps to the midpoint ofthe beam anda text box which says M id Point appears. Left click 
the mouse to start drawing a new beam from this midpoint location. 

15. Move the mouse up to the point labeled P in Figure 3-2. Again the mouse cursor will snap 
to the midpoint ofthe beam. Double click at point P to finish drawing this beam. 

16. Similarly, click on the point labeled Q in Figure 3-2 and then double click on the point 
labeled R to draw another beam. Note that both points Q and R are at the midpoints of 
beams. The model now appears as shown in Figure 3-3. · 

17. Now we will draw the area object that will defme the slab opening. Click the Draw 
Rectangular Area Object button O 1 on the side toolbar ( or select Draw Rectangular 
Object from the Draw menu). 
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18. Single click on the point labeled S in Figure 3-3 and then double click on the point labeled 
T to draw the area object. 

19. Click the Pointer/Select button _!J to switch from Draw mode to Select mode. 

20. Right click near the point labeled U in Figure 3-3 to display the Rectangular Slab 
lnformation dialog box for the just drawn area object. 

2!. In this dialog box: 

• In the Locate Slab area select the By Center option. 

• In the Identification and Location area verify thaí Center X and Center Y are both 12. 
These are the X and Y coordinates ofthe center ofthe area object. 

• In the Identification and Location area type 11 in the X Dimension and type 15 in the Y 
Dimension edit boxes. 

• Click the OK button. 
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22. Left click near the point labeled U in Figure 3-3 to select the just dimensioned area object. 

23. From the Assign menu select Opening. This area is now designated asan opening. 

24. Click the drop down box in the status bar to change the units to kip-in. \Klp-m ::J \ 
25. From the Define menu select Slab Properties ... to display the Slab Properties dialog box. 

26. In this dialog box: 

• In the Slab Property area highlight the property named SLAB and then click the 
Modify/Show Property button to display the Slab Property Data dialog box. 

• In this dialog box: 

:Y In the Anal ysis Property Data area: 

./ Verif'y that the Modulus ofElasticity is 3600 . 

./ Verif'y Poisson's ratio is 0.2. 

Note: We wi/1 verifv the unit weight later . 

./ Verif'y that the Bending Thickness (X), Bending Thickness (Y) and Twisting 
Thickness are all 6. 

Note: These values wi/1 al/ be 6 because we entered the footing thickness in the 
Ribbed S/ab dialog box in Step 3 . 

./ Verif'y that the Slab Type option is selected . 

./ Verif'y that the Thick Plate check box is checked. 

Note: Checking the Thick Plate check box tel/s the program to consider slab shear 
deformations in the ana!ysis. lf this box is not checked then slab shear 
deformations are not inc/uded in the ana/ysis. 

,. In the Design Property Data area: 

./ Verif'y that the Thickness is 6 . 

./ Type 2.5 in the X Cover Top (to Centro id) edit box . 

./ Type 1.5 in the Y Cover Top (to Centroid) edit box . 

./ Type 1.5 in the X Cover Bottom (to Centro id) edit box . 

./ Type 2.5 in the Y Cover Bottom (to Centro id) edit box. 
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v' VerifY the Concrete Strength, fe is 4. 

v' VerifY the Reinforcing Yield Stress, fY is 60. 

v' VerifY that the No Design check box is not checked. 

;.. Click the OK button twice. 

27. From the Define menu select Be a m Properties ... to display the Beam Propenies dialog 
box. 

28. In this dialog box: 

• Click the drop-down box in the Click To area and click on Add Rectangular Beam to 
display the Propeny Data For Rectangular Beam dialog box. 

• In this dialog box: 

» Type XBEAM in the Beam Propeny name edit box. 

» In the Analysis Property Data area: 

v' VerifY that the Modulus ofElasticity is 3600. 

v' VerifY Poisson's ratio is 0.2. 

Note: We will verify the unit weight later. 

v' VerifY the width is 12. 

v' T ype 18 in the Depth edit box. 

:.- In the Design Property Data area: 

,/ VerifY the width is 12. 

v' Type 18 in the Depth edit box. 

v' Type 2.5 in the Cover Top (to Centroid) edit box. 

,/ Type 1.5 in the Cover Bottom (to Centroid) edit box. 

v' VerifY the Concrete Strength, fe is 4. 

v' VerifY the Reinforcing Yield Stress, fY is 60. 

v' VerifY the Shear Steel Yield Stress, tys is 60. 

v' VerifY the Concrete Shear Strength, fes is 4. 
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<~' VerifY that the No Design check box is not checked. 

;... Click the OK button. 

• Click the drop-down box in the Click To area and click on Add Rectangular Beam to 
display the Property Data For Rectangular Bearn dialog box. 

• In this dialog box: 

~ Type YBEAM in the Beam Property narne edit box. 

~ In the Analysis Property Data area: 

<~' VerifY that the Modulus ofElasticity is 3600. 

<~' VerifY Poisson's ratio is 0.2. 

Note: We will verify the unit weight later. 

<~' VerifY the width is 12. 

<~' T ype 18 in the Depth edit box. 

~ In the Design Property Data area: 

<~' VerifY the width is 12. 

<~' Type 18 in the Depth edit box. 

<~' Type 1.5 in the Cover Top (to Centroid) edit box. 

<~' Type 2.5 in the Cover Bottorn (to Centro id) edit box. 

<~' VerifY the Concrete Strength, fe is 4. 

<~' VerifY the Reinforcing Yield Stress, fY is 60. 

<~' VerifY the Shear Steel Yield Stress, tys is 60. 

<~' VerifY the Concrete Shear Strength, fes is 4. 

<~' V erifY that the No Design check box is not checked. 

~ Click the OK button twice. ,. 

29. Click the drop down box in the status bar to change the units to kip-ft. jKJ¡:rH ~ 

30. Frorn the Define rnenu select Slab Properties ... to display the Slab Properties dialog box. 
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31. In this dialog box: 

• In the Slab Property area highlight the property named SLAB and then click the 
Modify/Show Property button to display the Slab Property Data dialog box. 

• In this dialog box: 

} Verity that the unit weight is 0.15. 

;.. Click the OK button twice to exit all dialog boxes. 

32. From the Define menu select Beam Properties ... to display the Beam Properties dialog box. 

33. In this dialog box: 

• In the Beam Property area highlight the property named XBEAM and then click the 
Modify/Show Property button to display the Property Data For Rectangular Beam 
dialog box. 

• In this dialog box: 

} Verity that the unit weight is 0.15. 

¡.. Click the OK button. 

• In the Beam Property area highlight the property named YBEAM and then click the 
Modify/Show Property button to display the Property Data For Rectangular Beam 
dialog box. 

• In this dialog box: 

} Verity that the unit weight is O.I5. 

;.. Click the OK button twice to exit all dialog boxes. 

34. Click in the plan view window titled Slab Properties to rnake sure it is active. When the 
window is active its tille bar is highlighted. 

35. Click the Seiect All button ~ 1 on the rnain toolbar to select all elements. 

36. From the Assign menu select Beam Properties ... to display the Beam Properties dialog 
box. 

37. In this dialog box: 

• In the Beam Property list box click on YBEAM to highlight it. 

• Click the OK button. The model now appears as shown in Figure 3-4. 
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', Figure 3-4: Model After Step 37 

38. Select the four X-direction beams that are circled in Figure 3-4 by clicking on them. 

39. From the Assign menu select Beam Properties ... to display the Beam Properties dialog 
box. 

40. In this dialog box: 

• In the Beam Property list box click on XBEAM to highlight it. 

• C!ick the OK button. 

41. Right click somewhere on the slab area object not in the opening, for example at the point 
labeled V in Figure 3-4 to display the Rectangular Slab Information dialog box. 

42. In this dialog box: 

• Note that the Slab Property is SLAB and recall that we have already defmed these 
properties. 
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• Note that the Load Case drop-down box says DEAD and that the associated w/area edit 
box says 0.035. This is the dead load we initially input (see step 3). 

• Select UVE from the Load Case drop-down box and note that the associated w/area 
edit box says O. l. This is the live load we initially input (see step 3). 

• Click the OK button. 

43. From the Options menu select Preferences._. and then select the Concrete Tab. 

44. In this dialog box: 

• Verify that ACI 3 I 8-95 is selected in the Concrete Design Code drop-down box. 

• Verify that in the Reinforcement Results Units area the Sq-in and Sq-in/ft option is 
selected. 

• Click the OK button. 

45. On the Design menu choose Select Design Combos to display the Design Load 
Combinations Selection dialog box. 

46. In this dialog box: 

• In the Design Combos list box click on DCON2 to highlight it and then click the Show 
button. 

• Note that this load combination is defined as l.4DL + l. 7LL. Also note that the Use 
For Design check box is checked. 

Note: SAFE automatical/y creates design load combinations based on the selected 
design code and on the static load types. In this case where the defined static load 
types are DEAD and LIVE (see Static Load Cases on the Define menu) and the 
design code is ACI 318-95. the program automatical/y creares two load cases. 
They are 1.4DL (DCONJ) and JADL + 1.7LL (DCON2). 

If we wanted to add an additional design load combination we could define it by 
selecting Load Combinations._. from the Define menu and then clicking the Add 
New Combo button, to display the Load Combination data dialog box. In this 
dialog box we can define the load combination and we can check the Use For 
Design check box if we want the load combination to be used in design. 

• Click the OK button twice to exit all dialog boxes. 

47. From the Anaiyze menu select Set Options to display the Analysis Options d!Jlog box. 

48. In this dialog box: 
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• In the Analysis T ype area verify that the Normal option is selected. 

• Accept the default' rnaximum mesh dimension of 4 feet. 

Note: To automatically mesh the model the program jirst develops a mesh that is 
broken at each grid line, at the edge of any area objects. at the ends of each line 
object and at each point object. Jf the dimension of any elements meshed in this 
manner exceeds the specified maximum mesh dimension then those elements are 
subdivided such that the maximum mesh dimension is no longer exceeded. 

Note: In general, the maximum mesh size should be based on the span length. It is 
good practice to have at least four elements in a span, and general/y it is not 
necessary to have more than eight elements in a span. Thus if the typica/ span 
/ength is less than sixteen feet, it may be advisable to reduce the default maximum 
mesh size to something less than 4 feet. 

In this example we are accepting the default maximum mesh of four feet. This 
means that the s/ab spanning between beams will be modeled using two elements 
which is less than the four elements recommended in the previous paragraph. Jf the 
accuracy of the slab results (moments, etc.) were importan! to us then we might 
want to reduce the maximum mesh size to l. 5 feet. 

Note: The mesh automaticalzv generated by the program can be viewed by clicking the 
Set Objects buttonJ~on the main too/bar (or selecting Se/ Object Options ... from 
the View menui to display the Set Objects dialog box, checking the Show Mesh 
check box in the Options area, and clicf...ing the OK button. You can turn off the 
display of the mesh by unchecking this box. 

• Click the OK button. 

49. Click the Run Analysis button -~ on the rnain toolbar (or select Run Analysis from the 
Analyze menu). 

50. When the initial analysis is complete check the messages in the Analysis window (there 
should be no wamings or errors) and then click the OK button to close the Analysis 
window. 

51. Click the Show Beam Forces button 1 & 1 on the main toolbar ( or select Show Beam 
Forces ... from the Display menu) to display the Beam Forces dialog box. 

52. In this dialog box: 

• Select DCON2 Combo from the Load drop-down box. 

• In the Componen! area select the Moment option. 
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• In the Display options area check the Show Values check box. Note that if the Fill 
Diagram check box is checked you will have to uncheck it before you can check the 
Show Values box. 

• Click the OK button to display the moment diagrams. 

53. Run the mouse cursor over the beams and read the moment values from the left-hand side 
ofthe status bar at the bottom ofthe SAFE window. 

54. If you want to view beam force results for other force components then repeat steps 51 
through 53. 

55. On the Design menu select Start Design. When the design is complete the calculated X­
strip reinforcement is displayed in square inches. 

56. From the Design menu select Display Beam Design Info ... to display the Beam 
Reinforcing dialog box. 

57. In this dialog box: 

• In the Type ofReinforcing area verify that the Flexura] option is chosen. 

• In the Reinforcing Values area verify that the Show Rebar Values at Controlling Station 
check box is checked. 

• In the Reinforcing Values area verify that the Show Rebar Values at Every Station 
check box is not checked. 

• Accept the other default values in this dialog box. 

• Click the OK button. 

58. Run the mouse cursor over the beams and read the flexura! steel values from the left-hand 
side of the status bar at the bottom of the SAFE window. 
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ProblemA 
Concrete Wall and Steel Frame 

Steel 
Fy = 36 ksi, E = 29500 ksi, Poisson's Ratio = 0.3 
Columns: W1 OX49, typical - pinned base 
Beams: As noted, pinned ends except continuous over top of brace 

Assume all W24X68 beams are braced at 1/3 points 
Assume W16X36 beams braced at center only 
Beams at concrete wall are not embedded in wall 

Braces: TS6X6X1/4, pinned ends 
Design Code: AISC-ASD89 

Concrete 
E- 4000 ksi, Poissons Ratio= 0.22 
Self weight = 150 pcf 

50k W24X68 W24X68 
~~~~--~~~ 

k~.@_;:,;;~'·'~/::·"'~_;-· -¡-Concrete wall 

:;~ .. ~~·~}~· _ -.. .- . :;·· 8" thick 
·< W24X68-· W24X68 

W24X68 

W24X68 

W24X68 

25' 25' 

Beam Span Loading 
Typical for all beams; includes 
self weight 

10k DL 
5k LL 

Equal Equal 

ToDo 
Determine reactions for the load 
combination of DL + LL + EQ. 
Determine steel stress ratios. 

W24X68 

W24X68 

25' 14' 14' 

Note: Our intent is that yo u try this problem on your own frrst. After you have solved it on your 
own, you can step through our solution if desired. lfyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem A Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. jKJp-ft 3 

2. Frorn the File rnenu select New Model From Template ••.. This displays the Model 
Templates dialog box. 

3. I"'hi' dlolog bo<e ilok '"''' Port> 1 F n m"""''"'~' j !JI bortoo ID di'P lo y <ho 
Portal Frame dialog box. 

4. In this dialog box: 

• Type 5 in the Nurnber ofStories edit box. 

• Type 4 in the Nurnber ofBays edit box. 

• Type 13 in the Story Height edit box. 

• Type 25 in the Bay Width edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. Click the Set Elements buttoni-ª.J on the rnain toolbar ( or select Set Elements ... frorn the 
View menu) to display the Set Elements Dialog box. 

7. In this dialog box: 

• Check the Labels box in the Joints area. 

• Check the Labels box in the Frames area. 

• Click the OK button. 

8. Select colurnn elernents 18, 19, 20, 23,24 and 25 and beam elernents 38, 39, 40, 43,44 and 
45. Press the delete key on the keyboard to delete these elernents. 

Note: You could select the elements by clicking on each one individual/y, by "windowing", 
by using the Intersecting Line Se/ect Mode, or by using the Select By Labe/s option 
(Select menu > Select > Labels). 

9. Click the Refresh Window button .1J to refresh the drawing. 

10. Frorn the Draw rnenu choose Edit Grid ... to display the Modify Grid Lines dialog box. 

11. In this dialog box: 
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• Verify that the X option is chosen in the Direction area. 

• Check the Glue Joints To Grid Lines box. 

• Click on the 50 grid line in the X Location list box to highlight it. Note that the 50 
appears in the X Location edit box. 

• Change the 50 in the X Location edit box to 53 and click the M ove Grid Line button. 

• Select the Z option in the Direction area. 

• Click on the O grid line in the Z Location list box to highlight it. Note that the O 
appears in the Z Location edit box. 

• Change the O in the Z Location edit box to -1 and click the M ove Grid Line button. 

• Click the OK button. 01V1de Selected Fromes 

12. Select beams 41 and 42. 

13. 

14. 

15. 

16. 

From the Edit menu select Divide Frames .•. to 
display the Divide Selected Frames dialog box. 

Fill in the dialog box as shown in the figure 
(typically the dialog box will default to these 
values) and click the OK button. 

' Verify that the Snap to Joints and Grid Points 
button 1-:• .1 on the side too] bar is depre. !d. 

Fromes 1 

1 

1 

r Break at intersectJons with selede-d 

1

1 

Frames Md Joints · 

Cencal J 

Click the Draw Frame Element button-;;J on the side toolbar, or select Draw Frame 
Element from the Draw menu. 

17. Draw the frrst brace element as follows: 

• Place the mouse pointer onjoint 19. When the text box saying "Grid lntersection" 
appears click the left mouse button once. 

• M ove the mouse pointer to joint 31. When the text box saying "Point" appears click 
the left mouse button once. 

• Press the Enter key on the keyboard. 

18. Click on joint 25 and then joint 31, and press the Enter key to draw the second brace 
element. 

19. Click onjoint 20 and thenjoint 32, andpress the Enter keyto drawthe third brace element. 
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20. Click on joint 26 and then joint 32, and press the Enter key to draw the fourth and final 
brace element. 

21. Click the Pointer button -~~ on the side too! bar to exit draw mode and enter select mode. 

22. Click the drop down box in the status bar to change the units to kip-in. IK!p-m _:::¡_[ 

23. From the Define menu select Materials ... to display the Define Materials dialog box. 

24. Click on STEEL in the Materials area to highlight (seiect) it, and then click the 
Modify/Show Material button. The Matenal Property Data dialog box is displayed. 

25. In this dialog box: 

• Type O in the Mass per Unit Volume edit box. 

• Type O in the Weight per Unit Volume edit box. 

• Type 29500 in the Modulus ofElasticity edit box. 

• Type .3 in the Poisson' s Ratio edit box, if it is not airead y entered. 

• Type 36 in the Steel Yield Stress, Fy edit box, if it is not airead y entered. 

• Click the OK button. 

26. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. · 

27. In this dialog box: 

• Type 4000 in the Moduius ofElasticity edit box. 

• Type .22 in the Poisson's Ratio edit box 

• Accept the other values in the dialog box. 

• Click the OK button. 

28. Click the OK button to close the Define Materials dialog box. 

29. Click the drop down box in the status bar to change the units to kip-ft. JK1p-ft ::l 
30. From the Define menu select Materials ... to display the Define Materials dialog box. 

31. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

32. In this dialog box: 
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• Veri:ty 0.15 is entered in the Weight per Unit Volume edit box. 

• Click the OK button. 

33. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

34. In the C!ick To area, click the drop-down box that says Import I!Wide Flange and then 
click on the Impon 1/Wide Flange item. 

35. Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections.pro and click the Open button. 

36. A dialog box appears with a list of al! wide flange sections in the data base. \n this dialog 
box: 

• Scroll down and click on the W24X68 section. 

• Scroll down to the Wl6X36 section, and click on it while holding down the Ctrl key on 
the keyboard. 

• Scroll down to the WlOX49 section, and click on it while holding down the Ctrl key on 
the keyboard. 

• Click the OK button twice to retum to the Defme Frame sections dialog box. 

37. In the Click To area, click the drop-down box that says Import l!Wide Flange and then 
click on the lmport Box/Tube item. 

38. A dialog box appears with a list of al! structural tube sections in the database. In this dialog 
box: 

• Scroll down and click on the TS6X6Xl/4 section. 

• Click the OK button three times to exit al! dialog boxes. 

39. From the Define menu select Shell Sections ... to display the Define Shell Sections dialog 
box. 

40. In the Click To area, click the Add New Section button to display the Shell Sections dialog 
box. 

4!. In this dialog box: 

• Type W ALL in the Section N ame edit box. 

• In the Thickness area type .6667 in both the Membrane and the Bending edit boxes. 
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• Verizy that the Shell option is selected in the Type area. 

• Click the OK button. 

42. Click the OK button to close the Define Shells dialog box. 

43. Select all ofthe beams except for the braced frame beams (i.e., select beams 26 through 37 
and do not select beams 46 through 49). The Intersecting Line Selection option could be 
useful for this. 

Note: To use the Intersecting Line Selection option, click the Set Jntersecting Line Select 
Mode button lliill on the side too/ bar. Then click the left mouse button at the top of one 
beam bay, and while holding down the /eft mouse button drag the mouse to the bottom 
of the be a m bay. A "rubberband !in e" will appear and al! elements that this 
"rubberband line "passes through will be selected. Release the left mouse button to 
make the selection. 

44. From the Assign menu select Frame and then Releases ... from the submenu to display the 
Frame Releases dialog box. 

45. In this dialog box check both the Start and the End boxes for Moment 33 (Major) and then 
click the OK button. 

46. Select beam elements 46 and 48. 

47. From the Assign menu select Frame and then Releases ... from the submenu to display the 
Frame Releases dialog box. 

48. In this dialog box check the Start box for Moment 33 (Major) and then click the OK button. 

49. Select beam elements 47 and 49. 

50. From the Assign menu select Frame and then Releases ... from the submenu to display the 
Frame Releases dialog box. 

51. In this dialog box check the End box for Moment 33 (Major) and then click the OK button. 

52. Select all ofthe braces (i.e., select braces 50 through 53). 

53. From the Assign menu select Frame and then Releases •.. from the submenu to display the 
Frame Releases dialog box. 

54. In this dialog box check both the Start and the End boxes for Mornent 33 (Major) and then 
click the OK button. 

55. From the Define rnenu select Sta tic Load Cases .•• to display the Define Static Load Case 
N ames dialog box. 

56. In this dialog box: 
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• Type DL in the Load Edit box. 

• Click the Change Load button. 

• Type LL in the Load Edit box. 

• Select Live from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• C!ick the Add New Load button. 

• Type EQ in the Load Edit box. 

• Select Quake from the T ype drop-down box. 

• Click the Add N ew Load button. 

• Click the OK button. 

57. From the Define menu select Load Combinations ... to display the Define Load 
Combinations dialog box. 

58. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box. 

• In this dialog box: 

>- Type ALL in the Load Combina .. on N ame edit box. 

~ Select ADD from the Load Combination Type drop-down box if it is not already 
selected. 

~ Type DL + LL + EQ in the Title edit box. 

~ Select DL Load Case in the Case Name drop down box (ifit is not already selected) 
and type 1 in the Scale Factor edit box (if it is not already there). 

~ Click the Add button. 

~ Select LL Load Case in the Case N ame drop down box. 

~ Click the Add button. 

~ Select EQ Load Case in the Case N ame drop down box. 

~ Click the Add button. 
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;... Click the OK button twice. 
11 

59. Select beams 26 through 37. 

60. From the Assign menu seiect Frame Static Loads .•. and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

61. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type .S in the first Distance edit box and type -lO in the first 
Load edit box 

• Type -1.2 in the Uniform Load area edit box. 

• Click the OK button. 

62. Click the Resto re Previous Seiection button @ 1 on the si de toolbar ( or select Get 
Previous Seiection from the Select menu). 

63. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

64. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Point Loads area type -5 in the frrst Load edit box 

• Type -.8 in the Uniform Load area edit box. 

• Click the OK button. 

65. Select beams 46 through 49. 

66. From the Assign menu seiect Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Unifonn Span Loads dialog box. 

67. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• In the Point Loads area type O in the frrst Distance edit box and type O in the frrst Load 
edit box 

• Type -1.2 in the Uniform Load area edit box. 
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• Click the OK button. 

68. Ciick the Restore Previous Selection button ~ 1 on the side toolbar (or select Get 
Previous Selection from the Select menu). . 

69. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

70. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• Type -.8 in the Uniform Load area edit box. 

• Click the OK button. 

7 J. Select joints 31 and 32. 

72. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

73. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• Type -10 in the Force Global Z edit box in the Loads area. 

• Click the OK button. 

74. Click the Resto re Previous Selection burton ~ 1 on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

75. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

76. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• Type -5 in the Force Global Z edit box in the Loads area. 

• Click the OK button. 

77. Select joints 2, 3, 4, 5 and 6 by "windowing". 

78. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

79. In this dialog box: 
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• Select EQ from the Load Case N ame drop-down box. 

• Type 10 in the Force Global X edit box in the Loads area. 

• Type O in the Force Global Z edit box in the Loads area. 

• Click the OK button. 

80. Select joints 3, 4, 5 and 6 (not 2) by "windowing". 

81. From the Assign menu select Joint Static Loads ..• and then Forces .•. from the submenu to 
display the Joint Forces dialog box. 

82. In this dialog box: 

• Verify Add To Existing Loads is selected in the Options arca. 

• Click the O K button. 

83. Select joints 4, 5 and 6 (not 2 and 3) by "windowing". 

84. From the Assign menu select Joint Static Loads ... and then Forces ... from.the submenu to 
display the Joint Forces dialog box. 

85. In this dialog box click the OK button. 

86. Select joints 5 and 6 (not 2, 3 and 4). 

87. From the Assign menu select Joint Static Loads •.• and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

88. In this dialog box click the OK button. 

89. Select joint 6 (not 2, 3, 4 and 5). 

90. From the Assign menu select Joint Static Loads ••• and then Forces ••. from thc submenu to 
display the Joint Forces dialog box. 

91. In this dialog box click the OK button. 

92. Select beams 26 through 37. 

93. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

94. In this dialog box: 

• Click on W24X68 in the Frame Sections area to highlight it. 
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• Click the OK button. 

95. Click the Show Undeformed Shape button O! to remove the displayed frame section 
assignments so that you can see the frame element labels again. 

96. Select beams 46 through 49. 

97. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

98. In this dialog box: 

• Click on W16X36 in the Frame Sections area to highlight it. 

• Click the OK button. 

99. Select all ofthe columns. An easy way todo this is to "window" each ofthe column lines 
separately. 

Note: To "window" a column fine, left click the mouse above and to the left ofthe column 
fine. TVhile holding the left mouse button down, drag the mouse so that it is below and 
to the right of the:co/umn fine. A "rubberband window" wi/1 appear surrounding the 
co/umn fine. Releas e ·rhe left m o use button to select al/ elements that are ful/y enclosed 
by the "rubberband window ". 

100. From the Assign menu se1ect Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

lO l. In this dialog box: 

• Click on WIOX49 in the Frame Sections area to highlight it. 

• Click the OK button. 

102. Select the four brace elements. 

103. From the Assign mcnu se1ect Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

104. In this dialog box: 

• Click on TS6X6X 114 in the Frame Sections area to highlight it. 

• Click the OK button. 

105. Click the Show Undeformed Shape button O 1 to remove the displayed frame section 
assignments. 
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106. eJick the Set Elements buttonJ t8Í 1 on the rnain toolbar ( or select Set Elements •.. from the 
View menu) to display the Set Elements Dialog box. 

107. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck the Labels box in the Frames area. 

• eiick the OK button. 

108. eJick the Quick Draw Rectangular Shell Element button ]j] on the side toolbar. 

109. elick the mouse pointer once in the areas labeled A, B, e, D and E in the figure below to 
draw the shell elements. 

SI SAPZIJDO- ft RI!IEI 
file fdrt ~- .Define D¡aw Selea ,6$Slgn A,oclyte OISpl~ De11gn Qp~ona tl.elp _ .. 

D 1~11011 ·+ l.l.J ~.L ... tl JI 1 ~IJ!>IP>Iflll!'!ll "'1 Q 1 u 1" 1.,.1 ~>lllllll...!.l.!J .:.1 r J..;..l.' H-"'1 .QJ 

E 

D 

e 

B 

A 
X 

X·Z Ple.ne @ Y•D 

11 O. eiick the Pointer button ~ on the side too] bar to exit draw mode and en ter select mode. 

111. Select the five shell elements just entered by clicking on them. 

112. From the Assign menu select SheU and then select Sections ..• from the submenu to display 
the Define Shell Sections dialog box. 

113. In this dialog box: 

• eiick once on the W ALL item in the Shell Sections area to highlight it. 

• elick the OK button. 
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114. Click the Show Undeformed Shape button O [ to remove the displayed shell section 
assignments. 

115. Click the Restore Previous Selection button ~ 1 on the side toolbar (or select Get 
Previous Selection from the Select menu). 

116. From the Edit menu select Mesh SheUs ... to display the Mesh Selected Shells dialog box. 

117. Fill out this dialog box as shown in the figure to 
mesh each shell into twelve elements (4 by 3) 
and click the OK button. 

118. Click the Set Elements buttoniJ!J on the main 
toolbar ( or select Set Elements ... from the View 
menu) to display the Set Elements Dialog box. 

119. In this dialog box: 

o Check the Hide box in the Shells area. 

o Check the Hide box in the Joints area. 

o Check the Sections box in the Frames area. 

o Click the OK button. 

120. Select all ofthe W24X68 beam sections (12 total). 

Mesh Selected Shells 

Shells ¡ 

(" Mesh using ~elected Joints on edges l 
'

1 
(" Mesh at interse~on with grids 

1------~~-------__j 

OK Cancel 1. 

121. From the Design menu select·Redefine Element Design Data ••. to display the Element 
Overwrite Assignments dialog box. 

122. In this dialog box: 

o Check the Unbraced Length Ratio (Minor, LTB) box and type .3333 in the associated 
edit box. 

o Click the OK button. 

123. Select all ofthe Wl6X36 beam sections (4 total). 

124. From the Design menu select Redefine Element Design Data ••. to display the Element 
Overwrite Assignments dialog box. 

125. In this dialog box: 

o Check the Unbraced Length Ratio (Minor, L TB) box and type .5 in the associated edit 
box. 

>, 
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• Click the OK button. 

126. C1ick the Set E1ements buttonJJ!'U on the rnain too1bar ( or se1ect Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

127. In this dialog box: 

• Uncheck the Hide box in the Joints area. 

• Check the Restraints box in the Joints area. 

• Uncheck the Sections box in the Frames area. 

• Uncheck the Hide box in the Shells area. 

• Click the OK button. 

128. From the Options menu select Preferences ... to display the Preferences dialog box. 

129. In this dialog box. 

• Click on the Steel Tab 

• Select AISC-ASD89 from the Steel Design Code drop-down box if it is not airead y 
selected. 

• Click the OK button. 

130. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo '"'' d i•log bo>O liek <he Pl•oe F"m' XZPb"' bmloo ¡ ¡ ¡ 1 10 '" Iho 
available degrees of freedom. 

• Click the OK button. 

131. Click the Run Analysis button _J to run the analysis. 

132. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

133. Click the Joint Reaction Forces button I.!J on the main toolbar to display the Joint 
Reaction Forces dialog box. 

134. In this dialog box: 

• Select All Combo from the Load drop-down box. 

• Verif'y that the Reactions option is selected in the Type area. 

14 



• Click the OK button. 

135. The reactions are displayed on the screen. You can right click on any joint to see the 
reactions at that joint or yo u can just read the reactions on the screen. Ifthe text is too 
small to read, you can zoom in, or you can change the minimum font size as described in 
the note below. 

Note: To change the minimum font size select Preferences from the Options menu and 
make sure the Dimensions Tab is selected. In the Minimum Graphic font Si~e edil box 
input a new size. maybe 5 or 6 points. Click the OK button. C/ick the Re(resh Window 
button _Lj located on the main too/bar to see the changes. 

136. From the Design menu click Start Design/Check Of Structure to run the design check of 
the steel frame elements. 

137. When the design check completes, the stress ratios are displayed. 

15 
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Problem 8 
Concrete Wall 

Concrete 
E = 3600 ksi, Poissons Ratio= 0.2 

ToDo 
Model wall using shell elements. 
Determine shear axial force and 
moment in Pier A, and determine 
total shear, moment and axial force 
al the sixth level for all piers 
combined. 

13'1 6
' 1 6

' 1 6
' 13'1 

Typical Bay Dimensions 

P (DL) = 21.6 k, P (LL) = 7.2 k 

r Earthquake 
.;¡¡ Loading 

Typical Bay Vertical Loading 

Wall Thickness = 12 inches, typical 

60k 

50 k 

24' 24' 24' 24" 24' 24' 

Note: Our intent is that you try this probiem on your own first. After you have soived it on your 
own, yo u can step through our soiution if desired. If yo u ha ve problems trying to create the 
model, then follow the steps in our soiution. 
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Problem B Solution 

l. Click the drop down box in the status bar to change the units to kip-ft.JK,p-fi :.:J 

2. From the File menu select New Model From Template .... This displays the Model 

3. 

Templates dialog box. . 

lo<hffi di•log ""' diok oo<ho Sh .. , W•lhompl"'llllll bottoo<o di'l'i•y <ho Shom 
Wall dialog box. 

4. In this dialog box 

• Type 8 in the Number of S paces Along X edit box. 

• Type 4 in the Number of S paces A long Z edit box. 

• Type 3 S pace Width Along X edit box. 

• Type 3 S pace Width Along Z edit box. 

• Click the OK button. 

5. Click the "X'' in the top right-hand comer ofthe 3-D View window to close it. 

6. Click the Set Elements buttonl~ on the rnain toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

7. In this dialog box: 

• Check the Labels box in the Joints area. 

• Check the Labels box in the Shells area. 

• Click the OK button. 

8. Select shell elements 6, 7, 10, ll, 22, 23, 26 and 27 by clicking on them. 

9. Press the Delete key on the keyboard to delete these elements. 

lO. Click the Refresh Window button .1J to refresh the drawing. 

11. From the Define menu select Sta tic Load Cases ... to display the Defme Static Load Case 
N ames dialog box. 

12. In this dialog box: 

• Type DL in the Load Edit box. 
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• Click the Change Load button. 

• Type LL in the Load Edit box. 

• Select Live from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Add N ew Load button. 

• Type EQ in the Load Edit box. 

• Select Quake from the Type drop-down box. 

• Click the Add New Load button. 

• Click the OK button. 

13. From the Define menu select Load Combinations ... to display the Define Load 
Combinations dialog box. 

14. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box. 

• In this dialog box: 

>- Type ALL in the Loa·d Combination Name edit box. 

>- Select ADD from the Load Combination Type drop-down box if it is not airead y 
selected. 

>- Type DL + LL + EQ in the Tille edit box. 

~ Select DL Load Case in the Case Name drop down box (ifit is not already selected) 
and type 1 in the Scale Factor edit box (if it is not airead y there). 

>- Click the Add button. 

l' Select LL Load Case in the Case N ame drop down box. 

)o.- Click the Add button. 

>- Select EQ Load Case in the Case N ame drop down box. 

~ Click the Add button. 

>- Click the OK button twice. 
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15. Selectjoints 10,25 and 45. 

16. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

17. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• T)1le -10.8 in the Force Global Z edit box in the Loads area. 

• Click the OK button. 

18. Selectjoint 25. 

19. From the Assign menu select Joint Static Loads ••• and then Forces ... from the submenu to 
display the Joint Forces dialog box. Click the OK button in this dialog box. 

20. Select joints 1 O, 25 and 45. 

21. From the Assign menu select Joint Static Loads .•• and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

22. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• T)1le -3.6 in the Force Global Z edit box in the Loads area. 

• Click the OK button. 

23. Select joint 25. 

24. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. Click the OK button in this dialog box. 

25. Click the drop down box in the status bar to change the units to kip-in. !Kip-in 3\ 
26. From the Define menu select Materials ... to display the Define Materials dialog box. 

Highlight the CONC material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

27. In this dialog box: 

• Veri:ty that the modulus ofelasticity is 3600 and poisson's ratio is 0.2. 

• Click the OK button twice to exit the dialog boxes. 

28. Click the drop down box in the status bar to change the units to kip-ft. ·¡Kl¡Ht :.:r 
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29. From the Define menu select SheU Sections ... to display the Defme Shell Sections dialog 
box. Click the Modify/Show Section button to display the Shell Sections dialog box. 

30. In this dialog box: 

• Accept all ofthe default values. 

• Click the OK button twice to exit the dialog boxes. 

31. Click the Select All button ~ on the side tool bar. 

32. From the Edit menu select Replicate ... to display the Replicate dialog box. 

33. In this dialog box: 

• Click the Linear Tab if it is not already selected. 

• In the Distance area type 24 in the X edit box. 

• Type 5 in the Number edit box. 

• Click the OK button 

34. Click the Set Elements buttonl_~j on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

35. In this dialog box: 

• Check the Hide box in the Joints area. 

• Uncheck the Labels box in the Shells area. 

• Click the OK button. 

36. Click the Select All button ~ on the side tool bar. 

37. From the Edit menu select Replicate ... to display the Replicate dialog box. 

38. In this dialog box: 

• Click the Linear Tab if it is not airead y selected. 

• In the Distance area type O in the X edit box. 

• Type 12 in the Z edit box. 

• Type 9 in the Number edit box. 

• Click the OK button. 
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39. Click the Set Elements buttonl!l.J on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

40. In this dialog box: 

• Uncheck the Hide box in the Joints area. 

• Check the Labels box in the Joints area. 

• Check the Restraints box in the Joints area. 

• Check the Fill Elements box in the Options area. 

• Click the OK button. 

41. Select joint 10. You may need to zoom in to distinguish it. 

42. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

43. In this dialog box: 

• Select EQ from the Load Case N ame drop-down box. 

• Type 10 in the Force Global X edit box in the Loads area. 

• Type O in the Force Global Z edil box in the Loads area. 

• Click the OK button. 

44. Select joint 243. 

45. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

46. In this dialog box: 

• Type 15 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

47. Selectjoint427. 

48. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

49. In this dialog box: 

• Type 20 in the Force Global X edit box in the Loads area. 
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• • Click the OK button . 

50. Select joint 611. 

51. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

52. In this dialog box: 

• Type 25 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

53. Select joint 795. 

54. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

55. In this dialog box: 

• Type 30 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

56. Select joint 979. 

57. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

58. In this dialog box: 

• Type 35 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

59. Select joint 1163. 

60. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

61. In this dialog box: 

• Type 40 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

62. Select joint 1347. 
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63. From the Assign meo u select Joint Sta tic Loads •.. and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

64. In this dialog box: 

• Type 45 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

65. Selectjoint 1531. 

66. From the Assign menu select Joint Sta tic Loads .•. and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

67. In this dialog box: 

• Type 50 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

68. Selectjoint 1715. 

69. From the Assign menu select Joint Sta tic Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

70. In this dialog box: 

• Type 60 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

71. Click the Show Undeformed Shape button Oito remove the displayedjoint force 
assignments. 

72. Click the Set Elements buttonli!l on the main toolbar ( or select Set Elements ••• from the 
View menu) to display the Set Elements Dialog box. 

73. In this dialog box: 

• Check the Labels box in the Shells area. 

• Click the OK button. 

74. Zoom in on the pier labeled Pier A in the problem statement. 

75. Select joints 208,212 and 218. 

76. Select shell elements 138 and 142. 
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• 77. From the Assign menu select Group N ame ... to display the Assign Group dialog box . 

78. In this dialog box: 

• Type PIERA in the Groups edit box. 

• Click the Add New Group N ame button. 

• C!ick the OK button. 

79. From the View menu select Restore Full View. 

80. Select al! joints leve! with the bottom ofthe sixth tloor windows by "windowing" Uoints 
972, 973, 980, etc., 49 joints total). 

81. Select al! shell elements leve! with the bottom half ofthe sixth floor windows by using the 
intersecting line se!ection method (shell elements 730, 738, 742, etc., 24 shells total). 

82. From the Assign menu select Group N ame ... to display the Assign Group dialog box. 

83. In this dialog box: 

• Type 6TH in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

84. C!ick the Set Elements buttonl~ on the rnain toolbar ( or select Set Eiements ... from the 
View menu) to display the Set Elements Dialog box. 

85. In this dia!og box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck the Labels box in the Shells area. 

• Click the O K button. 

86. From the Analyze menu se!ect Set Options ... to display the Analysis Options dialog box. 

• lo dlli dilllog bouliok<he PJ.o. F"m' XZ Pbo• boUoo ¡ 111m ~«he 
available degrees of free do m. 

• Click the OK button. 

87. Click the Run Analysis button _J to run the analysis. 
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88. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

89. From the Display menu select Show Group Joint Force Sums to display the Select 
Groups dialog box. 

90. In this dialog box: 

• Click on the group named 6TH to highlight it. 

• Hold down the Ctrl key on the keyboard and click on the group named PI ERA to add it 
to the selection 

• Click the OK button. 

9!. When finished viewing the group joint force sums press the "X" in the upper right-hand 
comer ofthe Group joint Force Summation window to clase it. 

10 



FA.C:ULTA.D DE INGENIERÍA. UNAN\ 
DIVISIÓN DE EDUC:A.C:IÓN C:~NTINUA. 

"Tres décadas de orgullosa excelencia" 1971 - 2001 

CURSOS ABIERTOS 

SAP 2000 PARA ANÁLISIS Y DISEÑO 
ESTRUCTURAL 

TEMA 

SAP2000 THREE DIMENSIONAL STA TIC ANO DYNAMIC 
FINITE ELEMENT ANAL YSIS ANO DESIGN OF 

STRUCTURES 

PROBLEM "C" 

EXPOSITOR: ING. FERNANDO MONROY MIRANDA 
PALACIO DE MINERIA 

OCTUBRE DE ~001 

Palacio de Moneóa. Calle de Tocuba No. 5, Primer piso, Delegación Cuauhtémoc. CP 06000, Col. Centro, México D.F .• 
APDO Pos1ol M-2285 o Tels 55214021 ol24. 5623.2910 y 5623.29n o Fax 5510.0573 



• Problem C 
Truss Frame 

Steel Frame 
E =29000 ksi, Poissons Ratio= 0.3 
All steel members are L4x4 angles, Fy = 36ksi 
Base is p1nned 

Diaphragms 
Concrete d1aphragms are 8" thick with a unit weight of 150 pcf 
Model as rigid diaphragm at Levels A and B 
Additional dead load at each diaphragm is 50 psf 
Uve load at each diaphragm is 100 psf 

!..Q_QQ_ 
Size steel members lar DL + LL using AISC - ASD89 
Determine the f~rst three modes of vibration 

Leve/B 

Leve/ A 

--: 
O' 
w 
--: ¡._ 
O' M 
w -
O' 

':':!. 
cT 

':':!. 
O' 
w 

Typical Elevation 
(AII four sides are the same} 

Note: Our intent is that yo u try this problem on your own first. After you have sol ved it on your 
own, you can step through our solution if desired. Ifyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem C Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. IKJ¡Ht :::J 

2. From the File menu select New Model. ... This displays the Coordina te System Definition 
dialog box. 

3. In this dialog box 

• Select the Cartesian Tab. 

• In the Number ofGrid Spaces area type O in the X direction edit box. 

• In the Number ofGrid Spaces area type O in the Y direction edil box. 

• In the Number of Grid S paces area type O in the Z direction edit box. 

• Click the OK button. 

4. From the Draw menu select Edit Grid ... to display the Modify Grid Lines dialog box. 

5. In this dialog box: 

• Verify that the X option is selected in the Direction area. 

• Type 7 in the X Location edit box and click the Add Grid Line button. 

• Type 10.5 in the X Location edit box and click the Add Grid Line button. 

• Select the Z option in the Direction area. 

• Type 25 in the Z Location edit box and click the Add Grid Line button. 

• Type 37 in the Z Location edit box and click the Add Grid Line button. 

• Click the OK button. 

6. Click in the window titled X-Y Plane@ Z=O to rnake sure it is active. The window is 
highlighted when it is active. 

7. Click the xz 2D View buttonGJ to change the view toan X-Z elevation. Note that the 
tille ofthe window changes to X-Z Plane @ Y=O. 

• 
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Figure C -1: Initial Grid Layout In X-Z Plane 

8. Click the Quick Draw Frame Element button -...1 on the si de toolbar or se1ect Quick 
Draw Frame Element from the Draw menu. 

9. Click on the grid 1ine at the point 1abeled "A" in Figure C-1 to entera frame e1ement 

3 

10. C1ick on the grid 1ine at the point 1abeled "B" in Figure C-1 to enter another frame e1ement. 

11. Click the Draw Frame Element button 'J on the side toolbar or select Draw Frame 
Element from the Draw menu. 

12. C1ick on the points 1abe1ed "C", "D", and "E" in Figure C-1, in that order, and then press 
the Enter key on the keyboard to draw two more frame e1ements. 

13. Click on the point labeled "F" and then doub1e click the point labeled "E" in Figure C-1 to 
draw the next frame element 

Note: Yo u could ha ve single-clicked the point /abe/ed "E" in Figure C-1 and then pressed 
the En ter key on the keyboard to finish drawing the frame element. 
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14. Click on the point labeled "G" and then double click the point labeled "D" in Figure C-1 to 
draw the next frame element. 

15. Click on the point labeled "D" and then double click the point labeled "F" in Figure C-1 to 
draw the next frame element. 

16. Click the Pointer button J:U to exit Draw Mode and enter Select Mode. 

17. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

18. In this dialog box: 

• Check the Labels box in the Joints area. 

• Check the Labels box in the Frames area. 

• Check the Fill Elements box. 

• Click the OK button. The screen appears as shown in Figure C-2. 

file f.dn ytft ,Oaline DCM .Select ~s¡gn Aa~e Q¡¡play Oes1,gn .Qp110ft5 tjalp 

olóo:tÍill_:c.L:.UJ~_ij Pl.®t.$1Jíll;912lli><I~I·Ht•·l ~>llllll~ .:.irt,.;,.t.t.I~I..:.:I.QJ 
Rlx-z Plan.o@ V• O I!I~EJ 

~
¡:¡; 

• 
• 

. x-z Ple~~e@ Y•D 

y 

z 

X 

¡' ,' 

.': 

1---------~--~-~~--------1 
í 

-. . • .. .. . · 1 Xll 65 YD.OO Z13D1 · 1 <o<t 

Figure C-2: Screen As lt Appears After Step 18 
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• 19 . Click on frame e1ements 1 and 3 to select them. 

20. Divide Seleded Fr~:~mes From the Edit menu select Divide Frames ... to 
display the Divide Selected Frames dialog box. ,--·'·_,-_.,._ .. ·,-"7",_ .. _··.,-·, ._ .. _._._' _ .. _., 1 

' 
21. r. DMde irrtD ~~ Freunes VerifY that this dialog box is filled out as shown 

in the adjacent figure and click the OK button. l.ast/First ratio _Ir._,,-_--
'· .. ' .· .. ·'-

22. Click the Draw Frame E1ement butto;;;' J on 
the side toolbar or select Draw Frame ement 
from the Draw menu. 

· (" Break at intersections 'W'ith selected 
. · Frames and Jomts 

23. Click on joint 9 and then double c1ick on joint 13 
to draw a frame element. 

. ·":". 
' '· .,., OK 

24. Click on joint 8 and then double click on joint 12 to draw a frame element. 

25. Click onjoint 7 and then double click onjoint 11 to draw a frame element. 

26. Click on joint 6 and then double click on joint 1 Oto draw a frame element. 

27. Click onjoint 13 and.then double click onjoint 2 to draw a frame element. 

28. Click on joint 12 and then double click on joint 9 to draw a frame element. 

29. Click on joint 11 and then double click on joint 8 to draw a frame element. 

30. Click on joint 10 and then double click on joint 7 to draw a frame element. 

31. Click the Pointer button JiJ to exit Draw Mode and enter Select Mode. 

32. Click in the 3D View window to actívate it. 

33. From the View menu select Refresh View to rescale the view. 

34. Click in the Window labeled X-Z Plane@ Y=O to actívate it. 

35. Click the Se1ect All button ~ on the side toolbar to select all elements. 

36. From the Edit menu select Replica te ... to display the Replicate dialog box. 

37. In this dialog box: 

• Select the Mirror Tab. 

• In the Mirror About area select Y -Z plane. 

• In the Ordinate area type 10.5 in the X edit box. 

Cancel 

1 
1 
1 

1 

1 

1 
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• Click the OK button to proceed with the replication. 

38. Click the Draw Frame Element button -....1 on the side toolbar or select Draw Frame 
Element from the Draw menu. 

39. ·cJick onjoint 4 and then double click onjoint 16 to draw a frame element. 

Note: lf the font size is too small for yo u to read the joint /a beis use the following 
procedure to increase the font size. From the Options menu select Preferences, click 
on the Dimensions Tab ifit is not a/ready visible, type in a new (larger) font size in the 
Minimum Graphic Font Size edil box (usual/y about 6 points is suj]icient), click the OK 
button and then c/ick the Refresh Window button .LJ on the main too/bar. 

Note: lf yo u still have difjiculty reading a particular joint /abe/ yo u can always right click 
the joint to bring up a dialog box that gives yo u informa/ion about the joint. 

40. Click the Pointer button ~ 1 to exit Draw Mode and enter Select Mode. 

41. Click the Select All button ~ on the side toolbar to select all elements. 

42. From the Edit menu select Replica te .•. to display the Replicate dialog box. 

43. In this dialog box: 

• Select the Radial Tab. 

• In the Rotate About area select the Z Axis option. 

• In the Increment Data area verify that the Angle is 90 and the Number is l. 

• Click the OK button to proceed with the replication. 

44. Click the Restore Previous Selection button ~ on the side toolbar. 

45. From the Edit menu select Replicate ... to display the Replicate dialog box. 

46. In this dialog box: 

• Verify the Linear Tab is selected. 

• In the Distance area type 21 in the Y edit box. 

• Verify that O is entered in the X and Z edit boxes. 

• Verify that 1 is entered in the Number edil box. 

• Click the OK button to proceed with the replication. 

47. Click in the window titled X-Z Plane@ Y;O to make sure it is active. 
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• 48. Click the yz 2D View buttonW to change the view toan Y-Z elevation. Note that the title 
ofthe window changes to Y-Z Plane@ X=O. 

49. Select al! ofthe elements in the Y-Z plane@ X=O by "windowing". 

50. From the Edit menu select Replicate •.. to display the Replicate dialog box. 

51. In this dialog box: 

• VerifY the Linear Tab is selected. 

• In the Distance area type 21 in the X edit box. 

• In the Distance area type O in the Y edit box. 

• V erifY that O is ente red in the Z edit box. 

• VerifY that l is entered in the Number edit box. 

• Click the OK button to proceed with the replication. 

52. Click the xy 2D View buttoni-'!J to change the view toan X-Y plan. Note that the title of 
the window changes to X-Y Plane@ Z=O. 

53. Select the four joints at this leve! either by "windowing" or by clicking on them 
individually. 

54. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

55. In this dialog box: 

• VerifY that the Translation !, Translation 2 andTranslation 3 boxes are checked. 

• VerifY that the Rotation About l, Rotation About 2 and Rotation About 3 boxes are not 
checked. 

• Click the OK button. 

56. Click the Show Undeformed Shape button O: to reset the window display from joint 
restraints to undeformed geometry. Note that the window title changes. 

57. Click the Up One Gridline button ~ on the main toolbar to display the elevation view at 
Z=25. 

58. Click the Draw Rectangular Shell Element button J5] on the side toolbar or select Draw 
Rectangular Shell Element from the Draw menu. 

59. Click onjoint 32 and thenjoint 14 to draw a shell element over the entire structure. 

7 

;. .~· 



60. Click the Pointer button .t;i 1 to exit Draw Mode and enter Select Mode. 

61. Click on the shell elernent to select it. 

62. Frorn the Edit rnenu select Mesh SheUs ... to 
display the Mesh Selected Shells dialog box. 

63. Fill in this dialog box as shown in the adjacent 
figure and click the OK button. 

64. Click the Up One Gridline button·~ on the 
rnain toolbar to display the elevation v1ew at 
Z;37. 

Mesh Selected Shells 

l. ~ ' . . ' ' : ' •. 

<•, (~ 1 ' . OK' f•i:• ,,.,:¿;;.;.;, ·~ .· 

65. Click the Draw Rectangular Shell Element button:Q] on the side toolbar or select Draw 
Rectangular Shell Element frorn the Draw rnenu. 

66. Click onjoint 33 and thenjoint 15 to draw a shell elernent over the entire structure. 

67. Click the Pointer button Ji] to exit Draw Mode and enter Select Mode. 

68. Click on the shell elernent to select it. 

69. 

70. 

71. 

Frorn the Edit rnenu select Mesh Shells ... to 
display the Mesh Selected Shells dialog box. 

Fill in this dialog box as shown in the adjacent 
figure and click the OK button. 

Click the Set Elements buttoni-ª.J on the rnain 
toolbar ( or select Set Elements ... frorn the View 
meno) to display the Set Elernents Dialog box. 

72. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck the Labels box in the Frarnes area. 

• Click the OK button. 

Mesh Selected Shells 
:;·::.::':•: ;.,,_· '·: n.· ; ".':;:r:·.~-; ·-~ --:.~.-:·: '-.-· e-:: f 
, .. 

. ... 
,.·.·:· .. ~- Meshin.to:<·, 

by 

.\·. r: Mesh using selected Joints on edges 
'!• ··.~:.:;~-= .•· ;; ·--· -::_-;:_ .. - . > ~-- f:. Mesh at intersedi'on with grids 
. :. 1,' :'; ::.' . :: •. ~ J•. -· ! '.. . ._, . . . ·.· 

OK 1., : , Cancel 

73. Frorn the Define rnenu select Sta tic Load Cases .... This will display the Define Static 
Load Case Narnes dialog box. 

74. In this dialog box: 

• Type DL in the Load edit box. 

• Click the Change Load button 
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• o Twe LL in the Load edit box . 

o Select LIVE from the Twe drop-down box. 

o Twe O in the Selfweight Multiplier box. 

o Click the Add New Load button. 

o Click the OK button. 

75. From the Define menu select Materials ... to display the Define Materials dialog box. 

76. In this dialog box: 

o Highlight the CONC material and click the Modify/Show Material button to display 
the Material Propeny Data dialog box. 

o In this dialog box: 

~ Verity that the Mass per Unit Volume is 4.658E-03. 

);- VerifY that the,..Weight per Unit Volume is 0.15. 

~ Click the OKbutton twice to exit all dialog boxes. 

77. Click the drop down box in the status bar to change the units to kip-in. IKip-in ::J: 
===~ 

78. From the Define menu select Materials ... to display the Define Materials dialog box. 

79. In this dialog box: 

o Highlight the STEEL material and click the Modify/Show Material button to display 
the Material Propeny Data dialog box. 

o In this dialog box: 

~ VerifY that the Modulus ofElasticity is 29000. 

>- VerifY that Poisson's ratio is 0.3. 

~ Verity that the steel yield stress is 36. 

>- Click the OK button twice to exit the dialog boxes. 

80. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

81. In this dialog box: 

... 
-~ 
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• Click the drop-down box that says Import I/Wide Flange and select the Import Angle· 
option. 

• Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections. pro and click the Open button. 

• A dialog box appears with a list of all wide flange sections in the database. In this 
dialog box: 

l' Scroll down and highlight the L4x4x3/4 by clicking on it. 

;. Hold down the Shift key on the keyboard and click on the L4x4xl/4 angle. All of 
the L4x4 angles will now be selected (seven total). 

l' Click the OK button twice to return to the Define Frame sections dialog box. 

• Click the drop-down box that says Add I/Wide Flange and select the Add Auto Select 
option to display the Auto Selection Sections dialog box. 

• In this dialog box: 

l' Highlight all ofthe angles in the List ofSections list box by ciicking on the top 
angle, pressing and holding down the shift key on the keyboard, and clicking on the 
bottom angle. 

l' Click the Add button to add the angles to the Auto selections list box. 

;. Click the OK button twice to exit all dialog boxes. 

82. Click the drop down box in the status bar to change the units to kip-ft. IKJp-tt ::J 
83. From the Define menu select Shell Sections ... to display the Define Shell Sections dialog 

box. 

84. In this dialog box: 

• Click the Modify/Show Section button to display the Shell Sections dialog box. 

• In this dialog box: 

;. VerifY the Material specified is CONC. 

l' In the Thickness area type .6667 in both the Membrane and Bending edit boxes. 

l' VerifY that the Shell option is chosen in the Type area. 

;. Click the OK button twice to exit all dialog boxes. 
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85. Click in the 3D View window to make sure it is active. 

86. Click the Select AH button ~ on the side toolbar to select all elements. 

87. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Defme. Frame Sections dialog box. 

88. In this dialog box: 

• Highlight the AUTO 1 section. 

• Click the OK button. 

89. Click the Select AH button ~ on the side toolbar to select all elements. 

90. From the Assign menu select SheH Static Loads ... and then Uniform ... from the submenu 
to display the Shell Uniform Loads dialog box. 

91. In this dialog box: 

• VerifY DL is selected in the Load Case Name drop-down box. 

• In the Uniform Load area type -.05 (50 psf) in the Load edit box. 

• In the Uniform Load area verity that the Dir item is set to Global Z. 

• Click the OK button. 

92. Click the Select All button ~ on the side toolbar to select all elements. 

93. From the Assign menu select SheU Static Loads ... and then Uniform ... from the submenu 
to display the Shell Uniform Loads dialog box. 

94. In this dialog box: 

• Select LL in the Load Case N ame drop-down box. 

• In the Uniform Load area type -.1 (1 00 psf) in the Load edit box: 

• Click the OK button. 

95. Click the Show Undeformed Shape button O! to remove the display ofthe shell static 
loads. 

96. Click in the window labeled X-Y Plane@ Z=37 to activate it. 

97. Select al! ofthe elements in the plan view by "windowing" 

. .-.. 

:'1 
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98. From the Assign menu select Joints and then Constraints ... from the submenu to display 
the Constraints dialog box. 

99. In this dialog box: 

• In the Click To area click the drop-down box that says Add Body and select Add 
Diaphragm to display the Diaphragm Constraint dialog box. 

• In this dialog box: 

;;- Type ROOF in the Constraint N ame edit box. 

;;- Verify that the Z Axis option is selected in the Constraint Axis area. 

;;- Click the OK button twice to exit all dialog boxes. 

100. Click the Show Undeformed Shape button O'ito remove the display ofthejoint 
constraints and reset the window display. 

101. Click the Down One Gridline button L:~J to move to the X-Y Plane@ 2=25. 

102. Select all ofthe elements in the plan view by "windowing" 

103. From the Assign menu select Joints and the Constraints ... from the submenu to display the 
Constraints dialog box. 

104. In this dialog box: 

• In the Click To area click the drop-down box that says Add Body and select Add 
Diaphragm to display the Diaphragm Constraint dialog box. 

• In this dialog box: 

;;- Type SECOND in the Constraint N ame edit box. 

;;- Verify that the Z Axis option is selected in the Constraint Axis area. 

;;- Click the OK button twice to exit all dialog boxes. 

105. Click the Show Undeformed Shape button O! to remove the display ofthe joint 
constraints and reset the window display. 

106. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Check the Dynamic Analysis check box. 

• Click the Set Dynamic Parameters button to display the Dynamic Analysis 
Parameters dialog box. 

12 



• o In this dialog box: 

;. Type 3 in the Number of Modes edit box. 

;. Click the OK button twice to exit al! dialog boxes. 

107. From the Options menu select Preferences ... to display the Preferences dialog box. 

108. In this dialog box: 

o Select the Steel Tab. 

o Select AISC-ASD89 from the Steel Design Code drop-down box. 

o Click the OK button. 

109. Click the Run Analysis button __!.] to run the analysis. 

110. When the analysis is complete checl: the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

111. From the Design menu select Start Design/Check of Structure to initiate the design. The 
design proceeds and when it is complete P-M interaction ratios are displayed. 

112. Click the Set Elements buttonJ-ª.J on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

113. In this dialog box: 

o Check the Sections box in the Frames area. 

o Click the OK button. The sections chosen by the program are displayed. 

Note: You may wantto zoom in using the Rubber Band Zoom bu/Ion .®1 on the main 
too/bar to see the chosen sections be/ter. 

114. Click the Show Undeformed S ha pe button O' to remo ve the display offrame sections 
and interaction values. 

115. Ifyou have zoomed in for a better view ofthe chosen sections, then click the Restore Full 
View button!.® 1 on the main toolbar. 

116. Click the Select All button ~ on the side toolbar to select al! elements. 

117. From the Design menu select Replace Auto W/ Optimal Sections to update the frame 
sections from Auto sections to the chosen angle sizes. Click OK when it says it will 
unlock the model and asks if it is OK to update. 

118. Click the Run Analysis button __!.] to run the analysis using the optimal sections. 
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119. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. Note 
that the 3-D window now shows the first mode shape. 

120. Click the Start Animation button 1 StortAnimauon 1, located in the status bar at the 
bottom ofthe SAP2000 window, to animate the mode shape. 

121. Click the Right Arrow button! '* j, located in the status bar at the bottom ofthe screen, to 
view the second mode shape. 

122. Click the Right Arrow button~ again to view the third mode shape. 

123. Click the Stop Animation button 1 SIC!lAnmolicrl l, ]ocated in the status bar at the bottom of 
the SAP2000 window, to stop the mode shape animation. 

124. From the Design menu select Start Design/Check of Structure to initiate a final design 
check of the structure based on the analysis results using the optimal sections. The design 
proceeds and when it is complete the final P-M interaction ratios are displayed. 

14 
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• Problem D 
lnclined Supports 

Steel 
E =29000 ksi, Poissons Ratio = 0.3 
All members are 10 feet long. 

ToDo 
Determine support reactions. 
Determine X-drrection displacements 
at joints A and B. 

100k 

e W24X68 

L 

a:> 

"' X 

~ 

o 

a:> 

"' X 

~ 

F 

A 

Note: Our intent is that you try this problem on your own first. After you ha ve solved it on your 
own, yo u can step through our solution if desired. Jf yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem D Solution 

l. Click the drop down box in the status bar to change the units to kip-ft.\Klp-tt :.:J 

2. From the File menu select New Model From Template .... This displays the Model 
Templates dialog box. E] 

3. In this dialog box click on the Beam template ~: button to display the Beam 
d1alog box. . ., · . 

4. In this dialog box 

• Type 2 in the Number of Spans edit box. 

• Type 10 in the Span Length edit box. 

• Uncheck the Restraints box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. Click the Set Elements buttonl~ on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

7. In this dialog box: 

• Check the Labels box in the Frames area. 

• Click the OK button. 

8. Click the drop down box in the status bar to change the units to kip-in. jKJp-;n _ jj 
9. From the Define menu select Materials ... to display the Define Materials dialog box. 

1 O. Click on STEEL in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

11. In this dialog box: 

• VerifY 29000 is entered in the Modulus ofElasticity edit box. 

• VerifY .3 is entered in the Poisson's Ratio edit box. 

• Accept the other default values. 

• Click the OK button to exit al! dialog boxes. 
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12. Click the drop down box in the status bar to change the units to kip-ft. II<Jp-tt ::J 
13. From the Define menu select Frame Sections ... to display the Define Frame Sections 

dialog box. 

14. In the Click To area, click the drop-down box that says Import I!Wide Flange and then 
click on the Import I/Wide Flange ítem. 

15. Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections.pro and click the Open button. 

16. A dialog box appears with a list of all wide flange sections in the database. In this dialog 
box: 

• Scroll down and click on the W24X68 section. 

• Click the OK button three times. 

17. Select frame elements 1 and 2. 

18. From the Assign menu select Frame and then Sections .•• from the submenu to display the 
Define F rame Sections dialog box. 

19. Highlight W24X68 in the Frame Sections area and click the OK button. 

20. Click the Show Undeformed S ha pe button O! to remove the displayed frame section 
assignments. 

21. Select frame element 2 by clicking on it. 

22. From the Edit menu select Replicate ... to display the Replicate dialog box. 

23. In this dialog box: 

• Click the Radial Tab. 

• Choose the Y Axis option in the Ro tate about area. Note it will ro tate about the Y -axis 
at the origin. 

• Type 45 in the Angle edil box in the Increment Data area. 

• Type 1 in the Number edit box in the Increment Data area. 

• Click the OK button. 

24. Select frame element 2 by clicking on it. 

25. From the Edit menu select Replicate •.. to display the Replicate dialog box. 
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26. In this dialog box: 

• Click the Radial Tab. 

• Type 90 in the Angle edit box in the Increment Data area. 

• Click the OK button. 

27. Select frame element 2 by clicking on it. 

28. From the Edit menu select Replicate ... to display the Replicate dialog box. 

29. In this dialog box: 

• Click the Radial Tab. 

• Type 270 in the Angle edit box in the Increment Data area. 

• Click the OK button. 

30. Select frame element 2 by clicking on it. 

31. From the Edit menu select Replica te ... to display the Replicate dialog r·· ··. 

32. In this dialog box: 

• Click the Radial Tab. 

• Type 330 in·the Angle edil box in the Increment Data area. 

• Click the OK button. 

33. Select frame element 2 by clicking on it. 

34. Press the Delete key on the keyboard to delete this member. 

35. Click the Refresh Window button_tlto refresh the drawing. 

36. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

37. In this dialog box: 

• Check the Labels box in the Joints area. 

• Uncheck the Labels box in the Frames area. 

• Click the OK button. 
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• 38 . Select joint 4. 

39. From the Assign menu select Joint and then Local Axes ... from the submenu to display 
the Joint Local Axis dialog box. 

40. In this dialog box: 

• Type -45 in the about Y' edit box. 

• Press the OK button. 

41. Select joint 7. 

42. From the Assign menu select Joint and then Local Axes ... from the submenu to display 
the Joint Local Axis dialog box. 

43. In this dialog box: 

• Type -120 in the about Y' edit box. 

• Press the OK button. 

44. Select joint l. 

45. From the Assign menu select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 

46. In this dialog box: 

• Check all six boxes in the Restraints in Local Directions area. 

• Click the OK button. 

47. Select joints 4 and 5. 

48. From the Assign menu select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 

49. In this dialog box: 

• In the Restraints in Local Directions area uncheck the three Rotation boxes and lea ve 
the three Translation boxes checked. 

• Click the OK button. 

50. Select joint 7. 

51. From the Assign m en u select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 
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52. In this dialog box: 

• In the Restraints in Local Directions area uncheck the Translation 3 box and lea ve the 
Translation l and Translation 2 boxes checked. 

• Click the OK button. 

53. Select joint 6. 

54. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

55. In this dialog box: 

• Type 100 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

56. Click the Show Undeformed Shape button O i to remove the displayed joint force 
assignments. 

57. Click the Set Eiements buttonl~ on the main toolbar (or select Set Eiements ... from the 
View menu) to display the Set Elements Dialog box. 

58. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Click the OK button. 

59. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Jo <hl' dlolog bo>OHok •h• PI••• Frnme XZ p¡.., lru«oo ¡ lll" ~ <h• 
available degrees of freedom. 

• Click the OK button. 

60. Click the Run Analysis button _Jto run the analysis. 

61. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

62. Right click on the joints labeled A and B in the problem statement to see their 
displacements. 

63. Click the Joint Reaction Forces button 1_!1 to display the Joint Reaction Forces dialog 
box. 

64. In this dialog box: 
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• • Verity that the Reactions option is selected in the Type area . 

• C!ick the OK button. 

65. The reactions are displayed on the screen. You can right click on any joint to see the 
reactions at that joint or yo u can just read the reactions on the screen. Ifthe text is too 
sma!lto read, you can zoom in, or you can change the minimum font size as described in 
the note below. 

Note: To change the minimumfont size select Preferencesfrom the Options menz1 and 
make su re the Dimensions Tab is selected. In the Minimum Graphic font Size edit box 
input a new size, maybe 5 or 6 points. Click the OK button. 
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• Problem E 
Cables In Tension 

Steel 
E =29000 ksi, Poissons Ratio= 0.3 
All members are 1.5" diameter steel cable 

Joint Loads At Joint D: 
Fx- 50 krps 
Fz = -750 kips 

lo Do 
Determine !he X-direction drsplacements at joint D 
with and without considering !he stiffening affect of 
tension in !he cables. Use P-Delta analysis to consider 
the stiffening altee!. 

e 

y 

Joint Coordinates 
(Feet) 

Joint X y z 

A -3 -2 10 

B o 4 10 

e 3 -2 10 

D o o o 

Note: Our intent is that you try this problem on your own frrst. After you have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to e reate the 
model, then follow the steps in our solution. 
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Problem E Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. jKJ~ :.:J 

2. From the File menu select New Model .... This displays·the Coordinate System Definition 
dialog box. 

3. In this dialog box 

• Select the Cartesian Tab. 

• In the Number ofGrid Spaces area type 2 in the X direction edit box. 

• In the Number ofGrid S paces area type 4 in the Y direction edit box. 

• In the Number of Grid S paces area type 1 in the Z direction edit box. 

• In the Grid Spacing area type 3 in the X Direction edit box. 

• In the Grid Spacing area type 2 in the Y Direction edit box. 

• In the Grid Spacing area type 10 in the Z Direction edit box. 

• Click the OK button. 

4. Click in the window titled X-Y Plane@ Z=l Oto make sure it is active. The window is 
highlighted when it is active. The screen appears as shown in Figure E-1. 

5. Click the Draw Special Joint button ....:...Jon the side toolbar or select Add Special Joint 
from the Draw menu. 

6. Click on the grid intersection labeled "A" in Figure E-1 to enter ajoint at (-3, -2, JO). 

7. Click on the grid intersection labeled "B" in Figure E-1 to enter ajoint at (0, 4, 10). 

8. Click on the grid intersection labeled "C" in Figure E-1 to en ter a joint at (3, -2, 1 0). 

9. Click the Down One Gridline button ~~ to move to the X-Y Plane@ Z=O. 

1 O. Click on the origin to entera joint at (0, O, 0). 

1 1. Click in the window titled 3-D View to activate it. The screen now appears as shown in 
Figure E-2. 

12. Click the Draw Frame Element button '1 on the side toolbar or select Draw Frame 
Element from the Draw menu. 

• 
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Figure E-1: Screen View Just Befare Entering Joints At Elevation Z=lO 

13. Click on the point labeled "D" and then the point labeled "A" in Figure E-2 and press the 
Enter key on the keyboard to draw the first frame (cable) element. 

14. Click on the point labeled "D" and then the point labeled "B" in Figure E-2 and press the 
Enter key on the keyboard to draw the next frame (cable) element. 

15. Click on the point labeled "D" and then the point labeled "C" in Figure E-2 and press the 
Enter key on the keyboard to draw the last frame (cable) element. 

16. Click the Pointer button ~ to exit Draw Mode and enter Select Mode. 

17. Click on the joints identified as A, B and C in Figure E-2 to select them. 

18. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

19. In this dialog box: 

• Verify that the Translation 1, Translation 2 and Translation 3 boxes are checked. 
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Figure E-2: Screen View After Joints Have Been Entered 

• VerifY that the Rotation About 1, Rotation About 2 and Rotation About 3 boxes are not 
checked. 

• Click the OK button. 

20. From the Define menu select Sta tic Load Cases •... This will display the Define Static 
Load Case N ames dialog box. 

21. In this dialog box: 

• Type VERT in the Load edit box. 

• Type O in the Selfweight Multiplier box. 

• Click the Change Load button 

• Type LAT in the Load edit box. 

• Select QUAKE from the Type drop-down box. 
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• • Click the Add New Load button . 

• Click the OK button. 

22. Select the joint identified as D in Figure E-2 by clicking on it. 

23~ From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

24. In this dialog box: 

• Verify VERT is selected in the Load Case name drop-down box. 

• Type -750 in the Force Global Z edit box. 

• Click the OK button. 

25. Select the joint identified as D in Figure E-2 by clicking on it. 

26. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

27. In this dialog box: 

• Select LA T from the Load Case name drop-down box. 

• Type 50 in the Force Global X edit box. 

• Type O in the Force Global Z edit box. 

• Click the OK button. 

28. Click the Show Undeformed Shape button O: to remo ve the display ofjoint static loads. 

29. Click the drop down box in the status bar to change the units to kip-in. IKJp-in _::J \ 

30. From the Define menu select Materials ... to display the Define Materials dialog box. 

31. Click on STEEL in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

32. In this dialog box: 

• Verify that the Modulus ofElasticity is 29000. 

• Verify that Poisson's Ratio is 0.3 

• Click the OK button twice to exit all dialog boxes. 
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33. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

34. In this dialog box: 

• Click the drop-down box that says Add I/Wide Flange and select the Add Circle option. 
This displays the Circle Section dialog box. 

• In this dialog box: 

};- Type CABLE in the Section N ame edit box. 

};- Verity that the selected material in the Material drop-down box is STEEL. 

:.> Type 1.5 in the Diameter (t3) edit box. 

};- Click the OK button twice to exit all dialog boxes. 

35. Select the three frame elements in the 3-D View window by clicking on them. 

36. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

37. In this dialog box: 

• Click on CABLE in the Frame Sections area to highlight it .. 

• Click the OK button. 

38. Click the Show Undeformed Shape button 0 1 to remove the display offrame sections. 

39. Click the Run Analysis button _J to run the analysis. 

40. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

41. Click the drop down box in the status bar to change the units to kip-in. jKip-in ::J [ 
42. Click in the window with the 3-D View to make sure it is active. 

43. Click the Display Sta tic Deformed Shape button 1 :6.. (or select Show Deformed Shape ... 
from the Display menu). The Deformed Shape dialog box appears. 

44. In this dialog box: 

• Select LAT Load Case from the Load drop-down box. 

• Click the OK button. 
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• 45. Right click on the bottorn joint (the one labeled "D" in the problern staternent) to see its 
displacement. Note the X-direction displacernent ofthis joint. This is the displacernent 
without considering the stiffening affect of the tension in the cables. 

46. Click the Lock!Unlock Model button~ on the rnain toolbar to unlock the rnodel. Click 
the OK button when asked ifit is OK to delete. 

47. Frorn the Analyze rnenu select Set Options ... to display the Analysis Options dialog box. 

48. In this dialog box: 

• Check the lnclude P-Delta check box. 

• Click the Set P-Delta Parameters button to display the P-Delta Pararneters dialog box. 

• In this dialog box: 

~ In the lteration Controls area type 5 in the Maximurn lterations edil box. 

~ Accept the other default values in the Iteration Controls area. 

~ In the P-Delta Load Cornbination area verify that the Load Case list box says VERT 
and the Scale Factor list box says l. 

~ Click the OK button twice to exit all dialog boxes. 

49. Click the Run Analysis button _J to run the analysis. 

50. When the analysis is complete check the rnessages in the Analysis window (there should be 
no wamings or errors) and then c!ick the OK button to close the Analysis window. 

51. Click the drop down box in the status bar to change the units to kip-in. !~'?"." ::JJ 

52. Click in the window with the 3-D View to make sure it is active. 

53. C!ick the Display Static Deformed Shape button !&~ (or select Show Deformed Shape ... 
from the Display rnenu). The Deformed Shape dialog box appears. 

54. In this dialog box: 

• Select LAT Load Case from the Load drop-down box. 

• Click the OK button. 

55. Right click on the bottornjoint (the one labeled "D" in the problem statement) to see its 
displacement. Note the X-direction displacernent ofthis joint. This is the displacement 
with the stiffening affect ofthe tension in the cables considered. Notice the difference 
between this displacement and that noted in step 45. 
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• Problem F 
Wall Resisting Hydrostatic Pressure 

Concrete 
E =3600 ksi, Poissons Ratio = 0.2 

Boundary Conditions 
Case 1: Wall clamped at bottom only. 
Case 2: Wall clamped at bottom and sides. 

ToDo 
Determine maximum Y-direction 
displacements at top of wall for Case 1 
and Case 2 support conditions. Use joint 
patterns to apply hydrostatic load. 

Top 

Bottom 

S id e 
15' 

z 

X 
y 

R 

Water pressure 
62.4 Jbsfft3 

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, yo u can step through our solution if desired. lfyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem F Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. )Klp-!t 3 

2. 

3. 

From the File menu select New Model From Template ••.. This displays the M o del 
Templates dialog box. 

I"'h"I"Iog ""' dk k ""'h' Sh"' W oll<ompl•"illlli lmtloo <o di'J' Wy •h• S hoM 
Wall dialog box. 

4. In this dialog box 

o Type 30 in the Number of S paces Along X edit box. 

o Type 15 in the Number of S paces Along Z edit box. 

o Type 1 S pace Width Along X edit box. 

o Type 1 S pace Width Along Z edit box. 

o Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to clase it. 

6. Click the drop down box in the status bar to change the units to kip-in. JKlp-in 3! 
7. From the Define menu select Materials •.. to display the Define Materials dialog box. 

Highlight the CONC material and click the Modify/Show Material button to display the 
Material Propeny Data dialog box. 

8. In this dialog box: 

o Verify that the modulus of elasticity is 3600 and poisson's ratio is 0.2. 

o Click the OK button twice to exit the dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-ft. JKlp-!t 3 
10. Select all ofthe supportjoints at the bottom ofthe wall by "windowing". 

11. From the Assign menu, chao se Joint, and then Restraints ... frorn the submenu. This will 
display the Joint Restraints dialog box. 

12. In this dialog box: 

o Click the fixed base fast restraint button !l.! to set all degrees of freedom (U 1, U2, U3, 
Rl, R2 and R3) as restrained. 
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• • Click the OK button . 

13. From the Define menu select Joint Patterns ... to display the Define Pattem N ames dialog 
box. 

14. In this dialog box: 

15. Type HYDRO in the edit box in the Pattems area. 

I6. Click the Add New Pattern Name button 

I 7. Click the OK button. 

18. Click the Seiect AII button ~ on the side too! bar. 

I 9. From the Assign menu select Joint Patterns ... to display the Pattem Data dialog box. 

20. In this dialog box: 

• Select HYDRO from the Pattem N ame drop-down box. 

Note: Press the F 1 key on the keyboard.for context sensitive help on the dia/og box 
illustrating the definition of the Constants. Whenfinished reading the help, click 
the 'X" in the top right-hand comer of the Help window to el ose it. 

• Type -1 in the Constant C edit box. 

• Type 15 in the Constant.D edit box. 

• Click the OK button. 

21. Click the Seiect AH button ~ on the side too] bar. 

22. From the Assign menu select Shell Static Loads ... and select Pressure ... from the 
submenu to display the Shell Pressure Loads dialog box. 

23. In this dialog box: 

• Select the By Joint Pattem option. 

• Select HYDRO from the Pattem drop-down box. 

• Type .0624 in the Multiplier edit box. 

• Click the OK button. 

24. Click the Show Undeformed Shape button O' to remove the displayed joint force 
assignments. 

..: 

:.; 

' 
r;.t.¡ 

' . ~. 

,. 
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25. Click the Run Analysis button _Jto run the analysis. 

26. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

27. Right click on the center joint at the top ofthe wall and note the Y-direction displacement. 

28. Click the Lock!Unlock Model button j ~ and click the resulting OK button to unlock the 
model. 

29. Selectthe joints along the sides ofthe model by "windowing" each side separately. 

30. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

31. In this dialog box: 

• Click the fixed base fast restraint button IJ.!to set all degrees offreedom (U!, U2, U3, 
Rl, R2 and R3) as restrained. 

• Click the OK button. 

32. Click the Run Analysis button _Jto run the analysis. 

33. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

34. Right click on the center joint at the top ofthe wall and note the Y-direction displacement. 

-'S 'i\ 
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• Problem G 
Frame With Support Displacement 

S te el 
E =29000 ksi, P01ssons Ratio= 0.3 
Pinned base 
All beam-column connections are rigid 

ToDo 
Determine support reactions due to a 
1" downward displacement of joint B. 

rG~----~W~2~4~X~5~5 ______ ~H 

D W24X68 E 

o o 
O> O> 
X X 

"'" "'" ~ ~ 

~ ~ 

A 
B 

30' 

¡..,¡ 
~ 

W24X68 F 

N 

"' X ... 
"'" ~ 

~ 

e 

30' 

Note: Our intent is that you try this problem on your own first. After yo u have sol ved it on your 
own, yo u can step through our solution if desired. lf yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem G Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. jKJp-tt :.:J 

2. From the File menu select New Model From Template .... This displays the Model 
Templates dialog box. 

3. lo dlli di>log bo'O !iek "" <he Po rt•l F nmdomp ''" ll ¡ ll b•~• <o dl,pJ.y <he 
Portal Frame dialog box. . 

4. In this dialog box 

• Type 14 in the Story Height edit box. 

• Type 30 in the Bay Width edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to clase it. 

6. Click the drop down box in the status bar to change the units to kip-in. jK,p-m ::J[ 

7. From the Define menu select Materials ... to display the Define Materials dialog box. 
Highlight the STEEL material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

8. In this dialog box: 

• VerifY that the modulus ofelasticity is 29000 and poisson's ratio is 0.3. 

• Click the OK button twice to exit the dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-ft. jKip-tt :.:J 

1 O. Click the Set Elements button[-ª.J on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

11. In this dialog box: 

• Check the Labels box in the Frames area. 

• Click the OK button. 

12. Select frame elements 6 and 10. Press the delete key on the keyboard to delete these 
elements. 

13. Click the Refresh Window button __éj to refresh the drawing. 
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14. From the Draw menu choose Edit Grid ..• to display the Modify Grid Lines dialog box. 

15. In this dialog box: 

• Verify that the Z option is chosen in the Direction area. 

• Check the Glue Joints To Grid Lines box. 

• Click on the 28 grid line in the Z Location list box to highlight it. Note that the 28 
appears in the Z Location edit box. 

• Change the 28 in the Z Location edit box to 26 and click the M ove Grid Line button. 

• Click the OK button. 

16. From the Define menu select Frame Sections ..• to display the Define Frame Sections 
dialog box. 

17. In the Click To area, click the drop-down box that says Import VWide Flange and then 
click on the Import I/Wide Flange item. 

18. Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. 

19. A dialog box appears with a list ofall wide flange sections in the database. In this dialog 
box: 

• Scroll down and click on the W24X68 section. 

• Scroll down to the W24X55 section, and click on it while holding down the Ctrl key on 
the keyboard. 

• Scroll down to the Wl4X90 section, and click on it while holding down the Ctrl key on 
the keyboard. 

• Click the OK button three times to exit all dialog boxes. 

20. Select frame member 8. 

21. From the Assign menu select Frame and then Sections •.. from the submenu to display the 
Define Frame Sections dialog box. 

22. In this dialog box: 

• Click on W24X55 in the Frame Sections area to highlight it. 

• Click the OK button. 
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23. Click the Show Undeformed Shape button O 1 to remove the displayed frame section 
assignments so that you can see the frame element labels again. 

24. Select frame members 7 and 9. 

25. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

26. In this dialog box: 

• Click on W24X68 in the Frame Sections area to highlight it. 

• · Click the OK button. 

27. Click the Show Undeformed S ha pe button O 1 to remove the displayed frame section 
assignments so that you can see the frame element labels again. 

28. Select frame members 1 through 5. 

29. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

30. In this dialog box: 

• Click on WI4X90 in the Frame Sections area to highlight it. 

• Click the OK button. 

31. Click the Show Undeformed Shape button O 1 to remove the displayed frame section 
assignments. 

32. Click the Set Elements buttonJ~ on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

33. In this dialog box: 

• Check the La beis box in the Joints area. 

• Uncheck the Labels box in the Frames area. 

• Click the OK button. 

34. Click the drop down box in the status bar to change the units to kip-in. JKrp,n :.:J J 

35. Select joint 4 (labeled B in the problem statement). 

36. From the Assign menu select Joint Static Loads ... and then Displacements ... from the· 
submenu to display the Ground Displacements dialog box. 
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• 37. In this dialog box: 

• Type -1 in the Translation Z edit box. 

• Click the OK button. 

38. Click the drop down box in the status bar to change the units to kip-ft. IKlP:t:_ __ j_ 

39. Click the Show Undeformed S ha pe button O i to remove the displayed joint displacement 
assignments. 

40. Click the Set Elements buttoniJ!! on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

41. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Click the OK button. 

42. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo ,h;, dl,log boH Hok<he p¡.,, F rum< XZ PI••• bm<oo ¡ 111 <o ~ '"' 
available degrees of freedom. 

• Click the OK button. 

43. Click the Run Analysis button __.J to run the analysis. 

44. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

45. Click the Joint Reaction Forces button !l:J to display the Joint Reaction Forces dialog 
box. 

46. In this dialog box: 

• Verity that the Reactions option is selected in the Type area. 

• Click the OK button. 

47. The reactions are displayed on the screen. You can right click on any joint to see the 
reactions at thatjoint oryou canjust read the reactions on the screen. Ifthe font size for 
the joint reactions shown on the screen is too small then read the note below. 

Note: To change the minimumfont size se/ect Preferencesfrom the Options menu and 
make su re the Dimensions Tab is selected. In the Minimum Graphic font Size edit box 
input a new size. maybe 5 or 6 points. Click the OK button. 
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• Problem H Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡t<Jp-tt 3 
2. From the File menu select New Model From Template .... This displays the Model 

Templares dialog box. B 
3. In this dialog box click on the Beam templare •• a íh: button to display the Beam 

dialog box. . 

4. In this dialog box: 

• Accept all ofthe default values. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to clase it. 

6. From the Define menu select Materials ... to display the Defme Materials dialog box. 

7. Click on COi'<C in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

8. In this dialog box: 

• Verity 0.15 is entered in the Weight per Unit Volume edit box. 

• Click the OK button twice to exit all dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-in. lt<Jp_-m 31 
1 O. From the Define menu select Materials ... to display the Defme Materials dialog box. 

11. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

12. In this dialog box: 

• Verity 3600 is entered in the Modulus ofElasticity edil box. 

• Verity .2 is entered in the Poisson 's Ratio edit box. 

• Verity 60 is emered in the Reinforcing Yield Stress, fY edit box. 

• Verity 4 is entered in the Concrete Strength, fe edit box. 

• Type 60 in the Shear steel Yield Stress, tys edit box. 
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Problem H Solution 

l. Click the drop down box in the status bar to change the units to kip-ft.IKJp-tt :::J 

2. From the File menu select New Model From Template .••. This displays the Model 
Templates dialog box. B 

3. In this dialog box click on the Beam template . .......,...... : button to display the Beam 
dialog box. : . 

4. In this dialog box: 

• Accept all ofthe default values. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to clase it. 

6. From the Define menu select Materials ••. to display the Define Materials dialog box. 

7. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

8. In this dialog box: 

• VerifY 0.15 is entered in the Weight per Unit Volume edit box. 

• Click the OK button twice to exit all dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-in. jKJp-m 3/ 
10. From the Define menu select Materials .•• to display the Define Materials dialog box. 

11. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

12. In this dialog box: 

• VerifY 3600 is·entered in the Modulus ofElasticity edit box. 

• VerifY .2 is entered in the Poisson's Ratio edit box. 

• VerifY 60 is entered in the Reinforcing Yield Stress, fY edit box. 

• VerifY 4 is entered in the Concrete Strength, fe edit box. 

• Type 60 in the Shear steel Yield Stress, fYs edit box. 

• 
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• • Type O in the Self weight Multiplier box . 

• Click the Add New Load button. 

• Click the OK button. 

18. Select the two frame elements. 

19. From the Assign menu select Frame Static Loads •.• and then Point and Uniform .•. from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

20. In this dialog box: 

• Verity that the Load Case Name is DL. 

• In the Load Type and Direction area verity that the Forces option is selected and that 
the Global Z direction is selected. 

• In the Uniform Load area type -2.2. 

• Click the OK button. 

21. Select the two frame elements. 

22. From the Assign menu select Frame Sta tic Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

23. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Uniform Load area type -1.6. 

• Click the OK button. 

24. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo •h k dlolo g bm !k k <ho Pb"' F nmo XZ Plooo bonoo ¡ ¡ ll m '" ilio 
available degrees of freedom. 

• Click the OK button. 

25. From the Options menu select Preferences ... to display the Preferences dialog box. 

26. In this dialog box: 

• Select the CONC Tab. 
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• Type O in the Selfweight Multiplier box. 

• Click the Add New Load button. 

• Click the OK button. 

18. Select the two frame elements. 

19. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

20. In this dialog box: 

• Verity that the Load Case N ame is DL. 

• In the Load Type and Direction area verify that the Forces option is selected and that 
the Global Z direction is selected. 

• In the Uniform Load area type -2.2. 

• Click the OK button. 

21. Select the two frame elements. 

22. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

23. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Uniform Load area type -1.6. 

• Click the OK button. 

24. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• 1" dlli dio lo g boo d /<k <he Plooo Fmmo XZ ?lo>< lm<Wo ¡ ¡ ¡f '"" <ho 
available degrees of freedom. · 

• Click the OK button. 

25. From the Options menu select Preferences ... to display the Preferences dialog box. 

26. In this dialog box: 

• Select the CONC Tab. 

• 
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• 34. Click the drop down box in the status bar to change the units to kip-in. \Klp-;n .. 31 

35. 

36. 

Note thatthe va/u es for the area of longitudinal reinforcing steel are now in units of square 
inches. 

From the Design menu select Display Design lnfo ... to display the Display Design Results 
dialog box. 

In this dialog box: 

• Verify that the Design Output option is selected. 

• Select Shear Reinforcing from the Design Output drop-down box. 

• Click the OK button. The required shear reinforcing is displayed on the screen. 

Note that the val u es for the shear reinforcing steel are reported asan area per unit length 
of e!ement. Since the current units are kips and inches, the shear reinforcing reported 
is in square inches per inch. 

37. Right click on the left beam to display the Concrete Design Information dialog box. 

38. In this dialog box: 

• Note that the required top and bono m longitudinal steel and the required shear stee 1 is 
reponed for each design load combination at each output segment along the beam. 

• Click the Details button to see design details for the highlighted design load 
combination and output station location. The Concrete Design Information ACI 318-95 
dialog box is displayed. 

• When finished viewing the detailed information click the "X" in the upper right-hand 
comer ofthe Concrete Design Infonmation ACI 318-95 dialog box to close it. 

• Click OK to close the Concrete Design Information dialog box. 
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34. Click the drop down box in the status bar to change the units to kip-in. Ji(j~n ::JI 
===""'"'-" 

Note that the values for the area of longitudinal reiriforcing steel are now in units of square 
inches. 

35. From the Design menu select Display Design Info ... to display the Display Design Results 
dialog box. 

36. In this dialog box: 

• Verity that the Design Output option is selected. 

• Select Shear Reinforcing from the Design Output drop-down box. 

• Click the OK button. The required shear reinforcing is displayed on the screen. 

Note that the valuesfor the shear reiriforcing steel are reported asan area per unit length 
of element. Since the curren/ units are kips and inches, the shear reiriforcing reported 
is in square inches per inch. 

37. Right click on the left beam to displaythe Concrete Design Information dialog box. 

38. In this dialog box: 

• Note that the required top and bottom longitudinal steel and the required shear steel is 
reported for each design load combination at each output segment along the beam. 

• Click the Details button to see design details for the highlighted design load 
combination and output station location. The Concrete Design Information ACI 318-95 
dialog box is displayed. 

• When finished viewing the detailed information click the "X" in the upper right-hand 
comer ofthe Concrete Design Information ACI 318-95 dialog box to close it. 

• Click OK to close the Concrete Design Information dialog box. 
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• Problem 1 
Prestressed Concrete Beam 

Concrete 
E =4400 ksi, Poissons Ratio= 0.2 
fe= 6 ksi 
Cable Tension = 200 kips 

ToDo 
Determine the moment diagram for a DL + LL + PRESTRESS loadmg 
combination. Compare the results using 4 output segments and using 
30 output segments. 

w0L = 2.2 kit (not including beam weight) 
WLL=1.6kJf 

30' Beam Section 

Note: Our intent is that you try this problem on your own frrst. After you have sol ved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to e reate the 
model, then follow the steps in our solution. 
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Problem 1 Solution 

l. Click the drop down box in the status harto change the units to kip-ft. jKJp-tt ::J 

2. From the File menu select New Model From Template .... This displays the Model 
Templates dialog box. . EJ 

3. In this dialog box click on the Beam template ~ · button to display the Beam 
dialog box. . • 

; ' . 
4. In this dialog box: 

• Type 1 in the Number of Spans edit box. 

• Type 30 in the Span Length edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. From the Define menu select Materials ... to display the Defme Materials dialog box. 

7. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

8. In this dialog box: 

• Verify 0.15 is entered in the Weight per Unit Volume edil box. 

• Click the OK button twice to exit all dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-in. jKip-in ::J 1 

1 O. From the Define menu select Materials ... to display the Define Materials dialog box. 

11. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

12. In this dialog box: 

• Type 4400 in the Modulus ofElasticity edit box. 

• . Verify .2 is entered in the Poisson 's Ratio edit box. 

• Verify 60 is entered in the Reinforcing Yield Stress, fy edit box. 

• Type 6 in the Concrete Strength, fe edit box. 

• 
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• • Type 60 in the Shear steel Yield Stress, fys edit box . 

• Type ~ in the Concrete Shear Strength, fes edit box. 

• Accept the other default values. 

• Click the OK button twice to exit all dialog boxes. 

13. From the Define menu select Franie Sections ... to display the Define Frame Sections 
dialog box. 

14. In this dialog box: 

• With the default section, FSEC l. highlighted, click the Modify/Show Section button to 
display the Rectangular Section dialog box. 

• In this dialog box: 

J;> Select CONC from the Material drop-down box. 

J;> Type 30 in the Depth (t3) edit box. 

¡;. Type 18 in the Width (t2) edit box. 

¡;. Click the OK button twice to exit all dialog boxes. 

15. Select the frame element by clicking on it. 

16. From the Assign menu select Frame and then Prestress ... from the submenu to display 
the Frame Prestressing Patterns dialog bo::. 

17. In this dialog box: 

• Type 200 in the Cable Tension edit box. 

• In the Cable Eccentricities area type 8 in the Start edit box. 

• In the Cable Eccentricities area type 12 in the Middle edit box. 

• In the Cable Eccentricities area type 3 in the End edit box. 

• Click the OK button. 

18. Click the drop down box in the status bar to change the units to kip-ft. IKJp-it 3 
19. From the Define menu select Sta tic Load Cases .... This will display the Define Static 

Load Case N ames dialog box. 

20. In this dialog box: 
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• Type DL in the Load edit box. 

• Click the Change Load button 

• Type LL in the Load edit box. 

• Select LIVE from the Type drop-down box. 

• Type O in the Selfweight Multiplier box. 

• Click the Add New Load button. 

• Type PRESTRES in the Load edit box. 

• Select OTHER from the Type drop-down box. 

• Click the Add New Load button. 

• Click the OK button. 

21. From the Define menu select Load Combinations •... This will display the Define Load 
Combinations dialog box. 

22. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box. 

• In this dialog box: 

> Accept the default load combination name, COMB 1 

;;. Accept the default load combination type, Add. 

;.. Type COMBl: DL + LL + Prestress in the Title edit box. 

;.. VerifY the DL Load Case is selected in the Case N ame drop-down box. 

;;. VerifY that 1 is entered in the Scale factor edit box. 

;;. Click the Add button. 

;;. Select LL Load Case from the Case N ame drop-down box. 

> Click the Add button. 

> Select PRESTRES Load Case from the Case N ame drop-down box. 

> Click the Add button. 

• 
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• );;. Click the OK button twice to exit al! dialog boxes . 

23. Select the frame element. 

24. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

25. In this dialog box: 

• Verif'y that the Load Case Name is DL. 

• In the Load Type and Direction area verify that the Forces option is selected and that 
the Global Z direction is selected. 

• In the Uniform Load area type -2.2. 

• Click the OK button. 

26. Select the frame element. 

27. From the Assign mcnu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Pomt and Uniform S pan Loads dialog box. 

28. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the U niform Load area type -1.6. 

• Click the OK button. 

29. Select the frame element. 

30. From the Assign menu select Frame Sta tic Loads ... and then Prestress ... from the 
submenu to display the Frame Prestress Loads dialog box. 

31. In this dialog box: 

• Select PRESTRES from the Load Case N ame drop-down box. 

• Type 1 in the S cale Factor edit box .. 

• Click the OK button. 

32. Select the frame element. 

33. From the Assign menu select Frame and then Output Segments ... from the submenu to 
display the Frame Output Segments dialog box. 
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34. In this dialog box: 

• Type 4 in the Number of Segments edit box. 

• Click the OK button. 

35. Click the Show Undeformed S ha pe button O\ to remove the displayed frame output 
segment assignments. 

36. From the Analyze menu select Set Options ••. to display the Analysis Options dialog box. 

• lo ili" dlolog lm o Jlok<ho """ Fmm• XZ "'""'""'" ¡ ¡ ~~ <o ""' <ho 
available degrees of freedom. 

• Click the OK button. 

37. Click the Run Analysis button _Jto run the analysis. 

38. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. · 

39. Click the Member Force Diagram for Frames·button 1 F 1, (or select Show Element 
Forces/Stresses from the Display menu and then select Frames ... from the submenu). 
The Member Force Diagram for Frames dialog box appears. 

40. In this dialog box: 

• Select COMB 1 Combo from the Load drop·down box. 

• Select the Moment 3-3 option in the Componen! area. 

• U ncheck the F ill D iagram check box. 

• Check the Show Values on Diagram check box. 

• Click the OK button to display the moment diagram. 

Note: Yo u m ay want to print this mamen! diagram for comparison with the one obtained 
when 30 output segments are specified. To print the mamen! diagram select Print 
Graphics from the File m en u. 

Note: For load combinations, whenforce diagrams are plotted, exact values are only 
ca/cu/ated at the ends ofeach output segment. These exact va/ues are plotted and then 
they are connected v.ith straight lines. 

41. Click the Lock!Unlock Model buttonl ~ on the main tooibar to unlock the model. Click 
the OK button when asked ifit is OK to delete. 
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• 42. Select the frame element. 

43. From the Assign menu select Frame and then Output Segments ... from the submenu to 
display the Frame Output Segments dialog box. 

44. In this dialog box: 

• Type 30 in the Number of Segments edit box. 

• Click the OK button. 

45. Click the Show Undeformed S ha pe button O 1 to remove the displayed frame output 
segment assignments. 

46. Click the Run Analysis button __Jto run the analysis. 

47. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

48. Click the Member Force Diagram for Frames button 1 F l. (or select Show Element 
Forces/Stresses from the Display menu and then select Frames ... from the submenu). 
The Member Force Diagram for Frames dialog box appears. 

49. In this dialog box: 

• Verity that the COMB 1 Combo is selected in the Load drop-down box. 

• Verity that the Moment 3-3 option is selected in the Componen! area. 

• Verity that the Show Values on Diagram check box is checked. 

• Click the OK button to display the moment diagram. 
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'-' Click the OK buttan twice ta retwn ta the Time Histary Display Definitian 
dialag bax. 

• Verify that HISTI is selected in the Time Histary Case drop-dawn bax. 

• Click an Jaint 4 in the List afFunctians area ta highlight (select) it. 

• Click the Add buttan ta mave Jaint 4 ta the Plat Functians area. 

• Click the Display buttan ta display the time histary. 

• Click the OK buttan ta clase the time histary display and return ta the Time Histary 
Display Definitian dialag bax. 

• Select HIST2 in the Time Histary Case drop-dawn bax. 

• Click the Display buttan ta display the time histary. 

• Click the OK buttan ta clase the time histary display and return ta the Time Histary 
Display Definitian dialag bax. 

• Select HIST3 in the Time Histary Case drop-dawn bax. 

• Click the Display buttan ta display the time histary. 

• Click the OK buttan ta clase the time histary display and return ta the Time History 
Display Definitian dialag bax. 

• Click the Done buttan ta clase the Time History Display Definition dialog bax. 

• 
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• Problem J 
Beam On Elastic Foundation 

Concrete 
E=3120ksi 
Poissons Ratio ': 0.2 

ToDo 
Determine !he mamen! diagram under combined dead plus live loads 
and !he maximum downward displacement. 

Note: Dead load shown does not include beam self weight. 

WoL = 10.6 kJf 
WLL = 5.4 klf 

+ + 

t t 
1'1' Typical 

+ + 

t t 
-K - 50 kfln, typ1cal 

20' 

p -250 k DL-
PLL=150k 

-~ r + 

1¡1 t 
6' 

Di 
Beam Seétion 

Note: Our intent is that you try this problem on your own frrst. After yo u have sol ved it on your 
own, you can step through our solution if desired. lfyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem J Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. lKip-ft ::J 

2. From the File menu select New Model From Template .... This displays the Model 

Templates dialog box. 8 
3. 1~ this dialog box click on the Beam template :....-T-1h button to display the Beam 

d~alog box. · 

4. In this dialog box: 

• Type 1 in the Number ofSpans edit box. 

• Type 20 in the Span Length edit box. 

• Uncheck the Restraints check box 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View wi.ndow to close it. 

6. From the Define menu select Materials ... to display the Defme Materials dialog box. 

7. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

8. In this dialog box: 

• VerifY 0.15 is entered in the Weight per Unit Volume edit box. 

• Click the OK button twice to exit all dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-in. lKJp-in ::JI 
1 O. From the Define menu select Materials ... to display the Define Materials dialog box. 

11. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

12. In this dialog box: 

• Type 3120 in the Modulus ofElasticity edit box. 

• VerifY .2 is entered in the Poisson 's Ratio edit box. 

• Accept the other default values. 

• 
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. ' 

• Click the OK button twice to exit aH dialog boxes . 

13. From the Define menu select Frame Sections •.. to display the Define Frame Sections 
dialog box. 

14. In this dialog box: 

• With the default section, FSEC 1, highlighted, click the Modify/Show Section button to 
display the Rectangular Section dialog box. 

• In this dialog box: 

~ Select CONC from the Material drop-down box. 

~ Type 42 in the Depth (t3) edit box. 

~ Type 24 in the Width ( t2) edit box. 

~ Click the OK button twice to exit aH dialog boxes. 

15. Click the drop down box in the status bar to change the units to kip-ft. J Klp-H ::J 
16. Select the frame element by clicking on it. 

17. From the Edit menu select Divide Frames •.. to 
display the Divide Select frames dialog box. 

18. FiH in the dialog box as shown in the adjacent 
figure and click the OK button. 

19. From the Define menu select Static Load 
Cases.... This wiH display the Define Static 
Load Case N ames dialog box. 

20. In this dialog box: 

• Type DL in the Load edit box. 

• Click the Change Load button 

• Type LL in the Load edit box. 

• Select LIVE from the Type drop-down box. 

• Type O in the Selfweight Multiplier box. 

• Click the Add New Load button. 

• Click the OK button . 

Divide Selected Frames ·. 

r. Divide nto izo Frames 

Last/Fnt ratio ~¡,-- ... 
·r Break at intersectiom win selected 
.. Frames andJoints · · ·•· 

.. ,,· 

OK .. Cancel ,_ • --
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21. From the Define menu select Load Combinations .... This will display the Define Load 
Combinations dialog box. 

22. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box. 

• In this dialog box: 

;.. Accept the default load combination name, COMB 1 

;.. Accept the default load combination type, Add. 

;.. Type COMBI: DL + LL in the Title edit box. 

;.. Verity the DL Load Case is selected in the Case N ame drop-down box. 

;.. Verity that 1 is entered in the Scale factor edit box: 

;.. Click the Add button. 

;.. Select LL Load Case from the Case N ame drop-down box. 

;.. Click the Add button. 

;.. Click the OK button twice to exit all dialog boxes. 

23. Select all ofthe frame elements by "windowing". 

24. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Unifonn Span Loads dialog box. 

25. In this dialog box: 

• Verity that the Load Case N ame is DL. 

• In the Load Type and Direction area verifY that the Forces option is selected and that 
the Global Z direction is selected. 

• In the Uniform Load area type -10.6. 

• Click the OK button. 

26. Click the Restore Previous Selection button. (!§ j on the side toolbar ( or select Gel 
Previous Selection from the Select menu). 

27. From the Assign menu select Frame Sta tic Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Unifonn Spari Loads dialog box. 
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• 28. In this dialog box: 

• Select LL from the Load Case Name drop-down box. 

• In the Unifonn Load area type -5.4. 

• Click the OK bunon. 

29. Click the Show Undeformed Shape button O\ to remove the displayed frame uniform 
load assignments. 

30. Click the Set Elements buttonl~ on the rnain toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

31. In this dialog box: 

• Check the Labels box in the Joints area. 

• Click the OK button. 

32. Select joint 16 (6 feet from the right end) by clicking on it. 

33. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. ' 

34. In this dialog box: 

• Select DL from the Load Case N ame drop-down box. 

• Type -250 in the Force Global Z edit box in the Loads area. 

• Click the OK button. 

35. Click the Restore Previous Selection button ~ 1 on the side toolbar (or select Get 
Previous Selection from the Select menu). 

36. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

3 7. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• Type -150 in the Force Global Z edit box in the Loads area. 

• Click the OK bunon. 

38. Click the Show Undeformed S lía pe bunon O 1 to remove the displayed joint load 
assignments. 
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39. Click the Set Elements buttoni-ª.Jon the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

40. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Click the OK button. 

41. Click the drop down box in the status bar to change the units to kip-in. JKíp·m 31 
42. Select all ofthe joint elements by "windowing". 

43. From the Assign menu select Joint and then Springs ... from the submenu to display the 
Joint Springs dialog box. 

44. In this dialog box: 

• Type 50 in the Translation 3 edit box. 

• Click the OK button. 

45. Click the Show Undeformed Shape button O 1 to remove the displayed frame output 
segment assignments. 

46. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

4 7. In this dialog box: 

• Uncheck the UX, UY, RX and RZ check boxes leavingjust the UZ and RY boxes 
checked. 

• Click the OK button. 

48. Click the Run Analysis button _Jto run the analysis. 

49. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

50. Click the Member Force Diagram for Frames button 1 F 1, ( or select Show Element 
Forces/Stresses from the Display menu and then select Frames ... from the submenu). 
The Member Force Diagram for Frames dialog box appears. 

51. In this dialog box: 

• Select COMB 1 Combo from the Load drop-down box. 

• Select the Moment 3-3 option in the Componen! area. 
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• • U ncheck the Fill Diagram check box . 

• Check the Show Values on Diagram check box. 

• Click the OK button to display the moment diagram. 

Note: Ifthefont size is too smallforyou toread the moment va/ues use thefol/owing 
procedure to increase the font size. From the Options menu se/ect Preferences, click 
on the D1mensions Tab if it is not already visible. type in a new (larger) font size in the 
Minimum Graphic Font Size edit box (usual/y about 6 points is sufjicient), click the OK 
button and then c/ick the Refresh Window button _{j on the main too/bar. 

Note: You can right c/ick on any oftheframe elements to see details ofthe moment 
diagram for that element. 

52. Click the drop down box in the status bar to change the units to kip-in. jKip-•n_.n ::J.! 
'=-===--"~ 

53. Click the Display Sta tic Deformed Shape button 1 A (or select Show Deformed Shape ... 
from the Display menu). The Deformed Shape dialog box appears. 

54. In this dialog box: 

• Select COMB! Combo from the Load drop-down box. 

• Click the OK button. 

55. Right click on the joint at the far right end ofthe beam to view its detlection. 
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• Problem K 
Steel Moment Frame 

Steel 
E =29000 ksi, Poissons Ratio= 0.3 
Pinned base 
All beam-column connections are rigid 
Beams: W24X55, Fy = 36 ksi 
Columns: W14X90, Fy = 36 ksi 

Beam Span Loadinq On All Beams 
1.0 klf Dead Load (not including steel frame member self weight) 
0.5 klf Live Load 

Lateral Loading !Earthguake\ 
As indicated in the figure 

Unbraced Lenqths 
Assume columns are laterally supported at each floor level 
Assume beams are braced at 1 O feet en center 

ToDo 
Determine stress ratios using AISC-ASDB9 due te DL, LL and EQ loads. 

40kEO~. r---------.---------r--------~ 

20kEo~ r--------~----------r---------4 

10kEO~ r---------4--------~r---------4 

20' 20' 20' 

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to ere ate the 
model, then follow the steps in our solution. 
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Problem K Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡KJp-tt :.:J 

2. From the File menu select New Model From Template .... This displays the Model 
Templates dialog box. 

3. lo "" di•log bo"liok ""''' Port•l F rnm"•mp '"' ll ¡¡J lmttoo <o diopm y <ho 
Portal Frame dialog box. 

4. In this dialog box 

• Type 3 in the Number of Stories edit box. 

• Type 3 in the Number ofBays edit box. 

• Accept the default value of 12 in the Story Height edit box. 

• Type 20 in the Bay Width edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. Click the drop down box in the status bar to change the units to kip-in. jKop-in :.:J 1 

7. From the Define menu select Materials ... to display the Define Materials dialog box. 

8. Click on STEEL in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

9. In this dialog box: 

• VerifY that the Modulus ofElasticity is 29000. 

• Verity that Poisson's Ratio is 0.3 

• VerifY that the Weight per Unit Volume is 2.830E-04. 

• VerifY that the steel yield stress is 36. 

• Click the OK button twice to exit al! dialog boxes. 

1 O. Click the drop down box in the status bar to change the units to kip-ft. jKJp-tt O:J 

JI. From the Define menu select Frame Sections ... to display the Defme Frame Sections 
. ' dmlog box. 

•• 
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• 12. In the Click To area, click the drop-down box that says Import 1/Wide Flange and then 
click on the Import I/Wide Flange item. 

13. Ifthe Section Property File dialog box appears then !acate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections.pro and click the Open button. 

14. A dialog box appears with a list ofall wide flange sections in the database. In this dialog' 
box: 

• Scroll down and click on the W24X55 section. 

• Scroll down to the Wl4X90 section, and click on it while holding down the Ctrl key on 
the keyboard. 

• Click the OK button three times to exit all dialog boxes. 

15. Select al! ofthe column elements by "windowing" each ofthe four column lines separately. 

16. From the Assign menu select Frame and then Sections., from the submenu to display the 
Define Frame Sections dialog box. 

17. In this dialog box: 

• Click on Wl4X90 in the Frame Sections area to highlight it. 

• Click the OK button. 

18. Se!ect a!l ofthe beam elements by using the intersecting line selection method on each of 
the three beam bays separately. 

19. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

20. In this dialog box: 

• Click on W24X55 in the Frame Sections area to highlight it. 

• Click the OK button. 

21. Click the Show Undeformed S ha pe button O 1 to remove the disp!ayed frame section 
assignments. 

22. From the Define m en u select Sta tic Load Cases.... This will display the Defme Static 
Load Case N ames dialog box. 

23. In this dialog box: 
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• Type DL in the Load edit box . 

• Click the Change Load button 

• Type LL in the Load edit box . 

• Select LJVE from the Type drop-down box . 

• Type O in the Selfweight Multiplier box . 

• Click the Add New Load button . 

• Type EQ in the Load edit box . 

• Select QUAKE from the Type drop-down box . 

• Click the Add New Load button . 

• Click the OK button . 

24. Click the Resto re Previous Selection button @! on the side toolbar ( or select Get 
Previous Selection from the Select menu) to reselect the beam elements. 

25. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

26. In this dialog box: 

• Verif)r thanhe Load Case N ame is DL. 

• In the Load Type and Direction area verif)r that the Forces option is selected and that 
the Global Z direction is selected. 

• In the Uniform Load area type -l. 

• Click the OK button. 

27. Click the Restore Previous Selection button @/ on the side toolbar (or select Get 
Previous Selection from the Select menu). 

28. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

29. In this dialog box: 

• ·select LL from the Load Case Name drop-down box. 

• In the Uniform Load area type -.5. 

• 
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• Click the OK button. 

30. Click the Show Undeformed Shape button O 1 to remove the displayed frame uniform 
load assignments. 

31. Click the Set Elements buttoni-ª.J on the rnain toolbar ( or select Set Elements •.. from the 
View menu) to display the Set Elements Dialog box. 

32. In this dialog box: 

• Check the Labels box in the Joints area. 

• Click the OK button. 

33. Select joint 4 by clicking on it. 

34. From the Assign menu select Joint Static Loads •.. and then Forces ..• from the submenu to 
display the Joint Forces dialog box. 

35. In this dialog box: 

• . Select EQ from the Load Case N ame drop-down box. 

• Type 40 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

36. Select joint 3 by clicking on it. 

37. From the Assign menu select Joint Static Loads ..• and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

38. In this dialog box: 

• Type 20 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

39. Select joint 2 by clicking on it. 

40. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

41. In this dialog box: 

• Type 1 O in the Force Global X edit box in the Loads area. 

• Click the OK button. 
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42. Click the Show Undeformed Shape button O 1 to remove the displayed joint load 
assigninents. 

43. Click the Set Elements buttoni-ª.Jon the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

44. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Click the OK button. 

45. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo<h;, dOiog b" '"'"'' ""'"' F•~• XZPI>"' '"'"" j lll ro~""' 
available degrees of freedom. 

• Click the OK button. 

46. Click the Run Analysis button _J to run the analysis. 

47. When the analysis is complete check the messages in the Analysis window (there should be. 
no warnings or errors) and then click the OK button to close the Analysis window. 

48. Click the Show Undeformed S ha pe button O 1 to reset the displayed deformed shape. 

49. Select all ofthe beam elements by using the intersecting line selection method on each of 
the three beam bays separately. 

50. From the Design menu select Redefine Element Design Data to display the Element 
Overwrite Assignments dialog box. 

51. In this dialog box: 

• Check the Unbraced Length Ratio (Minor, LTB) check box. 

• Type .5 in the Unbraced Length Ratio (Minor, L TB) edit box. 

• Click the OK button. 

52. From the Options menu select Preferences ... to display the Preferences dialog box. 

53. In this dialog box. 

• Click on the Steel Tab 

• Select AISC-ASD89 from the Steel Design Code drop-down box if it is not airead y 
selected. 
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• Click the OK button. 

54. From the Design menu click Start Design/Check Of Structure to run the design check of 
the steel frame elements. 

55. When the design check completes, the stress ratios are displayed. 
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• Problem L 
Periodic Loading 

Steel 
E =29000 ksi, Poissons Ratio= 0.3 
Pinned base 
All beam-column connections are rigid 

Joint Masses 
Lumped mass at joints e and D is 0.02 kip-sec2 1 in 

Loading 
The load P(t), applied to joint e, is a periodic load. Three different loading 
cases (functions) are defined for P(t). The three loading functions, which have 
periods of 0.25, 0.50 and 1.00 seconds respectively, are shown in the chart 
and graph below. Assume 5% damping for allloading. 

Time 
Point Force Function 1 

(k) (sec) 

a o o 
b 10 0.0625 
e o 0.125 
d -10 0.1875 
e o 0.25 

ToDo 

--'-P-"(t~.-) _
1010
e,,-__ W;..:....:.12:::X..::2:::6 __ --, D 

e 
Time 
(sec) 

Time 
Function 2 

(sec) 

o 
0.125 
0.25 
0.375 

0.5 

A B 

15' 

Time Note: The period of 
Function 3 time functions 1, 2 

(sec) and 3 is 0.25, 0.5 
o and 1 seconds 

0.25 
0.5 

respectively. 

0.75 
1 

1. Verify natural period of structure is approximately 0.50 seconds. 
2. Determine displacement at joint D for the three periodic functions. 

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, you can step through our solution if desired. Ifyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem L Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡KJp-11 ::J 

2. From the File menu select New Model From Template .... This displays the Model 
Templates dialog box. 

3 . ¡0 '"" di•Io g """Ji o k o o ilio P ort•l F nm"omp "" 1 ¡ !ll lmttoo <o di'P 1• Y Ihe 
Portal Frame dialog box. 

4. In this dialog box: 

• Type 1 in the Number ofStories edit box. 

• Type 1 in the Number ofBays edit box. 

• Type 15 in the Bay Width edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. Click the drop down box in the status bar to change the units to kip-in. !Kip-1n .31 
7. From the Define menu select Materials ... to display the Define Materials dialog box. 

Highlight the STEEL material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

8. In this dialog box: 

• VerifY that the modulus ofelasticity is 29000 and poisson's ratio is 0.3. 

• Click the OK button twice to exit the dialog boxes. 

9. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

1 O. In the Click To area, click the drop-down box that says Import 1/Wide Flange and then 
click on the Import I/Wide Flange item. 

11. Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections.pro and click the Open button. 

12. A dialog box appears with a list ofall wide flange sections in the database. In this dialog 
box: 
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• o Scroll down and click on the Wl2X26 section . 

o Scroll do\\'11 to the W8X48 section, and click on it while holding down the etrl key on 
the keyboard. 

o elick the OK button three times to exit all dialog boxes. 

13. Select the beam element. 

14. From the Assign menu select Frame and then Sections ••. from the submenu to display the 
Define Frame Sections dialog box. 

15. In this dialog box: 

o elick on Wl2X26 in the Frame Sections area to highlight it. 

o elick the OK button. 

16. Select the two column elements. 

17. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Defme Frame Sections dialog box. 

18. In this dialog box: 

o elick on W8X48. in the Frame Sections area to highlight it. 

o elick the OK button. 

19. Select the joints labeled e and D in the problem statement. 

20. From the Assign menu select Joint and then Masses ... from the submenu to display the 
Joint Masses dialog box. 

21. In this dialog box: 

o Type .02 in the Direction 1 edit box. 

o Type .02 in the Direction 3 edit box. 

o elick the OK button. 

22. elick the drop down box in the status bar to change the units to kip-ft. JKip-it :.:J 

23. elick the Show Undeformed Shape button O 1 to remo ve the displayed joint mass 
assignments. 

24. Select the joint labeled e in the problem statement. 
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25. From the Assign menu select Joint Static Loads ... and then Forces ••. from the submenu to • 
display the Joint Forces dialog box. 

26. In this dialog box: 

• Type 1 in the Force Global X edit box. 

• Click the OK button. 

27. Click the Show Undeformed Shape button O 1 to remo ve the displayed joint force 
assignments. 

28. From the Define menu select Time History Functions ... to display the Define Time 
History Functions dialog box. 

29. In this dialog box: 

• Click the Add New Function button to display the Function Definition dialog box. 

• In this dialog box: 

~ Accept the default FUNC 1 function na me. 

~ Click the Add button. 

~ Type .0625 in the Time edit box, type 10 in the Value edit box, and click the Add 
button. 

~ Type .125 in the Time edit box, type O in the Value edit box, and click the Add 
button. 

~ Type .1875 in the Time edit box, type -10 in the Value edit box, and click the Add 
button. 

~ Type .25 in the Time edit box, type O in the Value edit box, and click the Add 
button. 

~ C!ick the OK button to retum to the Define Time History Functions dialog box. 

• Click the Add New Function button to display the Function Definition dialog box. 

• In this dialog box: 

~ Accept the default FUNC2 function name. 

~ Click the Add button. 

~ Type .125 in the Time edit box, type 10 in the Value edit box, and click the Add 
button. 
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Type .25 in the Time edit box, type O in the Value edit box, and click the Add 
button. 

Type .375 in the Time edit box, type -lO in the Value edit box, and click the Add 
button. 

Type .5 in the Time edil box, type O in the Value edit box, and click the Add 
button. 

Click the OK button to return to the Defme Time History Functions dialog box. 

• Click the Add New Function button to display the Function Definition dialog box. 

• In this dialog box: 

~ Accept the default FUNC3 function name. 

~ Click the Add button. 

~ Type .25 in the Time edil box, type lO in the Value edit box, and click the Add 
button. 

~ Type .5 in the Time edit box, type O in the Value edit box, and click the Add 
button. 

~ Type .75 in the Time edit box, type -lO in the Value edit box, and click the Add 
button. 

~ Type l in the Time edit box, type O in the Value edit box, and click the Add button. 

~ Click the OK button twice to exit all ofthe dialog boxes. 

30. From the Define menu select Time History Cases ... to display the Define Time History 
Cases dialog box. 

31. In this dialog box: 

• Click the Add New HistOI')' button to display the Time History Case Data dialog box. 

• In this dialog box: 

~ Accept the default History Case N ame, HISTI. 

~ Select Periodic from the Analysis Type drop-down box. 

~ Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

~ In this dialog box: 
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./ Type .05 in the Damping For All Modes edit box . 

./ Click the OK bunon. 

>- Type 25 in the Number ofOutpUt Time Steps edit box. 

>- Type .01 in the Output Time Step Size edit box. 

>- Check the Envelopes check box. 

> In the Load drop-down box, select LOAD!. 

> In the Function drop-down box, select FUNC!. 

> Click the Add button. 

> Click the OK button to retum to the Define Time History Cases dialog box. 

• Click the Add New History button to display the Time History Case Data dialog box. 

• In this dialog box: 

> Accept the default History Case N ame, HIST2. 

);> Select Periodic ·from the Analysis Type drop-down box. 

> Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

> In this dialog box: 

./ Type .05 in the Damping For All Modes edit box . 

./ Click the OK button. 

> Type 50 in the Number of Output Time Steps edit box. 

> Type .01 in the Output Time Step Size edit box. 

> Check the Envelopes check box. 

> In the Load drop-down box, select LOAD l. 

> In the Function drop-down box, select FUNC2. 

> Click the Add button. 

> Click the OK button to retum to the Define Time History Cases dialog box. 

• 
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• • Click the Add New History button to display the Time History Case Data dialog box . 

• In this dialog box: 

:;;. Accept the default History Case N ame, HIST3. 

:;;. Select Periodic from the Analysis Type drop-down box. 

:;;. Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

:;;. In this dialog box: 

.,¡' Type .05 in the Damping For All Modes edit box . 

.,/ Click the OK button. 

);;- Type 100 in the Number ofOutput Time Steps edit box. 

);;- Type .01 in the Output Time Step Size edit box. 

);;- Check the Envelopes check box. 

;¡;. In the Load drop-down box, select LOAD l. 

);;- In the Function drop-down box, select FUNC3. 

> Click the Add button. 

);;- Click the OK button twice to exit all dialog boxes. 

32. From the Anaiyze menu select Set Options ... to display the Analysis O tions dialog box. 

• In this dialog box click the Plane Frame XZ Plane button FR 
available degrees of freedom. 

• Check the Dynamic Analysis check box, if it is not airead y checked. 

to set the 

• Click the Set Dynamic Parameters button to display the Dynamic Analysis 
Parameters dialog box. 

• In this dialog box: 

:;;. Type 4 in the Number ofModes edit box. 

;¡;. Click the OK button twice to exit all dialog boxes. 

33. Click the Run Analysis button _.tJ to run the arialysis. 

¡, 
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34. When the analysis is complete check the messages in the Analysis window (there should be • 
no warnings or errors). Note in the messages that the frrst mode period is about 0.5 
seconds. Click the OK button to clase the Analysis window. 

35. Note again in the window tille on the screen that the first mode period is about .5 seconds. 

36. From the Display menu select Set Output Table Mode ... to display the Select Output 
dialog box. 

37. In this dialog box: 

• Click on the HISTl history to highlight it. 

• Hold down the shift key on the keyboard and click on the HIST3 history. The HIST l, 
HIST2, and HIST3 histories should all be highlighted (selected) now. 

o Click the OK button. 

38. Right click on the joint labeled D in the problem statement to display atable of envelope 
values for the displacement at joint D. Note that the maximum displacement occurs for 
HIST2, as would be expected since the period ofFunction 2 is clase to the first mode 
period ofthe structure. 

39. Click the "X" in the upper right-hand comer ofthe table to clase it. 

40. We ha ve viewed the envelopes ofthe joint displacement at joint D. Now we will view the 
time histories ofthe displacement. Select the joint labeled D in the problem statement. 

41. From the Display menu select Show Time History Traces ... to display the Time History 
Display Definition dialog box. 

42. In this dialog box: 

• Click the Define Functions button to display the Time History Functions dialog box. 

o In this dialog box: 

~ Highlight Joint 4. 

;¡... Click the Modify/Show TH Function button to display the Time History Joint 
Function dialog box. 

~ In this dialog box: 

V' VerifY that the Displ option is selected in the Vector Type area. 

V' VerifY that the UX option is selected in the.Component area. 
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• Problem M 
Flat PI ate In The X· Y Plane With A Twist 

Concrete 
E =3600 ksi, Poissons Ratio = 0.2 

Available Degrees of Freedom 
UZ,RX,RY 

Supports 
Joints A, B and C have Z-direction supports, as shown. 

ToDo 
Determine support reactions at joints A, B and C. Explain the apparently 
odd results for the reaction at joint C. 

8' 

Note: Our intent is that you try this problem on your own flrst. After you have solved it on your 
own, you can step through our solution ifdesired. lfyou have problems trying to create the 
model, then follow the steps in our solution. 
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Problem M Solution 

l. C!ick the drop down box in the status bar to change the units to kip-ft. ·¡Klp-ft ::J 
2. From the File menu selecl New M o del. ... This displays lhe Coordinale System Definition 

dialog box. 

3. In lhis dial o g box 

• Se!ecl lhe Cartesian Tab. 

• In lhe Number ofGrid S paces area type 2 in lhe X direclion edil box. 

• In lhe Number of Grid S paces area type 2 in the Y direction edit box. 

• In lhe Number of Grid S paces area type O in lhe Z direclion edil box. 

• In lhe Grid Spacing area verify lhe X direclion spacing is 4. 

• In the Grid Spacing area lype 6 lhe Y direclion edil box. 

• Click lhe OK button. 

4. Click lhe "X" in lhe lop righl-hand comer oflhe 3-D View window lo close it. 

5. VerifY lhal lhe Snap lo Joinls and Grid Poinls buttonf-:;.lon lhe side 1oo!bar is depressed. 

6. Click lhe Draw Rectangular Shell Element button:gj on lhe side toolbar or sele~t Draw 
Rectangular Shell Element from lhe Draw menu. 

7. Click on upper left-hand comer grid inlerseclion (coordinales are (-4, 6, O)) and lhen click 
on lhe lower righl-hand grid inlersection ( coordinales are ( 4, -6, O)) to draw a shell elemenl 
over lhe enlire slructure. 

8. Click lhe Pointer bulton .. 1:$ 1 lo exil Draw Mode and 
enter Selecl Mode. 

9. Click on lhe shell elemenl to selecl it. 

1 O. From the Edit menu selecl Mesh Shells ••. lo display 
the Mesh Selecled Shells dialog box. 

JI. Fill in lhis dialog box as shown in lhe adjacenl figure 
and click the OK button. 

Mesh S elected Shells 

1 .. ,.--,-------.:..__-___ ._'".'---;-

¡'. ·. r.· Mesh~·,. re-• 
by r Srd~ 

¡. r .. Momusil¡¡oeioctodJoinlr en odgor • 
., - { '. '. • ; - ~~ •. ' • . .l-

1· : .. t;, M';'!'~~~-~!1ido,; ,Í' ; 

12. Selecl lhe joinls thal are labeled "A", "B" and "C" in the problem stalement. 
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• 13. From the Assign menu select Joints and then Restraints ... from the submenu to display 
the Joint Restraints dialog box. 

14. In this dialog box: 

• Uncheck the Translation 1 and Translation 2 check boxes. 

• Verify that the Translation 3 check box is checked. 

• Verify that the Rotation about 1, 2 and 3 check boxes are not checked. 

• Click the OK button. 

15. Click the Show Undeformed S ha pe button O i to remo ve the display of joint restraints 
and reset the window display (and title). 

16. Click the drop down box 'in the status bar to change the units to kip-in. IK1p-m ::J 1 

17. From the Define menu select Materials ... to display the Define Materia1s dialog box. 

18. Highlight the CONC material and click the Modify/Show Material button to display ihe 
Material Property Data dialog box. 

19. In this dialog box: 

• Verify that the Modulus of Elasticity is 3600. 

• Verify that the Poisson's Ratio is 0.2. 

• Click the OK button twice to exit the dialog boxes. 

20. From the Define menu select Shell Sections ... to display the Define Shell Sections dialog 
box. 

21. In this dialog box: 

• Click the Modify/Show Section button to display the Shell Sections dialog box. 

• In this dialog box: 

;,. Verify that the selected material is CON C. 

;,. Verify that both the Membrane and the Bending thicknesses are 12. 

;,. Verify that the Shell option is selected in the Type area. 

;,. Click the OK button twice to exit all dialog boxes. 

22. Click the drop down box in the status bar to change the units to kip-ft. l~p-h ::l 
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23. Click rhe Set Elements burronl~ on rhe main roolbar (or selecr Set Elements ... from rhe • 
View menu) ro display rhe Ser Elemenrs Dialog box. 

24. In rhis dialog box: 

o Check rhe Labels box in rhe Joinrs area. 

o Click rhe OK bu(ton. 

Note: Ifthefont size is too smal/foryou toread thejoínt labels use thefollowing 
procedure to increase thefont size. From the Options menu select Preferences, click 
on the Dimensions Tab ifit is not already visible, type in a new (/arger)font size in the 
Mínimum Graphic Font Síze edil box (usual/y about 6 poínts is sufficient);clíck the OK 
button and then click the Refresh Wíndow button 'jJon the maín too/bar. 

25. Selecr joinr 106 (coordinares (3, 6, O)) by clicking on it. 

26. From rhe Assign menu selecr Joint Static Loads ... and rhen Forces ... from rhe submenu ro 
display rhe Joinr Forces dialog box. 

27. In rhis dialog box: 

o Type -814 in rhe Force Global Z edir box in rhe Loads area. 

o Click rhe OK button. 

28. Selecr joinr 16 (coordinares (-3, O, O)) by clicking on it. 

29. From rhe Assign menu selecr Joint Static Loads ... and rhen Forces ... from rhe submenu ro 
display rhe Joinr Forces dialog box. 

30. In rhis dialog box: 

o Type -698 in rhe Force Global Z edir box in rhe Loads area. 

o Click rhe OK button. 

· 31. Selecr joinr 32 (coordinares ( -2, -3, O)) by clicking on it. 

32. From rhe Assign menu selecr Joint Static Loads ... and rhen Forces ... from rhe submenu ro 
display rhe Joinr Forces dialog box. 

33. In rhis dialog box: 

o Type -901 in rhe Force Global Z edir box in the Loads area. 

o Click rhe OK button. 

34. Click the Show Undeformed Shape button o·J to reser the window display. 
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• 35. Click the Set Elements buttonl_~_l on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

36. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Click the OK button. 

37. From the Anaiyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo '"" dill log !m d i<k <h< PW"' G rid XY p¡,,, mm o o 111111111111 >o "" <h< 'wil obi< 
degrees of freedom. 

• Click the OK button. 

38. Click the 3D View button 3-d J on the main toolbar to switch toa 3-D View. 

39. Click the Run Analysis button _..J to run the analysis. 

40. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to clase the Analysis window. 

41. Click the Joint Reaction Forces button ll:J on the main toolbar to display the Joint 
Reaction Forces dialog box. 

42. In this dialog box: 

• VerifY that the Reactions option is selected in the Type area. 

• Click the OK button and view the support reactions. 

Note: The reaction at the joint labeled "C" in the problem statement is zero (0). The 
reason for this apparently odd result is that the resultan/ of al/ the applied loads lies on 
a fine connecting the support points labeled "A" and "B ". and thus by simple statics 
the reaction at support point "C" must be zero. Note that yo u could m ove the support 
point labe/ed "C" anywhere on the stmcture (except on the fine connecting supporl 
points "A "and "B ", since this would resu/t in an unstable stntcture) and the resulting 
reactions wou/d not change. 
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• Problem N 
Frame-Shear Walllnteraction 

Concrete Material Properties 
E =3600 ksi, Poissons Ratio= 0.2 

Frame 
Beams: 12" wide by 24" deep 
Columns: 24" by 24", pinned base 

Diaphragm 
Provide rigid diaphragm constraint at each level. 

ToDo 
Determine shear carried by wall and by trame at 2nd level and at 6th level. 

1 12' ¡s· ¡ 

6" thick concrete shear wall. 
There are no beams or columns 
embedded in the shear wall. 

20' 20' 20' 

Roof 

N 
~ 

6th 

N 
~ 

5th 

N 
~ 

4th 

N 
~ 

3rd 

N 

2nd 

N 

Base 

Note: Our intent is that you try this problem on your own frrst. After you ha ve solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem N Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. jKJp-tt ::J 
2. From the File menu select New Model From Template .... This displays the Model 

Templates dialog box. 

3. 1" ili" dio lo g b"' d ;,k "" '"' Po mi F~ me<onp ¡,, 1 j ¡ ll bottoo <o '"'Jo Y<h• 
Portal Frame dialog box. 

4. In this dialog box 

• Type 6 in the N umber of Stories edit box. 

• Type 3 in the Number ofBays edit box. 

• Accept the default Story Height of 12. 

• Type 20 in the Bay Width edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to clase it. 

6. From the Draw menu select Edil Grid ••• to display the Modity Grid Lines dialog box. 

7. . In this dialog box: 

• Verity that the X option is selected in the Direction area. 

• Type -35 in the X Location edit box and click the Add Grid Line button. 

• Type -47 in the X Location edit box and click the Add Grid Line button. 

• Click the OK button. The screen appears as shown in Figure N-1. 

8. Click the Quick Draw Rectangular Shell Element button 01 on the si de toolbar ( or 
select Quick Draw Rectangular Shell Element from the Draw menu). 

9. Click in the area labeled "A" in Figure N-1 to input the frrst shell element. Note that a 
quick Shell element is drawn by clicking in a grid space, bounded by four grid lines. 

1 O. Click in. the areas labeled "B", "C", "D", "E" and "F", in that arder, in Figure N-1 to input 
the other shell elements. 

11. Click the Pointer button ~ on the side too! bar to exit draw mode and enter select mode. 

• 
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Figure N-1: Screen As lt Appears After Step 7 

12. Click the Set Elements buttoni-ª.J on the main toolbar ( or select Set Elements .•. from the 
View menu) to display the Set Elements Dialog box. 

13. In this dialog box: 

• Check the Labels box in the Joints area. 

• Check the Fill Elements check box. 

• Click the OK button. 

Note: If the font size is too small for yo u to read the joint labels use the fol/owing 
procedure to increase the Jont size. From the Options menu select Preferences, click 
on the Dimensions Tab if it is not already visible, type in a new (larger) Jont size in the 
Minimum Graphic Font Size edit box (usual/y about 6 points is sufficient). click the OK 
button and then c/ick the Refresh · Window button _tJ on the m a in too/bar. 

14. Select the joints 41 and 42 at the base ofthe shear wall. 
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15. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

16. In this dialog box: 

• Click the pinned base fast restraint buttonl 4l to set all translational degrees of 
freedom (U!, U2 and U3) as restrained. · 

• Click the OK button 

17. Click the Show Undeformed Shape button O\ to remo ve the display of joint restraints 
and reset the window display (title) .. 

18. Click the drop down box in the status harto change the.units to kip-in. IKip-in ::JI 
19. From the Define menu select Materials ... to display the Define Materials dialog box. 

20. Click on CONC in the Materials area to highlight (select) it, and then click the 
1\1 odify/Show Material button. The Material Property Data dialog box is displayed. 

21. In this dialog box: 

• Verity that the Modulus ofElasticity is set to 3600. 

• Verity that Poisson's Ratio is set to 0.2. 

• Click the OK button twice to exit all dialog boxes. 

22. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

23. In this dialog box: 

• In the Click To area, click the drop-down box that says Add I/Wide Flange and then 
click on the Add Rectangular item to display the Rectangular Section dialog box. 

• In this dialog box: 

)> Type BEAM in the Section name edit box. 

)> Select CONC from the Material drop-down box. 

)> Type 24 in the Depth (t3) edit box. 

)> Type 12 in the Width (t2) edit box. 

)' Click the OK button to retum to the Defme Frame Sections dialog box. 
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• • In the Click To area, click the drop-down box that says Add Rectangular and then click 
on the Add Rectangular item to display the Rectangular Section dialog box. 

• In this dialog box: 

>- Type COL in the Section name edit box. 

>- Select CONC from the Material drop-down box. 

>- Type 24 in the Depth (t3) edit box. 

>- Type 24 in the Width (t2) edit box. 

>- Click the OK button twice to exit all dialog boxes. 

24. From the Define menu select Shell Sections ... to display the Define Shell Sections dialog 
box. 

25. In this dialog box: 

• In the Click To area, click the Add New Section button to display the Shell Sections 
dialog box. 

• In this dialog box: 

>- Verify that the selected material is CON C. 

>- In the Thickness area type 6 in both the Membrane and the Bending edit boxes .. 

>- Verify that the Shell option is selected in the Type area. 

>- Click the OK button twice to close all dialog boxes. 

26. Select all ofthe column elements by "windowing" each ofthe four column lines separately. 

27. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

28. In this dialog box: 

• Click on COL in the Frame Sections area to highlight it. 

• Click the OK button. 

29. Select all ofthe beam elements by using the intersecrting line method on each ofthe three 
beam bays separately. 

30. From the Assign menu select Frame and then Sections ••• from the submenu to display the 
Define Frame Sections dialog box. 

5 



31. In this dialog box: 

• Click on BEAM in the Frarne Sections area to highlight it. 

• Click the OK button. 

32. Select all ofthe joints at the Roof leve! by "windowing". 

33. Frorn the Assign rnenu select Joint and then Constraints ... frorn the subrnenu to display 
the Constraints dialog box. 

34. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragrn to display the 
Diaphragrn Constraint dialog box. 

• In this dialog box: 

;.. Type ROOFDIA in the Constraint N ame edit box. 

:.- Select the Z Axis option in the Constraint Axis area. 

> Click the OK button twice to exit all dialog boxes. 

35. Select all ofthe joints at the 6th leve! by "windowing". 

36. Frorn the Assign rnenu select Joint and then Constraints ... frorn the subrnenu to display 
the Constraints dialog box. 

37. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragrn to display the 
Diaphragrn Constraint dialog box. 

• In this dialog box: 

> Type 6THDIA in the Constraint Narne edit box. 

> Select the Z Axis option in the Constraint Axis area. 

> Click the OK button twice to exit all dialog boxes. 

38. Select all ofthe joints at the 5th leve! by "windowing". 

39. Frorn the Assign rnenu select Joint and then Constraints ... frorn the subrnenu to display 
the Constraints dialog box. 

40. In this dialog box: 

• 
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• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

~ Twe STHDIA in the Constraint N ame edit box. 

;,. Select the Z Axis option in the Constraint Axis area. 

~ Click the OK button twice to exit all dialog boxes. 

41. Select all ofthe joints at the 4th leve] by "windowing". 

42. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

43. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

;,. TJPe 4THDIA in the Constraint N ame edit box. 

~ Select the Z Axis option in the Constraint Axis area. 

~ Click the OK~button twice to exit all dialog boxes. 

44. Select all ofthe joints at the 3rd leve] by "windowing". 

45. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

46. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

~ TJPe 3RDDIA in the Constraint N ame edit box. 

~ Select the Z Axis option in the Constraint Axis area. 

~ Click the OK button twice to exit all dialog boxes. 

47. Select all ofthe joints at the 2nd leve] by "windowing". 

,, 

. ]'¡ 
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48. From the Assign menu select Joint and then Constraints ... from the submenu to display • 
the Constraints dialog box. 

49. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

~ Type 2NDDIA in the Constraint N ame edit box. 

~ Select the Z Axis option in the Constraint Axis area. 

)'> Click the OK button twice to exit all dialog boxes. 

50. Select joints 39, 37, 35, 33, 29, and 32 (left·hand side ofshear wall from 2nd leve! to roof 
leve!) by ''windowing". 

51. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

52. In this dialog box: 

• Type 10 in the Force Global X edit box in the Loads area. 

• Click the OK button. 

53. Select joints 37, 35, 33, 29, and 32 (left-hand side of shear wall from 3rd leve! to roof 
leve!) by ''windowing". 

54. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. · 

55. In this dialog box click the OK button. 

56. Select joints 35, 33, 29, and 32 (left-hand side of shear wall from 4th leve! to rooflevel) by 
Hwindowing''. 

57. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

58. In this dialog box click the OK button. 

59. Se!ect joints 33, 29, and 32 (left-hand side of shear wall from 5th leve! to rooflevel) by 
"windowing". 

60. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 
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• 61. In this dialog box click the OK button . 

62. Select joints29, and 32 (left-hand side of shear wall from 6th leve! to rooflevel) by 
"'windowing". 

63. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

64. In this dialog box click the OK button. 

65. Select joint 32 (left-hand side of shear wall at rooflevel). 

66. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

67. In this dialog box click the OK button. 

68. Click the Show Undeformed Shape button O 1 to remove the display ofjoint forces. 

69. Click the Set Elements buttonl~ on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

70. In this dialog box: 

• Check the La beis box in the Frames area. 

• Check the La beis box in the Shells area. 

• Click the OK button. 

71. Select joints 29 and 30 and select shell element l. 

72. From the Assign menu select Group N ames ... to display the Assign Group dialog box. 

73. In this dialog box: 

• Type 6THW ALL in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

74. Select joints 6, 13, 20 and 27 by clicking on eachjoint individually and select frame 
( colurnn) elements 6, 12, 18 and 24 using the intersecting !in e method. 

75. From the Assign menu select Group N ames ... to display the Assign Group dialog box. 

76. In this dialog box: 
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• Type 6THFRAME in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

77. Select joints 39 and 40 and select shell element 5. 

78. From the Assign menu select Group N ames .•. to display the Assign Group dialog box. 

79. In this dialog box: 

• Type 2NDW ALL in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

80. Selectjoints 2, 9, 16 and 23 by clicking on eachjoint individually and select frame 
( column) elements 2, 8, 14 and 20 using the intersecting line method. 

81. From the Assign menu select Group N ames ... to display the Assign Group dialog box. 

82. In this dialog box: 

• Type 2NDFRAME in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

83. Click the Set Elements buttoniJ!!1Jon the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

84. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck ihe Labels box in the Frames area. 

• Uncheck !he Labels box in the Shells area. 

• Click the OK button. 

85. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo dlli dmlog b<n '¡; '""' Pl•o• F nm• XZ Pl•o• ""'""'e ¡ I I 1 m """' 
available degrees offreedom. 
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• Click the OK button. 

86. Click the Run Analysis button _J to run the analysis. 

87. When the analysis is complete check the messages in the Analysis window (there should be 
no. wamings or errors) and then click the OK button to close the Analysis window. 

88. From the Display menu select Show Group Joint Force Sums ... to display the Select 
Groups dialog box. 

89. In this dialog box: 

• Click on 2NDFRAME to highlight it. 

• Hold down the shift key on the keyboard and click on 6THWALL. All ofthe available 
groups, except the default ALL group should now be highlighted. 

• Click the OK button to display the a window with the Group Joint Force Summations 
tabulated. 

Note: Notice the direction ofthe shear (F-Xforce) in the shear wall at thc 6th leve/. 

• When finished viewing the window click the "X" in its upper right-hand comer to close 
it. 

Note: Ifyou want to print the group jointforce sum tables c/ick onthe File menu in the 
Group Joint Force Summations widow and select either Print Tables or Prillt 
Tables to File .... 
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Problem O 
lsolated Building • Nonlinear Time History Analysis 

S te el 
E =29000 ksi, Poissons Ratio= 0.3 
Beams: W24X55; Columns: W14X90 

Rubber lsolator Prooerties 
Vert1cal (axial) stiffness - 10,000 k/in (linear) 
lnitial shear stiffness in each direclion = 1 O klin 
Shear yield force in each direction = 5 kips 
Ratio of post yield shear stiffness to initial shear stiffness = 0.2 

Vertical Loading and Mass 
Roof: 75 psf DL Floor: 125 psf DL 

20 psf LL 100 psf LL 

Time Historv 
Apply LP-THO in the X-direction and LP-TH90 in the Y-direction simultaneously. 
Each timehistory is given in units of g. There are 2000 timesteps, atan equal 
spacing of 0.02 sec, for a total of 40 sec. There are 5 accelerations pomts per 
line. 

ToDo 
Plot time histories ofY-direction displacement at the 1st level and at the roof 
level. Plot a time history of the 1st level Y-direction displacement versus the 
Y -direction base shear. 

6" thick concrete 
slab at roof 

..---r--,. 1 O" thick concrete 
slab at 1st and 
2nd floors 

Provide diaphragm 
constraint at each level to 
make all diaphragms rigid. 

Note: Our intent is that you try this problern on your own first. After you have solved it on your 
own, you can step through our solution if desired. Ifyou ha ve problems trying to create the 
rnodel, then follow the steps in our solution. 
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Problem O Solution 

l. Click the drop down box in the status bar to change the units to kip-ft.IKJp-tt :::J 

2. From the File menu select New Model From Template .... This displays the Model 

3. In this dialog box click on the S pace Frame template button rmr:J to display the 

Templates dialog box. ~ 

S pace Frame dialog box. tt11l..l. 
4. In this dialog box: 

• Type 2 in the Number ofBays Along X edit box. 

• Type 30 in the Bay Width Along X edit box. 

• Type 30 in the Bay Width Along Y edit box. 

• Uncheck the Restraints check box. 

• Accept the rest ofthe default values. 

• Click the OK button. 

5. Click in the window labeled X-Y Plan e@ Z=24 to rnake sure it is active. The window is 
active when its title is highlighted. 

-. 

6. Click the Quick Draw Rectangular Shell Element button. [!]j on the side toolbar. 

7. Click once in each ofthe four quadrants in the plan view to input four shell elements. 

8. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@Z=l2. 

9. Click once in each ofthe four quadrants in the plan view to input four shell elements. 

10. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@Z=O. 

11. From the Draw menu select Draw NLLink Element. 

12. In the plan view ofthe X-Y Plane@ Z=O double click on each ofthe ninejoints to draw 
nine NLLink elements. 

13. Click the Pointer button Ut 1 to exit draw mode and enter select mode. 

14. Click the drop down box in the status bar to change the units to kip-in. r::¡Ki:--.P":--.n--:::J-¡ 1 
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• 15. From the Define menu select Materials ... to display the Defme Materials dialog box . 
Highlight the STEEL material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

16. In this dialog box: 

o Verif)r that the modulus ofelasticity is 29000 and poisson's ratio is 0.3. 

• . Click the OK button twice to exit the dialog boxes. 

17. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

18. In the Click To area, click the drop-down box that says Impon UWide Flange and then 
click on the Impon I/Wide Flange ítem. 

19. If the Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. 

20. A dialog box appears with a list of all wide flange sections in the database. In this dialog 
box: 

o Scroll down and click on the W24X55 section. 

o Scroll down to the Wl4X90 section, and click on it while holding down the Ctrl key on 
the keyboard. 

o Click the OK butÍon three times to exit all dialog boxes. 

21. From the Define menu select Shell Sections ... to display the Defme Shell Sections dialog 
box. 

22. In this dialog box: 

• Click the Add New Section button to display the Shell Sections dialog box. 

• In this dialog box: 

;¡;. Type ROOF in the Section N ame edit box. 

;¡;. Accept the default CONC material 

;¡;. Type 6 in the Membrane edit box. 

;¡;. Type 6 in the Bending edit box. 

;¡;. In the Type area verif)r that the Shell option is selected. 

;¡;. Click the OK button to retum to the Define Shell Sections dialog box. 

/ 

3 



• Click the Add New Section button to display the Shell Sections dialog box. 

• In this dialog box: 

);. Type FLOOR in the Section N ame edit box. 

);. Accept the default CONC material 

);. Type 1 O in the Membrane edit box. 

);. Type 10 in the Bending edit box. 

);. In the Type area verity that the Shell option is selected. 

);. Click the OK button twice to exit al! dialog boxes. 

23. From the Define menu select NLLink Properties ... to display the Defme NLLink 
Properties dialog box. 

24. In this dialog box: 

• Click the Modify/Show Property button to display the NLLink Property Data dialog 
box. 

• In this dialog box: 

);. Select Isolatorl from the Type drop-down box. 

);. Type .001 in the Mass edit box. 

);. Check the U 1 Direction check box. 

);. Click the Modify/Show For U1 button to display the NLLink Directional 
Properties dialog box. 

);. In this dialog box: 

v" Type 10000 in the Effective Stiffuess edit box. 

v" Click the OK button to retum to the NLLink Property Data dialog box. 

);. Check the U2 Direction check box. 

);. Check the U2 Nonlinear check box. 

);. Click the Modify/Show For U2 button to display the NLLink Directional 
Properties dialog box. 

);. In this dialog box: 

• 
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../ In the Linear Properties area type 1.5 in the Effective Stiffuess edit box . 

../ In the Nonlinear Properties area type 10 in the Stiffness edit box . 

../ Type 5 in the Yield Strength edit box . 

../ Type .2 in the Post Yield Stiffness Ratio edit box . 

../ Accept the rest of the default val u es . 

../ Click the OK button to return to the NLLink Property Data dialog box. 

;;.. Check the U3 Direction check box. 

;¡.. Check the U3 Nonlinear check box. 

;;.. Click the Modify/Show For U3 button to display the NLLink Directional 
Properties dialog box. 

;;.. In this dialog box: 

../ In the Linear Properties area type 1.5 in the Effective Stiffuess edit box . 

../ In the Nonlinear Properties area type 1 O in the Stiffness edit box . 

../ Type 5 in the Yield Strength edit box . 

../ Type .2 in the Post Yield Stiffness Ratio edit box . 

../ Accept the rest ofthe default values . 

../ Click the OK button three times to exit all dialog boxes. 

25. Click the drop down box in the status bar to change the units to kip-ft. jKJp-Jt 3 
26. From the Define menu select Materials ... to display the Define Materials dialog box. 

Highlight the CONC material and click the Modify/Show Section button to display the 
Material Property Data dialog box. 

27. In this dialog box: 

• Verif'y that the mass per unit volume is 4.657E-03 and that the weight per unit volume 
is 0.15. 

• Click the OK button twice to exit the dialog boxes. 

28. Click in the window labeled X-Y Plane@ Z=O to make sure it is active. 

29. Click the xz 2D View button."' /on the main toolbar. 
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30. Click the Perspective Toggle button 6'ú'jon the main toolbar. 

31. Click the Set Intersecting Line select Mode button ]!\¡¡ on the side toolbar and select al! of 
the bottom leve! columns. -

Note: To use the lntersecting Line Se/ection option, click the Set lntersecting Line Se/ect 
Mode button j[] on the side too/ bar. Then click the leji mouse button to the /eji of the 
first leve/ columns, and while holding down the left mouse bullan drag the mouse to the 
right of the first leve/ columns. A "rubberband /in e" wi/1 appear and al/ elemems that 
this "rubberband fine" passes through wi/1 be selected. Re/ease the leji mouse button 
to make the selection. 

32. Click the Set lntersecting Line select Mode button ]!\¡¡ on the side toolbar and select al! of 
the top leve! columns. -

33. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

34. In this dialog box: 

o Click on WI4X90 in the Frame Sections area to highlight it. 

o Click the OK button. 

35. Click the Show Undeformed Shape button O 1 to remove the displayed frame element 
assignments. 

36. Click the xy 2D View button ~on the main toolbar. The plan view ofthe X-Y Plane@ 
Z=O appears. 

37. Click the Up One Gridline button ..2J to move the plan display up to the X-Y Plane@ 
Z=l2. 

38. Select al! ofthe elements at this leve! by "windowing". 

39. Click the Up One Gridline button ·;o: 1 to move the plan display up to the X-Y Plane@ 
Z=24. 

40. Select al! ofthe elements at this leve! by "windowing". 

41. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

42. In this dialog box: 

o Click on W24X55 in the Frame Sections area to highlight it. 

o Click the OK button. 
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43. Click the Show Undeformed Shape button O 1 to remove the displayed frame element 
assignments. 

44. Select all ofthe elements at the Z=24level by "windowing". 

45. From the Assign menu select Shell and then Sections ... from the submenu to display the 
Define Shell Sections dialog box. 

46. In this dialog box: 

• Click on ROOF in the Shell Sections area to highlight it. 

• Click the OK button. 

47. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@Z=l2. 

48. Select all ofthe elements at this leve! by "windowing". 

49. From the Assign menu select Shell and then Sections ... from the submenu to display the 
Define Shell Sections dialog box .. 

50. In this dialog box: 

• C!ick on FLOOR in the Shell Sections area to highlight it. 

• Click the OK button. 

51. From the Define menu select Sta tic Load Cases ... to display the Define Static Load Case 
Names dialog box. 

52. In this dialog box: 

• Type DL in the Load edit box. 

• Click the Change Load button. 

• Type LL in the Load edit box. 

• Select UVE from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Add New Load button. 

• Click the OK button. 

53. Click the drop down box in the status bar to change the units to lb-ft.llb·ft ::J 

7 

l, 



54. Select all ofthe elements at the Z=l2 leve! by "windowing". 

55. From the Assign menu select Shell Static Loads ... and then Uniform ... from the submenu 
to display the Shell Uniform Loads dialog box. 

56. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• Type -100 in the Load edit box. 

• Click the OK button. 

57. Click the Up One Gridline button <l-ito move the plan display up to the X-Y Plane@ 
Z=24. 

58. Select all ofthe elements at the Z=24level by "windowing". 

59. From the Assign menu select Shell Static Loads ..• and then Uniform •.. from the submenu 
to display the Shell Uniform Loads dialog box. 

60. In this dialog box: 

• Type -20 in the Load edit box. 

• Click the OK button. 

61. Click the drop down box in the status barto change the units to kip-ft.l~p-ft ::J 
62. Click the Show Undeformed Shape button O 1 to remove the displayed shellload 

assignments. 

63. Click the Down One Gridline button ~to move the plan display down to the X-Y Plane 
@ Z=l2. 

64. Select all ofthe elements at the Z=l2 leve] by "windowing". 

65. From the Edit menu select Replicate ..• to display the Replicate dialog box. 

66. In this dialog box: 

• Select the Linear Tab. 

• Type -12 in the Z Distance edil box. 

• Type 1 in the Number edit box. 

• Click the OK button. 
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Note: Prior to defining time historyfunctions, you should /acate the time historyfiles 
named Lp-thO and Lp-th90 that are in the subdirector;• named Examples beneath the 
directory where you instal/ed SAP2000. Copy these files into the same direcior;· as 
your SAP2000 input file. 

Ifthe Examples subdirectory does not exist you may need to reinstall SAP2000, and 
select to install the examples. 

67. From the Define menu select Time History Functions ... to display the Define Time 
History Functions dialog box. 

68. In this dialog box: 

• Click the Add Function From File button to display the Time History Function 
Defmition dialog box. 

• In this dialog box: 

;.. Type LPTHO in the Function N ame edit box. 

:.. Click the Open File button to display the Pick Function Data File dialog box. 

:.. In this dialog box: 

v' Locate and highlight the file named LP-THO 

v' Click the Open button to retum to the Time History Function Definition dialog 
box. --· 

v' Type 5 in the Number Of Points Per Line edit box. 

v' Select the Function At Equal Time Step option. 

v' Type .02 in the Function At Equal Time Step edit box. 

v' Click the OK button to retum to the Define Time History Functions dialog box. 

• Click the Add Function From File button to display the Time History Function 
Definition dialog box. 

• In this dialog box: 

:.. Type LPTH90 in the Function N ame edit box. 

:.. Click the Open File button to display the Pick Function Data File dialog box. 

:.. In this dialog box: 

v' Locate and highlight the file named LP-TH90. 
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v' Click the Open button to retum to the Time History Function Definition dialog 
box. 

v' Type 5 in the Number Of Points Per Line edit box. 

v' Select the Function At Equal Time Step option. 

v' Type .02 in the Function At Equal Time Step edit box. 

v' Click the OK button twice to exit all dialog boxes. 

69. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Check the Dynamic Analysis check box, if it is not airead y checked. 

• Click the Set Dynamic Parameters button to display the Dynamic Analysis · 
Parameters dialog box. 

• In this dialog box: 

);> Type 30 in the Number ofModes edit box. 

J> In the Type Of Analysis area select the Ritz Vectors option. 

J> Verity that ACCEL X, ACCEL Y and ACCEL Z are in the Ritz Load Vectors box 
in the Starting Ritz Vectors area. 

J> Conftrm that the Include NLLink Vectors box is checked. 

;;.. Click the OK button twice to exit all dialog boxes. 

70. From the Define menu select Time History Cases ... to display the Define Time History 
Cases dialog box. 

71. In this dialog box: 

• Click the Add New History button to display the Time History Case Data dialog box. 

• In this dialog box: 

J> Type GRA V in the History Case N ame edit box. 

J> Select Nonlinear from the Analysis Type drop-down box. 

J> Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

J> In this dialog box: 
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• ./ Type .05 in lhe Damping For All Modes edil box . 

./ Click lhe O K button. 

;... Type 100 in lhe Number ofüulput Time Steps edit box. 

» Type .1 in the Output Time Step Size edit box. 

» Check the Envelopes check box. 

» In the Load drop-down box, select DL. 

» In lhe Funclion drop-down box, select RAMP. 

» Type 1 in the Scale Factor edit box. 

» Click the Add button. 

» Click the OK button to return to the Define Time History Cases dialog box. 

• Click the Add New History button to display the Time History Case Data dialog box. 

• In this dialog box: 

;... Type LP in the History Case Name edil box. 

;... Select Nonlinear from the Analysis Type drop-down box. 

;... Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

;... In this dialog box: 

./ Type .05 in lhe Damping For All Modes edit box . 

./ In the Modal Damping Overrides area type Type 1 in the Mode box, lype 0.02 
in the Damping box and click the Add button . 

./ In the Modal Damping Overrides area type Type 2 in the Mode box and click 
the Add button . 

./ In the Modal Damping Overrides area lype Type 3 in the Mode box and click 
the Add button . 

./ Click the OK button. 

;... Type 2000 in the Number ofOutput Time Sleps edil box. 

;... Type .02 in the Output Time Step Size edil box. 
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¡;. In the Start From Previous History drop-down box select GRA V. 

);- Check the Envelopes check box. 

¡;. In the Load drop-down box, select acc dir l. 

¡;. In the Function drop-down box, select LPTHO. 

);- Type 32.2 in the Scale Factor edit box. 

¡;. Click the Add button. 

¡;. In the Load drop-down box, select acc dir 2. 

¡;. In the Function drop-down box, select LPTH90. 

:;.. Click the Add button. 

);- Click the OK button twice to exit all dialog boxes. 

72. Click in the window labeled X-Y Plane @Z;l2 to make sure it is active. 

73. Click the Up One Gridline button 'Ú' : to move the plan display up to the X-Y Plane@ 
Z;24. 

74. Select all elements at the Z;24 leve! by "windowing". 

75. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

76. In this dialog box: 

• Click the drop-down box in the Click To area, and click Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

¡;. Type ROOF in the Constraint N ame edit box. 

¡;. Select the Z axis option in the Constraint Axis area if it is not airead y selected. 

);- Click the OK button twice to assign the diaphragm constraint. 

77. Click the Down One Gridline button ~to move the plan display down to the X-Y Plane 
@Z;l2. 

78. Select all elements at the Z=l2 leve! by ''windowing". 
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79. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

80. In this dialog box: 

o Click the drop-down box in the Click To area, and click Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

;.;.. Type 2ND in the Constraint N ame edit box. 

;.;.. Select the Z axis option in the Constraint Axis area if it is not airead y selected. 

;.;.. Click the OK button twice to assign the diaphragm constraint. 

81. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@Z=O. 

82. Select all elements at the Z=O leve] by "windowing". 

83. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

84. In this dialog box: 

• Click the drop-down box in the Click To are a, and click Add D iaphragm to display the 
Diaphragm Constraint dialog box. 

o In this dialog box: 

;.;.. Type 1ST in the Constraint Name edit box. 

:r- Select the Z axis option in the Constraint Axis area if it is not already selected. 

;.;.. Click the OK button twice to assign the diaphragm constraint. 

85. Click the Show Undeformed S ha pe button O [ to remove the displayed diaphragm 
constraint assignments. 

86. Click the Run Analysis button .2.J to run the analysis. 

Note: The analysis would run even quicker if we had not requested envelopes in the time 
history case data. 

87. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors). Click the OK button to close the Analysis window. 

88. Click in the window labeled X-Y Plane@ Z=O to make sure it is active. 
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89. Click the Set Elements buttoni!!J on the main toolbar (or select Set Elements ... from the • 
View menu) to display the Set Elements Dialog box. 

90. In this dialog box: 

• Check the La beis box in the Joints area. 

• Click the OK button. 

91. Click on the center joint, joint 13, in the plan at Z=O to select it. 

92. Click the Up One Gridline button ~ twice to move the plan display up to the X· Y Plane 
@Z=24. 

93. Click on the center joint,joint 15, in the plan at Z=24 to select it. 

94. Click the Set Elements buttoni!!J on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

95. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• C!ick the OK button. 

96. From the Display menu select Show Time History Traces ... to display the Time History 
Display Definition dialog box. 

97. In this dialog box: 

• Click the Define Functions button to display the Time History Functions dialog box. 

• In this dialog box: 

» Highlight Joint 13. 

» Click the Modify/Show TH Function button to display the Time History Joint 
Function dialog box. 

» In this dialog box: 

<1' Verif)r that the Displ option is selected in the Vector Type area. 

<1' Select the UY option is selected in the Componen! area. 

<1' Click the OK button to retum to the Time History Functions dialog box. 

:>- Highlight Joint 15. 
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• );> Click the Modify/Show TH Function button to display the Time History Joint 
Function dialog box. 

);> In this dialog box: 

v'" VerifY that the Displ option is selected in the Vector Type area. 

v'" Select the UY option is selected in the Componen! area. 

v'" Click the OK button to return to the Time History Functions dialog box. 

);> In the Click To area select Add Base Functions from the drop-down box to display 
the Base Functions dialog box. 

:r In this dialog box: 

v'" Check the Base Shear Y check box. 

v'" Click the OK button twice to return to the Time History Display Definition 
dialog box. 

• Select LP from The Time History Case drop-down box. 

• Click on Joint 13 in the List ofFunctions to highlight (select) it. 

• Hold down the Ctrl key on the keyboard and click on Joint 15 to add it to the selection. 

• Click the Add button to move Joints 13 and 15 into the Plot Functions list. 

• Click the Display button to display the displacement time histories. Note that there is 
very little difference between the 1st and rooflevel displacements. The structure is 
essentially moving as a rigid body on top ofthe isolators. 

• Click the OK button to close the time history display and return to the Time History 
Display Definition dialog box. 

• Click the F(t) vs F(t) tab. 

• Select Joint 13 from the Horizontal drop-down box. 

• Select Base Shear Y from the Vertical drop-down box. 

• Click the Display button to display the force-displacement plot. 

• Click the OK button to close the Time History Functions display and return to the Time 
History Display Definition dialog box. 

• Click the Done button to close the Time History Display Definition dialog box. 
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Problem P 
Critica! Buckling Load 

S te el 
E =29000 ksi, Poissons Ratio= 0.3 

ToDo 
Use P-Delta oplion and iteration to determine the criticar buckling load for this 
built-up column. Hint: PcRrTrCAL is between 15,480 and 15,490 kips. 
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Note: Our intent is that you try this problem on your own first. After you have solved it on your · 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem P Solution 

l. Click the drop down box in the status bar to change the units to kip-ft.IKip.Jt ::J 
2. From the File menu select New Model. ... This displays the Coordinate System Definition 

dialog box. 

3. In this dialog box: 

• Select the Cartesian Tab. 

• Type O in the X Direction Number of Grid S paces edit box. 

• Type O in the Y Direction Number ofGrid Spaces edit box. 

• Type 1 in the Z Direction Number of Grid S paces edit box. 

• Type 12 in the Z Direction Grid Spacing edit box. 

• Click the OK button. 

4. Click the Quick Draw Frame Element button ..._Jon the side toolbar. 

5. Click once on the grid line in the 3-D View window to draw the frame element. 

6. Click the Pointer button jJ on the side too! bar to exit draw mode and enter select mode. 

7. Click on the bottom joint in the 3-D View window to select it. 

8. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

9. In this dialog box: 

• Click the fixed base fast restraint button 1 J,l to set all degrees offreedom (U!, U2, 
U3, RI, R2 and R3) as restrained. 

• Click the OK button. 

1 O. Click the drop down box in the status bar to change the units to kip-in. jt<Jp-m ::J 1 

11. From the Define menu select Materials ... to display the Define Materials dialog box. 
Highlight the STEEL material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

12. In this dialog box: 
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• • VerifY that the modulus ofelasticity is 29000 and poisson's ratio is 0.3 . 

• Click the OK button twice to exit the dialog boxes. 

13. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dia1og box. 

14. In the Click To area, click the drop-down box that saysAdd I/Wide Flange and then click 
on the Add Box/Tube item to display the Box!Tube Section dialog box. 

15. In this dialog box: 

• Type BOX in the Section N ame edit box . 

• Type 20 in the Outside Depth ( !3) edit box . 

• Type 20 in the Outside Width (t2) edit box . 

• Type 1 in the Flange Thickness (tf) edit box . 

• Type 1 in the Web Thickness (tw) edit box . 

• Click the OK button twice to exit all dialog boxes . 

16. Click the drop down box in the status bar to change the units to kip-ft. IKJfHI .:J 

17. Click on the frame element to select it. 

18. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

19. In this dialog box: 

• Click on BOX in the Frame Sections area to highlight it. 

• Click the OK button. 

20. Click the Show Undeformed Shape button O J to remove the displayed frame element 
assignments. 

21. From the Define menu select Static Load Cases ... to display the Define Static Load Case 
N ames dialog box. 

22. In this dialog box: 

• Type LA T in the Load edit box. 

• Select OTHER from the Type drop-down box. 
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• Type O in lhe SelfWeighl Multiplier edil box. 

• Click lhe Change Load button. 

• Type AXIAL in lhe Load edil box. 

• Click lhe Add New Load button. 

• Click lhe OK button. 

23. Click on lhe frame elemenl lo selecl it. 

24. From the Assign menu select Frame Static Loads •.. and then Point and Uniform ... from 
1he submenu lo display the Poinl and Uniform Span Loads dialog box. 

25. In lhis dialog box: 

• Selecl LAT from the Load Case N ame drop-down box. 

• Selecl Global X from lhe Direclion drop-down box in lhe Load Type and Direclion 
area. 

• Type .3333 in the frrsl Dislance edil box and lype 25 in lhe frrst Load edil box. 

• Type .6667 in the second Distance edil box and lype 50 in the second Load edil box. 

• Click lhe OK button. 

26. Selecl lhe lop joint. 

27. From lhe Assign menu selecl Joint Static Loads .•. and lhen Forces •.. from the submenu lo 
display lhe Joinl Forces dialog box. 

28. In this dialog box: 

• Selecl AXIAL from lhe Load Case N ame drop-down box. 

• Type -1 in the Force Global Z edil box in the Loads area. 

• Click lhe OK button. 

29. Click lhe Show Undeformed Shape button O 1 lo remove the displayed joinl forc~ 
assignmenls. 

30. From the Analyze menu selecl Set Options .•• lo display lhe Analysis Oplions dialog box. 

• Check lhe lnclude P-Delta check box, if it is nol airead y checked. 

4 

• 



• • Click the Set P-Delta Parameters bunon to display the P-Delta Parameters dialog box . 

• In this dialog box: 

;;. Type 5 in the Maximum Iterations edit box. 

;;. Select AXIAL from the Load Case drop-down box. 

;;. Type 15485 in the Scale Factor area. 

Note: Since the hint says PcRITICAL is between 15,480 and 15,490 kips, we will start 
midway between these two va/ues at 15485 kips. 

>- Click the Add button. 

;;. Click the OK button twice to exit all dialog boxes. 

31. Click the Run Analysis bunon ___!] to run the analysis. 

32. When the analysis is complete check the messages in the Analysis window. There should 
be an error message similar to that shown below indicating the structure is unstable. This 
indicates that 15,485 kips is !arger than the critica! buckling load. Click the OK bunon to 
close the Analysis window. 

Analpis lncomplete Due to Eums 

1 o~ 

33. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Click the Set P-Delta Parameters button to display the P-Delta Parameters dialog box. 

• In this dialog box: 

;¡;. Highlight the AXIAL/15485 Load Case/Scale Factor .. 

;;. Type 15484 in the S cale Factor area. 

;;. Click the Modify button. 
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;.. Click the OK button twice to exit al! dialog boxes. 

34. Click the Run Analysis button _¿J to run the analysis. 

35. When the analysis is complete check the messages in the Analysis window. Again there 
should be an error message indicating the structure is unstable. This indicates that 15.484 
kips is larger than the critcal buckling load. Click the OK button to close the Analysis 
window. 

36. From the Analyze menu select Set Options •.. to display the Analysis Options dialog box. 

• Click the Set P-Delta Parameters button to display the P-Delta Parameters dialog box. 

• In this dialog box: 

;;.. Highlight the AXIAL/15484 Load Case/Scale Factor.. 

;;.. Type 15483 in the S cale Factor area. 

)> Click the Modify button. 

;.. Click the OK button twice to exit al! dialog boxes. 

37. Click the Run Analysis button _¿j to run the analysis. 

38. When the analysis is complete check the rnessages in the Analysis window (there should be 
no warnings or errors). The analysis run successfully. Thus the critica! buckling load.is 
approximately 15484 kips. Click the OK button to close the Analysis window. 
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• Problem Q 
Three Frames 

Concrete 
E =5000 ksi, Poissons Ratio= 0.2 
Beams: 24" wide by 36" deep 
Columns: 24" by 24" 

O amper Properties 
Linear Prooerties 

Effective stiffness = O klin 
Effective damping = O k-sec/in 

lsolator Properties (lsolator1 l 

Nonl1near Properties 
Stiffness = 1000 k/in 
Damping = 30 k-secAn 
Damping exponen!= 0.5 

Vertical (ax1al) stiffness = 10,000 k/in (linear) 
lnillal shear stiffness = 100 k/in 
Shear y'1eld force = 40 kips 
Ratio of post yield shear stiffness to initial shear stiffness = 0.1 

Time Historv 
Apply the ELCENTRO record. Three time and acceleration values are given 
on each line of this file. The acceleration value is in units of g. The length 
of the record is 12.1 seconds. 

ToDo 
Create three trames, ene bare, ene with dampers, and ene with isolators. 
Create a video (•.avi file) of the nonlinear time history run. Review the mode 
shapes. 

lnclude a 50 kip point load and a 0.25 kip-sec2fin point 

/
mass at each 2nd, 3rd and roo! level joint of each trame 

.....-----, Roo! 

"' ~ 3rd 
Rubber 
isolators at "' base of this 2nd 

this trame 
trame\ "' Base 

/7. ':7 /7. ?' 

24' 24' 24' 24' 24' 

Note: Our intent is that you try this problern on your own frrst. After you have solved it on your 
own, yo u can step through our solution if desired. lf yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem O Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. _,_Ir;,..:.· P_ .. __ ~::J,_ 

2. From the File menu select New Model From Template ••.. This displays the Model 
Templates dialog box. 

3. lo '""'"'" g """ liok """' Porto! F~ mo<ompill<o 1 ¡ !lllrunoo <o dl'p l•Y<h' 
Portal Frame dialog box. 

4. In this dialog box 

• Type 3 in the Number of Stories edit box. 

• Type 5 in the Number ofBays edit box. 

• Uncheck the Restraints check box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to clase it. 

6. Click the Set Elements button[~ on the main toolbar ( or select Set Eiements ... from the 
View menu) to display the Set Elements Dialog box. 

7. In this dialog box: 

• Check the La beis box in the Joints area. 

• Check the Labels box in the Frames area. 

• Click the OK button. 

8. Select beam elements 22, 23, 24, 28, 29 and 30. Press the delete. key on the keyboard to 
delete these elements. 

Note: You could se/ect the elements by clicking on each one individual/y, by using the 
Intersecting Line Select Mode, or by using the Select By Labe/s option (Select menu > 
Se/ect > Labels). 

9. Click the Refresh Window button _tj to refresh the drawing. 

10. From the Draw menu select QuickDraw Frame Element. 

11. Click on the grid line between joints 17 and 21 to entera beam at the base ofthe isolated 
frame. 
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12. Click the Pointer button JU on the side tool bar to exit draw mode.and enter select mode. 

13. Select joints 1, 5, 9 and 13. 

14. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

15. In this dialog box: 

• Click the Fixed Base Fast Restraint button I.J..ho set al! degrees of free do m (U 1, U2, 
U3, R 1, R2 and R3) as restrained. 

• Click the OK button. 

16. Click the drop down box in the status bar to change the units to kip-in. "''K='f'"1="===3~?'-'l 

17. From the Define menu select Materials ... to display the Define Materials dialog box. 

18. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

19. In this dialog box: 

• Type O in the Mass per Unit Volume edit box. 

• Accept the default Weight per Unit Volume. 

• Type 5000 in the Modulus ofElasticity edit box. 

• Type .2 in the Poisson's Ratio edit box, ifit is Ílot airead y entered. 

• Click the OK button twice to exit all dialog boxes. 

20. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

21. In the Click To area, click the drop-down box that says Add I/Wide Flange and then click 
on the Add Rectangular item to display the Rectangular Section dialog box. 

22. In this dialog box: 

• Type BEAM in the Section N ame edit box. 

• Select CONC in the Material drop-down box. 

• Type 36 in the Depth (t3) edit box. 

• Type 24 in the Width (t2) edit box. 
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• Click the OK button to return to the Define Frame Sections dialog box. 

23. In the Click To area, click the drop-down box that says Add Rectangular and then click on 
the Add Rectangular item to display the Rectangular Section dialog box. 

24. In this dialo g box: 

• Type COL in the Section N ame edit box . 

• Select CONC in the Material drop-down box . 

• Type 24 in the Depth (t3) edit box . 
' 

• Type 24 in the Width (t2) edit box . 

• Click the OK button twice to exit all dialog boxes . 

25. Select all beam elements ( 1 O total). 

26. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

27. In this dialog box: 

• Click on BEAM in the Frame Sections area to highlight it. 

• Click the OK button. 

28. Select all column sections by "windowing" on each column line separately ( 18 total). 

29. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Defme Frame Sections dialog box. 

30. In this dialog box: 

• Click on COL in the Frame Sections area to highlight it. 

• Click the OK button. 

31. Click the Show Undeformed Shape button O J to remove the displayed frame section 
assignments so that you can see the frame element labels again. 

32. From the Define menu select NLLink Properties ... to display the Define NLLink 
Propenies dialog box. 

33. In this dialog box: 

• Click the Add New Property button to display the NLLink Propeny Data dialog box. 
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• • In this dialog box: 

~ Type ISO in the Property N ame edit box. 

> Select Isolatorl from the Type drop-down box. 

> Type .001 in the Mass edit box. 

> Check the U l Direction check box. 

~ Click the Modify/Show For U1 button to display the NLLink Directional 
Properties dialog box. 

> In this dialog box: 

,r Type 10000 in the Effective Stiffuess edit box. 

,r Click the OK button to retum to the NLLink Property Data dialog ·box. 

~ Check the U2 Direction check box. 

:.- Check the U2 Nonlinear check box. 

~ Click the Modify/Show For U2 button to display the NLLink Directional 
Properties dialog box. 

> In this dialog box: 

,r In the Linear Properties area type 10 in the Effective Stiffuess edit box. 

,r In the Nonlinear Properties area type 100 in the Stiffness edit box. 

,r Type 40 in the Yield Strength edit box. 

,r Type .1 in the Post Yield Stiffuess Ratio edit box. 

,r Accept the rest ofthe default values. 

,r Click the OK button to retum to the NLLink Property Data dialog box. 

> Click the OK button to retum to the Defme NLLink Properties dialog box. 

• Click the Add New Property button to display the NLLink Property Data dialog box. 

• In this dialog box: 

:.- Type DAMP in the Property N ame edit box. 

> Select Damper from the Type drop-down box. 

. .. 
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:.- Type .001 in the Mass edit box. 

:.- Check the U 1 Direction check box. 

~ Check the U 1 Nonlinear check box. 

~ Click the Modify/Show For U1 button to display the NLLink Directional 
Properties dialog box. 

~ In this dialog box: 

../ In the Nonlinear Properties area type 1000 in the Stiffness edit box . 

../ Type 30 in the Damping edit box . 

../ Type .S in the Damping Exponent edit box . 

../ Click the OK button three times to exit all dialog boxes. 

34. From the Draw menu select Draw NLLink Element. 

35. Double click on joints 17 and 21 to draw two NLLink elements. 

36. Click onjoint 9 and thenjoint 14 to draw an NLLink element. 

37. Click onjoint 10 and thenjoint 15 to draw anNLLink element. 

38. Click on joint 11 and then joint 16 to draw an NLLink element. 

39. Click the Pointer button ~ on the side too! bar to exit draw mode and enter select mode. 

40. Click on the three NLLink element in the center frame to select them. 

41. From the Assign menu select NLLink and then Properties ... from the submenu to display 
the Define NLLink Properties dialog box. 

42. In this dialog box: 

• Click on DAMP in the NLLink Props area to highlight it. 

• Click the OK button. 

43. Click the Show Undeformed Shape button O 1 to remove the displayed NLLink property 
assignments so that yo u can see the joint labels again. 

44. Hold down the Ctrl key on the keyboard and left click joint 17 to display the Selection List 
dialog box. 
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45. In the dialog box click on the NLLink 1 element. The Selection List dialog box closes and 
the NLLink element is selected. 

46. Hold down the Ctrl key on the keyboard and left click joint 21 to display the Selection List 
dialog box. 

47. In the dialog box click on the NLLink 2 element. The Selection List dialog box closes and 
the NLLink element is selected. 

48. From the Assign menu select NLLink and then Properties ... from the submenu to display 
the Define NLLink Propenies dialog box. 

49. In this dialog box: 

• Click on ISO in the NLLink Props area to highlight it. 

• Click the OK button. 

50. Click the Show Undeformed Shape button O 1 to remove the displayed NLLink property 
assignments. 

51. Select al! joints at the 2nd, 3rd and Rooflevels by ''windowing". 

52. From the Assign menu select Joint Static Loads ... and then Forces ..• from the submenu to 
display the Joint Forces dialog box. 

53. In this dialog box: 

• Type -50 in the Force Global Z edit box. 

• Click the OK button. 

54. Select al! joints at the 2nd, 3rd and Roof levels by ''windowing". 

55. From the Assign menu select Joint and then Masses ... from the submenu to display the 
Joint Masses dialog box. 

56. In this dialog box: 

• Type .25 in the Direction l edit box. 

• Type .25 in the Direction 3 edit box. 

• Click the OK button. 

57. Click the drop down box in the status bar to change the units to kip-ft. ·JKrp-11 iJ 
58. Click the Show Undeformed Shape button O 1 to remove the displayed joint mass 

assignments. 
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59. Click the Set Ele.ments buttoni-ª.J on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

60. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck the Labels box in the Frames area. 

• Click the OK button. 

Note: Prior lo defining time history functions, yo u should loca te the time history file 
named El centro that is in the subdirectory• named Examples beneath the directory• 
where you installed SAP2000. Copy thisfile into the same directory• as your SAP2000 
input file. 

Jfthe Examples subdirectory does no/ exist you may need to reinsta/1 SAP2000, and 
select lo insta// the examples. 

61. From the Define menu select Time History Functions ... to display the Define Time 
History Functions dialog box. 

62. In this dialog box: 

• Click the Add Function From File button to display the Time History Function 
Defmition dialog box. 

• In this dialog box: 

>- Type ELCEN in the Function N ame edit box. 

>- Click the Open File button to display the Pick Function Data File dialog box. 

>- In this dialog box: 

../ Locate and highlight the file named Elcentro 

../ Click the Open button to return to the Time History Function Definition dialog 
box . 

../ Type 3 in the Number OfPoints Per Line edit box . 

../ Select the Time and Function Values option . 

../ Click the OK button twice to exit all dialog boxes. 

63. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 
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lo'"'' dilllog 00Hh<k<ho PI•~ F~m"<Z p¡,.. bmmo l!ll'""'"' 
available degrees of freedom. 

Check the Dynamic Analysis check box, if it is not airead y checked . 

Click the Set Dynamic Parameters button to display the Dynamic Analysis 
Parameters dialog box. 

In this dialog box: 

~ Type 30 in the Number ofModes edit box. 

~ In the Type Of Analysis area select the Ritz Vectors option. 

~ Verity that ACCEL X and ACCEL Z are in the Ritz Load Vectors box in the 
Starting Ritz Vectors area. Move any other vectors out ofthe Ritz Load Vectors 
box 

~ Confirrn that the Include NLLink Vectors box is checked. 

~ Click the OK button twice to exit all dialog boxes. 

64. From the Define menu select Time History Cases ... to display the Define Time History 
Cases dialog box. 

65. In this dialog box: 

• Click the Add New History button to display the Time History Case Data dialog box. 

• In this dialog box: 

~ Type GRA V in the History Case N ame edit box. 

~ Select Nonlinear from the Analysis Type drop-down box. 

~ Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

~ In this dialog box: 

v" Type .02 in the Damping For All Modes edit box. 

v" Click the OK button. 

~ Type 100 in the Number ofOutput Time Steps edit box. 

~ Type .1 in the Output Time Step Size edit box. 

~ Check the Envelopes check box. 
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:;... In the Load drop-down box select GRA V. 

:;... In the Function drop-down box, select RAMP. 

:;.. Type 1 in the Scale Factor edit box. 

:;.. Click the Add button. 

:;.. Click the OK button to return to the Define Time History Cases dialog box. 

• Click the Add New History button to display the Time History Case Data dialog box. 

• In this dialog box: 

:;.. Type ELCN in the History Case Name edit box. 

;,. Select Nonlinear from the Analysis Type drop-down box. 

:;.. Click the Modify/Show button for modal damping to display the Modal Damping 
dialog box. 

;,. In this dialog box: 

v' Type .02 in the Damping ForAl! Modes edit box. 

v' Click the OK button. 

:;.. Type 1210 in the Number ofOutput Time Steps edit box. 

;,. Type .01 in the Output Time Step Size edit box. 

;,. Check the Envelopes check box. 

;,. In the Load drop-down box select acc dir l. 

;,. In the Function drop-down box, select ELCEN. 

;,. Type 32.2 in the Scale Factor edit box. 

;,. Click the Add button. 

;,. Click the OK button twice to exit al! dialog boxes. 

66. Click the Run Analysis button .:....J to run the analysis. 

67. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors). Click the OK button to close the Analysis window. 
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68. 

69. 

70. 

71. 

72. 

73. 

74. 

Click the Start Animaiion buttonl StartAnimatm jlocated on the status bar at the bottom of 
the screen to animate the first mode shape. 

Click the Right Arrow button¡ <=:> llocated on the status bar at the bottom ofthe screen to 
view the next mode shape. 

Continuing clicking the Right Arrow button¡ e:>! to step through all of the mode shapes. 
_:.._¡ 

Click the Show Undeformed Shape button Oi to remove the displayed mode shape. 

From the File menu select Crea te Video ... and then select Crea te Time History 
Animation Video ... to display the Video File dialog box. 

In this dialog box select the na me and location for the video file (* .avi) and click the S ave 
button. The Time History Video File Creation dialog box is displayed. 

In this dialog box: 

• Type 50 in the Magnification Factor edit box. 

• In the Frame Size (Pixels) edit boxes type 640 by 480. 

• Click the OK button. The * .avi file is created. 

Note: Once the *.avi file has been created it can be played on any multimedia player that 
supports *.avifiles. A program cal/ed Media Player is supplied with Windows 95 that 
will play *.avi files. This program can afien be found by clicking the Start button, 
selecting Programs, then selecting Accessories and final/y selecting Multimedia. No 
multimedia player is provided with SAP2000. 

Note: The purpose of this example is lo display the capabilities of SAP2000. The 
structural properties of each frame ha ve no/ be en optimized in this example. Therefore, 
great care should be taken in drawing any conclusions about the relative performance 
of different structural systems based on this example. 
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Problem R 
Bridge With Moving Load 

Concrete Material Properties 
E -5000 ksi, Poissons Ratio- 0.2 
Member Properties 
Column Girder 
A~ 40 ft2 

1 = 400 ft3 
AS= 30 ft2 

Movina Load 
Number of Lanes = 2 

A~ 35 ft2 

1 = 500 ft3 

AS~ 12ft2 

------------------------------ r-~ 

-------·-··-··-··-··-··-··-·· 

Lane 2 Centerline 

Frame Elements Centerline 

Lane 1 Centerline 

Check for worst case of HS20-44 truck load and HS20-44L lane load applied 
to each lane srmultaneously. 

Use the Exact method of calculation. 

ToDo 
Set the number of ouput segments for girder elements to 2. Review the moving 
load influence line for vertical drsplacement at joint A in Lane 1. Review the 
moving load girder M33 moments in Lane 1. Set the number of ouput 
segments for the girder elements to 10. Review the same influence line and 
moments. 

A 

100' 100' 

o 
"' 

100' 

Note: Our intent is that you try this problem on your own frrst. After you have solved it on your 
own, yo u can step through our solution if desired. Ifyou have problems trying to create the 
model, then follow the steps in our solution. 
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Problem R Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡.,p-ft ::J 
2. From the File menu select New M o del From Template .•.. This displays the Model 

Templates dialog box. 

3. 1 o <h '' dilllog bouHek o o ilio Port•l F "m"omplo" ll j JI OOttoo ID di•p ill y <ho 
Portal Frame dialog box. . 

4. In this dialog box 

• Type 1 in the Number of Stories edit box. 

• Type 3 in the Number of Bays edit box. 

• Type 70 in the Story Height edit box. 

• Type 100 in the Bay Width edit box. 

• Uncheck the Restraints check box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close·it. 

6. Click the Set Elements buttonj~ on the rnain toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

7. In this dialog box: 

• Check the Labels box in the Joints area. 

• Check the Labels box in the Frames area. 

• Click the OK button. 

8. Select colurnn elements 1 and 4. Press the delete key on the keyboard to delete these 
elements. 

9. Click the Refresh Window button ~ to refresh the drawing. 

1 O. Select joints 2, 3, 5 and 8. 

11. From the Assign menu select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 
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12. In this dialog box: 

• Verify that the Translation 1, 2 and 3 check boxes are checked. If they are not checked, 
check them. 

• Click the OK button. 

13. Selectjoint 5. 

14. From the Edit menu select M ove ..• to display the M ove Selected Points menu. 

15. In this dialog box: 

• Type 20 in the Delta Z edit box. 

• Verify that O is entered in the Delta X and Delta Y edit boxes. 

• Click the OK button. 
D1vide Selected Frames 

16. 

17. 

Select frame elements 5, 6 and 7. 

From the Edit menu select Divide Frames ... to 
display the Divide Selected Frames dialog box. 

jz F~es l 
' 

e :. , J~syfi~~ r~o.' ~~ . ¡ , .¡ 
·r Bree.k l\t intersedJOrls ~h setected 

1 

18. Verify that the dialog box appears as shown in 
the figure and click the OK button. 

19. Select frame elements 8 through 13 (i.e., the 
girder elements). 

'-'·· 
Frames and Joints · .: - - _ · . 
. . ". . . 

le oK _JI ~·- · eancs1 1 

20. From the Assign menu select Frame and then Output Segments ... from the submenu to 
display the Frame Output Segments dialog box. 

21. In this dialog box: 

• Type 2 in the Number of Segments edit box. 

• Click the O K button. 

22. Click the Show Undeformed Shape button O 1 to remove the displayed output segment 
assignments so that you can see the frame element labels again. 

23. Click the drop down box in the status bar to change the units to kip-in. jKJp-m iJI 
24. From the Define menu select Materials ... to display the Define Materials dialog box. 

25. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 
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26. In this dialog box: 

• Type 5000 in the Modulus ofElasticity edil box. 

• Type .2 in the Poisson's Ratio edit box, ifit is not already entered. 

• Click the OK button twice to exit all dialog boxes. 

27. Click the drop down box in the status bar to change the units to kip-ft.JKlp-tt ::J 

28. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

29. In the Click To area, click the drop-down box that says Add I/Wide Flange and,then click 
on the Add General item to display the Property Data dialog box. 

30. In this dialog box: 

• T ype 40 in the Cross Sectional (Axial) Area edit box. 

• Type 400 in the Moment Oflnertia About 3 Axis edit box. 

• Type 30 in the Shear Area in 2 Direction edit box. 

• Click the OK button to display the General Section dialog box. 

• In this dialog box: 

» Type COLUMN in the Section N ame edit box. 

» Select CONC from the Material drop-down box. 

» Click the OK button to return to the Define Frame Sections dialog box. 

31. In the Click To area, click the drop-down box that says Add General and then click on the 
Add General item to display the Property Data dialog box. 

32. In this dialog box: 

• Type 35 in the Cross Sectional (Axial) Area edit box. 

• Type 500 in the Moment Oflnertia About 3 Axis edit box. 

• Type 12 in the Shear Area in 2 Direction edit box. 

• Click the OK button to display the General Section dialog box. 

• In this dialog box: 

4 



~ Type GIRDER in the Section N ame edit box. 

~ Select CONC from the Material drop-down box. 

~ Click the OK button twice to exit al! dialog boxes. 

33. Select frame elements 8 through 13 (girders). 

34. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

35. In this dialog box: 

• Click on GIRDER in the Frame Sections area to highlight it. 

• Click the OK button. 

36. Select the two colurnn elements. 

37. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

38. In this dialog box: 

• Click on COLUMN in the Frame Sections area to highlight it. 

• Click the OK button. 

39. Click the Show Undeformed S ha pe button O! to remove the displayed frame section 
assignments so that you can see the frame element labels again. 

40. From the Define menu select Moving Load Cases and then select Lanes ... to display the 
Define Bridge Lanes dialog box. 

4!. In this dialog box: 

• Click the Add New Lane button to display the Lane Data dialog box. 

• In this dialog box: 

:.> Accept the default Lane N ame, LANE l. 

~ Type 8 in the Frame edit box. 

~ Type -6 in the Eccentricity edit box. 

~ Click the Add button. 

)> Type 9 in the Frame edit box. 
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~ Click the Add button. 

~ Type 10 in the Frame edit box. 

~ Click the Add button. 

~ Type 11 in the Frame edit box. 

~ Click the Add button. 

~ Type 12 in the Frame edit box. 

~ Click the Add button. 

~ Type 13 in the Frame edil box. 

~ Click the Add button. 

~ Click the OK button to return to the Define Bridge Lanes dialog box. In this dialog 
box: 

• Click the Add New Lane button to display the Lane Data dialog box. 

• In this dialog box: 

~ Accept the default Lane N ame, LANE2. 

~ Type 8 in the Frame edit box. 

~ Type 6 in the Eccentricity edit box. 

~ Click the Add button. 

~ Type 9 in the Frame edit box. 

~ Click the Add button. 

~ Type 10 in the Frame edit box. 

~ Click the Add button. 

~ Type 11 in the Frame edit box. 

~ Click the Add button. 

~ Type 12 in the Frame edit box. 

~ Click the Add button. 
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~ Type 13 in the Frame edit box. 

~ Click the Add button. 

~ Click the OK button twice to exit all dialog boxes. 

42. From the Define menu select Moving Load Cases and then select Vehicles ... to display the 
Define Vehicles dialog box. 

43. In this dialog box: 

• In the Click To area click the drop-down box and select Add Standard Vehicle to 
display the Standard Vehicle Data dialog box. 

• In this dialog box: 

>- In the Data Definition area select HSn-44 in the Vehicle Type drop-down box. 

>- Type 20 in the Scale Factor edit box if it is not airead y there. 

>- Click the OK button to return to the Define Vehicles dialog box. 

• In the Click To area click the drop-down box and select Add Standard Vehicle to 
display the Standard Vehicle Data dialog box. 

• In this dialog box: 

>- In the Data Definition area select HSn-44L in the Vehicle Type drop-down box. 

~ Type 20 in the Scale Factor edit box if it is not airead y there. 

~ Click the OK button twice to exit all dialog boxes. 

44. From the Define menu select Moving Load Cases and then select Vehicles Classes ... to 
display the Define Vehicle Classes dialog box. 

45. In this dialog box: 

• Click the Add New Class button to display the Vehicle Class Data dialog box. 

• In this dialog box: 

>- Accept the default Vehicle Class Name, VECLI 

>- Verity that HSn441 is in the Vehicle Name drop-down box. 

~ Enter 1 in the S cale Factor edit box if it is not airead y there. 

~ Click the Add button. 
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:.> Select HSn442 in the Vehicle Name drop-down box. 

:.> Click the Add button. 

J> Click the OK button twice to exit all dialog boxes. 

46. From the Define menu select Moving Load Cases and then select Bridge Responses ... to 
display the Bridge Response Request dialog box. 

47. In this dialog box: 

• In the Type ofResults area check all four ofthe check boxes ifthey are not already 
checked. 

• In the Method of Calculation area se!ect the Exact option. 

• Click the OK button. 

48. From the Define menu select Moving Load Cases and then select Moving Load Cases .•. 
to display the Define Moving Load Cases dialog box. 

49. In this dialog box: 

• Click the Add New Load button to display the Moving Load Case Data dialog box. 

• In this dialog box: 

J> Accept the default Moving Load Case Name, MOVEI. 

J> Click the Add New Assign button to display the Moving Load Case Assignment 
Data dialog box. 

J> In this dialog box: 

'-' In the Assignrnent Lanes area click on LANEl in the Select Lanes From list box 
to highlight ( select) it. 

'-' Hold down the Ctrl key on the keyboard and click on LANE2 to add it to the 
selection. 

'-' Click the Add button to transfer these items to the Selected Lanes list box. 

'-' Click the OK button three times to exit all dialog boxes. 

50. Note that the joint labeled A in the problem statement is labeled 1 O on the screen. 

51. Click the Set Elements buttonl~ on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 
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52. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck the Labels box in the Frames area. 

• Click the OK button. 

53. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• ¡,.hdOlog OOH!kk >h< PI••• Fnm< XZ Pb"' bonoo ¡ ¡ ¡ 1'" "' >h< 
available degrees of free do m. 

• Click the OK button. 

54. Click the Run Analysis button __J to run the analysis. 

55. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

56. From the Display menu select Show lnfluence Lines ... and then Joints ... to display the 
Show Joint Influence Line dialog box. 

57. In this dialog box: 

• Select LANE 1 from the Lane drop·down box if it is not airead y showing. 

• Type 10 in the Joint ID edit box. 

• In the Vector Type area select the Displacement option if it is not already selected. 

• In the Componen! area select the U3 option (vertical displacement). 

• Click the OK button to display the influence line. 

Note: This injluence fine is constructed with two output segments specifiedfor the girder 
elements. Points for the inj/uence /in e are calculated al the ends of ea eh output 
segment. These points are then connected by straight lines. You can clearly see the 
segmenrs in the injluence fine. 

58. Click the Member Force Diagram For Frames buttonl F ¡ to display the Member Force 
Diagram For Frames dialog box. 

59. In this dialog box: 

• Select MOVEI Moving Load from the Load drop-down box. 

• In the Componen! area select the Moment 3-3 option. 
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• Uncheck the Fill Diagram check box. 

• Check the Show Values On Diagram check box. 

• Click the OK button to display the moment diagram. 

Note: This moment diagram is constntcted nith two output segments specifiedfor the 
girder elements. Points for the moment diagram are calculated at the ends of ea eh 
output segment. These points are then connected by straight fines. You can clearly see 
the segments in the moment diagram. 

60. Click the Lock!Unlock Model button ~ and click the resulting OK button to unlock the 
model. 

61. Select frame elements 8 through 13 (i.e., the girder elements). 

62. From the Assign menu select Frame and then Output Segments ... from the submenu to 
display the Frame Output Segments dialog box. 

63. In this dialog box: 

• Type 1 O in the Number of Segments edit box. 

• Click the OK button. 

64. Click the Show Undeformed Shape button O! to remo~e the displayed output segment 
assignments. 

65. Click the Run Analysis button _.J to run the analysis. 

66. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button toe lose the Analysis window. 

67. From the Display menu select Show Influence Lines ... and then Joints ... to display the 
Show Joint Intluence Line dialog box. 

68. In this dialog box click the OK button to display the intluence line. 

Note: This injluence fine is much sharper than the previous one. 

69. Click the Member Force Diagram For Frames buttonl F! to display the Member Force 
Diagram For Frames dialog box. 

70. In this dialog box click the OK button to display the moment diagram. 

Note: This moment diagram is much sharper than the previous one. 
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Problem S 
Finite Element Model of Steel Beam With Web Openings 

Steel 
E =29000 ksi 
Poissons Ratio = 0.3 
Built-Up Beam: d = 40 in 

t.,=0.75in 
b1=16in 
~= 2 in 
Beam openings are 20" high by 48" wide centered over the 
depth of the beam 

ToDo 
Construct a finite element model of this simply supported beam using shell 
elements. Detemine moments and shears at center of beam and at center 
of left opening. Plot shear stresses (S12) in beam web. 

18 klf 

~ 
4' 4' 4' 4' 4' 

1 
20' 

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to ere ate the 
model, then follow the steps in our solution. 
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Problem S Solution 

l. Click the drop down box in the status harto change the units to kip-in. ;JKl_p-~=n ==-']"'·"'i 

2. From the File menu select New Model .... This displays the Coordinate System Defmition 
dialog box. 

3. In this dialog box 

• Select the Cartesian Tab. 

• In the Number ofGrid Spaces area type 1 in the X direction edil box. 

• In the Number of Grid S paces area type 2 in the Y direction edil box. 

• In the Number ofGrid S paces area type 1 in the Z direction edit box. 

• In. the Grid Spacing area type 240 in the X direction edit box. 

• In the Grid Spacing area type 8 in the Y direction edit box. 

• In the Grid Spacing area type 40 in the Z direction edit box. 

• Click the OK button. 

4. Click in the window titled X-Y Plane@ Z=o40 to make sure it is active. The window is 
highlighted when it is active. The screen appears as shown in Figure S-l. 

5. Click the Draw Rectangular Shell Element button :QJ on the side toolbar or select Draw 
Rectangular Shell Element from the Draw menu. 

6. Click on the point labeled "A" and then the point labeled "B" in Figure S-1 to entera shell 
element. 

7. Click the Pointer button. ~ 1 to exit Draw Mode 
and enter Select Mode. 

8. Click on the shell element to select it. 

9. From the Edit menu select Mesh Shells ... to 
display the Mesh Selected Shells dialog box. 

1 O. Fill in this dialog box as shown in the adjacent 
figure and click the OK button. 

Me•h Selected Shell• 

ro Mem no . ~~-~ ... J ' 
. b, · . . . j2 ' Sheb 

.~-.• ~ .::·. 7'.".!--··· .,~~ ~··: 

(" M eoh using selected Joints oo edgeo 

r Mem at irior..,~ wlh ¡j,;d; 

11. Click the Select All button ·lió¡ on the side toolbar to select all elements. 

2 



81 SAP2COO IUnlidcdJ l!lrJ 13 
r-.e .t.<il Y.- Qeme Dr... s.-a &aqrl ~ JliiCikto L ~'~. ~ H• 

Dloilllill +·ILJ .. ~.L.J .ul.®l.el.®l.eiiÍIII ><~1·1~1,.1..,.1 ~,;11!11~ -:.III-1.·-I~I.;;;I..QJ. 

z 

y .X' 
'A 

Figure S-1: Screen After Step 4 

12. From the Edit menu select Copy. 

13. From the Edit menu select Paste ••. to displaythe Paste Coordinates dialog box. 

14. In this dialog box: 

• Type -40 in the Delta Z edit box. 

• Click the OK bunon. 

15. Click in the window titled X-Y Plane @ Z=40 to rnake sure it is active. Do not 
accidentally select any elements while doing this. 

16. From the View menu select Set 2D View ••. to display the Set 2D View dialog box. 

17. In this dialog box: 

• Select the X-Z Plane option. 

• Type O in the Y= edit box. 

B 
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• Click the OK button. The screen appears as shown in Figure S-2. 
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Figure S-2: Screen After Step 17 

18. Click the Draw Rectangular Shell Element button:g) on the side toolbar or select Draw 
Rectangular Shell Element from the Draw menu. 

19. Click on the point labeled "A" and then the point labeled "B" in Figure S-2 to entera shell 
element. 

20. Click the Pointer button ~ to exit Draw Mode 
and enter Select Mode. 

21. Click on the shell element to select it. 

22. From the Edit menu select Mesh SheUs ... to 
display the Mesh Selected Shells dialog box. 

23. Fill in this dialog box as shown in the adjacent 
figure and click the OK button. 

Ne•h,Selecled Shell• < 
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24. Click in the window titled 3-D View to make sure it is active. 
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25. Click the Select All button ~ on the side toolbar to select all elements. 

26. From the Edit menu select Change Labels ... to display the Relabel Selected items dialog 
box. 

27. In this dialog box: 

• Type 1 in the Joint Next Number edit box. 

• Type 1 in the Shell Next Number edit box. 

• Click the OK button. 

Note: It is not necessary to change re/abe/ the e/ements. We are doing it here to assure 
that la ter on in the solution when we refer to element labels that everybody has the 
same /abe/ing system. 

28. Click the Set Elements buttonl!l.J on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

29. In this dialog box: 

• Check the Fill Elements box. 

• Click the OK button. 

30. Click in the window titled X-Z Plane@ Y=O to make sure it is active. 

31. Click the Set Eleme~ts buttonl!l.J on the main toolbar ( or select Set Elements . .. from the 
View menu) to display the Set Elements Dialog box. 

32. In this dialog box: 

• Check the Labels box in the Shells area. 

• Check the Fill Elements box. 

• Click the OK button. 

33. Select shell elements 65, 66, 67, 68, 85, 86, 87 and 88 by "windowing". 

34. Press the Delete key on the keyboard to delete these shell elements. 

35. Select shell elements 73, 74, 75, 76, 93, 94, 95 and 96 by "windowing". 

36. Press the Delete key on the keyboard to delete these shell elements. 

37. Click the Refresh Window button .lJ on the main toolbar to refresh the view. 
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38. Click in the window titled 3-D View to make sure it is active. 

39. C!ick the Refresh Window button _Lj on the main toolbar to refresh the view. 

40. Click in the window titled X-Z Plane@ Y=O to rnake sure it is active. 

41. Click the Set Elements buttonl~ on the rnain toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

42. In this dialog box: 

• Check the Labels box in the Joints area. 

• Uncheck the Labels box in the Shells area. 

• Click the OK button. 

43. Select joint 22 (lower left-hand comer) by clicking on it. 

44. From the Assign menu. choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

45. In this dialog box: 

• Verity that the Translation l and Translation 3 boxes are checked. 

• Uncheck the Translation 2 box. 

• Verity that the Rotation About l, Rotation About 2 and Rotation About 3 boxes are not 
checked. 

• Click the OK button. 

46. Select joint 42 (lower right-hand comer) by clicking on it. 

47. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. 

48. In this dialog box: 

• Uncheck the Translation l box. 

• Verity that the Translation 2 box is not checked. 

• Verity that the Translation 3 box is checked. 

• VerifY that the Rotation About 1, Rotation About 2 and Rotation About 3 boxes are not 
checked. 
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o Click the OK button. 

49. Select joints 148 and 168 (upper left-hand and right-hand comers) by clicking on them. 

50. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

51. In this dialog box: 

o Type -9 in the Force Global Z edit box in the Loads area. 

o Click the OK button. 

52. Select joints 149 through 167 by "windowing". 

53. From the Assign menu select Joint Static Loads ... and then Forces ... from the submenu to 
display the Joint Forces dialog box. 

54. In this dialog box: 

o Type -18 in the Force Global Z edit box in the Loads area. 

o Click the OK button. 

55. Click the Show Undeformed Shape button O i to remove the display ofjoint force 
assignments. 

56. From the Define menu select Materials ... to display the Define Materials dialog box. 

57. Highlight the STEEL material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

58. In this dialog box: 

o VerifY that the Modulus ofElasticity is 29000. 

o VerifY that Poisson's ratio is 0.3. 

o Click the OK button twice to exit the dialog boxes. 

59. From the Define menu select SheU Sections ... to display the Define Shell Sections dialog 
box. 

60. In this dialog box: 

o Click the Add New Section button to display the Shell Sections dialog box. 

o In this dialog box: 
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;¡;. Type WEB in the Section N ame edit box. 

;¡;. Select STEEL from the Material drop-down box. 

;¡;. In the Thickness area type • 75 in both the Membrane and Bending edit boxes. 

;¡;. Verity that the Shell option is chosen in the Type area. 

;¡;. Click the OK button to return to the Define Shell Sections dialog box. 

• Click the Add New Section button to display the Shell Sections dialog box. 

• In this dialog box: 

;¡;. Type FLANGE in the Section Name edit box. 

;¡;. Select STEEL from the Material drop-down box. 

;¡;. In the Thickness area type 2 in both the Membrane and Bending edit boxes. 

;¡;. V erifY that the Shell option is eh osen in the Type area. 

;.. Click the OK button twice to exit all dialog boxes. 

61. Click the Select All button ~ on the side toolbar to select all elements. 

62. From the Assign menu select Shell and then Sections ... to display the Defme Shell 
Sections dialog box. 

63. In this dialog box: 

• Highlight FLANGE in the Shell Sections area by clicking on it. 

• Click the OK button. · 

64. Select all ofthe elements in the X-Z Plane@ Y=O window by "windowing". 

65. From the Assign menu select Shell and then Sections ... to display the Define Shell 
Sections dialog box. 

66. In this dialog box: 

• Highlight WEB in the Shell Sections area by clicking on it. 

• Click the OK button. 

67. Click the Show Undeformed Shape button O! to remove the display of shell section 
assignments. 
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68. Click in the window titled X-Z Plane@ Y=O to make sure it is active. 

69. From the View menu select Set Limits •.. to display the Set Limits dialog box. 

70. In this dialog box: 

o In the Set X Axis Limits area type -12 in the M in edit box. 

o In the Set X Axis Limits area type O in the Max edit box. 

o Click the OK button. 

71. Click the Perspective Toggie button l~on the main toolbar. A perspective view ofthe 
X-Z elevation is displayed. 

72. Click the Rubber Band Zoom button ~pn the main toolbar and zoom in on the view by 
"drawing" a window tightly around it. 

73. Select all ofthe joints on the right side ofthe section by "windowing". 

74. Click the Set Intersecting Line Select Mode button \l& 1 and select all ofthe shell elements 
by "drawing" a Iine through them. There should now be 9 joints and 8 shells selected. 
You can verif)r this by looking at the left-hand side ofthe status bar at the bottom ofthe 
SAP2000 window. 

75. From the Assign menu select Group Name ... to display the Assign Group dialog box. 

76. In this dialog box: 

o Type CENTER in the Groups edit box. 

o Click the Add New Group Name button. 

o Click the OK button. 

77. Click the Show Undeformed S ha pe bunon O j to reset the limits ofthe display. 

78. From the View menu select Refresh View to rescale the view. 

79. From the View menu select Set Limits ... to display the Set Lirnits dialog box. 

80. In this dialog box: 

o In the Set X Axis Limits area type -60 in the M in edit box. 

o In the Set X Axis Limits area type -48 in the Max edit box. 

o Click the OK button. 

9 



81. Click the Rubber Band Zoom bunon .@~m the main toolbar and zoom in on the view by 
"drawing" a window tightly around it.-

82. Select all ofthe joints on the right side ofthe section by "windowing". 

83. ' Click the Set Intersecting Line Select Mode button mil! and select all ofthe shell elements 
by "drawing" a line tbrough them. There should now be 8 joints and 6 shells selected. 
Yo u can verify this by looking at the left-hand side ofthe status bar at the bottom ofthe 
SAP2000 window. 

84. From the Assign menu select Group N ame ... to dispiay the Assign Group dialog box. 

85. In this dialog box: 

• Type LEFT in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

86. Select all ofthe joints on the right side ofthe top half ofthe section by "windowing". 

87. Click the Set Intersecting Line Select Mode button mili and select all ofthe shell elements 
in the top half by "drawing" a line through them. There should now be 4 joints and 3 shells 
selected. You can verify this by looking at the left-hand side ofthe status bar at the bottom 
ofthe SAP2000 window. 

88. From the Assign menu select Group N ame ..• to display the Assign Group dialog box. 

89. In this dialog box: 

• Type LEFTTOP in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

90. Select all ofthe joints on the right side ofthe bottom half ofthe section by "windowing". 

91. Click the Set Intersecting Line Select Mode button 1!iiil and select all ofthe shell elements 
in the bottom halfby "drawing" a line through them. There should now be 4 joints and 3 
shells selected. You can verify this by looking at the left-hand side ofthe status bar at the 
bottom ofthe SAP2000 window. 

92. From the Assign menu select Group N ame .•• to display the Assign Group dialog box. 

93. In this dialog box: 

• Type LEFTBOT in the Groups edit box. 
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• Click the Add New Group Name button. 

• Click the OK button. 

94. Click the Show Undeformed Shape button O • to reset the limits ofthe display. 

95. From the View menu select Refresh View to rescale the view. 

96. Click the Set Elements buttoni_~.J on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

97. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Click the OK button. 

98. Click on the xz 2D View buttonG.Jon the main toolbar to retum from the perspective view 
toa 2-D view. Note the title ofthe window is X-Z Plane@ Y=O. 

99. Click the "X" in the upper right-hand comer of the 3-D View window to close it. 

1 OO. From the Analyze menu select Set Options •.. to display the Analysis Options dialog box. 

• lo Ihi• dilllog ""' diok<ho ""' F ~m e XZ p¡,,, '"""" ¡ ¡ ll <o .en he 
available degrees of freedom. 

• Click the OK button. 

1 O l. Click the Run Analysis button _J to run the analysis. 

102. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

103. From the Display menu select Show Group Joint Force Sums ••. to display the Select 
Groups dialog box. 

104. In this dialog box: 

• Click on CENTER to highlight it. 

• Holding down the Shift key on the keyboard click on LEFTTOP to highlight it. All of 
the groups except the default ALL should now be highlighted. 

• Click the OK button to display the Group Joint Force Summation window and view the 
group joint force surns. When finished viewing the group joint force surns, click the 
"X" in the top right-hand comer ofthe Group Joint Force Summation window to close 
it. 
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105. From the Display menu select Show Element Forces/Stresses and then Shells ... from the 
submenu to display the Element Force/Stress Contours For Shells dialog box. 

106. In this dialog box: 

• Click the Stresses option button to select it. 

• In the Componen! area click the S 12 option button to select it. 

• In the Stress Averaging area verify that the At All Joints option is selected. 

• Check the Display on Deformed Shape check box. 

• Click the OK button to display the shell stresses. The screen should look similar to that 
in Figure S-3 . 

• SAP2000 - 5 I!!R]I3 

~--~---·· 

Figure S-3: Shell Stresses 
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Problem T 
· Domed Cylindrical Structure 

ToDo 
Create the model of this 
cylinder topped by a circular 
dome. Can you create this 
model in one m1nute or less? 

b 
N 

Three Dimensional Persoective View 

Top View 

~ 

.sl 
Q) 

E 
"' i5 
b 
N 

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to e reate the 
model, then follow the steps in our solution. 
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Problem T Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. jKJp-tt :.:J 

2. From the File menu select New Model From Template .... This displays the Model 
Templates dialog box. . 

1 o <hffi dl•lo g bO> dio k '" lb e Cyll "'" """''"llfl] 1 b""'" ID dL>p ''y <!re 
Cylinder dialog box. t±:±::±i 3. 

4. In this dialog box: 

• Accept the default Number ofCircumferential Spaces, 16. 

• Type 8 in the Number ofHeight Spaces edit box. 

• Type 20 in the Cylinder Height edit box. 

• Type lO in the Radius edil box. 

• Click the OK button. 

5. Click in the "X" in the upper right-hand comer ofthe r-thela Plane@ 2=20 window to 
clase it. 

6. Click the Se! Elements buttonj~ on the main toolbar ( or select Se! Elements ... from the 
View menu) to display the Set Elements Dialog box. 

7. In this dialog box: 

• Check the Fill Elements box. 

• Click the OK butlon. 

8. From the Edil menu select Add To Model From Template ... 10 display the Model 

9. In this dialog box click on the Dome template ' ~ , button lo display the Dome 

Templates dialog box. ~ 

dialog box. . Ct::ttJ 
1 O. In this dialog box: 

• Accepl the default Number ofCircumferential Spaces, 16. 

• Type 4 in the Number of Segments edil box. 
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• Type 1 O in the Radius edit box. 

• Accept the default Roll Down Angle. 90. 

• Uncheck the Restraints check box if it is not already unchecked. 

• Click the Advanced button to display the Location and Orientation dialog box. 

Note: In this dialog box yo u are defining a /ocation of the origin of a new coordina te 
system and its rotation with respect 10 the global coordina te system. The origin 
point of the templare will be inserted at the origin of this newly de(ined coordinare 
system. 

• In this dialog box: 

:Y In the Translations area type 20 in the Z edit box. 

:Y Click the OK button twice to exit all dialog boxes. 

11. Press the F7 key on the keyboard to toggle the grid lines off. 

'1' ¡'1 
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Problem U 
Barrel Vaulted Structure 

Concrete 
E =3600 ksi 
Poissons Ratio= 0.2 
12" thick concrete walls 
and slabs 

ToDo 
Determrne the maximum deflection 
at the center of upper and lower 
barrel vaults due te the self weight 
of the structure. Also determine 
the maximum deflection at center 
of upper and lower barrel vaults 
due to the self weight plus !he 
prescribed live load applied te the 
top barrel vault. 

Live Load = 300 psi downward 
¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ 

Barrel vault with 
30' radius and 35' 
roll down angle 

Barrel vault with 
20' radius and 35' 
roll down angle 

Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem U Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. jKJp<t ::J 
2. From the File menu select New Model From Template .... This displays the Model 

Templates dialog box. , -: • : · 
! . ' . . 

3. In this dialog box click on the Barre! templa te ( . :-~ button to display the Barre! 
dialog box. ,, C<¿)/ j 

4. In this dialog box: 

• Accept the default Number of Circumferential S paces, 8. 

• Accept the default Number ofSpan Spaces, 8. 

• Type 40 in the S pan edit box. 

• Type 20 in the Radius edit box. 

• Type 35 in the Rol! Down Angle edit box. 

• Uncheck the Restraints check box. 

• Click the OK button. 

5. Click in the 3-D View window to make sure it is active. The window is highlighted when 
it is active. 

6. Click the Select AH button ~ !Iocated on the side toolbar to select the entire structure. 

7. From the Edit menu select Move ... to display the Move Selected Points dialog box. 

8. In this dialog box: 

• Type 10 in the Delta Z edit box. 

• Click the OK button. 

9. From the Edit menu se!ect Add To Model From Template ... to display the Model 

lO. In this dialog box click on the Barre! template l . m button to display the Barre! 

Templates dialog box. ~ 

dialog box. .. ro/ 
1 l. In this dialog box: 
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• Accept the default Number of Circumferential S paces, 8. 

• Accept the default Number of S pan S paces, 8. 

• Type 40 in the S pan edit box. 

• Type 30 in the Radius edit box. 

• Type 35 in the Roll Down Angle edit box. 

• Uncheck the Restraints check box if it is not already unchecked. 

• Click the Advanced button. 

~ Type 25 in the Z edit box in the T ranslations area. 

l>- Click the OK button twice to exit all dialog boxes. 

12. Click in the Y-Z Plane@ X=20 window to make sure it is active. 

13. Click the Set Elements buttonl-ªl on the main toolbar (or select Set E1ements ... from the 
View menu) to display the Set Elements Dialog box. 

14. In this dialog box: 

• Check the La beis box in the Joints area. 

• Click the OK button. 

15. Right click on joint 154 in window with the Y -Z Plane @ X=20. The Joint Information 
dialog box is displayed. 

16. Highlight the Y-coordinate (-17.2073) and press the Ctrl and the C keys on the keyboard at 
the same time to copy the value to the clip board. 

17. Click the Cancel button to c!ose the Joint Information dialog box. 

18. From the Edit menu select Add To Model From Template ... to display the Model 
Templates dialo g box. 

19. 1' iliffidi•log bo.oliok o o dre ""' Woll _¡,., 111111 bottoo ID di<p I•y <1< g¡, 
Wall dialog box. 

20. In this dialog box 

• Type 8 in the Number ofSpaces A!ong X edit box. 

• Type 4 in the Number ofSpaces Along Z edit box. 
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• Type 5 S pace Width Along X edil box. 

• Type 2.5 S pace Width A long Z edit box. 

• Uncheck the Restraints check box if it is not already unchecked. 

• Click the Advanced button. 

);- Highlight the Y edit box and press the Ctrl and the V keys on the keyboard at the 
same time topaste the -17.2073 value from the clipboard. 

);- Type 15 in the Z edit box in the Translations area. 

);- Click the OK button twice to exit all dialog boxes. 

21. Right click onjoint 73 in window with the Y-Z Plane@ X=20. The Joint lnformation 
dialog box is displayed. 

22. Highlight the Y -coordinate ( -11.4 715) and press the Ctrl and the C keys on the keyboard at 
the same time to copy the value to the clipboard. 

23. 

24. 

25. 

26. 

Click the Cancel button to close the Joint lnformation dialog box. 

From the Edit menu select Add To Model From Template ... to display the Model 
Templates dialog box. 

Jo <h ¡, dilllo g bo" liok '" '"' Shm W '" ""'P 1""111 : 11 bottoo " di•p ¡,y dre SheM 
Wall dialog box. 1 

In this dialog box 

• Type 8 in the Number of S paces Along X edit box. 

• Type 4 in the Number of S paces Along Z edit box. 

• Type 5 S pace Width Along X edit box. 

• Type 2.5 Space Width Along Z edit box. 

• Uncheck the Restraints check box if it is not already unchecked. 

• Click the Advanced button. 

;¡;. Highlight the Y edit box and press the Ctrl and the V keys on the keyboard at the 
same time topaste the -11.4715 value from the clipboard. 

;;.. Click the OK button twice to exit all dialog boxes. 

27. Click the Pointer button ~ on the side too! bar to enter select mode. 
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28. Click in the Y-Z Plane@ X=20 window to make sure it is active. 

29. From the View menu select Set 2D View •.. to display the Set2D View dialog box. 

30. In this dialog box: 

• Select the X-Z Plane option. 

• Type -11.4715 in the Y= edit box. 

• Click the OK button. 

31. Select all ofthe elements in this view by "windowing" 

32. From the View menu select Set 2D View ..• to display the Set 2D View dialog box. 

33. In this dialog box: 

• Select the X-Z Plane option. 

• Type -17.2073 in the Y= edit box. 

• Click the OK button. 

34. Select all ofthe elements in this view by "windowing" 

35. From the View menu select Show Selection Only. 

36. Click the Perspective Toggle button Gó'lon the main toolbar. 

37. From the View menu select Show Grid to toggle the grids off. 

38. From the View menu select Show Axes to toggle the axes off. 

39. From the Draw menu select Draw Quad Shell Element. 

40. In the X-Z perspective view click onjoints 163, 
195, 73 and 1, in that order, to draw a shell 
element. 

41. Click the Pointer button ltl on the side too! bar 
to exit draw mode and enter select mode. 

42. Click on the just drawn shell element to select it. 

43. From the Edit menu select Mesh Shells ..• to 
display the Mesh Selected Shells dialog box. 

44. Fill in this dialog box as shown in the figure and 

Ne~h Selected Shell: 

f.·-

!'. .. - ¡r::-3 -; ' 
r. Mesh no 

• tJ, .'"~·. :.-la Sheb:' 

(' M e:h using •eiected j~~ "" ~dQeS . 1 
(' M e:h at inté,.;;eoo;., wiíti ¡j;;d~ · 

r'-¡ -'-::o::-K .:.,· ( ./ ~~Éai;~::: 1 < :2~ .: ji 
. '~ '; : ~· .. : '. . ". ., ' . ' . . 

·• ' 
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ciick the OK button. 

Note: It is difficu/t to figure out whether to mesh shells 3 by 8 or 8 by 3. !t is afien easiest 
to just go ahead and try one way, and if it isn 't right, simply click the Undo buttoll 
Oll the main too/bar alld mesh the shel/s ...:2.fther way. 

45. Select all ofthe elements in the X-Z perspective view by ''windowing". 

46. From the Edit menu select Replica te ... to display the Replicate dialog box. 

47. In this dialog box: 

o Select the Mirror Tab. 

o In the Mirror About area select the XZ Plane option. 

o In the Ordinate area type O in the Y edit box if it is not airead y there. 

o Click the OK button. 

48. From the View menu select Set 20 View ... to display the Set 2D View dialog box. 

49. In this dialog box: 

o Select the X-Y Plane option. 

o Type O in the Z= edit box. 

o Click the OK button. 

50. Select all ofthe joints at this leve] by ''windowing". 

51. From the Assign menu select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 

52. In this dialog box: 

o Verify that the Translation 1, 2 and 3 boxes are all checked. 

o Click the OK button. 

53. From the View menu select Set 20 View ... to display the Set 2D View dialog box. 

54. In this dialog box: 

o Select the Y -Z Plane option. 

o Type 20 in the X= edit box. 
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• Click the OK button. 

55. Click the Show Undeformed Shape button O; to reset the window title. 

56. From the View menu select Show AU. 

57. Click the drop down box in the status bar to change the units to kip-in. jKip-m ::JI 
58. From the Define menu select Materials. __ to display the Define Materials dialog box. 

59. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

60. In this dialog box: 

• Type 3600 in the Modulus ofElasticity edit box. 

• Verity .2 is entered in the Poisson's Ratio edit box. 

• Click the O K button twice to exit all dialog boxes. 

61. Click the drop down box in the status bar to change the units to kip-ft. ·¡Klp-ft ::J 
62. From the Define menu select Materials_.. to display the Defme Materials dialog box. 

63. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

64. In this dialog box: 

• VerifY that 4.657E-03 is entered in the Mass Per Unit Volume edit box. 

• Verity that .15 is entered in the Weight Per Unit Volume edit box. 

• Click the OK button twice to exit all dialog boxes. 

65. From the Define menu select SheU Sections_.. to display the Define Shell Sections dialog 
box. 

66. In this dialog box: 

• Click the Modify/Show Section button to display the Shell Sections dialog box. 

• In this dialog box: 

;;;. Verity that the Material is CON C. 

;¡;. V erifY that both the Membrane and Bending thicknesses are l. 

7 



~ V erif)r that the Shell option is eh osen in the T ype area. 

~ Click the OK button twice to exit all dialog boxes. 

67. From the Define menu select Sta tic Load Cases •.. to display the Define Sta tic Load Case 
Names dialog box. 

68. In this dialog box: 

• Type DL in the Load edit box. 

• Click the Change Load button. 

• Type LL in the Load edit box. 

• Select Live from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Add New Load button. 

• Click the OK button. 

69. From the Define menu select Load Combinations ... to display the Define Load Case 
Combinations dialog box. 

70. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box .. 

• In this dialog box: 

~ Accept the default Load Combination Name COMBI. 

~ Accept the default Load Combination Type, Add. 

~ Type COMBl: DL + LL in the Title edit box. 

~ Verif)r that DL Load Case appears in the Case N ame drop-down box, and that the 
S cale Factor is l. 

~ Click the Add button. 

~ Select LL Load Case from the Case N ame drop-down box 

~ Click the Add button. 

~ Click OK twice to exit all dialog boxes. 
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71. Click in the 3-D View window to activate it. Be careful not to accidemally select any 
members when you do this. 

72. From the View menu select Set Limits ... to display the Set Limits dialog box. 

73. In this dialog box: 

• Type 25 in the M in edit box in the Set Z Axis limits area. 

• Click the OK button. 

74. Select all ofthe displayed elements in the 3D View window (i.e., all elements in the roof 
barre!) by "windowing". 

75. From the Assign menu choose Shell Static Loads ... and then choose Uniform ... from the 
submenu to display the Shell Uniform Loads dialog box. 

76. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• Type -.3 in the Load edit box. 

• Veril)' that Global Z is selected in the Dir drop-down box. 

• Click the OK button. 

77. Click the Show Undeformed Shape button O i to remove the display of shell uniform 
loads and to remo ve the limits that were set. 

78. Click the Run Analysis button _í]to run the analysis. 

79. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

80. Click in the window titled Y -Z Plane@ X=20 to activate it. 

81. Click the Display Static Deformed Shape button ,t.¡ on the main toolbar to display the 
Deformed Shape dialog box. 

82. In this dialog box: 

• Select the DL Load Case from the Load drop-down box. 

• Select the Auto Scaling option. 

• Click the OK button. 

83. Click the drop down box in the status bar to change the units to kip-in. IKip-in ::TI 
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84. Right click on the center joint ofthe upper barre! vault to see its selfweight displacement 
in inches. 

85. Right click on the center joint ofthe lower barre! vault to see its selfweight displacement 
in inches. 

86. Click the Display Sta tic Deformed Shape button A 1 on the main toolbar to display the 
Deformed Shape dialog box. 

87. In this dialog box: 

• Select the COMBI Combo from the Load drop-down box. 

• Click the OK button. 

88. Right click on the center joint ofthe upperbarrel vault to see its selfweight plus live load 
displacement in inches. 

89. Right click on the center joint ofthe lower barre! vault to see its selfweight plus live load 
displacement in inches. 

Alternative Problem U Solution 

Now an alternative method of creating the model is shown. This alternative method do es not use 
the Advanced button feature ofthe Add To Model From Template feature. Instead it makes 
use of groups and the move command to accomplish essentially the same thing. 1t is a good 
example of one ofthe uses of groups. This alternative method takes more steps than the initial 
method shown. The initial method is recommended; this method is just shown for example 
purposes. 

Al. Click the drop down box in the status bar to change the units to kip-ft. !K'p-ft ::J 

A2. From the File menu select New Model From Template .... This displays the Model 

A3. In this dialog box click on the Barre! Template : ·~ button to display the Barre] 

Templates dialog box. ~· · " .. 

dialog box. . ~ 
A4. In this dialog box 

• Accept the default Number of Circumferential S paces, 8. 

• Accept the default Number of S pan S paces, 8. 
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• Type 40 in the S pan edit box. 

• T ype 20 in the Radius edit box. 

• Type 35 in the Roll Down Angle edit box. 

• Uncheck the Restraints check box. 

• Click the OK button. 

AS. Ciick in the 3-D View window to rnake sure it is active. The window is highlighted when 
it is active. 

A6. Click the Select AH button @iiljlocated on the side toolbar to seiect the entire structure. 

A7. From the Assign menu select Group Name ... to display the Assign Group dialog box. 

A8. In this dialog box: 

• Type LOBARREL in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

A9. Click the Restore Previous Selection button @ 1 on the side toolbar (or select Get 
Previous Selection from the Select menu). 

Al O. From the Edit menu select Move ... to display the M ove Selected Points dialog box. 

Al!. In this dialog box: 

• Type 10 in the Delta Z edit box. 

• Click the O K button. 

Al2. From the Edit menu select Add To Model From Template ... to displaythe Model 

AI3. In this dialog box click on the Barre! template ~ button to display the Barre! 

Templates dialog box. ~ 

dialog box. ~ 
A 14. In this dialog box 

• Accept the default Number ofCircumferential Spaces, 8. 

• Accept the default Number of S pan S paces, 8. 

• Type 40 in the S pan edit box. 
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• Type 30 in the Radios edit box. 

• Type 35 in the Roll Down Angle edit box. 

• Uncheck the Restraints check box if it is not already unchecked. 

• Click the OK button. 

Al5. Click the Pointer button Ji..] on the side too! bar to enter select mode. 

Al6. Click the Select AII button @iii!Iocated on the side toolbar to select the entire structure. 

Al 7. From the Select menu choose Deselect and then choose Groups ... from the submenu to 
display the Select Groups dialog box. 

Al8. In this dialog box: 

• Click on the LOBARREL group to highlight it. 

• Click the OK button. 

Al 9. From the Assign menu select Group N ame ... to display the Assign Group dialog box. 

A20. In this dialog box: 

• Type HffiARREL in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

A21. Click the Resto re Previous Selection button @ 1 on the side toolbar ( or select Get 
Previous Selection from the Select menu). 

A22. From the Edit menu select Move ... to display the M ove Selected Points dialog box. 

A23. In this dialog box: 

• Type 25 in the Delta Z edit box. 

• Click the OK button. 

A24. From the Edit menu select Add To Model From Template ... to display the Model 
Templates dialog box. 

A25. 1 o<hOdl,lo g be> 'li<k "' ""' Sh m W ~h=p ""1' 11111""""' '" di'P ''' ¡¡. Shom Wall dialog box. 

A26. In this dialog box 
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• Type 8 in the Number of S paces Along X edit box. 

• Type 4 in the Number of S paces A long Z edit box. 

• Type 5 S pace Width A long X edit box. 

• Type 2.5 S pace Width Along Z edit box. 

• Uncheck the Restraints check box if it is not already unchecked. 

• Click the OK button. 

A27. Click the Pointer button ~ on the side too] bar to enter select mode. 

A28. Click the Select All button GID!located on the side toolbar to select the entire structure. 

A29. From the Select menu choose Deselect and then choose Groups ... from the submenu to 
display the Select Groups dialog box. 

A30. In this dialog box: 

• Click on the HIB,¡\RREL group to highlight it. 

• Hold down on the Ctrl key on the keyboard and click on the LOBARREL group to add 
it to the selection 

• Click the OK button. 

A31. From the Assign menu select Group N ame ... to display the Assign Group dialog box. 

A32. In this dialog box: 

• Type W ALLI in the Groups edit box. 

• Click the Add New Group N ame button. 

• Click the OK button. 

A33. Click in the Window titled Y-Z Plane@ X=20 to activate it. 

A34. Click the Set Elements buttonl~ on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

A35. In this dialog box: 

• Check the La beis box in the Joints area. 

• Click the OK button. 
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A36. Right click on joint 154. The Joint Inforrnation dialog box is displayed. 

A37. In this dialog box: 

• Note that the Y-coordinate ofthis joint is -17.2073. 

• Click the OK bunon to close the dialog box. 

A38. From the Select menu choose Select and then choose Groups ... from the submenu to 
display the Select Groups dialog box. 

A39. In this dialog box: 

• Click on the W ALLI group to highlight it. 

• Click the OK button. 

A40. From the Edit menu select Move ... to display the Move Selected Points dialog box. 

A41. In this dialog box: 

• Type -17.2073 in the Delta Y edit box. 

• Type 15 in the Delta Z edit box. 

• Click the OK button. 

A42. Right click on joint 73. The Joint Information dialog box is displayed. 

A43. In this dialog box: 

• Note that the Y-coordinate ofthis joint is -11.4715. 

• Note that the Y -direction distance between joints 154 and 73 can be calculated as 
17.2073 o 11.4715 = 5.7358. 

• Click the OK button to close the dialog box. 

A44. From the Select menu choose Select and then choose Groups ... from the submenu to 
display the Select Groups dialog box. 

A45. In this dialog box: 

• Click on the W ALLI group to highlight it. 

• Click the OK button. 

A46. From the Edit menu select Replica te ... to display the Replicate dialog box. 
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A4 7. In this dialog box: 

• Select the Linear Tab. 

• Type 5. 7358 in the Y Distance edit box. 

• Type -15 in the Z Distance edit box. 

• Type 1 in the Number edit box. 

• Click the OK button. 

A48. Click the Select AH button ~ llocated on the side toolbar to select the entire structure. 

A49. From the Select menu choose Deselect and then choose Groups ... from the submenu to 
display the Select Groups dialog box. 

ASO. In this dialog box: 

• Click on the HIBARREL group to highlight it. 

• Hold down on the Ctrl key on the keyboard and click on the LOBARREL group to add 
it to the select ion 

• Click the OK button. 

AS!. From the View menu select Show Selection Only. 

A52. From the View menu select Set 2D View ... to display the Set 20 View dialog box. 

A53. In this dialog box: 

• Select the X-Z Plane option. 

• Type -17.2073 in the Y= edit box. 

• Click the OK button. 

A54. Click the Perspective Toggle button Gtrlon the main toolbar. 

A55. From the View menu select Show Grid to toggle the grids off. 

A56. From the Draw menu select Draw Quad SheU Element. 

A57. In the X-Z perspective view click onjoints 163,203,73 and 1, in that order, to draw a shell 
element. 
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A58. Click the Pointer button lJ on the side too! bar 
to exit draw mode and enter select mode. 

A59. Click on the just drawn shell element to select it. 

A60. From the Edit menu select Mesh Shells ... to 
display the Mesh Selected Shells dialog box. 

A61. Fill in this dialog box as shown in the figure and 
click the OK button. 

Note: lt is dijjicult to figure out whether to mesh 

Mesh Selecled Shells 
,,~·· ' -·-~. . . ~ 

. ''' 
r. Meoh into 13 - . -· ... -. ,-· 

ls ' Shels 
.··.' '·· , r. Meoh umg selectedJoint• on edg .. 

l· ., ..... ~· . . ' . • .. •. 

[: t; Meoh at intersectiOO "'lh ~ 
. ; ..... _. ., . " -' . " ., " ... .::,;:.' . ' 

·: .. OK J . . canco! 
'·' · ... 

she/ls 3 by 8 or 8 by 3. It is afien easiest to just go ahead and try one way, and if it 
isn 't right, simply click the Un do button .1('} ¡ on the m a in too/bar and mesh the she/ls 
the other way. 

A62. Select all ofthe elements in the X-Z perspective view by "windowing". 

A63. From the Edit menu select Replica te ... to display the Repiicate dialog box. 

A64. In this dialog box: 

• Select the Mirror Tab. 

• In the Mirror About area select the XZ Plane option. 

• In the Ordinate area type O in the Y edit box if it is not airead y there. 

• Click the OK button. 

A65. From the View menu select Set 2D View •.. to display the Set 2D View dialog box. 

A66. In this dialog box: 

• Select the X-Y Plane option. 

• Type O in the Z= edil box. 

• Click the OK button. 

A67. Select all ofthe joints at this leve! by "windowing". 

A68. From the Assign menu select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 

A69. In this dialog box: 

• Verif'y that the Translation 1, 2 and 3 boxes are all checked. 
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• Click the OK button. 

A 70. From the View menu select Set 2D View ... to display the Set 2D View dialog box. 

A 71. In this dialog box: 

• Select the Y -Z Plane option. 

• Type 20 in the X= edit box. 

• Click the OK button. 

A72. Click the Show Undeformed Shape button O! to reset the window title. 

A73. From the View menu select Show All. 

A 74. Click the drop down box in the status bar to change the units to kip-in. jKJp-m _ i]j 
A 75. From the Define menu select Materials ... to display the Defme Materials dialog box. 

A76. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

A77. In this dialog box: 

• Type 3600 in the Modulus ofElasticity edit box. 

• Verify .2 is entered in the Poisson's Ratio edit box. 

• Click the OK button twice to exit all dialog boxes. 

A78. Click the drop down box in the status bar to change the units to kip-ft jKip-tt :.:J 

A79. From the Define menu select Materials ... to display the Define Materials dialog box. 

ASO. Click on CONC in the Materials area to highlight (select) it, and then click the 
. Modify/Show Material button. The Material Property Data dialog box is displayed. 

A81. In this dialog box: 

• Verify that 4.657E-03 is entered in the Mass Per Unit Volume edit box. 

• Verify that .15 is entered in the Weight Per Unit Volume edit box. 

• Click the OK button twice to exit all dialog boxes. 

A82. From the Define menu select Shell Sections ... to display the Define Shell Sections dialog 
box. 

. .. 
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A83. In this dialog box: 

• Click the Modify/Show Section button to display the Shell Sections dialog box. 

• In this dialog box: 

;,. VerifY that the Material is CON C. 

;,. VerifY that both the Membrane and Bending thicknesses are J. 

;,. VerifY that the Shell option is chosen in the Type area. 

;,. Click the OK button twice to exit all dialog boxes. 

A84. From the Define menu select Sta tic Load Cases .•. to display the Define Static Load Case 
Names dialog box. 

A85. In this dialog box: 

• Type DL in the Load edit box. 

• Click the Change Load button. 

• Type LL in the Load edit box: 

• Select Live from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Add New Load button. 

• Click the OK button. 

A86. From the Define menu select Load Combinations ... to display the Define Load Case 
Combinations dialog box. 

A87. In this dialog box: 

• Click the Add New Combo button to display the Load Combination Data dialog box .. · 

• In this dialog box: 

;,. Accept the default Load Combination N ame COMB l. 

;;.. Accept the default Load Combination Type, Add. 

;,. Type COMBl: DL + LL in the Title edit box. 
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'y Verity that DL Load Case appears in the Case N ame drop-down box, and that the 
Scale Factor is l. 

>- Click the Add button. 

';- Select LL Load Case from the Case N ame drop-down box 

';- Click the Add button. 

>- Click OK twice to exit al! dialog boxes. 

A88. Click in the 3-D View window to actívate it. Be careful not to accidentally select any 
members when you do this. 

A89. From the Select menu choose Select and then choose Groups ... from the submenu to 
display the Select Groups dialog box. 

A90. In this dialog box: 

• Click on the HIBARREL group to highlight it. 

• Click the OK button. 

A91. From the Assign menu choose Shell Static Loads ... and then choose Uniform ... from the 
submenu to display the Shell Uniform Loads dialog box. 

A92. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• Type -.3 in the Load edit box. 

• Verity that Global Z is selected in the Dir drop-down box. 

• Click the OK button. 

A93. Click the Show Undeformed Shape button O: to remo ve the display of shell uniform 
loads. 

A94. Click the Run Analysis button _Jto run the analysis. 

A95. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

A96. Click in the window titled Y-Z Plane@ X=20 to actívate it. 

A97. Click the Display Sta tic Deformed Shape button & ¡ on the rnain toolbar to display the 
Deformed Shape dialog box. 
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A98. In this dialog box: 

• Select the DL Load Case from the Load drop-down box. 

• Select the Auto Scaling option. 

• Click the OK button. 

A99. Click the drop down box in the status bar to change the units to kip-in. JKi?"'" ::J! 
Al OO. Right click on the center joint of the upper barre! vault to se e its selfwetght displacement 

in inches. 

Al O l. Right click on the center joint of the lower barre! vault to see its self weight displacement 
in inches. 

Al02. Click the Display Static Deformed Shape button 4'. on the main toolbar to display the 
Deforrned Shape dialog box. -

Al03. In this dialog box: 

• Select the COMBI Combo from the Load drop-down box. 

• Click the.OK button. 

Al 04. Right click on the.center joint ofthe upper barre! vault to see its selfweight plus live load 
displacement in inches. 

Al05. Right click on the center joint ofthe lower barre! vault to see its selfweight plus live load 
displacement in inches. 
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Problem V 
Temperatura Loading 

Steel 
E =29000 ksi 
Poissons Ratio= 0.3 
Coefficient of thermal expansion = 0.0000065 (degrees Fahrenheit) 
Beam-column connections are rigid 
Cable is pinned at each end 

ToDo, 
Determine support reactions and trame displacement dueto a 1 oo· 
Fahrenheit temperatura drop 1n the cable only. 

W24X68 
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Note: Our intent is that you try this problem on your own first. After you have solved it on your 
own, you can step through our solution if desired. Ifyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem V Solution 

l. Click the drop dovm box in the status bar to change the units to kip-ft. ·¡KJ~ 3 
2. From the File menu select New Model From Template .... This displays the Model 

Templates dialog box. . . 

3. ¡ ""' di•lo g ¡,, diok '" <ho Porul F••me<omp '"' 1 ¡ j tllru<ooo m diop lo Y <h• 
Portal Frame dialog box. 

4. In this dialog box: 

• Type 1 in the Number of Stories edit box. 

• Type 1 in the Number of Bays edit box. 

• Type 14 in the Story Height edit box. 

• Type 30 in the Bay Width edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. From the Draw menu select Edit Grid ... to display the ModifY Grid Lines edit box. 

7. In this dialog box: 

• VerifY that the X Direction option is selected. 

• T ype 33 in the X Location edit box. 

• Click the Add Grid Line button. 

• Click the OK button. 

8. Click the xz 2D View button . "' Jon the main toolbar to reset the view. 

9. Click the Set Elements button/-ª.Jon the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

1 O. In this dialog box: 

• Check the Labels box in the Joints area. 

• Check the Labels box in the Frames area. 
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• Click the OK button. 

11. VerifY thatthe Snap to Joints and Grid Points button [-\• Jon the side too! bar is 
depressed. · · 

12. Click the Draw Frame E1ement button '1 on the side toolbar, or select Draw Frame 
E1ement from the Draw menu. 

13. Draw the cable element as fo!lows: 

• Place the mouse pointer onjoint 4. When the text box saying "Grid Intersection" 
appears click the left mouse button once. 

• Move the mouse pointer to to the grid intersection at the bottom ofthe cable (lower 
right-hand grid intersection). When the text box saying "Grid Intersection" appears 
click the left mouse button once. 

• Press the Enter key on the keyboard. 

14. Click the Pointer button ~ to exit draw mode and enter select mode. 

15. Select joints 1, 3 and 5. 

16. From the Assign menu, choose Joint, and then Restraints ... from the submenu. This will 
display the Joint Restraints dialog box. · 

17. In this dialog box: 

• Click the fixed base fast restraint button l.,1,l to set al! degrees of freedom (U 1, U2, 
U3, R 1, R2 and R3) as restrained. 

• Click the OK button. 

18. Click the drop down box in the status bar to change the units to kip-in. IKrp-m :.:J [ 

!9. From the Define menu select Materia1s ... to display the Define Materials dialog box. 
Highlight the STEEL material and click the Modify/Show Material button to display the 
Material Property Data dialog box. 

20. In this dialog box: 

• Verity that the modulus ofelasticity is 29000, poisson's ratio is 0.3 and the coefficient 
ofthermal expansion is 0.0000065. 

• Click the OK button twice to exit the dialog boxes. 

21. From the Define menu select Frame Sections ... to display the Defme Frame Sections 
dialog box. 

·r ¡,·~ 
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22. In the Click To area, click the drop-down box that says Import UWide Flange and then 
click on the Import I/Wide Flange item. 

23. Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. 

24. A dialog box appears with a list of al! wide flange sections in the data base. In this dialog 
box: 

• Scroll down and click on the W24X68 section. 

• Scroll down to the WI4X90 section, and click on it while holding down the Ctrl key on 
the keyboard. 

• Click the OK button twice to return to the Define Frame Sections dialog box. 

25. In the Click To area, click the drop-down box that says Add I/Wide Flange and then click 
on the Add Circle item. 

26. The Circle Section dialog box appears. In this dialog box: 

• Type CABLE in the Section N ame edit box. 

• Type 1 in the Diameter (t3) edit box. 

• Click the OK button twice to exit al! dialog boxes. 

27. Click the drop down box in the status bar to change the units to kip-ft. )~p-h :.:J 

28. Select the beam element (frame element 3). 

29. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

30. In this dialog box: 

• Click on W24X68 in the Frame Sections area to highlight it. 

• Click the OK button. 

3!. Select the two column elements (frame elements l and 2). 

32. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

33. In this dialog box: 

• Click on Wl4X90 in the Frame Sections area to highlight it. 
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• Click the OK button. 

34. Select the cable element (frame element 4). 

35. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

36. In this dialog box: 

• Click on CABLE in the Frame Sections area to highlight it. 

• Click the OK button. 

37. Click the Show Undeformed Shape button O! to remove the displayed frame section 
assignments. 

38. Select the cable element (frame element 4). 

39. From the Assign menu select Frame and then Releases ... from the submenu to display the 
Frame Releases dialog box. 

40. In this dialog box check both the Start and the End boxes for Moment 33 (Major) and then 
click the OK button. 

41. From the Define menu select Static Load Cases ... to display the Define Static Load Case 
N ames dialog box. 

42. In this dialog box: 

• Type O in the SelfWeight Multiplier edit box. 

• Click the Change Load button. 

• Click the OK button. 

43. Select the cable element (frame element 4). 

44. From the Assign menu select Frame Static Loads ... and then Temperature ••. from the 
submenu to display the Frame Temperature Loading dialog box. 

45. In this dialog box: 

• Verify that the Temperature option is selected in the Type area. 

• Verify that the By Element option is selected in the Temperature area. 

• Type -lOO in the Temperature edil box. 

• Click the OK button. 
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46. Click the Show Undeformed S ha pe button O; to remove the displayed temperature 
assignments. 

47. Click the Set Elements buttoni-ª.J on the mam toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

48. In this dialog box: 

• Uncheck the Labels box in the Joints area. 

• Uncheck the Labels box in the Frames area. 

• Click the OK button. 

49. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• !o<hl< dlolog boHHok ilio PI'"' F nmo XZ Plo•• Mwm ¡ ¡ ¡j <o "' <ho 
available degrees of free do m. 

• Click the OK button. 

50. Click the Run Analysis button _J to run the analysis. 

51. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors). Click the OK button to close the Analysis window. 

52. Click the Joint Reaction.Forces button j_I_j to display the Joint Reaction Forces dialog 
box. 

53. In this dialog box: 

• VerifY that the Reactions option is selected in the Type area. 

• Click the OK button. 

54. The reactions are displayed on the screen. You can right click on any joint to see the 
reactions at thatjoint or you canjust read the reactions on the screen. Ifthe text goes offof 
the screen, yo u can use click the Pan buttonl ~' on the main toolbar to move the display, 
or yo u can click the Zoom Out One Step buttonl ~ 1 on the main toolbar as many times as 
required to resize the display. Ifthe text is too sma toread, you can zoom in on the joint, 
or you can change the minimum font size as described in the note below. 

Note: To change the minimumfont size se/ect Preferencesfrom the Options menu and 
make sure the Dimensions Tab is selected. In the Minimum Graphicfont Size edit box 
input a new size, maybe 5 or 6 points. Click the OK button. 
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• Problem W 
Simple Beam With Trapezoidal loads 

S te el 
E =29000 ksi 
Poissons Ratio = 0.3 
Beam = W21X50 

ToDo 
Determine midspan deflection of beam. Ignore the self weight of the beam. 
Create the model as follows: 

1. From the File menu, choose New Model From Template. Select the 
Beam template in the upper left hand cerner. Set the number of 
spans to ene. 

2. Define the trame section properties. 

3. Apply the loads to the beam. 

4. Use the Divide Frames option in the Edil Menu to break the beam 
into two elements with a joint at the center. 

2 klf 

fnltiklf 

6' 

2 klf 

~ 
6' 

1 
2' 1 

30' 

5' 5' 
~ 

1 

Note: Our intent is that you try this problern on your own frrst. After you have sol ved it on your 
own, you can step through our solution if desired. Ifyou ha ve problerns trying to create the 
rnodel, then follow the steps in our solution. 
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Problem W Solution 

l. C1ick the drop do\Vn box in the status bar to change the units to kip-ft. JKlp-ít :.:J 

2. From the File menu se1ect New Model From Temp1ate •... This disp1ays the Mode1 
Temp1ates dialog box. E] 

3. In this dialog box click on the Beam template -Mh · button to display the Beam 
dtalog box. . ·- . · _ . 

4. In this dialog box: 

• Type 1 in the Number of Spans edit box. 

• Type 30 in the S pan Length edit box. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. Click the drop down box in the status bar to change the units to kip-in. JKip-m 3_/ 
7. From the Define menu select Materials .•. to display the Defme Materials dialog box. 

8. Click on STEEL in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Propeny Data dia1og box is disp1ayed. 

9. In this dia1og box: 

• VerifY 29000 is entered in the Modu1us ofE1asticity edit box. 

• VerifY .3 is entered in the Poisson 's Ratio edil box. 

• Accept the other default va1ues. 

• Click the OK button twice to exit all dialog boxes. 

1 O. C1ick the drop down box in the status bar to change the units to kip-ft. JKlp-ít :.:J 

1 1. From the Define menu se1ect Sta tic Load Cases ... to display the Define Static Load Case 
N ames dia1og box. 

12. In this dialog box: 

• Type O in the Se1fWeight Multiplier edit box. 

• Click the Change Load button. 

• 
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o Click the OK button. 

13. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

14. In the Click To area. click the drop-down box that says lmport 1/Wide Flange and then 
click on the Impon 1/Wide Flange item. 

15. Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. 

16. A dialog box appears with a list of all wide flange sections in the database. In this dialog 
box: 

o Scroll down and click on the W21X50 section. 

o Click the OK button three times. 

17. Select the frame element. 

18. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Defme Frame Sections dialog box. 

19. Highlight W21X50 in the Frame Sections area and click the OK button. 

20. Click the Show Undeformed S ha pe button O: to remove the displayed frame section 
assignment. 

21. Select the frame element. 

22. From the Assign menu select Frame Sta tic Loads ... and then Point and U niform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

) 

23. In this dialog box: 

• In the Load Type and Direction area verify that the Forces option is selected and that 
the Global Z direction is selected. 

o In the Point Loads area select the Absolute Distance From End 1 option. 

o In the Point Loads area type 25 in the frrst Distance edit box and type -30 in the first 
Load edit box 

o Click the OK button. 

24. Select the frame element. 

25. From the Assign menu select Frame Static Loads ... and then Trapezoidal ... from the 
submenu to display the Trapezoidal S pan Loads dialog box. 

.~· . " 
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26. In this dialog box: 

• In the Load Type and Direction area verify that the Forces option is seiected and that 
the G loba! Z direction is selected. 

• In the Trapezoidal Loads area select the Absolute Distance From End 1 option. 

• In the Trapezoidal Loads area type 2 in the first Distance edit box and type -2 in the 
frrst Load edit box 

• Type 2 in the second Distance edit box and type -2 in the second Load edil box 

• Type 8 in lhe third Distance edit box and lype -1 in the third Load edil box 

• Type 8 in lhe fourth Distance edil box and lype -1 in lhe fourth Load edit box 

• Click lhe OK button. 

27. Selecl lhe frame element. 

28. From lhe Assign menu select Frame Sta tic Loads ... and then Trapezoidal ..• from the 
submenu to display the Trapezoidal S pan Loads dialog box. 

29. In this dialog box: 

30. 

31. 

• In the Trapezoidal Loads area lype 10 in lhe firsl Dislance edil box and lype O in lhe 
frrsl Load edil box 

• Type 12 in the second Dislance edit box and lype -1 in lhe second Load edil box 

• Type 18 in the third Dislance edit box and type -2 in the third Load edit box 

• Type 20 in the fourth Distance edit box and lype O in the fourth Load edit box 

• Click the OK button. 

Selecl the frame eiement. 

From the Edit m en u select Divide Frames .•. to 
display the Divide Selected Frames dialog box. 
Verify that the dialog box appears as shown in 
the figure and click the OK button. The frame 
element is broken into lwo elements with a joint 
at the center. Note that the frame loading did not 
change. 

Divide Selected F1ame• · 

'·. -· .. ·'·. 

l; <:·'.~ :;:;:;~i .. "':~,...· .-... - Frame; 

• • -.. ': '·';;; ~. - d' • ' : ; ··r Sreak al inle~sectioo;. willi oelecled 
·; ·· Frames enc!Jornts ::: ·. :: •. · ·· 

' . 

32. Click the Show Undeformed Shape button 0\to remove the displayed frame static load 
assignments. 
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33. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Jo 1hi' dio log boH lk k dm Pl•o• F nmo XZ ••"' bortoo ¡ ¡ ¡ 1 '" ~libo 
available degrees of freedom. 

• Click the OK button. 

34. Click the Run Analysis button _Jto run the analysis. 

35. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors) and then click the OK button to close the Analysis window. 

36. Right click on the center joint to see its displacement in feet. 

37. Click the drop down box in the status bar to change the units to kip-in. IK,p..;n j_[ 

38. Right click on the center joint to see its displacement in inches. 

5 
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Problem X 
Through Truss Bridge 

Steel 
E =29000 ksi 
P01ssons Ratio = 0.3 
All members are W6X12 
Fy = 36 ksi 

Concrete Bridge Deck 
E =3600 ksi 
Poissons Ratio = 0.2 
12 inches thick 
Uve Load = 250 psf 

ToDo 
Review steel member stresses dueto self weight plus live load. 
Use AISC-ASD89. 

12' 12' 12' 

12' 
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Problem X Solution !J 

File New Model From Template ... 

Vortkol Tru" MXM 1 

• 

• 

• 
• OK 

Select AH 

Edit Replicate ... 

• 

• 12 

• 

• 

• OK 

Draw Edit Grid ... 

• 

• 12 Add Grid Line 

• OK 

2 



xy 2D View liJ 

y 

--~•----------~1-F--~~~M~-------1 
A 

G 
D B 

E 

----
l~tt 

Quick Draw Frame Element Quick 
Draw Frame Element Draw 

Click on the grid lines at the points labeled "A", "B", "C" and "D" in Figure X-1 to enter 
four frame elements spanning between the two vertical frames. 

14. Click on the grid lines at the points labeled "E", "F'' and "G" in Figure X-1 to enterthree 
sets of diagonal frame elements spanning between the two vertical frames. 

15. Click the Down One Gridline buttonl~ on the main toolbar to display the X-Y Plane@ 
Z=O. The screen appears as shown in Figure X-2. 

16. Click the Quick Draw Rectangular Shell Element button 81 on the si de toolbar ( or 
select Quick Draw Rectangular Shell Element from the Draw menu). 
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1 
"' X 

Click on the points labeled "A", "B" and "C" in Figure X-2 to enter three shell elements 
spanning between the two vertical frames. 

18. Click the Pointer button ~ on the side too! bar to exit draw mode and enter select mode. 

19. Click in the window titled X-Y Plane@ Z=O to make sure it is active. 

20. Click the Up One Gridline button ;·-o 1 on the main toolbar to display the plan view at 
Z=l2. 

21. Select the center four joints by clicking on them. 

22. From the Edit menu select M ove ... 

• 3 

• OK 
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Perspective Toggle lw 1 

Set lntersecting Line Select Mode Ni[j 
elements by "drawing" a line through them. There should now be 1 O frames and 3 shells 
selected. You can verify this by looking at the left-hand side ofthe status bar at the bottom 
ofthe SAP2000 window. 

26. From the Edit menu select Divide Frames ... 

• 

• OK 

xz2DView ~ 

Perspective Toggle lw 1 

Set Intersecting Line Select Mode Ni[j 
diagonal elements by "drawing'' a line through them. There should now be 20 frames 
selected. You can verify this by looking at the left-hand side ofthe status bar at the bottom 
ofthe SAP2000 windo"w. 

31. From the Edit menu select Divide Frames ... 

• 

• OK 

xz2DView ~ 

1 Ki p-m :::J_ 1 

Define Materials ... 

Modify/Show Material 
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• 

• Verify that Poisson's Ratio is 0.3. 

• Verify that the steel stress, Fy is 36. 

• Click the OK button. 

38. Click on CONC in the Materials area to highlight (select) it. and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

39. In this dialog box: 

• Verify that the Modulus ofElasticity is 3600. 

• Verify that Poisson's Ratio is 0.2. 

• Click the OK button twice to exit all dialog boxes. 

40. Click the drop down box in the status bar to change the units to kip-ft. JKíp-11 ::J 

41. From the Define menu select Materials ... to display the Define Materials dialog box. 

42. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

43. In this dialog box: 

• Verify that the Weight per Unit Volume is 0.15. 

• Click the OK button twice to exit all dialog boxes. 

44. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. • 

45. In this dialog box: 

• In the Click To area, click the drop-down box that says Import l!Wide Flange and then 
click on the Import I/Wide Flange item. 

• Ifthe Section Property File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections.pro and click the Open button. 

• A dialog box appears with a list of all wide flange sections in the database. In this 
dialog box: 

.J 

6 



-, Scroll down and click on the W6Xl2 section. 

-, Click the OK bunon three times to exit all dialog boxes. 

46. From the Define menu select Shell Sections ... to display the Define Shell Sections dialog 
box. 

47. In the Click To area, click the Modify/Show Section button to display the Shell Sections 
dialog box. 

48. In this dialog box: 

• 

• 

• 

• OK 

Select AII ~ 

Assign Frame Sections ... 

• 
• OK 

Show Undeformed Shape O [ 

Define Sta tic Load Cases ... 

• DL 

• Change Load 

• LL 

• 
• o 

··' 
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• Add New Load 

• OK 

Select All ~ 

Assign Shell Static Loads ... Uniform ... 

• 

• -.25 

• 

• OK 

Show Undeformed Shape O 1 

Click the "X" in the upper right-hand comer ofthe window labeled X-Z Plane@ Y=O to 
clase it. 

60. Click the Run Analysis button _J to run the analysis. 

61. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to clase the Analysis window. 

62. From the Options menu se lec! Preferences ... to display the Preferences dialog box. 

63. In this dialog box. 

• Click on the Steel Tab 

• Select A!SC-ASD89 from the Steel Design Code drop-down box ifit is not already 
selected. 

• Click the OK button. 

64. From the Design menu click Start Design/Check Of Structure to run the design check of 
the steel frame elements. 

65. When the design check completes, the stress ratios are displayed. 
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Problem Y 
Response Spectrum Analysis For Single Degree of Freedom System 

System 

~ k= _.?4_klin lA 

r"~ = 1 k-sec2/ in 

ToDo 
Perform a response spectrum analysis of lhis single degree of freedom system 
using the built-in 1994 UBC 51 spectrum. Compare the period with the 
calculated period below. Compare the spring force with the response 
spectrum below. 

T = 27t J~ = 27t J 6~ = 0.7854 seconds 

Note: 1.25 g • 386.4 in/sec2 = 483 in/sec2 
1 g 

1994 UBC 51 Spectrum 
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Note: Our intent is that you try this problem on your own first. After yo u have solved it on your 
own, you can step through our solution if desired. Ifyou ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem Y Solution 

I. Ciick the drop down box in the status bar to change the units to kip-in. JK!p-m :.:J.I 

2. From the File menu select New Model ..•. This displays the Coordinate System Definition 
dialog box. 

3. In this dialog box 

• Select the Cartesian Tab. 

• In the Number ofGrid Spaces area type O in the X direction edit box. 

• In the Number of Grid S paces area type O in the Y direction edit box. 

• In the Number ofGrid Spaces area type O in the Z direction edit box. 

• Ciick the OK button. 

4. Ciick the "X" in the upper right-hand comer ofthe window labeied 3-D View to close it. 

5. Ciick the Draw Special Joint button ...:Jon the side toolbar or select Add Speciai Joint 
from the Draw menu. 

6. Click on the grid intersection at the origin to entera joint. 

7. Ciick the Pointer button JiJ to exit Draw Mode and enter Seiect Mode. 

8. Seiect the joint by ciicking on it. 

9. From the Assign menu seiect Joint and then Springs ... from the submenu to display the 
Joint Springs dialog box. 

I O. In this dialog box: 

• Type 64 in the Translation I edit box. 

• Click the OK button. 

1 I. Select the joint by clicking on it. 

12. From the Assign menu select Joint and then Masses ... from the submenu to display the 
Joint Masses dialog box. 

13. In this dialog box: 

• In the Masses in Local Directions area type 1 in the Direction 1 edit box. 

,J 
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18. When the ana1ysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. Note 
thatthe 3-D window now shows the first mode shape. 

19. Note thatthe period is reported in the window title. It should be 0.7854 seconds. 

20. From the Display menu select Show Element Forces/Stresses and then Joints ... from the 
submenu to display the Joint Reaction Forces dialog box. 

21. In this dialog box: 

• Select SPEC 1 Spectra from the load drop-down box. 

• In the Type area selectthe Spring Forces option. 

• Click the OK button. 

22. lfthe axes make it difficult toread the spring force, then from the View menu select Show 
Axes to toggle the axes display off. 
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• Click the OK button. 

14. From the Define menu se!ect Response Spectrum Cases ... to display the Define Response 
S pectra dial o g box. 

15. In this dialog box: 

• Click the Add New Spectra button to display the Response Spectrum Case Data dialog 
box. 

• In this dialog box: 

;¡;. Accept the default Spectrum case name, SPEC l. 

);;- Accept the default Excitauon Angle, O. 

);;- Accept the default Modal Combination option, CQC. 

);;- Type .05 in the Damping edit box. 

);;- Accept the default Directional Combination option, SRSS. Note that this option is 
irrelevant in this example since the response spectrum is run in only one direction. 

);;- In the Input Response Spectra area select UBC94Sl from the U! Function drop­
down box. 

;¡;. In the Input Response Spectra area type 3 86.4 in the U 1 S cale factor edit box. 

;¡;. Click the OK button twice to exit al! dialog boxes. 

16. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Uncheck al! ofthe Available DOFs check boxes except for UX. 

• VerifY the the Dynamic Analysis check box is checked. 

• Click the Set Dynamic Parameters button to display the Dynamic Analysis 
Parameters dialog box. 

• In this dialog box: 

;¡;. VerifY that the Number ofModes is l. 

;¡;. VerifY that the Eigenvectors option is selected in the Type of Analysis area. 

);;- Click the OK button twice to exit all dialog boxes. 

17. Click the Run Analysis button _J to run the analysis. 

3 
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• Problem Z 
Response Spectrum Analysis 

Building Description 
The building is a four-story concrete shear wall building with concrete flat slabs 
supported by concrete columns. There is a 30 foot high steel fiagpole on the 
roof at one corner of the buildmg. A 250 pound man sits on top of the flagpole. 

Steel 
E =29000 ksi 
Poissons Ratio= 0.3 
Flagpole is 3" 0 standard pipe 

Concrete 
E =3600 ksi 
Poissons Ratio= 0.2 
Walls are 12" thick 

} b 
(") 

b 
(") 

-rl 

b Col umns & beams are 20" x 20" ..,. 
Floors & roof are 1 O" thick flat slab 

Response Spectrum Loadinq 
X-Dir (U1): 1994 UBC S2 
Y-Dir (U2): 30% of 1994 UBC S2 

Assumptions 
Diaphragms are rigid in plane. 
Columns are fixed base. 
Consider the mass of the 
250 pound man which is 
0.00065 kip-sec2/in. 

ToDo 
Determine maximum X-direction 
(U 1) displacement at top and 
bottom of the fiagpole for the 
specified response spectrum 
loading. 
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Typical Floor and Roof Plan 

Three Dimensional Perspectiva View 

Note: Our intent is that you try this problem on your own first. After yo u have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to create the 
model, then follow the steps in our solution. 
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Problem Z Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡Klp-ft ::J 
2. From the File menu select New Model From Template .•.. This displays the Model 

3. 

Templates dialog box. lfft@J .... 
In this dialog box click on the Space Frame template bunon . ~ to display the 
Space Frame dialog box. rt111.!. 

4. In this dialog box: 

• Type 4 in the Number of Stories edil box. 

• Type 4 in the Number ofBays Along X edil box. 

• Type 4 in the Number of Bays Along Y edit box. 

• Accept the default Story Height, 12. 

• Type 30 in the Bay Width Along X edit box. 

• Type 30 in the Bay Width Along Y edit box. 

• VerifY that the Restraints and Gridlines check boxes are checked. 

• Click the OK button. 

5. From the Draw menu select Edit Grid ... to display the ModifY Grid Lines dialog box. 

6. In this dialog box: 

• Check the Glue Joints To Grid Lines check box. 

• VerifY that the X option is selected in the Direction area. 

• Click on the -30 grid line in the X Location list box to highlight it. The -30 value 
appears in the X Location edit box. 

• T ype -35 in the X Location edit box and el ick the M ove G rid Line button. 

• Click on the 30 grid line in the X Location list box to highlight it. The 30 value appears 
in the X Location edit box. 

• Type 40 in the X Location edit box and click the M ove Grid Line button. 
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• Select the Y option in the Direction area. 

• Click on the -30 grid line in the Y Location list box to highlight it. The -30 value 
appears in the Y Location edil box. 

• Type -40 in the Y Location edit box and click the Move Grid Line button. 

• Click the OK button. 

7. VerifY that the 3-D View window is active. The window is active when its tille is 
highlighted. 

8. Click the Set Elements buttoni-ª.J on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

9. In this dialog box: 

• Check the Fill Elements check box. 

• Click the OK button.· 

lO. From the View menu select Refresh View to update the 3-D view. 

11. Click in the window labeled X-Y Plane@ Z=48 to activare it. 

12. Click the Set Elements buttoni-ª.J on the main toolbar (or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

13. In this dialog box: 

• Check the Fill Elements check box. 

• Click the OK button. 

14. Click the xz 2D View button "' \on the main toolbar. The view switches to the X-Z plane 
@ Z=60 and appears as shown in Figure Z-1. 

15. Click the Quick Draw Rectangular Shell Element button 01 on the side toolbar. 

16. Click once in each ofthe area labeled "A", "B", "C" and "D" in Figure Z-1 to enter four 
shell elements. 

17. From the View menu select Set 2D View ... to display the Set 2D View dialog box. 

18. In this dialog box: 

• VerifY that the X-Z Plane option is selected. 

• Type -60 in the Y= edit box. 
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Figure Z-1: Screen After Step 14 

• Click the OK button. The screen appears similar to that shown in Figure Z-1 ( except 
that the location is now at Y=-60). 

19. Click once in each ofthe area labeled "E", "F", "G" and "H" in Figure Z-1 to enter four 
shell elements. 

20. From the View menu select Set 2D View ... to display the Set 2D View dia!og box. 

21. In this dialog box: 

• Select the Y -Z Plane option. 

• V erifY that 60 is entered in the X= edit box. 

• Click the OK button. The screen appears as shown in Figure Z-2. 

22. C!ick once in each ofthe area labeled "A", "B", "C" and "D" in Figure Z-2 to enter four 
shell elements. 

23. From the View menu select Set 2D View .•. to display the Set 2D View dialog box. 
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Figure Z-2: Screen After Step 21 

24. In this dialog box: 

• Verity that the Y -Z Plane option is selected. 

• Type -60 in the X= edit box. 

• Click the OK button. The screen appears similar to that shown in Figure Z-2 ( except 
that the location is now at X=-60). 

25. Click once in each ofthe area labeled "E", "F", "G" and "H" in Figure Z-2 to enter four 
shell elements. This completes the drawing of the shear walls. 

26. Click the Pointer button ~to exit draw mode and enter select mode. 

27. From the Define menu select Materiais ... to display the Defme Materials dialog box. 

28. In this dialog box: 

• Highlight the CONC material and click the Modify/Show Material button to display 
the Material Property Data dialog box. 
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• In this dialog box: 

)» VerifY that the Mass per Unit Volume is 4.658E-03. 

:.- VerifY that the Weight per Unit Volume is 0.15. 

)» Click the OK button to return to the Define Materials dialog box. 

• Highlight the STEEL material and click the Modify/Show Material button to display 
the Material Property Data dialog box. 

• In this dialog box: 

:.- VerifY that the Mass per Unit Volume is 0.0152. 

:.- VerifY that the Weight per Unit Volume is 0.489. 

:.- Click the OK button twice to exit al! dialog boxes. 

29. Click the drop down box in the status bar to change the units to kip-in. bjKJ~p'"'""==·-'"3~1 

30. From the Define menu select Materials ... to display the Define Materials dialog box. 

31. In this dialog box: 

• Highlight the CONC material and click the Modify/Show Material button to display 
the Material Property Data dialog box. 

• In this dialog box: 

)>- VerifY that the Modulus ofElasticity is 3600. 

:.- VerifY that Poisson's ratio is 0.2. 

:.- Click the OK button to return to the Define Materials dialog box. 

• Highlight the STEEL material and click the Modify/Show Material button to display 
the Material Property Data dialog box. 

• In this dialog box: 

:.- VerifY that the Modulus ofElasticity is 29000. 

)'- VerifY that Poisson' s ratio is O .3. 

:.- Click the OK button twice to exit al! dialog boxes. 

32. From the Define menu select Frame Sections ... to display the Defme Frame Sections 
dialog box. 
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\ 
33. In this dialog box: 

o In the Click To area, click the drop-down box that says Impon l!Wide Flange and then 
click on the Impon Pipe ítem. 

• lfthe Section Propeny File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. 

• A dialog box appears with a list of all pipe sections in the database. In this dialog box: 

'r Scroll down and click on the P3 (3" diameter standard pipe section) ítem. 

;,. Click the OK button twice to retum to the Define Frame Sections dialog box. 

• In the Click To area, click the drop-down box that says Add I/Wide Flange and then 
click on the Add Rectangular ítem. The Rectangular Section dialog box is displayed. 

• In this dialog box: 

;,. Type BMCOL in the Section Name edit box. 

;,. Select CONC from the Material drop-down box. 

;,. Type 20 in the Depth (t3) edit box. 

~ Type 20 in the Width (t2) edit box. 

;,. Click the OK button twice to exit all dialog boxes. 

34. From the Define menu select Shell Sections ... to display the Defme Shell Sections dialog 
box. 

35. In this dialog box: 

• Click the Modify/Show Section button to display the Shell Sections dialog box. 

• In this dialog box: 

~ Type W ALL in the Section N ame edit box. 

;,. Accept the default CONC material 

;,. In the Thickness area verify that both the Membrane and the Bending thicknesses 
are 12. 

;.. In the Type area verify that the Shell option is selected. 

;,. Click the OK button to retum to the Defme Shell Sections dialog box. 

;,l 
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• Click the Add New Section button to display the Sheli Sections dialog box. 

• In this dialog box: 

~ Type FLOOR in the Section N ame edit box. 

:.- Accept the default CONC material. 

~ Type 10 in the Membrane edit box. 

:.- Type 10 in the Bending edit box. 

» In the Type area verity that the Sheli option is selected. 

» Click the OK button twice to exit ali dialog boxes. 

36. Click the drop down box in the status bar to change the units to kip-ft. jK,p-;o :.:J 

37. Click in the window labeled Y-Z Plane@ X=-60 to verity it is active. 

38. From the View menu select Set 2D View ... to display the Set 2D View dialog box. 

39. In this dialog box: 

• Select the X-Y Plan e option. 

• Verity that 48 is entered in the Z= edit box. 

• Click the OK button. 

40. Click the Set Elements button/li!:f 1 on the main toolbar ( or select Set Elements ... from the 
View menu) to display the Set Elements Dialog box. 

41. In this dialo g box: 

• Check the Labels box in the Joints area. 

• Click the OK button. 

42. Click the Draw Rectangular Shell Element button ]5] on the side toolbar or select Draw 
Rectangular Shell Element from the Draw menu. 

43. Click on joint 25 and then joint 105 to entera single sheli element for the entire floor. 

44. Click the Pointer button Jijto exit draw mode and enter select mode. 

45. Select ali elements in the X-Y Plane@ Z=48 by "windowing". 

46. From the Edit menu select Mesh Shells ••. to display the Mesh Selected Shelis dialog box. 
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4 7. In this dialog box: 

• Select the mesh Using Selected Joints on Edges option. 

Note: The Mesh At lntersections With Grids option would work equally we/1. 

• Click the OK button. 

48. Select all elements in the X-Y Plan e@ Z=48 by "windowing". 

49. From the Assign menu select Shell and then Sections ... from the submenu to display the 
Define Shell Sections dialog box. 

50. In this dialog box: 

• Highlight the FLOOR section by clicking on it. 

• Click the OK button. 

51. Click the Show Undeformed Shape button O 1 to remo ve the displayed shell section 
assignments. 

52. Click the Restore Previous Selection button ~~ on the side toolbar (or select Get 
Previous Selection from the Select menu). 

53. From the Edit menu select Replicate ... to display the Replicate dialog box. 

54. In this dialog box: 

• Verity the Linear Tab is selected. 

• In the Distance area type -12 in the Z edit box. 

• VerifY that O is entered in the X and Y edit boxes. 

• Type 3 in the Number edit box. 

• Click the OK button to proceed with the replication and create the other floor 
diaphragms. 

55. Click the Restore Previous Selection button ~~ on the side toolbar (or select Get 
Previous Selection from the Select menu). 

56. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

57. In this dialog box: 

. ¡ 
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• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

;¡.. Type ROOFDIA in the Constraint N ame edit box. 

;¡.. Select the Z Axis option in the Constraint Axis area. 

;¡.. Click the OK button twice to exit all dialog boxes. 

58. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@ Z=36. You can confirm the elevation by looking on the right-hand side ofthe staus bar 
at the bottom ofthe SAP2000 window. 

59. Select all elements at this leve! by "windowing". 

60. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

61. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

;¡.. Type 4THDIA in the Constraint N ame edit box. 

;¡.. Select the Z Axis option in the Constraint Axis area. 

;¡.. Click the OK button twice to exit all dialog boxes. 

62. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@Z=24. 

63. Select all elements at this leve! by "windowing". 

64. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

65. In this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

);> Type 3RDDIA in the Constraint N ame edit box. 
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-, Select the Z Axis option in the Constraint Axis area . 

.,_ Click the OK button twice to exit al! dialog boxes. 

66. Click the Down One Gridline button ~ to move the plan display down to the X-Y Plane 
@Z=l2. 

67. Select al! elements at this leve! by "windowing". 

68. From the Assign menu select Joint and then Constraints ... from the submenu to display 
the Constraints dialog box. 

69. ln this dialog box: 

• In the Click To area click the drop-down box and select Add Diaphragm to display the 
Diaphragm Constraint dialog box. 

• In this dialog box: 

.,_ Type 2NDDIA in the Constraint Name edit box. 

-, Select the Z Axis option in the Constraint Axis area. 

-, Click the OK button twice to exit al! dialog boxes. 

70. Click the Down One Gridline button -o 1 to move the plan display down to the X-Y Plane 
@Z=O. 

71. Select al! elements at this leve! by "windowing". 

72. From the Assign menu select Joint and then Restraints ... from the submenu to display the 
Joint Restraints dialog box. 

73. In this dialog box: 

• Click the Fixed Support buttonl_ J.: in the Fast Restraints area. 

• Click the OK button. 

74. Click the Select All button-ª.] on the side toolbar to select al! elements. 

75. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Defme Frame Sections dialog box. 

76. In this dialog box: 

• Click on BMCOL in the Frame Sections area to highlight it. 

• Click the OK button. 
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77. Click the Show Undeformed Shape button O 1 to remove the displayed frame section 
assignments. 

78. From the View menu select Set 2D View ... to display the Set 2D View dialog box. 

79. In this dialog box: 

• Select the X-Z Plane option. 

• Verify -60 is entered in the Y= edil box. 

• Click the OK button. 

80. From the Draw menu select Edit Grid ... to display the Modify Grid Lines dialog box. 

81. In this dialog box: 

• Select the Z option in the Direction area. 

• Type 78 in the Z Location edit box and click the Add Grid Line button. 

• Click the OK button. The screen appears as shown in Figure Z-3. 

82. Click the Quick Draw Frame Element button ...._, on the side toolbar or select Quick 
Draw Frame Element from the Draw menu. 

83. Click on the grid line at the point labeled "A" in Figure Z-3 to enter the flagpole frame 
element. 

84. Click the Pointer button J;tjto exit draw mode and enter select mode. 

85. Click on the frame element to select it. 

86. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. 

87. In this dialog box: 

• Click on P3 in the Frame Sections area to highlight it. 

• Click the OK button. 

88. Click the Show Undeformed Shape button O/ to remove the displayed frame section 
assignments. 

89. Click the drop down box in the status bar to change the units to kip-in. jt<Jp·m ::J 1 

90. Click on the joint at the top ofthe flagpole to select it. 
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Figure Z-3: Screen After Step 81 

91. From the Assign menu select Joint and then Masses ... from the submenu to display the 
Joint Masses dialog box. 

92. In this dialog box: 

• Type .00065 in the Direction 1, Direction 2 and Direction 3 edit boxes. 

• Click the OK button. 

93. Click the Show Undeformed S ha pe button O [ to remove the displayed joint rnass 
assignments. 

94. Click the drop down box in the status bar to change the units to kip-ft. /K<p-t¡ iJ 

95. Click the Set Elements buttonl~on the rnain toolbar (or select Set Elements .•. from the 
View menu) to display the Set Elements Dialog box. 

96. In this dialog box: 

• Uncheck the Labels box in the Joints area. 
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• Click the OK button. 

97. From the Define mem.i select Response Spectrum Cases .•• to display the Define Response 
Spectra dialog box. 

98. In this dialog box: 

• Click the Add New Spectra button to display the Response Spectrum Case Data dialog 
box. 

• In this dialog box: 

¡;. Accept the default Spectrum case na me, SPEC l. 

¡;. Accept the default Excitation Angle, O. 

¡;. Accept the default Modal Combination option, CQC. 

¡;. Type .05 in the Damping edit box. 

¡;. Accept the default Directional Combination option, SRSS. 

¡;. In the Input Response Spectra area select UBC94S2 from the U 1 Function drop­
down box. 

¡;. In the Input Response Spectra area type 32.2 in the Ul Scale factor edit box. 

¡;. In the Input Response Spectra area select UBC94S2 from the U2 Function drop­
down box. 

¡;. In the Input Response Spectra area type 9.66 (0.3 * 32.2 = 9.66) in the U2 Scale 
factor edit box. 

¡;. Click the OK button twice to exit all dialog boxes. 

99. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• Verif)r the the Dynamic Analysis check box is checked. 

• Click the Set Dynamic Parameters button to display the Dynamic Analysis 
Parameters dialog box. 

• In this dialog box: 

¡;. Type 20 in the Number ofModes edit box. 

¡;. In the Type o f Analysis area select Ritz Vectors. 

¡;. Click on ACCEL Z in the Ritz Load Vectors list box to highlight it. 
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• r Click the Remove button to remove ACCEL Z from the Ritz Load Vectors list box . 
ACCEL X and ACCEL Y should remain in the Ritz Load Vectors list box. 

r Click the OK button twice to exit all dialog boxes. 

1 OO. Click the Run Analysis button _J to run the analysis. 

10 l. When the analysis is complete check the messages in the Analysis window (there should be 
no wamings or errors). Click the OK button to close the Analysis window. 

102. Click in the window labeled X-Z Plane@ Y=-60 to make sure it is active. 

103. Click the Display Static Deformed Shape button J A (or select Show Deformed Shape ... 
from the Display menu). The Deformed Shape dialog box appears. 

104. In this dialog box: 

• Select SPEC1 Spectra from the Load drop-down box. 

• Click the OK button. 

105. Right click the joints at the top and bottom ofthe flagpole to see their displacements. 

Note: Jf the top of the jlagpo/e goes off of the screen when the deformed shape is 
displayed, then click the Zoom Out One Step buuon 1131 on the m a in too/bar as many 
times as required 10 bring the joint back on lo the screen. 
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-S"AP2000 

SAP2000 represents the state-of-the-art 1n three dimensional fin1te element technology for structural engmeering. This 
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buildrngs. The W1ndows based graph1cal rnterface allows for qu1ck model creatJon ustng templates The creat1on and 
modification of models, execution of the analys1S, viewing of the results, and design optimization are all performed 
1nteractively withm the same interface 

Analysis Options 
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modal comb1nations by the SRSS. the CQC or the GMC method. Veh1cle hve load generation for truck, Jan e and train 
Joading is also available. 

Design Options 
lntegrated design capabilit1es indude steel member (AISC-ASD and LFRO) selection and opt1mization, as well as 
reinforcmg calculations for concrete members (ACia89). 

Nonl1near Pushover 
New computational techn1ques have been integrated into SAP2000 Non linear Version 7 to allow a Static Pushover 
analysis to be performed in a simple and practJcal manner. Nonlinear hinges may be defined anywhere 1n the Frame 
elements, and propert1es may be u ser defined or calculated automatJcally by the program. Analyses may be force or 
displacement controlled. and results are available in both graphical and table form. The follow1ng are sorne of the 
highlights of·SAP2000/NL·PUSH The Only 3 Dimensional Oes1gn Tool for Performance Based Des1gn of Steel and 
Concrete Structures Nonlmear pushover analysis based on ATC-40 and FEMA -273 is fully mtegrated mto the SAP2000 
Windows Analysis and Design Graphical U ser Interface. Same model can also be u sed for Stat1c, Dynamic and Nonlinear 
Time History analysis. Nonhnear Pushover Analysis results can be used with the integrated steel and concrete design 
postprocessor opt1ons. Default and u ser defined Moment, Shear, Axial and PMM hinges at any Jocation along a trame 
member. Pushover Output 1s displayed and ava1lable Step by Step '" both graph1cal and text formats. Highly mteractlve 
capacity spectrum curve display form allows study of the effects of parameter changes instantaneously. 
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Three Available Versions Windows 95/98/NT/2000 
• SAP2000 Standard • Program offers Static and Dynamic Response Spectrum Analys•s for Frame and Shell Elements, 
along with Steel and Concrete Frame Design. 
Capacity· 1500 Nades 
• SAP2000 PLUS· Offers all of the same features as the Standard version Plus Dynamic Time Hlstory Analysis, Plane, 
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PDF Brochure 
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l. Terminologv For SAFE Method of Calculating Punching Shear 

The following tenns are used in describing the SAFE method of calculating punching shear: 

bo 
d 

lxx 

]yy 

L 
Mux 
Muv 
V u 
V u 
X¡, y¡ 
X2, Y2 

X), Y3 

x.., Y4 
Yvx 
Yvv 

= perimeter of critica! section for punching shear 
effective depth at critica! section for punching shear based on average of d for X 
direction and d for Y direction 
Moment of inertia of critica! section for punching shear about an axis that is parallel to 
the global X-axis 

= Moment of inertia of critica! section for punching shear about an axis that is parallel to 
the global Y-axis 

= Product of inertia of critica! section for punching shear with respect to the X and Y 
planes 

= Length of side of critica! section for punching shear currently being considered 
= Moment about line parallel to X -axis at center of column (positive per right-hand rule) 
= Moment about line parallel to Y -axis at center of column (positive per right-hand rule) 
= Punching shear stress 
= Shear at center of column (positive upward) 
= Coordinates of column centro id 
= Coordinates of center of one side of critica! section for punching shear 

Coordinates of centroid of critica! section for punching shear 
Coordinates oflocation where you are calculating stress 
Percent of Mux resisted by shear per ACI 318-95 equations 11-41 and 13-1 

= Percent of Muv resisted by shear per ACI 318-95 equations 1 1-41 and 13-1 

2. Basic Eguations For SAFE Method of Calculating Punching Shear 

V u J1'x[Mux- Vu(y¡- )'1)][Irr(y'- y¡)- Ixr(x'- Xl)] 
vu=--+ -

bod l>cdrr- Ixr 2 

/'M[ Mur+ Vu(x¡- X1)] [lxr(x'- Xl)- Ixr()'4- )'l)] 

Ixxlrr- In' 

Eq. 1 

Ixx = I l xr, where sides refers to the sides of the critica! section for punching shear Eq. 2 
s1des = 1 

" -
In·= ¿In·, where si des refers to the sides ofthe critica! section for punching shear Eq. 3 

s1des = 1 

" -
Ixr = L I xr, where si des refers to the si des of the critica! section for punching shear Eq. 4 

.ndes= 1 
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-· -· -
The equations for lxx, Jyy, and lXY are different depending on whether the side ofthe critica! 

section for punching shear being considered is parallel to the X-axis or parallel to the Y -axis. 
Refer to Figures la and lb. 

Critica! section for x, - x3 

punching shear \ 
shown by heavy lme 

Centroid of entire 
critica! section for ---~-~~iJ.­
punching shear. 
Coordinates are (x3,y3). - -

Side of critica! section 
being considered 
shown solid 

Center of side of critica! 
section being considered. $<>e·,.,.,,,, 

Figure 1 b: Plan View For Si de of Critica! Section Parallel to Y -Axis 
Work This Sketch With Equations 5b, 6b and 7 

Critical section for 
punching shear shown 
by heavy line. Side of \ 
critica! section being 
considered shown solid 

Centroid of entire 

1 
1 

critica! section for --
1
¡---=f.t!Ht--.­

punching shear. 
Coord1nates are (x3,y3). 

L 

y,- Y3 

Center of side of critica! 
section being considered. 
Coordinates are (x2 ,y2). 

Figure 1a: Plan View For Side of Critica! Section Parallel to X-Axis 
Work Th1s Sketch With Equations 5a, 6a and 7 

Ixx = Ld(y2- y¡) 2
, for si de of critica! section parallel to X-axis Eq. 5a 

To: = Ld' + dL' + Ld(y2- y¡) 2 , for side of critica! section parallel to Y-axis 
12 12 

Eq.Sb 

¡,.,. = Ld' + dL' + Ld(x2- xJ) 2 , for side of critica! section parallel to X-axis 
12 12 

Eq. 6a 

In = Ld ( x2 - XJ) 
2 

, for si de of critica! section parallel to Y -axis Eq.6b 

Ixr = Ld(x2- Xl)(y¡- )'l), for side of critica! section parallel to X-axis or Y-axis Eq. 7 
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3. Limitations of Punching Shear Calculations in SAFE 

• The shear and moment values used in the punching shear check have not been reduced by the 
load ( or reaction) that is included within the boundaries of the punching shear critica! section. 
Typically the effect ofthis simplification is small except in sorne cases for deep slabs (e.g., 
mat foundations) and slabs with closely spaced columns. 

• Punching shear is calculated for columns punching through a slab ora drop panel. It is not 
caiculated for a drop panel punching through a slab. The effect of column capitals is 
included in the punching shear calculation. 

• The program checks that each slab element in the are a enclosed between the fa ce of the 
column and the critica! section for punching shear has identically the same slab property 
la be l. Jf so, the punching shear check is performed, if not, punching shear is not calculated 
and N/C is displayed. 

• When line objects (beams, walls or releases) frame into a column, punching shear is not 
calculated and N/C is displayed. 

• lf a point load or column falls ( call it load/column A) within the critica! section for punching 
shear for another point loador column (call it load/column B), then it is ignored in the 
punching shear calculation (that is, the effect of load/columnA is ignored when doing 
punching shear calculations for load/column B.) 

• The program only considers critica! sections for punching shear that have sides parallel to the 
X and Y axes. Thus when the edge of a slab is not parallel to the X or Y axis, the program 
may not pick up the worst case critica! section for punching shear. For example, in Figure 2, 
the critica! sections for punching shear identified in Cases A and B are considered by SAFE, 
but CASE C is not considered. 

Critrca! section for 
punching shear 
shown dashed 

Case A 
Cons1dered by SAFE 

Case 8 
Considered by SAFE 

Critrcal section for 
punching shear 
shown dashed 

' 
' ' 

' ' ' ,, 

CaseC 
Not Considered by SAFE 

Figure 2: Critica! Sections For Punching Shear Considered By SAFE 
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4. Other Comments 

Equation 1 is based on Chapter 8, Section 50 of S. Timoshenko's book titled "Strength of 
Materials" (Re f. 1) and on the requirements of codes such as ACI 318-95. 

For interior columns and edge colurnns the punching shear formulation used in SAFE yields the 
same results as those that are obtained using the equations given in Figure 18-16 of the PCA 
Publication (Ref2). The results are different for comer columns. The reason for the difference 
is the lxv term that is included in the SAFE equations but not in the PCA equations. For interior 
columns and edge columns the lxv term included in the SAFE formulation reduces to zero. The 
lxv term is nonzero for comer columns because the X and Y axes are not the principal axes for 
this section. If the Ixv term in the SAFE equations is set to zero, then the SAFE equations yield 
the same results for comer colurnns as the PCA equations. (Note that there is no way to acrually 
set the Ixv term to zero in SAFE.) lt could be argued that the SAFE formulation is perhaps more 
theoretically sound than the equations given in the PCA Publication. The net effect ofthe Ixv 
term is to make the SAFE punching shear calculation for comer columns a little more 
conservative than that given in the PCA Publication. 

5. References 

l. S. Timoshenko, 1958 
Strength ofMaterials, Par/ 1, 3rd Edition, D. Van Nostrand Company, New York, New 
York. 

2. PCA, 1996 
Notes On ACI 318-95 Building Code Requirements For Structural Concrete With Design 
Applications, Portland Cement Association, Skokie, Illinois. 
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6. Numerical Example 

6a. Problem Statement 

The numerical example is a flat slab with drop panels that has three 24' spans in each direction, 
as shown in Figure 3. The slab overhangs beyond the face ofthe column by 6" along each side 
ofthe strucrure. The columns are typically 12" x 36" with the long side parallel to the Y -axis. 
The slab is typically 10" thick. At the drop panels there is an additional5" ofslab thickness. thus 
the total slab thickness at the drop panels is 15". The plan dimensions ofthe interior drop panels 
are 8' x 8', the edge drop panels where the edge is parallel to the X-axis are 8' x 6', the edge drop 
panels where the edge is parallel to the Y-axis are 5' x 8', and the comer drop panels are 5' x 6'. 

The concrete has a unit weight of 150 pcf and a fe of 4000 psi. The dead load consists of the self 
weight of the structure plus an additional 20 psf. The live load is 80 psf. 

Thick plate properties are used for the slab. 

Each column in Figure 3 is referenced with a number. For example, the column at the 
intersection of grid lines A and 1 is number 5. These numbers refer to the point object ID's in 
the associated SAFE model 

1 O'" thick flat slab with 
drop panels 

..l-1---Total slab thickness at 
drop panels is 15'" 

Columns are 12'" x 36'" 
with long side parallel to 
the Y -axis, typical 

Concrete Properties 
Unit weight = 150 pcf 
fe= 4000 psi 

Loading 
DL = Self weight + 20 psf 
LL = 80 psf 

Figure 3: Flat Slab With Drop Panels For Numerical Example 
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6b. SAFE Computer Model 

In SAFE it is easy to create a compuler model for lhis example, analyze il, design il, and prinl 
out lhe punching shear results. The following sleps are required: 

l. Set lhe unils lo kips and feel. 

2. From the File menu select New Model From Templale, and then click on lhe Flal Slab 
butlon to display the Flal Slab dialog box. 

3. In this dialog box: 

• Change the Top Edge Distance and Boltom Edge Dislance lo 2. 

• Check the Creale Live Load Pattems check box. 

• Accept lhe rest ofthe default values and click the OK bulton. 

4. From the Define menu select Slab Properties to display the Support Properties dialog 
box. Highlight the property named COL. click the Modify\Show Property bullon lo 
display the Slab Property Data dialog box, check the Thick Plate check box and click 
OK. Highlight the property named DROP, click the Modify\Show Property bullon to 
display the Slab Property Data dialog box, check the Thick Plale check box and click 
OK. Highlighl the property named SLAB, click the Modify\Show Property button lo 
display the Slab Property Data dialog box, check lht Thick Plale check box and click OK 
twice to exil all dialog boxes. 

5. From the Define menu select Column Supports to display the Support Properties dialog 
box. With the support property named COLUMN highlighted click the Modify\Show 
Property button to display the Column Support Property Data dialog box. In this dialog 
box change the Y Dimension to 3. Accept the resl ofthe default values and click the OK 
button twice to exit all dialog boxes. 

6. The SAFE model is now crealed and ready to run. From the Analyze menu select Run 
Analysis. Select a directory and provide a name for the input file and then click the Save 
button to proceed with the anal ysis. 

7. When the analysis is completed review the messages in the Analysis window and click 
lhe OK button. The model is now ready for design. 

8. From the Options menu select Preferences and click the Concrete tab. V erity that the 
Concrete Design Code selected is ACI 318-95. Ifnecessary, change the selection to this 
code. Click the OK button to exil this dialog box. 

9. From the Design menu select Start Design. 
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1 O. When the design is complete click Display Punching Shear Ratios on the display menu to 
show the punching shear results graphically. 

11. Change the units to kips and inches. 

12. From the File menu select Print Design Tables to display the Design Tables dialog box. 

13 In this dialog box: 

• In the Design Output area uncheck the Slab Strip Reinforcing check box and check 
the Punching Shear check box. 

• In the Design Forces area uncheck the Slab Strip check box. 

• Check the Print To File check box. Note that the default name for this file is the 
name ofyour model with a .txt extension. Accept this default name. 

• Click the OK button to create the punching shear output. 

The punching shear output is now in a text file whose name is the same as your input file with 
the extension .txt. You cari open this text file in any text editor or word processor, or you can 
use the Display Input/Output Text Files feature on the File menu in SAFE to open it. This 
feature opens the file in Wordpad, a text editor that is supplied with Windows. Ifyou open this 
text file in a word processor ora spreadsheet it should look similar to that shown in Figure 4. 

SAFE v6. H F::.le: PUNCHEX Klp-in Units PAGE 1 
Novemoe~ 1~,1998 7.59 

P U N C H I N G S H E A R STRESS C H E C K 

POINT X y RATIO COMBO VMAJ( VCAP V MX MY DEPTH PERIM LOe 

5 o.oo 0.00 l. 000 DCON2 o .179 0.179 -54 .696 -1962 1145.680 13.500 73.500 
6 288.00 0.00 O. 802 DCON2 o .144 0.179 -ll9.738 -3778 -348.558 13.500 123.000 
7 576.00 O.O.Q o. 802 DCON2 0.144 0.179 -119.739 -3778 348.558 13.500 1~3.000 

a 864.00 o.oo 1.000 DCON2 0.179 o .179 -54.696 -1962 -1146 13.500 73. sao 
9 o.oo 288.00 0.515 DCON2 o. 092 o .179 -94.860 174.953 1463.801 13. so o 99.000 

10 288.00 288.00 0.702 DCON2 0.126 o. 179 -225 707 464.658 -419.712 13.500 150.000 
ll 576.00 288.00 0.702 DCON2 o .126 o .179 -225.707 464.658 419.712 13.500 150.000 

" 864.00 288.00 0.515 DCON2 o 092 0.179 -94.860 174.953 -14 64 13.500 99.000 

13 o 00 576.00 0.515 DCON2 0.092 o .179 -94.860 -174.953 1463. BOl 13.500 99.000 

" 288.00 576.00 0.702 DCON2 0.126 o. 179 -225.707 -464.658 -419.712 13. 500 150.000 
15 576.00 576.00 0.702 DCON2 0.126 o. 179 -225.707 -464.658 419.712 13.500 150.000 
16 86<;.00 576.00 0.515 DCON2 0.092 o .179 -94.860 -174.953 -1464 13.500 99.000 
17 o.oo 864.00 l. 000 DCON2 o. 179 0.179 -54.696 1962.206 1145.680 13.500 73.500 

18 288.00 864.00 0.802 DCON2 0.144 o .179 -119.738 3777.943 -348.558 13.500 123.000 
19 576 00 864.00 o. 802 DCON2 o .144 0.179 -119.738 3777.943 348.558 13.500 123.000 
20 86{.00 864.00 1.000 DCON2 0.179 0.179 -54.696 1962.206 -1146 13.500 73.500 

Fis¡:ure 4: SAFE OutEut For Punchins¡: Shear 

Following are explanations of each ofthe column headings in the output shown in Figure 4: 

POINT 
X 

SAFE point object ID at location where punching shear stress is reponed 
= X-coordinate ofPOINT 

e 
E 
E 
e 
E 

E 
E 

E 
e 
E 
E 
e 
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y 
RATIO 
COMBO 
VMAX 
VCAP 
V 
MX 

MY 

DEPTH 

PERIM 
LOC 

= 
= 

= 

= 

= 

= 

= 

= 

= 

Y -coordina te of POTNT 
Punching shear stress divided by punching shear capacity 
Load combination that produces maximum punching shear stress 
Punching shear stress with the maximum absolute value 
Punching shear stress capacity with a phi factor included. i.e., ~Pvc 
Shear used in punching shear stress calculation 
Moment about a line through the column centroid and parallel to the X-axis used in 
punching shear stress calculation 
Moment about a line through the column centroid and parallel to the Y -axis u sed in 
punching shear stress calculation 
Effective depth for punching shear calculated as the average of the effective depths 
in the X and Y directions 
Perimeter length of critica! section for punching shear 
ldentifier for column location: I is an interior column, E is an edge column. and C is 
a comer column 

We will now derive sorne ofthe results shown in Figure 4 using hand calculations. The results 
we will calculate are the shear stress, shear capacity and the shear ratio for an interior column, an 
edge column with the edge parallel to the X-axis, an edge column with the edge parallel to the Y­
axis, anda comer column. We will ca!culate these values using the SAFE formulation and then 
calculate them again using the formulation in the PCA Publication (Ref 2). Final! y, we will 
compare the results obtained from SAFE, our hand calculations using the SAFE formulation, and 
our hand calculations using the PCA Publication formulation. 

6c. Hand Calculation For Interior Column Using SAFE Method 

d = [(15- 1) + (15- 2)] 12 = 13.5" 

Refer to Figure 5. 

b0 = 49.5 + 25.5 + 49.5 + 25.5 = 150" 

0.482 
1 

')h = 1 - -~ +-(-:-3.--:-)-.,~""4 9=. 5= 

3 25.5 

The coordinates of the center of the column 
(x~. y1) are taken as (0, 0). 
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Column 

Cantar of column la 
polnt (x1, x2). Set 
thla equal to (0, 0). 

A 

25.5" 

,.-----

y 
Cr1ttcal aectlon tor 

6~ 6 75" V-:punching ahear 
ahown daahed 

_____ g 
Sida 2 ~ 

:: = 
~: X fn 

e 

' : -i'~k-
~--- __ 1¿1~·-"----; --"1:----'"<-

D e 

Figure 5: Interior Column. Point 10 in SAFE Model 
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The following table is used for calculating the centro id of the critica! section for punching shear. 
Si de 1 , Si de 2, Si de 3 and Si de 4 refer to the si des of the critica! section for punching shear as 
identified in Figure 5. 

ltem 

X2 
Y2 
L 
d 

Ld 
Ldx2 
Ldy2 

XJ= 
2.Ldx, 

Ld 

Side 1 
-12.75 

o 
49.5 
13.5 

668.25 
-8520.19 

o 

_o_=O" 
2025 

2.Ldv' O 
V3= - =--=0" 
• Ld 2025 

Side 2 
o 

24.75 
25.5 
13.5 

344.25 
o 

8520.19 

Si de 3 S.ide4 Sum 
12.75 o N.A. 

o -24.75 N.A. 
49.5 25.5 bo = !50 
13.5 13.5 N.A. 

668.25 344.25 2025 
8520.19 o o 

o -8520.19 o 

The following table is used· to calculate lxx, !yy and IXY. The va1ues for Ixx, !yy and IXY are· 
given in the column titled "Sum". 

ltem Side 1 Side 2 
L 49.5 25.5 
d 13.5 13.5 

X2- X3 -12.75 o 
Y2- Y3 o 24.75 

Paralle1 to Y-Axis X-axis 
Equations 5b,6b, 7 5a.6a, 7 

lxx 146597 210875 
]yy 108633 23882 
lxv o o 

From the SAFE output at column point 10: 

V u= -225.707 k 
Mux = 464.658 k-in 
MUY= -419.712 k-in 

Side 3 Side 4 
49.5 25.5 
13.5 13.5 

12.75 o 
o 24.75 

Y-Axis X-axis 
5b,6b. 7 5a,6a, 7 
146597 210875 
108633 23882 

o o 

At the point labeled A in Figure 5, x., = -12.75 and y4 = 24.75, thus: 

Safe Technical Note 1 - Punching Shear 
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Sum 
N.A. 
N.A. 
N.A. 
N.A. 
N.A. 
N.A. 

714944 
265030 

o 
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-225.707 0.482[464.658- (-225. 707)(0- O)) [265030(24.75- O)- (0)(-12.75- O)] 
vu= + -

150*13.5 (714944)(265030)-(0) 2 

0.324[-419.712- ( -225. 707)(0- 0))[714944( -12.75- 0)- (0)(24.75- O)) 

(714944)(265030)- (O)' 

vu = -0.111 + 0.008-0.007 = -0.110 ksi at point A 

At the point 1abe1ed B in Figure 5, X4 = 12.75 and y4 = 24.75, thus: 

- 225. 707 -=-o ._48-=-2_,_[ 4....:6_4 ·-=-65-'8'---'<'---22...::.5_. 7-=-o 7-'J-'-'co_--'o'"') J'-'-[2-'6..:..5.:..:0 3-'0-'-( 2'-4;-. 7-=-5 _--=-o l'---'('-0'-'-)(_12_. 7_5_-_o~) 1 
vu +-

150*13.5 (714944)(265030)-(0)' 

0.324[-419. 712- (-225.707)(0- O)] [714944(12.75- 0)- (0)(24. 75- O)) 

(714944 )(265030)- (0) 2 

vu = -0.111 + 0.008 + 0.007 = -0.097 ksi at point B 

At the point labeled C in Figure 5, X4 = 12.75 and y4 = -24.75, thus: 

-225.707 0.482[464.658- (-225. 707)(0- O)) [265030( -24.75- 0)- (0)(12.75- O)) 
vu= + -

!50* 13.5 (714944)(265030)-(0) 2 

0.324[-419.712- (-225.707)(0- 0))[714944(12.75- 0)- (0)(-24.75- O)) 

(714944)(265030)- (0) 2 

vu = -0.111-0.008 + 0.007 = -0.113 ksi at point.C 

At the point labeled D in Figure 5, X4 = -12.75 and y4 = -24.75, thus: 

vu -225.707 + 0.482[464.658- (-225.707)(0- 0)][26503(X24.75- O)- (0)(-12.75- O)]_ 

150* 13.5 ' (714944)(265030)-(0) 2 

0.324{-41 9.712- (-225.707)(0- 0)][714944(-12.75- O)- (0)(-24.75- O)] 

(7 1 4944)(265030)- (O)' 

vu = -0.111 - 0.008 - 0.007 = -0.126 ksi at point D 

Point D has the largest abso1ute va1ue ofvu, thus Vmax = 0.126 ksi 

The shear capacity is calcu1ated based on the smallest of ACI 318-95 equations 11-35, 11-36 and 
11-37 with the bo and d terms removed to convert force to stress. 

0.85 (2 +-
4-J .J4000 

qJvc= 
36112 

0.179 ksi perequation 11-35 
1000 
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rpvc= 

0.85 (
40 * 13

·
5 

+ 2) .J4000 
I50 = 0.301 ksi per equation 11-36 

1000 

0.85. 4 • .J4000 . . 
rpvc= -----'----=0.215 kstperequatiOn 11-37 

1000 

Equation 11-35 yields the smallest value of[<!Jvc = 0.!79 ksi(, and thus this is the shear capacity. 

vu 0.126 
Shear Ratio=--= --=O. 702 

rpvc 0.179 

6d. Hand Calculation For Edge Column With Edge Parallel To X-Axis Using SAFE 
Method 

d= [(!5 -!)+ (15- 2)] /2= !3.5" 

Refer to Figure 6. 

bo = 48.75 + 25.5 + 48.75 = 123" 

íf'x = !-
1 

+ (3_)~48.75 
3 25.5 

0.480 

'}f.,.= l - 0.325 

1 + (I)~ 25 .5 
3 48.75 

The coordinates ofthe center ofthe 
column (x 1, y1) are taken as (0, 0). 

The following table is used for 

Column 

Center ol column ia 
po1nt ~•1. lll). Se! 
thts &qual to (0, O) 

o 

,,.. 
y 

e 

Figure 6: Edae Column With Edge Parallel To X·Axis. 
Point 6 in SAFE Model 

Edge of slab 

calcu!ating the centro id of the critica! section for punching shear. Si de l , Si de 2 and Si de 3 refer 
to the si des of the critica! section for punching shear as identified in Figure 6. 
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!te m Side 1 
x, -12.75 

_y, 0.375 
L 48.75 
d 13.5 

Ld 658.125 
Ldx2 -8391.09 
Ldy, 246.80 

XJ = I, Ldx2 = O = O" 
Ld 1660.5 

V3= 
I,Ldy2 

" Ld 

9013.78 

1660.5 
5.43" 

Side 2 Side 3 Sum 
o 12.75 N.A. 

24.75 0.375 N.A. 
25.5 48.75 bo = 123 
13.5 13.5 N.A. 

344.25 658.125 1660.5 
o 8391.09 o 

8520.19 246.80 9013.78 

The following tab1e is used to calcu1ate lxx, !yy and IXY. The va1ues for lxx, !yy and lxv are 
given in the co1umn tit1ed "Sum". 

!te m Side 1 Side 2 
L 48.75 25.5 
d 13.5 13.5 

X2- X3 -12.75 o 
Y2- YJ -5.05 19.32 

Paralle1 to Y-Axis X-axis 
Equations 5b.6b, 7 5a, 6a, 7 

lxx 157141 128518 
!yy 106986 23883 
lxv 42403 o 

From the SAFE output at co1umn point 6: 

Vu = -119.738 k 
Mux = 3778 k-in 
Muv = -348.588 k-in 

Si de 3 Su m 
48.75 N.A. 
13.5 N.A. 

12.75 N.A. 
-5.05 N.A. 

Y-Axis N.A. 
5b,6b, 7 N.A. 
157141 442800 
106986 237855 
-42403 o 

At the point 1abe1ed A in Figure 6, l4 = -12.75 and y4 = 24.75, thus: 
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~='" 

- ~-~ :1 
-119.738 0.480[3 778- ( -119. 738)(5.43 -O)) [23 7855(24. 75- 5.43)- (O)( -12.75- O)) 

vu = + . -
123 *13.5 (442800)(237855)-(0t ) 

0.325[-348.588- (-119.738)(0- O)) [442800(-12.75- 0)- (0)(24.75- 5.43)) 

( 442800)(23 7855)- (0) 2 

vu = -0.0721 - 0.0655 - 0.0061 = -0.144 ksi at point A 

At the point labeled B in Figure 6, x.; = 12.75 and y4 = 24.75, thus: 

-119.738 0.480[3 778- ( -119. 738)(5.43- 0))[237855(24. 75- 5.43)- (0)(12. 75- O)) 
vu= + -

123 *13.5 (442800)(237855)-(0) 2 

0.325[ -348.588- ( -119.738)(0- O)) [442800(12.75- O)- (0)(24.75- 5.43)) 

( 442800)(23 7855)- (0) 2 

vu = -0.072 - 0.065 + 0.006 = -0.131 ksi at point B 

At the point labeled e in Figure 6, x.; = 12.75 and Y4 = -24, thus: 

- 11 9. 7 3 8 -'-o ._48_0_,_[3_77_8_-....:.< -_1_1_9 ._7 3_8.:..:.)( 5_.4..:...3...,..-_o-'-') )'-'-[ 2-'-3-'-7 8_5..:...5('----2 4;----'5_.4_3'--) -_('--0'-'-)(1_2_. 7_5 _-~o) J 
vu= +-

123 *13.5 (442800)(237855)-(0) 2 

0.325[-348.588- (-119.738)(0- O)] [442800(12.75- O)- (0)(-24- 5.43)) 

( 442800)(23 7855)- (0) 2 

Vu = -0.072 + 0.100 + 0.006 = 0.034 ksi at point e 

At the point labeled D in Figure 6, X4 = -12.75 and y4 = -24, thus: 

-119.738 _0._48_0_,_[3_77_8_-....:.( -_1_1_9 ._73_8'-'.)(5_.4_3_-_0.:..;) )_,_[2_3_78_5_5('----24...,.-_5_.4_3'--) -_('-0'-'-)( -_1_2_. 7_5 _-....:..:.0) l 
vu= + 

123 *13.5 (442800)(237855)-(0)' 

0.325[ -348.588- (-119. 738)(0- O)) [442800(-12.75- O)- (0)(-24- 5.43)) 

( 442800)(23 7855)- (O)' 

vu = -0.072 + 0.100 - 0.006 = 0.022 ksi at point D 

Point A has the largest absolute value ofvu. thus Vmax = 0.144 ksi 

The shear capacity is calculated based on the smallest of Aei 318-95 equations 11-35, 11-36 and 
11-37 with the b0 and d terrns removed to convert force to stress. 

0.85 ( 2 + -
4
-) v'4000 

rpvc= 
36112 

=0.179 ksiperequation 11-35 
1000 
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o.85 (
30 

*
13

·
5 

+ 2) .J4ooo 
123 

~ve=----~--------~----
1000 

0.285 ksi per equation 11-36 

~ve= 
0.85*4* .Jm 

1000 
0.215 ksi per equation 11-37 

Equation 11-35 yields the smallest value ofi~Pvc = 0.179 ksij, and thus this is the shear capacity. 

vu 0.144 
Shear Ratio=---= --= 0.802 

~ve 0.179 

6e. Hand Calculation For Edge Column With Edge Parallel To Y-Axis Using SAFE 
Method 

d = [ (15 - 1) + ( 15 - 2) ]/ 2 = 13 .5" 

Refer to Figure 7. 

bo = 24.75 + 49.5 + 24.75 = 99" 

')'í·x = 1 
1 + (3.) {49.5 

3 I/2V5 
0.485 

J'í'r = 1 - 1 + (3.)P4. 75 

3 49.5 

0.320 

The coordinares ofthe center ofthe column 
(x 1, y 1) are taken as (0, 0). 

The following rabie is used for calculating the 
centroid of the critica! section for punching 
shear. Side 1 , Side 2 and Side 3 refer to the 

Cotumn 

Center of eolumn le 
polnt {x1, x2) S.t 
th•• •qual to (0, O). 

D 

y 

' = 
: ---i.'l<--
1 ~ 

___ _ SJct•J ___ ~ --~----"r 
e 

Figure 7: Edge Column With Edqe Parallel To Y·Axls. 
Point 9 in SAFE Model 

si des ofthe critica! section for punching shear as identified in Figure 7. 
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Item Side 1 Side 2 Side 3 'Sum 

X2 0.375 12.75 0.375 N.A. 

Y2 24.75 o -24.75 N.A. 
L 24.75 49.5 24.75 bo = 99 
d 13.5 13.5 13.5 N.A. 

Ld 344.125 668.25 344.125 1336.5 
Ldx2 125.30 8520.19 125.30 8770.78 
Ldy2 8269.59 o -8269.59 o 

'[_Ldx2 8770.78 
6.56" XJ = 

Ld 1336.5 

l:Ldy' o O" )'J= 
Ld 1336.5 

The fo!lowing tab1e is used to calcu1ate lxx, lyy and lxr. The va1ues for lxx, lyy and lxv are 
given in the co1umn tit1ed "Sum". 

ltem Side 1 Side 2 
L 24.75 49.5 
d 13.5 13.5 

X2- X3 -6.19 6.19 

Y2- Y3 24.75 o 
Paralle1 to X-axis ·Y-Axis 
Equations 5a, 6a. 7 5b,6b, 7 

lxx 204672.4 146597.2 
lyy 34922.6 25584.1 
lxv -51168 o 

From the SAFE output at column point 6: 

V u= -94.86 k 
Mux = 174.953 k-in 
Muy= 1463.801 k-in 

Side 3 
24.75 
13.5 
-6.19 

-24.75 
X-axis 

5a,6a. 7 
204672.4 
34922.6 
51168 

At the point labeled A in Figure 7, x4 = -12 and y4 = 24.75, thus: 

Safe Technical Note 1 - Punching Shear 
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Sum 
N.A. 
N.A. 
N.A. 
N.A. 
N.A. 
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555942 
95429 

o 
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vu -94.86 + 0.485[174.953- (-94.86)(0- O)) [95429(24.75- O)- (0)(-12- 6.56)) 
123 *13.5 (555942)(95429)-(0) 2 

0.320[1463.801- (-94.86)(6.56- O)) [555942( -12- 6.56)- (0)(24. 75- 0)) 

(555942)(95429)- (0) 2 

vu = -0.071 + 0.004 + 0.052 = -0.015 ksi at point A 

At the point 1abe1ed B in Figure 7, x., = 12.75 and y4 = 24.75, thus: 

vu = -94.86 + _0._48_5_,_[1_74_.9_5_3_--'-c -_9_4._86-'J"'-co_-_o"'""'"JJ_,_[9_54_2_9('--2_4._75..,...-_o:..;_)_--'-(O-'-J('--12_._75_-_6_.5_6=Jl 
123 *13.5 (555942)(95429)-(0) 2 

0.320[1463.801- ( -94.86)(6.56- O)) [555942(12.75- 6.56)- (0)(24.75- O)) 

(555942)(95429)- (O)' 

vu = -0.071 + 0.004 - 0.017 = -0.084 ksi at point B 

At the point 1abe1ed e in Figure 7, x., = 12.75 and Y• = -24.75, thus: 

-94.86 0.485[174.953- ( -94.86)(0- O)] [95429( -24.75- O)- (0)(12. 75 - 6.56)) 
vu= + -

123 *13.5 (555942)(95429)-(0) 2 

0.320[1463.801- (-94.86)(6.56- O)) [555942(12.75- 6.56)- (0)(-24.75- O)) 

(555942)(95429)- (O)' 

vu = -0.071 -0.004-0.017 = 0.092 ksi at point e 

At the point 1abe1ed D in Figure 7, x., = -12 and y4 = -24.75, thus: 

vu = - 94.8 6 + _o_.4_85_,_[1_7_4 ._9 5_3_---'c'----94_. 8_6..:..:l<..:..o _-_o J'-'-l "-[9.:....54_2_9('----24-'. 7..,..5_-_o:..:..J_--'-c o'""'"J_,_C -_1_2 _-_6_. 5--'-'-6) J 
123 *13.5 (555942)(95429)-(0) 2 

0.320[1463.801- (-94.86)(6.56- 0)) [555942( -12- 6.56)- (0)(-24.75- O)) 

(555942)(95429)- (0) 2 

vu = -0.071 -0.004 + 0.052 = -0.023 ksi at point D 

Point e has the 1argest absolute value ofv., thus Ymax = 0.092 ksi 

The shear capacity is calculated based on the smallest of A el 318-95 equations 11-35, 11-36 and 
11-3 7 with the b0 and d terrns removed to convert force to stress. 

0.85 (z + -
4
-) .J4ooo 

361!2 
~ve=--~--~~~----

1000 
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(/JVC = 

rpvc = 

0.85 eo ;~3.5 + 2) .J4oOO 
0.327 ksi per equation 11-36 

1000 

0.85 • 4 • .J4oOO 
1000 

0.215 ksi per equation 11-37 

Equation 11-35 y1elds the smallest val u e of jq,vc = 0.179 ksij, and thus this is the shear capacity. 

vu o 091 
Shear Ratio=--= -·-- = 0.515 

rpvc 0.179 

6f. Hand Calculation For Corner Column Using SAFE Method 

d= [(15 -1)+ (15 -2)]/2 = 13.5" 

Refer to Figure 8. 

bo = 24.75 + 48.75 = 73.5". 

){·x = l- l + (~)~48.75 
3 24.75 

/{T=l- (2)~24.75 
1+- --

3 48.75 

0.483 

0.322 

The coordinates of the center of the 
column (x 1, y1) are taken as (0, 0). 

Column 

Center of column 11 
poJnt (x1, x2) Set 
th11 equal to (0, 0). 

24 75" 

y 

' ' No 

~: 
0' 

:> 
In 

X ~ 

~ • 
~ 

e 

Figure 8: Cerner Column. Point 5 in SAFE Model 

The following table is u sed for calculating the centroid of the critica! section for punching shear. 
Si de 1 and Si de 2 refer to the si des of the critica! section for punching shear as identified in 
Figure 8. 
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!te m 

X2 

Y2 
L 
d 

Ld 
Ldx2 

Ldy2 

) Ldx2 
XJ = .,~,__ 

Ld 

Side-1 1 

0.375 
24.75 
24.75 
13.5 

334.125 
125.30 

8269.59 

8516.39 

992.25 
8.58" 

I Ldy2 8516.39 " 
1'3 = = = 8.58 
• Ld 992.25 

Side 2 Sum 
12.75 N.A. 
0.375 N.A. 
48.75 bo = 73.5 
13.5 N.A. 

658.125 992.25 
8391.09 8516.39 
246.80 8516.39 

, The following table is used to ca!cu!ate lxx, lyy and lxy. The values for lxx, lyy and l:o;y are 
given in the column titled "Sum". 

ltem Side 1 Side 2 
L 24.75 48.75 
d 13.5 13.5 

X2- X3 -8.21 4.17 
Yl- V] 16.17 -8.21 

Parallel to X-axis Y-Axis 
Eg_uations 5a.6a, 7 5b,6b. 7 

lxx 87332 184673 
lyy 44640 11428 
Ixv -44338 -22510 

From the SAFE output at column point 5: 

Y u= -54.696 k 
Mux = -1962 k-in 
Muv = 1145.68 k-in 

Sum 
N.A. 
N.A. 
N.A. 
N.A. 
N.A. 
N.A. 

272005 
56069 
-66848 

At the point labeled A in Figure 8, X4 = -12 and y4 = 24.75, thus: 
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-54.696 0.483[1962- (-54.696)(8.58- O)] [56069(24.75- 8.58)- ( -66848)(-12- 8.58)] 
vu= +--~~--~----~----~~--~-------+~~----~----~ 

73.5 * 13.5 (272005)(56069)-(-66848)' 

0.322[1145.68- (-54.696)(8.58- O)] [272005(-12- 8.58)- ( -66848)(24. 75- 8.58)] 

(272005)(56069)- ( -66848) 2 

vu = -0.055 + 0.031 + 0.091 = 0.067 ksi at point A 

At the point labeled B in Figure 8, x., = 12.75 and y4 = 24.75, thus: 

-54.696 0.483[1962- (-54.696)(8.58- O)] [56069(24.75- 8.58)- (-66848)(12.75- 8.58)] 
vu= + -

73.5 * 13.5 (272005)(56069)- ( -66848) 2 

0.322[1145.68- ( -54.696)(8.58- O)] (272005(12. 75- 8.58)- ( -66848)(24. 75- 8.58)] 

(272005)(56069)- ( -66848) 2 

vu = -0.055 - 0.079- 0.045 = -0.179 ksi at point B 

At the point labeled e in Figure 8, x., = 12.75 and y4 = -24, thus: 

vu = - 54.696 + -'-0_.4_83_,_[ 1_9_62_-_('----54_. 6.;_9_6'-)(8'-.'-'5 8'----0-") ]'-'['-'5 6'--0.:..:69_,_( -_2c_4_-_:8.:..:.5...:.8)'-,--(:_-...:.66.:..:8c_4.::..:8l.:..:(lc_2..c.. 7.;_5 _-_8._5 8=)] 
73.5 *13.5 (272005)(56069)-(-66848) 2 

0.322[1145.68- (-54.696)(8.58- O)] [272005(12.75- 8.58)- (-66848)(-24- 8.58)] 

(272005)(56069)- ( -66848)2 

V u = -0.055 + 0.104 + 0.021 = O.ü70 ksi at point e 

Point B has the largest absolute val u e of V u, thus Vmax = 0.179 k si 

The shear capacity is calculated based on the smallest of A el 318-95 equations 1 1-35, 11-36 and 
1 1-3 7 with the b0 and d terms removed to convert force to stress. 

0.85 (2 + -
4 
-) .J4000 

36112 k . - 1 35 rp ve= ----''--.....:e~=-<---- 0.179 SI per equauon 1-
1000 

0.85 ( 
20 

* 
13

·
5 

+ 2) .J4000 
73

·
5 

0.404 ksi per equation 1 1-36 
1000 

rpvc= 

0.85*4* .J4000 k. . 11 37 rpvc= =0.215 Siperequatwn -
1000 

Equation 1 1 -35 yields the sma!lest val u e of l<Pvc =O. 179 ksij, and thus this is the shear capacity. 
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. vu 0.179 
Shear Ratw =-= --= 1.000 

rpvc 0.179 

6g. Hand Calculation For Corner Coturno Using SAFE Method Except That h:v Is Set To 
Zero 

This ca1cu1ation is done for comparison with the comer ca1cu1ation using the PCA Pub!ication 
method (Ref. 2). Note that the computer program SAFE does not do the ca1cu1ation with 1xy set 
to zero. 

The calcu1ations in this case are exactly the same as in Section 6f. except that IXY is set to zero. 
Thus, using the intermediate resu1ts in Section 6f we can go right to calcu1ating the stresses. 

At the point 1abe1ed A in Figure 8, X4 = -12 and y4 = 24. 75, thus: 

-54.696 0.483[1962- ( -54.696)(8.58- 0)][56069(24.75- 8.58)- (0)(-12- 8.58)] 
vu= + -

73.5 *13.5 (272005)(56069)-(0) 2 

0.322[1145.68- ( -54.696)(8.58- 0)] [272005( -12- 8.58)- (0)(24. 75- 8.58)] 

(272005)(56069)- (0) 2 

vu = -0.055 - 0.043 + 0.080 = -0.018 ksi at point A 

At the point 1abe1ed B in Figure 8, X4 = 12.75 and y4 = 24.75, thus: 

-54.696 0.483[1962- (-54.696)(8.58- 0)] [56069(24.75- 8.58)- (0)(12.75- 8.58)] 
~ + -

73.5 *13.5 (272005)(56069)-(0) 2 

0.322[1145.68- ( -54.696)(8.58- O)] [272005(12. 75- 8.58) - (0)(24. 75- 8.58)] 

(272005)(56069)- (0) 2 

vu = -0.055 - 0.043 - 0.016 = -0.114 ksi at point B 

At the point 1abe1ed C in Figure 8, X4 = 12.75 and Y• = -24, thus: 

-54.696 0.483[1962- (-54.696)(8.58- O)) [56069(-24- 8.58)- (0)(12.75- 8.58)] 
~ + -

73.5 *13.5 (272005)(56069)-(0) 2 

0.322[1145.68- (-54.696)(8.58- O)) [272005(12.75- 8.58)- (0)(-24- 8.58)) 

(272005)(56069)- (0) 2 

vu = -0.055 + 0.086 - 0.016 = 0.015 ksi at point e 

1 Point B has the 1argest abso1ute va1ue ofvu, thus Ymax = 0.114 ksi 1 
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6h. Terminology For PCA Publication Method of Calculating Punching Shear 

a 
A e 
b¡ 

e 

e' 

J/c 
J/c' 
Mux 
MUY 
M UXtransformed 

= Distance from center of column to centroid of critica! section for punching shear 
= Area of critica! section for punching shear 
= Length of si de of critica! section for punching shear parallel to Y -axis for 

bending about X-axis, and parallel to the X-axis for bending about Y-axis 
Length of side of critica! section for punching shear parallel to X-axis for 
bending about X-axis, and parallel to the Y-axis for bending about Y-axis 

= For bending about the X-axis, shoner Y distance from centroid of critica! 
section for punching shear to an edge of the critica! section for punching shear 
that is parallel to the Y-axis. For bending about the Y-axis, shoner X distance 
from centro id of critica! section for punching shear to an edge of the critica! 
section for punching shear that is parallel to the X-axis. 

= For bending about the X-axis, longer Y distance from centroid of critica! section 
for punching shear to an edge of the critica! section for punching shear that is 
parallel to the Y-axis. Forbending about the Y-axis, longer X distance from 
centro id of critica! section for punching shear toan edge ofthe critica! section 
for punching shear that is parallel to the X-axis. 

= Section modulus associated with critica! section for punching shear 
= Section modulus associated with critica! section for punching shear 
= Moment about line parallel to X-axis at center of column or load 
= Moment about line parallel to Y -axis at center of column or load 

Moment about line parallel to X-axis at centroid of critica! section for punching 
shear 

MUYtmnsfonned = Moment about line parallel to Y -axis at centro id of critica! section for punching 
shear 

y = Percent of Mux resisted by shear per ACI 318-95 equations 11-41 and 13-1 

6i. Basic Equation For PCA Publication Method 

The basic equation for the PCA Publication method is: 

Ve , '}1:rMUXtrans_formrdCx ')11MUYtransformrJCr 
vu =-.,. + -'-------

A e Jx Jr 
Eq. 8 

Depending on the comer of the critica! section for punching shear where yo u are calculating 
stress this equation may be in one of the following forms: 

V u 'J1'xM UXtrans(ormedC
1 
X 

vu =--
'J1'rMVYiransformedC' Y 

A e Jx Jy 

V u J1'.tMUXtransfarmedC' X 'J1'rMUYtran~(nrmedCY 
vu =-- +.!------

Ac Jx Jr 
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V u ~xAfu:rtraliS.(ormedCY ')'1'1MCFilratzSformedC' Y 
vu =-+ .!----'---

A e Jx Jr 

6j. Hand Calculation For Interior Column Using PCA Publication Method 

From the SAFE computer output given 
in Figure 4 for Point: 

V u= --225.707 k (upward positive) 
Mux = 464.658 k-in (right-hand rule) 
Muv = -419.712 k-in (right-hand rule) 

d=[(l5-1)+(15 -2)]/2= 13.5" 

Column 

b,. 25 5" 

y 

67~J 6"= 
J 

1 
CrltJc:~~IINCllon fDr .. .,,., ~~""""' ...... 

• r r B lhown d .. l'led 

r----- ------, ~ 

r-t- : __j·~ i 
• 
• . 
• • " • ( ' . : ~-
• • ~ ' • M,,•M 
' ~! 

. 
'---- :~ • 

' 
.. ____________ , 

D e 

X 

To calcula te data for bending about X­
axis refer to Figure 9. Note that the 
direction and sign of Mux shown in 
Figure 15 is consisten! with that given . 
in the SAFE output. Figure 9: Interior Column Point 10 in SAFE Model 

Bendmg About X-Axis 

b, = 49.5" 
b2 = 25.5" 

}{x = 1-
1 

+ (3.)~49 _5 0.482 

3 25.5 

Ac = 2(b1 + bz)d = 2 * (49.5 + 25.5) * 13.5 = 2025 in2 

Jx bid(bi + 3b2) + d 3 

-= 
ex 3 

Jx bid(bi + 3b2) + d 3 

-= 
c'x 3 

bl 49.5 
ex=-=--= 24.75" 

2 2 

e',=!!:.= 
49

·
5 

=24.75" 
2 2 

49.5 * 13.5(49.5 + (3 * 25.5)) + 13.53 

3 

49.5 * 13.5( 49.5 + (3 * 25.5)) + 13.5 3 

3 

28886.6 in 3 

28886.6 in 3 

Muxrr.msfonned = Mux = 464.658 k-in ( direction of moment shown in Figure 9) 

Eq. 11 
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To calcu1ate data for bending about Y-axis refer 
to Figure 1 O. Note that the direction and sign of 
Muy shown in Figure 1 O is consisten! with that 
given in the SAFE output. 

y 

~~uy • Mu.-..,•-• • 419 712 k·ln 

b,. 25.5"" 

c•1275" c'•1275" 

b¡ = 25.5" 
b2 = 49.5" .J J 

Critlc.ll sectlon fot 

6 7~ 6" 6" 6.75"' V-:punchlng 1he1 
A \. r B shown dnhed 

}h=
1

- (2)~5.5 
1+- --

3 49.5 

0.324 

r----- ------ ' 
' ~ 

Column---1f---_.,..r-r 
: ~ 
' ' ' ' ' m 

' 
' ' ~ ' ' ,____ ' ' ~ 
' ' ~ 

~-------------' 
o e 

~ 
X ~ • 

~ • 
~ 

Figure 10: Interior Column. Point 10 in SAFE Model 
Bending About Y·Axis 

Jy b1d(bi + 3bz) + d 3 

= 
CY 3 

}y b1d(b1 + 3bz) + d 3 

e' 1 3 

er=!!:_= 
25

·
5 

=12.75" 
2 2 

e',=!!:_= 25
·
5 

=12.75" 
2 2 

25.5 * 13.5(25.5 + (3. 49.5)) + 13.53 

3 

25.5 * 13.5(25.5 + (3. 49.5)) + 13.53 

3 

20786.6 in 3 

20786.6 in 3 

Muv~cansfonned =MUY= 419.712 k-in (direction ofmoment shown in Figure 10) 

The punching shear stress at point A in Figures 9 and 1 O is calcu1ated using equation 10: 

225.707 
vu 0.482*464.658 + 0.324*419.712 O.III-.008 +.007 =0.IIOksi 

2025 28886.6 20786.6 

The punching shear stress at point B in Figures 9 and 1 O is calculated using equation 9: 

225.707 
vu = 

2025 

0.482 * 464.658 

28886.6 

0.324. 419.712 

20786.6 
o. 1 1 1 - .008- .007 = 0.096 ksi 

The punching shear stress at point C in Figures 9 and 1 O is calculated using equation 1 1: 
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vu = 225.707 + _0_.4.c,82_* 4_6_4_.6_5_8 
2025 28886.6 

0.324 * 419.712 

20786.6 
0.111 + .008- .007 = 0.112 ksi 

The punching shear stress at point D in Figures 9 and 1 O is calcu1ated using equation 8: 

vu = 225.707 + 0.482 * 464.658 + 0.324 * 419.712 = 0 _111 + _008 + _007 =O. ¡26 ksi 
2025 28886.6 20786.6 

Point D has the 1argest abso1ute value of \" "' thus Vmax - 0.126 ksi 

6k. Hand Ca1cu1ation For Edge Co1umn With Edge Paralle1 To X-Axis Using PCA 
Publication Method 

From the SAFE computer output 
given in Figure 4 for Point 6: 

V u= -119.738 k (upward positive) 
Mux = -3778 k-in (right-hand rule) 
Muv = -348.588 k-in (right-hand rule) 

d = [(15- 1) + (15- 2)] 12 = 13.5" 

A 

Co lumn 

b:•255" 

y 

6 75"..1 6" 

./ Crlttcal •ecUon for 

,. 6.75" ~'""'"'"' '"'" 

1 - - ~-- - !l ahown dashed 

,..-----
' 

~ ¡;: 

' :< l! 
' - - Mu-..::,-· 
' • . u 

• = u 1/\X ' ' ' ~ \ ' :., 
~ 

' .. 

3128 k·ln 

To calculate data for bending about 
X-axis refer to Figure 11. Note that 
the direction and sign of Mux shown 
in Figure 11 is consisten! with that 
given in the SAFE output. Also note 
that X-direction bending is bending 
perpendicular to the edge. 

• 
' 

!! ~ 
N 

; Mw:. Jns k • ·In 

b¡=48.75" 
b2 = 25.5" 

)Vx = 1- 1 + (3.)~48.75 = 0.480 

3 25.5 

• ' .___ "u ,; ../ Edgeof 11 ' ' .. 
o e 

Figure 11: Edge Co/umn With Edge Parallel To X-Axis 
Point 6 in SAFE Model. Bendinq About X-Axis 

•• 

Ac = (2b 1 + b2)d = ((2 * 48.75) + 25.5) * 13.5 = 1660.5 in2 

Safe Technical Note 1 - Punching Shear 
Initial Release Date: November 16, 1998 

Revision 4, June 16, 2000 
Page 24 of31 



ex 6bl 

2 * 48.75 2 * 13.5( 48.75 + (2 * 25.5)) + 13.5 3 ((2 * 48.75) + 25.5) 

6 * 48.75 
22917.3 in 3 

c'x 6(b1 + b2) 

2 * 48.75 2 * 13.5( 48.75 + (2. 25.5)) + 13.5'((2. 48. 75) + 25.5) 

6* (48.75 + 25.5) 
15046.7 in 3 

48.75 2 

19.32" 
(2 * 48.75) + 25.5 

e' _ b,(b, + b2) 48.75 • (48.75 + 25.5) 29 .4
3
" 

'- 2bl + b2) (2 * 48.75) + 25.5 

ax = 18 + 6.75- 19.32 = 5.43" 

Mux~cansfonned = 3778- 119.738 * 5.43 = 3128 k-in (direction ofmoment shown in Figure 11) 

To ca1cu1ate data for bending about Y-axis refer 
to Figure 12. Note that the direction and sign of 
Muy shown in Figure 12 is consisten! with that 
given in the SAFE output. A1so note that Y­
direction bending is bending paralle1 to the edge. 

bl = 25.5" 
b2 = 48.75" 

1 ')11· = 1- 0.325 

1+(~)~::.:5 
Column 

Edge of 

Y, 
Muv • Mu•- • 348.588 k-In 

/::-1' 
••• 2S.SH 

c•1275R e' • 12.75R 

6 75"'J 6" 

J Crltlcal nc:tcon 

,. "" ~·""'"'"• '"" 
• r r B •hown dashed 

r------ ------ :n 
• 
' :;¡ 
' r-~ 
' 
• 
' ¡, . 
• X~ • 
' , 

"' ' • ' = ~-• 
• 

slab"' : '-- • 

o e 

'" 

Figure 12: Edge Column With Edge Parallel To X-Axis 
Point 6 in SAFE Model. Bending About Y-Axis 

Jr b1d(b, + 6b2) + d 3 

cr 6 

Jr b,d(b1 + 6b2) + d 3 

c'r 6 

25.5 * 13.5(25.5 + (6 * 48.75)) + 13.53 

6 
18655.3 in 3 

25.5 *13.5(25.5 + (6 • 48. 75)) + 13.53 = 
18655

.
3 

in' 

6 
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cr = !2 = 
25

·
5 

= 12.75" 
2 2 

c'r = !2 = 
25

·
5 

= 12.75" 
2 2 

Muvn-ansfonned = Muv = 348.588 k-in (direction ofmoment shown in Figure 12) 

The punching shear stress at point A in Figures 11 and 12 is calcu1ated using equation 8: 

vu 119.738 + 0.480 * 3128 + 0.325 * 348.588 0.072 + .066 + .006 = 0.144 bi 
1660.5 22917.3 18655.3 

The punching shear stress at point B in Figures 11 and 12 is ca!culated using equation 11: 

119.738 0.480 * 3128 
vu = + ---=--

1660.5 22917.3 

0
·
325

• 
348

·
588 

0.072 + .066-.006 = 0.132 bi 
18655.3 

The punching shear stress at point C in Figures 11 and 12 is calculated using equation 9: 

119.738 
vu=---

1660.5 

0.480. 3128 

15046.7 

0
'
325 * 348

'
588 

0.072-.100-.006 =- 0.034 bi 
18655.3 

The punching shear stress at point D in Figures 11 and 12 is calculated using equation 10: 

119.738 
vu=--- 0.480 * 3128 + 0.325 * 348.588 0.072 - .1 00 + .006 =- 0.022 bi 

1660.5 15046.7 18655.3 

J Point A has the largest absolute value ofvu. thus Vmax = 0.144 ksi j 

61. Hand Calcu1ation For Edge Co1umn With Edge Paralle1 To Y-Axis Using PCA 
Publication Method 

From the SAFE computer output given in Figure 4 for Point 9: 

V u= -94.86 k (upward positive) 
Mux = 174.953 k-in (right-hand rule) 
Muv = 1463.801 k-in (right-hand rule) 

d = [ ( 15 - 1) + ( 15 - 2) J 1 2 = 13 .5" 

To calculate data for bending about X-axis referto Figure 13. Note that the direction and sign of 
Mux shown in Figure 13 is consisten! with that given in the SAFE output. Also note that X­
direction bending is bending parallel to the edge. 
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b¡ = 49.5" 
b, = 24.75" 

b,•247S-

y 

,.J 6" 
J CrltJg¡l HCtlon for 

')f·x = 1 -
1 = 0.485 

(
2)Hffi9.5 

Edg~~ of 

.. .,,. t.('"""'"'...,, 
··~ 

.:. r B 1howm dun.d 

------ ~ 

f- : ___;le- ~ 1+- --
3 24.75 

Ac = (b¡ + 2b2)d 
= (49.5 + (2 * 24.75)) * 13.5 
= 1336.5 in2 

Column r 
~ 

' ;, 'o 

( X 

" ..\1 . ~ ~ 
' 

.... 
'---- ~ ~! • 

__________ .. 
D e 

Figure 13: Edqe Column With Edge Parallel To Y-Axis 
Point 9 m SAFE Model. Bending About X-Axis 

Jx bid(bi + 6b2) + d 3 49.5 * 13.5(49.5 + (6 * 24.75)) + 13.53 

22462.3 in 3 

a 6 6 

bid(bi + 6bz) + d 3 49.5 * 13.5( 49.5 + (6 * 24.75)) + 13.53 

= = 
Jx 

22462.3 in 3 

c'x 6 6 

ex=':.;_= 49
·
5 

= 24. 75" 
2 2 

e' x = ':.;_ = 49
·5 

= 24.75" 
2 2 

Muxi,nsfonncd = Mux = 174.953 k-in (direction of 
moment shown in Figure 13) 

To calculate data for bending about Y-axis refer 
to Figure 14. Note that the direction and sign of 
Muv shown in Figure 14 is consisten! with that 
given in the SAFE output. Al so note that Y­
direction bending is bending perpendicular to 
the edge. 

b¡ = 24.75" 
bz = 49.5" 

1 /'f'>· = 1 - = 0.320 

1 + (~) (24.75 
3 v49.5 
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Point 6 in SAFE ModeL Bending About Y-Axis 

Revision 4, June 16, 2000 
Page 27 of31 

,, 



cr 6bl 

2. 24.75 2 *13.5(24.75 + (2. 49.5)) + 13.53 ((2. 24. 75) + 49.5) 

6*24.75 

Jr 2bl 2 d(bl + 2b2) + d'(2bl + b>) 
-= 
c'r 6(b1+b2) 

15422.9 in3 

2 • 24.75 2 *13.5(24.75 + (2 • 49.5)) + 13.53((2 • 24.75) + 49.5) = 
514

1.
0 

in' 

6. (24.75 + 49.5) 

cr = 
24.75 2 

6.19" 
2bl + b, (2. 24. 75) + 49.5 

c'r=b,(b,+b>) 24.75*(24.75+49.5) 18.56, 
2b, +b>) (2. 24.75) + 49.5 

av = 6 + 6.75-6.19 = 6.56" 

MUY1ransfonned = 1463.801 - 94.86 • 6.56 = 841 k-in (direction ofmoment shown in·Figure 14) 

The punching shear stress at point A in Figures 13 and 14 is calculated using equation 9: 

94.86 
vu= 

1336.5 

0.485 *174.953 

22462.3 

0.320 * 841 

5141.0 
0.071 - .004- .052 = 0.015 ksi 

The punching shear stress at point B in Figures 13 and 14 is calcu1ated using equation 10: 

vu = 94.86 0.485*174.953 + 0.320*841 0.071 -.004+.017=0.084/csi 
1336.5 22462.3 15422.9 

The punching shear stress at point e in Figures 13 and 14 is calculated using equation 8: 

94.86 0.485 *174.953 0.320. 841 
vu = + + 0.071 + .004 + .017 = 0.092 ksi 

1336.5 22462.3 15422.9 

The punching shear stress at point D in Figures 13 and 14 isca1culated using equation 11: 

94.86 0.485 *174.953 
vu= +------

1336.5 22462.3 

0.320. 841 

5141.0 
0.071 + .004- .052 = 0.023 ksi 

1 Point e has the largest absolute va1ue of V u, thus Vmax = 0.092 ksi 1 
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6m. Hand Calculation For Corner Column Using PCA Publication Method 

From the SAFE computer output given 
in Figure 4 for Point 5: 

V u= -54.696 k (upward positive) 
Mux = -1962 k-in (right-hand rule) 
Muy= 1145.68 k-in (right-hand rule) 

d = [(15- 1) + (15- 2)]/2 = 13.5" 

y 

, j Critl~l uc:IJOn tor 
6~j 6- 6" 6 7S"t¿P\Ineh~ng81Ho•• 
A r 1' B •hown d .. l'led 

Edgeohl.l~ --- ------ In ... 

-f- ¡ ____;._ ; ,- ' . 
' o 

Column 

e 

'1/\X 

~ \ 
! M"" •1962 k-in 

• 

To calculate data for bending about X­
axis refer to Figure 15. Note that the 
direction and sign of Mux shown in 
Figure 15 is consisten! with that given 
in the SAFE output. Figure 15· Cerner Column. Point 5 in SAFE Model 

Bending About X-Axis 

b, = 48.75" 
b" = 24.75" 

)'fcr=l- (2J~48.75 
1+- --

3 24.75 

0.483 

Ac = (b 1 + b2)d = (48.75 + 24.75) • 13.5 = 992.25 in2 

Jx bt 2d(br+4b,)+d 3(bt+b2) 
= 

ex 6bt 

48.75 2 *13 .5( 48.75 + ( 4 * 24. 75)) + 13.5 3 
( 48.75 + 24. 75) 

6 * 48.75 

Jx br' d(b1 + 4b,) + d\bt + b2) 
= 

c'x 

b/ 

6(bt + 2b2) 

48.75 2 * 13.5( 48.75 + ( 4 * 24. 75)) + 13.5 3 
( 48.75 + 24. 75) 

6. (48.75 + (2 * 24.75)) 

48.75' 
cx=--- 16.17" 

2(bt + b¡) 2 * (48.75 + 24.75) 

bl(bt + 2b2) 48.75 * (48.75 + (2 * 24.75) 
c'x = 32.58" 

2(bl + bl) 2. (48.75 + 24.75) 

ax = 18 + 6. 75 - 16.17 = 8.58" 

16824.6 in 3 

8348.1 in 3 
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Mux<mnsfonned = 1962-54.696 * 8.58 = 1493 k-in (d1rection ofmoment shown in Figure 15) 

To ca1cu1ate data for bending about Y -axis refer 
to Figure 16. Note that the direction and sign of 
Muv shown in Figure 16 is consisten! with that 
gi ven in the SAFE output. 

b¡ = 24.75" 
b, =48.75" 

1 (h = 1 - = 0.322 

1 + (3.) [24.75 
3 'V4i05 

Edge of Sil~ 

Column 

:;u~-·-· " 
y 1' M~ 1145.68 k-In 

rP\' 

676 kol 

b,• 24 75" 

e' • 2 .58H , .. tr 

•• 8-\ -
,.J ·-
~ Cr111CII MCIIOn ,. J _,-t.¿"""'"'"''"" 

._!'_ r anown dnhed 

--· ~ 
r- -

~ ' X~ 
•> ~ 

• 
~ ..; 

e 

'" 

Figure 16: Corner Column. Point 5 in SAFE Model 
Bending About Y·Axis 

Jr b! 1 d(bl+4b,)+d 3 (b!+b>) 
= = 

cr 

.;. 
-= 
c'F 

24.75 2 * 13.5(24.75 + (4. 48.75)) + 13.53(24.75 + 48.75) 

6 * 24.75 

bi 2 d(b! + 4b2) + d 3 (b! + b>) 

6(b! + 2b2) 

24.75 2 *13.5(24.75 + ( 4. 48. 75)) + 13.53 (24.75 + 48.75) 

6 * (24.75 + (2 * 48.75)) 

24.75 2 
4.17" 

2. (24.75 + 48.75) 

' bt(bt + 2b2) 24.75. (24.75 + (2. 48.75) 
e x = = = 20.58" 

2(bt + b2) 2. (48.75 + 24.75) 

ay= 6 + 6.75-4.17 = 8.58" 

13455.1 in 3 

2724.0 in 3 

Muvtmnsfonned = 1145.68- 54.696 * 8.58 = 676 k-in (direction ofmoment shown in Figure 16) 

The punching shear stress at point A in Figures 15 and 16 is ca1cu1ated using equation 11: 
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vu = 54.696 + 0.483 * 1493 - 0.322 * 676 = 0.055 + .043- .080 = 0.018 ksi 
992.25 16824.6 2724.0 

The punching shear stress at point B in Figures 15 and 16 is calcu1ated using equation 8: 

54.696 0.483 * 1493 0.322 * 676 
vu + + 0.055+.043+.016=0.114ksi 

992.25 16824.6 13455.1 

The punching shear stress at point C in Figures 15 and 16 is ca1cu1ated using equation 10: 

vu 
54.696 

992.25 

0.483 * 1493 0.322 * 676 
_:.,:_c..:.,____:..:...+ 0.055- .086 +.o 16 =- 0.018 ksi 

8348.1 2724.0 

Point B has the 1argest abso1ute va1ue ofv"' thus Vm"- 0.114 ksi 

6n. Comparison {)f Punching Shear Stress Results 

A comparison of the punching shear stress resu1ts is shown in the tab1e be1ow. The hand 
ca1cu1ations using the SAFE method yie1d resu1ts the same as the SAFE computer mode1 for all 
cases, that is for the interior co1umn, the edge co1umn with the edge paralle1 to the X-axis, the 
edge co1umn with the edge paralle1 to the Y -axis and the comer co1umn. The hand calcu1ations 
using the PCA Publication method (Ref. 2) yie1d resu1ts the same as the SAFE computer mode1 
(and SAFE hand calcu1ations) foral! cases except the comer co1umn. For the comer co1umn if 
the lxv term in the hand ca1cu1ations using the SAFE method is set to zero, then this ca1cu1ation 
yie1ds the same resu1t as the hand ca1cu1ation using the PCA method. 

Punching Shear Stress Results, ksi 

SAFE Computer 
Column Tvpe 

Interior 
Edge paralle1 to X-axis 
Edge parallel to Y -axis 
Corner 
Corner with lxv = O 

Safe Technica1 Note 1 - Punching Shear 
lnitia1 Re1ease Date: November 16, 1998 

Model 
0.126 
0.144 
0.144 
0.179 
N.A. 

Hand Calculation 
Using SAFE 

Method 
0.126 
0.144 
0.144 
0.179 
0.114 

Hand Calcu1ation 
Using PCA 

Publication Method 
0.126 
0.144 
0.144 
0.114 
N. A. 
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15.9.3 Design Checks for Steel and Concrete Beams 

Unfortunately, most design check equations for steel structures are v.Titten in terms 

of "design strength ratios" which are a nonlinear function of the axial force in the 

member; therefore, the ratios cannot be calculated in each mode. A new 

approximate method, to replace the curren! state of the art approach of calculating 

strength ratios based on maximum peak values of member forces, is proposed by the 

author. This would involve first calculating the maximum axial force. The design 

ratios would then be evaluated mode by mode, assuming the maximum axial force 

reduction factor remains constan! for all modes. The design ratio for the member 

would then be estimated by a double-sum modal combination method such as the 

CQC3 method. This approach would improve accuracy and still be conservative. 

F or concrete structures additional development work is required in arder to develop 

a completely rational method for the use of maximum spectral forces m a design 

check equation because of the nonlinear behavior of concrete members. A time 

history analysis may be the only approach that will produce rational design forces. 

15.9.4 Calculation of Shear Force in Bolts 

With respect to the interesting problem of calculating the maximum shear force in a 

bolt, it is not corree! to estímate the maximum shear force from a vector summation 

since the x and y shears do not obtain their peak values at the same time. A correct 

method of estimating the maximum shear in a bolt is to check the maximum bol! 

shear at several different angles about the bolt axis. This would be a tedious 

approach using hand calculations; however, if the approach is built into a post 

processor computer program, !he computational time to calculate !he maximum bolt 

force is trivial. 

The same problem exists if principal stresses are to be calculated from a response 

spectrum analysis. One must check at several angles in arder to estimare !he 

maximum and mínimum val u e of the stress at each point in the structure. 
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1. Background 

SAFE creates a rectangular mesh for analysis. There is an X and Y direction mesh Jine passing 
through each point in the model. The points these mesh lines pass through include point objects, 
the end points of !in e objects and the comer points of area objects. As yo u can imagine, if your 
points do no! align somewhat in an X-Y grid system you can very easily ha ve a large number of 
closely spaced grid Jines. This may not be desirable since it creates abad aspect ratio for the 
shell elements, greatly increase the running time for your model and also increase the display 
time for results. 

The Align Vertical/Horizontal command was added to the Edit menu in SAFE version 6.16. The 
purpose ofthis command is to assist you in aligning points, lines and area objects in your model. 

2. How to Implement the Align VerticaUHorizontal Command 

To use the Align Vertical/Horizontal command do the following: 

l. Select the point, Jine and area objects that you want to align. 

2. On the Edit menu click Align Vertical/Horizontal to display the Align 
Selected Lines/Edges/Points dialog box. 

3. In this dialog box either type in the maximum move allowed or accept the 
default and click the OK button. The value yo u type in is a distance in the 
curren! units. It is the maximum distance any point will move to align with 
another point. 

SAFE will automatically align all ofthe selected objects as described below. You may want to 
run through this process three times to cover the structual !ayer, X-strip !ayer and Y -strip !ayer. 

3. How the Align Vertical/Horizontal Command Works 

When yo u implement the Align Vertical/Horizontal command SAFE goes through the following 
sequence of steps in !he order specified: 

1. SAFE changes the selection from point line and area objects to a group of 
points. This group ofpoints consists ofall ofthe selected point objects, the 
end points ofall ofthe selected Jine objects and the comer points ofall ofthe 
selected area objects. 

2. SAFE steps through the grid Jines one-by-one. If one ofthe selected points is 
within the specified maximum to!erance ofthe grid Jine, then that point is 
moved onto the grid line. The program frrst steps through all ofthe horizontal 
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grid !ines from bottom to top and then through al! the vertical grid lines fr~m 
left to right. 

Note that once a point is moved horizontal! y it will not be moved horizontal! y 
again because of another criterion further down the list. Simi!arly, once a 
point is moved vertical! y it will not be moved vertical! y again because of 
another criterion further down the list. However, a point that has been moved 
horizontal! y can still be moved vertical! y and vice versa. 

3. SAFE goes over al! ofthe column supports in the order in which they were 
input into the model. If one of the selected points is within the specified 
maximum tolerance of a vertical line passing through the column support then 
the point is moved to that vertical Iine. Similarly, if one ofthe selected points 
is within the specified maximum tolerance of a horizontal line passing through 
the column support then the point is moved to that horizontal line. 

Note that ifthe point is within the maximum specified tolerance in both the 
vertical and horizontal directions then it will move right on top ofthe column 
support. 

4. SAFE steps through each ofthe unselected points on the structural !ayer in the 
order that they were input into the model. If one ofthe selected points is 
within the specified maximum tolerance of a vertical line passing through the 
point currently being considered, then the other point is moved to that vertical 
Iine. Similarly, if one ofthe selected points is within the specified maximum 
tolerance ofa horizontal line passing through the point currently being 
considered, then the other point is moved to that horizontal Iine 

5. SAFE steps through each ofthe selected points that can still be moved in the 
order in which they were input into the model. If one ofthe other selected 
points is within the specified maximum toleran ce of a vertical !in e passing 
through the point currently being considered, then the other point is moved to 
that vertical line. Similar! y, if one ofthe other selected points is within the 
specified maximum tolerance of a horizontal !in e passing through the point 
currently being considered, then the other point is moved to that horizontal 
line. 

Note that if a point is moved in one direction to align with the considered 
point, then the considered point is assumed to have been moved once airead y 
in that direction and will not be moved in that direction again. 

Also note that at the end ofthis sequence there may be sorne selected points 
which were not moved at al!. 
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4. Tips on Using the Align Vertical/Horizontal Command 

l. From the moment you start your model yo u should try to align objects as 
much as possibleípractical. 

2. We recommend that you align points first for the structurallayer. then for the 
X-strip !ayer and fmaliy for the Y-strip !ayer. 

3. The best way for you to control where a point moves to is to creare a 
temporary grid line at the location where yo u want the point to move. 

4. You can use the Align Vertical/Horizontal command on local portions ofyour 
model or globally on the entire model. Our intent is for you to use it on local 
are as of your model. If yo u use the command globaliy then yo u should 
typicaliy use a smali value for the maximum move aliowed and yo u should 
check the model carefuliy to make sure yo u did not get any unanticipated 
aligning. 

5. The Align Vertical/Horizontal command may cause sorne objects to be 
deleted. lfthe two end points of a line object move on top of each other then 
the line object wili be deleted. If an area object ends up with no are a then the 
area object wili be deleted. 

Iftwo point objects end up one on top ofthe other then the point object that 
was moved merges into the other point object. The loads on the moved point 
object are added to the other point object. If the moved point object has 
support properties and the other point object does not, then the support 
properties are transferred to the other point object. Ifboth point objects ha ve 
support properties then the support properties for the moved point are lost and 
the support properties for the other point are maintained. 

6. The Undo command on the Edit menu does work for undoing the effects of 
the Align Vertical/Horizontal cornmand. 

7. We recommend that when yo u are learning how the Align Vertical/Horizontal 
command works you try it on a smali test model, not on a large model that 
yo u ha ve spent many hours developing. Once yo u are comfortable with the 
command on the test model then yo u can move on to using it in local areas of 
your real model. 

8. It is probably a good idea to make a backup copy ofyour model right before 
you use the Align Vertical/Horizontal command in case you later (perhaps the 
next da y) decide you want to go back to the old model. 

Safe Techmcal Note 2 - Align Vertical/Horizontal 
Initial Release Date: December 28, 1998 

Revision 1, January 11, 1998 
Page 3 of4 
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5. Final Comments 

We will be adding additional capability to the Align VerticaVHorizontal command in a future 
release. Specifically, we will add a feature that allows yo u to align to any specified line that can 
be drawn in any orientation. We will also add the capability to align vertically and horizontally 
separately. 

Safe Technical Note 2- Aligo Venical/Horizontal 
Initial Release Date: December 28, 1998 

Revision 1, January 11, 1998 
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GEOMETRIC STIFFNESS ANO 
P- DELTA EFFECTS 

P-Delta Effects, Due To Dead Load, Can Be Considered 
Without lteration For Both Static And Dynamic Analysis 

11.1. DEFINITJON OF GEOMETRIC STJFFNESS 

We are all aware that a cable. when subjected to a large tension force, has an 

increased lateral stiffness. If a long rod is subjected to a large compressive force, 

and is on the verge ofbuckling, we know that the lateral stiffness ofthe rod has been 

reduced significantly and a small lateral load may cause the rod to buckle. This 

general type of behavior is caused by a change in the "geometric stiffness" of the 

structure. lt is apparent that this stiffness is a function of the load in the structural 

member and can be either positive or negative. 

The fundamental equations for the geometric stiffness for a rod or a cable are very 

simple to derive. Consider the horizontal cable, shown in Figure 11.1, of length L 

with an initial tension T. lfthe cable is subjected to lateral displacements, v; and v,, 

at both ends, as shown. then addítional forces, F, and F; , must be developed for the 

cable element to be in equilibrium in its displaced position. Note that we have 

assumed all forces and displacements are positive in the up direction. We ha ve also 

made the assumption that the displacements are small and do not change the tension 

in the cable. 
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Figure 11.1. Forces Acting on a Cable Element 

Taking moments about point j in the defonned position, the following equilibrium 

equation can be written: 

T 
F=-(v-v) , L , 1 

And from vertical equilibrium the following equation is apparent: 

E;= -F, 

(1 1.1) 

(11.2) 

Combining Equation 11.1 and 11.2 the lateral forces can be expressed in terms of 

the lateral displacements by the following matrix equation: 

[F,]= T[ 1 -IJ[v'] 
F, L -1 1 v, 

or symbolically, (11.3) 

Note that the 2 by 2 geometric stiffuess, k•, matrix is not a function of the 

mechanical properties ofthe cable and is only a function ofthe element's length and 

the force in the element. Hence, the term "geometric" or "stress" stiffness matrix is 

introduced in order that the matrix has a different name than the "mechanical" 

stiffness matrix which is based on the physical properties of the element. The 

geometric stiffness exists in al/ structures; however, it only becomes importan! if it 

is large compared to the mechanical stiffuess of the structural system. 
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In the case of a beam element with bending properties in which the deformed shape 
is assumed to be a cubic function due to the rotations 1/;, and !/! 

1 
at the ends, 

additional moments M, and M
1 

are developed. Fro'm Reference [l) the force­

displacement relationship is given by the following equation: 

F, 36 3L -36 3L V 
' 

M, T 3L 4L2 -3L -L' t/J, 
= or,Fc=kcv (11.4) 

FJ 30L -36 -3L 36 -3L Vl 

Mj 3L -L' -3L 4L2 
t/JJ 

The well-known elastic force deformation relationship, for a prismatic beam without 

shearing deformations, is 

F, 12 6L -12 6L V 
' 

M, El 6L 4L2 -6L -2L2 t/J, 

F; =u -12 -6L 12 -6L 
or, FE =kEv ( 11.5) 

vj 

M} -6L -2L' -6L 4L2 t/Jj 

Therefore, the total forces acting on the beam element will be 

(11.6) 

Hence, if the large axial force in the member remains constant, it is only necessary 
to form the total stiffness matrix, k r , in arder to account for this stress stiffening or 

softening effect. 

11.2. APPROXIMATE BUCKLING ANAL YSIS 

In the case when the axial cornpressive force is large, T = - P, the total stiffness 

matrix of the beam can become singular. In arder to illustrate this instability, 

consider the beam shown in Figure 11.2 with the displacements at point j set to zero. 
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p El -~ 
J 

~--------~L~----------~/ 

Figure 11.2 Cantilever Beam Subjected to Buckling Load 

From Equation (11.6) the equilibrium equations for the beam. sho\\n in Figure 11.2, 

are in matrix form 

[12+36-1. 6L+3LA ]["·] [O] 
6L+3LA. 4L2 +4L2A. 1/J, = O 

(11.7) 

PL2 

Where A This eigenvalue problem can be solved for the lowest root =---
30EI 

which is 

A.,= -0.0858 or 

The well-known exact Euler buckling load for the cantilever beam is given by 

;r'EI 
p =--

cr 4 L2 

( 11.8) 

( 11. 9) 

Therefore, the approxirnate solution Equation (11.8), which is based on a cubic 

shape, is within five percent of the exact solution. 

Ifthe straight line approxirnation is used, given by Equation (11.3), an approxirnate 

buckling load of 3.0 E; is obtained. This is still a reasonable approximation. 
L 
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11.3. P-DEL TA ANAL YSIS OF BUILDINGS 

The use of the geometric stiffness matrix is a general approach to include secondary 

effects in the static and dynamic analysis of all types of structural systems. 

However, in Civil Structural Engineering it is commonly referred to as P-Delta 

Analysis that is based on a more physical approach. F or example, in buildmg 

analysis the lateral movement of a story mass to a deforrned position generales 

second-order ovenurning moments. This second-order behavior has been tcrrned the 

P-Delta effect since the additional ovenurning moments on the building are equal to 

the sum of story weights "P" times the lateral displacemems "Delta". 

Many techniques have been proposed for evaluating this second-order behavior. 

Rutenberg [2] summarized the publications on this topic and presents a simplified 

method to include these second-order effccts. Sorne methods consider the problem 

as one of geometric non-linearity and propase iterative solution techniques that can 

be numerically inefficient. Also, these iterative methods are not appropriate for 

dynamic analysis where the P-Delta effect causes lengthening of the periods of 

vibration. The equations presented in this section are not new. However, the simple 

approach used in their derivation. should add physical insight to the understanding of 

P-Delta behavior in buildings [3]. 

The P-Delta problem can be linearized and the solution to the problem obtained 

directly and exactly, without iteration, in building type structures where the weight 

of the structure is constan! during lateral motions and the overall structural 

displacements can be assumed to be small compared to the structural dimensions. 

Furtherrnore, the additional numerical effort required is negligible. 

The method does not require iteration since the total axial force at a story leve! is 

equal to the weight of the building above that leve! and does not change during the 

application of lateralloads. Therefore, the sum of the colurnn of geometric stiffness 

terrns associated with the lateral loads cancels and only the axial forces due to the 

weight of the structure need be included in the evaluation of the geometric stiffness 

terrns for the complete building. 

The effects of P-Delta are implemented in the basic analytical forrnulation that 

causes the effects to be consistently included in both static and dynamic analyses. 

The structural displacements and the mode shapes and frequencies thus obtained 
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indicate the structural softening automatically. Member forces satisfY both static and 

dynamic equilibrium and reflect the additional P-Delta moments consisten! with the 

calculated displacements directly. 

Leve! 

1 

2 

i + 1 

N 

-
( a ) Displaced position 

of story weights 

h, 
i + 1 

-
( b) Additional overturning 

moments or lateral loads 

Figure 11.3 Overturning Loads Dueto Translation of Story Weights 

The vertical "cantilever type" structure shown in Figure 11.3 (a) is considered to 

illustrate the basic problem. Under lateral displacements let us consider the 

additional overtuming moments due to one mass, or story weight, at leve! "i'". The 

total overtuming effects will be the sum of all story weight contributions. Figure 

11.3 (b) indica tes statically equivalen! force systems which produce the same 

overtuming moments. Or, in terms of matrix notation 

[ f;] = ~ [ l.O][u;] 
f,., h, -LO 

{11.10) 
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The lateral forces shown in Figure 11.3 (b) can be evaluated for al! stories and 

added to the externa! loads on the structure. The resulting lateral equilibrium 

equation of the structure is 

Ku=F+Lu (11.11) 

where K is the lateral stiffness matrix with respect to the lateral story 

displacements u. The vector F represents the known lateral loads and L is a matrix 
that comain> w, 1 h, factors. Equation ( 11.11) can be rewritten in the form 

* K u=F (11.12) 

* where K =K-L 

Equation (11.12) can be solved directly for the lateral displacements. lfintemal member 

forces are evaluated from these displacements, consisten! with the linear theory used, it 

will be found that equilibrium \\ith respect to the deformed position has been obtained . 
• 

One minar problem exists with the solution ofEquation (11.12)- the matrix K is not 

symmetric. However, it can be made symmetric by replacing the lateralloads shown in 

Figure 11.3 (b) with another statically equivalen! load system. 

From simple statics the total contribution to ovenuming. due to the relative story 
displacement "U

1 
- ll

1
+1 ",can be written as 

[ 
f; ] W [ LO 

f,., = t -1.0 -1.0][ U; ] 

1.0 u,., 
(11.13) 

where W; is the total dead load weight above story "i". The L matrix is now 

symmetrical and no special non-symmetric equation solver is required. 

lt is of significan! interest to note that Equation (11.13) is the exact form of the 

"geometric stiffness", Equation (11.3), for a column including axial force effects 

only. Therefore, the physical development given here is complete! y equivalen! to the 

more theoretical approach normally used to formulate the incremental stiffness in 

nonlinear structural analysis. 
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The equilibrium of a complete building can be formulated in terms of the lateral 

displacement of the !loor leve!. Then, one can evaluate the contribution to the total 

geometric stiffness for each column at a particular story leve! in which the effects of 

the externa! lateral loads F are included in the evaluation of the axial forces in all 

columns. If this approach is used, the total geometric stiffness at !he lateral 

equilibrium leve! is identical to Equation (11.13) since the lateral axial forces F do 

not produce a net increase in the total of all axial forces which exist in the columns 

at any leve!. Such a refined analysis must be iterative in nature; however, it does not 

produce more exact results. 

It is clear that the beam-column stiffness effects, as defined by Equation ( 11.4), ha ve 

been neglected. The errors associated with these cubic shape effects can be 

estimated at the time member forces are calculated. However, the method presented 

here does mclude the overall large displacement side-sway behavior of the complete 

structure that is associated with the global stability of the building. 

J 
Y dwl dqy \ / / u,¡;Y rdqx 

J.~ "xi X 
Center of Mass 

Level i 

~:. 
Level i + 1 

Figure 11.4 Mass Distribution at Typical F/oor Leve/ 

11.4. EQUATIONS FOR THREE-DIMENSIONAL BUILDINGS 

Equation (11.13) can be applied directly in both directions for buildings in which the 

centroids are the same for all story levels. However, for the more general building 

the equations for the story couples are more complicated. A general !bree­

dimensional building system is shown schematically in Figure 1 1 .4. It is assumed 
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that the three dimensional building stiffness of the system has been formulated with 

respect to the two lateral displacements, u,; , u y;, and rotation, un , at the center of 

mass at each story leve!. In addition to the overtuming forces given by Equation 

11.13, secondary forces exist due to the distribution of the story mass o ver a finite 

floor size. 

The first step, prior to the development of the 6 by 6 geometric stiffness matrix for 

each story, is to calculare the location of the centcr of mass and the rotational 

moment of inertia for all story levels. For a typical story "i" it is then necessary to 

calcula te the total weight and centro id of the structure above that leve!. Due to the 

relative displacements between story "i" and story "i + 1 ", from Equation 11.13, 

forces must be developed to maintain equilibrium. These forces and displacements 

must then be transformed to the center of mass at both leve! "i" and "i + 1 ". 

11.5. THE MAGNITUDE OF P-DELTA EFFECTS 

The comparison of the results of two analyses with and without P-Delta will 

illustrate the magnitude of the P-Delta effects. A well-designed building usually has 

well-conditioned leve! by leve! stiffness/weight ratios. For such structures, P-Delta 

effects are usually not very significan!. The changes in displacements and member 

forces are less than 10%. 

However, ifthe weight ofthe structure is high in proportion to the lateral stiffness of 

the structure, the contributions from the P-Delta effects are highly amplified and, 

under certain circumstances, can change the displacements and member forces by 25 

percent or more. Excessive P-Delta effects will eventually introduce singularities 

into the solution, indicating physical structure instability. Such behavior is clearly 

indicative of a poorly designed structure that is in need of additional stiffness. 

An analysis of a 41-story steel building was conducted with and without P-Delta 

effects. The basic construction was braced frame and welded steel shear wall. The 

building was constructed in a region where the principallateralloading is wind. The 

results are summarized in Table 11.1. 

" 
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Table 11.1. P-Delta Effects on Typical Building 

Without P-Delta With P-Delta 

F~rst Mode Penad (seconds) 5.33 5.52 

Second Mode Period (seconds) 4.21 4.30 

Third Mode Period (seconds) 4.01 4.10 

Fourth Mode Period (seconds) 1.71 1.75 

Wind D1splacement (inches) 7.99 8.33 

Since the building is relatively stiff, the P-Delta effects are minimal. Also, it is 

apparent that P-Delta effects are less importan! for higher frequencies. 

11.6. P-DEL TA ANAL VSIS WITHOUT COMPUTER PROGRAM 
MODIFICA TI ON 

Many ehgineers are using general purpose, structural analysis programs for 

buildings that cannot be easily modified to include the equations presented here. 

Equation 11.4 presents the form of the lateral force-displacement equations for story 

"i". We note that the form of this 2 x 2 geometric stiffuess matrix is the same as the 

stiffness matrix for a prismatic colurnn that has zero rotations at the top and bottom. 

Therefore, it is possible to add "dummy columns" between story levels of the 

building and assign appropriate properties in order to achieve the same effects as the 

use of geometric stiffness [2]. The force-displacement equations of the "dummy 

column" are 

(11.14) 

Therefore, if the moment of inertia of the column is selected as 

1 (11.15) 

The dummy colurnn will have the same negative stiffness values as the linear 

geometric stiffness 
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11.7. EFFECTIVE LENGTH · K FACTORS 

The solution procedure for the P-Delta effects described in this chapter has been 

implemented and verified in the ET ABS program. The application of the method of 

analysis presented in this chapter should lead to the elimination of the column 

effective length (K-) factors, since the P-Delta effects automatically produce the 

required design moment amplifications. Also, the K-factors are approximate, 

complicated. and time-consuming to calculate. Building codes for concrete [ 4] and 

steel [5] now allow explicit accounting of P-Delta effects as an altemative to the 

more involved and approximate methods of calculating moment magnification 

factors for most column designs. 

11.8. GENERAL FORMUlATION OF GEOMETRY STIFFNESS 

Jt is relatively simple to develop the geometric stiffness matrix for any type of 

displacement based finite element [1]. lt is only necessary to add to the linear strain­

displacement equations, Equation (2.3), the higher order nonlinear terms. These 

large strain equations, in a local x-y-z reference system. are 

Ollx I-r­
E: =--+-u u 

.f ax 2 ,X ,.r 

Oll ,. I -r­
t:,. = ély +2u_,.u,. 

0!1. J -T­e =--·+-u u ' oz 2 ·' ·' 

oux ou,. I-r- I-r­
y =--+--· +-u u +-u u 

xy oy OX 2 .x.y 2 .y.x 

ou. 0!1. I-r- I-r­Y =--·+--·+-u u +-u u 
~ OZ dX 2 .x •' 2 ·' ,x 

ou,. ou. I-r- I-r-y =--· +---+-u u +-u u 
T- OZ 0X 2 ,X ,Y 2 ,y ,X 

The nonlinear terms are the product of matrices that are defined as 

(11.16) 

;. 

., 
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(11.17) 

Equation (11.16) can be expressed in terms of the following sum of linear and 

nonlinear components: 

(11.18) 

These strain-displacement equations, written in terms of engineering strains and in 
matrix notation, are identical to the classical Green-Lagrange strains. This is often 
referred to as the total Lagrangian approach in which the strains are computed with 
respectto the original reference system and the large rigid-body rotation is exact. 

If the initial stress es are large, the potential energy of the structure must be modified 
by the addition of the following terro: 

The initial stresses are defined as 

(11.19) 

Equation ( 11.19) can be written in the following forro: 

¡·· s,X}. Tl n.=~J~.~ u: l s,x 
x: .x 1 

-T 
s,, ~·' dV=2fgrSgdV (11.20) u,y S J'1.' 

S" S Z_l S" U, 

The 3 by 3 initial stress matrices are ofthe following form: 

o 
(11.21) 

Using the same shape functions as used to forro the element stiffuess matrix, the 

derivatives of the displacements can be written as 

g=Gu (11.22) 
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Therefore. the geometric stiffness for any element can be calculated from 

(11.24) 

For most finite elements the geometric stiffness IS evaluated by numerical 

integration. 

11.9. SUMMARY 

The SAP2000 program has the option to add a three-dimensional geometric stiffness 

matrix to each frame element. Therefore, guyed towers, cable stay and suspension 

bridges can be modeled if the tension in the cable is not modifted by the application 

of the load. If the initial axial forces in the elements are signiftcantly changed by the 

addition of loads, iteration may be required. However. in the case of dynamic 

analysis the evaluation of the eigen or LDR vectors must be based on one set of 

axial forces. 

Most traditional methods for incorporating P-Delta effects in analysis of buildings 

are based on iterative techniques. These techniques are time-consurning and are, in 

general, used for static analysis only. For building structures, the mass, which 

causes the P-Delta effect, is constan! irrespective of the lateral loads and 

displacements. This information is used to linearize the P-Delta effect for buildings 

and solve the problem "exactly", satisfying equilibrium in the deformed position 

without iterations. An algorithrn is developed that incorporales P-Delta effects into 

the basic formulation of the structural stiffness matrix as a geometric stiffness 

correction. This procedure can be used for static and dynamic analysis and will 

account for the lengthening of the periods and changes in mode shapes due to P­

Delta effects. 

A well designed building should not ha ve significan! P-Delta effects. Analyses with 

and witltout tite P-Delta effects will yield the magnitude of the P-Delta effects 

separately. If these lateral displacements differ by more than 5%, for tite same 

lateral load, the basic design may be too flexible and a redesign should be 

considered. 

,. 
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The current SEA OC Blue Book states "the drift ratio of0.02/Rw serves to define the 

threshold of deformation beyond which there may be significan! P-De!ta effects". 

Clearly, if one includes P-Delta effects in all analyses one can disregard this 

statement. If the loads acting on the structure have been reduced by a ductility 

factor Rw. however, the P-Delta effects shou!d be amplified by Rw in order to retlect 

u!timate load behavior. This can be automatically included in a computer program 

by using a multiplication factor for the geometric stiffness terms. 

lt is possible to calculate geometric stiffness matrices for all types of finite elements. 

The same shape functions used in the development of elastic stiffness matrices are 

used in the calculation of the geometric stiffness matrix. 
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12.1 INTRODUCTION 

DYNAMIC ANAl VSIS 

Force Equilibrium Is Fundamental In 
The Dynamic Analysis Of Structures 

All real physical structures, when subjected to loads or displacements, behave 
dynamically. The additional inertia forces,from Newton 's second law, are equal to 
the mass times the acceleration. If the loads or displacements are applied very 
slowly then the inertia forces can be neglected and a static load analysis can be 
justified. Hence, dynamic analysis is a simple extension of static analysis. 

In addition, all real structures potentially have an infinite number of displacements. 
Therefore, the most critica! phase of a structural analysis is to create a computer 
model, with a finite number of mass!ess members anda finite number of node (joint) 
displacements, that will simulare the behavior of the real structure. The rnass of a 
structural system, which can be accurately estimated, is lumped at the nodes. Also, 
for linear e!astic structures the stiffness properties of the members, with the a id of 
experimental data, can be approximated with a high degree of confidence. However, 
the dynamic loading, energy dissipation properties and boundary (foundation) 
conditions for many structures are difficult to estimate. This is always true for the 
cases of seismic input or wind loads. 

To reduce the errors that may be caused by the approximations summarized in the 
previous paragraph, it is necessary to conduct many different dynamic analyses 
using different computer models, loading and boundary conditions. It is not 
unrealistic to conduct 20 or more computer runs to design a new structure or to 
investiga te retrofit options for an existing structure. 



2 STA TIC AND DYNAMIC ANAL YSIS 

Because of the Jarge number of computer runs required for a typical dynamic 
analysis, it is very importan! that accurate and numerically efficient methods be used 
within computer programs. Sorne of these methods ha ve been developed by the 
author and are relatively new. Therefore, one of the purposes of this book is to 
summarize these numerical algorithms, their advantages and limitations. 

12.2 DYNAMIC EQUILIBRIUM 

The force equilibrium of a multi-degree-of-freedom lumped mass system as a 

function of time can be expressed by the following relationship: 

F(t)1 + F(t)n + F(t)5 = F(t) (12.1) 

in which the force vectors at time 1 are 

F(¡)1 is a vector of inenia forces acting on the node masses 

F(tJn is a vector ofviscous damping, or energy dissipation, forces 

F(t)5 is a vector of interna] forces carried by the structure 

F (t) is a vector of extemally applied loads 

Equation (12.1) is based on physicallaws and is valid for both linear and nonlinear 

systems if equi1ibrium is formulated with respect to the deforrned geometry of the 

structure. 

For many structural systems, the approximation of linear structural behavior is 

made in arder to con ven the physical equilibrium statement, Equation (12 .1 }, to the 

following set of second-order, linear, differential equations: 

M ü(t). + e iJ.(t). + K u(t). = F(t) (12.2) 

in which M is the mass matrix (lumped or consisten!), e is a viscous damping 

matrix (which is norrnally selected to approximate energy dissipation in the real 

structure) and K is the static stiffness matrix for the system of structural elements. 
The time-dependen! vectors u(t). , iJ.(t). and ü(t). are the absolute node 

displacements, velocities and accelerations, respective! y. 
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Many books on structural dynamics present severa! different methods of applied 

mathernatics to obtain the exact solution ofEquation (!2.2). Within the past severa! 

years, however, with the general availability of inexpensive, high-speed personal 

computers (see AppendlX Z) the exact solution of Equation (!2.2) can be obtained 

without the use of complex mathematical techniques. Therefore, the modem 

structural engineer, with a physical understanding of dynamic equilibrium and 

energy dissipation, can perfonn dynamic analysis of complex structural systems. A 

strong engineering rnathernatical background is desirable: however, in my opinion, it 

is no longer mandatory. 

F or seismic loading, the externa! loading F (t) is equal to zero. The basic seismic 

motions are the three components of free-field ground displacements u{t),g that are 

known at sorne point below the foundation leve! of the structure. Therefore, we can 
write Equation (!2.2) in terms of the displacements u(t), velocities ü(t) and 

accelerations ü(t) that are relative to the three components of free-field ground 

displacements. 

Therefore, the absolute displacements, velocities and accelerations can be eliminated 

from Equation ( 12.2) by writing the following simple equations: 

u(t)a = u(t) + 1, u{t),, + I,. u(t),, + 1, u(t)"' 

ü(t)a = ü(t) + lx u(t),, + ly u(t),.g + 1, u{t),g (12.3) 

Ü{l}a = Ü{l} + lx Ü{/},
8 

+ I, Ü{l}yg + 1, Ü{t},g 

where 1, is a vector with ones in the "i" directional degrees-of-freedom and zero in 

all other positions. The substitution of Equation (!2.3) into Equation (12.2) allows 

the node point equilibrium equations to be rewritten as 

Mü{t) + Cu(t) + Ku(t) = -M,ü{t),, - M,.ü(t),. - M,ü(t),g (12.4) 

where M,= MI,. 
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The simplified fonn of Equation (1 2.4) is possible sine e the rigid body velocities and 

displacements associated with the base motions cause no additional damping or 

structural forces to be developed. 

lt is importan! for engineers to realize that the displacements, which are nonnally 

printed by a computer program, are relative displacements and that the fundamental 

loading on the structure is foundation displacements and not extemally applied loads 

at the joints of the structure. For example, the static pushover analysis of a 

structure is a poor approximation of the dynarnic behavior of a three dimensional 

structure subjected to complex time-dependen! base motions. Also, one must 

calculate absolute displacements to properly evaluate base isolation systems. 

There are severa! different classical methods that can be used for the solution of 

Equation (12.4). Each method has advantages and disadvantages that depend on the 

type of structure and loading. T o provide a general background for the various 

topics presented in this book. the different numerical solution methods are 

summarized below. 

12.3 STEP BY STEP SOLUTION METHOD 

The most general solution method for dynarnic analysis is an incremental method in 
which the equilibrium equations are solved at times 111, 2ill, 3ill, etc. There are 

a large number of different incremental solution methods. In general, they involve a 

solution of the complete set of equilibrium equations at each time increment. In the 

case of nonlinear analysis, it may be necessary to refonn the stiffness matrix for the 

complete structural system for each time step. Also, iteration may be reqUired 

within each time increment to satisty equilibrium. As a result of the large 

computational requirements it can take a significan! amount of time to solve 

structural systems with just a few hundred degrees-of-freedom. 

In addition, artificial or numerical damping must be added to most incremental 

solution methods in order to obtain stable solutions. For this reason, engineers must 

be very careful in the interpretation of the results. For sorne nonlinear structures, 

subjected to seisrnic motions, incremental solution methods are necessary. 

For very large structural systems, a combination of mode superposition and 

incremental methods has been found to be efficient for systems with a small number 
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of nonlinear members. This method has been incorporated in the new versions of 

SAP and ET ABS and will be presented in detaillater in this book. 

12.4 MODE SUPERPOSITION METHOD 

The most common and effective approach for seismic analysis of linear structural 

systems is the mode superposition method. This method, after a set of orthogonal 

vectors are evaluated, reduces the large set of global equilibrium equations to a 

relatively small number of uncoupled second order differential equations. The 

numerical solution of these equations involves greatly reduced computational time. 

1t has been shown that seismic motions excite only the lower frequencies of the 

structure. Typically, earthquake ground accelerations are recorded at increments of 

200 points per second. Therefore, the basic loading data does not contain 

infonnation over 50 cycles per second. Hence, neglecting the higher frequencies and 

mode shapes of the system nonnally does not introduce errors. 

12.5 RESPONSE SPECTRA ANAL YSIS 

The basic mode superposition method, which is restricted to linearly elastic analysis, 

produces the complete time history response of joint displacements and member 

forces due to a specific ground motion loading [1,2]. There are two major 

disadvantages of using this approach. First, the method produces a large amount of 

output infonnation that can require an enonnous amount of computational effort to 

conduct all possible design checks as a function of time. Second, the analysis must 

be repeated for severa! different earthquake motions in order to assure that all the 

significan! modes are excited, since a response spectrum for one earthquake, in a 

specified direction, is nota smooth function. 

There are significan! computational advantages in using the response spectra method 

of seismic analysis for prediction of displacements and member forces in structural 

systems. The method involves the calculation of only the rnaximum values of the 

displacements and member forces in each mode using smooth design spectra that are 

the average of severa! earthquake motions. In this book, we will recommend the 

CQC method to combine these maximum modal response values to obtain the most 

probable peak value of displacement or force. In addition, it will be shown that the 

,, 

'' 
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SRSS and CQC3 methods of combining results from orthogonal earthquake motions 

will allow one dynamic analysis to produce design forces for al! members in the 

structure. 

12.6 SOLUTION IN THE FREQUENCY DOMAIN 

The basic approach, used to salve the dynamic equilibrium equations in the 
frequency domain, is to expand !he externalloads F(t) in terms ofFourier series or 

Fourier integrals. The solution is in terms of complex numbers that cover !he time 

span from - oo to oo. Therefore, it is very effective for periodic types of loads such 

as mechanical vibrations, acoustics, sea-waves and wind [1]. However, the use of 

the frequency domain solution method for solving structures subjected to earthquake 

motions has !he following disadvantages: 

l. The mathematics, for most structural engineers including myself, is difficult to 

understand. Also, the solutions are difficult to verify. 

2. Earthquake loading is not periodic; therefore, it is necessary to select a long time 

period in arder that the solution from a finite length earthquake is completely 

damped out prior to the application of the same earthquake at the start of the next 

penad of loading. 

3. For seismic type loading the method is not numerically efficient. The 

transfonnation of the result from the frequency domain to the time doma in, even 

with the use of Fas! Fourier Transfonnation methods, requires a significan! 

amount of computational effort. 

4. The method is restricted to the solution of linear structural systems. 

5. The method has been used, without sufficient theoretical justification, for the 

approximate nonlinear solution of site response problems and soil/structure 

interaction problems. Typically, it is used in an iterative manner to create linear 

equations. The linear damping terms are changed after each iteration in arder to 

approximate !he energy dissipation in the soil. Hence, dynamic equilibrium, 

within !he soil, is not satisfied. 
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12.7 SOLUTION OF LINEAR EQUATIONS 

The step·by-step solution of the dynamic equilibrium equations, the solution in the 

frequency doma in, and the evaluation of eigenvectors and Ritz vectors all require the 

solution of linear equations of the following form: 

AX = B (12.5) 

Where A is an N by N' symmetric matrix which contains a large number of zero 

terms. The N by M' X displacement and B load-matrices indicate that more than 

one load condition can be sol ved at the same time. 

The method used in many computer programs, including SAP2000 [5] and ET ABS 

[ 6], is based on the profile or active column method of compact storage. Beca use 

the matrix is symmetric, it is only necessary to form and store the first nonzero term 

in each column down to the diagonal term in that column. Therefore, the sparse 

square matrix can be stored as a one dimensional array along with a N by 1 integer 

array that indicates the location of each diagonal term. If the stiffness matrix 

exceeds the high-speed memory capacity of the computer a block storage form of !he 

algorithm exists. Therefore, the capacity of the solution method is governed by the 

low speed disk capacity of the computer. This solution method is presented in detail 

in Appendix C of this book. 

12.8 UNDAMPED HARMONIC RESPONSE 

The most common and very simple type of dynamic loading is the applica!ion of 

steady-state harmonic loads of the following form: 

F(t) = f sin (W t) (12.5) 

The node point distribution of all static load patterns, f , which are not a function of 

time, and the frequency of the applied loading, w , are user specified. Therefore, 

for the case of zero damping, the exact node point equilibrium equations for the 

structural system are 

Mü(t) + Ku(t) f sin(Wt) (12.6) 

•· 

.!' 
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The exact steady-state solution of this equation requires that the nade point 

displacements and accelerations are given by 

u(t) = v sin( m t), ü(t) = -v m2 sin(mt) ( 12.7) 

Therefore, the harmonic nade point response amplitude is given by the solution of 

' the following set of linear equations: 

[K - m 2 M]v = f or Kv = f (12.8) 

1t is of interest to note that the normal solution for static loads is nothing more than a 

solution of this equation for zero frequency for all loads. lt is apparent that the 

computational effort required for the calculation of undamped steady-state response 

is almost identical to that required by a static load analysis. Note that it is not 

necessary to eva!uate mode shapes or frequencies to salve for this very common type 

of !oading. The resulting nade point displacements and member forces vary as 

sin (m t) . However, other types of !oads that do not vary with time, such as dead 

loads, must be evaluated in a separate computer run. 

12.9 UNDAMPED FREE VIBRATIONS 

Most structures are in a continuous state of dynamic motion because of random 

loading such as wind, vibrating equipment, or human Ioads. These small ambient 

vibrations are normally near the natural frequencies of the structure and are 

terminated by energy dissipation in the real structure. However, special instruments 

attached to the srructure can easily measure the motion. Ambient vibrarían field 

tests are often used ro calibra te computer models of structures and their foundations. 

After all externa! loads are removed from the structure, the equilibrium equation, 

which govems the undamped free vibration of a typical displaced shape v, is 

Mv+Kv=O (12.9) 

At any time the displaced shape v may be a natural mode shape of the system, or 

any combination of the natural mode shapes. However, it is apparent the total 

energy within an undamped free vibrating system is a constan! with respect to time. 

The sum of the kinetic energy and strain energy, at all points in time, is a constan! 
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and JS defined as the mechanical energy of the dynamic system and can be 

calcuiated from: 

l.T]\~" ITK =-v .v+-v v 
2 2 

( 12.1 0) 

12.10 SUMMARY 

Dynamic analysis of three dimensional structural systems is a direct extension of 

static analysis. The elastic stiffness matrices are the same for both dynamic and 

static analysis. It is only necessary to lump the mass of the structure at the joints. 

The addition of inertia forces and energy dissipation forces will satisfy dynamic 

equilibrium. The dynamic solution for steady state harmonic loading, without 

damping, involves the same numerical effort as a static solution. Classically, there 

are rnany different mathematical methods to solve the dynamic equilibrium 

equations. However, it will iater be shown in tlus book that the majority of both 

linear and nonlinear systems can be sol ved with one numerical method. 

Energy is fundamental in dynamic analysis. At any point in time the externa! work 

supplied to the system must be equal to the sum of the kinetic and strain energy plus 

the energy dissipated in the system. 

lt is my opinion, with respect to earthquake resistan! design, that we should try to 

minimize the mechanical energy in the structure. lt is apparent that a rigid structure 

will have only kmetic energy and zero strain energy. On the other hand. a 

completely base isolated structure will have zero kinetic energy and zero strain 

energy. A structure cannot fail if it has zero strain energy. 
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DYNAMIC ANALYSIS USING 
RESPONSE SPECTRUM 

SEISMIC LOADING 

Prior To The Existence Of Inexpensive Personal Computers 
The Response Spectrum Method Was The Standard Approach 

For Linear Seismic Analysis 

15.1 INTRODUCTION 

The basic mode superposition method, which is restricted to Iinearly elastic analysis, 

produces the complete time history response of joint displacements and member 

forces. In the past there have been two majar disadvantages in the use of this 

approach. First, the method produces a large amount of output infonnation that can 

require a significan! amount of computational effort to conduct aii possible design 

checks as a function of time. Second, the analysis must be repeated for severa! 

different earthquake motions in order to assure that aii frequencies are excited, since 

a response spectrum for one earthquake in a specified direction is not a smooth 

function. 

There are computational advantages in using the response spectrum method of 

seismic analysis for prediction of displacements and member forces in structural 

systems. The method involves the calculation of only the maximum values of the 

displacements and member forces in each mode using smooth design spectra that are 

the average of severa! earthquake motions. 
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The purpose of this chapter is to sununarize the fundamental equations used in the 

response spectrum method and to point out the many approximauons and limitations 

of the method. For, example it cannot be used to approximate the nonlinear 

response of a complex three-dimensional structural system. 

The recen! in crease in the speed of computers has made it practica! to run many time 

history analyses in a short period of time. In addition, it is now possible to run 

design checks as a function of time, which produces superior results, since each 

member is not designed for rnaximum peak values as required by the response 

spectrum method. 

15_2 DEFINITION OF A RESPONSE SPECTRUM 

For three dimensional seismic motion, the typical modal Equation (13.6) is rev.Titten 

as 

Y(t), + 2 r;, (J), j;(t), + (¡)~ y(t), = 
( 15.1) 

where the three Mode Participation Factors are defined by p,. = - ¡'),r M, in 

which i is equal to x, y or z. Two majar problems must be solved in arder to obtain 

an approximate response spectrum solution to this equation. First, for each 

direction of ground motion rnaximum peak forces and displacements mus! be 

estimated. Second, after the response for the three orthogonal directions is solved it 

is necessary to estimate the maximum response due to the three components of 

earthquake motion acting at the same time. This section will address the modal 

combination problem due to one componen! of motion only. The separate problem 

of combining the results from motion in three orthogonal directions will be discussed 

la ter m this chapter. 

For input in one direction only, Equation (15.1) is written as 

Y(!), + 2(,w,y(t), + w~y(t), = p,.ü(t), ( 15.2) 
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Given a specified ground motion ü(t)
8

, damping value and assuming p., =-LO it 

is possible to solve Equation (15.2) at various values of W and plot a curve of the 
maximum peak response y( m) MAX. For this acceleration input, the curve is by 

definition the displacement response spectrum for the earthquake motion. A 

different curve will exist for each different value of damping. 

A plot of llJ y(w) MAX is defined as the pseudo-ve/ocity spectrum and a plot of 

w'y(w)MAX is defined as thepseudo-acceleration spectrum. These three curves 

are normally plotted as one curve on special log paper. However, these pseudo­

values have minimum physical significance and are not an essential part of a 

response spectrum analysis. The true values for maximum velocity and acceleration 

must be calculated from the solution ofEquation (15.2). 

There is a mathematical relat1onship, however, between the pseudo-acceleration 

spectrum and the total acceleration spectrum. The total acceleration of the unit 

mass, single degree-of-freedom system, governed by Equation (15.2), is given by 

Ü(t)T = ji(t)+Ü(t)8 (15.3) 

Equation (15.2) can be solved for ji(t) and substituted into Equation (15.3) which 

yields 

ii(t) r = -w' y(t)- 2~(o/(t) (15.4) 

Therefore, for the special case of zero damping, the total acceleration of the system 

is egua! to w'y(t). For this reason, the displacement response spectrum curve is 

normally not plotted as modal displacement y(w)MAX vs W. lt is standard to 

present the cur-Ve in terms of S( llJ) vs. a period T in seconds. where 

S(w)" = w'y(w)MAX and T= 2n 
llJ 

(l5.5a) and (l5.5b) 

The pseudo-acceleration spectrum, S(w),, curve has the units of acceleration vs. 

period which has sorne physical significance for zero damping only. It is apparent 

that all response spectrum curves represen! the properties of the earthquake at a 

specific si te and are not a function of the properties of the structural system. After 

•r 
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an estimation is made of thé linear viscous damping properties of the structure, a 

specific response spectrum curve is selected. 

15.3 CALCULATION OF MODAL RESPONSE 

The maximum modal displacement, for a structural model. can now be calculated 
for a typical mode n with period T, and corresponding spectrum response value 

S(mJ. The maximum modal response associated with period T, is given by 

(T) _S(m,) 
YnMA.r- 2 m, 

( 15.6) 

The maximum modal displacement response of the structural model is calculatcd 

from 

( 15. 7) 

The corresponding interna! modal forces, f.,, are calculated from standard matrix 

structural analysis using the same equations as required in static analysis. 

15.4 TYPICAL RESPONSE SPECTRUM CURVES 

A ten second segment ofthe Loma Prieta earthquake motions, recorded on a soft si te 

in the San Francisco Bay Area, is shown in Figure 15.1. The record has been 

corrected, by use of an iterative algorithm, for zero displacement, velocity and 

acceleration at the beginning and end of the ten second record. For the earthquake 

motions given in Figure 15.la, the response spectrum curves for displacement and 

pseudo-acceleration are summarized in Figure 15.2a and 15.2b 

The velocity curves have been intentionally omitted since they are not an essential 

part of the response spectrum method. Furtherrnore, it would require considerable 

space to clearly define terrns such as peak ground velocity, pseudo velocity 

spectrum, relative velocity spectrum and absolute velocity spectrum. 
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The maximum ground acceleration, for the earthquake defined by Figure 15.1 a. is 

20.01 percent of gravity at 2.92 seconds. It is importan! to note that the pseudo 

acceleration spectrum, shown in Figure 15.2b, has the same value for a very short 

period system. This is due to the physical fact that a very rigid structure moves as a 

rigid body and the relative displacements within the structure are equal to zero as 

indicated by Figure 15.2a. Also, the behavior of a rigid structure is nota function of 

the viscous damping value. 

The maximum ground displacement shown in Figure 15.1 b is -11.62 inches at 1.97 

seconds. For long period systems, the mass of the one-degree-of-freedom structure 

does not move significantly and has approximately zero absolute displacement. 

Therefore, the relative displacement spectrum curves, shown in Figure 15.2a, will 

converge to 11.62 inches for long periods and all values of damping. This type of 

real physical behavior is fundamental to the design of base isolated structures. 

The relative displacement spectrum, Figure 15.2a, and the absolute acceleration 

spectrum, Figure 15.2b, have physical significance. However, the maximum 

relative displacement is directly proportional to the maximum forces developed in 

the structure. For this earthquake the maximum relative displacement is 18.9 inches 

at a period of 1.6 seconds for one percent damping and 16.0 inches at a period of 

four seconds for five percent damping. It is importan! to note the significan! 

difference between one and five percent damping for this typical soft site record. 

Figure 15.2b, the absolute acceleration spectrum, indicates maximum values at a 

period of 0.64 seconds for both values of damping. Also, the multiplication by 

m' tends to completely elirninate the infortnation contained in the long period range. 

Since most structural failures, during recen! earthquakes, ha ve been associated with 

soft sites, perhaps we should consider using the relative displacement spectrum as 

the fundamental form for selecting a design earthquake. The high frequency, short 

period, part ofthe curve should always be defined by 

or 
(T) .. T2 

y MAX = Ug MAX 
411

2 (15.8) 

where ü, MAX is the peak ground acceleration. 
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15.5 THE CQC METHOD OF MODAL COMBINATION 

The most conservative method that is used to estimate a peak value of displacement 

or force within a structure is to use the sum of the abso!ute of the modal response 

va!ues. This approach assumes that the maximum modal values, for all modes, 

occur at the same point in time. 

Another very common approach is to use the Square Root of the Sum of the 

Squares, SRSS, on the maximum modal values in order to estimate the values of 

displacement or forces. The SRSS method as sumes that all of the maximum modal 

values are statistically independent. For three dimensional structures, in which a 

large number of frequencies are almost identica!, this assumption is not justified. 

The relatively new method of modal combination is the Complete Quadratic 

Combination, CQC, method [2] that was first pubiished in 198 J. It is based on 

random vibration theories and has found wide acceptance by most engineers and has 

been incorporated as an option in most modern computer programs for seismic 

analysis. Because many engineers and building codes are not requiring the use of 

the CQC method, one purpose of this chapter is to explain by example the 

advantages of using the CQC method and illustrate the potential problems in the use 

of the SRSS method of modal combination. 

The peak value of a typical force can now be estimated, from the maximum modal 

values, by the CQC method with the application of the following double summation 

equation: 

(15.9) 

where /, is the modal force associated with mode n. The double summation is 

conducted over all modes. Similar equations can be applied to node displacements, 

relative displacements and base shears and ovenurning moments. 

The cross-modal coefficients, P,m, for the CQC method with constan! damping are 

P,m = (!- r 2 
)' + 4(1r(l + r)2 

8(' (1 + r) r 312 

(15.10) 
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where r = úJ, 1 úJ m and must be equal to or less than 1.0. lt is importa m to note 

that the cross-modal coefficient arra y is symmetric and all terrns are positive. 

15.6 NUMERICAL EXAMPLE OF MODAL COMBINATION 

The problems associated with the use of the absolute sum and the SRSS of modal 

combination can be illustrated by their application to the four story building shown 

in Figure 15.3. The building is symmetrical; however, the center of mass, of all 

floors, is located 25 inches from the geometric center of the building. 

Frame# 1 ~ 
• 

,._ 200" ~i<-150''-+- 200" ~¡ 
1 J ' ' 

, Frame#3 ~ -.-

\__ Frame # 2 • 

~ • C.G. 1 

b 

"' "' 

~ 1- Frame # 4¡ 
_L_ , --~-r 250" 1 ¡- 550" 

Plan 

"'" -'- -

Elevation 

Figure 15.3. A Simple Three Dimensional Building Example 
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4>,. 4> •• 4>7' 4>9 Mode Frequencies 

/ 
(Radians/sec.) 

/ 
1 13.869 
2 13.931 
3 43.995 

u, ./ ~q,s, 4>10' 4>n• 4>12 
4 44.189 - 5 54.418 
6 77.686 
7 78.029 
8 108.32 
9 108.80 

y 10 172.613 

L 4>, ' 4>3 ' 4>6 ' 4>, 
11 304.80 
12 425.00 

X 

Figure 15.4 Frequmcies and Approximate Directions oJMode Shapes 

The direction of the applied eanhquake motion, a table of natural frequencies and 

the principal direction ofthe mode shape are summarized in Figure 15.4. One notes 

the closeness of the frequencies which is typical of most three dimensional building 

structures that are designed to equally resist earthquakes from both directions. 

Because of the small mass eccentricity, which is normal in real structures, the 

fundamental mode shape has X, y, as well as torsion components. Therefore, the 

model represents a very common three dimensional building system. Also, note that 

there is not a mode shape in a particular given direction as implied in many 

building codes and sorne text books on elementary dynamics. 

The building was subjected to one componen! of the Taft, 1952, eanhquake. An 

exact IJme history analysis, using al! 12 modes, and a response spectrum analysis 

were conducted. The maximum modal base shears in the four frames for the first 

five modes are shown in Figure 15.5. 

Figure 15.6 summarizes the maximum base shears, in each ofthe four frames. using 

different methods. The time history base shears, Figure 15 .6a. are exact. The 

SRSS method, Figure 15.6b, produces base shears which under-estimate the exact 

values in the direction of the loads by approximately 30 percent and over-estimate 

the base shears normal to the loads by a factor of ten. The sum of the absolute 
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values, Figure 15.6c, grossly over-estimates al! results. The CQC method, Figure 

15.6d, produces very realistic values that are close to the exact time history solution. 

47.33 k 52.30 k 

57.53 k 52.30 k 

7.42 k 8 12 k 0.40 k 

9.02 k 8.12 k 0.33 k 

Figure 15.5. Base Slrears i11 Eaclz Frame for First Five Modes 

102.1 k 

112.4 k 

(a) T•me Hrstory 

116 k 

127 k 

(e) Sum of Abso!ute Values 

71.4 k 

78.8 k 

(b) SRSS 

100.8 k 

1, 1.1 k 

(dJ cae 

Figure 15.6. Compariso11 oJModa/ Combi11atio11 Metlrods 

•' 
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The modal cross-correlation coefficients for this buildmg are summarized in Table 

15. l. lt is of importance to note the existence of the relatively large off-diagonal 

terrns that indicate which modes are coupled. 

Table 15.1. Modal Cross-Correlation Coefficients -~ =0.05 

M o de 1 2 3 4 5 "'· rad/sec 

1 1.000 0.998 0.006 0.006 0.004 13.87 

2 0.998 1.000 0.006 0.006 0.004 13.93 

3 0.006 0.006 1.000 0.998 0.180 43.99 

4 0.006 0.006 0.998 1.000 0.186 44.19 

5 0.004 0.004 0.180 0.186 1.000 54.42 

If one notes the signs of the modal base shears, shown in Figure 15 .3, it is apparent 

how the application of the CQC method allows the sum of the base shears in the 

direction of the externa! motion to be added directly. In addition, the sum of the 

base shears, normal to the externa! motion, tend to cancel. The ability of the CQC 

method to recognize the relat1ve sign of the terrns in the modal response is the kcy to 

the elimination of errors in the SRSS method. 
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15.7 DESIGN SPECTRA 

Design spectra are not uneven curves as shown in Figure 15.2 since they are 

intended to be the average of many earthquakes. At the present time, many building 

codes specifY design spectra in the form shown in Figure 15.7. 

3 

e: .g 2.5 
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.!!! 
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"' .g 
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1 \ 1 ' 
' \ 1 
' 

"' .r .\ 
't> 1 "' ~ 
"' ~ 0.5 

[". 

~ 
1 

o 
<: 1 

o 
o 2 4 6 8 10 

PERIOD - Seconds 

Figure 15.7 Typical Design Spectrum 

The Uniform Building Code has defined specific equations for each range of the 

spectrum curve for four different soil types. For majar structures it is now common 

practice to develop a site-dependent design spectrum which includes the effect of 

local soil conditions and distance to the nearest faults. 
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15.8 ORTHOGONAL EFFECTS IN SPECTRAL ANAL YSIS 

A well-designed structure should be capable of equally resisting earthquake motions 

from all possible directions. One option in existing design codes for buildings and 
bridges requires that members be designed for "lOO percent ofthe prescribed scismic 

forces in one direction plus 30 percent of the prescribed forces in the perpendicular 

direction". Other codes and organizations require the use of 40 percent rather than 

30 percent. However, they give no indication on how the directions are to be 

determined for complex structures. For structures that are rectangular and have 

clearly defined principal directions, these "percentage" rules yield approximately the 

same results as the SRSS method. 

For complex three dimensional structures such as non-rectangular buildings, curved 

bridges, arch dams or piping systems, the direction of the earthquake which 

produces the maximum stresses, in a particular member or at a specified point, is 

not apparent. For time history input, it is possible to perform a large number of 

dynamic analyses at various angles of input in arder to check all points for the 

critica! earthquake directions. Such an elaborate study could conceivably produce a 

different critica! input direction for each stress evaluated. However, the cost of such 

a study would be prohibitive. 

It is reasonable to assume that motions that take place during an earthquake have 

one principal direction [ l]. Or, dunng a finite period of time, when maximum 

ground acceleration occurs, a principal direction exists. For most structures this 

direction is not known and, for most geographical locations, cannot be estimated. 

Therefore, the only rational earthquake design criterion is that the structure must 

resistan earthquake of a given magnitude from any possible direction. In addition to 

the motion in the principal direction, a probability exists that motions normal to that 

direction will occur simultaneously. In addition, because of the complex nature of 

three dimensiOnal wave propagation, it is valid to assume that these normal motions 

are statistically independent. 

Based on these assumptions, a statement of the design criterion is "a structure must 
resist a majar earthquake motion of magnitude S1 for al! possible angles {) and, at 

the same point in time, resist earthquake motions of magnitude S2 at 90° to the angle 

{) ". These motions are shown schematically in Figure 15.!. 
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15.8.1 Basic Equations For Calculation Of Spectral Forces 

The stated design criterion implies that a large nurnber of different analyses rnust be 

conducted in arder to determine the maxirnurn design forces and stresses. It will be 

shown, in this section, that rnaxirnurn values for all rnernbers can be exactly 

evaluated frorn one cornputer run in which two global dynamic rnotions are applied. 

Furthermore. the rnaxirnurn mernber forces calcu1ated are invariant with respect to 

the se1ection system. 

go" 

s, 

a 

Plan View 

--+-----------------------~0 

Figure 15. 7. Dejinition of Eart/rquake Spectra Input 

Figure 15.7 indicates that the basic input spectra S1 and S, are app1ied at an 

arbitrary ang1e 6 . At sorne typica1 point within the structure, a force, stress or 

disp1acernent F is produced by this input. In arder to simp1ity the ana1ysis, it will 

be assurned that the minar input spectrum is sorne fraction of the majar input 

spectrurn. Or, 

(15.11) 

where a is a nurnber between O and 1.0. 

Recently, Menun and Der Kiureghian [3] presented the CQC3 method for the 

cornbination of the effects of orthogona1 spectrurn. 

( 
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The fundamental CQC3 equation for the estimation of a peak val u e is 

F [F' 'F' ( , ) ( , !':'') . , B = 0 +a 90 - 1-a F;, - r 90 sm 

1 (15.12) 

+ 2 (1- a' )F0-90 sin BcosB+ r;'J' 

where 

(15.13) 
n m 

(15.14) 
n m 

(15.15) 
n m 

(15.16) 
n m 

in which fon and / 90 • are the modal values produced by 100 percent of the lateral 

spectrum applied at O and 90 degrees respective/y and /,. is the modal response 

from the vertical spectrum which can be different from the lateral spectrum. 

It is importan! to note that for equal spectra a = l. the value F is not a function of 

G and the selection ofthe analysis reference system is arbitrary. Or, 

This indicares that it is possible to conduct only one analysis, with any reference 

system, and the resulting structure will ha ve all members that are designed to equally 

resist earthquake motions from all possible directions. This method is acceptable by 

most building codes. 
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15.8.2 The General CQC3 Method 

For a=! the CQC3 method reduces to the SRSS method. However, this can be over 

conservative since real ground motions of equal value in all directions ha ve not been 

recorded. Normally, the value of 6 in Equation (15.12) is not known; therefore. it 

is necessary lo calculate the critica! angle that produces the maximum response. 

Differentiation ofEquation (15.12) and setting the results to zero yields 

(15.17) 

Two roots exist for Equation (15.17) that must be checked m order that the 

following equation is maximum: 

2 2 2 2 2 2 ·2 F,w: =[F, +a F90 -(l-a )(F0 -F90)sm ()" 
1 

-2(1-a')F~>-90 sin()" cose"+ F;'J' 
(15.18) 

At the present time no specific guidelines ha ve been suggested for the value of a. 
Reference [3] presented an example with values a between 0.50 and 0.85. 

15.8.3 Examples Of Three Dimensional Spectra Analyses 

The previously presented theory clearly indicates that the CQC3 combination rule, 

with a egua! 1.0, is identical to the SRSS method and produces results, for all ' 

structural systems, which are not a function of the reference system used by the 

engineer. One example will be presented in order to show the advantages of thé 

method. A very simple one-story structure, shown in Figure 15.8, was selected to 

compare the results of the 100/30 and 1 00/40 percentage rules with the SRSS rule. 

Note that the masses are not at the geometric center of the structure. The structure 

has two translations and one rotational degrees-of-freedom located at the center of 

mass. The columns, which are subjected to bending about the local 2 and 3 axes, 

are pinned at the top where they are connected to an in-plane rigid diaphragm. 
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2 

X= Y= 106.065 ft. 

Sym. 

ífypical Column: 

¡22 =100ft' 
! 33 =200ft' 
E= 30 k 1 ft 2 

L = lOft 

M roP = 0.25k- sec' 1ft 

Figure 15.8. Three Dimensional Structure 

The periods and nonnalized base shear forces associated with the mode shapes are 
summarized in Table 15.2. Since the structure has aplane of symmetry at 22.5 
degrees, the second mode has no torsion and has a nonnalized base shear at n.5 
degrees with the x-axis. Due to this synunetry, it is apparent that columns 1 and 3 

(or columns 2 and 4) should be designed for the same forces. 

Table 15.2. Periods and Base Reaction Forces 

Period X- Y- X- Y-

M o de Seconds Force Force Moment Mamen! Torsion 

1 1.01029 .383 ·.924 9.24 3.83 -115.5 

2 0.76918 ·.924 ·.383 3.83 ·9.24 0.0 

3 0.43102 .383 ·.924 9.24 3.83 ·115.5 

The definition of the mean displacement response spectrum used in the spectra 
analysis is given in Table 15.3. 
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Table 15.3. Participating Masses and Response Spectrum Used 

M o de Period X- Y-
Spectral 

Displacement 
Seconds MASS MASS Used For 

Analysis 

1 1.01029 14.43 84.081 1.00 

2 0.76918 85.36 14.65 1.00 

3 0.43102 0.22 1.27 1.00 

The moments about the local 2 and 3 axes at the base of each of the four columns 

for the spectrum app!ied separately at 0.0 and 90 degrees are summarized in Tables 

15.4 and 15.5 ~nd are compared to the 100/30 rule. 

Table 15.4. Moments About 2-Axes- 100/30 Rule 

Member M o M,. MsRss = Mwo13o Error% 

~M o' + M9o
2 

1 0.742 1.750 1.901 1.973 3.8 

2 1.113 2.463 2.703 2.797 . 3.5 

3 0.940 1.652 1.901 1.934 1.8 

4 1.131 2.455 2.703 2.794 3.4 

Table 15.5. Moments About 3-Axes -100/30 Rule 

Member M o M,. MsRss = Mwo/3o Error% 

~Mo' + M•o 
2 

1 2.702 0.137 2.705 2.743 1.4 

2 2.702 0.137 2.705 2.743 1.4 

3 1.904 1.922 2.705 2.493 -7.8 

4 1.904 1.922 2.705 2.493 -7.8 

For this example, the maximum forces do not vary significantly between the two 

methods. However, it does illustrate that the 100/30 combination method produces 

·• 
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moments which are not symmetric, whereas the SRSS combination method produces 

logical and symmetric moments. For example. member 4 would be over-designed by 

3.4 percent about the local 2-axis and under-designed by 7.8 percent about the local 

3-axis using the 100/30 combination rule. 

The SRSS and 100/40 design moments about the local 2 and 3 axes at the base of 

each of the four columns are summarized in Tables 15.6 and 15.7 

Table 15.6. Moments About 2-Axes- 100/40 Rule 

Member M o M90 MsRSs = Mwo,•o Error% 

~Mo2 + M•o' 

1 0.742 1.750 1.901 2.047 7.7 

2 1.113 2.463 2.703 2.908 7.6 

3 0.940 1.652 1.901 2.028 1.2 

4 1.131 2.455 2.703 2.907 7.5 

Table 15.7. Moments About 3-Axes -100/40 Rule 

Member M o M90 MsRSs = MIOQ/40 Error% 

~M o' + M•o' 

1 2.702 0.137 2.705 2.757 1.9 

2 2.702 0.137 2.705 2.757 1.9 

3 1.904 1.922 2.705 2.684 -0.8 

4 1.904 1.922 2.705 2.684 -0.8 

The results presented in Tables 15.6 and 15.7 also illustrate that the 100/40 

combination method produces results which are not reasonable. Because of 

symmetry, members 1 and 3 and members 2 and 4 should be designed for the same 
moments. Both the 100/30 and 100/40 rules fail this simple test. 
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If a structural engineer wants to be conservative, the results of the SRSS directional 

combination rule or the input spectra can be multiplied by an additional factor 

greater than one. One shou!d not try to justify the use of the 100/40 percentage rule 

because it is conservative in 11 most cases". For complex three dimensional structures 
the use of the 100/40 or 100/30 percentage rule will produce member designs which 

are not equally resistan! to eanhquake motions from all possible directions. 

15.8.4 Recommendations On Orthogonal Effects 

For three dimensional response spectra analyses, it has been shown that the "design 

ofelements for !00 percent ofthe prescribed seismic forces in one direction plus 30 

or 40 percent of the prescribed forces applied in the perpendicular direction" is 

dependent on the user's selection of the reference system. These commonly used 

"percentage combination rules" are empírica! and can underestimate the design 

forces in certain meltlbers and produce a member design which is relatively weak in 

one direction. It has been shown that the altemate building code approved method, 

in which an SRSS combination of two 1 00 percent spectra analyses with respect to 

any user defined onhogonal axes, will produce design forces that are not a function 

of the reference system. Therefore, the resulting structural design has egua! 

resistance to seismic motions from all directions. 

The use of the CQC3 method should be used if a value of a less than 1.0 can be 

justified. It will produce realistic results that are not a function of the user se!ected 

reference system. 

15.9 liMJTATIONS OF THE RESPONSE SPECTRUM METHOD 

It is apparent that use of the response spectrum method has Jimitations, sorne of 

which can be removed by additional development. However, it will never be 

accurate for nonlinear analysis of multi-degree of freedom structures. The author 

believes that in the future more time history dynamic response analyses will be 

conducted and the many approximatíons associated with the use of the response 

spectrum method will be avoided. Sorne of these additional limitations will be 

discussed in this section. 

.l' 

·~· 

',f 
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15.9.1 Story Drift Calculations 

AIJ displacements produced by the response spectrum method are positive numbers. 

Therefore, a plot of a dynamic displaced shape has very little meaning since each 

displacement is an estimation of the maximum value. lnter-story displacements are 

used to estima te damage to nonstructural elements and cannot be calculated directly 

from the probable peak values of displacement. A simple method to obtain a 

probable peak value of shear strain is to place a very thin panel element, with a 

shear modulus of unity, in the area where the deformation is to be calculated. The 

peak value of shear stress will be a good estimation of the darnage index. The 

curren! code suggests a maximum value of O .005 horizontal dril\ ratio, which is the 

same as panel shear strain if the vertical displacements are neglected. 

15.9.2 Estimation of Spectra Stresses in Beams 

The fundamental equation for the calculation of the stresses within the cross section 

ofa beam is 

P M,.x Mxv 
0"=-+--+--·-

A 1,. IX 
(15.19) 

This equation can be evaluated for a specified x and y point in the cross section and 

for the calculated maximum spectral axial force and moments which are all positive 

values. It is apparent that the resulting stress may be conservative since all forces 

will probably not obtain their peak values at the same time. 

For response spectrum analysis, the corree! and accurate approach for the 

evaluation of equation (15.19) is to evaluate the equation for ea eh mode of vibration. 

This will take into consideration the relative signs of axial forces and moments in 

each mode. An accurate value of the maximum stress can then be calculated from 

the modal stresses using the CQC double sum method. It has been the author's 

experience, with large three dimensional structures, that stresses calculated from 

modal stresses can be Jess than 50 percent of the value calculated using maximum 

peak values of moments and axial force. 
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15.10 SUMMARY 

In this chapter 11 has been illustrated that the response spectrum method of dynamic 

analysis must be used carefully. The CQC method should be used to combine modal 

maxima in arder to minimize the introduction of avoidable errors. The increasc in 

computational effon, as compared to the SRSS method. is small compared to the 

total computer time for a seismic analysis. The CQC mcthod has a sound 

theoretical basis and has been accepted by most expens in eanhquake enginecring. 

Tt use of the absolute sum or the SRSS method for modal combination cannot be 

justified. 

In arder for a structure to have equal resistance to eanhquake motions from all 

directions, the CQC3 method should be used to combine the effects of eanhquake 

spectra applied in three dimensions. The percentage rule methods have no 

theoretical basis and are not invariant with respect to the reference system. 

Engineers, however, should clearly understand that the response spectrum method is 

an approximate method used to estimate maximum peak values of displacements and 

forces and that it has significan! limitations. It is restricted to linear elastic analysis 

in which the damping properties can only be estimated with a low degree of 

confidence. The use of nonlinear spectra, which are commonly used, has very httle 

theoretical background and should not be used for the analysis of complex three 

dimensional structures. For such structures, true nonlinear time-history response 

should be used as indicated in Chapter I 9. 

15.11 REFERENCES 

I. J. Penzien and M. Watabe, "Characteristics of 3-D Eanhquake Ground Motions," 

Earthquake Engmeering and Structural Dynamics, Vol. 3, pp. 365-3 73, 1975. 

2. E. L. Wilson, A. Der Kiureghian andE. R. Bayo, "A Replacement for thc SRSS 

Method in Seismic Analysis," Earthquake Engineering and Struc/llral Dynamics, 

Vol. 9, pp. 187-192, 1981. 

3. C. Menun and A. Der K!Ureghian, "A Replacement for the 30 % Rule for 

Muticomponent Excitation", Earthquake Spectra. Vol. 13, Number 1, February 

1998. 



RESPONSE SPECTRUM ANAL YSIS 23 

15.9.3 Design Checks for Steel and Concrete Beams 

Unfortunately, most design check equations for steel structures are \\Titten in terms 

of "design strength ratios" which are a nonlinear function of the axial force in the 

member; therefore, the ratios cannot be calculated in each mode. A new 

approximate method, to replace the curren! state of the art approach of calculating 

strength ratios based on maximum peak values of member forces, is proposed by the 

author. This would involve first calculating the maximum axial force. The design 

ratios would then be evaluated mode by mode, assuming the maximum axial force 

reduction factor remains constan! for all modes. The design ratio for the member 

would then be estimated by a double-sum modal combination method such as the 

CQC3 method. This approach would improve accuracy and still be conservative. 

For concrete structures additional development work is required in arder to develop 

a completely rational method for the use of maximum spectral forces in a design 

check equation because of the nonlinear behavior of concrete members. A time 

history analysis may be the only approach that will produce rational design forces. 

15.9.4 Calculation of Shear Force in Bolts 

With respect to the interesting problem of calculating the maximum shear force in a 

bolt, it is not corree! to estimate the maximum shear force from a vector summation 

since the x and y shears do not obtain their peak values at the same time. A correct 

method of estimating the maximum shear in a bolt is to check the maximum bolt 

shear at severa! different angles about the bolt axis. This would be a tedious 

approach using hand calculations; however, if the approach is built into a post 

processor computer program, the computational time to calculate the maximum bolt 

force is trivial. 

The same problem exists if principal stresses are to be calculated from a response 

spectrum analysis. One must check at severa! angles in arder to estimate the 

maximum and minimum value ofthe stress at each pomt in the structure. 
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DYNAMIC ANALYSIS USING 
MODE SUPERPOSITION 

The Mode Shapes Used To Uncouple The 
· Dynamic Equilibrium Equations Need Not Be 

The Exact Free- Vibration Mode Shapes 

13.1 EQUATIONS TO BE SOL VED 

The dynamic force equilibrium Equation (12A) can be rewritten in the following 

formas a set of N second arder differential equations: 

J 

Mü(t) + Cu(t) + Ku(t) = F(t) = L,f1 g(t)j (13.1) 
j•l 

All possible types oftime-dependent loading, including wind, wave and seismic, can 

be represented by a sum of "J" space vectors f 1 , which are not a function of time, 

and J time functions g(t)
1 

, where J cannot be greater than the number of 

displacements N. 

The number of dynamic degrees-of-freedom is equal to the number of lumped 

masses in the system. Many publications advocate the elimination of all massless 

displacements by static condensation prior to the solution of Equation (13 .1 ). The 

static condensatwn method reduces the number of dynamic equilibrium equations to 

salve; however, it can significantly increase the density and the bandwidth of the 

condensed stiffuess rnatrix. In building type structures, in which each diaphragm 
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has only three lumped masses, this approach is effective and is automatically used in 

building analysis programs. 

For the dynamic solution of arbitrary structural systems, however, the elimination of 

the massless displacement is, in general, not numerically efficient. Therefore, the 

modern versions of the SAP program do not use static condensation in arder to 

reta in the sparseness of the stiffuess matrix. 

13.2 TRANSFORMATION TO MODAL EQUATIONS 

The fundamental mathematical method that is used to salve Equation (13.1) is the 

separation of variables. This approach assumes the solution can be expressed in the 

following form: 

u(t) = ct>Y (t) (13.2a) 

Where ct> is an "N by L" matrix containing L spatial vectors which are nota function of 
time, and Y (t) is a vector containing L functions of time. 

' 
From Equation (13.2a) it follows that 

ü(t) = ct>Y (t) and ü(t) = ct>Y (t) (13.2b) and (13.2c) 

Prior to solution, we require that the space functions satisty the following mass and 

stiffuess orthogonality conditions: 

cpr M<l> = 1 and ct>rK<l> = 112 (13.3) 

where 1 is a diagonal unit matrix and 112 is a diagonal matrix which may or may not 

contain the free vibration frequencies. It should be noted that the fundamentals of 

mathernatics place no restrictions on these vectors, other !han the orthogonality 

properties. In this book all space function vectors are normalized so that the Genera/ized 

Mass tfJ/ MtfJ, = 1. 

After substitution ofEquations (13.2) into Equation (13.1) and the pre-multiplication by 

el> r , the following matrix of L equations are produced: 

1 
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J 

IY ro + dY (tJ + n' ; I P1 g(t)1 
( 13.4) 

j=l 

where p 
1 

; <P T f 1 and are defmed as the modal panicipation factors for time function 

j. The tenn p ,
1 

is associated v.ith !he n th mode. 

Foral! real structures the "L x L" matrix d is not diagonal; however, in order to uncouple 

the modal equations it is necessary to assume that there is no coupling berween the 

modes. Therefore, it is assumed to be diagonal v.ith the modal damping terms defmed by 

(13.5) 

where S, is defmed as the ratio of the damping in mode n !o the critica! damping of the 

mode [1]. 

A rypical uncoupled modal equation, for linear structural systerns, is of the following 

form: 

J 

y(t), + 2 (, (1), Y{t), + (1)~ y(t), ; LP "J g(t)J (13.6) 
;•1 

For three dimensional seismic motion, this equation can be written as 

Y(t), + 2 S, (1), Y(t), + (1); y(t), ; p ru Ü(l)gx + p "Y Ü(t).,. + p"' Ü(t)., 

(13.7) 

where the three directional Mass Participa/ion Factors are defined by 
p"' ; - 1/J, 1 M, in which i is equal to x, y or z and n is the mode number. 

Prior to presenting the solution of Equation (13.6) for various types of loading it is 

convenient to define additional constants and functions which are summarized in 

Table 13.1. This will allow many ofthe equations presented in other parts ofthis 

book to be written in a compact form. Also, the notation reduces the tedium 

involved in the algebraic derivation and verification of various equations. In 

addition, it will allow the equations to be in a form that can be easily programmed 

and verified. 
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13.3 RESPONSE DUETO INITIAL CONDITIONS ONLY 

If the "n" subscript is dropped, Equation (!3.6) can be written for a typical mode 

as 

Y(t) + 2qmy(t) + w' y(t) = O (13.8) 

in which the initial modal displacementy0 and velbcity j•0 are specified due to 

previous loading acting on the structure. Note that the functions S(t) and C(t), 

given in Table 13.1, are solutions to Equation (!3.8). 

Table 13.1. Summary of Notation used in Dynamic Response Equations 

CONSTANTS 

Wn=wn 

FUNCTIONS 

l 

a, = - t:J.t 

.t.~ 
a=-·-

o (J) t:J.t 

as= -as 

S(t) =e-<"' sin(wnt) 

C( f) = e -qM COS ( (J) Dt) 

S(t) = -wS(t)+wnC(t) 

C(t) = -wC(t)- wnS(t) 

S(t) = -a9S(t) -a10C(t) 

1 
A4 (t) = - 2 [a, +a6t +a7S(t) + a8C(t)] 

(J) 
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The solution ofEquation (13.8) can now be written in the following compact fonn: 

y(t) = A1 (t)y0 + A2 (t)j'0 ( 13.9) 

This solution can be easily verified since it satisfies Equation (13.8) and the initial 

conditions. 

13.4 GENERAL SOLUTION DUETO ARBITRARY LOADING 

There are many different methods available to solve the typical modal equations. 

However, the use of the exact solution for a linear load over a srnall time increment 

has been found to be the most economical and accurate method to numencally salve 

this equation within computer programs. It does not have problems with stability 

and it does not introduce numerical damping. Since most seismic ground motions 

are defined as linear within 0.005 second intervals, the method is exact for this type 

of Ioading for all frequencies. 

In arder to simplify the notation, all loads are added together to fonn a typical modal 

equation of the following fonn: 

Y(t) + 2 ~ úJ }'(1) + m2 y(t) = R(t) ( 13.10) 

where the modal loading R(t) is a piece-wise linear function as shown in Figure 

13. l. 

R(l) 

Figure 13.1 Typical Modal Load Function 
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The equation for the linear load function within the time step is by definition 

t t 
R(t)=(I--)R,_,+-R, (13.11) 

tJ.t tJ.t 

where the time t is in reference to the stan of the time step. Now the exact solution 

within the time step can be written as 

y(t) = A1(t)y,_, + A2(t)y,_ 1 + A3 (t)R,_, +A, (t)R, (13.12a) 

where all functions are defined in Table 13.1. Again, the solution can be easily 

verified by substitution of Equation (13.12a) into Equation (13.1 0). It is apparent 

that the exact modal velocity and acceleration within the time step are given by 

.Htl =A, (t)y,_, + A,(t))•,_, + A3 (t)R,_, + A,(t)R, 

Y(t) =A, (t)y,_, +A, (t).v,_, + A3 (t)R,_, +A, (t)R1 

(13.12b) 

(13.12c) 

Equations (13.12a, b ande) are evaluated at the end ofthe time increment tJ.t and 

the following modal displacement, velocity and acceieration at the end of the i th 

time step are given by the following set of recurrence equations: 

Y, = A,Y;.¡ + A, Y;.¡ 

Y, = A, Y,.¡ +A, ,Y,.¡ 

.Y, = A, Y;.¡ + AIO )',.¡ 

+ A, R,_, 

+A, R,_, 

+ A,,R,_, 

+A, R; 

+ A,R, 

+A, R, 

(13.13a) 

(13.13b) 

(13.13c) 

The constants A1 to A12 , which are summarized in Table 13.2, need to be computed 

only once for each mode. Therefore, for each time increment only 12 multipiications 

and 9 additions are required. Modern, inexpensive personal computers can complete 

one mul!Iplication and one addition in approximately 10"' seconds. Hence, the 

computer time required to solve for 200 steps per second for a 50 second duration 

eanhquake is approximately 0.01 seconds. Or, 100 modal equations can be solved in 

one second of computer time. Therefore, there is no need to consider other 

numerical methods, such as the approximate Fast Fourier Transforrnation method or 

the numerical evaluation of the Duhamel integral, to sol ve these equations. Beca use 

of the speed of this exact piece-wise !mear technique, it can also be used to develop 

accurate eanhquake response spectra using a very small amount of computer time. 
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Table 13.2. Constants Used in Recurrence Equations (13.13) 

A, =A, (ilt) = C(ilt) +.; S(ill) 

1 
A, = A2 (ilt) = -S(ilt) 

• (/) D 

1 
A, = A4 (ilt) = -, [a,+ a6!lt + a7S(Ilt) + a8C(!lt)] 

o.r 

. 1 . 
A6 = A2 (M) = -S(!!.t) 

(/)D 

• 1 . . 
A,= A,(llt)= w' [a, +a7S(ilt)+a8C(ilt)] 

•. 1 .. 
A, 0 = A2 (ilt) = -S(!!.t) 

. (/)D 

.. 1 .. .. 
A12 =A, (ilt) = -, [a7S( ilt) + a,C(Ilt)] 

(¡)" 

7 

.,. 
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13.5 SOLUTION FOR PERIODIC LOADING 

The recurrence solution algorithm, summarized by Equation 13.13. is a very 

efficient computational method for arbitrary, transient, d:-11amic loads with initial 

conditions. lt is possible to use this same simple solution method for arbitrary 

periodic loading as shown in Figure 13.2. Note that the total duration of the loading 
is from - oo to + oo and the loading function has the same amplitude and shape for 

each typical period r;,. Wind, sea wave and acoustic forces can produce this type 

of periodic loading. Also, dynamic live loads on bridges may also be of periodic 

forrn. 

F(t) 

1--=---+---=--f--"-:=--+--=---+- Time 
T,. T, T, T, 

Figure 13.2. Example of Periodic Loading 

F or a typical duration r;, of loading, a numerical solution, for each mode, can be 

evaluated by the application of Equation ( 13.13) without initial conditions. This solution 

is incorrect since it does not have the corree! initial conditiOns. Therefore, it is necessary 
for this solution y(t) to be corrected in arder that the exact solution z(t) has the same 

displacernent and velocity at the beginning and end of each loading period In arder to 
satisfY the basic dynamic equilibrium equation the corrective solution x(t) must have 

the following forrn: 

(13.14) 

where the functions are defined in Table 13.1. 

The total exact solution for displacernent and velocity for each mode can now be written 

as 

z(t) = y(t) + x(t) (13.15a) 



MODE SUPERPOSITION METHOD 9 

z(t) = y(t) + x(t) (13.!5b) 

In arder that the exact solution is periodic the follo\\ing conditions must be satisfied: 

(13.!6a) 

(13.!6b) 

The numerical evaluation of Equation (13.14) produces the following matrix equation 

which must be sol ved for the unknown initial conditions: 

(13.17) 

The exact penodic solution for modal displacements and velocities can now be calculated 

from Equations (13.!5a and 13.15b). 

13.6 PARTICIPATING MASS RATIOS 

Severa! Building Codes require that at least 90 percent of the participating mass is 

included in the calculation of response for each principal horizontal direction. This 

requirernent is based on a unit base acceleration in a particular direction and calculating 

the base shear due to that load. The steady state solution for this case involves no 

damping or elastic forces; therefore, the modal response equations, for a unit base 

acceleration in the x-direction, can be written as 

(13.18) 

The nade point inertia forces. in the x-direction, for that mode are by defmition 

(13.19) 

The total resisting base shear in the x-direction for mode n is the sum of all nade point x 

forces. Or, 

2 = Pru (13.20) 
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The total base shear in the x-direction, including L modes, will be 

(13.21) 

We can now define the participating rnass in all three directions as a ratio of the total 

mass in that direction by 

L 

2>~ 
Xmas.s = ~ 

Lmx 
(!3.22a) 

L 

LP~, 
Y mass = ~ 

I,m, 
(!3.22b) 

L 

LP;, 
Zma.ss = ~ 

I,m, 
(13.22c) 

If all modes are used, these ratios will all be equal to 1.0. lt is clear that !he 90 percent 

participation rule is intended to estimate the accuracy of a solution for base motion only. 

It can not be u sed asan error estimator for other types of loading suclr as poitrt loads 

acting on the structure. The SAP and ET ABS prograrns produce the contribution of 

each mode to these ratios. In addition, an examination of these factors gives the engineer 

an indicat1on ofthe direction ofthe base shear associated with each mode. 

13.7 STA TIC LOAD PARTICIPATION RATIOS 

For arbitrary loading it is useful to detennine if the number of vectors used is adequate to 

approximate the true response of the structural system. One method, which the author 

has proposed, is to evaluate the static displacernents using a truncated set of vectors to 

solve for the response dueto static load patterns. As indicated by Equation (13.1) the 

loads can be vmtten as 
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J 

F(tJ = Lf1g(t) 
1 

(13.23) 
r! 

If one sol ves the statics problem for the exact displacement u
1 

dueto the load pattem /
1 

the total strain energy associated v;ith load condition j is 

(13.24) 

From the fundamental defmition of the mode superposition method, a truncated set of 
vectors defines the approximate static displacernent ü

1 
as 

L 

Uj = LYn\!Ín (13.25) 
n=l 

where, from Equation 13.6, the static modal response, neglecting inertia and damping 

forces, is given by 

1 T 
Yn =--,¡!),J; 

úJ, 

The total strain energy associated with the truncated mode shape solution is 

A load participation ratio rj can now be defmed for load condition j as 

(13 .26) 

( 13.27) 

(13.28) 

If this ratio is clase to l. O the errars introduced by vector truncation will be very small. 

However, if this ratio is Jess than 90 percent additional vectors should be used in the 

analysis in arder ta capture the static load response. Additional experience with this 

factor is reqUired in arder ta use it as an accurate error estimator for al! problerns. 
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lt has been the experience of the author that the use of exact eigenvectors is not an 

accurate vector basis for the dynamic analysis of structures subjected to point loads. 

Whereas, load-dependen! vectors, which are defined in the fo!lowing chapter, always 

produce a load panicipation ratio of 1.0. 

13.8 SUMMARY 

The mode superposition method is a very powerful method used to reduce the 

number of unknowns in a dynamic response analysis. All types of loading can be 

accurately approximated by piece-wise linear functions within a srnall time 

increment. An exact solution exists for this type of loading and this solution can be 

computed with a trivial amount of computer time for equal time increments. 

Therefore, there is no need to present other methods for the numerical evaluation of 

modal equations when a computer program is used. 

To salve for the linear dynamic response of structures subjected to periodic loading 

it is only necessary to add a corrective solution to the transient solution for a typical 

time period of loading. Hence, only one numerical algorithm is required to salve a 

large number of different dynamic response problems in structural engineering. 

Panicipating rnass factors can be used to estimate the number of vectors required m an 

elastic seismic analysis. The use of rnass panicipation factors to estima te the accuracy of 

a nonlinear seismic analysis can introduce significan! errors; because, interna! nonlinear 

forces, that are in equal and opposite directions, do not produce a base shear. A dynamic 

load panicipation ratio is defmed which can be used to estimate the number of vectors 

required for other types of loading. 



Practical Three Dimensional Nonlinear Static Pushover Analysis 
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The recent advent of performance 
based design has brought the 
nonlinear static pushover analysis 
procedure to the forefront. Pushover 
analysis is a static. nonlinear 
procedure in which the magnitude of 
the structuralloading IS incrementally 
increased in accordance with a certain 
predefined pattem. With the increase 
in the magnitude of the loading. weak 
Jinks and failure modes of the 
structure are found. The !oading is 
monotonic with the effects of the 
cyclic behavior and load reversals 
being estimated by using a modified 
monoronic force-deformation criteria 
and with damping approximations. 
Static pushover analysis is an attempt 
by the structural engineering 
profession ro evaluare the real 
strength of the structure and it 
promises to be a useful and effective 
too! for performance based design. 

The A TC-40 and FEMA-273 
documents ha ve deve!oped modeling 
procedures, acceptance criteria and 
analysis procedures for pushover 
analysis. These documents define 

force-deformation criteria for hinges 
used in pushover analysis. As shown 
in Figure!, five points labe!ed A. B, 
C. D, andE are used to define the 
force deflection behavior of the hinge 
and three points labeled 10, LS and 
CP are used to define the acceptance 
criteria for the hinge. (10, LS and CP 
stand for lmmediate Occupancy, Life 
Safety and Col!apse Prevention 
respective! y.) The values assigned to 
each of these points vary depending 
on the type of member as well as 
many other pararneters defined m the 
ATC-40 and FEMA-273 documents. 

This article presents the steps used in 
performing a pushover analysis of a 
simple three-dimensional building. 
SAP2000, a state-of-the-art, general­
purpose, three-dimensional structural 
analysis program. is used as a tool for 
performing the pushover. The 
SAP2000 static pushover analysis 
capabilities, which are fui! y 
integrated into the program. allow 
quick and easy implementation of the 
pushover procedures prescribed in the 
ATC-40 and FEMA-273 documents 

.__o _ _,E 

A 
Deformation 

Figure 1: Force-Deformation For 
Pushover Hinge 

for both two and three-dimensional 
buildings. 

The fol!owing steps are included in 
the pushover analysis. Steps 1 
through 4 discuss creating the 
computer model, step 5 runs the 
analysis, and steps 6 through 10 
review the pushover analysis results. 

1. Create the basic computer model 
(without the pushover data) in 
the usual manner as shown in 
Figure 2. The graphical interface 
of SAP2000 makes this a quick 
and easy task. 

S SAP2080- pUdi l!lli!EI 

' '• ~· 

Figure 2: Basic SAP2000 Model (Without Pushover Data) 

\' 



2. D~fine properties and acceptance 
criteria for the pushover hinges as 
shown in Figure 3. The program 
in eludes severa! built-in default hinge 
propert1es that are based on average 
values from A TC-40 for concrete 
members and average values from 
FEMA-273 for steel members. These 
built in properties can be useful for 
preliminary analyses, but user­
defined properties are recommended 
for final analyses. This example uses 
default propenies. 

3. Locate the pushoverhmges on the 
model by selecting one or more frame 
members and assigning them one or 
more hinge propenies and hinge 
locations as shown m Figure 4. 

4. Define the pushover load cases. In 
SAP2000 more than one pushover 
load case can be run in the same 
analysis. Also a pushover load case 
can stan from the final conditions of 
another pushover load case that was 
previously run in the same analysis. 
Typically the first pushover load case 
is used to apply gravity load and then 
subsequent lateral pushover load 
cases are specified to start from the 
final conditions of the gravity 
pushover. Pusbwer load cases can 
be force control1ed. that is, pushed to 
a certain defined force leve!, or they 
can be displacement controlled, that 
is, pushed to a specified 
dJSplacement. Typically a gravity 
load pushover is force controlled and 
lateral pushovers are displacement 
controlled. SAP2000 allows the 
distribution of lateral force used in 
the pushover to be based on a 
uniform acceleration in a specified 
direction, a specified mode shape, or 
a user-defined static load case. The 
dialog box shown in Figure 5 shows 
how the displacement controlled 
lateral pushover case that is based on 
a user-detined static lateral load 
pattern (named Push) is defined for 
this example. 

¡,_..._~D.o•l• IOH' MJ 

.• . · .. 
... ·: " ·;/ .. · .. >~~~ 1 

Figure 3: Frame Hinge Property 

Figure 4: Assign Pushover Hinges 

Figure 5: Pushover Load Case Data 



5. Run the basic static analysis and, 
if desired. dynamic analysts. 
Then run the static non linear 
pushover analysis. 

6. Display the pushover curve as 
shown in Figure 6. The File 
menu shown in this display 
window allows you to view and 
if desired, print to either a printer 
oran ASCII file, atable which 
gives the coordinates of each step 
of the pushover curve and 
summarizes the number of hinges 
in each state as defined in Figure 
1 (for example, between 10 and 
LS, or between D andE). This 
table is shown in Figure 7. 

7. Display the capacity spectrum 
curve as shown in Figure 8. Note 
that you can interactively modify 
the magnitude of the earthquake 
and the damping infonnation on 
this form and immediately see 
the new capacity spectrum plot. 
The performance point for a 
given set of values is defined by 
the intersection of the capacity 
curve (green) and the smgle 
demand spectrum curve (yellow). 
Also, the file menu in this 
display allows you to print the 
coordinates of the capacity curve 
and the demand curve as well as 
other information used to convert 
the pushover curve to 
Acceleration-Displacement 
Response Spectrum format (also 
known as ADRS format, see 
page 8-12 in ATC-40). 

8. Review the pushover displaced 
shape and sequen ce of hinge 
formation on a step-by-step basis 
as shown in the left-hand side of 
Figure 9. The arrows in the 
bottom right-hand comer of the 
screen allow you to move 
through the pushover step-by­
step. Hinges appear when they 
yield and are color coded based 
on their state (see legend at 
bottom of screen). 

.. 
. ··-··- --- -- .. ·;;¡- ¡,¡¡ - -·-- ___ :_ __ :..:•_-

-·· --~ 

' :! 

Figure 6: Pushover Curve 

}IiPUSHOVER CURVE EJ 
¡¡. . - . : ~ , ... Dt..pl-at Bae Shear ._, B-IO IO-LS lS-CJ' CP-< e :O ... ,. TOT1l. 

• 1.1111 0.1111 .. .. 
1 1.1214 101.4111 " .. 

1.11!1 151.4911 " 1 .. 
' 1.1111 lU.lU1 .. 11 1 • o .. 
• •. 1411 lU. U14 .. 1 o .. 

1.3Ul 161.1111 .. " I.Ull 1U.UU .. .. , O.JUl lU,lUl .. .. 
• l. J~UI 144.4U' .. .. 

1.3564 144.U55 .. .. 
10 1.3515 101.15U .. .. 
11 0.35U lii.IIU .. .. 
" O.l5U u.uu .. • .. 
" 1.4531 n.nn .. 12 • .. 
" I.Ull ,.UM .. o " .. 
" l. U,. t.,.llH .. 10 • .. 
" 1.1131 1U.32U .. o 13 • .. 
" 1.1031 ·0.4143 .. o u .. 
" 1.2131 ·0.4414 .. u .. 
" l.Ull ·O.UU .. o u 1 • .. 
" l.Ull ·•· n:u .. o u 1 • .. 
u 1.1131 ·O.liU .. u .. 
" 2.1111 ·1.2154 .. 11 1 .. 

Figure 7: Tabular Data For Pushover Curve 

Figure 8: Capacity Spectrum Curve 



9. Review member forces on a step­
by-step basis as shown in the 
right-hand side of F1gure 9. 
Often it is useful to view the 
model in two side-by-side 
windows with the step-by-step 
displaced shape in one window 
and the step-by-step member 
forces in the other. as shown in 
Figure 9. These windows can be 
synchronized to the same step, 
and can thus greatly enhance the 
understanding of the pushover 
results. 

1 O. Output for the pushover analysis 
can be printed in a tabular form 
for the entire model or for 
selected elements of the model. 
The types of output available in 
this form include joint 

displacements at each step of the 
pushover. frame member forces 
at each step of the pushover. and 
hinge force. displacement and 
state at each step of the pushover. 

For buildings that are being 
rehabilitated it is easy to investigate 
the effect of different strengthening 
schemes. The effect of added 
damping can be immediately seen on 
the capacity spectrum form ( step 7, 
Figure 8). You can easily stiffen or 
strengthen the buildmg by changing 
member propenies and rerunning the 
analysis. Finally you can easily 
change the assumed detailing of the 
building by modifying the hinge 
acceptance criteria (step 2, Figures 1 
and 3) and rerunning the analysis. 
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SOIL-STRUCTURE 
INTERACTION 

AtA Finite Distance from A Structure the Absolute 
Displacements Must Approach the Free-Field Displacements 

16.1. INTRODUCTION 

The estimation of earthquake motions at the si te of a structure is the most importan! 

phase of the design or retrofit of a structure. Because of the large number of 

assumptions required, experts in the field often disagree by over a factor of two as to 

the magnitude of motions expected at the site without the structure present. This 

Iack of accuracy of the basic input motions, however, does not justifY the 

introduction of additional unnecessary approxirnations in the dynamic analysis of the 

structure and its interaction with the material under the structure. Therefore, it will 

be assumed that the free-field motions at the location of the structure, without the 

structure present, can be estimated and are specified in the form of earthquake 

acceleration records in three directions. lt is now common practice, on majar 

engineering projects, to investigate severa! different sets of ground motions in arder 

to consider both near fault and far fault events. 

If a lightweight flexible structure is built on a very stiff rock foundation, a valid · 

assumption is that the input motion at the base of the structure is the same as the 

free-field earthquake motion. This assumption is valid for a large number of 

building systems since most building type structures are approximately 90 percent 

voids, and, it is not unusual that the weight of the structure is excavated befare the 

structure is built. However, if the structure is very rnassive and stiff, such as a 
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concrete gravity dam, and the foundation is relatively soft, the motion at the base of 

the structure may be significantly different than the free-field surface motion. E ven 

for this extreme case, however, it is apparent that the most significan! interaction 

effects will be near the structure. and, at sorne finite distance from the base of the 

structure, the displacements will converge back to the free-field earthquake motion. 

16.2. SITE RESPONSE ANAL YSIS 

The 1985 Mexico City and many recen! earthquakes clearly illustrate the importance 

of local soil properties on the earthquake : csponse of structures. These earthquakes 

demonstrated that the rack motions could oe amplified at the base of a structure by 

over a factor of five. Therefore, there is a strong engineering motivation for a site­

dependent dynamic response analysis for many foundations in arder to determine the 

free-field earthquake motions. The determination of a realistic site-dependent free­

field surface motion at the base of a structure can be the most importan! step in the 

earthquake resistant design of any structure. 

For most horizontally layered sites a one dimensional pure shear model can be used 

to calculate the free-field surface displacements given the earthquake motion at the 

base of a soil deposit. Many special purpose computer programs exist for this 

purpose. SHAKE [ 1] is a well-known program, based on the frequency doma in 

solution method, which itcrates to estimate effective linear stiffness and damping 

properties in arder to approximate the non!inear behavior of the si te. WA VES [2] is 

a new nonlinear program in which the nonlinear equations of motion are sol ved by a 

direct step-by-step integration method. If the soil material can be considered linear 

then the SAP2000 program, using the SOLID element, can be used to calculare 

either the one, two or three dimensional free-field motions at the base of a structure. 

In addition. a one dimensional nonlinear site analysis can be accurately conducted 

using the FNA option in the SAP2000 program. 

16.3. KINEMATIC OR SOIL-STRUCTURE INTERACTION 

The most common soil-structure interaction SS! approach, used for three 

dimensional soil-structure systems, is based on the "added motion" formulation [3]. 

This formulation is mathematically simple, theoretically corree!, and is easy to 

automate and use within a general linear structural analysis program. In addition, 
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the fonnulation is valid for free-field motions caused by earthquake waves generated 

from all sources. The method requires that the free-field motions at the base of the 

structure be calculated prior to the soil-structure interactive analysis. 

In arder to develop the fundamental SS! dynamic equilibrium equations consider the 

three dimensional soil-structure system shown in Figure 16.1. 

Added Structure fsl 

Soil Foundation System ffl 

U=v+u 

U"" Absolute Dtsplacements 

v = Free Field Displacemenrs 

u = Added DtsplacementJ 

Figure 16.1. Soil-Structure /nteraction Model 

u=O 

Consider the case where the SS! model is divided into three sets of nade points. 

The common nades at the interface of the structure and foundation are identified 

with "e"; the other nades within the structure are "s" nades; and the other nades 

within the foundation are "!" nades. From !he direct stiffness approach in 

structural analysis, the dynamic force equilibrium of the system is given in tenns of 

the abso/ute displacements, U, by the following sub-matrix equation: 

o 
O ][~'] [K" O U, + K,1 

Mff U1 O 

(16.1) 

;,\ 

•.<1'· 
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where the mass and the stiffuess at the contact nades are the sum of the contribution 

from the structure (s) and foundation (/), and are given by 

( 16.2) 

In terms of absolute motion, there are no externa! forces acting on the system. 

However, the displacements at the boundary of the foundation must be known. In 

arder to avoid solving this SS! problem directly, the dynamic response of the 

foundation without the structure is calculated. In many cases, this free-jield 

solution can be obtained from a simple one-dimensional site model. The three 
dimensional free-field solution is designated by the absolute displacements ,. and 

absolute accelerations v. By a simple change of variables it is now possible to 

express the absolute displacements U and accelerations Ü in terms of 

displacements u relative to the free-field displacements v. Or, 

(16.3) 

Equation (16.1) can now be written as 

(16.4) 

If the free-field displacement v, is constan! over the base of the structure, the term 

v, is the rigid body motion of the structure. Therefore, Equation (16.4) can be 

further simplified by the fact thatthe static rigid body motion of the structure is 
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(16.5) 

Also. the dynamic free-field motion ofthe foundation requires that 

(16.6) 

Therefore, the right-hand si de of Equation ( 16.4) can be written as 

[

M, 

R= ~ 

o 
(16. 7) 

o 

Hence, the right-hand side of the Equation (16.4) does not contain the mass of the 

foundation. Therefore, three dimensional dynamic equilibrium equations, for the 

complete soil-structure system with damping added, are of the following form for a 

lumped mass system: 

Mü + Cti + Ku =-m, v,(l)- m,\'y(t)- m, v,(r) (16.8) 

where M, C and K are the mass, damping and stiffness matrices .. respectively. ofthe 

soil-structure model. The added, relative displacements, J!, exist for the soil­

structure system and must be set to zero at the sides and bottom of the foundation. 
The terms v, (t), V y (1) and v, (1) are the free-field components of the acceleration 

if the structure is not present. The column matrices, m;, are the directional mas ses 

for the added structure only. 

Most structural analysis computer programs automatically apply the seismic loading 

to all mass degrees-of-freedom within the computer model and cannot solve the SS! 
problem. This lack of capability has motivated the development of the massless 

foundation model. This allows the corree! seismic forces to be applied to the 

structure; however, the inertia forces within the foundation material are neglected. 

The results from a massless foundation analysis converge as the size of the 

foundation model is increased. However, the converged solutions may have 



6 STA TIC AND DYNAMIC ANAL YSIS 

avoidable errors in the mode shapes, frequencies and response ofthe system. 

T o activa te the soil-structure interaction within a computer program it is only 

necessary to identifY the foundation mass in arder that the loading is not applied to 

that part of the structure. The program then has the required inforrnation to form 

both the total mass and the mass of the added structure. The SAP2000 program has 

this option and is capable of solving the SS! problem correctly. 

16.4. RESPONSE DUETO MULTI-SUPPORT INPUT MOTIONS 

The previous SS! analysis assumes that the free-field motion at the base of the 

structure is constan!. F or large structures such as bridges and arch dams the free­

field motion, at all points where the structure is in contact with the foundation. is not 

constan!. 

The approach norrnally used to salve this problem is to define a quasi-static 
displacement v, that is calculated from the following equation: 

KssVs +KscVc =0 or, V =-K"'K V =T V s ss:rcc scc (16.9a) 

The transforrnation matrix T" allows the corresponding quasi-static acceleration in 

the structure to be calculated from 

Equation (16.4) can be written as 

[

M, 

R=- O 

o 

o 

o 

(16.9b) 

(16.10) 

After substitution of Equations ( 16.6) and (16.9), Equation (1 6.1 O) can be written as 
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--[0 M.,T" 
R- O M" 

o o 
o]["'] [o o o][v'] ~ ~; - ~ Ko" ~ :; 

( 16.11) 

The reduced structural stiffness at the contact surface K" is given by 

Kcc = Kcc +KcsTsc (16.12) 

Therefore, this approach requires a special program option to calculate the mass and 

stiffness matrices to be used on the right-hand side of the dynamic equilibrium 

equations. Note that the loads are a function ofboth the free-field displacements and 

accelerations at the soil-structure contact. Also, in arder to obtain the total stresses 

and displacements within the structure the quasi-static solution must be added to the 

solution. At the present time, there is not a general-purpose structural analysis 

computer program that is based on this "numerically cumbersome" approach. 

An altemative approach is to formula te the solution directly in terms of the absolute 

displacements of the structure. This involves the introduction of the following 

change of variables: 

(16.13) 

Substitution of this change of variables into Equation (1 6.1) yields the following 

dynamic equilibrium equations in terms of the absolute displacement, u,, of the 

structure: 

[
M, O O ][ü'] [K" K,

1 O ][u'] O M" O ~' + K,1 K" K,1 u, = R 
o o Mff U¡ o K¡, Kff U¡ 

(16.14) 

After the free-field response, Equation (1 6.6), is removed the dynamic loading is 

calculated from the following equation: 

.-
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[

K, 
R=- ¿, (16.15a) 

o 

This equation can be further simplified by connecting the structure to the foundation 

with stiff massless springs that are considered as part of the structure. Therefore, 

the mass ofthe structure at the contact nodes is eliminated and Equation (l6.15a) is 

reduced to 

(16.15b) 

It is apparent that the stiffness terms in Equation (l6.15b) represen! the stiffness of 

the contact springs only. Therefore, for a typical displacement componen! (n = x, y 

or z), the forces acting at point "i" on the structure and point 'T on the foundation 

are given by 

[
R,] =-k,[ 1.0 
R, -1.0 

" 

-t.o][ o] 
1.0 v, 

(16.16) 

where k, is the massless spring stiffness in the nth direction and 1', is the free-field 

displacement. Hence, points "i" and "j" can be at the same location in space and the 

only loads acting are a series of time-dependen!, concentrated, point loads that are 

equal and opposite forces between the structure and foundation. The spring stiffness 

mus! be selected approximately three orders-of-magnitude greater than the stiffness 

of the structure at the connecting nodes. The spring stiffness should be large enough 

so the fundamental periods of the system are not changed. and small enough not to 

cause numerical problems. 

The dynamic equilibrium equations, with damping added, can be written m the 

following form: 

Mü+Cü+Ku=R (16.17) 
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lt should be pointed out that concentrated dynamic ioads generaily require a large 

number of eigenvectors in arder to capture the corree! response of the system. 

However, if LDR vectors are used, in a mode superposition analysis. the required 

number of vectors is reduced significantly. The SAP2000 program has the ability to 

salve the multi-suppon, soil-structure interaction problems using this approach. At 

the same time. selective nonlinear behavior ofthe structure can be considered. 

16.5. ANALYSIS OF GRAVITY DAM ANO FOUNDATION 

In arder to illustrate the use of the soil-structure interaction option severa! 

eanhquake response analyses of the Pine Flat Dam were conducted with different 

foundation models. The foundation propenies were assumed to be the same 

propenies as the dam. Damping was set at five percent. Ten Ritz vectors, 

generated from loads on the dam only, were used. However, the resulting 

approximate mode shapes, used in the standard mode superposition analysts, 

included the mass inenia effects of the foundation. The horizontal d)11amic loading 

was the typical segrnent of the Loma Prieta eanhquake defined in Figure 15.1 a. A 

finite element model of the dam on a rigid foundation is shown in Figure 16.2. 

l\ 
11\\ 
1\\\\ 
1 1 \\ 

Figure 16.2. Finite E/ement ModeJ of Dam only 

The two different foundation models used are shown in Figure 16.3. 
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Figure 16.3. Models of Dam witlt Small and Large Foundation 

Se!ective results are summarized in Table 16.1. For the purpose of comparison, it 

wi!l be assumed that Ritz vector results, for the large foundation mesh, are the 

referenced values. 

Table 16.1. Selective Results Of Dam-Foundation Analyses 

DAMWITH SMALL LARGE 

NO Foundation Foundation Foundation 

TOTAL MASS !b-sec2/in 1.870 13.250 77.360 

PERlO OS seconds 0.335 0.158 0.404 0.210 0.455 0.371 

Max. Displacement inches 0.65 1.28 1.31 

Max & M in Stress ksi -37 to +383 -490 to +289 -512 to+297 

The differences between the results of the srnall and large founda tion models are 

very clase which indicates that the solution of the large foundation model may be 

nearly converged. It is true that the radiation damping effects in a finite foundation 

model are neglected. However, as the foundation model becomes larger, the energy 

dissipation due to normal modal damping within the rnassive foundation is 

significantly larger than the effects of radiation damping for transient earthquake 

type of loading. 
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16.6. THE MASSLESS FOUNDATION APPROXIMATION 

Most general purpose programs for the earthquake analysis of structures do not 

have the option of idemifying the foundation mass as a separate type of mass on 

which the earthquake forces do not act. Therefore. an approximation that has 

commonly been used is to neglect the mass of the foundation comp!etely in the 

analysis. Table 16.2 summarizes the resu!ts for an ana!ysis of the same dam­

foundation systems using a massless foundation. As expected, these results are 

similar. For this case the results are conservative; however, one cannot be assured 

of this for all cases. 

Table 16.2. Selective Resu/ts Of Dam With Mass/ess F oundation Ana(rses 

DAMWITH SMALL LARGE 

NO Foundation Foundation Foundation 

TOTAL MASS !b-sec'im 1,870 1,870 1.870 

PERIODS seconds 0.335 0.158 0.400 0.195 0.415 0.207 

Max. Displacement inches 0.65 1.27 1.43 

Max & Min Stress ksi -37 to +383 -480 to +289 -550 to + 330 

16.7. APPROXIMATE RADIATION BOUNDARY CONDITIONS 

Ifthe foundation volume is large and the modal damping exists, it was demonstrated 

in the previous section that a finite foundation with fixed boundaries can produce 

converged results. However, the use of energy absorbing boundaries can further 

reduce the size of the foundation required to produce a converged solution. 

In order to calculate the properties of this boundary condition consider a plane wave 

propagating in the x-direction. The forces, which cause wave propagation, are 

shown acting on a unit cube in Figure 16.4. 
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Figure 16.4. Forces Acti11g on U11it Cuhe 

From Figure 16.4 the one dimensional equilibrium equation in the x-direction is 

() 'u 

p di' 
o (16.18) 

Ju 
Since CJ =k =A- the one dimensional panial differential equation is written 

X X dX 

in the following classical wave propagation form: 

J'u -V 2 J'ux =O 
Jt' P Jx' 

(16.19). 

where vp is the wave propagation veloclty ofthe material and is given by 

Vp=H ( 16.20) 

in which p is the rnass density and A is the bulk modulus given by 

A= 1-Y E 
(1 + v)(I- 2v) 

(16.21) 

The solution of Equation ( 16. 13 ), for harmonic wave propagation in the positive x­

direction, is a displacemem of the fo!lowing form: 

lllX IUt 
u(t,x) = U[sin(ax --) +cos(ar--)] 

vp vp 
( 16.22) 
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This equation can be easi1y verified by substitution into Equation ( 16.18). The 

. f h . . au f . 1 arbttrary frequency o the armomc mouon is a;. The velocity, -,o a paruc e at 
. ()¡ 

1ocation x is 

ü(t ,x) = U w [ cos( úX - wx)- sin (úX - wx )] 
vp vp 

( 16.23) 

The strain in the x -direction is 

( ) o u ü(x,t) 
t:x,t =--=----

dx vp 
(16.24) 

The corresponding stress can now be expressed in the following simplified form: 

CJ'(x, t) = l.t:(x, t) = -VP pü(x, t) ( 16.25) 

The compression stress is identical to the force in a simple viscous damper with 
constant damping va1ue equa1 to VP p per unit area of the boundary. Therefore, a 

boundary condition can be created, at a cut boundary. which will allow the wave to 

pass without reflection and allow the strain energy to "radiate" away from the 

foundation. 

A1so, it can be easi1y shown that the shear wave "radiation" boundary condition, 
parallel to a free boundary, is satisfied if damping values are assigned to be V p 

S 

per unit of boundary area. The shear wave propagation ve1ocity is given by 

V= (G 
' fp 

where G is the shear modu1us. 

(16.26) 

The FNA method can be used to so1ve structures, in the time domain, with these 

types of boundary conditions. In later editions of this book, the accuracy of these 

boundary conditions approxirnation will be illustrated with numerica1 examp1es. 

Also, it will be used with a fluid boundary where on1y compression waves exist. 
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16.8. USE OF SPRINGS AT THE BASE OF A STRUCTURE 

Another importan! structural modeling problem, which must be solved, is at the 

interface of the major structural elements within a structure and the foundation 

material. For example, the deformations at the base of a rnajor shear wall in a 

building structure will significantly affect the displacement and force distribution in 

the upper stories of a building for both static and dynamic loads. Realistic spring 

stiffness can be selected from separate finite element studies or by using the classical 

half-space equations that are given in Table 16.3. 

lt is the opinion of the author that the use of appropriate site-dependent free-field 

earthquake motions and selection of realistic rnassless springs at the base of the 

structure are the only modeling assumptions required to include site and foundation 

properties in the earthquake analysis ofmost structural systems. 

Table 16.3 also contains effective mass and damping factors that include the 

approximate effects of radiation damping. These values can be used directly in a 

computer model without any difficulty. However, considerable care should be taken 

in using these equations at the base of a complete structure. For example, the 

effective earthquake forces must not be applied to the foundation mass. 

Table 16.3. Properties OfRigid Circular Plate On Surface OfHalf-Space 

DIRECTION STIFFNESS DAMPING MASS 

Vertical 4Gr 1.79~Kpr3 1.50pr3 

K= --
1-v 

Horizontal 0-v') 1.08~Kpr3 0.28pr3 

18.2Gr , 
(2-v)" 

Rotation 2.7G r3 0.47~Kpr3 0.49pr5 

1 

Torsion 5.3Gr3 1.ll~Kpr5 0.70pr5 

r = plate radius; G = shear modulus; V = Poisson's ratio; p = rnass density 

Source: Adapted from "Fundamentals ofEarthquake Engineering, by Newmark and Rosenblueth, Prent1ce-Hall. 1971 
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16.9. SUMMARY 

A large number of research papers and severa! books ha ve been written on structure­

foundation-soil analysis and site response dueto earthquake loadmg. However. the 

majority of these publications have been restricted to the linear behavior of soil­

structure systems. lt is possible, with the use of the numerical methods presented in 

this book, to conduct accurate earthquake analysis of real soil-structure systems in 

the time domain. including many realistic nonlinear properties. Also. it can be 

demonstrated that the solution obtained is converged to the correct soil-structure 

interactive solution. 

For major· structures on soft soil one dimensional site response analyses should be 

conducted. Under major structural elements, such as the base of a shear wall, 

massless elastic springs should be used to estimate the foundation stiffness. For 

massive structures, such as gravity dams, a part of the foundation should be 

modeled by three dimensional SOLID elements in which SS! effects are included. 
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SEISMIC ANALYSIS MODELING 
TO SATISFY BUILDING CODES 

The Current Building Codes Use the Terminology 
Principal Direction without A Unique Definition 

17.1. INTRODUCTION 

Currently a three-dimensional dynamic analysis is required for a large number of 

different types of structural systems that are constructed in Seismic Zones 2, 3 and 4 

[!]. The lateral force requirements suggest severa! methods that can be used to 

determine the distribution of seismic forces within a structure. However, these 

guidelines are not unique and need further interpretations. 

The majar advantage of Úsing the forces obtained from a dynamic analysis as the 

basis for a structural design is that the vertical distribution of forces may be 

significantly different from the forces obtained from an equivalen! static load 

analysis. Consequently, the use of dynamic analysis will produce structural designs 

that are more earthquake resistant than structures designed using static loads. 

For many years, approximate two-dimensional static load was acceptable as the 

basis for seismic design in many geographical areas and for most types of structural 

systems. During the past twenty years, dueto the increasing availability of modern 

digital computers, most engineers ha ve had experience with the static load analysis 

of three dimensional structures. However, few engineers, and the writers of the 

curren! building code, have had experience with the three dimensional dynamic 
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response analysis. Therefore, the interpretation of the dynarnic analysis requirement 

of the curren! code represents a new challenge to most structural engineers. 

The current code allows the results obtained from a dynarnic analysis to be 

norrnalized so that the maximum dynarnic base shear is egua! to the base shear 

obtained from a simple two-dimensional static load analysis. Most members of the 

profession realize that there is no theoretical foundation for this approach. 

However, for the purpose of se!ecting the magnitude of the dynarnic loading that will 

satisfy the code reguirements, this approach can be accepted, in a modified form, 

until a more rational method is adopted. 

The calculation ofthe "design base shears" is simple and the variables are defined in 

the code. lt is of interest to note, however, that the basic magnitude of the seisrnic 

loads has not changed significan!! y from previous codes. The major change is that 

"dynarnic methods of analysis" must be used in !he '"principal directions" of the 

structure. The present code does not state how to define !he principal directions for 

a three dimensional structure of arbitrary geometric shape. Since the design base 

shear can be different in each direction, this "scaled spectra" approach can produce 

a different input motion for each direction, for both regular and irregular structures. 

Therefore, the current code dynamic analysis approach can result in a structura/ 

design which is relatively "weak" in one direction. The method of dynarnic 

analysis proposed in this chapter results in a structural design that has egua! 

resistance in al! directions. 

In addition, the maximum possible design base shear, which is defined"by the present 

code, is approximately 35 percent of the weight of the structure. For many 

structures, it is less than 1 O percent. lt is general! y recognized that this force leve! is 

small when compared to measured earthguake forces. Therefore, the use of this 

design base shear reguires that substantial ductility be designed into the structure. 

The definition of an irregular structure, the scaling of the dynarnic base shears to !he 

static base shears for each direction, the application of accidental torsional loads and 

!he treatment of orthogonal loading effects are areas which are not clearly defined in 

the curren! building code. The purpose of this section is to present one method of 

three dimensional seisrnic analysis that will satisfy !he Lateral Force Reguirements 

of the code. The method is based on the response spectral shapes defined in !he code 

and previously published and accepted computational procedures. 
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17.2. THREE DIMENSIONAL COMPUTER MODEL 

Real and accidental torsional effects must be considered for all structures. 

Therefore, all structures must be treated as three dimensional systems. Structures 

with irregular plans, vertical setbacks or soft stories will cause no additional 

problems if a rea!istic three dimensional computer model is created. This model 

should be developed in the very early stages of design since it can be used for static 

wind and verticalloads, as well as dynamic seismic loads. 

Only structural elements with significan! stiffuess and ductility should be modeled. 

Non-structural brittle components can be neglected. However, shearing. axial 

deformations and non-center line dirnensions can be considered in all members 

without a significan! increase in computational effon by most modern computer 

programs. The rigid. in-plane approxirnation of floor systerns has been shown to be 

acceptable for most buildings. For the purpose of elastic dynamic analysis. gross 

concrete sections, neglecting the stiffness of the steel. are normally used. A cracked 

section mode should be used to check the final design. 

The P-Delta effects shou!d be included in all structural models. Jt has been shown in 

Chapter 11 that these second arder effects can be considered, without iteration. for 

both static and dynamic loads. The effect of including P-Delta displacements in a 

dynamic analysis results in a small increase in the period of all modes. In addition 

to being more accurate, an additional advantage of autornatically including P-Delta 

effects is that the moment magnification factor for all members can be taken as unity 

in all subsequent stress checks. 

The mass of the structure can be estimated with a high degree of accuracy. The 

majar assumption required is to estimate the amount of live load to be included as 

added mass. F or cenain types of structures it rnay be necessary to conduct severa! 

analyses with different values of mass. The lumped mass approxirnation has proven 

to be accurate. In the case of the rigid diaphragm approxirnation, the rotational 

rnass moment of inertia must be calculated. 

The stiffness of the foundation region of most structures can be modeled by massless 

structural elements. It is particularly importan! to model the stiffness of piles and 

the rotational stiffness at the base of shear walls. 



4 STA TIC ANO DYNAMIC ANAL YSIS 

The computer model for static loads only should be executed prior to conducting a 

dynamic analysis. Equilibrium can be checked and various modeling 

approximations can be verified with simple static load patterns. The results of a 

dynamic analysis are generally very complex and the forces obtained from a 

response spectra analysis are always positive. Therefore, dynamic equilibrium is 

almos! impossible to check. However, it is relallvely simple to check energy 

balances in both linear and nonlinear analysis. 

17.3. THREE DIMENSIONAL MODE SHAPES ANO FREQUENCIES 

The first step in the dynamic analysis of a structural model is the calculation of the 

three dimensional mode shapes and natural frequencies of vibration. Within the past 

severa! years, very efficient computational methods have been developed which ha ve 

greatly decreased the computational.requirements associated with the calculation of 

orthogonal shape.functions as presented in Chapter 14. 1t has been demonstrated 

that load-dependen! Ritz vectors, which can be generated with a minimum of 

numerical effort, produce more accurate results when used for a seismic dynamic 

analysis than ifthe exact free-vibration mode shapes are used. 

Therefore, a dynamic response spectra analysis can be conducted with 

approximately twice the computer time requirements·of a static load analysis.· Since 

systems with over 60,000 dynamic degrees-of-freedom can be solved within a few 

hours on personal computers, there is not a significan! increase in cost between a 

static and a dynamic analysis. The major cost is the "man hours" required to 

produce the three dtmensional computer model that is necessary for a static or a 

dynamic analysis. 

In order to illustrate the dynamic properties of the three dimensional structure, the 

mode shapes and frequenctes are calculated for the irregular, eight story, 80 foot tal! 

building shown in Figure 17 .l. This building is a concrete structure with severa! 

hundred degrees-of-freedom. However, the three components ofmass are lumped at 

each of the eight floor levels. Therefore, only 24 three dimensional mode shapes are 

possible. 
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Figure 17.1. Example of Eight Story Irregular Buildbtg 
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Each thtee ·dimensional mode shape of a structure may ha ve displacement 

components in al! directions. For !he special case of a symmetrical structure. the 

mode shapes are uncoupled and will ha ve displacement in one direction only. Since 

each mode can be considered to be a detlection due to a set of static loads, six base 

reaction forces can be calculated for each mode shape. For the structure shown in 

Figure 17.1, Table 17.1 summarizes the two base reactions and thtee overtuming 

moments associated with each mode shape. Since vertical rnass has been neglected 

there is no vertical reaction. The magnitudes of the forces and moments ha ve no 

meaning since the amphtude of a mode shape can be normalized to any value. 

However, the relative values of !he different components of the shears and moments 

associated with each mode are of considerable value. The modes with a large 

torsional componen! are highlighted in bold. 
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Table 17.1. Three Dimensional Base Forces and Moments 

MDDE PERIOD MODAL BASE SHEAR MODAL OVERTURNING 

REACTIONS MOMENTS 

Seconds X-DIR Y-DIR Anqle DeQ. X-AXIS Y-AXIS Z-AXIS 

1 .6315 .781 .624 38.64 -37.3 46.6 -18.9 

2 .6034 -.624 .781 -51.37 -46.3 -37.0 38.3 

3 .3501 .785 .620 38.30 -31.9 40.2 85.6 

4 .1144 -.753 -.658 41.12 12.0 -13.7 7.2 

5 .1135 .657 -.754 -48.89 13.6 11.9 -38.7 

6 .0706 .989 .147 8.43 -33.5 51.9 2438.3 

7 .0394 -.191 .982 -79.01 -10.4 -2.0 29.4 

8 .0394 -.983 -.185 10.67 1.9 -10.4 26.9 

9 .0242 .848 .530 32.01 -5.6 8.5 277.9 

10 .0210 .739 .673 42.32 -5.3 5.8 -3.8 

11 .0209 .672 -.740 -47.76 5.8 5.2 -39.0 

12 .0130 -.579 .815 -54.63 -.8 -8.8 -1391:9 

13 .0122 .683 .730 46.89 -4.4 4.1 -6.1 

14 .0122 .730 -.683 -43.10 4.1 4.4 -40.2 

15 .0087 -.132 -.991 82.40 5.2 -.7 -22.8 

16 .0087 -.991 .135 -7.76 -.7 -5.2 30.8 

17 .0074 -.724 -.690 43.64 4.0 -4.2 -252.4 

18 .0063 -.745 -.667 41.86 3.1 -3.5 7.8 

19 .0062 -.667 .745 -48.14 -3.5 -3.1 38.5 

20 .0056 -.776 -.630 39.09 2.8 -3.4 54.1 

21 .0055 -.630 .777 -50.96 -3.4 -2.8 38.6 

22 .0052 .776 .631 39.15 -2.9 3.5 66.9 

23 .0038 -.766 -.643 40.02 3.0 -3.6 -323.4 

24 .0034 -.771 -.637 39.58 2.9 -3.5 -436.7 

A careful examinarion of the directional properties of the three dimensional mode 

shapes at the early stages of a preliminary design can gtve a structural engineer 

additional information which can be used to improve the earthquake resistan! design 

of a structure. The current code defines an "irregular structure" as one which has a 

certain geometric shape or in which stiffness and mass discontinuities exist. A far 
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more rat10nal definition is that a '"regular structure" is one in which there is a 

minimum coupling between the lateral displacements and the torsional rotat10ns for 

the mode shapes associated with the lower frequencies· of the system. Therefore, if 

the model is modified and "tuned" by studying the three d1mensional mode shapes 

during the preliminary design phase, it may be possible to com•en a '"geometrically 

irregular" structure to a "dynamically regular" structure from an eanhquake­

resistant design standpoint. 

Table 17.2. Three Dimensional Participating Mass- (percent) 

MODE X-DIR Y-0/R Z-DIR X·SUM Y-SUM Z-SUM 

1 34.224 21.875 .000 34.224 21.875 .000 

2 23.126 36.212 .000 57.350 58.087 .000 

3 2.003 1.249 .000 59.354 59.336 .000 

4 13.106 9.987 .000 72.460 69.323 .000 

5 9.974 13.102 .000 82.434 82.425 .000 

6 
.. .002 .000 .000 82.436 82.425 .000 

7 .293 17.770 .000 82.729 90.194 .000 

8 .. 7.72" 1 .274 .000 90.455 90.469 .000 

9 .039 .015 .000 90.494 90.484 .000 

10 ·- 2.382 1.974 .000 92.876 92.458 .000 

11 1.955 2.370 .000 94.831 94.828 .000 

12 .000 .001 .000 94.831 94.829 .000 

13 1.113 1.271 .000 95.945 96.100 .000 .. 
14 1.276 1.117 .000 97.220 97.217 .000 

15 .028 1.556 .000 97.248 98.773 .000 

16 1.555 .029 .000 98.803 98.802 .000 

17 .011 .010 .000 98.814 98.812 .000 

18 .503 .403 .000 99.316 99.215 .000 

19 .405 .505 .000 99.722 99.720 .000 

20 .102 .067 .000 99.824 99.787 .000 

21 .111 .169 .000 99.935 99.957 .000 

22 .062 .041 .000 99.997 99.998 .000 

23 .003 .002 .000 100.000 100.000 .000 

24 .001 .000 .000 100.000 100.000 .000 
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For this building, it is of interest to note that the mode shapes. which tend to have 

directions that are 90 degrees apart, have almos! the same value for their period. 

This is typical of three dimensional mode shapes for both regular and irregular 

buildings. For regular synunetric structures, which have equal stiffness in all 

directions, the periods associated with the lateral displacements will result in pairs of 

identical periods. However, the directions associated with the pair of three 

dimensional mode shapes are not mathematically unique. For identical periods, most 

computer programs allow round-off errors to produce two mode shapes with 

directions which differ by 90 degrees. Therefore, the SRSS method should not be 

used to combine modal maximums in three dimensional dynamic analysis. The 

CQC method eliminates problems associated with closely spaced periods. 

For a response spectrum analysis, the current code states that "at least 90 percent of 

the participating mass of the. structure must be included in the calcula !ion of 

response for each principal direction." Therefore, the number of modes to be 

evaluated must satisfy this requirement. Most computer programs automatically 

calculate the participating mass in all directions· using the equations presented in 

Chapter 13. This requirement can be easily satisfied using LDR vectors. For the 

structure shown in Figure 17.1, the participating mass for each .mode and for each 

direction is shown in Table 17.2. For this building, only eight·modes are required to 

satisfy the 90 percent specification in both the x and y directions. · 

17.4. THREE DIMENSIONAL DYNAMIC ANAL VSIS 

lt is possible to conduct a dynamic, time-history, response analysis by either the 

mode superposition or step-by-step methods of analysis. However, a standard time­

history ground motion, for the purpose of design, has not been defined. Therefore, 

most engineers use the response spectrum method of analysis as the basic approach. 

The first step in a response spectrum analysis is the calculation of the three 

dimensional mode shapes and frequencies as indicated in the previous section. 

17.4.1. Dynamic Design Base Shear 

For dynamic analysis, the 1994 UBC requires that the "design base shear", V, is to 

be evaluated from the following formula: 

V = [ Z 1 C 1 Rw ] W (17.1) 
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Where 

Z = Seismic zone factor given in Table 16-1. 

1 Importance factor given in Table 16-K. 

Rw= Nwnerical coefficientgiven in Table 16-N or 16-P. 

W = The total seismic weight of the structure. 

e = Numerical coefficient (2. 75 maximum value) determined from: 

e = 1.25 S/ T213 (1-2) 

Where 

S· = Si:e coefficient for soil characteristics given in Table 16-J. 

T = Fundamental period ofvibration (seconds). 

The period, T, determined from the three dimensional computer model, can be used 

for most cases. This is essentially Method B of the code. 

Since the computer model often neglects nonstructural stiffness, the code requires 

that Method A be used under certain conditions. Method A defines the period, T, as 

follows: 

T = e, h31
' (l-3) 

where h is the height of the structure in feet and C. is defmed by the code for various 

types of structural systems. 

The Period calculated by Method B cannot be taken as more than 30% longer than 

that computed using Method A in Seismic Zone 4 and more than 40% longer in 

Seismic Zones 1, 2 and 3. 

For a structure that is defined by the codeas "regular", the design base shear may be 

reduced by an additional 1 O percent. However, it must not be less than 80 percent 

of the shear calculated using Method A. For an "irregular" structure this reduction 

is not allowed. 

.•. ........ , 

_,, .. ,. 
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17 .42. Definition of Principal Directions 

A weakness in the current code is the lack of definition of the "principal horizontal 

directions" for a general three dimensional structure. If each engineer is allowed to 

se!ect an arbitrary reference system, the "dynamic base shear" will not be unique 

and each reference system could result in a different design. One solution to this 

problem, that will result in a unique design base shear, is to use the direction of the 

base shear associated with the fundamental mode of vibration as the definition of the 

"majar principal direction" for the structure. The "minar principal direction" will 

be, by defmition, ninety degrees from the majar axis. This approach has sorne 

ratio na! basis since it is va! id for regular structures. Therefore, this definition of the 

principal directions will be used for the method of analysis presemed in this chapter. 

17 .4.3. Directional and Orthogonal Effects 

The required design seismic forces may come from any horizontal direction and. for 

the purpose of design, they may be assumed to act non-concurrently in the direction 

of each principal axis of the structure. In addition, for the purpose of member 

design, the effects of seismic loading in two orthogonal directions may be combined 

on a square-root-of-the-sum-of-the-squares (SRSS) basis. (Aiso, it is allowable to 

design members for 100 percent of the seismic forces in one direction plus 30 

percent of the forces produced by the loading in the other direction. We. will not use 

this approach in the procedure suggested here for reasons presented in Chapter !5.) 

17.4.4. Basic Method of Seismic Analysis 

In arder to satisfy the curren! requirements, it is necessary to conduct two separate 

spectrum analyses in the majar and minar principal directions (as defined abo ve). 

Within each of these analyses, the Complete Quadratic Combination (CQC) method 

is used to accurately account for modal interaction effects in the estimation of the 

maxirnum response values. The spectra used in both of these analyses can be 

obtained directly from the Norrna!ized Response Spectra Shapes given by the 

Uniforrn Building Code. 

17.4.5. Scaling of Results 

Each ofthese analyses will produce a base shear in the majar principal direction. A 

single value for the "dynamic base shear" is calculated by the SRSS method. Also, 
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a "dynamic base shear" can be calculated in the minar principal direction. The next 

step is to scale the previously used spectra shapes by the ratio of "design base 

shear" to the minimum value of the "dynamic base shear". This approach is more 

conservative than proposed by the curren! requirements, since only the scaling factor 

that produces the largest response is used. However, this approach is far more 

rational since it results in the same design earthquake in all directions. 

17.4.6. Dynamic Displacements and Member Forces 

The displacement and force distribution are calculated using the basic SRSS method 

to combine the results from 100 percent of the scaled spectra applied in each 

direction. If two analyses are conducted in any two orthogonal directions. in which 

the CQC method is used to combine the modal maximums for each analysis, and the 

results are combined by the SRSS method, exactly the same results will be obtained 

regardless of the orientation of the orthogonal reference system. Therefore. the 

direction of the base shear of the first mode defines a reference system for the 

building. 

If site-specific spectra are given, for which scaling is not required, any orthogonal 

reference system can be used. In either case, only one computer run is necessary to 

calculate all member forces to be used for design. 

17.4.7. Torsional Effects 

Possible torsional ground motion, the unpredictable distribution of live load mass 

and the variations of structural properties ·are three reasons why both regular and 

irregular structures must be designed for accidental torsional loads. Also, for a 

regular structure lateral!oads do not excite torsional modes. One method suggested 

in the Code is to conduct severa! different dynamic analyses with the mass at 

different !ocations. This approach is not practica! since the basic dynamic 

properties ofthe structure (and the dynamic base shears) would be different for each 

analysis. In addition, the selection of the maximum member design [orces would be 

a monumental post-processing problem. 

The curren! Code allows the use of pure static torsional !oads to predict the 

additional design forces caused by accidental torsion. The basic vertical distribution 

of lateral static !oads is given by the Code equations. The static torsional moment at 

. ' ~;. 

.. ... , . --. 

,. 
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any leve! is calculated by the multiplication of the static load at that leve! by 5 

percent of the rnaximum dimension at that leve!. In this book it is recommended that 

these pure torsional static loads, applied at the center of mass at each leve!, be used 

as the basic approach to account for accidental torsionalloads. This static torsional 

load is treated as a separate load condition so that it can be appropriately combined 

with the other static and dynantic loads. 

17.5. NUMERICAL EXAMPLE 

To illustrate the base-shear scaling method recommended here, a static seisntic 

analysis is conducted on the building shown in Figure 17.1. The eight-story building 

has 1 O feet story heights. The seisntic dead load is 238.3 kips for the top four 

stories and 363.9 kips for the lower four stories. For I = 1, Z = 0.4, S= 1.0. and 

Rw = 6.0. the evaluation of Equation 17.1 yields·the design base forces given in 

Table 17.3.Table 17.3. Static Design Base Forces Using The Uniform Buildmg 

Code 

Period.(sec) Angle (deg) Base Shear Overturning 

Moment 

0.631 38.64 279.9 14,533 

0.603 -51.36 281.2 14,979 

The norrnalized response spectra shape for soil type 1, which is defined in the 

Uniform Building Code, is used as the basic Joading for the three dimensional 

dynantic analyses. Usmg eight modes only and the SRSS method of combining 
modal rnaxima, the base shears and overturning moments are surnrnarized in Table 

1 7.4 for various directions ofloading. 



SEISMIC ANAL YSIS MODELING 13 

Table 17.4. Dynamic Base Forces Using The SRSS Method 

BASE SHEARS OVERTURNING MOMENTS 

Angle -deg v, V2 M, M2 

o 58.0 55.9 .2982 3073 

90 59.8 55.9 2983 3185 

38.64 70.1 5.4 66 4135 

-51.36 83.9 5.4 66 4500 

The 1-axis is in the direction of the seisrnic input and the 2-axis is normal to the 

direction of the loading. This example clearly illustrates the rnajor weakness of the 

SRSS method of modal combination. Unless the input is in the direction of the 

fundamental mode shapes, a large base shear is developed normal to the direction of 

the inpu\ and the dynarnic base shear in the direction of the input is significantly 

underestirnated as illustrated in Chapter 15. 

As indicated by Table 17.5, the CQC method of modal combination elirninates 

problems associated with the SRSS method. Also, it clearly illustrates that the 

directions of 38.64 and -51.36 degrees are a good definition of the principal 

directions for this structure. Note that the directions of the base shears of the first 

two modes differ by 90.00 degrees. 

Table 17.5. Dynamic Base Forces Using The CQC Method 

BASE SHEARS OVERTURNING MOMENTS 

Angle -deg v, v2 M, M2 

o 78.1 20.4 1202 4116 

90 79.4 20.4 1202 4199 

38.64 78.5 0.2 3.4 4145 

-51.36 84.2 0.2 3.4 4503 

Table 17.6 summarizes the scaled dynarnic base forces to be used as the basis for 

design by two different methods. 

. ' 
•• --,¡.;. 
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Table 17.6 Normalized Base Forces In Principal Directions 

38.64 Degrees -51.36 Degrees 

V M(ft· V M(ft-kips) 

(kips) kips) (kips) 

Static Code Forces 279.9 
1 

14,533 281.2 14,979 

Dynamic Design Forces 279.9 14,732 299.2 16,004 
Scaled by Base Shear 

279.9/78.5 = 3.57 

For this case. the input spectra scale factor of 3.57 should be used for all directions 

and is based on the fact that both the dynamic base shears and the dynamic 

overturning moments must not be less than the static code forces. This approach is 

clearly more conservative than the approach suggested by the current Uniforrn 

Building Code.· It is apparent that the use of different scale factors for a design·. 

spectra in the two different directions, as allowed by the code, results in a design 

that has a weak direction relative to the other principie direction. 

17.6. DYNAMIC ANALVSJS METHOD SUMMARY 

In this section, a dynamic analysis method is surnmarized that produces unique 

design displacements and member forces which will satisty the current Uniforrn 

Building Code. It can be used for both regular and irregular structures. The major 

steps in the approach are as follows: 

1. A three dimensional computer model must be created in which all significan! 

structural elements are modeled. This model should be used in th'e early phases of 

design since it can be used for both static and dynamic loads. 

2. The three dimensional mode shapes should be repeatedly evaluated during the 

design of the structure. The directional and torsional properties of the mode 

shapes can be used to improve the design. A well-designed structure should have 

a minirnum amount of torsion in the mode shapes associated with the lower 
frequencies of the structure. 
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3. The direction of the base reaction of the mode shape associated with the 

fundamental frequency of the system is used to define the principal directions of 

the three dimensional structure. 

4. The "design base shear" is based on the longest period obtained from the 

computer model, except when hmited to 1.3 or 1.4 times the Method A calculated 

period. 

5. Using the CQC method, the "dynamic base shears" are calculated in each 

principal direction dueto 100 percent ofthe Normalized Spectra Shapes. Use the 

minimum value of the base shear in the principal directions to produce one 

"scaled design spectra". 

6. The dynamic displacements and mcmber forces are calculated using the SRSS 

val u e of 1 00 percent of the scaled ciesign spectra applied non-concurrently in any 

two orthogonal directions as presented in Chapter 15. 

7. A pure torsion static load condition is produced using the suggested vertical 

lateral load distribution defined in the code. 

8. The member design forces are calculated using the following load combination 

rule: 

FoESIG~ = FoEADLOAD ± 1 FoY~AMIC + 1 FroRSION 11 + FornER 

The dynamic forces are always positive and the accidental torsional forces mus! 

always increase the value of force. If vertical dynamic loads are to be considered, a 

dead load factor can be applied. 

One can justify many other methods of analyses that will satisfy the current code. 

The approach presented in this chapter can be used directly with the computer 

programs ET ABS and SAP2000 with their steel and concrete post-processors. 

Since these programs ha ve very large capacities and operate on personal computers, 

it is possible for a structural engineer to investigate a large number of different 

designs very rapidly with a minimum expenditure of manpower and computer time. 

~···· , .. . .. .~.. 

',i,', . . • ,•::t 
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17.7. SUMMARY 

After being associated with the three dimensional dynamic analysis and design of a 

large number of structures during the past 40 years, the author would like to take 

this opportunity to offer sorne constructive comments on the lateral load 

requirements of the currcnt code. 

First: the use of the "dynamic base shear" as a significan/ indication of the 

response of a structure may not be conservative. An examination ofthe modal base 

shears and overturning moments in Tab!es 17.1 and 17.2 clearly indicates that base 

shears associated with the shorter periods produce relatively small overtuming 

moments. Therefore, a dynamic analysis, which will contain higher mode response, 

will always produce a larger dynamic base shear relative to the dynamic overtuming 

moment. Since the code al!ows al! results to be scaled by the ratio of dynamic base 

shear to the static design base shear, the dynamic overtuming moments can be 

significantly less than the resu!ts of a simple static code analysis. A scale factor 

based on the ratio of the "static design overtuming moment" to the "dynamic 

overturning moment" would befar more logical. The static overturning moment can 

be calculated by using the static vertical distribution of the design base shear which 

is currently suggested in the code.: 

Second: for irregular structures. the use of the terminolog;• "period (or mode 

shape) in the direction under consideration" must be discontinued. The stiffness 

and mass properties of the structure define the directions of al! three dimensional 

mode shapes. The term "pnncipal direction" should not be used unless it is clcarly 

and uniquely defined. 

Thi~d: the scaling ofthe resulrs of a dynamic analysis should be re-examined. The 

use of site-dependent spectra is encouraged. 

Finally: it is not necessary ro distinguish between regular and irregular structures 

when a three dimensional dynamic analysis is conducted. lf an accurate three 

dimensional computer model is created, the vertical and horizontal irregularities and 

known eccentricities of stiffness and mass will cause the displacement and rotational 

components of the mode shapes to be coupled. A three dimensional dynamic 

analysis, based on these coupled mode shapes, will produce a far more complex 

response with larger forces than the response of a regular structure. It is possible to 
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predict the dynamic force distribution in a very irregular structure with the same 

degree of accuracy and reliabihty as the evaluauon of the force distribution in a very 

regular structure. Consequently. if the design of an irregular structure is based on a 

realistic dynamic force distribution. there is no logical reason to expectthat it will be 

any less earthquake resistant than a regular structure which was designed using the 

same dynamic loading. A reason why many irregular structures have a documented 

record of poor performance during earthquakes is that their designs were often based 

on approximate two dimensional static analyses. 

One majar advantage of the modeling method presented in this chapter is that one set 

of dynamic design forces. including the effects of accidental torsion. is produced 

with one computer run. Of greater significance. however, is the resulting structural 

design has equal resistance to seismic motions from all possible directions. 

17.8. REFERENCES 

l. Recommended Lateral Force Requirements and Commentary, 1996 Sixth 
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DAMPING ANO ENERGY 
DISSIPATION 

Linear Viscous Damping 
Is A Property Of The Computer Model 

And ls NotA Property Of A Real Structure 

19.1. INTRODUCTION 

In structural engineering, viscous, velocity-dependent damping is very difficult to 
visualize for most real structural systems. Only a small number of structures ha ve a 
finite number of damping elements where real viscous dynamic properties can be 
measured. In most cases modal damping ratios are used in the computer model to 
approximate unknown nonlinear energy dissipation within the siructure. 

Another form of damping, that is often used in the mathematical model for the 
simulation of the dynamic response of a structure, is proportional to the stiffness and 
mass of the structure. This is referred to as Rayleigh damping. Both modal and 
Rayleigh damping are used in arder to avoid the need to form a damping matrix 
based on thc physical properties of the real structure. 

In recent years, the addition of energy dissipation devices to the structure has forced 
the structural engineer to treat the energy dissipation in a more exact manner. In this 
chapter, the limitations of modal and Rayleigh damping will be discussed. In 
addition, detailed algorithms will be presented for numerical solution, by iteration, 
for severa) different types of nonlinear energy dissipation devices. 
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19.2. DAMPING IN REAL STRUCTURES 

lt is possible to estimate an "effective" viscous damping ratio d¡rectly from 
laboratory or field tests of structures. One method is to apply a static d1splacement 
by attaching a cable to the structure and then suddenly removing the load by cutting 
the cable. If the structure can be approximated by a single degree of freedom, the 
displacement response will be of the form shown in Figure 1 9.1. For multi-degree­
of-freedom structural systems, the response will involve the response of more modes 
and the test and the analysis method requrred to predict the damping ratios will be 
more complex. 

It should be pointed out that the decay of the typical displacement response only 
indica tes that energy dissipation is taking place. The cause of the energy dissipation 
may be due to many different effects such as material damping, joint friction and 
radiation damping at the supports. However, if it is assumed that all energy 
dissipation is due to linear viscous damping. the free vibration response is given by 
the following equation: 

(19.1) 

where 01 0 =OJ~ 

Figure 19.1. Free Vibration Test of Real Structures, Response vs. Time 
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Equation ( 19.1) can be evaluated at any two maximum poims m cycles apart and the 

following two equations are produced: 

u(2Jrn) =u. = u(O)e-(wlnnlwo 

The ratio of these two equations is 

21r m.= 
u. - <Jl-q; ---e 

un+l 

(19.2) 

(19.3) 

(19.4) 

Taking the natural 1ogarithm of this ratio and rewriting produces the following 

equation: 

.t = ln(u. !u ••• )~~- .t' or, .t .t ¡ P 
~ 2~rm ~ ~u¡=~ovl-~u-IJ (19.5) 

This equation can easily be so1ved for the damping ratio ~ by iteration. For 

example, ifthe decay ratio un+m is equal to 1.25 between two adjacent maximums, 

three iterations yield 

~ ~ 0.07023 ~ 0.07005 = 0.07005 

Field testing of real structures. subjected to small displacements, indicates typical 

damping ratios are less than two percent. Also, for most structures, the damping is 

not linear and is not proport10na! to the velocity. 

19.3. USE OF VISCOUS CAMPING IN ANAL YSIS 

In the elastic dynamic analysis of most structures subjected to earthquake motions it 

is very common to use five percent damping for all modes. However, this value, in 

most cases, has very little experimental or theoretical justification. Also, for mu!ti 

degree-of-freedom systems, the use of modal damping violates dynamic equilibrium 

and the fundamental laws of physics. For example, it is possible to calculate the 

··' 
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reactions, as a function of time, at the base of a structure by the following two 

methods: 

First, the inertia forces, at each mass point, can be calculated in a specific direction 

by the multiplication of the absolute acceleration in that d1rection times the mass at 

the point. In the case of earthquake loading, the sum of all these forces must be 

equal to the sum of the base reaction forces in that direction since no other forces act 

on the structure. 

Second, the member forces, at the ends of all members attached to reaction points, 

can be calculated as a function of time. The sum of the components of the member 

forces in the direction of the load is the base reaction force experienced by the 

structure. 

In the case of zero modal damping these reaction forces, as a function of time. are 

identical. However, for nonzero modal damping, these reaction forces are 

significantly different. These differences indicate that linear modal damping 

introduces externa! loads, acting on the structure above the base, which are 

physically impossible. This is clearly an area where the standard "state of the art" 

assumption of modal damping needs to be re-examined and an alternative approach 

must be developed. 

Energy dissipation exists in real structures. However, it must be in the form of 

equal and opposite forces between points within the structure. Therefore, a viscous 

damper, or any other type of energy dissipating device, connected between two 

points within the structure is physically possible and will not cause an error in the 

reaction forces. There must be zero base shear for all interna! energy dissipation 

forces. 

Another type of energy dissipation that exists in real structures is radiation damping 

at the supports ofthe structure. The vibration ofthe structure strains the foundation 

material near the supports and causes stress waves to radiate into the infinite 

foundation. This can be significan! if the foundation material is soft relative to the 

stiffness of the structure. A spring, damper and mass at each support often 

approximate this type of damping. 
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19.4. NUMERICAL EXAMPLE 

In arder to illustrate the errors involved in the use of modal damping a simple seven­

story building was subjected toa typical earthquake motion. Table 19.1 indicares 

the values of base shear calculated from the externa! inertia forces. which satisty 

dynamic equilibrium, and the base shear calculated from the exact summation of the 

shears at the base of the three columns at each time increment. 

lt is of interest to note that the maximum values of base shear, calculated from two 

different methods, are significantly different for the same computer run. The only 

logical explanation is the existence of externa! damping forces that exist only in the 

mathematical model of the structure. Since this is physically impossible, the use of 

standard modal damping can produce a small error in the analysis. 

TABLE 19.1. Comparison of Base Shear for Seven Story Building 

Damping Dynamic Equilibrium Su m of Column ERROR 

Percent BASE SHEAR (kips) SHEARS (kips) Percent 

o 370.7 @ 5.355 Sec. 370.7 @ 5.355 Sec. 0.0 

2 314.7 @ 4.690 Sec 318.6 @ 4.695 Sec +1.2 

5 253.7 @ 4.675 Sec 259.6 @ 4.690 Sec +2.3 

10 214.9 @ 3.745 Sec 195.4 @ 4.035 Sec -9.1 

20 182.3 @ 3.055 Sec 148.7 @ 3.365 Sec -18.4 

lt is of interest to note that the use of only five percent damping reduces the base 

shear from 371 kips to 254 kips for this example. Since the measurement of 

damping in most real structures has been found to be less than two percent the 

selection of five percent reduces the results significantly. 

19.5. STRUCTURES WITH LINEAR VISCOUS DAMPERS 

lt is possible to model structural systems with linear viscous dampers at arbitrary 

locations within a structural system. The exact solution involves the calculation of 

complex eigenvalues and eigenvectors and a large amount of computational effort. 

Since the basic nature of energy dissipation is not clearly defined in real structures 

and viscous damping is often used to approximate nonlinear behavior, this increase 

,,, 
·•'' 
·~ .. 
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in computational effort is not justified since we are not solving the real problem. A 

more efficient method to solve this problem is to move the damping force to the right 

hand side of the dynarnic equilibrium equation and sol ve the problem as a nonlinear 

problem using the FNA method. 

19.6. STIFFNESS ANO MASS PROPORTIONAL CAMPING 

A very common type of damping used in the nonlinear incremental analysis of 

structures is to assume that the damping matrix is proportional to the mass and 

stiffuess matrices. Or, 

C = 17 M+ t5 K (19.6) 

This type of damping is normally referred to as Rayleigh damping. In mode 

superposition analysis the damping matrix must have the fol!owing properties in 

order for the modal equations to be uncoupled: · 

( 19. 7) 

Due to the orthogonality properties of the mass and stiffness matrices, this equation 

can be rewritten as 

1 llJ 
or r =-n+-' t5 ' ~' 2 '/ 2 w, 

(19.8) 

It is apparent that modal damping can be specified exactly at only two frequencies in 
order to sol ve for 17 and t5 in the above equation. In addition, the assumption of 

mass proportional damping implies the existence of externa! supported dampers that 

are physically impossible for a base supported structure. The use of stiffness 

proportional damping has the effect of increasing the damping in the higher modes of 

the structure for which there is no physical justification and can result in significan! 

errors for impact type of problems. Therefore, the use of Rayleigh type of damping 

is difficult to justify for most structures. However, it continues to be used by many 

computer programs in order to obtain results for numerically sensitive structural 

systems. 
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19.7. NONLINEAR ENERGY DISSIPATION 

Most physical energy dissipation in real structures is in phase with the 

displacements and is a nonlinear function of the magnitude of the displacements. 

Nevertheless. it is common practice to approximate the nonlinear behavior with an 

"equivalen! linear damping" and not conduct a nonlinear analysis. The majar reason 

for this approximation is that alllinear prograrns for mode superposition or response 

spectrum analysis can consider linear viscous damping in an exact manner. This 

approximation is no longer necessary if the structural engineer can identifY where 

and how the energy is dissipated within the structural system. The FNA method 

provides an alternative to the use of equivalen! linear viscous damping. In this 

section various nonlinear devices will be discussed and their iterative solution 

algorithm will be summarized. 

Base isolators are one of the most cornmon types of predefined nonlinear elements 

used in earthquake resistan! designs. Mechanical dampers, friction devices and 

plastic hinges are other type of common nonlinear elements. In addition. gap 

elements are required to model contact between structural components and uplifting 

of structures. A special type of gap element, with the ability to crush and dissipate 

energy, is useful to model concrete and soil types of materials. Cables, that can take 

tension only and dissipate energy in yielding, are necessary to capture the behavior 

of many bridge type structures. 

19.8. BILINEAR PLASTICITY ELEMENT 

The general plasticity element can be used to model many different types of 

nonlinear material properties. The fundamental properties and behavior of the 

element are illustrated in the figure shown below: 

.,., 
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1 

~------------------------1 

Figure 19.2. Fundamental Behavior ofBilinear Plasticity E/ement 

Where k 
' 

initiallinear stiffness 

Yield stiffness 

Yield deforrnation 

The force-deformation relationship is calculated from 

f = k,. d + (k, - k,.) e ( 19.9) 

Where d is the total deforrnation and e is an elastic deformation term and has a 
range ± d,. . lt is calculated at ea eh time step by the numerical integration of one of 

the following differential equations: 

' e . 
If de ?: O e = (1 - !-¡-1 )d (19.10) 

y 

If de <O e = d (19.11) 

The following finite difference approximations, for each time step, can be made: 

d,- d, . ., 
d = 

tJ.t 
And e= 

tJ.t 

The numerical solution algorithm (six program statements) can be summarized at 
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the end ofeach time increment ó.t, at time" t "for iteration "i ",in Table 19.2. 

Table 19.2. Iterativa Algorithm For Bilinear Plasticity Element 

l. Change in deformation for time step Ó.l at time t for iteration i 

V= d{;J - d t t•t.J 

° Calculate elastic deformation for iteration i 

if v e~'·l) > O e1
,'
1 = e + (1 ,.¡u 

if e~'J > d,. ef'J = 
if ef'' < -d,. ef'J = 

3. Calcula te iterative force: 
f~i) = k d 01 + (k, - k ) (•1 

y 1 ¡· e1 

" 
/•-•• j) V 

d,. 

d,. 

-d,. 

9 

Note that the approximate term e, .• , is used from the end of the last time increment 
d,. 

e71 

rather than the iterative term 
d,. 

This approximation eliminates all problems 

associated with convergence for large values of n . However, the approximation has 

insignificant effects on the numerical results for all values of n . F or all practica! 

purposes, a value of n equal to 20 produces true bilinear behavior. 

19.9. DIFFERENT POSITIVE ANO NEGATIVE PROPERTIES 

The previously presented plasticity element can be generalized to have different 
positive, d, . and negative, d, , yield propenies. This will allow the same element 

to model many different types of energy dissipation devices such as the double 

diagonal Pall friction element. 

For constan! friction the double diagonal Pall element has k, =O and n = 20. For 

small forces both diagonals remain elastic, one in tension and one in compression. 
At sorne deformation, d" , the compressive element may reach a maximum possible 
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value. Friction slipping will start at the deformation u P after which both the tension 

and compression forces will remain constant until the maximum displacement for the 

load cycle is obtained. 

This element can be used to model bending hinges in beams or columns with non­

symmetric sections. The numerical solution algorithm for the general bilinear 

plasticity element is given in Table 19.3. 

Table 19.3. Iterativa Algorithm For Non-Symmetric Bilinear Element 

l. Change in deformation for time step D.t at time t for iteration i 

V - d") d 
- 1 - 1·~1 

2. Calculate elastic deformation for iteration i 
if V ¿•·/) $ 0 

if ve~-1) > O 

if ve~·n > O 

if ¿•J > d,. 

if e~'! < - d 1 

and e,_.,> O 

é,'' ; e, . ., + (1 -

and e,_.,< O 

¿1} = dy 

ef') = -dy 

+ (1 -

3. Calculate iterative force at time t : 

/ r•J ; k dr'J + (k - k ) m . 
1 y 1 e y e, 

,e,_, /") ¡-- V 
d,. 

e " 
/~/)v 

d, 

19.10. THE BILINEAR TENSION-GAP-YIELD ELEMENT 

The bilinear tension only element can be used to model cables connected to different 

parts of the structure. In the retrofit of bridges this type of element is often used al 

expansion joints to limit the relative movement during earthquake motions. The 

fundamental behavior of the element is summarized in Figure 19.3. The positive 
number d 0 is !he initial pre-stress deformation. A negative number specifies the 

axial deformation associated with initial cable sag. The permanent element yield 
deformation is u P. 
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1 
d, d, 

k,¡ 

L-~-------------1 

Figure 19.3. Tension-Gap-Yield Element 

The numerical solution a!gorithm for this element is summarized in Table 19.4. 

Note that the permanent deformation calcu!ation is based on the converged 

deformation .at the end of the !ast time step. This avoids numerical solution 

problems. 

Table 19.4. Iterativa Algorithm -Tension-Gap-Yield Element 

l. Update Tension Yield Deformation From Previous Converged Time Step 
y=d,_.,+d,-d)' 

if y < d P then d P = y 

2. Calculate Elastic Deformation for lteration (i) 
d =d(<} +d 

1 o 

1/1 = d -d p 

if e~'1 > d,. then ¿•J = d Y 

3. Calculate ltcrative Force: 

r = k,.(d~')-d,) +(k, - ky)e71 

if /,<•l >O then 1,<•! =O 
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19.11. NONLINEAR GAP-CRUSH ELEMENT 

Perhaps the most common type of nonlinear behavior that occurs in real structural 

systems is the closing of a gap between different pans of the structure; or. the 

uplifting ofthe structure at its foundation. The element can be used at abutment-soil 

interfaces and for modeling soil-pile contact. The gap/crush element has the 

followmg physical propenies; 

l. The element cannot develop a force until the opening d 0 gap is closed 

2. The element can only develop a compression force 

3. The crush deformation d P is always a monatomic decreasing negative number 

The numerical algorithm for the gap-crush element is summarized in Table 19.5. 

Table 19.5. lterative Algorithm To Model Gap-Crush Element 

l. Update Crush Deformation From Previous Converged Time Step 

y=d,_., +d0 +dr 

if y> d, then d, =y 

2. Calculate Elastic Deformation: 

-",'' = d(') +d -d er t n y 

l.f e1,'' < d h - ,. t en 

3. Calculate lterative Force: 

f~'i = ky(d~0 -d0 ) +(k, - k,.)ef1 

if J/' 1 >O then f/' 1 =O 

The numerical convergence of the gap element can be very slow if a large elastic 
stiffuess term k, is used. The user must take great care in selecting a physically 

realistic number. In arder to minimize numerical problems, the stiffuess k, should 

not be o ver 1 00 times the stiffness of the elements adjacent to the gap. The dynamic 

contact problem between real structural components often does no! have a unique 

solution. Therefore, it is the responsibility of the design engineer to select materials 



DAMPING ANO ENERGY DISSIPATION 13 

at contact points and surfaces to have realistic material properties that can be 

predicted accurately. 

19.12. VISCOUS CAMPING ELEMENTS 

Linear velocity-dependent energy-dissipation forces exist m only a few special 

materials subjected to srnall displacements. In tenms of equivalen! model damping, 

experiments indicate that they are a small fraction of one percent. Manufactured 

mechanical dampers cannot be made with linear viscous properties since all fluids 

ha ve finite compressibility and nonlinear behavior is present in all rnanmade devices. 

In the past it has been common practice lo approximate the behavior of these 

viscous nonlinear elements by a simple linear viscous force. More recently, vendors 

ofthese devices have claimed that the damping forces are proportional toa power of 

the velocity. Experimental examination of a mechanical device indicates a far more 

complex behavior that cannot be represented by a simple one-element model. 

The FNA method does not require that these damping devices be linearized or 

simplified in arder to obtain a numerical solution. If the physical behavwr is 

understood it is possible for an iterative solution algorithm to be developed which 

will accurately simulate the behavior of almos! any type of damping device. In arder 

to illustrate the procedure let us consider the device shown in Figure 19.4. 

/
Ul =k d(') 

p p 1 

Figure 19.4. General Damping Element Connected Between Points 1 and J 

It is apparent that the total deformation, e,<,¡, across the damper must be accurately 

calculated in arder to evaluate the equilibrium within the element at each time step. 

The finite difference equation used to estimate the damper deforrnation at time 1 is 
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(19.12) 

A summary ofthe numerical algorithm is summarized in Table !9.6. 

Table 19.6. Iterative Algorithm For Non linear Viscous Element 

l. Estima te damper force from Iast iteration: 

/,1<~ = k(d,1'l -e~•-'J) 

2. Estímate damper velocity: 

l') 1 

i/0 = (-'-)" sig~(J;.1 ' J) 
e 

3. Estima te damper deformation: 

,¡- _1_. •(1) .!/ -e,_., + 
2

!J.t (e,_., l +e, ) 

4. Calculare total iterative force: 

f !i! = k d!i1 +k (d 10 - e!i1) 
1 f' 1 S 1 1 

19.13. SUMMARY 

The use of linear modal damping, as a percentage of critica! damping. has been used 

to approximate the nonlinear behavior of structures. The energy dissipation in real 

structures is far more complicated and tends to be proportional to displacements 

rather than proportional to the velocity. The use of approximate '·equivalen! viscous 

damping" has little theoretical or experimental JUStification. 

lt is now possible to accurately simulate the behavior of structures with a finite 

number of discrete energy dissipation devices installed. The experimental 

determined properties of the devices can be directly incorporated into the computer 

model. 
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DYNAMIC ANALYSIS BY 
NUMERICAL INTEGRATION 

Normal/y, For Eartlzquake Loading 
Direct.Numerical Integration /s Very Slow 

20.1 INTRODUCTION 

The most general approach for the solution of the dynamic response of structural 

systems is the direct numerical integratíon of the dynamic equilibrium equations. 

This involves, after the solution is defined at time zero, the attempt to satisty 

dynamic equilibrium at discrete points in time. Most methods use equal time 
intervals at !J.t, 2!J.t, 3tJ.t ........ N!J.t. Many different numerical techniques 

have previously been presented; however. all approaches can fundamentally be 

classified as either explicit or imp/icit integration methods. 

Explicit methods do not in vol ve the solution of a set of linear equations at each 

step. Basically, these methods use the differential equation at time "t "to predict a 

solution at time "t + !J.t ". For most real structures, which contain stiff elements, a 

very small time step is required in order to obtain a stable solution. Therefore, all 

explicit methods are conditionally stable with respect to the size ofthe time step. 

lmplicit methods attempt lo satisfy the differential equation at time "t " after the 

solution at time "t- !J.t" is found. These methods require the solution of a set of 

linear equations at each time step; however, larger time steps may be used. 

lmplicit methods can be conditionally or unconditionally stable. 
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There exist a large number of accurate. higher·order. multi-step methods that ha ve 

been developed for the numerical solution of differential equations. These multi­

step methods assume that the so!ution is a smooth function in which the higher 

derivatives are continuous. The exact soiution of many nonlinear structures 

requires that the acce!erations. the second denvative of the displacements, are not 

smooth functions. This discontinuity of the acceleration is caused by the nonlinear 

hysteresis of most structura! materials, contact between pans of the structure. and 

buckling of elements. Therefore, only single-step methods will be presented in this 

chapter. Based on a significan! amount of experience, it is the conclusion of the 

author that only single-step, implicit, unconditional stable methods be used for the 

step-by-step seismic analysis of practica! structures. 

20.2 NEWMARK FAMILY OF METHODS 

In 1959 Newmark [ !] presented a family of single-step imegration methods for the 

so!ution of structural dynamic problems for both blast and seismic loading. During 

the past 40 years Newmark's method has been applied to the dynamic analysis of 

many practica! engineering structures. In addition, it has been modified and 

improved by many other researchers. In arder to illustrate the use of this family of 

numerical integration methods consider the solution of the linear dynamic 

equilibrium equations written in the following form: 

Mü, + Cu, + Ku, = F, (20.1) 

The direct use of Taylor's series provides a rigorous approach to obtain the 

following two additional equations: 

(20.2a) 

(20.2b) 
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Newmark truncated these equations and expressed them in the following form: 

(20.2a) 

u, =u,.,, +t>tü,.,, +yt>t2u (20.2b) 

If the acceleration is assumed to be linear within the time step, the following 

equation can be wrl!ten: 

¡¡ = (ü, - ü,_,,) 

D.t 
(20.3) 

The substitution of Equation (20.3) into Equations (20.2a and b) produces 

Newmark's equations in standard form 

- - + . + 1 2·· 2·· u,- u,_,, D.to,_,, (2- fJ)t>t u,_, +/3 D.t u, (20.4a) 

u, =u,_,, + (!-¡ J t>t ü,_,, + 1 t>t ü, (20.4b) 

Newmark used Equations (20.4a, 20.4b and 20.1) iteratively, for each time step, for 
each displacement DOF of the structural system. The term ü, was obtained from 

Equation (20.1) by dividing the equation by the mass associated with the DOF. 

In 1962 Wilson [2] formulated Newmark's method in matrix notation, added 

stiffness and mass proportional damping, and eliminated the need for iteration by 

introducing the direct solution of equations at each time step. This requires that 

Equations (20.4a and 20.4b) be rewritten in the following form: 

u, =b,(u, -u,_,,)+b5u,_,, +b6ü,_,, (20.5b) 

where the constants b, to b6 are defined in Tabl~ 20.1. The substitution of 

Equations (20.5a and20.5b) into Equation (20.1) allows the dynamic equilibrium of 

the system at time "t "to be written in terms of the unknown node displacements 
u,. Or, 

... 
.. .. 
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(20.6) 

The Newmark direct integration algorithm is summarized in Table 20.1. Note that 
the constants b, need be calculated only once. Also. for linear systems. the 

effective dynamic stiffness matrix K is formed and triangularized only once. 

20.3 STABILITY OF NEWMARK'S METHOD 

For zero damping Newmark's method is conditionally stable if 

1 
y>­- 2' 

1 
fl$-

2 
(20.7) 

where llJ MAX is the maximum frequency in the structural system [ 1]. Newmark's 

method is unconditionally stable if 

1 
2/l~r~-

2 
(20.8) 

However, if "} is greater than V>, errors are introduced. These errors are associated 

with "numerical damping" and "period elongation". 

For large multi degree-of-freedom structural systems the time step limit, given by 

Equation (20. 7), can be written in a more useable formas 

At 1 
$--¡==;o= 

2n~/S- f3 
(20.9) 

Computer models of large real structures normally contain a large number of 

periods which are smaller than the integration time step; therefore, it is essential 

that one select a numerical integration method that is unconditional for all time 

steps. 
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Table 20.1. Summary of the Newmark Method for Direct lntegration 

l. INITIAL CALCULA TION 

A. Form static stiffness matrix K, mass matrix M and damping matrix C 

B. Specify integration parameters f3 and ¡ 

C. Calculate integration constants 

b =-!­
¡ jJD.t' 

b =-!-
2 fJ D.t 

b, = 1 + 1 D.t b, b6 =D.! (1 + 1 b, -¡ ) 

D. Form effective stiffness matrix K= K +b1M +b4C 

E. Triangularize effective stiffness matrix K= LDLT 

F. Specify initial conditions u 0 , i10 , Ü0 

II. FOR EACH TIME STEP t = !:J.t, 2!:J.t, 3D.t 

A. Calculate effective load vector 

B. Salve for nade displacement vector at time t 

T -LDL u, =F, forward and back-substitution only 

C. Calculate node velocities and accelerations at time t 

D. Go to Step Il.A with t = t + !:J.t 

5 
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20.4 THE AVERAGE ACCELERATION METHOD 

The average acceleration method is identical to the trapezoidal rule that has been 

used to numerically evaluate second arder differential equations for approximately 

100 years. lt can easily be derived from the following truncated Taylor's series 

expansion: 

(20.1 O) 

. r' ü +ü 
~u +ru +-( •·•• ') 

t·At t-6t 2 2 

where 1 is a variable point within the time step. 

obtained by differentiation of Equation (20.1 O). Or, 

The consisten! velocity can be 

(20.11) 

If 1 = t.t 

(20.12a) 

. . t.t .. Llt .. 
u, =u,_., +-u, .. +-u 

" 2 ·= 2 ' 
(20.12b) 

These eguations are identical to Newrnark's Equations (20.4a and b) with 1 = 112 

and/3=114. 

lt can easily be shown that the average acceleration method conserves energy for 

the free vibration problem, Mü + Ku =O, for all possible time steps [4] .. 

Therefore, the sum ofthe kinetic and strain energy is constan!. Or, 

2E . TM. TK . T M. T K = ut ut + ut ut = ut-At ut-At + ut-& ut-.~t (20.13) 
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20.5 WILSON'S e FACTOR 

In I 973, the general Newmark method was made unconditionally stable by the 
introduction ofa 6 factor [3]. The introduction ofthe 6 factor is motivated by the 

observation that an unstable solution tends to oscillate about the true solution. 

Therefore, if the numerical solution is evaluated within the time increment the 

spurious oscillations are minimized. This can be accomplished by a simple 

modification to the Newmark method by using a time step defined by 

.1t' = 6 .1t (20.14a) 

and a load defined by 

(20.14b) 

where 6~ 1.0. After the acceleration ü,. -vector is evaluated by Newmark's 

method at the integration time step 6 .1t, values of node accelerations, velocities 

and displacements are calculated from the following fundamental equations: 

il, = il,.,, + (1-¡) .1t ü,.,, + 1 .1t ü, 

(20.15a) 

1 
(20.15b) 

(20.15c) 

The use of the e factor tends to numerically damp out the high modes of the 

system. If 6 equals 1.0 Newmark"s method is not modified. However. for 

problems where the higher mode response is importan!, the errors that are 

introduced can be large. In addition, the dynamic equilibrium equations are not 

exactly satisfied at time t . Therefore, the author no longer recommends the use 

of the 6 factor. At the time of the introduction of the method, it solved all 

problems associated with stability of the Newmark family of methods. However, 

during the past twenty years new and more accurate numerical methods ha ve been 

developed. 
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20.6 THE USE OF STIFFNESS PROPORTIONAL DAMPING 

Because of the unconditiona1 stability of the average acceleration method, it is the 
most robust method to be used for the step-by-step dynamic analysis of large 

complex structural systems in which a 1argc number of high frequencies, short 

periods. are present. The only problem with the method is that the short periods, 

which are smaller than the time step, oscillate indefinitely after they are excited. 
The higher mode oscillation can be reduced by the addition of stiffness 

proportional damping. The additional damping that is added to the system is of the 

form 

e =ó K D (20.16) 

where the modal damping ratio, given by Equation (8.8) is defined by 

1 ¡¡ 
;: =-0 (J) =-0 
'>n 2 n T 

n 

(20.17) 

One notes that the damping is large for. short periods and small for the long periods 

or low frequencies. 1t is apparent that periods which are greater than the time step 
cannot be integrated accurately by any direct integration method. Therefore. it is 

logica1 to damp these short periods to prevent them from oscillating during the 
solution procedure. For a time step equa1 to the period, Equation (20.17) can be 

rewritten as 

(20.18) 

Hence, if the integration time step is 0.02 seconds and we wish to assign a 
mínimum of 1.0 to all periods shorter than the time step, a va1ue of Ó = 0.0064 

should be used. The damping ratio in al! modes is now predictab1e for this 

examp1e from Equation (20.17). Therefore, the damping ratio for a 1.0 second 

period is 0.02 and for a 0.1 O second period is 0.2. · 
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20.7 THE HILBER, HUGHES ANO TAYLOR a METHOD 

The a method [4) uses the Newmark method to salve the following modified 

equations of motion: 

Mü, +(l+a)Cú, +(l+a) Ku, = (l+a)F, 
(20.19) 

-aF, +aCú,_"' +aKu,_"' 

With a equals zero the method reduces to the constant acceleration method. 1t 

produces numerical energy dissipation in the higher modes; however, it cannot be 

predicted as a damping ratio as in the use of stiffness proponional damping. Also, 

it does not salve the fundamental equilibrium equation at time t. However, it is 

currently being used in many computer programs. The performance of the method 

appears to be very similar to the use of stiffness proponional damping. 

20.8 SELECTION OF A DIRECT INTEGRATION METHOD 

It is apparent that a large number of different direct numerical integration methods 

are possible by specifying different integration parameters. A few of the most 

commonly used methods are summarized in 20.2. 

Table 20.2. Summary of Newmark Methods Modified by the ¡) Factor 

METHOD ¡ fJ ~ 
Ó[ ACCURACY -

T MI~ 

Central Difference 112 o o 0.3183 Excellent for small .1t 

Unstable for large .1t 

Linear Acceleration 112 1/6 o 0.5513 Very good for small .1t 

Unstable for large .1! 

Average Acceleration 1/2 114 o 00 Good for small .1t 
No energy dissipation 

Modified Average 112 114 t>.T 00 Good for small .1! - EnergY. dissipation for 
Acceleration 1l large ílt 

•. 
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For single degree-of-freedom systems the central difference method is most 

accurate; and the linear acceleration method is more accurate than the average 

acceleration method. However, if only single degree-of-freedom systems are to be 

integrated the piece-wise exact method, previously presented. should be used smce 

there is no need to use an approximate method. 

lt appears that the modified average acceleration method, with a minimum addition 

of stiffness proportional damping, is a general procedure that can be used for the 

dynarnic analysis of all structural systems. Using el = .ó. T 1 ¡¡ will damp out 

periods shorter than the time step and introduces a rninimum error in the long 

period response. 

20.9 NONLINEAR ANAL YSIS 

The basic Newmark Constan! acceleration method can be extended to nonlinear 

dynarnic analysis. This requires that iteration must be perforrned at each time step 

in arder to satisfy equilibrium. Also, the incremental stiffness matrix must be 

formed and triangularized at each iteration or at selective points in time. Many 

different numencal tricks, including element by element methods, have been 

developed in order to rninimize the computational requirements. Also. the 

triangularization of the effective incremental stiffness matrix may be avoided by 

the introduction of iterative solution methods. 

20.10 SUMMARY 

For earthquake analysis of linear structures, it should be noted that the direct 

integration of the dynamic equilibrium equations is normally not numerically 

efficient as compared to the mode superposition method using LDR vectors. lfthe 

triangularized stiffness and mass matrices and other vectors cannot be stored in 

high-speed storage, !he computer execution time can be large. 

After using direct integration methods for approximately forty years, the author can 

no longer recommend the Wilson method for the direct integration of !he dynarnic 

equilibrium equations. The Newmark constan! acceleration method, with the 

addition of very small amount of stiffness proportional damping, is recommended 

for dynarnic analysis nonlinear structural systems. For all methods of direct 
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integration great care should be taken to make certain that the stiffness proportional 

damping does not eliminate 1mportant high-frequency response. Mass proportional 

damping cannot be justified because it causes externa! forces to be applied to the 

structure that reduce the base shear for seismic loading. 

In the area of nonlinear dynamic analysis one cannot preve that any one method 

will always converge. One should always check the error in the conservation of 

energy for every solution obtained. In future editions of this book it is hoped that 

numerical examples will be presented in arder that the appropriate method can be 

recommended for different c!asses of problems in structural analysis. 
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THE EIGENVALUE PROBLEM 

Eigenvalues And Eigenvectors Are Properties Of The 
Equations That Simulate The Behavior Of A Real Structure 

0.1 INTRODUCTION 

The classical mathematical eigenvalue problem is defined as the solution of the 

following equation: 

Av =Av n= !.. .... N 
" " " 

(0.1) 

The N by N A matrix is real and symmetric; however, it may be singular and ha ve 

zero eigenvalues A,. A typical eigenvector v" has the following orthogonality 

properties: 

vrv =1 and vrv =0 ifn;tm, therefore n n n m 

vrAv =A and vrAv =O ifn;tm 
n n n n m 

(0.2) 

If al! eigenvectors V are considered the problem can be written as 

AV= Vf.! or VTAV= Q (0.3) 

There are many different numerical methods to solve Equation (0.3) for 

eigenvectors V and the diagonal matrix of eigenvalues Q. In structural analysis, in 

general, it is only necessary to solve for the exact eigenvalues of small systems. 

Therefore, the most reliable and robust will be selected since the computational time 

will always be relatively small. For the determination of the dynamic mode shapes 
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and frequencies of !arge structural systems subspace iteration or Load Dependen! 

Ritz, LDR, vectors are the most efficient approaches. 

0.2 THE JACOBI METHOD 

One of the oldest and most general approaches for the solution of the classical 

eigenvalue problem is the Jacobi method that was first presented in 1846. This is a 

simple iterative algorithm in which the eigenvectors are calculated from the 

following series of matrix multiplications: 

(D.4) 

The staning transformation matrix T(OJ is set to a unit matrix. The iterative 

onhogonal transformation matrix Ttkl, with four nonzero terms in the i and j rows 

and columns, is of the following onhogonal form: 

T,, TsJ 

Tt'l = (D.5) 

Tjl Tff 

The four nonzero terms are functions of an unknown rotation angle 6 and are 

defined by 

T,, = TiJ = cosB and TJ' = -T" =sinO (D.6) 

Therefore, TtkJTT(kl = 1 which is independent of the angle6. The typical iteration 

involves the following matrix operation: 

(0.7) 

The angle is selected to force the terms i.j and j,i in the matrix A (kl to be zero. 

This is satisfied if the angle is calculated from 
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2A"-11 

tan 2(} = " (D.8) 
A¡< 11 _ A"-11 

u p 

The classical Jacobi eigenvalue algorithm is surnrnarized within the computer 

subroutine given in Table D.l. 

' 

Table 0.1 Subroutine to Solve the Symmetric Eigenvalue Problem 

e 
e 
e 
e 
e 
e 
e----

SUBROUTINE JACOBI(A,V,NEQ,TLJ 
IMPLICIT REAL•8 (A~H,O-ZJ 
DIMENSION A{NEQ,NEQ) ,V{NEQ,NEQ) 
EIGENVALUE SOLUTION BY JACOBI METHOD 
WRITTEN BY ED WILSON DEC. 25, 1990 
A - MATRIX (ANY RANK) TO BE SOLVED ---

EIGENVALUES ON DIAGONAL 
V - MATRIX OF EIGENVECTORS PRODUCEO 
TL- Nln-1BER OF SIGNIFICANT FIGURES 
INITIALIZATION ----------------------­
ZERO = O. ODO 
SUM .. ZERO 
TOL = DABS (TL) 

C---- SET INITIAL EIGENVECTORS -------------
00 200 1=1. NEQ 
DO 190 J:l,NEQ 
IF (TL.GT.ZERO) V(I,Jl = ZERO 

190 SUM = SUM ~ DABS(A(I,J)) 
IF (TL.GT.ZERO) V(!,I) = 1.0 

200 CONTINUE 
C---- CHECK FOR TRIVIAL PROBLEM ----------­

IF (NEQ.EQ.l) RETURN 
IF (SUM.LE.ZERO) RETURN 
SUM ~ SUM/DFLOAT(NEQ*NEQ) 

c-------------------------------------------
e---- REDUCE MATRIX TO DIAGONAL ------------
e-------------------------------------------

400 SSUM "' ZERO 
AMAX "' ZERO 
DO 700 J=2,NEQ 
IH .. J - 1 
DO 700 I=l,IH 

C---- CHECK IF A(I,J) IS TO BE REDUCED 
AA= DABS(A(I,J)) 
IF {AA.GT.AMAX) AMAX ., AA 
SSUM ., SSUM + AA 
IF {AA.LT.O.l*AMAX) GO TO 700 

C---- CALCULATE ROTATION ANGLE ---------­
AA.,ATAN2 (2. O*A(I,J) ,A(!, Il- (J,J)) /2 .O 
SI • DSIN (AA) 
ca "' neos fAAl 

C---- MODIFY "!" AND "J" COLUMNS --------
00 500 K=l,NEQ 
TT.,A(K,I) 
A(K,Il = CO*TT + SI*A(K,J) 
A(K,J) = -SI*TT + CO*A(K,J) 
TT "' V(K, I) 
V(K,I) = CO*TT + SI*V(K,J) 

500 V(K,J) = -SI*TT + CO*V(K,Jl 
C---- MODIFY DIAGONAL TERMS ------------­

A(I.IJ = CO*A(I,Il + SI*A(J,I) 
A(J,J) .. -SI*A(I,J) + CO*A(J,J) 
A(I,J) = ZERO 

C---- MAKE "A" MATRIX SYMMETRICAL 
DO 600 K=l,NEQ 
A(l.Kl = A(K,Il 
A(J,Kl = A(K,J) 

600 CONTINUE 
C---- A(I,Jl MADE ZERO BY ROTATION ------

700 CONTINUE 
C---- CHECK FOR CONVERGENCE ------------­

IF(DABS(SSUM)/SUM .GT.TOL)GO TO 400 
RETURN 
END 

One notes that the subroutine for the solution of the symmetric eigenvalue problem 

by the classieal Jacobi method does not contain a division by any number. Also, it 

can be proved that, after eaeh iteration cycle, the absolute sum of the off-diagonal 

terrns is always reduced. Hence, the method wil! always converge and yield an 

accurate solution for positive, zero or negative eigenvalues. 
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The Jacobi algorithm can be directly applied to all off-diagonal tenns, in sequence, 

until all terms are reduced to a small number compared to the absolute value of all 

tenns in the matrix. However, the subroutine presented uses a "threshold" approach 

in which it skips the relatively small off-diagonal tenns and operates only on the 

large off-diagonal terms. 

To reduce one off-diagonal term to zero requires approximately 8N numerical 

operations. Clearly, one cannot precisely predict the total number of numerical 

operation because it is an iterative method; however, experience has indicated that 

the total number of numerical operations to obtain convergen ce is the order of 1 ON3 

Assuming a modern ( 1998) personal computer can perform over 6,000.000 

operations a second, it would require approximately one second of computer time to 

calcula te the eigenvalues and eigenvectors of a full 100 by 100 matrix. 

0.3 CALCULATION OF 30 PRINCIPAL STRESSES 

The calculation of the principal stresses for a three dimensional solid can be 

numerically evaluated from the stresses in the x-y-z system by the solution of a · 

cubic equation. However. the definition of the directions of the principal stresses is 

not a simple procedure. An alternative approach to this problem is to write the basic 

stress transformation equation in terms of the unkno-...n directions of the principal 

stresses in the 1-2-3 reference system. Or, 

[": 
o o f' xl l'y! V =1 "x r -'J' T,e V xl 1' x2 V x] 

"2 o Vx2 Vy2 V =2 Tyx CTy t}':" VyJ VyJ Vd 

o "3 V :d V y3 V =3 T;:x Tzy "= V zl r :2 V =3 

(0.9) 

Or, in symbolic form 

n=vrsv (D.JO) 
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in which V is the standard direction cosine matrix. Since V V T is a unit matrix Equation 

(D.3) can be wrinen as the following eigenvalue problem: 

SV=VQ (D.II) 

where Q is an unkn~wn diagonal matrix of the principal stress es ( eigenvalues) and 

Vis the unknown direction cosine matrix (eigenvectors) which uniquely define the 

directions of the principal stresses. In arder to illustrate the practica! application of 

the classical Jacobi method consider the following state of stress: 

Ux r .t:l' Tx:: [120 -55 -,;'] s~ r J'X U y Ty: = -55 -55 (D.I2) 

-75 33 -85 
r::x T.:y u= 

The eigenvalues, principal stresses, and eigenvectors (direction cosines) are 

[

0
1 l [ 162 54] [ .224 .352 .909] 

172 ~ -68.40 and ,.= -.308 .910 -.277 

17, -114.14 .925 .217 -.312 

(D.13) 

The so1ution of a 3 by 3 eigenva!ue problem can be considered as a trivial numerical 

problem. Severa! hundred of these problems can be solved in one second of 

computer time. 

0.4 SOLUTION OF THE GENERAL E1GENVALUE PROBLEM 

The general eigenvalue problem is written as 

AV= BVQ (D.I4) 

where both A and B are symmetrical matrices. The first step is to calculate the 

eigenvectors V 8 of the B matrix. We can now Jet the eigenvectors V be a linear 

combination or the eigenvectors ofthe B matrix. Or, 
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V= V8V (0.15) 

Substitution of Equation (0.15) into Equation (0.14) and the pre multiplication of 

both si des by V; yields 

vrAV V= VrBV VQ B B B B (0.16) 

Jf all e1genvalues of the B matrix are nonzero the eigenvectors can be nom1alized so 

that v;s V 8 = I. Hence. Equation (0.16) can be \\Titten in the following classical 

form: 

Av= vn (O.l7l 
- T 

where A= V8 A V8 . Therefore, the general eigenvalue problem can be solved by 

the application of the Jacobi algorithm to both matrices. If the B rnatrix is diagonal 

the eigenvectors V 8 matrix will be diagonal with the diagonal terms equal to 

11 JB::. This is the case for a lumped mass matrix. Also, mass must be 

associated with all degrees-of-freedom and all eigenvectors and values must be 

calculated. 

0.5 SUMMARY 

Only the Jacobi method has been presented in detail in this section. lt is restricted to 

small full matrices m which all eigenvalues are required. For this problem the 

method is very robust and simple to program. For the dynamic modal analysis of 

large structural systems; or, for the stability analysis of structural systems, other 

more numerically efficient methods are recommended. 



FACULTAD DE INGENIERÍA UNA/V\ 
DIVISIÓN DE EDUCACIÓN CC>NTINUA 

"Tres décadas de orgullosa excelencia" 1971 - 2001 

CURSOS ABIERTOS 

SAP 2000 PARA ANÁLISIS Y DISEÑO 
ESTRUCTURAL 

TEMA 

SAFE TECHNICAL NOTE 2 

SPEED OF COMPUTER SYSTEMS 

EXPOSITOR: ING. FERNANDO MONROY MIRANDA 
PALACIO DE MINERIA 

OCTUBRE DEL 2001 

Palacio de Minería. Calle de Tacuba No. 5. Pnmer piso. Delegación Cuauhtémoc. CP 06000. Col. Centro. México D.F .• 
APDO Paslal M-2285 • Telso 5521.4021 al24, 5623.2910 y 5623.2971 • Fax: 5510.0573 



SPEED OF COMPUTER 
SYSTEMS 

The Current Speed Of A $2,000 Personal Computer 1s 
Faster Than The $10,000,000 Cray Computer Of 1975 

H.1 INTRODUCTION 

The calculation of element stiffness matrices, solution of equations and evaluation of 

mode shapes and frequencies are all computationally intensive. Furthermore, it is 

necessary to use double-precision floating-point arithmetic to avoid numerical 

errors. Therefore, all numbers must occupy 64 bits of computer storage. The 

author started developing structural analysis and design programs on the IBM-701 

in 1957 and since that time has been exposed to a large number of different 

computer systems. In this section the approximate double-precision floating-point 

performances of sorne of these computer systems are summarized. Since different 

FORTRAN compilers and operating systems were used the speeds presented can 

only be considered accurate to within 50 percent. 

H.2 DEFINITION OF ONE NUMERICAL OPERATION 

F or the purpose of comparing floating-point speeds the evaluation of the following 

equation is defined as one operation: 

A=B+C*D Definition of one numerical operation 

Using double precision arithmetic, the definition involves the sum of one 

multiplication, one addition, extracting three numbers from high-speed storage, and 

--
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transferring the results to storage. In most cases. this type of operation is within the 

inner DO LOOP for the solution of linear equations and the evaluation of mode 

shapes and frequencies. 

H.3 SPEED OF DIFFERENT COMPUTER SYSTEMS 

Table H.l indtcates the speed of different computers used by the author. 

Table H.1. Floating-Point Speeds of Computer Systems 

YEAR COMPUTER OPERATIONS RELATIVE 

OrCPU PER SECOND SPEED 

1963 CDC-6400 50,000 1.0 

1967 CDC-6600 100,000 2.0 

1974 CRAY-1 3.000,000 60.0 

1980 VAX-780 60,000 1.2 

1981 IBM-3090 20,000,000 400. 

1981 CRAY-XMP 40,000,000 800. 

1990 DEC-5000 3,500,000 70. 

1994 Pentium-90 3,500,000 70. 

1995 Pentium-133 5,200,000 104. 

1995 DEC-5000 upgrade 14,000,000 280. 

1998 Pentium JI- 333 16,500,000 330. 

If one considers the initial cost and maintenance of the various computer systems, it 

is apparent that the overall cost of engineering calculations has reduced significantly 
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during the past 20 years. The most cost effective computer system, at the present 

time, is the INTEL Pentium type of personal computer system. At the present time. 

a very powerful personal computer system. that is five times faster than the first 

CRA Y computer. can be purchased for approximately $2.500. 

H.4 SPEED OF PERSONAL COMPUTER SYSTEMS 

Many engineers do not realize the computational power of the present day 

inexpensive personal computer. Table H.2 indica tes the increased speed of personal 

computers that has occurred during the past 18 years. 

Table H.2. Floating-Point Speeds of Personal Computer Systems 

YEAR INTELCPU Speed Operations Relative COST 
M Hz Per Second Speed 

1980 8080 4 200 1 $6,000 

1984 8087 10 13,000 65 $2.500 

1988 80387 20 93,000 465 $8,000 

1991 80486 33 605,000 3,025 $10,000 

1994 80486 66 1,210.000 6.050 $5,000 

1995 Pentium 90 4,000.000 26,000 $5,000 

1996 Pentium 233 10,300,000 52,000 $4,000 

1997 Pentium 11 233 11,500.000 58.000 $3,000 

1998 Pentium 11 333 16.500,000 82,500 $2,500 

One notes that the floating·point speed of the Pentium 11 is not significantly different 

than the basic Pentium chip. The increase in clock speed, from 90 to 333 MHz, has 

accounted for the increase in speed during the last three years. 

H .5 PAGING OPERATING SYSTEMS 

The above computer speeds ~ssume all numbers are in high-speed memory. For the 

analysis of large structural systems it is not possible to store all information within 

high-speed storage. If data needs to be obtained from low-speed disk storage, the 

effective speed of a computer can be reduced significantly. Within the SAP and 

ET ABS programs the transfer of data to and from dtsk storage is conducted in large 

-;:;:: 

!l 

'"' 

\1' ·:·¡ 
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blocks in arder to minimize disk access time. This programming philosophy was 

used prior to the introduction of the paging opllon used in thc modern W mdows 

operating systems. 

In a paging operating system, if the data requested ts not stored in high-speed 

memory, the computer automatically reads the data from disk storage in relatively 

small blocks of information. Therefore, the modern programmer need not be 

concemed with data management. However, there is a danger in the application of 

this approach. The classical example, that illustrates the problem with paging. is the 

following example of adding two large matrices together. The FORTRAN 

statement can be one of the following forms: 

DO 100 J=1,NCOL 
DO 100 I=1,NROW 

100 A(I,J)=B(I,J)+C(I,J) 

DO 100 I=1,NROW 
DO 100 J=1,NCOL 

100 A(I,J)=B(I,J)+C(I,J) 

Since all arrays are stored row-wise, the data will be paged to and from disk storage 

in the same arder as needed by the program statements on the left. Howcver. if the 

program statements on the right are used the computer may be required to read and 

wTite blocks of data to the disk for each term in the matrix. Hence, the computer 

time required for this simple operation can be very large if paging is automatically 

used. 

H.6 SUMMARY 

Personal computers will continue to increase in speed and decrease in price. lntel's 

Merced 64-bit CPU chip will be released in 1999. It is the opinion of many experts 

in the field that the only way significan! increases in speed will occur is by the 

addition of multi-processors to the personal computer systems. The NT operating 

system supports the use of multi-processors. 
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Prol::.lem H 
Reinforced Concrete Beam 

Concrete 
E -3600 ksi, Poissons Ratio= 0.2 
t'c=4ksi 
ty = 60 ksi 
Concrete cover to longitudinal rebar center at top ot beam = 3.5 in 
Concrete cover to longitudinal rebar center at bottom ot beam = 2.5 in 

ToDo 
Determine required longitudinal reintorcing steel and required shear 
stirrups based on ACI 318-95 

w0L = 2.2 kit (untactored, doesn't include beam weight) 

wLL = 1.6 kit (unfactored) D gl 
¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ¡ ,., 

~ & 
24' 1 24' 1 Beam Section 

Note: Our intent is that you try this problem on your own frrst. After you have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to ere ate the 
model, then follow the steps in our solution. 

1 



Problem H Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. ·¡KJp-ft ::J 
2. From the File menu select New Model From Template .... This displays the Model 

Templates dialog box. B 
3. In this dialog box click on the Beam template ~: button to display the Beam 

dialog box. · 

4. In this dialog box: 

• Accept al! ofthe default values. 

• Click the OK button. 

5. Click the "X" in the top right-hand comer ofthe 3-D View window to close it. 

6. From the Define menu select Materials ... to display the Define Materials dialog box. 

7. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

8. In this dialog box: 

• Verity 0.15 is entered in the Weight per Unit Volume edit box. 

• Click the OK button twice to exit al! dialog boxes. 

9. Click the drop down box in the status bar to change the units to kip-in. jKJp-m . ::Ji 
1 O. From the Define menu select Materials ... to display the Define Materials dialog box. 

11. Click on CONC in the Materials area to highlight (select) it. and then click the 
1\lodify/Show Material button. The Material Property Data dialog box is displayed. 

12. In this dialog box: 

• Veril)• 3600 is entered in the Modulus ofElasticity edit box. 

• Verity .2 is entered in the Poisson's Ratio edit box. 

• Verity 60 is entered in the Reinforcing Yield Stress, fY edit box. 

• VerifY 4 is entered in the Concrete Strength, fe edit box. 

• Type 60 in the Shear steel Yield Stress, tys edit box. 
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o VerifY 4 is entered in the Concrete Shear Strength. fes edit box. 

o Accept the other default values. 

o Click the OK button twice to exit all dialog boxes. 

13. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

14. In this dialog box: 

o With the default section, FSEC 1, highlighted, click the Modify/Show Section button to 
display the Rectangular Section dialog box. 

o In this dialog box: 

;¡;.. Select CONC from the Material drop-down box. 

~ Type 30 in the Depth (t3) edit box. 

;¡;.. Type 18 in the Width (t2) edit box. 

;¡;.. Click the Reinforcement button to display the Reinforcement Data dialog box. 

;¡;.. In this dialog box: 

./ In the Element Class area select the Beam option . 

./ In the Concrete Cover To Rebar Center area type 3.5 in the Top edit box . 

./ In the Concrete Cover To Rebar Center area type 2.5 in the Bottom edit box . 

./ Click the OK button three times to exit all dialog boxes. 

15. Click the drop down box in the status bar to change the units to kip-ft.lt:Jp-lt :;:J 

16. From the Define menu select Static Load Cases .... This will display the Define Static 
Load Case N ames dialog box. 

I 7. In this dialog box: 

o Type DL in the Load edit box. 

o Click the Change Load button 

o T ype LL in the Load edit box. 

o Select UVE from the Type drop-down box. 

3 
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• Type O in the Selfweight Multiplier box. 

• Click the Add New Load button. 

• Clid: the OK button. 

18. Select the two frame elements. 

19. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

20. In this dialog box: 

• VerifY that the Load Case N ame is DL. 

• In the Load Type and Direction area verify that the Forces option is selected and that 
the Global Z direction is selected. 

• In the Uniform Load area type -2.2. 

• Click the OK button. 

21. Select the two frame elements. 

22. From the Assign menu select Frame Static Loads ... and then Point and Uniform ... from 
the submenu to display the Point and Uniform S pan Loads dialog box. 

23. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Uniform Load area type -1.6. 

• Click the OK button. 

24. From the Analyze menu select Set Options ... to display the Analysis Options dialog box. 

• lo dú; di,Io g bo. d Iok<ho P~oo F nmo XZ PI .o o boUoo ¡ ¡ ll '"""""' 
available degrees of freedom. 

• Click the OK button. 

25. From the Options menu select Preferences ... to display the Preferences dialog box. 

26. In this dialog box: 

• Select the CONC Tab. 
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• Select ACI 318-95 from the Concrete Design Code drop-down box. 

• Verify that the Strength Reduction Factors are 0.9, 0.85, 0.7 and 0.75 for 
Bendingffension, Shear, Compression (T) and Compression respectively. 

• Click the OK button. 

27. Click the Run Analysis button _Jto run the analysis. 

28. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to clase the Analysis window. 

29. On the Design menu verify that the Concrete Design feature is active. There should be a 
check mark next Concrete Design if it is active. 

30. From the Design menu click Select Design Combos ... to display the Design Load 
Combinations Selection dialog box. 

31. In this dialog box: 

• Verify that the default combinations for concrete design, DCON 1 and DCON2 are 
included in the Design Combos list box. 

• Highlight DCONl and click the Show bullan to display the Load Combination Data 
dialog box. 

• In this dialog box: 

>- Note the definition ofthe load combination in the Define Combination area. It 
should be 1.4DL. 

>- Click the OK bullan to return to the Design Load Combinations Selection dialog 
box. 

• Highlight DCON2 and click the Show bullan to display the Load Combination Data 
dialog box. 

• In this dialog box: 

>- Note the definition ofthe load combination in the Define Combination area. lt 
should be 1.4DL + l. 7LL. 

:r. Click the OK bullan twice to exit all dialog boxes. 

32. From the Design menu select Start Design/Check of Structure to run the design check. 

33. When the design is done the area oflongitudinal bar required is displayed on the screen. 
Note that the curren! units are kips and feet. 
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34. Click the drop down box in the status bar to change the units to kip-in. \1-.Jp-~n-- _ _ :::J · 

Note that the val u es for the area of longitudinal reif!forcing steel are now in units of square 
inches. 

35. From the Design menu select Display Design Info ... to display the Display Design Results 
dialog box. 

36. In this dialog box: 

• Verify that the Design Output option is selected. 

• Select Shear Reinforcing from the Design Output drop-down box. 

• Click the OK button. The required shear reinforcing is displayed on the screen. 

Note that the val u es for the shear reinforcing steel are reported asan area per unitlength 
of element. Since the current units are kips and inches. the shear rein{orcing reponed 
is in square inches per inch. 

3 7. Right click on the left beam to display the Concrete Design Informal ion dialog box. 

38. In this dialog box: 

• Note that the required top and bottom longitudinal sted and the required shear steel is 
reported for each design load combination at each omput segment along the beam. 

• Click the Details button to see design details for the highlighted design load 
combination and output station location. The Concrete Design lnformation ACI318-95 
dialog box is displayed. 

• When finished viewing the detailed information click the "X" in the upper right-hand 
comer ofthe Concrete Design Informal ion ACI 3!8-95 dialog box to clase it. 

• Click OK to clase the Concrete Design Informal ion dialog box. 

6 



FA.C:LJL TA.D DE INGENIERÍA LJNA./V\ 
DIVISIÓN DE EDLJC:A.C:IÓN C:C>NTINLJA. 

"Tres décadas de orgullosa excelencia" 1971 - 2001 

CURSOS ABIERTOS 

SAP 2000 PARA ANÁLISIS Y DISEÑO 
ESTRUCTURAL 

TEMA 

SAFE TECHNICAL NOTE 2 

PROBLEM X 

EXPOSITOR: ING. FERNANDO MONROY MIRANDA 
PALACIO DE MINERIA 

OCTUBRE DEL 2001 

··•' 

Palado de Minería. Calle de Tacuba No. 5. Primer piso, Delegación Cuouhlémoc, CP 06000. Col. Centro. México D.F .. 
APDO Postal M-2285 • Te!so 5521.4021 al24, 5623.2910 y 5623.2971 • Faxo 5510.0573 

.'! 

·,l 

·:~ 



Problem X 
Through Truss Bridge 

S te el 
E =29000 ksi 
Poissons Ratio= 0.3 
All members are W6X12 
Fy = 36 ksi 

Concrete Bridge Deck 
E =3600 ks1 
Poissons Rat1o = 0.2 
12 inches thick 
Live Load = 250 psf 

ToDo 
Review steel member stresses dueto self weight plus live load. 
Use AISC-ASD89. 

12' 12' 12' 

12' 

Note: Our intent is that yo u try this problem on your own first. After yo u have solved it on your 
own, yo u can step through our solution if desired. If yo u ha ve problems trying to e reate the 
model, then fol!ow the steps in our solution. 
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Problem X Solution 

l. Click the drop down box in the status bar to change the units to kip-ft. IK'p-ít ::J 
2. From the File menu select New M o del From Template . ... This displays the M o del 

3. In this dialog box click on the Vertical Truss template IVlV1V\ button to display the 

Templates dialog box. ~ 

Vertical Truss dialog box. ~ 

4. In this dialog box: 

• Accept the default number ofbays, 3. 

• Accept the default Height ofTruss, 12. 

• Accept the default Truss Bay Length, 12. 

• Click the OK button. 

5. Click the Select AH button ~ on the side toolbar to select al! elements. 

6. From the Edit menu select Replica te ... to display the Replicate dialog box. 

7. In this dialog box: 

• Verify the Linear Tab is selected. 

• In the Distance area type 12 in the Y edit box. 

• V erify that O is entered in the X and Z edit boxes. 

• Verify that 1 is entered in the Number edit box. 

• Click the OK button to proceed with the replication. 

8. From the Draw menu select Edit Grid ... to display the Modify Grid Lines dialog box. 

9. In this dialog box: 

• Select the Y option in the Direction area. 

• Type 12 in the Y Location edit box and click the Add Grid Line button. 

• Click the OK button. 
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10. Chck in the window titled X-Z Plane @ Y=O to activate it. The window is activated when 
its title bar is highlighted. 

11. Click the xy 2D View button¡·;,.J to change the view toan X-Y plan. Note that the tille of 
the window changes to X-Y Plane@ Z=l2. The screen appears as shown in Figure X-1. 

[le .Eci y.,.. Ql!ih: O¡.., .5eeet ~ /t()$e ~~ Duan tl~tr:n l]elp 

D lo;;l!i!l-=::l..:::.UJ..~L.J Pl.®lflli.®I.SI!!lll ><1 ~ 1 ~ 1 ~ '"'1 ~~~ ~ 1 ~ .:.1 I 1--13·1 -"I.;;:;I.QJ 
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Figure X -1: View of S creen After Step 11 

12. Click the Quick Draw Frame Element button ..._jon the side toolbar or select Quick 
Draw Frame Element from the Draw menu. 

D 

13. Click on the grid lines at the points labeled "A", "B", "C" and "D" in Figure X-1 to enter 
four frame elements spanning between the two vertical frames. 

14. Click on the grid lines at the points labeled "E", "F' and "G" in Figure X-1 to enter three 
sets of diagonal frame elements spanning between the two vertical frames. 

15. Click the Down One Gridline buttonl~ on the main toolbar to display the X-Y Plane@ 
Z=O. The screen appears as shown in Figure X-2. 

16. Click the Quick Draw Rectangular Shell Element button [!] 1 on the side toolbar ( or 
select Quick Draw Rectangular Shell Element from the Draw menu). 
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Figure X-2: View ofScreen After Step 15 

17. Click on the points labeled "A", "B" and "C" in Figure X-2 to enter three shell elements 
spanning between the two vertical fi:ames. 

18. Click the Pointer buttonjJ on the side too! bar to exit draw mode and enter select mode. 

19. Click in the window titled X-Y Plane @ Z=O to make sure it is active. 

20. Click the Up One Gridline button .. -o 1 on the main toolbar to display the plan view at 
2=12. 

21. Select the center four joints by c!icking on them. 

22. From the Edit menu select Move ... to display the Move Selected Points dialog box. 

23. In this dialog box: 

• Type 3 in the Delta Z edit box. 

• Click the OK button. 
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24., Click the Perspective Toggle button!&jon the main toolbar. A perspective birds-eye 
view ofthe structure is displayed. 

25. Click the Set Intersecting Line Select Mode button lÑ 1 and select all ofthe roofand !loor 
elements by "drawing'' a line through them. There should now be lO frames and 3 shells 
selected. You can verify this by looking at the left-hand side ofthe status bar ar the bottom 
ofthe SAP2000 window. 

26. From the Edit menu select Divide Frames ... to display the Divide Selected Frames dialog 
box. 

27. In this dialog box: 

• Click on the Break At lntersections With Selected Frames and Joints option to select it. 

• Click the OK button ro add a center joint at each set of cross braces in the roo f. 

28. Click on the·xz 2D View buttonGJ on the main toolbar to view an elevation in the X-Z 
plane. Note the title ofthe window is X-Z Plane@ Y=O. 

29. Click the Perspective Toggle buttonl&ion the main toolbar. A perspective view ofthe 
structure is displayed. 

30. Click the Set Intersecting Line Select Mode button lÑ 1 and select all ofthe vertical and 
diagonal elements by "dcawing" a line through them. There should now be 20 frames 
selected. You can verify this by looking at the left-hand side ofthe status bar at the bottom ·.·• 
ofthe SAP2000 window. 

31. From the Edit menu select Divide Frames ... to display the Divide Selected Frames dialog 
box. 

32. In this dialog box: 

• Verify that the Break At Intersections With Selected Frames and Joints oprion is 
selected. 

• Click the OK button to add a center joint ar each ofthe six sets ofvertical cross braces. 

33. Click on the xz 2D View buttonGJ on the main toolbar to view an elevation in the X-Z 
plane. 

34. Click the drop down box in the status bar to change the units to kip-in. IKJp-m ::J) 

35. From the Define meim select Materials ... to display the Define Materials dialog box. 

36. Click on STEEL in the Materials area to highlight (select) it, and then click the 
1\lodify/Show Material button. The Material Property Data dialog box is displayed. 
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37. In this dialog box: 

o VerifY that the Modulus ofElasticity is 29000. 

o VerifY that Poisson's Ratio is 0.3. 

o VerifY that the steel stress, Fy is 36. 

o Click the OK button. 

38. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Property Data dialog box is displayed. 

39. In this dialog box: 

o VerifY that the Modulus ofElasticity is 3600. 

o VerifY that Poisson's Ratio is 0.2. 

o Click the OK button twice to exit all dialog boxes. 

40. Click the drop down box in the status bar to change the units to kip-ft. jKJp-tt 3 
41. From the Define menu select Materials ... to display the Define Materials dialog box. 

42. Click on CONC in the Materials area to highlight (select) it, and then click the 
Modify/Show Material button. The Material Propeny Data dialog box is displayed. 

43. In this dialog box: 

o VerifY that the Weight per Unit Volume is 0.15. 

o Click the OK button twice to exit all dialog boxes. 

44. From the Define menu select Frame Sections ... to display the Define Frame Sections 
dialog box. 

45. In this dialog box: 

o In the Click To area, click the drop-down box that says Impon 1/Wide Flange and then 
click on the Impon I/Wide Flange item. 

o Ifthe Section Propeny File dialog box appears then locate the Sections.pro file which 
should be located in the same directory as the SAP2000 program files. Highlight 
Sections.pro ande tick the Open button. 

o A dialog box appears with a list of all wide flange sections in the database. In this 
dialog box: 
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» Scroll down and click on the W6X 12 section. 

» Click the OK button three times to exit all dialog boxes. 

46. From the Define menu select SheU Sections ... to display the Define Shell Sections dialog 
box. 

47. In the Click To area, click the Modify/Show Section button to display the Shell Sections 
dialog box. 

48. In this dialog box: 

• Veri:ty that the Material chosen is CON C. 

• Veri:ty that both the Membrane and the Bending thicknesses are l. 

• Veri:ty that the Shell option is selected in the Type area. 

• Click the OK button twice to exit all dialog boxes. 

49. Click the Select All button ~ on the side toolbar to select all elements. 

50. From the Assign menu select Frame and then Sections ... from the submenu to display the 
Define Frame Sections dialog box. · 

51. In this dialog box: 

• Click on W6XI2 in the Frame Sections area to highlight it. 

• Click the OK button. 

52. Click the Show Undeformed S ha pe button O f to remo ve the displayed frame section 
assignments. 

53. From the Define menu select Sta tic Load Cases ... to display the Define Static Load Case 
N ames dialog box. 

54. In this dialog box: 

• Type DL in the Load Edit box. 

• Click the Change Load button. 

• Type LL in the Load Edit box. 

• Select Live from the Type drop-down box. 

• Type O in the SelfWeight Multiplier edit box. 

1.; '. 
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• Click the Add New Load button. 

• Click the OK button. 

55. Click the Select All button QiÚ on the side toolbar to select all elements. 

56. From the Assign menu select Shell Sta tic Loads ... and then Uniform ... from the 
submenu. This will display the Shell Uniform Loads dialog box. 

57. In this dialog box: 

• Select LL from the Load Case N ame drop-down box. 

• In the Uniform Load area type -.25 in the Load box and select Global Z from the drop­
down Dir box. 

• In the Options area verify that the Add To Existing Loads option is selected. 

• Click the OK button to apply the load. 

58. Click the Show Undeformed Shape button O J to reset the window display. 

59. Click the "X" in the upper right-hand comer ofthe window labeled X-Z Plane@ Y=O lo 
close it. 

60. Click the Run Analysis button _J to run the analysis. 

61. When the analysis is complete check the messages in the Analysis window (there should be 
no warnings or errors) and then click the OK button to close the Analysis window. 

62. From the Options menu select Preferences ... to display the Preferences dialog box. 

63. In this dialog box. 

• Click on the Steel Tab 

• Select AISC-ASD89 from the Steel Design Code drop-down box if it is not airead y 
selected. 

• Click the OK button. 

64. From the Design menu click Start Design/Check Of Structure to run the design check of 
the steel frame elements. 

65. When the design check completes, the stress ratios are displayed. 
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For nearly thl..'ty years, the TABS and ETABS senes o1 computar 
programs have defmed the standard íar bUlldmg analysJ.S and 
deSign software. and the tradlban conbnues Wlth tlus latest release 
of ETABS. 

These programs were the flrst ta take mta account the uruque 
praperbes inherent in a mathemat.Ical model af a bwldmg. 
allowmg a computer representaban ta be constructed. m the same 
fasluon as a real buildmg. fioor by floor. stary by stary. ETABS uses 
terrrunalogy ia::rnllla::r ta the buildmg deSlgner such as columns, 
beams, braces and walis ratner than nodes and flillte elements. 

In any encteavor, a too! tcn.!ored. to a specillc task lS the most 
efficient. For bwldmgs, ETABS proVIdes the automatlon and 
speclabzed. apbons need.ed to make the process af model creatlan. 
analySJS and design fast anct converuent. Tools for Iaymg out Jloor 
iraming, colunms. trames and walls, m either concrete or steeL as 
well as techruques far qwckly generabng gravity anct lateral 
loads ofter many advantages not available from most general 
purpose Ílnlte element programs. SelSnuc and wmd loods are 
generated. automabcally accordmg to the requrrements ol the 
selected. building cod.e. All o! these modelmg and analysJ.S opbons 
are completely mtegrated. Wlth a Wlde range al steel and concrete 
deSign features. 

Whlle ETABS is familiar anct strmghtforward to use for the bwldmg 
deSlgner, 1t aiso o1ters many sophlsbcated. analybcal anct deSign 
capablliUes not found m ather camrnerctal programs Full 
dynanuc analysiS, mcludmg nonlmear hme-history capo.oilltles for 
se1Sl11ic base isolabon ana VlSCOus ctampers, along Wlth stabc 
nonlmear pushover features afler state-of-the-art technalogy to the 
engmeer domg performance des1gn. Powerful features lar the 
selecban and ap1Jrruzatlan of verbcal frarrung members as well as 
the tdenb!Icatlon of key elements for lateral drtft control provide 
Slgniftcant tune savmgs m the ctes1gn cycle. In add.itlon. because 
ETABS mcludes complete and detmled. steel and concrete destgn 
calculatiOns tor beams anct columns, broces. walls and slabs. the 
time typ¡cally OSSOCiated. Wlth the transter of data between 
analysiS and desJ.gn programs has been ellrrunated. nus destgn 
m.tegrahon, m combmatlon Wlth the fact that ETABS generates 
CAD output files, means that producbon d.rawm.gs can be 
generated. faster and with greater accuracy. 

f.iABS has long been a favorite far the analysiS and design ot 
bULldJngs, and whether the pro¡ect 15 a one story shoppmg center 
or the tallest buildmg m the warld. th1S latest release ofters the 
comprehensive tools need.ed. ta produce bmely, efhCient and. 
elegant engmeenng solubons 
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ETABS P FEA TU RES 
Bullding Model 
• Mulbple Slffiultaneous rectcmgular and cylmd.nca.l gnd systems 
• Story deíuubons USli'lg the concept of surular Stones 
• Buildmg mocieled as .Aiea. I.me and Pomt objects 
• Common labelmg of Ob;ects between surulcrr S tones 
• Area ob¡ects íor. Walls. Slabs/Decks. Operungs. Spnngs. Mass. Loads 
• Lme ob¡ects íor. Colurnns. Beams. Broces. l.mks. Spnngs. Mass. Loads 
• Pomt ob¡ects for Supp:Jrts. Spnngs. Mass. Loads 
• Rlg¡d Dl.aphragm defuub.ons 
• Bwlt-m databa:Se of steel sechons 
• Graphlcal Sectlon DeSigner 1or deúrung custom secbons 

Bullding Loads 
• No lrrrut on number of mdependent load cases 
• GrOVJ.ty loads specúled as p:::m1t. llne or area loads 
• AutomatJ.c wmd load generaban. UBC. BOCA. ASCE. NBCC 
• AutomatJ.c selSITUc load generat:J.on: UBC, BOCA. NBCC 
• Built-m response spectrum and time history mput 
• Tem~rature and thermal-grad.lent loads 
• Algebrmc. absolute. SRSS. and envelopmg load combmahons 
• Mass dlrectly specúled. or calculated trom grOVIty loads 

Analy!ical Options 
• StatJ.c and dynarruc analyslS 
• Automab.c meshmg of trame members mto analYSlS elements 
• Automanc trCI!'.sfer of Ioa:ds on decks/slabs to beams and walls 
• AutomatJ.c meslung o1 decks/slabs tor flexlble dlaphragm analysis 
• P-d.elta cmalySlS wüh e1ther stallc or dyncmuc analyslS 
• Automated center-of-ngldlty calcu..lattons 
• Integrated output !orces for walls/slabs/decks for allloads 
• Exphctt PaneJ-zone deformallons 
• AutomatJ.c tnbutary-area calcu..lallons for l.J.ve-Load red.ucbon factors 
• Construcbon sequence loadmg CinalVSlS 
• El.gen and load-dependent Rltz vector determmation 
• Multlple Response SpectrUm. cases 
• Modal combmabon by SRSS, CQC or GMC CGupta) method 
• CombmatJ.on o! tiuee dJrecbons by ABS or SRSS method 
• Stcr!Jc and dynanuc response comblnabons and envelo¡:es 
1 Mulbple Tune Hlstory cases 
1 Sequen tal T1me Hlstory cases 
1 SeiSffilc accelerat:J..on or d.LspJacement exCitahon 
1 Wmd-Joad torcmg hmcbons 
1 TrCil1.Sl.ent or steady-state excitaban 
• Envelope or step-by-step deSlgn for Time-History loads 
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Analysts Output Options 
• Deformed. and Undeformed geometry m 3D perspecbve 
• Loadmg dlagrams 
• Bendmg-Moment and Shecn:-Force dlagrams for Frames 
• Stress contours for Shells 
• lntegrated-force dlagrams for Wall Plers and Spandrels 
• lnteract:J.ve Secbon-torce results usmg Groups 
• Arumcrbon of deformad shapes 
• Tune-Hlstory deformed shapes as real tune AVI flles 
• D15plays of nodal and element bme-hlstory records 
• Tune Hlstory dlsplays of funct:J.on vs tune or funct?:l vs. tuncbon 
• Response spectrum curves tor any ¡omt from Tune Hlstory response 
• Instantaneous on-screen results outpm Wlth nght-buhon c.llck on element 
• Selecbve or complete tabulated. output for all output qucmtltles 
• Graphics output to screen. pnnter. DXF b.le. or Wmdows Metafile 
• Tabu!ated output to screen. pnnter. or A~ss Database 

THE El.EMENT UBRARY Wl" ROOIOOOm 
Underlymg the ITABS ob)ect-based blllldmg mod.els IS a comprehensive 
analys¡s engme compnsed. of the followmg element types. 

The 30 Beam/ColwnnjBrace CFrar:ne) Element 
• Axial. bendlng, torSJonal and shear deformations 
• Mulbple non-prismabc segments over element length 
• Ends offset trom reference nodes m any cilrecbon 
• Automated evaluaban of offsets tor }OIIlt SlZe 
• Moment and shear raleases and p:Jrt:J.al-ÍlXlty 
• Pomt. unúorm and trapezo1dalloadmg m any dlrecbon 
• Temperatura and thermal-gradlent loadmg 

The 3D Wall/Slab/Deek (Shell) Element 
• Shell, plate or membrane act:J.on 
• Tiuck -shell optlon 
• General quadrüateral or triangular element 
• Orthotropic matenals 
• SlX degrees ot treedom per ¡oint 
• Unúorm load m any d.Jrecbon 
• Temperatura and thermal-gradlent loadmg 

The Joint Element 
• Supp:>rt 
• Coupled. or uncoupled grounded. spnngs 
• Force loads 
• Ground-chsplacement Ioads 

The lJnk Element 
• Two node hnecn: spnng with 6 degrees ot treedom 
• Can be used to model Panel-zone de!ormat:J.ons 

.. 

A COMMITMENT TO SOFTWARE INNOVATION ANO SUPPORT 



r• r • 

..._ !": ~~- .. ' u ·~·~·· ..... . .. . ,. , .. · ........ 

-· ... 
--·-. 

DESIGN OPTIONS 

E ·-·· -
.. 

The followmg deSJ.gn ophons crre fully mtegrated. Wlth analys¡s 
m the ITABSI! graphl.cal user mtertace. 

Steel Frcane Oesign 
• Fuily mtegrated steel trame desJ.gn 
• AlSC-ASD, AISC-U<FD. UBC. COnadlan and Euro Cedes 
• DeSlgn for stat:J.c and ctynarruc loods 
• Groupmg tor design envelo}Jes 
• OptlrruZatlon for strength and lcrteral dnft 
• SelSIIUc deSlgn o! speclO.l moment-r€Sl5tlng trames 
• SelSIIUc desJ..gn of concentnc and eccentnc braced trames 
• Check of panel zones for doubler and contlm.nty plates · · 
• Graphlcal cbsplay of stress rabOs 
• Interact:Ive des:J.gn and reVlew 
• Sumrnary cmd deta:J.led re¡:orts mcludmg database tormats 

Concrete Frame Design 
• Fully mtegrated concrete trame deSlQTI 
• ACI. UBC, Canadlan and Euro Codes 
• Deslgn for static and ctynarruc loods 
• Seisrruc design of mtermed.late/special moment-resistmg trames 
• SelSITUc deSign of t:eam;column JOmts 
• SelSffilc check for strong-column/weak-beam desJ.gn 
• Graptucal Se:;non Des1gner for concrete retxn lcxxrtlon 
• BlOXJ.Cil-moment;CIXlal·lood mteracbon d.Iagrams 
• Graphlcal d.lsplay ot remto:cement and stress ratlOs 
• Interac1:Lve deSlgn and revtew 
• Sumrnary and detCll.led reports mcludmg datal:xlse 1ormats 

Composlte Beam Design 
• Fully mtegrated composlte beam desJ.gn 
• AISC-ASD and AISC-LRFD Spocillcabons 
• AutomatJ.c calculabon of eflecbve slab Widths 
• Numerous user·specúled constrcnnts 
• Shored and unshored des¡gn 
• Optlmal deSign for strength and deflecbons 
1 Ccnnl::er calculcrtlons 
• Floor Vlbrabon analysLS 
• Graphlcal display ol all desJgn quantilles 
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• lnteract:J.ve deSJgn and revtew 
• Sumrnary and detCll.led reports mcludmg databose tormats ' ! 
Concrete Shear Wa!l ne.!gn t .... ,,_. 
• Fully mtegrated wall p1er and spandrel desJ.gn ' 

• ACI, UBC and Can.ad.tan Cedes ' ~ 
• Deslgn lor statJc and ctyna:rruc loods " ~ 
• AutomatJ.c integraban alforces for p1ers and sp:mdrels S 
• 2D wall pter destgn and boundcrry-member checks · · l 
• 2D wall spandrel deSI.gn ' .. S • 
1 3D wall p1er check for provtded remiorcement '· .... _ # 
1 GraphJ.cal Secbon Desrgner tor concrete rebcu loca1lon 
• Graphlca.l dJsplay of remtorcement and stress ranos i S 
• lnteractlve deSign ana reVIew ,; .. 
• Sumrncrry and detcnled repons mcludmg databcrse tormats ~ 'li 



ETABS NON LINEAR FEATURES 
ETABS Nonlinear extends !he capabWties o! !he PLUS version 
to include the following static and dynamic nonlinear 

; analysls oplions 

Static Nonlinear Analysis Options 
Large dJsplacement option 
Sequentlalload.mg optlon 

PlasUc Hinge Element 
• U sed. as Spnng. Link. Panel zone or ms1de Frame Elements 
• AxmL flexura!. shear cmd torSlonal behOVIor 
• Axlal-load/biCXlal-moment mterachon 
• Multilmear behavior mcludJ.ng softerung 
• Tabulated. and Graphlcal dJsplay of hmge status 

Specializatton tor Static Pushover Analysis 
• FEMA 273, ATC-40 
• Automated. force-deformab.on relab.ons for steel and concrete tunges 
• Modal. unúorm. or user-defmed lateral load pcrtterns 
• Start 1rom appl.Ied. grav1ty load 
• Capa:Clty Spectrum converSlons 
• Effecb.ve dampmg calculab.on 
• Demand Spectrum compcmsons 
• Performance pomt calculatJ.on 
• Summc:ny reports mcludmg plastlc-hmge deformahons 

Dynamic Nonlinear Analysis Options 
Tne nonllnear dynarruc analySJS option extends the capabilibes 
of the !..mear Tune Hlstory optlon of the ETABS Plus by allowmg for 
nonlineanty m pred.efmed nonlmear elements 

Nonllnear Unlc Element 
• Used. with the Dynarruc Nonlmear AnalySlS ophon 
• Used as Link. Spnng or as Panel zone 
• VlSCOus damper Wlth non.JJnear exponent on veloctty term 
• Gap (compreSSlon only) and Hook (tensJ.on only) 
• Urua:x:J.al plastlcity (alió degrees of freed.om) 
• Base lSOlator Wlth bJCIXlal-plashClty behOVT.or 
• Base isolator WJ.th tr.ctJ.on and/or pendulurn behavtOr 
• Force or dlsplacement vs. nme plots 
• Force vs. detormatlon plots 

The Wllson FNA Method 
The ETABS nonllnear tune hJstory analyslS uses the new nurnerica.l 
mtegratton techruque kno\Om as the Wllson FNA (Fast Nonlmear 
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TUTORIAL 1 

2-D Frame with 

Static Loading 

Description 
This tutorial describes the modeling and analysis of a seven~story two-dimensional frame 
structure, subjected to static earthquake Ioads. The framing and the static loads are shown in 
Figure 1-1. 

Significant Features of Model and SAP2000 
• Using Templates 

• Editing the model graph!cally 

• Two-dimensional frame analysts 

• Diaphragm constraints 

• Lateral joint loads 

• Vertical span loads 

• Graphical output of results 
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Tutorial 1 2-D Frame Wlth Stat1c Loading 
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Tutorial 1 2·D Frame with Stattc Loading 

Building the Model in SAP2000 

Using Templates 
l. Select the units you want to worl< with from the status bar at the bonom of the SAP2000 

window. In this case let's start with K.Jp-ft. 

2. 

3. 

4. 

~· 

Note: You can change the units you are working with at any time and 
SAP2000 wi/1 hand/e the conversion. 

From the File menu select New Model from Templa te. 

Select 2D Frnme.l J j Jj 
Fill in story and bay infonnation.· For now use 13 ft for story height and we will edit the frn;t 
two floors and their grids next. 

Editing Model 
We are going to edit the framing and the grid at the same time. 

l. From the Draw menu select Edil Grid. 

Hint: Always try to /ocate your joints at grid intersections. By providing 
grids you can make inputting, modifying and viewing ofyour mode/ 
much easier and /aster. 

2. Select the Z direction button to change the grids defining the story heights. 

3. Select the Glue Jolnts to Grid Unes option. This willlet you edit the joint locations and 
framing by simply editing the grid. 

4. Edit the grid locations and press the OK button to close the form. 

Hint: When you have jinished editing the grid you can right click with the 
mouse on the columns to find out ifthe columns are the proper 
/ength. This is a very practica/ way to inquire about any joint or 
frame member. 
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Tutonal 1 2-D Frame wnh Stauc Loadmg 

Editing Supports 
The next step is ro change the supports on the structure from the default ofpinned to fixed. 

l. Select the Pointer Tool icon from the floating too! bar. 

2. Draw a box completely around the threejoints at the base ofthe structure 

Hint: You can always look at the status bar to see what type of elements 
and how many ofthem ha ve been selected. 

3. Select Assign Joint Restraints icon from the floating too! bar to set the fixed supports. 
You can a!so define other Joint properties inciuding the restraint through the Assign 
menu. 

Assigning Member Sections 
l. Load al! the frame sections that you will need for your model first. From the Define 

m en u select Frame Sections option. Then import the wide flanges shown m Figure 1·1. 

Note: You can select more than one section ata time in the Section 
Selection list by using the ctrl key while you make the selections. 

2. You will fmd under the Select menu item many ways to selectjoints and elements. For 
this problem you may find the Pointer/Window and the Intersecting Line select mode 
ro be the most helpful. 

3. Once you have selected the frame members you want, you can assign steel sections to 
them through the Assign Frame Sections button on the floating too! bar. 
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Tutonal 1 2-D Frame with Static Loading 

Assigning Loads 
o.,tine Static load Case Names 

Ftgure 1·2 Static Load Case Names Input Fonn 

l. The first step in entering the loads is to define static load cases. From the Define menu 
select Static Load Cases. 

• DEAD can be used for the beam verticalloads and keep the Self Weight Multiplier 
as l. 

2. Define a static lateral load case called EQ for the earthquake load. Assign the lateral load 
as a QUAKE type load. This will allow the load combinations for the design fearures of 
the program to be calculated automatically. Al so set the Self Weight Multiplier to zero. 

3. The verticalloads shown in Figure 1·1 can be assigned to the beams by selecting all the 
beams and using the Assign Frame Span Loads burton on the floating too! bar. 

4. The static lateral loads need to be entered by selecting each node individually and using 
the Assign Joint Loads button. 

Reminder: Make su re that you are adding the /oads to the proper load 
case. 

Setting Up Floor Diaphragms 
Setting up floor dJaphragms and specitying the floor mass in only the X direction are sorne common 
techniques used to reduce the size of the problem solved by SAP2000. In addition, setting 
diaphragms makes the strucrure behave more like a building with a rigid diaphragm. 

l. Repeat these Steps for each floor: 

• Select all the joints on a floor. 
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Tmonal l 2-D Frame with Stanc Loadmg 

• From the Assign menu seiect Joint ... Constraints. 

• Select Add Diaphragm from the drop down list box. 

• In the Diaphragm Constraint form give the diaphragm a name like DIA 1 for 
the first floor. 

• Select Z-axis constraint. This defines a diaphragm perpendicular to the Z-axis. 

• Press the OK button. 

• Press the OK buttons to finish the operation. 

• Repeat the steps for the other floors with a different diaphragm name for each one. 

2. The Story masses are the same on all floors so select one node from each floor. 

3. Change the input units to K.Jp-in since the Twical Story Mass provided in Figure 1-1 is given 
in those units. 

4. From the Assign menu select Joint ... Masses 

• Enter the story mass in the local direction 1 (which in this case is the global X) 
direction. 

• AJI the other values are zero. 

5. Change the units back to Kip-ft. 

Material Properties 
The final thing to check before running the analysis is the material properties. 

l. From the Define menu select Materials. 

2. In the Materials form select STEEL and press the MOD!FY/SHOW MATERIAL button. 

• In the Material Property Data form check that the material propenies are correct. 
Remember that the values are reponed in the current units. 

Running Analysis 
Once data has been entered, tt is time to run the model and take a look at our results. 

l. S ave your model. 

2. Set the parameters for the analysis run by selecting from the Analyze menu Set Options. 

• In the Analysis Options form select a Plan e Frame analysis to reduce the size of the 
solution and thus reduce the time needed for the analysis. 

• Press the OK button to accept your changes. 
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Tutorial 1 2·0 Frame w¡th Static Loading 

3. Select Run from the Analyze menu to analyze the strucrure. 

Note: Once the analysis has finished, you may want to look at the en tire 
ana(vsis results screen before pressing the OK button. This is your 
jirst check to see ifthere are any problems with the modeL 

Using the Results 

Checking Results 
Once you have nm the model successfully you need to check and see that the output is correct and 
close to what you expected. 

Model checks: 

l. Check that the base shear adds up to the total lateral load in the EQ load case. 

• Select the bottom set offrame members and the nodes at the base ofthe structure. 

• From the Assign menu select Group N ames. 

• Give the group a name like BASE SHEAR. 

• Select the ADD NEW GROUP NAME button and press the OK button. 

• From the Display menu select Show Group Joint Force Sums and select the group 
name that you just assigned. 

2. Look at the deflection and anima te it for both lateral and vertical!oads to make sure that 
the model is behaving as expected. 

• From the Display menu se!ect Show Deformed Shape and select the loading case in 
which you are interested. Also select the Wire Shadow option, so you can see the 
undeforrned structural shape. See Ftgure 1-3 and Figure 1-4 for the deforrned shapes 
of the structure. Right click on any joint to see its displacement and rotation. 

• Ammate the displayed load by pressing the START ANIMA TJON button at the 
bottom ofthe status bar (A window with the deforrned shape will need to be active 
for the bunon to show). You can also save the animation asan •.AVI file for later 
viewing from the File menu. (See online help under "Expon an A VI file".) 

Try This: Press the + and- buttons next to the Animate bunon and see 
what happens to the form with the deformed shape. 

• Press the STOP ANIMA TION bu non when you are finished looking at it. 

Ifthese checks show that the input inforrnation appears to be correct then we can move 10 the more 
advanced checks. 
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m Detonned Shape IDEAD) I!IJiiEJ m Delonned Shape tEQ) I!IJiiEJ 

. ···--·-

· ... --···· 

... --

···~ 
. --... -. 

------

~- ··----· ---. ----- . -----

• __!__ 

Figure 1·3 Static Deformed Shape Figure1-4 Lateral Deformed Shape 

Structural Perfonnance 
You will often want to make certain that the structure is within the performance limits. such as 
stresse ratio, set by the code being used. SAP2000 will do the stress checks automatically when a 
member is designed. (The design fearures of SAP2000 will be discussed in more detail in 
subsequent tutorials.) 

J. The structural elements can be designed by sunply selecting rrom the Design menu the Start 
Design/Check ofStructure option. 

• The frame elements wiii now display colors showing their stress leve! with the stress 
ratio leve! value indicated below the beam. A value of 1 is 100% stressed. 

• Other deSign and input information can also be displayed by selecting from the 
Design menu the Display Design Info option. 

8 SAP2000 Tutorial Manual 



Tu!onal 1 2·0 Frame wilh Static Loadmg 

2. There is also the ability to see the design uúonnation on individual members and to assign 
altemate secuons to them by right chcking on the element. 

• From the screen that appears you can select the DETAILS button to view detailed 
information on the section for each of the load combinations used in the design. 

• You can also redesign the element after changing its design parameters, effective 
length, K factor and section propetttes by pressing the REDESIGN button. 

3. If you ltave selected a new section and want to use that for your final design you can select 
from the Design menu the Update Analysis Sections option so the soucture can be reanalyzed 
using the new secnons that have been selected. 

Note: l'ou m ay need to use the Refresh Window hutton on the too/ bar to 
update the design information in the active window after changing 
any of the design parameters. 

Looking At and Printing Analysis Results 
You will often want to look at and ha ve a copy of the results that you get from a SAP2000 analysis 
run. There are different ways to do this. 

l. You can choose to output the results during the analysis run by selecting Generate 
Output on the Analysis Options form. The Select Output Options button that appears 
will allow you to select how much of the results to output. The results are written to a file 
with the name of the data file andan extension of • .OUT . 

2. The input and most ofthe output information can be viewed from the Display menu. 

3. From the File menu you can choose to print Graphics, Input Tables, Output Tables and 
Design Tables ofthe model's data and results. 

Hint: lf members or joints are selected when printing the rabies, you wi/1 
havr the output ro only print the selected memhers. Todo this, check 
the Se/ection Only option. 

4. The SAP2000 analysis run also provides two output files. The filename.EKO file includes 
all the input information used for the analysis. Thefilename.OUT file contains analysis 
result data as well as any output requested from the Analyze •.• Set Options menu. 

Remember: You may wantto make a habit ofprinting the output to afile 
first. This wi/1 give you a fast way to look at your output using a text 
editor without wasting large piles of paper. 
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Tutorial 1 2·0 Frame with Statlc Loadmg 

Final Comments 
As you can see, SAP2000 is a powerful structural analysis too! and can be used for a vanety of 
problems. However it is very important to understand the engineenng principies on whkh 1t is 
based. 

Most projects start as feasibility exemses and mature into a full analysis/design project. This makes 
it very importan! to decide early on what the proper too! is so there will be no need to change 
programs during the middle of a praject. SAP2000 tries to address as many of the needs that a 
designer may bave during the life ofthe project. 

Features that help in the design process include: 

• The ability to design small and large projects without having to leam a new program. 

• The ability to design steel and concrete members withm the same program. 

• Fast analysis algorithms allowing time for developing the model and optimizing the 
design of structural elements. 

• The ability to easily modify and improve the design. 

There are probably as many ways to model a structure as there are engineers. However, you may 
fmd sorne ofthese ideas helpful: 

• Start with a basic model of your structure and try and understand it befare adding more 
detail. It is always easier to fix structural system related problems while the modelts sull 
simple. 

• Ensure the structure can be constructed and will behave the way you have modeled 11. lf 
it can not be built in such a way, you may need to understand what effect that will ha ve 
on the structure. 

• Thoroughly document your design including assumptions, areas that need to be 
reviewed and information that is still requ1red. You can use the User Comments and 
Session Log text editor under the File menu. This basic text editor is built into the 
program allowing your notes to be with your model. 

• Experiment with altemative structural systems. SAP2000 was designed to be fast; use 
the extra time to improve your design. 

• lf there is time to do it properly later there should be time to do it properly from the stan. 
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TUTORIAL 2 

2-D Frame with 

Response Spectrum Loading 

Description 
This tutorial is a continuation of T utorial l. In this tutorial we will demonstrate how to add a 
Response Spectnun analysis to the 2-d frame. The basis for the Response Spectnun will be the 
UBC94S2 spectnun. which 1s included in SAP2000. 

Significant Features of Model and SAP2000 
• Using Help to get instructions on SAP2000 features 

• Adding a Response Spectrum load case 

• Scaling the Response Spectrum for use in design 
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Tutorial2 2-D Frame with Response Spectrum Loadmg 

Defining Response Spectrum 
A Response Spectrum is the maximum response of a system excited at iis base by a time 
acceleration funcrion. It is expressed in tenns ofthe natural frequency and the amount of damping of 
the system. The UBC94S2 Response Spectrum function that we are gomg to use is provided with 
SAP2000 and so it will not need to be defined separately. If there were a need to defme your own 
Response Specnum Function you could use the on!ine help to get step-by-step lllStructions. 

OnlineHelp 

Remember: You can use the fol/owing methods to get information on any 
SAP2000'sfunctions. 

l. From the Help menu select Search for He!p on. 

2. With the lndex tab selected: 

• In Area 1 type 'Define'. You will then see in the Area 2 a list ofall the help tapies 
that start with define. One of those top1cs is Define Response Spectrum Functions. 
which is the topic we need help on. Double click on the !in e with the words 'Define 
Response Spectrum Functions' to show the help information on rpat top1c. 

3. Altemately, se!ect the Find tab to search for key words in any ofthe online help tapies. 

• Ifthis is the first ume that you use Find for the SAP2000 online help. a Find Setup 
Wizard form will appear. 

• Press the NEXT buuon to accept the criteria for building the fmd database. 

• Press the FINISH bunon to have the database built. 

• In Area 1 type 'Response Spectrum' 

• In Area 3 you will again find 'Define Response Spectrum Functions' whtch you can 
select to get to the help information. 

Note: Yo u can find more information on using online he/p, in your 
windows documentation. You cana/so run the WJNHELP32.HLP 
file in you,r C:\ WINDOWS\HELP folder. 

Defining Response Spectrum Case 

l. lfthe model is !ocked then use the Lock!Unlock Model bunon to unlock it so you can 
make changes to the model. 

2. Set the units to Kip-ft. 

3. From the Define menu select Response Spectrum Case. 

4. Press the ADD NEW SPECTRA bunon on the Response Spectra form. 

5. In the Response Spectrum Case Data form: 
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Tutoria12 2-D Frnme with Response Spectrum Loadmg 

• 
• 

• 
• 

Input a Damping of0.05 (5 %) 

Select the UBC94S2 for the U! direction anda Scale Factor of32.2 ft./sec'. The 
scale factor is used for the Response Spectrum beca use UBC94S2 is normahzed by 
the acceleration due to gravit:' g. 

The remainder of the default values are acceptable . 

Press the OK buttons to accept the changes you have made to both forms . 

Running Analysis 
Once you have made the modifications, tt is time to run the model and take a look at the Response 
Specnum results. 

l. Save your model. 

2. Set the parameters for the analysis by selecting from the Analyze menu Set Options. 

• Select the Dynamic Analysis check box. 

• Press the SET DYNAMIC PARAMETERS button and change the Number of 
Modes used in the solution to 7. The remaining default values are acceptable. 

• Press the OK button on both forms to accept your changes. 

Note: You have to decide how many modes you wi/1 need to consider in 
your analysis to make the results meaningful There are many 
criteria to take into account, butfor a structure as simple as ours you 
can consider the same number of modes as there are jloors. 

3. Select Run Minimized from the Analyze menu to analyze the structure. 

Note: The Run Minimized option is extreme/y helpful when running large 
models that may take a /ot oftime to ana/yze. This option al/ows 
SAP2000 to run in the background so you can continue working on 
other programs. The other advantage to this option is that you get a 
cancel button that a/Jows you to cancel a run if you need to. 

Checking Results 
l. Check the modal shapes and periods to see that they are as expected. 

• From the Display menu select Show Mode Shape and select the mode you are 
interested m. You may al so want to select the Wire Shadow option so you can see 
what the undeformed shape looks like. See Figures 2-1 through 2-4 and note that the 
mode number and period is shown as the title of the window. 
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Tutoria12 2-D Frame w1th Response Specrrum Loading 

Note: }'ou can /ook at subsequent mode shapes by pressing the + and­
buttons thatare next to the START ANIMATION button. 

2. It is helpful to see the base shear produced dueto the Response Spectrum analysis. 

• Using the BASE SHEAR group that was set up in Tutorial 1, look at the base shear 
for the structure due to the Response Spectrum. You will see that it is substamially 
larger than the static load case. 

3. You can also check the displacement of a joint due to the Response Spectrum. 

• From the Display menu select Show Deformed Shape. 

• In the Deformed Shape form select the load case for the spectral analysis. 

• Press the OK bunon. 

• Right click on a joint at the top leve! of the structure to see the displacement of the 
joint in the global X direction. 

4. Check the mass participation to see if enough modes were included in the solution. This 
will need to be done outside ofSAP2000 by looking at the.filename.OUT file using a text 
editor like WordPad. 

• Minimize the SAP2000 program. 

• Start WordPad or another text editor. 

• In WordPad open the filejilename.OUT. Wherefilename is the name ofthe file you 
used when saving this tutorial. 

t Find the section titled MODAL PARTICIPA TINO MASS RA TIOS as shown in 
Figure 2·5. 

• You will find under the CUMULATIVE SUM column that Mode 1 through 
Mode 7 includes 100% ofthe mass participation. Which means that the 7 modes 
included in the analysis were enough. 
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Tutonal2 2-D Frame with Response Specrrum Loadmg 
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Figure 2·3 Modo 3 Shape and Period Figure 2-4 Modo 4 Shape and Period 
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Tutorial 2 2-D Frame w1th Response Spectrum Loading 

M O O AL P A R T 1 CIPATING M A S S R A T I O S 

MODE PERIOD INDIVIDUAL MOOE (PERCENTJ CUMULA TIVE SUM (PERCENT) 
ux UY uz ux UY uz 

1 1.388750 79.6359 0.0000 0.0000 79.6359 0.0000 0.0000 
2 o. 477633 11.5761 0.0000 0.0000 91.2120 0.0000 0.0000 
3 o .268126 4.3023 0.0000 0.0000 95.5144 0.0000 0.0000 
4 0.178439 2.1229 0.0000 0.0000 91.6373 0.0000 0.0000 
5 o .133618 1.4011 0.0000 0.0000 99.0450 0.0000 0.0000 
6 0.101631 o. 6592 0.0000 0.0000 99.1043 0.0000 0.0000 
1 0.090718 0.2951 0.0000 Q .0000 100.0000 0.0000 0.0000 

Figure 2-5 Output File Block for Mass Participation 

Scaling Response Spectra 
Sorne design codes allow you to scale the spectral analysis base shear to the static base shear. So in 
this caseto get the new scale factor for the Response Spectra you would: 

l. Divide the Static Base Shear by the Spectral Base Shear and multiply that number by 
32.2 ft/sec' to get a new sea! e factor for the Response Spectrum. 

2. Substitute the new sea! e factor for the Response Spectra Case. 

3. Rerun the analysis to get the new member forces dueto the scaled Response Spectrum. 

Final Comments 
A Response Spectra analysis introduces another leve! of complexity, which requires the engineer to 
further check the analysis results and the assumptions used in the modeling. Things to keep in mmd 
during a Response Specmun analysts: 

• Completely understand the static behavior ofthe model before running a dynamic 
analysis. 

• You will need to completely understand the rationale and applicability ofscaling 
dynamic analysis results to equivalent static base shear before scaling results for any 
given model. 

• The speed advantages ofrunning a Response Spectrum ana!ysis over a full Ttme History 
analysis can be substantial. In design, the Response Spectrum analysis can provide an 
even greater speed advantage, dueto the fact that the design check does not need to be 
done at each time segment. However, one needs to be aware of the limitations of this 
method o ver a fu!l Time History analysis. 
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TUTORIAL 3 

2-D Frame with 

Time History Loading 

Description 
This tutorial builds on Tutorials 1 and 2 by adding an earthquake load specified as a base 
acceleration time history. The earthquake excitation is shown in Figure 3-1. It is the N-S 
componen! ofthe 1940 El Centro earthquake. The results ofthe Time History are used to 
generate a Response Spectrum which in tum is used to reanalyze the structure as a 
comparison. 

Significant Features of Model and SAP2000 
• Time History response to base excitation 

• Ploning time history results 

• Plotting a Response Spectrum from a Time History 

• Importing a Response Spectrurn to use for analysis 
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Figure 3·1 El Centro Ground Acceleration Input· ftlsec' 

Time History Definition 
Time Histol)' is a record of the ground acceleration at defined rime segments for a specific 
earthquake in a certain direction. The record is usually normalized and therefore needs to be 
multiphed by the acceleration dueto gravity ora factor thereof. 

l. From the Define menu select Time History Functions. 

2. Select the ADD FUNCTION FROM FILE bunon. 

• Press the Open File bunon and then find and select the ELCENTRO file from the 
EXAMPLES directory in SAP2000. 

• Change the name of the function to EL CENTRO to make it easier to recognize. 

• The forrnat for this file is three pairs of data columns per row. The first column of 
the pair is the time and the second is the acceleration. 

• Enter 3 for Points Per Line. 

• Select the Time and Function Values (in data file) option. 

• Press the OK bunon. 

• Press the OK bunon lo accept the additions that you have made. 
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3. From the Define menu select Time History Cases to define the specifics ofthe Time 
History for your model. 

• Select the ADD NEW HISTORY button. 

• Press the MODIFY/SHOW MODAL DAMPfNG button and enter 0.05 (5%) for all 
modes and hit the OK button. 

• Enter 500 in Number ofüutput Time Steps. 

• Enter 0.02 (sec) in Output Time Step Sizes. This will give us 10 seconds ofthe 
earthquake time history. 

• Select Linear from the Analysis Type drop down list box. 

• In the Load Assignment area: 

• select ACC DIR 1 under Load 

• select ELCENTRO under Function 

• Set the Scale Function to the acceleration dueto gravity which is 386.4 in/sec2 

if your units are in Kip-in and 32.2 ft/sec2 if your units are in Kip-ft. 

• Set the Arrival Time and Angle to Zero. 

• Press the ADD button to add the load assignments and the OK button to accept 
the data you just entered. 

• Press the OK button on both forms to accept your additions. 

We ha ve now entered all the infonnation we need for a Time History analysis. 

Note: It is usual/y a good idea to run your model every time yo u make a 
major change or addition. This will give you a way to catch your 
mistakes early and save you time in your final design. Í 

Running Analysis 
l. Save your model. 

2. Set the parameters for the design run by selecting from the Anal~·ze menu Set Options. 

• Check that the Dynamic Analysis settings are the same as for Tutorial 2. 

3. Select Run from the Analyze menu to analyze the structure. 
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Using the Results 

Checking Results 
Once you have run the model successfully you need to check and see that the output is correct and 
close to what you expected. 

l. Check the base shear produced due to the time history analysis. 

• From the Display menu select the Show Time History Traces option. 

• From the Time History Display Definition form press the DEFINE 
FUNCTJONS button. 

+ In the Time History Functions form select Add Base Functions and check only 
the Base Shear X option. 

• Press the OK buttons to get back to the Time History Display Definition form. 

• Add the Base Shear X function to the Plot Functions lis! box. 

• Then press the DISPLAY button to see the plot of the base shear in the global X 
direction as a function oftime. See Figure 3~2. 

Note: You can also view the Time History plot ofthe base shear by 
selecting Add Group Summation Forces instead of Add Base 
Functions and selecting the base shear group that was defined in 
Tutoria/1. 

2. You can also check the dtsplacement of ajoint dueto the time history. 

• Select a joint and from the Display menu choose the Show Time History Traces 
oprion. 

• Press the DEFINE FUNCTJONS button and in the Time History Functions 
form select thejoint name from the list and press the MODIFY/SHOW TH 
FUNCTJON button. 

• In the Time History Joint Function form select the DISPL Vector Type and UX 
Vector Direction. 

• Press the OK button to accept the changes. 

• Press the OK buttons to go back to the Time HistOl)" Display Definition form. 

• Add the jomt from the List of Functions to the Plot Functions list box and 
remove the Base Shear X function. 

• Press the DISPLAY button to see the jomt displacement with respect to time. 
See Figure 3-3. 
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• You can also define a joint function directly in the Time History Display Definition 
form without selectmg it first. 

• In the Time History Display Definition forro press the DEFINE FUNCTIONS 
button and in the Time History Functions form select Add Joint Disps/Forces. 

• In the Time History Joint Function form enter the Joint ID. 

• Select the Vector Type and Vector Direction. 

• Press the OK bunons to go back to the Time History Display Definition forro 
wherc you will find the new joint function in the List of Functions list box. 
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Figure 3-3 Roo! Time History Displacement ·in 

Building Response Spectrum Data 
The first thing to do is plot a Response Spectrum from the time history data. Then the data will need 
to be printed toa file and the file edited into a fonmat that can be read by SAP2000. 

Plotting the Response Spectrum 
l. Select one joint at the base ofthe structure. 

2. From the Display menu select Show Response Spectrum Curves. This option only 
appears when a joint is selected. 

3. In the Response Spectrum Generation form you will find the name ofthe joint that was 
selected. 

• Under the Define tab select the X Vector Direction. 

• Under the Axes tab select Period for the Abscissa and PSA (Pseudo Spectral 
Acceleration) for the Ordinate. 

• Under the Options tab select Arithmetic for both the Abscissa and Ordinate. For 
the Ordinate set the scale factor to lig (g=32.2 ft/sec2

) which will be .03106 sec2/ft 
ifthe unas are set to kip-ft. 
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Note: The sea/e factor is used to normalize the Response Spectra. The 
Time History that is being used to produce the Response Spectra has 
been sca/ed by g so we need to divide by the same number to get back 
to normalized val u es. 

• Under the Period tab select the Default and Structural frequencies, which are used 
in the generauon ofResponse Spectrum. Default frequencies are a set ofbuilt-in 
frequencies, typ1cally of interest in structures. Structural frequenc1es are the 
structure's natural frequencies. 

• Under the Damping tab keep only the .05 Damping Value. As the strucrure is 
assumed to ha ve 5% damping, we will not need any other values. 

• Press the D!SPLA Y button when yo u finish. 

4. You will see a plot of a response spectrum for the El Centro earthquake at 5% damping. 
See Figure 3-4. 
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Figure 3-4 Response Spectrum from Time History 

5. In the Response Spectrum Curves form select from the File menu the Print Tables to 
File option. This will make a file that has two columns. The first one is the Period and the 
second is the PSA for each period. 

• Save the file underthe name RS-ELCEN.TXT 
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Editing Table 
The nexl step is lo do sorne minar editing on the RS-ELCEN.TXT lexl file so il is in a formal lhat 
SAP2000 can read. When the file is rnade. there is sorne extrnneous information that is added to 
help you understand the content ofthe file. This extra informalion needs 10 be deleted. 

l. Open RS-ELCEN.TXT in a texl editor like WORDPAD or NOTEPAD. 

• Selecl all lhe 1ex1 1ha1 is shown highlighled in Figure 3-5 and delele 11. 

• Save RS-ELCEN.TXT as a lexl file using the same narne. 

2. Now tha1 the file only has the Period and the PSA columns, il is in a formal that SAP2000 can 
read. 

0.0303 3 .0666!:-Ql 
0.0357 3 .2657E-Ql 
0.0400 3.1139!-01 
0.0'155 3.ZZ17:E-Dl 
0.0500 3 .2Z05E-Dl 
0.0556 3 .3099!-Ql 
0.0606 3 .4265!-Ql 
o .066? 3. 713 U:-Dl 

Figure 3-5 Text File of Response Spectrum Table 

Reading Spectral Data 
Now tha1 we have the data in a formal tha1 can be read by SAP2000 we simply need to lell the 
program where the file is and how il is sel up. 

l. If the rnodel is locked press the Lockl Unlock Model button on the loolbar. This will unlock 
the rnodel and allow you lo make rnodificatíons to it. 

2. From the Define menu select Response Spectrum Functions. 
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3. In the Response Spectrum Functions form press the Add Function from File bunon. 

• N ame the spectra RSELCEN 

• Press the Open File bunon and pick the RS-ELCEN.TXT file from the Pick File 
form. 

• Keep the N umber Of Points Per Line to 1 as there is only one set of response data 
on each line. 

• Select the Period and Acceleration Values option. 

• Press the OK bunons to el ose the forms. 

4. From the Define menu select Response Spectrum Cases. 

5. In the Response Spectrum form press the ADD NEW SPECTRA button. 

• Set the Modal Damping to 0.05. 

• In the Input Response Spectra area select RSELCEN for the U 1 dtrection and give 
ita scale factor of32.2 ft/sec2

. 

• The remaining default val u es are acceptable. 

• Press the OK buttons to close the forms. 

Running Analysis 
Once you have made the modifications, it is time to run the model and take a look at our results. 

l. Save your model. 

2. Select Run Minimized from the Analyze menu to analyze the structure. 
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Checking Results 
The first thing to do is check the maximum deflecrion at the top of the snucture and the base shear 
due to the Time History and the Response Specnum. This will show how well the outlined method 
works. At the end of this sectton you will find the results of the staric lateral load. Response 
Specnum and Time History analysis. 

Response Spectrum Deflection 

l. From the Display menu select Display Deformed Shape. 

• In the Deformed Shape form select the load case for the specrral analysis. 

• Press the OK button. 

2. Right click on ajoint at the top leve! ofthe structure to see the displacement ofthejoint 
in the global X direction. 

Response Spectrum Base Shear 

Using the BASE SHEAR group that was set up in Tutorial 1, look at the base shear for the snucture 
due to the Response Specnum. 

Time History Deflection and Base Shear 

l. Using the method outlined in the first part of this tutorial, plot the deflection at the top of the 
structure. 

2. Now remove the joint from the Plot Functions list and plot the Base Shear X direction by 
selecting it from the List of Functions in the Time History Display Definitions form. 

Static Lateral Response Spectrum Time History· 

Max Deflection 1.6 in 5.5 in 5.9 in 

Max Base Shear 72.5 Kips 306 Kips 286 Kips 

Table 3·1 Comparison of lateral load Results 

Final Comments 
As you have seen the Time History analysis is much more rime consuming than a Response 
Specnum analys1s. The Response Specnum and Time History analysis results can give similar 
results. However it is very irnportant for the engineer to understand the strengths and lirnitations of 
each method so they can be effectively used. 
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TUTORIAL 4 

2-D Frame Steel Design 

Description 
This tutorial is provided to highlight the powerful tools in SAP2000 for desi¡ming the structure after 
it has been analyzed. The steel design features will be looked at in this tutorial to desi¡m the structure 
that was modeled in Tutorial l. 

Significant Features of Model and SAP2000 
• Assigning member rigid End Offsets 

• Automatic select10n groups 

• Changing member properties 

• Designing members by groups 

• lncluding ?-Delta effects in analysis 

• Viewing design results 

• Overriding Auto Selection sections 
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Building the SAP2000 Model 
You will be able to use the file you developed in Tutorial 1 with a few modificarions. 

Materials 
First thing to do is set the material properties. 

l. Check that the units are set to K.ip-m. 

2. From the Define menu select Materials. 

3. Select the STEEL Material type and press the MODIFY/SHOW 1\-IATERIAL bunon. 

4. Set the Steel Yield Stress fy to 36 Ksi. 

5. Set Modulus of Elasticity E to 29,500 Ksi. 

6. Press the OK bunons to accept the changes and clase the forms. 

Loads 
l. In Tutorial 1 you assigned a set of point and uniform loads as DEAD load and included the 

member self weight. (See Figure 4-2 for the new Sta tic Loads Case list.) In this tutorial we 
will assign a load case for the live load and one for the self weight of the members. lncluding a 
load case for the selfweight ofthe structure is a good way to keep track ofthe structurnl weight 
for design oprimization purposes. The loads are separated into dead, live and lateral earthquake 
load cases so the design pan ofSAP20 oan automatically generate load combinations. 

• For the DEAD load case set the JfWeight Multiplier toO. 

• Add a load case SELF ofType DEAD for the member selfweight and set Self 
Weight Multiplier to l. 

• Add another static load case named UVE and assign itas Type UVE. 

2. Add the same loads that are in the DEAD load case to the UVE load case. This will mean that 
each beam in the strucrure has idenucal dead and live loads. (See Tutorial 1 for instrucrions on 
entering loads.) 
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$tatic Load Case Hautes 

Figure 4-2 Static Load Cases 

Defining an Auto Selection Group 
The Auto Selection feature in SAP2000 is a vety effective way to design structures. By defirung a 
set of steel sections as an Auto Selection section group. the program can destgn each frame element 
using only !he sections in that group. For example we can defioe an Auto Selection group called 
COLUMN with only Wl4 sections anda BEAM group with only W24 sections. In this way frame 
members assigned a COLUMN Auto Selection secrion will only be designed using W 14 sections. 

The first thing to do is define an Auto Selection group, which only includes column secuons. 
Essentially what we are doing is giving !he program a list of sections which it can choose fi-om 
when designing !he fiame members. In tum the program will select !he most efficient secuon out of 
that group. 

Once !he preliminary design is done and it is time to start fme tuning !he design, !he BEAM and 
COLUMN groups can be repiaced by !he optimum sections fi-om !hose Auto Selecrion groups. Tius 
will then assign a specific section for both !he analysis and design, which will make it much easier 
to change !he few secrions that may need to be modified. 

Note: Auto Selection only works for steel frame sections. 

l. From the Define menu select Frame Sections. 

2. In the Frame Sections form import all the steel sections between Wl4x6I and Wl4x283. 

• Select IMPORT I/WIDE FLANGE from the Import drop down list box. 

• In the sections form scroll down and select Wl4x283. 

• With the SHIFT bu non pressed left click on W 14x61 and press the OK bunon. This 
will select these sections and al! the sectlons in between. 

3. In the Frame Sections form delete any duplicate sections. 
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Remember: You will not be able to delete a section that is in use. This 
feature is a way for the program to insure tlrat al/ the members are 
assigned to existing sections. 

4. From the Frame Section form add an Auto Select section which will be at the bonom of 
the Add drop down list box. 

• Change the Auto Section Name to COLUMN. 

• In the Auto Selections list box select and remove using the Remove bunon al! the 
sections except the W14's. This will mean that any frame member assigned a 
COLUMN sect10n will be destgned from the list ofWI4 sections in the Auto 
Selections list box. (See Figure 4-3.) 

Auto Sr.lr.r.t1nn Sr,~r.tion~ 

!> 
:, ( 

. ' 1 

1 

1 

~··.1 
1 

Figure 4-3 Defining the COLUMN Auto Selection group 

5. Using the instructions outlined in steps 2 through 4: 

• Impon all the sections between W24x55 and W24x 162. 

• Assign an Auto Selection group called BEAM with only the W24 sections in it. 

6. Finally, select all the vertical frame members and assign the COLUMN section to them. 
Then select all the horizontal frame members and assign the BEAM section to them. (See 
Tutorial 1 for mstructions on assigning sections to frame members.) 

Note: You can of course selecta specific section for both the analysis and 
design instead ojusing an Auto Select section. You simply need to 
assign the frame member a steel section and design itas outlined in 
Tutorial l. The steel section can either be a user-defined section ora 
section from the Section Property ji/e_ 
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Running Analysis 
Once data has been entered, it is time to run the model and take a look at our results. 

l. Save your model. 

2. Set the parameters for the design run by selecting from the Analyze menu Set Options. 

• In the Analysis Options form select a Plan e Frame analysis to reducé the size of the 
solution and thus reduce the time needed for the analysis. 

• Select the Include P-Delta check box. 

• Press the SET P-DELTA PARAMETERS button to set the analysis parameters. 

• Set Maximum Iterations to 10. 

• lnclude the two dead load cases DEAD and SELF m the P-Delta load 
combination with a factor of l. 

• Include the UVE load case with a factor of l. 

Note: The load factors that you use need to be the load factor for the 
design load combo that includes lateralloads and has the largest 
vertical load on the structure. 

• The remaining default values are acceptable. 

• Press the OK buttons to accept the changes and close the forms. 

3. Select from the Analyze menu the Run option to analyze the structure. 

Note: Beca use we have assigned groups of sections and not speci.fic 
sections for our design, SAP2000 will take suitable section properties 
to cale u/ate the stiffness matrix and any other properties it m ay need. 
Once thejirst analysis and design has been performed, the program 
can be instructed to use the designed sections for ana/ysis. 

Designing Sections 
Once you have run the analysis and checked the analysis results, you can set the parameters needed 
for steel desigu. 

Selecting Code 
The informarion in the analysis run is used to do a code check on the frame elements. 

J. From the Options menu select Preferences. 
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2. In the Preferences fonn under the Steel tab, select the steel code you want to use. In thts 
case let's use AISC-ASD-89. 

• Use the same Section Properties file that was used for imponing the steel sections. 

Load Combinations and Design 
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Figure 4-4 Design Menu Options 

Once you have selected the code you will be using to design the members, you need to check the 
load combinations that will be used for the design. 

l. The first thing to do is make sure that under the Design menu the Steel Design item has a 
check mark on it. This will tell SAP2000 to design the steel sections. 

2. From the Design menu choose Select Design Combos. 

• Look at the automatically created combos in the Design Combos list box by 
selecting the combo and pressing the SHOW bunon. 

• Ifyou find that there are other load combos that you want to use in your design, you 
can add them. Simply define the combo from the Define menu and then in the Select 
Design Combos form add the combo lo the Design Combos list. 

3. Run the Design/Check from the Design menu by selecting Start Design!Check of Structure. 

• Each of the elements will be designed with the most efficient section from its Auto 
· Selection secrion group. 

• SAP2000 will automatically display on the active window the percent of maximum 
stress below each of the elements. 

• The elernents will also be color coded for convenience with a stress ratio color key 
located at the bonom ofthe window. 
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Note: lf you just want to check the design for a limited number of frame 
members, you can selec11hose members and lhen choose S1art 
Design/Check of Structure. 

Viewing Results and Redesigning 
The first thing to do when a Design/Check is perfonned, is to see that the results are correct. 
SAP2000 gives the user sorne tools to check the results. 

l. Right ciick on any member to view its design results. The eiement yo u ha ve seiected will 
be flashing to identify itseif. 

2. in the Steei Stress Check Information fono, you wiil find a list ofthe load 
combmauons used to check the section at various locations along the members. (See 
Figure 4-5) 

• One ofthe combos wiil be htghlighted when you first see the fono. That ts the 
controlling combo that was used to design the section. 

• Next to each combo there is the location along the member where the check was 
performed followed by the stress ratio for moment interaction and shear. 

Hint: You can change the numberoflocalions al which lheforces are 
reporled. Selecllhe frame elements and choose from the Assign menu 
Frame .•. Output Segments and change the number ofsegmenls. You 
will then need to rerun the analysis to gel the resultfor the new 
segments. 

3. Selecting any ofthe combo checks and pressing the Details bunon wiil show the analysis 
results for that member and goveming equation fi'om the code. (See Figure 4-6) 

4. Pressing the ReDesign bunon will bring up the Element Overwrite Assignments fono. 
In this fono you can: 

Note: lfyou make any changes in the Elemenl Overwrite Assignments 
form through the ReDesign button, you wi/1 need to press the Refresh 
Window button on lhe too/ bar lo see the upda1ed design results on 
the current window . 

• Select another section to see the effects ofthe change on the stress ratios. 

Note: In the Auto Selection mode, this section can be used in developing a 
new stiffness matri.x ifyou "Update Ana/ysis Seclions". However, 
Auto Selection will sti/1 take place the next time you run the design 
check. 

• Set the member as a Moment Resisting Element or a Brace. 

• Overwrite design factors like the effecttve iength, unbraced iength ratio and so on. 
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• Overwrite Allowable Stresses used for the des1gn. This is a value in the current 
units for the allowable stress of the section. 

• When you have finished modifying the design parameters press the OK bunon. 

Note: Changing any ofthe information in the ReDesign form K'i/1 make 
SAP2000 automatically recalcu/ate the design stress ratios for that 
new information and update the Steel Stress Check lnformation 
form. See the Re·Ana/yzing section for instructions on updating the 
analysis sections. 

5. To use the ReDesign section in the next analysis you will need to select from the Design 
menu the Update Analysis Sections option. Thts will replace the sections used to build 
the stiffness matrix so that a more accurate design check can be made. 

Steel Sbesc Check lnton..tion , -
..... ' .. 
1 !Doto~ 11 RoOn..,j 

CUI!IIO . STI.TIIIB /----1!1l12:11'1' Ili1ERI.CTIOlf OIECK-----11-SHEm 2-.:..-SKDR 3-1 

"' "' nnn llCL • Bll • ... R>rm uno 
DSU.l liD.OO 0.431(t) - o.ooo + 0.431 + o.ooo 0.114 0.000 . 
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DSU.2 tO.DO o. 351(1) -o. DIO + 0.351 + 0.001 O.H, 0.000 
DSU.2 110. DI 0.~54.(1) • o.aao • o.~5fo + 0.001 D.U4 0.000 
DSU.2 :no. oo 0.1511(1) • o.oao • o.ua + o.ooo 0.245 0.000 
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:: ::..·:::r.:~ ~ •, . ' . -.· 
• - 1 ••• ~.: : • •• 

Figure 4-5 Steel Stress Check for Specified load Combinations 
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Note: lfyoujust want to check the designfor a limited number offrame 
members, you can selectthose members and then choose Start 
Design/Check of Structure. 

Viewing Results and Redesigning 
The frrst thing to do when a Design/Check is pcrfonned, "¡s to see that the results are correct 
SAP2000 gives the user sorne tools to check the results. 

l. Right click on any member to view its design results. The element you ha ve selected will 
be flashing to identify itself. 

2. In the Steel Stress Check lnformation form, you will find a list ofthe load 
combinations used to check the section at various locations along the members. (See 
Figure 4-5) 

• One of the combos will be highlighted when you first see the form. That is the 
controlling combo that was used to design the section. 

• Next to each combo there is the location along the member where the check was 
performed followed by the stress ratio for moment interaction and shear. 

Hint: You can change the number oflocations at which theforces are 
reported. Se/ect the frame elements and choose from the Assign meiru 
Frame ••• Output Segments and change the number of segments. You 
will then need to rerun the analysis to getthe resu/t for the new 
segments. 

3. Selecting any ofthe combo checks and pressing the Details button will show the analysis 
results for that member and goveming equation from the code. (See Figure 4-6) 

4. Pressing the ReDesign button will bring up the Element Overwrite Assignments form. 
In this form you can: 

Note: Ifyou make any changes in the E/ement Overwrite Assignments 
form through the ReDesign button, you wi/1 need to press the Refresh 
Window button on the too/ bar to see the updated design resu/ts on 
the curren/ window. 

• Select another section to see the effects of the change on the stress ratios. 

Note: In the Auto Selection mode, this section can be used in developing a 
new stiffness matrix ifyou "Update Ana/ysis Sections". However, 
Auto Se/ection wi/1 sti/1 take place the next time you run the design 
check. 

• Set the member as a Moment Resisting Element ora Brace. 

• Overwrite design factors like the effective length, unbraced length ratio and so on. 
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Figure 4-6 Detailed Steel Design lnfo of a Beam Element 

6. You can also look at various design results on the graphics screen by selecting from the 
Design menu the Display Design lnfo opuon. These results will be ploned on the bonom 
and to the right of frame members. · 

Note: The sections used for the analysis are shown at the top and to the 
/eft ofthe frame members. Al/ the design informarion is shown al the 
bonom and to the right oftheframe members. 
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Display Ocsign RcsaJts 

Figure 4-7 Display Design Input and Results Fonn 

7. You can also Print out the design results by selecting from the File menu Print Design 
Tables. T o print results on a hmited number of members, select the members and then 
selecting from the File menu Print Design Tables. 

Editing Section Properties 
From Figure 4-1 you will see that the beams have point loads coming in at their third points. Let us 
assume these point loads are coming from other members and so the beams are supported lateral! y 
at their third points. The model as it is defined does not take that mto considerarion. so the beams are 
over designed. To design the beam more accurately we will need to edit the beam design properties. 

l. Select al! the beams in the structure. You may want to use the Intersecting Line Select 
Mode. 

2. Select from the Design menu the ReDefine Element Design Data. 

• In the Element Overwrite Assignments form select the Unbraced Length Ratio. 
L22 check box and set the value to 0.33. This will brace that member at 1/3 rd points 
(against buckling in the local 1-2 plane) instead ofthe default ofbraced at the ends 
only. (See Figure 4-8) 

• Press the OK button when you have entered the new value. SAP2000 will then 
automatical!y rerun the Design!Check and update the model. 

3. You will now see that the beam members are smaller. 

Hint: You can get a group load joint sum report on the Base Shear group 
to find what the self-weight ofthe structure is. This is a quick way to 
see ifyour changes have produced a more efflcient structure. You 
can also gel the total weight of the structure from the filename.EKO 
file. 
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Elemenl Overwnte An'!P!..enls 
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Figure 4-8 Element Overwrite Assignments lor Beams 

Re-Analyzing 
The first analysis run used approximate secrion properties to develop the stiffuess matrix. So the 
model will need to be run again as an iterarive process to make sure that the analysis is done using 
the selected secuons. · 

l. Once you ha ve finished modifying the structural sections you will need to use. from the 
Design menu select the Update Analysis Sections option. Then rerun the analysis to use 
the selected member propenies for the stiffness matrix. 

2. Then rerun the design to see which members have changed. 

3. Once you are satisfied with the sections selected, from the Design menu choose the 
Replace Auto w/ Optimal Sections option. This will permanently replace the auto 
sections with the current design sections. This effectively makes thC: des1gn secuon the 
analysis section and therefore replaces the BEAM and COLUMN analysis sections with 
the optimal or user selected sections. 
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LRFD Design 
The method used for LRFD design is essenrially the same as that used for ASD. The combos and 
checks made on the frame members will be performed using the LRFD code so the results and 
informarion reponed are different. To run an LRFD Design/Check you will need to change sorne of 
. your input pararneters. 

l. Enter new load factors for the P-Delta artalysis. 

2. Select from the Preferences form the A!SC-LRFD93 steel code. 

3. Redesign the steel sections. 

Advanced Features 

Defining Frame Element Groups 
Sometimes you may find it helpful to design using frame member groups. This will force all the 
members in the group to be designed with the same section. The advantage of this method is that it 
will reduce the various number of sections used in the design. For example you can group two or 
three tloors as one group when designing them. This will then provide you with one section that 
works for all the columns and one secrion that works for all the bearns in that group. 

l. Reassign the Auto Selection sections to the frame members. 

2. Assign all the frame sections at leve! 3 and below to a group name BOTTOM. 

3. Assign al! the frame elements between Leve! 5 and Leve! 3 to a group name MIDDLE. 

4. Assign the remaining elements toa group name TOP. 

5. Rerun the analysis on the model. 

6. From the Design menu choose the Select Design Group option . .This is where one can 
ha ve the program design a group of members and assign all of them with the lightest 
section that satisfies the stresses in all of them. 

• lnclude in the Design Groups list box only the member groups TOP, MIDDLE and 
BOTIOM. This will mean that each frame element group is designed with the most 
efficient section from the Auto Selection group. 

Note: lfthere are no groups in the Design Group list box then al/ the 
members wi/1 be designed individual/y. 

• When you press the OK button, SAP2000 will automatically design the steel sections 
and display the results in the active window. 

3. Compare the results from the fir.;t design run and the group design run to see how that will 
affect the selected secuons. 
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End Offset 
This strucrure is designed to be a moment frame system with members that have no cross secrional 
dimensions for analysis purposes. However, even though this is not a bad assumption, SAP2000 
allows a more accurate way of modeling this problem. By setting Member End Offsets, you can 
define a region about the beam column cmmection where the members can not bend. This 
essenrially produces a rigid zone at that cormecrion. The area can be as large as the user wants. but n 
is usually taken as the depth ofthe member that is framing into it, at that joint (ora !Taction thereof). 

l. Select all the frame elements. 

2. From the Assign menu select Frame ••• End Offsets. 

• In the End Offset form select the Update Lengths From Curren! Connectivity 
option. This will make the program automatically calculate the end offset from the 
sections coming into each joint. 

• Enter 1 for Rigid Zone Factor. This means that 100% ofthe potential End Offset 
length should be taken as rigid in the analysis run. 

• Press the OK bunon. 

3. lfyou set the Element Shrink option on from the Set Elements form and look at the 
active graphics window, you will see that there are lines at each joint that show the . 
assigned End Offsets. 

Remember: You wi/1 need to reset End Offsets every time theframe · 
sections are changed. 

Note: The moment and shear values on the beams and columns will be 
slightly different than with no rigid End Offsets. This is beca use the 
rigid End Offset assignment reduces thej/exible /ength ofthe 
members. 

Final Comments 
The steel design tools in SAP2000 are very helpful in designing the trame members. However there 
are a few things to keep in mind: 

l. Make.sure that all the design data for the sections are correct. The default values that the 
program uses for design may not be correct due to various methods you may ha ve used to 
model your structure, e.g. K and Unbraced Length Ratios. You can use the Display 
Desígn Results forrn to view this information on the framing. For convenience, you can 
also view the analysis sections at the same time as the design informauon. 

2. Check that the design combos the program has provided are correct and sufficient for 
your particular structure. If they are not, add your own to the list used in design. 

3. Check the final design results at key locattons to make sure they are the results you 
expect. 
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4. Check that the load factors used for the P-Delta analysis are correct. 

5. Redesign the srructure whenever you make changes to the model. This will give you a 
way to see if the members are still acceptable. 

6. Use a group to help find the totalweight "Ófthe structure.·(See Tutorial 1 for instructions 
on how tó" do this.) 

7. Use groups for your design to reduce the different number of secuons that are in your 
model. 

8. Thefi/ename.EKO file contains the total weights for each section used. This infonnation 
can be used for initial cost estimations. 
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Appendix A-Tool Bar lcon Descriptions 
lean Control Name Allows You to 

1@ 1 New Model Start a new model. 
., 

1~ Open • .SDB file Open 'existing SAP2000 file. 

m¡ Save Model Save the current model. 
'. 

B Undo Undo last cliange. 

EJI Redo Reverse last Undo. 

0 Refresh Window Refresh current window using latest data. 

~ Lock/Unlock Model Lock model against changes to analysis data. 

GJ Run Analysis Run analysis. 

~ Zoom Zoom in on strucrure by defining area with mouse. 

~ Restore Full View Restore full view of model. 

~ Restore Previous View Restare previous view of model 

~ Zoom In Zoom in to model. 

~ Zoom Out Zoom out of model. 

~ Pan Dynamically move strucrure in any direction. 

~ Show 3-d view Show 3-d view of model. 

B Show 2-d View ofX-Y/r-0 Plane Show 2-d View ofmodel parallel to X-Y/r-0 plane. 

IEI Show 2-d View ofX-Z/r-Z Plane Show 2-d View of model parallel to X-Zir-Z plane. 

0 Show 2-d Vtew ofY-Z/0-Z Plane Show 2-d View ofmodel parallel to X-Z plain ora 
developed view of the r-Z plane. 

~ Perspectivo Toggle Show view in 3-d perspecuve. 

~ Shrink Elements Shrink al! elements to help view element connectivity. 

@] Set Element Set visibility of elements and their properties. 

12] Up One Gridline Move up one grid line in 2-d viewing plane. 

~ Down One Gridline Move down one grid line in 2-d viewing plane. 
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Appendix 8- Floating Toolbar lcon.Descriptions 
Icon Control Name Allows You to 

1m 1 Pointer Tool Select elements mdividually or within a box. 

IBJI Select All Select all elements in drawing. 

~ Restare Previous Selection Restare previously selected elements. 

lill Clear Selection Clear all selected elements. 

mJl Set lntersecting Line Select Mode Select all elements intersected by drawn line. 

m¡ Reshape Element M ove elements by selecling them at their center and 
to reshape them by selecting them at their ends. 

DI Add Special Joint Add ajoint that is not automatically added when an 
element is entered. 

IGJJ Draw Frame Element Draw a frame element by locating its end locations. 

19 Draw Shell Element Draw a shell element by locatmg its comers. 

GJl Quick Draw Frame Element Draw a frame element between grid lines. 

1m Quick Draw Shell Element Draw a shell element between gnd lines. 

~ Asstgn Joint Restraints Assign translational and rorational restraints. 

10 Assign Frame Sections Assign frame section and material properties. 

1~1 Assign Shell Sections Assign shell section and material properties. 

10 Assign Joint Load Assign JDint loads. 

~ Assign Frame Span Loading Assign frame loads. 

~ Assign Shell Uniform Loading Assign shell loads. 

~ Show Undeformed Shape Show original structural shape. 

[!] Display Stauc Deformed Shape Display deformed shape due ro static loads. 

lm Display Mode Shapes 1 Display Mode shapes and periods. 

[[]] Display Element Force/Stress Display Element analysis data on the structure and 
Diagram individually. 

[!] Set Output Table Mode DISplay Joint or Element Text Output on Screen. 
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SAP2000 is now fully mtegrated mto Wmdows. 

Model bwldmg, Anatysis, Oesrgn and Drsplay of results may be carried out rn the same wrndow. 

The model may be vrewed in multrpte windows (up to 4). 

Zoommg rs possible either in steps or wrth a mouse defined wmdow IL~!.®l.®I.S!~Ij 
Members may be extruded on therr center1rnes. 

The model may be viewed rn Perspectiva ISJ 
Context sensitiva help rs available m the 'iorms" with a right mouse button click. 

Detarled rnformatron aboutJoints and members m the modelrs also avarlable wrth a nght mouse button cllck 
(e.g. bendrng moment dragrams, JOint drsplacements or~connectJVIty etc.) 

Designer's Convention 
The desrgner's sign convention is quite drfferent from the typical structural analysis sign convent1on descnbed 1n most 
text books. The moment wh1ch produces compress1on 1n the pos1t1ve face/fiber 1s called a positiva moment and the 
axial force which produces tens1on rn the member is called a positive ax1al force 

Noun-Verb 
All commands 1n SAP2000 work 1n the "Noun-Verb" modeLe. you make a select1on f1rst and then pertorm an act1on 
on 11. As an example, if you want to delete a member from the model you would first select that member and then 
press the delete key. 

2 Modes of SAP2000 
SAP2000 has two very distinct modes 1.e. DRAW and SELECT. SELECT mode 1s the default mode. DISPLAY and 
ASSIGN funct1ons are camed out in the SELECT mode. 
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Select Mode 
When SAP2000 is not 1n the DRAW mode, SELECT 1s the default mode. ltts possible to make mulbple selecttons and 
then perform a task on the selected entJtles. Dtsplay, Asstgn, Oestgn, Output or even Delete functlons are carned out 
m th1s mode. 

T ell me more about 

~ Selectton Procedures 

~ Dtsplay Options 

~ Asstgn Options 

Setup Coordinate System 
To set up a Coordinate System tor creating a new model 

1 On the File menu. cllck New Model . 
2 Choose either the Cartestan or the Cylindncat tab. 

3 Type 1n the number of gnds and thetr spactng and then click OK. 

To add another Coordinate System 

1 On the Options menu, click Set Coordmate System. 

2 Cltck Add new System. 

3 Choose etther the Cartesian or the Cyltndrical tab. 

4 Type in System Name, to define the new Coordinate System 

5 Type in the number of gnds and their spacrng. 

6 CIJck on Advanced to specrfy Locatron and Onentatron. 

7 Click Ok, Ok, and OK. 

Tip: You can add a new grid by pressing the c·TRL key and dragging an existrng grrd to a new location, 
or by using the Edit Gnd command from the Draw menu Double clicking on an exrstrng grrd opens 
the Edrt Grrd box where you may add or modity the locatron of a grid. 

Also See 

~ Edrt Grids 

• 



• Frame Element 
FRAME etement follows the des1gner's conventico. 

~/ 
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Frame Element Interna! Forc:es 



Shell Element • Face6 TOp{•3tace) 
F ke ~ 9ol1con 1-3 IK<II 

Shelllnternal Forces 

FINT = F intermediate 

FVM =-1{1/2[(FMAX- FINT)'2+( FMAX- FMIN)'2+( FINT- FMIN)'2]). 

Also See: Ven M1ses Stress 



• Asolid Element 

Four- to Nlne-Node 
Quadrllateral Elemant 

Thi'H-Node 
Trtangular Elemenl 

Yf2) S22 

4 ~" 

!+10~',, 
\ T X(1) 

Z(3) 

Plane and Aso/id Element Stresses 

SINT = F lntermediate 

SVM =1(1/2[(SMAX • SJNT)•2+( SMAX • SMIN)•2+( SJNT • SMIN)•2J). 

Al so See: Van Mises Stress. 

Solid Element 

Solid Element Stresses 

Nonlinear Analysis 

z {3) 

4 
i 
,____.Y(2) 

~/ 

Xf1J Global 
Coord•natea 

NonJinear analysis capabilit1es are available through a nonhnear hnk element (Nllink). This link element 1s used to 
model local structurat nonhneanties such as gaps, dampers, Jsolators, and the like. Nonl1near behavior 1s exh1b1ted 
only during non linear lime-h1story analyses. For aH other analyses, th1s lmk element behaves linearly. 

Each nonlinear link element may be e1ther: 
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• a one-Joint grounded spring, or 
• a two·Joint l'lnk 

Propertres for Mher type of element are defined in the same way. 

Each element rs assumed to be composed of srx separate nonlinear spnngs. one for each of the srx defonnatlonal 
degrees-of freedom. The force-defonnatron relatlonshrps of these spnngs may be coupled or rndependent of each 
other. 

The types of non linear behavior that can be modeled with the lrnk element mclude. 

1 Vrscoelastic damping 

2 Gap (compression only) and hook (tension only) 

3 Unraxial plastrcrty 

4 Braxial-plastrcity base rsolator 

5 Fnction-pendulum base rsotator 

Each element has rts own local coorchnate system for definrng the force-deformatlan propert1es and for interpreting 
output. 

Each NLLink element may be loaded by gravrty (in any drrectron). 

Available output includes the deformatron across the element, and the intemal torces at the Jornts of the elemer1t. 

• 



• 
F 1 LE MENU 

Getting a Head Start With Templates 
New models may be created with very fittJe effort us1ng pre·programmed templates. 

Click on any of the template buttons to leam more about them. 

.. . .. X 

...-.-+, FR 00 fi§ m 
fffi @ll . fHBl· ~~ diO 

.. .•· 

'jif. fl7':. ~ • 
To Base a new modal on a template: 

1 On the File menu, cllck New Model from Temptate. Th1s will display the poss1bfe templates shown above. 

2 CJ1ck on a template most appropriate for your model. 

3 Choose or change the default values rn the edit boxes. 

4 Cllck OK. 

To add one or more templates to the existing modal: 

1 On the Edit menu, cllck Add to Model From Template ... Th1s will display the template options s1m1lar to the 
one shown above 

2 Chck on the template you want. 

3 Fill in the parameters in the edit boxes and then click on Advanced to specrfy an 1nsertion po1nt. 

4 ClickOK. 

Note: Remember to save your model penod1cally. Click on V . 
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lmport/Export Capabilities 
lmport and Exportare available through the F1le pull down menu. SAP2000 now works around a central data base 
created for the model The database 1s maintained 1n a bmary format and does not operate WJth text rnput files. 
However, text Input files may be read or written us1ng the lmport Export facll1ty. 

What do you want to do? 

~ tmport a SAP90 text input file 

~ lmport a SAP2000 text onput file 

2!1 Exporta SAP2000 text mput file 

2!1 lmport a DXF file 

2!1 Exporta OXF file 

2!1 lmport a SAP2000 Job Run rn DOS mode 

2!1 Export an AVI file 

lmport a SAP90 text input file 
On the File menu, cl1ck Jmport and then SAP90. This wilt diSplay the Open SAP90 Data File dialog box 

2 Choose the file from the l1st box (extens1on not allowed). 

3 CIJck Open 

lmport a SAP2000 text input file 
On the File menu. cl1ck tmport and then SAP2000.S2K. This will d1splay the Open SAP2000 Data File d1alog 
box. 

2 Choose the file from the list box ( must have either .S2K or .$2K extension ). 

3 CHck Open. 

Caution: 

Note: 

The text file w1th an extension . $2k 1s automatJcally wntten out whenever the model is saved This 
file 1s good for analysJs purposes only or recovenng the model in emergency crash sJtuat1ons and Js 
nota subst1tute for the database file (.SDB). lt does not conta1n all the informat1on about the model. 

The analysrs and design informatron prov1ded 1n the SDB file 1s atso saved in the S2K file. Thrs 
g1ves the user the abillty to modJfy the model usrng a text edJtor like WordPad. To find the forma! 
used in the S2K file for the des1gn data. Create a trame element 1n SAP2000 with the des1gn 
information that you desrre. Export the model and open it in a text edrtor to see the format used for 
the defined desrgn mformatJon rn the S2K file. 

Export a SAP2000 text input file 
On the File menu, click Export and then SAP2000.S2K. Thrs wiJJ drsplay the Save Model File As dialog box. 

2 Type m the file name in the Frie name edit box. 

3 Chck Save Th1s w1JI save the text input file with an extens1on filename.S2K. 

Note: A text fiJe with an extension filename $2k is also saved at the same time as the model database is 
saved (as a file wrt.h .SDB extension). ThJs text file rs good for analysJs purposes only or for 
recovering the model 1n emergency crash situations and JS nota subst1tute for the data base file. lt 
does not conta1n all the informatJon about the modeJ. 

• 



• lmport a DXF file 
1 On the F1le menu, click lmport and then .OXF. This will display the lmport DXF File diatog box. 

2 Choose the file from the llst box. Frame elements must be Unes on a !ayer named SAP _FRAMES and shell 
elements must be 30 Faces on a !ayer named SAP _SHELLS. Nades w1JI be entered automatlcally by 
SAP2000. 

3 Cltck Open. 

Note: The DXF file 1mport 1s mtended to facilitate 1mportmg geometry from AutoCAD. Pomt. Line and Area 
( Jo1nt, Frame and Shell elements) are the only entities imported currently. DXF for AutoCAD r12, 
r13 and r14 are supported. 

Export a DXF file 
lf you want to exporta limtted number of elements then setect the elements otherwise go directly to step 2. 

2 On the File menu, click Export and then .DXF. Th1s will dtsplay the Save AutoCAD DXF File As d1alog box. 

3 Type 1n the file na me m the File name edit box. 

4 Cllck Save. This will save the OXF file, wh1ch may be importad in AutoCAD. Frame elements will be Lmes on 
a !ayer named SAP _FRAMES and shell elements wiU be 30 faces on a !ayer named SAP _SHELLS. 

Note: The DXF file export is intended to facilitate exporting geometry from SAP2000. Point, Une and Area 
(Joint, Frame and Shell elements) are the only ent1t1es exportad currently. 

Hint: lf you want to only exporta 20 platn of the model then set the 20 v1ew that you are interested 1n 
Select all the elements that are VISible, and then select Export ... DXF. 

lmport a SAP2000 Job Run in DOS ·mode 
1 On the FJ!e menu, click lmport and then SAP2000.JOB. This will display the Open SAP2000 File dialog box. 

2 Choose the file from the list box (w1th extens1on .JOS). 

3 Cllck Open. 

Export an AVI file 
1 On the File menu, click Create History Video .. Th1s will display the Time History V1deo F1le Creation d1alog 

box. 

2 Clzck on AVI File Name button to change the AVI file name or accept the default name. 

• In the Trme History Data area: 
• Select the H1story Name from the drop down list box. 

• Specify the Start and End Time and the T1me lncrement in the edtt boxes. 

• In the Display Options area· 
• Cl1ck to check 1f W1re Shadow is to be retaJned 1n the Video file capture. 

• Click to check if Cubic Curve 1s to be used. 

• Type in the Magnificat1on Factor 1n the ed1t box. 

• In the AVI OptJons area: 
• Type 1n the an1mat1on speed in the Frames per Second edit box or accept the defaull value. 

• Specify the Frame szze m P1xels in the edJt boxes or accept the default values. 

4 Cl1ck OK 

Note: The AVI file may be ptayed back using W1ndows Media Player. 

Tip: To play the AVI file in real time animation make sure that the number of trames per second is 
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equal to 1fr1me lncrement. The value of number of trames per second may be ad¡usted to speed up 
or down the an1mat1on 

View Real Time Animation for Time History 
Results 

On the File menu, click Create H1story V1deo ... This will d1splay the Video File dialog box. 

2 Type m a file name or accept the default name. 

3 Cl1ck Save. Th1s will display the Time History Video File Creation dialog box. 

4 Select the Time H1story case from the Hlstory Name drop down box. 

5 Enter the Start T1me, End Time and Time lncrement in the edit boxes. 

6 Checkmg the W1re Shadow box w1U also display the undeformed shape as a reference. 

7 Check1ng the Cubic Curve box will display the defonned elements w1th cub1c curve fit. 

8 Changing the Magnification Factor will scale the vector components. The default factor ts 10. 

9 Enter Frame Speed in trames per second for animation and the Frame S1ze m Pixels. The default for Frame 
Speed is 10 and Frame S1ze is 320x240. 

10 Click OK. Creatmg AVI File window w1U appear and the an1matJon will be saved asan AVI file which may be 
ptayed back through the Windows Media Player. 

Note: lf you want to View real ltme animation then the value for trames per second should be the same as 
1frlme Jncrement. A larger value will speed up the ammat1on anda smaller value wlll slow il down. 

Print Setup 
Pnnt Setup is where you can set number of lmes of text to be orinted per page, pro¡ect information and notes to be 
pnnted With text and graph1cs output. You can atso do regular pnnter setup. 

1 From the File menu select Print Setup. 

2 In the Print Page Setup diatog box: 

• Check the No Page Eject if you do not want SAP2000 to break the printed text into pages and place page 
headmgs. 

• lf you want to have SAP2000 break the pnnted text into pages and place page head1ngs then: 
• Select Default to use the default number of lines per page 

• Or setect User Defined and enter m the prov1ded text input box the number of lmes per page. 

• Enter under the Tilles area, Pro¡ect and other comments 1n the prov1ded text input boxes. 
• Click the Setup button to set printer opt1ons. (See windows documentation for instructions on us1ng th1s 

dJalog box.) 
• CIJck OK on the Print Page Setup dialog box when finished. 

Print Selected Graphical Output to a Printer ora 
File 

1 Ptot the desired deformad or undeformed shape on the Screen. 

2 On the File menu, click Pnnt Graphics ... 

3 The plot wlll be pnnted to the default printer. lf the default Pnnter has been set to print toa file then the file 
d1alog box wlll be displayed. 

Note: lf more than one W1ndow is open the hJghtighted window will be printed. 

• 



• Text Output 
Text output tora Jo1nt ora member for the chosen Load Case(s) and/or Load Combinat1on(s) may be e1ther v1ewed on 
the screen or pnnted toa pnnter ora file. 

What do you want to do? 

~ 01splay Jo1nt or Member Text Output on Screen 

~ Print Output to a Printer or a File 

Print Input Tables toa Printer ora File 
Select the members or Joints forwhich the input data is desired.lf no members are selected tne 1nput data 
15 generated for all the members rn the modeL 

2 On the File menu, chck Pnnt Input Tables ... This w1ll display the Pnnt Input Tables dialog box. 

3 In the Pnnt Input Tables dialog box: 

• Check the information you want printed 
• lf you want to generated output for all the members in the model even though sorne members were 

selected then remove the check for Select1on Only check box. 
• lf Output toa File iS des1red check the Print to F1Je check box. 

• lf yo u want the output appended toan exlstmg file check the Append check box. 

• CIJCk OK. 

Print Output to a Printer ora File 
1 Setect the members or Joints for which the output is desired. lf no members are selected the output JS 

generated for all the members in the model. ~. • -

2 On the File menu, cllck Pnnt Output Tables ... Th1s Will d1splay the Pnnt Output Tables dialog box. 

3 In the Print Output Tables dialog box: 

• Chck on Select Loads to select Load Cases or Combos. 
• Select the Load Cases and/or the Load Combmations la beis for whtch the output iS to be disolayed m a 

tabulated form. Loads may be selected by cllcking on the Load labels in the hst bax: For se!ecttng a range 
of loads, click and drag, or for multiple loads hotd down the Ctrl Key and chck on different toad tabels. 

• Click OK to clase the Select Output dlalog box. 
• Click on the check boxes to select the Type of Anatys1s Results desrred, e.g. Disptacements, Reactlons, 

Spnng Forces, Frame Forces. NLLink Forces. Shell Rest..ittants, Shell Stresses, Plane Stresses, ASO UD 
Stresses and Salid Stresses, Element Nodal Forces. Group Forces. 
• lf Group Forces rs checked, you can use the Setect Group button that appears to setect predefined 

Groups for whtch you want torces reported. 

• Jf Output toa File ts destred check the Pnnt to File check box. 
• Jf Spreadsheet output format 1s desrred check the Spreadsheet check box. 

• lf you want the output appended toan ex1stmg file check the Append check box. 

lf only Envelopes of Load Combos are desired check the Envelopes Only check box. 
• lf you want to generated output for aH the members in the model even though some members are selected 

then remove the check for Selection Only check box. 
ClickOK. 

Note: You can not select Envelope resutts m a Spreadsheet format. 

Print Design Results to a Printer or a File 
Select the members or Joints for which the design results are desired. lf no members are setected the 
destgn results are generated for al! the des1gned members 1n the model. 

2 On the File menu, cl1ck Pnnt Desrgn Tables ... Th1s will d1sptay the Print Oesign Tables d'1alog box. 

3 In the Print Des1gn Tables dialog box: 

• Check the information you want printed for steel and concrete members. 
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• lf you want to generated output for all the members in the model even though sorne members were 
selected then remove the check for Selectmn Only check box. 

• lf Output toa F~e 1s deslred check the Pnnt to FJie check box. 
• lf you want the output appended to an exist1ng file check the Append check box. 

• CIJck OK. 

User Comments and Session Log 
SAP2000 provides the user w1th a way to keep notes wrth the model file. 

1 Th1s JS done by select1ng from the F1le menu, User Comments and Sess1on Lag. 

• Thrs w111 bnng up a text edrtor that works JUSI ltke Notepad. 

Uses for the U ser Comments and Session Lag Text Editor: 

• Keeprng track of what has been done on the model to date. 

• Keep1ng aTo Do list for the model 

• Retaming key results to see the effect of changes on the model 

• Paste a Cut or Cop1ed model rnto the text editor. Mod1fyrng the 1nformatton, CuUCopymg Jt and then Past1ng 
the modtfied model back into SAP2000. 

• The Lag file automat1cally prov1des a lag of all file saves by the user. 

• 



• 
EDIT MENU 

Undo and Redo Capabilities 
SAP2000 aJiows you to go back one step al a t1me 1n an ed1t1ng session. Therefore, it Js possible to Undo a series of 
act1ons prev1ously performed. lf you go too far 1n the Undo process you may Redo !hose act1ons. 

1 Cllck BJ to Undo (in steps) the most recent actiOns performed. Undo JS al so ava1lable in the Ed1t menu. 

Jf you later decide you dJdn't want to undo an act1on 

1 Chck lE] to Redo the action(s). Redo is also available in the Ed1t menu. 

Note: Undo only works on Objects wh1ch have been moved, deleted or added. Once a file is saved Undo 
and Redo act1ons are no Jonger available. 

Cut, Copy and Paste 
1 SAP2000 now supports standard Wmdows Cut, Copy and Paste commands. 

2 The entlre structure or any selected part may either be cut or cop1ed and then pasted back into the model 
area at any user specrfied tocation. 

3 lt rs also possible to Paste the Cut or Copred modet mto Microsoft Excet, modify, CuUCopy m Excel and then 
Paste the modified model back m the SAP2000 wrndow. 

Also see: 

.!!1 Reptrcate 

Deleting Members 
1 You can detete members by selectmg them and pressing the Delete button on your keyboard. 

2 You can atso delate members by selectrng them and clickrng on Delete From the Edrt menu. 
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M ove 
The move feature is a way to select parts of the structure and relocate them rn the model. 

1 Select the members and ¡omts you want to move. 

2 On the Edil menu, click Move. This WJJI d1splay the Move dialog box. 

• Enter the relat•ve movement of the selected members in the global X, Y and Z d1rection. 
• Chck OK to move the selected elements. 

Replicate 
Replicate 1S another very poweriul way of generatrng a large model from a smaU model when the elements and/or 
¡oints form a hnear or rad1al pattern orare symmetrical about a plane. When ¡o1nts or elements are repl¡cated the 
assignments on those jornts and elements are also repl1cated, e.g. member sect1on assignments, member loads, JOinl 
loads and ¡oint restrarnts Thrs is a ma¡or benefit of us1ng Rephcate over Cut, Copy and Paste, wh1ch onJy operates on 
llnes and JOints. 

What do you want to do? 

~ Replicate in a Linear Array 

..EJ Repllcate in a Rad1al Array 

~ Repllcate m a Radial Array by Shiftmg the Ongin 

2!J Replicate by Using the M1rroring Opt1on 

Replicate in a Linear Array 
1 Select the members and ¡oints you want to replicate. 

2 On the Ed1t menu, click Rephcate. This will d1splay the Rephcate d1alog box with the Lmear, Rad1al and 
Mirror Tabs. 

3 Click on the Unear T ab. 

4 Fi111n the X, Y and Z offset distances 1n the D1stance edit boxes. 

5 Type in the number of times you want the selected ent1t1es rephcated in the Number ed1t box. 

6 Click OK. 

EXAMPLE: 

Replicate in a Radial Array 
Select the members and JOints you want to rephcate. 

2 On the Edit menu, dick Rephcate. Th1s will display the Replicate d1alog box w1th the L1near, Radial and 
M1rror Tabs. 

3 CJ1ck on the Radial Tab. 

4 Check the axis about wh1ch the selected entll.ies are to be rotated, i.e. X. Y or Z m the Rotate About section. 

5 Type in the increment angle and the number of t1mes you want the selected entilles rephcated in the 
lncrement Data box. 

6 Click OK. 

• 



• EXAMPLE: 

Replicate in a Radial Array by Shifting the Origin 
On the OptJons menu. cllck Set Coordinate System ... This will display the Coordmate Systems d1alog box. 

2 Select the coordmate system from the Systems IJst box. 

3 Cllck on Modify/Show System This will display the LocatJon and Onentation dialog box. 

• In the locatJon and Onentat1on d1alog box 
• Type in the values by wh1ch yÜu need to shift the coordinate system in Translatlons ed1t boxes 

and/or Rotations in Degrees ed1t boxes. 

• Cl1ck OK 

4 ClickOK 

5 Select the members and joints you want to rephcate. 
6 On the Ed1t menu, click Rephcate. This will display the Replicate d1alog box with the Linear, Radial and 

Mirror Tabs. 

7 Click on the Radial Tab. 
8 Check the ax1s about Wh!Ch the selected entitJes are to be rotated, i.e. X, Y or Z m the Rotate About secf1on. 

9 Type in the íncrement angle and the number of t1mes you want the selected ent1t1es replicated m the 
lncrement Data box. 

10 Click OK. 

EXAMPLE: 

Replicate by Using the Mirroring Option 
Select the members and JOints you want to replicate. 

2 On the Edit menu, chck Rephcate. Th1s w111 display the Replicate dlalog box w1th the L1near, Radial and 
M1rror Tabs. 

3 Ciick on the M1rror Tab. 

4 Check the plane about which the selected entít1es are to be rotated, J.e. XY, YZ or XZ. 1n the M1rror About 
section. 

5 Type in the ordinate by wh1ch you want to shlft the mirrored rephcation 1n the Ordínate section. 

6 Click OK. 

EXAMPLE: 
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Merge Joints 
Jo1nts withm the default Auto Merge ToJerance are automat1cally merged. Those Jo1nts which fart outside this tolerance 
may be merged as follows: 

Select the Jomts you want merged. 

2 On the Ed1t menu click Merge J01nts ... This wlll display the Merge Selected Jomts d1alog box. 

3 Accept or change the Merge Tolerance. 

4 Click Ok 

Hints: Th1s is a very useful command for merging two separate models together. 

lf elements are drawn with Snaps turned off there may be extraneous jornts at common locat1ons. 
These extraneous Jomts may be easily elrminated by th1s command. 

Models developed 10 CAD programs may have beam ¡ornts drawn 6 rnches or so away from column 
jornts. Th1s 1S a powerful option to merge beam ¡oints to column ¡omts in such models imported from 
CAD. 

Automatic Meshing 
lt rs not necessary to define Jornts pnor to defining elements. Joints are automatrcaUy created when elements are 
drawn TyprcaUy, draw the boundary of your structure and then use the foUowrng meshrng technrques to create a 
detarled model. 

What do you want to do? 

2'!1 Divide or Break Frames 

~ Mesh Shells 

~ Jorn Frames 

~ Merge Jornts 

2!1 Disconnect 

2!1 Connect 

2!1 Show Duphcates 

Divide or Break Frames 
To Divide 

1 Select the Frame Elements you want divrded. 

2 On the Edrt menu click Divrde Frames ... Thrs will drsplay the Drvide Selected Frames dralog box. 

3 Select Divide rnto option. 

4 Type rn the number of elements the Frame Elements should be drvided into. 

5 Type in the ratro of the Jast element to the first. tf the drvisron rs not to be rn equal Jengths. 

6 Chck OK. 

To Break 
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• Select the Frame Elements you want to break into multiple elements and also select the intersectrng 
Elements or Joints. 

2 On the Edrt menu clrck Divrde Frames .. Thrs will drsplay the Divide Selected Frames dialog box. 

3 Select Break at mtersectrons with selected Frames and Jomts optron. 

4 Click Ok 

EXAMPLE: 

Mesh Shells 
To Mesh 

1 Setect the Shell Elements you want meshed. 

2 On the Edil menu clrck Mesh Shells. Thrs wdl drsplay the Mesh Selected Shells dialog box. 

3 Select Mesh mto option. 

4 Type in the number of elements ( in both drrections ) the Shell Elements shoutd be meshed mto. 

5 CilckOK. 

To Mesh using selected Joints on edges 

1 Select the Shell Elements you want meshed into multiple elements and .al§..Q setect the Joints on the edges 
of the Shelt Elements. 

2 On the Edrt menu click Mesh Shells Thrs will drsptay the Mesh Selected Shells dialog box. 

3 Select Mesh usmg selected Jomts on edges optron. 

4 Ciick Ok 

To Mesh using grld intersections 

1 Select the Shell Elements you want meshed rnto multiple elements. 

2 On the Edit menu chck Mesh Shells This will drsplay the Mesh Selected Shells d1alog box. 

3 Select Mesh at intersectron w'rth gnds. 

4 Ciick Ok 

Note: In arder for the mesh usmg selected Jornts on edges to work you have to have an equal number of 
jomts on the opposrte edges. Also, rf both sides are not drvrded thrs optron will not work. 

Join Frames 
1 Select the Frame Elements you want JOined. 

2 On the Edit menu click Join Frames. 

3 This wrll JOin the selected Frame Elements into a smgle element and remove unused JOrnts left over from the 
JOining process. 

Disconnect 
All elements connected to each other normally share a common Joint. Drsconnect will break off the Elements from the 
Jornt and will add dupJ1cate Jomts to each of those Elements. To use Drsconnect 
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1 Setect the Jo1nts you want d1sconnected from the Elements. 

2 On the Edit menu ct1ck 0Jsconnect. 

Hlnts: ThJs is a very usefut command for sorne special modehng condJtJons. 

Th1s feature adds separata jomts to Elements shanng common Jomts. After the Joint 1s 
disconnected special Constraints may be added to those Jomts. e.g. You coutd use th1s feature to 
specify moment ralease Constramts between two adjacent edges of Shell etements or if you need 
to add a zero length non-lmear tmk you would need separate Jo1nts at the same tocatJon. 

Connect 
Connect faciiJtates re-connectmg art seiected elements which had been d1sconnected from each other and were 
connected to their own mdependent Jomts. When Elements are connected back to each other the Jndependent Joints 
are coltapsed toa common joint which is shared by all the combmed Etements. To use Connect 

1 Select the Etements you want connected to each other. 

2 On the Edlt menu ciJck Connect. 

Show Duplicates 
Th1s JS a useful command to select duphcate Joints, Frames, Shells, AS OLIO and SoiJds from the ent1re structure. lf 
the dupl1cates are unnecessary they may be deleted or merged. 

1 Select the Jo1nts and or Elements. 

2 On the EdJt menu cllck Show Dupticates. 

3 DupiJcate Joints and Elements will be re-drawn with a different color. J 

Joint and Element Labels 
SAP2000 automatJcaily Jabets JOINTS, FRAME and SHELL elements. However, 11 JS possible to initialize a labellng 
scheme orto change la beis after they have been ass1gned. 

What do you want to do? 

~ lnitialize a New labeling Scheme 

~ Re-Label Prev1ousty Ass1gned Labets 

Re-Label Previously Assigned Labels 
The labets m SAP2000 are atphanumeric. lt is possible to setect sorne Jomts and Etements and changa their labels by 
assigmng them another tabelmg scheme. 

To Change Labels: 

1 Select the Jomts and Elements (FRAME and SHELL) for wh1ch you want to changa the la beis. 

2 On the Ed1t menu, chck Changa Labets .. ThJS will d1sptay the Re-Label Selected ttems dialog box. 

3 In the Re-Label Selected Jtems d1alog box 

• Enteran alphanumenc prefix, the starting numeric number for the scheme to be added to the prefix and a 
numenc increment for the numenc sequence for Jomts, Frames and Shells 

• Click on the Jo1nt, Frame and/or Shell check boxes to further select wh1ch type of members w1th1n the total 
selectJon will be affected by the label change. 

• Select the first and second Re-Label arder from the drop down boxes. See exampte betow. The Jabets 
have been changed to add an alpha prefix and have been sorted first by X and then by Z. 

4 Click OK. 
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• 
VIEW MENU 

Select 3-D Views 

Jt rs sometrmes helpful to vrew the model rn 3-D views. 1t is possible to chose a qurck 30 view by clickrng on the fSI 
button m the Toolbar. 

Setting 3-D View 

1 On the View menu, click Set 30 View ... This opens the 30 Vrew dialog box. 

2 Click the appropriate Fast Vrew button. 

3 Use the up/down scroll buttons or enter values rn the text edit box for the Plan, Elevation and Apertura. 

4 Clrck OK when finished. 

Note: You can vlew the model orientation rn the Vrew wmdow in the top left cerner of the 30 Vrew dralog 
box. 

Tips: You can save Irme by savrng 30 vrews by assignrng them names and then recalhng them later. 
Vrews may be saved through the Vrew menu under Save Named Vrews. 

Also See 

~ Select 20 Vrews 

Select 2-D Views 
lt rs sometrmes easier to build a model while workmg in 2-D elevatJon or plan views. 

Select an X-Y, X-Z or Y-Z Plane 

1 On the V1ew menu, click Set 20 V1ew ... This opens the 20 V1ew dialog box 

2 SeJect the X-Y, X-Z or Y -Z plane. 

3 Fill in the edit box with the appropnate Z, Y or X coordmate or click on a relevant plane within the w1ndow 
show1ng an out11ne of the model. 

4 Chck OK. 

Note: 11 is also possible lo choose aplane ~y rc~rng on one of lhe 20 view buttons lt ~ 1 ~ 1" 1/ and then 

using the up or down arrow buttons -o .o. to move to an appropriate plan e. 
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You can use rubber band zoom to zoom into the w1ndow showing the outl1ne of the model. Clickrng once anywhere 
rn the window wrJI restare the ongmal vrew 

Tips: You can save t1me by savrng 20 views by ass1gnrng them names and then recalllng them later. 
V1ews may be saved through the V1ew menu under Save Named V1ews. 

Also See 

~ Select 3D V1ews 

Set Elements 
Settrng Elements allows you to select1vely display various optrons assoc1ated wrth the elements. Use th1s method to 
selectively d1splay various element types, assoclated elementiD numbers and element sectron prooerty types, labels 
and extrusions. You can also suppress element. element fills or shnnk the elements about their correspondmg 
centroids to enhance the danty of the display. 

1 

2 

On the V1ew menu, cl1ck Set Elements or press the ~ button on the toolbar. Thrs will brrng up the Set 
Elements dialog box. 

In the Set Elements dialog box: 

• Check the options to be activated using the check boxes. Check the Hrde under each element's category if 
you don't want any of the elements and 1ts opt1ons VISible. 

• Check Shnnk Elements if you want the elements shrunk rn s1ze to 1mprove v1ew1ng of the model orto 
check element connectiv1ty. You can also do thrs from outs1de the Set Elements d1alog box by press1ng the 

~ button on the toolbar. 
• Check Show Extrusions if you want to see the frame element sectron shape on the screen. This can help 

in seerng 1f the member rs onented properly. 
• Check Fill Elements to see the elements shaded 1n as opposed to transparent. 
• Check show edges to see the ouUrne of the elements. 
• Clrck the OK button to update the actrve screen. 

Note: You Set Elements for mdivrdual windows not for the full model. So you can use this method to vrew 
d1fferent rnformatron in each wmdow. 

Set Limits 
Use Set Umrts menu when you do not want the whole structure to appear 10 the drsplay. This opt1on allows you to 
select1vely d1splay portrons of the structure by defining lrm1ts on the X, Y and Z axes vlewing range. 

1 On the Vrew menu. cllck Set Limits. Thrs will bring up the Set Limits dralog box. 

2 In the Set Lrmits dralog box. 

Note: 

Method 1 

• Click on each of the XY, YZ and XZ planes. 

• Us1ng the mouse, draw a box around the area you want to view rn the vrewing screen that appears 
rn the top left comer of the dialog box. 

• Note that the lrmits of the box you define will be reflectad in the Max and M in range for the 
correspondrng Ax1s Lrm1ts at the bottom of the screen 

Method 2 

• 
• 
• 
• 

Altemately drrectly enter in the Max and Min Axis Lrmits for the X, Y and Z axes . 

Click the Show All button to reset the fuU vrew for the correspondrng axis . 
Checkrng the Ignore Lrm1t Settings allows you to view the full structure without resetting the 11m1ts . 
Click OK. 

You can also use from the Vrew menu the Show Selectron Only option to v1ew only the members 
that you have selected. Use the Show All option to go back viewrng all the elements in the model. 
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• 
DEFINE MENU 

Define Materials 
On the Define menu, ctick Matenals .. This will dtsplay the Matenats diatog box wtth default matenats, 
CONC, OTHER and STEEL hsted m the Materials ltst box. 

What do you want to do? 

~ Add a New Steel Material Type 

...!!] Add a New Concrete Material Type 

2!J Add a New Other Matenal Type 

Add a New Steel Material Type 
To Add a New Steel Material: 

1 In the Matenals diatog box, cJick on Add new Material button. Thts will dtsplay the Material Property Data 
box. 

2 In tne Materral Property Data box 

• Choose Steel from the Destgn Type drop down hst. 
• Enter the Matenal name m the Matenal Name edtt box or accept the default name. 
• In the Analysts Property Data area, enter new values for Mass per unit volume, Weight per unit vofume, 

Modutus of Etasticny, Potsson's Ratto and Co-efficient of thermal expansron, rfthe default values are not 
acceptable. 

• ln the Design Property area, enter the value for Steel yield stress, fy or accept the default value. 
• Click OK. 

3 The new Material Name will be added to the Matenals lrst box. 

4 To Delete or Modify/Show Matenal, chck on the material rn the list box and then click on the Modify/Show 
Material or Delete Material button. 

5 Cl1ck OK. 

Add a New Concrete Material Type 
To Add a New Concrete Material: 

1 In the Materials dralog box, click on Add new Material button. This wrll display the Material Property Data 
box. 

2 In the Matenal Property Data box 

• Choose Concrete from the Desrgn Type drop down ilst. 
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• Enter the Matenal name in the Matenal Na me ed1t box or accept the default name. 
In the Analys1S Property Data area. enter new values for Mass per unlt volume. We1ght per umt volume, 
Modulus of Elastfc¡ty, Po1sson's Ratro and Co-effic1ent of thermal expansron, if the defautt values are not 
acceptable. 

• In the Oes1gn Property area, enter the value for Reinforcíng y1eld stress (fy), Concrete strength (fe). Shear 
steel y1eld stress (fys) and Concrete shear strength (fes) or accept the default values. 

• Cllck OK. 
3 The new Materral Name will be added to the Matenals l1st box 

4 To Delete or Mod1fy/Show Matenal, click on the matenal m the l1st box and then cl1ck on the Mod1fy/Show 
Material or Oelete Material button. 

5 Cl1ck OK. 

Add a New Other Material Type 
To Add a New Other Material: 

1 In the Matenals d1alog box, c11ck on Add new Matenal button. This wrll display the Material Property Data 
box. 

2 In tne Matenal Property Data box 

• Choose Other from the Des1gn Type drop down l1st 
• Enter the Matenal name rn the Material Name edil box or accept the default name. 

In the Analys1s Property Data area. enter new values for Mass per un1t volume, We1ght per un•t volume, 
Modulus of Elast•c•ty, Po1sson's Rallo and Co-efficfent ofthermal expansion, if the defautt values are not 
acceptable. 

• Chck OK. 
3 The new Matenal Name w11J be added to the Materials hst box. 

4 To Delete or Mod1fy/Show Material, click on the matenaJ rn the hst box and then click on the Modffy/Show 
Matenal or Delete Matenal button. 

5 Click OK. 

Define Section Properties 
Sect1on properties may be defined at any time befare they are ass1gned to elements. 

What do you want to do? 

~ Jmport a Frame Section from the Section property file 

~ Add a Frame Section by defin1ng the dimensrons and or propert1es manually 

~ Add a Nonpnsmatic Frame Sectfon 

~ Add an Auto Setect Frame Group 

~ Add a Shell Section by definmg the d1mensrons and/or propert1es 

~ Add an NLLink Property 

Define Frame Section Properties 
Sect1on propert1es may be defined at any time befare they are assigned to elements. The define trame sectfon d1alog 
box 1s composed of a l1st of defined sect1ons, a drop down llst of sectrons that can be 1mported and a drop down trst of 
sect1ons that can be added by defining their d1mens•ons There are also two buttons, one to Modlfy/Show Sect1ons and 
one to Delete sect1ons. 

What do yo u want te do? 

2H lmport a Frame Sect1on from the Sect1on property file 



• ~ Add a Frame Sect1on by defrning the d1menslons and or properties manually 

~ Add a Nonpnsmatic Frame Section 

2!J Add an Auto Select Frame Group 

lmport a Frame Section from the Section property 
file ( e.g. Sections.pro) 

1 On the Oefme menu, clrck Frame SectJons ... Th1s will display the Frame SectJons d1alog box. 

2 In the Frame Sect1ons diatog box ctJck on the lmport drop down button and choose rmport1ng IJ'IN¡de Flange 
or Channel, Tee, Angle etc. Th1s Wllf display the SectJon Property File setection box. 

3 Choose the file name from the Sectton Property File selection box. 

4 Click Ooen. This will display a multipte select1on hst box. 

5 Select one or more sections from the list box: 

• CJ1ckmg on a sect1on name will select only that sect1on. 
• Clicking on a sect1on name and dragging the mouse to other sections will selecta range of sections 
• Press1ng the Ctrl key and click1ng on different sectrons will select all of those sectrons. 

6 Click OK. Thrs wrll drsplay a Secllon Property form that shows the physical shape and drmensrons of the 
sectron. 

7 The lrst of selected sections will appear in the Section Name drop down frst box. 

8 You can contrnue to load other sect1ons by pressing the lmport button wh1ch will drspfay the multrple 
selection Jrst box. 

9 Jt rs possible to fook at the section properties by clrcking on Sectron Propertres. 

10 You can modify the sect1on propertres by pressing the Modrficatron Factors button. There you can changa 
the default factor of 1 that the section properties are multlphed by. 

11 Click OK to accept all the selected sect1ons. 

12 The new sectron names w1ll be added to the Name lrst box. 

13 To Oelete or Mod1fy/Show Sectron, dick on the Section name 1n the list box to select 1t and then cllck on the 
Mod1fy/Show Section or Oelete Sect.on button. 

14 Chck OK. 

Add a Frame Section by defining the dimensions 
and or properties manually 

On the Oefrne menu. chck Frame Sections ... This will display the Frame Sections dialog box. 

2 In the Frame Sectrons d1alog box chck on the Add drop down button and choose Add lfv'Vide Flange or 
Channel. Tee, Angte etc. by double clicking on one of the section types. This will d1sptay a Sect1on Property 
fonn that shows the physical shape and dimensions of the section. 

3 Enter the section name or accept the default name. 

4 Enter the physical d1mensions of the section or accept the default values. 

5 Choose the matenal type ( e.g. Steel, Concrete or Other) from the Matenal drop down list box. For Concrete 
sectlons se e below. 

6 1t is possible to look at the section properties by clicking on Sectlon Properties. 

7 You can modify the sect1on properties by pressing the ModificatJon Factors button. There you can changa 
the default factor of 1 that the sectron propert1es are multiphed by. 

8 Clrck OK to accept the selected section. 

9 The new seci!On name will be added to the N ame list box. 

10 To Delate or Mod1fy/Show Section, click on the Section name 10 the list box to select it and then cfick on the 
Mod1fy/Show Section or Oelete SectJon button. 

11 Cl1ck OK. 

Concrete Section 

For concrete sect1ons you wHJ need to also perform the followmg steps: 
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When you selecta Concrete matenal type. an addltional Reinforcement button wm appear at the bottom of 
the form. Click the Reinforcement button. 

• In the Re1nforcement Data dialog box, select Element Class e.g. Column or Beam. 
For Columns 

• 
• 
• 
• 

Select the Configuratlon of Remforcement e.g. Rectangular or Circular . 

Enter the Concrete Cover in the text edil box . 

Enter the Number of Bars m the 3~Direct•on 1n the text edil box . 

Enter the Number of Bars m the 2~D1rect•on m the text edil box . 

D . 
• 

Example of Concrete Column 

3 bars 1n the 3-Direction 

2 bars in the 2~01rect1on 

• 
• 
• 

lf Circular Remforcement Configuration JS selected then enter total number of bars . 

Select and Enter the Area of 1 Bar or 

Select Design Area of Steel for SAP2000 to automatically find the area of steel reqUired during 
des1gn mode. 

For Beams 
• Enter the T op and Bottom Concrete Cover m the text edJt boxes. 

• lf you want to specify top and bottom steel, enter remforcement area for the sect1on rn the 
appropriate text edil box. Otherw•se leave values of zero for SAP2000 to calculate the 
re1nforcement automatrcally. 

Click OK to return to the Sect•on Defin•t•on form. 

Add a Nonprismatic Frame Section 
On the Define menu, click Frame Sections ... This will dJsplay the Frame Sect•ons d1alog box. 

2 In the Frame Sections d1alog box click on the Add drop down button and choose Add NonprismatJc. Th1s w•II· 
d1splay the NonpnsmatJc Section Defin1tions form. 

Note: There must be al leas! two trame sections already defined for the Add NonpnsmatJc option to show 
in the add dropdown list box. 

3 Entera name for the NonprismatJc sect•on if the default na me 15 not acceptable. 

4 Select from the drop down list box of airead y def•ned trame sect1ons. the Start Section and End Section for 
the Nonpnsmatic member. These can both be the same sect•on. 

5 Enter the Jength of the sect1on and Absolute Length Type or enter the Length ratio and Variable Length 
Type. 

6 Select the El variation in the 2-2 and 3-3 d1rections. 

7 Press the Add button to add the sect•on to the list. 

8 Use the lnsert, Modify and Delete buttons to edJt the NonpnsmatJc section. 

9 Press the OK button when finished. 

Note: You can add more !han ene pa1r of trame secllons to build the Nonpnsmat1c sect1on. By entenng 
Absolute lengths (defined 1n the current units) you can define sections that are of flxed length. Then 
the sect1ons defined as Vanable Length Type will be extended between the fixed sectJons. The 
Vanable Length value 1s the rat1o of the length of the sect•on relatJVe to all the vanable length 
sect1ons defining the Nonprismat1c member. E.g. if there are two Vanable Length sectiOns with 
lengths of 1 and 2, the sect1on w1th length 1 wlll be 1/3 of the total vanable Jength, and the section 
with a length of 2 will be 2/3 of the total vanable length. 

This method of defining Nonpnsmat1c secllons can be uSed to define sect•ons that have top and 
bottom fixed length Nonpnsmat1c sections with a pnsmat•c sect1on defined between them, hke a 
bridge pier, where the pnsmallc part of the sect1on can ''telescope" to flt the space between the 
fixed ends. 
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• Add an Auto Select Frame Group 
Auto Select section is a list of frame sectrons that are used for domg steel optrmrzatron design. SAP2000 will use the 
average properties of all the sectrons rn the group for the first analysrs run. Then selecting Start Desrgn/Check of 
Structure wdl desrgn each frame member ass1gned toan Auto Select group wrth the hghtest sectron rn the Auto Select 
group that satisfies all the stress checks. Then selectrng Update Analysrs Sectrons wrll make the selected sectlon from 
the Auto Select group the new analysrs sectron. 

On the Define menu, click Frame Sections ... Thrs will drsplay the Frame Sectlons dralog box. 

2 In the Frame Sectrons dialog box click on the Add drop down button and choose Add Auto Select. Thrs will 
drsplay the Auto Setect1on Secbons form. 

3 Entera na me for the Auto Setect section 1f the default name is not acceptable. 

4 Select and Add sect1ons from the Ust of Sect1ons to the Auto Selectlons Llst. 

5 Cl1ck OK 

Add a Shell Section by defining the dimensions 
and 1 or properties 

1 On the Define menu, click Shell Sections .. This will display the Shell Sect1ons d1alog box. 

2 In the Shell SectJons d1alog box click on the Add New Secl1on button. Th1s w111 d1splay Shell Sect1ons Data 
dJalog box. 

3 In the Shell Sections Data dJalog box 

• Enter the Section Name or acceptthe default name. 
• Select the material type by clickJng on the Matenal drop down box. 
• Enter the Membrane and Bend1ng Th1ckness. 
• Choose the shell type to be Shell, Membrane or Plate. 

CJ1ck OK. 
4 The new sectJon name will be added to the Shell SectJons hst box. 

5 To Delete or ModJfy/Show Section, c1'1ck on the SectJon na me m the l1st box to select it and then chck on the 
Modify/Show SectJon or Delete Section button 

6 Chck OK. 

Add an NLLink Property 
1 On the Define menu, cl1ck NLL1nk Propert1es ... This will d1sptay the NLLink Properties dialog box. 

2 In the NLLink Propert1es d1alog box chck on the Add New Property button. Th1s w1ll display NLL1nk Property 
Data d!alog box. 

3 In the NLLmk Property Data dialog box 

Enter the Propeny Name or accept the default name. 
• Select the Property type to be Damper, Gap, Hook, PlastJc1 , lsolator1 or lsolator2 by clicking on the 

Type drop down box. 
• Enter the Mass, We1ght and RotatJonar !nenias 1n the ed'Jt boxes. 
• Choose the appropriate d1rectrons (U1 ,U2,U3,R1 .R2.R3) for th1s property by clickmg the check boxes and 

also choose whether it is non linear or not. 
• OJrectJonal properties such as Stiffness, Damp1ng. Y1eld Strength, Post Y1eld Stiffness Ratio and 

exponents etc. may be specified by chck1ng on the ModJfy/Show Properties button. 
• Cl1ck OK. 

4 The new section name wlll be added to the Nllmk Props tist box. 

5 To Delete or Modify/Show Property, chck on the Property name in the l1st box to select it and then click on 
the Modify/Show Property or Delete Property button. 

6 Click OK. 
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Define Group Names 
Defining Groups is a powerful toolm SAP2000. lt helps in se1ect1ng elements, d1splaying and printing results as well as 
helprng w'1th des1gn. 

On the Define menu, cl1ck Groups ... This will d1splay the Define Groups dialog box with default Group ALL 
llsted rn the Groups list box. 

2 To add a new Group, type in the new name in the Groups edJt box and then chck the Add new Group Name 
button. 
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3 To Change or Delete a group na me. chck on the Group name in the Jrst box to select it and then click on the 
Change Group N ame or Delete Group Name button. 

3 Click OK. 

Also see: 

.!d Assrgn Group Names 

Define Static Load Cases 
1 On the Define menu. dick Static Load Cases ... Thrs will d'rsplay the Static Load Case Na mes d1alog box with 

a default load Case, LOAD1 listed m the Loads hst box 

2 T o add a new load Case na me 

• Type in the new name m the Load ecilt box 
• Choose the load type to be Dead, Uve, Quake, Wmd, Snow or Other trom the Type drop down hst 
• Type rn a self·weight multiplrer m the edit box and 
• Click Add new Load button. 

3 To change a Load Case name cilck on the name in the Jrst box and then type over the changes 1n the ed1t 
boxes or choose a different Load Type from the drop down list and click Change Load button. 

4 To delete a Load Case name dick on the name m the list box and chck Delete load button. 

5 Click OK. 

Tip: Load Case names defined here are used in Load Combrnatrons. Load Case Types are used by 
SAP2000 to develop automatic load combinatrons for Desrgn/Stress Check of the structure. 

Bridge Analysis 
The bridge analysis can be used to compute influence lrnes for traffic on bndge structures and to analyze these 
structures for the response due to veh1cle hve loads. The vehicle hve Joads can be combrned with static and dynamic 
loads and envelopes of the response can be computed. 

Drsplacements, spring torces and Frame.etement internal torces can be determinad dueto the influence of Vehicle live 
Joads. Other element types (Shell, Plane, Asohd, Salid and NLUnk) may be used; they contnbute to the stiffness of the 
structure, but they are not analyzed for the effects of Vehicle toads. 

You may select Vehicle lrve loads from a set of standard highway and railway Vehrcles, or you may create your own 
Vehrcle live loads. 

What do you want to do ? 

~ Define Lanes 

~ Assrgn FRAME Lanes 

..?!f Define Vehrcles 

~ Define Vehrcles Classes 

~ Define Bndge Response 

~ Define Movrng Loads 

..!!J Define Jornt lnfluence lrnes 

~ Display Frame lnfluence Unes 

Define Lanes 
This information rs needed to define the traffic Lanes that are requrred for bndge moving.Joad analysis. Frame 
elements are used to represent the traffic Lanes. 

1 On the Define menu, cfrck Movrng Load Cases ... lanes ... This will display the Define Bndge Lanes d1alog 
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• bOX . 

2 Cllck Add new Lane button. Th1s wil! display the Lane Data dtalog box. 

In the Lane Data d1alog box 

HINT: 

• Enter the Lane Name or acceot the default name. 
lf you want to define the lanes exphcltly: 

• Enter the Label of the Frame representing the lane in the ed1t box 

• Enter the d1stance of the Lane (tn the curren! length umts) from the Frame representlng the Lane in 
the Eccentnc1ty ed1t box. 

• Press the Add button to add the new lane. 

• Cl1ck OK when you are fin1shed addmg frame members to the lane. 

lf you want to define the lanes through the graphlc interface by Assrgnmg Lanes: 
• Click OK to just add the tane name to the hst of lanes. 

You can use the lnsert button to 1nsert a new Lane above the selected Lane 

3 The new Lane name wl!l be added to the Lanes llst box. 

4 To Delete or Mod1fy/Show a Lane, select 11 from the Lanes l1st box and then cl1ck on the Modify or Delete 
Lanes button. 

5 Clíck OK. 

Note: The trame members denoting the Lane should be nearly cont1guous and progress m a cons1stent 
long1tudmal d1rect1on In the same way that a real lean on a road would be defined. 

Also see: 

~ Ass1gn FRAME Lanes 

Define Vehicles 
This informat1on defines the Vehicle loads that are required for bridge movmg-load analysis. 

On the Define menu, ciJck Moving Load Cases .. Ve hieles ... Thts w111 display the Define Vehtcles d1alog box. 

To Add A New Standard Vehlcle 

1 Chck Add new Standard Vehicle from the drop down hst box. This will display the Standard Ve hiele Data 
d1atog box. 

In the Standard Veh1cle Data dialog box 

• Select the Veh1cle type from the drop down hst. 
• Oependmg on the selected vehicle you may be requrred to entera Scale Factor or Dynamic Allowance 1n 

the appropriate ed1t box. 
• CJick OK. 

2 The new Vehicle name witl be added to the Vehicles ltst box 

3 To Delete or Mod1fy/Show a VehJcle, select 11 from the Veh1cles l1st box and then click on the Modify or 
Detete Lanes button. 

4 Click OK. 

To Add A New General Vehicle 

1 Chck Add General VehJcle from the drop down hst box. This will display the General Vehicle Data d1alog box. 

In the General Vehicle Data dialog box 

• Enter the Vehicle Name or accept the default name. 
• Select what the Vehicle will be used for 1n the Usage area. More than one usage can be selected for a 

Veh1cte. 
• Enter uniform and first axle load values 1n the Leading and Tra1ling Loads are a. 
• Enter Float1ng Axial Load Values by selectmg 9/ther a S1ngle Valued Axle ora Double Valued Axle with 

separate values for Lane Moments. 
• Enter tntermediate Loads. 
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• 
• 

Enter Uniform load between axles •n the ed1t box . 

Enteran Axle load m the edit box . 

• Entera M•n•mum and Max1mum Distance between the current and prev1ous axle. 

• Press the Add button to add the axle mformat•on. 

• Click OK. 
Note: A value of Zero for Max Distance •ndJcates an infinita dJstance. Only one 1ntermed•ate axle may 

have a value of Max D1stance > M in 01stance. The remammg •ntermed1ate axles must have a value 
of Max Dtstance = M1n D1stance. 

2 The new Vehicle name will be added to the Vehicles l1st box. 

3 To Delete or Modify/Show a Veh1cte. select it fromthe Vehicles list box and then cl1ck on the Modrfy or 
Delete Lanes button. 

4 CIICk OK. 
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Define Vehicle Classes 
This 1nformation is needed to define the Vehicle Ciasses or groups that are used to perform the bndge moving-
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load analysrs. The arder in whrch the Vehrcles are assigned to a Vehrcle class are not rmportant. The Lanes 
assrgned to the Vehrcle dass will be checked for each Vehicle in that Vehicle Ctass. 

1 On the Define menu. chck Movrng Load Ca~es ... Vehicle Classes ... Thrs wiiJ drsplay the Define Vehicle 
Classes dialog box 

2 Chck Add Class button. This wriJ drsplay the Vehicle Class Data dralog box. 

In the Vehicle Class Data dratog box 

• Enter the Vehicle Class Name or accept the default name. 
• Selecta Vehicle Name from the drop down lrst box. 
• Entera Scale Factor for the Vehrcle rn the edit box. 
• Press the Add button to add the Vehrcle. 
• Click OK when you are finrshed adding Vehicles to the Vehrcle Class 

3 The new Vehicle Class name will be added to the Classes lrst box. 

4 To Delete or Modrfy/Show a Vehicle Class, select rt from the Classes lrst box and then chck on the Modrfy or 
Delete Lanes button. 

5 CIJckOK. 

Define Bridge Response 
Thrs rnformatron is needed to allow you to setectrvely control what rnformatron is calcutated for JOints and frame 

elements in the computatronally intensrve moving-load anatysrs that rs performed 

1 On the Define menu. clrck Movrng Load Cases ... Bridge Responses ... This w.tl drsptay the Bridge 
Response Requests dralog box. 

2 Check each of the response categones for which you want analysrs done 

• From the Select Group drop down list choose the group for which you want the responses computad. The 
default rs ALL 

3 Under the Method of Calcutation select Exact or Refinement Level and entera value rn the text input box. 
The value entered can be any posrtrve rnteger. Thrs feature rs provided to grve the user a fast analysrs option 
for prehminary anatysrs. The larger the rnteger the greater the Jevel of refinement. The recommended 
Refinment Levels rntegers are 1 to 4. 

4 Check Calculate Correspondence Values for Frames if you want to use the MaX/Mrn Correspondence rn 
your desrgn of trame sectrons when usrng movrng toads. Thrs rs a very trme-mtensive operatron so you are 
advísed to only use it when rt rs requrred. 

5 Cl1ckOK. 

Define Moving Loads 
This informatron defines the Moving Load cases that determrne the response to the Vehicles rn the Vehicle Classes 
movrng a long the traffic Lanes. 

1 On the Define menu, click Movrng Load Cases ... Moving Load ... This wil! drsplay the Define Moving Load 
Cases dialog box 

2 Click Add Load button. This will drsplay the Movrng load Cases Data dralog box. 

In the Moving Load Cases Data diatog box. 

HINT: 

• Enter the Moving Load Case Name or accept the default na me. 
• Entera Scale Factor for each of the Number of Lanes combrnatrons selected from the drop down lrst box. 

Th1s number rs lrmrted by the number of lanes defrned rn the Lane Data dialog box. 
• Press the Add Assrgn button to assrgn a Vehrcle class to the Movrng Load Case. 

• In the Movrng Load Case Ass1gnment Data dialog box . 

• Select the Vehicte Ctass. 

• 
• 

• 
• 

Enter the Vehrcle Ctass Load Sea le Factor. 

Enter the Minimum and Maxrmum Number of Loaded Lanes for the selected Vehicle Class . 

A value of zero for Mimmum and Maximum Number of Loaded Lanes means include all the lanes . 

In the Assignment Lanes area Add the Lanes that the Vehrcle Class can be assrgned to . 

Chck OK . 
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• To ModJfy/Show a Veh1cle Class- Lane Ass1gnment, select 11 from the Assignment Number drop 
down llst box and press the Modify/Show Ass1gn button. 

• Add as many Veh1cle Class Lane Ass1gnments as required. 
• Click OK when fin1shed. 

3 The new Moving Load Case name witl be added to the Moving Loads l1st box. 

4 To Delete or Mod1fy/Show a Moving Load, select it from the Movmg Loads llst box and then chck on the 
Modify or Delete Load button. 

5 Cl1ckOK. 

Define Joint Patterns 
On the Define menu, chck Jo1nt Pattems ... This will d1sptay the Pattern Na mes dialog box w1th a defautt 
pattem, OEFAULT hsted m the Pattems list box 

2 To add a new pattem name type in the new name in the Pattems edil box and chck Add new Pattem Name. 

3 To changa a pattem na me click on the name 1n the list box and then type over the changes in the edit box 
and click Change Pattern Name. 

4 To delete a pattem name click on the name 1n the hst box and chck Oelete Pattem Name. 

5 Chck OK. 

Tip: Pattern na mes def1ned here are u sed m Assign Joint Pattems . 

Assign Dynamic Loads 
Dynamic Loads (as ground mot1ons) may be mput as Response Spectra or T1me H1stories. Time Histones may also be 
apphed as Jo1nt T1me Histones. 

What do yo u want todo? 

~ Define T1me Hlstory Func_hons 

~ Define Time H1story Cases 

~ Define Response Spectrum FunctJons 

~ Define Response Spectrum Cases 

Define Time History Functions 
On the Define menu, click T1me H1story Functions ... Th1s will display the T1me H1story Functions d1alog box 
with a bullt-m RAMP funct1on hsted in the Funct1ons hst box. 

To Define Function by specifying Time and Value: 

• Click Add new Funct1on button. This will display the Function DefinJtJon dialog box. 
• Entera paír of Time and Value ( acceleration, displacement or veloc1ty ) 1n the Define Functlon edit box 

and then chck Add. Th•s w111 add the pair to the list box. 
• Repeat to enter other pairs defimng the funct1on. 
• Clicking on a value m tne hst box selects it and then it is possible to e1ther modify or delete lt. 
• Click OK. 

To Define Function from File: 

• Click Add Funct1on from F1le button. Th1s wlll display the Time History Function Def1nition d1alog box. 
• Enter the function name m the Funct1on N ame ed1t box or accept the default name. 
• Click on the Open F1le button to selecta file. 
• Choose the file name from the Pick Function Data File selectJon box. 
• Cl1ck Open. 
• Enter the number of pomts defined per hne in the file. 
• Click to check if the function is defined at equal intervals oras pa1rs of time and function values. 
• lf the funct1on is defined at equal intervals then enter the time step 1n the edil box. 

37 

:': 



• CJ1ck OK 

2 The new Funct1on Name wiiJ be added to the Funct1ons hst box. 

3 To Delete or Modify/Show Functlon, select the functJon name trom the hst box and then click on the Show or 
Delete Functlon button. 

4 ClíckOK. 

Define Time History Cases 
1 On the Define menu, cJ¡ck Time History ... Th1s w111 diSplay the T1me History Cases dialog box. 

2 Click Add new History button. Th1s will d1splay the T1me H1story Case Data dialog box. 

In the T1me H1story Case Data dialog box 

• Enter the T1me Hislory Case Name or accept the default name. 
• In the Opl1ons area: 

• Choose Analysis Type to be Linear, Period1c or Non Linear from the drop down box. 

Cllck Modify/Show button to spec1fy Modal Damp1ng. 

• Enter the Number of Output T1me Steps 1n the ed1l box. 

• Enter lhe Output T1me Step s1ze 1n the edil box. 

• tf desired, choose the name of the Time History from which lhis T1me History should be started by 
cllcking on the Start From drop down hst. 

• In the Load Assignments area: 
• Choose the Load Case from the Load drop down box (acc dir 1 , acc dir 2_, acc dir 3 and LOAD1 

are llsted as default cases) 

• Choose the FunctJon Name from the Function drop down box (RAMP function is listed as default 
funct1on) 

• Enter the Scale Factor, Amval T1me and Angte of excitat1on d1rection m the edil boxes. The Angle is 
only available for base accelerallons and 1s turned off for Load Cases. 

• Click Add. Th1s will add a Load Assignment to the lis! box betow. 

To change or delete the definition of a Load Ass1gnment, select the assignmenl from the hst box 
and lhen click on the Modify or Detete button. 

Repeat to add more load ass1gnmenls lo make up a T1me History Case. 

• Click OK. 
3 The new T1me H1story Case name will be added lo the History Cases hst box. 

4 To Delete or Modify/Show H1story, select the history case from the J1sl box and then ciJck on the Modify or 
Delele H1story button. 

5 Cl1ck OK. 

Define Response Spectrum Functions 
1 On lhe Define menu, cl1Ck Response Speclrum Functions ... This will disolay the Response Spectrum 

Funct1ons dJalog box w1th built in UNIT, UBC94S1 , UBC94S2 and UBC94S3 funct1ons listed in lhe 
F unciJons hst box. 

To Define Function by speclfying Time and Acceleration: 

• Cfick Add new Funct1on button .. 
• Enter the function name in the Funct1on Name ed1! box or accepl the defaull name. 
• Enler a pa1r of Penad and AcceleratJon vafues 1n lhe Define FunctJon edit boxes and lhen click Add. This 

wifl add the pair to the list box. 
• Repeat lo enter other pairs defrning the function. 
• Cflckrng on a value in the list box selecls 11 and lhen 11 is possible lo either modify or defete it. 
• Cllck OK. 

To Defrne Functlon from File: 

• Cllck Add Function from File button .. 
• Enter the funct1on name in the Funct1on Name edil box or accept the default name. 
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• 
• 
• 
• 
• 

Cllck on Open Ftle button to selecta file . 
Choose the file na me from the Pick Function Data Ftle selectton box. 
Cl!ck Open . 
Enter the number of points defined per hne m the file . 
Chck to check 1f the functron ts defined at equal intervals oras pairs of Penad and Acceleratron values . 
lf the function ts defined at equat intervats then enter the Penad step in the edtt box . 
Click OK. 

2 The new Functton N ame will be added to the Functions list box 

3 To Delete or Modtfy/Show Function, select rt from the Functions ltsl box and then click on the Modify or 
Oelete Functton button. 

4 Click OK. 

Define Response Spectrum Cases 
On the Define menu, cltck Response Spectrum Cases ... Thts wtll dtsplay the Response Spectra dialog box 

2 Chck Add new Spectra button. Thts will display the Response Spectrum Data d1alog box. 

3 

4 

5 

In the Response Spectrum Data dlalog box 

• 
• 
• 
• 
• 
• 
• 

Enter the Response Spectrum Name or accept the default name 
Enter the exc1tat1on angle 1n the ed1t box . 
Choose the Modal Combinat1on Techmque by cllcking on e1ther CQC, SRSS, ABS or GMC . 
Enter the Damping ratio in the edit box. Th1s ratio is used for modal combination . 
lf GMC JS chosen then enter characterist1c frequenc1es F1 and F2 as defined 1n ASCE 4 for GMC . 
Choose the D1rectronal Combrnat1on Technrque by cllcking on either SRSS or ABS . 
In the Input Response Spectra area: 
• Seiect the Funct1on Names for U1. U2 and U3 dlrect1ons from the Function drop down boxes. Unrt 

funct1on JS the defautt built in functJon 

• Enter the Scale Factor for each functton rn the Scale Factor edtt box The default value 1s 1.0 

• Click OK 
The new Spectrum nañ1e Wlll be added to the Spectra hst box. 

To Delete or Modify/Show Spectra. select 11 from the Spectra hst box and then cllck on the Mod1fy or Delete 
Spectra button. · 

Click OK. 

Define Load Combinations 
On the Define menu. cl1ck Load Combina!Jons .. Thrs will display the Load Comb1nations d1alog box. 

2 To add a new Load CombJnatJon, chck Add new Combo button. Th1s wi!l d1splay the Load Combmation Data 
dialog box. 

In the Load Comb1natron Data d1alog box 

• Type in the combmat1on name rn the Load CombJnatJon Name ed1t box. 
• SeJect the Load Combmatron Type: ADD, ENVE, ABS, SRSS 
• Type m the t1tle (descnpt1on of load combo) in the Tille ed1t box. 
• Select an Analys1s Case name from the Case Name drop down l1st box and type rn the multiplier in the 

Scale Factor ed1t box and chck ADD. This will add the Anatys1s Case and the multipher to the hst box. 
• Simllarly select other Analysis Cases and add them to the list box to complete the Load Combmat1on 

definit1on. 
• lt 1s poss1ble to mod1fy or delete an Analysis Case from the Combrnat1on defin1tron by selecting the 

AnaJys1s Case from the list box and clickrng the Modify or Delete button. 
• Select whether the combo should be used as a part of the Steel or Concrete design loading combmations. 
• Click OK Thrs will add the Load Comb1natJon to the CombinatJons hst box. 

3 T o include the default des1gn load combmations for the code specified '" Concrete and Steel Preferences, 
chck on the Add Defaull Des1gn Combo Button. The program will add Steel design combos if the Steel 
Design rs selected in the Des1gn menu and Concrete des1gn combos if the Concrete Design 1s selected in 
the Design menu. The Type assignment for the Static Load Case 1s used to determine the appropnate load 
factors. 

4 To modrfy a Load Combinat1on, click on the name rn the Combmations lrst box to select it and then click: 
ModJfy/Show Combo button. Th1s wlll display the Load CombinatJon Data dJalog box. Make the appropriate 
changes and then cllck OK. 
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5 To delete a Load Combmat1on. click on the name 1n the CombJnatlons l1st box to select Jt and then chck 
Delete Combo button. Th1s w1ll delete the Load Combmat1on. 

6 Clrck OK. 

Tip: Load Combmat1ons defined here are used 1n Select Des1gn Combos to define design load1ng 
comb1nations. 
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DRAW MENU 

Draw Mode 

Click1ng on any of these buttons 1 crJ 1 .¡,j,!Oic:::J!I from the Floating Toolbar puts SAP2000 m the Draw mode. 

The Draw mode allows for drawing of new members and ed1bng ene element ora JOint at a t1me. 

Draw Mode is also the default mode when a NEW model Js started. 

Select vanous Draw options by cilck1ng as follows: 

To Draw or Edlt 

Ed1VShape/Move Element 

An extra or Special Joint 

A Frame Element Oornt to joint) 

Quick draw Frame Elements 

A Shell Element (jmnt to jo1nt) 

Quick draw Shell Elements 

Draw Members 
There are two ways to draw Elements: 

Do this 

Cllck on m and cllck on a jomt or Element. Use the 
handles to move or stretch. 

Click on lc::JI and click on any pornt to add a Joint 

Clickon GJ 
Cllck on EJl 
Click on l9J 
Click on 1@11 

Quick Draw a single click on a gnd segment (for FRAME) oran area bounded by four grids (for 
SHELL) will draw the element. The ESC key takes you out of the Oraw Mode and puts 
you in the Select mode. 

Joint to Joint Draw 

What do you want to do? 

a sequential drawrng of elements by clrckrng on previously defined Jmnts or pornts rn 
space. Double clrck on a jornt or pressrng ENTER termrnates the sequentral draw and the 
ESC key takes you out of the Draw Mode and puts you in the Select mode. 

~ Draw a Qurck FRAME Element 

2'H Draw a FRAME Element by clrcking on 2 Joints 
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~ Draw a Qwck: SHELL Element 

~ Draw a SHELL Element by chck:mg on 4 Jomts 

~ Draw an NLLJNK Element 

Reshape Element 
Reshape Element optron is used to edrt elemenl forms or shapes. Wrth lhe help of lhrs optron it rs possrble to m ove 
FRAME or SHELL eJements, stretch or shrrnk FRAME etements and reshape SHELL elements. To move or res ha pe 
an e!ement do the followrng: 

Add in 2-D 

1 On the Vrew menu. chck Show Gnds. This puts a check mark next to rt and works as a toggle to tum on or 
off the Gnds. 

2 

3 
4 

5 
6 

Select 2-D Plane in whrch you want to reshape the member. 

Chck on m to switch to Reshape Element mode. 

Click once on a FRAME ora SHELL element to select it. Thrs will drsplay the member end handles 

Grabbing one of the handles of the element and movmg it will stretch. shrink, rotate or reshape the etement. 

Grabbing the element { any pornt away from lhe handles ) and droppmg lt al another tocatron wllt atlow you 
to move the element. 

Add in 3-0 

In 3-D, the element editing works lhe same way as 2-D excepl that the hand!e may onty be dropped al 
another pre-defined JOJNT or Gnd mtersection. 

Note: Onty one Element ata Irme may be moved or reshaped through this optron. 

Add Special Joints 
In burJdrng a model in SAP2000 it rs not necessary to pre-define Jornts. The Jornts are aulomatrcally added to the ends 
or comers of the etements. Special Jomts are those Jornts whrch are added by the user. These Joints may be 
necessary 10 add in rare cases such as at one end of an NLLink Element - an end where there rs no other eJement 
present and hence no aulomatically generated Jmnt. To add a Specrat Jornt do the followrng: 

Add in 2-D 

1 On the Vrew menu, click Show Grids. This puts a check mark next to it and works as a toggte to turn on or 
off the Grrds. 

2 

3 

4 

Select 2-D PJane in whrch you want to add a Jornt. 

Ctrck on [J lo switch to Add Special Jornt mode. 

Chck on a Grid intersection or any other pornt in that plane to add a Jornt. 

Add in 3-D 

1 On the View menu, clrck Show Gnds. Thrs puts a check mark next to rt and works as a toggle to tum on or 
off the Grids. 

2 
3 

Chck on ICJ to SWitch to Add Special Jmnt mode. 

In the 3-D vrew, clrck on a Grid rntersectron lo add a Jornt. 

Note: The Joints may only be added at gnd intersections rn 3-D vrew. 
Right Chck on a Jornt will open Jornt lnformatron edtt box. You may edit the Joint Jocatron m lhis edrt 
box to Jocate the Jornt prectsely rn the desrred Jocauon. 
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• Draw a Frame Element from Joint to Joint 
Draw in 2-D 

2 

3 

4 

On the V1ew menu, click Show Gnds Th1s puts a check mark next to 1t and works as a toggle to turn On or 
Off the Gnds. 

Select 2-D Plane rn which you want to draw the member. 

Click on 8 to sw1tch to drawing a FRAME element between 2 polnts. 

Cllck on a Grid rntersect1on, a previously defined Joint or any prnnt 1n the plane. Cllck agarn on another po1nt 
to add a srngle FRAME element. Every subsequent chck will add another FRAME element unless a oouble 
chck on the same joint is performed or the ENTER key 1s pressed. Press1ng the ESC key will also terrmnate 
the sequential draw and take you out of the Draw mode. 

Oraw in 3-0 

2 

3 

4 

On the V1ew menu, chck Show Gnds. Th1s puts a check mark next to 1t and works as a toggle to tum on or 
off the Grids. 

Clickon ~ to sw1tch to drawmg a FRAME element between 2 pornts. 

In the 3-0 view click on a Grid intersectron ora prevrousty defined Jomt ( a small red baU appears to confirm 
that the jornt has been selected ). 

Click on another Grrd mtersect1on ora Jo1nt to add a FRAME element. Every subsequent click on a setected 
po1nt wiU add another FRAME etement untess a double click on the same JOmt 1s perfonned or the ENTER 
key is pressed. Pressing the ESC key wiU atso termínate the sequential draw and take you out of the Draw 
mode. 

Note: lt is not possible to draw a FRAME etement between any two arbitrary pornts rn space rn the 3-D 
view. 

Draw a Quick Frame Element 
Draw in 2-0 

2 

3 
4 

On the View menu, click Show Grids. This puts a check mark next to 11 and works as a toggle to turn On or 
Off the Gnds. 

Setect 2-D Plane in which you want to draw the member. 

CHck on GJ to choose the qu1ck draw mode. 

Ct1ck on a grid segment to draw a qu1ck smgle FRAME element. 
Clicking m a space bounded by 4 gnd l1nes will add a Cross Brace. 

Oraw in 3-0 

On the View menu, cllck Show Grids. Thrs puts a check mark next to rt and works as a toggle to tum On or 
Off the Grids. 

2 In the 3-D view click on a gnd segment. Thrs witl add a single etement between two grid intersections. 

Note: lt rs not possible to Quick Draw a Cross Brace in 3-D. 

Draw a Shell Element between 4 Joints 

1 

2 

3 

4 

5 

On the Vrew menu. click Show Grids. Thrs puts a check mark next to it and works as a toggle to turn on or 
off the Grids. 

Setect 2-0 Ptane rn whrch you want lo draw the member. 

Click on ~ to sw1tch to drawrng a SHELL element between 4 Joints. 

Clrck on a Grid intersectron, a prevrously defined Joint or any po1nt 1n that ptane. 

Click again on 3 other pornts e1ther ctockwrse or counterclockwise to add a SHELL element. 
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Note: lf you want to add a triangular element the fourth point cltcked should be the same as the first. 

Orawin 3-0 

1 On the Vtew menu, click Show Grids. Thts puts a cneck mark next to 11 and works as a toggle to tu~ on or 
off the Grids. 

2 Click on ~ to switch to drawmg a SHELL element between 4 Joints. 

3 In the 3-D view click on a Gnd tntersection ora prevtously defined Joint ( a small red ball appears to confirm 
that the p01nt has been setected ). 

4 Cltck on 3 other stmilar potnts either clockwtse or counterclockwrse to add a SHELL element . 

Note: lt is not possible to draw a SHELL element between any 4 arbttrary potnts rn space 1n the 3-0 vtew 

Draw a Quick Shell Element 
Oraw in 2-0 

2 

3 
4 

On the View menu, cltck Show Grids. Thts puts a check mark next to tt and works as a toggle to tum on.or 
off the Grids. 

Setect 2-D Plane in which you want to draw the member. 

Click on D to choose the qutck draw mode. 

Click in a gnd space, bounded by 4 grid l~nes, to draw a qurck single SHELL element. 

Oraw in 3-0 

Note: lt is not posstble to draw a Quick SHELL Element in 3-D view. 

Draw an NLLink Element 
Draw in 2-0 

On lhe Vtew menu. cltck Show Gnds. This puts a check mark next to tt and works as a toggle lo turn On or 
Off the Grids. 

2 Select 2-D P/ane in which you want to draw the member. 

3 On the Draw menu, click Draw NLLink Element. ThJS puts you 1n the non-linear hnk drawing mode. 

4 Cltck on a previousty defined Joint in thal plane. Chck again on another Joint to add a single NLUnk element. 
Click again on two Jotnts to add another NLLink element. Double clickrng on the same Jotnt will add a zero 
tength link element. ESC key will take you out of the NLLmk drawmg mode. 

Oraw In 3-0 

1 On the Vtew menu, cltck Show Gnds. Thts puts a check mark next to ti and works as a toggle to turn on or 
off the Grids. 

2 On lhe Draw menu, c/ick Draw Nlltnk Element. Thts puts you tn the non-linear link drawmg mode .. 

3 In the 3-D vtew, chck on a prevrously defined Joint (a small red ball appears to confirm thal the JOint has 
been selected ). Click again on another Jotnt to add a smgle NLLink etement. Click agarn on two Joints to 
add another Nlltnk element. Doubte cltcktng on the same Jomt wil/ add a zero length Jtnk elemenl. ESC key 
wi/1 take you out of the NLLink drawing mode. 

Note: 11 is not possible to draw an NLLtnk element between any two arbitrary pomts m space. The link 
element may only be drawn between prevtousty defined or generated Joints. 

Edit Grids 
After deftmng your coord1nate system you can edtt the location of the rndividual grids 1n the actrve coordinate system. 

1 On the Draw menu, chck Edil Grid or doubte cltck on a gnd lme rn the graphics screen. 
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• 2 In the Modify Grids dialog box. Select Oirect10n of the gnds you want to ed1t. 

3 In the locat1on area· 

To Move a Grid 

• Select the gnd locatJon from the llst. 
• Ed1t the grid's locaúon in the text edil box. 

Cl1ck the Move Gnd Une button. 

To Add a new Grid 

• Enter the grid's location in the text edil box. 
• Click the Add Grid Une button. 

lo Delate a Grid 

• Select the gnd locat1on from the list. 
• Cllck the Delete Grid Llne button. 

4 The Dele! e Atl button will delete all the gnds 1n the coordmate system 

5 Check the Lock Grid Ltnes 1f you want to lock the grid lmes from being moved usmg the method d1scussed 1n 

the note below. 

6 Check the Snap to Gnd lmes if you want the feature on 

7 Check Glue Jo1nts to Gnd L!nes if you want tne ¡oints to move with the gnds. Th1s 1s a very powerful way to 
qUJcldy ed1t the structure without having to redefine jo1nt locatJons. 

8 Cl1ck OK when fimshed. 

Note: From the display screen with the Reshape Element option set, you can add a new gnd hne by 
holding the CTRL~key down and chckmg on an ex1stmg gnd lme and draggmg away a dupllcate. 

Also See 

~ Setup Coordinate System 

Snap to Grid 
1 On the Draw menu, chck Snap to Grid. This opt1on JS avaJtable as an On and Off toggle. 

2 lf Snap to Grid is on, an element drawn or moved near a gnd ora grid intersection snaps to it lt is a useful 
opt1on for ahgn1ng ob¡ects w1th precis1on. 

3 When al! three snap opt1ons are on, Snap to Jomts has highest prionty, Snap to Grid has prionty over Snap 
to Frame/Edge . 

Tip: Yo u can add a new gnd by pressing the CTRL key and dragging an existing gnd toa new locatJon, 
or by us1ng the Mod1fy Grid command from the Draw menu. Oouble chcking on an ex1stmg grid 
opens the ModJfy Gnd box where you may add or mod1fy the locat1on of a gnd. 

Snap to Joints 
On the Oraw menu, chck Snap to Joints. Th1s opt1on 1s ava¡Jable asan On and Off toggle. 

2 lf Snap to Joints is on, the end of an Element bemg drawn snaps to the Joint when it comes clase to it ( 
within the default or user specified tolerance ). lt 1s ver¡ useful for draw1ng FRAME and SHELL elements 
when previously defined or generated Jomts are ava1lable. 

3 When all three snap optlons are on, Snap to Jomts has highest prionty, Snap to Grid has pnonty over Snap 
to Frame/Edge . 

Tip: You can mod1fy the default tolerances 11sted 1n Preferences withm the Opt1ons pull down menu. 
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Snap to Frame/Edge 
1 On the Draw menu, chck Snap to Frame/Edge. This option 1s avallable as an On and Off toggle. 

2 lf Snap to Frame!Edge is on, an element drawn or moved near a Frame element ora She!l element Edge 
snaps to 1t. Th1s optJon guarantees that the new generated JOint wlll be exactly on the Frame element or the 
Edge of the Shell element. 

3 When a U three snap options are on, Snap to Joints has highest prionty,, Snap to Gnd has pnonty over Snap 
to Frame/Edge . 

Jnitialize a New Labeling Scheme 
The labels 1n SAP2000 are alphanumenc. By defaurt the program automat¡caJiy ass1gns a numeric numbenng scheme 
to the Joints and Elements. However, it ts possible ass1gn an alphanumenc label1ng scheme by g1v1ng an alpha prefix 
and a start1ng numenc sequence. All Jomts and Elements, added after the scheme 1s iOJtJahzed. w11J be affected by the 
scheme 

To lnitialize a New Labeling Scheme: 

1 On the Oraw menu, click New Labels .. This will display the New Labels dialog box. 

2 In the New Labels d1alog box enteran alphanumenc prefix, the start1ng numenc number for the scheme to 
be added to the prefix anda numenc 1ncrement for the numenc sequence for Jomts. Frames and Shells. 

3 Cilck OK 

Select Menu 

Selection Procedures 
Multiple select1on or Ob¡ects (i.e. Elements or Joints) may be made in any session except wh1le m the DRAW mode. In 

the ORAW mode only one Joint or Element m may be selected for edJtJng purposes CIJckmg on an ob¡ect selects 
it. Chckmg again on a selected ob¡ect wlll deselect it. 

You may Also 

~ Select Ob¡ects by drawing a w1ndow around them 

~ Select Ob¡ects by drawing a line intersectlng them 

~ Select Ob¡ects ly1ng 1n XY, XZ and YZ planes 

i!J Select Ob¡ects by pre-assigned Group na mes 

~ Select Ob¡ects by Types of Frame Sect1ons 

~ Select Ob¡ects by Types of Shell Sect1ons 

~ Select Ob¡ects by Nllink PropertJes 

~ Select Ob¡ects by Types of Constraints 

~ Select Ob¡ects by Labets 

.!!J Select All Ob¡ects 

Note: Deselect Options are the same as Select Options and are ava1lable through the Select menu. 

Hints: 

When Deselect opt1ons are act1vated they wJIJ deselect the prev1ously selected ob¡ects. 

brings back the prev1ous selectJon. 

clears the ent1re seled1on. 
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• Select Objects by Window 

Cl1ck [§] from the floatmg toolbar or on the Select menu, chck Select and then Pointer!Window from the 
sub-menu. Th1s wili sw1tch you into tne select1on mode. 

2 Select Objects by e1ther cl1cking on them or drawmg a wmdow around them. Only those elements completely 
w1th1n the wtndow are selected. 

HINT: lt 1s sometimes eas1er to selecta stngle Joint by draw1ng a w1ndow around it 

Select Objects by lntersecting Line 

Cl1ck ~ from the floatmg toolbar or on the Select menu, CIJck Select and then lntersectrng L1ne from the 
sub-menu. Thls Wlll sw1tch you into the select1on mode. 

2 Draw a lrne by ciJckrng at one end and then holdrng down the left mouse button drag the pornter to the other 
end of the lme. All Objects crossing th1s lme w1!1 be selected. 

HINT: lt 1s somehmes easier to selecta smgle ora few Elements by drawmg a hne across 

Select Objects by 20 Planes 
On the SeJect menu, chck Select and then XY Plane or XZ Plane or YZ Plane from the sub-menu. This will 
sw1tch you into the selection mode. 

2 P1ck any po1nt on the plane desired and al! Elements on that Plane will be selected 

HINT: lt is a useful selection for ed1tmg purposes e.g. addrng or delet1ng a story may very easlly be 
accomplished by th1s selectron optron. 

Select Objects by Groups 
On the Select menu. cl1ck Select and then Groups from the sub-menu. Th1s will open the Select Groups lrst 
box. Click to select ene or more of the prev1ously defined groups. 

2 Chck OK. All Elements belongrng to !hose groups will be selected. 

HINT: lt is a very useful seJectron for edit1ng or viewing purposes. You may drsplay, delete, assign or 
output based upon group select1ons. 

Select Objects by Frame Sections 
On the Select menu, chck Select and then Frame Sections •.• from the sub-menu. Th1s wiU open the Select 
Sections list box. Click to select one or more of the prev1ously defined sectrons. 

2 Clrck OK. All Frame Elements belongmg to the selected section types wil~ be selected. 

HINT: lt 1s a very useful selectron for edi!lng or v1ewing purposes. You may display, delete. assign or 
output Frame Elements based upon selected sect1ons. 

Select Objects by Shell Sections 
On the Select menu, click Select and then Shell Sections .•• from the sub-menu. This will open the Select 
Sections hst box. Click to select one or more of the previously defined sections. 
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2 Clrck OK. All Shell Elements belonging to the selected SectJons will be setected. 

HINT: lt ts a very useful selectton for edittng or vtewtng purposes. You may dtsptay. delate, assrgn or 
output Shell Elements based upon selected secttons. 

Select Objects by NLLink Properties 
On the Select menu. cllck Select and then Nllink PropertJes ... from the sub-menu This wi!! open the Select 
Properttes list box. Click to select ene or more of the prevtousty defined nonfinear ltnk properttes. 

2 Click OK. All nonllnear link Elements belongtng te the setected properttes will be selected. 

HINT: 1t ts a very useful selectton for editing or vtewrng purposes You may dtsptay, delete, asstgn or 
output nonltnear hnk Elements based u pon setected properttes. 

Select Objects by Constraints 
On the Select menu. cltck Select and then Constraints ... from the sub-menu. Thts wlll open the Setect 
Constratnts list box. Cltck to setect one or more of the previously deftned Constratnts. 

2 Cltck OK. AJJ Jotnts betongtng to the selected Constratnts witl be setected. 

HINT: lt is a very useful setectton for editing or vtewtng purposes. You may dtsplay. delate. asstgn or 
output support Joints or Joints with other type of Constratnts. 

Select Objects by Labels 
On the Select menu, chck Select and then La beis from the sub-menu Thts wtll open the Setect by La beis 
dialog box. 

• Select the Element Type from the drop down list box. 
• Enter Start and End la beis. 
• Enter Jncrement between tabels 
• Click OK to setect the etements using the spectfied entena. 

2 The total number of Etements selected ts dtsplayed on the status bar. 

HINT: lt is a useful technique to find spectfic elements 10 a large modal. 

Select All Objects 

1 Click li1J from the floattng toolbar or on the Setect menu, click Select and then All from the sub~menu 
This will select all of the ob¡ects tn the modal. 

2 The total number of all the Jomts and Etements setected ts dtsplayed on the status bar. 

HINT: lt is a useful techmque to find out the total number of Jotnls or Elements in the modal. 
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AS S 1 G N MENU 

Assign Options 

Clrckrng on any of these buttons 11¿;.1 I 141~ l±l§fj from the Floating Toolbar al!ows you to Assrgn propertres. 
loads and restrarnts/constramts to your select10n. Members or Jomts have to De selected frrst m arder to make an 
assrgnment. 

Select varrous Assrgn options by cllckmg as foJiows· 

To Assign 

Supports or Restraints to Joints 

Sectrons to Frame Elements 

Thrckness to Shell Elements 

Loads on Joints 

Span and Point Loads on Frame Elements 

Unrform Loads on Shell Elements 

Do this 

Clickon GJ 
Clickon m 
Click on ¡g;¡j 
Clickon f0j 
Click on 8J 
Chck on ll!J 

Assign Section Properties 
FRAME Elements 

1 Select one or more Frame Elements to which you want to Assrgn the same Section properties. 

2 On the Assrgn menu, cllck Frame and then Sections ... in the sub-menu. 

3 In the Frame Sections display bax· 

• Select a previously defined Section 
• Cllck the OK button 

Note: lf you have not prev1ously defined trame sections, you may define them by importing new sectiOns 
from a SectJon property fiJe or adding a user defined sect1on trom the "Frame Sections" display box. 

SHELL Elements 

1 Select one or more Shell Elements to which yo u want to Assign Section properties. 

2 On the Ass1gn menu, click Shell and then SecUons ... in the sub-menu. 
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3 In the Shell Sect1ons display box 

• Selecta prev1ously defined Sect1on 
• Cf1Ck the OK button 

Note: lf you ha ve not previously defined shell sect10ns, you may add new sect1ons by chckmg on Add New 
Section 

Assign Joint Constraints 
Constraints are applied to selected joints. 

1 Select the Jomts to wh1ch you want to apply Constraints 

2 On the Ass1gn menu, chck Joint and then Constra1nts ... 1n the sub-menu Th1s will display the Constra1nts 
d1alog box. 

3 In the Constraints d1atog box: 

• Either select default names for d1fferent types of Constraints such as Beam, Body, D1aphragm. Equal, 
Local, Plate, Rod or Wefd or 

• Add a new Constra1nt by chck1ng on the Add drop down list and se1ect1ng the appropnate type of 
constra1nt Type 1n the new na me or accept the defauft name. choose the ax1s (X. Y or Z) or Auto to define 
the direct1on of the constra1nt and then chck OK. 

4 Click OK. 

Howdo 1? 

~ Add sorne Jo1nts toan ex1stmg Constraint 

~ Delete or Remove some Joints from an ex1stmg Constraint 

Add Joints to an existing Constraint 
1 Sefect the Joints you want to add toan ex1sting Constra1nt 

2 On the Ass1gn menu. cl1ck Jomt and then Constramts ... in the sub-menu. Th1s wJII d1splay the Constramts 
dialog box. 

3 In the Constramts d1alog box: 

• Choose the ex1stmg Constraint from the Constramts hst box 
• Click OK 

4 The J01nts w111 be added to the existing Constra1nt. 

Delete or Remove Joints from an existing 
Constraint 

1 Select the Jo1nts you want to remove from an ex1stmg Constramt. 

2 On the Assign menu, click Jo1nt and then Constramts .. m the sub-menu. This will display the Constraints 
d1alog box. 

3 In the Constraints dialog box: 

• Choose the ex1st1ng Constratnt from the Constraints l1st box 
• Click on Mod1fy/Show Constramt 
• Choose Remove Constramt 
• Click OK 

4 The Joints wlll be removed from the ex1stmg Constra1nt. 

Generalized Constraints 
Constralnts are used to enforce certaln types of rigid-body behavior, to connect together d1fferent parts of the model, 
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• and/or to rmpose certarn types of symmetry condi!lons . 

A constrarnt consists of a set of two of more constrained joints. The drsplacements of each parr of ¡omts in the 
constraint are related by constramt equatmns. The types of behavror that can be enforced by constrarnts are, Rrgrd­
body behavior, Equat-disptacement behavror, Symmetry and anti-symmetry condrtrons. 

Al so See 

~ Rrgrd Body: fully rigrd for all drsplacements 

~ Rrgrd Diaphragm: ngrd for membrana behavior rn a plane 

~ Rrgrd Plate: ngrd for plate bending in a plane 

~ Rrgid Rod: rigrd for extensron along an axis 

2?J Rigid Beam: ngrd for beam bendrng on an axrs 

~ Equal-drsplacement behavror 

~ Partral Connectron 

~ Local-Constrarnt 

2?J Symmetry About a Plane 

~ Antr-symmetry About a Plane 

..!!J Axrsymmetry 

.2!1 Cyclic symmetry 

~ Symmetry About a Po1nt 

Hint: The use of constramts reduces the number of equat1ons in the system to be solved and w111 usually 
result 1n mcreased computatJonal effic1ency. 

Body Constraint 
A Body Constraint causes all of 1ts constra1ned ¡mnts to move together as a three-d1mensional rig1d body. Effect1vety, 
all constra1ned joints are connected to each other by ng1d llnks and cannot displace retat1ve to each other. 

Th1s Constraint can be used to: 

• Model ng1d connections, such as where severa! beams and/or columns frame together 
• Connect together different parts of the structural model that were defined us1ng separata meshes 
• Connect Frame elements that are act1ng as eccentric stiffeners to Shell elements 

Joint Connectivlty 

Each Body Constraint connects a set of two or more jmnts together. The jo1nts may have any arb1trary tocation in 
space. 

Local Coordinate System 

Ea eh Body Constraint has its own local coordmate system. the axes of wh1ch are denoted 1, 2, and 3. These 
correspond to the X, Y, and Z axes of the global coordmate system, respecllvely. The actual onentat1on of the local 
axes is not important smce the constramt equat1ons are independent of the coord1nate system. 

Diaphragm Constraint 
A D1aphragm Constra1nt causes all of its constrarned joints to move together as a planar diaphragm that is rigid 
agamst membrana deformat1on. Effect1veJy, all constra1ned JOints are connected to each other by 

links that are rig1d m the ptane, but do not affect out-of-plane (plate) deformat1on. 

This Constraint can be used to: 

• Model concrete floors (or concrete-filled decks) in building structures, wh1ch typ1cally have very high in­
plana st1ffness 

• Modet diaphragms Jn'bridge superstructures 
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The use of the Dtaphragm Constratnt for bUJidtng structures ehminates the numencal-accuracy problems created when 
the Jarge tn-plane sttffness of a floor dtaphragm is modeled wtth membrane elements. lt ts atso very useful tn the 
lateral (honzontal) dynamic analysts of buildtngs, as 1t results m a stgnrficant reduction tn the s!Ze of the etgenvalue 
problem to be solved. 

Joint Connectlvity 

Each Dtaphragm Constratnt connects a set of two or more JOtnts together. The JOtnts may have any arbttrary locatton m 
space. but for best results all JOtnts shoutd Jte m the ptane of the constramt. Otherwise. m-plane moments may be 
generated that are restramed by the Constratnt. which unrealistJcally sttffens the structure. lf thts happens. the 
constraint torces pnnted tn the output file may not be in equllibnum. 

Local Coordinate System 

Each Dtaphragm Constramt has tts own local coordinate system. the axes of whtch are denoted 1, 2, and 3. Local axis 
3 ts always normal to the plane of the constramt. The program arbttranly chooses the 

onentatton of axes 1 and 2 rn the plane. The actual onentatton of the planar axes rs not tmportant srnce only the 
normal drrectton affects the constrarnt equattons 

Plate Constraint 
A Plate Constramt causes all of 1ts constrained JO!Ots to move together as a flat olate that 1s ríg1d agarnst bend1ng 
deforrnatton. Effectively, all constrained JOints are connected to each other by l1nk.s that are 

ng1d for out-of-plane bendrng, but do not affect m-plane (membrana) deforrnat1on. 

This Constraint can be used to: 

• Connect structural-type elements (Frame and SheJI) to sohd-type elements (Piane and Salid}: the rotat1on 
m the structural element can be converted toa pa1r of equal and opposite translat1ons in the sohd element 
by the Constramt 

• Enforce the assumption that "plane sections rema m plane" 1n detatled models of beam bendrng 

Joint Connectivlty 

Each Plate Constra1nt connects a set of two or more Joints together. The jo1nts may have any arbitrary locatton in 
space. Unlike the Dtaphragm Constramt, equilibnum rs not affected by whether or not a!l JOints 

lte in the plane of the Plate Constramt. 

Local Coordinate System 

Each Plate Constra1nt has 1ts own local coordtnate system. the axes of whtch are denotad 1, 2. and 3. Local axrs 3 IS 
always normal to the ptane of the constramt. The program arb1tranly chooses the onentatton of axes 1 and 2 rn the 
pfane. The actual orientatton of the planar axes 1s not importan! srnce onfy the normal dtrectron affects the constraint 
equations. 

Rod Constraint 
A Rod Constraint causes all of 1ts constratned JOints to move together as a stra1ght rod that 1s rigid against axial 
deformation. Effecttvety, all constrained JOrnts mainta1n a fixed drstance from each other in 

the drrect1on parallel to the ax1s of the rod, but translat1ons normal to the axis and all rotations are unaffected. 

This Constraint can be used to: 

Prevent axial deformation tn Frame elements 
• Model ngrd truss-like Jinks 

An exampte of the use of the Rod Constramt rs in the analysis of the two-dtmens1onal trame shown rn F1gure 30 (page 
128} of the User's Manual. lf the axial deformattons m the beams are neg1tg1ble. a srngle Rod Constratnt could be 
defined contatning the five joints. lnstead of five equatJons. the program would use a stngle equation to define the X­
dlsplacement of the whole floor. However, it should be noted that th1s will result Jn the axtal' torces of the beams bemg 
output as zero, as the Constramt will cause 

the ends of the beams to translate together in the X-dtrect1on. lnterpretations of such resutts associated Wlth the use of 
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• Constraints should be dearly understood . 

Joint Connectivity 
Each Rod Constraint connects a set of two or more jornts together The ¡oints may have any arbrtrary location in 
space. but for best results aiJ joints should líe on the axis of the constramt. Otherwrse, 

transversa (bendrng) moments may be generated that are restrarned by the Constrarnt. whrch unreallstrcally stiffens 
the structure. lf this happens, the constramt torces prmted in the output file may 

not be in equilibrium. 

Local Coordinate System 
Each Rod Constramt has tts own local coordinate system. the axes of whrch are denotad 1, 2, and 3. Local axrs 1 rs 
always the axrs of the constraint. The program arbrtranly chooses the onentation 

of the transversa axes 2 and 3. The actual onentatJon of the transverse axes is not important smce only the ax1al 
directlon affects the constra1nt equations. 

Beam Constraint 
A Beam Constraint causes all of its constra1ned jo1nts to move together as a straight beam that 1s rigid agamst bend1ng 
deformation. Effectlvely, all constra1ned ¡o1nts are connected to each other by hnks that are ng1d for off·axis bend1ng, 
but do not affect translat1on along or rotat1on about the ax1s. 

Th1s Constramt can be used to: 

• Connect structural·type elements (Frame and Shell) lo solid·type elements (Piane and Salid); the rotatJon 
·In the structural element can be converted toa pazr of equal and oppos1te trans!ations 1n the sol1d element 
by tne Constraint 

• Preven! bend1ng defor":J_at1on 1n Frame elements 

Joint Connectivlty 

Each Beam Constra1nt connects a set of two or more JOIOIS together The joints may have any arb1trary locatJon 1n 

space, but for best resufts all jo~nts sfiould He on the axis of the constraint. OtherwJse, 

torsional moments may be generated that are restrained by the Constramt, which unreallstically st1ffens the structure. 
lf this happens, the constraint forces,~nnted 1n the output file may not be 1n eqUJIJbnum. 

Local Coordinate System 

Each Beam Constraint has 1ts own local coord1nate system, the axes of which are denoted 1, 2. and 3. Local axis 1 is 
always the axis of the constramt. The program arb1tranly chooses the onentation 

of the transversa axes 2 and 3. The actual orientat1on of the transversa axes 1s not 1mportant s1nce only the axial 
d1rect1on affects the constra1nt equat1ons. 

Equal Constraint 
An Equal Constraint causes all of its constra1ned joints to move together with the same (or opposite) d1splacements for 
each selected degree of treedom, taKen 1n the constramt local coordmate system. The other degrees of freedom are 
unaffected. 

The Equal Constraint d1ffers from the ng1d-body types of Constra1nts 1n that there is no coupling between the rotatJons 
and the translat1ons. 

This Constraint can be used to: 

• Model symmetry and ant1-symmetry cond1110ns w1th respect toa plane 
• Partially connect together different parts of the structural model, such as at expans1on joints and hinges 

For fully connect1ng meshes, 1t 1s better to use the Body Constraint when the constra1ned joints are not in exactly the 
same !ocat1on. 
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Joint Connectivity 

Each Equal Constraint connects a set of two or more ¡oints together. For a given Constraint. tf any of the selected 
degrees of freedom are negattve (1.e., opposite). only two constratned ¡otnts are allowed for that Constratnt. Otherwise 
any number of constramed ¡otnts are perrmtted. 

The ¡otnts may have any arbttrary locatJon in space, but for best results all joints should share the same location m 
space tf u sed for connecttng meshes. Otherwise, moments m ay be generated tnat are 

restrained by the Constra1nt. whtch unrealtsltcally stiffens the structure. Jf thts happens, the constramt torces pnnted m 
the output file may not be 1n equtlibnum. 

Such restrained moments may also be generated when Equal Constramts are used for syrnmetry purposes. They are 
necessary to enforce the desired symmetry or antt-syrnmetry of the dtsplacements when the applied loads are not 
correspondingly symmetrtc or anti-symmetnc. 

Local Coordinate System 

Each Equal Constramt uses a fixed coordtnate system. csys. that you spectfy. The default for csys 1s zero, tndicattng 
the global coordmate system. The axes of the fixed coordtnate system are denoted X, Y, and Z. 

Selected Oegrees of Freedom 

For each Equal Constramt you may specify a hst, cdofs, of up to s1x degrees of freedom in coordmate system csys 
that are to be constratned. The degrees offreedom are indtcated as UX, UY, UZ, RX, RY, and RZ. A negattve stgn 
mdtcales a degree of freedom that 1s constramed to be opposite, e.g., -UX. 

Partial Connection 
When joints are being connected. all spectfied degrees of freedom are pos'tltve. For example, constder an idealtzed 
htnge connectton of eight soace-truss members. Only dtsplacements are contmuous across 

the htnge, not rotations. Each truss member is connected toa separate ¡oint (nade) at the connectton. One Equal 
Constramt 15 defined for the eight constratned ¡oints. The degrees of freedom that would be 

specified forthis Constraint are: UX, UY. and UZ. 

The eight joints should be cotncident or the axes of the truss members should allmtersect at the same pJint. 
Otherwise, moments may be generated that are unreahstJcally restramed by the Constramt. 

Local Constraint 
A Local Constraint causes all of its constratned JOIOts to move together wtth the same (or oppostte) displacements for 
each selected degree of freedom. taken in the separata JOtnl local coordmate systems. 

The other degrees of freedom are unaffected. 

The Local Constratnl dtffers from the ngid·body types of Constramts m that there 1s no couplmg between the rotations 
and the translations. The Local Constraint is the same as the Equal Constraint tf all constratned j01nts have the same 
local coordtnate system. 

Thts Constramt can be used to: 

• Model syrnmetry condttions wtth respect to a ltne or a potnt 
• Model displacements constrained by mechanJsms 

The behavtor of this Constratnt is dependen! upon the cho1ce of the local coordtnate systems of the constramed JOints. 

Joint Connectivity 

Each Local Constraint connects a set of two or more JOints together. lf any of the selected degrees of freedom for a 
gtven Constraint are negattve (te .• oppos1te) only two constratned JOints are allowed 

for that Constraint. Otherwtse any number of constratned jotnts are permttted. 

The joints may have any arbitrary Jocatlon in space. lf the jotnts do not share the same location in space, moments 
may be generated that are restratned oy the Constra1nt. lf thts happens, the constra1nt 
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torces printed in the output file may not be •n equl11brium These moments are necessary to enforce the des1red 
symmetry of the d1splacements when the apphed loads are not symmetric, or may represen! the constraimng action of 
a mechanrsm. 

No Local Coordinate System 

A Local Constraint does not have its own local coordinate system. The constra1nt equat1ons are wntten 1n terms of 
constra1ned JOint local coordmate systems, which may differ. The axes of these coord1nate 

systems are denoted 1, 2, and 3. 

Selected Degrees of Freedom 
For each Local Constramt you may specify a list, ldofs, of up to s1x degrees of freedom m the ¡omt local coordrnate 
systems that are to be constra1ned The degrees of freedom are md1cated as U1, U2, U3, R1, R2, and R3 A negative 
s1gn 1ndrcates a degree of treedom that 1S constrained to be opposite, e.g., ~U1. 

Constraint Equations 

The constraint equat1ons relate the d!splacements at any two constramed jomts (subscripts 1 and J) 1n a Local 
Constraint. These equatlons are expressed in terms of the transtat1ons u1, u2. and u3 and the rotat1onsr1. r2 and r3, 
all taken rn joint local coordinate systems The equations used depend upon the selected degrees of freedom and the1r 
signs. Sorne rmportant cases are descnbed next. 

Symmetry About a Plane 
For a structure that rs symmetrrc about a plane, symmetnc loading causes symmetric drsplacements as follows: 

• 
• 
• 
• 

Forces and drsplacements parallel to the plane of symmetry are equal 
Forces and d1splacements nonnal to the ptane of symmetry are oppoSJte 
Moments and rotatrons parallel to the ptane of symmetry are oppos1te 
Moments and rotatrons nonnal to the plane of symmetry are equal 

As an example, considera structure that •s symmetnc w1th respect to a plane normal to the X axis and sub¡ected to 
symmetnc loading. A separata Equal Constra•nt must be defined for each pa1r of jomts 

that is symmetncally located w1th respect to the plane. The degrees of freedom that would be spec1fied for these 
Constra•nts are: ~UX, UY, UZ, RX. RY, and ~RZ. 

Any ¡o1nts on the plane of symmetry should not be constrained, but rnstead have the1r UX, RY. and RZ degrees of 
freedom restrarned. 

Anti-symmetry About a Plane 
For a structure that 1s symmetric about a plane, antf·symmetric loading causes ant1·symmetnc dlsplacements. All 
degrees of freedom that are equal when symmetric are oppos1te when antl·symmetnc, and all degrees of freedom that 
are opposite when symmetnc are equal when anli·symmetnc. Thus the spec1ficat•on of the antr·symmetnc degrees of 
freedom simply uses the oppoSite s1gns from the symmetnc case. 

Cons1der the example above of a structure that is symmetric Wlth respect toa plane normal to the X axis, but now 
subjected to anti·symmetnc load1ng. A separata Equal Constramt must be defined for each parr 

of jo1nts that 1s symmetncally located w1th respect to the plane. The degrees of freedom that would be specified for 
these Constraints are: UX. ·UY, .uz. ~RX. RY, and RZ. The signs of the constramt equations are corresponding 
changed from the symmetnc case. 

Axisymmetry 
Axisymmetry 1s a type of symmetry about a hne lt 1s best descnbed in terms of a cylindncal coordrnate system having 
1ts Z axis on the line of symmetry. The structure, loadrng, and drsplacements are each 

said to be axisymmetnc about a Jine if they do not vary with angular pos1t1on around the hne, i.e., they are mdependent 
of the angular coordinate CA. 
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Te enforce axisymmetry using the Local Constramt: 

• Model any cylindncal sector of the structure usrng any axrsyrnmetric mesh of joints and elements 
• Assrgn ea eh j01nt a local coorchnate system such that local axes 1, 2, and 3 correspond te the coordmate 

drrect1ons +CR, +CA, and +CZ, respectrvely 
• For each axisymmetric set of joints (i.e., havmg the same coordmates CR and CZ. but drfferent CA), define 

a Local Constramt using all s1x degrees offreedom: U1, U2, U3, Rl. R2, and R3 
• Restrain joints that lre on the lme of symmetry so that, at most. only axral translatJons (U3) and rotat1ons 

(R3) are permrtted 

Cyclic symmetry 
Cyclrc symmetry JS another type of symmetry about a lrne. 11 rs best described rn terms of a cylmdrical coordinate 
system having rts Z axrs on the line of symmetry. The structure, loadrng. and drsplacements 

are each said to be cyclrcally symmetric about a hne if they vary with angular posrt1on rn a repeated (perrodic) fashron. 

To enforce cychc symmetry using the Local Constrarnt. 

• Model any number of adjacent, representativa, cylindrrcal sectors of the structure; denote the srze of a 
srngle sector by the angle q 

• Assign each joint a local coordmate system such that local axes 1, 2, and 3 correspond to the coordmate 
directrons +CR, +CA, and +CZ, respectively 

• For each cychcally symmetnc set of ¡ornts (i.e., havrng the same coordrnates CR and CZ. but with 
coordrnate CA drffering by multiples of q, define a Local Constrarnt usrng all six degrees of freedom: Ul, 
U2, U3, R1, R2. and R3. 

• Restram ¡oints that lie on the hne of symmetry so that, at most, only axial translatrons (U3) and rotatrons 
(R3) are permitted 

For example. suppose a structure is composed of six identrcal 600 sectors, identrcally loaded. lf two ad¡acent sectors 
were modelad, each Local Constraint would apply toa set of two ¡omts, except that 

three jornts would be constrarned on the symmetry planes at 00, 600, and 1200. 

lf a single sector is modelad, only jornts on the symmetry planes need to be constramed. 

Symmetry About a Point 
Symmetry about a pornt is best described rn terms of a sphencal coordinate system having its Z axts on the lrne of 
symmetry. The structure. Joadrng, and drsplacements are each sard to be symmetric about a point if they do not vary 
w1th angular posillon about the po1nt, r.e., they are Jndependent of the angular coordrnates SB and SA. Radial 
translation rs the only dlsplacement componen! that rs permrsstble. 

To enforce symmetry about a point using the Local Constraint: 

• Modet any sphencal sector of the structure usmg any symmetnc mesh of joints and elements 
• Assrgn each ¡ornt a local coordrnate system such that local axes 1, 2, and 3 correspond to the coordrnate 

directrons +58, +SA, and +SR, respecuvely 
• For each symmetnc set of JOints (te., havmg the same coordmate SR, but different coordmates SB and 

SA), define a Local Constraint usmg only degree of freedom U3 
• For all Jornts, restrain the degrees of freedom U1, U2, Rl, R2, and R3 
• Fully restrarn any jomts that he at the point of symmetry 

lt is also possible to define a case for symmetry about a pomt that rs similar te cychc symmetry around a Jrne. e.g., 
where each octant of the structure ts rdenttcal. 

Assign Joint Springs 
Springs are added to selected joints. 

1 Select the Jolnts to whtch you want to apply Spnngs. 



• 2 On the Ass'rgn menu, ciJck Jornt and then Spnngs .. m the sub-menu. Thrs will drsplay the Jornt Springs 
dialog box. 

3 In the Jornt Springs dralog box: 

• Type in the Spnng Strffness values in the local directiOns for the three Translatrons and the three 
Rotations. 

• In the Optrons area select the appropnate optron- Add to exrstrng springs, Replace existrng spnngs or 
Delete existrng springs. 
lf required specify the upper half of the Coupled 6X6 Spnng matnx, accessed by clicking the Advanced 
button. 

4 CllckOK. 

Assign Joint Masses 
Masses are added to selected joints. 

1 Select the Jornts to whrch you want to apply Masses. 

2 On the Assrgn menu, click Joint and then Masses .. rn the sutrmenu Thrs will display the Jomt Masses 
dralog box. 

3 In the Jornt Masses dtalog box: 

• Type m the Mass vatues 1n local Direclton 1, Dtrectton 2 and Directron 3. 
• Type tn the Mass Moment of !nerita values rn Rotatton about 1, Rotalton about 2 and Rotaban about 3. 
• In the Options area select the appropnate optton - Add to extsttng masses, Reptace extstmg masses or 

Detete extsllng masses. 
4 CllckOK. 

Assign Joint Restrair.ts 

Restraints are added to selected joints. 8 
1 Select the Joints to which you want to apply Restraints 

2 On the Assign menu, click Joint and then Restraints .. rn the sub-menu. This will dtsplay the Joint Restraints 
dtalog box. 

3 In the Joint Restraint dtalog box: 

• Select from the Restraints tn Local Dtrecttons, the JOint restratnt(s) destred, or 
• Select from Fast Restratnts, the tcon that represents the desired restraint condttton. 

4 Cllck OK. 

Assign Joint Patterns 
1 Select the Joints to which you want to assign the pattem. 

2 On the Assign menu, click Jotnt Pattems ... Thts wilt dtsptay the Pattem Data diatog box. 

3 Cltck on the Pattem Name drop down box and choose a prevtousty defined pattem name by clicking en ti. 

4 Type in the values tn the edil boxes for Constants A, B, C and D. relevan! to defining the Value of 
Ax+By+Cz+D ( x, y and z are JOtnt coordtnates ). ltts thts Value that wtlt be asstgned to the Joints. lt can 
define the variation of Temperatura for Frame Elements and vanatton of Pressure for Shell Elements. These 
Values are then subsequently multiplted by the Temperatura vatues asstgned from the Frame Static Loads 
or Pressure values asstgned from the Shell Stattc Loads. For instance tf you want to assign a pattem whtch 
represents the vanatton of sotl pressure on a wall 
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5 Opt1ons 

To add computad Values from Constants to exist1ng Values from prev1ously assigned pattems. click on 
Add to exJst1ng values under Options. 

• To replace computed Values from Constants to ex1sbng Values from previously ass1gned pattems, cllck 
on Replace ex1sting values under Opt1ons. 
To delate prev1ously assigned pattems, cllck on Delete exist1ng values under Opt1ons 

6 Cllck to check Zero negat1ve values if negat1ve vanat1on is not desired. 

7 Cllck OK. 

Also See: 

.!!:.J Define Joint Pattems 

Assign Local Axes 
AJJ Elements and Jo1nts have default local axes. lt is possible to change the defimtJon of local axes by s1mply defining a 
rotatlon angle. 

What do yo u want to do? 

.!!] Ass1gn/Change Local Axes for FRAME Elements 

~ Ass1gn/Change Local Axes for SHELL Elements 

~ Assign/Change Local Axes for JOINTS 

Assign Local Axes for Joints 
Select one or more Joints to wh1ch you want to Ass1gn the same Local Axes. 

2 On the Assign menu, click Joint and then Local Axes ... 1n the sub-menu. 

3 In the Jomt Local Ax1s d1splay box: 

Type in a value for rotation anglas about Z, Y' and X" axes, in degrees (Y' and X" 1nstead of Y and X are 
used as axes names to emphas1ze that once an angle about z is specifled the local X and Y will change as 
a result) 

• Check the Use default box if Global definition is to be used for the local axes. 
• CJ1ck the OK button 

Note: The local axes arrows are only shown when the local axes for the JOINT are different than the 
Global. 

EXAMPLE: 

Assign Local Axes for Frame Elements 
1 Select one or more Frame Elements to which you want to Ass1gn the same Local Axes. 

2 On the Assign menu, cllck Frame and then Local Axes ... in the sub-menu. 

3 In the Frame Local Axis d1splay box· 

• Type 1n a value for Angle in Degrees. Th1s is an angle by which local axis 2 of the Element will be rotated 
around local axis 1. Local axis 1 1s along the tength of the Element. By default local axis 2 is always 1n the 
1~Z plana except if the Element is vertical and then 11 is paraJJel to the global X axis. The definit1on of the 
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• local axes follow the nght hand rule. The angle is measured antJ-clockwJse as posit1ve 1f local ax1s 1 ts 
pomtJng towards you .. 

• Check the Reverse start and end connectiv1ty box if you want to fhp the l and J ends of the members 1.e 
f11p the local ax1s 1. 

• Cllck the OK button 

Note: By default global Z ts taken as the 30 V1ew Up 01rection. You may change the UP drrectton trom 
the Opt1on pull down menu. lf you change the UP d1rection. 1t will only affect the display of the 
model and does not affect the local axes defin1t1on in any way. 

Assign Frame Releases 
Raleases are assigned to selected Frame Elements. 

1 Select tne FRAME Elements to wh1ch you want to apply the releases. 

2 On the Ass1gn menu, chck Frame and then Releases .. m the sub-menu. Th1s w1il display the Frame 
Releases d1alog box. 

3 In the Frame Raleases dtalog box: 

• For each end of the FRAME Element check the type of release destred (Axtal, Shear Force 2 (Ma¡or), 
Shear Force 3 (Mmor), Torsion, Moment 22 (Mmor) and Moment 33 (Ma¡or). 

• lf no releases are desired then check the No Reteases box. 
4 Clrck OK. 

Note: The releases spectfied always reptace the exist!ng releases. 

Assign Frame End Offsets 
Frame End Offsets are assigned to selected Frame Elements. 

1 Select the FRAME Elements to which you want to apply the Frame End Offsets. 

2 On the Asstgn menu, click Frame and then End Offsets ... tn the sub-menu. Thts wtll dtsplay the Frame End 
Offsets dtalog box. 

3 In the Frame End Offsets dialog box. 

• lf you want to use User SpeCified End Offsets then check Define Lengths and type in the values for the 
Offsets at End 1 and End J. 

• lf you want the program to catculate the End Offsets from the connecttvity of the model then check Update 
lengths from current connecttVíty. The program witl automattcally calculate the End Offsets from the Depth 
(MaJar) and Wtdth (Minar) specified for the Frame Element properttes. 

• Spectfy a Rtgtd Zone Factor in the edtt box. Thís is a factor used to define the percentage of the Zone 
specified through End Offsets to be taken as fully rigid. O means no rigid zone and 1 means that the enttre 
zone is taken as ngtd. 

4 Click OK. 
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Assign Frame Output Segments 
Frame Output Segments are assigned to selected Frame Elements. 

1 Select the FRAME Elements to which you want to assign the Frame Output Segments. 
2 On the Ass1gn menu, cllck Frame and then Output Segments ... in the sub-menu. Thts will d1splay the Frame 

Output Segments d1alog box. 

3 In the Frame Output Segments dialog box: 

• In the Number of Segments edit box speclfy the number of segments at which the output is destred .. 
4 CIJckOK. 

Note· The output segments are spec1fied on the C!ear Length of the Elements. 

Tip: lt 1s adv1sable to specify a different number of output segments for Columns than for Beams 
(columns typ1cafly are designed using only the two end values of forces and moments whereas 
beams may be designad at the max1mum values occumng somewhere in between the Jength 
beca use of the presence of pomt or dJstnbuted Joads on the span of the beam). 

Assign Frame Prestress 
Ass1gning Frame Prestress loads is a way to model the prestress cable toad on a frame member. 

1 Select the FRAME Elements to whJch you want to assign a Prestress toad. 

2 On the Ass1gn menu, click Frame and then Prestress .. in the sub-menu. This w111 display the Frame 
Prestressmg Pattems dJalog box. 

3 In the Frame Prestress1ng Pattems d1atog box enter; 

• The Cable T ens1on in the text edJt box 
• The Start, Mlddle and End cable locations 
• Setect from Add, Reptace or Delete. 

4 Clíck OK. 

Note: You can assign more than one Prestress load toan 1nd1viduar frame member. Once you have 
assigned prestress toads to elements you w1ll need to assign the frame prestress loads to a static 
load case. 

Also see: 

..!!) Ass1gn Pre~tress to FRAME Static Load 

• 



Assign Frame lnitial P-Delta Force 
1 Select the FRAME Elements to which you want to ass1gn a P·Delta load. 

2 On the Assign menu, cllck Frame and then P·Delta .. 1n the sub-menu. This wifl dtsplay the Frame lni!Jal p. 
Delta Forces dialog box 

3 In the Frame lnitial P-Delta Forces diatog box: 

Select 1n which drrect1on you want the load spec1fied and enter the P-Delta axial force act1ng on the 
selected frame elements. 

• Setect from Add, Replace or Delete. 
4 Cllck OK. 

Note: You can assign more than one P-Delta load toan individual trame member. 

Assign Frame Lanes 
Select the FRAME Elements you want assrgned toan already defrned tane. 

2 On the Assign menu, cllck Frame and then lane .. m the sub-menu. This will display the Assign Lane dialog 
box. 

3 In the Assign Lane dialog box: 

• Select the lane you want the frames assigned to from the drop down list box. 
• Enteran eccentncity for the Jane relative to the trame member m the text edit box. The units for the 

eccentnc1ty are the same as the current length umts. 
• Press the Modify/Show Lane button to edil the arder of the frame elements and their eccentricitJes. 

4 Chck OK. 

Note· A frame member can be a part of more then one lane 

~ Define Lanes 

Assign Prestress to Frame Static Load 
Once the prestress has been assigned to the frame member the toad from that prestress needs to be assigned toa 
Load Case for SAP2000 to be able to mclude 11 m the analysrs. 

1 Select the FRAME Elements for which you want the prestress toad ass1gned to a defined Load Case 

2 On the Assign menu, click Frame Static Loads and then Prestress ... rn the sub-menu. This w1JI display the 
Frame Prestress Loads d1alog box. 

• Select the Load Case from the drop down Jrst box. 
• Seta scale factor for the prestress load This value iS mdependent of scale factor for Load Combinations . 

Select Add, Replace, Delete ex1stmg load. 
3 Chck OK 

Also see: 

..!!] Assrgn FRAME Prestress 

Assign Local Axes for Shell Elements 
1 Select one or more SheU Elements to which you want to Assign the same Local Axes. 
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2 On the Assign menu, cllck Shell and then local Axes ... 1n the sub-menu 

3 In the Shelllocal Ax1s display box: 

• Type in a value for Angle in Degrees. Th1s 1s an angle by which local ax1s 2 of the Element will be rotated 
around local ax1s 3. Local axis 3 ts normal to the surface of the SHELL Element. By defau!llocal ax•s 2 is 
always 1n the 3-Z plane (and IJes in the plane of the SHELL) except if the Element is honzontal and then 11 
is parallel to the global X axis. The defimtJon of the local axes follow the right hand rule. The angle 1s 
measured anll-clockwise as pos1t1Ve if local ax1s 3 is po1nting towards you .. 

• Check the Reverse dJrectJon of normal box if you want to f11p the direction of local ax1s 3. 
• Cl1ck the OK button 

Note: The pos1tNe d1rect1on of the local axis 31s detemf1ned by the definition of the SHELL connectiv1ty. 
See S1gn ConventJon for more mfo. 

Assign Local Axis For NLLinks 
Select one or more Nllink Elements to which you want to Ass•gn the same Local Axes. 

2 On the Assign menu, click Nllink and then Local Axes ... 1n the sub-menu. 

3 In the NLlink Local Axis display box: 

• Type in a value for Angle 1n Degrees. Th1s ts an angle by wh1ch local ax1s 2 of the Element wi!l be rotated 
around local ax1s 1. Local axis 1 1s along the length of the Element. By default local ax1s 2 1s always 1n the 
1-Z plane except if the Element 1s verttcal and then it 1s parallel to the global X ax1s. The defimtiOn of the 
local axes follow the right hand rule. The angle 1s measured ant•-clockwise as posJIJVe if local ax1s 1 1s 
pointing towards you .. 
Check the Reverse start and end connectiVJty box if you want to filp the 1 and J ends of the members 1.e 
f11p the local ax1s 1. 

• Click the OK button 

Note: By default global Z is taken as the 30 V1ew Up Direct1on. You may change the UP direct1on from 
the Opt1on pull down menu. lf you change the UP d1rect1on, 11 will only affect the display of the 
model and does not affect the local axes def1mt•on m any way. 

Assign Static Loads 
Loads are applied to selected JOJNTS, FRAME elements or SHELL elements 

What do you want to do? 

~ Ass1gn Loads or D•splacements to JOINTS 

~ Ass1gn Gravity Loads to FRAMES 

~ Assign Pornt and Un1fonn loads to FRAMES 

..!!J Assign Trapezoidal Loads to FRAMES 

~ Ass1gn Temperature Loads to FRAMES 

~ Assign Grav1ty Loads lo SHELLS 

~ Assrgn Uniform Loads to SHELLS 

~ Ass1gn Pressure Loads to SHELLS 

~ Ass1gn Temperature Loads to SHELLS 

Assign Loads or Displacements to Joints 
1 Select one or more JOINTS to assign loads to. 

2 On the Assign menu, click Joint Static Loads and then Forces ... or D•splacements ... in the sutrmenu. 

3 In the Jo1nt Forces or Ground D1splacement diaJog box: 

• Select the load Case 
• Provide Forces and Moments or Translatrons and Rotat1ons. 



• Select from Add, Replace. Oelete 
4 CIICk OK. 

The screen w111 refresh w1th a graphical representatron of the load assigned on the Joints selected. 

Note: Oisplacements may only be app!Jed to previously RESTRAINED Jo1nts. 

Tip: Cl1ck [!)] to ass1gn Joint torces. 

Assign Gravity Loads to Frames 
Th1s loadrng method is a way to add the factored se!f we1ght of the members rn as a force tn any of the global 
d1rections. lt 1s recommended that the actual self werght of the structure be mctuded 1n the definitron of the Stat1C Load 
Cases 

Select one or more FRAMES to ass1gn loads to. 

2 On the Assign menu, chck Frame Stat1c Loads and then Grav1ty ... in the sub-menu. This will display the 
Frame Grav1ty Loads d1alog box. 

3 In the Frame Gravity Loads d1alog box: 

• Select the Load Case 
• Provide Grav1ty MuttipiJers 
• Select from Add, Replace, Oetete 

4 Cilck OK. 

The screen wdl refresh with a graphical representatron of the load assrgned on the members setected. 

Assign Pointand Uniform Loads to Frames 
1 Setect one or more F~MES to assign loads to. 

2 On the AssJQn menu, chck Frame StatJc Loads and then Point and Uniform ... in the sub-menu. Th1s wil! 
display the Pomt and Un1form Span Loads d1alog box. 

3 In the Point and Uniform Span Loads dralog box: 

Setect Load Case 
• Choose Load Type and 01rectron 
• Provrde Pomt Loads and 01stances 
• Prov1de Un1form Load 
• Select from Add, Reptace, Oelete 

4 Click OK. 

The screen wlll refresh with a graphical representatron of the load assigned en the members selected. 

Tip: Cl1ck ~ to assign Point and Uniform loads to FRAMES. 

Assign Trapezoidal Loads to Frames 
1 Select one or more FRAMES to assign toads lo. 

2 On the Assign menu, chck Frame Static Loads and then Trapezoidal .. in the sub-menu. Thrs wilt display the 
Trapezoidal Span Loads d1alog box. 

3 In the Trapezoidal Span Loads d1atog box: 

• Select Load Case 
• Choose Load T ype and Dlrect1on 
• Provide loads and 01stances 
• Select from Add, Reptace, Delete 

4 Cilck OK. 

The screen will refresh with a graphical representation of the load assigned on the members selected. 
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Assign Temperature Loads to Frames 
1 Select one or more FRAMES to assign loads to. 

2 On the Assrgn menu. click Frame Statrc Loads and then Temperatura ... in the sub-menu. Thrs wrll display 
the Frame Temperatura Loadtng dialog box. 

3 In the Frame Temperatura Loading dralog box: 

• Select Load Case 
• Select Type from Temperatura, Temperatura Gradient 2·2, Temperatura Gradrent 3-3 
• Select Temperatura by Etement or Jomt Pattem 
• Select from Add, Replace, Delete 

4 Clíck OK. 

The screen will refresh wrth a graphical representatron of the load assigned on the members setected. 

Assign Gravity Loads to Shells 
This Joadmg method is a way to add the factored seff werght of the members tn as a force tn any of the global 
drrectiOns. /t rs recommended that the actual self werght of the structure be rncluded in the definttton of the Stattc Load 
Cases 

1 Setect one or more SHELLS to asstgn toads to. 

2 On the Asstgn menu, cltck Shell Stattc Loads and then Gravtty ... in the sub·menu. Thts will dtsptay the Shetl 
Gravity Loads dtatog box. 

3 tn the Shell Gravity Loads dtalog box: 

• Select the Load Case 
• Provtde Gravtty Multiptiers 
• Setect from Add, Replace, Delate 

4 CIICk OK. 

The screen wilt refresh with a graphicat representation of the load assigned on the members selected. 

Assign Uniform Loads to Shells 
Select one or more SHELLS to assign loads to. 

2 On the Asstgn menu, click Shell Stattc Loads and then Uniform ... in the sub·menu. Thts will dtsplay the SheJI 
Uniforrn Loads dialog box. 

3 In the Sheff Uniforrn Loads dialog box: 

• Select Load Case 
• Provide Unifonn Load value and Dtrection 
• Select from Add, Replace, Delete 

4 Cl1ckOK. 

The screen wtlt refresh wtth a graphtcal representation of the load assigned on the members selected. 

Tip: Cfick ~ to assign Untfonn loads to SHELLS. 

Assign Pressure Loads to Shells 
Setect one or more SHELLS to assign loads to. 

2 On the Assign menu, click Shell Stattc Loads and then Pressure ... tn the sub-menu. Thts wtll dtsptay the 
Shell Pressure Loads dtatog box. 

3 In the Shell Pressure Loads dialog box: 

• Setect Load Case 
• Choose if pressure be applied by Element or by Joint Pattem 
• lf by Element, then specify pressure vatue 
• lf by Jotnt Pattem, then choose pattem and multiplter 
• Select from Add, Replace, Delate 

4 ClickOK. 

The screen will refresh with a graphtcal representation of the load asstgned on the members selected. 



Assign Temperature Loads to Shells 
Select one or more SHELLS to ass1gn loads to 

2 On the Assign menu. cltck Shell Stattc Loads and then Temperatura ... m the sub-menu. Thts will dtsplay the 
Shell Temperatura Loadtng dtalog box. 

3 In the Shell Temperatura Loadtng dialog box· 

• Select Load Case 
• Choose the type ofTemperature Loadrng, i.e. Temperatura or Gradtent 
• Choose if temperatura to be apphed by Element or by Jotnt Pattem 
• lf by Element, then specify temperatura value 
• lf by Joint Pattern, then choose pattem and multiplter 
• Select from Add, Replace, Dele te 

4 Cl1ck OK. 
The screen wlll refresh wtth a graphtcal representat1on of the load assrgned on the members selected 

Assign Gravity Loads to Nllinks 
This toad~ng method ts a way to add the factored self weight of the members in as a force m any of tne global 
directions. 1t is recommended that the actual self we1ght of the structure be 1ncluded m the defin1t1on of the Static Load 
Cases 

1 Select one or more NLL1nks to assign loads to. 

2 On the Assign menu. d1ck NLLmk Loads and then Gravity ... in the sub-menu. This wlll display the NLUnk 
Gravity Loads dialog box. 

3 In the NLLink Grav1ty Loads d1alog box· 

• Select the Load Case 
• Prov1de Gravity-MultJpliers 
• Select from Add: Replace, Delete 

4 CllckOK. 

The screen wdl refresh with a graph1cal representation of the load assigned on the members selected. 

Assign Group Names 
Ass1gning Groups 1s a powerful tool1n SAP2000. 1t helps m selecting elements, d1splay1ng and pnntmg results as well 
as help1ng w1th design. 

Group Name is assigned to selected Joints and Elements. 

1 Select the Joints and Elements to which yo u want to ass1gn a Group Name. 

2 On the Assign menu, Click Group Name ... Th1s will display the Ass1gn Group dialog box. 

3 In the Assign Group d1alog box: 

• Click on the group name m the Groups hst box. A defautt name ALL is always present rn the hst box. 
• Jt 1s possible to define a new group at thJs stage by typ1ng 1n the new name in the Groups ed1t box and then 

cl1cking on the Add new Group Name button. 
• To Change or Delete a group name, chck en !he Group name m the l1st bex to setect 1t and then click on 

the Change Group Name or Delete Group Name button. 
4 Click OK. 

Tip: Te add more Joints and/or Elements to an airead y assigned Group, first select by group name, 
select more Joints and/er Elements and then ass1gn them to the Group. Group ass1gnment always 
replaces the existing Elements in that group. 
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ANALYZE MENU 

Analyzing a Model 
1 Chck on the Analyze menu and then Set Options ... This wiiJ d1spJay the Anatys1s Opt1ons dialog box. 

2 Chck to check the appropnate degrees of freedom ( U1, U2, U3, R1, R2, R3) to be available for either a 2-D 
or 3-0 model m the Available DOF's area. 

3 Altemat1vely, the available degrees of freedom may be automatically checked by click1ng on the tour Fast 
OOF's option 1.e. Space Frame, Plane Frame, Plane Gnd and Space Truss. 

4 lf a Dynam1c Analysis 1s reqUired, check the Dynam1c Analys1s box. Check1ng th1s box will display the Set 
Dynamic Parameters button. Chckmg on th1s button will display the Oynamic AnalysJs Parameters dialog 
box. 
In the Dynam1c Analysis Parameters box: 

• Type in the number of Modes 
• Select the Type of Analys1s. E1genvectors or Ritz Vectors. 
• Jf Eigenvector Analys1s is selected. then E1gen Value parameters may be def1ned. The default values 

shown 1n the ed1t boxes are adequate for a majority of cases. 
• Choosmg R1tz Vector Analys1s makes !he Start1ng Ritz Vector dialog box ava11able. 
• Select Starting Ritz Load Vectors from !he L1st of Loads. Use the ADD and RE M OVE buttons to mod1fy 

the list. 
• Cl1ck OK 

5 lf P-Delta analysis is reqUired, then check the tnclude P-Delta box. Check1ng this box wJ!I allow you to select 
the Set P-Delta Parameters button. Clickmg on this button will d1spJay the P-Delta Parameters dialog box. 

In the P-Delta Parameters diaJog box: 

• Enter max1mum number of 1teratlons or accept the default. A reasonable number is usually 5 or less. 
• Enter dispiacement tolerance or accept the default. Failure to converge may result if too small a 

dlsplacement 1s specified. The default tolerance JS 0.001 
• Enter force tolerance or accept the default. 
• Define the load combmat1on from exist1ng Load Cases us1ng appropnate scale factors. Use the Add, 

Modify and Oelete buttons lo set up th1s combmat1on. 
• Ci1ck OK. 

6 lf you want to have any analys1s results saved toan output file, then check the Generate Output box . 
Checkmg th1s box will allow you to select the Select Output Options button. Click on th1s button to drsplay the 
Select Output Results diatog box. 

In the Select Output Results dJatog box: 

• Check the type of anatysis results that you are interested 1n. 
• Checkmg thJs box will allow you to select the SeJect/Show Loads button. You can press this button and 

select which load cases and load combmations to output infonnat1on on for that category. You can not 
select the range of elements to indude rn the output. 

• Cl1ck OK. 
7 Specify the memory in Kilobytes (KB) The defaurt memory size is 2000 kilobytes. For larger problems more 

memory may be necessary. 

8 Cllckmg the OK button will save the anaJys1s parameters and exit the form. 

9 From the Analyze menu Cl1ck Run or Run min1mized. Run mmrmized will perfonn the executron in lhe 
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Note: 

background i.e w111 allow you to minimize SAP2000 while the analys1s 1s bemg camed out. 

The program will seek the number of lowest frequency (longest penad) Modes. Only the number of 
modes selected are ava1lable for any subsequent response-spectrum or t1me-h1story analys1s 
process1ng. The number of modes 1S llmited to the mass degrees of freedom. 

Caution: P-Delta analys1s m SAP2000 is an iterative analysis and the iterations do not mclude the change in 
geometry. 



DISPLAY MENU 

Display Options 

Chckrng on any of these buttons llO).&I+IP iml) from the Floating Toolbar or sorne buttons from the Toolbar 
allows you to Display your selection w1th varied opt1ons. 

Select various Display optJons by cllckmg as follows: 

To Disolay 

Undeformed geometry 

lsometnc v1ew (toggle) 

2-D V1ew (XY, X2 or YZ plane) 

3-D V1ew 

Deformed Shape 

Element Stress Dragram 

Jomt, Frame or Shell Loads 

Patterns 

Tabular Input 

Mode Shapes 

Tabular Output 

Response Spectrum 

T1me History 

Shrunken Elements (toggJe) 

Selectiva EJements 

Graphical Output 

What do you want to do? 
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Do this 

Click on I@JJ 
Cllckon 8J 
C!ick on any one of the buttons IG:OlO!Ji'DI to display an elevatJon view in 
that spec1fic plane. 

Click on [E]] 
Cl1ck on [!)} or Display menu and Show Oeformed Shape 

Cllck on [!] or Display menu and Show Element Stress Diagram. 

Right cllck wlll show the details. 

Click on Display menu and Show Loads. 

Click on Display menu and Show Pattems 

Chck on Display menu and Show Input Tables. 

Cl1ck on ~ or D1splay menu and Show Mode Shapes. 

C!ick on [!]] or Display menu and Show Output Tables . 

C!ick on D1splay menu and Show Response Spectrum Curves . 

Chck on Display menu and Show T1me H1story Traces. 

Cl1ck on ~ or chck on [ID] and select shrink. 

Chck on ~ or V1ew menu and Set Elements. 



~ D1splay Undeformed Geometry 

~ D1sptay Stat1c Deformed S ha pe 

~ D1splay Mode Shape 

~ 01splay Member Force or Stress D1agram 

~ V1ew T1me H1story Results 

~ V1ew Generated Response Spectra Curves 

...E.J Anímate Oeformed Shape 

.i!J V1ew Real Time Animation for Time Hlstory Results 

~ Pnnt Setected Graph1cal Output toa Pnnter ora File 

Displaying Undeformed Geometry 

On the Display menu, chck Show Undeformed Shape, or chck ~ from the floatmg Toolbar. 

Display Static Loads 
To display graph1ca1Jy the toads on the structure: 

1 On the D1sptay menu, cl1Ck Show Loads .. , setect the element type you are 1nterested m. This w1U display the 
Show member type Loads diatog box. 

2 tn the diatog box: 

• Select the Load Case for the loads yo u wantto see. 
• Select an ltem from the Load Type area. 
• lf prov1ded select to have the Load Values Shown. 

3 Cl1ck OK to v1ew the loads 1n the act1ve w1ndow. 

Display Joint Patterns 
To display Joint Pattems : 

1 On the Display menu, chck Show Joint Pattems 

2 In the Setect Pattem dialog box, select the pattem you are 1nterested m. 
3 Click OK to v1ew the load pattem in the act1ve window. 

Display Bridge Lanes 
To graphicaUy d1sptay lanes: 

1 On the Display menu. cl1ck Show Lanes . 

2 In the Show Lane d1atog box, 

• Select the Lane you are interested in. 
• Check Show Eccentnc1ty if you want to see the lane eccentncit1es. 

3 Click OK to v1ew the lane m the act1ve w1ndow. · 

Also See: 

Bndge Anatys1s 



Display Input in Tabular Format 
To view your mput data as it appears m an S2K file or by pnntmg Input Tables from the file menu: 

1 On the Display menu. click Show Input Tables ... Geometry Data or Load1ng Data. 

2 In the Display Geometry/Load1ng OptJons d1alog box 

• Select the Type of input information you are mterested in. 
3 Click OK to v1ew the Input Table. 

• Under the File menu, in the form that appears, there are pnnt1ng options 
• Glose the form by ciJckmg on the X in the top right hand comer of the form. 

Display Static Deformed Shape 

1 

2 

On the D1splay menu, cllck Show Deformad Shape ... , or press ~ on the floating Toolbar. This w111 d1splay 
the Deformad Shape d1alog box. 

In the Deformed Shape dialog box· 

• Select the Load Case or Combinat.Jon Name from the Load drop down hst. 
• Select the Scaling method used. Selectrng Auto will automat1cally set the scale factor. Selectrng Scale 

Factor lets the user scale the drsplacement vector components. lf the Auto was selected prevrously, then 
the scale factor text edrt box wrll show the scale factor usad by the Auto option. 

• Checkrng the Wire Shadow box will also display the undeformed shape as a reference for companson with 
the deformad shape. 

• Checking tha Cubre Curve box will drspJay the deformad etaments with a cubic curve fit. 
• After setecting the options, click OK and the screen drsplay witt be updated. 

3 Clrckrng the Start Animation button on the Status Llne wm anrmate the deformad shape of the model. 
Anrmatron speed is controrted by+ and- buttons next to the animatron button 

To vrew the displacement components for a single joint do the following: 

• Rrght clrck once on the jornt. Tha selected joint is highlighted and values are disptayed in a floatrng 
window called the Jomt Drsplacements wrndow. 

• Clicking on any other JOint updates the display. 
• Chcking anywhere etse clases the floatrng wrndow. 

Caution: The deformad shape drsplay for dynamic Load Cases rs basad on the absoluta values of maxrmum 
drsplacements. 

Note: Jornt drsplacements can not be displayed durrng anrmatron. To stop the anrmation, press the Stop 
Anrmation button. 

Display Mode Shape 

1 On the Drsplay menu, chck Show Mode Shape ... , or click [!] on the floating Toolbar. Thrs will display the 
Moda Shape dralog box. 

2 In the Moda Shape dialog box: 

• Select the moda number by either tyorng rt in the edil box or chcking on tha spin button. 
• Select the Scalrng method usad. Setectrng Auto will automatrcalty set the scale factor. Seiectmg Scala 

Factor lets tha usar scale the vector components. lf tha Auto was selected prevrousty, then the scala factor 
text edrt box will show the scale factor usad by the Auto optron. 

• Checkrng the Wrre Shadow box will also drsplay the undeformed shape as a referance for comparrson with 
the moda shape. 

• Checkrng the Cubre Curve box will drsplay the deformad elements with cubic curve fit. 
• After salecting the optrons, click OK and tha screen display will be updated. 

3 Clicking tne Start Animatlon button on the Status Lrne wilt anrmate the deformad shape of tha modal. 
Ammatron speed rs controlted by a slrding button next to tha anrmatron button. Clrckrng on + and - buttons will 
changa tha drsplay of the moda shape number by +1 or -1. 
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To vrew the normahzed modal components for a smgle jomt do the fol!owmg: 

• Right chck once on the JOmt. The selected jornt 1s highhghted and values are displayed rn a floatrng 
window caUed the Joint Modal Components window. 

• CHckmg on any other JOint updates the display. 
• Chckmg anyy.rhere etse clases the floatlng wrndow. 

Note: Modal components can not be dJsplayed dunng anrmatJon. To stop the anrmatron, press the Stop 
Anrmatron button. 

Animate Deformed Shape 
1 Plot the desrred deformed shape on the Screen. 

2 Clrckrng the Start Animation button on the Status Lrne wrll anrmate the deformed shape of the model. 
Anrmatron speed JS controlled by a slrdrng button next to the anrmatron button. Clrckrng on + and - buttons will 
change the Analysrs Case for the drsptay by +1 or -1. · 

Display Member Force or Stress Diagram 
1 On the Display menu, chck Show Element Force/Stresses, or click the F (Frame), S (SheU) or J (Jornts) 

buttons on the Floatrng Toolbar. Thrs wrll drsplay the Member Force Dragram dialog box. 

2 In the Member Force Diagram diafog box. 

lf Frames rs selected 

• Select the Load Case or Combinatron Name from the Load drop down hst. 
• Select the desired member force component. that rs. Axral Force, Shear 2, Shear 3, Torsron, Moment 2-2, 

or Moment 3-3 . 
• Select the Scaling method used. Selectrng Auto will automatically set the scale factor. Selecting Scale 

Factor lets the user scale the Member Force dragrams. lf the Auto was serected previously, then the scale 
factor text edrt box will show the scale factor used by the Auto. · 

• Check on Fill Diagram to see the dragrams wrth colorad fill. 
• Check on Show Values on Dragram to print numerical values on the diagram. 

lf Shells rs selected 

• Select the Load Case or Combrnation N ame from the Load drop down lrst 
• Select output Type as Resultants or Stresses. 
• Select the desrred member force Componen! { lf Resultants F11. F22. F12, FMAX, FMIN, FVM. M11, 

M22. M12, MMAX, MMIN, V13, V23, VMAX and i!Stresses S11, S22, S12, SMAX, SMIN, SVM, S13, S23, 
SMAXV). 

• Select the contour range. 
• Select if the Stress should be averaged at jornts. 
• Setect if the Stress contours to be drsplayed on defonned shape. 

lf JOints is selected 

• Select the Load Case or Combinatron Name from the Load drop down hst. 
• Select either Reactrons or Spnng Forces 

3 Click OK. The screen drsplay will be updated with the options selected. 

Hlnts: To display the detalfs of a force dragram for a srngle member, right chck on the member. This will 
open a floatrng wrndow whrch drsplays the variatron of the selected componen! over the length of 
the element lf more than one element exists within the tolerance ofthe cursor, a lrst box of the 
elements is drsplayed. You can then select the desired element. 

Move the pointer a long the length of the member to vrew the Distance and Vatue at that pornt. 
AJtematrvely, click on the dragram rn the floatmg wrndow at the desired locatron. The magnitude of 
force componen! and assocrated Jocatron are drsplayed. The element ID number is drsplayed in thrs 
wrndow. 

Click anywhere in the main display window to clase the Member Force Oragram window. 



View Time History Results 
Drsplaying of the time history results is a four-step process. 

Step 1: Choose a Trme Hrstory Case for which you want to see the traces. 

Step2: 
Step 3: 

Step4: 

Setect Jomts or Elements for whrch you want te drsplay Trme Htstory traces. 

Define Output Functions for Selected Jornts or Elements and add to Display LJst. 

Plot Trme H1story traces added to Drsplay List. 

What do you want to do? 

~ Drsplay Input Trme History Functions 

~ Display Jomt Output Trme History Trace 

2?J Display Frame Etement Force Output Trme Hlstory Trace 

2!J Display Shell Etement Stress Output Trme Hrstory Trace 

2?.l Drsptay Structural Energy Trme History Trace 

..!!] Display Base Function Trme History Trace 

Display Input Time History Functions 
To drsplay Input Trme Hrstory Funcllons do the following: 

1 On the Drsplay menu, cllck Show Ttme Htstory Traces ... This wtll displaythe Ttme History Otsplay Oefinttlon 
dialog box. 

2 To Add the Input Functton: 

• Cllck the Defme Functions button. This wtll display the Trme History Functton dtalog box. 
• Cltck on Ada Input Functrons from the Add drop down ltst box. 
• In the Ttme 1-:rstory Input Funcbon dralog box. 

• Select the Input Function from the Function N ame drop down lrst box. 

• Chck OK. 

• The Functron Name will be Added rn to the Functtons hst box. 
3 Chck OK on the Ttme Hrstory Functions d·ralog box. Thts wiiJ retum focus back to the Trme Htstory Display 

Definttton diatog box. 

~ Plot the vanattons of Function against Trme ( F(t) vs. t) 

.!!J Change Ltne Type. Llne Color and Scale Factorfor the Plots 

~ Zoom m on a smaller area of the plot to see the details 

~ Pnnt Time History Plots or Tables 

Display Joint Output Time History Trace 
To display Jornt Output Ttme Hrstory Trace by selecting the jornt first, do the following: 

1 Select the Jotnts for whtch you want to Dtsptay Ttme Htstory traces. 

2 On the Drsplay menu, cllck Show Ttme History Traces ... Thts will dtsplay the Ttme Htstory Display Definitton 
dralog box wrth the Joint labels ltsted as Functtons. 

3 To Modrfy an exrstmg Functron: 

• Click the Define Functions button. Thrs will dtsplay the Time History Functton dialog box. 
• In the Time History Function dratog box: 
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• Cllck on a FunctJon N ame. 

• Cltck the Modrfy/Show TH Functron button. 

• tn the Ttme History Jomt Functton dialog box 

• Accept or modify the functron name in the Function Name edil box. 

• Setect the Vector Type ( Displacement, Vetocity, Acceleration, Absoluta Acceleratton, Reacbon 
or Spnng }. 

•• 
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• Select the Vector Drrection (X Translation, Y Transtation, Z Translation, X Rotaban, Y 
Rotation, Z Rotatron ). 

• To recover the lime hrstory for a partrcutar mode. 

• Setect the lnclude One button. 

• Enter the moda number d~rectly, or, use the spin button up and down arrows to select 
from the list. 

• Click OK. 

4 Clrck OK on the Trme Hrstory Functrons diatog box. This wrtt retum focus back to the Time History Drsptay 
Definitron dialog box 

To drsplay Joint Output Trme Hrstory Trace drrectly from the Trme History Orsplay Definrtron dialog box, do the 
fottowrng: 

1 On the Drsplay menu, click Show Trme History Traces .. Thrs wriJ drsplay the Trme History Drsplay Definrtron 
dialog box. 

2 To Add a joint Function: 

• Chck the Define Functrons button. This will drsptay the Trme History Function dialog box. 
• Click on Add Joint Q¡sps/Forces from the Add drop down list box. 
• In the Trme History Jornt Functron dralog box. 

• Enter the JorntiD. 

• A functron name wilt automatrcalty appear in the Functron Name text box. 

• Select the Vector Type ( Drsplacement. Velocity, Acceleratron, Absotute Acceleratron, Reaction or 
Spnng ). 

• Select the Vector Drrectron (X Translatron, Y Translatron. Z Translation, X Rotatron, Y Rotatron. Z 
Rotatron ). 

• T o recover the Irme history for a particular mode: 

• Select tne Jnclude One button. 

• Enter the mode number drrectty, or, use the sprn button up and down arrows to select from the 
lis t. 

• Clrck OK. 

• The Functron Name will be Added in to the Functlons hst box. 
3 Click OK on the Trme Hrstory Functions dralog box. Thrs w111 retum focus back to the Trme Hrstory Drsplay 

Defin1tron dratog box. 

~ Plot the vanatron of Functron agarnst Trme ( F(t) vs. t) 

~ Plot the variatron of Functron against Function( F(t) vs. F(l) ) 

~ Changa Une Type, Une Color and Scale Factorfor the Plots 

~ Zoom in on a smaller area of the plot to see the detarls 

2!J Pnnt Ttme History Plots or Tables 

Display Frame Element Force Output Time History 
Trace 

To drsplay Frame Output Trme History Trace by setectrng the trame first. do the following: 

1 Select the Frames for which you want to Display Trme History traces. 

2 On the Drsplay menu, click Show Trme H1story Traces ... Thrs will drsplay the Time History Display Definit1on 
dralog box with the Frame Labels trsted as Functions. 

3 To Modify an existrng FunctJon: 

• Click the Define Functions button. Thrs will drsplay the Time H1story FunctJon dralog box. 
In the Time History Functron dialog box: 
• Click on a Functron Name. 

• Clrck the Modify/Show TH Function button. 

• In the Trme History Frame Funct1on dialog box 

• Accept or modify the functron name in the Funct1on Name edit box. 



• Select the Component ( Ax1al Force. Shear 2. Shear 3, Torsion. Moment 2-2, Moment 3-3). 

• Select the Locat1on Station for the Frame Element. 

• To recavar the t1me history for a part•cular mode: 

• Select the lnclude One button. 

• Enter the mode number dJrectly, or, use the spm button up and down arrows to select 
from the nst 

• Chck OK. 

5 Click OK on the Trme History FunctJons dialog box. This will retum focus back to the Time H1story Display 
Definit1on dialog box 

To display Frame Output T1me Htstory Trace d1rectly from the Trme H1story Drsplay Definttron d1alog box, do the 
following: 

1 On the D1splay menu, click Show T1me History Traces ... This wlll display the Trme H1story Display DefiOitJon 
d1alog box. 

2 To Add a frame Funct•on: 

• Click the Define Funct1ons button Th1s will display the Time History Functron d1alog box. 
• Chck on Add Frame Etement Forces from the Add drop down list box. 
• In the T1me H1story Frame Function dialog box: 

• Enter the ElementiD. 

A funct1on name will automatJcally appear in the FunctJon Na me text box. 

• Select the Component (Axial Force, Shear 2-2, Shear 3-3, Torsion, Moment 2-2. Moment 3-3). 

• Select the location Station for the Frame Element. 

• T o recover the time h1story for a particular moda: 

• Select the lnclude One button. 

• Enter the mode number d1rectly, or, use the spm button up and down arrows to select from the 
lis t. 

• Click O K. 

• The Function Name will be Added 1n to the Functions list box 
3 Click OK on the T1me H1story Funct1ons d1alog box Th1s will retum focus back to the Time History Drsplay 

Defimtron dialog box. 

....?!J Plot the vanat1on of Functfon agafnst Time ( F(t) vs. t) 

~ Plot the vanation of Funct1on agamst FunctJon( F(t) vs. F(t) ) 

~ Changa Une Type, lrne Color and Scale Factor for the Plots 

~ Zoom 1n on a smaller area of the plot to see the details 

~ Pnnt T1me HJstory Plots or Tablas 

Display Shell Element Stress Output Time History 
Trace 

To display Shell Output Time History Trace by selecting the shell first, do the fo1Jow1ng: 

1 Select the Shells for whJch you want to Drsplay T1me H1story traces. 

2 On the D1sptay menu, cl1ck Show Trme History Traces ... Th1s W1JJ display the Trme Hrstory D•splay Definition 
diatog box with the Shelllabels listad as Functrons. 

3 To Modffy an existing Funct1on: 

• Chck the Define Funct1ons button. This will display the T1me History FunctJon d1alog box. 
• In the T1me HLstory Function d1alog box: 
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• Click on a Funct1on Name. 

• Click the Modify/Show TH Function button. 

• In the Time H1story Shell Function d1alog box 

• Accept or modify the funct1on name in the Function Name edrt box. 

• Select output Type as Resultants or Stresses ( top or bottom ). 

o 5elect the Componen! ( lf Resultants; F11, F22, F12,FMAX,FMAIN.FVM, M11, M22, 
M12,MMAX.MMIN, V13, V23,VMAX and if 5tresses; 511, 522. 512, 5MAX, 5MIN, 5VM, 513, 

.'·' 

. . 



S23. SMAX) 

• SeJect the Jo1nt of the Shell at which the Resultants or Stresses are required from the Jomt 
drop down list. 

• To recover the time history for a particular mode: 

• Select the lnclude One button 

• Enter the mode number d1rectly, or, use the spin button up and down arrows to select 
from the llst. 

• Click OK. 

6 Click OK on the T1me History Functions diatog box Th1s w111 retum focus back to the T1me History D1splay 
Definition dialog box 

To drsplay Shell Output T1me H1story Trace d1rectty from the T1me H1story Display Definit1on dralog box, do the 
follow1ng: 

1 On the Display menu, chck Show T1me H1story Traces ... Th1s will d1splay the T1me Hrstory D1splay Definition 
d1atog box. 

2 To Add a shell Function: 

• CJ1ck the Define Functions button. This w111 display the T1me H1story Function d1alog box. 
• Cl1ck on Add Shell Element Forces from the Add drop down list box. 
• In the T1me H1story Shell Function d1atog box: 

• Enter the ElemenUD. 

• A function name will automat1cally appear m the Function Name text box. 

• Select output Type as Resultants or Stresses ( top or bottom ). 

• Select the Componen! ( lf Resultants: F1 1, F22. F12,FMAX.FMAIN,FVM. M1 1. M22. 
M12,MMAX,MMIN, V13, V23,VMAX and if Stresses; S1 1, S22. S12, SMAX. SMIN, SVM, S13. S23, 
SMAX ). 

• Select the Joint of the Shell at which the Resultants or Stresses are reqwred from the Jomt drop 
down list. 

• To recover the time history for a particular mode: 

• Select the lnclude One button. 

• Enter the mode number dJrectly, or, use the sp1n button·up and down arrows to select from the 
lis t. 

• Cl1ck OK. 

• The Function Name will be Added 1n to the Funct1ons IJst box. 
3 Cl1ck OK on the T1me H1story Funct1ons dJalog box. Th1s w1ll retum focus back to the Time History D1splay 

Defimtron dJalog box . 

..!!J Plot the variat1on of Funct1on against T1me ( F(t) vs. t) 

..!!J Plot the vanatton of Function against Function( F(t) vs. F(t) ) 

~ Change Une Type, L1ne Color and Scale Factor for the Plots 

~ Zoom m on a smaller area of the plot to see the deta1ls 

~ Pnnt T1me History Plots or Tables 

Display Structural Energy Time History Trace 
On the Display menu, click Show T1me H1story Traces ... This will display the Ttme History Display Definition 
d1alog box. 

2 To Add the Energy Functions: 

• Click the Define Functions button. Th1s will display the T1me H1story Function dialog box. 
• CJ1ck on Add Energy Functions from the Add drop down list box. 
• In the Energy Funct1ons dlalog box: 

• Select the des!fed Energy Funct1ons: Input Energy, Kinetic Energy, Potential Energy, MDamp 
Energy, NDamp Energy, Nlllnk, Energy Error. 

• CJ¡ckOK. 

• The Funct1on Name will be Added in to the Funct1ons llst box. 
3 Ct1ck OK on the T1me H1story Funct1ons d1alog box. Thts will retum focus back to the Time History Otsptay 

Defin1üon dialog box. 



~ Plot the vanation of Functron agarnst Trme ( F(t) vs. t ) 

~ Plot the vanatron of Functron agarnst Functton( F(t) vs. F(t) ) 

~ Change Lrne Type, Lrne Color and Scale Factor for the Plots 

~ zoom rn on a smaller area of the plot to see the detarls 

~ Prrnt Trme Hrstory Plots or Tables 

Display Base Function Time History Trace 
On the Drsplay menu, chck Show Time History Traces .. Thrs wlll drsplay the Trme Hrstory Drsplay Definitlan 
dralog box. 

2 To Add the Base Function: 

• Chck the Defrne Functrons button Thrs will display the Trme Hrstory Function dialog box. 
• Clrck on Add Base Functrons from the :Add drop down lrst box. 
• In the Base Functrons dralog box: 

• Select the desired Base Functrons: Base Shear X, Base Shear Y, Base Shear Z, Base Moment X, 
Base Moment Y, Base Moment Z. 

• Clrck OK. 

• The Functron hlame will be Added in to the Functions hst box. 
3 Clrck OK on the Time History Functrons dialog box. Thrs will retum focus back to the Trme History Display 

Definrllon dralog box. 

~ Plot the vanatron of Functron against Trme ( F(l) vs. t ) 

~ Plot the variatron of Functron agarnst Functron( F(t) vs. F(t) ) 

~ Change Lrne Type, Lrne Color and Scale Factor for the Plots 

~ Zoom rn on a smaller area of the plot to see the details 

~ Prinl Trme Hrstory Plots or Tablas 

Display Group Summation Forces Time History 
To drsplay Group Summation Forces Trme Hrstory Trace from the Trme History Orsplay Definition dialog box, do the 
following: 

1 On the Orsplay menu, click Show Trme Hrstory Traces .. Thrs will drsplay the Trme Hrstory Drsplay Definition 
dralog box. 

2 To Add a Group Summatron Forces Functron: 

• Click the Define Functions button. This will display the Trme History Function dialog box. 
• Clrck on Add Group Summatron Forces from the Add drop down lrst box. 
• In the Trme Hrstory Group Functron dralog box: 

• Select the Group name from the Group drop down !rst box. 

• A functron name will automatically appear rn the Function Name text box. 

• Select the Component Force or Moment rn the three global drrections. 

• To recover the Irme history for a partrcular mode: 

• Select the lnclude One button. 

• Enter the mode number drrectly, or, use the spin button up and down arrows to select from the 
hst. 

• Chck OK. 

• The Function Name will be Added rn to the Functrons list box. 
3 Click OK on the Time History Fundrons dralog box. Thrs wifl retum focus back to the T1me History Drsplay 

Definition dialog box 
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2!J Plot the variation of Funct1on aga1nst T1me ( F(t) vs. t) 

2!J Plot the vanat1on of Function against Functlan( F(t) vs F(t) ) 

2!J Change Une Type, Lme Color and Scale Factor for the Ptots 

2!J Zoom 1n on a smaller area of the ptot to see the deta1ls 

2!.l Pnnt T1me History Plots or Tablas 

F(t) vs. t 
To plot the variations of one function against time: 

In the T1me History Display Definition diatog box. 

• Choose the F(t) vs. t Tab. 
• From the drop down llst box, select the Trme H1story Case for which you want to display Input /Output 

T1me H1story Traces. 
• Click on the Function name to be plotted 1n the L1st of Functions box. 

Chck on the Add button. The funct1on na me w1H be added to the Plot Functions list box. 
• Repeat to 1nclude other funclion names (if any) for Slmultaneous display of severa! funct1ons 
• Use the Remove button to remove a funct1on from the Plot Funct1ons hst box. 
• Use the Show button to display the function's attnbutes ( e.g. Vector Type, OirectJon etc.) 
• Enter the time range 1n the From and To ed1t boxes. By default, the fu!l t1me range Js selected. 
• Enter the ax1s labels 1n the Honzontal and Vertical ed1t boxes tn the Axts La beis area. 
• Remov1ng the check mark from the Grid Over1ay box will d1sabte the generat1on of a grid through the ma¡or 

d1visrons of the axes. 
3 Cltck on D1splay. Th1s will open a ftoating window labeled Ttme History Traces in which functions are 

graphtcally displayed. A sma!l Legend w1ndow displays the max1mum and mtmmum numencal vatues for the 
funct1ons and another small wmdow Just below ti displays the coordtnates of the po1nter. 

2!.l Plot the vanations of Function agamst Time ( F(t) vs. F(t} ) 

~ Change Une Type, L1ne Color and Scale Factor for the Plots 

2!.l Zoom in on a smaller area of the plot to see the details 

~ Pnnt T1me History Plots or Tables 

F(t) vs. F(t) 
To plot the variations of one function against another function: 

1 In the Time History Display Oefinition dialog box: 

• Choose the F(t) vs. F(t) Tab 
• From the drop down list box, select the Ttme H1story Case for which you want to display Input /Output 

Time History Traces 
• Select the honzontal time function from the drop down l1st m the Choose Funct1ons area. 
• Select the verttcal Irme funct1on from the drop down hst 1n the Choose FunctJons area. 
• Enter the t1me range tn the From and To boxes By default, the full time range is selected. 
• Enter the ax1s labels 1n the Honzontal and Vertical ed1t boxes tn the tn the Axis Labels area. 
• Removing the check mark from the Gnd Overlay box will drsable the generat1on of a gnd through the majar 

diVISJons of the axes. 
4 Chck on Display. Th1s wtfl open a noatmg window labeled T1me H1story Traces rn which tunct1ons are 

graph1cally d1splayed. A small Legend w1ndow d1spJays the Funct1on names for the Honzontal and Vert1cal 
axes together w1th the1r attnbutes and another small wmdow JUSt below it d1spfays the coordinates of the 
pointer . 

....21 Plot the vanatrons of Function aga1nst T1me ( F(t) vs. t) 

~ Change Une Type, Une Color and Scale Factor for the Plots 

~ Zoom m on a smaller area of the plot to see the details 



~ Pnnt T1me H1story Plots or Tables 

Scale Factor, Line Type and Color 
To change the Line Type 

• Cl1ck on the funct1on name m the Plot FunctiOns l1st box. 

• Seiect the hne type to be SolJd, Dashed or Ootted from the Line Options area. 

To change the Line Color 

Chck the Color button m the Lme Color area Th1s will d1splay the Color dialog box. 

• Cl1ck on the des1red color in the palette. 

• Cl1ck OK. 

To change the Scale Factor 

Note: 

The Scale Factors default to 1. 

• Check the Honzonta1Nertical d1rect1on for which you want to change the S cale Factor. 

• Press the Define button that appears. 

• Enter 1n the HonzontaiNertlcal Scale for the Max1mum and Mm1mum Scale Factor in the 
appropnate ed1t box. 

• Cl1ck OK 

Max1mum and M1n1mum Scale Factors of zero mean that the default scale factors are used. 

Zoom into the Plot 
T o zoom on a spec1fic part of the plot: 

~ Pomt to a comer of the region, hold down the mouse button and drag to define the rectangular zoom 
reg1on. and release the mouse button. 

• Chckmg anywhere 1n the mam display area bnngs back the full v1ew. 

Print Time History or Response Spectrum Plots or 
Tables 

To print the Plots dJsplay do the following: 

• From the Pnnt menu, choose 'Pnnt Graphics'. 
To pnnt the Tables (results in a numencally tabulated form, 1n an ASCII format,) do the followlng: 

• From the Print menu, choose ·Pnnt Tables'. 
To save the Tables 1n a File, do the following: 

• From the Pnnt menu, choose 'Save Tables as F1Je .. .'. Th1s will display the Save File As dialog box 
• In the Save F1le As d1alog box: 

• Select the dnve and the directory 1n wh1ch the file is to reside. 

• Entera new filename or overwrite an ex1stmg file. 

Cl1ck the OK button. 

Clicklng anywhere else clases the floatmg window. 

View Generated Response Spectra Curves 
1 Select the Jomt for which you want to Display Response Spectrum Curve. 

2 On the D1splay menu, click Show Response Spectrum Curves ... This wlll display the Response Spectrum 
Generation dialog box. The d1alog box has five Tabs labeled Define, Axes, Options, Freq~ency and 
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Damping. Clickmg on any Tab hrghlrghts rt. 

2!.1 The Define T ab 

2!.1 The Axes Tab 

~ The Options Tab 

2!.1 The Frequency Tab 

2!.1 The Da m prng T ab 

After mak'rng the necessary changes rn aJI the Tabs in the Response Spectrum Generatron dralog box: 

3 Click on Drsplay to open a floatrng wrndow Jabeled Response Spectrum Curves in which the response 
spectra are graphrcally drsplayed. A small Legend window drsplays the Jornt number Drrectron, Scale Factor, 
Wrdenrng percentage and Dampmg Ratros color ceded to correspond to the Spectra Curves Another small 
wrndow JUSt below rt drsplays the coordinates of the pointer 

4 Click on Done to save the changes made rn alt the Tabs and exit the Response Spectrum Generatron dralog 
box . 

..!?J Zoom in on a smalter area of the plot to see the detarls 

2!.1 Change Line Type, Une Color and Scale Factor for the Plots 

2!.1 Prrnt Response Spectrum Plots or Tables 

Spectrum Generation Define Tab 
In the Define Tab: 

• From the drop down Jist select the Trme History Case for whrch you want to generate a Response 
Spectrum. 

• Clrck on a Jomt in the Choose a Joint lrst and then clrck on the appropriate drrectron X, Y or Z from the 
Vector Direction optron adJacent to rt to define the drrectron for which you want to generate a spectrum. 
By default the X (global X-drrectron) rs checked. 

Spectrum Generation Axes Tab 
In the Axes Tab: 

• Select the Abscissa to show as either Frequency or Period. 
• Select the Ordinate to be one of the five chorces r.e. SO (Spectral Drsplacement). SV (Spectral Velocrty), 

PSV (Pseudo Spectral Velocrty), SA (Spectral Acceleratron) and PSA (Pseudo Spectral Acceleratron) 

Spectrum Generation Options Tab 
In the Options Tab: 

• Set the Abscissa scale. By default Log is checked 
• Changrng the percentage of Spectrum Widening wrll change the peaks of response spectra curves. The 

default rs set to zero. 
• Set the Ordinate scate. By default Arithmetic rs checked. 
• Changrng the ordrnate scale factor wr!l scale the spectral values The default is 1.0. 
• Removmg the check mark from the Grid Overlay box wrll disable the generatron of a grid through the maJar 

drvisrons of the axes. 

Spectrum Generation Frequency Tab 
In the Frequency Tab: 

• Removrng the check mark trom of the Default box wili exclude the built-rn set of frequencres in the 
generation of response spectrum. 



• Removing the check mark from of the Structural box will drsabte merging of the structural trequenc1es into 
the set of frequenc1es used m the generatron of response spectrum. 

• T o enter user·defined frequencies do the followrng: 
• Cneck the User box in the tnclude Frequenc1es area. 

Enter the vatue m the User Frequencres edil box. 

• Cl1ck the Add Value button 

• Repeat to include all the frequencres. 

Use the Changa Value and Delate Value buttons to edrt or delete the values 1nduded. 

Spectrum Generation Damping Tab 
tn lhe Camping Tab: 

• Use th1s optron to add a new dampmg value or edil lhe defaull damp1ng values. 
• T o Add a new damp10g val u e do the following: 

• Type in a new value m the edit box. 

• Click the Add Value button. 

• To change one of lhe default damping values do the following: 
• Cl1ck on the damping value rn the Damprng values hsl box. 

• Change the vatue 1n the edil box. 

Chck the Changa Value button. 

• To remove one of the values from the set do the following: 
• Chck on the damprng value. 

• Ctrck lhe Delate Value button. 

Display Group Joint Force Sums 
The option 1s an easy way to find the sum of torces and momenls on a Group of jo1nts. 

1 On the Display menu, chck Show Group Jo10t Force Sums. Thrs will display the Selecl Groups dralog box. 

2 Setect !he Group or Groups for which you wantthe sum. 

3 Click OK lo v1ew 1n tabular form the sum of the shears and moments in lhe group. 

4 You can pnnt the lable from the File menu. 

5 When finished, clase the table by chcking on the clase button al the top right of the form. 

Note: The group for the Group Sum mus! be selected carefully. The group must consrst of a set of joinls 
and the elements d1rectty connected to only one s1de of them. For exampte 1f the base shear for a 
structure is required, the group should consist of the ¡oints at the base of the structure and lhe 
frame/shell elements above them that are directty connected to them. 

Display Joint lnfluence Unes 
The rnfluence lines can be d1spJayed for any jo1nt disptacement, react1on or force componen! dueto a un1t toad on a 
defined Bridge Lane m the structure. 

1 On the Display menu, click Show lnfluence Lrnes ... Joints. Th1s wiJJ display the Show Jornts lnfluence Line 
dialog box. 

2 Select the Lane for which you want to see rnfluence trnes. 

3 Setect the Joint for wh1ch the results are reportad. 

4 Select the Vector Type as D1sptacement, Spnng Force or React1on. There may be no influence lines for 
so me of these Vector T ypes, dependrng on the structural configurat1on. 

5 Setect the Scahng method used. Selecting Auto will automaticarty set the scale factor. Selecting Scale Factor 
lets the user scate the diagrams. Jf the Auto was selected previously, then the scale factor text ed1t box will 
show the scale factor used by the Auto. 

6 Pressing the Table button wllt show the influence lme data points m tabular form. The tabla 1ncludes the 
Lana na me, Frame name, Location relatJYe to the startrng po1nt of the tane, Location relat1ve to the r end of 
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the trame member, and the rnfluence hne value. 

7 Clrck OK to vrew the lnfluence line or Cancel to clase the dralog box without viewing the influence lines. 

Display Frame lnfluence Lines 
The influence lrnes can be drsplayed for any Frame mamen!, shear, torsion or axralload componen! dueto a unrtload 
on a defined Bridge Lane rn the structure. 

1 On the Drsplay menu, clrck Show lnfluence Llnes ... Frames. Thrs will drsplay the Show Frames lnfluence 
Une dralog box. 

2 Select the Lane for which you want to see influence llnes. 

3 Select the Frame for which the results are reportad 

4 Select the Componen! as Moment, Shear. Torsron or Axral Load. There may be no influence lines for sorne 
of these Componen!, dependmg on the structural configuration. 

5 Select the StatJon (Output Segment ) for which you want the influence lines. 

6 Select the Scaling method used. Selecting Auto wrll automatlcally set the scale factor. Selecting Scale Factor 
lets the user scale the diagrams. lf the Auto was selected prevrously, then the sea le factor text edrt box will 
show the scale factor used by the Auto. 

7 Pressrng the Table button will show the rnfluence lme data points in tabular form. The table rncludes the 
Lane name, Frame name, Locatron relatrve to the startrng point of the lane, Locatron relatrve to the i end of 
the frame member, and the rnfluence hne value. 

8 Clrck OK to view the lnfluence line or Cancel to clase the dralog box without vrewmg the rnfluence lrnes. 

Display Joint or Member Text Output on Screen 

1 

2 

On the Drsplay menu. click Set Output Table Mode ... , or click ~ on the Floatrng Toolbar. This will 
drsplay the Seled Output dialog box. 

In the Select Output dralog box. 

• Select the Load Cases and/or the Load Combinatrons la beis for which the output is to be displayed rn a 
tabulated form Loads may be selected by chckrng on the Load la beis rn the hst box. For selectrng a range 
of loads, click and drag, or for multrple loads hold down the Ctrl Key and chck on different load labels. 

• Click OK to clase the Select Output dralog box. 
• To drsplay the member force, drsplacement or reactron output table, right clrck on the element or ¡oint of 

rnterest. Thls will open a floating wrndow whrch drsplays the output table. Jf more than one element or joint 
exists within the tolerance of the cursor, a lrst box of the elements and ¡ornts is drsplayed. You can then 
ctrck on the desrred element or jmnt. 

• Click anywhere in the main drsptay wrndow to ctose the output table window. 



DESIGN 

Steel Design 
On the Des1gn menu, clJck Steel Des1gn. This will sw1tch the program into the Steel Oes1gn mode. 

What do you want to do? 

2?J Def1ne Sect1on Propert1es 

~ Settrng Steel Design Parameters 

~ Group Elements for Oes1gn 

~ SelecURedefine Des1gn Load Comb1nat1ons 

~ Overwrite Element Design Propert1es 

~ Re place Auto with Optima! Sect1ons 
"· .1!1 Display Steel Stress Check/Oes1gn Rat1os on Screen 

.!!J Display Steel Stress Check/Oesign Input on Screen 

.!!J Review Steel Stress Checi(.{Des1gn Detall 

~ Redes1gn a Steel Member 

~ Start Des1gn/Check of Structure 

~ Update Analys1s Sect1ons 

..?!J Pnnt Des1gn Results toa Printer ora File 

~ Defin1ng Elements as a single Member for bending 

Concrete Design 

MENU 

On the Des1gn menu. chck Concrete Design. This will sw1tch the program into the Concrete Oesign mode. 

What do you want to do? 

2!J Define Sect1on Propert1es 

2!.1 Senmg Concrete Des1gn Parameters 

~ SelecURedefine Design load Combinatlons 

..?!J Overwnte Element Oesign Propert1es 

:.:ill Display Concrete Des1gn/Check Output on Screen .,, . 
....!!.! Display Concrete Design!Check Input on Screen 
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~ Revrew Concrete Desrgn/Check Detail 

~ Vrew lnteraction Diagram for a Concrete Cotumn 

_21 Redesign a Concrete Member 

~ Start Desrgn!Check of Structure 

~ Update Anatysis Sections 

~ Pnnt Design Resutts to a Printer or a File 

2!J Definrng Elements as a single Member for bendrng 

Group Elements for Design 
Grouprng elements for design will desrgn all the elements m the group to the same sectron or steel rernforcement area. 
Usrng the sectron or reinforcing area that wrll work for all of the members rn the group. 

NOTE: Grouping elements for design currently onty wor1<s on steel members wrth Auto Select sections assigned to 
them 

1 On the Design Menu, click Select Design Groups ... This wiJI drsplay either the Steel Design Group Selection 
or Concrete Oesign Group Selectron dialog box. 

2 In the Steel or Concrete Desrgn Group Selectron box: 

• Select previously defined Groups from the lrst of Groups 
Click on the Add button to add Groups to the Desrgn Groups hst 

• Clickrng on the Remove button wrll remove the selected Groups from the Oesrgn Groups lrst 
• crrck OK 

Start Design/Check of Structure 
1 Select the Frame Elements to be designad or checked 

2 On the Desrgn Menu, clrck Start Design/Check of Structure .. 

3 This will immedrately start the stress check or desrgn of all the selected frame members in the model. 

4 The ratro of actual to allowable stress/capacrty or member desrgn reinforcement, based upon the prevrously 
selected combos, wrJI be displayed. 

5 Subsequent member selectrons can be Oesrgned/Checked and added to the display. 

6 The Check/Design results display will onty affect the selected elements and all other eiements will show the 
prevrous values, if any. 

Note: lf no Elements are seJected then the program wrli automatically select aJJ Frame Etements and 
perform the Desrgn or Check. 

Selecting Design Load Combinations 
1 On the Desrgn Menu, click Select Desrgn Combos ... This will drsplay the Oesrgn Load Combinatrons 

Selectron dialog box. 

2 In the Desrgn load Combinatrons Selectron box: 

• Select prevrousty defined Combos from the Ust of Combos 
• Clrck en Add button to add Combos to the Desrgn Combos list 
• Clrcking on Remove button will remove the selected Combos from the Design Combos hst 
• Clrck OK 

Note: The Design load Combrnatrons Selection menu lrsts a series of default load combinatrons tabeled 
DCON# for Concrete desrgn and DSTL# for Steel design. The number and type of default 
combrnatlons depenas upon the statrc load Cases previously defined. Other user defined Load 
Combos that were rndicated as design combos in the Load Combinatron Data dialog box will also 
be mctuded in the Desrgn Combos 

lf other load combrnatrons have been defined and were not mdrcated as design combos in the Load 
Combinatron Data dralog box, they are shown under list of Combos. The Des1gn Combos Hst can 
be modified by removing ene or more default Combinations and/or by adding from the list of 
Combos. 



Cltcktng on the Show button wtll present the Load Cases and Sea le factors for the htghlighted 
Combo. 

Overwrite Element Design Data 
1 Select the Elements for which you want to overwnte asstgnments. 

2 On the Desrgn Menu. click ReDefine Etement Destgn Data .. This will dtsplay the Element Overwnte 
Assrgnment menu. 

3 In the Etement Overwrite Assignments dta!og box· 

• Check the destred Element assrgnments to be overwritten by chckmg on the releva ni check boxes for K-
factors. Unbraced Lengths. Cm. Cb, Uve Load Reducllon Factor or Magnificatron Factors 

• Provide the new value in the edtt boxes 
• Changa the Element Section by cftcktng on the Changa button 
• lf Concrete sections are selected, choose the Element Types to be Special, lntermedrate or Ordmary. 

lf Steel secttons are selected, chck the Overwrite Allowable Stresses button to overwnte axtal, bending and 
shear allowable stresses. 
Cltck the OK button 

Note: Entenng a value of Zero sets the value back to the program default. 

Tip: 

The Element Overwrite menu ltsls a senes of asstgnments, whtch can be overwntten. The selectron 
options are mutually exclusrve and may be selected tn any arder. 

Selecting and modifytng the appropnate factor will overwnte the default or computad value. 

The new value(s) are dtsplayed in the active wtndow. 

The Effective Length Factors K33 (majar) and K22 (minar) can be any positiva reasonable number. 

The Unbraced Length Ratros L33 (majar) and l22 (mtnor) are to be tnput as a positiva ratto of the 
fui! length. Le. 0.33 O. 75, etc. 

The bending coeffictent Cm can be any positiva number less than or equal to 1 .O. 

The moment gradtent coefficrent Cb can be any positiva number from 1.0 to 2.3. 

The Uve Load Reduction Factor 1s a postttve number between·O and 1.0 and represents a fractton 
of the fuJIIIve load prevtously input. 

The Non Sidesway and Stdesway Magnification Factors 0833, 0822, 0833, 0822 are numbers 
greater thañ·or equal to 1.0 lf P-delta 1s camed out DS33 and 0822 may be set to 1.0 

Element Class specification (Column or Beam) for Concrete Secttons is done at the Section 
definition leve!. 

Defining Elements as a Single Member for 
Bending 

lt ts often practtcal to diVIde structural members mto multtple elements when developtng your computar model. 
However for destgn 11 ts important to know the actual member start and end potnt. This tnformatron is used for defining 
un braced length in the mBJOr and minar access bending, Cb and Cm values where appltcable as well as the 
provtsions relat1ng to the distnbution of moment and shear along a member for Speaal and lntermedtate moment 
resisttng trames. 

SAP2000 provtdes vanous ways to enter thts mformation for destgn. L22.L33 Cb and Cm can be defined directly for 
each element tn the modal using the Element Overwnte Assignments dialog box. This will however not supply the 
destgn module wtth the dtstributton of moment and shear a long a member. 

To Define a set of trame elements to be part of a single Frame Member for bending 1n the majar and/or minar 
dtrectton: 

Select the frame elements that you want to asstgn as a single Member for bending tn the majar and/or mtnor 
dtrectron. 

2 On the Design Menu, cltck ReDefine Element Oestgn Data ... This will display the Element Overwrite 
Asstgnment menu. 

3 In the Element Overwrite Assrgnments dtalog box: 
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• Check Define Member for Ma¡or Bend1ng to ass1gn the selected frame elements to be part of the same 
trame member for majar ax1s bend1ng. 

• Check Define Member for M1nar Bending ta ass1gn the selected trame elements to be part of the same 
trame member for m mor ax1s bendmg. 

• Chck the OK buttan. 

Note: Values overwntten explic1tly in the Element Overwnte Assignments dialog box will take precedence 
over the values calculated by the defined bending members. AU elements selected as a part of the 
defined Bendmg Member must be connected. Only one Member can be defined at one t1me. 

Replace Auto with Optimal Sections 
Th1s setect1on will re place the "AUTO" sect1ans with the optimally section chosen from the auto select group. Th1s is 
an irreversible act1on 1.e. once the AUTO sect1ons are replaced they will no longer be available for opt1mal design. Yau 
wilt have to re-ass1gn them as AUTO rf you want them 1ncluded 1n OptlmJzatJon. 

1 Select the trame members that you want ta replace the analysis sectians for. 

2 On the Des1gn Menu, click Replace Auto w/Opt1mal Sect1ons. 

3 This wi111ssue a wamrng message that Replac1ng Auto-Selected Sections will changa the analysis model 
and cause analysis results ta be deleted. 

4 Chck OK if acceptable otherwrse click Cancel. 

Note: This optian should anly be used after the final design cycle. Use Uodate Analysis Sect1ans ta 
update the sect1ans chosen at the des1gn/redesign leve! as 1t will update the sect1ons propert1es for 
analys1s w1thout changmg the sect1ons from being "AUTO". 

Display Design lnput/Results on Screen 
What do you want to do? 

~ D1splay Steel Stress Check/Des1gn Input on Screen 

~ D1splay Steel Stress Check!Des1gn Rat1os on Screen 

~ Drsplay Concrete Design/Check Input on Screen 

~ Display Concrete Design!Check Output an Screen 

Display Steel Stress Check/Design Ratios on 
S creen 

On the Design Menu, clrck Orsplay Design lnfo ... 

2 This will display the Display Design Results box. 

3 In the Display Design Results box, clrck on Des1gn Output. then from the drop down lrst box chaose e1ther P­
M rabos or Shear Rat1os to be displayed. 

4 Click OK. This will refresh the window and d1splay the Stress check Ratios. 

Display Concrete Design/Check Output on Screen 
1 On the Design Menu, clrck Display Oesign lnfo ... 

2 Th1s will display the Display Oesign Results box. 

3 In the Display Design Results box, click on Des1gn Output, then from the drop down l1st box choose either 
LongitUdinal Re1nforcement or Shear Reinforcement to be d1splayed. 

4 Cllck OK. This will refresh the wmdow and display the area of Rernforcement 



Display Steel Stress Check/Design Input on 
S creen 

On the Oes1gn Menu, click Display Design lnfo .. 

2 This will display the Display Desrgn Results box. 

3 In the Display Design Results, click on Design Input, then from the drop down l1st box you may choose 
Design Sections, K-factors. Effect1ve Length Ratios, Cm Factors, Cb Factors, Ltve Load Reduction Factors. 
OS Factors, OS Factors. Destgn Type, Ax1al Allowables, Bend1ng AJJowables or Shear Allowables to be 
d1splayed. 

4 Cllck OK Th1s will refresh the w1ndow and d1splay the mput parameter setected. 

Display Concrete Design/Check Input on Screen 
On the Design Menu. click Display Des1gn lnfo ... 

2 Th1s w1JJ d1splay the Display Des1gn Results box. 

3 In the Display Des1gn Resutts, cllck on Des1gn Input, then from the drop down list box you m ay choose 
Des1gn Sect1ons, K-factors. Etfective Length Rat1os. Cm Factors, Cb Factors, L1ve Load Reduct1on Factors, 
OS Factors, DB Factors or Design Type to oe d1splayed. 

4 CIJck OK ThJs will refresh the window and d1splay the input parameter selected. 

Review Stress Check/Design Details 
What do you want todo? 

2?.1 Review Steel Stress Check/Des1gn Detail 

~ Rev1ew Concrete Des1gn/Check DetaiJ 

Review Steel Stress Check/Design Detail 
1 On the Oesign Menu, click Display Oes1gn lnfo ... 

2 This will display the Display Design Results box. 

3 In the Display Design Results box. chck on Des1gn Output, then from the drop down l1st box choose either P­
M rat1os or Shear Rat1os to be displayed. 

4 Cl1ck OK. This wlll refresh the window and display the Stress Check Ratios. 

5 Right Click on a member for which you want see the Design Details. Th1s wiiJ display the Steel Stress Check 
lnformatlon box w1th a breakdown of the Stress Rat10 ( Axial, Majar and Minar Bend~ng, and Majar and Minar 
Shear ). 

6 In the Steel Stress Check lnformatJon box, click Details to see more details (Actual Stress, Allowable Stress, 
Cm, Cb, Fe' etc.) pertaining to the calculation of the Stress RatJo. 

Review Concrete Design/Check Detail 
On the Des1gn Menu, click Display Des1gn lnfo ... 

2 ThJs w11l display the Display Oesign Results box. 

3 In the Display Des1gn Results box, click on Oesign Output, then from the drop down list box choose either 
Longitudinal Re~nforcement or Shear Re~nforcement to be dJsplayed. 

4 Chck OK. This will refresh the window and display the area of Re1nforcement. 

5 R1ght Click on a member for wh1ch you want see the Design Details. This will display the Concrete Design 
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lnformation box with Flexura! and Shear Reinforcement areas lisled ( Top Reinforcement. Bottom 
Remforcement and Shear Reinforcement for Beams and Longitudinal and MBJOr and Mrnor Shear 
Remforcement for Columns). 

6 In the Concrete Design tnfonnation box, click DetaiiS to see more details (Vn, Ve. Vs. Cm MBJOr and Mrnor 
Magnificatron factors etc.) pertarnrng to the catculation of the Reinforcement for each of the load 
combrnations. 

View lnteraction Diagram for a Concrete Column 
1 On the Desrgn Menu, Click Display Design lnfo ... 

2 This will display the Display Desrgn Resutts box. 

3 In the Drsptay Desrgn Results box. click on Oesign Output, then from the drop down lrst box choose 
Longrtudrnal Reinforcement to be drsplayed. 

4 Click OK. ThiS will refresh the wmdow and display the area of Longitudrnal Rernforcement. 

5 Right Click on a Cotumn for which you want to see the lnteractron Dragram. This will drsplay the Concrete 
Design lnformatron box. 

6 In the Concrete Oesrgn lnformation box, click lnteraction. This will display the rnteraction diagram. Click on 
pxy to see the 3·0 interactron, xy to see the interaction between Mx and My, px to see the rnteraction 
between P and Mx and py to see the interactron between P and My. 

7 Use the spin buttons to changa the Plan and Elevation anglas. 

8 T o zoom on a specrfic part of the plot: 

• Point toa comer of the region, hold down the mouse button and drag to define the rectangular zoom 
region, and ralease the mouse button. 

• Clicking anywhere in the marn display area brings back the full view. 
9 Use the Pnnt menu to print lnteractron Cures. 

Redesign a Steel Member 
1 On the Design Menu, click Orsplay Oesrgn tnfo ... 

2 This will display the Display Desrgn Results box. 

3 In the Display Design Resutts box, chck on Design Output, then from the drop down list box choose erther P· 
M ratros or Shear Ratios to be displayed. 

4 Cllck OK. This will refresh the wmdow and display the Stress Check Ratros. 

5 Right Clrck on a member for which you want see the Design Detalls. This will display the Steel Stress Check 
lnformatron box wrth a breakdown of the Stress Ratro ( Axral, Majar and Minar Bendrng, and MaJar and Mrnor 
Shear ). 

6 In the Steel Stress Check lnformation box, click Redesrgn. This will display the Element Overwnte 
Assignments box. 

7 Make appropriate changas to the assignments and click OK. This will bring you back to the Steel Stress 
Check lnfonnation box with the redesign carned out and the new results displayed in the design informatron 
box. 

Redesign a Concrete Member 
1 On the Desrgn Menu, chck Display Oesign lnfo ... 

2 This will display the Display Desrgn Results box. 

3 In the Display Desrgn Results box, click on Design Output, then from the drop down hst box choose either 
Long¡tudmal Remforcement or Shear Reinforcement to be drsplayed. 

4 Click OK. Th1s will refresh the window and displaythe area of Rernforcement. 

5 Right Click on a member for which you want see the Design Details. This will display lhe Concrete Design 
lnfonnat1on box Wlth Flexura! and Shear Reinforcement areas lrsted ( Top Rernforcement, Bottom 
Rernforcement and Shear Rernforcement for Beams and Longrtudrnal and Majar and Minar Shear 
Reinforcement for Columns). 

6 In the Concrete Design lnfonnatron box, click RedesiQn. This wilf display the Element Overwrite Assignments 



box. 

7 Make appropnate changes to tne assignments and click OK. Thrs will bnng you back to the Concrete Design 
Jnfonnatron box with the redesrgn carned out and the new results drsplayed rn the desrgn rnforrnatron box. 

Update Analysis Sections 
SAP2000 alJows you to change sectron properties while rn the Desrgn Mode (Steel or Concrete) and redesrgn the 
member. Redesrgn uses the analysrs results from the origrnal propertres unless you update analysrs sectron propertres 
and re-run the analysis Jt rs advrsable to use the Update Analysis Sectron option after you have revlewed the enure 
desrgn as the analysrs results will no longer be available after the propertres are updated. 

1 Select the frame elements that you want to update. 

2 On the Design Menu, click. Update Analysrs Sectrons ... 

3 Thrs willrssue a wamrng message that Updating Analysis Sectrons wiiJ change the analysrs mode! and cause 
anaJysrs results to be deleted. 

4 Clrck OK if acceptable. otherwise click Cancel. 

Reset Design Sections 

SAP2000 al!ows you to change section properties while in the Desrgn Mode (Steel or Concrete) and redesign the 
member. Sorne trmes you may find that you want to revert to havrng the ana!ysrs sectron used for desrgn. 

1 Select the trame elements that you want to update. 

2 On the Desrgn Menu, c!ick Reset Desrgn Sectrons ... 

3 Thrs wil! reset the same sectrons used rn the analysis for desrgn. 
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OPTIONS MENU 

Preferences 
SAP2000 has sorne bwlt-in Tolerances and defau!t values for sorne parameters and Oes1gn Cedes. lt 1s possible to 
change most of those default values by edltmg them rn the three Preference Tabs, namely 0Jmensions, SteeJ and 
Concrete Design Coeds and parameters. 

On the Opt1ons menu, chck Preferences ... Th1s will display the Preferences d1alog box with three Tabs 
namely 0Jmensions, Steel and Concrete. 

2 Cflck on the appropriate tab to modJfy the default options. 

3 Click OK. 

Also see: 

~ Setting Steel Design Parameters 

~ Sett1ng Concrete Design Parameters 

Setting Steel Design Parameters 
Select Preferences from the Opt1ons menu. 

2 Press on the Steel Tab to v1ew the Steel Design Preferences . 

6 From the Steel Design Code drop down Hst box select the code you want used rn steel design. 

7 lf the Section Properties file is not the one you want used in the desrgn then press the Choose File button to 
select another file. 

8 Select the preferred desrgn method for multt valued load cases if you have any rn the design. 

• The envelope optron will desrgn for the maxrmum and mrnimum values rn a member. 
• The Trme Step optron will check the section for each time step of a Trme Hrstory analysrs. Thts method rs 

very trme consumrng and should be used marnty for the final design. 
• The Max/Mrn Correspondence wrll desrgn for the maximum and minimum momenV axial force and rts 

corresponding axial force/moment. 
9 Click on OK when finished. 

Setting Concrete Design Parameters 
1 Select Preferences from the Options menu. 

2 Press on the Concrete Tab to vrew the Concrete Oesign Preferences . 

3 From the Concrete Oesrgn Code drop down list box select the code you want used in concrete desrgn. 
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4 Ed1t any Strength reductlon factors that may not be sat1sfactory. 

5 EdJt the lnteract1on D1agram Parameters that are used to develop for the column design. 

6 Se!ect the preferred des1gn method for mult1 valued load cases 1f you have any 1n the design. 

• The envelope opbon wm des1gn for the max1mum and min1mum values in a member. 
• The T1me Step opt1on wlll check the section for each time step of a T1me H1story analys1s This method is 

very time consummg and should be used mamly for the final design. 
• The Max/Mm Correspondence w111 oes1gn for the max1mum and mm1mum momenV axial force and 1ts 

corresponding axJal force /moment. 
7 Chck on OK when fimshed 

Setting Colors 
In SAP2000 you have the ab1l1ty to changa the colors used by the program for both v1ewlng 1n the graphic Interface 
and for pnnt1ng to a color or monochrome pnnter. 

1 On the Options menu, ciJck Colors ... Th1s will diSplay the Assign Colors d1alog box w1th a D1splay and Output 
tab. 

• Under the Display tab you can set colors for VIBWing the structurat configuration includ•ng: Jo1nts, Frames 
Shells. Grids and the Background. 

• Under the Output tab you can set the colors for the analys1s and des1gn results. 
2 On either form you can choose to set the colors for the Screen and the Pnnter. 

• Select Screen or Printer. 
• Change the colors by pressmg the appropriate button under the D1splay tab or by double cl1Ck1ng on the 

appropriate color under the Output tab. 
• Then selecta new color and press the OK button. 

3 lf you want to set the colors back to the SAP2000 default va!ues, press the Reset button. 

4 Click OK. 

Note: The Default printer colors are set for a monochrome pnnter. To pnnt in color you will need to 
manually select the colors you want for the pnnter. 

Editing Toolbars 
8oth the Toofbar and the Floating Toolbar can be ed1ted to suit the way yo u work. w1th SAP2000. 

1 Oouble cflck on the Toolbar or Floating Toolbar away from a button, e.g. between two buttons orto the nght 
of the last button 

2 Add and Remove buttons as reqUJred. 

3 Chck on Move Up and Move Down to !acate the buttons as desired. 

4 The Reset button seis the Toolbar to ns default sett1ngs. 

5 Press the Clase button when finished. 

User Defined Coordinate System 
The default coordinate system is the global coordmate system. AJI user defined coordmate systems are defined 
relat1ve to th1s global coordmate system All coordmate systems follow the right·hand rule. 

Also See: 

2!J Definmg a new Coordmate System 
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FINAL NOTES 

General Tips 

You can vrew the t1me history displacements 1n real time video via the SAP2000 v1deo creat1on opt1Dn. 

2 You can use the new nonllnear link element to model base isolators and dampers. 

3 You can animate defonned shapes and mode shapes in 3-d perspectNe by a Simple cllck of the 'Start 
An1mation' button. 

4 You can an1mate shelt structures d1splaymg stress contours with the correspond1ng defonned shapes 1n full 
m 3-d perspectrve 

5 You can automatJcally break frame members into elements at their intersect1on pomts 'r' 3-d space. 

6 You can automatrcally generate a macro shell element by a smgle clrck on the workrng gnd and then mesh rt 
mto finer elements with srmple meshing parameters. 

7 Large models can be generated automatrcally usmg the SAP2000 templates. The models can then be 
scufptured with on screen edJ!Jng to satisfy spec1fic SJtuations. 

6 In SAP2000 you only define elements All JOlnts needed by the elements are automatJcally generated. No 
pre-definition of joints 1s needed. 

9 You can display informatJon about any joint or element by pointrng to it and click1ng the nght mouse button" 

10 The SAP2000 model generatron features allow on screen linear and cylindrical repllcation and mirronng of 
selected portrons of the model. 

11 Joints can be glued toa grid l1ne. Moving the grid line wifl modJfy the location of all JOJnts on the grid lrne and 
stretch or shnnk all elements connected te !hose ¡oints. 

12 You can double c!Jck a gnd lme te bnng up an ed1t box that will allow you to accurately reposition the grid 
llne. 

13 You can unlock the gndlines and drag and drop them on the screen to new locatrons. 

14 You can add a new gnd hne by holdmg the CTRL-KEY down and clrcking on an exrstrng gnd lrne and 
draggmg away a dupiJcate 

15 Click1ng en a view w1th the CTRL-KEY down will give you a list of the JOints and elements w1thm the click 
tolerance. 

16 The SAP2000 non linear time h1story analysis is based upon a new specJal purpose algonthm callad the 
Wilson-FNA methcx:l 

17 You can produce scaled perspectiva extrusrons of the structural sect1ons by simply activating the SAP2000 
'extrude' opt1on. 

18 You can copy a selected three dJmensJonal reg1on of your model to the cllpboard and paste it back at any 
locat1on rn 3d space. 

19 While displaying mode shapes or deformad shapes the vector being d1splayed can be rnstantaneously 
changed w1th the '+/-' buttons that wrll appear at the bottom of the screen. 

20 You can sWitch un1ts at any Irme while creatmg the model. 

21 Back in 1970, with the frrst release, the slang name SAP was selected to remind users that this program, like 
all computer programs, lacks Jnterngence and that it is the responsibJhty of the eng1neer to use the program 
correctly. 
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22 Wrth good engmeering judgment you can produce on the back of an envelope that whrch otherwrse cannot 
be produced wrth a ton of computer output'. - Anonymous Crrca 1974 

Speclfic Tips 

SAP2000 Versions and Limitations 
SAP2000 may be purchased rn the followrng four versrons: 

SAP2000 Standard 

Capaclty 
Analysls 

Elements 

Design 

SAP2000 Plus 

Capacity 

Analysis 

Elements 

Oesign 

SAP2000 Nonllnear 

1500 Nodes 

Statrc and Dynamrc Response Spectrum Analysrs 

FRAME and SHELL Elements only 

Steel (AISC-AS089, AISC-LRF093, BS5950 90, CISC 95, EUROCOOE 3-1992), 
Concrete (ACI318-95, BS8110 89, CAN3-A23.2-M84. EUROCOOE 2-1991) 

No Practicar Lirllit 
Statrc, Oynamic Response Spectrum, Trme Hrstory and Bndge Analysis 

FRAME, SHELL. PLANE, SOLIO and ASOLIO Elements 

Steel (AISC-AS089, AISC-LRF093, BS5950 90, CISC 95, EUROCOOE 3-1992), 
Concrete (ACI318-95. BS8110 89. CAN3-A23.2-M84. EUROCOOE 2-1991) 

Capacity No Practica! Umit 

Analysis Static, Dynamic Response Spectrum, Trme Hrstory, Brrdge and Dynamrc Nonlrnear. 
Trme Hrstory Analysis 

Elements FRAME, SHELL, PLANE, SOLIO, ASOLIO, and NLLINK ( as externa! Oamping . Base 
lsolators, Gap and Hook Elements) 

Design Steel (AiSC-AS089, AISC-LRF093, BS5950 90. CISC 95, EUROCOOE 3-1992), 
Concrete (AC/318-95, BS8110 89, CAN3-A23.2-M84, EUROCOOE 2-1991) 

SAP2000 Educational 

Capaclty 30 Nades 

Analysis Statrc, Dynamic Response Spectrum, Time Hrstory, Bridge and Dynamic Nonlinear 
Trme Hrstory Analysrs 

Elemento FRAME, SHELL, PLAN E, SOLIO, ASOLIO, and NLLINK ( as externa! Oamp1ng, Base 
lsolators, Gap and Hook Elements) 

Oesign Steel (AISC-AS089, AISC-LRF093, BS5950 90. CISC 95. EUROCOOE 3-1992), 
Concrete (ACI 318-95, BS8110 89, CAN3-A23.2-M84, EUROCOOE 2-1991) 

Error Messages 

Phone and Fax Support 
Support rs avarlable, free of charge, for 90 days after purchase and for the term of the maintenance agreement. Please 
can CSI's offices to inqurre about the marntenance agreement. 

Standard phone and fax support is available in the United States, from CSI support engineers vra a toll call between 
8:30A.M. and 5:00P.M. Pacific time, Monda y through Friday, excludrng holidays. 



lf you are expenencing problems using the software: 

• Consult the documentat1on and other printed 1nformation mcluded w1th the software. 
• Check the onllne Help. 

Jf you cannot find a solution then: 

• Contact CSI's Offices v1a phone at (510) 845-2177. 
• Senda fax w1th quest1ons anda sketch of the model to CSI at (510) 845-4096. 
• You may also send the mput file via e-mail to support@csiberkeley.com . 

When you call, you should be at your computar and have the appropriate documentat1on ( User's manual ) at hand. 
Please have the following ¡nformatlon: 

• The version number of the program that you are us1ng. 
• The hardware configurat1on (computar make, operatrng system, hard drsk size and RAM srze). 
• The exact wordrng of error messages that appeared on your screen. 
• A description of what happened and what you were dorng when the problem occurred. 
• A descriptiOn of how you tned to salve the problem. 

When you senda Fax or e-marl, rnclude the followmg information: 

• Your name, Company name, and phone number. 
• The versron and versron number of the program that you are using 
• The hardware configuratron (computar make, operatmg system, hard disk srze and RAM s1ze). 
• The exact wordrng of any error messages that appeared on your screen. 
• A full descrrptron of what you are having problem with. 
• A full descnptron of how you tried to salve the problem. 
• An attachment rncludrng your model and any other pertrnent data files (For e-mait only!} 

Online Support 
Online support 1s available by: 

Sendrng an e-mail and your model file to support@csiberkeley.com 

Visrtrng CSI's web site at http:/lwww.csiberkeley.com (frequently asked questions) 

When you send a Fax or e-mall, rnclude the following rnformat1on: 

• Your name, Company name. and phone number. 
• The versron and version number of the program that you are using. 
• The hardware configurat1on (computar make, operat1ng system, hard drsk srze and RAM srze). 
• The exact wordrng of any error messages that appeared on your screen. 

A full description of what you are havmg problem with. 
A full descnption of how you tned to salve the problem. 

• An attachment rncludrng your model and any other pertrnent data files. (For e-mait only!) 

Frequently Asked Questions 
Q. Why do 2-D views show objects whlch are not on that plana? 
R The length tolerance, g1ven as Auto-merge tolerance 1n the Dimension tab of Preferences 1n the Options pul! 

down menu may be too Jarge. The default value 1s 0.1 1nches. The value of this tolerance determmes the 
cl1pprng th1ckness of the 2-D view plana and all JOints within that chpprng depth wifl be ava1lable on that 
plane. 
Caution: This length tolerance is also used to merge together jo1nts automat1cally generated. 

Program Manuals 
SAP2000 Volume 1 

This volume describes all of the theoret1cal concepts behind the modeling and analys1s features offered by 
the SAP2000 structural analys1s program. The focus of this manual is on the analysis port1on of the program. 

2 SAP2000 Volume 11 
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This volume describes the contents of SAP2000 text mput data file. Most users can skip th1s volume. 

3 SAP2000 Getting Started 

Th1s manual is des1gned to help you become quickly product1ve with SAP2000. lt g1ves an 1ntroduct1on to the 
bas1c concepts of the graphical user mterlace and mcludes a tutonat on us1ng the program. lt 1s strongly 
recommended that you read th1s manual and work tne tutorial befare attempt1ng a real proJeCt Wlth 
SAP2000. 

4 SAP2000 Verlfication Manual 

This manual contams example problems solved using SAP2000. The problems demonstrate many of the 
capabillt1es of SAP2000. For purposes of venficat1on, key results from the examples are comparad w1th 
theoretJcal or publlshed results. 

5 SAP2000 Steel Oesign Manual/ SAP2000 Concrete Design Manual 

Th1s manual includes a steel/ concrete des1gn tutorials and descnptlon of the imptementat1on of the des1gn 
coeds '" SAP2000. 

6 SAP2000 Tutorial Manual 

This manual has vanous tutonal to help users make the most effic1ent use of SAP2000. 

Primers 

Newsletters 

Text Books 
Three Dimensional Analysis of Structures 
W1th EmphasJs on Earthquake Engmeenng 
Edward L. Wllson 

lf you are 1nterested in obtaining a copy of this book, contact CSI for cost and shipp1ng. 
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End U ser License Agreement for CSI Software 
This is a legal agreement between you (either an indrvidual or entrty). the end user, (hereinafter referred toas 
~lrcensee~) and COMPUTERS ANO STRUCTURES, IN C. {herernafter referred toas "CSI"). lf Ucensee does no! 
agree lo the terms of thts Agreement. Licensee shatJ promptty retum !he unopened disk package and any 
accompanying rtems (tncludrng wntten matenats and brnders or other conlarners) lo the place Lrcensee obtarned them 
for a fult refund. Thts package ts to be opened only by the Ucensee (or authonzed represenlattve thereof). By 
opening this sealed diskette package, the licensee tndicates acceptance of thts Agreement. 

GRANT OF LICENSE. 

Oedicated Use. CSI grants to Licensee the right to use one (1) copy of the software program identrfied 
above (lhe "Software") on a single computar ("Dedrcated Computer"). Ltcensee may transfer the Software to 
another srng!e computer, nrovided Licensee does so no more often !han once every ninety (90) days and no 
copres of tne Software lrcensed herern are retained for use on any other computer. 



Transferabilitv. CSI granls lo L1censee a nontransferable L1cense lo use th1s Software. Mulliple hcenses of 
lhe Software to same hcensee are available at d1scoun1ed rates. Th1s L1cense hmits the use of lh1s copy of 
the Software to projects of the Licensee. Apphcation of the Software as a service lo other eng1neenng finns 
or indiv1duals. or use of the Software by other eng1neenng finns or 1ndividuats, 1s nol allowed. Licensee shall 
nol sell, rent. tease, transfer, network, pubhsh, disclose, display or olheiWISe make ava1table any portlans of 
the Software or cop1es thereof to others. 

For the purposes of th1s sect1on, "use" means load1ng the Software into RAM, as well as 1nstallat1on on a hard disk or 
olher storage dev1ce (other than a network server). licensee may access the Software from a hard dJsk, over a 
network, or any olher method L1censee chooses, so long as licensee otherwise cbmphes with this CSI License 
Agreement. 

TERM OF LICENSE. 

The terrn of this L1cense shall beg1n from the date of this LJcense and witllast as long as the L1censee compiles with 
lhe lerrns of th1s Agreement This L1cense is sub¡ect to cancellat1on by CSI if L1censee fails lo comply w1th the terrns 
and condltlons of thJs Agreement. W1th10 five (S) days of such cancellat1on, L1censee shaU relum the Software to CSI. 

COPYRIGHT. 

The Software is owned by CSI and is protecled by United States copynght laws and international treaty prov1s1ons. 
Therefore, L1censee must treat the Software like any other copynghted matenal (e.g., a book or mus1cal recordmg) 
except that L•censee may either make one (1) copy of the Software solely for backup or arch1val purposes. or transfer 
lhe Software toa s~ngle hard d1sk, provided Llcensee keeps the original solely for backup or archiva! purposes. 
Ucensee may not copy the wntten materials accompanying lhe Software. 

OTHER RESTRICTIONS. 

This CSilicense Agreement 1s licensee's proof of llcense to exercise the rights granted herem and must be reta1ned 
by licensee. Licensee agrees to secure and protect the Software and cop1es thereof in a manner cons1stent w1th the 
maintenance of the propnetary rights of CSI. L1censee agrees to take appropnate act1on, by 1nstruction or agreement 
w1th 1ts employees who are penn1tted access to the Software, to protect unauthonzed prol1feration of lhe Software. 
llcensee may not reversa engmeer, decompile, or disassemble the Software. lf lhe Software is an update, any 
transfer must mclude the update and all prior vers1ons. Jf the Software package contams both 3.5" and 5.25" d1sks, 
then Ucensee may use only the d1sks appropnate for Ucensee's single des1gnated computer or network server. 
llcensee may not use the other disks on another computar or computer network, or loan, rent, lease, or transfer them 
to another user except as part of a transfer or other use as expressly perm1tted by th1s CSI Ucense Agreement. 

PROGRAM UPGRADES. 

From time to time, CSI may, at its discretion, offer program upgrades. lf offered. such upgrades will be prov1ded at no 
charge lo the Ucensee for a penod of mnety (90) days from the date of thJs Agreement. Thereafter, upgrades w111 be 
provided under the tenns defined by the CSI Software Mamtenance Agreement. 

SUPPORT. 

User support will be avaitable to one (1) contact IndiVidual designated bythe licensee, for a period of ninety (90) days 
from the date of th1s Agreement Thereafter, contJnued support w111 be avallable under the terms defined by the CSI 
Software Ma1ntenance Agreement. 

Dunng the terrn of this LJcense, CSI, at 1ts d1scret1on, will ass1st L1censee 1n resolving problems suspected of being 
caused by possible defects in the Software. However, Jf 11 is determinad that the problem stems from a user data 
error, the LJcensee agrees to re1mburse CSI for the 11me spent 1n resolvmg the problem, at the prevaillng professional 
rates of CSI. 

LIMITED WARRANTY; NO OTHER WARRANTIES. 

CSI warrants that the Software will perfonn substantially in accordance WJth the accompanying written materials for a 
period of ninety (90) days from the date of receJpt. Any 1mpiJed warrant1es on the Software are limitad to ninety (90) 
days. Sorne states do not allow llmitat1ons on duration of an 1mplied warranty, so the above limitation may not apply to 
LJcensee. 
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CSI dJscla1ms att other warranties, either express or imphed. 1nctuding but not tim1ted to ¡mplled warrant1es of 
merchantabihty and fitness for a particular purpose, wrth respect to the Software, the accompanying wntten matenals, 
and any accompanying hardware Th1s hmited warranty g1ves Ucensee spec1fic legal nghts. Llcensee may have 
others, which vary from state to state. 

CUSTOMER REMEDIES. 

CSI's ent1re habitity and L1censee's exclusiVe remedy shall be, at CSI's optJon, e1ther (a) retum of the pnce pa1d or 
(b) repa1r or replacement of the Software that does not meet CSI's L1m1ted Warranty and that 1s retumed to CSI with a 
copy of licensee's receipt. This Um1ted Warranty JS void if fa1lure of the Software has resultad from acc1dent. abuse or 
mJsappiJcation. Any replacement Software will be warranted for the remamder of the original warranty penador th1rty 
(30) days, wh1chever is longer. These remedies are not available outside of the Unlted States. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. 

In no event shall CSI or its supphers be liable for any damages whatsoever (mcludmg, without hmitation. damages for 
toss of business profits, business mterruption, loss of bus1ness information, or other pecuniary loss) arising out of the 
use of or 1nabi11ty to use th1s CSI product, even if CSI has been adv1sed of the possibillty of such damages. Beca use 
sorne states do not allow the exclus1on or hmitat1on of IJabillty for consequent1al damages, the above 11m1tation may not 
apply to L1censee. 

DISCLAIMER 

CONSIDERABLE TIME. EFFORT ANO EXPENSE HAVE GONE INTO THE DEVELOPMENT OF THE SOFTWARE. 
ANO IT HAS BEEN THOROUGHLY TESTEO ANO USED HDWEVER. EXCEPT AS OTHERWISE SPECIFICALLY 
PROVIDED HEREIN. NO WARRANTY IS MADE ON ITS ACCURACY OR RELIABILITY. IT IS THE 
RESPONSIBILITY OF THE ENGINEER TO VERIFY THE RESULTS OBTAINED FROM THE SOFTWARE. IN THE 
EVENT THE SOFTWARE IS FOUND TO BE DEFECTIVE. CSI"S ONL Y OBLIGATION IS TO REMEDY THE 
DEFECT CSI WILL IN NO EVENT HAVE OBLIGATIONS OR LIABILITIES FOR INCIDENTAL OR 
CONSEOUENTIAL DAMAGES ASSOCIATED WITH THE USE OF THE SOFTWARE NO OTHER WARRANTY IS 
MADE. 

U.S. GOVERNMENT RESTRICTEO RIGHTS 

The Software and documentation are prov1ded with RESTRICTED RIGHTS. Use. duplicat1on, or dJsclosura by the 
Government is sub¡ect to restnct1ons as set forth in subparagraph (c)(1 )(i1) of The R1ghts 1n Techn1cal Data and 
Computar Software ctause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commerc1al Computar 
Software-Restncted Rights at 48 CFR 52.227-19, as appl1cable. 

GENERAL 

This L1cense shall be interpretad by the taws of the State of Califorma In the event that any port1on of th1s Agreement 
1s mvalldated by court or tegLslatJon, the remainmg portJOns of the Agreemant shall remain 1n bmd1ng effect. In the 
event of legal act1on brought by e1ther party, the prevailing party shatl be entitled to re1mbursement of actual legal fees 
and related expenses. The Licensee agrees that th1s Agreement shall inure to the benefit of CSI, 1ts admrmstrators, 
successors, he1rs and assignees. This Agreement may only be changed by mutual written consent. 

Should L1censee have any quest1ons concermng th1s Agreement, or if Licensee des1res to contact CSl for any reason, 
please wnte: CSI, Consumar Sales and Service, 1995 Umversity Avenue, Berkeley, Califorma 94704. 

Questions and Answers about the End User 
License Agreement 

...:ill Can 1 sell my end user license agreement for SAP2000 to someone else? 

.2!J Can 1 sell or g1ve away old vers1ons of SAP when l acquJre an upgrade? 

~ Can 1 make a second copy for my personal use? 



~ Can t rent or tease the Program to someone etse? 

~ When t upgrade from SAP90, do my l1cense nghts for SAP2000 change? 

~ tn what ways can t use the software over a network? 

Can 1 sell my end user license agreement for 
SAP2000 to someone else? 

No. You may not setl, rent or tease SAP2000 on a temporary or permanent bas1s. 

Can 1 sell or give away old versions of SAP when 1 
acquire an upgrade? 

No. The ong1nat SAP90 and the upgrade SAP2000 together are cons1dered as a s1ngte software umt. You must reta1n 
the otd SAP90 vers1on as part of the l1cense agreement. tt 1s a good idea m any case to save the older vers1ons m 
case you need to go back and run the otd data files 

Can 1 make a second copy for my personal use? 
CSI grants to Licensee a non;transferable License to use th1s Software. Mult1ple licenses of the Software to same 
11censee are avaitable at discounted rates. This License l1mits the use of this copy of the Software to projects of the 
Licensee ApplicatJon of the Software as a serv1ce to other eng1neenng firms or mdividuats, or use of the Software by 
other engineenng firms or ¡ndJviduals, 1s not allowed. 

1 

Can 1 rent or lease the Program to someone else? 
L1censee shatl not sell, rent. tease, transfer, network, publ1sh, dJsctose. display or other..v1se make avallable any 
portions of the Software or copies thereof to others. 

When 1 upgrade from SAP90, do my license rights 
for SAP2000 change? 

Y es, the license agreement inctuded w1th the SAP2000 upgrade sets forth the hcense rights for both the SAP90 and 
the SAP2000. W1tn every new upgrade product. you w1ll rece1ve a new IJcense agreement. Upgrade vers1ons are 
treated as part of the whole product. 

In what ways can 1 use the software o ver a 
network? 

Network vers1on of the software 1s available. Please contact CSI for pricmg. For all other vers1ons you must acqUire a 
hardware protectJon dev1ce and ded1cate one md1viduaJ computar from wh1ch you use the software. For multiple 
computers you must purchase mult1ple hcenses which are ava1lable ata d1scounted rate. A hcense to use a particular 
copy of the software may not be shared or used concurrently on d1fferent computers. 
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APPENDIX 

Complete Quadratic Comb1nation- a modal combtnation technique whtch accounts for modal damping. Same as 
SRSS if dampmg 1s zero 

Square Roo! of Sum of Squares- a modal combinat1on techmque wh1ch does not account for modal dampmg. 

General Modal Combinat1on - also known as Gupta Method. 

Absolute- arithmetic summation without signs 

EIGENVECTORS 
Eigenvalue analysis determmes the undamped free·vibrat1on mode shapes and trequenc1es of the system. These 
natural modes provtde an excel!ent1nS1ght 1nto the behavtor of the structure. 

RITZ 
R1tz vectors take 1nto account the spatial dJstribut1on of the dynam1c loadlng. 

Rigid-body behavior 
Rtgld·body behavior. in wh1ch the constra1ned jornts translate and rotate together as 1f connected by ngid links. The 
types of ng1d behav1or that can be modeled are· 

Equal-displacement behavior 
Equal-displacement behavior, 1n wh1ch the translat1ons and rotations are equal at the constra~ned joints. 

Symmetry Conditions 
For a structure that is symmetric about a plane, symmetric loading causes symmetric displacements as follows: 

• Forces and d1splacements parallel to the plane of symmetry are equal 
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• Forces and drsplacements normal to the plana of symmetry are opposrte 
• Moments and rotatrons parallel to the plane of symmetry are opposrte 
• Moments and rotatrons normal to the plana of symmetry are equal 

Anti-symmetry Conditions 
For a structure that is symmetric about a plana, antr-symmetric loadrng causes anti-symmetric drsplacements. All 
degrees of freedom that are equal when symmetnc are opposite when anti-symmetric, and a!l degrees of freedom that 
are opposrte when symmetnc are equal when antr-symmetnc. Thus the specrficatron of the anti-symmetnc degrees of 
freedom srmply uses the opposrte signs trom the symmetnc case. 

Von Mises Stress 
The Van Mrses Stress provides a measure of the shear, or drstortronal, stress in the materral. Thrs type of stress tends 
to cause yrelding rn metals. lt rs independent of the amount of hydrostatrc stress 
(cr1= cr2= cr3) action on the material. 

The Van Mrses Stress is identified in terrns of the princrpal stresses as 
crvm=~1/2[(a1· a2)2+( a1· a3)2+( a2· a3)2]. 

In a state of pure tensron, say cr11 =o and a!t other stresses are zero, then avm=cr. In a state of pure shear. say cr12=t 
and all other stresses are zero, then avm=-.13 t. 

For materials, initial yreldrng can be expected when avm=ay, where ay rs the tensile yield stress. or when avm=V3 -ry, 
where ty is the yreld stress rn shear. For other materials, partrcularly fnctional materials such as soil and concrete, the 
Van Mises Stress may have no value in predrcting yreld or faJlure. 

Analysis Cases 
Analysis Cases rnclude: 

Statrc Load Cases 

Response Spectrum Analysrs Cases 

Trme Hrstory Analysis Cases 

Movmg Load Case 

Modal case based on a specrfic vibration mode shape 

Load Combos located above the present Load Combo in the Combrnatrons list box 

Load Combination Type 
ADD = All Analysrs case results are multíplied by therr scale factor and added together. Combo type can be used for 

statrc Joads. 

ENVE = An Max/Min Envelope of the defined Analysrs cases is evatuated for each trame output segment and element 
joints. The Analysrs cases that grve the Maximum and Minrmum components are used for this combo. 
Therefore the Load Combo holds two values for each output segment and jornt. Combo type can be used for 
movrng loads and any Analysis case where the load producing the maxrmum or mrnrmum force/stress rs 
requrred. 

ABS = The absoluta of the rndrvidual Analysrs case results are summed and positrve and negatrve value are 
automatically produced for each output segment and joint. Combo type can be used for lateral loads. 

SRSS = The Square Root Sum of the Squares calculation is done on the Analysis cases and positiva and negatrve 
value are automatically produced for each output segment and Jornt. Combo type can be used for lateral 
loads. 



• Linear Time History Analysis 
Tne T1me H1story functions spec1fied are mduced on the structure and all eiements are taken to be linear. 

Periodic Time History Analysis 
The T1me H1story funct1ons are assumed to be penodtc and the steady state results are d1sptayed tak1ng all elements 
to be linear. 

Non Linear Time History Analysis 
The Trme H1story Analysis 1s perforrned with nonhnear lmk elements be1ng allowed to act nonlinearly. 

Ground Acceleration 
The spec1fied Time H1story FunctiOn w11l be 1nduced on the structure as a ground acceterat1on through a!l support 
JO!nts. 
acc dir 1 = Ground Acceleration in the global X direct1on. 

acc dir 2 = Ground AcceJeratJon in the global Y d1rect1on. 

acc d1r 3 = Ground Acceleration in the global Z drrect1on. 

UBC94 Response Spectrum 
UBC94S1 Response Spectrum for Soil Type 1. 

UBC94S2 Response Spectrum for Soil Type 2. 

UBC94S3 Response Spectrum for So11 Type 3 

(type popup definition text he re) 

(type popup defin1tion text here) 

Energy Functions 
Input Energy 

K1net1c Energy 

Potenllal Energy 

MDamp Energy 

NDamp Energy 

Nllink Energy 
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Work done on structure by force and acceleration funct1ons. In an exact solution this would 
equal the sum of the KmetJc, Potenlial, Mdamp, Ndamp and Nlllnk Energies. 

A function of the sums of the masses and their correspondmg vetocity for the structure. 

A function of the sums of the elastic constants and the1r corresponding displacements for the 
structure. The sum 1ncludes NLLmk members. 

(Modal Damping Energy) ls the energy absorbed through modal dampJng. 

(Nllink Damping Energy) Js the energy absorbed through Nlllnk damping. 

(NLLink HysteretJC Energy) Js the energy absorpt1on by PJast1c1, lsolator1 and lsolator2 Nllink 
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Error Energy 

elements. Damper, Gap and Hook NLLmk elements are not 1ncluded. 

The is an estimate of the error m the analysis.lt 1s the difference between the Input energy and 
the sum of the remainmg energy components. 

Base Functions 
Base Shear: The total shear on all the supports in a given global d1rection. 

Base Moment· The OvertummgfTorsJonal moment on the supports of the structure 1n a g1ven global d1rection. 

DXF 
DXF 1s a Computer Alded Drafting (CAD) file formal used by many CAD programs 

Joint Stress Averaging 

Nene: 

Th1s option is used to display contours w1th no averag1ng. 1t 1s used to see if the model is meshed properly. By selectmg 
th1s optlon you can see whether there are large stress vanations between elements. This can be an md1cation that the 
model1s not properly meshed and may need to be refinad to proper1y capture the vanation 1n stress. 

At All Joints: 

Once you are confident that the model ts acceptable, the stress Averagtng wtll give better results of the stress 1n the 
elements by averagmg the stress between etements and thus reductng the error dueto the stress on each lndivtdual 
element. 

At Select Joints: 

tf you have a d1scontinuity in the modet, like two planes meeting atan angle, then you will need to do the averaging on 
each plane mdependently by us1ng th1s opt1on. Th1s witl avoid the problem of averag1ng across the two planes which 
would g1ve tncorrect result. This is dueto the stress along the two planes not bemg contmues retative to the elements 
local axes. 

Paste Coordinates 
Pa.~te CoafdlnlltC!: D 
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Set Coordinate System 
t:oordiiiKlte !:iystems ~ • a 
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Shell Element ( 4 Joints ) 
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Shell Element ( 4 Joints 3-D ) 

Shell Element ( Quick ) 

Frame Element (Quick) 

Frame Element (Cross Brace) 

Frame Element ( 2 Joint ) 
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Frame Element ( 2 Joint 3-D ) 

Floating Toolbar 

SAP2000 Screen 
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Concrete Design Parameters 
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lntroduction 

This manual presents a set of example problems solved using the SAP2000 struc­
tural analysis program. These examples demonstrate many ofthe capabilities ofthe 
SAP2000 program. For purposes of verification, key results from these examples 
are compared with theoretical or published results from other computer programs, 
where such are available. The verification problems e o ver each type of element and 
include both static and dynamic examples. 

For each example, this manual contains: 

A short description of the problem 

• A list of significan! SAP2000 options activated 

• A description of the input data used to crea te the model 

.A comparison ofkey results with theoretical results or results from other com­
puter programs, if available 

Sorne examples are solved using severa! different elements, mesh sizes and/or 
boundary conditions. Key results from these different solutions are presented for 
comparative purposes. 

The data files and selected output files associated with the example problems are 
provided in subdirectory EXAMPLES ofthe SAP2000 directory. For each exam­
ple, the following files may be provided: 

1 
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The SAP2000 model file, with extension .SDB. This file can be accessed in 
SAP2000 using the Open command under the File menu 

• The input data text file. with extension .S2K. This is an altemative to the .SDB 
file and can be accessed in SAP2000 using the Impon command under the File 
menu 

Binary results files, with various extensions. Ifthese files are provided, analy­
sis results can be viewed in SAP2000 without running the analysis 

Sorne of the examples ha ve more than one model file corresponding to the use of 
different element types or mesh sizes in the creation ofthe model. The filen ames as­
sociated with a panicular problem are identified (without extension) in each exam­
ple. 

Note that no! all examples can be run with every version of the program. F or exam­
ples, time-history analyses require the PLUS or Nonlinear version. and the nonlin­
ear examples require !he Nonlinear version. 



Example 1 

Two-Dimensional Frame -
Static and Dynamic Loads 

Description 
This is a seven-story two-dimensional frame structure, subjected to static lateral 
and vertical loads and dynamic lateral loads due to earthquakes. The structure is 
analyzed once using earthquake loads specified as a response spectrum, and once 
using earthquake loads specified as a base acceleration time history. A solution to 
this problem using another computer program is documented in Reference [ 1]. The 
framing and the static loads are shown in Figure 1-1. The earthquake excitation is 
shown in Figure 1-8. It is the N-S componen! ofthe 1940 El Centro earthquake. The 
framing and the loads are all identical to the ones used in Reference [!]. 

Significant Options of SAP2000 Activated 
Two-dimensional frame analysis 

• Diaphragm constraints 

• Lateral joint loads 

• Vertical span loads 

• Response-spectrum analysis 

• Time-history response to base excitation 

3 
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Input Data 
The computer model used is shown in Figures 1-1 and 1-2. Kip-inch units are used. 
Two different input files are used. The first file is to analyze the structure for static 
vertical and lateralloads and response spectrum dynamic loads. The input data file 
for this analysis is FRAME. The second file is to repeat the dynamic analysis but 
using base acceleration time-history as a loading. The input data file for this analy­
sis is FRAMETH and the dtgitized base acceleration is given in file ELCENTRO. 
This is shown in Figure 1-8. 

The file FRAME is described first. Verticalloads input as Load Case 1 are specified 
as span loading on beams. Static lateralloads input as Load Case 2 are specified as 
joint loads. The lateral (Y) displacements ofthe columns at each story Jevel are con­
strained together using a separate Diaphragm Constraint for each !loor. Also, 
masses are specified only in the lateral (Y) direction at each story level. These are 
common modeling techniques u sed to reduce the size of the equation system and 
are also utilized in the analysis reported in Reference [1). The Diaphragm Con­
straints eliminate all axial deformations in the beam. This, and the absence ofmass 
specification in the vertical direction reduces the dynamic problem to seven natural 
modes of vibration. All seven modes are included in the analysis. 

lt should also be noted that the AISC section properties in the database file SEC­
TIONS.PRO are not used in this example and the required properties are explicitly 
entered. This is intentional as most of the sections shown are older sections not in 
the curren! AISC database. 

The input file FRAMETH is identical to file FRAME for the structural model. 
However, no static or response spectrum loads are specified. lnstead the base accel­
eration is specified in the Y direction. The acceleration data is discretized in une­
qua! time steps. The output sampling time used is 0.02 seconds and the response is 
calculated for the first eight seconds. A damping value of0.05 is u sed for all modes. 

Comparison of Results 

4 

Reference [!) presents results only for the static lateral load analysis and the dy­
namic analysis. A comparison ofkey results for these analyses is presented in Fig­
ures 1-3, 1-4 and 1-5. The static results and the time periods are identical for the two 
programs. The comparison is excellent for the response spectrum results and good 
for the time-history results. Explicit time integration, not dependen! on the size of 
the time steps, is used in SAP2000. 

F or the response-spectrum results, the program of Reference [ 1) uses the square 
root of the sum of the squares (SRSS) method of modal combination. SAP2000 
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allows both the SRSS method and the complete quadratic combination (CQC) 
method of modal combination. The CQC method is the default for SAP2000 and is 
general! y recommended. Figure 1-5 presents two sets of results for SAP2000 re­
sponse spectrum analysis: the default CQC results, and the SRSS results. 

Plots ofthe deformed shape ofthe structure under the static lateralloads and ofthe 
sixth mode shape are shown in Figures 1·6 and 1· 7. A plot of time versus dtsplace­
ment at the top ofthe structure is given in Figure 1-9. 

References 
l. Static and Dynamic Analysis of Mu/tistory Frame Structure Using DY­

NAMIC!EASE2, Engineering Analysis Corporation and Computers/Structures 
lnternational. 
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Quantity SAP2000 Reference (1) 

Lateral Dtsplacement 
1.450764 1.450764 

at Nade 22 

Axial Force 
69.99 69.99 

in Member 1 

Moment in 
Member 1 2324.68 2324.68 

at Nade 1 

Figure 1-3 
Comparison of Results for Static Lateral Loads 

Mode SAP2000 Reference (1) 

1 1.2732 1.2732 

2 0.4313 0.4313 

3 0.2420 0.2420 

4 0.1602 . 0.1602 

5 0.1190 0.1190 

6 0.0951 0.0951 

7 0.0795 0.0795 

Figure 1-4 
Comparison ofResultsfor Periods ofVibration 
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SAP2000 Reference 111 

Quantity ~esponse Response Response 
Time Time. 

Spectrum Spectrum 
History 

Spectrum 
History 

ICQC) (SRSS) (SRSS) 

Lateral Dis-

placement 5.431 5.437 5.486 5.438 5.46 
at Node 22 

Axial Force 
261.5 261.7 263.0 261.8 258.0 

in Member 1 

Moment in 
Member 1 9916 9864 9104 9868 8740 

at Node 1 

Figure 1-5 
Comparison of Resultsfor Dynamic Analyses 
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Figure 1-6 
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Figure 1-7 
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Example 2 

Bathe and Wilson Frame -
Eigenvalue Problem 

Description 
This is a ten-bay, nine-story, two-dimensional frame structure solved in Reference 
[l). The framing and the material and section propenies are shown in Figure 2-l. 
The mass per unit length and other propenies used are consisten! with References 
[l) and [2], to which the results are compared. The first three eigenvalues are com­
puted. 

Significant Options of SAP2000 Activated 
Two-dimensional frame analysis 

• Eigenvalue analysis 

Input Data 
The computer model used is shown in Figure 2-l. Kip-foot units are used. Mass per 
unit length of the members is specified. The program automatically computes the 
joint masses to be used in the eigenvalue analysis. 

The input data file for this example is FRAMEBW. 

13 
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Comparison of Results 
A comparison of the first three eigenvalues computed by SAP2000 with results 
from References [!] and [2] is presented in Figure 2-2. The comparison is excel­
lent. 

References 

14 

l. Bathe, K. J. and Wilson, E. L. 
Large Eigenva/ue Problems in Dynamic Anazvsis, Journal of the Eng. Mech. 
Div., ASCE, Vol. 98, No. EM6, Proc. Paper 9433, Dec. 1972. 

2. Peterson, F. E. 
EASE2, Elastic Analysis for Structural Engineering, Example Problem 
Manual, Engineering Analysis Corporation, Berkeley, California, 198!. 
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Mode 

1 

2 

16 

SAP2000 Reference 111 

0.589541 0.589541 

5.52696 5.52695 

Figure 2-2 
Comparison of Eigenvalues 

Reference 121 

0.589541 

5.52696 



Example 3 

Three-dimensional Frame -
Dynamic Loads 

Description 
This is a two-story, three-dimensional frame structure with rigid diaphragm floors. 
The problem is the same as the one sol ved in Reference [ 1]. The framing is shown 
in Figures 3-1 and 3-2. The structure is doubly symmetric in plan, except that the 
center of gravity at each story leve! is eccentric and is given by coordinates X= 38 
feet and Y= 27 feet, represented in Figure 3-1 by joints 28 and 29. 

Significant Options of SAP2000 Activated 
Three-dimensional frame analysis 

• Rigid diaphragm modeling 

,• Response spectrum analysis 

Input Data 
The computer model used is shown in Figures 3-1 and 3-2. Kip-foot units are used. 
An additional joint ts added to each story at the center ofgravity, and all story mass 
is given at these two joints. 

17 
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Two rigid Diaphragm constraints are defined, one each for Stories 1 and 2. All 
joints on story 1 are constrained together, including the joint at the center of gravity. 
Similarly, alljoints for story 2 are constrained together. For each story. the X and Y 
displacements and the Z rotations for all joints are dependen! u pon each other. 

Masses at the centers of gravity are specified in the X and Y directions. No rota­
tional mass inertia is used for consistency with Reference [1]. 1t should be noted 
that the problem has only four natural modes. All four modes are used in the analy­
sis. 

The input data file for this example is FRAME3D. 

Comparison of Results 
A comparison ofthe SAP2000 results with Reference [l] results forthe four natural 
periods ofvibration and the X-deflection at Joint 29 is presented in Figure 3-3. The 
comparison is excellent. 

Reference 

18 

l. Peterson, F. E. 
EASE2, Elastic Ana(vsis for Stnlctura/ Engineering, Examp/e Problem Man­
ual, Engineering Analysis Corporation, Berkeley, California, 1981. 
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26 

2 

1 1 .--- 35'-' _ __,¡'7'--- 35 . __ .._ 

STORY 1 C.G. (NODE 28) AT (38,27,13) 
STORY 2. C.G. (NODE 29)AT (38,27,26) 

TYPICAL STORY MASS = 6.212 kip-sec"/ft 

Figure 3-1 
Three-dimensional Frame Example: Dimensions 
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LOCALAXES 
BEAMS 25-30,37-42 
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Quantity 

Period, Mode 1 

Penod, Mode 2 

Period, Mode3 

Period, Mode 4 

X Detlection. Joint 29 

Three-dimensional Frame- Dynamic Loads 

SAP2000 

0.2271 

0.2156 

0.0733 

0.0720 

0.0201 

Figure 3-3 
Comparison of Resu/ts 

Reference [ 1] 

0.2271 

0.2156 

0.0733 

0.0720 

0.0201 

21 



Description 

Example 4 

· ASME Frame­
Eigenvalue Problem 

This is a sing1e-story, sing1e-bay in each direction, three-dimensiona1 frame struc­
ture made of2-inch stee1 pipe segments and 2.75-inch stee1 cubes as shown in Fig­
ure 4-1. The frame is the same as mode1ed in References [1] and [2] and is Prob1em 
1 from the ASME 1972 Program Verification and Qua1ification Library (Reference 
[3]). 

Significant Options of SAP2000 Activated 
Three-dimensiona1 frame ana1ysis 

Use ofrigid end offsets on Frame e1ements 

• Eigenva1ue ana1ysis 

Ritz vector ana1ysis 

Input Data 
The computer mode1 used is shown in Figure 4-2. The pipe segments are mode1ed 
using Frame e1ements. For consistency with Reference [ 1], masses are specified at · 
the nodes instead ofusing the Frame membermass per unit 1ength specification and 
additiona1 noda1 masses on1y for the solid cubes. Masses identica1 to those used in 
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Reference (!] are specified. Since masses at 14 nodes are specified in three direc­
tions, this problem has 3 x 14 = 42 dynamic degrees of freedom. The first 24 modes 
are calculated using both eigenvectors and Ritz vectors. The Ritz vectors are calcu­
lated using ground acceleration in the three global directions as the starting load 
vectors. The input data file for this example using Ritz vector analysis is FRA­
MASME. For eigenvector analysis,just change the type ofmodes requested. 

Comparison of Output 
A one-to-one comparison of SAP2000 results with References [ 1] and [2] results 
for this problem is not possible. This is beca use both References [ 1] and [2] use the 
Guyan reduction method to reduce the 42 dynamic degrees of freedom problem to 
24. This introduces approximations into the solution. A comparison ofthe results is 
presented in Figure 4-3 for the first 12 natural frequencies. Two sets ofresults are 
presented for SAP2000: one using Ritz vector analysis, and one using eigenvector 
analysis. 

The comparison between SAP2000 and References [ 1] and [2] is good considering 
the modeling differences between the different solutions. The SAP2000 eigenvec­
tor and Ritz-vector results are essentially the same for the first 11 modes, but begin 
to differ in the higher modes. In general, only the eigenvectors represen! the natural 
modes of the structure. The Ritz vectors are a better basis for response-spectrum 
and time-history analyses. but may not ha ve the same frequencies and mode shapes . 
as the eigenvectors. 

References 
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l. Peterson, F. E. 
EASE2, Elastic Analysisfor Structural Engineering. Example Problem Man­
ual, Engineering Analysis Corporation, Berkeley, California, 1981. 

2. DeSalvo, G. J. and Swanson, J. A. 
ANSYS, Engineering Analysis System, Examples Manual, Swanson Analysis 
Systems, loe., Elizabeth, Pennsylvania, 1977. 

3. Program Verijication and Qualijication Library•, ASME Pressure Vessel and 
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Example 4 

AS Figure 4-1 
MEFrameE · xamp/e 
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X 

26 

z 

3 

18 
1 JOINT NUMBERS 
1 MEMBER NUMBERS 

TYPICAL PROPERTIES 
2.375 in O.D. PIPE 0.154" THICK 
MODULUS OF ELASTICITY = 27.9 x 10

6 
psi 

POISSON'S RATIO = 0.3 _
3 

2 
JOINT MASSES = 8.942 x 10 lb-sec /in 
ADDITIONAL MASSES AT 

JOINTS 3,6,13 and 16 = 16.439 x 10"3 lb-sec2tin 

Figure 4-2 
ASME Frame Model 

y 



Example 4 ASME Frame- Eigenvalue Problem 

• 

Mode 
SAP2000 SAP2000 

Ritz Analysis Eigen Analysis 

1 114 114 

2 119 119 

3 141 141 

4 222 222 

5 399 399 

6 422 422 

7 450 450 

8 550 550 

9 774 774 

10 800 799 

11 909 909 

12 955 946 

8oth results are based u pon Gu_van reducrion from 
41 to 24 dynamic degrees offreedom. 

Figure 4-3 
Comparison of Modal Frequencies 

Reference 111 & 
Refcrence 121 * 

112 

116 

138 

218 

404 

423 

452 

S~-' 

736 

762 

853 

894 
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Example 5 

Three-dimensional Braced Frame -
Dynamic Loads 

Description 
This is a three-story, L-shaped braced frame structure. The floors act as rigid dia­
phragms. The framing consists of four identical frames and the frame members 
carry only axial loads. The problem is ident¡cal to the one solved in Reference [!]. 
The framing is shown m Figure 5-1. 

Significant Options of SAP2000 Activated 
• Three-dimensional frame analysis 

Axial-load-only frame members 

Rigid diaphragm modeling 

Response spectrum analysis 

Input Data 
The computer model used for Frame 1 is shown in F1gure 5-2. Kip-inch units are 
used. The models for F rames 2, 3 and 4 are identical except that node numbers are 
incremented by 12 and member numbers by 21, for each successive frame. It must 
be noted that the common column between Frames 2 and 3 is modeled twice, once 
for each frame. This is done for consistency with the modeling in Reference [ 1]. 
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Joints 49,50 and 5rare specified at the center ofgravity ofstories 1, 2 and 3, re­
spectively. X- and Y-direction masses and the mass moment of inenia about the 
Z-axis are specified at these joints. Al! joints on a given story are connected to­
gether using a Diaphragm constraint. 

The modeling is identical to that used in Reference [ !]. Al so, only the first two 
modes are used in the response spectrum analysis. The input data file for this exam­
ple is FRAMBRAC. 

Comparison of Results 
Key results from the SAP2000 analysis are compared with the Reference (!] solu­
tions in Figure 5-3. The comparison is excellent. 

Reference 

30 

l. Peterson, F. K 
EASE2. E/astic Ana/ysis for Stntctura! Engineering. Examp/e Problem Man­
ual, Engineering Analysis Corporation, Berkeley, California, 1981. 



Example 5 Three-dimensional Braced Frame - Dynamic Loads 

RAME2 

1 
FRAME 3 

40' 

Mv 

1 
C.M. 

~lzf-Mx 
33'-4~ 1 
-¡ 33'-4" 

FRAM y 
FRAME 1 

20' 

t 
-L 

PLAN 
X 

T 
3@ 12' 

j_ 
1-2~ 201!-' ·.¡..¡,.,_,_ 401:.._' --1 X 

ELEVATION 

TYPICAL STORY MASSES, Mx and Mv = 1.24224 kip·sec2/in 

TYPICAL STORY MASS MOMENT OF INERTIA, lz = 174.907X103 kip·sec2-in 

Figure 5-1 
Three-dimensional F rame Example 
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T 
12' 

12' 

12' 

j_ 

~20' + 20'---i 
3 . Joint Numbers 
3 Member Numbers 

ELEVATION 

TYPICAL PROPERTIES 
AREA = 6 in2 

MODULUS OF ELASTICITY = 29500 ksi 

Figure 5-2 
Three-dimensional Braced Frame Example- Model of Frame 1 
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Example 5 Three-dimensional Braced Frame - Dynamic Loads 

Quantity SAP2000 Reference fl] 

Penod, Mode 1 0.326887 

Period, Mode 2 0.320640 

Axial Force, 
279.47 

Member 1 

Axial Force, 
194.50 

Member4 

Axial Force, 120.52 
Member 5 

Figure 5-3 
Comparison of Results for Three-dimensiona/ 

Braced Frame Example 

0.326887 

0.320640 

279.48 

194.50 

120.52 

33 



Example 6 

Beam - Steady-State Harmonic Loads 

Description 
L!s is a fixed-end beam in two dimensions subjected toa unifonnly distributed 
load which varies hannonically with respect to time. The beam is shown in Figure 
6-1. The problem is the same as given in Reference [ 1]. The beam is sol ved twice, 
once using the undamped, steady-state analysis option and once using the periodic 
loading, time-history analysis option. 

Significant Options of SAP2000 Activated 
• Two-dimensional frame analysis 

Steady-state analysis 

Time-history analysis for periodic loading 

Input Data 
The computer model used is shown in Figure 6-1. Pound-inch units are used. 

For the steady-state option the frequency ofthe forcing function is provided in cy­
cles per second. The input data file for this option is BEAM. 
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For the time-history option the time function (sine wave) portion ofthe loading is 
discretized at 37 points at egua! intervals covering one complete cycle of loading. 
See Figure 6-2. The input data file for this example is BEAMTH. 

Comparison of Results 
Reference [ 1] computes the deflection at the center of the beam to be -0.0541 sin 
3001. The SAP2000 result for the amplitude ofthis deflection for the steady-state 
option is -0.054535. It should be noted that Reference [1] uses only the first five 
mode shapes of the beam for its computation. The SAP2000 results for the time­
history option are shown in Figure 6-3. The maximum amplitude being reported is 
-0.05440. The comparison ofresults for both methods of analysis in SAP2000 with 
the theoretical results is excellent. 

Reference 

36 

l. Paz, M. 
Structura/ Dynamics, Theory and Computarions, Van Nostrand Reinhold, 
1985. 



Example 6 Beam - Steady-State Harmonic Loads 

200 Sin 300 t 

14---------- 240 in 

MODULUS OF ELASTICITY = 30X106 psi 
MOMENT OF INERTIA = 100 in4 

MASS PER UNIT LENGTH = 0.1 lb-sec2/in/in 
y 

j 1 10 

1 
2 3 4 5 6 7 8 9 10 

11 
X 

2 Joint Number 
2 Element Number 

•' Figure 6-1 
Beam Example 
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Figure 6-2 
Time Variation of Loading 
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Center Span Displacement 
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Example 7 

Two-dimensional Truss -
Static Loads 

Description 
This is a two-dimensional truss structure. All members can carry only axial loads. 
The truss is shown in Figure 7-1. 

Significant Options of SAP2000 Activated 
Two-dimensional truss analysis 

• Vertical joint loads 

Input Data 
The computer model used is shown in Figure 7-1. Truss members are modeled us­
ing frame elements with zero moments of inertia. Load case 1 is live load, and Load 
case 2 is dead load. Load combination 1 is dead load plus live load. 

The input data file for this example is TRUSS. 
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Comparison of Results 

40 

This example is included as a sample only. Other results for comparison are not 
available. 
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Example 8 

Three-dimensional Building -
Dynamic Loads 

Description 
This is a two-story, three-dimensional framed building. The structure is shown in 
Figure 8-1. The tloors actas rigid diaphragms. The building is unsymmetrical and 
is subjected to lateral dynamic loads along two horizontal axes ata 30° angle to the 
building axes. 

Significant Options of SAP2000 Activated 

Input Data 

Three-dimensional frame analysis 

Rigid diaphragm modeling 

Response-spectrum analysis in two directions 

The computer model used is shown in Figure 8-1. Kip-foot units are used. Joints 19 
and 20 are specified at the center of gravity ofStories 1 and 2, respectively, and the 
X- and Y -direction masses and the mass moment of inertia about the Z axis is de­
fined al these joints only. A11 six modes of the structure are used for the dynamic 
analysis. The response spectra are defined for two horizontal axes ata 30° angle to 
the building axes. 
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The input data file for this example is BUILDING. 

Comparison of Results 

44 

This example is included as a sample only. Other results for comparison are not 
available. 



Example 8 Three-dimensional Building- Dynamic Loads 

12 

11 

@ JOINT NUMBER 
14 ELEMENT NUMBER 
TYP. COL. 18" x 18" 
TYP. BM. 12" x 24" 

MODULUS OF ELASTICITY = 432000 ksf 

TYPICAL STORY MASSES, Mx and Mv = 3.88 kip-sec2/ft 

TYPICAL STORY MASS MOMENT OF INERTIA, lz = 1011 kip-sec2-ft 

Figure 8-1 
Three-dimensional Building Examp/e 
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Example 9 

Patch Tests- Prescribed 
Displacements 

Description 
This is a rectangular plate with irregularly-shaped elements and subjected to pre­
scribed displacements at the edges. The plate is shown in Figure 9-l. The location 
of the inner nodes and the prescribed displacements are the same as suggested in 
Reference [l]. The problem is solved using both Plane Stress elements and Shell 
elements. 

Significant Options of SAP2000 Activated 
Plane stress analysis using 4-node Plane elements 

Displacement specification 

• Plate bending and membrane analysis using Shell elements 

Input Data 
The computer model used is shown in Figure 9-1. The prescribed displacements at 
the edges are calculated as: 

u = w·' ( x + 2::. ) 
2 
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v = w·' (y+~¡ 
2 

·' (x' +xy+v') w= ro· · 
2 

e = w·' <Y+~) 
' 2 

e = 10"3 (-x-l) 
' 2 

These represen! constan! stress fields. 

For the Plane element solution, only the X- and Y -translations are unrestrained. All 
other degrees offreedom are restrained. For the Shell element solution, all six de­
grees of freedom are unrestrained beca use the membrane forrnulation of this shell 
element gives rotational stiffness components about a direction normal to the plane 
of the shell. 

For this example, the input data file using the Plane element is PA TCHPLN, and 
that using the Shell element is P A TCHSHL. 

Comparison of Results 
The theoretical results for the problem areS_.= S,= 1333 and S,,= 400 for the 
membrane components; and M .. = M,= l.lll x w·' and M,;= 0.333 x 10·' for the 
plate bending components. These theoretical results are reproduced by SAP2000. 

Reference 

48 

l. MacNeal, R. H. and Harder, R. C. 
A Proposed Standard Set of Problems to Test Finite E/ement Accuracy, Finite 
Elements in Analysis and Design l (1985), pp.- 20, North-Holland. 



Example 9 Patch Tests- Prescribed Displacements 

.12 

yf .... ...._ _______ 24 -------~ 
2 8 

4 

2 X 
1 7 

Location of inner nodes: 3 Joint Number 
X y 3 Element Number 

3 .04 .02 
4 . 08 .08 
5 .18 .03 
6 .16 .08 

THICKNESS = 0.001 

MODULUS OF ELASTICITY = 1.0X106 

POISSON'S RATIO = 0.25 

Figure 9-1 
Patch Test Examp/e 
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Example 10 

Straight Beam - Static Loads 

Description 
This is a straight cantilever beam ofproponions shown in Figure 10-1. The beam 
has unit forces at the tip in the three onhogonal directions and a unit twist, each 
modeled as a separate Load case. The beam is modeled using different mesh geo­
metries as suggested in Reference [ !]. The problem is sol ved using Shell elements, 
nine-node Plane stress elements ,and Solid e!ements. 

Significant Options of SAP2000 Activated 
• Shell element analysis 

Plane element analysis with plane-stress option 

• So! id element analysis with and without incompatible bending modes 

Input Data 
Severa! mesh geometries are used and key results for these are presented. The fol­
lowing data files are provided: 

• STRBMSHL for the rectangular mesh of Shell elements. 

• STRBMPLN for the rectangular mesh of Plane elements. 
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STRBMSOL for the rectangular mesh of Solid elements with incompatible 
bending modes. 

Figures 10-1 to 10-3 represen! the models used for the Shell, Plan e and Sol id ele­
ments. 

The unit forces at the tip are applied as 1/2 at each node for the Shell element; 1/6 at 
each comer node and 4/6 at the midside node for the Plane element; and 1/4 at each 
node for the So lid element. This represents a consisten! set of forces for the ele­
ments. The unit rwist for the Shell and Solid elements is applied as a couple. 

For the model using Shell elements the nodes at the fixed end are restrained in the 
axial direction, in the out-of-plane direction, and for rotations that cause out of 
plane bending. The transverse, in-plane direction is restrained only at one node so 
as not to cause local Poisson's effect. The other node is. however, provided with the 
transverse reaction as a load. 

For the model using Plane elements the nodes at the fixed end are restrained in the 
axial direction and one of them is al so restrained in the transverse, in-plane direc­
tion forthe same reason as forthe Shell element. The other nodes are, however, pro­
vided with the transverse reactions as loads. AII rotations and the out-of-plane di­
rection for al! nades are also restrained. 

For the model using Salid elements the nades at the fixed end are restrained in the 
axial direction and one ofthem is al so restrained in the rwo transverse directions for 
the same reason as for the Shell element. This, however, does not make the model 
stable. so an additional node is restrained in the venical direction to prevent rotation 
about the axial direction. The other nades are, however, provided with the trans­
verse reactions as loads. 

Comparison of Results 

52 

The displacements at the tip in the direction ofthe load is compared for each type of 
element and the different mesh es with the theoretical results in Figures 10-4, 10-5, 
and 10-6. 

The results for the Shell element are good except for the in-plane shear results for 
the irregular meshes and the results for the unit twist. The twist results are too stiff. 
The element is too thick compared to the width for the thin plate twisting behavior 
the Shell element is capable ofmodeling. The irregular mesh behavior in in-plane 
shear can be improved by decreasing the skewness and aspect ratio of the elements 
and using more elements. 



Example 10 Straight Beam - Static Loads 

The results for the nine-node P1ane e1ement for all mesh geometries is excellent. 
The four-node Plan e e1ement is too stiff in bending anda finer mesh would be re­
quired to accurately capture the bending behavior. 

The results for the Salid element with a rectangular mesh and using incompatible 
bending modes are good except for the case with the unit twist. To capture the twist­
ing behavior accurately, more elements are needed across the beam section. The 
Sol id element model without incompatible bending modes is too stiff in the bend­
ing mode. A finer mesh a1ong the length ofthe beam would give better results . 

. Reference 
l. MacNeal, R. H. and Harder, R. C. 

A Proposed Standard Set ofProblems to Test Finite Element Accuracy, Finite 
Elements in Analysis and Design 1 ( 1985), pp. 3-20, Nonh-Holland. 
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z 

2 
1 

1 13 X 

a) Regular Shape Elements 

z 

2 4 
1 

X 
b) Trapezoidal Shape Elements 

z 

2 4 6 
1 

1 3 5 7 X 
e) Parallelogram Shape Elements 

3 Joint Number 
l. Element Number 

LENGTH = 6.0 
WJDTH = 0.2 
THICKNESS = 0.1 
MODULUS OF ELASTICITY = 1.0X107 

POISSON'S RATIO = 0.30 

LOADING: UNIT FORCES AT FREE END 

Figure 10-1 
Straight Beam Example - She/1 Element Mode/s 
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Example 10 Straight Beam - Static Loads 

z No! los cale 

;i. 27 28 29 30 31 32 33 34 35 36 37 38 39 
-1'"' 

.1 2 ~ j .§ .§ 

~ • • • • • • 26 
14 

<t 
-1'"' 

1 2 3 4 5 6 7 8 9 10 11 12 13 y 

6 Joint Number 
6 Element Number 

Figure 10-2 
Straight Beam Examp/e- Plane Stress Element Model 

Not to Scale 

',,'A 

z 

6 Joint Number 

§.. Element Number 

Nade 1 is fixed 
8,15 and 22 are restrained ax1ally 

Figure 10-3 
Straight Beam Examp/e- So/id Element 
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SAPlOOO 

Load 
Theoretical 

Direction Rectangular Trapezoidal Parallelogram 
Mesh Mesh Mesh 

Extension 3.000xl0"5 3.000xl0"5 3.000x10"5 3.000xl0"5 

Out-of-plane 
0.4263 0.4266 0.4266 0.4321 

Shear 

In-plane Shear 0.1072 0.0221 0.0790 0.1081 

Twist 0.00233 0.00233 0.00233 0.00321 

Figure 10-4 
Comparison ofTip Displacemems Using She/1 Elements 

SAP2000 

Load 
Rectangular Rectangular Trapezoidal 

Parallelo-
Theoretical 

Direction Mesh Mesh Mesh 
gram 

4-Node 9-Node 9-'iode 
Mesh 

Element Element Element 
9-Node 

Element 

Extension 3.000xl0"5 3.000xi0-5 3.000xl0"5 3.000x 10"5 3.000x10-5 

In-plane Shear 0.0101 0.1076 0.1063 0.1065 0.1081 

Figure 10-5 
Comparison ofTip Disp/acemems Using Plane Stress Element 
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Example 10 Straight Beam - Static Loads 

SAP2000 

Load Rectangular Rectangular 
Thcoretical 

Direction Mesh with Mesh without 
Incompatible Incompatible 

Bending Modes Bending ~lodes 

Extension 3.000xl0.5 3.000xi0·5 3.000xl0·5 

Out-of-plane Shear 0.4283 0.0109 0.4321 

ln-plane Shear O. 1072 0.0101 0.1081 

Twist 0.00286 0.00286 0.00321 

Figure 10-6 
Comparison ofTip Displacements Using So/id Elements 

.. 

f 
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Example 11 

Curved Beam - Static Loads 

Description 
This is a curved cantilever beam ofproportions shown in Figure 11-1. The beam is 
loaded with unit shears at the free end. The problem is the same as suggested in Ref­
eri:nce [1]. The problem is solved using Shell elements and Plane elements. 

Significant Options of SAP2000 Activated 
Shell element analysis 

Plane element analysis using plane- stress option 

Input Data 
The input data file for the Shell element example is CRVBMSHL, and for the Plan e 
element example is CRVBMPLN. 

Comparison of Results 
The displacement at the free end in the direction ofthe load is compared with theo­
retical results (Reference [1]) for both element types in Figure 11-2. 

For the Plane element, more elements along the length ofthe beam would give bet­
ter results. The aspect ratio ofthe element is quite large in this model. 
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For the Shell element, the in-plane (membrane) results are good; the out-of-plane 
(bending) results ~e not as good. This is beca use of the stiffer twisting behavior 
when the thickness is Jarge compared with the width. 

Reference 

60 

l. MacNeal, R. H. and Harder, R. C. 
A Proposed Standard Set ofProblems to Test Finite Element Accuracy, Finite 
Elements in Analysis and Design 1 (1985), pp. 3-20, Nonh-Holland. 



Example 11 Curved Beam- Static Loads 

y 

z 

3 Joint Number 
1 Element Number 

8 

SUPPORT/ 

INNER RADIUS = 4.12 
OUTER RADIUS = 4.32 
ARC = goo 
THICKNESS = 0.1 
MODULUS OF ELASTICITY = 1.0X107 

POISSON'S RATIO = 0.25 

LOADING: UNIT FORCES AT FREE END 

Figure 11-1 
Curved Beam Examp/e - She/1 Element Model 
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Load 
Direction 

ln-plane 
Shear 

Out-of-plane 
Shear 

62 

SAP2000 

9-l'iode 
Shell 

Plane Stress 
Element 

Element 

0.0775 0.0851 

0.4518 

Figure 11-2 
Comparison ofTip Disp/acements 

Theoretical 

0.0873 

0.5022 



Example 12 

Twisted Beam - Static Loads 

Description 
This is a twisted cantilever beam ofproportions shown in Figure 12-1. Unit 1oads 
are applied at the free end. The prob1em is the same as suggested in Reference [ 1]. 
The prob1em is solved using Shell e1ements. 

Significant Options of SAP2000 Activated 
• SHELL e1ement analysis 

Input Data 
The computer mode1 used JS shown in Figure 12-1. The input data file for this ex· 
ample is TWSBMSHL. 

Comparison of Resufts 
The disp1acements at the tip in the direction ofthe 1oads are compared with theoreti· 
cal results (Reference [1]) in Figure 12·2. The comparison is excellent. 
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Reference 
l. MacNeal, R. H. and Harder, R. C. 

64 

A Proposed Standard Set of Problems /0 Test Finite Element Accuracy. Fimte 
Elements in Analys¡s and Design 1 (1985), pp. 3-20, North-Holland. 



Example 12 

29 30 
1_4 

~ 
4 3 2 

14 Jo1nt Number 
~ Elemenl Number 

Load 
Direction 

In-plane Shear 

Out-of-plane Shear 

Twisted Beam Static Loads 

13 

31 10 11 
32 7 8 9 _o 

5 6 33 34 35 36 37 38 39 

LENGTH = 12.0 
WIDTH = 1.1 
THICKNESS = .32 
TWIST (root to tip) = 90° 
MODULUS OF ELASTICITY = 29.0X106 

POISSON'S RATIO = 0.22 

LOADING: UNIT FORCES AT FREE END 

Figure 12-1 
Twisted Beam Example 

SAP2000 Shell 
Element 

12xl2 Mesh 

0.005413 

0.001770 

Figure 12-2 
Comparison of Tip D~f/ections 

Theoretical 

0.005424 

0.001754 

z 
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Example 13 

Beam On Elastic Foundation -
Static Loads 

Description 
This is a simply supported beam on an elastic foundation. Half ofthe beam is mod­
eled as shown in Figure 13-1. The geometry and the loads are the same as used in 
Reference [1]. 

Significant Options of SAP2000 Activated 

Input Data 

Plane element analysis using the plane stress option 

Spring supports representing elastic foundations 

The co.mputer model used is shown in Figure 13-1. Pound-inch units are used. 
Nine-node Plane elements with the plane stress option are used. Halfofthe beam is 
modeled using 1 O elements and symmetry is utilized to obtain the boundary condi­
tions. Springs are used to model the elastic foundation. 

The input data file for this example is BEAMONFN. 
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Comparison of Results 
The transverse displacements along the center ofthe beam and the maximum bend­
ing stress (using the average ofthe val u es at the top and bottom fiber) are e o m pared 
with theoretical results (Reference [ 1]) in Figure 13-2. The comparison is good. 

Reference 

68 

l. Peterson, F. E. 
EASE2. E/astic AnaZvsis for Stntctura/ Engineering, Example Problem Man­
ual, Engineering Analysis Corporation. Berkeley, California, 1981. 



Example 13 Beam On Elastic Foundation - Static Loads 

r 43.4 lb/In 

( 1 1 t t 
63 

.l 2 ª ~ § § z ª ~ 

• • • • • • • • 

3 Joint Number 
ª- Element Number 

THICKNESS = 1 in 
MODULUS OF ELASTICITY = 30X106 psi 

Figure 13-1 
Beam on E/astic Foundation Example 
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Axial 
Station 

o 
6 

12 

18 

24 

30 

36 

42 

48 

54 

60 

66 

72 

78 

84 

90 

96 

102 

108 

114 

120 
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Transverse . Maximum 
Displacements Bending Stress 

SAP2000 Theoretical SAP2000 Theoretical 

1.0458 

1.0336 

0.9973 

0.9373 

0.8546 

0.7507 

0.6275 

0.4874 

0.3335 

0.1695 

0.0002 

1.0453 

1.0331 

0.9967 

0.9367 

0.8541• 

0.7502 

0.6270 

0.4870 

0.3331 

0.1693 

0.0000 

Figure 13-2 
Comparison of Results 

18029 18052 

17751 17773 

17183 17206 

16304 16327 

15082 15106 

!3476 !3501 

11436 11462 

8902 8930 

5810 5839 

2089 2119 



Example 14 

Rectangular Plate - Static Loads 

Description 
This is a rectangular plateas shown in Figure 14-1. This problem is sol ved using 
two different aspect ratios: one square plate of2 x 2, and another rectangular plate 
of2 x 10. ·Two Load cases are used: Load case 1 for a concentrated load at the cen­
ter and Load case 2 for uniforrn load. Also, the problems are sol ved once with the 
edges clamped, and once with the edges simply supported. The problem is modeled 
using both Shell and Sol id elements. The geometry, properties and loads used are 
those suggested in Reference [ 1]. 

Significant Options of SAP2000 Activated 

Input Data 

Plate bending analysis using Shell elements 

Plate bending analysis using Salid elements 

Static load analysis 

The computer model using Shell elements is shown in Figure 14-1. For both types 
of elements, a 6 x 6 mesh is used on a quarter ofthe plate, with symmetry conditions 
applied to represen! the remainder ofthe plate. Incompatible bending modes are in-

. cluded for the Sol id element solutions. 
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The input data file for the model using Shell elements with clamped edges is 
RCPL TSHL. The input data file for the model using Sol id elements with simple 
supports is RCPL TSOL. Both are for a rectangular (2 x 1 O) plate. 

Two different thicknesses are used in models using Sol id elements. One is 100 
times thicker than the model using Shell elements, the other is l 000 times thicker. 
The loads for each modelare inversely proportional to the cube ofthe thickness so 
that all displacements are of the same order of magnitude. 

Comparison of Results 
The central detlection results for the various boundary conditions. loading condi­
tions, and element types are compared in Figure 14-2 with the theoretical results. 
The comparison is good. The thicker model using SO LID elements gives better re­
sults because of the improved aspect ratio. 

Reference 

72 

l. MacNeal, R. H. and Harder, R. C. 
A Proposed Standard Set of Prob/ems to Test Finite Element Accuracy, Finite 
Elements in Analysis and Design 1 ( 1985), pp. 3-20, North-Holland. 



Example 14 

T 
2.0 

43 

36 

29 

22 
15 

8 

Rectangular Plate- Static Loads 

sym 1 
--:':'~_,!5__~_47_4~. !L_ 

31 35 36-,42 
25 _135 
19 !28 sym 
13 !, 
7 ! . ! 14 

..!. 2 3 4 5 6 1 

1

'.. 2 1+------- 2.0 or 10.0 

3 5 6 

6 Joint Number 
~ Element Number 

THICKNESS (SHELL ELEMENT) : 0.0001 
THICKNESS (SOLIO ELEMENT) :0.01 or 0.1 
MODULUS OF ELASTICITY : 1.7472x107 

POISSON'S RATIO : 0.3 

LOADING: UNIFORM LOAD: 1.0x104 

CENTRAL LOAD : 4.0x1 04 

BOUNDARIES: SIMPLY SUPPORTED OR CLAMPED 

Figure 14-1 
Rectangular Piare Examp/e 
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SAPZOOO 

Boundary 
Aspect 

0.0001 0.01 Thick 0.1 Thick Loading Ratio 

Uniform 

Concen-
trated 
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Condition 
(b/a) Thick Sol id 

Shell Element 
Element 

Simply 
1.0 4.061 3.175 

Supported 
5.0 12.92 9.37 

1.0 1.29 0.83 
Clamped 

5.0 2.60 1.83 

Simply 
1.0 11.77 . 8.76 

Supported 5.0 17.74 6.40 

1.0 5.76 3.44 
Clamped 

5.0 7.80 1.78 

Figure 14-2 
Comparison of Dej/ection at Center 

So lid 
Element 

4.084 

12.91 

1.30 

2.61 

11.89 

15.97 

5.87 

6.39 

Theoreti-
cal 

4.062 

12.97 

1.26 

2.56 

11.60 

16.96 

5.60 

7.23 



Example 15 

Cantilever Plate- Eigenvalue Problem 

Description 
This is a square cantilever plate and the first five eigenvalues are computed. The 
plate is shown in Figure 15-1. 

Significant Options of SAP2000 Activated 

Input Data 

Shell elements for plate bending analysis 

Eigenvalue analysis 

Large capacity analysis- over 4900 dynamic degrees offreedom 

Three different mesh sizes are used: a 1 O x 1 O mesh, a 19 x 19 mesh, and a 40 x 40 
mesh. The computer model used for the 19 x 19 mesh is shown in Figure 15-1. 
Kip-inch units are used. Unit mass for the plate is specified to generate the mass 
matrix. 

The input data file is PLATE for the 19 x 19 mesh and LARGEPLT for the 40 x 40 
mesh. 
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Comparison of Output 
Reference [ 1] gives results for the first five natural frequencies of a square cantile­
ver pi ate obtained by using the Ritz method with beam m o de shapes. A comparison 
ofthe SAP2000 results with the Reference [!] results is given in Figure 15-2. 

The comparisons ofthe periods of vibration for the first. third and fourth modes are 
excel!ent; however, the comparisons ofthe periods ofvibration for the second and 
fifth modes are not as good because the results of Reference [ 1] involve approxi­
mating plate mode shapes with beam mode shapes. 

The SAP2000 results using three different mesh sizes are very close. 

Reference 
l. Harris, C. M. and Crede, C. E. 

Shock and Vibration Handbook, McGraw-Hill, 1976. 
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ORIGI 

Cantilever Plate - Eigenvalue Problem 

y 

24" 

19 equal spaces 

381 400 -cr-

1 

' 

24" 
19 equal spaces 

41 60 

21 20 21 22 23 24 38 40 
1 .. "1 2 3 4 5 6 7 e 9 10 11 12 13 14 15 16 17 18 19 20 

N~l!!//l/////l////~;:;,;1:::.1 11 
""" u///////////////1// 

PLATE 24"x 24"x 1" 
MODULUS OF ELASTICITY = 29500 ksi 
MASS DENSITY = 0.49/1728/386.4 kip-sec 2 /in/in 3 

Figure 15-1 
Cantilever Piare Examp/e 

X 
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SAP2000 

M o de 40 X 40 19 X 19 10 x 10 Reference [ 1) • 

MESH MESH 1\IESH 

1 0.01779 0.01781 0.01787 0.01790 

2 0.00647 0.00648 0.00654 0.00732 

3 0.00284 0.00285 0.00288 0.00292 

4 0.00221 0.00223 0.00228 0.00228 

5 0.00186 0.00187 0.00190 0.00201 

• Using Rit: 's method with beam mode shapes 

Figure 15-2 
Comparison of Natural Periods of Vibra/ion 
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Example 16 

Scordelis-Lo Roof- Static Loads 

Description 
This is a reinforced concrete single span cylindrical roof as shown in Figure 16-1. 
The roofis to be analyzed for gravity loads. The problem sol ved is the same as sug­
gested in Reference [ 1]. 

Significant Options of SAP2000 Activated 
• Three-dimensional shell analysis 

• Gravity load analysis 

Large capacity analysis- 7991 static degrees of freedom 

Input Data 
Two different mesh sizes are used for this problem: one, a 6 x 6 mesh used on a 
quaner ofthe roofas shown in Figure 16-1; another, an 18 x 72 mesh used on half 
the roo f. Pound-foot units are used. Symmetry boundary conditions is used to rep­
resen! the omitted pans ofthe structure. Unit weight is specified to apply the uni­
formly distributed loading. 

The input data file for the 6 x 6 mesh is ROOF. The input data file for the 18 x 72 
mesh is LARGEROF. 
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Comparison of Results 
The theoretical vertical deflection atthe center ofthe free edge is 0.3086, and Ref­
erence [ 1] suggests a value of 0.3024 for comparison of finite element behavior. 
SAP2000 gives a value of0.3068 for the 6 x 6 mesh and 0.3012 for the 18 x 72 
mesh. The comparison is excellent. 

A comparison of SAP2000 displacement and bending moment results using the 6 x 
6 mesh. and theoretical results provided in Reference [2] using the theory presented 
in Reference [3], is given in Figures 16-2 and 16-3. The theoretical results are meas­
ured from the figures given in Reference [2]. Nodal averages are used for the 
SAP2000 bending moments shown. The comparison is good. 

References 

80 

l. Macl'iea1. R. H. and Harder, R. L 
A Proposed Standard Set ofProblems to Test Finite Element Accuracy, Finite 
Elements in Analysis and Design 1 (1985), pp. 3-20, North-Holland. 

2. Zienkiewicz, O. C. 
The Finite Element Method, McGraw-Hill. 1977. 

3. Scordelis, A. C. and Lo, K. S. 
Computer Analysis ofCylindrical Shells, Journal ofthe American Concrete In­
stitute, Vol. 6i, May 1964. 



Example 16 Scordelis-Lo Roof- Static Loads 

z 

1 

"',,~ 
' 

25' 

y 

\ 
' 

THICKNESS 
MODULUS OF ELASTICITY 
POISSON'S RATIO 
GRAVITY LOAD 

7 

/ 
/ 

/ 

21 
14 

42 
35 

28 FREE 

50' 

7 Joint Number 
7 Element Number 

= 3 in 
= 4.32 x1 o8 psf 
= 0.0 
= 90 psf 

(UNIFORM ON SURFACE AREA) 

BOUNDARY CONDITION: SIMPL Y SUPPORTED 
ON CURVED EDGES 

Figure 16-1 
Scorde/is-Lo Roof Example 
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Location 

o o 

6.67° 

13.33° 

20.00° 

26.67° 

33.33° 

40.00° 

Location 

o o 

6.67° 

13.33° 

20.00" 

26.67° 

33.33° 
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Axial Deformations Vertical Displacements 
at Support at Central Section 

SAP2000 6x6 SAP2000 6x6 
Mesh Theoretical Mesh Theoretical 

0.0000 0.0004 0.046 0.045 

0.0005 0.0009 0.031 0.027 

0.0018 0.0020 -0.013 -0.018 

0.0029 0.0030 -0.078 -0.082 

0.0024 0.0021 -0.155 -0.155 

-0.0017 -0.0016 -0.234 -0.241 

-0.0118 -0.0120 -0.307 -0.309 

Trans\·erse Moments Twisting 1\1oments 
at Central Section at Support 

SAP2000 6x6 SAP2000 6x6 
Mesh Theoretical Mesh Theoretical 

-2099 -2090 -91 o 

-1978 -2000 -359 -380 

-1614 -1620 -698 -670 

-1045 -1000 -982 -1000 

-408 -430 -1183 -1240 

37 lOO -1248 -1290 

Figure 16-2 

Comparison of Results 



Example 17 

Hemispherical Shell - Static Loads 

Description 
This is a hemispherical shell loaded by point loads at the edge as shown in Figure 
1 7 -l. The problem sol ved is identical to the one suggested in Reference [ 1]. 

Significant Options of SAP2000 Activated 
• Three-dimensional shell analysis 

Input Data 
The computer model used is shown in Figure 17-1. An 8 x 8 mesh ofShell elements 
is used on a quarter of the hemispherical shell. Symmetry is used to define the 
boundary conditions. A single restraint in the vertical direction is applied at the cen­
ter of the free edge to pro vide stability. 

The input data file for this example is SHELL. 

Comparison of Results 
The theoreticallower bound for the displacement under the load in the direction of 
the load is 0.0924, where the hole at the e en ter is not present. Reference [ 1] suggests 
a val u e of 0.094 fór comparison ofresults. The SAP2000 solution gives a value of 
the displacement under the load of0.0937. The comparison is excellent. 
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Reference 
l. MacNeal, R. H. and Harder, R. C. 

84 

A Proposed Standard Ser of Problems to Test Finite Element Accuracy. Finite 
Elements in Analysis and Design 1 (1985), pp. 3·20, North·Holland. 



Example 17 Hemispherical Shell - Static Loads 

z 18°----y 
81 

SYM 
55 

i! 
46 

SYM 33 

37 

~ 28 
17 y 

19 

! 
10 

9 
F = 1.0 

(on quadrant) 

1 2 l 
1 

;:2 3 4 
FREE 

X F = 1.0 
on quadrant) 

6 Joint Number 
~ Element Number 

RADI US = 10.0 
THICKNESS = 0.4 
MODULUS OF ELASTICITY = 6.825xtal 
POISSON'S RATIO = 0.3 

LOADING: CONCENTRATED FORCES AS SHOWN 

Figure 17-1 . 
Hemispherica/ Shell Examp/e 
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Example 18 

Portal with P-delta 

Description 
These are two two-dimensional. one story, one bay, ponal frames fixed at the base 
as shown in Figure 18-1. One frame carries a central load of 1000 pounds and the 
other carries an eccentric load ofthe same magnitude. The critica! buckling load for 

the frame in the symmetrical, non-sway mode is 6082 pounds (P"' = 255~ El) and 
h 

2 
in the asymmetrical, sway mode is 1784 pounds (P" = ·

748
7!
2 

El). The purpose of 
h 

this example is to verify the adequacy of the P-Delta algorithm in SAP2000 for 
these type ofproblems. Theoretical results for these problems can be derived using 
the stability function approach. Tables for stability functions can be obtained from 
References [ 1]. 

Significant Options of SAP2000 Activated 
• P-Delta analysis of frameworks 
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Input Data 
The two frames are modeled together in SAP2000 usíng Frame elements. The load­
ing is applied as span loads to the beams of the structures. Pound-mch units are 
use d. 

The theoretical results are computed assuming no axial deformation and no shear 
deformation in the members. To duplícate this behavior a large axial area is specí­
fied for the elements and the shear areas are defaulted as zero (program interprets 
this to mean that the shear deformation is to be ignored.) It is importan! to note that 
the axial deformations of the members were not forced to be zero by restraining or 
constraining the joints. Setting the axial deformation to be zero in this manner also 
sets the axial load in the member to be zero . .This then completely eliminares the P­
Delta effect from that member. 

For the P-Delta analysis the default value of the relative displacement tolerance 
(.00 1) is used and the maximum number ofiterations is set at JO e ven though the so­
lution converges at a much lower number of iterations. All loads are in a single 
Load case and this is used as the P-Delta load combination. 

The input data for this example is PORTALPD. 

Comparison of Results 

88 

The lateral displacement,joint rotation and member end-moment results for the two 
load configurations are compared in Figure 18-2 with theoretical results and with 
results for a model in which the P-Delta effect was ignored. The agreement between 
the SAP2000 and theoretical results is excellent. 

Theoretical values are obtained using the slope-deflection method ofanalysis by in­
cluding the effect ofaxialloads in members. In this case the stiffness and carry-over 
factor of each member, instead of being constan!, are functions of the axial load in 
the member. These functions are tabulated in Reference [ 1 ]. 

It is interesting to study the effect of P-Delta for these frames. In the symmetrical 
frame (central load), the decrease in the stiffness ofthe columns dueto compressive 
axial loads causes a decrease in the beam end moments (top column moments) but 
increases the bottom column moments. For the asymmetrical frame (eccentric 
load), the same effect is seen in the column that carries the larger axial load. How­
ever, the column with the lesser axial load is now comparatively stiffer and attracts 
a larger moment at each end when P-Delta effects are considered. 



Example 18 Portal with P-delta 

Reference 
l. Livesley, R. K., and Chandler, D. B. 

Stability Functions for Structural Frameworks, Manchester University Press, 
UK, 1956. 

Deformed Shope 

Undelormed Shope 

(o) Oeformotion Under Central Load 

b/4 

"' 
:_s~~--+---~~ 

Ms 

Deformed Shope 

Undeformed Shope 

-r 7 r 

(b) Deformotion Under Eccentric Load 

TYPICAL PROPERTIES 

SPAN, b 

HEIGHT, h 

AREA, A 

MOMENT of INERTIA, 122 .1 33 

MODULUS of ELASTICITY, E 

• lOO in 

"" 100 in 
2 

"" 1 in 

1/12 in• 

• "" 29x10 psi 

Figure 18-1 
Portal Frame Examp/e 
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Wlth P-Delta 
\Vithout 

P-Delta 
QUANTITY 

SAP2000 Theoretical 
SAP2000 & 
Theoretical 

Rotation Jomt 2 ( e, ) 0.09178 0.09192 0.08620 

Moment Joint 1 ( M12 ) 4589.1 4606.6 4166.7 

Moment Joint 2 ( M21 ) 8260.4 8254.0 8333.3 

Shear Force ( F) 128.5 128.6 125.0 

Frame Under Central Load 

With P-Delta 
\\'ithout 
P-De1ta 

QUANTITY 

SAP2000 Theoretical 
SAP2000& 
Theoretical 

Lateral Displacement 1.894 !.893 1.385 
( .6 ) 

Rotarían Joint 6 ( 96 ) 0.1014 0.1013 0.0924 

Rotation Joint 8 ( eM } 0.0367 0.0367 0.0369 

Moment Joint 5 ( Ms6) 2550.9 2544.9 2455.4 

Moment Joint 6 ( M6s ) 6183.6 6088.6 6919.6 

Moment Jomt 7 ( M78) 4503.5 4456.9 3794.6 

Moment Joint 8 ( Ms7 ) 6124.9 6153.0 5580.4 

Shear Force ( F) 101.6 101.4 93.75 

Frame Vnder Eccentric Load 

Figure 18-2 
Comparison of Results for aPlanar Rigid Portal Frame 
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Example 19 

Pounding of Two Planar Frames -
Non linear Time-History Analysis 

Description 
A two-bay; seven-story plane frame is linked toa one bay four story plan e frame us­
ing Nllink Gap elements. The structure experiences pounding due to ground mo­
tion. El Centro 1940 (N-S) record is used in the nonlinear time history analysis. 

The geometry ofthe structure is shown in Figure 19-1. 

Significant Options of SAP2000 Activated 
• Two-dimensional frame analysis 

Use of uniaxial Nllink gap elements 

Nonlinear time-history analysis 

Input Data 
A Diaphragm constraint is applied to each floor of the two frames. Kip-inch units 
are used. 

The joints at column line 3 are connected to the correspondingjoints at column line 
4 by Nllink Gap elements. The local 1 axes ofthese elements are in the global X di­
rection, and gap properties are specified for the local 1 direction. The opening dis-
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placement for the gaps is 0.25 inches, corresponding to the distance between the 
outer faces of the buildings. 

The nonlinear gap stiffness was set to 1000 klin, an estima te of the stiffness of a 
tributary region around the point of contact. The linear effective stiffness, used for 
calculating the modes, was set to zero, since the gap elements are normally open. 
Care should be taken not to use values ofnonlinear stiffness or linear effective stiff­
ness that are too large relative to the stiffness of connecting elements. Overly large 
values of stiffness can cause numerical sensitivity, which can reduce the accuracy 
and the efficiency of the solution. 

The modes were calculated using Ritz vectors, with the ground acceleration and the 
non linear deformation loads used as starting vectors. All eleven modes ofthe struc­
ture were requested. 

The input data for this example is POUND. The time history ofthe ground accelera­
tion is given in file ELCN-THU 

Comparison of Results 

92 

This example is included as a sample only. A typical results plot is shown in Figure 
19-2. lt shows the variations of displacement ofColumn lines 3 and 4 and the link 
force at Story level4.lt can be clearly seen that the link force is generated whenever 
the two column lines move in phase and their separation is less than the specified 
initial opening or ifthey move towards each other out ofphase. For most part the 
pounding has the effect ofkeeping the buildings in phase. For display purposes the 
displacements are scaled up by a factor of 100. 



Example 19 Pounding o!Two Planar Frames- Nonlinear Time-History Analysis 
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Figure 19-11 
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• All columns are W14's 
• All Beams are W24's 

Geometry ofTwo Pounding Frames 
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Time 
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Figure 19-2 
Displacements of Powzding Co/umns and Pounding Force at Story 4 



Example 20 

Friction-Pendulum Base-lsolated 3D Frame­
Non linear Time-History Analysis 

Description 
This is a two-story, three-dimensional frame with base isolation using friction-pen­
dulum base isolators. The structure is subjected to earthquake motion in two per­
pendicular directions using the Loma Prieta acceleration records. 

The geometry of the structure is shown in Figure 20-1. 

Significant Options of SAP2000 Activated 
• Three-dimensional frame analysis 

Use ofbiaxial Nllink friction-pendulum elements 

• Nonlinear quasistatic time-history analysis 

Nonlinear time-history analysis 

Computer Model 
The structure is modeled as a reinforced concrete frame with 9 column lines and 12 
bays. Kip-inch units are used. The modulus ofelasticity is taken to be 3000 ksi. The 
self-weight ofthe concrete is taken as 150 pcf. 
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96 

The !loor slab is taken to be 8" thick covering al! the specitied !loor bays at the base 
and the 1st story levels. At the second story leve] the comer colurnn as well as the 
two edge beams are eliminated together with the !loor slab to render this particular 
leve] unsymmetric as depicted in Figure 20-1. A diaphragrn constraint is applied to 
each story. The !loor slab is modeled with Shell Membrane elements. These are 
used for the purpose of generating mass only; their stiffness is ignored due to the 
diaphragm Constraints. 

Friction-pendulum type base isolators ofthe type described in Reference [1] are 
modeled using the SAP2000 Nllink Isolator2 elements. 

The isolator properties are detined as follows: 

Stiffness in direction 1 (vertical) 1 E3 
Stiffness in directions 2 and 3 (horizontal) 1 E2 
Coefticient of friction al fast speed .04 
Coefficient offriction at slow speed .03 
Parameter determining the variation 

of the coefficient of friction with velocity 20 
Radius of contact surface in directions 2 and 3 60 

A single Load case is defined that models tlie self-weight ofthe structure. This will 
be applied befare the seismic analysis in arder to generate the proper frictional re­
sponse in the isolators. This self-weight must be applied as pan ofthe time-history 
analysis, as described below. 

Seventeen Ritz vectors are requested for the modal analysis, using the two horizon­
tal ground accelerations, the gravity load, and al! the nonlinear deformation loads as 
the starting load vectors. There are 27 nonlinear deformation loads, one for each of 
the three translational degrees of freedom for the nine isolators. However, only 
three ofthe 18 horizontal degrees offreedom are independent dueto the diaphragm 
constraint. The program will automatically discard 15 dependen! starting load vec­
tors. Thus the total number of independent starting load vectors is 15. By listing the 
two ground accelerations as first, two Ritz vectors are generated for these two start­
ing load vectors, and one for each of the remaining 13, for a total of 17 modes. 

lt is very importan! that the nonlinear deformation loads be used as starting load 
vectors in arder to capture non linear behavior. In this case, the axial load in each 
isolatormust be adequately modeled since the shear force depends strongly upon it. 

Two time-history analyses are performed. The tirst history applies the self-weight 
quasistatically. This history consists of 1 O time steps of one second, for a total time 
of 1 O seconds. The load is increased linear! y to fui! value for the first ti ve seconds, 
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and allowed to come to equilibrium for the remaining five seconds. A damping 
value of99% is used for all modesto prevent vibration. 

The second history starts from the tirst history, and applies the seismic acceleration. 
This history consists of2000 time steps of0.02 seconds, for a total time of 40 sec­
onds. Zero damping is used for all modes since most energy dissipation is expected 
to be dueto the friction properties ofthe isolators, with little damage occuring in the 
superstructure. 

The input data file forthis example is 1SOLAT2 and the input time history files are 
LP-THO and LP-TH90. 

Comparison of Results 
This example is included as a sample only. No results are available for comparison. 
Typical plots are shown for the seismic time history. Figure 20-2 shows the time 
variation of input, kinetic, potential ( strain), damping. and frictional energies; these 
energies do not start at zero since they continue from the self-weight time history. 
Figure 20-3 shows the time variation of the displacements of the second !loor at 
Column line l. Figure 20-4 shows the interaction diagram for the two shear forces 
in the isolator beneath Column line l. Figure 20-5 shows the force-displacement 
plot for motion in the X direction of the isolator beneath Column line l. 

References 
l. Zayas, V. and Low, S. 

"A Simple Pendulum Technique for Achieving Seismic lsolation," Earthquake 
Spectra, Vol. 6, No. 2, Earthquake Engineering Research Institute, Oakland, 
California,l990. 
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DISClAIMER 

CONSIDERABLE TIME. EFFORT ANO EXPENSE HA VE GONE 
INTO THE DEVELOPMENT ANO DOCUMENTA TI ON OF 
SAP2000. THE PROGRAM HAS BEEN THOROUGHL Y TESTEO 
ANO USED. IN USING THE PROGRAl\1. HOWEVER. THE USER 
ACCEPTS ANO UNDERSTANDS THAT NO WARRANTY !S EX­
PRESSED OR IMPLIED BY THE DEVELOPERS OR THE DIS­
TRIBUTORS ON THE ACCURACY OR THE RELIABILITY OF 
THE PROGRAM. 

THIS PROGRAM !S A VERY PRACTICAL TOOL FOR THE DE­
SIGN OF REINFORCED CONCRETE STRUCTURES. HOWEVER, 
THE USER MUST THOROUGHL Y READ THE MANliAL ANO 
CLEARL Y RECOGNIZE THE ASPECTS OF REINFORCED CON­
CRETE DESIGN· THA T THE PROGRAM ALGORITHMS DO NOT 
ADDRESS. 

THE USER MUST EXPLICITL Y UNDERST ANO THE ASSUJ\IP­
TIONS OF THE PROGRAM ANO MUST INDEPENDENTL Y VER­
IFY THE RESUL TS. 
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Chapter 1 

lntroduction 

Overview 
SAP2000 features powerful and complete! y integrated modules for design ofboth 
steel and reinforced concrete structures (CS! 1 997a. 1 997b). The program provides 
the user with opnons to create. modify, ana!yze and design structural models, al! 
from w1thin the same user interface. 

The program provides an interactive environment in which the user can study the 
stress conditions. make appropriate changes. such as member size revisions. and 
update the design without re-analyzing the structure. A single mouse click on an 
element brings up detailed design infonmation. Members can be grouped together 
for des1gn purposes. The output in both graphical and tabulated fonmats can be 
read!ly displayed and printed. 

Thc program is structured to support a wide variety of design codes for the auto­
mateó design and check of concrete frame members. The program currently sup­
ports the following design codes: U.S. (ACI 1995). Canadian (CSA 1984), British 
(BSI 1985). and European (CEN 1 992). 

The design is based upon a set of user-specified loading combinations. However, 
the program provides a set of default load combinations for each design code sup­
ported in SAP2000. Ifthe default load combinations are acceptable, no definition of 
additional load combinations are required. 

Overview 1 
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In the design of the columns. the program calculates the required longitudinal and 
shear reinforcement. However the user may specify the longitudinal steel. in which 
case a column capacity ratio is reponed. The column capacity ratio gives an indica­
tion of the stress condition with respectto the capacuy of the column. 

Every beam member ts designed for flexure and shear ata user defmed number of 
stations a long the beam span. 

The presentat10n ofthe output is clear and concise. The infonnation is in a form that 
allows the engineer to take appropriate remedtal measures in thc event of member 
overstress. Backup design mfonnat10n produced by the program is al so provided 
for convenient verification of the results. 

English as well as SI and MKS metric unus can be used to define the model geome­
try and to specify design parameters. 

Organization 
This manual is organized in the following way: 

Chapter ll provides a quick tutorial aiming at giving the first time users hands-on 
experience. Severa! ofthe basic features ofthe SAP2000 concrete design modules 
are explored m this tutonal. 

Chapter III outlines various aspects of the concrete design procedures of the 
SAP2000 program. This chapter describes the common tenninology of concrete 
destgn as implemented in SAP2000. 

Each of four subsequent chapters gtves a detailed description of a specific codc of 
practice as interpreted by and implemented in SAP2000. Each chapter describes the 
design loading combination. column and beam design procedures, and other spe­
cial consideration required by the code. 

Chapter IV gives a detailed description of the ACI codc (ACI 1995) as imple­
mented in SAP2000. 

Chapter V gives a detailed description ofthe Canadian code (CSA 1984) as imple­
mented in SAP2000. 

Chapter VI gives a detailed description ofthe British code (BSI 1985) as imple­
mented in SAP2000. 

Chapter VII gives a detailed description of the Eurocode (CEN I 992) as imple­
mented in SAP2000. 

2 Organization 
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Chapter VIII outlmes vanous aspects of the tabular and graphical output from 
SAP2000 re!ated to concrete design. 

Recommended Reading 
Jt is recommended that first time users fo!low through the steps ofthe "Quick Tu­
torial .. in Chapter ll and read Chapter lll "'Design Algorithms'· and one of four sub­
sequen! chapters corresponding to the cede of interest to the user. Fmally the uscr 
should read "Destgn Output" in Chapter VIII for understandmg and interprcting 
SAP2000 output related to concrete des1gn. 

Recommended Reading 3 



Chapter 11 

Quick Tutorial 

Overview 
Severa] ofthe basic features ofthe SAP2000 concrete design modules are explored 
in this tutorial. Th1s introduction is aimed at giving the firsttime user hands-on ex­
perience for designing concrete frames with SAP2000. The program allows you to 
select from severa] U.S. and international codes to design and review concrete 
structures. A comprehensive on-line Help is included in the program for your quick 
reference. It is assumed that yo u ha ve a working knowledge of concrete design pro­
cedures and are reasonably familiar with the current codes ofpractice and their un­
derlying design concepts. 

\Ve will access the SAP2000 commands from both the Toolbar and from the 
menus. The Toolbar. however. provides quick access to most commonly used fea­
tures ovailable from the menus. 

In the assignmem sequence, there are two importan! points you must remember. 
First, you ha ve to define an entity befare you can assign an attribute to it. and sec­
ond, you ha veto select member(s) befare you can assign new attributes or modify 
old ones. ' 

Overview 5 
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Description of the Model 

The structure is a two-story. two-by-two bay office building located m Seisnuc 
Zone No. 4 (htgh setsmic are a). lt is designed as a special moment resisung con­
crete frame using the ACI 318-95 code . 
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Geometry 

The two-story structure has a panial floor diaphragm anda full roof diaphragm. Se e 
Figure II-1. The story height of the top and bottom floor is taken as 1 o·o· and 12 o·· 
respective1y. The initial member sizes and reinforcement are given in Tablc II-1. 

ID Structural Componen! 
1 

Description 

12 " x 1 ::!", Re bar nor specificd, 
1 Typical columns at the top story 

2 " cover to center of sreel 

2 Typical columns at the bottom story 
18 x 18 .. Rebar not specified. 
i. cover to center of steel 

12 
" 

x2·t'·. Rebar not specificd, 
3 All othcr beams 

2 .. cover to center of steel 

4 The longest span beam (Beam 33) 
¡~" x36 ... Rebar not spccified, 
2 e o ver to centcr of steel 

Table 11-1 
Struclllral Properry Dara (Tutoria/ Example) 

Material Properties 

The properties ofthe materials used in the modelare given in Table II-2. lt is as­
sumed that the materials used for.the beams and columns are the same. However. 
the shear reinforcement is different from the longitudinal reinforcement. 

Material Property 1\lagnitude 

l 4.0 ksi 

E, 3600 kSI 

l 60 ksi 

/, 40 ksi 

Table 11-2 
Material Spec(fications (Turorial Example) 

For analysis m SAP2000, the value of E .. is modified to account for cracking. A 
multiplier of0.4 (as recommended in AC! 318-89) is used for columns assumed to 
ha ve about 2% steel. anda multiplier of 0.5 (as recommended in ACI 318-89) is 

Oescription of the Model 7 
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used for the beams. These multiplication factors are slightly dtfferent in AC1318-
95. See Section R!O.II.l of ACI 318-95. 

Load Cases 

Four load cases are considered in the analysis. The dead and live loads are defined 
as load cases DL and LL respectively. The lateral seismic loads. in tum. are dcsig­
nated as QX and QY respectively. 

The dead and live loads are simplified as line loads on the beams. The equivalen! 
static setsmic forces are applied as Iateralloads at the centroids ofthe diaphragms: 

Load case 1 : DL- 1.0 kip/ft on all beams which are connected with the diaphragm 
along thc X-direct10n (Self-weight included) 

Load case 2 : LL- 0.5 kip/ft on all beams which are connected with the diaphragm 
along the X-direcuon 

Load case 3 : QX- Static equivalent earthquake force in the X-direcuon 

Load case 4 : QY- Static equivalent earthquake force in the Y -directwn 

Analysis 

Two diaphragm constraints are applied for the two dtaphragms at the two floors. 
These constraints prevent in-plane relative displacements ofthe nades at each !loor. 
The lateral earthquake loads are assumed to be apphed at the centroid of the dia­
phragm. A P-Ll analysis is camed out with a load leve! ofO. 75 ( 1.4 DL + 1.7 LL)/ij> 
as recommended in the chapter "Design for ACI 318-95" on page 40. where <O is 
taken as O. 75. 

Desig11 

The design IS performed in accordance with ACI 318-95. Kip-in units are used. The 
input database file for thts model is EXCONC.SDB. This is supplied as part ofthe 
SAP2000 package. 

Starting the Tutorial 
A step-by-step procedure for the design ofthe model is outlined below. lt is recom­
mended that you actually perform these steps while reading this chapter. \Ve as­
sume that you have successfully started the program. You can do thts by running 
SAP2000 from the Start Menu. 

8 Staning the Tutorial 
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In thís tutoría!. whenever poss1ble. we wíll use the Toolbars to access varíous or­
tions quickly. Most ofthe features available on the Toolbars can al so be accessed 
from the Menu Bar. Use the on-line Help or refer to the "SAP2000 Getting Staned" 
manual for a detailed descript!on of the SAP2000 screen. 

The input data base file for the model IEXCONC.SDB) is m the EXAMPLES sub­
d!rectory under the mam d1rectory where the program has been installed. In this ex­
ample, the analysis model1S already created. This tutorial gives the highlights ofthe 
design phase. You are assumed to be familiar Wlth creating and editing structural 
models usmg SAP2000 

Opening the Model Database File 

1. C!ick on the Open button from the File menu. This will display the Opcn 
Model File dialog box. 

2. In this dialog box: 

Se!ect the EXCONC.SDB file. 

Click on the Open button. 

The screen will now show two venically-tiled windows. The left window displays a 
plan view of the model at leve! + 264 in. Section labels are not displayed m this 
view. A three-dimensional view ofthe model is shown in the right window. 

···. 

. .. 
.--

1· 
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Note: ·when working with m u/tiple windows, clickmg anyu·here in a parucular H'in­

dow wil/ activare tlzat windo·w. 

Befare we proceed funher. we will make a copy afthe data file by saving the madel 
under a new name. say, TUTOR I.SDB. We will use the cap y during the tutoría! and 
leave the original file unaltered. 

3. From the File menu. choose Saw As .... This will display the Save 1\lodel File 
As dialog box. 

4. In this dialog box: 

Enter new filename, Tutori.SDB. 

Note: E ven ifyou do not rype in the extension .SDB. tlze program awomati­

cal/y appends rhis exrension ro rhe filename. 

Click an the Save button. 

The new name is d1splayed in the Mam Title Bar. 

Analyzing the Model 
We will naw analyze the madel. Befare analyzing the model we need ta set the P-6 
force and other parameters for P-6 analysis. Todo th1s: 

l. Select the Set Options ... button in the Anal~·ze menu. This will immediately 
bring up the Analysis Options dialog box. In this dialog bax: 

Check the lnclude P-Delta check box. 

Click an the Set P-Delta Parameters button This will bring up the P­
Delta Parameters d1alog ba,. In this dialog bax: 

- Set maximum iteratians to 5. 

- Change the DL scale factor to 1.4 and click 1\lodify. 

- Click an the Load Case drop down arrow. 

- Select LL. 

- Change the LL scale factor to l. 7 and click Add. 

- Click OK to clase the P-Delta Parameters día lag box 

Click OK to clase Analysis Options dialog bax. 

2. Click on the Run Analysis button on the main taalbar. 

10 Analyzing the Model 

" 



Chapter 11 Quick Tutorial 

A top window is opened in wh1ch various phases of analysis are progressively re­
poned. When the analysis is complete the screen will display the following: 

.;otNT OU1fUT l8:0~:JJ 

19:04.35 

" 
lBo0hJ5 

. ,~. 

3. Use the scroll bar on the top window to review the analysis messages and to 
check for any error or warning messages. In our case there should be none. 

4. Click on the OK bunon in the top window to close it. This will display a de­
forrned shape forthe first load case (DL) in the active window (right window in 
this example) as follow:s 

1 1 

-·--- ---------- .. ..-

. 

·. 

1· 1'. .¡ 

Analyzing the Model 11 

" 

' ' 



SAP2000 Concrete Design Manual 

Selecting the Design Code 

Selection of a design code is activated from Preferences ... in the Options menu. 
The default design code is ACI 318-95 forreinforced concrete design. Since the de­
fault code is used in this tutoría!, we can by-pass this step. To confirm. however, 
yo u can follow this: 

l. C!ick on the Preferences ... bunon from the Options menu. This willlaunch the 
Options d~a!og box. 

2. Chck on the Concrete tab. 

3. You can see the currently selected concrete design code. strength reductwn fac­
tors, interaction diagram parameters. and other parameters as shown in the next 
page. Y ou do not need to change anything. 

4. Click on the Cancel button to clase the dialog box. 
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Starting Design 

-. 

With the analysis phase and selection of the design code completed, we will now 
design the structure using the requirements of ACI 318-95. 

l. From the Design menu, choose Start Design/Check of Structure. The pro­
gram now designs each of the concrete frame members. (lf we had selected 
sorne frame members, then only the selected frames would be designed). In a 
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few moments the longitudinal reinforcement requirements are displayed in the 
active wmdow. For beams the compression and the tensile reinforcement are 
dtsplayed separately. For columns the total overall reinforcement area is dis­
played. In the display. the reinforcement areas are reponed for the gO\·cming 
design combination, by default. 

1 1 

0 Right click on a column rnember. for example element 2 (see Figure ll-1 ). This 
will open the Concrete Design Information dialog box showing longitudinal 
and shear reinforcement requirements at various stations along the element 
length for the various load combinations (see screen below). The dialog box 
also can show infonnation regarding the Details of calculation for design, the 

element overwrite assignrnents for ReDesign for the selected member. and col­
umn lnteraction propenies. However. ifthe member is a beam. rather than a 
column, the Interaction propenies are not relevant and are not available from 
the Concrete Design lnformation dtalog box. 

Staning Design 13 
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3. In this dialog box: 

!~ 

::¿]! 

Selecta design check station in the Concrete Design lnformation dialog 
box. 

Click on the Details button. This will open the Concrete Design lnforma­
tion AC1318-95 screen showing the design parameters including the rein-· 
forcement areas and the factored member forces for the selected load com­
bination at that panicular station. See screen below. 
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Close the Concrete Design Information ACI 318-95 window. 

Click on the lnteraction button. This will open the dialog box showing the 
column interaction dtagram and the current state ofthc design forces in the 
diagram for the selected load combination at that particular station. The in­
teractwn diagram can be rotated about any axis to Ytew the diagram from 
different directwns. See screen below. 

108.00 J.2&0 
lU 00 J :uo 

0.00 J.UO 
36.00 

*" 1011.00 

lU.OO 

Click on the Done button toe lose the Interaction inforrnation dialog box. 

Click on the ReDesign button. This will open the Element Overwrite As­
signments mforrnatwn dialog box showing the input design factors includ­
ing the K factors. Cm factors, etc. These factors can be edited for redesign­
ing. See screen on the next page. There is also an alternative way of editing 
the properties of a set of members which will be demonstrated in the next 
section "Changing Member Properties". 

• Click on the OK button to close the Element Overwrite Assignments dia­
log box. 

Click ~n the OK button toe lose the Concrete Design Information dialog 
box. 

Note: The number o(stations (nwnber ofsegments + !) used in the design is set by 
the user through Frame and Output Segment buttons ji-o m the Assign menu prior 
10 the anal.l'Sis phase The default number of segments is 4 for beams and :! for 
columns. 
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Till now we have analyzed and designed the concrete frame and reviewed sorne of 
the design mformation. SAP2000 allows you to interactively change the design 
code, member properues, remo ve or add new load combinations, etc. and re-run the 
analysis and design phases. As a demonstration m this tutorial. we will edit/change 
a member propeny for a set of frame members in the next section . 

. , ... , . 
- '.--

... 
·_.,:;,.·. ,. 

Changing Member Properties 
With the analysis and prehminary design successfully completed, we will now 
modify the section propenies of al! the columns ofthe bottom story befo re perform­
ing re-analysis. lnitially. in the analysis, the section type of each column member of 
the bottom story was taken to be 2. Referring to the screen that follows. we will 
change the section type of every column at the bottom stol)' to be l. Note that there 
are already four previously defined section types in the model wh1ch were named 
numerically as 1, 2, 3. and 4. In arder to make these changes. we will change the 
view in the nght wmdow to make al! the columns visible for selection. Notice that 
this window is currently showing the longitudinal reinforcmg from the prevtous de­
sign. 

l. Chck on the Show Undeformed Shape button from the floating toolbar. 

2. Click on the 2D View (xz) button from the main too! bar foran elevation view. 

3. Click on the Perspective Toggle button from the main toolbar. This will dis­
play a 3D view. Al! columns except the middle two will be visible. These two 
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columns w!ll be overlapping each other. To look at them better, we need toro­
tate the model about a venical axis. 

4. Click on the Set 3D View ... button on the View menu. Increase the plan Vicw 
Direction Anglc from 270 to 300 on the Set 3D Vicw popup window and then 
click on the OK button. 

Now. wilh all the columns vtsible. we can select and modify theirdesign section in­
formation. Remember, SAP2000 maintains two sets of information for sections. 
One is for analysis and the other ts for design. Changing section type here will af­
fect the design section only. To update the analysis section, you need to explicitly 
request an update ofthe analysis information from the current design state using the 

menu item Update Analysis Sections in the Design menu. 

5. To see the current setting ofDesign Sections do the following: 

Click on the Display Design Info ... menu itcm from the Design mcnu. Se­
lect the Design Input optton button. 

Select Design Scctions from the drop-down list. 

Click O K. 

This will display the design sections on the screen as shown below. Now we can se­
lec! and modify the sections for the columns at the first story. 

J.- - -- .. ;;;· 
l - - • 

--
• -:¡ 

.... J • ~ :3- '-· 

1 1· 1 
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6. To select all the columns at the bottom story do the fo!lowing: 

Click the Set lntersecting Line Select l\lode button on the Floatmg Tool­
bar. 

M ove the pointer to the left and middle ofthe leftmost comer column at the 
bottom story. 

Chck and hold down the left mouse button. 

While holding, move the pomter horizontally to the nght of the members 
intersecting all the columns at the bottom story. A ''rubber-band line·· will 
show the mtersecting line. 

Release the left mouse button to select all members that imersect the 
rubber-band line. 

Note: To se/ect allthe columns inthe bouom story. we have todo this op­
eration only once. Any member can also be se/ected just by c/icking the 
member itse!f 

The selection of all the bottom story columns ¡s now complete. The selected mcm­
bers appear as dashed lines. 

J .. 

_ , , _ -- ;· . -, 
--

! 1 

7. From the Design menu. choose ReDefine Element Design Data .... This will 
display the Element Overwrite Assignments dialog box to edit the sections 
and the design factors. The design factors are code dependen!. To change the 
sections from this dialog box: 
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Click the Change button on the Element Section area. This will dtsplay 
Select Sections dialog box. In this dialog box: 

~ Select 1 by clicking once. 

~ Chck on the OK button to accept the change. 

Click on the OK button on Element Overwrite Assignment dialog box. 

This will recompute the longitudinal reinforcement based on the new section prop­
erties and the previous analys1s results. 

8. To see the recomputed longitudinal reinforcement. do the following: 

• Click on the Display Design lnfo ·-- menu uem from the Design menu. Se­
lect the Design Output option button. 

Select Longitudinal Reinforcing from the drop-down list. 

Click O K. This will display the longitudinal reinforcement as recomputed 
based on the new section propenies and the previous analysis results. 

Click on the 3D View (3-d) button from the m a in toolbar to dtsplay the re­

sults in an orientation used earher. 

¡--

N atice that as a result of changing the section. the reinforcement areas in those par­
ticular columns are changed. To see the difference. compare this display with the 
one on page 13. 
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1t is importan! to realize that changes made to member section properties m the de­
sign phase are not automatically reflected in the analysts results. These changes are 
only local to the post-processing phase unless a re-run ofthe analysis. wtth updated 
elements. is requested by the user. In other words, overwriting the sectiOn proper­
ties only affects the stress val u es and not the factored element forces obtamed in thc 
analy,is precedmg such changes. The redistribuuon of member forces due to 

change ofstiffness (revisiOn ofsection propenies) is effected in a re-run ofanalysis. 

In the Design menu click on Update Analysis Sections. This will prompt a 
dialog box asking "Updating Analysis Section will unlock model! OK to up­
date?". Click OK. 

From the Analyze menu. choose Run. This will immediately start the analysis 
procedure. A top window ts opened in which various phases ofanalysis arl' pro­
gressively displayed. The results will obviously differ from those produced m 
the initial analysis beca use of the change of section properties we m a de in the 
design stage. Click OK to clase the top window. 

Click on the Start Design/Check of Structures from the Design menu. This 
will redesign the structure and display the new required longitudinal reinforce­
ment. 

You can see the difference after re-runnmg the destgn based on the lates! analysts 
results. 

. ! 
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Concluding Remarks 
We have come lo 1he end oflhis lutorial on the SAP2000 concrete design options. 
The iment has been 10 highlighl and demonslratc a few oflhe bas1c features in order 
to open up the palh for you lo explore and use lhe more advanced options. For more 
infonnatlon on various top1cs consull the on-line Help provided with the program. 

Concluding Remarks 21 
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Design Algorithms 

This chapter outlines various aspects ofthe concrete design and design-chcck pro­
cedures that are used by the SAP2000 program. The concrete design and check may 
be performed m SAP2000 according to one of the following design codes: 

The 1995 American Concrete Jnstuute Building Code Requirements for Struc­
tural Concrete, ACI318-95 (ACI 1995). 

The 1984 Canadian Standards Association Design of Concrete Structures for 
Buildings. CAN3-A23.3-l\1.84 (CSA 1984 ). 

The 1985 British Standards lnstitution Structural Use of Concrete. BS 811 O, 
(BSI 1 985). 

The 1992 European Cornmittee for Standardization. Design ofConcrete Struc­
tures. EUROCODE 2 (CEN 1992). 

Details of the algorithms associated with each of these codes as implememed in 
SAP2000 are described in the subsequent chapters. However, this chapter provides 
a background which is comrnon to all the design codes. 

In writing this manual it has been assumed that the user has an engineering back­
ground in the general area of structural reinforced concrete design and familiarity 
with at least one of the abo ve mentioned design codes. 

23 
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For referring to pertinent sections ofthe corresponding code. a uniquc prefix is as­
signed for each code. For example. a!l references to the ACI 318-95 codeare pre­
ceded by the word "ACI". Similarly, 

- References to the Canadtan code (CSA 1984 l carry the prefix of "CAl\"' 

- References to the Bntish code (8511985) carry the preftx of"BS" 

- References to the Eurocode (CEN 1992) carry the prefix of"EC2" 

Design load Combinations 
The design load combinations are used for deterrnining the various combinations of 
the load cases for which the structure needs to be designed/checked. The load com­
bination factors to be used vary with the selected design code. The load combina­
tton factors are applied to the forces and moments obtained from the associated load 
cases and are then summed to obtain the factored design forces and moments for the 
load combination. 

For multi-valued load combinations involving response spectrum, time htstory. 
moving loads and multi-valued combinations (of type enveloping. square-root of 
the sum ofthe squares or absolute) where any correspondence between interacting 
quantities is lost, the program automatically produces multiple sub combinations 
using maxima/minima pennutations of interacting quanttties. Separate combina­
tions with negative factors for response spectrum cases are not required because the 
program automatically takes the mínima to be the negative ofthe maxima forre­
sponse spectrum cases and the above described perrnutations generate the requtred 
sub combinations. 

When a design combination involves only a smgle multi-valued case of time his­
tory or moving load. further options are available. The program has an option to re­
quest that time htstory combinations produce sub combmations for each umc step 
ofthe time history. Also an option is available to request that moving load combina­
tions produce sub combinations using maxtma and minima of each design quantity 
but with corresponding values of interacting quanttties. 

For norrnalloading conditions involving static dead load. live load. wind load. and 
earthquake load, and/or dynamic response spectrum earthquake load the program 
has built-in default loading combinattons for each design code. These are based on 
the code recommendations and are documented for each code in the corresponding 
chapters. 

For other loading conditions involving moving load. time history, pattern live 
loads. separate consideration ofrooflive load, snow load. etc., the user rnust define 
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design ioading combinauons either in !ieu of or m adduion to the default design 
loading combinations. 

The default load combinatiOns assume all static load cases deciared as dead load to 
be additive. Similarly. all cases declared as live load are assumed additive. Ho"­
ever. each static load case declared as wind or earthquake. or response spectrum 
cases, is assumed to be non additive w1th each other and produces multiple lateral 
load combinations. Also wmd and static earthquake cases produce separate loading 
combinatwns with the sense (positive or negative'¡ reversed. lfthese conditions are 
not correct. the user must provide the appropriate design combmations. 

The default load combmations are included in design ifthe user requests them to be 
included or ifno other user defined combination 1s available for concrete design. lf 
any default combmation is mcluded in des¡gn, then all default combinations will 
automatically be updated by the program any time the des1gn code is changed or if 
static or response spectrum load cases are modified. 

Live load reduction factors can be applied to the member [orces ofthe live load case 
on an element-by-element basis to reduce the contribution of the live load to the 
factored loadmg. 

The u ser is cautioned that if moving loador time history results are not requested to 
be recovered m the analysis for sorne oral! the frame members, then the effects of 
these loads will be assumed to be zero in any combination that mcludes them. 

Design and Check Stations 
For each load combination. each element is des1gned or checked ata number oflo­
cations along the length ofthe element. The locatwns are based on equally spaced 
segments along the clear length ofthe element. The number ofsegments in an ele­
ment is requested by the u ser befo re the analysis is made. The u ser can refine the de­
sign a long the lcngth of an element by requesting more segments. 

ldentifying Beams and Columns 
Since SAP2000 is a general purpose analysis and design program. all beams and 
columns are represented as frame elements. But design of beams and columns re­
quires separate treatment. Therefore, identifying each frame element as either a 
beam ora column is necessary. This identification for a concrete element is done by 
specifying the frame section assigned to the element to be oftype beam or column. 
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Design of Beams 
In the design of concrete beams. m general. SAP2000 calculates and repons the re­
qUJred areas of steel for flexure and shear based upon the beam moments. shears. 
load combination factors. and other critena whtch are described m detail in the code 
specific chapters. The remforcement requirements are calculated at a user-defined 
number of stations along the beam span. 

A!l the beams are only designed for majar direction flexure and shear. Effects due 
to any axial forces, minar direction bending. and torsion that m ay exist in the beams 
must be investigated independently by the user. 

In d~signing the flexura! reinforcement for the major moment ata panicular section 
of a particular beam. the steps involvc the determina! ton ofthe maximum factored 
moments and the determination of the reiníorcing steel. The beam section is de­
signed for the maximum positive M: and maximum negative M: factored moment 
envelopes obtained from a!l of the load combinauons. Negative beam moments 
produce top steel. In such cases the bcam is always designed as a rectangular sec­
tion. Positive beam moments produce bottom steel. In such cases the beam may be 
designed as a rectangular-ora T-beam. For the design of flexura! remforcemcnt, 
the beam is first designed as a singly reinforced beam. If the beam section is not 
adequate, then the required compression remforcementts calculated. 

In designing the shear reinforcement for a particular beam for a particular set of 
loading combinations ata particular station dueto the bcam majar shear. the steps 
involve the detennination ofthe factored shear force. the determination ofthe shear 
force that can be resisted by concrete. and the determination of the reinforcement 
steel required to carry the balance. 

Special considerations for seismic dcsign are incorporated in SAP2000 for ACI 
31 S-95 and !984 Canadian codes. 

Design of Columns 
In the design ofthc columns. the program ca!culates the required longitudinal steel, 
or if the longitudinal steel is specified, the column stress condition is reponed in 
terms of a column capaCity ratio, which is a factor that gives an indication of the 
stress condition of the column with respcct to the capacity of the column. The de­
stgn procedure for the reinforced concrete columns ofthe structure involves the fol­
lowing steps: 
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Generare axial force-biaxial moment interaction surfaces for all ofthe different 
concrete section types of the m o del. A typical interaction surface rs shown in 
Figure III-1. 

Check the capacity of each column for the factored axial force and bending mo­
menrs obtamed from each loading combination at each end ofthe column. This 
step is al so used to calculare the required reinforcement (ifnone was specified) 
that will produce a capacity ratio of 1.0. 

Design the column shear reinforcement. 

Axial compress1on 

+Po 

Curve #1 Curve #NRCV 

M, 
M, 

-Po 

Axial tension 

Figure III-1 
A Typica/ Column lnteraction Surface 
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The generauon ofthe interaction surface is based on the assumed strain and stress 
distributions and sorne other simplifying assumptions. These stress and stram dis­
tributions and the assumptions vary from code to code. A typical assumed strain 
dJstribution 1s described m Figure III-2. 

Varymg Ltnear 
Stram Plane 

Remforcement 
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Varymg Linear 
Straln Plane _, 

1 
Remforcement __/ +(, 
Bars .___+_,('--'"_l·_.~',, 

Neutral Axrs 
Drrectron 

O E, 

_, 1 1 +< 

Strarn Plan·;~· JA ~ +oo~ Varymg Linear 8'' 
~ NeutraiAxrs 

Rernforcement Drrectron 
Bars 

Figure III-2 
ldea/i:ed Strain Distributionfor Genera/ion oflnteraction Swfaces 

He re maximum compression strain is limned toE,·. For most of the design codes, 
this assumed distnbution remains val id. However. the value o fE,- varies from code 
to code. For example. E,. = 0.003 for ACI and Canadian codes. and E, = 0.0035 for 
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Brirish and European codes. The details of the generat1on of interaction surfaces 
differ from code ro code. These are described m the chapters specific to the code. 

The capacity check is based on whether the design load points lie ins1de the interac­
tion volume in a force space. as shown in Figure 111-3. If thc point lies ins1dc the 
volume. the column capacity is adequare, and vice versa. 

The shear reinforcement design procedure for columns is very similar to that for 
beams. e'cepr that the effect ofthe axial force on the concrete shear capaciry needs 
to be considered. 

Axial Compression 

1----- Lmes Defining 
Failure Suriace 

Mx Mv 

Axial Tension 

Figure III-3 
Geometric Representa/ion ofCo/umn Capacity Ratio 
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P-.Ll Effects 
The SAP2000 design algorithms require that the analysis results include the P-t. ef­
fects. The P-t. effects are considered differently for "braced" or "nonsway·· and 
··unbraced" or "sway" columns or frames. For the braced columns. the effect ofP-t. 
is limited to "individual member stability''. For unbraced frames, "lateral drift ef­
fects" should be considered m addition to individual member stability effect. 

For the individual member stability effects. the moments are magnified with mo­
ment magnification factors as in the ACI and Canadian cedes or with additional 
moments as in the British and Eurocode codes. 

For lateral drift effects ofunbraced or sway frames. SAP2000 assumes that the am­
plification is already included in the results because P-6 effects are considered. 
The moments and forces obtained from P-6 analysis are further amplified for indi­
,·idua! column stability effect if reqlllred by the goveming code as in the ACI and 
Canadian codes. 

The users of SAP2000 should be aware that the default analysis option m SAP2000 
is tumed OFF for P-6 effect. The user can tum the P-6 analysis ON and set the 
maximum number ofiterations for the analysis. The default number of iteratJOn for 
P-6 analysis is l. For further reference. the user is referred to "SAP2000 Reference 
Manual" (CSI 1997b ). 

The user is also cautioned that SAP2000 currently cons1ders P-6 effects dueto axial 
loads in frame members only. Forces in other types of elements do not contri bu teto 
this effect. If significan! forces are present in other type of elements. for example, 
huge axialloads in shear walls modeled as shell elements. then the additional forces 
computed for P-6 will not be accurate. 

Element Unsupported lengths 
To account for co!umn slendemess effects the column unsupported lengths are re­
qlllred. The two unsupported lengths are/" and /00 • These are the lengths between 
support pomts ofthe element in the corresponding directions. The length 133 corre­
sponds to instability about the 3-3 axis (majar axis), and /02 corresponds to instabil­
ity about the 2-2 axis (minar axis). 

Normal! y. the unsupported element length is equal to the length ofthe elemcnt. i.e .. 
the distance between EN D-I and END-J ofthe element. See Figure III-4. The pro­
gram. however, allows users to assign severa! elements to be treated as a single 
member for design. This can be done differently for majar and minar bending. 
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Therefore. extraneous joints as shown in Figure Ill-5 that affect the unsupported 
Jength of an element are automatically taken into consideration. 

In determming the values for /
00

and /
33

ofthe elements. the program recogmzes 
various aspects ofthe structure that ha vean effect on these lengths. su eh as member 
connectivity. diaphragm constraints and support points. The program automati­
cally tocares the element support points and evaluates the corresponding unsup­
ported element length. 

Therefore. the unsupported Jength of a column may actually be evaluated as bcing 
greater than the corresponding element Jength. If a beam frames into only one di­
rection ofthe column, the bcam is assumed to give lateral support only in that dtrec­
tion. 

The user has options to specify the unsupported lengths of the elements on an 
element-by-elcment basis. 

Figure III-4 
Axes of Bending and Unsupponed Length 
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Special Considerations for Seismic Loads 
The ACI code (ACI I 995) 1mposes a special ductility requirement for frames in 
seismic regions by specifying frames either as Ordinary, lntermediate. or Special 
moment resisting frames. The Special moment resisting frame can provide the re­
quired ductility and energy dissipation in the nonlinear range of cyclic defonnation. 
The Canadian code (CSA 1984) also requires that the concrete frame must be de­
signed as either an Ordmary, Nominal, or Ductile moment resistmg frame. 

Unlike the ACI (ACI 1995) and the Canadian code (CSA 1984), the curren! impk­
mentation of the British code (BSI 1985) and the Eurocode (CEN !992) m 
SAP2000 does not account for any special requirements for seismic design. 

Figure III-5 
Unsupported Lengths and Interior Nades 

Choice of Input Units 
English as well as SI and MKS metric units can be used for input. But the cedes are 
based on a specific system ofunits. All equations and descriptions presented in the 
subsequent chapters correspond to that specif1c system of units unless otherwise 
noted. For example, the ACI code is published m inch-pound-second units. By de­
fault, all equations and descriptions presented in the chapter "Design for ACI 318-
95" correspond to inch-pound-second units. However, any system of units can be 
used to define and design the structure m SAP2000. 
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Design for ACI318-95 

This chapter describes in detail the various aspects ofthe concrete design procedure 
that is used by SAP2000 when the user selects the ACI 318-95 Design Code (ACI 
1995). Various notations used in this chapter are listed in Table IV -l. 

The design is based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
stgn of most building type structures. 

SAP2000 provides options to design or check Ordinary, Intermediare (moderate 
seismic risk areas). and Special (high seismtc risk areas) moment resisting frames 
as required for seismic design provisions. The details ofthe design criteria used for 
the different framing systems are described in the following sections. 

English as well as SI and MKS metric units can be used for input. But the code is 
based on Inch-Pound-Second unus. For simplicity, all equations and descriptions 
presented in this chapter correspond to Inch-Pound-Second units unless otherwise 
noted. 

Design load Combinations 
The design load combinations are the various combinations ofthe prescribed load 
cases for which the structure needs to be checked. For the ACI 318-95 code, if a 
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A,'l, 

A, 
A, 
A, 

.4:ntC<¡IIIrcd) 

A~ 

A, 

a 

a, 
b 

b, 
' 

e 

e, 
d 

d' 

d, 

E, 
E, 
1.: 
1, 
/.IJ 
/¡ 

I, 

/~ 

k 

L 

Area of concrete used to deterrnme shear stress. sq-m 

Gross area of concrete. sq-in 

Area of tension reinforcement. sq-in 

Area of compression remforcement. sq-in 

Area of steel required for tension reinforcement. sq-m 

Total area of column longitudinal reinforcement. sq-in 

Area of shear reinforcement. sq-in 

Depth of compression block. in 

Depth of compression block at balanced condnion. m 

Width ofmember, in 

Effecttve width of flange (T-Beam section). in 

Width of web (T -Beam section). m 

Coefficient. dependen! upon column curvature. used to calculate mo­
ment magnification factor 

Depth to neutral axis. in 

Depth to neutral axis at balanced conditions, in 

Distance from compression faceto tension remforcement. in 

Concrete e o ver to center of reinforcing. in 

Thickness of slab (T-Beam secuon). in 

Modulus of elasticity of concrete, psi 

Modulus of elasticity of reinforcement, assumed as 29,000,000 psi 

Specified compressive strength of concrete. pst 

Specified yield strength of flexura! reinforcement, psi 

Specified yield strength of shear reinforcement, psi 

Dimension of column. in 

Moment of inertia of gross concrete scction about centroidal axis. ne­
glecting reinforcement, m 4 

Moment of inertia of reinforcement about centro ida! axis of 
member cross section, in 4 

Effective length factor 

Clear unsupported length, in 

Table IV-1 
List ol Symbols U sed in the A CJ eode 
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M
1 

Smaller factored end moment in a column. lb-in 

M. Larger factored end moment in a column, lb-in 

M. Factored moment to be used m design. lb-in 

M~ Nonsway component of factored end moment. lb-in 

M, Sway component offactored end moment, lb-in 

M, Factored moment at sect10n. lb-in 

M~ Factored moment at section about X-axis. lb-in 

M Factored moment at section about Y -axis. lb-in ,, 
P, Axial load capacity at balanced strain conditions. lb 

P, Critica! buckling strength of column, lb 

P _ Maximum axial load strength allowed. lb 

P
0 

Axial load capacity at zero eccentricity, lb 

P, Factored axial load at section. lb 

r Radius of gyration of column section. in 

V,. Shear resisted by concrete, lb 

VE Shear force caused by eanhquake loads, lb 

Vi).~ Shear force from span loading. lb 

V, Factored shear force ata section, lb 

v, Shear force computed from probable moment capacity, lb 

a Reinforcing steel overstrength factor 

~ 1 Factor for obtaining depth of compression block in concrete 

~d Absolute value ofratio ofmaximum factored axral dead load to maxi­
mum factored axial total load 

E, 

Moment magnification factor for sway momcnts 

Moment magnification factor for nonsway moments 

Strain in concrete 

Strain m remforcing steel 

Strength reduction factor 

Table IV-1 
LIS/ ofSvmbols U sed inthe ACI code (continued) 
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srructure is subjected rodead load (DL) and live load (LL) only. the stress check 
may need only one load combmation. namely 1.4 DL + 1.7 LL (ACI 9.2.1 ). How­
ever, in addition ro the dead and hve loads. if the structure is subjecred to wmd 
(WL) and earthquake (EL) loads. and considering that wind and earthquake forces 
are reversible. then the following load combinatrons have ro be considered (ACI 
9.2). 

1.4 DL 
1.4 DL + 1.7 LL (ACI 9.2.1) 

0.9 DL:: 1.3 \VL 
0.75 ( 1.-l DL + 1.7 LL ± 1.7 \VL) (ACI 9.2.2) 

0.9 DL ± 1.3 * 1.1 EL 
0.75(1.4DL+ 1.7LL ±1.7*1.1EL) (ACI 9.2.3) 

These are al so the default design load combinations in SAP2000 whenever thc ACI 
318-95 code rs used. 

Live load reduction factors can be applied to the member forces of the live load 
condttion on an element-by-element basis to reduce the comribution ofthe Ir ve load 
to the facrored loading. 

Strength Reduction Factors 

The strength reduction factors, <p. are applied on the nominal strength ro obtain the 

design strength provided by a member. The <p factors for flexure. axial force. shcar, 

and rorsron are as follows: 

<p = 0.90 for flexure, 

<p = 0.90 for axial tcnsion, 

<p = 0.90 for axial tension and flexure. 

<p = O. 75 for axial compressron. and axial compression 
and flexure (spirally reinforced column), 

<p = 0.70 for axial compresswn. and axial compression 
and flexure (ried column). and 

<p = 0.85 for shear and rorsion. 
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Column Design 
The user may define the geometry ofthe reinforcing bar configuration of each con­
crete column section. Ifthe are a of remforcing is provided by the u ser. the program 
checks the column capacity. However, ifthe area ofremforcing ts not provided by 
the user. the program calcula tes the amount ofreinforcing required for the column. 
The design procedure for the reinforced concrete columns ofthe structure im·o!ves 
the following steps: 

Generate axial force-biaxialmoment interaction surfaces foral! ofthe different 
concrete section types of the model. A typical btaxial interaction surface ts 
shown in Figure lll-1. When the steel is undefined. the program generales the 
interaction surfaces for the range of allowable reinforcement- 1 to 8 percent 
for Ordinary and lntermediate moment resisting frames (ACI 1 O. 9. I) and 1 to 6 
percent for Special moment resisting frames (ACI 21.4.3.1). 

Calculate the capacity ratio or the required reinforcing area for the factored ax­
ial force and biaxial ( or uniaxial) bending moments obtained from each loadmg 
combination at each station ofthe column. The target capacity ratio is takcn as 
one when calculating the required reinforcing area. 

Design the column shear reinforcement. 

The following three subsections describe in detail the algorithms associated with 
the above-mentioned steps. 

Generation of Biaxiallnteraction Suñaces 

The column capacity interaction volume is numerically described by a series of dis­
crete pomts that are generated on the three-dimensional mteraction failure surface. 
In addinon to axial compression and btaxial bending. the formulation allows for ax­
tal tension and biaxtal bending considerations. A typical interaction diagram is 
shown m Figure lll-1. 

The coordinates ofthese points are determined by rotating aplane oflinear strain in 
three dimenswns on the section of the column. See Ftgure Ill-2. The linear strain 
diagram limits the maximum concrete strain. E •. , at the extremity of the section 
to 0.003 (ACI 10.2.3 ). 

The formulanon is based consistently upon the general principies of ultimate 
strength design (ACI !0.3). and allows for any doubly symmetric rectangular, 
square, or circular column section. 
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The stress in the steel is given by the product ofthe steel stram and the steel modu­
lus ofe!asticiry.E ,E,. and is limited to the yield stress ofthe steel.j, (ACI 10.2.4). 
The area associated with each reinforcing bar is assumed to be placed at the actual 
locatton ofthe center ofthe bar and the algorithm does not assume any funher sím­
plifications in the manner in whtch the are a of steel is dtstributed o ver the cross sec­
tion of the column. su eh as an equivalen! steel tu be or cylinder. See Figure IV -l . 
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(1) Concrete Sect1on (11) Strain D1agram (i1i) Stress D1agram 

Figure IV-1 
Ideafi=arion o.fStress and Strain Distribution in a Column Section 

The concrete compress10n stress block is assumed to be rectangular. with a stress 
value of0.85/,· (ACI 1 0.2. 7.1 ). See Figure IV-l. The interaction algorithm provides 
correction to account for the concrete area that is displaced by the reinforccment in 
the compression zone. 

The effects ofthe strength reduction factor, cp, are included in_ the generation ofthe 
interaction surfaces. The maximum compresstve axial load is limited to P"'~, where 

P _ ~0.85 cp[0.85 f; (A, ·A,) +/_..A,] spiral column, 

P_~0.80cp[0.85f;(A, -A,)+ f,A,] tiedcolumn, 

cp = O. 70 for tied columns, and 

cp ~ 0.75 for spirally reínforced columns. 
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The value of (jl u sed in the interaction diagram varíes from (jl '""' to 0.9 based on the 

axial load. For low values of axial load, (jl is increased linearly from (jl '"'" to 0.9 as 

the axial load decreases from the smaller of 0.1/.:A, or P, to zero, where P, 1s the 

axial force at the balanced condition. In cases involving axial tension. (jl is always 
0.9 (ACI 9.3.2.2). 

Check Column Capacity 

The column capacity is checked for each loading combination at each check station 
of each column. In checking a particular column for a particular loading combma· 
tion ata particular station. the following steps are in volved: 

Determine the factored moments and forces from the analysis load cases and 
the specified load combination factors to give P". M~ .and M"' .. 

Determine the moment magnification factors for the column moments. 

Apply the moment magníficat ion factors to the factored moments. Determine 
whether the point. defined by the resulting axial load and biaxial moment set. 
lies within the interaction volume. 

The factored moments and corrcsponding magnification factors depend on the 
identification ofthe individual columnas either "sway" or "non-sway". 

The following three sections describe in detail the algorithms associated with the 
above-mentioned steps. 

Determine F acto red Moments and F orces 

The factored loads for a particular load combination are obtained by applying the 
corresponding load factors to all the load cases, giving P", M~ .and M"'. The fac­
tored moments are further in crea sed for non-sway columns. if required. to obtain 
mínimum eccentricities of(O.ó + 0.0317) inches, where h is the dimension ofthe col· 
umn in the corresponding direction (ACI 1 0.12.3.2). 

Determine Moment Magnification F actors 

The moment magnification factors are calculated separately for sway ( overall sta· 
bility effect).li, and for non-sway (individual column stability effect),li,. Al so the 
moment magnification factors in the majar and minar directions are in general dif· 
ferent. 
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The program assumes that a P-t. analysis has been perfonned in SAP2000 and. 
therefore, moment magnification factors for moments causing sidesway are taken 
as unity (ACI 10.10.2). For the P-t. analysis the load should correspond toa load 

combination of 0.75 ( 1 .4 dead load+ 1.7 Ji ve load) 1 <p. where <¡> is the understrength 
factor for stability which is taken as O. 75 (ACI 1 O. 12.3 ). See al so White and Hajjar 
(1991). 

The moment obtained from analysis is separated into two components: the sway 
(M,) and the non-sway (M,,) components. The non-sway components which are 
identified as "ns" subscripts are predominantly caused by gravity load. The sway 
components are identified by the "s" subscripts. The sway moments are predoml­
nantly caused by lateral Joads, and are related to the cause of side sway. 

For individual columns or column-members in a !loor. the magnified moments 
about two axes at any station of a column can be obtained as 

M= M m +o,M,. (ACI lO. 13.3) 

The factor li, is the moment magnification factor for moments causmg side.sway. 
The moment magnification factors for sway moments,li ,, is taken as 1 beca use the 
componen! moments M, and M m are obtained from a '·second order elastic (P-t.) 
analysis" (ACI R 10.13 ). 

The computed moments are funher amplified for mdividual column stability effect 
(AC! 1 0.13.5) by the nonsway moment magnification factor.o m' as follows: 

Af, = li ~ M, . where (ACI 10.12.3) 

M,. is the factored moment to be used in design, and 

M, is the 1arger factored and amplified end moment. 

The non-sway moment magnif1cation factor, li "'' associated with the majar or mi­
nar direction of the column is given by (ACI 10.12.3) 

15 ~ = __ e-'.:':-- 2 J. O. where 
1- P, 

0.75 P, 

rr' El 
p =--

,. (kL)' ' 

k is conservat1vely taken as 1, however SAP2000 allows the user to ovemde 
this value. and 
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El is assoctated with a panicular column direction given by the larger of: 

El= 

El= 

O.~E l, +E,!,. 

1 + ~d 

~ = maximum factored axial dead load and 
d maximum factored axial total load · 

M e = 0.6 +0.4-" ~0.4. (ACIIO.l2.3.1) 
m M 

b 

M" and M, are the moments at the ends ofthe column, and M, is numerically 
larger than M". M"/ M, is positive for single curvature bending and ncgattve 
fordouble curvature bending. The above expression o fe mis val id ifthere is no 
transverse load applied between the suppons. Jf transverse load is prescnt on 
the span. or the length is overwritten. or for any other case. e m =l. e m can be 
overwritten by the user on an element by element basis. 

The magnification factor. om, must be a positive number and greater than one. 
Therefore P" must be less than O. 75P, .. If P., is found to be greater than or equal to 
O. 75P,, a failure condnion is declared. 

The above calculations use the unsupponed length ofthe column. The two unsup­
poned lengths are /00 and /33 corresponding to instability in the minar and majar di­
rections of the element, respective! y. See Figure IJI-4. These are the lengths be­
tween the support pomts of the element in the corresponding directions. 

Ifthe program assumptions are not satisfactory for a particular member, the user 
can explicitly specify ,·alues ofo, ando m. 

Determine Capacity Ratio 

As a measure of the stress condition of the column, a capacity ratio is calculated. 
The capacity ratio is basically a factor that gtves an indication ofthe stress condi­
tion of the column with respect to the capacity of the column. 

Befare entering the interaction diagram to check the column capacity, the moment 
magnification factors are applied to the factored loads to obtain P". M~, and M.,. 
The point (P". M~. M,.) ts then placed in the interaction space shown as point L in 
Figure Ill-3. Ifthe poiÍJt lies withm the interaction volume, the column capacity is 
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adequate: however. ifthe point lies outside the interaction volume. the column is 
overstressed. 

This capacity ratio is achieved by plotting the point L and determining the location 
of pomt C. The point C is defined as the point where the fine OL (if extended out­
wards) will intersect the failure surface. Thts pomt is determined by three­
dimcnsionallincar interpolauon between the points that define the failure surface. 

See Figure III-3. The capacity ratio, CR. is given bv the ratio OL. - . oc 

• lfOL =OC (orCR= 1) the point lies on the interaction surface and the column is 
stressed to capacity. 

lfOL <OC (or CR<I) the point lies within the interaction volume and the col­
umn capacity is adequate. 

lfOL >OC ( or CR> l) the point lies outside the interaction volume and the col­
umn is overstressed. 

The maximum ofall the values ofCR calculated from each load combinatwn is re­
ported for each check station of the column along with the controlling 
P", M~ ,and M"'. set and associated load combination number. 

lf the reinforcing area is not defined. SAP2000 computes the reinforcement that 
will give an interaction ratio of unity. 

Design Column Shear Reinforcement 

The shear reinforcement is designed for each loading combination in the majar and 
minar directions ofthe column. In designing the shear reinforcing for a particular 
column for a particular loading combination due to shear forces in a particular di­
rection, the fol!owing steps are in volved: 

Determine the factored forces acting on the section. P~ and V". Note that P" is 
needed for the calculation of V,. 

Determine the shear force, V,, that can be resisted by concrete alone. 

Calculare the reinforcement steel required to carry the balance. 

For special moment resisting frames (ductile frames). the shear design of the col­
umns is based upon the probable moment capacities ofthe members. Effects ofthe 
axial forces on the column moment capacities are included in the formulation. 

The fol!owing three sections describe in detail the algorithms associated with the 
above-mentioned steps. 
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Determine Section F orces 

In the design of the column shear reinforcement of an Ordinary moment re­

sisting concrete frame. the forces for a panicular load combination. namclv. 
!he column axial force, P,. and the column shear force. V,. m a panicular direc­
tion are obtained by factoring the SAP2000 analysts load cases with the corre­
sponding load combination factors. 

In the shear design of Spccial moment resisting frames (seismic design) thc 
followmg are checked in addition to the requirement for the ordinary moment 
resisting frames. In the design ofSpecial moment resisting concrete frames. thc 
design shear force in. a column, V

11
• in a panicular direction is also calculatcd 

from the probable moment capacities of the column assocwted with the fac­
tored axial force actmg on the column. 

For each load combination. the factored axtalload. P,. is calculated. Then. the 
positive and negative momcnt capacities, M: and M:. ofthe column in a par­
ticular direction under the influence ofthe axial force P, ts calculated using the 
uniaxial interaction diagram in the corresponding direction. The design shear 
force, 1 ·,. is then given by (ACI 21.4.5.1) 

1' =V + 1' 
~< p D•L (ACI 21.4.5.1) 

where. 1·, is the shear force obtained by applying the calculated probable ulti­
mare moment capacitles at thc two ends of the column acting in two opposite 
directions. Thereforc. VP is the maximum of VI', and VI',, where 

V=M;+M; 
~ -'---"- , and 

V = 1', 

L 

L 

Af' 7 M; 1 
· , where 

L 

Positivc and negative moment capaciues at end l of 
the column using a steel yield stress val u e of af, 
and no <p factors, 

Posittve and negative moment capaciues at end J of 
the column using a steel yield stress value of af, 
and no <p factors. and 

Clear span of column. 
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For Special moment resisting frames a is taken as 1.25 (ACI R21.3.4.1 ). r·1,.. 

is the contribution of shear force from the in-span distributiOn of gravity Joads. 
For most ofthe columns, it ts zero. 

For Intermedia te moment resisting frames. the design shear force is taken to 

be the mínimum of that based on the nominal moment capacity and factored 
shear force The procedure for calculating nommal moment capac1ty is the 
same as that for computing the probable moment capacity for spectal moment 
resisting frames, except thata is taken equal to 1 rather than 1.25. The factored 
shear forces are based on the specified load factors except the eanhquake load 
factors are doubled (ACI 21.8.3). 

Determine Concrete Shear Capacity 

Given the design force set P, and V,. the shear force carried by the concrete. f/. is 
calculated as follows: 

If the column is subjected to axial compression. i.e. P, is posnive. 

r· =2/f.(J+ P, )A. 
' V ' 2000.4, " 

(ACI 11.3.1.2) 

where, 

.Ji: S 100 psi. and (ACI 11.1.2) 

r·. S 3.5 'f: ( 1 +~)A. . v 1 ' 500.4 '' 
g 

(ACI 11.3.2.2) 

p ' 
The terrn -" must ha ve psi units. A" is the effective shear area which is shown 

A, 
shaded in Ftgure IV-2. 

Ifthe column is subjected to axial tension. P, is negative, 

V.=2lf(I+~)A.~O 
' V ' 500A n 

g 

(ACI 11.3.2.3) 

For Special moment resisting concrete frame design, V, is set to zero if the 

factored axial compressive force. P,, including the eanhquake effect is small 
(P, < ¡; A,/20) and ifthe shear force contribution from eanhquake, VE, is 
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more than half ofthe total factored maximum shear force o ver the length ofthe 
member J ·, (J ·E ~ 0.5 J',) (ACI 21.4.5.2). 
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Figure IV-2 
Shear Stress Area, A~. 

Determine Required Shear Reinforcement 

Given V,, and V,. the required shear reinforcement in the form of stirrups or ti e 
within a spacing. s, is g¡ven by 
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(V.Iq> -V, )s 

!,, d 
(ACI I 1.5.6.2) A, 

(V.Iq>-V,),; s.JJ:A~ (ACI 11.5.6.8) 

Otherwise redtmensioning ofthe concrete section is required. Here q>. the strcngth 
reduction factor. is 0.85 (ACI 9.3.2.3). The maxtmum ofall the calculatedA, val­
ues obtained from each load combination are reponed for the majar and minar di­
rections of the column along with the controlling shear force and associated load 
combination label. 

The column shear remforcement requirements reponed by the program are based 
purely upon shear strength consideration. Any minimum stirrup requircmcnts to 

satisfy spacing considerations or transverse reinforcement volumetric constdera­
tions must be investigated independently ofthe program by the user. 

Beam Design 
In the design of concrete beams. SAP2000 calculates and repons the required are as 
of steel for flexure and shear based u pon the beam moments, shears, load combma­
tion factors. and other criteria described below. The remforcement requiremcnts 
are calculated at a user defined number of check/design stations along the bcam 
span. 

AJI the beams are only designed for majar direction flexure and shear. Effects due 
to any axial forces. minar direction bending. and torsion that m ay extst in the bcams 
must be investigated mdependently by the user. 

The beam design procedurc mvolves the following stcps: 

Design bcam flexura! reinforcement 

Design beam shear remforcement 

Design Beam Flexura! Reinforcement 

The beam top and bottom flexura! steel is designed at check/design stations along 
thc beam span. In destgnmg the flexura! reinforcement for the majar moment for a 
panicular beam for a particular section, the following steps are involved: 

Determine the maximum factored momcnts 

Determine the reinforcing steel 
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Determine F acto red Moments 

In the design of flexura! remforcement of Special. Intermediare. or Ordinary mo­
ment reststing concrete frame beams. the factored moments for each load combina­
ti en at a panicular beam section are obtained by factoring the corresponding mo­
ments for different load cases with the corresponding load factors. 

The beam section ts then designed for the maximum posittve M,~ and maximum 
negatJve M; factored moments obtained from all ofthe load combinations. 

Negative beam moments produce top steel. In such cases the beam is always de­
signed as a rectangular section. Positive beam moments produce bottom steel. In 
such cases the beam may be designed as a Rectangular-ora T-beam. 

Determine Required Flexura! Reinforcement 

In the flexura! reinforcement design process. the program calculares both thc ten­
sien and compressJOn remforcement. Compression remforcement is added when 
the applied design moment exceeds the maximum moment capacity of a singly re­
inforced section. The uscr has the option of avoiding the compression reinforce­
ment by increasing the effective depth. the width, or the grade of concrete. 

The design procedure is based on thc simplifled rectangular stress block as shown 
in Figure IV-3 (ACI 10.2). Furthermore itts assumed that the compression carried 
by concrete is less than O. 75 times that whtch can be carried at the balanced condi­
tion (ACI I0.3.3). When the applied moment exceeds the momem capacity at this 
designed balanced condition, the arca of compression reinforcement is calculated 
on the assumption that the addttional moment will be camed by compression and 
additionaltension reinforcemem. 

The design procedure used by SAP2000. for both rectangular and flanged sections 
(L- and T-beams) is summarized below. It is assumed thatthe design ultimare axial 
force do es not exceed 0.1/,:A, (ACI 1 0.3.3 ), hence allthe beams are designed for 
maJar direction flexure and shear only. 

Design for Rectangular Beam 

In designing for a factored negative or positive moment, M", (i.e. designing top or 
bottom steel) the depth ofthe compression block is given by a (see Figure IV-3), 
where, 

a= d-
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where. the value of <p is 0.90 (ACJ 9.3.2.1) in the above and the following equa­
tions. Al so P, ande, are calculated as follows: 

p = o.85- o.o5( 1.: -4000 
)· 1 
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87000 
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If a ,; 0.75P1 e,, the area oftensilc steel reinforcement is then given by 

This steel is to be placed at the bottom if lvf" is posit1ve. or at the top if AI" is 
negative. 

If a > O. 75 p, e, . compression reinforcement is required (ACI 1 0.3.3) and is 
calculated as follows: 
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- The depth of compress10n block is given by 

a, =0.75~ 1 e,. (ACI 10.3.3) 

- The compressive force developed in concrete aione is given by 

e =0.85/)a,. and (ACI 10.2.7.1) 

the moment resisted by concrete compression and tensile steel is 

- Therefore the moment res1sted by compression steel and !ensile steel is 

Mus =A1u -Mue. 

- So the required compression steel is given by 

. M 
A = "' where 

' ¡;(d-d'~, 

. r c-d'l 
/, =0.003 E, l-c-J' (ACI 10.14) 

- The required tensile steel for balancing the compression in concrete is 

A,, M,, d ---''--- , an 

the tensde steel for balancing the compression in steel is given by 

A,= M~ 
'· f (d- d' y )<jl 

- Therefore, the total tensile reinforcement. A, =A,, +A,2 , and total com­
pression remforcement is A;. A, is to be placed at bottom andA; IS to be 
placed at top if M" is positive, and vice versa if M u is negative. 

De>ign for T-Beam 

In designing for a factored negative moment, M u, (i.e. designing top steel), the cal­
culation ofthe steel area is exactly the same as above, i.e., no T-Beam data is to be 
used. See F1gure IV-4. If M, >0. the depth ofthe compression block is given by 
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a=d- d'- 2 M, 
0.85f, <jl b¡ 

The depth of compression block under design balanced condition is given by 

lf a$ d,. the sub sequen! calculations for A, are exactly the same as previously 
defined for the rectangular section design. However. in this case the width of 
the compression flange is taken as the width ofthe beam for analysis. Whcther 
compression reinforcement is required depends on whether a> a,. 

If a> d,, calculation for A, is done in two pans. The first pan IS for balancing 
the compressive force from the flange. e r' and the second part is for balancing 
the compressive force from the web, e.: as shown in Figure IV -4. e f IS given 
~ . 

e1 =0.85f.:(b1 -b. )d,. 

~----b,----- _d, 

(rJBEAM 
SECTION 

E = 0.003 
0.851~ 
~---

. o.s5:c 1 

----' 

·~. \//~ ~ 
' 1 

e ' ' '/ ' ' 
_,_ 1 

' l 

L 
--Es 
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1, 
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1 __ ... 
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Thercfore. A,, 
e 

= --' and the ponion of M that is resisted bv the Oan~e is f\ u . .._ 

given by 

Agoin. the value for <¡lis 0.90. Therefore, the balance ofthe moment. ,\/., to be 

carned by the web is given by 

M =M ·M. 
"" u 1!' 

The web is a rectangular section of dtmensions b, and d. for whtch the design 
depth ofthe compression block is recalculated as 

2M~ 

0.85/ 'l' b. 

If a 1 ,; a,. the area oftensile steel reinforcement is then given by 

This steel is to be placed at the bottom ofthe T-beam. 

If a 1 >a.-. compression remforcement is reqlllred (ACI !0.3.3) and is cal­
culated as follows: 

- The compressive force m web concrete alone is given by 

e =0.85(ba,. (ACI 1 0.2. 7. I) 

- Thereforc the moment resisted by concrete web and !ensile steel is 

M~ =e ( d - a; )'~' . and 

the moment resisted by compression steel and tensile steel is 

M~=M~ -M~ .. 

- Therefore. the compression steelts computed as 
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' Al A = u• where 
' ¡;(d -d''ff¡' 

· 1 c-d'l 
J, =0.003 E, L-c-J' (ACI 10.2.4) 

The tensile steel for balancmg compression in web concrete is 

A = M,.. and ,, . 
- a 

f,(d-; '/{¡ 

the tensile steel for balancing compression in steel 1s 

A = M~ 
,, f, ( d - d' 'f4l 

- The total tensile reinforcement. A, =A,
1 

+A,, +A,,. and total com­
pression reinforcement isA ;. A, is to be placed at bonom and .( is to be 
placed at top. 

Afinimum Ten si/e Reinforcemeut 

The minimum flexura! tensile steel provided in a rectangular sect!On in an Ordinary 
moment resisting frame is given by the minimum of the two follo\\ ing limits: 

A > {
3¡¡: b d s _ max -- " 
!, 

4 
A >-A s -

3 
slrequ¡red) 

200 } and -b.d or 
f., 

Special Consideration for Seismic Design 

(AC110.5.1) 

(ACI 1 0.5.3) 

For Special moment resistmg concrete frames (seismic design). the beam design 
satisfies the following addnional conditions (see also Table IY-2 for comprehen­
stve listing) : 

The minimum longitudinal reinforcement shall be provided at both at the top 
and bottom. Any of the top and bottom reinforcement shall not be less than 
A,.mm> (ACI 21.3.2.1). 
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200 
h d} or !, . 

(ACI I 0.5. I) 

(ACI 10.5.3) 

The beam flexura! steel is limited toa maximum given by 

A, ? 0.025 b,d. (ACI21.3.2.I) 

Al any end (support) ofthe beam. the beam posittve moment capacity (i.e. as­
sociated with the bottom steel) would not be less than l/2 ofthe beam negative 
moment capacity (i.e. associated with the top steel) atthat end (ACI21.3.2.2). 

Neither the negative monient capacity nor the positive moment capacity at any 
ofthe secttons within the beam would be less than l/4 ofthe maximum ofposi­
tive or negative moment capacities of any of the beam end (support) stations 
(ACI 21.3.2.2). 

For Intermediare moment resisting concrete frames (seismic design). the bcam de­
sign would satisfy the followmg conditions: 

At any support ofthe beam. the beam positive momcnt capacity would not be 
less than 113 ofthe beam negattve moment capacity atthat end (ACI 21.8.4.1 ). 

Neither the negative moment capacity nor the positive moment capacity at any 
ofthe secuons withm the beam would be less than l/5 ofthe maximum ofposi­
tive or negative moment capaciues of any of the beam end (support) stations 
(ACI 21.8.4.1.). 

Design Beam Shear Reinforcement 

The shear reinforccment ts designed for each load combination at a user defined 
number of stations a long the beam span. In designing the shear reinforcement for a 
particular beam for a particular loading combinar ion at a particular station due to 
the beam majar shear. the following steps are involved: 

Determine the factored shear force. V,. 

Determine the shear force, V,, that can be resisted by the concrete. 

Determine the remforcement steel required to carry the balance. 
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Type of Ordinary l\1oment Intermediare 7\1oment 

Check/ Resisting Frames Reshting Frames 
Design (non-Seismic) (Seismic) 

Column 
Check NLD1 Combmations !\LD1 Combmations 
(interaction) 

Column 
NLD 1 Combinauons !\"LD1 Combmatmns 

Design 
l%<p<8% 1% < p < 8% 

(lnteraction) 

Modified f'\LD1 Combinattons 
Column 

h'LDt Combinarions 
(earthquakc' Joads doubled) 

Shcars Column Capae~ty 
e¡> ~ 1.0 and a~ 1.0 

Beam 
Design NLD t Combinauons NLD1 Combinatwns 
Flexure 

M~sv ~ 
1 . 
~ MJ.ND 

Beam 1\lin. 
) 

1\loment 
No Requtrement 

Af:SP-t.V ~ ]_ max{Af~· ,Afw-} 
Override 

5 END 

Check M~-t.\ ~ ].max{Afw •. Mw-} 
5 END 

Modified NLDr Combma1ions 

Beam Design 
( eanhquake loads doubled) 

Shcar 
NLD1 Combmations Beam Capacny Shear (V,) 

wi<h a~ 1.0 and cp ~ 1.0 
plus VD•L 

t Number of specified loadmg 
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Special Moment 
Resisting Frames 

(Seismic) 

i\LD1 Combmauons 

NLD1 Combtnations 
a~ 1.0 

1%< p<6% 

NLD1 Combinat10ns and 
Column she::~r capacity 
e¡>~ 1.0 anda ~ 1.25 

NLDt Combinauons 
p5 0.025 

J/7. 200 
p2-:-.p2-

}. f. 

Af~.\D ~ 
1 . 2 M..ENV 

M:S,4.J,' ~ ¡max{AC ,MM- }.v.·n 

M:SPAN ~..!. ma.\{ Al" .Atw-} 4 ~ EMJ 

!\LDr Combinarions 
Beam Capacity Shear (V,) 
wnh a= 1.25 and <p = 1.0 
plus vn.t 
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Chapter IV Design for ACI 318-95 

For Special and lntennediate moment resisting frames (ductil e frames ). the shear 
design ofthe beams is based upon the probable and nominal moment capacities of 
the members. respectively. 

The following three seClions descnbe in detail the algorithms associated with the 
above-mentioned steps. 

Determine Shear Force and Moment 

In the design ofthe beam shear reinforcement of an Ordinary momcnt rcsist­
ing concrete frame, the shear forces and moments for a panicular load combi­
nation at a panicular beam section are obtained by factoring the associated 
shear forces and moments with the corresponding load combination factors. 

In the design of Special moment resisting concrete trames ( seismtc dcstgn). 
however. the shear force. V"' is calculated from the probable moment capacities 
of each end ofthe beam and the gravity shear forces. The procedure for calcu­
lating the design shear force in a beam from probable moment capacity is the 
same as that described for a column in section "Column Design"' on page 43. 
See al so Table IV -2 for details. 

The design shear force V, is then given by (ACI 21.4.5.1) 

(ACI 21.4.5.1) 

where, V, is the shear force obtained by applying the calculated probable ulti­
mate moment capacities at the two ends ofthe beams acting m two oppostte di­
rections. Therefore. V is the maximum ofV

1
• and J'P , where 

p 1 : 

M: -'-At: 
' ·' , and 

L 

, where 

M; Moment capacity at end ], with top steel 
in tension, using a steel yield stress value 

of af, and no <p factors. 

M; Moment capacny at end J, with bottom 
steel m tension. using a steel yield stress 

value of af,. and no <p factors, 

" 
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M; Moment capacity at end 1, with bottom 
steel in tension, using a steel yield stress 
value ofaf, and no <p factors, 

L 

Moment capacity at end J, with top steel 

in tension. using a steel yield stress value 
of al_,. and no <p factors. and 

Clear span ofbeam. 

For Special moment resisting frames a is taken as 1 .~5 (ACI R2 1 .3.4. 1 ). ~-'v.L 

is the conrribution of shear force from the load in-span distribution of gravity 
loads. 

For lntermediate moment resisting frames, the design shear force in beams 
is taken to be the maximum of that based on the nominal moment capacity and 
factored shear force. The procedure for calculating nominal moment capacny 
is the same as that for computing the probable moment capacity for Spccial mo­
ment resisting frames. except that a is taken equal to 1 rather than 1 .25. The 
factored shear forces are based on the specified load factors except the eanh­
quake load factors are doubled (ACI 21.8.3 ). The computation of the design 

shear force in a beam of an Intermedia te moment rcsisting framc. is al so the 
same as that for columns, which is described earher on page 44. See also Table 
IV -2 for details. 

Determine Concrete Shear Capacity 

The allowable concrete shear capacity is given by 

(ACI 1 1.3.1. 1) 

For Special moment resisting frame concrete design, V, is set to zero ifboth the fac­
tored axial compressive force including the eanhquake effect P. IS less than 
f ;A. 120 and the shear force comribution from eanhquake V, is more than half of 
the total maximum shear force o ver the length of the member V, (i.e. VE <: 0.5 V,) 
(ACI 21.3.4.2). 

Determine Required Shear Reinforcement 

Given V" and V,. the required shear reinforcement in area/unit length is calculated 
as 
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- (VJ<¡>- V,) S 
A,-

f .. d 
(ACI 11.5.6.2) 

The shear force reSISted by steel is limited by 

(ACl 11.5.6.8) 

where. q>. the strength reduction factor, ¡s 0.85 (ACI9.3.c.3). Thc mJximum ofall 
the calculatcd A, 'alues. obtained from each load combination. is reponed along 
with the controlling shear force and associated load combination number. 

The beam shear reinforcement requirements displayed by the program are based 
purely upon shear strength considerations. Any minimum stirrup requirements to 

satisfy spacing and volumetnc considerations must be invesugated mdependently 
of the program by the user. 
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Chapter V 

Design for CAN3-A23.3-M84 

This chapter describes in detail the various aspects ofthe concrete design procedure 

that is used by SAP2000 when the user se!ects the Canad1an code. CAN3-A23.3-
!\184 (CSA !984) Various notations used in this chapter are listcd in Table V-1. 

The design IS based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requiremcnts for thc de­
sign ofmost buildmg type structures. 

SAP2000 provides options to design or check Ordinal)·. Nominal (modera te seis­
m¡c risk areas). and Ductil e lhigh seismic risk arcas) moment resisting frames as re­
quired for seism1c design The details of the design cnreria used for the different 
framing systems are described in the following sections. 

English as well as SI and MKS metnc units can be used for input. But the code is 
based on Newton-Millimeter-Second units. For simplicity, all equations and de­
scriptions presented m th1s chapter correspond to Newton-l\1illimeter-Sccond 
units unless otherw¡se noted. 
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A, 
A, 
A, 

A~ 

A,. 

a 

e 

e, 
d 

d' 

d, 
E, 
E, 
¡; 
f, 

!, 
h 

I, 

k 

L 
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Area of concrete used to detennine shear stress. sq-mm 

Gross area of concrete. sq-mm 

Are a of tension reinforcement. sq-mm 

Area of compress10n reinforcement. sq-mm 

Are a of steel required for tension remforcement. sq-mm 

Total area of column longitudinal reinforcement. sq-mm 

Area of shear reinforcement. sq-mm 

Depth of compression block, mm 

Depth of compression block at balanced condition. mm 

Width ofmember, mm 

Effective width offlange (T-Beam section). mm 

W 1dth of web (T -Beam section), mm 

Coeffic1ent. dependen! upon column curvature. used to 
calculate moment magnification factor 

Depth to neutral axis, mm 

Depth to neutral axis at balanced condnions. mm 

Distance from compression face to tension reinforcement. mm 

Concrete cover to center of reinforcing. mm 

Thickness of slab (T-Beam sect1on). mm 

Modulus of elasticity of concrete. MPa 

Modulus of elasticity of reinforcement. assumed as 200.000 MPa 

Specified compressive strength of concrete. MPa 

Specified y¡eld strength of flexura! reinforcement, MPa 

Specified yield strength of shear remforcement, MPa 

Dimension of column, mm 

l\1oment of inertia of gross concrete section about centroidal axis, 
neglectmg reinforcement. mm4 

Moment of inertia of reinforcement about centroidal axis of 
member cross section, mm 4 

Effective length factor 

Clear unsupported length, mm 

Table V-1 
Lis¡ of Symbols Used inlhe Canadian eode 
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Chapter V Oesign for CAN3-A23.3-M84 

ll-/1 Smaller factored end moment in a column, N-mm 

M. Larger factored end moment in a column. N-mm 

M, Factored moment to be used in des1gn, N-mm 

M~ Nonsway component offactored end moment. N-mm 

M, Sway componen! of factored end moment. N-mm 

M 
11 

Factored moment at section, N-mm 

M~ Factored moment at sectton about X-axis. N-mm 

M,,, Factored moment at section about Y -axts. N-mm 

P, Axtalload capacity at balanced stram conditions. N 

Crit1cal buckhng strength of column, N 

Maximum ax1alload strength allowed, N 

Ax¡aJioad capacity at zero eccentricny, N 

Factored axial load at section. N 

V, Shear resisted by concrete. N 

V0 ,L Shear force from span loading, N 

V 
p 

v" 
V 

' 
a 

~1 
~d 

'P, 

'Pm 
l. 

Shear force computed from probable moment capacuy. N 

Factored shear force ata section. N 

Shear force ata section resisted by steel. N 

Remforcing steel overstrength factor 

Factor for obtaining depth of compression block in concrete 

Absolute val u e of the ratio of the maximum factored axial 
dead load moment to the maximum factored total load moment 

Moment magnification factor for nonsway moments 

Moment magnification factor for sway moments 

Strain in concrete 

Strain in reinforcing steel 

Strength reduction factor for concrete 

Strength reduction factor for steel 

Strength reduction factor for member 

Shear strength factor 

Table V-1 
List of Symho/s Used in the Canadian code (continuedJ 
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Design Load Combinations 
The design load combinations are the various combinations of the prescribed load 
cases for whtch the structure needs to be checked. For this code. if a structure ts sub­
jected to dead load (DL), hve load (LL), wind (\VL). and eanhquake (EL) loads. 
and considering that wind and eanhquake forces are reversible. then the following 
load combinations may ha veto be considered for design of concrete frames (CAN 
9.2): 

1.25 DL 
1.25 DL + !.50 LL 

1.25 DL ± 1.50 WL 
0.85 DL ± 1.50 WL 
1.25 DL + 0.7 (1.50 LL ± 1.50 WL) 

1.25 DL ± 1.50 EL 
0.85 DL ± 1.50 EL 
1.25 DL + 0.7 (1.50 LL ± 1.50 EL) 

(CAN 9.2) 

(CAN 9.2) 

(CAN 9.2) 

These are also the default design load combmations in SAP2000 whenever the Ca­
nadian Code is used. 

In generating the above default loading combinations. the imponance factor is 
taken as 1. The user should use other appropriate loading combinations if roof live 
load is separately treated. other types of loads are present, or pattern live loads are 
to be considered. 

Live load reduction factors can be applied to the member forces ofthe live load case 
on an element-by-element basis to reduce the contribution of the live load to the 
factored loading. 

Strength Reduction Factors 

The strength reduction factor, <p, is material dependent and is defined as 

<p, = 0.60 for concrete and 

<p, = 0.85 for steel. 

(CAN 9.3.2) 

(CAN 9.3.3) 

In sorne special cases; a member resistance factor. <p •• is used asan additional re­
duction factor in addition to <p ,. and <p, (CAN 9.3. 1). 
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Column Design 
The u ser m ay define the geometry ofthe reinforcing bar configuration of ea eh con· 
crete column section. Ifthe are a of reinforcmg is provided by the u ser. the program 
checks the column capacity. However. ifthe area ofreinforcing is not provided by 
the u ser. the program calculates the amount of reinforcing required for the column. 
The design procedurc for the reinforced concrete columns ofthe structure involves 
the following steps: 

Generate axial force-biax¡a] moment interaction surfaces for all ofthe different 
concrete section types of the model. A typical biaxial interaction surface is 
shown in Figure Jll-1. When the steel is undefined. the program generales the 

interaction surfaces for the range of allowable reinforcement- 1 to 8 percent 
for ordinary moment resisting frames (CAN 10.9.1 and CAN 10.9.2) and 1 to 6 
percent for ductilc moment res1sting frames (CAN 21.4.3.1 ). 

Calculate the capacity ratio or the required reinforcing area for the factored ax· 
ial force and biax1al ( or uniaxial) bcndmg moments obtamed from each loading 
combmation at each stat¡on ofthe column. The target capacity ratio is taken as 
one when calculating the required reinforcing area. 

Design the column shear reinforcement. 

The following three subsections describe m detail the algorithms associated with 
the above-mcntioned steps. 

Generation of Biaxiallnteraction Surfaces 

The column capac1ty interact10n volume is numencally described by a series of dis­
crete pomts that are generated on the three-dimensional interaction failure surface. 
In addiuon to axial compression and biaxial bending. the formulation allows for ax· 
ial tension and biaxial bending considerations. A typical mteraction diagram is 
shown in Figure Ill-1. 

The coordinates ofthesc points are determined by rotating aplane ofhnear strain in 
three dimensions on the section of the column. See Figure III-2. The linear strain 
diagram limits the maximum concrete strain. E,. at the extremity of the section. 
to 0.003 (CAN 10.2.3). 

The formulation 1s based consistently upon the general principies of ulumate 
strength design (CAN 1 0.3), and allows for any doubly symmetric rectangular. 
square, or Circular column section. 
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The stress in the steel is given by the product ofthe steel strain and the steel modu­
lus of elasticttv, E E , and is limited to the vield stress of the steeL ( (CAN 

• S .¡- • • .' 

10.2.4). The area associated with each reinforcing bar is assumed to be placed at 
the actuallocation of the center of the bar and the algorithm do es not assume any 
further simplifications in the manner in which the area of steel is distributed o ver 
the cross secuon ofthe column (such asan eqUivalent steel tube or cylinder). See 
Figure V-1. 

· l ··r l 
l. • 

+1 
1- :J r· :_ -. :·-.J: 

1 T • • T 1 

1 1 

[i) CONCRETE 
SECTION 

Ec=0003 
1 .¿ 

'¡ T 
e 

1 
..L._ 

[u)STRAIN 
DIAGRAM 

Figure\' -1 

¡ 0.85 f'c ' 
:...-~ 
' . 

[ii1)STRESS 
DIAGRAM 

ldea/zzatwn oJStress and Srram Disrribwion in a Column Section 

The concrete compression stress block is assumed to be rectangular, with a stress 
value of0.85f; (CAN 1 0.2. 7) The interaction algorithm provides correction to ac­
count for the concrete area that is dtsplaced by the reinforcement in the compres­
sien zone. 

The effects ofthe strength reduction factor, <p, are included in the generation ofthe 
interaction surfaces. The maximum compressive axial load is limited to Pm~, where 
the maximum factored axial load resistance is given by 

P _ = 0.80 [0.85 <p J; (A, -A,) T<jl, J, A,] (tied column),(CAN 1 0.3.5.3) 

Pm~ = 0.85 [0.85<p, ¡; (A,-A,)+<pJ,A,](spiral column).(CAN 10.3.5.2) 
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Check Column Capacity 

The column capacity is checked for each loading combmation at each check sta· 
tions of each column. In checking a pamcular column for a panicular load in¡: com· 
binatwn ata panicular location. the following steps are involved: 

Detennine the factored moments and forces from the analysis load cases and 
the specified load combination factors to give P,. Af ~ .and M"' . 

Determine thc moment magnification factors for the column moments. 

Apply the moment magnificarían factors to the factored loads obtained in the 
first step. Detennine whether the point. defined by the resulting axial load and 
biaxial moment set. líes within the imeraction volume. 

The following three sectíons describe in detail the algorithms associated with the 
above-memioned steps. 

Determine Factored Moments and Forces 

The factored loads for a panicular load combinarían are obtained by applymg the 
corresponding load factors to all the load conditíons. givíng P,. M •a .and M ,

0 
. The 

factored momems are funher increased. ifrequired. to obtain mínimum ecccntrici­
ties of (15 + 0.03 /¡)mm. where h ís the dimension of the column in the correspond· 
ing direction (CAN 1 0.11.6.4). The computed moments are funher amplified by us­
ing "Moment Magnification Factors" to allow for "Lateral Drift Effect" and "1\lem· 
ber Stability Effect". 

Determine Moment Magnification F actors 

The moment magnificarían factors are apphed in two different stages. First the mo· 
ments are separated into their "sway" and '·non-sway" components. The non-sway 
components are amplified for lateral drift effect. Although this amplification may 
be avoided for "braced" frames accordmg to the code. SAP2000 treats aii frames 
unifonnly to amplify non-sway components of moments. Thcsc amplified mo­
ments are funher amplified for individual member stability effect. 

Lateral Drift Effect 

For aii frames. the moment magnification factor for lateral drift effect is appiied 
only to the "sway" moment in SAP2000. 

M=M~+o,M, (ACI 10.1 1.5.2) 
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The moment magnification factors m the majar and mmor directions can be differ­
ent. The moment magnification factors for moments causing sidesway. o~ ando~. 
can be taken as 1.0 ifa P-ó analysis is carried out (CAN 10.11.7). Thc programas­
sumes that the SAP2000 anal~·sis models P-ó effects, thereforc, o~ and o,, are 

taken as 1.0. 

lt is suggested that the P-ó analysis be done at the factored load leve! ( \Vhne and 
Hajjar 1991). The necessary factors for a P-ó analysis for the CAN3-A23.2-l\184 
code should be (1.25 DL + 0.7*1.50 LL)I<jl m· where <jl m is the strength reductJon 
factor for stability and is equal to 0.65. 

The user is reminded ofthe special analysis requirements. especially those related 
to the value of El used in analySIS (CAN 1 0.11.2.2). lfthe program assumptions are 
not satisfactoty for a panicular member. the u ser can explicitly specify val u es ofo ~ 

ando~ .. 

Member Stability Effects 

All compression members are designed using the factored axial load. P,. from the 
analysis and a magnified factored moment. M,. The magnified moment is com­
puted as, 

(CAN 1 0.11.6) 

where M. is the column maximum end moment obtained from elastic analysis af­
ter consid~ring minimum eccentricity and lateral drift effect. and M,. is the maxi­
mum moment occurring either at the end or at an interior point within the span of 
the coiumn. The moment magnification factor. c3 b, for momenrs not causing 
sidesway associated with the majar or minar direction ofthe column is given by 

<jl m = 0.65, 

rr' El 
P,. 

(kL)' 

~ 1.0, where (CAN 10.11.6.1) 

k is conservat1vely taken as l. however the user can override the value. 

El is associated with a panicular column direction given by the larger of: 
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El~ 
0.2 E e 1, +E, 1" 

1 + ~d 
or El~ 0.25 E_. Jg. and (CAN 10.11.6.2) 

Maximum factored dead load moment 
~d ~ ~--:---:----:--:-:---:---­

Maximum factored total load moment 

M e m ~ 0.6 + 0.4 -" ;o, 0.4. 
M, 

(CAN 10.01 

(CAN 1 0.11.6.3) 

M, and M, are the moments at the ends ofthe column. and M, 1s numeri­
cally larger than M,. M,/ M, 1S positive for smgle curvature bending and 
negative for double curvature bending. The above expression of e m IS 
valid if there is no transverse load applied between the suppons. lf trans­
verse load is present on the span. or the length is overwritten. or for any 
other case. e~ ~l. e m can be overwritten by the user on an element by ele­
ment basis. 

The magnification factor. 6,. must be a positive number and greater than one. 
Therefore P, must be less than q> mP,. If P, is found to be greater than or equal to 
q> m P ... a failure condition is declared. 

The above calculations use the unsupported length ofthe column. The two unsup­
ported lengths are 100 and 1, corresponding to instability in the minar and majar di­
rections of the element. respectively. See Figure III-4. These are the lengths be­
twecn the support points of the element in the corresponding directions. 

Determine Capacity Ratio 

As a measure of the stress condition of the column. a capacity ratio is calculated. 
The capacity ratio is basically a factor that gives an mdication of the stress condi­
tion of the column with respect to the capacity of the column. 

Befare entering the interaction diagram to check the column capacity. the momcnt 
magnif1cation factors are apphed to the factored loads to obtain P,. M~ ,and M,, .. 
The point (P,. M~, M~) is then placed m the interaction space shown as point L in 
Figure III-3. Ifthe point lies withm the mteraction volume. the column capacily is 
adequate; however, if the point lies outside the interaction volume, the column is 
overstressed. 

This capacity ratio is achieved by ploning the point L and determining the location 
of point C. The point C is defined as the pomt where the !in e OL (if extended out­
wards) will intersect the failure surface. This point is determined by three-
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dimensional linear interpolation between the poims that define the faiiure surface. 

See figure lll-3. The capacitv ratio. CR. ts eiven b}' the ratto OL . - . - oc 

lfOL =OC (or CR=l) thc point lies on the mteractJOn surface and thc coiumn is 
stressed to capacny. 

lfOL <OC (or CR<l) the pomt lies within the interaction volume and the col­
umn capacity is adequaJe. 

lfOL >OC ( or CR> 1) the pomt lies outside the interaction \'Olume and the col­
umn is overstressed. 

The maximum ofall the values ofCR calculated from each load combination is rc­
ported for each check station of the coiumn along with the controlling 
P,, M~ ,and M"' set and associated load combination number. 

lf the reinforcing area is not defined. SAP2000 computes the reinforcement that 
will give an interaction ratio of unity. 

Design Column Shear Reinforcement 

The shear reinforcement is designed for each loadmg combination in the ma¡or and 
minar directions ofthe column. In designing the shear reinforcmg for a particular 
column for a particular loading combination due to shear forces in a panicular di­
rection. the following steps are involved: 

Determine the factored forces actmg on the section. P, and V,. Note that P, ts 
needed for the calculatton of V •.. 

Determine the shear force, Ve, that can be resisted by concrete alone. 

Calculate the reinforcement steel required to carry the balance. 

The following three sections describe in dctail the algorithms associated with the 
above-mentioned steps. 

Determine Section Forces 

In the design of the column shear remforcement of an Ordinary moment re­
sisting concrete frame, the forces for a particular load combinatian. namely, 
the column axial force. P,, and the column shear force. V,. in a panicular direc­
tion are obtained by factoring the SAP2000 analysts load cases with thc corrc­
sponding load combination factors. 
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In the shear design of Ductile moment resisting trames 1 seismic design) the 
following are checked in addition to the requirement for the ordinary moment 
resisting frames. In the design ofDuctile moment resisting concrete frames. the 
design shear force. V"' in a panicular direction is al so calculated from the prob· 
able moment capacities ofthe column associated with the factored a:-.ial force 
acting on the column. 

For each load combination. the factored axial load. P", is calculated. Then. the 
positive and negative moment capacities, M: and A1,~. ofthe column m a par­
ticular direction under the influence ofthe axial force P" ts calculated using the 
uniaxial interaction diagram in the corresponding direction. Thc design shear 
force, V", is then given by 

V +V p D~L 
(CAN 2!.7.2.1) 

where. v, is the shear force obtained by applying the calculated probable ulti· 
mate mamen• capacities at the two ends of the column acting in two opposite 
directions. Therefore, V, is the maxtmum of Vll and v,.,. where 

V 
P, 

V = 
P, 

L 

M; +M; 
-'---"-' . and 

L 

Ar ~M. 
1 

.J where L , 

Positive and negative moment capacities at end l of 
the column using a steel yield stress value ofaf.,. 
and no cp factors, 

Posmve and negative moment capacities at end J of 
thc column using a steel yield stress value ofaf_.. 
and no cp factors. and 

Clear span of column. 

For Ductilemoment resisting frames a is taken as 1.25 (CAN 21.1 ). V o.L is 

the contribution of shear force from the in-span distribution of gravity loads. 
For most ofthe columns, u is zero. 

For Nominal momcnt resisting trames (seismic), the design shear force is 
taken to be the maximum of that based on the nominal moment capacity and 
factored shear force. The procedure for calculating nominal moment capacity 
ts the same as that for computing the probable moment capacity for Ductil e m o-
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ment resisting frames. except that a is taken egua! to 1 rather than 1.25 (CAN 
21.1 ). The factored shear forces are based on the specified load factors. 

Determine Concrete Shear Capacity 

Given the design force set r, and V,. the shear force carried by the concrete. 1 ·,. is 
calculated as follows: 

Ifthe column is subjected to flexure and shear only. i.e. P, is zero, 

(CAN 11.3.4.1) 

where A is taken as 1 for normal weight concrete For other types of sections 
b, d is replaced by A

0
• the effectivc shear area whtch is shown in Ftgure V -2 

Ifthe column is subjected to axial tension. i.e. P, is negative. 

(CAN 11.3.4.2) 

Ifthe column is subjected to axial compression. i.e. P, is positive. 

V.= 0.2'fl.AJ?( 1 +3~Jb. d. • • ' • A . • 
'J' 

(CAN 11.3.4.3) 

F or Ductil e moment resisting frames, the shcar strength at any beam or column 
section is taken as zero if axial force is tensile or compress10n is vcry small. 
This is given as 

V,.= O if P,:;; O.IOf; A,. (CAN 21.7.3.1 and CAN 21.3.1) 

Determine Required Shear Reinforcement 

Given V, and V,. the required shear reinforcement for a spacing s is gtven by 

(V -V )< A = u e' 

, 't'J,, d . 
(CAN 11.3.6.1) 

The shear resistance dueto the remforcement, V,, is limited by 

(CAN 11.3.6.6) 

70 Column Design 

" 



Chapter V Design for CAN3-A23.3-M84 

The maximum of all the calculated A, values obtamed from ea eh load combination 
are reponed for the major and minor directions of the column a long with the con­
trolling shear force and associated load combmatwn !abe l. 
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The column shear reinforcemerit requirements reponed by the program are based 
purely upon shear strength consideration. Any mmimum stirrup requirements to 
satisfy spacing and/or volumetric requirements must be investigated independently 
of the program by the u ser. 
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Beam Design 
In the design of concrete beams. SAP2000 calcula tes and reporrs the required are as 
of steel for flexure and shear based u pon the beam moments. and shears. load com­
bination factors and other criteria described below. The remforcement require­
ments are calculated at a user defined number of check stations along the beam 
span. 

All the beams are only designed for major dtrection flexure and shear. Effects due 
to any axial forces. minor dtrection bending. and torswn that m ay extst in the beams 
must be investtgated independently by the user. 

The beam design procedure involves the following steps: 

Des1gn beam flexura! remforcement 

Design beam shear reinforcement 

Design Beam Flexura! Reinforcement 

The beam top and bottom flexura! steel 1s designed at a user defined number of 
des1gn statíons along the beam span. In designing the flexura! reinforccment for the 
maJor momento fa panicular beam for a panicular scction. the following steps are 
in volved: 

Determine the maximum factored moments 

Determine the reinforcing steel 

Determine Factored Moments 

In the design offlexural reinforcement of ductile, nominal. or ordmary momcnt rc­
sisting concrete framc beams. the factored momcnts for each load combination ata 
panicular beam station are obtained by factoring the corresponding moments for 
different load cases with the corresponding load factors. 

The beam section is then designed for the maximum positive M: and maximum 
negat¡ve M; factored momems obtained from all ofthe load combinations 

Negative beam moments produce top steel. In such cases the beam is always de­
signed as a rectangular section. Positive beam moments produce bottom steel. In 
such cases the beam may be designed as a Rectangular- or T-beam. 
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Determine Required Flexura! Reinforcement 

l n the flexura! reinforcement destgn process. the program calcula tes both the tcn­
sion and compression reinforcement. Compression reinforcement is added when 
the apphed design moment exceeds the maximum moment capacity of a smgly re­
inforced section. The user has the option of avoiding the compression reinforce­
ment by increasmg the,effective depth. the width. or the grade of concrete. 

The design procedure is based on the simplified rectangular stress block as shown 
in Figure V-3 (CAN 10.2). Funhemwre it IS assumed that the compression carried 
by concrete is less than that which can be carried at the balanced condition (CAN 
10.3.2). When the applied moment exceeds the moment capacity at the balanced 
condition. the area of compresswn reinforcement is calculated on the assumption 
that the additional moment will be carried by compression and additional tenston 
reinforcement. 

The design procedure used by SAP2000. for both rectangular and flanged sections 
(L- and T-beams) is summarized below. lt is assumed that the design ultimate axial 
force does not exceed 0.15/.~A, (CAN !0.3.3). hence al! the beams are designed 
for major d1rection flexure and shear only. 

Design for Fle.xure nf a Rectangular Beam 

In designing for a factored negative or positive moment. M,, (i.e. des1gning top or 
bottom steel) the dcpth ofthe compression block is given by a. where, 

a = d- /d: - _2..:..1'\.,..I ",;..1 -
v o.85 1.: '1'. b • 

where the va!ue of<p ,· is 0.60 (CAN 9.3.2) in the above and following equations. 
See Figure V-3. Also ~ 1 ande, are calculated as follows: 

", = o 8'\. 0·08 (.( ' 30). 0.6)' < " < o 85 d .., _ _ ..,, _ . , an 
10 

600 
ct- =----d. 

600 + f, 

(CAN 10.2.7) 

(CAN 1 0.3.3) 

lf a ,;; ~:e,. the are a oftensile steel reinforcement is then given by 
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This steel is to be placed at the bottom if M, is positive. or at the top if M, is 
negative. 

lf a>~: e,. compression reinforcement is required (CAN 10.3.2) and is calcu­
lated as follows: 

- The balanced depth of compression block is given by 

(CAN l 0.3.2) 

- The compressive force developed in concrete alone is given bv 

(CAN 10.2.7) 

the moment resisted by concrete and bottom steel is 

- The moment resisted by compression steel and tensile steel is 

M~ =M, -M •... 
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E= 0.003 
! 

' 0.851~ 1 
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- So the required compress10n steel IS given by 

' ¡\/ 
4 = "' . where 
. ' (\d-d')<j!, 

· , lc-d'l 
f, = O.OOo E, L-c-J (ACI 1 0.2.4) 

- Thc required tensile steel for the balancing thc compression in concrete is 

4 M,, d 
• , 1 = --~~--.an 

. d a~ /,( --2)<j!, 

the tensile steel for balancing the compression m steel is 

A~::: = -,--,A_f-"""'' __ 
f,(d-d')<j!, 

- Therefore. the total tensile reinforcement. A, =A,, +A,,. and total com­
pression reinforccmcnt is A;. A, is to be placed at bottom and .-( IS to be 
placed at top 1f M" is positive. and vice versa. 

Design for F/exure of a T-Beam 

In designing for a factored negative momcnt. M". ( i.e. designing top steel ). the cal­
culation ofthe steel arca is exactly the same as above. Le .. no T-Beam data is to be 
used. If M, >0. the depth ofthe compression block is given by (see Figure V-4). 

/ , 2M, 
a= d- \/d· - o.ss;;<f!, b1 

The depth of compression block under balanced condition is given by 

a, =0,c,. 

If a~ d,. the subsequent calculations for A, are exactly the same as previously 
done for the rectangular scction design. However. in this case the width ofthe 
compression tlangc is taken as the width of the beam for analysis. Whether 
compress10n reinforcement is reqUired depends on whether a> a,. 

If a> d,. calcu!Jrion for A, is done in two pans. The first pan is for balancing 
the compressive force from the tlange. e 1' and the second pan is for balancing 
the compressive force from the web, e .. As shown in Figure V -4, 
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Therefore. A . 
" 

C,q>' and the portian of M, that is res1sted by the tlange is 
[, <P' 

given by 

Therefore. the balance ofthe moment. M, to be carned by the web is given by 

The web is a rectangular section of d1menswns b.,. and d, for which the dcpth of 
the compression block is recalculated as 

a, = d- Id' - 2M •· . 
' 0.85f.. <P' b. 

----b,----. ..1 - d, 

' ' i 
1 

d 

L1_]t-l __ _._ 
A,_. 1 
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If a1 <;a,. the area oftensile steel reinforcement is then giYen by 

This stee!JS to be placed at the bottom of the T-beam. 

If a 1 >a,. compresswn reinforcement is reqUJred (CAN 1 0.3.2) and is cal­
culated as follows: 

- The compressive force m concrete web alone is gi,·cn by 

e~ 0.85fba,, and (CAN 10.2.7) 

the moment resisted by concrete web and tensile steel is 

- The moment resisted by compression steel and tensilc steel is 

lt.f~= M~, -M~.· 

- Thercfore. the compression steel is computed as 

. M . 
A = . U\ • wherc 
'/,(d-d')'í', 

· , lc-d'l 
/, = O.OOJ E, l-c-J" (CAN 10.2.4) 

- The tensile steel for balancing compression in web concrete is 

A M~. d ,, = ---"'--- . an 
a. 

/ (d--"-J'í' 
.1 ") S 

the tensile steel for balancing compression in steel is 
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- Total tensile remforcement . .4) =As1 +AJ: +As3 • and toral compre::::­
sion reinforcemem is .(.A, is to be placed at bottom andA; is 10 be 
placed at top. 

1Uinimum Tensi/e Reinforcement 

The minimum flexura] tensile steel pronded in a rectangular sectwn in an ordinJry 
moment resisting frame is gi,·en by the minnnum of the two limits 

(CAN 1 0.5.1 1 

(CAN 10.5.2) 

Specia/ Consideration for Se~smic Design 

For Ductile moment res1sting concrete frames (seismic design). the beam design 
should satisfy the following addit10nal conditions (see al so Tablc V -2 for comprc­
hensJve listmg): 

The mmimum longitudinal reinforcemer: shall be provided at both at thc top 
and bottom. Any of the top and bottom rcinforcement shall not be less than 

.4stmm•· 

A > Jrmm! -
(CAN 21.3.2.1) 

The beam flexura) steel is limited 10 a maximum given by 

A, S 0.025 h"d. (CAN 21.3.2.1) 

At any end (support) ofthe beam. the heam posnive moment capacity (i.e. as­

sociated with the bottom steel) would not be less than 1/2 ofthe beam negative 
moment capacity (i.e. associated with the top steel) at that end (CAN 21.3.2.2). 

Nenher the negative moment capacity nor the posttn·e moment capacity at any 
ofthe sectwns within the beam would be less than 1/4 ofthe maximum of posi­

ttve·or negative moment capacities of any ofthe beam end (support) stations 
(CAN 21.3.2.2). 

For Nominal moment res1stmg concrete frames (seismic design), the beam design 
would satisfy the following condnions· 
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At any suppon of the be a m. the beam positive moment capacity would not be 
less than ií3 ofthe beam negative moment capacity at that end (CAN e 1.9.2.1 ). 

Neither the negative moment capacity nor the positive moment capacity at any 
ofthe sections wnhin the beam would be less than 1/5 ofthe maximum ofposi­
tive or negative moment capacities of any ofthe beam end (suppon) stations 
(CAN 21.9.2.1 ). 

Design Beam Shear Reinforcement 

The shear remforcement is designed for each load combination at user defined 
number of stations along the beam span. In destgmng the shear reinforcement for a 
panicular beam for a panicular loading combmation at a panicular station duc to 
the beam majar shear. the following steps are invo!ved: 

Determme the factored shear force, V.,. 

Determine the shear force, V, that can be resisted by the concrete. 

Determine the reinforcement steel required to carry the balance. 

For Ductile and Intermediate moment reststing frames. the shear design of the 
beams is based on the probable and nominal moment capacities ofthe members. re­
spectively. 

The following three sections describe in detail the algorithms associated \\'ith the 
above-mentioned steps. 

Determine Shear Force and Moment 

In the design ofthe beam shear reinforcement of an Ordinary moment resist­
ing concrete frame. the shcar forces and moments for a panicular load combi­
nation at a panicular beam section are obtained by factoring the assoctated 
shear forces and moments with the corresponding load combmation factors. 

In the design ofDuctile momcnt resisting concrete frames (seismic design). 
however, the shear force. V.,. is calculated from the probable momem capacities 
of each end ofthe bcam. and the gravity shear forces. The procedure for calcu­
lating the design shear force in a beam from probable moment capacity is the 
same as that described for a co!umn in section "Column Design" on page 69. 
See also Table V-2 for more detai!s. 

The design shear force V., ts then given by 

(CAN 21.7.2.1) 
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where. V, is the shear force obtained by applying the calculated probable ulti­
mare moment capacities at the two ends ofthe beams acting in two opposite dt­
rections. Therefore. V, is the maximum of V,: and VP,. where 

V ~ 
P, 

V = 
?, 

L 

M: +M; 
· · , and 

L 

u; +M; 
· · . where 

~ 

L 

Moment capacity at end l. with top steel 
in tension. using a steel yield stress value 

of a(,. and no <p factors, 

Moment capacity at end J. with bottom 
steel in tension. using a steel yield stress 

value o fa/, and no <p factors, 

Moment capacity at end 1, with bottom 
steel in tension. using a steel yield stress 
value ofaf, and no<p factors, 

Moment capacity at end J, with top steel 

in tension. using a steel yield stress value 
of a(,. and no <p factors. and 

Clear span of beam. 

The overstrength factor a is always taken as 1.25 for Ductile moment resisting 
frames (CAN 21.1 ). V D+L is the contribution of shear force from the load in­
span distribuÚon of gravity loads. 

In the design ofNominal moment resisting frames (seismic). the design shear 
force m beams is taken to be the maximum of that based on the nominal m o· 
ment capacity and factored shear force. The procedure for calculating nominal 
moment capacily is the same as that for computing the probable moment 
capacily for Ductile moment resisting frames. except that a is taken equal to 1 
rather than 1.25 (CAN 21.1 ). The factored shear forces are based on the speci­
fied load factors. The computation ofthe design shear force in a beam of an In­
termedia te moment resisting frame, is also the same as that for columns. 
which rs described earher in section "Column Design" on page 70. The value of 
V D+L is based on the span load. See al so Table V -2 for details. 
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Type of Ordmary ;\loment l'\ominall\loment Resisting Ductile ;\foment 

Checkl Resisting Frames Frames Resisting Frames 
Design fnon-Seismic) (Seismic) (Seismic) 

Column 
Check NLDt Combinatwns NLD r Combinat10ns NLD 1 Combm:nions 
(interaction) 

Column 
NLD1 Combinauons NLDr CombJn.JtJons 

NLD; Combmouons 
Design 

l%<p<8% l%<p<8% 
a~ 1.0 

(lnteraction) l%<p<6~0 

Modified NLDt Combmations ~:LD1 Combm:nions and 
Column 

NLD; Combmations Column Capacit:· Shear (I:P) Column Capacny Shear (l'r) 
Shears 

'í' " 1.0 anda ~ 1.0 <P = 1.0 anda"" 1.25 

NLD1 Combmations 
Be a m p $ .0.025 
Design NLD1 Combinations NLD i Combinations 1.4 
Flexure p~-

f. 

Af ~SD ~ 
1 . 

1 ¡· - M..END 
M~.,·v 2: 

Beam 1\lin. 
3 :;- ,\ oE.\D 

,\f .. ~l'tX ';::: ~max{A!; .Al~-} E.,D 

-
1\lomcnt 

No Rcquircment M:S,A., ~ ..!..max{M~- .uw-} 
Onrride 

~~ma:-.{AfM . • M:t,_D 
-t 1:..\'1! 

Check ¡\f :,Pi., 
M:,,As ~¡ma:\{.u; .M.-}J:.SJI 

l\LD; Combmations 1\LDt Combinatwns 

Beam Drsign 
NLD; Combinauons 

Bcam Capacity Shear (V
1
,) Beam Capacny Shear (V,.) 

Shear 
w1th a = 1 O and ~ == 1 O Wlth U = 1.25 and ~ = r.0 
plus Vv.t' plus Vo+L 

I>O 

t Number of specified loading 

Tablo V-2 
Comparison of0rdii1G!J". Ductil e. all(/ Nonwzal A1omen! Resisting Frame Design 
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Determine Concrete Shear Capacity 

The allowable shear capacity for ordmary and nominal moment resistmg frames is 
given by 

(CAN 11.3.4.1) 

V, is taken as zero for ductil e moment resisting beams (CAN 21.7.3.1 ). 

Determine Required Shear Reinforcement 

Given V, and V,., the required shear reinforccment in area/unit length is calculated 
as 

(CAN 11.3.6.1) 

The shear force to be resisted by steel, V,. is limited by 

(CAN 11.3.6 6) 

The beam shear reinforcement requiremems displayed by the program are based 
purely u pon shear strength considerations. Any mimmum stirrup requirements to 
satisfy spacing and volumetric requirements must be investigated independently of 
the program by the user. 
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Design for BS 8110-85 

This chapter describes in detail the various aspccts ofthe concrete design proccdure 
that is used by SAP2000 when the user selects the British limit state design code BS 
8110 (BSII985) Vanous notations used in this chapterare listed in Table VI-l. 

The design ts based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
sign of most building type structures. 

English as well as SI and MKS metric units can be used for input. But the code is 
based on Newton-Millimeter-Second units. For simplicity, al! equations and de­

scriptions presented in this chapter correspond to l\ewron-!\lillimeter-Sccond 
units unless otherwise noted. 

Design load Combinations 
The design loading combinations define the various factored combinations of the 
load cases for which the structure is to be checked. The design loading combina­
tions are obtamed by multiplying the characteristic loads by appropriate panial fac­
tors ofsafety, y r (BS 2.4.1.3). !fa structure is subjected to dead load (DL) and Ji ve 
load (LL) only. the design will need only one loading combination. namely 1.4 DL 
+ 1.6 LL. However. in addition to the dead load and live load, ifthe structure is sub­
jccted to wind (\VL) and/or eanhquake (EL) loads. and considering that those loads 
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b 

b' 

e mm 

f. 
/. 
f .. 
·¡, 

h¡ 

K'. 

k 
1 

Area of section for shear resistance. mm2 

' Are a of tension rcinforcement. m m-

Area of compression reinforcement. mm2 

Total area of column longitudinal reinforcement. mm2 

' Total" cross-sectional area of links at the neutral axts. mm-

Dcpth of compression block, mm 

Width or effective width ofthe section in the comprcssion zone, mm 

Shorter section dimension. mm 

Shorter effective depth of biaxmlly bent column. mm 

Width or effective width of flange. mm 

Average web width of a flanged beam. mm 

Compression force, N 

Effective depth of tension remforcement. mm 

Depth to center of compression reinforce111ent. 111111 

Modulus of elasticity of concrete. MPa 

Modulus of elasticity of reinforcement. assumed as 200.000 MPa 

Minimum or nominal eccentricity, mm 

Characteristic cube strength at 28 days. MPa 

Compressive stress in a beam compression steel. MPa 

Characteristic strength of reinforcement. MPa 

Characteristic strength of link reinforcement.MPa (< 460 MPa) 

Overall depth of a section in the plan e of bending. mm 

Flange thickness. mm 

Maximum M_" for a singly reinforced concrete section taken as 0.156 
bd-Jo, 

by assuming that mo111ent rcdistribuuon is h11111ed to 1 O% 

Shcar strength enhancement factor 
. [ 1 '3 

Concrete shear strength factor, f ru feS] 
Effective height of a column, mm 

Clear height between end restramts. mm 

Table VI-l 
List of Symbols Used m the BS code 
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Design moment ata sectwn. tv1Pa 

Smaller and larger end moments in a slender column. N-mm 

~laximum adduional moment column. N-mm 

lnittal momem at the point of maximum addirional moment. N-mm 

Applied moments about the majar and minar axes of a column, N-mm 

Ulttmate axial load. N 

Spacing of hnks. mm 

Tension force, N 

Shear force at ultimare design load. N 

Shear stress, MPa 

Design ultimate shear stress resistance of a concrete beam. MPa 

Design concrete shear stress corrected for axial forces, MPa 

Design ultimate shear stress of a concrete section. MPa 

Neutral axrs depth, mm 

Depth ofneutral axis in a balanced section. mm 

Lever arm. mm 

Effective length factor 

Moment redrstribution factor in a member 

Panial safery factor for load 

Panral safety factor for material strength 

Concrete strain 

Strain in tension steel 

Strain in compression steel 

Table VI-l 
Lis1 of Svmbols Used /11 th~ BS code (colllinued) 
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are subJeCt to reversals, the following load combinations for ultJmate Jimll state 
might have to be cons1dered (BS 2.4.3): 

1.4 DL 
1.-l DL + 1.6 LL 

1.0 DL ± 1.4 WL 
1.4DL±I.4WL 
1.2 DL + 1.2 LL ± 1.2 WL 

1.0 DL ± 1.4 EL 
1.4 DL ± 1.4 EL 
1.2 DL + 1.2 LL ± 1.2 EL 

(BS 2.4.3) 

(BS 2.-1.3) 

These are the default load combinations. In addition to the above load combina­
tions, the code requires that all bUJidings should be capable of resisting a not1onal 
design ultimate horizontal load applied at each !loor or rooflevel. The notionalload 
should be equal to 0.015 times the dead load (BS 3.1.4.2). lt is recommcnded that 
the u ser define additionalload cases forconsidering the notionalload in SAP2000. 

Live load reduction factors, as allowed by sorne design codes. can be applied to the 
member forces of the live load case on a member-by-member basis to reduce the 
contribution of the live load to the factored loading. 

Design Strength 
The design strength for concrete and steel are obtained by dividing the characteris­
tic strength ofthe material by a partial factor of safety, y m. The values ofy m u sed in 
the program are listed below (BS 2.4.4.1 ). 

Values ofym for the ultimatc limit statc 

Reinforcernent 1.15 

Concrete in flexure and 
!.50 

axial load 

Shcar strength without 
1.25 shear reinforcement 
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Column Design 
The user may define the géometry ofthe reínforcing bar configuratíon of each con· 
crete column section. Ifthe area ofreinforcíng is provided by the user. the program 
checks the column capacity. However. ¡fthe area ofreinforcmg is not provided by 
the u ser. the program calculates the amount of remforcing required for the column. 
The desígn procedure for the reínforced concrete columns ofthe structure involves 
the following steps: 

Generate axial force-biax¡aJ moment interaction surfaces for all ofthe d1fferent 
concrete sectwn types of the model. A typical biaxíal interaction surface is 
shown in Figure III-1. When the steel is undefined. the program genera tes thc 
interaction surfaces for the range of allowable reinforccment from 1 to 8 per­
cent (BS 3.12.6.2). 

Calculate the capacity ratio or the required reinforcing area for the factored ax­
ial force and biaxial (or umaxial) bending moments obtained from each loadmg 
combination at each station ofthe column. The target capacny ratio is taken as 
one when calculating the requ1red reinforcmg area. 

Design the column shear reinforcement. 

The following three subsections describe in detail the algorithms associated with 
the above-mentioned steps. 

Generation of Biaxiallnteraction Surfaces 

The column capacity interaction volume is numerically described by a series of dis­
crete points that are generated on the three-dimenswnal interaction failure surface. 
In addition to axial compression and biaxial bendmg. the fonnulation allows for ax­
Ial tension and biaxial bending considerations (BS 3.8.4.1 ). A typical interaction 
diagram is shown m Figure 111-1. 

The coordmates ofthese points are detennined by rotating aplane oflinear strain in 
three dimensions on the scction ofthe column (BS 3.4.4.1). See Figure Jll-2. The 
linear strain diagram hmits the maximum concrete strain. E •. , at the extremity ofthe 
section, to 0.0035 (BS 3.4.4.1). 

The fonnulation is based consisten ti y upon the basic principies ofultimate strength 
design and allows for any doubly symmetrlc rectangular. square, or circular column 
section (BS 3.8.4). 
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The stress in the steel is given by the product ofthe steel strain and the steel modu­
lus of elasticity, E,E, and is limited to the destgn strength the steel. .l,./1.15 
(0.87 J, ). The are a associated with each reinforcing bar is placed at the actual loca­
tion or'the center ofthe bar and the algonthm does not assume any simplifications 
m the manner m which the area of steel is dtstributed over the cross section of the 
column (such asan equivalen! steel tube or cylindcr). See Figure VI-l. 

-
1 1 

1 - t ., + 
' 1 
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(i) CONCRETE 
SECTION 

• 
1 • 

(ii)STRAIN 
DIAGRAM 

Figure \'1-1 

(iii) STRESS 
DIAGRAM 

ldealized Stress and Strain Dzstribwion 111 a Column Section 

The concrete compression stress block is assumed to be rectangular, with a stress 
valueof0.67 f.-/Y m =0.45f.- (BS 3.4.4.1). See Figure VI-l. The interaction algo­
rithm provides corrections to account for the concrete area that is displaced by the 
reinforcement in the compression zone. 

Check Column Capacity 

The column capacity is checked for ea eh Joading combination at each output station 
ofeach column. In checking a panicular column for a panicular loading combina­
twn ata panicular Jocation, the following steps are invo!ved: 
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Determine the factored moments and forces from the analysis load cases and 
the specified load combination factors to give N .F, ,V,. M,. and M, . 

Determine the additwnal moments dueto slender column effect. Compute mo­
ments due to mmimum eccemncity. 

Determme total design moments by addmg the corresponding additional mo­
ments to the factored moments obtained from the analysis. Determine whether 
the point. defined by the resulting axial load and biaxial moment set. líes within 
the mteraction volume. 

The following three subsections describe in detail the algorithms associated wnh 
the above-mentioned steps. 

Determine Factored Moments and Forces 

Each load combination is dcfined with a set of load factors corresponding to the 
load cases. The factored loads for a panicular load combination are obtained by ap· 
plying the corresponding load factors to the load cases, giving N .V, ,V_,.. M, and 
M, .. 

Determine Additional Moments 

The determination of additional moments depends on whether the frame is 
"braced" or "unbraced'' against side-sway (BS 3.8.1.5). For "unbraced" co!umns 
additional momcnt is automattcally considercd in the P-1'1 analysis. But for 
"braced" columns. funher calculation ts reqwred for stability ofindividual column 
members. 

Braced Colum11 

The additional moment in a braced column in a panicular plan e is the product ofthe 
a'ialload and the lateral deflection ofthe column m that plane (BS 3.8.3), 

At/aJd=Na,.. (BS 3.8.3.1) 

where. a, ts the defleetion at the ultimate limit state which is obtained from 

(BS 3.8.3.1) 

1 ( 1 )' P. = 2ooo ~, . (BS 3.8.3.1) 

In thc above equations, 
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1,. is the effective length in the plane under consideration. lt is obtained irom 

!,=PI,, (BS 3.8.1.6.1) 

where pis the effective length factor. and /
0 

the unsupporred !ength correspond­
ing to instability in the majar or minar direction of the elemcnt. lx or 11 m 
Figure Ill-4. In calculatmg the value ofthe effective length. the P factor is con­
servatively taken as l. However, SAP2000 allows the user to overridc thi, de­
fault value. 

h' is the dimenswn ofthe column in the plane ofbending considered. 

h is also the dimension ofthe column in the plane ofbending considercd. and 

K is the correction factor to the deflection to take care of the influence of the 
axml force and K ts conservatively taken as l. 

SAP2000 then ca!culates the total design moments by combining the factorcd mo­
ments obtained from analysis and the additional moments. If M, and M, 
(M 0 > M

1 
) are the initial end momems in a co!umn mcmber in a panicular pbne. 

then thc maxtmum design moment for thc column is taken as the greatest ofthc fol­
lowing: 

M. 

}vf¡ +M <Jdd 

M,+ Mo&J/2 

N e mm 

\vhere. 

(BS 3.8.3.2) 

(BS 3.8.3.2) 

·,cBs 3.8.3.21 

(BS 3.8.3.2) 

M, is the initial moment in a column dueto design ultima te !oads at the point of 
maximum additional moment and ts given by 

M, =0AM
1 

+0.6M, 2 OAM •. (BS 3.8.3.2¡ 

M
1 

and M 0 are the smaller and the larger end moments respective! y. Both mo­
ments are assumed to be posit1ve ifthe co!umn ts in single curvature.lfthe col­
umn is in double curvature. M, is assumed to be negattve. 

e mm is the mínimum eccentncity which is taken as 0.05 tunes the overall di­
mension ofthe column in the plane ofbending considered but not more than 20 
mm (BS 3.8.2.4). 

h 
e =-o> 20mm 

mm 20 
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Unbraced Co/umn 

In the case of the unbraced column. it is assumed that the SAP2000 analysis in­
eludes p.,; effects so that the analysis results includc the effccts of thc additional 
moments. Therefore. no adduional computation is required. That means. moment 
magnification factors for moments causmg sidesway are taken as unity. However. 
it is recommended that for P-"' analysis a factor be used to obtain a P equl\·alent to 
1.2 DL + 1.2 LL (Whtte and Hajjar I 99 I ). 

Also, the mimmum eccemncity requirement are sattsfied so thc design moment 
should at lcast be 

M ~ Ne u mm' 
(BS 3.8.3.2) 

where. e mm JS the minimum eccentricity which is described in the pre\ ious SCCtion. 
In biaxial bending the algorithm ensures that the eccentrictty exceeds the minunum 
about both the axes simultaneously. 

Determine Capacity Ratio 

As a measure ofthe stress condition ofthe column. a capacity ratio is calculated. 
The capacity ratio is bastcally a factor that gtves an mdication ofthe stress condi­
tion of the column with respect to the capacity of the column. 

Befare entering the interaction dtagram to check the column capacity, the design 
forces N. M.,. and M 

1 
are obtained according to the prevwus subsections. The 

point (N. M •. M, Yis then placed in the interaction space shown as point L in Figure 
lll-3. Ifthe point lies within the interaction volume. the column capacity is ade­
quate; however. ifthe pomt lies outstde the interaction volumc, the column ts over­
stressed. 

This capacny ratio is achie,·ed by plotting the point L and determining the location 
of pomt C. The point C is defined as the point where the l in e OL (if extended out·. 
wards) will intersect the fatlure surface. This point is determined by three­
dtmensional linear interpolation bctween thc points that define the failure surface. 

See Figure lll-3. The capacity ratto. CR, is given by the ratio OL. 
oc 

IfOL =OC ( or CR= l J the point lies on the interaction surface and the column is 
stressed to capacity. 

IfOL <OC (or CR<l) the point lies within the interaction volume and the col­
umn capacity is adequate. 
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lfOL >OC ( or CR> 1 ¡ the point lies outside the mteraction volume and the col­
umn is overstressed. 

The maximum ofall the values ofCR calculated from each load combination is re­
poned for each check station of the column along wnh the contrallmg 
N. M, .and M,. set and associated load cambinatian number. 

If the reinforcmg area is not defined. SAP2000 computes the remforcement that 
will give an interactian ratiO of unny. 

Design Column Shear Reinforcement 

Thc shear reinforcement IS designed far each laadmg cambination in the majar and 
minar directions afthe calumn. In designing the shear reinforcement for a particu­
lar co!umn for a particular loading combinmion dueto shear forces in a particular 
direction. the followmg steps are in volved (BS 3.8.4.6): 

Calculate the destgn shear stress from 

V 
v = - ·, A o = bd. where 

A o 

(BS 3 4.5.2) 

,. s; 0.8 JJ::, and (BS 3:4.5.12) 

(BS 3.4.5. 12) 

If v exeeeds either 0.8 JJ:: or 5 N/mm:, the section area should be increased. 

• If axial load ts tensile then the shear resistance of concrete is totally neglected. 
i.e .. the design shear stress is assumcd to be resisted by the hnks whosc area per 
unit length ts given by 

A V h --!!...¿: 
s,. 0.87 !,, 

If axial load is compressive and M/ N< 0.75h, where h is the dimension af the 
column in the direction ofshear, provide mínimum links given by (BS 3.8.-1.6) 

A,. 0.4 b 
2 

s, 0.87 !" 
(BS 3.4.5.3) 

where J,,. can not be greater than 460 iv!Pa (BS 3.4.5. 1 ). 
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lfaxialload is compressive and AI/N ~0.75/z. calculate the design concrete 
shear stress from (BS 3.8.4.6) 

' 07_NVd .h V =1· + )-- Wit , , . A, M . (BS 3.-\.5.12) 

,._ = 0.79 k,L ( iOOA, r (400r 
. bd d , 

'fm 

(BS 3.4.5.-\) 

where. 

k, is the enhancement factor for suppon compression and taken conscrva­
tively as 1, (BS 3.4.5.8) 

L = ( {., )y, 
. 25 

'fm = 1.25. 

0.15 S IOOA, S 3, 
bd 

400 ~ l. 
d; 

' f ro S 40 N/mm·, and 

A, is the area oftensile steellayer. 

If ·,.S v', +0.4, provide minimum links defined by 

A,. ~ 0.4 b 

s, 0.87 J.,_ 

else if v > ,.-, +0.4, provide links given by 

(v-v',)b 

0.87 /, , 

(BS 3.4.5.4) 

(BS 3.4.5.4) 

(BS 3.4.5.4) 

(BS 3.4.5.12) 

(BS 3.4.5.4) 

(BS 3.4.5.3) 

(BS 3.4.5.3) 

where f,, can not be greater than 460 MPa (BS 3.4.5.1). 
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Beam Design 
In the design of concrete beams, SAP2000 calculares and reports the required arcas 
of steel for flexure and shear based u pon the beam moments. and shcars. load com­
bmatwn factors. and other criteria described below. The remforcement require­
ments are calculared at a user defined number of check srarions a long the beam 
span. 

AII rhe beams are only designed for major direction flexure and shear. Effects due 
to any axial forces. minor direction bending, and torsion rhat m ay exist in the beams 
must be investrgared mdependently by the user. 

The beam design procedure in vol ves the following steps: 

Design beam flexura! reinforcement 

Design beam shear reinforcement 

Design Beam Flexura! Reinforcement 

The beam top and bottom flexura! sreel is desrgned at a user defmed number of 
checkstations along the beam span. In designing the flexura) reinforcement for the 
ma_1or moment for a particular beam ata panicular secrion. the following steps are 
involved: 

Determine the maximum factored moments 

Detennine the reinforcing steel 

Determine F actored Moments 

In the design of flexura) reinforcement of concrete frame beams. the factored mo­
ments for each load combination ata particular beam station are obtained by factor­
ing the correspondmg moments for drffercnt load cases with the corresponding load 
factors. 

The beam section is then designed for the maximum positive and maximum nega­
tive factored moments obtained from all ofthe load combinations at that section. 

Negatrve beam moments produce top steel. In such cases the beam is always de­
signed as a rectangular section. Positive beam moments produce bottom steel. Jn 
such cases. the beam may be designed as a rectangular section. or T-Beam effects 
may be mcluded. 
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Determine Required Flexura! Reinforcement 

In the flexura! reinforcement design process. the program calculates both the tcn­
sion and compression remforcement. Compression reinforcement is added when 
the applied design moment exceeds the maximum moment capacity ofa smgly re­
inforced section. The user has the option of avoidmg the compression remforce­
mcnt by increasing the effective depth. the width. or the grade of concrete. 

The design proccdure ts based on the simplified rectangular stress block as shown 
in Figure VI-2 (BS 3.4.4.1 ). Funhermore it is assumed that moment redisrribution 
in the member does not exceed 10% (i.e. ~b 2: 0.9) (BS 3.4.4.4). The code also 
places a limitation on the neutral axis depth. xjd s; 0.5, to safeguard agamst non­
ductil e failures (BS 3.4.4.4). In addition. the area ofcompression reinforcement is 
calculated on the assumption that thc neutral axis depth remains at the maximum 
permitted value. 

The design procedure used by SAP2000, for both rectangular and flanged sections 
(L- and T-beams) is summanzed below. lt ts assumed that the design ulttmate axial 
force does not exceed 0.1 f ~A, (BS 3.4 . .4.1 ). hence all thc beams are destgned for 
majar dtrection flexure and shear only. 

Design ofa Rectangular beam 

For rectang\IIar beams. the moment capacity as a singly reinforced beam. A1 srngle. !S 

obtamed first for a section. The remforcmg steel area is determined based on 
whether M ts greater than. less than, or equal to M 1 • Sec figure V!-2. 

smg•· -

Cale u late the ulttmate momcnt ofrcsistance ofthe scctwn as singly reinforced. 

M smgle = K' fn. bd::.. where (BS 3.4.4.4) 

K'~ 0.!56. 

If M s; .4! ""''' the are a of tension reinforcement. A,. is obtained from 

A = 
' 

M 
----.where 
(0.87 /,)o 

o~ d{ 0.5 + \/0.25 · 
0
K
9

} s; 0.95d, and 

K= M 

103 

(BS 3.4.4.4) 
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A 

This is the top steel if the section is under negative moment and the bottom 
steel if the section is under positive moment. 
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lf Af > Ñfsmgle' the area ofcompression reinforcement. A.'s· is given by 

A' 
' 

M-M sm'<:l.: 

f,(d-J') 

where d' IS the depth of the compression steel from the concrete compression 
face. and 

J:= 0.87 /y iJ 
d' 1 r 1. 1 
-$ 2l 1 

- sooJ' d 

¡;= 1oo[1-
2:'J iJ 

d' 1 r 1. 1 
- > 2l1

- sooJ' d 
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This is thc bottom steel ifthe scction 1s undcr negative mamen t. From equilib­
rium. the area oftcnsion remforcement is calculated as 

A = 
' 

M 
~myl~ + A' where 

(0.87/,)z ,. 
(BS 3 .4.4.4) 

z = 0.775d. 

Desigu as a T-Beam 

(i) Flanged bcam undcrncgarivc momenr 

The contribution of the flange to the strength of the beam is 1gnored. The dcsign 
procedure is therefore identical to the one used for rectangular beams cxcept that in 
the corrcsponding equauons bis rcplaced by b •. See Figure Vl-3. 

(ii) Fianged beam under positire momcnr 

With thc flange in compression. the program analyzes the section by considcnng 
alternativc locauons ofthe neutral axis.lnitially the neutral axis is assumed to be lo­
cated m the flangc. Based on this assumption. thc program calculares the exact 
depth ofthe neutral axis.lfthe stress block does not extend beyond thc flange thick­
ness the scction is designed as a rectangular be a m of w1dth b, . lf the stress block 
extends bcyond the flangc w1dth, then the contribution of the web to the flexura! 
strength ofthc beam is taken into account. See Figure Vl-3. 

Assuming the neutral axis to lie in the flange. the nonnalized momcnt is computed 
as 

K= M 

f .. ,.b1 d' 

Then the moment arrn is computed as 

the depth of neutral axis is computed as 

l 
x = - (d .z). and 

0.45 

the depth of compression block is given by 

"' 
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a= 0.9x. 

lf a S h r· the subsequent calculations for A, are exactly the sarne as preYi­
ously defined for the rectangular section design. However. in this case thc 
width of the cornpression flange. b 1 , is taken as the width of the bearn. h. for 
analysis. Whether cornpress10n remforcement is required depends on whether 
K >K'. 

If a> h !' calculation for A, is done in two pans. The first pan ts for balancing 
the cornpressive force frorn the flange. e 

1
• and the second pan is for balancmg 

the cornpressive force frorn the web, e .. as shown in Figure VI-3. 

In this case. the ultimare resrstance mornent of the flange is given by 

the balance of rnoment taken by the web is computed as 

M. = M- M 1 • and 

d 
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the nonnalized moment res1sted by the web is gi,·en by 

M. 

- If K" ~ 0.156, the beam is des1gned as a singly reinforced concrete beam. 
The area ofsteel1s calculated as the sum oftwo pans. one to balance compres­
swn m the flange and one to balance compression in the web. 

A = , 
M 1 M 

-----'---- + " , where 
0.87 J, (d -0.5111) 0.87 !,. ~ 

: = d{o.s + Jo.2s- ~.~ } ~ o.95d. 

- If K" > 0.156. compression reinforcement is reqU!red and is calculated as fol­
lows: 

The ultimate moment ofresistance ofthe web onlv is given by 

The compression reinforcement is reqUired to res1st a moment of magnitude 
M" -·.M~ . The compression reinforcement is computed as 

. M :M A = .. u-• 

, ¡;(d-d'). 

where. d' is the depth ofthe compress1on steel from the concrete compression 
face. and · 

¡; = 0.87/,' if 
d' 1 r 1. 1 

~ 2ll - 800 J . and d 

¡;= 7oo[l-
2
:']. if 

d' 1 r 1 .. 1 
-> 

2l
1 

- 8ooJ d 

The are a of tenswn reinforcement is obtained from equilibrium 
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Design Beam Shear Reinforcement 

The shear reinforcement is des1gned for each loading combinarion in thc majar and 
minar directions ofthe column. In designing the shear reinforcement for a panicu~ 
lar beam for a panicular loading combination dueto shear forces in a panicular di­
rection. the following steps are involved (BS 3.4.5): 

Calculate the design shear stress as 

V 
r =- 4 =bd where 

.4 ..... .. "' . 

,. $ 0.8 J7::. and 

o 
r $5 Ni mm-. 

Calculate the design concrete shear stress from 

l' = 
' 

where. 

0.79k1k, (IOOA, )Y,(400)Y. 
Ym bd d 

(BS 3.4.5.2) 

(BS 3.4.5.2) 

(BS 3.4.5.2) 

(BS 3.4.5.4) 

k1 is the enhancement factor for suppon compression. and is conscrva-
tn·ely taken as 1, (BS 3.4.5.8) 

L = ( / ~ )Y, 2 1 , and 
- 25 

Ym = 1.25. 

However. the following hmitations al so apply: 

0.15 $ IOOA, $ 3, 
bd 

400 
2 l. and 

d 

f ~ $ 40 Nimm2 (for calculation purpose only). 

A, is the area oftensile sreel. 
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If ,. S ,-,+0.4, provide minimum links defined by 

A" 0.4 b 
2: 

s, 0.87 f., 

clse if ,. > ,-,+OA providc links given by 

A" 2: (¡·. ,., ) h 

s, 0.87/.,. 

wheref., can not be greaterthan460 iv!Pa (BS 3.4.5.1) 

(BS 34.5.3) 

(BS 3.4.5.3) 
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e h a p te r VIl 

Design for Eurocode 2 

Th1s chapter describes in detail the various aspects ofthe concrete design procedure 

that is used.by SAP2000 when the user selem the 1992 Eurocode 2 (CEN 1992). 
Various notations used in this chapter are listed in Table VII-l. 

The design is based on user-specified loading combinations. However, the program 
pro,·ides a set of default load combinations that should satisfy requirements for the 
design of most building type structures. 

English as well as SI and MKS mctric units can be used for input. But the codc is 
based on Newton-Millimeter-Second units. For simplicity, all equations and de­

scnpt!Ons presented in this chapter correspond to 1\ewton-Millimeter-Second 
units unless otherwise noted. 

Design load Combinations 
The design loading combinations define the various factored combinations of the 
load cases for which the structure is to be checked. The design loading combina­
t!Ons are obtained by multiplying the characteristic loads by appropriate partial fac­
tors ofsafety. !fa structurc 1s subjected to dead load (DL) and live load (LL) only, 
the design will need only one loading combination, namely 1.35 DL + 1.5 LL. 
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A 

!,, 

/,, 
¡; 
f,. 

' Area of concrete. mm-
' Area of section for shear resistance. mm-

Gross cross-sectional area of a frame member. mm2 

Are a of tension reinforcement. mrn2 

Area of compression remforcement. mm2 

' Total cross-secuonal area of links at the neutral axis. mm-

Depth of compression block. mm 

Width or effecttve width ofthe section in the compression zone. mm 

Width or effective width of flange. mm 

Average web width of a flanged beam. mm 

Effective depth of tension reinforcement. mm 

Effective depth of compression reinforcement. mm 

Modulus of elasticity of concrete, MPa 

Modulus of elasticity of reinforcement. assumed as 200.000 :'>.1Pa 

Eccemricity of axial load in a column. mm 

Minimum or nominal eccentricity. mm 

Total eccentricity for a braced column, mm 

Design concrete strength = f r;~. , lv1Pa 
Y •. 

Characteristic compressive cylinder strength of concrete at 28 days. MPa 

Design yteld strength of reinforcing steel ~ /,, . MPa 
y, 

Characteristic yield strength of reinforcement, MPa 

Compressive stress in a beam compression steel. MPa 

Characteristic strength of remforcement, MPa 

Design strength of shear reinforcement. MPa 

Characteristic strength of shear reinforcement, MPa 

Overall depth of a section in the plane ofbending, mm 

Flange thickness, mm 

Effective height of a column, mm 

Table VII-I 
List of Symbols Used m the Eurocode ] 
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Clear height between end restraints. mm 

Design moment ata section. N-mm 
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Smaller and larger end moments in a slender column. N-mm 

Apphed moments about the major and minor axes of a column. N-mm 

Design moment of resJstance of a section N-mm 

Moment ata sect10n obtamed from analys1s. N-mm 

M Nonnalized design moment. _.,..:..._ 

. Ultunate axial load. N 

Spacmg of links. mm 

bd=ar,d 

Design shear resistance from concrete alone. N 

Design limiting shear resistane of a cross-section, N 
Shear force at ultimate design load. N 

Shear force at ultima te design load in two directions. N 

Shear force from remforcement. N 

Concrete strength reduction factor for sustained loading 

Effective length factor. 

Enhancement factor of shear resistance for concentrated load 

Panial safety factor for load 

Panial· safety factor for concrete strength 

Panial safety factor for material strength 

Panial safety factor for steel strength 

Redistribution factor 

Concrete stram 
Strain in tension steel 

Strain in compression steel 

Effectiveness factor for shear resJstance without concrete crushing. 

Out of plumbness factor 

T cnsion reinforcement ratio, A,/ bd 

Effective average compressive stress in concrete column, MPa 

Nonnahzed tensile steel ratio. A J ,J jaf.Jbd 

Nonna!ized compression steel ratio, A,' f,J jaf .. dbd 

Nonnalized limiting tensilo steel ratio 

Table VII-I 
List of Svmbo!s Used in the Eurocode 2 (continued)" 
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However. in addition to the dead load and live load. ifthe structure 1s suhjected to 
wind (WL) and earthquake (EL) forces, and considering that wind and earthquake 
forces are subject to reversals. the followmg load combinatwns m1ght have to be 
considered (EC2 2.3.3): 

1.35 DL 
1.35 DL + 1.50 LL 

1.35 DL ± 1.50 WL 
1.00 DL ± 1.50 WL 
1.35 DL + 1.35 LL ± 1.35 WL 

1.00 DL ± 1.00 EL 
1.00 DL + 1.5*0.3 LL ± 1.0 EL 

(EC2 2.3.3) 

(EC2 2.3.3) 

(EC2 2.3.3) 

These are the default load combinauons. These default loading combinations are 
produced for persisten! and transient design situations (EC2 2.2. 1 .2) by combining 
load dueto dead. live, wmd. and earthquake loads according to the simplified for­
mula (EC2 2.3.3. 1) for ultimate limit states. 

In addition to the above load combinations. the code requires that all buildings 
should be capable ofresisting a notional design ultimate horizontal load applied at 
each floor or rooflevel (EC2 2.5. 1 .3 ). It is recommended that the user define addi­
tional load cases for considering the notional load in SAP2000. 

Live load rcduction factors. as allowed by sorne design codes. can be applied to the 
member forces ofthe live load condition on a member-by-member basis to reduce 
the contribution ofthe live load to the factored loading. 

Design Strength 
The design strength for concrete and steel are obtained by dividing the characteris­
tic strength ofthe matenal by a partial factor ofsafety, y m. The values ofy"' u sed m 
the programare listed below. These values are recommended by the code to gtve an 
acceptable leve! of safety for normal structures under regular design situat1ons 
(EC2 2.3.3.2). For accidental and earthquake situations. the recommended values 
are less than the tabulated value. The user should constder those separately. 

Considering the partial safety factors for the materials. the dcsign strengths of con­
crete and steel are given below: 
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f .• = Design yield strength of reinforcing steel = /,, , and 
Y, 

/,, = Characteristic yield strength ofreinforcement. 

f~d = Design cylinder concrete strength =feA , \VhÚe, 
Y, 

f"' = Characteristic compresSI\'C cvlinder strength of concrete at 28 days. 
y, = Panial safety factor for steel = 1.15, and 
y, = Panial safety factor for concrete= 1.5. 

Column Design 
The u ser may define the geometry ofthe reinforcing bar configuration of cach con­
crete column section.lfthe area ofreinforcing is provided by the user. thc program 
checks the column capacit}. However. ifthe area of reinforcing is not provided by 
the user. the program calculates the amount ofreinforcing reqmred for the column. 
The design procedure for the reinforced concrete columns ofthe structure involves 
the following steps: 

Generate axial force-biax1al moment interaction surfaces for all ofthe different 
concrete sections types ofthc model (EC2 4.3.1.2). A typ1cal biaxial mteracnon 
surface is shown in Figure 111-1. When the steel is undefined. the program gen­
erares the interaction surfaces for the range of allowable reinforcement from 1 
to S percent (EC2 5.4.1.2.1 ). 

Calculate the capacity ratio or the required reinforcing area for the factored ax­
ial force and biaxial ( or umaxial) bending moments obtained from each loadmg 
combination at each station ofthe column. The target capacity ratio is takcn as 
one when calculatmg the required reinforcing area. 

Design the column shear remforcmg. 

The followinc three sections describe in detail the aJgorithms associated with the - - . 
above-mentwned steps. 

Generation of Biaxiallnteraction Surfaces 

The column capacity interaction volume is numerically described by a series of di s­
erete points that are generated on the three-dimensional interaction failure surface. 
In addition to axial compression and biaxial bendmg. the fonnulation allows for ax­
ial tension and biaxial bending considerations as shown in Figure 111-1. The coordi­
nares of these points are detennined by rotating a plan e of linear stram in three di­
menswns on the section of the column. Se e Figure 111-2. 
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The forrnulation is based consistently upon the basic principies ofultimate strength 
design and allows for any doubly symmetric rectangular. square. or circular col umn 
section. The linear stram d1agram limits the maximum concrete strain. E.-. at the ex-

tremity ofthe section to 0.0035 and ata depth of~ d from the most compres sed fa ce 
7 

to 0.0020 (EC2 4.3.1.2). See Figure VII-l. 

The stress in the steel is gn·en by the product ofthe steel strain and the steelmodu­
lus of elasticity. E ,E, and is limited to the design yield strength the steel. f,J (EC2 
4.2.3.3.3 ). The are a associated with each reinforcing bar is placed at the actualloca­
tion ofthe center ofthe bar and the algorithm does not assume any simplitications 
in the manner in which the area of steel is distributed over the cross section ofthe 
column (such asan equivalen! sreel tube or cylinder). 
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(i1i) STRESS 
DIAGRAM 

ldcahzed Stress and Strain Distnbution in a Column Sectron 

The concrete compression stress block is assumed to be rectangular, with a stress 
va!ue of af, •. where f.-J is the design value of concrete cylinder compressive 
strength and a is the reduction factor to account for sustained compression. a is 
generally assumed to be 0.80 (EC2 4.2.1.3). See Figure VII-l. The interaction algo­
rithm provides corrections to account for the concrete area that is displaced by the 
reinforcement in the compression zone. 
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Check Column Capacity 

The column capacity is checked for each loading combination of each column. In 
checking a panicular column for a panicular loadmg combmation ata panicular lo­
carian, the following steps are mvolved: 

Determine the factored moments and forces from the analysis load cases and 
the specified load combination factors ro give N. V,. V, .. Al,, and M, .. 

Determine the code total muments dueto slender column effect. Compute mo­
ments dueto minimum eccentncity. 

Check the column capacity ratio or compute the reinforcement for the column 
for resistmg the factored moments, the code total moments. and the moments 
from mmimum eccentricity. 

The following three subsections describe in detail the algorithms associared with 
the above-mentioned steps. 

Determine Factored Moments and Forces 

Each load combination is defined with a ser of load factors corresponding to the 
load cases. The factored loads for a pantcular load combination are obtained by ap­
plying the corresponding load factors to the load cases. g1ving N. r·x. V, .. A1.\. and 
M,. . 

Determine Code Total Moments 

The determinatwn of code total moments depends on whethcr the frame is "braced" 
or '·unbraced" against stde-sway. 

Braced Co/umn 

Eurocode specifies that for braced columns the total moment should be computed 
from a ser of eccentricities. such that 

eror = eu +ea +e::! where 

e
0 

= 0.4 M, +0.6 M, 
N N 

v/n 
e=- . 

u 2 ' 

(EC2 4.3.5.6.2) 

M_ 
> O 4 --- where - . !v' ' jM,j S IM ,¡, (EC2 4.3.5.6.2) 

(EC2 4.3.5.4) 

\' is taken as 1/1 OO. howeverrhe u ser can override this value (EC2 2.5.1.3 ), 
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/
0 

is the effective length ofacolumn in a given plane and is obtained from 

(EC2 4.3.5.3.5) 

where pis the effective length factor depending on the end conditwns and 
resistance against side-sway, ~ is conservatively taken as 1 for braced 
frames. and 1.~1 is the unsupponed lcngth corresponding to instabiht! m 

the majar or minar direction ofthe element, /" and l, in Figure III-4. 

e~ = 

k -¡-

kl k,(f,d 

45E,d 

fo 
1 

1 
j!:.-075. 
120 

1 

l 1 

forJ.:>I5. 

for15<1, :> 35, 

forA>35, 

rG = the radius of gyration about the axis ofbending. and 

L= ·"-'ud -Nd 

Nud -N t-ul 

:> 1, k. is taken as 1.0. 

(EC2 4.3.5.6.3) 

However, the minimum eccentricity requirement is satisfied such that 

M Rd > N Sd e mm , where 

M Rd = Design moment resistance ofthe section, 

N SJ = The axial force obtained from analysis. and 

(EC2 4.3.5.5.3) 

e mm tS the minimum eccentricity which is taken as 0.05 times the overail di-
mension of the column in the plan e of bending and is given by 

e =h/20. mm (EC2 4.3.5.5.3) 

Finally the design moments are computed from the maximum ofthe three, 

MRd = max(NR.deror, NRdemm. M ru.-tored). (EC2 4.3.5.6) 

In biaxial bending, the program calculates the design moments at any station about 
two axes. 
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Uubraced Colum11 

In the case of the unbraced column. rt is assumed that the SAP2000 analysis in­
eludes P-Ll effecrs so that the analysis results include the effects of the addnional 
moments. Therefore. any additional computatron is nor required. That means. rhe 
moment magníficat ion factors for moments causing sídesway are taken as umty. 
However. n is recommended that a factor be used ro obrain a P equinlcnt to 1.35 
DL + 1.35 LL for P-Ll analysis (White and HajJar 1991 ). 

In addiuon. the mínimum eccenrricity requrrement needs ro be sarrsficd so that the 
design momenr should at least be 

MRd ~ i'v'emv:, (EC2 4.3.5.5.3) 

where. e mm is the mínimum eccentricity which is described in the previous section. 
In biaxial bending the algorithm ensures that the eccenrricity exceeds the mmimum 
about both the axes simulraneously. 

Determine Capacity Ratio 

As a measure of the stress condition of the column, a capaciry ratio is calculared. 
The capacity ratio is basically a factor thar gives an indrcation ofrhe stress condi­
tion ofthe column with respect ro the capacny ofthe column. 

Befare entering the inreraction diagram to check the column capacity. the design 
forces N, M ,and M, are obtained according ro the previous subsections. The 
point (N, M •. M,) is then placed in the interaction space shown as poinr L in Figure 
lll-3. lfthe poinr líes within rhe interaction volume. rhe column capaciry is ade­
quate; however. ifthe point líes ourside the interacrion volume, the column is over­
stressed. 

This capacity ratio is achieved by plotting the pornt L and determining the locarion 
of poi m C. The pomt C rs defined as thc pornt where rhe !in e OL (if extended out­
wards) will inrersect the failure surface. Thts point is derermmed by three­
dimensional linear mrerpolatton berween thc poinrs that define the failure surface. 

See Figure lll-3. The capacitv ratio, CR, is given by the ratto OL . - oc 

lfOL =OC (or CR= 1) the point lies on rhe interaction surfacc and the column is 
stressed ro capacity. 

lfOL <OC (or CR<l) the point líes withm the interaction volume and the col­
umn capacity is adequate. 
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lf OL >OC (or CR> 1) the point lies outside the interactton volume and the col­
umn is overstressed. 

The maxrmum of aJI the values of CR calculated from each load combmation is re­
poned for each check station of the column along with the controlling 
N, M, . and M, set and associated load combination number. 

If the reinforcing area is not defined. SAP2000 computes the remforcement that 
wiJI give an interaction ratio of unity. 

Design Column Shear Reinforcement 

The shear reinforcement rs designed for each Joading combination in the majar and 
minar directions ofthe column. The assumptions in designing the shear reinforce­
ment are as follows: 

The column sections are assumed to be prismatic. The effect of any variation of 
width in the column section on the concrete shear capacity is neglected. 

The effect on the concrete shear capacity of any concentrated .or distributed 
load in the span ofthe column between two beams is ignored. Also. the effect of 
the direct support on the columns provided by the beams is ignored. 

All shear reinforcement is provided through shear reinforcement which are per­
pendicular to the longitudinal reinforcement. 

The effect of any torsion is neglected for the design of shear remforcement: 

In designing the shear reinforcement for a particular column for a particular Joading 
combination due ro shear forces in a particular direction, the following steps ofthe 
standard method are involved (EC2 4.3.2. 1 ): 

Obtain the design value ofthe applied shear force VsJ from the SAP2000 analy­
sis results. 

V"' = V, or V3 

Calculare the design shear resistance of the member without shear reinforce­
ment. 

V Rdl = ~[ "tRdk (1 .2 +40p 1 ) +0.15cr,,J ( b, d), where (EC2 4.3.2.3) 

~ = enhancement factor for shear resistance for members with concen­
trated loads located near the face ofthe support. ~ is taken as J. 
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= O .25f_-rk 1J 05 
't RJ = basic destgn shear strength of concrete 

Y.-

fcrk005 = 0.7fcrm • 

1 -03f y, 
Clm - ' e/;; • 

k = strength magnification factor for cunailment oflongitudinal remforce­
ment and JS considered to be l. 

tension reinforcement ratio=~ :5 0.02. 
b,d 

A 5 1 = arca oftension reinforcement, 

N 
average stress in concrete due to axial force=_.§.!!_. 

A,-

N Sd is the destgn val u e of the applied axial force in secnon. and 

A .. is the total area of concrete cross-sect10n. 

Calculare the maximum design shear force that can be carried without crushing 
of the n_otional concrete compressive struts. VNJ:. 

VRJ: = ~v .. ll/.* J\o.9b, d). where 
- Y. 

v is the effectiveness factor= O. 7 - J,_, 2 0.5. 
200 

(EC2 4.3.2.3) 

(EC2 4.3.2.3) 

If the effective average stress in concrete cr ,,. 
,p,c,~.r 

is more than 0.4 f,, , 
Y, 

should be reduced as follows: 

VRJ:~J = L67VRd:(l- cr/:fl )~vR_,, where (EC2 4.3.2.2) 

cr cp.cjf = 

N sJ is the design axial force. 
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f,a ts the design yield stress of compression steel. f,a s; 400 MPa. 

A~~ is the are a of reinforcement m the compression zonc. AL-: is 
conservatively taken as zero for a conserva ti ve design, and 

A,. is the total area of concrete cross-section. 

If r ·sd ~ Vru, ~d . the notional concrete-struts will be crushed. The section is not 
adequate to carry the shear force. 

If Fsd <V""' "d . either the mínimum shear reinforcement or the design shear 
remforcement is required. 

- lf V,d s; VRJl • the concrete shear capacity ts adequate to carry thc shear 
force. Only mínimum shear rcmforcement is required. 

- lf Vsd >V rul • the concrete alone is not enough to carry the shear force. De­
signed shear reinforcement is required. The requrred shear rcsistance from 
reinforcement. V wd is given by 

v.d = vSd -vRdi · (EC2 4.3.2.43) 

The required shear reinforcement per unit length ofthe column is given by 

Asw V,.J Ys 
- = -:-"'--'.:;__ 

S,. 0.9c/ f¡wd 

(EC2 4.3.2.4.3) 

where, /.,,J is the design yield strength of the shear reinforccment. 

Beam Design 
In the desrgn of concrete beams, SAP2000 calculates and reports the required areas 
of steel for flexure and shear based u pon the beam moments. shears. load combina­
ti en factors. and other criteria described below. The reinforcement requirements 
are calculated ata user defined number of check stations along the beam span. 

All the beams are only designed for majar direction flexure and shear. Effects duc 
to any axial forces. mmor dtrection bending. and torston that m ay exist in the beams 
must be investigated independently by the user. 

The beam desrgn procedure involves the following steps: 

Desrgn beam flexura! reinforcement 

Design beam shear reinforcement 
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Design Beam Flexura! Reinforcement 

The beam top and bottom flexura! stee!ts designed at the design stations a long the 
beam span. In designing the flexura! reinforcement for a panicular bcam for a par­
ticular section. for the beam major moment, the following steps are involved: 

Detcm1ine thc maximum factored moments 

Detennine the reinforcing steel 

Determine F acto red Moments 

In the design of flexura! reinforcement. the factored moments for cach load combi­
nauon ata panicular beam station are obtained by factoring the corresponding mo­
ments for different load cases with the corresponding load factors. The beam sec­
tion is then designed for the maximum posillve M: and maximum ncgative M: 
factored moments obtained from al! of the load combinations 

Negative beam moments produce top steel. In such cases the beam is always de­
signed as a rectangular section. Positive beam moments produce bottom steel. In 
such cases. the beam may be designed as a rectang~lar section. or T-Beam effects 
may be included. 

Determine Required Flexura! Reinforcement 

In the flexura! reinforcement dcsign process. the program calculares both the ten­
sion and compression reinforcement. Compression reinforcement is added when 
!he applied dcsign moment cxceeds !he maximum momcnt capacity of a singly re­
inforced section. The user has the option of avoiding the compression reinforce­
menl by increasing the effective depth. the width, or the grade of concrete. 

The design procedure is based on the simplified rectangular stress block as shown 
in Figure VII-2 (EC2 4.3.1.2). Funherrnore. it is assumed that moment redtstribu­
tion in the member does not exceed the code spectfied hmitmg value. The codc also 
places a ltmitatwn on the neutral axis depth. to safeguard against non-ductile fail­
ures (EC2 2.5.3.4.2). When thc applied moment exceeds M"' the area of compres­
sion reinforcement is calculated on the assumption that the neutral axis depth re­
mains at the maximum perrnitted value. 

Thc design procedure used by SAP2000, for both rectangular and flanged sectwns 
(L- and T-beams) is summarized below. It is assumed that the design ultimatc axial 
force do es not exceed 0.08 [,,A, (EC2 4.3.1.2), hence al! the beams are designed 
for major directwn flexure and shear only. 
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Design as a Rectangular Beam 

For rectangular beams, the nonnalized moment, m and the nonnalized section ca­
pacity as a singly remforce beam, m1=. are obtained first. The reinforcing steel arca 
is detennined based on whether mis greater than, less than, or equal to m1=. 

Calculate the nonnalized design moment. m 

M 
m= -.,.--- , where 

bd'af,d 

a JS the reduction factor to account for sustained compression. a is gcnerally 
assumed to be 0.80 for assumed rectangular stress block, lEC~ 4.2.1.3). See 
al so page 108 for a . The concrete compression stress block is assumed to be 
rectangular, with a stress val u e of aj'", where f"' is the design concrete 

strength and is equal to f" . See Figure Vll-2. 
Y. 
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Calculate the nonnalized concrete moment capacity as a singly reinforced 
beam. m1'"'. 

where the Jimning value ofthe ratio.:::.. ofthe neutral axis depth at the ultimatc 
d 

lim!l state after redistribution to the effective depth. is expressed as a function 
ofthe ratio ofthe red1stributed moment to the moment befare redistribution. o. 
as follows: 

(X) o-0.44 
if f.* , 35. (EC2 2.5.3.4.1) 

d lrm 1.25 

('") o -0.56 
if .r .• >35. (EC 2.5.3.4.1) 

d /¡m 1.25 

o is assumed to be l. 

lf m ,_ m1=. a singly reinforced beam will suffice. Calculate the nonnalized 
steel ratio, 

W= 1- .JI- 2m. 

Calculate the area oftension reinforcement. A,. from 

Í a( bd l 
A,=wl·'J J· 

f.d 

Th1s is the top steel if the section is under negative moment and the bottom 
steel if the section is under positive moment. 

lf m > m1=. the be a m will not suffice as a smgly reinforced beam. Both top and 
bonom steel are required. 

- Calculate the nonnalized steel ratios w. w1=, and w. 

w. = 0.807 (:::.) ' 
11171 J /un 

,_./ m-m1 w ---'="'- and 
1-d'/d' 
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- Calculare the area of compression and tension reinforcement. A', andA,. as 
follows: 

A' 
' 

r · bd l 
= üf la( ro J and 

f.. . 

r a/ bd l 
A,= wl 'd J· 

l,. 

Design as a T-Beam 

(¡) F/anged beam under negative moment 

The contribution ofthe flange to the strength ofthe beam is ignored ifthc flange is 
in the tension side. See Figure Vll-3. The design procedure is therefore idenncal to 
the one used for rectangular beams. However, the width ofthe web,. b., is taken as 
thc width of the beam. 

(il) Flanged beam under positil'e moment 

With the flange in compression. the program analyzes the section b)· considering 
alternan ve locatwns ofthe neutral axts. Initially the neutral axis is assumed to·bc lo­
cated within the flange. Based on this assumption. the program calculates the depth 
ofthe neutral axis. lfthe stress block does not extend beyond the flange thickness 
the section is designed as a rectangular bcam ofwidth b r. Ifthe stress block extcnds 
beyond the flange, addinonal calculation is requtred. See Figure Vll-3. 

Calculate thc nonmalized destgn moment, m. 

M 
m= , where 

b 1 d'af,d 

a is the reduction factor to accou¡¡¡ for sustained compression. a is generally 
assumed to be 0.80 for assumed 1ec:angular stress block, (EC2 4.2.1.3 ). See 
al so page 108 for a. The concrete compression stress block is assumed to be 
rectangular, with a stress value ofaf ro. 

Calculate the limiting value ofthe rano, (~) , ofthe neutral axis depth at the 
d /m 

ultimate limit state after redtstribution to the effective depth.whtch is expressed 

118 Beam Design 

"' 



Chapter VIl Design for Eurocode 2 

as a function of the ratio of the redJstributed momem to the momem befare re­
dJstribution.li, as follows: 

(: L =0~-~~44 if ~-~ $35. 

( 
.dx ),_ =o -0.56 

-·· 1.25 
if 1_.,>35. 

o is assumed to be l. 
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Design of a T-Beam Section 

Calculare the normalized steel ratio, 

X 
Calculate the ratio,-. as follows: 

d 

X W 

d 0.807 

(EC2 2.5.3.4.1) 

(EC2 2.5.3.4.1) 

-­' 

: ·¡ R ' :·r·r- e, 

• c. 

/_ ..... 
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Beam Design 119 

,, 

'j 



SAP2000 Concrete Design Manual 

If (; )~ ( h: ) . the neutral axis hes withm the flange. Calcula te the area of 

tension reinforcement. A,. as follows: 

• If (S)> ( h: } the neutral axis lies below the flange. 

Calculate steel area required for equilibrating the flange compresswn. A,,. 

As::= 
(b, -h. )h,afro 

f.d 

and the corresponding resistive moment IS given by 

M.= A .f "(d-!:...!_)· - s. ·'" 2 

Calculate steel area required for rectangular section of width b; ·to rcsist 
moment. M, =M- M: . as follows: 

120 Beam Design 

M, 
m, = --"--- • and 

b. d'a!.,; 

w, =I-.JI-2m, .and 

_ ll aj "b" djl A,, -w, . 
. l.d 

üf= n~ -mhm 
i-d'/d 
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w,~ = 0.807(::.) . 
d llm 

r a( ,h d l 
A,¡ = úl¡ l . ,... . J . 

f .• 

Calculate total steel area requ1red for the tension s1de. 

Design Beam Shear Reinforcement 

The shear reinforcement is designed for each loading combination at various check 
stations along the beam span. The assumptions m designing the shear reinforce­
ments are as follows: 

The beam sections are assumed to be prisma!Jc. The effect of any variation of 
width m the beam sectJon on the concrete shear capacity is neglected. 

Thc effect on the concrete shear capacity of any concentrated or distnbuted 
load in the span ofthe beam between two columns is ignored. Also. the effect of 
the direct suppon on the beams provided by the columns is ignored. 

All shear remforcements are assumed to be perpendicular to the longitudmal 
reinforcement. 

The effect of any torsion is neglected for the design of shear rcinforcement. 

In designing the shear remforcement for a panicular column for a panicular loading 
combination dueto shear forces in a panicular direction. the following steps ofthe 
standard method are in volved. 

Obtain the design value of the applied shear force VSd from the SAP2000 
analysis results. 

v~d = v~ 
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Calculate the design shear resistance of the member without shear rcinforce­
ment. 

(EC2 4.3.2.3) 

Calculate the maximum design shear force that can be carried without crushing 
of the notional concrete compressivc struts. FRd: . 

(EC24.3.2.4.3) 

lfthe effective average stress in concrete a ,.,_,ff' as defincd earher on page 113. 

is more than 0.4 j"' . V ;u: is reduced as follows: 
Y, 

, _ , ( 0--,4')<' f RdO.nd- 1.67 f Rd: ! ----¡-:;- - f RdO" (EC2 4.3.2.2) 

If V SJ ~ VRJ: nd • the notional concrete-struts will be crushed. The section is 
not adequate to carry the shear force. 

If VSd <V RJ: red • either the minimum shear remforcement or the design shcar 
reinforcement is required. 

- If Vsd S: V Rdl. the concrete shear capacity is enough to carry the shear force. 
Only minimum shear reinforcement is required. 

- If V5" >V Rdl, the concrete alone is not enough to carry the shear force De­
signed shear reinforcement rs required. The required shear resistance from 
reinforcement, v •. J· is gtven by 

(EC2 4.3.2.4.3) 

The required shear remforcement per unit length ofthe beam is g1ven by 

(EC2 4.3.2 4.3) 
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e h a p t e r VIII 

Design Output 

Overview 

SAP2000 creates destgn ourput in three majar different formats- graphical dis­
play, tabular outp~t, and member specific detailed destgn infomtation. 

The graphical display of design output includes input and ourput design 
information. Input design information includes desrgn sectwn label, K-factors. ltve 
load reduction factor, and other design parameters. The output design information 
mcludes longitudinal retnforctng. shear reinforcing. and column capacity ratio. All 
graphical output can be printed. 

Thc tabular output can be sa\'ed in a file or printed. The tabular output includes 
most of the information which can be displayed. This is generated for added con­
venience to thc des1gner. 

The member specific detailed design mformation shows the details of the calcula­
tion from the designer's point ofview. lt shows the design forces. desrgn section di­
mensions. reinforccment. and some intermedtate results for all the load combina­
tions at all the design sect10ns of a specific frame member. For a column member, it 
can also show the position ofthe current statc of design forces on the column inter­
action diagram. 
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In the following sections. sorne ofthe typical graphical display. tabular output. and 
member specific detailed design infonnatwn are described. Some of the destgn in­
fonnauon is specific to the chosen concrete design codes which are aYailable in the 
program and are only described where required. The ACI 318-95 design code ts de­
scribed in the Jater pan ofthis chapter. For all other codes. the destgn outputs are 
similar. 

Graphical Display of Design Output 
The graphical output can be produced either as color screen display or in gray­
scaled printed fonn. Moreover. the active screen dtsplay can be sent directly to the 
printer. The graphical display of design output includes input and output design in­
fonnation. 

Input design infonnation. for the ACI 318-95 code. me ludes 

Oesign sectwn la beis. 

K -factors for majar and minar direction of buckhng. 

U nbraced Length Ratios, 

e m- factors. 

Live Load Reduction Factors, 

o, -factors, and 

8, -factors. 

The output design infonnation which can be displayed is 

• Longitudinal Reinforcing, 

Shear Reinforcing. and 

Column Capacity Ratios. 

The gr&phical displays can be accessed from the Design menu. For example. the 
longitudinal reinforcement can be displayed by selecting Display Design Info ... 
from the Design menu. This will pop up a dialog box called Display Design 
Results. Then the user should switch ON thc Design Output option button (de­
fault) and select Longitudinal Reinforcing in the drop-down box. Then clicking 
the OK button will show the longitudinal remforcing in the active window. 

The graphics can be displayed in either 30 or 20 mode. The SAP~OOO standard 
view transfonnations are available for all concrete design output dtsplays. For 
switching between 30 or 20 view of graphtcal displays, there are severa! buttons 
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on the main too! bar. Altematively. the view can be set by choosing Set 3D View ... 

from the View menu 

The graphical display in an active window can be printed in gray scaled black and 
whne from the SAP2000 program. To send the graph1ca! output directlv to the 

pnnter, click on the Print Graphics bunon in the File menu. A screen capture of 
the active window can also be made by fol!owing the standard procedure provided 
by the Windows operating system. 

Tabular Display of Design Output 
The tabular design output can be sent directly either toa printer orto a file. The 
printed fonn oftabular output 1s the same as that produced for thc file output with 
the exception that for the pnnted output font size is adjusted. 

The tabular des1gn output includes input and output design infonnation which de­
pends on the design code of choice. For the ACI 318-95 code. the tabular output in­
eludes the·followmg. Al! tab!es ha ve formal headings and are self-explanatory. so 
further description ofthese tables is not given. 

Input design infonnation includes thc fol!owing: 

Concrete Column Property Data 

- Material !abe!. 

Column dimensions. 

- Reinforcement panem. 

Concrete cover. and 

- Bar area. 

Concrete Beam Property Data 

- Materiallabel, 

Beam dimensions. 

Top and bonom concrete cover. and 

- Top and bottom reinforcement areas. 

Load Combmation Multipliers 

Combination name, 

Load types. and 

- Load factors. 
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Concrete Design Element Inforrnation (code dependent) 

Design Section ID, 

- K -factors for majar and minor direction ofbuckling. 

- Unbraced Length Ratios, 

- e m-factors, 

- Live Load Reduction Factors. 

Concrete Moment MagnificatiOn Factors (code dependen!) 

- Section ID, 

- Element Type. 

- Framing Type, 

- o,- factors, and 

- o, -factors. 

The output design information includes the fol!owmg: 

Column Design Information 

- Secuon ID. 

- Station location, 

- Total longitudinal reinforcernent and the goveming load combination, 

- Majar shear reinforcement and the governing load combination. and 

- Minar shear reinforcement and the goveming load combination. 

Beam Design Information 

- Section ID. 

- Station location, 

- Top longitudinal remforcement and the goveming load combination, 

- Bottom reinforcement and the goveming load combination, and 

- Majar shear reinforcement and the goveming load combination. 

The tabular output can be accessed by selecting Print Design Tables ... from the 
File menu. This will pop up a dialog box. Then the user can specify the design 
quantities for which the results are to be tabulated. By default, the output will be 
sent to the primer. If the user wants the output stream to be redirected to a file, 
he/she can check the Print to File box. This wil! provide a default filename. The 
default filename can be edited. Altemauvely, a file hst can be obtained by clicking 
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the Filo l\ ame button toe hose a file from. Then chcking the Oh: button will dircct 
thc tabular output to the requested srream- the file or the primer. 

Member Specific lnformation 
The member spccific design information shows the dctails of the calculation from 
the designer's point of view. lt provtdes an access to the geometry and material 
data. other input data. design forces. design section dunensions. rcinforcement de­
tails. and somc ofthe inten11ediate resulrs for a mcmber. The design detail mforma­
tion can be dtsplayed for a spccific load combination and for a specific station o fa 
frame member. For a column mcmber. it can al so show the position ofthe current 
state of dcstgn forces on the column interaction dtagram. 

The detailed design information can be accessed by right clicking on the desired 
frame member. This will pop up a dialog box called Concrete Design lnformation 
which includes thc following tabulated infonnatton for the spccific mcmber. lfthc 
selected membcr is a column. thc dialog box includes 

- Load combmation ID. 

- Station location. 

- Longitudinal reinforcement area, 

- M~!or shear reinforcemcnt area. and 

Minor shear reinforcement arca. 

Ifthe selected member is a bcam. the dtalog box includes 

- Load combination ID, 

- Statton location, 

- Top remforcement area. 

- Bottom reinforcement area. and 

- Shear reinforcement area. 

Additional informa non can be accessed for column members bv clicking on the Re­
Design. Details. and lnteraction buttons in the dtalog box. For beams additional 

informa non can be accessed by clicking on the RoDosign and Details buttons in the 
dialog box. 

Additional mformation that is available by clicking on the RoDesign button is as 
follows: 
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Design Factors (code dependen!) 

- Effective length factors, K, for major and m mor dlfection of bucklmg. 

- Unbraced Length Ratios, 

- e m-factors, 

- Ltve Load Reduction Factors, 

- li,-factors. and 

- o, -factors. 

• Element Section ID 

Element Framing Type 

Additional information tha1 is available by cltcking on the Details button IS gtven 
below. The details ofthis information depends on whetherthe selected member is a 
beam ora column. lfthe member is a column, the information mcludes: 

Frame. Section. Station, and Load Combination !Ds, 

Section geometric information and graphical representation, 

Material properties of steel and concrete, 

Design axial force and biaxial moments, 

Minimum design moments, 

Moment factors, 

Design shear forces, and 

• Shear capacities of concrete and steel. 

lfthe member is a beam. the information includes: 

Frame, Section. Station, and Load Combination !Ds, 

Section gcometric infonnat10n and graphical representation, 

Material properties of steel and concrete, 

Design moments and shear forces, 

• Minimum design moments, 

Top and bottom reinforcing areas, 

Shear capacities of concrete and steel, and 

Shear reinforcmg area. 
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Clicking on the lnteraction button displays the interaction diagram in a three di­
mensional space for thc column section. The design axial force and the btaxial mo­
ments are plotted on the mteraction diagram to show the statc of stress 111 thc col­
umn. The mtcractwn dtagrarn can be viewed m any orientatiOn and thc \'Íew can be 
manipulated from the interaction dialog box. The interaction dtagram can be 
printed for hard-copy output. 
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Chapter 1 

lntroduction 

Overview 
SAP2000 features powerful and completely integrated modules for design ofboth 

. steel and reinforced concrete structures. The program provides the user with op­
tions to create, modify, analyze and design structural models. all from within the 
same user interface. The program is capable of performing initial member sizing 
and optimization from within the same interface. 

The program provides an interactive environment in which the user can study the 
stress conditions, make appropriate changes, such as revising member properties, 
and re-examine the results without the need to re-run the analysis. A single mouse 
click on an element brings up detailed design information. Members can be 
grouped together for design purposes. The output in both graphical and tabulated 
formats can be readily printed. 

The program is structured to support a wide variety of design codes for the auto­
mated design and check of steel frame members. The program currently supports 
the following steel design codes: U.S. ASD and LRFD (AISC 1989, AISC 1994), 
Canadian (CISC 1995), British (BSI 1990), and European (CEN 1992). 

The design is based upon a set of user-specified loading combinations. However, 
the program pro vides a set of default load combinations for each design code sup· 

Overview ·.1 
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ported in SAP2000. Ifthe default load combinations are acceptable, no definition of 
additionalload combination is required, 

In the design process the program picks the least weight section required for 
strength for each element to be designed, from a set ofuser specified sections. Dif­
ferent sets of available sections can be specified for different groups of elements. 
Also severa! elements can be grouped to be designed to have the same section. 

In the check process the program produces demandlcapacity ratios for axial load 
and biaxial moment interactions and shear. The demandlcapacity ratios are based 
on element stress and allowable stress for allowable stress design, and on factored 
loads (actions) and factored capacities (resistances) for !imit state design. 

The checks are made for each user specified ( or program defaulted) load combina­
tion and at severa! user controlled stations along the length of the element. Maxi­
mum demandlcapacity ratios are then reported andlor used for design optimization. 

All allowable stress va!ues or design capacity values for axial, bending and shear 
actions are calcu!ated by the program. Tedious calculations associated with evalu­
ating effective length factors for col umns in moment frame type structures are auto-
mated in the algorithms. · 

The presentation ofthe output is clear and concise. The information is in a form that 
allows the designer lo take appropriate remedia! measures ifthere is member over­
stress. Backup design information produced by the program is also provided for 
convenient verification of the results. 

Special requirements for seismic design are not implemented in the curren! version 
ofSAP2000. 

English as well as SI and MKS metric units can be used lo define the model geome­
try and lo specity design parameters. 

Organization 
This manual is organized in the fo!lowing way: 

Chapter II pro vides a quick tutorial aimed at giving the first time users hands-on ex­
perience. Severa! ofthe basic features ofthe SAP2000 steel design modules are ex­
plored in this tutorial. 

Chapter Ili outlines various aspects ofthe steel design·procedures ofthe SAP2000 
program. This chapter describes the common terrninology of steel design as imple­
mented in SAP2000. 

2 Organization 
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Ea eh of the subsequent chapters gives a detailed description of a specific code of 
practice as interpreted by and implemented in SAP2000. Each chapter describes the 
design loading combinations to be considered: allowable stress or capacity calcula­
tions for tension, compression, bending, and shear; calcu!ations of demand/capac­
ity ratios; and other special considerations required by the code. 

Chapter IV gives a detailed description ofthe AISC ASO code (AISC 1989) as im­
plemented in SAP2000. 

Chapter V gives a detailed description ofthe AISC LRFD code (AISC 1994) as im­
plemented in SAP2000. 

Chapter VI gives a detailed description ofthe Canadian code (CISC !994) as imple­
mented in SAP2000. 

Chapter VII gives a detailed description ofthe British code BS 5950 (BSI 1990) as 
implemented in SAP2000. 

Chapter VIII gives a detailed description ofthe Eurocode 3 (CEN 1992) as imple­
mented in SAP2000. 

Chapter IX outlines various aspects of the tabular and graphical output from 
SAP2000 related to steel design. 

RecommendedReading 
lt is recommended that first time users follow the steps ofthe "Quick Tutorial" in 
Chapter 11 and read Chapter III "Design Algorithms" and the Chapter correspond­
ing to the code ofinterest to the user. Finallythe user should read "Design Output" 
in Chapter IX for understanding and interpreting SAP2000 output related to steel 
design. 

Recommended Reading 3 
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Chapter 11 

Quick Tutorial 

Overview 
Severa! of the basic features of the SAP2000 steel design module are explored in 
this tutorial. This introduction is aimed at giving the first time users hands-on expe­
rience. The program allows you to select from severa! U.S. and intemational codes 
to stress check and design a steel structure. It is assumed that you haYe a working 
knowledge of steel design procedures and are reasonably familiar with the curren! 
codes ofpractice and their underlying design concepts. A comprehensive on-line 
Help is included in the program for your quick reference. 

We will access the SAP2000 commands from both the Toolbar and from the 
menus. The Toolbars, however, provides quick access to most commonly used fea­
tures available from the menus. 

In the assignment sequence, there are two importan! points you must remember. 
First, you have to defme an entity before you can assign an attribute to it, and sec­
ond, you have to select member(s) before you can assign new anributes or modify 
old ones. 

Overview 5 
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Description of the Model 
The structure is a two-story, two-by-three bay office building. The frame will be 
designed in accordance with the AISC-LRFD93 code. Earthquake induced force is 
considered in the analysis and design ofthis frame. However. special requirements 
for the design of moment resisting ductile steel frames are not currently imple­
mented in SAP2000. 

Geometry 

The moment frame is ofstructural steel as shown in Figure Il-1. The second tloor 
has metal deck and lightweight concrete fill, whereas the roofhas metal deck only. 
Typical story height is taken as 13'0'. The initial member sizes are given in Figure 
Il-1. 

Material Properties 

Material specifications are: 

Beams and girders: ASTM A36 (F, =36ksi) 
Columns: ASTM A572 (~. =50 ksi) 

Load Cases 

Four load cases are considered in the analysis- DL, LL, QX. and QY. The dead 
and live loads are defined as the load cases DL and LL respectively. The lateral 
seismic loads, in turn, are designated as the load cases QX and QY. 

The dead and live loads are applied as beam span loads based on the loading inten­
sities given below: 

Roof Dead load = 30 psf 
Live load = 20 psf 

Floor Dead load = 75 psf 
Live load = 80 psf 

Wall Dead load = 15 psf 

Equivalen! static seismic forces are applied as lateral joint loads in the global X and 
global Y directions, separately. The total base shear in each direction is computed 
as 51 kips. 

6 Description of !he Model 
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Loading: 

Roof Oead load 
Uve load 

Floor Dead load 
Uve load 

Extenor Wall 

AIJ columns are W14x132 

Transversa Elevation 

= 30 psf 
= 20 psf 
= 75 psf 
= 80 psf 
= 15 psf 

Figure II-1 

Steel Grades: 

For beams Fy = 36 ksi 
For columns Fy = 50 ksi 

Description ofthe Model (Tutorial Example) 

Description of !he Model · 7 
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A11alysis 

Two diaphragm constraints are applied for the two diaphragms at the two f!oor lev­
els. These constraints preven! in-plane relative displacements of the nodes at each 
floor. The lateral earthquake loads are applied at nodal points on the floor Ievels. A 
P-.:l analysis is carried out wíth a load combination of 1.2 DL + 0.5 LL as described 
in Chapter "Check!Design for AISC-LRFD93". The initial unbraced length is taken 
as the full member length. 

Desig11 

The stress check and design are performed in accordance with AISC-LRFD93. 
Kip-in units are used. The input data file for this model is EXSTL.SDB. This is 
supplied as part of the SAP2000 package. 

Starting the Tutorial 
A step-by-step procedure for the stress check and design of the model is outlined 
below. lt is recommended that you actually perform these steps while reading this 
chapter. We assume that you have successfully started the program. You can do this 
by running SAP2000 from the Start Menu ofthe Windows operating system. 

In this tutoría! we will typically use the Toolbars to access varíous options quickly. 
Most ofthe features available on the Toolbars can also be accessed from the Menu 
Bar. Use the on-line Help or refer to the "SAP2000 Getting Started" (CSI 1997a) 
manual for a detailed descríption of the SAP2000 screen. 

The input data file for the model (EXSTL.SDB) is in the EXAMPLES subdirectory 
under the directory where the program has been installed. A section property file of 
name SECTIONS.PRO is also required for the tutoría!. The SECTJONS.PRO file 
is also available in the directory where the program has been installed. 

Opening the Model Database File 

l. Click on the Open button in the File menu. This will display the Open Model 
File dialog box. 

2. In this dialog box: 

Select the EXSTL.SDB file. 

Click on the Open button. 

8 Staning the Tutorial 



/ 

Chapter 11 Quick Tutorial 

The screen will now show two vertically-tiled windows. The left window displays a 
plan view of the model at leve!+ 312 in. Section labels are displayed in this view. A 
three-dimensional view ofthe model is shown in the right window. Element and 
node !Ds are shown in this view. In addition, a floating toolbar is displayed al the 
bottom ofthe main window along with the main toolbar at the top ofthe window. 

" 

• 

{ 
' 

Note: When working with mu/tiple windows, clicking anywhere in a particular win­
dow wi/1 aCtivare that window. 

Before we proceed further, we will make a copy ofthe data file by saving the model 
under a new name, say, TUTOR2.SDB. We will use this copy during the tutorial 
and leave the original file unaltered. 

3. From the File menu, choose Save As .... This will display the Save Model File 
As dialog box. 

4. In this dialog box: 

• Enter new filename, Tutor2.SDB. 

Note: E ven if yo u do not type in the extension .SDB, the program automati­
cal~v appends this extension to the jilename. 

Click on the Save button. 

The new name is displayed in the Main Title Bar. 

Opening the Model Database File 9 
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Analyzing the Model 
We will now ánalyze the model. Before analyzing ihe model we need to set the P-t> 
force (1.2 DL + 0.5 LL) and other parameters for P-tl analysis. Todo this: 

l. Select the Set Options •.. menu item in the Analyze menu. This will immedi­
ately bring up the Analysis Options dialog box. In this dialog box: 

Click the lnclude P-Delta check box. 

• Click on the Set P-Delta Parameters button. This will bring up the P­
Delta Parameters dialog box. In this dialog box: 

- Set maximum iteration to 5. 

Change the DL scale factor to 1.2 and click Modify. 

- Click on the Load Case drop down arrow. 

- Select LL. 

- Change the LL scale factor to 0.5 and click Add. 

- Click OK to close the P-Delta Parameters dialog box 

• Click OK to close the Analysis Options dialog box. 

2. Click on the Run Analysis button from the main toolbar. 

A top window is opened in which various phases of analysis are progressively re­
ported. When the analysis is complete the screen will display the following: 

ltiiiiT IOJJT•fO.CI 011TIOT U114<4J 

1 O Analyzing lhe Model 
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3. Use the scroll bar in the top window to review the anaiysis messages and to 
check for any error or warning messages. In our case there shouid be none. 

4. Ciick on the OK button in the top window to ciase it. This will respond by dis­
playing the deforrned shape in the right window for the first load case (DL). 

" 

' l . 

! 
' 

The floating tooibar occupies soine of the display area. To gel it back, move the 
floating tooibar below the SAP2000 main window. 

Selecting the Design Code 
The default design code is AISC-ASD89 for design of steel structures. To choose 
the AISC-LRFD93 design code, do the following: 

l. Click on Preferences ... from the Options menu. This will launch the 
Preferences diaiog box. 

2. In the dialog box click on the Steel tab. You can see the currently seiected steel 
design code, default section property file, and sorne other options as shown be­
iow. 

3. You need to change the default design code (AISC-ASD89) to AISC-LRFD93. 
todo this: 

Ciick on the drop down arrow in the design code box. 

Select the AISC-LRFD93 design code. 

Selecting the Design Code 11 
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4. Click on the OK button to close the dialog box. 

5. To make sure that SAP2000 will design the steel members, select Steel Design 
menu item from the Design menu. 

Starting Design and Stress Check 
With the analysis phase and selection of design code completed, we will now exam­
ine member stress ratios using the requirements of AISC-LRFD93. 

l. From the Design menu, choose Start Design/Check of Structure. The pro­
gram now calculates the interaction ratios for each ofthe steel frame members . 
. (If we had selected sorne of the frame members, then stress ratios would ha ve 
been calculated for only the selected frame members). In a few moments the 
color-coded stress ratios are displayed for each member. By default, these are 
the axial force-moment interaction ratios which, according to the code, should 
not exceed 1.0. In the display, the stress ratios are reported fór the governing 
design load combination. 

Note: Since no load combinations were defined in the model, SAP2000 design auto­
matically provided a set of design load combinations Jor the selected design code 
(AISC-LRFD93 for Stee/). The defaultload combinations can be added by any of 
the three following ways. 

12 Staning Design and Stress Check 
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- Clicking Add Default Load Combinations in the Load Combinations dia­
/og box /aunchedfrom the Define menu by c/icking Define Load Combina­
tions. 

Cliding Select Design Combos ... from the Design menu when there are no 
design load combinations defined in the model. 

- Clicking Start Design/Check of Structure from the Design menu when there 
are no design load combinations dejined in the mode/. 

2. Right click on a member, say the beam on gridline A, lines 1-2 (element ID 
38). See Figure 11-1 on page 7 and the screen above. This will open the Steel 
Stress Check lnformation dialog box showing stress ratios at various stations 
along the element length for different load combinations. The dialog box also 
shows information regarding the structural section (W 1 8x50) assigned to !he 
member. The largest stress ratio is highlighted in this box. The dialog box also 
can show information regarding !he Details of calculation for design and the 
element overwrite assignments for ReDesign for the selected member. 

Starting Design and Stress Check · 13 
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3 .. In this dialog box: 

Select a design check station by clicking once (select the default high­
lighted one by doing nothing). 

Click on the Details button. This will open the Steel Section Design de­
tailed infonnation window showing the steel section design parameters in­
cluding the member identification, geometric parameters, material proper­
ties, nominal strength values, the factored member forces for the selected 
load combination, and other design parameters at that particular station. 
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• Close the Steel Section Design information window. 

4. Click on the ReDesign button on the Steel Stress Check Information dialog 
box. This will open the Element Overwrite Assignments information dialog 
box showing the input design factors including the K factors, Cm factors, etc. 
These factors can be edited for redesigning. See screen below. There is al so an 
alternate way ofeditingthe properties ofa set ofmembers which will be dem­
onstrated in the next section "Modifying Member Properties of a Group". 

• Click on the Cancel button to close the Element Overwrite Assignments 
information dialog box. 

• Click on the Cancel button to close the Steel Stress Check Information 
dialog box. 

Note: The number of stations (number of segments + 1) used in the design and 
stress check is set by the user through Frame and Output Segment menu items 
from the Assign menu prior ro the analysis phase. The defau/t number ofsegments 
is 4 for beams and 2 for co/umns. 

At this point we have analyzed and designed the steel frame and reviewed sorne of 
the design information. SAP2000 allows you to interactively change the design 
code, member properties, rernove or add new load ccímbinations, etc. and re-run the 
analysis and design phases. As a demonstration in the tutorial, we will edit/change a 
member property for a set of frame members. 

Starting Design and Stress Check 15 
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Modifying Member Properties 
With the analysis and stress check successfully completed, we will now modify the 
lateral unsupported length of all the beams and girders because the stress ratios are 
greater than l for sorne of the beams and girders and 1/ r > 200 for many of the 
beams. Initially, in the design check, the unbraced length of each member was 
taken to be the member full length in both the major and minor directions, i.e. 
1" = /33 =L. However, the secondary beams ofthe floor structure pro vide restraints 
against lateral displacement of the compression flange. Referring to Figure II-l 
(page 7) we will take the minor direction unbraced length, /21 , of every beam span­
Íling N-S (Y-Y) as 33% of the actual length. Likewise, for beams spanning E-W 
(X-X), /

01 
is assumed to be 25% of the actual length. In order to make these 

modifications we will change the view in the right window to make all the beams 
visible for selection. Notice that this window is currently showing the stress ratios 
from the previous check in a 3D view. 

l. Click on the 2D View (xy) button on the main toolbar. 

2. Click on the Perspective Toggle button on the main toolbar. 

! ' 
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Now, with all the beams visible, we can select beams and modify their lateral un­
braced lengths. 

3. To select the N-S (Y -Y) beams do the following: 

• Click the Set lntersecting Line Select Mode button on the Floating Tool­
bar. 

16 Modifying Member Properties 
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• Move the pointer to the left ofthe beam on line l, hay A-B. 

• Click and hold down the left mouse button. 

• While holding, move the pointer to the right intersecting al! the beams in 
the hay between lines A and B. A "rubber-band line" in the Y-Y direction 
will show !he intersecting line. 

Release the left mouse button to select al! members that intersect this line. 
The message area at the bottom-left comer of SAP2000 responds by show­
ing that 8 Frames Selected. 

Note: To select al/ the N-S beams we have to do this operation (Step 3) 
twice: once, foral/ the beams be Meen lines A and B. and once for beams 
spanning between lines B and C. 

The selection of al! N-S beams is now complete. The selected members appear as 
dashed lines. 

'"l"f'Q 1 lb 1 iif ffli' 'hit ii!Ril 'eh! 

.... ~~~~"-'· ~- ~- .t . .:~~>~ 
~~ ~ ~ H r ¡ 
~Johid. 

¡¡ ... 1 <bl>k~ ••• l ! \j 
~' :á =S ~ ... ~ 

f l...- í w ~~~.,~ ~~ .. tt" ... •m 

... ,!~-·onza,.4N o.~ 

4. From the Design menu, choose the menu item ReDefine Element Design 
Data .... This will display the Element Overwrite Assignments dialog box. In 
this dialog box: 

Check the Unbraced Length Ratio, L22 box in the Design factors area. 

Replace 1 by 0.33. 

Modifying Member Properties 17 
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,15, .. v .. 

Note: The Design Factors shown in this dia/og box are code-dependent. 

• Click on the OK button to accept the unbraced length ratio. 

Click on the Refresh Window button from the main toolbar. Notice that as 
a result ofusing shorter unsupported lengths, the stress ratios in these par­
ticular members have decreased significantly. 

5. Repeat Steps 3 and 4 to modifY al! the E-W (X-X) beams, except en ter the un­
braced length ratio as 0.25. 

6. The stress ratios after redefining the unbraced member length can be made 
more visible in the 3D display. Click 3D View button on the main toolbar. 
Compare the following display with the one on page 13. 

18 Modifying Member Properties 
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Selecting Sections Automatically 
After changing !he unbraced length, most ofthe beam members are found to be un­
derstressed except only 3 members which are overstressed. These three over­
stressed members are color coded with red. As an exercise, we will select sections 
for sorne ofthese overstressed members automatically. 

These three overstressed beams are identified by element numbers 31, 33, and 35. 
Currently all of these members ha ve a W!Sx35 section. If we gradually replace 
these sections with larger ones, the stress ratio can be made el ose to 1 but less than 
l. Wl8x50 section will satisfy the requirements. Instead we will do an exercise 
showing automatic selection of members. 

In the right side window, where the steel stress ratios are displayed in a 3D view: 

• Select these three overstressed members, which are color coded with red, by 
clicking on them one by one. 

• Unlock the model by clicking on the Lock!Unlock Model from the mailtool-
bar. · 

- This will prompt a dialog box asking "Unlocking rnodel will delete analy­
sis results! OK to delete?". Click O K. 

• Click on the Frarne Sections ... in the Define menu. This will bring up a Define 
Frame Sections dialog box. This dialog box shows the available sections in the 
model. We will make sorne more sections available for !he model so that the 

Selecting Sections Automatically 19 
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program can choose the automatically selected section from a wider group. 
Since the W 18x35 is too big for sorne members, we will add sorne smaller sec­
tions. especially wide flange sections with 12 inch depth. for the domain of 
AUTO section. To achieve this, in this dialog box: 

Click on the lmport pul! down arrow. 

- Scroll through the sections and choose lmport 1/Wide Flange. Tbis will 
bring a Section Property File dialog box. In this dialog box, the default 
section property files are listed. 

- Select the default section property file Section.pro. 

- Click Open to open the file Sections.pro. This will show a list of available 
Wide Flange sections. 

- Scroll down through the sections and select Wl2x96 by clicking. Scroll 
down through the sections again and select Wl2xl4 by holding down the 
Shift Key and clicking. This will select all the sections ranging from 
WI2x96 to Wl2xl4. 

- Click OK to clase the Sections.pro file. The response will be a display of 
inforrnation in the 1/Wide Flange Sections dialog box about the last se­
lected section, i.e., Wl2xl4. 

- Click OK in the 1/Wide Flange Sections dialog box. This will complete 
importing the newly selected sections into the model from th~ database. 
The imponed sections are added to the Frame Sections list in the Define 
Frame Sections dialog box. 

- Click on the Add pull down arrow in the Define Frame Sections dialog 
box. 

- Scroll through the sections and choose Add Auto Select. This will bring an 
Auto Selection Sections dialog box. In this dialog box. the default domain 
ofthe Auto Sections is listed. You can edit the list by adding and deleting 
new sections. Scroll through the sections down to Wl4x 132 and select it by 
clicking. The Remove button is highlighted. Click on the Remove button 
to remove this specific section from the domain ofthe auto section because 
the Wl4xi32 is specifically used in this model for columns. The default 
name ofthe auto section is given as AUTO!. Click OK to accept the de­
fault name and the list of sections. 

- Click the OK button to clase the Define Frame Sections dialog box. 

Click on the Assign menu, select the Frame menu item, and then select Sec­
tions .... Tbis will open the Define Frame Sections dialog box. In this dialog 

20 Selecting Sections Automatically 
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box you select AUTOI and then click O K. This will change the display recog­
nizing that the selected members have AUTOI section. 

Reanalyze the model by clicking on the Run Analysis button on the main tool­
bar. Click OK to close the top window. 

• Recalculate the stress ratio by clicking on the Start Design/Check of Struc­
ture menu item in the Design menu. This will respond by displaying new 
stress ratios on a 3D View in the right window. 

. -:-:- ... -~--
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No ti ce that as a result of changing the section, the stress ratios for those particular 
beams are changed. To see the difference, compare this display with the one on 
page 19. 

• To see the newly selected sections, click on the Display Design lnfo ... menu 
item in the Design menu. This will bring up the Display Design Results dialog 
box. In this dialog box, select the Design Input option bunon, accept the De­
sign Sections from the Design Input drop down lis! item. and click O K. This 
will show the newly selected sections on the 3D view at the right window. 

Selecting Sections Automatically 21 
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Note: The displayed sections are the design sections. Ana(rsis sections cana/so be 
displayed by clicking on the Set Elements button on the m a in too/bar and clicking 
on the Sections check boxfor Frames on the Set Elements dialog box. 

Re-analyzing with Updated Elements 
lt is imponant to realize that changes made to member section propenies in the 
stress/design phase are not automatically reflected in the analysis results. These 
changes are only local to the post-processing phase unless a re-run ofthe analysis, 
with updated elements, is requested by the user. In other words, overwriting the 
section propenies only affects the stress values and not the factored element forces 
obtained in the analysis preceding such changes. The redistribution of member 
forces dueto change ofstiffness (revision ofsection propenies) is effected in a re­
run of analysis. We need to refresh the analysis model, reanalyze the model, and re­
design the structure. Todo this: 

• In the Design menu click on the menu ítem Update Analysis Sections. This 
will prompt a dialog box asking "Updating Analysis Section will unlock 
model! OK to update?". Click O K. 

• From the Analyze menu, choose Ruo. This will immediately stan the analysis 
procedure. A top wmdow is opened in which various phases ofanalysis are pro­
gressively displayed. The results will obviously differ from those produced in 
the initial analysis because ofthe change ofsection propenies we made in the 
design stage. Click OK to close the top window. 

22 Re-analyzing with Updated Elements 
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Click on the Start Design/Check of Structures from the Design menu. This 
will redesign the structure and display the new stress ratios. 

Click on the Replace Auto w/Optimal Sections menu item from the Design 
menu. 

- This will ask "Replacing Analysis Sections with Au10-Selected Sections 
will unlock model! OK to replace?". Click OK to replace. 

Note: Once yo u are satisjiedwith the selected sections. se/ecling rhe Replace Auto 
w/Optimal Sections menu item will permanant/y replace the auto sections with 
the currenr deszgn sections. This effectively replaces the analysis sections with rhe 
optzmal design sections and removes the auto tag. Soselecting this m en u item is one 
ofthe last things you should do. 

You can see the difference after re-running the design based on the lates! analysis 
results. 

Concluding Remarks 
We ha ve cometo the end ofthis tutorial on the SAP2000 steel design options. The 
intent has been to highlight and demonstrate a few ofthe basic features in arder to 
open up the path for yo u to explore and use the more advanced options. For more in­
formation on various tapies consult the on-Iine Help provided. 
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Design Algorithms 

This chapter outlines various aspects of the steel check and design procedures that 
are used by the SAP2000 program. The steel design and check may be performed 
according to one ofthe fol!owing codes of pracuce. 

American lnstitute ofSteel Construction 's "Allowable Stress Design and Plas­
tic Design Specification for Structural Steel Buildings", AISC-ASD (AISC 
1989). 

American Institute of Steel Construction's "Load and Resistance Factor De­
sigo Specitication for Structural Steel Buildings", AISC-LRFD (AISC 1994). 

Canadian lnstitute ofSteel Construction's "Limit S tates Design ofSteel Struc­
tures", CAN/CSA-516.1-94 (CISC 1995). 

• British Standards lnstitution's "Structural Use of Steelwork in Building", BS 
5950 (BSI 1990). 

• European Committee for Standardization's "Eurocode 3: Design of Steel 
Structures- Part 1.1: General Rules and Rules for Buildings", ENV 1993-1-1 
(CEN 1992). 

Details of the algorithms associated with each of these codes as implemented in 
SAP2000 are described in subsequent chapters. However, this chapter provides a 
background which is common to al! the design codes. 
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It is assumed that the user has an engineering background in the general area of 
structural steel design and familiarity with at least one of the above mentioned de­
sign codes. 

For referring to pertinent sections ofthe corresponding code, a unique prefix is as­
signed for each code. For example, all references to the AISC-ASD89 code carry 
the prefix of"ASD". Similarly, 

- References to the AISC-LRFD93 code carry the prefix of "LRFD" 

- References to the Canadian code carry the prefix of "CISC" 

- References to the British code carry the prefix of"BS" 

- References to the Eurocode carry the prefix of"EC3" 

Design Load Combinations 
The design load combinations are the various combinations of the load cases for· 
which the structure needs to be designed/checked. The load combination factors to 
be used vary with the selected design code. The load combination factors are ap­
pl ied to the forces and moments ob¡¡iined from the associated load cases and are 
then summed to obtain the factored design forces and moments for the load combi­
nation. 

For multi-valued load combinations involving response.spectrum, time history, 
moving loads and multi-valued combinations (oftype enveloping, square-root of 
the sum ofthe squares or absolute) where any correspondence between interacting 
quantities is lost, the program automatically produces multiple sub combinations 
using maximalminima perrnutations of interacting quantities. Separate combina­
tions with negative factors for response spectrum cases are not requiied beca use the 
program automatically takes the minima to be the negative ofthe maxima forre­
sponse spectrum cases and the above described perrnutations genera! e the required 
sub combinations. 

When a design combination involves only a single multi-valued case of time his­
tory or moving load, further options are available. The program has an option to re­
quest that time history combinations produce sub combinations for each time step 
ofthe time history. Al so an option is available to request that moving load combina­
tions produce sub combinations using maxima and minima of each design quantity 
but with corresponding values of interacting quantities. 

For norrnalloading conditions involving static dead load, live load, wind load. and 
earthquake load, and/or dynamic response spectrum earthquake load, the program 
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has built-in default loading combinations for each design code. These are based on 
the code recommendations and are documented for each code in the corresponding 
chapters. For other loading conditions involving moving load, time history, pattem 
live loads, separa te consideration of roof live load, snow load, etc., the user must 
define design loading combinations either in lieu of or in addition to the default de­
sign loading combinations. 

The default load combinations as sume all static load cases declared as dead load to 
be additive. Similarly, all cases declared as live load are assumed additive. How­
ever, each static load case declared as wind or earthquake, or response spectrum 
cases, are assumed to be non additive with each other and produce multiple lateral 
load combinations. Also wind and static earthquake cases produce separate loading 
combinations with the sense (positive or negative) reversed.lfthese conditions are 
not corree!, the user must provide the appropriate design combinations. 

The default load combinations are included in design ifthe user requests them to be 
included or if no other user defined combination is available for steel design. lf any 
default combination is included in the design, then all default combinations will 
automatical.Jy be updated by the program any time the design code is changed or if 
static or response spectrum load cases are modified. 

Live load reduction factors can be applied to the member forces ofthe live load case 
on an element-by-element basis to reduce the contribution of the !ive load to the 
factored loading. 

The user is cautioned that if moving load or time history results are not requested to 
be recovered in the analysis for sorne or all frame members then the effects of these 
loads will be assumed to be zero in any combination that includes them. 

Design and Check Stations 
For each load combination, each element is designed or checked ata number oflo­
cations along the length ofthe element. The locations are based on equally spaced 
segments along the clear length of the element. The number of segments in an ele­
ment is requested by the user befare the analysis is made. The user can refine the de­
signa long the length of an element by requesting more segments. 

Element Stress Ratios 
For ea eh element, the axial force/biaxial moment stress ratios as well as shear stress 
ratios are calculated for each station along the length of the member for each load 
combination. The actual member stress components and corresponding allowable 
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stresses are calculated. Then, the stress ratios are evaluated according to the code. 
The controlling compression and/or tension stress ratio is then obtained, along with 
the corresponding identification of the station, load combination, and code­
equation. A stress ratio greater than 1.0 indica tes an overstress or exceeding a 1 imit 
state. 

P-L1Effects 
The SAP2000 design algorithms require that the analysis results include the P-.C. ef­
fects. The P-.C. effects are considered differently for "braced" or "nonsway" and 
"unbraced" or "sway" columns or frames. For the braced columns, the effect ofP-.C. 
is limited to "individual member stability". For unbraced frames, "lateral drift ef­
fect" should be considered in addition to individual member stability effect. 

For the individual member stability effects. the moments are magnified with mo­
ment magnification factors as in the AJSC-LRFD code orare considered directly in 
the design equations as in the Canadian, British, and European codes .. 

For lateral drift effects of unbraced or sway frames, SAP2000 assumes that the am­
plification is already included in the results because P-.C. effects are considered .. 

Users should be aware that the default analysis option in SAP2000 is OFF for P-.C. 
effect. The default number of iterations for P-.C. analysis is l. The user should turn 
the P-.C. analysis ON and set the maximum number ofiterations for the analy­
sis. For further reference, the user is referred to "SAP2000 Reference Manual" 
(CSI 1997b). 

The user is also cautioned that SAP2000 currently considers P-.C. effects dueto axial 
loads in frame members only. Forces in othertypes ofelements do not contribute to 
this effect. Jf significan! forces are present in other types of elements, for example, 
large axialloads in shear walls modeled as shell elements, then the additional forces 
computed for P-.C. will be inaccurate. 

Element Unsupported Lengths 
To account for column slenderness effects the column unsupported lengths are re­
quired. The two unsupported lengths are 133 and 1

02
• See Figure IJI-1. These are the 

lengths between support points ofthe element in the corresponding directions. The 
length 133 corresponds to instability about the 3-3 axis, and 1, corresponds to insta­
bility about the 2-2 axis. The length 1::: is also used for lateral-torsional buckling 
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caused by major direction bending (i.e., about the 3-3 axis). See Figure Ill-2 for cor­
respondence between the SAP2000 axes and the axes in the design codes. 

Normally, the unsupported element length is equal to the length ofthe element, i.e., 
the distance between END-1 and END-J of the element. See Figure III-1. The pro­
gram, however, allows users to assign severa] elements to be treated as a single 
member for design. This can be done differently for major and minor bending. 
Therefore, extraneous joints as shown in Figure III-3 that affect the unsupported 
length of an element are automatically taken into consideration. 

Axis 1 

1 
Figure III-1 

Majar and Minar Axes af Bending 

In determining the values for 100 and 133 of the elements, the program recognizes 
various aspects ofthe structure that ha vean effect on these lengths, such as member 
connectivity, diaphragm constraints and support points. The program automati­
cally locates the element support points and evaluares the corresponding unsup­
ported element length. 

Therefore, the unsupported length of a column may actual! y be evaluated as being 
greater than the corresponding element length. lf a beam frames into only one di­
rection ofthe column, the beam is assumed to give lateral support only in that direc­
tion. 
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The user has options to specify the unsupported lengths of the elements on an 
element-by-element basis. 

y y 

AISC (ASD89 & LRFD95) CISC95 

Figure III-2 

y 

BS5950 

z 

EUROCODE 3 

Correspondence between SAP2000 Axes and Code Axes 

Effective Length Factor (K) 

The column K -factor algorithm has been developed for building-type structures, 
where the columns are vertical and the beams are horizontal, and the behavior isba­
sically that of a moment-resisting nature for which theK -factor calculation is rela­
tively complex. For the purpose of calculating K -factors, the elements are identi­
fied as columns, beams and braces. Al! elements parallel to the Z-axis are classified 
as columns. Al! elements paral!el to the X-Y planeare classified as beams. The rest 
are braces. 

The beams and braces are assigned K -factors of unity. In the calculation of the 
K -factors for a column element, the program first makes the fol!owing four stiff­
ness summations for each joint in the structural model: 

S a= I( E¡~' l 
sq = I(E¡~, 1 

30 Effective Lenglh Factor (K) 
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where the x and y subscripts correspond to the global X and Y directions and the e 
and b subscripts referto column and beam. The local2-2 and 3-3 terms El, 1 ¡ __ and 

El 33 1/33 are rotated to give components· along the global X and Y directions to form 

the ( E/11). and (El/!), val u es. Then for each column, the joint summations at 
END-1 and the END-J ofthe member are transformed back to the column local 1-
2-3 coordina te system and the G-values for END-1 and the END-J of the member 
are calculated about the 2-2 and 3-3 directions as follows: 

G/, = S''" 
S 1 

b::!1 

G1 _S 1
d3 

3]- --

S1 bJJ 

GJ .. .,= S
1

c:u 

- S J '" 

G133 =S
1

"33 

S 1 
bJJ 

Figure III-3 
Unsupported Lengths are not Affected by Intermedia/e Nada/ Points 

lf a rotational release exists at a particular end (and direction) of an element, the 
corresponding value is set to 1 0.0. lf al! degrees of freedom for a particular joint are 
deleted, the G-values foral! members connecting to that joint will be set to 1.0 for 
the end ofthe member connecting to thatjoint. Final! y, if G/ and GJ are known for a 
particular direction, the column K -factor for the corresponding direction is calcu­
lated by solving the following relationship for a: 

Effective Length Factor (K) 31 
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a' G 1 G 1 -36 

6(G 1 +G 1
) 

a 
tan a 

from which K = 1t 1 a. This relationship is the mathematical formulation for the 
evaluation of K factors for moment-resisting frames assuming sidesway to be unin­
hibited. For other structures. such as braced frame structures, trusses, space frames, 
transmission towers, etc., the K-factors for al! members are usually unity and 
shou!d be set so by the user. The fol!owing are sorne importan! aspects associated 
with the column K-factor algorithm: 

• An element that has a pin at the joint under consideration will noten ter the stiff­
ness summations ca!culated above. An element that has a pin at the far end from 
the joint under consideration will contribtite only 50% of the calculated El 
value. Also, beam elements that ha ve no column member at the far end from the 
joint under consideration, such as cantilevers, will not enter the stiffness sum­
mation. 

If there are no beams framing into a particular direction of a co!umn element, 
the associated G-va!ue will be infinity. Ifthe G-va!ue at any one end of a col­
umn for a particular direction is infinity, the K-factor corresponding to that di­
rection is set equal to unity. 

Ifrotational releases exist at both ends of an element for a particular direction, 
the corresponding K-factor is set to unity. 

The automated K-factor calculation procedure can occasionally genera te artifi­
cially high K-factors. specifical!y under circumstances involving skewed 
beams, fixed support conditions, and under other conditions where the program 
may have difficulty recognizing that the members are lateral! y supported and 
K-factors ofunity are to be used. . 

Al! K-factors produced by the program can be overwritten by the user. These 
values should be reviewed and any unacceptable va!ues should be replaced. 

Choice of Input Units 
English as well as SI and MKS metric units can be used for input. But the codes are 
based on a specific system ofunits. Al! equations and descriptions presented in the 
subsequent chapters correspond to that specific system of units un!ess otherwise 
noted. For example, AISC-ASD code is published in kip-inch-second units. By de­
fau!t, al! equations and descriptions presented in the chapter "Check/Design for 
AISC ASD89" correspond to kip-inch-second units. However, any system ofunits 
can be used to define and design the structure in SAP2000. 
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Check/Design for AISC-ASD89 

This chapter describes the details ofthe structural steel design and stress check al­
gorithrns that are used by SAP2000 when the user selects the AISC-ASD89 design 
code (AISC 1989). Various notations used in this chapter are described in Table 
IV-l. 

The design is based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
sign of most building type structures. 

In the evaluation ofthe axial force/biaxial moment capacity ratios ata station along 
the length of the member, first the actual member force/moment components and 
the corresponding capacities are calculated for each load combination. Then the ca­
pacityratios are evaluated at each station under the influence of all load combina­
tions using the corresponding equations that are defined in this section. The con­
trolling capacity ratio is then obtained. A capacity ratio greater than 1.0 indicates 
overstress. Similarly, a shear capacity ratio is also calculated separately. 

English as well as SI and MKS metric units can be used for input. But the code is 
based on Kip-Inch-Second units. For simplicity, all equations and descriptions pre­
sented in this chapter correspond to Kip-Inch-Second units unless otherwise 
noted. 

33 
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A 
A¡ 
A, 
A~2 , A~~ 

A, 
e, 
cm 
c. 
D 

E 

F. 

F, 

FbB ,Fb22 

F" 

F;)J 

F;-:.2 

F,. 

FY 
K 

KJ~•Kll 

Mn,Mzl 
p 

P, 

S 

SB,S22 

V2 ,V3 

b 

34 

= 

Cross·sectional area, in2 

Area of flange , in' 

Gross cross-sectional area. in2 

Majar and minar shear areas, in1 

Web shear area. dt,.., in2 

Bending Coefficient 

Moment Coefficient 

Warping constant, in~ 

Omside di a meter of pipes. in 

Modulus of elasticity, ksi 

Allowable axial stress, ksi 

Allowable bending stress, ksi 

Allowable majar and minar bending stresses. ksi 

Critica! compressive stress, ksi 

12rr' E 

23(K 3J/33 /r:n) 
2 

12 rr' E 

23(K,12:Jr,)' 
Allowable shear stress, ksi 

Yield stress of material, ksi 

Effective length factor 

Effective length K-factors in the majar and minar directions 

Major and minar bending moment moments in member, kip-in 

Axial force in member, kips 

Euler buckling load, kips 

Section modulus, in1 

Majar and minar section moduli. in1 

Shear forces in majar and minar directions, kips 

Nominal dimension of longer leg of angles, in 

(b1 -21.) for welded and 

(b1 -3t1 )for rolledBOX (TS) sections, in 

Flange width, in 

Overall depth of member, in 

Table IV-1 
A/SC-ASD Notations 
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Axial stress either in compression or in tension, ksi 

Normal stress in bending, ksi 

Normal stress in majar and minar direction bending. ksi 

Shear stress, ksi 

Shear stress m majar and minar direction bending, ksi 

Clear distance between flanges less fillets, in 

assumed (d-2k) for rolled sections and 
(d-2r 1 ) for welded sections 

Distance from outer face of flange to web toe of fillet , in 

Paramerer used for classification of sections, 
4 

[ ]
'" ifh/1,>70, 

h/t. 
1 if h/t. $70. 

Majar and minar direction unbraced member lengths. in 

Criticallength, in 

Radius of gyration, in 

Radü of gyration in the majar and minar dtrections. in 

Mínimum Radios of gyration for angles, in 

Thickness. in 

Flange thickness, in 

Web thickness, in 

Slendemess parameter 

Table IV-1 
AISC-ASD Notations (cont.) 
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Design Loading Combinations 
The design load combinations are the various combinations ofthe prescribed load 
cases for which the structure needs to be checked. For the AISC-AS089 code. if a 
structure is subjected to dead load (OL) and live load (LL) only, the stress check 
may need only one load combination, namely OL + LL (AISC A.4). However. ifin 
addition to the dead and live loads, the structure is subjected to wind (WL) and 
earthquake (EL) induced loads, and considering that wind and earthquake forces 
are reversible, then the following load combinations may ha ve to be considered for 
the design ofsteel frames (ASO A.4): · 

OL 
OL+LL 

OL±WL 
OL+ LL ±WL 

OL±EL 
OL+ LL ±EL 

(ASO A4.1) 

(ASO A4.1) 

(ASO A4.1) 

These are also the default design load combinations in SAP2000 whenever the 
AISC-AS089 code is used. 

When designing for combinations involving earthquake and wind loads, allowable 
stresses is increased by 33% ofthe allowable value (ASO A5.2). 

Live load reduction factors can be applied to the member forces ofthe live load case 
on an element-by-element basis to reduce the contribution of the live load to the 
factored loading. 

Classificátion of Sections 
The allowable stresses for axial compression and flexure are dependen! upon the 
classification of sections as either Compact, Noncompact, or Slender. SAP2000 
classifies the individual members according to Table IV -2 (ASO B5.1 ). The vari­
ables related to the section dimensions are shown in Figure IV -1 and the nomencla­
ture ofthe other variables is shown in Table IV-l. 

Ifthe section dimensions satisfy the limits shown in the table, the section is classi­
fied as either Compact or Noncompact.lfthe Iimits for Noncompact sections are 
not met, the section is classified as Slender. Currently SAP2000 does not check 
stresses for Slender sections. 
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Section 
Description 

GENERAL 

RECTANGLE 

1-SHAPE 

BOX 

CHANNEL 

T-SHAPE 

ANGLE 

ROUNDBAR 

PIPE 

DOUBLE 
ANGLES 
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Ratio Compact Noncompact Noncompact 
Checked Section Section (Compression) 

- Assumed Noncompact 

- Assumed Compact 

b,/21¡ S 65/.fF, S 95/ j¡; S 95/.fF. 
( rolled) 

b, /21¡ S 65/.JF: S 95/ ~F, 1 k, S 95/ .jF,. 
(welded) 

S~(l-3.74 J.:) 
d/1. 

..jF,. F, 
S 253/.fF. 

for jj F. S 0.16; -
:5. 257/JF': for;; 1 F, > 0.16 

h/1. - S 760/ .{i; -

b/1¡ :5. 190/ .JF, ( rolled) :5. 238/ .¡¡; S 253/ .jF,. 

d/1. As for 1-shapes - -

h/1. - As for 1-shapes :5. 2531 .JF. 

b1 /11 As for I-section, for P $O :5. 95/ F. 
b1 j11 Not app!Jcable. for P = O :5. 95/ F. :5. 951 .jF,. 
h/1. Not applicable As for 1-shapes 

b¡ /21¡ Not apphcable :5. 95/ .jF,. :5. 95/ .¡¡; 
d/1. Not applicable S 127/ .jF. :5. 1271 .JF. 

b/1 Not applicable S 76/ .jF. :5. 76/ .JF. 

- Assumed Compact 

D/1 :5. 3300/ F, - S 3300/F, 

b/1 1\ot apphcable 
:5. 95/ F, (sep.) :5. 95/ F, (sep.) 

:5. 127/ .JF. (con.) S 127/ .jF,. (con.) 

Table IV-2 
Classification ofSections According ro AISC-ASD 

Urniting Width-Thickness Ratiosfor Compression Elements 
Classilication of Sections 37 
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AtSC-ASD89 : Axes Conventions 

3-3 is the cross-section axis parallel to the flanges or the 
smaller leg in angle sections. 

2-2 is the cross-section axis perpendicular to the flanges 
or the smaller leg in angle sections. 

Figure IV-1 
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AISC-ASD Definition ofGeometric Properties 
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Calculation of Actual Stresses 
The stresses are calculated at each ofthe previously defined stations. The member 
stresses that are calculated for each load combination are: 

f" =P!A 
/,33 = M ,,!S 33 

J,, = M,,IS= 
/,. 2 = V2 /A, 2 

J,, = V,IA., 

Calculation of Allowable Stresses 
The allowable stresses in compression, tension, bending, and shear are computed 
for Compact and Noncompact sections according to the fol!owing subsections. 

For Slender sections and any singly symmetric and unsymmetric sections requiring 
considera/ion ofjlexural·torsional and torsional buck/ing. a reductionfactor in the 
allowable stress may be app/icable. The user must separately investiga/e this re· 
duction if suclz elements are used. 

Jf the user spec!fies nonzero allowable stresses for one or more elements in the 
. SAP2000 "Redefine E/ement Design Data", those values wil/ override al/ the al· 
lowable stresses calculated by the programas dejined in thefollowing subsections. 

Allowable Stress in Compression 

The allowable axial compressive stress value, F", for compact or non-compact sec· 
tions, depends on the slendemess ratio K!/ randa corresponding critica! value, e,. 
K/. l fK.,/33 K,.l, ¡. / . 
- 1s the arger o -'-- and · and e, = v(2Tr ·E) F,. . F. 1s evalu· 
r ~ ~ . 

ated as follows: 

• lf K/ S e,, 
r 

{!.O- (Kl/r !' }F,. 
2C; . 

F. = --~----~~--~ 
3 ( Kllr) ( Kl/r) 

3 
5 
-T 

3 8 e, se' 
' 

(ASO E2-l) 
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If K/ > C 
r 

,, 

12 ¡¡'E 

23(K/ / r)' 
(ASD E2-2) 

For single angles r, is used in place of r, and r33 . For members in compression, if 

K/ is greater than 200, a message is printed. 
r 

Allowable Stress in Tension 

The allowable axial !ensile stress value F. is assumed to be 0.60 F, . 1t should be 

noted that net section checks are not rnade. For members in tension, if 1/ r is 

greater than 300, a message to that effect is printed. 

F. = 0.6F, (ASO DI) 

Allowable Stress in Bending 

The allowable bending stress depends on the following criteria: the geometric 
shape ofthe cross-section, the axis ofbending. the compactness ofthe section, and 
a slendemess parameter. 

1-sections, C-sections, T-sections, Angles and Double angles 

For all 1-sections, C-sections, T-sections, Angles, and Double angles, the slender­
ness parameter is taken as the laterally unbraced length, /, measured compared toa 
criiicallength, /,. The criticallength is defined as 

. f 76b 1 20000A r 1 
1, =mm\--, f [.,JF: dF, j 

Major Axis of Bending 

If /
33 

is less than /,, the major allowable bending stress is taken as 

F.,, = 0.66 F,. (For Compact section), 

F.,, = 0.60 F, (For Noncompact section), 

40 Calculation of Allowable Stresses 
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and if the unbraced length /
33 

is greater than 1,, then for both Compact and 

Noncompact l-sections the allowable bending stress depends on the !.J¿_ ratio. 
'r 

For 
102x!0

3e,. 5.!.J¿_ 5. 510x!03 e, 
F_1 rr F 1 

(ASD Fl-6) 

/
33 

510x!03 e 
and for -> ' 

rr F.,. 

rl70xi03 C, l 
F,, = l . J 5. 0.60F,. , 

(1 33 /rr)" 

and F,, is not !ess than that given by the following formula: 

12xiO' e, < O.óF 
l

33
(d!A

1
)- ' 

For C-sections, only formula ASD Fl-8 is used. 

In al! the above cases, 

(ASD Fl-7) 

(ASD Fl-8) 

r r is the radius of gyration of a section comprising the compression flange and 
1/3 the compression web taken about an axis in the plane of the web, 

e, = 1.75 + L05 ( ~: ) +0.3 ( ~: )' 5. 2.3, (ASD Fl.3) 

M" and M, are the end moments of any unbraced segment ofthe member and 
M" is numerically less than M,; M"/ M, being positive for double curvature 
bending and negative for single curvature bending. Also, if any moment within 
the segment is greater than M,, e, is taken as 1.0. Al so, e, is taken as 1.0 for 
cantilevers and frames braced againstjoint translation (ASD Fl ). SAP2000 de­
faults e, to 1.0 ifthe unbraced length, /, ofthe member is redefined by the u ser 
(i.e. it is not equal to the length of the member). The user can overwrite the 
value of e, for any member by specifying it. 
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Minor Axis of Bending 

The minar directian allawable bending stress F,-::: is taken as 

F,, = 0.60 F, , (ASO F2-2) 

except in the case af Campact 1-sectians, where it is taken as 

F,, = 0.75 F, . (ASO F2-1) 

Box Sections and Rectangular Tubes 

Far all Bax sectians and Rectangular tubes, the slenderness parameter is taken as 
the laterally unbraced length, /, measured campared to a critica! length, 1,. The 
critica! length is defined as 

{ 
b I200b} 1 = max (1950+1200/lf IM,)-,--

c " F F . 
y )" 

(ASO F3-2} 

where M. and M, ha ve the same definitian as noted earlier in the formula far C,. 

If 1 is specified by the user, (. is taken as 
1200 

b in SAP2000. 
F,. 

Major Axis of Bending 

If /33 is less than 1,. the allawable bending stress in the majar direction afbending 
is taken as: 

F,33 = 0.66 F,. (for Compact section) 

F,33 = 0.60 F,. (far Noncompact section) 

(ASD F3-I) 

(ASO F3-3) 

lf /33 exceeds 1,. the allowable bending stress in the major directian ofbending is 
taken, irrespective of compactness, as: 

F,33 = 0.60 F,. (ASO F3-3) 

Minor Axis of Bending 

For box sectians and rectangular tubes, the allowáble bending stress about the mi­
nor axis ofbending is the same as that about the major axis ofbending. The allow­
able stresses are given by ASO equatians F3-l and F3-3 which are described ear­
lier. 
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Pipe Sections 

F or Pipe sections, the a!lowable bending stress for both major and minor axes of 
bending is taken as 

F, = 0.66 F,. (for compact section), and 

F, = 0.60 F, (for noncompact section). 

Rectangular and Round Bars 

(ASD F3-l) 

(ASD F3-3) 

For so lid square and round bars, the a!lowable bending stresses are the same in both 
major and minor directions ofbending. The a!lowable stress for both the major and 
minor axis ofbending of square and round bars and minor axis ofbending of rectan­
gular bars is taken as, 

F, = 0.75 F, .. (ASD F2-l) 

For so lid rectangular bars bent about their major axes, the a!lowable stress is given 
by 

F, = 0.66F,.. (ASD Fl-l) 

General sections 

For General sections the allowable bending stress in both major and minor direc, 
tions is taken as, 

F, = 0.60 F,.. . 

Allowable Stress in Shear 

F or webs with .!!_ s; 
r. 

F,. = 0.40 F,.. . 

For webs with .!!_ > 
r. 

3
: , the allowable shear stress F,. is assumed to be 

...¡F,.. . 

(ASD F4-l) 

3
: , a reduction in the allowable shear stress applies and 

...¡' ¡· 

must be separately investigated by the user. 
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Calculation of Stress Ratios 
In the calculation of the axial and bending stress capacity ratios, first, for each sta­
tron along the Jength ofthe member, the actual stresses are calculated for each load 
combination. Then the corresponding a!lowable stresses are calculated. Then, the 
capacity ratios are calculated at each station foreach member underthe influence of 
each of the design load combinations. The controlling capacity ratio is then ob­
tained, along with the associated station and load combination. A capacity ratio 
greater than 1.0 indicares an overstress. 

During the design, the effect ofthe presence ofbolts or welds is not considered. 
Also, the joints are not designed. 

Axial and Bending Stresses 

With the computed a!lowable axial and bending stress values and the factored axial 
and bending member stresses at each station, an interaction stress ratio is produced 
for each ofthe load combinations as fo!lows: 

• If f. is compressive andf" 1 F" > 0.15, the combined stress ratio is given by 
the larger of 

(ASO Hl-1) 

where (ASO Hl-2) 

f., fb33, f,~, F., F"", and F,, are defined earlier in this chapter, 

e •" and e., are coefficients representing distribution of moment along 
member Jength and are assumed to be 1.0 for a!l cases except for columns m un­
braced frames when they are taken as 0.85. However, users can specify overrid­
ing values and 

F.= 127t' E 

' 23(KI 1 r¡' 

If f. is compressive and f. 1 F. S 0.15, a relatively simplified formula is 
used for the combined stress ratio. 
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(ASO HI-3) 

• If 1" is !ensile or zero, the combined stress ratio is given by 

(ASO H2-l) 

1", 1m, 1.,,, F", F,33 , and F,, are defined earlier in this chapter. However, 
either F, 33 or F, 22 need not be less than 0.6F, .. 

For circular sections, an SRSS combination is tirst made ofthe two bending com· 
ponents before adding the axial load componen!, instead of the simple addition im· 
plied by the above fonnulae. 

Shear Stresses 

From the allowable shear stress values and !he factored shear stress values at each 
station, shear stress ratios for major and minor directions are produced for each of 
the load combinations as follows: 

1,, 
F,. 

1,., 
F,. 

and 
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Check/Design for AISC-lRFD93 

This chapter describes the details ofthe structural steel design and stress check al­
gorithms that are used by SAP2000 when the user selects the AISC-LRFD93 de­
sign code (AISC 1994). Various notations used in this chapter are described in 
Table V-1. 

The design is based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
sign of most building type siructures. 

In the evaluation ofthe axial force/biaxial moment capacity ratios ata station along 
the length of the member, first the actual member force/moment components and 
the corresponding capacities are calculated for each load combination. Then the ca­
pacity ratios are evaluated at each station under the influence of all load combina­
tions using the corresponding equations that are defined in this section. The con­
trolling capacity ratio is then obtained. A capacity ratio greater than 1.0 indicates 
exceeding a limit state. Similarly, a shear capacity ratio is also calculated sepa­
rately. 

English as well as SI and MKS metric units can be used for input. But the code is 
based on Kip-lnch-Second units. For simplicity, all equations and descriptions pre­
sented in this chapter correspond to Kip-Inch-Second units unless otherwise 
noted. 
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A 

A, 
A,.2 ,A~3 
A, 

B,. 

B, 
e, 
c. 
c. 
D 

E 

F, 

G 

I, 

J 

K 

K ll ,K 22 

L, 
LP 
L, 

M" 
M. 
Mm 
M,33 ,M,122 

Mp)J ,Mpz2 

M,JJ ,M,ll 

M. 
Mu33•Mu22 

P, 

P. 
P. 

P, 

Cross-sectional area, in
2 

Gross cross-sectional area, in
1 

Majar and minar shear areas, in~ 

Shear area, equal dt ~ per web, in~ 

Moment magnification factor for moments not caus.ing sidesway 

Moment magnification factor for moments causing sidesway 

Bending coefficient 

Moment coefficient 

Warping constant, in6 

Outside diameter of pipes, in 

Modulus of elasticity. ksi 

Critical compressive stress, ksi 

Compressive residual stress in flange assumed 10.0 for rolled 
sections and 16.5 for welded sections, ksi 

Yield stress of material, k si 

Shear modulus, ksi 

Minar moment of inertia, in
4 

Torsional constant for the section. in• 

Effective length factor 

Effective length K-factors in the majar and minar directions 

Laterally unbraced length of member, in 

Limiting laterally unbraced length for fu!l plastic capacity, in 

Limiting latera!ly unbraced length for inelastic lateral-torsional 
buckling, in 

Elastic buckling moment, kip-in 

Factored moments causing sidesway. kip-in 

Factored moments not causing sidesway, kip-in 

Nominal bending strength in majar and minar directions, kip-in 

Majar and minar plastic moments. kip-in 

Major and minor limitmg buckling moments, kip-in 

Factored moment in member, kip-in 

Factored majar and minar moments in member, kip-in 

Euler buckling load, kips 

Nominal axial load strength. kip 

Factored axial force in member, kips 

A,F,. kips 

Table V-1 
AISC-LRFD Notations 
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Section modulus, in1 

Majar and minar section moduli, in3 

Nominal majar and minar shear strengths, kips 

Factored major and minar shear loads, kips 

Plastic modulus, in1 

Majar and minar plastic moduli, in1 

Nominal dimension of longer leg of angles, in 
b 1 - 2t. for welded and b 1 - 3t. for rolled BOX (TS) sections 

Flange width, in 

Overall depth of member, in 

Clear distance between flanges less fillets, in 
assumed d- 2k for rolled sections 
and d- 2t 1 for welded sections 

Distance from outer face of flange to web toe of fillet, in 

Parameter used for section classification, 
4 .¡¡;¡¡::, 0.35Sk, 50.763 

Majar and minar direction unbraced member lengths, in 

Radius of gyration, in 

Radii of gyration in the majar and minar directions, in 

Mínimum Radius of gyration for angles, in 

Thickness, m 
Flange thickness, in 

Thickness ofweb, in 

Slenderness parameter 

Column slenderness parameter 

Limiting slenderness parameter for compact element 

Limiting slendemess parameter for non·compact element 

Limiting slendemess parameter for seismic element 

Resistance factor 

Resistance factor for bending, 0.9 

Resistance factor for compression, 0.85 

Resistance factor for tension, 0.9 

Resistance factor for shear, 0.9 

Table V-1 
AISC-LRFD Notations (con!.} 

57 

49 

cLno,{lb.L 



SAP2000 Steel Design Manual 

Design Loading Combinations 
The design load combinations are the various combinations of the load cases for 
which the structure needs lo be checked. Forlhe AISC-LRFD93 code. if a structure 
is subjected lo dead load (DL), Jive load (LL). wind load (WL). and earthquake in­
duced load (EL), and considering that wind and earthquake forces are reversible, 
lhen lhe following load combinations may ha veto be defined (LRFD A4.1 ): 

1.4 DL 
1.2 DL + 1.6 LL 

0.9 DL ± 1.3 WL 
1.2 DL ± 1.3 WL 
1.2 DL + 0.5 LL ± 1.3 WL 

0.9 DL ± 1.0 EL 
1.2 DL ± 1.0 EL 
1.2 DL + 0.5 LL ± 1.0 EL 

(LRFD A4-l) 
(LRFD A4-2) 

(LRFD A4-6) 
(LRFD A4-4) 
(LRFD A4-4) 

(LRFD A4-6) 
(LRFD A4-4) 
(LRFD A4-4) 

These are also the default design load combinations whenever the AISC-LRFD93 
code is used. The user should use olher appropriate loading combinations if roof 
Ji ve load is separately treated, if other types of loads are present, or if pattern Ji ve 
Joads are to be considered. 

Live load reduction factors can be applied lo the member forces ofthe Ji ve load case 
on an element-by-element basis to reduce lhe contribution of the live load to the 
faclored Joading. 

When using lhe AISC-LRFD93 code, SAP2000 design assumes that a P-t. analysis 
has been performed so that momenl magnificalion faclors for moments causing 
sidesway can be taken as unity. It is recommended that the P-t. analysis be done at 
lhe factored load leve! of 1.2 DL plus 0.5 LL (White and Hajjar 1991 ). 

Classification of Sections 
The nominal strengths for axial compression and flexure are dependen! on the clas­
sificalion oflhe seclion as Compact, Noncompact, or Slender. SAP2000 classifies 
individual members according lo lhe widthllhickness ratio quantities given in Ta­
bles V-2 and V-3 (LRFD B.5.1 ). The definilion ofthe section properties required in 
these tables are given in Figure V -1 and Table V-1. In SAP2000, a seclion is classi­
fied as Compact or Noncompact. Moreover, special considerations are required 
regarding the 1 imits of width-thickness ratios for Compact seclions in Seismic 
zones and Noncompacl sections with compressive force as given in Table V-3. If 
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the limits for non-compact are not met, the section is classified as Slender. 
Currently SAP2000 does not check stresses for Slender sections. 

Description 
of Section 

GENERAL 

RECTANGULAR 

1-SHAPE 

BOX 

CHANNEL 

T-SHAPE · 

ANGLE 

ROUNDBAR 

PIPE 

DOUBLE-ANGLE 
_ (Separated) 

Check COMPACT NONCOMPACT 
(A) 0.. p) 0..,) 

- Assumed Noncompact 

- Assumed Compact 

b,/21¡ ,; 65/ .¡¡; ,; 141/ ~F,. lOO 
(rolled) 

b1 j211 ,; 65/ .¡¡; 
(welded) 

,; 162/ ~(F. -16.5)/k, 

For P./ r~ S O. 125, 

,; ~ 1 - 2. 75?,) 
~F, <p,P, 

hj1. ,; 970 [1-0.74~] 
For P./<1'.1', > 0.125 JF: <p~ P,. 

s{ 191 ( 2_33 _.!,__ )~253'} 
:¡¡:: <p,P, ~F, 

bj11 S 190/ [F, (rolled) S 238/ [F, (rolled) 

bj11 NI A for welded section S 253/ .JF; (welded) 
h,/ l. As for 1-shapes As for 1-shapes 

b¡/1¡ As for 1-shapes As for 1-shapes 
hj1. As for 1-shapes As for I-shapes 

b¡ /21¡ As for 1-Shapes As for I-Shapes 

d/t. Not applicable ,; 127/fF, 

b/1 Not applicable ,; 76/ .¡¡; 
- Assumed compact 

Dj1 ,; 2070/ F, S 8970/ F. 

b/1 Not applicable ,; 76/ .¡¡; 

Table V-2 
Limiting Width- Thickness Ratio for Flexure 

Classification ofSections According to AISC-LRFD 

Classification of Sections 51 

" 

,:2 



SAP2000 Steel Design Manual 

Description Width- COMPACT NONCOMPACT 
ofSection Thickness (SEISMIC ZONE) (Uniform Compression) 

Ratio (M, =M, =O) 
(A.) (A.,) (A..) 

GENERAL - Assumed Noncompact 

RECTANGULAR - Assumed Compact 

b,/2t, $ 52/ ..JF, ,; 95/ F. 
(rolled) 

b,/2t, . ,; 52/ ..JF, ,; 95/ .JF, 
(welded) 

ForP,/<¡>,P,,; 0.125, 

1-SHAPE ,; 520J 1-1.54~) JF: 'Pb~ 
hjt_ For P. <¡>,P, > 0.125 ,; ~53/¡¡: 

,;{ 
191 

( 2.33-~ )"El JF: 'l'.P, ~F, 

BOX 
b/t, Not applicable ,; 238/ ,¡¡; 
hjt_ Not applicable ,; 253/ ¡¡: 

CHANNEL b,/t, Not applicable As for I-shapes 
hjt_ Not applicable As for 1-shapes 

T-SHAPE 
h,/2t, Not applicable ,; 95/ ¡¡: 
d/t. Not apphcable ,; 1271 ¡¡: 

ANGLE b/t Not applicable ,; 76/ ..JF, 
ROUNDBAR - Not applicable -

PIPE D/t Not applicable ,; 3300/ F, 

DOUBLE-ANGLE b/t Not applicable $ 76/ F. 
(Separnred) 

Table V-3 
Limiting Width-Thickness Ratios 

for Classification of Sections According lo AISC-LRFD 
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Calculation of Factored Forces and Moments 
The factored member loads that are calculated for each load combination are P,, 
M""' M ,·21 , V,, and V,, correspondingto factored values ofthe axial load, the ma­
jor moment, the minor moment. the major direction shear force and the minor direc­
tion shear force, respectively. These factored loads are calculated atea eh ofthe pre­
viously defined stations. 

For loading combinations that cause compression in the member, the factored mo­
ment M" (M"" and M.:: in the corresponding directions) is magnified to consider 
second order effects. The magnified moment in a particulardirection is given by: 

M,= B1 M., +B,M,, ,where (LRFD Cl-1) 

B1 = Moment magnification factor for non-sidesway moments, 
B, = Moment magnification factor for sidesway moments, 
M"'= Factored moments not causing sidesway, and 
M,,= Factored moments causing sidesway. 

The moment magnification factors are associated with corresponding directions. 
The moment magnification factor B1 for moments not causing sidesway is given by 

e 
B, = -,--,--"'m.,-~) <! 1.0, where 

(1-P,./P, 
(LRFD Cl-2) 

P is the Euler buckling load (P = A,F, , with J.= K/ ~ ), and 
e ~ J..'~ r1t ~E 

M e m =0.6 -0.4-" , where 
M, 

(LRFD Cl-3) 

M. 1M, is the ratio ofthe smaller to the larger moment at the ends ofthe mem­
ber, M. 1M, being positive for double curvature bending and negative for sin­
gle curvature bending. F or compression members with transverse load on the 
member, e m is assumed as 1.0. When M, is zero, e m is taken as 1.0. The pro­
gram defaults e m to 1.0 ifthe unbraced length, /, ofthe member is redefined by 
the u ser (i.e. it is not equal to the length ofthe member). The user can overwrite 
the val u e of e m for any member. 

The magnification factor B1, must be a positive number. Therefore P. must be less 
than P,. lf P. is found to be greater than or equal to P,, a failure condition is de­
clared. 
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SAP2000 design assumes the analysis includes P-.:l effects, therefore B, is taken as 
unity for bending in both directions. lt is suggested that the P-.:l analysis be done at 
the factored load leve! of 1.2 DL plus 0.5 LL. See al so White and Ha ijar ( 1991). If 
the program assumptions are not satisfactory for a panicular structural model or 
member, the user has a choice of explicitly specifying the values of B

1 
and B: for 

any member. 

Calculation of Nominal Strengths 

The nominal strengths in compression, tension, bending, and shear are computed 
for Compact and Non-compact sections according to the following subsections. 
The strength reduction factor, <p, is taken as follows (LRFD A5.3): 

Resistance factor for tension, 0.9 
Resistance factor for compression, 0.85 
Resistance factor for bending, 0.9 
Resistance factor for shear, 0.9 

(LRFD 03) 
(LRFD E2) 
(LRFD Fl) 
(LRFD F2) 

For Slender sections and any sing~v symmetric and unsymmetric sections requiring 
considera/ion of/oca/ buckling (LRFD Appendix B5).j/exural-torsional and tor· 
siona/ buckling (LRFD Appendix E3), or web buckling (LRFD Appendix G), re­
duced nominal strengths may be app/icable. The user must separate~v investiga/e 
this reduction if such e/ements are used. 

lf the u ser specifies nominal strengths for one or more elements in the "Redefine 
Element Design Data", these values wil/ override al/ above the mentioned calcu­
lated va/u es for tlwse elements as defined in the following subsections. 

Compression Capacity 

The nominal axial compressive strength, P,, depends on the slendemess ratio, K/' 
r 

d . ·· 1 1' K/. hl fK 33133 andK"'/",and an tts cnllca va ue, 1\,. - ts t e arger o 
r r33 'n 

(LRFD E2-4) 

P, for compact or non-compact sections is evaluated for flexura! buckling as fol­
lows: 

Calculation of Nominal Strengths 55 
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P. = A,F" , where 

F" = (0.658'~) F,., 

F _ ro.877l F "-lTJ ,. 

for A, S 1.5, and 

for A,> 1.5. 

(LRFD E2-l) 

(LRFD E2-2) 

(LRFD E2-3) 

For single angles r2 is used instead of r33 and r"'. For members in compression, if 

K! is greater than 200, a message to that effect is printed (LRFD 87). 
r 

P. for flexural-torsional buckling of double-angle and T -shaped compression 
members whose elements ha ve width-thickness ratios less than A, is given by 

(LRFD E3-l) 

4F J H l 
1- "- '~ j where 

(F"' + Fm )' ' 
(LRFD E3-l) 

r" = Polar radius of gyration about the shear center, 

are the coordina tes of shear center with respect to the centro id, 
x 0 =O for double-angle and T -shaped members (.v-axis of symmetry), 

is determined according to the equation LRFD E2-l for flexura! 

buckling about minar axis of symmetry for A, = K/ {F:- . 
r~1t VE 

For double-angles and T -shaped members with width-thickness ratios greater than 
A, or other symmetric and unsymmetric columns, the user is advised to separately 
perform a complete check for lateral-torsional buckling. 

Tension Capacity 

The nominal axial tensile strength value P. is based on the gross cross-sectional 
area and the yield stress. 

56 Calculation of Nominal Strengths 

.. 



Chapter V Check/Design for AISC-LRFD93 

(LRFD DI-!) 

lt should be noted that no net section checks are made. For members in tension, if 
1/ r is greater than 300, a message to that effect is printed (LRFD B7). 

Nominal Strength in Bending 

The nominal bending strength depends on the following criteria: the geometric 
shape ofthe cross-section, the axis ofbending, the compactness ofthe section, and 
a slendemess parameter for lateral-torsional buckling. The nominal bending 
strength is the minimum value obtained from yielding. lateral-torsional buckling, 
flange local buckling, and web local buckling, as follows: 

Yielding 

For laterally braced compact (and seismic) members with L, ~ L,, 

M, = Z F,. ~ 1.5 S F, , where 

Laterally unbraced length, 1:: and 

(LRFD Fl-1) 

Limiting laterally unbraced length for full plastic capacity, 
300 r 02 

JF. 
for 1-shapes and channels. and (LRFD Fl-4) 

3 750 r, r.; 
--~-~- v JA for boxes and rectangular bars. 

M p33 

(LRFD Fl-5) 

Laterai-Torsional Buckling 

Doubly Symmetric Shapes and Chan11els 

For 1-shapes. channels, boxes and rectangular bars bent about the major axis, if 
L, ~ L, 

(LRFD Fl-2) 

and if L, > L, , 

M nJJ = M crJJ S M P 33 , where (LRFD Fl-12) 
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Mn33 

M pJJ 

Mr33 

M,r33 

L, 

x, 

X, 

e, 

= 

= 

Nominal major bending strength, 
Major plastic moment, Z,F, ::; !.SS 33F, , 

Major limiting buckling moment, 
(F, - F, )S 33 for I-shapes and channels, 
and F,.S 33 for rectangular bars and boxes, 
Critica! elastic moment, 

e ,7t El .,GJ + (1tE )' 1 .. e. 
L, - L, -

(LRFD FI-7) 
(LRFD Fl-11) 

for 1 -shapes and channels, and (LRFD F 1-13) 
s?ooo e JJA 
-----:-.!:.' -- for boxes and rectangular bars, (LRFD F 1-14) 

L, / r'" 
Laterally unbraced length, 1"' , 

Limiting laterally unbraced length for full plastic capacity, 
300 r"' 

,JF: 
for I-shapes and channels, and 

3 750 
r"' JJA for boxes and rectangular bars, 

M p33 

Limiting laterally unbraced length for 
inelastic lateral-torsional buckling, 

r,X, {!+[!+X,(F -Fl']y,}X 
F .. -F, -)' 

for 1-shapes and channels, and 
57 000 r_. JJA 

-- for boxes and rectangular bars, 
M r33 

....::_~EGJA' 
S 33 2 

4 ,S,:_( S 33 )', 

1, GJ 

12.5 M.~ d 
, an 

2.5M.w +3M A+ 4M8 + 3Mc 

(LRFD Fl-4) 

(LRFD Fl-5) 

(LRFD Fl-6) 

(LRFD Fl-10) 

(LRFD Fl-8) 

(LRFD FI-9) 

(LRFD Fl-3) 

M·~, M A, M 8 ,and Me are absolute values ofmaximum moment, 1/4 point, ceo­
ter of span and 3/4 point major moments respectively, in the member. e, should be 
taken as 1.0 for cantilevers. However, the program is unable to detect whether the 
member is a cantilever. The user should overwrite e, for cantilevers. The program 
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also defaults e, ·to 1.0 ifthe unbraced length, /, ofthe member is redefined by the 
user (i.e. it is not equal to the length of the member). The user can overwrite the 
val u e of e, for any member. 

For pipes and circular bars bent about any axis, 

M,= Mp = ZF, ~1.5SF,.. 

F or all sections bent about their minar axis; 

T-sectio11s a11d Double A11gles 

For T -shapes and double angles the nominal majar bending strength is given as, 

rr,/ELGJ [ ~] M = -- B +vi+ s- ~ 
,,33 L 

h 

F
1 
S 33 , where (LRFD Fl-15) 

B (LRFD Fl-16) 

The positive sign for B applies for tension in stem of T or outstanding legs of dou­
ble angles (positive moments) and the negative sign applies for compression in 
stem (negative moments). 

F or T -shapes and double angles the nominal minar bending strength is assumed as, 

M,00 =F,.S,. 

For single angles and for GENERAL sections the nominal majar and minar direc­
tion bending strengths are assumed as, 

M = SF. 
lt .1 

Local Buckling 

For non-compact 1-shapes, channels and boxes, the nominal bending strengths are 
given by the lowest value calculated in the formulas below for the various local 
buckling modes possible for these sections. The nominal flexura! strength M, for 
the limit state of flange and web local buckling is: 

Mn33 = (LRFD A-Fl-3) 
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for major direction bending, and 

(LRFD A-F 1-3) 

for minor direction bending, where 

M"" = Nominal major bending strength, 
M, 00 Nominal minor bending strength, 
M pJ3 Majar plastic moment, Z33 F,. s; 1.5 S 33 F, , 
M P" Minar plastic moment, Z,F,. s; 1.5 S ,F,. , 
M,, Majar limiting buckling moment, (LRFD Table A-FI.I) 

(F,. - F, )S 33 for flange buckling ofl-shapes and channels, 
F,.S 33 for web buckling of 1-shapes and channels, 
and F,.S 33 for flange and web buckling of boxes, 

M, 00 Minar limiting buckling moment, (LRFD Table A-FI.I) 
F,.s, or flange buckling ofl-shapes, channels and boxes, 

A Controlling slenderness parameter, 
A P Largest value of A for which M, = M, , and 
A, Largest value of A for which buckling is inelastic. 

For Noncompact pipe sections the nominal majar and minor direction bending 
strength is 

M = M = ( 
600 

+ F )s. 
n33 1122 D / f J' 

(LRFD Table A-FI.I) 

Shear Capacities 

Major Axis of Bending 

The nominal shear strength, V,,, for majar direction shears in 1-shapes, boxes and 
channels is evaluated as follows: 

For ~ s; 
1, 

418 

,JF;' 

V,, = 0.6F,.A •• (LRFD F2-l) 

for ~ < ~ s; 523 ' 
F: 1,. F: 
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V = 0.6F A ~~.!!.._ and 
n::: 1 ... fF r .... 

...¡•,. 
(LRFD F2-2) 

523 
for -- < 

.jF, 
.!!.... "5.260' 
r. 

V,= 132000 A, 
•· [h!tS 

(LRFD F2-3 and A-F2-3) 

The nominal shear strength for all other sections is taken as: 

V,, = 0.6 F,.A,,. 

Minor Axis of Bending 

The nominal shear strength for minar direction shears is assumed as: 

V,3 = 0.6F, A,.3 

Calculation of Capacity Ratios 
In the calculation of the axial forcefbiaxial moment capacity ratios, first, for ea eh 
station along the length of the member, the actual member force/moment compo­
nents are calculated for each load combination. Then the corresponding capacities 
are calculated. Then, the capacity ratios are calculated atea eh station for ea eh mem­
ber under the influence of each of the design load combinations. The controlling 
compression and/or tension capacity ratio is then obtained, along with the associ­
ated station and load combination. A capacity ratio greater than 1.0 indicares ex­
ceeding a limit state. 

During the design, the effect ofthe presence ofbolts or welds is not considered. 
Also, the joints are not designed. 

Axial and Bending Stresses 

The interaction ratio is deterrnined based on the ratio ~. If P is !ensile, P is the 
p " " 

(jl " 

nominal axial !ensile strength and q> = q>, = 0.9; and if P. is compressive, P,. is 
the nominal axial compressive strength and q> = q>, = 0.85. In addition, the resis­
tance factor for bending, q>, = 0.9. 
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Por ~ <= 0.2, the capacity ratio is given as 
q>P, 

+ M,, )· 
q>' M"" 

Por P, < 0.2, the capacity ratio is given as 
<jlP, 

~ +( M,33 + M,_ ) . 
2q>P, q> ,M,33 q> ,M,"' 

(LRFD HI-la) 

(LRFD Hl-lb) 

Por circular sections an SRSS (Square Root ofSum ofSquares) combination is first 
made of the two bending components befare adding the axial load componen! in­
stead of the simple algebraic addition implied by the abo ve formulas. 

Shear Stresses 

Similarly to the normal stresses, from the factored shear force val u es and the nomi­
nal shear strength val u es at each station for each ofthe load combinations, shear ca­
pacity ratios for majar and minar directions are produced as follows: 

V, . 
-"--- and V , 
q> • n~ 

v,,J 
-v-· 
q> ~ n3 

where q> ,. = 0.9. 
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Check/Design for CISC94 

This chapter describes the details ofthe structural steel design and stress check al­
gorithms that are used by SAP2000 when the user selects the CAN/CSA-S 16.1-94 
design code (CISC 1995). Various notations used in this chapter are described in 
Table VI-l. 

The design is based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
sigo of most buildmg type structures. 

In the evaluation ofthe axial force/biaxial moment capacity ratios ata station along 
the length of the member, first the actual member force/moment components and 
the corresponding capacities are calculated for each load combination. Then the ca­
pacity ratios are evaluated at each station under the influence of all load combina­
tions using the corresponding equations that are defined in this section. The con­
trolling capacity ratio is then obtained. A cap'acity ratio greater than 1.0 indicates 
exceeding a limit state. Similarly, a shear capacity ratio is also calculated sepa­
rately. 

English as well as SI and MKS metric units can be used for input. But the code is 
based on Newton-Millimeter-Second units. For simplicity, all equations and de­
scriptions presented in this chapter correspond to Newton-Millimeter-Second 
units unless otherwise noted. 
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A 

A, 
A,..2 ,A~3 
A. 
c. 
C¡ 
c. 
c .. 
e, 
D 

E 

F, 
G 

I, 
J 

K 

K 33 ,K 22 

L 

M/JJ•Mn2 

MP33 ,MP2~ 
M,)) .M,22 

M. 

M>33'Myu 

s)3's22 

T¡ 

T, 

u, 

u, 

v/2 .V fl 
v,2 ,V,3 

Z33 ,Z22 

Cross-sectional area, mm~ 

Gross cross-sectional area, mm! 

Majar and minar shear areas, mm: 

Shear are a. mm: 

Euler buckling strength. N 

Factored compressive axial load, N 

Factored compressive axial strength, N 

Warping constant. mm6 

Compressive axial load at yield stress, A,FY, N 

Outside diameter of pipes. mm 

Modulus of elasticity. MPa 

Specified minimum yoeld stress, MPa 

Shear modulus, MPa 

Minar moment of inertia, mm • 

T orsional constant for the section. 'mm4 

Effective length factor 

Effective length K-factors in the major and minar direcions 

(assumed as 1.0 unless overwritten by user) 

Laterally unbraced length ofmember. mm 

Factored major and minor bending loads, N-mm 

Majar and minar plastic moments, N-mm 

Factored majar and minor bending strengths, N-mm 

Critical elastic moment, N-mm 

Major and minor yield moments, N-mm 

Major and minor section moduli, mm1 

Factored tensile axial load, N 

Factored !ensile axial strength, N 

Moment magnification factor to account for defonnation 
of member between ends 

Moment magnification factor ( on sidesway moments) 
to account for P-~ 

Factored major and minor shear loads. N 

Factored major and minar shear strengths, N 

Major and minar plastic moduli, mm3 

Table VI-l 
CISC 94 Notations 
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Nominal dJmensiOn of longer leg of angles 

(b1 -2r.) forwelded 

( b1 - 3r r) for rolled box secuons. mm 

Flange w1dth. mm 

Overall depth of member, mm 

Cle3r distance between flanges, taken as (d-2tf ~mm 

Web plate buckling coefficient. assumed as 5.34 (no suffeners) 

Distance frorn outer face offlange to web toe offillet. mm 

Unbraced length of mernber. mm 

Majar and minar direction unbraced member lengths. mm 

Radius of gyration. mm 

Radu of gyration m the maJar and minor directions. mm 

M mimum Radms of gyration for angles. mm 

Thickness. mm 

Flange thickness. mm 

Web thickness. mm 

Slendemess pararneter 

Resistance factor. taken as 0.9 

Moment Coefficient 

Majar and minar dtrection moment coeffictents 

Bending coefficient 

Table VI-I 
CISC 94 Notations (cont.) 

" 
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Design Loading Combinations 
The design load combinations are the various combinauon> of the load cases for 
which the structure needs to be checked. For the CAN/CSA-Sió.l~g..¡ code, if a 
structure is subjected to dead load (DL), Ji ve load (LL). wind load (WL ). and earth­
quake induced load !EL). and considering that wind and earthquake forces are re­
versible, then the following load combinations may ha veto be defined (CISC 7.2): 

1.25 DL 
1.25 DL + 1.50 LL 

1.25 DL ± 1.50 WL 
0.85 DL ± 1.50 WL 
1.25 DL + 0.7 (1.50 LL ± 1.50 WL) 

1.00 DL ± 1.00 EL 
1.00 DL + 0.50 LL ± 1.00 EL 

(CISC 7.2.2) 

(CISC 7.2.2) 

(CISC 7.2.6) 

These are al so the default design load combinations whenever CISC Code is used. 
In generating the above default loading combinations. importance factor is taken as 
l. 

The user should use other appropriate loading combinations if roof hve load is 
separately treated. other types of loads are present, or ifpattem hve loads are to be 
considered. 

Live load reduction factors can be apphed to the member forces ofthe Ji ve load case 
on an element-by-element basis to reduce the contnbution of the live load to the 
factored loading. 

When using the CISC code. SAP2000 design assumes that a P-~ analysis has been 
performed so that moment magnification factors for moments caustng s1desway 
can be taken as unity. It is suggested that the P-~ analysis be done at the factored 
load leve! of 1.25 DL plus 1.05 LL. See also White and Hajjar ( 1991 ). 

For the gravtty load case only. the code (CISC 8.6.2) requires that notionallateral 
Joads be applied at each story. egua! to 0.005 times the factored gravity loads acting 
at each story. If extra load cases are used for such analysis, they should be included 
in the loading combinations with due considerauon to the fact that the notional 
lateral forces can be positive or negative. 
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Classification of Sections 
For the deterrnination of the nommal strengths for axial compression and flexure, 
the sectwns are classified as either Class 1 (Piastic), C!ass 2 (Compact). Class 3 
(Noncompact). or Class 4 (Slender). The program c!assifies the ind•vidual sections 
according to Table VI-2 (CISC 1 1 .2). According to this table. a sectwn is classified 
as either C!ass 1. Class 2. or Class 3 as apphcable. 

lf a section Jails to satisfi' the limits for C/ass 3 sections. the scction is classi[icd as 

C/ass 4 Current(v SAP 2000 do es not check stressesfor Class 4 scctions. 

Calculation of Factored Forces and Moments 
The factored member forces for each load combination are calculated at each ofthe 
previously defined stations. These member forces are T, or C r. Al,.,.. M, ::.o. V r: 
and VI' corresponding to factored values ofthe tensile or compressi1·e a'ial load. 
the majar moment. the minar moment, the majar direction shear, and the minar di-
rection shear. respective! y. · 

Because SAP2000 design assumes that the analysis includes P-6 effects. any mag­
nification of sidesway moments due to the second arder effects are already in­
cluded, therefore U, for both directions ofbending is taken as unity. lt is suggested 
that the P-6 analysis be done at the factored load leve! of 1 .25 DL plus 1 .05 LL. See 
al so White and Hajjar (199 1 ). 

However, the user can overwnte the values of U, for both majar and minar direc­
tion bending. In this case M 

1 
m a panicular direction is taken as: 

(CISC 8.6. 1) 

U, Moment magmficatwn factor for sidesway moments, 
M ¡g Factored moments not causing translation. and 
A1

11 
Factored moments causing sidesway. 

Calculation of Factored Strengths 
The factored strengths in compression. tension, bendmg. and shear are computed 

forC!ass 1. 2. and 3 sections in SAP2000. The strength reduction factor, <p, is taken 

as 0.9 (CISC 13.1). 
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Description Ratio 
of Section Checked 

GE:-;ERAL -

RECTA~- -
GULAR 

b, 1 21¡ 

I-SHAPE 

h/1. 

b/1¡ 

BOX 

h/1. 

CHANNEL 
b¡/1¡ 
h/1. 

b¡ /21¡ 
T-SHAPE d/1. 

ANGLE b/1 

ROUNDBAR -

PIPE D/1 
(flexure) 

PIPE (Axial) D/1 

DOUBLE 
b/1 

ANGLE 

Class 1 Class 2 
(Piastic) (Compact) 

Assumed C\ass 3 

Assumed Class 2 

5145/~F, 5170/F, 

5 IIOO[I-039C,) 
,'F. e, 

5 1700(1-061C¡ 1 
~F, c. 

5 420/ F, (rolled) 
5 5:!.5/ ~F, 

5 525/ F, 1 welded) 

As for J-shapes As for 1 -shapes 

!\ot applicable Not applicable 
Not apphcable Not app!icable 

!\ot applicable Not appllcable 
1\ot apphcable Not applicable 

Not applicable Not appllcable 

Assumed Class 2 

S 13000/ F, SISOOO/F, 

- -

J\ot apphcable Not applicable 

Table Vl-2 
Limiting Wrdth-Thickness Ratio 

Class!ficarion of Sections in CISC 94 
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Class 3 
("oncompact) 

1 

5 200/ F. 

5
1
;

00
(1-0.65c,) 

, .. F. e, 

5 670/ /F: 

As for 1-shapes 

5 200/ /F: 
As for 1-shapes 

5 200/ F. 
5 340/ ~F. 

5 200/ .¡¡: 

5 66000/ F, 

5 23000/ F, 

5200/ F. 
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1----- br ---1 

h 

¡, 

i 
' l-o-1 

1'-b--f br~ 
1--b 
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d 

~ 1--t = tw= tr 

l 
lw 

b=Or-3tr 

T T 
b b 

lL:::::== l 
CISC95 : Axes Conventions 

3-3 is the cross-sectJon ax1s parallel to the flanges or the 
smaller leg in angle sect1ons. This is !he same as the x-x 
axis. 

2-2 is the cross-sectlon ax1s perpendicular to the ftanges 
or the smaller leg in angle sect1ons. This is the same as 
the y-y axis. 

Figure VI-l 

2,y 

3, X---+--.3, X 

CISC 94 Definilion oJGeometric Properties · 
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For Class 4 {S/ender) sectwns and any sing/y symmerric and unsymmetric sections 
requiring considerarían af local buck/ing, jlexural-rorsianal and rarsianal buck­
/ing, or web buckling. reduced nammal srrengrhs may be applicable. The user musr 
separare/y inrestigare thzs reduction if su eh elements are used. 

lf rhe u ser specifies nominal srrengths far ane or more elemems in rhe "Redefine 
Elemenr Design Dar a", rhese values wi/1 o1•erride alltlze abo ve meutioned ca/cu­
lated values for !hose e/ements as defined in thefollall'ing subsecfions. 

Compression Strength 

The factored axial compressive strength value. e,, for Class l. 2. or 3 sections de­

pends on a factor,) .. which eventually depends on the slenderness ratio, KI_ which 
r 

. h 1 f K" 1" ts t e arger o ~. · · 

A~ K/ /F, 
11! V E 

,.33 

K., L. . 
and ·- -- . and ts defined as 

r ...... 

Then the factored axial strength is evaiuated as foliows (CISC 13.3.1): 

1 

e, = <¡> AF,(i +'A'" r;, where (CISC 13.3.1) 

n = 1.34, for all types of sections except wide-flange sections with thickness 
iess than or equal to 25.4 mm, and (CISC Table 1-2 and 6-2) 

n =0.98. for all wide-flange sections with thickness greater than or equal to 
25.4 mm. (CISC Tabie 1-2 and 6-2) 

For single angies r2 is used in place of r3., and r,. The abo ve caicuiated val u e o fe, 
is conservative for hot-formed or stress-reheved hollow sections where the code al-

iows a higher value (CISC 13.3.1 ). For members in compression. if K/ is greater 
r 

than 200, a message is printed (CISC 10.2.1). 

Tension Strength 

The factored axial tensile strength vaiue. T,, is taken as <¡>Ag F,. (CISC 13.2.(a).(i)). 
For members in tension, if 1/r is greater than 300, a message IS printed accordingly 
(CISC 10.2.2). 
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T, = <p A, F, (CISC 13.2) 

Bending Strengths 

The factored bendmg strength m the majar and minar dircctians is based an the 
geametric shape afthe section. the sectian c!assificat10n far campactness. and the 
unbraced length af the member. The bending strengths are e\·aluated accarding to 
CISC as fallows (CISC 13.5 and 13:6): 

Far laterally suppaned members, the mament capac!lies are cansidered to be as fal­
!aws: 

Far Class 1 and 2, 

For Class 3. 

M, = <p ZF,. . and 

M,= <p SF, . 

(CISC 13.5) 

(CISC 13.5) 

Special cansideratians are required far laterally unsuppaned members. The proce­
dure far the detenninatian afmament capacities for laterally unsuppaned members 
(CISC !3.6) is described in the fallawmg subsecuans. 

· 1-shapes and Boxes 

Major Axis of Bending 

Far Class 1 and 2 sectians af 1-shapes and boxes bent abaut the major axis, 

when M, > 0.67 M , 33 , 

M, = 1.15 <p M ,33 ( 1-0.28 A~:,' ) $ <p M ,33 • and 

when M, $ 0.67 M , 33 , 

M r 33 = <p .M u • where 

M,]] 

M p3] 

M, 

Factored major bending strength, 
Majar plastic mament. Z"F,. , 
Critica! elastic mament, 

w, n \In ,GJ + (nE )- 1 ,e 
L'- L --" 

L Latera!ly unbraced length. /
00 

, 

C" Warping canstant assumed as 0.0, 

(CISC 13.6) 

(CISC 1 3.6) 

(CISC 13.6) 
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for boxes. pipes. rectangular and circular bars. and 

w. 1.75+!.05(M" )+0.30(M" J'::; 2.5. (CISC !3.6) 
M, M" 

M" and M, are end moments of the unbraced segment and M" is less than 

M,, ( M" J being positive for double curvature bending and negative for sin-
M, 

gle curvature bending. If any moment within the segment is greater than M,. 
w, is taken as 1.0. The program defaultsw, to 1.0 ifthe unbraced length./ ofthe 
member 1s overwritten by the user (i.e. it ¡s not egua! to the length ofthe mem­
ber). w, shou!d be taken as 1.0 for cantilevers. However. the program is unable 
to detect whether the member is a cantilever. The user can overwrite the value 

of w, for any member by specifying it. 

For Class 3 sections ofl-shapes, channels, boxes bent about the major axis. 

when M"> 0.67M,.,,. 

M 3• ~ 1.15<p M ,,(1-0.28 M,.,,)::: <p M 
3
,.and 

r .J 1 - M u 1 -

when M, ::; 0.67 M,.,, 
M"'~ <pM,. where 

(CISC !3.6) 

(CISC !3.6) 

M, 33 and M, are as defined earlier for Class 1 and 2 sections and 
M "' is the m a jor y1eld moment. S 33 F, .. 

Minar Axis af Bending 

For Class 1 and 2 sections of 1-shapes and boxes bent about their minor axis, 

For Class 3 sections of 1-shapes and boxes bent about their minor ax1s, 

Rectangular Bar 

Majar Axis af Bending 

For Class 2 rectangular bars bent about the major axis, 
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when M, >0.67 M , 33 • 

M,, ~ 1 15 (jl M ,33 ( 1-0.28 A:;:' )s <1> M ,33 • and 

when M, S 0.67 M,,,,. 

A1r33 = <p ¡\/, · 

Afinor Axis of Bending 

Far Class 2 secuans afrectangular bars bent abaut their minar axis. 

M-- ~(jl M •• ~(jlZ.J 
1 -- P-- -- 1 

Pipes and Circular Rods 

Far pipes and circular rads bent abaut any ax1s 

When M, > 0.67 M , 33 , 

M 
3

, ~ 1.15(jl M 
3
,(1-0.28 M,,, )s 

1 • p . ¡\1" 

when M, $ 0.67 M , 33 , 

Mr33 =<p Mu · 

Channel Sections 

Major Axis of Bending 

(jl M.,. and 
p •• 

Far C1ass 3 channe1 scctians bent abaut the majar axis, 

when M,> 0.67 M , 33 • 

M,. 33 ~ L15(jl M ,33 (1- 0.28 :·:')S <p Af ,. 33 , and 

when A!, S 0.67 M"' . 
M, 33 ~ (jl M, . 

(CISC 13.6) 

(CISC 13.6) 

(CISC 13.6) 

(CISC 13.6) 

(CISC 13.6) 
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Minor Axis of Bending 

For Class 3 channel sections bent about thetr m mor axis. 

M,:::: =M~:::: =S:::F,. 

T-shapes and double angles 

Major Axis of Bmding 

For C!ass 3 sections of T-shapes and double angles the factored major bending 
strength is assumed to be (CISC 13.6d), 

W.11~ El .. GJ [ r:--;::c] 
M, 33 =tp - L -- B+,¡I+B· :><!>F,S,,.where 

B = ± 2.3(djL),II, /J. 

The positive sign for B applies fortension in stem ofT-sec11ons oroutstanding legs 
of doublc angles (positive moments) and the negative sign applies for compression 
in stem (negative moments). 

Minor Axis of Bmding 

For C!ass 3 sections of T-shapes and double angles the factored minor bending 
strength is assumed as. 

M,, =<pF,S,. 

Single Angle and General Sections 

For Class 3 single angles and for General sections. the factored major and minor di­
rection bending strengths are assumed as, 

M, 33 = tpF,.S 33 , and 

M,,= tp F,S,. 

Shear Strengths 

The factored shear strength. V,,. for major dtrectton shears in 1-shapes. boxes and 
channels is eva!uated as follows (CISC !3.4.1. 1 ): 
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• For h $ 439/!'.c:_, 
1" \ F, 

V,,~ <pA,{066F,.}. (CISC 13.4.1.1) 

or ·- < - :::; ) _ - , F 439 /C" h -oojt·· VF,. 1, F, 

r Jk, F 1 
<pA,\290 '}. 

l h/1, J 
(CISC 13.4.1.1) 

For 502 ~ < .!!_ $ 621 ~-k_, , 
V F, 1,. V F, 

v,, ~ <pA, {F"' +F,}, where (CISC 13.4.1.1) 

fkF 
F ·~ 290 \ ' ' and 

"' 1 1 , 
1 f" 

r 1 1 
F, ~ (0.5F, -0.866F,) j _ } . 

l ~¡ +(a!h)' J 

Assummg no stiffener !S used. the value of F, is taken as zero. 

h ~· For - > 621 -·· , 
t., F). 

V,, ~ <pA, {f,,. + F,}, where 

F ~ !80000k, 
,,. (M,¡' . 

(CISC 13.4.1.1) 

In the above equations, k, is the shear buckling coeff1cient. and 1t is defined as: 

k = 4+ 5.34 
' (alh)'' 

alh<! 

k =5.34 + 
4 

- , 
(a 1 h)' 

a 1 h ~ 1 
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and the aspect ratio a/ h is the ratio of the distance between the stiffeners to web 
depth. Assummg no stiffener is used. the value of k, is taken as 5.34. 

The factored shear strength for minor direction shcars in 1-shapes. boxes ande han­
neis is assumed as 

V,, ~ 0.66 q> F, A,., . (CISC 13.4.2) 

The factored shear strength for major and minor direction shears for all other sec­
tions is assumed as (CISC 13.4.2): 

V-,_ 0.66 q> F, A,., , and 

0.66q>F,A, 3 • 

Calculation of Capacity Ratios 

(CISC 13.-1.2) 

(CISC 13.4.21 

In the calculation of the axial force/biaxial moment capacity ratios. first, for ea eh 
station along the lengtli ofthe member. for each load combination. the actual mem­
ber force/moment components are calculated. Then the corresponding capacittes 
are calculated. Then, the capactty ratios are calculated at each statton for ea eh mem­
ber under the tnfluence of each of the design load combinations. The controlling 
compression and/or tension capacity ratio is then obtained, along with the associ­
ated station and load combination. A capacity ratio greater than 1.0 indicares e\­
ceeding a limit state. 

During the design, the effect ofthe presence of bolts or welds is not considered. 
Also, the joints are not designed. 

Axial and Bending Stresses 

From the factored axialloads and bending moments at each statwn and the factored 
strengths for axial tenston and compression and major and minar bending. an inter­
action capacity ratio is produced for each ofthe load combinations as follows: 

Compressi••e Axial Load 

Ifthe axial load is compressive. the capacity ratiO for all sections except Class 1 
l-shaped sections ts given by: 

C, U 13 M'" U, M"' + ---''---..:..:'- -,-
cr MrJ3 Mr:: 

76 Calculation of Capacity Ratios 
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For Class 1 1-shaped sections the capacity is given by: 

e, 
C, 

U M 
+0.85 13 

{3.3 

Af r33 

U
1

, M,,, 
+0.6 - --

M--, --
(CISC 13.8.2) 

The above ratios are calculated for ca eh of the fol!owing conditions and the largest 
rallo is reported: 

Cross-sectional Strength: 

- M, 33 and M,, are calculated assuming latcrally braced mcmbers. 

-e, =<JlAF,, and 

- U 13 =U" =1.0. 

Overall Member Strength: 

- M"' and M,, are calculated assuming lateral! y braced members. and 

- e, is evaluated with K= 1.0 in the d1rection ofbending. 

Lateral-Torsional Buckhng Strcngth: 

e . 1 1 d b K-- /,, , 1s ca cu ate ased on -- -- onl) . and 
r~~ 

For Class 1 I-shapes, the following ratio is al so checked: 

M n; 
--+ 
Af r3' 

M'" 
M, 

'--

In the above expressions, 

u 1 

e,.= 

1-C¡IC,. 

rr: E 1 

L: 

W¡ = 0.6 -0.4 M, /M, ~ 0.4, and 

(CISC 13.8.2) 

(CISC 13.8.3) 

M, 1M, 1s the ratio ofthe smal!er to the larger moment at the ends ofthe member, 
M, 1M, being positive for double curvature bending and negative for single cur­
vature bending. W¡ is assumed as 1.0 for beams with transverse load and when M, 
is zero. 
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The program defaults w, to 1.0 ifthe unbraced length./. ofthe member is redefined 
by the user (i.e. it is not equal to the length ofthe member). The user can overwrite 
the value of w, for any member by specifying it. The factor U 1 must be a posil!ve 
number. Therefore e 

1 
must be less than e, .. Ifthis is not true. a failurc condition is 

declared. 

Tensile Axial Load 

Ifthe axial load IS tensile the capacity ratio is given by the larger of: 

(CISC 13.9) 

assuming M,3 and M,:: are calculated based on fully supported (/ =0). and 

r M'" + 
M r:: l rr,Z33 l 

(íor Class 1 and 2) or l M,, M,, J - l M,3 A J (CISC 13.9) 

r M f3' + M"' l r rl s" l 
(for Class 3). l M,, M,:: J lM, 31 Aj (CISC 13.9) 

For circular sections an SRSS combination¡s jirst m a de ofthe two bending compo­
nents be(ore adding the axial load compone1ll instead ofthe szmple algebraic addt­
tion implied by the above interactionformulas. 

Shear Stresses 

From the factored shear force values and the factored shear strength values at each 
station. for each ofthe load combinattons. shcar capacity ratios for major and minor 
directwns are produced as follows: 

Vr: 
and 

Vr:: 

vn 
v, 

78 Calculation of Capacity Ratios 

" 



e h a p te r VIl 

Check/Design for BS 5950 

This chapter describes the details ofthe structural-steel design and stress check al­
gorithms that are used by SAP2000 when the user selects the BS 5950 design code 
(BSI 1990). Various notauons used in this chapter are described in Table VII-L 

The design is based on user-specified loading combmations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
sign of most building type structures. 

In the evaluation ofthe axial force/biaxial moment capacity ratios ata station along 
the length of the member, first the actual member force/moment cr·•1ponems and 
thc corresponding capacittes are calculated for each load combinatto ... Then the ca­
pacity ratios are evaluated atea eh station under the influence of all load combina­
tions using the corresponding equations that are defined in this section. The con­
trolling capacity ratio is then obtained. A capacity ratio greater than 1.0 indicates 
exceeding a limlt state. Similarly, a shear capacity ratio is also calculated sepa­
rately. 

English as well as SI and MKS metric units can be used for input. But the code is 
based on Newton-Millimeter-Second unus. For simplicity, all equations and de­
scriptions presented in this chapter correspond to Newton-Millimeter-Second 
units unless otherwise noted. 

79 
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80 

A 

A, 
A,~.A,.1 

B 
D 

E 

G 

H 

/H 

1, 
J 

K 

K33'K~: 
M 

A/33 

M, 
t\1 a)3 

M a:: 

t\1 h 

i\1 e 

Af c~J 

/t.f e:: 

M, 
P, 

pc3) .P,:: 

P, 

P.: ,P~, 
S).~.S:: 

T 

Cross-sectional area. mm' 

Gross cross-seclional area. mm' 

Majar and minor shear areas. mm' 

Breadth. mm 

Depth of section. mm 
or outside diarneter of pipes. mm 

Modulus of elasticit). MPa 

Axial cornpression. N 

Axml tens10n. N 

Majar and minar shear loads. N 

Shear modulus. ~!Pa 

\Varping constant. mm~ 

MaJOT moment ofmerua. mm~ 

Minor moment of men1a. mm~ 

Torsional constan! for the section. mm~ 

Effect1ve Jength factor 

Majar and minor effecnve length factors 

Apphed mornent. r\-mm 

Applied moment about maJar axis. N-mm 

Applied mornent about m mor axis. N-mm 

Majar max1mum bendmg moment. N-mm 

Minar max1murn bending moment. N-mm 

Buckling resisto.nce mament. N-mm 

Moment capacny. f\-mm 

MaJar mament capacity. N-mm 

Minor moment capacity, N-mm 

Elastic criucal moment. N-mm 

Compression resistance. N 

Major and rninor cornpressian res¡stance. N 

Tensian capacity. N 

Majar and minar shear capacities. N 

Major and minor plastic section modulL mm 1 

Th1ckness of tlange or leg. mm 

Speciiied y1eld strength. MPa 

Majar and mmar elastic section moduli. mm1 

Table VII-I 
ES 5950 Norations 
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d 

h 

k 

/)),/:: 

/e))' /e1~ 
m 

1¡ 

r. 
ll 

V 

E 

11 
'la 
P, 
p, 
P. 
ljl 
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Robenson constant 

Outstand width. mm 

Depth of web, mm 

Story height, mm 

Distance from o u ter face of flang:e ro web toe of fillet, mm 

Unbraced length of rnember. mm 

MaJar and minar direction unbraced member lengths. mm 

MaJor and mmor effective lengths, mm 

Equivalent unifonn rnoment factor 

Elasuc critica! shear strength of web panel. MPa 

Critica! shear strength of \Veb panel. MPa 

Majar and minor radi1 of gyration, mm 

Mmimum radius of gyration for angles. mm 

Thickness. mm 

Flange th1ckness. mm 

Thickness of web. mm 

Buckling parameter 

Slenderness factor 

Ratio of smaller to larger end moments 

[ 
17' )~ 

Constan! ~>-

Siendemess parameter 

Limiting slendemess 

Equivalent s!enderness 

Limiting equivalent slenderness 

Perry factor 

Peny coefficient 

Compressive strength, MPa 

Euler strength, MPa 

Yield strength, MPa 

Monosymmetry 1ndex 

Table VII-I 

BS 5950 Notations (con t.} 

" 
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Design loading Combinations 
The design load combmations are the various combinations of the load cases for 
which the structure needs to be checked. According to the BS 5950 code. ifa struc­
ture is subjected to dead load (DL), live load (LL). wind load (WL). and earthquake 
load (EL); and considering that wind and earthquake forces are reversiti!e. then the 
fo!lowing load combmations may ha ve to be considered (BS 2.4 ): 

1.4 DL 
1.4 DL + 1.6 LL 

1.0 DL ± 1.4 WL 
1.4 DL ± 1.4 WL 
1.2 DL + 1.2 LL ± 1.2 WL 

1.0 DL ± 1.4 EL 
1.4 DL ± 1.4 EL 
1.2 DL + 1.2 LL ± 1.2 EL 

(BS 2.4.1.1) 

(BS 2.4.1.1) 

These are a!so the default design load combinations whenever" BS 5950 Code is 
used. The user should use other appropriate loading combinations ifrooflive load 
is separately treated, other types of loads are present. or if patte:n !ive loads are to 
be considered. 

Live load reduction factors can be applied to the member forces ofthe live load case 
on an element-by-element basis to reduce the contribution of the live load to the 
factored loading. 

In addition to the above load combinations. the code requires that all buildings 
should be capable ofresisting a notional design horizontal load applied at each !loor 
or rooflevel. The notionalload should be egua! to the maximum ofO.O! times the 
factored dead load and 0.005 times the factored dead plus live loads (BS 2.4.2.3). 
The notional forccs should be assumed to act in any one direction at a time and 
should be taken as actmg simultaneously with the factored dead plus verttcal im­
posed live loads. They should not be combined with any other horizontal load cases 
(BS 5.1.2.3 ). It ts recommended that the user should define additionalload cases for 
considering the notionalload in SAP2000 and define the appropriate design combi­
nations. 

When using the BS 5950 code, SAP2000 design assumes that a P-L'i analysis has al­
ready been performed. so that moment magnification factors for the moments 
causing side-sway can be taken as unity. It is suggested that the P-L'i analysis be 

82 Design Loading Combinations 
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done at the factored load le,·el corresponding to 1.2 dead load plus 1.2 hve load. See 
al so White and Hajjar ( 1991 ). 

Classification of Sections 
The nominal strengths for axial compression and flexure are dependen! on the clas­
sificat!On of the section as Plastic, Compac1. Semi-compact. or Slender. SAP2000 
checks the sections according to Table Vll-2 (BS 3.5.2). In th1s Tab1e: 

R is the ratio of mean longnudinal stress in the web to p, in a semi-compact 
section. This implies that for a semi-compact section in pure bending R is zero. 
In ca1culating R. compression is taken as positive and tension is taken as nega­
tive. 

a is given as 2y of d, where y, is the distance from the plast1c neutral axis to the 
edge ofthe web connected to the compression flange. For a> 2. the section is 
treated as having compression throughout. 

1'-
E is defined as (275/ p,) - . 

The section is classified as either C1ass 1 (P1astic). C1ass 2 (Compact). or Class 3 

(Semi-compact) as applicable. If a section fails to satisfy the limits for C1ass 3 
(Semi-compact) sections, thc section is classified as Class 4 (Siendcr). Cur-

rently SAP2000 does not check stresses for Siender sections. · 

Calculation of Factored Forces and Moments 
The factored member loads that are calculated for each load combinar ion are F, or 
F,. M 33 , M'". F,:. and F" correspondmg to factored values ofthe tensile or com­
pressive axial load, the majar momem. the minar moment. the majar direction 
shear load. and the minar direction shear load. respectively. These factored loads 
are calcu1ated at each of the prev10usly defined stat10ns. 

The moment magnification for non-sidesway moments is included in the overall 
buck1ing interact10n equauons. 

M = M, + { 
1 

} M, . where 
1-200 !jl,.,u 

(BS 5.6.3) 

!jl """' Maximum story-dnft divided by the story-height. 
M, Factored moments not causing translation, and 
M, Factored moments causing sidesway. 
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Description Ratio Class 1 Class 2 Class 3 
of Section Checked (Piastic) (Compact) (Semi-compact) 

GE!'iERAL - Assumed Semi-compact 

SO LID 
Assumed Compact 

RECT Al'iGLE -

b/T(Rolled) 5 8.5 E $ 9.5 E :5!5E 

b/T(welded) $75E 585E $ !3 E 

ForR > 0: 

!20E (41 ) 5---and$ --13 E(welded) 

79 E 
h 1.5R R 

98 E 
d/t 5 5- 120E (41 ) 0.4 + 0.6 a a 5--- and :5 -- 2 e (rolled) 

webs (a < 2) 1 + 1.5R · R 

1-SHAPE ForR=0:SJ20r 
POE 

For R < 0: S:----- and $ 250 f 
<I-Rr 

d/t 
5 39 E 5 39 E $39 E 

webs (a~ 2) 
(rolled) 

d/t 
webs (a ~ 2) $28 E S: 28 E $ 28 E 

(welded) 

b/T(Rolled) $ 26E $ 32 E 5 39 E 

BOX b/T(welded) $13 E $ 25 E $ 28 E 

d/t As for As for As for 
1-shapes 1-shapes I-shnpes 

CHAI'iNEL 
b/T As for As for As for 
d/t 1-shapes 1-shapes 1-shapes 

Table VII-2 
C/assification ofSections According to BS 5950 
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Description Ratio Class 1 Class 2 Class 3· 

of Section Checked (Piastic) (Compact) (Semi-compact) 

T-SHAPE 
h/T 

1 

::; 8.5 E $9.5 E $ 19 E 

d/t $ 8.5 E $9.5 E $!9E 

b/T $8.5 E S: 9.5 E S:l5E 

ANGLE h+d -- - - $23E 
T 

SO LID 
Assumed Compact 

C!RCLE -

PIPE D/t :5 40 E~ $ 57é s: go é 

d/T :5 8.5 E $9.5 E $ 15 E 

DOUBLE 
ANGLE 

tseparared) hTd 
$13 E -- - -T 

Table Vll-2 (con!.) 
C/assificalion o(Secrions According ro BS 5950 

The moment magnification factor for moments causing sidesway can be taken as 
unity if a P-L'I analysis is carried out. SAP2000 design assumes a P-L'I analysis has 
been done and. therefore. 4' ··••" for both major and m mor direction bending is 
taken as O in the followmg equation. Jt is suggested that the P-L'I analysis be done at 
the factored load level of 1.2 DL plus 1.2 LL. See al so White and Haj_¡ar ( 1991 ). 

Calculation of Section Capacities 
The nominal strengths in compression. tension. bending, and shear are computed 
for Class 1, 2. and 3 sections according to the following subsections. By default, 
SAP2000 takes the des1gn strength, p ,. , to be 1.0 times the minimum yieJJ strength 
of steel. Y,. as specified by the u ser. In mputting values of the y1eld strength. the 
user should ensure that the thickness and the ultimare strength hmitations given in 
the codeare satisfied (BS 3.1.1). 

p ,. = J.OY, (BS 3.1.1) 
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ll-'=== 
1--- b _.¡ 

BS 5950 : Axes Conventions 

3-3 is the cross-section axis parallel to the flanges or the 
smaller Jeg in angle sect10ns. Th1s JS the same as the x-x 
axis. 

2-2 is !he cross-section axis perpendicular to !he flanges 
or the smaller leg in angle sections. This JS the same as 
the y-y axis. 

Figure VII-I 
ES 5950 Definition ofGeometricProperties 
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For Class 4 (5/ender) secrions and any singly symmetric and unsymmetric sections 
requiring special Ereatment. su eh as the considera !ion of local bucklmg . .flexural­
torsional and torsional buckling, or lveb buck!ing. reduced section capacities may 
be app/icable. The u ser must separare/y investiga le this reducuon if suclz elements 
are used. 

{fthe user speCI(ies nominal srressesfor one or more elemenrs in the "Redefine Ele­
ment Design Dara ··. these values wil/ override al/ abrJI'e the melltÍolled ca/culated 
t.'aluesfor tltose e/ements a!J defined in the [o!lm1·rng subsecrions. 

Compression Resistance 

The compress10n resistance for plastic, compact, or semi-compact sections is 
evaluated as follows: 

where p, is the compressive strength given by 

P, +(ll+l)p, 
<p=----"-

" 
= 

a 

Euler strength, n'E /"-', 

Perryfactor.0.001a(A-A
0

) ~O, 

Robenson constant from Table Vll-3. 

( . Ir, n-E 
Limiting slendemess, 0.2 -- , and 

l p' ) 

(BS 4.7.4) 

(BSC.I) 

(BS C.2) 

(BS C.2) 

/, tS the slendemess ratio in either the majar. ). 33 = 1,. 33 1 r33 , or in the mmor, 
A., = 1, 00 1 r:: direction. The larger ofthe two values is used in the above equa­
tiOns to calcuiate Pe. 

For members m compression, if ), is grcater than 180. a message to that effect is 
printed (BS 4.7.3.2). For single angles r, is used instead of r

33 
and r00 • 
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Description 
Axis of Bending 

of Section 

1-SHAPE 
(rolled) 

H-SHAPE 
lrolled) 

1-SHAPE 
(welded) 

BOX 
(welded) 

RECTA:\GULAR 
orCIRCLE 

AI'>GLE, CHANI\'EL. 
T-SHAPE 

GEl\' ERAL 

Thickness (mm) 

1\!ajor 

any 2.0 

540 3.5 
>40 55 

,; 40 3.5 
>40 3.5 

,; 40 3.5 
>40 5.5 

,; 40 35 
>40 5.5 

any 5.5 

any 5 5 

Table VII-3 
Robertson Constan/ in BS 5950 

Tension Capacity 

The tension capacity of a member is given by 

1\!inor 

3.5 

5.5 
8.0 

5.5 
8.0 

3.5 
5.5 

3.5 
5.5 

5.5 

5 5 

(BS 4.6.1) 

lt should be noted that no net section checks are made. For mam members in ten­
sion, the slendemess, A, should not be greater than 250 (BS 4. 7.3.2). If A is greater 
than 250, a message is displayed accordingly. For brace members, a similar mes­
sage is displayed when slendemess exceeds 350 (BS 4. 7.3.2). 

The user may have to separately investigare the members which are connected ec­
centrically to the axis ofthe member. for example angle sectiOns. 
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Moment Capacity 

The moment capacities in the majar and minar directlons. M"' and M ,::are based 
on the design strength and the section modulus. the co-existen! shear and the posst­
bility of!ocal buckling ofthe cross-section. Local buckling is avoided by applying 
a limitatton to the width/thickness ratios of elements ofthe cross-section. The mo­
ment capacities are calculated as follows: 

Plastic and Compact Sections 

For plastic and compact sections, the moment capacities about the majar and the 
minar axes ofbending dcpend on the shear force. F,. and the shear capacity. P, .. 

For 1-. Box-. and Channel-sections bending about the 3-3 axis the moment capaci­
ues considering the effects of shear force are computed as 

M,.~ p,S S: 1.2 p,.Z, for F, S: 0.6P, , (BS 4.2.5) 

(BS 4.2.6) M, ~p,(S- S,.p,) S:l.2p, Z, for F,.>0.6P,. 

where 

S ~ Plastic modulus ofthe gross section about the relevan! axis, 

z 

S, 

P, 

Elastic modulus ofthe gross section about the relevant axis, 

Plastic modu!us of the gross sectton about the relevan! axis 
less the the p!astic modulus ofthat pan ofthe section remaining 
after dcduction of shear are a i.e. plastic modulus of shear are a. 
For example, for rolled 1-shapes S,, is taken to be tD: /4 and 

for welded 1-shapes it is taken as td' /4, 

The shear capacity described later m thts chapter, 

2.5F, 
- 1.5. 

P,. 

The combined effect ofshear and axial forces is not being considered beca use prac­
tica! situations do not warrant this. In rare cases, however, the user may ha veto in­
vestiga te this independently, and if necessary, overwnte values of the section 
modult. 
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For all other cases, the reduction of moment capacities for the presence of shcar 
force is not considered. The user should investigate the reduced moment capaclly 
separately. The moment capacity for these cases is computed in SAP2000 as 

M, =p,S::; 1.2p,Z. (BS 4.2.5) 

Semi-compact Sections 

Reduction of moment capaCity due to coexisten! shear does not apply for semi­
compact sections. 

(BS 4.2.5 J 

Laterai-Torsional Buckling Moment Capacity 

The lateral to~sional buckling resistance moment, M,. of a member is calculated 
from the following equations. The program assumes the members to be unifonn (of 
constant properties) throughout their lengths. Furthennore members are assumed to 

be symmetrical about at least one axis. 

For 1-, Box-, and Channel-sections M h is obtained from 

M = 
h where (BS B.2.1) 

The elastic critica! moment. 
S,,rr'E d 

· an 
A.u' . 

(BS 82.2) 

ll,T = The Perry coefficient. 

The Perry coefficient. llu . for rolled and welded sections is taken as follows: 

For rolled sections 

llLT = ah {A.,T -1., 0 } <:0, and 

for welded sections 

90 Calculation of Section Capacities 

" 

(BS B2.2) 



Chapter VIl Check/Design for BS 5950 

In the abo ve definition of ll,r. i," and ), u are the limitwg equivalent slendemess 
and the equivalem slendemess. respectively. and a" is a constant. a, is taken as 
0.007. For flanged members symmetrical about at least one axis and unifom1 
throughout their length. A"' and ), LT are defined as follows: 

/rr' E 
ALU= 0.4¡- • 

\ P, 

A LT = n u v f~ , wherc 

A is the slendemess and is equivalen! to 1" / r". 

(8:, 82.4) 

(8S 82.5) 

11 is the slendemess correction factor. For flanged members in general. not 
loaded between adjacent lateral restraims. and for cantilevers without tnterrne­
diate lateral restraintS,I11S taken as 1.0. For members with equal flanges loadcd 
between adjacent lateral restraints. the value of 11 is conservatively taken as 
. gtven by the following forrnula. Thts. however, can be ovcrwritten by the user 
for any member by specifymg it (8S Table 13). 

1 
n = --== . where 

,le, 

e 12.5 M mar d 
, = , an 

2.5M""' +3MA +4AI8 •3Mc 

M'""'. M" , M 8 , and M e are absolute val u es of maximum moment. 1/4 
point, cemer of span and 3/4 point majar moments respectively. in the 
mcmber. The program al so defaults e, to 1.0 ifthe unbraced length, /, of 
the member is redefined by the user (i.e. it is not equal to the length ofthe 
member). e, should be taken as 1.0 for cantilevers. However. the program 
is unable to detect whether the member is a cantilever. The user can over­
write the value of e, for any member. 

11 !S the buckling parameter. lt is conservatively taken as 0.9 for rol!cd 1-
shapes and channels. For any other section, u is taken as 1.0 (8S 4.3.7.5). 

,. is the slendemess factor. lt is gtven by the followmg forrnu1a for symmetric 
sections. Thts equation is a stmplified version of equation (8S 8.2.5 ). The tor­
sional index used in the calculation of the slendemess factor is simplified to 
DjT (8S 4.3. 7.5). 
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1 
V = ------""""7 

{¡ 1 P-Tl' }r. 
+ 2o L"DJ 

(BS 8.2.5) 

For all other sections, lateral torsional buckling is not cons1dered. The user should 
investigate moment capacity considering lateral-rorswnal buckling separately. 

Shear Capacities 

The shear capacities for both the majar and minar direction shears in 1-shapes. 
boxes or channels are evaluated as follows: 

P,., = 0.6 p, A,, , and (BS 4.2.3) 

P,., = 0.6 p, A,, . (BS 4.2.3) 

Moreover, the shear capacity computed above is val id only if d/ 1 s; 63 E, stnctiY 
speaking. For d/ 1 > 63 E, the shear buckling ofthe thm members should be checked 
independently by the u ser in accordance with the code (BS 4.4.5 ). 

Calculation of Capacity Ratios 
In the calculation of the axial forcetbiaxial moment capacity ratios, first. for each 
station along the !ength ofthe member, for each load combination, the actual mem­
ber force/moment components are calculated. Then the corresponding capaclt!es 
are calculated. Then, the capacity ratios are calculated at each station for each mem­
ber under the influence of each of the design load combinations. The controlhng 
compression andlor tension capacity ratio is then obtained. along with the associ­
ated station and load combination. A capacity ratio greater than 1 .O indicates e~­
ceeding a limit state. 

During the design, the effect ofthe presence ofbolts or welds is not considcred. 
Also, the joints are not designed. 

Local Capacity Check 

For members under axial load and moments. local capacity ratios are calculated as 
follows: 

92 Calculation of Capacity Ratios 
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Under Axial Tension 

A simp!ified approach allowed by the code is used to check the local capacity for 
plastic and compact sections. 

~ + A433 
A¡:p 1. i\-1, 3_; 

Under Axial Compression 

(BS 4.8.2) 

Similarly, the same simplified approach is used for axial compression. 

+ M3; 

M,33 

M, 
+ -----

M,.o:; 

Overall Buckling Check 

(BS 4.8.3.2) 

In addition to local caracity checks, which are carríed out at section leve!. a com­
pression member with bendíng moments is also checked for overall buckling tn ac­
cordance with the following interaction ratio: 

~+ m3~A1 33 .,_ m~ ... Al.., ... 

A,p, M"3 p,Z, 
(BS 4.8.3.3.1) 

The equivalent uníforrn moment factor. m. for members of uniforrn sectíon and 
with flanges, not loaded between adjacent lateral restraints. ís defined as 

m~ 0.57 +0.33~+0.10P'. (BS Tablc 18) 

For other mcmbers. the value of m ts taken as 1.0. The program defaults m to 1 .O íf 
the unbraced length,/, ofthe member is overwrítten by the user (í.e. ifit ts not equal 
to the length ofthe member). The user can overwrite the value of m for any mem­
ber by specifyíng it. ~ is the ratio ofthe smaller end moment to the larger end mo­
ment on a span equal 'to the unrestramed length. being positive for single curvature 
bending and negative for double curvature bendíng. 

Shear Capacity Check 

From the factored shear force values and the shear capacity values at each statíon. 
shear capacity ratws for majar and minar dírections are produced for each of the 
load combinations as follows: 
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F,.: -, 
P, . -
F,.3 

P,.J 

and 
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e h a p t e r VIII 

Check/Design for EUROCODE 3 

This chapter describes the details ofthe structural steel design and stress check al­
gorithms that are used by SAP2000 when the user selects the Eurocode 3 design 
code (CEN 1992). The program investigates the limiting states of strength and sta­
bility but does not address the serviceability limit states. Various notations used in 
this chapter are described in Table VIII-l. 

The design is based on user-specified loading combinations. But the program pro­
vides a set of default load combinations that should satisfy requirements for the de­
sigo of most building type structures. 

In the evaluation ofthe ax•al force/biaxial moment capacity ratios ata station along 
the length of the member. first the actual member force/moment components and 
the correspondmg capacities are calculated for ea eh load combination. Then the ca­
pacity ratios are evaluated at each station under the influence of all load combina­
tions using the corresponding equations that are defined in this section. The con­
trolling capacity ratio is then obtained. A capacity ratio greater than 1.0 indicates 
exceeding a limit state. Similarly, a shear capacity ratio is calculated separately. 

English as well as SI and MKS metric umts can be used for input. But the code is 
based on Newton-Millimeter-Second units. For simplicity, all equations and de­
scriptions presented m this chapter correspond to Newton-Millimeter-Second 
units unless otherwise noted. 

95 



SAP2000 Steel Design Manual 

96 

A 

E 

G 

1, 

!, 

1 J) 

I, 

K 

L 

K 31 .K:: 

Mb"' 

M" 
M,_Sd 
M,s¿ 

. A433Sd 

M:2Sd 

A1 33 Rd 

MnM 
1\''b Rd 

Nb33&! 

Nb22M 

]\/e Sd 

N,"' 
Nrsd 

N,"' 
NI'IRrl 

V::.s.1 

VJSd 

V:.Rd 

.v)Rd 

U',., n, ~r .. , ~~ 

Gross cross-sectional area. mm= 

Areas for shear in the 2- and 3-direcuons. mm~ 

Modulus ofelasticny. Mpa 

Shear modulus. Mpa 

Torsion consrant, mm' 

\Varpmg constant. mm~ 

Majar momenr of inenia. mm" 

Minor moment ofmertla, mm4 

Effecuve length factor 

Length. span. mm 

Majar and minar effecuve length factors 

Design buckhng resistance moment. N-mm 

Elastic cnttcal moment for lateral-torsional bucklmg. N-mm 

Design moments not causing sidesway. N-mm 

Design moments causing sidesway. N-mm 

Design value of moment about the majar ax1s. N-mm 

Design value ofmoment about the minar ax1s, N-mm 

Design moment resistance about the major axis. N-mm 

Design moment resistance about the rninor ax1s. N-mm 

Design bucklmg resistance of a cornpression mernber. N 

Design buckling resistance of a cornpression member 
about the majar axis. N 

Design buckling resistance of a compression member 
about the mmor axis. N 

Design value of compressive force. N 

Design compression resistance, N 

Design value oftensile force, N 

Design tension resistance, N· 

Design plast1c shear res1stance. N 

Design value of shear force in the maJor dnection. N 

Design value of shear force in the minar direction. N 

Design shear res1stance in the maJor d¡recuon, N 

Design shear res1stance m the mmor direction, N 

Major and mmor elasuc section moduli. mm1 

Majar and mmor plasllc section moduh, mm
3 

Table VIII-1 

Eurocode 3 Notations 
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Width,mm 

D1stance. mm 

Depth of web. mm 

Nominal yield strength of steel, IvfPa 

Overall depth. mm 

MaJar and minar direction unbraced mcmber Jengths. mm 

Majar and minar radii of gyrauon. mm 

Minimum radius of gyratlon for angles .. mm 

Facrors applied ro the majar and minar design momt!ntS in 
the interaction equations 

Factor apphed ro the ma_1or design moments in the mteraction 
cquation checkmg for failure due ro lateral-torswnal bucklmg 

Th1ckness. mm 

Fiange th1ckness. mm 

Web thickness. mm 

Ratio used m classification of secuons 

Material partial safety factors 

[ ~.S r (/, m MPa) 

Reduction factor 

Post-cntical shear strength, MPa 

Reduct10n factors for buckling about the 3~3 and 2-2 axes 

Reduction factor for lateral-torsional buckling 

Ratio of smaller w larger end moment of unbraced segment 

Amplificauon factor for sway moments 

Table VIII-1 

Eurocode 3 Nowtions (con t.) 
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Design Loading Combinations 
The design loadmg combinations define the vario~s factored combinations of the 
load cases for which the structure is to be checked. The design loadmg combma­
tions are obtained by multiplying the characteristic loads with appropnate panial 
factors of safety. If a structure is subjected to dead load (DL) and live load (LL) 
only. the design will need only one loading combination. namely 1.35 DL + 1.5 LL. 

However, in addition to the dead load and live load. ifthe structure is subjected to 
wmd (WL) or eanhquake induced forces (EL). and considenng that wind and canh­
quake forces are subject to reversals. the following load combinations may ha veto 
be considered (EC3 2.3.3 ): 

1.35 DL 
!.35 DL + 1.50 LL 

1.35 DL ± 1.50 WL 
I .00 DL ± 1.50 WL 
!.35 DL + !.35 LL ± 1.35 WL 

1.00 DL ± 1.00 EL 
1.00 DL + 1.5*0.3 LL ± 1.0 EL 

' 

(EC3 2.3.3) 

(EC3 2.3.3) 

(EC3 2.3.3) 

In fact. these are the default load combinations which can be used or overwritten by 
the user to produce other cntical design conditions. These default loading combina­
tions are produced for persistent and transient design situations (EC3 2.3.2.2) by 
combining forces dueto dead. live. wind. and eanhquake loads for ultimare limit 
states. See al so section 9.4 ofEurocode 1 (CEN 1994) and Table l. 3. and 4 and sec­
tion 4 ofUnited Kingdom National Application Document (NAO). 

The default load combinations will usually suffice for most building des1gn. The 
user should use other appropriatc loading combinations if roof live load is sepa­
rately treated. other types of loads are present. or ifpattern live loads are to be con­
sidered. 

Live load reduction factors can be applied to the member forces ofthe live load case 
on an element-by-element basis to reduce the contribution of the live load to the 
factored loading. 

In addition to the loads described earlier, equivalent lateral load cases for geomet­
ric imperfection should be considered by the u ser, This equivalent load is similar to 
the notional load of the Briush code, and depends on the number of stories and 
number of columns in any !loor (EC3 5.2.4.3 ). Additional load combinations are 
also needed for these load cases. 
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\Vhen using Eurocode 3. SAP2000 design assumes that a P-!i analysis has been per­
fonned so that moment magnification factors for moments causing sidesway can be 
taken as unity. lt is suggested that the P-!i analysis should be done at the factored 
load leve! correspondmg to 1.35 dead load plus 1.35 live load. See also \Vhite and 
Hajjar ( 1991 ). 

Classification of Sections 
The design strength o fa cross-section subject to compresswn dueto moment or ax­
ial load depends on its classification as Class 1 (Piastic¡, Class 2 (Compact). Class 3 
(Semi-compact), or Class 4 (Siender). 

According to Eurocode 3. the classification of sections depends on the classifica­
tion of flange and web elements. The classificatwn a!so depends on whethcr the 
compresston clemcnts are in purc compresswn, pure bending, or under the influ­
ence of combined axial force and bending (EC3 5.3.2). SAP2000 conservatively 
classifies the compression elements for only pure compression according to Table 
VIII-2 and for pure bending according to Table VIII-3, depending on whether the 
member is a column ora beam. The sectton dimensions used m the tables are given 
in Figure VIII-!. Ifthe section dimensions satisfy the limits shown in the tab!es. the 
section is classified as Class 1. Class 2, or Class 3 as applicable. A cross-section ts 
classified by reportmg the highest (least favorable) class of its compression e!e­
ments. 

lf a section fails to satisfy the limits for Class 3 sections. the section is classified 
as Class 4, Currently SAP200" does not check stresses for Class-' sections. 

One ofthe major factors in deterrnining the limiting width-thtckness ratio isE. This 
parameter is used to reflect the influence ofyield stress on the section classification. 

(';1< 
E= /::.:..::. 

VI. 

Calculation of Factored Forces 

(EC3 5.3.2) 

The interna! design loads whtch are calculated for each load combination are N, sJ 

or N cSJ. 111 33 SJ. M 00 sd. V05d and V, 5,~ corresponding to design values ofthe ten­
sile or compressive axtalload. the maJor moment. the mirior moment. the major di­
rection shear and the mmor directton shear respectively. These design loads are cal­
culated at each of the previously defined stattons of ea eh frame element. 
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Section 

GENERAL 

RECTA!\"GLE 

1-SHAPE 

BOX 

CHANNEL 

T-SHAPE 

Al\"GLE 

ROUNDBAR 

PIPE 

DOUBLE 
ANGLES 

Element Ratio Checked Class 1 
1 

Class 2 

- None Assumed Class 3 

- None Assumed Class 2 

weh d/1. 33 E 38 E 

cj11 lrolled) 10 E 11 E 
tlange 

rj11 (welded) 9E lOE 

web d/1. 33 E 38 E 

(h-31¡)/1¡ 
42 E 42 E 

flange 
(rollcd) 

bj11 (weldedj 42 E 42 E 

web d/1. 33 E 38 E 

flange b/lr lOE 11 E 

web d/1. 33 E 38 E 

bj211irolled) 10 E 11 E 

flange 
bjl11 lwelded) 9E 10 E 

h/1 
Not applicable Not applicable - (b+ h)/(21) 

- ?\one Assumed Class 1 

- d/1 50E0 7ÜE0 

h/ 1 
Not apphcable Not apphcable - (h+ h)/(21) 

Table VIII-2 
Classi(ica/ton o(Sections According ro Eurocode 3 

Limiting Widtlr-Tirickness Ratiosfor Compression Elements 
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Class 3 

42 E 

15 E 

14 E 

42 E 

42 E 

42 E 

42 E 

15 E 

42 E 

15 E 

14 E 

15E 

JJ.5E 

9ÜE0 

15E 
11.5E 



Section 

GEl' ERAL 

RECTAI\GLE 

1-SHAPE 

BOX 

CHAI\1\EL 

T-SIIAPE 

Ar\GLE 

ROUNDBAR 

PIPE 

DOUBLE 
ANCLES 
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Element -1 Ratio Checked Class 1 
1 

Class 2 
1 

Class 3 

- None Assumed Ctass 3 

- None Assumed C:bss 2 

web d/1. 72 E 83 E 124 E 

cjrf lrolicd) 10r 1 1 E l5 E 

flange 
cji, (wc1dedl 9E 10 E 14 E 

W•..:b 
1 

d/1. 72 E 83 E 124 E 

(b- )'.1 )/1 1 ¡rolledl 33 f 38 E 42 E 

flang:e 
h/l.r ¡weldedl 33 E 38 E 42 E 

.. djr .. ( MaJOf ax1s) 72E 83 E 124 E 
web 

dfr. (Mmorax1s) 33 E 38 E 42 E 

flange hjt¡ 10 f 11 f ]5 E 

web d/1. 33 E 38 E 42 E 

b/211 lrolled) 10 E 11 E 15 E 

flange 
bf211 (wclded) 9E 10 E 14 E 

h/1 Not Not !5.0E - lb+ h)/(21) appllcablc apphcable 11.5E 

-
1 

Non e Assumed Class 1 

- d/1 5ÜE
1 70E' 90r' 

h/1 Not Not 15.0 f 
- (h+ hl/(21) apphcablc apphcable 11.5 f 

Table Vlll-3 
C/assijica1ion o( Sections According to Eurocode 3 

Limiting Width-Thickness Ratios for F/exure Elements 
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1---- b ._..¡ 1---- b ._..¡ 
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h d 

1 
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t¡ 
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1---- b ---1 

¡ T 
d h 

¡ ~ -tw 

1 
- -t = tw= t¡ 

!¡ 
_j 

1 
d=h-3t 

T 
h 

ll2::== 
1------- b -----+1 

EUROCODE 3 : Axes Conventions 

3-3 is the cross-section axis parallel to the flanges or the 
smaller leg '" angle sect1ons. Th1s is the same as the y-y 
axis. 

2-2 is the cross-section axis perpendicular to the fianges 
or the smaller leg 1n angle sections. Th1s 1s the same as 
the z-z ax1s. 

Figure VIII-1 

tw 

b 

T 
h 

l 

ID 
2,z 

3, y·---t--c3, y 

2,z 

Eurocode 3 Definition of Geometric Properties 
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The design moments and forces need to be corrected for second order effects. This 
correction are different for the so caiJed "sway" and "nonsway" componcnts ofthe 
moments. The code requires that the additional sway moments introduced by the 
horizontal deflection of the top of a story relative to the bottom must be takcn into 
account in the elastic analysis of the frame in one of the foiJowing ways (EC3 
5.2.6.2): 

Directly- by carrying out the global frame analysis using P-il analysis. Mem­
ber dcs1gn can be carried out using inplane buckling lengths for nonsway mode. 

Indirectly- by modifying the results of a linear elastic analysis using an ap­
proximate mcthod which makes aiJowance for the second order effects. There 
are two altemative ways to do this - "amplified sway moment mcthod" or 
'·sway mode inplane buckling method". 

Thc advantage ofthe direct second order elastic analysis is that this mcthod avoids 
uncenainty in approximating the buckling length and also avoids splitting up mo­
ments into their '·sway" and "nonsway" components. 

SAP2000 design assumes that P-il effects are included in the anal~·sis. There­
fore any magnification of sidesway moments dueto second order effects is al­
ready accounted for, i. e. ljl, in the foiJowing equation is taken as 1.0. It is 

suggested that the P-il analysis be done at the factored load leve! of 1.35 DL plus 
1.35 LL. See also White anc HajJ3r (1991). However. the user can overwrite the 
values ofljl, for both major and mmor d¡rection bending in which case Msd in a 
panicular direction is taken as: 

M 5d = A1~ 5d + \VJ M,S.J, where (EC3 5.2.6.2) 

M = ¡:.SJ 

M,sd 

Design moments not causing translation. and 
Design moments causing stdesway. 

Momcnt magnification for non-sidesway moments is included in the overaiJ buck­
ling interaction equations. 

Sway moments are produced in a frame by the action of any load which results in 
sway displacements. The horizontalloads can be expected always to produce sway 
moments. However. they are al so produced by venicalloads if either the loador the 
frame are unsymmetrical. In the case of a symmetrical frame with symmetrical ver­
ticalloads. the sway moments are simply the interna! moments in the frames dueto 
the horizontalloads (EC3 5.2.6.2). 
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Calculation of Section Resistances 
The nominal strengths in compression, tension. bending. and shear are computed 
for Class 1, 2. and 3 sections according to the fol!owing subsections. The material 
panial safety factors used by the program are: 

y" 0 = l. 1 , and 
Y,,"= 1.1. 

(EC3 5. Ll) 
(EC3 5. Ll) 

For Class 4 (Siender) sections and any singf.v symmetric and unsymmetric sections 
requiring special treatment. such as the consideration of local buckling, flcxural­
torsiona! and torsional buckling, or web buckling. reduced section capacities may 
be apphcable. The user must separatef.v mvestigate tlus reduction if su eh elemcnts 
are used. 

lfthe user speci(ies nommal stressesfor one or more e/ements in the "Redefine Ele­
ment Design Data", these values are wi/1 override al/ the above mentioned ca/cu­
lated va/u es for those elemellls as de_(ined in thefol/owing subsections. 

Tension Capacity 

The design tension resistan ce foral! classes of sections is evaluated in SAP2000 as 
follows: 

N,,, =A(, /YMo (EC3 5.4.3) 

It should be noted that the design ultima te resistance ofthe net cross-section at the 
holes for fasteners is not computed and checked. The user is expected to investigate 
this mdependently. 

Compression Resistance 

The design compressive resistance ofthe cross-section is taken as the smaller ofthe 
design plastic resistance of the gross cross-section (N'"") and the design local 
buckling resistance ofthe gross cross-section (N""). 

N e Rd = min (N pi Rd, N h Rd) (EC3 5AA) 

The plastic resistance of C!ass 1, Class 2, and C!ass 3 sections is given by 

N,,,, = Afy /YMP' (EC3 5.4.4) 
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The design buckling resistance of a compress10n member is taken as 

NhRd =x,J/1 ~;.. Af, /Yu 1 , where (EC3 5.5.1) 

~-' = 1, for Class 1, 2 or 3 cross-sect10ns. 

z is the reduct10n factor for the relevant buckling mode. This factor is calcu­
lated below based on the assumption that al! members are of uniform cross­
section. 

1 
X = < 1 . in which 

<p +[<p' .},']X 
(EC3 5.5.1.2) 

<p = 0.5 [ 1 +a ( X:- 0.2) + ¡:: ], 

A=K33/33 K" /,. 
or ---

133 i..~ 
The two values of A gl\'e X 3 and X:. X"'"' is 

the lesser of the two. 

K = !._ s; 1 , K is · conservatively taken as 1 m SAP2000 design (EC3 
L 

5.5.1.5 ). The user can however override this default option if it is deemed 
necessary. An accurate estímate of K can be obtained from the Annex E of 
the code. 

is the buckhng length, 

L is the length ofthe column, 

i is the radius of gyration about the neutral axis. and is determine'ci using 
the propenies of the gross cross-section, 

a is an imperfection factor and ts obtained from Table VIII-4. Values of 
this factor for different types of sections. axes ofbuckling, and thickness of 
materials are obtained from Tables 5.5.1 and 5.5.3 ofthe code. 
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Section Limits a a 
(major axis) (minor axis) 

GENERAL any 0.49 0.49 

RECTANGLE any o 49 049 

1-SHAPE (rolled) tr$40 mm 0.21 0.34 

h/b > 1.2 
tr>40 mm o 34 0.49 

1-SHAPE (rolled) t,SIOOmm 0.34 0.49 

h/b $ 1.2 
tr> lOO mm 0.76 0.76 

trS40mm 0.3.¡ 0.49 

1-SHAPE (welded) 
t

1
>40 mm 0.49 0.76 

BOX 
Rolled 0.21 0.21 
welded 0.3.¡ 0.34 

CHANNEL any 0.49 0.49 

T-SHAPE any o 49 0.49 

ANGLE any 
1 

0.49 0.49 

ROUNDBAR any 049 0.49 

PIPE any 0.21 0.21 

DOUBLE Al\'GLES any o 49 049 

Table VIII-4 
The a .factor for different secuons and different axes of buckling 
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Angle. Channel. and T -sections in compression are subjected toan addiuonal mo­
ment due to the shift of the centrmdal axts of the effective cross-sectwn (EC3 
5.4.4). SAP2000 does not currently considers this eccentricity. The uscr is expected 
to investigare thts issue separately. 

Shear Capacity 
Thc design shear resistance ofa secuon is the mínimum ofthe plastic shear capacity 
and the buckling shear capacity. For al! types of secuons, the plasttc shear resis­
tance is computed as 

V -V - A,/,./ 
R.t- p!Rd-~ Y.uo' ,_, (EC3 5.4.6) 

where A, is the effective shear area forthe scction and the appropriate axis ofbend­
mg. 

The buckling shear capacities are only computed for the 1-. Box-. and Channel­
sections if the wtdth-thickness ratio is large (d/ 1, > 69E). The capacities are com­
puted as 

VRd = vhaRJ =dt,. -r,., /Y.Ifl 
d 

(for - > 69E) 
1, 

(EC3 5.6.3) 

where.T '" is the stmple post-critica! shear strength which is deterrnined as follows: 

,, /n, 
-~, 

../3 
for Í.,. :5:0.8. (EC3 5.6.3) 

't ha =[l-0.625(Í., -0.8)]~, for 0.8 < Í., < 1.2, and (EC3 5.6.3) 

[09/~ l' tha=. l.., . ...¡)' for I, ~ 1.2. (EC3 5.6.3) 

in which I, ts the wcb slendemess ratio. 

d/1, d 
--"--':= , an 
37.4E,jk, . 

(EC3 5.6.3) 

and k, is the buckling factor for shear. For webs with transverse stiffeners atthe 
suppons but no intermediare transverse stiffeners, 

k, = 5.34. (EC3 5.6.3) , 
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Moment Resistance 

The moment res1stance in the maJar and minar directions is based on the scction 
classification. Moment capacity is al so influenced by the presence of shcar force 
and ax1al force at the cross section. Ifthe shear force is Iess than half ofthc shcar ca­
pacity. the moment capaCity is almost unaffected bv the presence ofshcar force. If 
the shear force is greater than half of the shcar capacity. additional factors need to 
be considered. 

If v,d :; o.sv,,Rd 
For Class 1 and Class 2 Sections 

M =M =Wf/Y ,~, piM ~ ¡· ~w· 
(EC3 5.4.5.2) 

F or Class 3 Sections 

A1,·Rd = MclRJ = 11-',.,/) /Y~j{l · (ECJ 5.4.5.2) 

If vSd > o.sv,,Rd 
For 1-. Box-, and Channel-sections bending about the 3-3 ax1s the momcnt ca­
pacities considering the effects of shear force are computed as 

M _ÍW pA'lJ, 
J .RJ -l pi- -¡;-j --_ 

Í 2 V l' 
p=l~ -IJ 

p/Rd 

" y JHIJ 

$ Al, Rd , where (ECJ 5.-1.7) 

1 
For all other cases. the reduction of moment capacities for the presence ofshear 
force is not considered. The user should mvestigate the reduced moment capac­
ity scparate!y. 

lateral-torsional Buckling 

For the determination oflateral-torswnal buckling resistance, it is assumed that the 
section is uniform. doubly symmetric. under standard conditions ofrestraint at each 
end, and loaded through its shear center. The latera!-torswnal bucklmg resistance 
of a beam is evaluated as. 

(EC3 5.5.2) 
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~-

~ .. 

1, for Class 1 and Class 2 sections, 

w,n~ for Class 3 sections, 
w /31 1' . 

,; 1 . in which 
<j>LT +[q>;T -),;T J>5 

ULT =Q.2J, for rolled sections, 

(X LT = 0.49, for welded sections, and 

r~ w l"' 
1 _I·JJ., .mf,. h 
II.Lr-l Ma J ,were 

(EC3FL!) 

1, The torsion constant,. 

1" The warping constan t. 

L Laterally unbraced length for buckling about the minar axis, 

e, = L88 -1.40\jl +Q.521j1: ,; 2.7, and 

= The ratio of smaller to larger end moment ofunbraced segment, M" .ljl 
- - M 

h 

varies between -1 and 1 ( -1 ,; ljl ,; 11. A negative value implies double curva­
ture. M, and M" are end moments of the unbraced segment and M, is Jess 

than M" ( ~:: ) being negative for double curvature bending and positive for 

single curvature bending. lf any moment within the segment is greater than 
M" e, ts taken as LO. The program defaults e, to LO ifthe unbraced length./ 
ofthe member is overwrmen by the user (i.e. it is not equal to the length ofthe 
member). e, should be taken as 1 .O for cantilevers. However, the program is 
unable to detect whether the member 1s a cantilever. The user can overwrite the 

value of e, for any member by specifying it. 
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If );: ,, s; 0.4. no allowance for lateral torsional buckling is required by e o de and JS 

not made in the design. 

Calculation of Capacity Ratios 
In the calculation of thc axtal force/bmxial moment capacity rauos. first. for each 
station along the length ofthe membcr. for each load combmation. the actual mem­
ber force/moment components are calculated. Then the corresponding capacities 
are calculated. Then. the capacJty ratios are calculated atea eh station for ea eh mem­
ber under the influence of each of the design load combinations. The controlling 
compression and/or tension capaCJty ratio is then obtained. a long with thc associ­
ated station and load combination. A capactty ratio grcater than 1.0 mdicates e'­
ceeding a limit state. 

During the design, the cffect ofthe presence ofbolts or welds is not considered. 
Also, the joints are not designed. 

Bending, Axial Compression, and Low Shear 

When the destgn value of the coexistmg shear. V
5

,1 • tS less than half of the corre­
sponding capacities for plasuc resistance. v,t.RJ and buckling resistancc: l'n" R.J. i.e. 

Vs., :::;; 0.5VpiRJ' and (EC3 5.4.9) 

(EC3 5.4.9) 

the capacity ratios are computed for different types of sections as follows: 

For Class 1 and Class 2 secuons. the capacity ratio is conservattvely taken as 

N 
~ 

N p/Rd 

M_lJSd 

Al p133RJ 

. M.,," -r -- -

Al pi:.: Rd 

For Class 3 sections, the capaCJty ratio is conservauvely taken as 

N M _0:i... + 33 S,/ 

Af.~ w,,,f,d 

J =L._ 
.~ . 

"f MO 

+ MO:Sd 

w,.¡:,/," 
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Bending, Axial Compression, and High Shear 

When the design val u e of the coexisting shear. V,". is more than half the corre­
sponding capacities for plastic resistance, V pi Rd or buckling resistance. V t>u Rd. the 
shear is considered to be high. i.e. the shear is high if 

V Sd > 0.5 V"' RJ • or (EC3 5.-1.9) 

(EC3 5.4.9) 

Under these conditions. the capacity ratios are computed for different types of sec­
tions as follows (EC3 5.4.9): 

For Class l. 2, and 3 sections. the capacity ratiO is conservatively taken as 

N 
_.!;2!_ + 
N p/Rd 

M33 Sd 

MI'33Rd 

M" SI + -- ·' . where (EC3 5.4.8.1) 
Afr.::: Rd 

M..,"" and M,., RJ are the design moment resistances about the majar and 
and the minar axes, respective! y, considermg the effect ofhtgh shear (see page 
108). 

Bending, Compression, and Flexura! Buckling 

For all members of Class 1, 2. and 3 sections subject to axial compression, N'". 
majar axis bendmg. M,'". and minar axis bendmg, M 00 ,,~, the capacity ratio is 
given by 

N¡SJ 

N h ""' Rd 

k M + 3:'- 33Sd 

11M d3 RJ 

+k::: M::::::sd 

YJM,::RJ 
where (EC3 5.5.4) 

N h min Rd =mm {J./ h 33 RJ' N h ::::: Rd}' 

k =I-1-l.nNcSJ 
" Af X 33 y 

::; 1.5' 

¡!,. /1' SI k.., ... =}--~ r¡ ::; 1.5, 
-- X:: A/,. 
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r w - w 1 
J.l 33 =X 33 (2~.1133 -4) +l '"' d3J J $ 0.9. (Class 1 andC!ass2). 

we/33 

- ~ J . r w,,::;o - w,¡:: l < 
J.l:: -1-:.: (-~u::- 4) -rl W " J _ 0.9. (Class 1 and Class 2). 

d --

J.l,,=X,(2~ 11,-4)$ 0.9, 

ll:: =1:, (2~.~~:: -4) $ o.9, 

(for Class 3 secttons), 

(for Class 3 sections), 

~ " 33 =Equivalen! uniforrn mamen! factor for flexura! buckling about the 
3-3 (majar) axis between poims braced in 2-2 direction, and 

~ •11 :: = Equivalen! uniforrn mamen! factor for flexura! buckling about the 
2-2 (minar) axis between poims braced in 3-3 direction. 

The equivalen! uniforrn moment factars, ~ .11 33 and ~ .11 ::, are deterrnined from 

MQ 
~.~~= (1.8-0.71j1)+--(0.71jl-0.5),and 

!:J. M 

M Q = Absolute maximum moment due to lateral load only assuming 
simple suppon at the ends, 

1jl Absolute value ofthe ratio of smaller to larger end moment. 
1jl varies between -1 and 1 ( -1 $1j1 $ 1). A negattve value implies 
double curvature. 

!:J. M= Absolute maximum value of moment for moment diagram without 
change of stgn, and 

!1M= Sum ofabsolute maximum and absolute minimum value ofmoments 
for moment diagram Wtth change of sign. 

Bending, Compression, and laterai-Torsional Buckling 

For all members ofC!ass l. 2. and 3 sections subject to axial compression. N sd, ma­
jar axis bending, M 33 sd. and m mor axts bending, M 00 sJ, the capacity ratiO is given 
by 

Nh:!2Rd 

N , Sd + k,T M33Sd +k, M,Sd 

A1bR,/ 11A1,::Rd 
where (EC3 5.5.4) 

Calculation of Capacity Ratios 
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k 22 and r¡ are as defined in the previous subsection "Bending. Compression. 
and Flexura! Buckling", 

k ~ 
LT 

" N }-j"ALT cSd 

X:: AJ, 
,; l. where 

lln ~ 0.151::: P..,u -0.15 ,; 0.9. and 

P, LT ~ Equivalen! uniform moment factor for lateral-torsional b~ckling. lt is 
determined for bending about the y-y axis and between two pomts 
braced in the y-y dtrection . 

. Bending, Axial Tension, and low Shear 

When the design value of the coexisting shear. Vs,. IS less than half of the corre­
sponding Capacities forplastiC resistance. V pi RJ and buckiing reSiStance. V,"·RJ' Í.e. 

(EC3 5.4.9) 

(EC3 5.4.9) 

the capacJty rauos are computed for different types of sections as follows: 

For Class 1 and Class 2 sections, the capacity ratio is conservatively taken as 

NtSJ . ld33Sd M~~sJ 
-- T --"-'"'-.- + •- • 
N,RJ A1 p133RJ A1 pi~: Rd 

For Class 3 sectwns. the capacity ratio is conservatively taken as 

Af," w J el 33 •d 

+ M::sd 

w,.¡:J.d 

Bending, Axial Tension, and High Shear 

(EC3 5.4.8.1) 

(EC3 5.4.8. 1) 

When the design values ofthe coexisting shear. Vs,· is more than halfthe corre­
sponding capacities for plastic resistance, Vr, RJ or buckling resistance, Vb" Rd, the 
shear is constdered to be high, i.e. the shear is high if 

V5" >0.5Vp,Rd' or (EC3 5.4.9) 

(EC3 5.4.9) 
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Under these conditions. the capacity ratios are computed for different types of sec­
tions as follows (EC3 5.4.9): 

For Class 1, 2, and 3 sections. the capacity ratio IS conservatively taken as 

N,Sd 

NrRJ 

A133 Sd 

MI'33RJ 

M :OS.! +--=-=-
A1 r:::: Rd 

Bending, Axial Tension, and lateral-Torsional Buckling 

(EC3 5.4.8.1 J 

The axial tensile force has a beneficia! effect forlateral-torsional buckhng. In order 
to check whether the member fails under lateral-torsional buckling. the effective in­
tema! moment about the 3-3 axis is calculated as fo!lows: 

M M ut NlSdWc"(}m33 where 
eff.33 Sd = 33 Sd - 't' wt· A ' (EC3 5.5.3) 

1jl '" = 0.8 (according to the EC3 box value). and 

W,.,m 33 is the elastic section modulus for the extreme compression fiber. 

For all members of Class l. 2. and 3 sections subject to axial tension. N, s.1. majar 
axis bending, M 33 Sd, and minar axis bendmg. M, sJ. the capacny ratio is taken as 

NtSd 

N,Rd 

N W \ji k t.Sd .,,,, 3:< 

m LT A A1 
1> Rd 

where k a, k, and TJ are as defined in the previous subsectiOns. 

Shear 

(EC3 5.5.4) 

From the design values ofshear force at each station. for each ofthe load combina­
tions and the shear resistance values. shear capacuy ratios for majar and minar di­
rections are produced as follows: 

114 Calculation of Capacity Ratios 
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e h a p te r IX 

Design Output 

Overview 

SAP2000 crea tes design output in three different rnajor fonnats- graphical dis­
play, tabular output, and member specific detailed design mfonnation. 

The graphtcal dtsplay ofsteel design output mcludes input and output design infor­
mation. Input destgn infonnation includes destgn section labels. K-factors, live 
load reduction factors. and other design parameters. The output design information 
includes axial force-bendmg moment interaction ratios and shear stress ratios. All 
graphical output can be printed. 

The tabular output can be saved in a file or printed. The tabular output includes 
most of the infonnat10n which can be displayed. This is generated for added con­
venience to the designer. 

The mernber specific detailed design infonnation shows details of the calculatton 
from the designer's point ofview.lt shows the design section dimensions, material 
propenies, design and allowable stresses or factored and nominal strengths. and 
sorne intennediate results for all the load cornbinations at all the design sections of a 
specific frame member. 

Overview 115 
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In the following sections, sorne ofthe typical graph1cal display. tabular output. and 
member specific detailed design information are described. Sorne ofthe design in­
formatwn is specific to the chosen steel design codes which are available m thc pro­
gram and is only described where required. The A!SC-ASD89 design code is de­
scribed m the Jatter pan ofth1s chapter. For all other codes. the des1gn outputs are 
similar. 

Graphical Display of Design Output 
The graphical output can be produced either as color screen display or in gray­
scaled printed form. Moreover, the active screen display can be sent directly to the 
primer. The graphical display of design output mcludes mput and output design in­
formation. 

Input design information, for the A!SC -ASD89 code. includes 

Design section labels, 

K -factors for majar and minar direction ofbuckling, 

Unbraced Length Ratios, 

e m-factors, 

e' -factors, 

Live Load Reduction Factors, 

li, -factors, 

li, -factors, 

des1gn type, 

allowable stresses in axiaL bending, and shear. 

The output design informatwn which can be dispJ¡¡yed IS 

Color coded P-M mteraction ratios with or without values, and 

Color coded shear stress ratios. 

The graphical displays can be accessed from the Design menu. For examplc. the 
color coded P-M interaction ratios with values can be displayed by selecting the 
Display Design Info ... from the Design menu. This will pop up a dialog box called 
Display Design Results. Then the u ser should swnch on the Design Output option 
button (default) and select P-M Ratios Colors & \'a!ues in the drop-down box. 
Then clicking the OK button will show the mteraction rauos in the active wmdow. 

· 116 Graphical Display of Design Output 
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The graphics can be displayed in either 30 or 20 mode. The SAP~OOO standard 
view transfonnations are availablc for all steel design input and output d1splays. 
For switching between 3D or 20 view of graphical d¡splays. there are severa! but­

tons on the main toolbar. Altematively. the v1ew can be set by choosing Set 30 
View ... from the View menu. 

The graphical display in an active window can be pnnted in gray scaled black and 
white from the SAP2000 program. To send the graphical output directly to the 

primer. chck on the Print Graphics button in the File menu. A screen capture of 
the active window can also be made by following the standard procedure providcd 
by the Windows operating system. 

Tabular Display of Deslgn Output 
The tabular design output can be sent directly either to a printer or to a file. The 
printed fonn of tabular output is the same as that produced for the file output with 
the exception that for the printed output font size 1s adjusted. 

The tabular design output includes input and output design infom1ation which de­
pends on the design code of choice. For the AISC-ASD89 code. the tabular output 
includes the following. All tables ha ve fonnal headings and are self-explanatory. so 
further description of these tables is not given. 

Input design infonnation mcludes the following: 

Load Combination Multipliers 

- Combination name, 

- Load types. and 

- Load factors. 

Steel Stress Check Element Infonnation (code dependen!) 

- Frame m,· 
- Design Section ID, 

- K-factors for major and minor direction ofbuckling, 

- Unbraced Length RatiOS. 

- e m-factors, 

- e'- factors. and 

- Live Load Reduction Factors. 

Steel Moment Magnification Factors (code dependen!) 

Tabular Display of Design Output 117 
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- Frame ID, 

- Section ID, 

- Framing Type, 

- 1i,-factors, and 

- li .. -factors. 

The output design information includes the following: 

Steel Stress Check Output ( code dependen!) 

- Frame ID, 

- Section location, 

- Controlling load combination ID for P-M interaction, 

- Tension or compression indication, 

- ·Axial force-bending moment interacnon ratio, 

- Controlling load combination ID for maJor and minor shear forces. and 

- Shear stress ratios. 

The tabular output can be accessed by selecting Print Design Tables ... from the 
File menu. This will pop up a dialog box. Then the user can ·specify the design 
quanl!ties for which the results are to be tabulated. By default, the output will be 
sent to the primer. If the user wants the output stream to be redirected to a file. 
he/she can check the Print to File box. This will provide a default filename. The 
default filename can be edited. Alternatively. a file list can be obtained by clicking 
the File !\ame button to chose a file from. Then clicking the OK button will d1rect 
the tabular output to the requested stream- the file or the primer. 

Member Specific lnformation 
The member specific design information shows the details ofthe calculation from 
the designer's point of v1ew. It provides an access to the geornetry and material 
data, other input data, design section dimensions. design and allowable stresses. re­
inforcement details, and some ofthe mtermediate results for a rnember. The design 
detail information can be displayed for a specific load combination and for a spe­
cific station of a frame member. 

The detailed design information can be accessed by right clicking on the demed 
frame member. This will pop up a dialog box cal!ed Steel Stress Check Informa­
tion which includes the fol!owing tabulated information forthe specific mernber. 
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- Frame ID. 

- Section ID. 

- Load combination ID. 

- Station location. 

- Axial force-bendmg moment interaction ratio. and 

- Shear stress ratio a long two axes. 

Additional information can be accessed by clickmg on the ReDesign and Details 
buttons m the d¡alog box. Add!tional information that is available by clicking on the 

ReDesign button is as follows: 

Design Factors (code dependent) 

- Effective length factors, K. for majar and minar direction of buckling. 

- Unbraced Length Ratios, 

e m. factors. 

e'-factors. 

- Live Load Reduction Factors, 

o,- factors. and 

o,- factors. 

Elemcnt Section ID 

Elemem Framrng Type 

OvenHitrng allowable stresses 

Additwnal infom1ation that is available by clickmg on the Details button is given 
below. 

Frame. Section. Station. and Load Combination IDs. 

Section geometric information and graphtcal representation. 

Material propenies of steel, 

Moment factors, 

Design and allowable stresses for axtal force and biaxial moments, and 

Design and allowable stresses for shear. 

Member Specific lnformation 119 
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Bendmg strength 
.-\SD (allowableJ, 40 
BS. 89 
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Braced frames. 28 
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Compact section 
See Classificatwn of sections 

Compressive strength 
ASD (allowable), 39 
BS, 87 
CISC, 70 
Eurocode. 104 
LRFD, 55 

Demonstration 
accessmg detailed infonnation. 14 
anal ysts, 1 O 
automattc member selection, 19 
editing member propenies, 16, 19 
reanalysis, 21 
redestgn. 15 
stress check. 12 

Destgn output. 115 
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Effective length factor, 30 
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Factored forces and moments 
BS. 83 
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LRFD. 54 

Flexura! buckling 
ASD. 39 
CISC. 70. 87 
Eurocode. 104 

Graphical output. I 16 

lnteraction equations 
See Capacity ratio 

InteractJve environment, 1 

Lateral drift effect. 28 
See Also P-Delta analysis 
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Live load reduction factor. 27. 36, 50. 66, 
82. 98 

Loadmg combinations, l. 26 
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LRFD, 50 

l'vlember specific output, 118 

Member stabílity effect. 28 
See Also P-Delta analysis 

Moment magnification 
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Eurocode. 103 
LRFD, 54 
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Noncompact section 
See Classificauon of sections 

Nonsway. 28 
BS. 85 
CISC, 67 
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LRFD, 54 

Notional load 
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CISC. 66 
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Output, 2 
details. 14. 119 
graph1cal. 115 
member specific. 13 
tabular. 115 
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BS, 82. 85 
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LRFD. 50. 55 

P-Delta effects. 28 

Perry factor. 87 

Plastic sectiOn 
See Classification of sections 

Redesign. 119 

Robertson constan t. 87 

Second order effects 
See P-Delta effects 

Shear strength 
ASD (allowable), 43 
BS, 92 
CISC. 74 
Eurocode. 107 
LRFD. 60 

Slender sectlon 
See Classificatíon of sections 
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BS. 85 

Supporred desrgn cedes. 1 
ASD. 25.33 
BS. ~5. 79 
CISC. 25. 63 
Eurocode. 25. 95 
LRFD. 25.47 

Sway. 28 
BS. 85 
CISC. 67 
Eurocode. 103 
LRFD. 54 

Tabular ourput. JI 7 

Tensile strength 
ASD ¡allowable). 40 
BS. 88 
CISC. 70 
Eurocode. 104 
LRFD. 56 

Cnbraced frames. 28 
BS. 85 
CISC. 67 
Eurocode. 103 
LRFD. 54 

Cmts. 2. 32 
ASD. 33 
BS. 79 
CISC. 63 
Eurocode. 95 
LRFD. 47 

Cnsupporred Jength. 28 
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PRÓLOGO 

La serie de programas SAP son quizá los programas más conocidos, probados y utilizados en 
el campo de la Ingeniería Estructural, particularmente en el Análisis Estructural, desde las primeras 
versiones SOLIDSAP, SAP 3, SAP IV, etc., hasta la más reciente SAP 2000, han sido utilizadas por 
un gran número de ingenieros en nuestro país y en muchas partes del mundo, cuenta con respaldo y 
soporte técnico al que tiene derecho el usuario autorizado así como a los manuales respectivos. 

Por lo anterior, desde hace algunos años el Departamento de Estructuras de la División de 
Ingeniería Civil Topográfica y Geodesia del la Facultad de Ingeniería de la UNAM consideró 
conveniente impartir una serie de cursos para enseñar a manejar el programa, para ello el contar con 
un instructivo que permita introducir al usuario de una manera fácil al programa facilitará el objetivo 
anterior, por lo que se sugiere que el lector asista a los cursos que organiza del Departamento de 
Estructuras o la División de Educación Continua de la FI de la UNAM. 

En este instructivo se describen algunos de los principales elementos que intervienen en el 
uso del programa de computadora para Análisis y Diseño Estructural SAP-2000, cuya p~jncipal 
utilización será para los alumnos de la materia "Diseño Estructural" de la carrera de Ingeniero Civil 
que se imparte en la Facultad de Ingeniería de la UNAM. 

Se ha procurado realizar este instructivo de una manera sencilla y resumida para que el 
usuario no emplee demasiado tiempo en leerlo y pueda resolver su problema en lo que respecfa al 
Análisis y Diseño de Estructuras utilizando el programa SAP-2000. 

Se recomienda que si algunos de los elementos no son descritos ampliamente se consulten los 
manuales respectivos o la ayuda en linea incluida en el programa y se observen losejemplos que se 
desarrollan al final del instructivo. Se supone que el usuario esta familiarizado con la nomenclatura y 
terminología utilizada en el Análisis y Diseño Estructural y que cuenta con conocimientos básicos de 
computación en lo que respecta a manejo de información (archivos) y ejecución de programas en 
ambiente Windows 95, 98. 

El autor agradece al Ing. Miguel Ángel Rodríguez Vega, Jefe del Departamento de 
Estructuras el apoyo para el desarrollo de este tipo de actividades, por las facilidades otorgadas para 
la realización de este trabajo así como la revisión del presente instructivo. 
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1.1 INTRODUCCIÓN 

EL PROGRAMA 
SAP 2000 

EJ program1 SAP2000 

CAPÍTULO·~ 
I 1 

' 

En los últimos años, el desarrollo de los equipos y sistemas de computo ha permitido una 
comunicación mucho más rápida, directa y sencilla entre el usuario y la computadora logrando la 
posibilidad de desarrollar programas que, utilizando las características de las computadoras de hoy en 
día, nos permitan usarlas mas eficientemente y entre otras cosas facilitándonos la posibilidad de 
explorar varias alternativas de solución de problemas estructurales o bien considerar más variables en 
el comportamiento de las estructuras con el objeto de lograr un mejor modelo de la estructura. 

Tomando en cuenta lo anterior, SAP 2000 es el resultado de un trabajo desarrollado en los 
Estados Unidos de Norteamérica cuyo principal objetivo fue desarrollar un programa para Análisis y 
Diseño de Estructuras en donde el usuario tenga gran versatilidad en el manejo del mismo a· través de 
una interacción directa en la mayor parte de la ejecución de los módulos que componen el programa y 
junto con la sencillez y facilidad de uso son algunas de sus principales características 

El Sistema SAP 2000 es un programa escrito para computadoras personales IBM o 
compatibles mediante el cual puede realizarse el Análisis y Diseño de Estructuras bajo uno o varios 
sistemas de carga formados por un conjunto de fuerzas estáticas y/o dinámicas aplicadas a la 
estructura. 

SAP 2000 fue desarrollado bajo la hipótesis de que la estructura está formada por barras 
prismáticas (aunque también maneja cierto tipo de barras de sección variable) de eje recto, 
.considerando también la posibilidad de modelar elementos placa y sólido (Elementos finitos) 

Consta básicamente de una serie de menús (Véase Figura 1) que se despliegan en la pantalla al 
inicio del programa y por lo general después de terminada la ejecución de cada una de las opciones, 
con ellas, el usuario puede introducir y/o modificar datos, o bien almacenarlos para su procesamiento 
posterior, analizar la estructura, ver resultados en la pantalla o imprimirlos, ver resultados de diseño, 
etc. 
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Capttulo 1 El programa SAP1000 

Figura l.l SAP 2000, menú principal. 

Una de las principales caracteristicas del programa es la interacción que se puede establecer 
entre éste y el usuario, y débido al numero de opciones que el usuario puede activar, se requiere 
aprender su lenguaje especifico para poder utilizarlo, ya que, el usuario puede seleccionar varias 
opciones y la ejecución de cada una de ellas genera otras más, SAP 2000 es un programa orientado 
a eventos (seleccionar un elemento con el ratón, elegir una opción, activar/desactivar sucesos, etc.) y 
no siempre solicita textualmente los elementos (datos) que se vayan requiriendo para la 
ejecución completa de ese módulo, por otro lado además es necesario saber las convenciones de 
signos empleadas, los sistemas de referencia utilizados así como algunas recomendaciones para su 
uso, éstas y algunas características más son descritas en los capítulos posteriores. 

En el capítulo 2 se dan las recomendaciones necesarias para facilitar la preparación e 
introducción de datos, en el capítulo 3 se comentan los módulos que componen el programa, el 
capítulo 4 describe el módulo para crear la estructura, en el capítulo S se presenta el módulo de 

análisis, en el capítulo 6 se presentan las opciones para ver resultados del Análisis y Diseño, en el 
capítulo 7 se describen algunas opciones adicionales o complementarias, el capítulo 8 contiene 

algunos ejemplos con la correspondiente interpretación de los resultados obtenidos por el programa 
SAP 2000, por último en el capítulo 9 se incluyen algunos comentarios y sugerencias finales. 
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CaptntiC\2 R~daQMea pva d uso del pro¡uam• SAP'2000 

RECOMENDACIONES 
PARA EL USO DEL 

PROGRAMA 

CAPÍTUL0.-
2 

2.1 INTRODUCCION 

El programa SAP 2000 posee una interfase gráfica como una opción que le permite al usuario 
modelar, analizar, diseñar y desplegar tanto datos como resultados de una estructura, una vez que se 
cuenta con los datos de geometría, propiedades de los materiales de los cuales están hechos los 
elementos estructurales así como las cargas y desde luego un completo y correcto entendimiento del 
problema, se esta en condiciones de utilizar el programa, para ello habrá necesidad de modelar a los 
elementos anteriores, una vez definido el modelo que se utilizará para esos elementos se introducirá 
el modelo completo utilizando por ejemplo la interfase gráfica. 

La estructura idealizada estará formada por: 

• Elementos barra (FRAME) usados para representar a las vigas, columnas, diagonales, etc. 
• Elementos placa (SHELL) usados para representar muros, losas, rampas, etc. 
• Elementos sólidos (SOLIO) usados para modelar estructuras continuas tridimensionales. 
• Nudos (JOINTS) que representan la conexión entre los elementos barra, placa y sólido. 
• Propiedades fisicas y elásticas de los materiales 
• Apoyos y resortes que representan las restricciones de desplazamiento del nudo. 
• Cargas (concentradas, uniformes, etc.) que representan a las acciones (peso propio, 

viento, sismo, ocupación, etc.). 

2.1 PASO l. TIPO DE ESTRUCTURA 

SA P 2000 permite manejar a la estructura en un sistema coordenado tridimensional, sm 
embargo, antes de realizar el análisis se pueden seleccionar determinados grados de libertad (ver 
figura 2. 1) y asi aunque la estructura este referida a un sistema tridimensional se pueden analizar: 

Marcos y vigas en un plano vertical 
Retículas (en un plano horizontal) 

Desde luego se permite modelar y analizar Armaduras y marcos tridimensionales. 
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C•pmllo 2 Reeomcnd&~ ~ d uao del prognma SAP1000 

Figura·2.l. Sélección de grados de libertad de acuerdo al tipo de estructura 

Para el caso de las estructuras tipo armadura sólo se considerará el efecto axial en eÚnálisis. 

En las estructuras planas se consideran cortante y axial en el plano de la estructura y flexión 
perpendicular a ese plano. 

El tipo retícula permite analizar estructuras con acciones perpendiculares a su plano 
considerando flexión en el plano, torsión y cortante. 

El caso general lo constituye el tipo marco tridimensional en donde se consideran flexión y 
conante en dos direcciones, torsión y axial con seis grados de libertad por nudo, desde luego que se 
pueden liberar extremos de las barras a algún elemento mecánico y suprimir o ligar grados de libertad 
(diafragma rígido por ejemplo). 

2.2 PASO 2. DEFINICIÓN DE LA GEOMETRÍA 

Antes de iniciar la ejecución del programa SAP 2000 es conveniente como segundo paso 
definir completamente la geometría del modelo .. La estructura real se idealizará mediante una serie de 
elementos estructurales conectados entre sí, los cuales, de acuerdo a sus características se podrán 
modelar como elementos barra (trabes, columnas, diagonales), elementos placa (losas, muros) o 
elementos sólidos tridimensionales (elementos continuos), estos elementos estarán unidos en puntos 
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CaprtuW 2 

comunes (nudos), algunos nudos estarán completamente o parcialmente restringidos (apoyos), en uno 
o varios grados de libertad. -

La definición de los elementos (barra, placa, sólido, etc.) se logra localizando sus nudos 
extremos (incidencias) en un sistema coordenado cartesiano proporcionando las coordenadas de esos 
nudos. 

No es necesario numerar en ningún orden a los nudos que forman parte de la estructura ya 
que el programa los numera. Es conveniente localizar nudos en donde se tenga cambio de 
propiedades geométricas o elásticas, recordando que el elemento barra requiere de dos nudos para 
localizarlo, el elemento placa 3 ó 4 y el sólido comunmente 8 nudos. 

Como se verá posteriormente el editor gráfico permite introducir la geometría de la estructura 
de una manera bastante sencilla y directa, ya que con la ayuda del "ratón" (dispositivo tipo puntero o 
mouse) simple y sencillamente por ejemplo haciendo clic en las coordenadas de los puntos extremos 
de la barra automáticamente se definen sus incidencias así como las coordenadas de esos nudos. 

2.3 PASO 3. DEFINICIÓN DE LAS PROPIEDADES GEOMÉTRICAS DE LOS 
ELEMENTOS 

SAP 2000 permite manejar una gran variedad de formas predefinidas para la sección 
transversal de las barras que componen la estructura (ver figura 2.2), como por ejemplo: 

Secciones I, canal, T, ángulos, ángulos dobles, cajón, tubos, etc. 
Secciones rectangulares, circulares. 
Secciones cualquiera (proporcionando sus propiedades) 
Sección no prismáticas (propiedades variables). 

Figura 2.2. Algunas formas para la sección transversal de las barras 
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Una vez elegida la forma de la sección transversal será necesario introducir los datos relativos 
a las dimensiones (tamaño) de la forma seleccionada (ver figura 2.3). 

Figura 2.3. Dimensiones de una forma de sección transversal específica. 

Para los elementos barra prismáticos (general) de una estructura tridimensional se requiere 
proporcionar las siguientes propiedades referidas a ejes locales, centroidales y principales de la barra 
(ver figura 2.4). 

Figura 2.4. Características del tipo de sección transversal "general". 
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C.,.rulo 2 R~ pua el \la(l de.l prOftl'mll SAP2000 

Dependiendo del tipo de estructura, en la tabla 2.1 se muestran las propiedades geométrica.A 
mínimas que es necesario proporcionar para que el análisis se pueda realizar. .. 

Tipo de estructura 

TRUSS 
PLANE 
FLOOR 
S PACE 

Propiedad requerida 

AX 
AX, IZó IY 
IX, IZó IY 
AX, IX, IY, IZ 

Tabla 2.1 Propiedades geométricas mínimas requeridas. 

El programa SAP 2000 permite asignar las propiedades de los elementos barra de acuerdo a una tabla 
de perfiles de acero estándar (P. ej. tabla AISC, ver figura 2.5) o tomarlas de una tabla definida por 
el usuario. 

r.,.~ ... ;r.~.:r.',,.:-.:.'.):1'~~~Jt~;,:¿~~!~~t~~.:-:."7')\:~;:=:(~~;~~$~~~.z; ~21'7( 
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Figura 2.5. forma y propiedades geométricas tomadas de una tabla de perfiles. 
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Para el caso de los elementos placa será necesario proporcionar el espesor de la placa y 
seleccionar el tipo de trabajo de esta ("Shell", "Membrane" o "Plate", ver figura 2.6), para el sólido 
no es necesario proporcionar . . · · sólo constantes elásticas 

Figura 2.6. Datos para los elementos placa. 

2.4 PASO 4. DEFINICIÓN DE LAS PROPIEDADES ELÁSTICAS DE LOS 
MATERIALES 

Para realizar el análisis se requiere tener definidas las constantes del material del cual, están o 
estarán hechos los elementos (barra, placa, sólido) como son E (Módulo elástico), y v (relación de 
Poisson). Para incluir el peso propio es necesario proporcionar el peso volumétrico, si se desea 
emplear alguna opción de análisis dinámico entonces es necesario proporcionar la masa por unidad de 
longitud (en un modelo de masas distribuidas), masas en los nudos (modelo de masas concentradas), 
si quiere que se considere efectos de temperatura será necesario especificar el coeficiente lineal de 
dilatación térmica (ver figura 2. 7). 
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Clp¡tulo 2 

Figura 2. 7. Datos para las propiedades de un material. 

2.5 PASO 5. TIPOS DE FUERZAS Y COMBINACIONES 

Es necesario tener completamente identificados cornunrnente los sistemas o conjuntos d· 
fuerzas (condiciones de carga) bajo los que se realizará el análisis ( P. ej. peso propio, carga viva, 
sismo, viento, etc.) y para cada condición de carga las características de las fuerzas (tipo, magnitud, 
dirección, etc ) que forman parte de ese sistema de fuerzas. 

Por ejemplo una condición de carga puede ser la carga muerta que puede estar formada por 
ejemplo por: fuerzas uniformes en algunas barras simulando el peso de los muros divisorios, fuerzas 
concentradas simulando el peso de tanques, etc. 

Otra condición de carga puede ser el sismo, que por ejemplo pudiera ser representado por una 
serie de fuerzas estáticas (sismo estático) aplicadas en determinados nudos. 

Una condición más puede ser la carga viva, idealizada corno una fuerza por unidad de área 
actuando en una determinada zona de la estructura (P. ej. azotea, entrepiso, escaleras, etc.). 

Los sistemas de carga independientes pueden ser utilizados para formar sistemas de carga 
dependientes es decir combinaciones, si lo anterior se desea, es necesario saber de antemano el 
número de combinaciones a incluir en el análisis y para cada combinación las condiciones de carga 
que se incluinin así como su participación respectiva (factor de carga), por ejemplo teniendo como 
marco al Reglamento de Construcciones para el D.F. pensando en una estructura del grupo A, 
localizada en el D. F. una combinación es 1.5 de la carga muerta + 1.5 de la carga viva máxima, por 
lo que el factor de carga (o de participación) de las condiciones anteriores (1 y 2) es 1.5, siendo 1 ,. 
2 las condiciones de carga respectivas. 
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2.6 PASO 6. ELECCIÓN DEL TIPO DE ANÁLISIS Y RESULTADOS 

SAP 2000 permite realizar un análisis elástico lineal de 1 er. orden, también se pueden incluir 
efectos P-ó o bien un análisis dinámico, por lo anterior habrá que decidir sobre el tipo de análisis a 
efectuar por el programa. 

En cuanto a los resultados que el programa puede proporcionar, será necesario saber cuales 
se requerirán, por ejemplo: desplazamientos, elementos mecánicos, gráficas y diseño, y de que 
elementos se requieren; por ejemplo: de algunos o de todos los nudos, de algunos o de todas las 
barras, gráficas de la deformada, de algún marco o de toda la estructura, etc., lo anterior se tendrá 
que definir para una, algunas o todas las condiciones de carga y/o combinaciones. Si el usuario no 
selecciona o define los elementos (nudos, barras, etc.), condiciones y/o combinaciones la impresión la 
realiza para todos los elementos y todos los sistemas de fuerzas existentes. 

2.7 PASO 7. DISEÑO DE ELEMENTOS 

SAP 2000 permite diseñar elementos de acero y concreto por lo que será necesario definir un 
código o especificaciones a utilizar (ACI, AISC, LRFD, ASSTHO, etc.) y proporcionar los valores 
de los parámetros a utilizar (fe, fY, etc.), así como especificar los elementos que se diseñarán y el 
criterio a seguir para su diseño (viga, columna, etc.). :i 
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3.1 INTRODUCCION 

DESCRIPCION 
GENERAL 

Oescnpc10n Ocuen.l 

Una vez que se ha modelado la estructura (previo al uso del programa), es decir; seleccionada 
la forma de la sección transversal de las barras, definidas las características fisícas y mecánicas de los 
materiales estructurales, especificados los sistemas de fuerzas (definidas cada una de las fuerzas que 
componen a cada sistema o condición de carga y combinaciones) bajo las cuales se analizará el 
modelo estructural, seleccionado el tipo de análisis así como el tipo de resultados, entonces se esta en 
condiciones de introducir los datos antes mencionados utilizando la interface gráfica que ofrece el 
programa con la cual es posible: 

Manejar (Definir, mover, copiar, borrar) elementos estructurales (barra, placa, etc.). 

Definir Tipos de apoyo (fijo o con grados de libertad, resortes). 

Definir y asignar propiedades geométricas a los elementos barra de acuerdo a una tabla . de 
perfiles estándar (AISC por ejemplo) o usar secciones prismáticas (circular, rectangular, Te, 
etc.), también es posible la utilización de secciones no prismáticas o de sección variable. 

Definir el espesor de los elementos placa. 

Definir y asignar propiedades a uno o varios elementos o grupo de elementos (barra, placas), 
las propiedades pueden ser densidad, módulo elástico, relación de Poisson, coeficiente de 
dilatación térmica, etc. Así como definir la posición de la sección dentro de la estructura 
(posición de ejes locales con respecto a los globales). Algunas de las propiedades se tienen 
predefinidas para ciertos materiales (acero y concreto) o se pueden introducir valores 
particulares. 

Es posible seleccionar barras para liberarlos de algunos elementos mecánicos en sus extremos, 
también se pueden definir diafragmas rígidos. 

Desde luego se permite introducir fuerzas estáticas aplicadas a los nudos, desplazamientos 
prescritos en ellos, en el caso de barras se puede incluir el peso propio, fuerzas uniformes, 
concentradas, con variación lineal, de presfuerzo y debidas a incrementos de temperatura, a 
ajustes en la longitud inicial de los elementos y algunas otras. 

Además de las fuerzas de tipo estático, se puede incluir cargas variables (móviles), de acuerdo 
a AASHTO ( HS20, HS 15, H20, HIS, etc.), o al UBC, o bien especificadas por el usuario. 
Una buena variedad de fuerzas dinámicas (fuerza-tiempo o aceleración-tiempo) pueden 
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incluirse como sistemas de fuerzas, especificadas de acuerdo a sus características dinámicas 
(amplitud y frecuencia), definiendo el lapso de tiempo de actuación de la fuerza. 

Una vez introducida la geometría, propiedades y fuerzas que actúan sobre la estructura, SAP 
2000 permite la realización del Análisis operando sobre el contenido del archivo que se ha 
seleccionado o definido previamente el cual desde luego debe contener los datos de la estructura en 
estudio, el módulo de análisis interpreta cada una de las ordenes o definiciones indicadas en el archivo 
de datos en el orden en que se encuentran, el contenido del archivo de datos e instrucciones puede 
introducirse manualmente vía algún editor previo a la ejecución de SAP 2000 o bien mediante la 
instrucción Save al estar creando la estructura a través del editor gráfico característico del programa, 
ambas opciones se describirán posteriormente. 

Después de ejecutada la opción de análisis, SAP 2000 genera archivos conteniendo los 
resultados de la fase de análisis, si este concluye satisfactoriamente se desplegará la configuración 
deformada de la estructura. Enseguida se podrán seleccionar opciones y elementos para que de ellos 
se muestren en el monitor los resultados numéricos y gráficos obtenidos por el programa como 
resultado del análisis. 

3.2 EJECUCIÓN DEL PROGRAMA, MENU DE OPCIONES "' 

Para iniciar el programa se puede hacer doble die en el icono del programa o bien desde el ··· 
menú de inicio hacer die en la carpeta programas SAP 2000 educacional (versión educativa) o SAP 
2000 NonLinear (versión profesional), enseguida se ejecuta el programa presentándose la imagen ': 
mostrada en la figura 3.1, una vez haciendo die en la caja OK de la ventana en la parte cent¡-al (" Tip 1: 

oj !he day") desaparece esta dejando lugar a la ventana principal del programa SAP 2000. ·;.; 

En el "renglón" superior de esta ventana se encuentra en su extremo izquierdo el nombre del 
programa (SAP2000) seguido del nombre de archivo en donde se almacenarán los datos o de donde 
han sido tomados, en el extremo derecho se encuentran los iconos de minimizar, restaurar la ventana 
y cerrarla (una forma de finalizar la ejecución del programa es haciendo die en este icono), debajo de 
lo anterior se localiza la barra de menú conteniendo las opciones que el programa tiene disponibles 
(Eile, J;;;dit, View, etc.) las cuales se describirán posteriormente, debajo de esas opciones se 
encuentran una serie de iconos que realizan acciones de uso frecuente (seleccionar elementos, 
cambiar alguna opción de presentación, elegir algún tipo de resultado, etc.), se recomiendo al lector 
consultar las tablas que se presentan al final de este trabajo en donde se describe cada uno de esos 
iconos (incluyendo los de la barra flotante que también forma parte de la ventana de SAP 2000). 

Debajo de los iconos está el área de presentación (con fondo negro) en la que se muestra 
gráficamente el modelo de la estructura por analizar así como diversa información en forma de 
ventanas que serán desplegadas por el programa después de que el usuario seleccione alguna de las 
opciones disponibles de SAP 2000. 

Por último, en la parte inferior debajo de la barra flotante de iconos se muestra información 
acerca de las características del área de dibujo (vista o plano de presentación, coordenadas de algún 
nudo, etc.) y un poco a la derecha esta el cuadro de selección de unidades en las que se introducirá la 
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información, antes de este cuadro se muestra información acerca del estado que guarda 
instrucción o del programa. 

alguna 

lil SAP '!000 - 1 1 Jl!lr;;) El 

D1d yo u know thot .. 

Usmg Set Lim1ts o.nd Show Selections Only 
options. both lrom the V1ew menu. can 
reduce the number of elements thot ore 
VISible on the screen 

Figura 3.1 Iniciando el programa SAP 2000 

En la versión 6. 1 del programa SAP 2000 se pueden seleccionar varias opciones, las que se 
describen a continuación pueden ser las de uso más frecuente. 

3.3 El menú file 

EL menú file (ver figura 3.2) permite entre otras opciones manejar la información de alguna 
estructura contenida en un archivo, esa información pudo haberse generado previamente a la 
ejecución del programa o durante su uso, las opciones de este menú permiten: 

New Model Iniciar un problema nuevo. 

New Model from template Iniciar un problema nuevo, seleccionando una geometría 
típica de algunas formas estructurales como las mostradas en la 
figura 3.3. 

Open... Abrir un archivo existente con datos de alguna estructura. 

lrllll'liCQVI' para la nnlvliCJn!l ctcl PT!'11nfTll SAP 2000, Fl UNAM F Mr>nr<'Y 
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~ave 

Save As 

Import 

Export 

Print ... 

Guarda los datos de la estructura. 

Guarda los datos de la estructura en otro archivo. 

Permite ingresar los datos de un archivo generado con 
AutoCad, o bien para SAP90. 

Proporciona la flexibilidad de poder enviar los datos de la 
estructura existente a una archivo para SAP2000 con extensión 
. S2K el cual puede ser modificado por ciertos procesadores de 
texto (p.ej. WordPad) y poder ser utilizado nuevamente por 
SAP2000, o bien enviarlos a un archivo .DXF y poder ser 
interpretado por AutoCad por ejemplo. 

Nos permite configurar características de impresión, imprimir el 
contenido del área de dibujo así como una lista de datos y 
resultados. 

Cerrar el programa y regresar a Windows. 

17 
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Figura 3.2 Módulos principales del menú file. --
l1'! Mod•ll"emplat•s t::l 

Figura 3.3. Geometrías predefinidas en la opción New Model from Template 

Existen dentro de este menú otras opciones de uso no muy frecuente. Al iniciar SAP 2000 S' 

recomienda seleccionar las unidades en las que se van a introducir los datos de la estructura a 
analizar, por ejemplo si estas fueron ton-m (toneladas y metros) los valores de las fuerzas uniformes 
se deben de proporcionar en ton/m, de las inercias en m4

, para el módulo elástico en ton/m2
, etc., es 

decir los valores deben ser consistentes. 

3.3 El menú Edit 

EL menú J;;;dit (ver figura 3.4) permite desde introducir y hacer cambios a la geometría del 
modelo hasta suprimir algunos de sus elementos muchas de las opciones contenidas en este menú 
operan en conjunto con las del menú Select (ver siguiente sección), las opciones de este menú 
permiten: 

Cut 

Copy 

Paste 

Dele te 

Suprimir los elementos seleccionados, guardándolos en la memona 
temporal. 

Copiar sin borrar los elementos seleccionados a la memoria temporal 

Insertar los elementos contenidos en la memoria temporal especificando 
nuevas pos1c1ones. 

Suprimir los elementos seleccionados. 

lnstructlV('I p~n Le. ulllwiaM del proghma SAP 2000. Fl UNAM 
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Capítulo 3 

Merge Joints 

M ove 

Replicate 

Divide frames 

Join frames 

Change Labels 

Juntar los nudos que tengan una separación menor que un cierto valor 
(dejando uno solo y suprimiendo los demás es decir los nudos 
duplicados). 

Mueve los nudos seleccionados especificando el incremento en sus 
coordenadas, moviendo también los elementos que estén conectados a 
esos nudos. 

Realiza una copia (réplica) de los elementos seleccionados 
especificando el incremento en las coordenadas de sus nudos extremos. 

Divide a las barras seleccionadas en un número especificado por el 
usuano. 

Junta varias barras seleccionadas en una sola (operación m versa de 
Divide frames). 

Cambia la numeración de los elementos seleccionados (renumera). 
., 

fl! SAP!DDO · (Untitlcd) ll!ll;]f.l 

Figura 3.4. Opciones del menú Edit. 

3.4 El menú View 

EL menú View (ver figura 3.5) permite cambiar la presentación del área de dibujo de la 
estructura, algunas opciones que resultan de uso cotidiano son: 

lnstruetlv<> pvalfl ullhDaC>n del prt'lgfVIla SAP 2000, Fl UNAM F. Monroy 19 
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Set ,Eiements 

Figura 3.5. Opciones del menú View. 

Permite seleccionar la información a ser incluida dentro del área de 
dibujo (numeración de nudos, barras, ejes, etc.), ver figura 3.6. 
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Figura 3.6. Opciones de Set J);lements. 

Show Grid Permite Activar (mostrar) o desactivar la malla auxiliar para dibujo de 
elementos. 

·' 

Show Axes Dibuja o suprime los ejes globales de la estructura. ' 
. :..: 
::.'-i 

.:­
~ 

Se deja al lector que pruebe el efecto de las otras opciones, las características de algunas de ·¡ 
ellas se verán posteriormente en el desarrollo paso a paso de algún ejemplo. ·· -! 

3.5 El menú Define 

El menú Define (ver figura 3. 7) permite especificar propiedades de los materiales 
(Materials .... ), características geométricas como forma, dimensiones, material, etc. para las barras del 
modelo (Frame Sections .. ) y algunas características para los elementos placa (Shell Sections ... ) 
También permite definir" características generales de las condiciones de carga estática como su titulo 
o identificación, el tipo de carga (de acuerdo a su origen) y si se incluirá el peso propio en la 
condición de carga. 

En este menú se podrá seleccionar o introducir un espectro de respuesta así como funciones 
de excitación para análisis dinámico, también se podrán definir las combinaciones de carga (Load 
Combinations ... ) seleccionando las condiciones de carga que se incluirán en cada combinación con 
sus respectivos factores de carga. 
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Figura 3.7. Opciones del menú Define. 

3.5 El menú Draw 

Algunas de las opciones del menú Draw (ver figura 3 .8) permiten dibujar esquemáticamente a 
los elementos barra, placa, etc. con los que se irá construyendo el modelo estructural por analizar, 
algunas opciones de uso frecuente son: 

_Edit Grid 

Draw frame Element 

Permite adicionar, modificar, suprimir, etc las lineas que forman 
la malla auxiliar para dibujo de elementos. 

Permite iniciar el dibujo (con la ayuda del ratón) de elementos 
barra, después de seleccionar esta opción se hace clic izquierdo 
del ratón en el nudo donde inicia la barra (en caso de que este 
no ha!la sido creado se hace clic en sus coordenadas), luego se 
desplaza el puntero (sin arrastrar) hacia el nudo final de la 
barra haciendo die izquierdo en el nudo con lo que queda 
especificada esa barra (se recomienda utilizar la malla auxiliar 
cambiando la separación de las líneas de la malla para que 
algunas de las intersecciones de esas líneas coincidan con la 
mayoría de los nudos de la estructura), la secuencia de dibujo de 
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Draw Shell Element 

barras se puede interrumpir con un doble clic del botón derecho 
en cualquier parte del área de dibujo (con lo que es posible 
dibujar barras en otras posiciones), para terminar el dibujo de 
barras se hace clic en el icono de puntero de la barra flotante de 
iconos, posteriormente se puede dibujar más barras volviendo a 
seleccionar esta opción, lo anterior se puede hacer tantas veces 
como se reqwera. 

Permite iniciar el dibujo (con la ayuda del ratón) de elementos 
placa, funciona de manera muy similar a la opción anterior solo 
que en este caso se seleccionaran tres o cuatro nudos 
dependiendo del tipo de elemento finito que se quiera dibujar, la 
selección de nudos se hará en sentido horario o antihorario. 

Quick Draw frame Element y Quick Draw Shell Element permiten el dibujo de barras y 
placas respectivamente con un solo clic izquierdo cerca de alguna de las lineas de la malla 
auxiliar (para el caso de barras) y en algún punto dentro de un área delimitada por lineas de la 
malla auxiliar de dibujo (para el dibujo de placas), se deja al lector la práctica con estas 
opciones antes de abordar los ejemplos que se presentan en el capitulo correspondiente. 

Figura 3.8. Opciones del menú Draw. 
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3.6 El menú §elect 

Algunas de las opciones del menú Select (ver figura 3.9) nos permitirán seleccionar element~ 
ya existentes dentro del modelo, la selección de elementos es necesaria para poder asignar (ver menú 
Assign) algunas características a los mismos, por ejemplo si se seleccionan barras se les podrá asignar 
secciones, cargas, etc. las siguientes son algunas opciones que resultan de uso frecuente: 

Pointer/Window 

Intersecting Line 

Permite seleccionar a los elementos que quedan contenidos 
dentro de un área rectangular que se define haciendo clic 
izquierdo en una de las esquinas del área y arrastrando el 
puntero del ratón hasta la esquina opuesta y soltando el botón 
del ratón en esa esquina, los elementos seleccionados cambian 
su aspecto de línea continua a línea interrumpida (punteada). 

Con esta opción se seleccionan a aquellos elementos que son 
intersectados por una linea que se define haciendo clic izquierdo 
en uno de los extremos de la misma y arrastrando el puntero del 
ratón hasta el otro extremo de la línea y soltándolo ahí mismo. 

Las otras opciones de Select permiten seleccionar elementos que tienen alguna característica 
en común. 

!E SAPlDilll • (UntiU•d) Jl!llr:;)EJ 

Figura 3.9. Algunas opciones del menú §elect. 

lnstrucbvCI pua ~ utlhzrocwn del pwpnma SAP 2000, fl UNAM 24 



El menú Select dispone de las mismas opciones para excluir elementos ya seleccionados, Jo 
anterior se realiza con la opción Unselect, otra manera de quitar elementos de la selección es 
haciendo clic en el icono de flecha de la barra flotante de iconos y luego hacer clic en cada uno de 
los elementos que han sido previamente seleccionados y que se quieren excluir, inclusive si se hace 
clic en un elemento no seleccionado este se selecciona y viceversa 

3. 7 El menú Assign 

Una vez seleccionados algunos elementos (nudos, barras, etc.) podemos asignarles alguna 
característica propia del elemento (restricciones, fuerzas, secciones, etc.), el menú Assign (ver figura 
3. 1 O) junto con sus opciones nos permitirán realizar esa actividad, enseguida una breve descripción 
de algunas opciones del menú assign. 

Joint 

Joint Static Loads 

Frame 

Frame Static Loads 

lnsb"'liOtM'I p1111la lltihzllcu'•n del prfllt!'lm& SAP 2000, Fl UNAM 

Permite asignar a los nudos seleccionados 
apoyos (restraints), asignar el mismo 
(constraints), asignar resortes (springs), etc. 

restricciones o 
desplazamiento 

Con esta opción se asignan a los nudos seleccionados. fuerzas 
(Forces) o desplazamientos prescritos (Displacements). 

Permite asignar a las barras seleccionadas propiedades 
(Sections), liberarlas de algún elemento mecánico (Releases), 
especificar sus ejes locales (Local Axes), etc. 

Con esta opc10n se asignan fuerzas estáticas de gravedad 
(Gravity), puntuales y/o uniformes (Point and Uniform), con 
vanac1on lineal (Trapezoidal), efectos de temperatura 
(Temperature ), y efectos de presfuerzo (Prestress). 
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Figura 3.1 O. Algunas opciones del menú Assign. 
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3.8 El menú Analyze. 

El menú Analyze (ver figura 3. 11) permite seleccionar algunas opciones de análisis (Set 
Options ... ), o bien se puede solicitar que el programa SAP 2000 realice el análisis (Run) con los 
resultados desplegados en una ventana normal o bien en una ventana minimizada (Run Minimized ), 
se recomienda guardar el archivo de trabajo antes de solicitar el análisis (inclusive guardarlo en disco 
flexible y luego en el disco duro). 

lJl SAP!OOU- (Untwod) ~' l!llr;lfl 

' ¡ 
j 
¡ 

1 

Figura 3.11 Opciones en el menú Analyze. 

Las opciones de Set Options ... (ver figura 3. 12) permiten seleccionar Jos grados de libertad 
activos (Available DOFs) dependiendo del tipo de estructura que se analizará, será necesario 
identificar y seleccionar haciendo clic en los cuadros respectivos del área correspondiente (un cuadro 
en blanco significa que ese grado de libertad no esta activo), otra manera de seleccionar los grados de 
libertad es utilizando la opción de seleccionado rápido (Fast DOFs), lo anterior se realiza haciendo 
clic en alguna de las figuras que corresponda a nuestra estructura, la selección inadecuada de los 
grados de libertad puede generar resultados incorrectos o estructura inestable (división entre cero) 
durante la fase de análisis. 
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Figura 3.12. Opciones de Set Options ... del menú A.!!alyze. 

Al final de la caja de selección se puede indicar que se realice un Análisis Dinámico (Dynamic 
Analysis), que se incluyan efectos P-ll (lnclude P-Delta) y que se generen archivos de salida 
(Generate Output), para estas ultimas opciones es conveniente indicar algunos parámetros y 
seleccionar algunas opciones especificas. 

Cuando se selecciona la opción de Análisis (Run), y algunos resultados del proceso se van 
desplegando en la pantalla (ventana) quedando al final algo similar a lo que se muestra en la figura 
3.13. 
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Figura 3.13. Ventana al finalizar el análisis. 

Al hacer clic en el botón OK de la ventana que se muestra al final del análisis, se despliega en 
el área de dibujo la configuración deformada de la estructura para determinada condición de carga, en 
esta parte del programa se podrán seleccionar los resultados del análisis por ejemplo desplazamientos 
de los nudos, reacciones, elementos mecánicos, diagramas de elementos mecánicos, configuraciones 
deformadas, etc. 

3.9 El menú Display 
... 

Este menú permite solicitarle al programa que muestre la geometría no deformada del modelo 
(Show Undeformed Shape), las cargas en los nudos (Show Loads), en las barras, en los elementos 
placa o no mostrarlas. 

Mediante la opción Show Input Tables (ver figura 3.14) se solicita al programa que muestre 
en una ventana conteniendo una lista con los datos numéricos de la geometría en lo que respecta a 
nudos (coordenadas, restricciones, etc.), barras (incidencias, tipo de sección, etc.) y cargas (en los 
nudos, en las barras y en las placas), produciendo una salida parecida a la de la figura 3.15, la tabla 
mostrada puede imprimirse o grabarse en un archivo. 

lnstructlvo pan 11 ullla.ac¡,on del propam~ SAP 2000, F1 UNAM F Monroy 28 

:í ., ,. 
:~ 

.'1~ 



1 
2 
.1 

[)escnpcwn Gencnl 

Figura 3.14. Opciones del menú Display. 
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Figura 3.15. Salida tipica a partir de Show Input tables del menú Display. 

Mediante la opción Show Deformed Shape y después de seleccionar la condición de carga, 
SAP 2000 muestra la configuración deformada correspondiente (ver figura 3.16). 
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Figura 3.16. Salida típica a partir de Show Deformed Shape del menú Display 

La opción Show Element Forces/Stresses y dependiendo de la selección que se haga SAP 
2000 puede mostrar elementos mecánicos, esfuerzos, reacciones, etc. produciendo una salida similar 
a la que se muestra en la figura 3. 17. 
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Figura 3.17. Salida obtenida con Show Element Forces/Stresses del menú Display 

3.10 El menú Design 

EL menú Design (ver figura 3.1 8) permite seleccionar algunas opciones de diseño, realizar el 
diseño (verificación) de elementos con la posibilidad de optimizar secciones, con la característica de 
producir salidas similares a las mostradas en las figuras 3.19 y 3.20 de entre otras. 
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Figura 3.18. Opciones del menú Design. 

113 
5.00 *2 113 0.000 
0.00 112 117 0.000 
1. 25 0.007 117 0.000 
2.50 O/ S 112 117 0.000 
3.75 o/s 112 117 0.000 

Figura 3.19. Algunos resultados del menú Design. 

lrutruenvo pm. 11 utiliuC'lon del pro¡uvrll SAP 2000, Fl UNAM F. Monroy 31 



Figura 3.20. Algunos resultados del menú Design. 
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Figura 3.21. Algunos resultados del menú Design. 
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3.11 Los menús Options y Help 

El menú Options (ver figura 3 .22) permite por así decirlo controlar el tipo y características de 
la información que será mostrada en las diferentes áreas de presentación (colores, número de 
ventanas, etc.). 

En este punto podemos mencionar que una vez que se realiza el análisis SAP 2000 "bloquea" 
al modelo no permitiendo realizarle ninguna modificación por lo que solo es posible manejar los 
resultados (ver valores numéricos, gráficas, imprimirlos, etc.), para desbloquear al modelo y poder 
hacerle cambios se selecciona la opción Lock Model con esto ahora los resultados ya no están 
disponibles para poder tener acceso a ellos una vez realizados los cambios será necesario solicitar 
nuevamente la realización del análisis. 

Figura 3.21. Opciones en el menú Options y desbloqueo del modelo. 

Se deja al lector que pruebe el efecto de las otras opciones del menú Options así como las del 
menú Help, las características de algunas de ellas se verán posteriormente en el desarrollo de algunos 
ejemplos. 
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4.1 INTRODUCCIÓN 

GENERACION DE 
LA ESTRUCTURA CAPÍTUL~~ 

En SAP 2000 la generación de la estructura se entiende como la ubicación con respecto a un 
sistema de coordenadas (global) de los elementos barra, placa y sólido, la asignación de propiedades 
geométricas y elásticas a los elementos ya localizados, la introducción de apoyos, la definición y 
asignación de fuerzas a los nudos, barras y placas, la selección del tipo de análisis y resultados, por 
último, el dimensionamiento o revisión de elementos. 

La forma de iniciar el programa SAP 2000 ha sido descrita con anterioridad (ver inciso 3.2 
del capitulo anterior), enseguida se recomienda elegir las unidades en que se introducirán los datos 
haciendo clic en la pestaña que se encuentra a la derecha del cuadro de unidades y seleccionándolas 
de la caja que muestra el programa (ver figura 4.1 ). 

Figura 4.1 Selección de unidades. 
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SAP 2000 ofrece varias alternativas para introducir la topología de la estructura, aquí 
empezaremos por una de las más comunes que es introduciendo elemento por elemento, para ello se 
recomienda auxiliamos de la malla (grid) que el programa nos proporciona por lo que se tendrá que 
ajustar la separación de las líneas que forman esa malla, seleccionemos New Model del menú File, 
enseguida el programa mostrará un cuadro en donde se especificarán las características de la malla 
como el número de espacios en cada dirección así como su separación los cuales se pueden modificar 
introduciendo valores particulares en los cuadros en fondo blanco haciendo die en el que se quiera 
modificar (ver figura 4.2) 

! 

Figura 4.2 Ventana para definir las características de la malla auxiliar. 

Una vez que se ha hecho clic en el botón OK el programa muestra la malla resultante en el 
área de dibujo (con fondo negro) dividiéndola en 2 cuadros mostrando en ellos una vista diferente de 
la malla (3D y en el plano X-Y en Z=IO.S), también puede observarse los ejes coordenados globales 
(ver figura 4.3). 
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Figura 4.3 Imagen típica después de definir las características de la malla auxiliar. 

Cada una de esas ventanas tiene en su extremo superior derecho los botones de minimizar, 
ventana completa y cerrar, el número y tipo de ventanas a mostrarse en la pantalla puede 
seleccionarse a través de la opción Windows del menú Options. 

De las ventanas que se muestran, la ventana activa o en la que se muestran los resultados de 
los comandos que se elijan es aquella cuya barra de título está en color (generalmente diferente del 
gris), se activa una ventana haciendo clic en su interior. 

La malla así creada tiene separación constante entre las líneas de una misma dirección, existen 
varias maneras de cambiar la separación entre cada línea de la malla, una de ellas es, después de 
seleccionar una vista en planta hacer dos clics seguidos en una de las líneas de la malla (con el botón 
izquierdo del ratón), enseguida se mostrará una ventana conteniendo información acerca de la 
posición de esas líneas con la opción de seleccionar la dirección de las lineas de la malla así como 
adicionar, mover y borrar lineas. 

Haciendo clic en el cuadro en blanco e introduciendo el valor de la nueva posición de la línea 
y después de hacer clic en la opción Add grid line se ha introducido una nueva línea a la malla. Para 
modificar el valor de una línea se selecciona de la caja en gris haciendo clic izquierdo en la línea a 
modificar con lo cual se muestra en la caja en blanco y haciendo clic en esa caja se puede cambiar SI 

valor, para que el cambio resulte efectivo después de modificar el valor de la caja en blanco se 
necesita hacer clic en el botón Move, las demás opciones complementan la modificación de la malla 
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(ver figura 4.4). Desde luego que para que todos los cambios produzcan efecto es necesario hacer 
clic en el botón OK. 

Madi!Y Grid Line• . 

Figura 4.4 Modificación de la separación individual entre las líneas de la malla. 

Otra manera para que se muestre el cuadro de la figura 4.4 es seleccionando Edit Grid del 
menú Draw, otro comando que resulta útil es la opción Show Grid del menú View con el c¡Jal se 
suprime o activa la aparición de la malla en área de dibujo. 

Los datos de la estructura que se vayan introduciendo son almacenados en memoria volátil 
(RAM) por tal motivo se recomienda que con cierta frecuencia se graben en el disco duro (o en disco 
flexible), para ello se puede utilizar la opción Save o Save As del menú File, el programa asignará al 
nombre del archivo proporcionado por el usuario la extensión .SDB. 

Ahora podemos introducir todos los elementos que componen a la estructura, a continuación 
se presenta una breve descripción lógica de las opciones de uso común así como de los comandos 
que nos permitirán la generación de la estructura en el orden mencionado al inicio de este capítulo, 
varios de los comandos fueron descritos en el capítulo anterior. 

4.2 DESCRIPCIÓN GENERAL 

La parte del proceso de modelación que consume más recursos (tiempo y esfuerzo) es la que 
concierne a la introducción de elementos (barra, placa, etc.), es por ello que el uso eficiente de los 
comandos del menú Draw y en combinación con algunos otros nos permitirá la generación de la 
topología (forma) de la estructura lo más pronto posible, como recomendaciones generales, se 
pueden mencionar las que se indican en los párrafos siguientes. 
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Procurar iniciar la geometría de la estructura a partir de alguna de las predefinidas que trae la 
librería del programa (vigas, marcos, etc ), enseguida realizar los cambios necesarios para ajustar esa 
geometría a la del modelo por analizar (adicionando o borrando algunos elementos, cambiándolos d~ 
posición, copiándolos, etc,) · W' 

Para la definición de elementos (barra, placa, etc.) auxiliarse de la malla (grid) cambiando la 
separación de las lineas de la malla para que sus intersecciones definan la mayor cantidad de 
coordenadas de los nudos de nuestro modelo procurando que con la nueva separación de las lineas de 
la malla los elementos resultantes tengan las características (dimensiones e inclinación) deseadas con 
lo que el usos de las opciones de dibujo rápido de elementos (con un solo clic, en lugar de dos clics) 
traerá algún ahorro y facilidad de creación o modificación del modelo. 

Las características a ser mostradas en la pantalla (numeración, ejes locales, etc.) de los 
elementos. que se van adicionando al modelo (nudos, barras, placas, etc.) pueden ser controladas 
mediante la opción Set Elements del menú View (ver figura 4.5). La información mostrada puede ser 
de utilidad, también es conveniente recordar que las características de algún elemento (nudo, barra, 
placa, etc.) pueden desplegarse seleccionándolo ( clic izquierdo) y luego haciendo clic derecho, 
algunos de los elementos en la caja mostrada pueden ser modificados (ver figura 4.6). 

Figura 4;5 Selección de información a desplegarse en el área presentación del modelo. 
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Figura 4.6 Características del elemento barra seleccionado (la información en el cuadro en blanco 
puede ser modificada directamente). 

4.3 GENERACIÓN DE LA GEOMETRÍA 1: 

Una de las maneras de crear el archivo de datos o de modificar su contenido, es a través del 
editor gráfico cuyas opciones están contenidas principalmente en el menú Draw (ver figura 4.7), 
algunas de ellas se describen a continuación. · 

Draw Frame Element permite adicionar un nuevo elemento barra. para ello se hace clic 
primero en el punto extremo de la barra y luego en el opuesto. 

Draw Shell Element permite adicionar un nuevo elemento placa, haciendo clic en los punto·s 
extremos (vértices) sucesivos del elemento empezando por cualquiera de ellos se define la geometría 
de este elemento. 

Quick Draw Frame element permite adicionar un elemento barra haciendo un solo clic en 
una linea de la malla auxiliar de dibujo que este delimitada por otras dos perpendiculares a la primera, 
esas lineas definen los límites del elemento, si se hace clic en cualquier punto de la zona delimitada 
por cuatro lineas de la malla o por cuatro nudos se adicionan dos elementos barra diagonales. 

Quick Draw Shell element adiciona un nuevo elemento shell haciendo un solo die en 
cualquier punto de la zona delimitada por cuatro lineas de la malla. 

Comúnmente al seleccionar alguna de las opciones anteriores la forma del cursor cambia a una 
flecha vertical vacía hacia arriba, para cancelar o terminar la opción se hace clic en el primer icono de 
la barra flotante con lo que el cursor cambia a flecha inclinada llena. 
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Figura 4.7 Opciones del menú Draw. 

Con objeto de completar el modelo o realizar los cambios que se deseen, una vez que se· han 
ubicado elementos, cuando sea posible se recomienda generar algunos otros realizando copias, giros, 
etc. de uno o varios de los que ya se tienen definidos. 

Para 'tal efecto varias opciones se encuentran en el menú Edil (ver figura 4.8), pero para 
poder utilizar algunas de ellas es necesario seleccionar elementos (por ejemplo los que se van a 
copiar), para ello existen disponibles varias formas de seleccionar elementos, la más sencilla es hacer 
clic en el elemento a seleccionar (nudo o barra), el elemento seleccionado se muestra con línea 
discontinua, se puede anular la selección haciendo clic en un elemento seleccionado, también se 
pueden seleccionar elementos que queden totalmente contenidos en una ventana rectangular creada 
haciendo clic en uno de los vértices de la ventana y arrastrando el ratón hasta el vértice opuesto de la 
misma y soltando ahí, otras opciones de selección se encuentran en la opción Select del menú con el 
mismo nombre, desde luego que las acciones anteriores se pueden aplicar en repetidas ocasiones e 
inclusive combinar varias maneras de seleccionar y excluir (Unselect) elementos para lograr un 
resultado deseado. 

Hecha la selección de algunos elementos (también puede ser uno o todos) se pueden llevar a 
cabo ciertas acciones con ellos dando como resultado posibles cambios a esos elementos y en general 
al modelo o estructura por analizar, cuando el efecto final no es el esperado se recomienda cancelar la 
acción, para ello se hace clic en el icono (Un Do) que está casi por debajo del menú View. 
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Figura 4.8 Opciones del menú Edit. 

Cut y Delete Elimina los elementos seleccionados. 
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Copy copia los elementos seleccionados a una memona temporal ... , 
permitiendo ser insertádos posteriormente, los elementos que actualmente se encuentran 
seleccionados no se suprimen, cuando se aplica nuevamente la opción Copy a una nueva 
selección, los elementos seleccionados anteriormente (si es que los había) se eliminan de la 
memoria temporal quedando los actualmente seleccionados. 

Paste inserta los elementos que se almacenaron previamente en la memoria temporal mediante 
la opción Copy, al seleccionar esta opción se presenta una ventana en donde se puede 
especificar un incremento a todas las coordenadas de los nudos y a los nudos extremos de los 
elementos guardados previamente con la opción Copy (ver figura 4.9). 
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Figura 4.9 Opción Paste del menú Edit. 

Move Una vez seleccionados algunos nudos este comando permite cambiar las coordenadas 
de los nudos seleccionados desplazándolos hacia nuevas posiciones obtenidas a partir de sus 
coordenadas actuales y de la información que el usuario proporcione en la ventan~ que se 
despliega cuando se elige esta opción (ver figura 4.1 0). 
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Figura 4.10 Información complementaría de la opción Move del menú Edit. 

Replica te Una de las opciones más poderosas con la que se pueden realizar varios efectos es 
la opción Replicate del menú Edit, dentro de esta opción a su vez se encuentran disponibles 
otras J, Linear, Radial y Mirror. 

La opción Linear permite realizar varias copias de los elementos seleccionados, esas copias 
se pueden realizar en cualquiera de las direcciones x, y o z, por ejemplo si las copias se 
quieren realizar en dirección x se especifica un valor de x diferente de cero en la caja 
respectiva y cero en las demás (ver figura 4.11 ), desde luego se pueden especificar valores 
diferentes de cero con el efecto correspondiente, la opción Radial permite realizar copias en 
dirección radial (angular) especificando el eje alrededor del cual se van a hacer las copias asi 
como el incremento en grados y el número de estas. 
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Figura 4.11 Efecto de Linear en la opción Replica te del menú Edit. 

La opción Mirror permite realizar una copia tipo espejo de los elementos 
seleccionados especificando la posición del espejo mediante la selección de un plano (xy, yz o 
xz) y la distancia del origen a la posición del espejo (ver figura 4.12), esta opción resulta muy 
útil cuando se tiene una estructura simétrica ya que se introduce una parte de la misma y se 
genera la otra (parte simétrica) mediante la opción Mirror. 
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Figura 4.12 Efecto al seleccionar Mirror de la opción Replicate en el menú Edit. 
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4.4 DEFINICIÓN Y ASIGNACIÓN DE MATERIALES 

En el menú Define en la opción Materials se podrán especificar las características de lo­
materiales del cual estarán formados los elementos estructurales, en este menú se pueden especific. 
materiales tales como concreto, acero y otros; después de seleccionar esta opción aparece el cuadro -­
que se muestra en la figura 4. 13, en donde como puede observarse mediante la opción Modify/Show 
Materials, se mostrarán con la posibilidad de modificar algunas características del material que 
interviene para el análisis y el diseño de elementos (ver figura 4. 14). 

Figura 4.13 Ventana para definición de materiales. 

Figura 4.14 Ventana Modifi/Show Material de la opción Define Materials. 

Add New material permite definir un nuevo material, se tendrá que especificar desde el 
nombre (Material N ame), formado por un conjunto de hasta ocho caracteres el cual hará referencia 
a este material, se tendrán que proporcionar por lo menos los datos que se muestran en el cuadro 
análisis Property Data, sobre todo el módulo elástico y la relación de Poisson, en el caso de que se 
requiera considerar el peso propio en alguna condición de carga se tendrá que proporcionar el peso 
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por unidad de volumen, si se va a .solicitar alguna opción de análisis dinámico en donde se quiera 
considerar a la masa de la estructura repartida a lo largo de sus elementos será necesario 
proporcionar el valor de la masa por unidad de volumen, en el caso de que se requiera considerar el 
efecto de temperatura es necesario proporcionar el coeficiente de expansión térmica (ver figura 
4.15). 

Figura 4.15 Opción Add New material de Deline Materials 

Se pueden definir varios materiales dependiendo de los que se requieran para especificar a 
los elementos en la estructura, la opción Materials del menú Deline también permitirá el.iminar 
algún material de los que se muestran en el cuadro Materials con excepción de los materiales 
Conc y Steel, para ello sólo se hace clic en el nombre del material a eliminar y luego en el botón 
Delete Material. 

4.6 DEFINICION Y ASIGNACION DE PROPIEDADES GEOMETRICAS 

En el menú Deline también se encuentra presente la opción para definir características de las 
secciones transversales (Frame Sections) de los elementos que están presentes en la estructura por 
analizar. En la ventana correspondiente (ver figura 4.16), se tiene la opción lmport para seleccionar 
las propiedades de una base de datos con extensión PRO, la versión educativa del programa 
SAP2000 proporciona los archivos Aisc.Pro, Cisc.Pro y Sections.Pro de los dos primeros se 
pueden seleccionar algunas formas comunes, esos archivos se encuentran en la carpeta SAP2000e. 

También se pueden definir las propiedades a partir de formas comunes mediante la opción 
Add, otras opciones que también se encuentran disponibles permiten modificar (Modify/Show 
Section) o eliminar alguna propiedad (Delete Section), 
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Figura 4.16 Opciones en Define Frame Sections del menú Define. 

En la opción Add se tendrá que seleccionar la forma de la sección (rectangular, circular, tee, 
general, etc., ver figura 4.17). 

Figura 4.17 Selección de una forma predeterminada. 

Una vez seleccionada la forma habrá que proporcionar algunas de las dimensiones de la 
misma con las cuales el programa obtiene de manera automática las propiedades geométricas de la 
forma definida (ver figura 4.18). 
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Figura 4.18 Especificación de las dimensiones de la forma de una sección transversal seleccionada. 

El nombre de la sección se puede cambiar modificando el contenido del cuadro en blanco 
(Section Name), este nombre se utilizará para referencias posteriores (asignar esta sección 
transversal a uno o más elementos del modelo). Las características a modificar se presentan en el 
cuadro Dimensions, del cuadro Material se deberá seleccionar el material (los materiales se 
definieron previamente, ver párrafos anteriores) del cual esta o estará formada esa sección 
transversal. Una vez proporcionadas las dimensiones de la forma de la sección transversal se pueden 
mostrar sus propiedades geométricas (área, momentos de inercia, etc.) seleccionando la opción 
Section Properties del cuadro Properties, se pueden modificar (aumentar o disminuir en cierta 
proporción) algunas de esas propiedades modificando el factor correspondiente a la propiedad que 
se quiera modificar (el factor que se especifica es con respecto a la unidad) para ello habrá que 
seleccionar el botón Modification Factors del cuadro Properties y modificar el contenido del 
cuadro en blanco que corresponda a la propiedad que se quiere modificar. 

Una vez definidas las distintas secciones de los diversos elementos estructurales habrá que 
indicar la sección transversal que corresponda al o a los elementos estructurales (la forma de la 
estructura ya se ha generado), primero se seleccionan los elementos que tiene una misma sección 
transversal, para ello se puede utilizar algún método de selección de la opción Select del menú con 
el mismo nombre, enseguida seleccionar Sections de la opción Frame en el menú Assign, con lo 
que aparece la ventana que se muestra en la figura 4.16, por último, en esa ventana se tendrá que 
seleccionar el nombre de la sección (la cual se definió previamente) del cuadro Frame Sections, 
después de hacer clic en el botón OK se asigna a los elementos seleccionados las características 
especificadas en la sección transversal seleccionada. La operación anterior se repetirá tantas veces 
como sea necesario para asignar secciones a todos los elementos que componen al modelo. 

4.6 CONDICIONES DE FRONTERA, TIPOS DE APOYO 
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Para especificar los tipos de apoyo o condiciones de frontera de la elástica de la estructura 
primero se seleccionan aquellos nudos que tengan las mismas restricciones de desplazamiento, esto 
se hace con algunas de las opciones aplicables del menú Select y después seleccionar Restraints dA 
la opción Joint del menú Assign (ver figura 4.19), desplegándose la ventana que se muestra en W" 
figura 4.20, en ella se habrá de indicar el tipo de restricción que tendrán los nudos que se han 
seleccionado previamente, a menos que se modifiquen las direcciones 1, 2 y 3, corresponden a las 
direcciones globales X, Y y Z respectivamente, se puede seleccionar algún tipo de apoyo particular 
de uso común haciendo clic en alguno de ellos en el cuadro Fast Restraints. La operación anterior 
se puede aplicar en repetidas ocasiones para especificar completamente todos los nudos restringidos 
que tiene el modelo. 

l 

.. . : . '~ 
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Fig. 4.19 Selección de restricciones. 

Para cambiar las restricciones de algún nudo se requiere seleccionarlo y asignarle las nuevas 
restricciones, si se desea que ese nudo tenga posibilidad de desplazamiento lineal y angular en todas 
las direcciones habrá que dejar en blanco todos los cuadros del marco Restrainsts in Local 
Directions o bien hacer clic en el icono con un punto negro del marco Fast Restraints. 
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4.7 ASIGNACION DE FUERZAS Y COMBINACIONES 

Para introducir diversos tipos de fuerza estática al modelo, primero habrá que definir 
condiciones de carga estática, para ello se selecciona la opción Sta tic Load Cases del menú Define 
mostrándose la ventana de la figura 4.20, en ella se puede adicionar una nueva (Add New Load), 
modificar características de una que existe (Change Load), o suprimir una condición de carga 
(Delete Load), resulta lógico que ál menos se debe proporcionar una condición de carga. 

El nombre de la condición se espeCifica en el cuadro en blanco debajo de Load y si se quiere 
considerar el peso propio en esa condición de carga se debe de proporcionar el valor de 1 en el 
cuadro en blanco debajo de Self Weight Multiplier, una vez que se han introducido los datos 
anteriores se puede seleccionar Add ... para definir una nueva condición de carga o bien Change ..• 
para cambiar los datos de la condición de carga seleccionada (con fondo oscuro) por los datos de los 
cuadros en blanco. 

Para modificar el nombre y el multiplicador del peso propio además de introducir el nuevo 
valor en los cuadros en blanco habrá que seleccionar la condición que se quiera modificar haciendo 
clic sobre ella, con lo que el fondo de la condición seleccionada cambia a obscuro y después hacer 
clic en el botón Change Load se realizan los cambios indicados ya que hasta que se ha hecho clic 
en este botón quedan registrados esos cambios es decir no basta modificar el contenido de las cajas 
en blanco. 

Oefuie Sbti< Load Case Nomu · · · · 

Fig. 4:20 Definición de condiciones de carga estática. 

Para la asignación de fuerzas y o momentos a los nudos habrá que seleccionar aquellos nudos 
que tengan las mismas fuerzas y después seleccionar Forces de la opción Joint Static Loads en el 
menú Asign (ver figura 4.21). 
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Fig. 4.21 Opción para asignar fuerzas a los nudos previamente seleccionados. 

Enseguida se despliega la ventana mostrada en la figura 4.22, en ella se habrá de seleccionar 
del marco Load Case Name la condición en que se incluirán las fuerzas que se están especificando 
(por omisión aparece LOAD 1), en el cuadro correspondiente a la dirección de la fuerza y o 
momento que actuará sobre los nudos seleccionados se introducirán los valores respectivos (en el 
marco Loads), también se encuentran disponibles las opciones: 

Add To Existing Loads (seleccionada por omisión), la cual adicionará a las fuerzas 
existentes en los nudos seleccionados las nuevas fuerzas que se están especificando, es 
decir si los nudos ya tenían fuerzas se les adicionarán las nuevas fuerzas cuyos valores se 
han introducido en los cuadros en blanco. 

Replace Existing Loads permitirá eliminar las fuerzas existentes en los nudos 
seleccionados remplazándolas por las que se están especificando en el marco Loads. 

Delete Existing Loads suprimirá las fuerzas existentes en los nudos seleccionados, 
independientemente de los valores que se están especificando en el marco Loads. 
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Fig. 4.22 Especificación de fuerzas en los nudos. 

Para definir y asignar fuerzas a las barras primero se seleccionan las barras a las cuales se les 
asignarán las mismas fuerzas, después se selecciona el tipo de fuerza (uniforme, concentrada, 
variación lineal, etc.) de la opción Frame Static Loads del menú Assign (ver figura 4.23). 

Por ejemplo para cargas puntuales y o uniformes en las barras se muestra la ventana de la 
figura 4.24, en donde se selecciona el nombre de la condición a donde se incluirán las fuerzas que se 
están especificando, así como el tipo de carga (fuerza o momento) así como la dirección en que 
actuarán y la opción a utilizar (Add ... , Replace ... y Delete ... ). En los cuadros en blanco del marco 
Point Loads se especifica el valor de las cargas concentradas así como la posición de cada una de 
ellas con respecto a la longitud del elemento, es decir si el valor de Distance es 0.5 indica que la 
carga está aplicada a la mitad del elemento, en el cuadro en blanco del marco Uniform Load se 
proporciona el valor correspondiente a la carga uniforme que actuará sobre el elemento. Pueden 
especificarse simultáneamente cargas concentradas y uniformes o sólo algún tipo de los anteriores. 
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Fig. 4.23 Opción para introducir fuerzas en las barras. 
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C.pctulo .. 

Fig. 4.24 Definición de fuerzas uniformes y/o concentradas en las barras. 

Una vez que se especifican las fuerzas y se hace clic en el botón OK se ejecuta la opción 
seleccionada, en el caso de que esta sea adicionar o remplazar cargas, estas se muestran con sus 
características en el área de dibujo de la pantalla. 

Definidas las condiciones de carga se pueden realizar combinaciones de las anteriores, es 
decir condiciones de cargas dependientes, para ello se selecciona la opción Load Combinations del 
menú Define mostrándose la ventana de la figura 4.25, con la posibilidad de adicionar, modificar y 
suprimir combinaciones de carga estas opciones se muestran en el marco Combinations las 
combinaciones que se tengan definidas hasta el momento. 
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Capitulo 4 

Fig. 4.25 Ventana para especificar y modificar combinaciones. 

La opción para adicionar una nueva combinación despliega la ventana que se muestra en la 
figura 4.26, ahí se especificara el nombre, tipo y algún título para la combinación. Para definir las 
condiciones de carga que participaran en la combinación que se especifica, así como su respectivo 
factor de participación (con relación a la unidad, 1=100%) se selecciona el nombre y se modifica el 
valor en el cuadro en blanco debajo de Scale Factor en el marco Define Combination y después se 
hace clic en cualquiera de los botones Add, Modify, o Delete. 

Fig. 4.26 Especificación de las características de una combinación. 
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CapJtulO 4 

Cuando se han especificado·los datos de la combinación se hace clic en el botón OK. 

Una vez que se han definido combinaciones se puede modificar sus características con la 
opción Modify/Show Combo o bien suprimir alguna combinación con la opción Delete Combo, 
cualquiera de estas opciones se selecciona haciendo clic sobre ella en el marco Combinations. Se 
pueden especificar tantas combinaciones como el problema de Análisis lo requiera. 

4.8 OPCIONES DE ANALISIS SELECCIÓN DE RESULTADOS 

Una vez que se han especificado completamente las características geométricas, elásticas, 
condiciones de frontera y fuerzas se está en posibilidades de que el programa SAP2000 realice el 
Análisis Estructural del modelo, sin embargo es conveniente especificar algunas opciones de 
Análisis, para ello se selecciona la opción Set Options del menú Analyze, desplegándose la ventana 
que se muestra en la figura 4.27. 

Figura 4.27 Selección de opciones de Análisis. 

En ella se pueden seleccionar las componentes de desplazamiento independientes o grados 
de libertad que se considerarán para el análisis, SAP2000 permite analizar estructuras en un espacio 
tridimensional por lo que cada nudo tiene la posibilidad de desplazarse lineal y angularmente en tres 
direcciones ortogonales. es decir en general posee 6 grados de libertad (a menos que se indique otra 
alternativa). 
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Si la estructura está contenida en un plano es conveniente indicar los grados de libertad que 
no intervienen en el Análisis con objeto de eliminar la posibilidad de inestabilidad en dirección 
perpendicular al plano de la estructura, disminuyendo además el tiempo de ejecución del Análisis, !". 
anterior se realiza desactivando grados de libertad en el marco Available DOFs o bien permitiencw 
que el programa lo realice dependiendo del tipo de estructura que se selecciona haciendo clic en 
alguno de los iconos que se muestran en el marco Fast DOFs y que corresponda con las 
características de la estructura que se vaya a analizar. 

En la parte inferior de la ventana se muestran las opciones de Análisis Dinámico y efectos P­
Delta, también se pueden seleccionar resultados que han de almacenarse en el archivo de salida 
(nombre. OUT), en el último renglón se muestra en un cuadro en blanco el valor de la memoria 
reservada para la solución del problema, este valor deberá aumentarse en caso de que no sea 
suficiente cuando se muestre el mensaje correspondiente durante el proceso de Análisis. 

La selección de resultados del Análisis se puede realizar haciendo clic en el cuadro en blanco 
a la izquierda de Generate Output (ver figura 4.27) y después de hacer clic en el botón Select 
Output Options se muestra la ventana de la figura 4.28. 

Figura 4.28 Selección de combinaciones de carga y tipos de resultados a incluirse en el archivo de 
salida. 
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En ella habrá que indicar los resultados que se incluirán en el archivo de salida haciendo clic 
en los cuadros en blanco y seleccionando para cada uno de esos resultados las condiciones de carga 
de los cuales se requieren Jos resultados seleccionados, lo anterior se logra haciendo clic en el botón 
Select/Show Loads correspondiente, con lo que se presentará una ventana mostrando las 
condiciones y combinaciones de Análisis que se han especificado para la estructura por analizar, en 
esa nueva ventana se deberán seleccionar las condiciones de carga para las que se requieren los 
resultados seleccionados, la condición o combinación de carga seleccionada se muestra con fondo 
oscuro, se puede seleccionar más de una combinación de carga arrastrando el ratón en el cuadro de 
selección. 

Es necesario que se seleccione al menos una condición o combinación de carga para que los 
resultados se encuentren disponibles en el archivo de salida ya que de no hacerlo Jos resultados no se 
almacenarán (ver figura 4.28). 

' 
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5.1 ANALISIS DEL MODELO 

ANALISIS 
DELA 
ESTRUCTURA 

CAPÍTULO 

Una vez que se han especificado las opciones de Análisis se puede solicitar la ejecuCión del 
mismo, seleccionando la opción Run del menú Analyze con lo que el análisis se efectúa y los 
resultados de esta fase se muestran en la ventana de la figura 5.1, en su extremo derecho se observa 
una barra de desplazamiento vertical que permite ver el contenido de la pantalla, al final de esta se 
muestra el botón OK haciendo clic en él se despliega en la mayoría de los casos la configuración 
deformada de la estructura para la primera condición de carga con lo que se está en posibilidades de 
tener acceso a varias opciones del menú Display las cuales nos mostrarán de manera gráfica y 
numérica algunos resultados del Análisis (desplazamientos, elementos mecánicos, etc.). 

Figura 5.1 Ventana después de seleccionar la opción Run del menú Analyze 

5.2 VERIFICACION DE ALGUNOS ELEMENTOS DEL PROCESO DE ANALISIS 

Después de que el Análisis ha concluido se generan una serie de archivos con el mismo 
nombre que el archivo de datos pero con extensión diferente, algunos de los que se generan y que 
pueden ser de utilidad son: 

El archivo nombre.LOG (ver figura 5.2), el cual contiene información de la fase de Análisi 
(memoria disponible, número de ecuaciones de equilibrio formadas, características de la matriz dé 
rigideces, balance de errores relativos y diversa información de salida). 
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El archivo nombre.$2k contiene los datos de la estructura a analizar como son: geometría, 
materiales, secciones, cargas, combinaciones, etc., tal y como se generaron por ejemplo mediante el 
editor gráfico del programa SAP2000, se puede recurrir a este archivo en el caso de que el archivo 
nombre.SDB sufra algún cambio que lo imposibilite para ser procesado por SAP2000. 

llJ m~b:o.LOC- WonlPod Ml'i.IEJ 
' :,: ' :. . : ' ..... '.: ': ~· :. ':: '.'(',. : ,•,•,•,:''" 

PROG-RIIH :1o\P2000 - VI:Jt:IIOlf 1:6.10 flLZ:.PP.lJt:liA.LO!;. 
t»UCATIO•AL V&it:IJOB - C~CIAL U:lt FltOHJBIT~ 
BI:COIB ABALY313 PHASI: 2000/0S/01 14.50:40 
KI:HOitY AVAILAII'U: rop. DATA IBYft31 1000000 
oiOI.T I:LI:HI:BT FOII:Ho\TIOJ 14 .. n:u 
NUII:P OF oiOUfT Z:Lz:t.a:JTS FOJIKI:tl • 
B\IKBZ:P or :IPitllfCO I:LI:KI:JTS roPHJ:D O 
f:P.AHZ: I:LZ:NI:JT FOJtNATIOJ 
Jr\IMllz:Jt or rP.NU: nz:ta:JTS roPHJ:D • u 
I:OVATIOlf SOL\ITIOJ 14. H. 50 
TOTAL BUKBI:JI. OF I:OVILDJtiW tO\IATIOI:I 20 
APPitOXINATI: "rrO:CTtvZ:• BAnl IHPTll O 
INHlii:JI. or Z:OUATIOB :ITOJtA!ñ: !ILOCJC:I 
NAXlHW BLOOC :11n: llllMJD OF TOH:IJ UO 
snz: or nzrr.t" rzu I!IYft:IJ 1240 
II\IHlii:Jt or I:011AT 1033 TO 'OLVI: 20 
.uter:.Jt or :ITATIC LOAD CUt' 

I\IHDZ:P. Of lfOJil.JlftAP; DZ:fOPHATlOlf l.OAD' O 
oiOIBT OUTP11T l4H.U 
c;.t.ODAL fORCZ: DALAJCI: P.I:Lo\TIVZ: Z:P.P.Oit' 
PZ:P.CI:liT ro ~tez: AlfD HOKI:BT Z:~OP. AT THt OP.IG-11, JI G-LOBAL COOlliiiiATI:' 

LO .. nc ry " KX "" "' COlJDJ. '7.Ul:-U .oooooo .000000 .000000 1.J.Ot·l4 .000000 
COIIIIZ .000000 ,000000 .000000 .000000 . 000000 .000000 
COlfDO Z.'l'OE·U . 000000 . 000000 .000000 l.l.IX-14 . 000000 
C01JD4 .000000 ,000000 .000000 .OOOOCIO . 000000 .000000 
LOAD J. S.OOI:-J.S . 000000 '7.06I:·lS .000000 4. 7'7E·l4 .000000 

Cotm HAX/N 13 n ry " KX K'l "' ''""' '?, SZt·U ,000000 • 000000 .000000 1.J.OZ:·J.4 . 000000 
COK>l '7.SZt·l6 ,000000 . 000000 .000000 1.10E·J.4 .000000 

t t. 1: N t lf T ' o ¡ • T . r o P. e t 0\ITPUT 14:50: Sl 
avtetlt or r11.AfU! I:LI:Ktli'U SAVI:D 14 
F P. A K 1: Z:LI:NtlfT OUTPUT u. so: u 
JrWOI:R or n.Na: l:I.EKI:liT' '.\VI:D 14 
.\ • AL y 3 ¡ • CONPLtTZ: ZOOO/ OS/ 01 J.4:$0:SZ 

Figura 5.2 Contenido típico del archivo nombre.LOG 

El archivo nombre.EKO contiene una imagen o resultado del procesamiento de los datos 
contenidos en el archivo nombre.SDB generado mediante el editor gráfico del programa SAP2000, 
este archivo (nombre.EKO), contiene textos que indican las características de los datos procesados 
por ejemplo: hay un titulo y encabezado para las coordenadas de los nudos seguido de éstas, es 
decir se despliega información respectiva para cada bloque de datos asi como los valores 
respectivos, únicamente se incluyen en este archivo los datos procesados. 

En el caso de que se hayan seleccionado resultados para ser impresos éstos se encuentran en 
el archivo nombre.OUT. 

Es conveniente verificar algunas características particulares del problema que se resolvió, 
por ejemplo que coincida el número total de grados de libertad que la estructura tiene con el número 
de ecuaciones de equilibrio que el programa formó y resolvió. también es conveniente verificar el 
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Analasas de la Estruc!Ura 

número de elementos barra, placa, etc. que el programa procesó. Desde luego es conveniente 
verificar que todos los datos del problema fueron procesados por el módulo de Análisis, para todo lo 
anterior se recurre a revisar el contenido de los archivos mencionados en los párrafos anteriore­
para tener acceso al contenido de esos archivos se puede recurrir a varios programas o procesador .. 
de texto (por ejemplo Edit, Word Pad, Word, etc.) 
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ScletciOfl e lni~IICIOn de Resultados 

6.1 INTRODUCCION 

SELECCIONE 
INTERPRETACION 
DE RESULTADOS 

CAPÍTULO 
6 

Una vez que el Análisis se ejecuta sin que se hayan generado errores durante el mismo y 
después de hacer clic en el botón OK de la ventana que se muestra en la opción Run del menú 
Analyze, se pueden seleccionar varias opciones del menú Display que nos permitirán ver los 
diversos resultados tanto de manera gráfica como numérica, por ejemplo Show Deformed Shape 
nos mostrará la configuración deformada de la estructura para alguna condición de carga, Show 
Element Forces/Stresses nos mostrará el diagrama de elementos· mecánicos, como puede verse en 
la figura 6.1, se encuentran disponibles algunas otras opciones para despliegue de resultados. 

~~,~~r·;,,¡!o~·,\ll~:;''"a~yu, ¡;; 12»>t>l<v .. ·Ci.~~;;.,JQ¡>Iic.<>L· 11•1.~ , ... ,. :· ::; :::· .. ::;.,;+'.:. 
·Sh.,,.;i:/,;:<IOro<iM<I!lh<.P•••• ... · · .... ,.,. f';\:· :·, ... · 

~::!::.'::~~:;,:~~§::!:§::!§§~· '~~;;:.~~,.:.· ' ,:,_;; 
Y>W••L~wm•····· ' 

:: ::·~;r-'~-/i)i+~V;.:.:: .,. 
:: :~;~o:".~~:r~~~~·.·;:·: .. ·· :.:·:.:-;:;.:::/.>. ,. 

............ : .. .. ................. .. 

Figura 6.1 Opciones en el menú Display 
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6.2 VER LA ESTRUCTURA DEFORMADA 

Para ello como se indicó en el párrafo anterior se selecciona la opción Show Deform'' 
Shapr del rnenu Display mostrándose la ventana de la figura 6.2, en esa ventana se selecciona de 
marco Load (parte superior de la ventana) la condición de carga de la cual se quiere ver la estructura 
deformada; en el marco Scaling se presentan dos opciones para la escala que se utilizará al 
desplegar la configuración deformada en caso de que se seleccione Scale Factor se presentará el 
factor de escala que se utilizará para tal fin, este factor mostrado en la caja en blanco puede ser 
modificado por el usuario, otras dos opciones se encuentran en el extremo inferior izquierdo de esa 
ventana, la primera de ellas es decir Wire Shadow mostrará además de la configuración deformada 
la no deformada, la ultima opción que es Cubic Curve, en caso de estar activada mostrará la 
configuración deformada ajustando una curva a esa configuración, en caso contrario sólo se dibujará 
la configuración deformada con lineas rectas. 

·...... /" .. .... ,.. -:-,· 
/ '· / ' 

/ '· .• ~ 

Figura 6.2 Sele:ción de parámetros para despliegue de la configuración deformada. 

Una vez mostrada la configuración deformada de la estructura se puede seleccionar algún 
nudo (p. ej. haciendo clic izquierdo) y después hacer clic derecho en el nudo seleccionado con lo. 
cual se presentará una ventana conteniendo el valor de los desplazamientos de ese nudo (ver figura 
63). 
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Figura 6.3 Valores del desplazamiento de un nudo seleccionado. 

6.3 VER LOS DIAGRAMAS DE ELEMENTOS MECANICOS 

Como se ha mencionado. SA P2000 permite mostrar gráficamente los valores de algún 
elemento mecánico para determinada condición de carga. para ello se selecciona Frames de la 
opción Show Element Forces/Stresses en el menú Display presentando la ventana de la figura 6.4. 

En el marco Load se selecciona la condición de carga y en Componen! se selecciona el tipo 
de elemento mecánico. las opciones en· el marco Scaling producen el mismo efecto al caso de la 
configuración deformada. las opciones que se encuentran al final de la ventana nos permiten 
seleccionar si se desea un diagrama "lleno" y sin despliegue de valores del elemento mecánico o con 
valores en el diagrama. 
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Figura 6.4 Selección de parámetros para despliegue de diagramas de elementos mecánicos. 

Una vez mostrado el diagrama se puede seleccionar algún elemento barra haciendo clic sobre 
él y después de hacer clic derecho sobre el mismo se presenta una ventana mostrando el diagrama 
del elemento seleccionado, así como el valor del elemento mecánico en una sección transversal 
situada a la distancia que se muestra en el cuadro en blanco (ver figura 6.5), desplazando el puntero 
del ratón a lo largo del eje del elemento dentro de la ventana desplegada se muestra tanto la posición 
de la sección transversal como el valor respectivo del elemento mecánico, el contenido del cuadro 
puede ser modificado por el usuario desplegándose instantáneamente el valor del elemento mecánico 
que corresponda a la sección cuya posición se especificó en el cuadro en blanco. 
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Figura 6.5 Diagrama de un elemento mecánico de; una barra seleccionada. 

6,4 VER LOS RESULTADOS DE DISEÑO 

Algunas opciones de diseño se encuentran disponibles en el menú Design una vez realizado 
el Análisis se pueden tener acceso a ellas. 

Como primer paso se seleccionará el tipo de diseño y características a utilizar, por ejemplo 
en el caso de diseño de concreto se tendrán que especificar algunas características de refuerzo lo 
cual se deberá de hacer en Modify/Show Section de la opción Define Frame Sections en el menú 
Define. seleccionando en la ventana que se despliega el botón Reinforcement para enseguida 
especificar el tipo de elemento (columna o viga), la configuración del refuerzo y las características 
de éste (ver figura 6.6). · 
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Figura 6.6 Características para diseño de un elemento. 

Como segundo paso se deberá especificar las combinaciones de carga que se utilizarán para 
verificar el diseño activando la que se quiera para ser usada en el diseño, esto se puede hacer en Add 
o Modify/Show Combo en la opción Load Combinations del menú Define (ver figura 6.7). 
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Figura 6. 7 Especificación de combinaciones de carga para diseño. 

Una vez realizado el Análisis, como tercer paso se seleccionarán las combinaciones de 
diseño para ello utiliza la opción Select Design Combos del menú Design (ver figura 6 8). 
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Sclec:c1on e lnlcrptctaciOn de Resultados 

Figurá 6.8 Alguna~ opciones del menú Design. 

Como cuarto paso se seleccionará la opción Start Design ... del menú Design (ver figura 6.8) 
con lo que se desplegarán algunos resultados del diseño, seleccionado una barra y después de hacer 
clic derecho sobre la misma se m'úéstra una ventana similar a la de la figura 6.9. 
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Se/«c1011 e lnlerpretac10n de Resultados 

Figura 6.9 Resultados de diseño de un elemento seleccionado. 

De ella se puede seleccionar el botón Details mostrándose información más detallada acerca 
de las características de diseño del elemento, se puede mostrar información diversa de la ventana 
arrastrando el m o use (botón izquierdo hacia alguna zona especifica de la ventana, ver figura 6.1 O) 
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Figura 6.1 O Detalle de los resultados de diseño de un elemento seleccionado. 

6.4 OTRAS CARACTERISTICAS 

El despliegue de reacciones puede .ser seleccionado mediante Joints de la opción Show 
Element... del menú Display mostrándose la ventana de la figura 6. 11, en donde se podrá 
seleccionar la condición de carga, después de hacer clic en OK se muestran las reacciones 
correspondientes a la condición de carga seleccionada (ver figura 6.11 ). 
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Jaint Rea:ct:ion FoFCeS ' ' , 

Figura 6.11 Ventana para la selección de reacciones 

Están disponibles en el menú Display algunas otras características relacionadas con el 
Análisis Dinámico como el dibujo de formas modales, espectros de respuesta y análisis de la 
respuesta en el tiempo y otras más. 

Los resultados del Análisis se pueden almacenar en un archivo a manera de tablas para ello 
se selecciona la opción Set Output Table Mode del menú Display mostrándose una ventana en 
donde se seleccionarán las condiciones de carga de los resultados que se incluirán, después de hacer 
clic en el botón OK se pasa a una ventana con de título Analysis Output Tables (ver figura 6.12) 
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Clp1fulo6 Sclecc1on e InterpretaCIÓn de R~ultadoo 

Figura 6.12 Selección de condiciones y para la generación de resultados en forma tabular.· 

En esa ventana se podrá· seleccionar algún nudo o elemento después de hacer clic derecho en 
un nudo seleccionado, se desplegará una ventana conteniendo tanto los desplazamientos como las 
reacciones del nudo para las condiciones de carga seleccionadas (ver figura 6.13) 
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Capitulo 6 Selccxaón e Interpretación de Rcsultldos 

l'l E N T S 

ux 
0.0000 
0.0000 

UY 
0.0000 
0.0000 

uz 
-1. <)47r.-o~~ 
"2. :J06E .. 03 

Figura 6.13 Ventana de resultados de un nudo seleccionado. 

Si el elemento sobre el que se hace clic es una barra entonces la ventana que se despliega 
contiene los elementos mecánicos de las condiciones de carga seleccionadas (ver figura 6.14). 
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CaPlnllo6 

:~ Cot-ml. 0.0000 

iT O I N T 
,JOINT 

3 
3 

R E A C T 1 O H S 
T.OAD F1 
I.OADl. 
COiilH 

0.0000 
0.0000 ............... ::·: 

0.0000 0.0000 
0.0000 0.0000 

FZ 1'3 
1). 0000 
0.0000 

Setec<:ton e tnterprell<:ltlfl de Resultados 

RX 
0.0000 
0.0000 3 .1.50E-o:~ 

Figura 6.14 Ventana de resultados de una barra seleccionada. 

Tanto en la ventana de resultados de nudos como de barras en el extremo superior izquierdo 
de esta se encuentra la opción File, que permite el almacenamiento de los resultados contenidos en 
la tabla mostrada en un archivo, para ello después de hace clic en File, habrá que proporcionar en el 
cuadro en blanco el nombre del archivo y hacer clic en el.botón guardar (ver figura 6.15). 
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o.oo o.oo ··17. 40 0.00 0.00 
.1. !jo 0.00 -4.98 0.00 0.()0 
3.00 0.00 ··4. 753E··01 0.00 0.00 
4. ~o 0.00 4.02 0.00 0.00 
t\.00 o.oo fl. 52 o.oo 0.00 

Open Fil~ for Printiil¡¡ Jable~ · ' · iJ Ei 

ejemplo3 
ejemplo33 
ajamplo44 
e¡emplo99.0UT 

······~··· .. 

curso sap 1000 

·¡~ ........... ' ··.·rl-'.0.,.., . .iool,;, .... "'",.":":r ""1 

¡to;;'F.'r~~r~t•'l ........... c., . ..: ................................ -._3 ·. C~n<:~lar 

Figura 6.15 Almacenamiento de resultados en un archivo. 
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7.1 INTRODUCCION 

OPCIONES. 
ADICIONALES 

Opc1ones AdlcKmales 

CAPÍTULO 
7 

1 -
SAP2000 posee varias características, con algunas de ellas se pueden modelar por ejemplo 

muros y losas mediante elementos Shell, las opciones abarcan desde la definición de materiales 
dibujo de elementos, definición de características geométricas del elemento (Shell Sections) así 
como la asignación de las características anteriores además de las fuerzas (uniformes, presión, 'etc.) a 
este tipo de elementos. La estructura y secuencia es muy parecida a la utilizada para los elementos 
barra, se recomienda consultar la ayuda en linea, los temas relacionados en los manuales o bien ver 
los ejemplos en la carpeta de ejemplos o en el disco. 

En cuanto al elemento finito sólido, este no se puede generar utilizando el editor gráfico de la 
versión estudiantil (versión 6.1 ó 6.13), por lo que su definición y demás características se tendrán 
que realizar mediante una serie de instrucciones que se adicionarán al archivo de datos mediante un 
editor. la misma recomendación hecha en el párrafo anterior es aplicable a este caso. 

Una gran variedad de opciones para Análisis Dinámico está incluida en el programa 
SAP2000, para usar alguna de ellas se recomienda consultar los ejemplos que acompañan al 
presente instructivo o que se encuentran en el diskete, o bien los que se encuentran en el manual 
respectivo. 

También existe la posibilidad de Análisis de estructuras de puentes obteniendo mediante el 
programa por ejemplo: líneas de influencia, envolventes de elementos mecánicos, etc., lo anterior 
para varias condiciones de carga incluyendo uno o varios carriles con cargas vehiculares tipo o 
definidas por el usuario, la recomendación del párrafo anterior es igualmente aplicable. 

Se recomienda consultar al autor ya que se encuentra en proceso un instructivo similar al 
presente para los fines mencionados en los párrafos anteriores 

7.2 VER EL ARCHIVO DE ENTRADA 

Durante una sesión con el programa SAP2000 las opciones Save y Save as del menú File 
permiten almacenar en un archivo con extensión SDB los datos de la estructura que se han 
introducido, al archivo así creado sólo se podrá acceder (para fines de este programa) mediante la 
opción Open del mismo menú, sin embargo los datos pueden ser almacenados en un archivo que 
pueda modif1carse y ser reconocido por el programa SAP2000 para ello se selecciona 
SAP2000.S2K de la opción Exporten el menú File (ver figura 7.1 ). 
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Figura 7.1 Almacenamiento de datos para poder realizar cambios al archivo. 

El archivo extensión S2K puede ser modificado con la ayuda de algún editor (por ejemplo 
Edit, WordPad, etc.), el archivo resultante de la modificación deberá ser almacenado sin ningún 
caracter de control especial que se almacene en el mismo archivo, y con la misma extensión, si se 
usan algunos editores o procesadores de palabras se deberá tener especial cuidado de lo anterior, en 
caso de uso de esos procesadores se recomienda hacer varias copias de respaldo con objeto de no 
perder Jos cambios efectuados. 

Una vez realizados los cambios. el contenido del archivo extensión S2K modificado podrá 
ser procesado por SAP2000, para ello se selecciona SAP2000.S2h: de la opción lmport en el menú 
File, para ambas opciones (Export e lmport) será necesario proporcionar el nombre del archivo en 
el cuadro en blanco correspondiente de la ventana como la que se muestra en la figura 7.2. 
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Cap¡tulo 7 

San E ort Filo Al . " . 0 EJ 

k · elgebre (.J fmm 
t· ., anellsts3d 2.Hotos tam1liares 
~/ ... bodege. ocho e 2.1 fotos naye universum 
t :J carlas pret · D gomez ,. 
~~ "'. colegio reine.1sebel CJ infone.vil 
f ~ curso se.p 2000 O mgen;ene. sJsmJca t .... De di ::J mampostena DEPFf 
f., Diseño Eólrco DEPFI D mothcad 
1::. ~ ejsep2000 :J prol 

:_J puentes 
CJ sherw1n 

id;;~,~~,;,~.·· 
Letch.vos de 1ipoo. ·· ····· ··· ·· :· ·· · 

· ·:. r Abrir.co,;,o iOlo !Et:lura .·· .... ,: .· 

Figura 7.2 Ventana en la opción Export SAP2000.S2K. 

7.3 VER EL ARCHIVO DE SALIDA 

El contenido del archivo de resultados nombre. OUT indicado mediante Generate Output en 
la opción Analysis Options del menú Analyze se genera después de ejecutar la opción Run del 
menú del mismo nombre, el archivo así generado puede ser consultado mediante cualquier editor o 
procesador de palabras e inclusive por algunas hojas de cálculo, para ello se seleccionará la opción 
abrir (Load u Open) del programa que se vaya a utilizar con ese fin y especificar el nombre del 
archivo desde luego con extensión OUT (ver figura 7.3 ). 
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Opciones AchcJonaies 

m~li~·J[tj~~~~,~r ~~~ ~:::::::··~; · ¡:t);·:'·;: ~ ;'':·:!·:·i:·;; =!~t' 
]~aune~ N~ . . ......•. ·· .•. 3 r--::r 'H'jK.IJi ~~~r¡: alilil §¡];< :::::; : 

S A P 2 O O 0 (P.) 

Structu~al Analy~i~ Programs 

Abrir . 013 

·.·f.}.::]:;~~~~~~~~;:.>J ~ ~. ~·.·o····'.e~·.2·0·0. o,. ' . y;·.=.~:.{~'."?'.''' 

\: .. ,;,enu~Jimm ::JEJEMPL0100UT 
;l¡ ~ e¡13dm OUT ~ EJEMPL012A OUT 
"·'·· ~ ej16din OUT [el e¡emplo4 OUT 
'\(: ¡:] e¡17dm.OUT ;!] e¡emplo5.0UT 
)' ~ ej18din OUT ~ e¡emplo6.0UT 
;; ~ e¡19dln OUT :!!) e¡emplo7 OUT 
:( leJe¡20dm OUT ':.] e¡emplo9 OUT 
:\' ~ e¡21 din.OUT i!J e¡emplo99.0UT 
::¡ ;!]ej3dmar1 OUT ~ J,ninfl OUT 
'~ .. 

PROGRAM SAP2000 - VERSION E6.10 

linini2.0UT 
lininflOUT 

., lininfS OUT 
losal.OUT 

"prueba OUT 
" shellt OUT 

EDUCATIONAL VERSION - C~1ERCIAL USE PROHIEITED 
FILE:EJ3DMARl.OUT 

PAGE 
l 

Figura 7.3 Acceso al archivo nombre. OUT mediante el programa WordPad. 

7.4 RELACION CON AUTOCAD 

La geometría de la estructura puede ser generada por AutoCAD realizando el dibujo de las 
barras (lineas) en una capa (Layer) de nombre Sap_frames (ver figura 7.4). 

La geometría así generada se deberá exportar a un archivo extensión dxf como se muestra en 
la figura 7.5. 
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C1p1tukl7 

Figura 7.4 Geometría generada en AutoCAD. 

ExpDJtData .· · · ' llJF.'J, 

; n~~~&!~~,,·~·; .J .. ~.c.urs~ 7.0.~. ~~00 
_j me.nualtmm 

·. ~ e¡emplol 

·.· .. • 

;., 

..... . • , ..... ·",::.'·''.::..'· •.;.;' ~:_:.;·_· .. •..:.:''':..-.c..:· '-'-' ·";_;·' '::-"."'_;.• '.;;_'·'·.;.;'''...:.' __:.;;...::.; 

., f)lómíJ<e d.a archrva: ]e¡ecedl dx1 ... 

: Óu~~ ~~o ' . • •.•• r¡ A-u.:.to":CA=o-::R.:-1-::4 -::D.:.XF.,:.;:!""-dxll-'-.:...:."-'-.:...:.-.:...:..:...:.--""1 

. . ·~NOS~~· tipo::. Lltnogrophy r sil) 
EnCf.IPSII!el~=>rl PS r "'riS) 
OX< Ex1rerl ("' rh·._.-) 
B'r~op !" h'"f') 

Figura 7.5 Exportando la geometría generada con AutoCAD a un archivo extensión dxf. 
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Para recuperar la información de un archivo dxf, se selecciona .dxf de la opción Import en 
el menú File ( ver figura 7 6 ). 

,. 

Figura 7.6 Importando datos de un archivo .dxf. 

Desplegándose enseguida la ventana que se muestra en la figura. 7. 7, en donde se deberá 
especificar el nombre del archivo cuya extensión es dxf después de hacer clic en abrir se seleccionan 
de la ventana que se muestra .en la figura 7.8 la dirección global y las unidades. 

Jnstruchvf' pltnl le uhh7aC!(In del prro¡m~nu SA.P 2000. Fl Li'IA\1 83 



Cap¡tulo 1 

Figura 7.7 Ventana para importar datos de un archivo dxf. 
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1 ....... 

";;,": 
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OK · ·i ~· ;! c..•o;ell ... { 
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Figura 7.8 Indicando características de los datos a importar de un archivo dxf 
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8.1 INTRODUCCION 

EJEMPLOS E 
INTERPRETACION 
DE RESULTADOS 

CAPÍTULO 
'8 

Durante la impartición del curso para uso y manejo del programa SAP2000 tanto en la 
División de Ingeniería Civil, Topográfica y Geodésica como en la División de Educación Continúa 
de la Facultad de Ingeniería de la UNAM, se han desarrollado varios ejemplos típicos para el 
análisis de formas estructurales comunes (vigas continuas. marcos, armaduras, etc.) permitiendo al 
asistente practicar el uso de los comandos básicos tratados en los capítulos anteriores así como de 
algunos otros que no se han descrito o mencionado en este instructivo, por lo que seria conveniente 
que el lector interesado tuviera la oportunidad de asistir a alguno de esos cursos con objeto de 
despejar algunas dudas, desarrollar una mejor habilidad en el manejo del programa y adquirir una 
mejor comprensión de algunas de las opciones de Análisis así como de sus ventajas y limitaciones 

A continuación se presentan los listados (datos. resultados numéricos y gráficas) de algunos 
de los ejemplos que se han desarrollado durante los cursos que ha impartido el autor, los datos y 
resultados de otros mas (incluyendo los que se listan a continuación) se encuentran en el disco que 
acompaña al presente instructivo, se sugiere que el interesado los consulte ya sea directamente 
(mediante algún editor) o procese los archivos de datos a través del programa SAP2000 
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; file C:\Mis documentos\curso sap 2000\ejemplo1.s2k saved 3/12/00 20:38:00 in Ton-m 
SYSTEM 

DOF•UX,UZ,RY LENGTH-m FORCE•Ton PAGE•SECTIONS 
JOINT 

1 x-o 
2 X•6 
3 X•11 

x-17 
s x-4 

RESTAAINT 

Y•O 
Y•O 

Y•O 
Y•O 

Y•O 

z-o 
z-o 
z-o 
z-o 

z-o 

ADD-1 
ADD-2 
ADD-3 
ADD-4 

DOF•Ul,U2,U3,Rl,R2,R3 
DOF•U3 
DOF•U3 
DOF•U3 

PATTERN 
NAHE•DEFJWLT 

MATERIAL 
NAME•STEEL IDES•S ~.798142 w-7.833413 

T•O E•2.038902E+07 U•.3 A•.0000117 
NAME•CONC IDES•C ~.2448012 ~2.402616 

r-o E•2531051 u-.2 A-.ooooo99 
NAHE-OTHER IDES•N ~.2448012 Woo2.402616 

r-o E-2531051 u-.2 A-.ooooo99 
NAHE•W\T2 IDES-N M-. 7981 Wo-7. 8334 

r-o E•220oooo u-.25 A-.oo00117 
rn.AME SECTION 

NAME•FSE:Cl MAT•STEEL SH•R T•.S, .3 A•.lS J•2.817371E-03 !•.003125, .001125 AS•.125, .125 
NAME-FSl MAT,.MAT2 SH .. R T..-.5,.25 A ... 12? Jal.78El127E-03 1•2.604161E-03,6.510417E-04 AS•.1041667,.1041667 
NN1l::.OFS2 MAT=MAT2 SH .. R ¡.,.. 5, , 5 A•, 25 J•8, 802084E-03 1•5. 208333E.-03, 5. 208333E-03 AS•. 2083333, , 2083333 

fRAHE 
2 
3 
4 
5 

J•2,3 
J .. 3, 4 
J-1, 5 
J-5,2 

LOAD 
NAME•LOAD1 

SEC.,FSl 
SEC .. FSl 
SEC•FS1 
SEC•FS2 

TYPE•FORCE. 

NSEG-4 
NSEG--<4 
NSEG--<4 
NSEG-4 

ADD-=5 uz..--s 
TYPE•CONCENTRATED SPAN 

ADOa4 RD-.5 uz--s 
ADD-3 RD-.25 uz--a 

TYPE•DISTRIBUTED. SPAN·' 
ADD-2 RD-0,1 UZ•-3,-3 
ADD-3 RD-0,1 UZ•-3,-3 

OUTPUT 
; No OUtput Requested 
END 

ANG•O 
AAG-0 
ANG-0 
ANG-0 

The following data is not required for analys1s. It is written here as a bad:up. 
This data will be used for graphlcs and design if thls file lS lmported. 
lf changes are made te the analysis data above, then the follow1ng data 
should be checked for cons1~tency. 
Any errors 1n lmporting the following data are ~gnored without warnlng. 

SAP2000 V6 .10 SUPPLEME.NTAL DATA 
GRID GLOBAL X "1" O 
GRID GLOBAL X "2" 1 
GRID GLOBAL X "J" 2 
GRID GLOBAL X "4" 3 
GRID GLOBAL X "5" 4 
GRID GLOBAL X "6" 5 
GRID GLOBAL X "7" 6 
GRID GLOBAL X "8" 7 
GRID GLOBAL X "9" B 
GRIO GLOBAL X "lO" 9 
GRID GLOBAL X "11" lO 
GRID GLOBAL X "12" 11 
GRIO GLOBAL X "13" 12 
GRID GLOBAL X "14" 13 
GRID GLOBAL X "15" 14 
GRID GLOBAL X "16" 15 
GRID GLOBAL X "17" lE 
GRID GLOBAL X "18" 17 
GRID GLOBA~ Y "19" O 
GRID GLOBAL Z "20" O 
GRID GLOBAL Z "21" 1 
GRIO GLOBAL Z "22" 2 
GRIO GLOBAL Z "23" 3 
GRID GLOBAL Z "24" 
~TERIAL STEEL FY 25310.5 
~TERIAL CONC FYREBAR 42184.16 FYSHEAR 28122.78 FC 2812.278 FCSHEAR 2812.278 
FRAMESECTION FSl NAME REC25X50 
FRAMESECTION rs2 NAME RECSOX50 
STATICLOAD LOAOl TYPE DEAD 

END SUPPLEMENTAL DATA 

'~ ·.-
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1 File C:\Hh doc:umentoa\c:urso up :ZOOO\ej-plol.S2k uved 3/12/00 20138:00 tn Ton-~n 

SYSTEM 
DOF•UX,UZ,RY LENGTH•m FORCE-Ton P~GE•StCTlONS 

JOINT 
1 x-o 
2 X•6 
3 X•ll 
4 X•l7 
5 X•4 

RE:.STRAINT 

,_, ,_, ,_, ,_, ,_, 

z-o 
z-o 
z-o 
z-o 

z-o 
AO[loool DOF•Ul,U2,UJ,Rl,R2,RJ 
AO[looo2 oor-u3 
AO[loooJ oor-uJ 
ADD-4 oor-u3 

PATTERN 
NAMt•DtfAUL T 

MATERIAL 
NAME•STI:r.L IOtS•S H-.798142 W•7,833413 

r-o t-2.0JB902t+07 u-.3 ~-.oooot17 
NAME•CONC IOtS•C H-. 2448012 W•2, 402616 

T•O E•2531051 U•.2 ~·.0000099 
NAHt•OTHtR IOES•N H-.2448012 w-2.402616 

T•O t•2531051 u-.2 ~-.0000099 
NAHE-MAT2 IOES•N M-. 791Jl Ww7, 8334 

r-o t-22ooooo u-.25 A-.oooo111 
f'R1IHt SECTION 

NAMt•f'SECl MII.T•STttL SH•R T•. S, . 3 A•. 15 J•2. 817J71t•03 l•. 003125 •. 001125 AS ... 115, .125 
N.IJ'It•FSl MAT•MAT2 SH•R !•,5,.25 /1.•,125 J•l,78Bl27E•OJ 1•2.604l67t·03,6.5I04!n•04 .a.5•.104l667,.1041667 
NAME•f'S2 HAT•MAT2 SH•R T•.5,.5 A-.25 J•8.802064E·OJ 1•5.20BJJJt-OJ,5.20BJ33t-OJ AS ... 2063333,.2083333 

F!W1E 
2 J-2. 3 
3 J-3, 4 
4 J•l, 5 
5 J•S, 2 

LOAD 
NAME•LOAOl 

SEC•f'Sl 
StC•FSl 
SEC•f'Sl 
stc-rsz 

TYPE•f'ORCE 

NSEG-4 
NSEG-4 
NSEG-4 
NSEG-4 

ADD-5 uz;--s 
TYPE•CONCENTRATED SPAN 

ADD-4 RD-.5 uz;--5 
.A.Do-3 RD-.25 uz;--a 

TYPE•D!STRI8UTED SPAN 
ADD-2 RD-0,1 uz;--3, •3 
.a.D[looo3 RD-0, l UZ•-3, -3 

OUTPUT 
¡ No Olltput Requested 
EN!) 

The followin9 data i:~ not re<:¡uired for analy.sis. It h written here as a b«c:kup. 
; Thill dat.!l will be uaed !or 9raphica and desiqn if this !Ue ia imported. 
; If chenqes are 10.ade to the analysis data above, then the !ollowinq data 
; .should be checked !or con:~istency. 
; Any errors in irnporting the !oilowlnc¡ d.!ltll t~re iqnored without warninq. 
SAP2000 V6.10 SUPPLtHtNTAL DATA 

GRID GLOBAL X ~1 ~ O 
GRID GLOBAL X ~ 1 
GRID GLOBAL X ~3~ 2 
GRID GLOBAL X ~4• 3 
GRID GLOBAL X •s~ 4 
GRID GLOBAL X "6~ S 
GRIO GLOBAL X "7" 6 
GRIO GLOBAL X •e~ 7 
GRID GLOBAL X •g• B 
GRID GLOBAL X "10" 9 
GRIO GLOBAL X "ll" 10 
GRID GLOBAL X ~12" 11 
GRID GLOBAL X "13" 12 
GRID GLOBAL X "14" 13 
GRID GLOBAL X ~15" 14 
GRID GLOBAL X "16" 15 
GRID GLOBAL X ~17" 16 
GRIO GLOBAL X •te• 17 
GRIO GLOBAL Y "19" O 
GRID GLOBAL z; "20" O 
GRID GLOBAL z; "21" 1 
GRIO GLOBAL Z "22" 2 
GRIO GLOBAL Z "23" 3 
GRIO GLOBAL Z "24" 
MATERIAL STEtl.. rY 25310, 5 
MATERIAL CONC f'YREBAR 42184.18 f'YSHEAR 28122.78 FC 2812.278 rcSHEAR 2812.278 
rRAHtstCTION FSl NAKE REC25X50 
f'RAME:SECTION rs2 NAMt RECSOX50 
STATICLOAD LOADl TYPE DEAO 

END SUPPLEHENTAL ~TA 

91 



SAP2000 

¡ 
i 
1 

1 

¡ __ 
! 

-z 
ISl 
ISl 

! ___,-----·¡ 
! --~ 1 Có7·¡ (S)_n ____ ~~ -- -- :::;, (S) . ' . ' . l ! 1 i CJ;¡ 

SAP2000 v... - File:ejemplo2 - Frame Span Loads (VERTICAL)- Ton-m Units 

Marzo 18,2000 8:22 

T 

1 
-----· 1-, 

' 
- ----~·····- ----- -- .. 

========~====~;--



SAP200~0======================= /~~' 

z 

SAP2000 v6.10- Shape - Ton-m Units 

Marzo 



SAP2000 

. . . '(] M 

1 
-

1 
-

1 

SAP2000 ~· ':'':: File:ejemplo2 • Restraint Reactions (VERTICAL)- Ton-m U. 

Lf] 
N . 
M 

Marzo 8:58 

. 

1 



SAP2000 
~=========================== 

z 

Cú 
1 

. SAP2000 v6.10- File:ejemplo2- Shear Force 2-2 Diagram 

"" 1 

Marzo 

¡ 
1 1 

! 



SAP2000 Marzo 18,2000 8:55 

z 1\ 

\ • 1 
1 1 

i \ . . 

SAP2000 >~t". '- File:ejemplo2- Moment ~ Diagrem (VERTICAL)- Ton-m l 
==============~·~ 



EJemplo 2 
¡ rile C1~s documentos\curso sap 2000\ejemplo2.s2k seved 3/18/00 8:59:59 in Ton-m 
SYSTEM 

DOr•UX,UZ,RY LENGTH-m FORCE•Ton LINES•59 
JOINT 

5 x-o 
6 X•6 
7 X-11 
B X•l? 
9 x-21 

RESTAAINT 

Y•O 
Y•O 

Y•O 
Y•O 
Y•O 

z-o 
z-o 
z-o 
Z•O 
z-o 

ADD-5 oor-u1,u2,u3 
ADD-6 DOF•U3 
ADD-7 DOF•U3 
ADD-8 DOF•U3 
AD~9 OOF•U3 

PATTERN 
NAME•DEFAULT 

MATERIAL 
NAME•STEEL IDES•S H-.798142 w-7.833413 

r-o E•2.038902E+07 u-.3 A-.oooo111 
NAME•CONC IDES•C M-.2448012 ~2.402616 

r-o E-2531051 u-.2 A-.ooooo99 
NAME•OTHER IDES•N M-.2448012 w-2.402616 

T•O E•2531051 U•.2 A•.0000099 
NAME-MA.TD !Dt.S•C M-. 7981 w-7 .8334 

r-o E•t8ooooo u-.25 A-.ooo0111 
FRAME SECTION 

NAME•FS1 MAT•HATD SH•R T•.5, .25 A~.l25 J•1.788127E-03 I•2.604167E-03,6.510417E-04 AS•.1041667,.1041667 
FRAME 

3 J-5, 6 
4 J-6, 7 
5 J-7,8 
6 J•B, 9 

LOAD 

SEC•FS1 
SEC•FSl 
SEC•FSl 
SEC•FSl 

NSEG-4 
NSEG-4 
NSEG-4 
NSEG-4 

NAME•VERTICAL 
TYPE•CONCENTRATED SPAN 

ADD-3 RD=.75 uz--5 

!'.NG-0 
!'.NG-0 
!'.NG-0 
!'.NG-0 

TYPE•DISTRIBUTED SPAN 
ADD-3 RD-0,.5 uz--2,-5 
ADD-4 RD-0,1 UZ•-2,-5 
ADD-5 RD-0,.5 UZ•0,-3 
ADD-5 RD=.5,1 UZ•-3,0 
AOD-6 RD-0, .5 UZ•-2,-5 
ADD-6 RD-.5,1 UZ•-5,-2 

OUTPUT 
: No Output Requested 
END 

The follow1ng data is not required for analys1s. It is written here as a backup. 
Thls data will be used for qraph1cs and design if this file is 1mported. 
If changas are made to the analysis data above, then the following data 
should be checked for consist~ncy. 
Any errors 1n 1mporting the follow1ng data are ignored without warning. 

SAP2000 V6.10 SUPPLEMENTAL DATA 
GRID GLOBAL X •¡~ O 
GRID GLOBAL X wz• 6 
GRID GLOBAL X •3• 11 
GRID GLOBAL X •4• 17 
GRID GLOBAL X •s• 21 
GRID GLOBAL Y ~6• O 
GRID GLOBAL Z •7w 0 
GRIO GLOBAL Z •a• 1 
GRID GLOBAL Z "9• 2 
GRIO GLOBAL Z •10" 3 
GRIO GLOBAL Z w11• 
~TERIAL STEEL FY 25310.S 
~TERIAL CONC FYREBAR 42184.18 FYSHEAR 28122.78 FC 2812.278 FCSHEAR 2812.278 
MATERIAL MATO FYRt.BAR 60 FYSHEAR 40 FC 4 FCSHE.AR 4 
FRAMESECTION FS1 NAHE REC25X50 
CONCRETESECTION REC25X50 BEAM COVERTOP .OS COVERBOTTOM .OS 
STATICLOAD VERTICAL TYPE OEAD 

END SUPPLEMENTAL DATA 
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; File C:\~s documentos\curso sap 2000\eJemplo3.s2k saved 3/18/00 9:28:09 in Ton-m 

SYSTEM 
DOF•UX,UZ,RY LENGTH=m FORCE•Ton LINES•59 

JOINT 
1 X•O Y•O Z•2 
2 x-o Y•O z-s 
3 X•4 Y•O Z•S 
4 X•B Y•O z-o 

RESTAAINT 
ADD~1 DOF-Ul,U2,U3,Rl,R2,R3 
ADD•4 DOF•Ul,U2,U3 

PATTERN 
NAME•DEFAULT 

MATERIAL 
NAME•STEEL IDES•S M•.798142 W•7.833413 

T•O E•2.03B902E+07 U•.3 A•.0000117 
NAME•CONC IDES•C M•.244B012 W•2.402616 

T•O E•2531051 U•.2 A•.0000099 
NAME•MA.T1 IDES•N M•.2448 W•2.4026 

T•O E•1000000 U•.2 A•.0000099 

FRAME SECTION 
NAME•FSl MAT•MATl SH•R T•.S, .25 A•.125 J•l.788127E-03 I•2.604167E-03,6.510417E-04 AS•.l041667, .1041667 

FRJ\ME 
l J•l' 2 
2 J .. 2' 3 
3 J•3,4 

LOAD 
NAME•UNICA 

SEC•FSl 
SEC•FSl 
SEC•FSl 

NSEG•2 
NSEG•4 
NSEG•2 

TYPE•DISTRIBUTED SPAN 
ADD-2 RD•O,l UZm-2,-2 
ADD•3 RD•O,l U2•-3,-3 

OUTPUT 

ANG•O 
ANG•O 
ANG•O 

ELEM•JOINT TYPEgDISP LOAD•UNICA 
ELEM•JOINT TYPE•APPL LOAD•UNICA 
ELEM•FRAME TYPE•FORCE LOAD•UNICA 
ELEM•FRAME TYPE•JOINTF LOAD•UNICA 

END 

The following data ~s not required for analys~s. It is written here as a backup. 
Th~s data will be used for graphlcs and des~;n lf thls file is lmported. 
If changes are made to the analys~s data above, then the follow~ng data 
should be checked for cons~stency. 
Any errors ln lmportlng the followlng data are lgnored without warn~ng. 

SAP2000 V6.10 SUPPLEMENTAL DATA 
GRID GLOBAL X ~¡~ O 
GRID GLOBAL X ft2~ 4 
GRID GLOBAL X ftJ~ 8 
GRID GLOBAL Y "4ft 0 
GRID GLOBAL Z "5" 0 
GRID GLOBAL Z ft6" 2 
GRID GLOBAL Z ~7" 5 
MATERIAL STEEL FY 25310.5 
MATERIAL CONC FYREBAR 42184.18 FYSHEAR 2812¡,78 FC 2812.278 FCSHEAR 2812.278 
FRAMESECTION FSl NAME REC25X50 
STATICLOAD UNICA TYPE OTHER 

END SUPPLEMENTAL DATA 
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--
SAP2000 v6.10 File: EJEMPL03 Ton-m Units PAGE 1 
Marzo lB, 2000 9:30 

S T 1< T I e L O 1< D e " S E S 

STATIC Cl<SE SELF WT 
Cl<SE TYPE FACTOR 

UNICI< OTHER 0,0000 

SA.P2000 v6.10 File: EJEMPL03 Ton-m Units PAGE 2 
Marzo 18, 2000 9:30 

MI< T E R I 1< L p R O P E R T Y O A T A 

MAT MODULUS OF POISSON'S THERMAL WEIGHT PER 
LABEL ELABTICITY RATIO COEFF UNIT VOL 

S TE EL 203B9020 0.300 l.l70E-05 7.B33 
CONC 253l05l 0.200 9. 900E-06 2.403 
MATl lOOOOOO,OOO 0.200 9.900E-06 2. 403 

SAP2000 v6.10 File: EJEMPL03 Ton-m Units PJ\GE 3 
Marzo lB, 2000 9:30 

Ml<T E R I AL D E S I G N O ATA 

MAT DESIGN STEEL CONCRETE RE !!AA 
LABEL CODE FY re FY 

STEEL S 253l0.500 
eONe e 2Bl2.27B 42l84.lBO 
MATl N 

SAP2000 v6.10 File: EJEMPL03 Ton-m Uni.ts PJ\GE 4 
~rzo 18, 2000 9:30 

F RAM E S E C T I O N P R O P E R T y O A T " 

MASS PER 
UNIT VOL 

0.79B 
0.245 
o. 245 

CONCRETE 
FCS 

2Bl2.27B 

RE !!AA 
FYS 

2Bl22.779 

SECTION MAT SECTION DEPTH FLANGE FLANGE 
LABEL LABEL TYPE WIDTH THieK 

REe2SX50 MATl 0.500 

SAP2000 v6.10 File: EJEMPL03 Ton-m Uni ts PAGE 5 
Marzo lB, 2000 9:30 

F R 1< M E S E C T I O N p R o P E R T y DATA 

SECTION AAEI< TORSIONAL MOMENTS OF INERTIA 
LABEL INERTIA I 33 I22 

REe25X50 O.l25 l.7BBE-03 2.604E-03 6.5l0E-04 

SA.P2000 v6.10 F~le: EJEMPL03 Ton-m Un~ts PAGE 6 
Marzo lB, 2000 9:30 

F RAM E 

SECTION 
LABEL 

S E e T I O N PROPERTY D A T A 

SECTION MODULII 
S33 522 

PLASTie MODULII 
Z33 Z22 

REC25X50 l.042E-02 5.20BE-03 l.563E-02 7.Bl3E-03 

SAP2000 v6.10 File: EJEMPL03 Ton-m Units PAGE 7 
Marzo 18, 2000 9:30 

F RAM E 

SECTION 
LABEL 

REC25X50 

S E e T I O N 

TOTAL 
WEIGHT 

4.025 

P R O P E R T Y 

TOTAL 
MASS 

0.4l0 

D A T A 

SAP2000 v6.10 F~le: EJEMPL03 Ton-m Units PAGE 8 
Marzo 18, 2000 9:30 

TOP TOP 
0.250 0.000 

SHEAR AREAS 
1<2 1<3 

O.l04 O.l04 

RADII OF GYRATION 
R33 R22 

O.l44 7.2l7E-02 

WEB FLANGE FLANGE 
THICK WIDTH THICK 

BOTTOM BQTTOM 
0.000 o.ooo 0.000 -.. 
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SAP2000 v6.10 File: 
Marzo 18, 2000 9:30 

S H E L L S E C T 

SECTION TOTAL 
LABEL WEIGHT 

SSECl 0.000 

SAP2000 v6.10 File: 
Marzo 18, 

F RAM E 

2 
3 

2000 9:30 

S P A N 

TYPE 

FORCE 
FORCE 

EJEMPL03 Ton-m Units PAGE 9 

I O N p R OPERTY DATA 

TOTAL 
MASS 

0.000 

EJEMPL03 Ton-m Units PAGE 10 

O I S T R I 8 U T E O LO A O S Load case UNICA 

OIRECTION OISTANCE-A VALUE-A OISTANCE-B VALUE-8 

GLOBAL-Z 
LOCAL-2 

0.0000 
0.0000 

-2.0000 
-3.0000 

l. 0000 
l. 0000 

-2.0000 
-3.0000 

~ 

lOA 



SAP2000 v6.10 F~le: EJEMPL03 Ton-m Units PAGE 1 
Marzo lB, 2000 9:2B 

~ 
J O I N T O I S p L A e E M E N T S 

JOINT LOAD ux UY uz RX RY RZ 

l UNICA 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 

2 UNICA -0.0175 0.0000 -1.817E-04 0.0000 -3.490E-03 0.0000 

3 UNieA -0.0179 0.0000 -0.0149 o.oooo 7.018E-03 0.0000 

4 UNieA 0.0000 o.oooo 0.0000 0.0000 -0.0153 0.0000 

SAP2000 v6.10 File: EJEMI'L03 Ton-m Units PAGE 2 
Marzo lB, 2000 9:2B 

J O I N T R E A e T 1 O N S 

JOINT LOAD Fl F2 F3 Ml H2 H3 

l UNICA 13 .llBO 0.0000 7.5697 0.0000 22.7067 0.0000 

4 UNICA l. BB20 0.0000 12.4303 0.0000 0.0000 0.0000 

SAP2000 v6.10 File: EJEMPL03 Ton-m Units PAGE 3 
Marzo 18, 2000 9:2B 

F RAM E E L E M E N T F O R e E S 

FRAHE LOAD LOC p V2 V3 T H2 H3 

l UNICA 
0.00 -7.57 -13.12 o.oo 0.00 0.00 -22.71 
l. 50 -7.57 -13.12 0.00 0.00 o.oo -3.03 
3.00 -7.57 -13.12 0.00 0.00 0.00 16.65 

2 UNICA 
0.00 -13.12 -7.57 0.00 0.00 .0.00 -16.65 
1.00 -13.12 -5.57 0.00 0.00 0.00 -lO.OB 
2.00 -13.12 -3.57 0.00 0.00 0.00 -5.51 
3.00 -13.12 -l. 57 0.00 0.00 0.00 -2.94 
4.00 -13.12 4. 303E-Ol 0.00 0.00 0.00 -2.37 

3 UNICA 
o.oo -B.53 -9.97 0.00 0.00 0.00 -2.37 
3.20 -B.53 -3. 699E-01 0.00 0.00 0.00 14.19 
6.40 -B.53 9.23 0.00 0.00 0.00 0.00 

109 



;:).IU'It.UUU Marzo 1tl,:.!UUU 11:31 

X 

SAP2000 v6 .. _ - File:ejemplo4- Frame Span Loads (UNICA) -Ton-m Units 
==============~~ 



SAP2000 ,,,,;;=, ============= Marzo 18,2000 11:34 

z 

X 

SAP2000 v6.10- File:ejemplo4- Deformad Shape (UNICA)- Ton-m Units 



SAP2000 11:38 

r 
l"- 1 L __ _j i 

1 ~~.:n 
1 1 
1 - .~ 

! ~ 

i : -7. 58 
1 
1 

1 

1 

-¿~ L1 . ' 
(! 
< • 
·-- i 
1 ¡ 
1 (Y) 

1 
!:'-... i . 

1 -
1 

- í º . Ü'.. 

-7 ·vta 1 
!0 1 

1 

1 L 

·SAP2000 • File:ejemplo4 • Axial Force Diagram (UNICA) ·Ton-m 



SAP200~0===================== 

N 
"<r 

N 
1 

. S 1 

)!-, '-1 .. 

1 

! 

Force 2-2 Diagram (UNICA)- Ton-m Units 

: . ¡ 

Marzo 



SAP2000 

N 
1 

-21.7.3 --------:7 
- ---~ 

Marzo1 

" cd 
-! 

"'' ___ .! 

' 
• 1 -17.86 

~--~-~~.--~-,--/~~~ ~--~-.~ 

~= 

11:44 



8AP2000 Marzo 18,2006 11 :4i' 

-
CSJ 

SAP2000 v6.10- File:ejemplo4- Restraint Readions (UNICA)- Ton-m Units 



¡ fU• C: \Hh doc¡a,•ntoa\curlo np 2000\•j.mplo4 .a21c uv.cl 3/19/00 11:57:20 J.n Ton-110 

SYSTEM 
OOF•UX, UZ, riY 

JOINT 
1 X·-10 Y•O 
3 X•-10 Y•O 
4 x-o y .. o 
5o x-o Y•O 
6 x-o Y-o 
7 x--10 Y•O 
9 X•lO Y•O 

Rf:STRAINT 

t.tNGTH.., 

Z•O 
Z•8 

Z•O 
Z•4 
Z•8 

Z•O z-• 

ADD-1 OOF•Ul,U2,UJ 

FORCE• Ton 

AOD-4 OOF•Ul,U2,UJ,Rl,R2,RJ 
AD!>-7 OOF•Ul,U2,UJ,Rl,R2,RJ 

PATTERN 
NAME•DEFAULT 

MATERIAL 

t.lNtS•59 

NAHE-STEEL IDES•S Moo. 799142 W•7. 833413 
T•O E•2.038902E•07 U•.J A•.0000117 

NAME•CONC IDES•C ~.2448012 W•.2.402616 
T•O E•2531051 U•.2 A•.0000099 

NAME:.,OTRO !DES .. N M ... 2448 ~2.4026 
T•O E•lOOOOOO U•.2 A ... 0000099 

FRAMt SECTION 
NAME•FSl MA.T...OTRO SH•R j ... 5, .25 A•.125 J•l. 799127E-03 1•2. 604l67E-OJ, 6. 5104l7E-04 A$•.1041667, .1041667 

F1W1E 
l J•l, 3 SEC .. FSl NSEG-2 
3 J•4, S SEC .. FSl NSEG-2 

• J•S, 6 SEC•FSl NSEG-2 

' J•i,8 sr.c .. rst NSEG-2 

' J•J, 6 SEC•FSl NSEG-4 
9 J .. S,B SEC•FSl NSEG-4 

LOAD 
NAME-UNICA 

TYPE•FORCE 
ADJ>oJ UX•lO 

TYPE•DISTRIBUTED SPAN 
ADD-8 ~0.1 uz .. -1, -1 
ADD-9 RD-0,1 UZ•-1, -1 

"'"'"' ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 

OIJTPUT 
ELEH-JOlNT 
ELEH-JOINT 
ELEM•FRAME 
ELEM-FAAME 

TYPE•D!SP LOAD-UNlCA 
TYPE•APPL LOAD-UNICA 
TYPE•FORCE LOAt-UNlCA 
TYPE•JOINTF LOAD-UNICA 

"'' 
1 Tl'l• lollowing d.11ta 1~ not r•quir•d !or analys1s. It is written h•r• aa a backup. 
1 Th1s dat.11 will be used for qraphics and design if thi~ file 1~ imported. 

I! changes ~:~re mad~ to ~he .e~naly~l.!l d~:~ta above, then the follO\ollnq data 
1 should be checked !or conslatency. 
1 Any error:~ in importinq the !ollow1nq data are ic¡nored without w~:~r-n1ng. 
SAP2000 V6.10 SUPPLEMENTAL DATA 

GRID GLOBAL X -¡· -lO 
GRID GLOBAL X •2• O 
GRID GLOBAL X •J• lO 
GRIO GLOBAL Y "'4~ O 
GRIO GLOBAL Z •s~ O 
GRIO GLOBAL Z •5• 4 
GRID GLOBAL Z •¡• 8 
MATERlPJ. STEEL rY 25310.5 
MATERIAL CONC fYRE:BAR 42184.18 rYSHtAR 26122.78 FC 2612.276 FCSHEAR 2812.276 
FRAMI:StCTlON rSl NA.Mt RtC2SX50 
STATICLOAD UNICA TYPL OTHER 

tND SUPPLEMENTAL DATA 

' ' ' 



SAP2000 v6.10 F~le: EJEMPL04 
Marzo 18, 2000 11:58 

Ton-m. Units 

S T A T I e L O A D C A S E S 

STATIC CASE SELF WT 
CASE TYPE FACTOR 

UNICA. OTHER 0.0000 

PAGE 1 

SAP2000 v6.10 File: EJEMPL04 Ton-m. Un~ts PAGE 2 
Marzo 18, 2000 11:58 

MA T E R I A L p R OPERTY DATA 

MAT MODULUS OF POISSON'S THERMAL WEIGHT PER 
LABEL ELASTICITY RATIO COEFF UNIT VOL 

STEEL 20389020 0.300 1.170E-05 7.833 
CONC 2531051 0.200 9.900E-06 2.403 
OTRO 1000000.000 0.200 9.900E-06 2.403 

SAP2000 v6.10 File: EJEMPL04 Ton-m. Units PAGE 3 
Marzo 18, 2000 11:58 

MA T E R I AL D E S I G N DATA 

MAT DESIGN STEEL CONCRETE RE BAR 
LABEL CODE FY re FY 

STEEL S 25310.500 
CONC e 2812.278 42184.180 
OTRO N 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE 4 
Marzo 18, 2000 11:58 

F R A M E S E e T I O N P R O P E R T y O A T A 

MP.SS PER 
UNIT VOL 

0.798 
0.245 
0.245 

CONCRETE 
FCS 

2812.278 

RE BAR 
FYS 

28122.779 

SECTION MAT SECTION DEPTH FLANGE FLANGE 
LAS EL LABEL TYPE WIDTH THICK 

REe2SXSO OTRO 0.500 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE S 
Marzo 18, 2000 11: 58 

r RAM E S E e T I O N p R O P E R T y D A T A 

SECTION AREA TORSIONAL MOMENTS or INERTIA 
LABEL INERTIA I33 I22 

REC25X50 0.125 1.788E-03 2.604E-03 6.510E-04 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE 6 
Marzo 18, 2000 11:58 

F RAM E 

SECTION 
LABEL 

SECTION P R O P E R T Y D A T A 

SECTION MODULII PLASTIC MODULII 
S33 S22 Z33 Z22 

REe25XSO 1.042E-02 5.208E-03 1.563E-02 7.813E-03 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE 7 
Marzo 18, 2000 11:58 

F RAM E 

SECTION 
LAS EL 

REC25XSO 

S E C T I O N 

TOTAL 
WEIGHT 

12.013 

P R O P E R T Y D A T A 

TOTAL 
MASS 

1.224 

TOP TOP 
0.250 0.000 

SHEAR AREAS 
A2 AJ 

o .104 0.104 

RADII OF GYRATION 
R33 R22 

0.144 7.217E-02 

WEB FLANGE FLANGE 
THieK WIDTH THICK 

BOTTOM BOTTOM 
0.000 0.000 0.000 
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SECTION 
LABEL 

SSEC1 

M>.T 
LABEL 

CONC 

SHELL MEMBRANE BENDING MATERIAL 
TYPE THICK THICK ANGLE 

1 l. 000 1.000 0.000 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE 9 
Marzo 18, 2000 11:58 

S H E L L 

SECTION 
LABEL 

SSEC1 

SECTION 

TOTAL 
WEIGHT 

0.000 

PROPERTY 

TOTAL 
M>.SS 

o.ooo 

O ATA 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE 10 
Marzo 18, 2000 11:58 

J O I N T F O R C E S Load Case UNICA 

JOINT GLOSA.L-X GLOBAL-Y GLOBAL-Z GLOBAL-XX GLOBAL-Y'! 

3 10.000 o.ooo 0.000 

SAP2000 v6.10 File: EJEMPL04 Ton-m Units PAGE 11 
Marzo 18, 2000 11:58 

0.000 o.ooo 

GLOBAL-ZZ 

0.000 

F RAM E S P A N O I S T R I B U T E O L O A D S Load Case UNICA 

B 
9 

TYPE 

FORCE 
FORCE 

DIRECTION OISTANCE-A 

GLOB.A.L-Z 
GLOB.A.L-Z 

0.0000 
0.0000 

VALUE-A DISTANCE-B 

-l. 0000 
-l. 0000 

l. 0000 
l. 0000 

VALUE-B 

-l. 0000 
-l. 0000 
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; File C:\Mi:s documento:s\curso sap 2000\ejemplo5.:s2k saved '3/18/00 13:43:48 ln Ton-m 

SYSTEM 
DOF•UX,UZ,RY LENGTH•m FORCE•Ton LINES•59 

JOINT 
1 x-o Y•O z-e 
2 x-5 Y•O Z-11 
3 X•10 Y•O z-e 
4 X•l4 Y•O z-e 
5 X•10 Y•O z-o 
6 X•10 Y•O Z•4 
7 X•l4 Y•O Z•4 

RESTRAINT 
ADD-1 DOF•U1,U2,U3 
ADD-5 DOF•U1,U2,U3,R1,R2,R3 

PATTERN 
NAME•CEFAULT 

MATERIAL 
NAME•STEEL ICES•S M•.798142 w-7,833413 

T•O E•2.038902E~07 U•.3 A•.0000117 
NAME•CONC IDES•C ~.2448012 w-2.402616 

T•O E•2531051 U•.2 A•.0000099 
NAME•OTRO !CESaN Mc.2448 w-2.4026 

r-o E-1oooooo u-.2 A-.ooooogg 

mAME SECTION 
NAME•FS1 MAT•OTRO SH•R T•.3, .3 A•.09 
NAME•FS2 MAT•OTRO SH•R T•.5, .3 A•.15 

mAME 
1 J•l, 2 SEC•FS2 NSEG-2 
2 J-2,3 SECoofS2 NSEG•2 
J J-3, 4 SECafS2 NSEG-4 
4 J-5,6 SEC•fSl NSEG-2 
5 J-6, 7 SEC•FS2 NSEG-4 
6 J-6,3 SEC•FSl NSEG-2 

LOI\D 
NAME•UNICA 

TYPE•FORCE 
AD~2 ux-s 
ADD-4 uz--10 

TYPE•DISTRIBUTED SPAN 
ADD-1 Ro-0,1 uz--3,-3 
ADD-5 RD-0,1 uz--2,-2 

OUTPUT 

ANG-0 
ANG-0 
N.JG•O 
AAG-0 
AAG-0 
AAG-0 

ELEM-JOINT TYPE•DISP LOAD-UNICA 
ELEM-JOINT TYPE•APPL LOAD-UNICA 
ELEH-FRAME TYPE•FORCE LOAI:-UNICA 
ELEM-FRAME TYPE•JOINTF LOAD-UNICA 

END 

J•l.l4075E-03 I•6.750001E-04,6,750001E-04 AS•7.500001E-02,7.500001E-02 
J•2. 817371E-03 1•,003125,, 001125 AS•.125, .125 

The following data 1:s not required for analysis. It is wr1tten here as a backup. 
This data will be used for graphics and design if this file is importad. 

1 If changes are made to the analysis data above, then the following data 
should be checked for consistency. 
Any errors in importing the following data are ignorad without warning. 

SAP2000 V6.10 SUPPLEMENTAL DATA 
GRID GLOBAL X "1" O 
GRIO GLOBAL X "2" 5 
GRID GLOBAL X "3" 10 
GRID GLOBAL X "4" 14 
GRIO GLOBAL Y "5" O 
GRID GLOBAL Z "6" O 
GRID GLOBAL Z "7" 4 
GRID GLOBAL Z •a• 8 
GRID GLOBAL Z •g• 11 
~!ERIAL STEEL FY 25310.5 
MATERIAL CONC FYREBAR 42184.18 FYSHEAR 28122.78 FC 2812.278 FCSHEAR 2812.278 
FRAMESECTJON FSl NAME COL30X30 
FRAMESECTION fS2 NAME REC30X50 
STATICLOAD UNJCA TYPE OTHER 

END SUPPLEHENTA~ DATA 
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SAP2000 

Structural Analy~is Programs 

Version 6.10 

Copyright CCJ 1978-1997 
COMPUTERS ANO STRUCTURES, INC. 

All n.qhts reservad 

This copy of SAP2000 is for the exclusive use of 

THE LICENSEE 

Unauthorized use ~s in v~olation of Federal copyright laws 

lt is the responsibility of the user to verify all 
results produced by this program 

18 ~r 2000 13:19:35 

C S 1 1 S A P 2 O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 1 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\eJemplo5.EKO 

SYSTEM DATA 

STEADY STATE LOAD FREQUENCY 

LENGTH UNITS -
FORCE UNITS 

UP DIRECTION -

GLOBAL DEGREES OF FREEDOM 

PAGINATION BY - - - - -
NUMBER OF LINES PER PAGE 
INCLUDE WARNING MESSAGES IN OUTPUT FILE 

O.OOOOE+OO 

M 
TON 

•Z 

UJ( 

uz 
RY 

LINES 
59 

y 

e s 1 S A P 2 O O G FIN:TE: ELEMENT ANALYSIS OF STRUCTURES PAGE 
PROGRAM:SAP2000/FILE:\M~sdocumentos\cursosap2000\ejemploS.EKO 

G E N E R A T E D J O 1 N T e O O R D I N A T E S 

JOINT 
1 
2 
3 
4 
5 
6 
7 

X 
o.ooo 
5.000 

10.000 
14. 000 
10.000 
10.000 
14. 000 

y z 
0.000 8.ooo 
0.000 11.000 
0.000 8.000 
0.000 e.ooo 
0.000 0.000 
0.000 4.000 
0.000 4.000 

e S I 1 S A P 2 O 0 O FINITE ELEMENT .ANALYSIS OF STRUeTURES PAGE 3 

P A T T E R N S 

PATTERN JOINT 
DEFAULT 

e S I 1 S A P 2 

R E S T R A I N T 

JOINT 
1 U! 
5 Ul 

e S I S A p 2 

M A T E R I A L 

PROGRAM:SAP2000/FILE:\Misdocurnentos\cursosap2000\ejemplo5.EKO 

VALUE 

O O O FINITE ELEMENT .ANALYSIS OF STRUeTURES PAGE 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\ejemplo5.EKO 

DATA 

U2 U3 
U2 U3 Rl R2 R3 

O O O FINITE ELEMENT ANALYSIS OF STRUeTURES PAGE 5 
PROG~~:SAP2000/FILE:\Mlsdocumentos\cursosap2000\ejemplo5.EKO 

PROPERTY DATA 
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MAT 
LABEL 

STEEL 
eONe 
OTRO 

NUMBER 
TEHPS 

WEIGHT PER 
UNIT VOL 

0.7833E+01 
O .2403E+Ol 
0.2403Et01 

MASS PER DES!GN 
UNIT VOL CODE 

0.7981E+OO S 
0.2448E+OO e 
0,244BE+00 N 

C S S A P 2 O O O fiNITE ELEMENT ANALYSIS OF STRUCTURES PAGE Ei 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\eJemplo5.EKO 

T E M P E R A T U R E D E P E N D E N T O A T A 

~TERIAL PROPERTIES 

MAT TEMP MODULUS OF ELASTICITY SHEAA MODULI I 
LABEL El E2 E3 Gl2 Gl3 G23 

STEEL 0.00 0.204E+08 0.204[+08 0.204E+08 0.784E+07 O. 784E+07 0.784E+07 

eONe o.oo 0.253E+07 0.253E+07 0.253E+07 0.105E+07 0.105E+07 0.105E•07 

OTRO o.oo O.l00E+07 O.lOOE+07 0.100E+07 0.417E+06 O. 417E+06 0.417E+06 

C S 1 S A P 2 O O O fiNITE ELEMENT ANAL'fSIS OF STRUCTURES PAGE 7 
PROGRAM:SAP2000/FILE:\Hisdocumentos\cursosap2000\ejemploS.EKO 

TEMPERATURE O E P E N D E N T O A T A 

THERMAL EXPANSION COEFFICIENTS 

MAT TEHP COEFFICIENTS OF THERMAL EXPANSION 
LABEL J\1 J\2 J\3 J\12 J\13 J\23 

STEEL 0.00 O.ll7E-04 O .117E-04 O .117E-04 O.OOOE+OO O. OOOE+ 00 O.OOOE+OO 

CON e 0.00 0.990E-05 O. 990E-05 0.990E-05 O.OOOE+OO Q.OOOE+OO O.OOOE+OO 

OTRO 0.00 O, 990E-05 O. 990E-OS 0.990E-05 O.OOOE•OO O.OOOE•OO O.OOOE•OO 

e s S A p 2 o o o fiNITE ELE!-'EN":' ANALYSIS OF STRUCTURES PAGE 8 
PROGRAM:SAP2000/FILE:\MJSdocume~tos\cursosap2000\ejemplo5.EKO 

TEMPERATURE DEPENDENT DATA 

MATERIAL PROPERTIES 

MAT TEHP POISSONS RATIO 
LABEL Ul2 Ul3 U23 IJ14 U24 UJ~ Uló U2ó UJS V4~ U16 U26 U36 U46 U 56 

STEEL o.oo o' 3 0,3 0,3 0,0 0,0 0,0 0,0 0,0 0,0 0,0 0,0 0,0 0.0 0.0 0,0 

CONC 0.00 0,2 0,2 0,2 o' o o' o 0,0 0,0 0,0 0,0 0,0 0,0 0,0 0,0 0,0 0,0 

OTRO o.oo 0,2 0,2 0,2 0,0 o' o 0,0 0,0 0,0 o' o o,o o,o o,o o,o 0,0 0,0 

C S 1 S A P 2 O O O FINITE ELEMENT ANALYSIS Of STRUCTURES PAGE 9 
PROGRAM:SAP2000/FILE:\M~sdocumentos\cursosap2000\ejemplo5.EKO 

MATERIAL PROPERTIES 

MAT 
LABEL 

CON e 

TEMP 

o.oo 

YIELD 
FY 

36.00 

CSI 1 SAP2000 FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 10 
PROGRAM:SAP2000/FILE:\Hisdocumentos\cursosap2000\ejemplo5.EKO 

F RAM E S E e r 1 O N P R O P E R T Y D A T A p R I S M A T I e 

SECT!ON SHAPE DEPTH FLANGE Fl..ANGE WEB FLANGE FLANGE 
LABEL TYPE WIDTH TH!CK TH!CK WIDTH THICK 

TOP TOP BOTTa-1 BOTTa-1 

FSl R 0.300 0.300 
FS2 R 0.500 0.300 

--
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,. eS! 1 S A P 2 O O O FINITE E:LEHENT ANALYSIS OF STRUCTURES PAGE 11 
PROGRAMISAP2000/FILE1\Misdocumentos\cursoaap2000\ejemplo5.EKO 

F RAM E S E e T I O N p R O P E R T y DATA - p RISHATIC 

SECTION AXIAL TORSIONAL Ma-1ENTS or UtERTIA. SHEAA MEAS 
LABEL AREA CONSTANT !33 122 A2 A3 

FS1 0.900E-01 O .114E-02 0.675E-03 0.675E-03 0.750E-Ol O. 750E-01 
FS2 0 .lSOE+OO 0.282E-02 O. 313E-02 O.llJE-02 0.125E+OO 0.125E+OO 

e s 1 S A P 2 O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 12 
PROGRAM:SAP2000/FILE:\Hisdocumentos\cursoaap2000\ejemplo5.EKO 

F RAM E S E C T I O N PROPER T y DA T A - P R I S M A T 1 C 

SECTION H!\T ADDITIONAL ADDI"!'IONAL 
lJ\EEL lJ\EEL ~S PER WEIGHT PEA 

LENGTH LENGTH 

FS1 OTRO O.OOOE+OO O.OOOE+OO 
FS2 OTRO O.OOOE+OO O.OOOE•OO 

e s 1 S A P 2 o o o FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 13 
PROGRAM:SAP2000/FILE:\Misdocumentoa\cursosap2000\ejemplo5.EKO 

f RAM E E L E M E N T DATA 

ELEMENT JOINT JOINT ELD1E:NT END-OFFSET-LENGTHS RIGID-END NUMBER Of 
LABEL END-I END-J LENGTH END-1 END-J FACTOR SEGMENTS 

1 1 2 5.831 0.000 0.000 o.oooo 2 
2 2 3 5.831 0.000 0.000 0.0000 2 '.• 3 3 4 4.000 o.ooo 0.000 0.0000 4 
4 5 6 4.000 o.ooo 0.000 0.0000 2 
5 6 ' 4.000 0.000 o.ooo 0.0000 4 
6 6 3 4.000 o.ooo 0.000 0.0000 2 

e S I S A p 2 o o o FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 14 
PROGRAM:SAP2000/FILE:\M1sdocumentos\cursosap2000\ejemplo5.EKO ¡,.:-7' 

F RAM E E L E M E N T DATA ··-
ELEMENT SECTION LOCAL COORD PLN PLN PLANE PLANE COORD 

LABEL LABEL PLANE SYSTEH 1ST 2ND JOINTA JOINTB ANGLE 

1 FS2 12 o •Z •X o o o.oo 
2 FS2 12 o •Z •K o o o.oo 
3 FS2 12 o •Z •X o o 0.00 
4 FS1 12 o •Z •X o o o.oo 
5 FS2 12 o •Z •X o o o.oo 
6 FS1 12 o •Z •X o o o.oo 

e s 1 1 S A P 2 o o o FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 15 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\ejemp1o5.EKO 

T O T A L w E 1 G H T S A N O M A S S E S 

SECTION WEIGHT H!\SS 
Ll\BEL 

FS1 l. 7299 0.1763 
FS2 7.0860 o. 7220 

TOTAL 8.8158 o. 8 982 

e S 1 S A P 2 o o o FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 16 
PROGRAM:SAP2000/FILE1\Misdocumentos\cursosep2000\ejemplo5.EKO 

LOAD CONDITION UNICA 

SELF-WEIGHT MULTIPLIER FOR ENTIRE STRUCTURE • O.OOOOE+OO 

JOINT FORCES IN LOCAL COORDINATES 
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JOINT FORCE 
LABEL 1 

2 O. SOOE+Ol 
4 O.OOOE+OO 

FORCE 
2 

FORCE 
3 

O.OOOE+OO O.OOOE+OO 
O.OOOE+OO -0.100E+02 

DISTRIBUTED SPAN LOADS ON n:tAME ELEMENTS 

MCMENT MCHENT 
1 2 

O.OOOE+OO O.OOOE+OO 
O.OOOE+OO O.OOOE+OO 

MC>!!:NT 
3 

O.OOOE+OO 
O.OOOE+OO 

ELEMENT LOC DISTANCE DISTANCE FORCE FORCE HCMENT MC>!!:NT 
AT END LABEL OOF AT STAAT AT END AT START AT END AT START 

1 
1 
5 

U1 O.OOOE+OO 
U2 O.OOOE+OO 
U2 O. OOOE+OO 

0.100E+Ol -0.154E+01 -0.154E+01 
0.100E+Ol -0.257E+01 -0.251E+01 
0.100E+Ol -0.200E+01 -0.200E+01 

e s r S A P 2 O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 17 
PROGRAM:SAP2000/FILE:\Mi~docurnento~\cursosap2000\ejernplo5.EKO 

OUTPUT S ELECTION 

D!SPLACEMENTS AT JOINTS 

LOAD MODES SPEe HIST 
LABEL LABEL LAS EL 

UNICA 

APPLIED ANO INTERNAL LOADS AT JOINTS 

LOAD HODES SPEe 
LABEL LABEL 

UNICA 

INTERNA!. FORCES AT ELEMENT FR.AME 

LOAD 
IJ\BEL 

UNICA 

JOINT fORCES 

LOAD 
IJ\BEL 

UNICA 

HOCES 

AT ELEMENT 

MODES 

SPEC 
IJ\BEL 

fR!\ME 

SPEC 
LABEL 

HIST 
LABEL 

HIST 
LAS EL 

HIST 
IJ\BEL 

MOVE 
LABEL 

MOVE 
IJ\BEL 

MOVE 
LAS EL 

MOVE 
LAS EL 

CCHl 
LABEL 

CCHl 
LAS EL 

C<Ml 
LAS EL 

CCHl 
IJ\BEL 

e S 1 S A P 2 O O O fiNITE ELEMENT ANALYSIS OF STRUCTURES PAGE 18 
PROGRAM:SAP2000/FILE:\M1sdocurnentos\cursosap2000\ejernplo5.EKO 

I N P U T e O M P L E T E 
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S A P 2 O O O (RJ 

Structural Analysis Programs 

Vers1on E6.10 

Copyright (Cl 1978-1997 
COMPUTERS ANO STRUCTURES, INC. 

All rights reservad 

This copy of SAP2000 is for the exclusive use of 

THE LICENSEE 

Unauthorized use is in violation of Federal copyright laws 

It is the responslbility of the user to verify all 
results produced by this prograrn 

18 Mar 2000 13:19:37 

PROGRAM SAP2000 - VERSION E6.10 
EOOCATIONAL VERSION - CCM'-!ERCIAL USE PROHIBITE.O 

OISPLACEHENT DEGREES Of fRE:EOOM 

<Al • Act1ve DOF, equilibr1um equation 
1-l • Restra1ned OOF, reaction cornputed 
(+) • Constra1ned OOF 
( l • Null OOF 

JOINTS 
1 

UX UY UZ RX RY RZ 
A 

2 TO 
5 

A A A 

6 TO 7 A A A 

PROGRAM SAP2000 - VERSION E6.10 
EOUCATIONAL VERSION COMMERCIAL USE PROHIBITED 

J O I N T O 1 S P L A C E M E N T S 

TRANSLATIONS ANO ROTATIONS, IN GLOBAL COOROINATES 

LOAD UNICA ------------------

JOINT 
1 
2 
J 
4 
5 
6 
7 

ux 
.000000 

0.029221 
0.056748 
0.056748 

.oooooo 
0.020272 
0.020272 

uz 
.oooooo 

-0.048177 
-0.002094 
-0.103539 

.000000 
-0.001225 
-0.104378 

PROGRAM SAP2000- VERSION E6.10 

RY 
o .022226 

-0.008848 
0.008103 
0.033703 

.000000 
0.020592 
0.027418 

EDUCATIONAL VERSION - COMMERCIAL USE PROHIBITED 

A P P L I E O L O A O S 

FORCES ANO MOMENTS ACTING ON JOINTS, IN GLOBAL COORDINATES 

LOAD UNICA ------------------

JO!NT FX FZ MY 
-8.33E-16 -8.746428 7.288690 

2 5.000000 -8.746428 -7.288690 
4 .000000 -10.000000 .000000 
6 .000000 -4.000000 2. 666667 
7 .000000 -4.000000 -2.666667 

PROGRAH SAP2000 - VERSION E6.10 
EDUCATIONAL VERSION - COMMERCIAL USE PROHIBITEO 

GLOBAL FORCE BALANCE 

TOTAL FORCE ANO HOMENT A7 THE OR!GIN, IN GLOBAL COOROINATES 

FILE; EJEMPLOS .001' 
PAGE 

1 

FILE:EJEMPL05.0UT 
PAGE 

2 

FILE:EJEMPLOS.OUT 
PAGE 

J 

FILE:EJEMPL05.0UT 
PAGE 

4 
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LOAD UNICA ------------------

rx FY rz MX 
APPLIED 5.000000 . 000000 -35.492856 .000000 
REACTNS -5.000000 . 000000 35.492856 . 000000 

TOTAL 2. 90E-13 .000000 -1.07E-13 .000000 

PROGRAH SAP2000- VERSION E6.10 
EDUCA.TIONAL VERSION - Ca-HERCIAL USE PROHIBITED 

F RAM E E L E M E N T J O I N T FORCE S 

MY MZ 
334.732139 .oooooo 

-334.732139 • 000000 

l.BBE-12 .000000 

FILE:EJEMPLOS.OUT 
PAGE 

5 

FORCES ANO MOMENTS ACTING ON ELEHENTS, IN GLOBAL COORDINATES 

ELE>< l ------------------
LOAD UNICA ------------------

JOINT rx FY rz MX 
l -7.604415 .000000 7. 92977 3 .000000 
2 7.604415 .000000 9.563083 .oooooo 

ELEM 2 ------------------
LOAD UNICA ------------------

JOINT rx FY rz MX 
2 -2.604415 .000000 -9.563083 .000000 
3 2.604415 .000000 9.563083 .000000 

ELEM 3 ------------------
LOAD UNICA ------------------

JOINT rx FY .. , MX 
3 l.lJE-14 .000000 10.000000 .000000 

-!..lJE-14 .000000 -10.000000 .000000 

ELEM ' ------------------
LOAD UNICA ------------------

JOINT rx FY rz MX 
5 2.604415 .oooooo 27.563083 . 000000 
6 -2.604415 . 000000 -27.563083 .000000 

ELE>< 5 =a•••••••••••••~•• 

LOAD UNICA ------------------
JOINT rx FY rz MX 

6 2.30E-13 .000000 8.000000 .oooooo 
7 -2.30E-13 .000000 -6.66E-15 .000000 

ELEM 
6 ------------------

LOAD UNICA ------------------

JOINT rx FY rz MX 
6 2.604415 .oooooo 19.563083 .000000 
3 -2.604415 .000000 -19.563083 .000000 

PROGRAM SAP2000 - VERS!ON E6.10 
EDUCATION~L VERSION - COHMERCIAL USE PROHIBITED 

FRAME: ELEMENT INTERNAL FORCES 

ELE>< 1 •••••••••••••••••• LENGTH • 

LOAD UNICA ------------------

REL DIST 
0.00000 
0.50000 
1.00000 

ELEM 

p 
2.440898 
6.940898 

11.440898 

V2 
-10.712164 

-3.212164 
4.287836 

V3 
.000000 
.000000 
.000000 

2 •••••••••••••••••• LENGTH • 

LOAD UNICA ------------------

5.830952 

T 
.ooooco 
.000000 
,000000 

5. 830952 

MY MZ 
-3.55E-15 .oooooo 

-18.729972 .000000 

MY MZ 
18.729972 .000000 
36.898686 .000000 

"' HZ 
-40.000000 .000000 
-6.06E-15 .000000 

MY MZ 
1.734009 .000000 
8.683652 . 000000 

MY MZ 
-16.000000 .000000 

9.33E-15 .000000 

MY MZ 
7.316348 .000000 
3.101314 .000000 

FILE:EJEHPL05.0UT 
PAGE 

6 

M2 
.000000 
.000000 
.000000 

M3 
-2.45E-15 
20.298021 
18.729972 
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REL DIST 
o.ooooo 
0.50000 
1.00000 

p 
-2.686898 
-2.686898 
-2.686898 

V2 
9.540236 
9.540236 
9.540236 

V3 
.000000 
.000000 
.000000 

ELEM 3 •••••••••••••••••• LENGTH • 

LOAD UNICA ------------------

REL DIST 
0.00000 
0.25000 
o. 50000 
0.75000 
1.00000 

p 
-l.lJE-14 
·l.lJE-14 
-l.lJE-14 
-l.lJE-14 
-l.l3E-14 

V2 
-10.000000 
-10.000000 
-10.000000 
-10.000000 
-10.000000 

V3 
.000000 
.000000 
.000000 
.000000 
.oooooo 

ELEM 4 •••·•--•••••--•••• LENGTH • 

LOAD UNICA ------------------

REL DIST 
0.00000 
0.50000 
1.00000 

p 
-27.563083 
-27.563083 
-27.563083 

V2 
-2.604415 
-2.604415 
-2.604415 

V3 
.000000 
.000000 
.000000 

ELEM 5 •••••••••••••••••• LENGTH • 

LOAD UNICA ------------------

REL DIST 
0.00000 
0.25000 
0.50000 
o. 75000 
l. 00000 

p 

·2. JOE-13 
-2.30E-13 
-2.30E-13 
-2.30E-13 
-2. 30E-13 

V2 
-8.000000 
-6.000000 
-4.000000 
-2.000000 
-5.33E-15 

PROGRAM SAP2000- VERSION E6.10 

V3 
.000000 
.000000 
.000000 
.000000 
.000000 

T 
.000000 
. 000000 
. 000000 

4.000000 

T 
.000000 
.000000 
.000000 
. 000000 
. 000000 

4.000000 

T 
.000000 
.oooooo 
.oooooo 

4.000000 

T 
.000000 
.000000 
.000000 
.000000 
.000000 

EOUCATIONAL VERSION - COMMERCIAL USE PROHIBITED 

fRAME ELEMENT INTERNAL FORCES 

ELEM 6 ••••••••••••••·--• LENGTH • 

LOAD UNlCA ------------------

REL DIST 
o.ooooo 
0.50000 
1.00000 

p 
-19.563083 
-19.563083 
-19.563083 

V2 
-2.604415 
-2.604415 
-2.604415 

V3 
. 000000 
.000000 
.oooooo 

4.000000 

T 
.000000 
.000000 
.000000 

M2 
.000000 
.000000 
.oooooo 

M2 
.000000 
.000000 
.000000 
.000000 
.000000 

M2 
.000000 
.000000 
.oooooo 

M2 
.000000 
.000000 
.000000 
.000000 
.000000 

M3 
18.729972 
-9.084357 

-36.898686 

M3 
-40.000000 
-30.000000 
-20.000000 
-10.000000 

3.55E-15 

M3 
-1.734009 

3.474822 
8.683652 

M3 
-16.000000 

-9.000000 
-4.000000 
-1.000000 
·l. 78E-14 

FILE1EJEMPL05.0UT 
PAGE 

7 

M2 
.000000 
.000000 
.000000 

MJ 
-7.316348 
-2.107517 

3.101314 
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; F~le C:\~s documento~\cur~o ~ap 2000\ejemplo6.~2k aaved 3/18/00 14:39:08 ~n Ton-m 

SYSTEM 
DOF-UX,UZ,RY LENGTH-m FORCE•Ton LINES•59 

JOINT 
1 x--2 
3 X•O 
4 x-o 
6 x-2 

RESTRAINT 
ADD•1 
AD0•6 
AD0•3 
ADD•4 

Y•O zgo 
Y•O z-o 
Y•O Z•2 
Y•O Z•2 

DOF•U1,U2,U3,R1,R2,R3 
DOF-U1,U2,U3,Rl,R2,R3 
DOF•U2,Rl,R2,R3 
DOF•U2,R1,R2,R3 

PATTERN 
NAME•DEFAULT 

MATERIAL 
NAME•STEEL IDES•S M•.798142 W•7.833413 

T•O E•2.03B902E+07 U•.3 A•.0000117 
NAME-cONC IOES•C M-.2448012 W•2.402616 

T•O E•2531051 U•.2 A•.0000099 
NAME•RARO IDES•N M•.2448 W•2.4026 

T•O E•lOOOOOO U•.2 A•.0000099 

FRAME SECTION 
NAME•FSECl MAT•STEEL SH•R T•.S, .3 A•.l5 J•2.817371E-03 !•.003125, .001125 AS•.l25, .125 

FRAME 
2 J•3,4 SEC•FSEC1 
4 J•l,3 SEC•FSECl 
7 J•4,6 SEC•FSECl 
B J•l,4 SEC•FSECl 
9 J .. 3,6 SEC•FSECl 

LOAD 
NAME•VERTICAL 

TYPE•FORCE 
ADD•4 UZ•-10 
ADD-3 uz--s 

OUTPUT 

NSEG-2 ANG•O IREL•R3 
NSEG-4 rum-o IREL•R3 
NSEG•4 rum-o IREL•R3 
NSEG•2 ANG•O IREL•R3 
NSEG•2 ANG•O IREL•R3 

ELEM•JOINT TYPE•DISP LOAD•VERTICAL 
ELEM•JOINT TYPEmAPPL LOAD•VERTICAL 
ELEM•FRAME TYPE•FORCE LOAD•VERTICAL 
ELEM•FRAME TYPE•JOINTF LOAD•VERTICAL 

ENO 

JREL•R3 
JREL•R3 
JREL•R3 
JREL•R3 
JREL•R3 

The following data 1s not required for analysis. It 1s wr1tten here a~ a backup. 
Th~s data will be used for graph1cs and desiqn if th1s f1le is imported. 
If changes are made to the analysls data above, then the fol1ow1ng data 
should be checked for consistency. 
Any errors 1n 1mport1ng the follow1ng data are 1gnored without warn1ng. 

SAP2000 V6.10 SUPPLEMENTAL DATA 
GRID GLOBAL X "1" -2 
GRID GLOBAL X "2" O 
GRID GLOBAL X "3" 2 
GRID GLOBAL Y "4" O 
GRID GLOBAL Z "5" O 
GRID GLOBAL Z "6" 2 
MATERIAL STEEL FY 25310.5 
MATERIAL CONC FYREBAR 42184.18 FYSHEAR 28122.78 FC 2812.278 FCSHEAR 2812.278 
STATICLOAD VERTICAL TYPE OTHER 

END SUPPLEMENTAL DATA 

' l ' ~~ 
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SAP2000 
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Version 6.10 

Copyright (C) 1978-1997 
COMPUTERS ANO STRUeTURES, INe. 

A.ll rights reserved 

This copy of SAP2000 lS for the exclusive use of 

THE LICE:NSEE 

Unauthor1zed use is in violation of Federal copyright laws 

It is the responsibility of the user to verlfy all 
results produced by th1s program 

18 Mar 2000 14:26:16 

e S I / S A P 2 O O O FINITE ELEHENT ANALYSIS OF STRUCTURES PAGE 1 
PROGRAM:SAP2000/FILE:\Mlsdocumentos\cursosap2000\ejemplo6.EKO 

SYSTEM DATA 

STEADY STATE LOAD FREQUENeY 

LENGTH UNITS -
FORCE UNITS -

UP DIRECTION -

GLOBAL DEGREES OF FREEDOM 

PAGINATION BY - - - - -
NUMBER OF LINES PER PAGE 
INeLUDE WARNING MESSAGES IN OUTPUT FILE 

O.OOOOE+OO 

M 
TON 

+Z 

ux 
uz 
RY 

LINES 
59 

y 

e S I 1 S A P 2 O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 2 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\ejemplo6.EKO 

G E N E R A T E D J O 1 N "!" C O O R D N A T E S 

JOINT 
l 
3 

' 6 

X 
-2.000 
o. 000 
o. 000 
2.000 

y 

0.000 
0.000 
0.000 
0.000 

z 
o. 000 
0.000 
2.000 
2.000 

e s 1 S A P 2 O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE J 

PATTERNS 

PATTERN 
DEFAULT 

JOINT 

PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\ejemplo6.EKO 

VALUE 

e S I 1 S A P 2 O O O FINITE ELE:MENT ANALYSIS OF STRUCTURES PAGE 4 
PROGRAM:SAP2000/FILEr\~sdocumentos\cursosap2000\ejemplo6.EKO 

R E S T R A I N T D A T A 

JOINT 
1 U! U2 U3 Rl R2 R3 
3 U2 R! R2 R3 

U2 Rl R2 R3 
6 Ul U2 U3 Rl R2 R3 

e s 1 1 S R P 2 o o o FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE S 
PROGRAM:SAP2000/fiLE:\~sdocumentos\cursosap2000\ejemplo6.EKO 

MATERIAL PROPERTY DA T A 

~ 
\ -- . 
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''! MI\T NUMBER 
LABEL TEMPS 

STEEL 
CONC 
RARO 

e s 1 S A P 2 

WEIGHT PER W\SS PER DES!GN 
UNIT VOL UNIT VOL CODE 

Q,7833E+Ol O. 7981E+OO S 
0.2403E+O: 0.2448E•OO e 
0.2403E+Ol 0.2448E+OO N 

O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 6 
PROGRAM:SAP2000/FILE:\M~sdocumentos\cursosap2000\ejemplo6.EKO 

T E M P E R A T U R E DEPENDEN! DATA 

MATERIAL PROPERTIES 

MAT 
LABEL 

S TE EL 

eONe 

RARO 

TEMP MODULUS OF ELASTICITY 
El E2 E3 

SHFJ&Jl; MODULI I 
Gl2 GlJ G23 

0.00 0.204E+08 0.204E+06 0.204E+OB 0.7B4E+07 0.784E+07 Q.784E+07 

0.00 0.253E+07 0.253E+07 0.253E+07 0.105E+07 O.lOSE+07 O.lOSE+Oi 

0.00 0.100E+07 0,100E+07 0.100E+07 0.417E+06 0.417E+06 0.417E+06 

C S 1 S A P 2 O O O FINITE ELE:HENT ANALYSIS OF STRUCTURES PAGE 7 
PROGRAM:SAP2000/FILE:\~sdocumentos\cursosnp2000\ejemplo6.EKO 

TEHPERAT u R E D E P E N D E N T DATA 

THERMI\L EXPANSION COEFFICIENTS 

MI\T TEMP COEFFICIENTS OF THERM.JU. EXPANSION 
LABEL Al A2 A3 A12 A13 A23 

STEEL 0.00 O.ll7E-04 o .117E-04 O .117E-04 O.OOOE+OO O.OOOE+OO O.OOOE+OO 

CON e 0.00 O. 990E-05 0.990E-05 O. 990E-05 O .OOOE+OO O.OOOE+OO O.OOOE+OO 

RARO 0.00 O. 990E-05 0.990E-05 0.990E-05 O.OOOE+OO O.OOOE+OO O. OOOE+ 00 

e s 1 S A P 2 O O O riNITE ELEMENT ANALYSIS OF STRUCTURES PAGE 8 
PROGRAM:SAP2000/FILE:\~sdocumentos\cursosap2000\ejemplo6.EKO 

TEMPERATURE DEPENOENT DATA 

MATERIAL PROPERTIES 

MAT TEMP POISSONS RATIO 
LABEL U12 Ul3 U23 Ul4 U2< U34 U15 U25 U35 U45 Ul6 U26 U36 U46 U56 

S TE EL o.oo 0.3 0.3 0.3 0.0 o.o o.o o.o 0.0 o. o o.o 0.0 0.0 0.0 o.o o.o 

CONC o.oo 0.2 0.2 0.2 o.o 0.0 0.0 o.o 0.0 0.0 0.0 0.0 o.o 0.0 o.o 0.0 

RARO 0.00 0.2 o. 2 0.2 0.0 0.0 o.o 0.0 0.0 0.0 0.0 0.0 0.0 0.0 o.o o.o 

e s S A P 2 o o o fiNITE ELE:MENT ANALYSIS Of STRUCTURES PAGE 9 
PROGRAM:SAP2000/FILE:\Hisdocumentos\cursosap2000\ejemplo6.EKO 

MATERIAL PROPERTIES 

MAT 
LABEL 

CONC 

TEMP 

o.oo 

Y lELO 
ry 

36.00 

C S 1 S A P 2 O O O fiNITE ELD-1ENT ANALYSIS Of STRUC11JRES PAGE 10 
PROGRAM:SAP2000/FILE:\Mlsdocurnentos\cursosap2000\eJemplo6.EKO 

F R AH E S E e T 1 O N PROPERTY DATA - p R I S HA T 1 e 

SECTION SHAPE DEPTH FLANGE fLANGE WEB fLANGE FLANGE 
LABEL TYPE WJDTH THICK THICK WIDTH THICK 

TOP TOP BOTTCM BOTTCM 

fSECl R o. 500 0.300 

., 
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C S I 1 

FRAME 

SECTION 
IJ\BEL 

FSE.C1 

e S I 

S A P 2 0 O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE. 11 
PROGRAM:SAP2000/fiLE:\Misdocumentos\cursosap2000\eJemplo6.EKO 

S E C T I O N P R O P E R T Y DATA- PRISMA!IC 

AXIAL TORSIONAL 
ARE.A. CONSTAN! 

MOMENTS OF INERTIA 
133 !22 

SHEAA MEAS 
1\2 1\3 

0.1SOE.+00 0.282E-02 0.313E-02 0.113E-02 0.125E+00 0.12SE+OO 

S A P 2 O O O FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 12 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\ejemplo6.EKO 

FRAME SECTION PROPERTY DATA- PRISMATIC 

SECTION 
IJ\BEL 

FSEC1 

C S I 

F R A M E 

ELEMENT 
!.AS EL 

2 

• 
7 

8 
9 

e s r 

F RAM E 

HAT AD~ITIONAL 

LABEL MASS PER 
LENGTH 

STEEL O.OOOE+OO 

ADDITIONAL 
WEIGHT PER 

LENGTH 

O.OOOE+OO 

S A P 2 O O O FINITE ELEMENT ANALYSIS Of STRUCTURES PAGE 13 
PROGRAM:SAP2D00/F!LE:\Misdocumentos\cursosap2000\ejemplo6.EKO 

E L E M E N T DATA 

JOINT JOINT ELEMENT END-OFFSET-LENGTHS RIGID-END NUMBER OF 
E:ND-1 END-J LE:NGTH END-I END-J FACTOR SE:GMENTS 

3 • 2.000 o.ooo 0.000 0.0000 2 
3 2.000 0.000 o.ooo 0.0000 • 
6 2.000 0.000 0.000 0.0000 • 
' 2. 828 0.000 0.000 0.0000 2 
6 2.828 0.000 0.000 o.oooo 2 

S A p 2 o o o FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 14 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\eJemplo6.EKO 

E L E M E N T DATA 

ELEMENT SECTION LOCAL COORD PLN PLN PLJ\NE PLJ\NE COORD 
LI\BEL 

2 

• 
7 
8 
9 

e s r 1 

F R A M E 

ELEMENT 
LABEL 

2 

' 7 
B 
9 

e s r 

!.AS EL PLANE SYSTEM 1ST 2ND JOINTA JOINTB ANGLE 

FSECl !2 o •Z •X o o 0.00 
FSECl 12 o •Z •X o o 0.00 
FSECl 12 o •Z •X o o 0.00 
FSECl 12 o •Z •X o o 0.00 
FSECl 12 o ., •X o o o.oo 

S A P 2 o o o FINITE ELEHENT ANAL~SIS OF STRUCTURES PAGE 15 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\eJemplo6.EKO 

E L E M E N T D A T A 

END-1 REL~E COCES 

R3 
R3 
R3 
R3 
R3 

E.ND-J RELEASE COCES 

R3 
R3 
R3 
R3 
R3 

S A P 2 O O O FlNITE ELEMENT ANALYSlS OF STRUCTURES PAGE 16 
PROGRAM:SAP2000/FILE:\Mlsdocumentos\cursos~p2000\e]emplo6.EKO 

TOTAL WEIGHTS ANO MASSES 

SECTION 
LABEL 

FSECl 

TOTAL 

WEIGHT 

13.6969 

13.6969 

CSI 1 SAP2000 

MASS 

1.3956 

1. 3956 

FINITE ELEMENT ANALYSIS OF STRUCTURES PAGE 17 

\ 
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PROGRAM:SAP2000/fiLE:\M~~documentos\cursosap2000\ejemplo6.EKO 

L O A D e o N DITION VERTICAL 

SELF-WEIGHT MULTIPLIER fOR ENTIRE STRUCTURE • Q.OOOOE+OO 

JOINT FORCES IN LOCAL COORDINATES 

JOINT FORCE FORCE FORCE MCMENT Ma<ENT MCMNT 
LI\BEL 1 2 3 1 2 3 

3 O.OOOE+OO O.OOOE+OO -0.500E+Ol O.OOOE+OO O.OOOE+OO O.OOOE+OG 

• O.OOOE+OO O.OOOE+OO -0.100E+02 O.OOOE+OO O.OOOE+OO O.OOOE+OO 

e S I 1 S A P 2 O O O FIN!TE ELEM:r.NT ANALYSIS OF STRUC11JRES PAGE 18 
PROGRAM:SAP2000/FILE:\Misdocumentos\cursosap2000\ejemplo6.EKO 

OUTPUT S E L E e T I O N 

DISPLACEMENTS AT JOINTS 

LOAD MODES SPEC HIST 
LI\BEL LAS EL LABEL 

VERTICAL 

APPLIED AND INTERNAL LOADS AT JOINTS 

LOAD MODES SPEC 
LI\BEL LI\BEL 

VERTICAL 

INTERNAL FORCES A.T ELEMENT fRAHE 

LOAD 
LABEL 

VERTICAL 

JOINT FORCES 

LOAD 
LABEL 

VERTICAL 

MODES 

A.T ELEMENT 

MODES 

SPEC 
LI\BEL 

........: 

SPEC 
LABEL 

HIST 
LABEL 

HIST 
LABEL 

HIST 
LAS EL 

MCVE 
LABEL 

MCVE 
LI\BEL 

MOVE 
LABEL 

MCVE 
LABEL 

CC><B 
LI\BEL 

CC><B 
LI\BEL 

CCWJ 
LABEL 

C<Ml 
LAS EL 

e S I 1 S A P 2 O O O FINITE ELEMENT ANAL'iSIS OF STRUCTUR.ES PAGE 19 
PROGRAM:SAP2000/FILE:\M1sdocurnentos\cursosap2000\ejemplo6.EKO 

I N P U T C O M P L E T E 

'ti, 
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S A P 2 O O O (R) 

Structural Analysi.s Proqrams 

Version E6.10 

Copyriqht !Cl 1978-1997 
CCJo!PUTERS ANO STRUCTIJRe5, INC. 

All riqhts reserved 

This copy ot SAP2000 i.s for the exclusive use of 

THE LICENSEE 

Unauthoriled u.se l.s in vlolatlon of federal copyrlqht laws 

It l.s the re.sponsibility of the user to verify aH 
re.sults produced by this proqram 

18 Mar 2000 14:26:17 

PROGRAH SAPZOOO- VERSION E6.10 
EOOCATIONAL VERSION - COI+ItRCIAL USE PROHIBITEO 

riLE:EJEHPL06. OUT 
PAGE 

l 

O 1 S P L A e E M E N T O E G R E E S O f fREEOOH 

JOINTS 
1 

(Al • Active oor, equilibri~ equation 
{-J • Restrained oor, reactlon computed 
(~) • Con.strained DOf 
( l • Null oor 

UX UY UZ RX RY RZ 

3 TO • • • 
PROGRAH SAP2000 VERSION E6.l0 
EOUCATJONAL VERSION - COHHERCIAl USE PROHIBITEO 

J O I N T O l S P L A C E M E N T S 

TRANSLATIONS ANO ROTATIONS, IN GLOBAL COORDINATES 

LOAOVERTICAL ------------------

JOINT vx uz RY 
1 .000000 .000000 .000000 
3 4. 72E-06 -l.SIE-05 .000000 

' S.09E-06 -1.9SE-05 .000000 

' .000000 .000000 .000000 

PROGRAM SAP2000- VERS!ON E6.10 
EOUCATIONAL VERSION - CCK'-!ERCIAL USE i'ROHIBITED 

A P P L 1 & O L O A O S 

fORCES ANO HOMENTS ACTING ON JOINTS, IN GLOBAL COORDINATES 

LOADVERTICAL ------------------

JOJNT 
3 

' 
"' .000000 

.000000 

rz 
-5.000000 

-10.000000 

PROGRAM SAP2000 - vtRSION t6.10 

HY 
,000000 
. 000000 

EOOCATIONAL VERSION - Cet+!ERCIAL USI: PROHlBITI:D 

G L O 9 A L f O R C E B A L A N C E 

TOTAL roRCE ANO MOMENT AT THE ORIGIN, IN GLOBAL COORDINATES 

LOADVtRTICAL ------------------

APPLIEO 
RtACTNS 

TOTAL 

"' .000000 
1. 78E-15 

l. ?SE-15 

fY 
.000000 
.000000 

.oooooo 

PROGRAH SAP2000- VERSION E6.10 

fZ 
-15.000000 

15.000000 

.000000 

EDUCATIONAL VERSION COMHERCIAL USE PROHIBITEO 

Ml< 
.oooooo 
.oooooo 

.000000 

F RAM t E ~ E M E N T J O I N T r o P. e E s 

fiLE EJEHPL06.0UT 
PAGE 

2 

fiLE: EJEHPL06 .OUT 
PAGE 

3 

fiLE· EJEHPL06 .OUT 
PAGE 

"' . 00000() 
l '78t-l5 

1.'78E-15 

' 

MZ 
.000000 
.000000 

.000000 

FILE: EJtHPL06. OUT 
PAGE 

' 

FORC[.S ANO MCMENTS ACTING ON ELE:.MENTS, IN GLOB~ COOROINATES 

LOADVER'I'ICAL ~~----~---~~~----~ 



JOINT fX F'Y fZ "" MY HZ '] 3 .000000 .000000 2.211211 • 000000 .oooooo .000000 

• .000000 .000000 -2.211211 • 000000 .000000 .000000 

<I.EM -------------
LOADVERTICAL ------------------

JOINT fX F'Y rz "" MY HZ 
1 -"1.211211 .000000 .000000 . 000000 .000000 .000000 
3 "1.211211 .000000 .000000 . 000000 .000000 .000000 

E:LE:M ------------------
LOADVE:RTICA.!. ------------------

JOINT fX rY rz "" MY HZ 

• 7. "188789 .000000 .oooooo .000000 .000000 .000000 
6 -"1. 788789 .000000 . 000000 • 000000 .000000 .000000 

ELE>< .................................... 
LOA.DVtRTICAL ------------------

JOINT fX F'Y rz MX MY HZ 
1 7.'188'789 .000000 7.'188789 . 000000 .000000 .000000 

• -7. "188789 .000000 -7.798789 .000000 .000000 .000000 

ELEM -----------------
LOADvtRTICAL ------------------

JOINT fX F'Y rz MX MY HZ 
3 -7.211211 .000000 -7.211211 • 000000 .000000 .oooooo 
6 7.211211 .000000 7.211211 • 000000 .000000 .000000 

PROGRAM SAP2000- VE:RSION E:6.10 riLE: E:Jt:HPLOEi.OUT 
E:DUCATIONAL vtRS!ON CotfltRCIAL USt PROHIBITtO PAGt 

6 

r RAM E E L E M E N T 1 N TE:RNAL roRe ES 

ELE>< 2 -------------- Lf.NGTH • 2. 000000 
·-

LOADVERTICAL ------------------

RE:L OIST p V2 V3 T M2 H3 
0.00000 -2.211211 .000000 .000000 .000000 .000000 .000000 
0.50000 -2.211211 .000000 .000000 .000000 .000000 .000000 
1.00000 -2.211211 .000000 .000000 .oooooc .000000 .oooooo 

ELEM ------------------ LENGTH • 2.000000 

LOA.DVtRTICAL ------------------ ... 
REL OIST p V2 V3 T M2 H3 
0.00000 "1.211211 .000000 .000000 .000000 .000000 .000000 
0.25000 7.211211 .000000 .000000 .000000 .000000 .000000 
0.50000 "1.211211 .000000 .000000 .000000 .000000 .000000 
0.75000 "1.211211 .000000 .000000 .000000 .000000 .000000 
1.00000 7,211211 .000000 .000000 .oooooo .000000 .oooooo 

ELE>< '1 .................................... LENGTH " . 000000 

LOADVtRTICAL ------------------
REL DIST p V2 V3 T M2 H3 
0.00000 -7.788789 .000000 .000000 • 000000 .000000 .000000 
0.25000 -7.788789 .000000 .000000 .000000 .000000 .000000 
0.50000 -7. "198799 .000000 .000000 .000000 .000000 .000000 
0.75000 -7. '189789 .000000 . 000000 .000000 .000000 .000000 
1.00000 -'1. '188'189 .000000 • 000000 .000000 .000000 .000000 

""' ------------------ LtNGTH • 2.828417 

LOADVE:RTICAL ------------------
Rf.L DIST p V2 V3 T M2 H3 
0.00000 -11.015010 .000000 .000000 .000000 .000000 .000000 
0.50000 -11.015010 .000000 .000000 .000000 .000000 .000000 
1.00000 -11.015010 .oooooo .000000 .000000 .000000 .000000 

ELEM ------------------ Lf.NGTH .. 2.82842i 

LOADVE:RTICAL ------------------
RE:L DIST p V2 V3 T M2 H3 
0.00000 10.199193 .000000 . 000000 ,000000 .000000 .000000 
0.50000 10.199193 .000000 • 000000 .000000 .000000 .000000 

1.00000 10.198193 .000000 .000000 .000000 .oooooo .oOOOOO 
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¡ File C:\~s documentos\curso sap 2000\ejemplo7.s2k saved 3/18/00 15:22:55 in Ton-m 

S'iSTEM 
DOF-UX,UZ,RY LENGTH-m FORCE•Ton LINES•59 

JO IN'!' 
1 x--9 Y•O z-o 
3 X•O Y•O z-o 
4 x-o Y•O z-4.S 
S X•9 Y•O z-o 
7 X•-6 Y•O z-o 
8 x--3 Y•O z-o 
9 X•3 Y•O z-o 
10 X•6 Y•O z-o 
11 X•-6 Y•O Z•l. S 
12 X•-3 Y•O Z•3 
13 x-6 Y•O z-1. s 
14 x-3 Y•O z-3 
17 X•-9 Y•O z--6 
18 X•9 

RESTRAINT 
1\DD-17 
ADD•18 
ADD"'l 
ADD•3 
ADD•4 
ADD•S 
ADD•7 
l\D0•8 
ADD•9 
AD0•10 
1\DO•ll 
ADD•12 
l\D0•13 
l\D0•14 

Y•O z--6 

DOF•Ul,U2,U3,Rl,R2,R3 
DOF•Ul,U2,U3,Rl,R2,R3 

DOF•U2, Rl, R3 
DOF•U2, Rl, R3 
DOF•U2,Rl,R3 
DOF•U2,Rl,R3 
DOF•U2, Rl, R3 
DOfwoU2,Rl,R3 
OOFmU2,R1,R3 

DOF•U2,R1,R3 
DOF ... U2,Rl,R3 
DOF•U2,Rl,R3 
DOF-U2, Rl, R3 
DOF<:<U2, Rl, R3 

PA.TTERN 
NA.ME•DEFAULT 

MA.TERIA.L 
NAME•STEEL IDES•S M•.798142 W•7.833413 

T•O E•2.038902E+07 U•.3 A.•.0000117 
NA.ME•CONC IDES•C M•.2448012 W•2.402616 

T•O E•2531051 U•.2 A•.0000099 
NAME•ACERO 1DES•N M•.2448 W•2.4026 

T•O E•2E+07 U•.3 A•.0000099 
NAME•CONCRETO 1DES•N M•.7981 W•7.8334 

T•O E•1800000 U•.2S A•.0000117 

FRAME SECTION 
NAME•FSECl ~T•STEEL SH•R T•.S, .3 A•.15 J•2.817371E-03 1•.003125, .001125 AS•.125, .125 
NAME•FSEC2 MAT•ACERO A•.OOS J•O 1•0,0 AS•O,O 5•1,1 Z•1,1 R•l,l T•.4572, .254 
NAME•FSEC3 MAT•CONCRETO SH•R T•.5, .5 A•.25 J•B.802084E-03 I•5.208333E-03,5.208333E-03 

AS•.2083333, .2083333 

FRAME 
2 J•3,4 SEC•FSEC2 NSEG•2 ANG•O IREL•R3 JREL•R3 
12 J•1,7 SEC•FSEC2 NSEG•4 1\NG•O IREL•R3 JREL•R3 
13 J•7,8 SEC•FSEC2 NSEG-4 ANG-0 IREL•R3 JREL•R3 
14 J•8,3 SEC•FSEC2 NSEG•4 1\NG•O IREL•R3 JREL•R3 
1S J•3,9 SEC•FSEC2 NSEG•4 1\NG-0 1REL•R3 JREL•R3 
16 J•9,10 SEC•FSEC2 NSEG•4 ANG•O IREL•R3 JREL•R3 
17 J•10,5 SEC•FSEC2 NSEG•4 ANG•O IREL•R3 JREL•R3 
18 J•1,11 SEC•FSEC2 NSEG•2 1\NG•O IREL•R3 JREL•R3 
19 J•ll, 12 SEC•FSEC2 NSEG•2 ANG•O IREL•R3 JREL•R3 
20 J•l2,4 SEC•FSEC2 NSEG•2 ANG•O IREL•R3 JREL•R3 
21 J•5,13 SEC•FSEC2 NSEG•2 1\NG•O IREL•R3 JREL•R3 
22 J•13,14 SEC•FSEC2 NSEG•2 ANG•O IREL•R3 JREL•R3 
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23 J•l4,4 SEC•FSEC2 NSEG•2 ANG•O 
24 J•7,11 SEC•FSEC2 NSEG-2 ANG•O 
25 J•ll, 8 SEC•FSEC2 NSEG•2 ANG-0 
26 J•8,12 SEC•FSEC2 NSEG•2 ANG•O 
27 J•l2,3 SEC•FSEC2 NSEG•2 ANG•O 
28 J•3,14 SEC•FSEC2 NSEG•2 AtlG•O 
29 J•l4,9 SEC•FSEC2 NSEG•2 ANG-0 
30 J•9,13 SEC•FSEC2 NSEG•2 ANG-0 
31 J•10,13 SEC•FSEC2 NSEG•2 ANG•O 
33 J•l7,1 SEC•FSEC3 NSEG•2 ANG•O 
34 J•18,5 SEC•FSEC3 NSEG•2 ANG-0 

LOAD 
NAME•VERT 

TYPE•FORCE 
ADD-=4 uz ... -3 
ADD•ll uz--3 
ADD•12 uz--3 
ADD•13 uz--3 
ADD•l4 uz--3 

OUTPUT 
ELEM-JOINT TYPE•DISP LOAD•VERT 
ELEM~JOINT TYPE•APPL LOAD•VERT 
ELEM•FRAME TYPE•FORCE LOAD•VERT 
ELEM•FRAME TYPE•JOINTF LOAD•VERT 

END 

IREL•R3 JREL•R3 
IREL•R3 JREL•R3 
IREL•R3 JREL•R3 
IREL•R3 JREL•R3 
IREL•R3 JREL•R3 
IREL•R3 JREL•R3 
IREL•R3 JREL•R3 
IREL•R3 JREL•R3 

IREL•R3 JREL•R3 

The follow1ng data ~s not required for analys~s. It is wr1tten here as a backup. 
Th1s data w1ll be u~ed for graphics and des1gn if this file 1s 1mported. 
If changes are made to the analysis data above, then the follow~ng data 
should be checked for con~~stency. 
Any errors ~n ~mporting the following data are ~gnored w~thout warn~ng. 

SAP2000 V6.10 SUPPLEMENTAL DATA 
GRID GLOBAL X "1" -9 
GRID GLOBAL X "2" 0 
GRID GLOBAL X "3" 9 
GRID GLOBAL Y "4" 0 
GRID GLOBAL Z "S" -6 
GRID GLOBAL Z "6" 0 
GRID GLOBAL Z "7" 4.5 
MATERIAL STEEL FY 25310.5 
MATERIAL CONC FYREBAR 42184.18 FYSHEAR 28122.78 FC 2812.278 FCSHEAR 2812.278 
STATICLOAD VERT TYPE OTHER 

END SUPPLEMENTAL DATA 
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e s 1 

SAP2000 

Structural Analysia Pro;rama 

Veraion 6.10 

Copyright (Cl 191B-1991 
COMPUTERS ANO STRUCTURES, INC. 

All righta reservad 

This copy o! SAP2000 is for the exclusive uae of 

THE LICE:NSE:E 

Unauthorized uae ia in violation of Federal copyri;ht law~ 

It 1a the responaibility of the uaer to verify ell 
reaulta produced by thia program 

lB Mar 2000 15:10144 

S A P 2 O O O FJNITE ELEMENT ANALYSIS OF STRUCTURES PAGE 
PROGRAM:SAP2000/FILE:\M1adocumentoa\curaoaap2000\ejemplo7.EKO 

S Y S T E M D A T A 

STtADY STATE LOAD FREQUENCY 

LtNGTH UNI TS 
FORCE UNITS 

UP DIRECTION 

GLOBAL DEGREES OF FREEDOM 

PAGINATION BY - - - - -
NUMEIER OF LINE:S PER PAGE 
INCLUDE WARNING HESSAGES IN OUTPUT FILE 

O.OOOOE+OO 

H 
TON 

., 
vx 
uz 
RY 

LINES 
59 
y 

e s 1 S A p 2 O 0 0 riNITE E.LE:MtNT ANALYSIS OF STRUCTURES PAGE: 2 
PROGRAM:SAP2000/FILE:\Miadoeumentoa\curaoaap2000\ej~plo7.EKO 

G E N E R A T E D J O I N ! C O O R D I N A T E S 

JOINT X y z 
1 -9.000 o.ooo 0.000 
3 0.000 0.000 o.ooo 
4 0.000 0.000 4. 500 
5 9.000 o.ooo 0.000 
7 -6.000 o.ooo 0.000 

' -J.OOO o.ooo 0.000 

' 3.000 o.ooo 0.000 
10 6.000 o.ooo 0.000 
11 -6.000 o.ooo l. 500 
12 -3.000 o.ooo J.OOO 
13 6.000 o.ooo l. so o 

" J' 000 0.000 J. 000 
17 -9.000 0.000 -6.000 

" ' 000 0.000 -6.000 

e s r S A P 2 o o o riNITE: tLE.MtNT ANALYS!S OF STRUCTURES PAGE 
PROGRAM: SAP2000/ riLE:: \Misdocumentoa\curso.!lap2000\ejemplo7. E: KO 

PATTERNS 

PATTERI'l 
DEFAULT 

JOINT VALllE: 

e s 1 SAP2000 FHo/ITE: ELEMENT ANALYSIS Of STRUCTURES PAGt 
PROGRAM: SAP2000/ FILE: \M1a<1ocuml!lntoa\curaoup2000\ejemplo1, EKO 

R E S T R A I N T O A T A 

JOINT 
1 U2 R1 Rl 
J U2 R1 Rl 
4 UZ R1 Rl 
5 U2 R1 ., 
7 U2 R1 Rl 

• U2 R1 Rl 

' U2 Rl Rl 
10 U2 R1 Rl 
11 U2 R1 Rl 
12 U2 R1 Rl 
13 U2 R1 Rl 

" U2 R1 Rl 
17 U1 U2 Ul R1 R2 Rl 
18 U1 U2 UJ R1 R2 RJ 

e s 1 S A P 2 o o o f'INJTE ELEMtNT ANALYSlS OF STRUCTURES PAGE 5 
PROGRAM:SAP2000/FILE:\Misdoeumento.!l\cur.!lo.!lap2000\ejemplo7.tKO 

MA1tRIAL P R O P E R T Y O A T A 
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H>\T 
Ll\BEI. 

ST&&L 
eONe 

ACERO 
COt-ICRtTO 

e S I 

NUMBER 
TEMPS 

WEIGHT PER 
UNIT VOL 

0.7833&+01 
0.2403& .. 01 
0.2403&+01 
0.78JJt•Ol 

HP.SS PER 
UNIT VOL 

0.1981t+OO 
0.2UIH:+OO 
0.2UBE+OO 
o. 7981&+00 

DtsiGN 
COOE 

S 
e 
N 
N 

S 11. P O O O FJNITE &LE:ME:NT ANAL'fSIS OF STRUCTUPJ:S PAGt 6 
PROGRAH: SAP2000/F'ILE: \H.l sdocu=~entos\cur sosap2000\ejfll!lplo7. EKO 

T E M P E R A T U R E DEPENDEN! DATA 

W.TERJAL PROPERTIES 

MAT 
LABI:L ''"' MOOIJLUS OF ELASTICUY 

El E2 EJ 
SHE:.AR HOOVLII 

G12 Gll G2J 

ACERO 0.00 0.200&+08 0.200&+08 0.200&+08 0.769&+07 0.769&+07 0.769&+07 

CONCRETO 0.00 0.190t+07 0.180E+07 O.l80E+07 0.720&+06 0.720&+06 0.720&+06 

C S 1 S A P 2 O O O riNI'l'E ELE:MtNT A.NALYSIS OF STRUCTURES PAGt 7 
PROGRAM:SAP2000/FILE:\Mi~docu~entos\cursosap2000\ej.-plo7.tKO 

T E M P E R A T U R E O E P E N O E N T O A T A 

THERMAL EXPANSION COEFFICIENTS 

MAT 
Ll\BEI. 

STEtL 

eONe 

ACERO 

CONCRETO 

e S I 

TEMP COEFFICIENTS OF THERMAL EXPANSION 
Al A2 A3 Al2 Al3 A23 

0.00 0.117E-04 O.ll7E-04 O.ll7E-04 O.OOOE+OO 0.000[+00 O.OOOE+OO 

0.00 0.990E-OS 0.990E-OS 0.990E-OS O.OOOE+OO O.OOOE+OO O.OOOE+OO 

0.00 0.990E-OS 0.990[-05 0.990E-05 0.000[+00 O.OOOE+OO O.OOOE+OO 

0.00 0.117[•04 0.117E·04 O.ll?t•04 0.000[+00 O.OOOE+OO O.OOOE+OO 

S A P 2 O O O flNITE ELtMENT A.NA.LYSIS or STRUCTURES PAGE 
PROGRAM: SAP2000/ fiLE: \Mi 3dOCUfllento.!l \CYUO.!Illp2000\ejelllplo7, EKO 

T E M P E R A T U R E DEPENDENI DATA 

MATERIAL PROPERIIES 

MIIT 
Ll\BEI. 

TtMP POISSONS RATIO 
Ul2 U13 U23 Ul4 U24 U34 Ul5 U25 U35 U45 Ul6 U26 U36 U46 056 

STEEL 0.00 0.3 O.J O.J O. O 0.0 0.0 O. O O. O O. O 0.0 0.0 0.0 0,0 O. O 0.0 

CONC 0.00 0.2 0.2 0.2 0.0 O. O 0.0 0.0 O. O O. O O. O 0.0 0.0 O. O O. O 0.0 

ACERO 0.00 0.3 O.J O.J 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

CONCRETO 0.00 O.J 0.3 O,J O. O 0.0 0.0 O. O 0.0 0.0 O. O O. O 0.0 0.0 0.0 0.0 

C S 1 S A P 2 O O O FINITE t.LEMWT A.NA.LYSIS OF STRUCTIJR!S PAGE 9 
PROGRAH: SAP2000/fiLE: \Mi3doeu~ento.s\eur.soup2000\ejemplo7. EKO 

MATERIAl. PROPERTIES 

""' Ll\BtL 

eONe 

TEMP 

0.00 

YltLD 
fY 

36.00 

C S S A P 2 O O O riNITE ELEMWT A.NALYSIS Of STRUCTURE:S PAGE 10 
PROGRAM: SAP2000/ fiLE: \Mhdoeumento.!l \eur .!IO.!Iap2000\ejelllplo7. EKO 

r R A M E S E C T I O N PROPERTY O A T A P R I S M A T I C 

SECTION 
LABEL 

FSECl 
rstcz 
FSE:CJ 

C S I 

S HA PE: 
TYPE: 

' G 

' 

DEPTH n.ANGE 

0.500 

o. 500 

WIDTH 
TOP 

o. 300 

o.soo 

n.ANGE WEB 
THTCK TH!CK 

TOP 

!l.ANGt 
WIDTH 

BOTTOM 

f"LANGt 
THICK 

BOTTOM 

S A P 2 O O O riNITE ELEMENT A.NAl.YSIS OF STRUCTURE:S PAGE 11 
PROGRAH:SAP2000/FILE:\MJ..!IdOCu!llentoa\eur.!loaap2000\ej~plo7.EKO 

r R A M E S E C T I O N P R O P E R T Y D A T A RISMATJC 

SECTION 
LABEI. 

FSECl 

AXIAL TORSIONAL 
AREA CONSTAN! 

MOMENTS OF lNERTIA 
I 33 122 

SHEAR ARt.AS 
A2 A3 

0.150E+OO 0.282E-02 O.JlJE-02 O.ll3E-02 0.125E+OO O.l25E+OO 
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rstc2 o.soor~o2 O.OOOE+OO O.OOOt+OO 0.000t+00 O.OOOt+OO O.OOOt+OO 
rstcJ 0.250t+OO 0.880E-02 o. 521t-02 0.52lt~02 0.208t+OO 0.208E+OO 

~~ e S ¡ SAP200 o riN!TE E!.Dofr:N! ANA.LYSIS or S!RUCTURES PAGE l2 
PROGRAH: SAP2000/ril.E: \M11documentoll\curl!o.3ap2000\ejl'lllplo7. EJ(Q 

F RAM ' S < e T I O N PROPtR ,., O A T A PRISMATIC 

SECl'ION MAT AOOI!IONAl AOOI!IONAl 
LA!l<I. LAB<L MASS PtR wtiGH! PtR 

LtNGTH LtNGTH 

r5l:Cl STtEL O.OOOt+OO O.OOOE+OO 
rse:c2 ACERO O.OOOt+OO O.OOOE+OO 
FSEC3CONCRETO O.OOOt+OO O.OOOE+OO 

e S ¡ S A P 2 o o o rlNITE ELEMtNT ANALYSIS Or STRUCTUR&S PAGE l3 
PRCXiRAM: SAP2000/Fil.E: \M1.3docu~entol!\curl!o.3ap2000\ejemplo7.EJ(0 

F RAM ' < L E M E N T O A T A 

ELt:MtNT JOINT JOINT El.EMENT tND-OFrSET-LtNGTHS RIGID-END NUMBER Of 
LAS EL END-1 !:ND-J LENGTH END-1 END-J FACTOR StQo!ENTS 

2 J 4 4.500 o.ooo 0.000 0.0000 
l2 l 7 3.000 o.ooo 0.000 0.0000 
l3 7 ' 3.000 0.000 0.000 0.0000 4 
l4 ' J J.ooo 0.000 o.ooo 0.0000 • 
l5 J 9 J. 000 o.ooo o.ooo 0.0000 4 
l6 ' lO J. 000 o.ooo o.ooo 0.0000 • 
17 10 5 J.OOO o. 000 0.000 0.0000 • 
" ll 3. 354 0.000 0.000 0.0000 2 
l9 ll " J.354 0.000 o.ooo 0.0000 2 
20 l2 4 J. 354 o.ooo 0.000 0.0000 2 
2l 5 l3 J. 35~ 0.000 0.000 0.0000 2 
22 l3 l4 3. 354 0.000 o.ooo 0.0000 ' " l4 4 3. 354 o.ooo 0.000 o.oooo ' 24 7 ll 1.500 o.ooo 0.000 0.0000 ' " ll ' 3. 354 0.000 0.000 o. 0000 ' 26 ' l2 3.000 o.ooo o.ooo 0.0000 2 ,, 12 J ~. 243 0.000 0.000 0.0000 2 

" J 14 4. 243 0.000 0.000 o.oooo 2 
29 " 9 3.000 o.ooc o. 000 o. 0000 ' JO 9 IJ J. 354 o. 000 o.ooo 0.0000 
ll lO IJ l. 500 o. 000 o.ooo o. 0000 
3J 17 l 6.000 0.000 0.000 o.oooo 

" " 5 6.000 0.000 0.000 0.0000 

e s 1 S A o o o FINITE ELEMENT ANALYSIS Of STRUCTUIU:S PAGE l4 
PROGRAM:SAP2000/FILE:\M1sdocumentoll\cur3ol!ap2000\ejemplo7.EKO 

F R A M ' E L E M E N T O ATA 

ELEMENT StCilON LOCA!. COORO PLN PLN PLAN< PLAN E COOR.O 
LAS EL LABtL PLAN< SYSTI:H lST 2NO JOINTA JO!NTI'! ANGLE 

2 fStC2 12 o ., •X o o o.oo 
l2 rstc2 12 o ., •X o o o.oo 
13 FSEC2 l2 o ., •X o o 0.00 
l4 rstcz l2 o ., •X o o 0.00 
15 fSI:C2 l2 o ., •X o o 0.00 
l6 FSEC2 l2 o ., •X o o 0.00 
17 FSEC2 l2 o ., •X o o 0.00 
18 FSEC2 l2 o " •X o o 0.00 
19 FSEC2 l2 o •2 •X o o 0.00 
20 FSEC2 12 o •Z •x o o 0.00 
2l FSEC2 l2 o ., •x o o 0.00 
22 FSEC2 l2 o •Z •X o o 0.00 

" rse:cz l2 o ., ., o o 0.00 

" FStC2 l2 o •Z ., o o 0.00 
25 FSEC2 l2 o ., •X o o 0.00 

" rsr:c2 l2 o ., •X o o 0.00 
27 rstcz l2 o ., •X o o 0.00 

" FSEC2 l2 o ., •X o o 0.00 

" FSEC2 l2 o ., •X o o 0.00 
JO FSEC2 l2 o ., •X o o 0.00 
Jl rstc2 l2 o ., •X o o o.oo 
JJ FSE:C) l2 o •Z •X o o 0.00 
J4 rstcJ ;¡ o •l ., o o 0.00 

e s 1 S A P l o o o flNtTE tLtMENT ANIU.YSIS OF STRUCTURES P.».GE 15 
PR<XiRAM: SAP2000/ rt LE: \Mi tdoeurnento~\cur liOllsp2000\•jempl o7. EKO 

F R A H ' t ' < M < N T O ATA 

ELtHENT tND-I RtLEASE COOES END-J IU:LEASE COOts 
LABEL 

' " " l2 " " IJ RJ RJ 
14 RJ " 15 RJ " " RJ RJ 
17 RJ RJ 

15:::! 



.. •• 
10 
10 
20 
21 
22 
23 
24 

" 26 
21 

" " JO 
31 

., ., ., ., ., 
R3 
R3 
R3 
R3 
R.) 

R3 
R3 
R3 
R3 

R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 
R3 

C S I S A P 2 O O O FINlit tLt:M:EN! ANALYSIS Of STRUCTURES PAGt 16 
PR.~R.AM: SAP2000/ nLt: \Mi sdoeu"'entos\eur .!losap2000\• jemplo7. tr<O 

t o r A L 

SECTION 
LABEL 

rstc2 
FStCJ 

TOTAL 

H E I G H T S A N O M A S S t S 

WEIGHT 

0.8027 
23.5002 

24.3029 

MASS 

0.0818 
2.3943 

2.4761 

C S I S A P 2 O O O F'INITt E:Lo-!ENT ANALYSIS OF STRUCTUIU:S PAGE 17 
PROGP.AM: SAP2000/FI LE: \M.i sdocumentoa\eur5onp2000\ej emplo7, EKO 

L O A O e o N D 1 T 1 O N VER! 

StLF-wtiGHT MULTIPLIER FOR ENTIRE STRUCTUR.E - O. OOOOt•OO 

JOINT FORCts IN LOCAL COORDINA TES 

JOINT FORCE FORCE FORCE Ha-!E:NT MCMENT H<l1ENT 
LABtL 1 2 3 1 2 3 

' 0.000[•00 O.OOOE•OO -o. J()Ot•C1 O.OOOE•OO O.OOOE•OO o.ooot•Oo 
11 O.OOOE•OO 0.000[•00 -0. JOOE:•Ol O.OOOE•OO o.ooot•oo o.ooot•oo 
12 O.OOOE•OO O.OOOE•OO -0.300[>•01 O, OOOE•OO O.OOOE+OO O.OOOt•OO 
l3 O.OOOE+OO O.OOOE•OO -O.JOOE•Ol O.OOOE+OO O.OOOE•OO O.OOOE•OO 
l4 O.OOOE+OO O.OOOE+OO -O.JOOE+Ol O.OOOE•OO O.OOOE•OO O.OOOE•OO 

C S I S A P 2 O O O riNITE ELtMENT ANALYSIS Or STRUCTVRtS PAGE 18 
PROGRAM: SAP2000/FI L. E: \M.hdocumentos \cursosop2000\ejemplo7, EKO 

OUTPUT S t r. t e T I O N 

DISPLACtMtNTS AT JOINTS 

L.OAD MODES SPEC HlST 
L>JI<C LABEL LABE:L. 

VER! 

APPLIED ANO INTE:RNAL LOADS AT JOINTS 

LOAD MOOES SPtC 
LABEL LABEL 

Vl:Rl 

INTERNA!. FORCES AT tL.tMENT FRAME 

LOAD MODES 
LABEL 

VER! 

JOINT roRCts AT tLD«.NT 

LOAD 
LABEL 

VER! 

MOOts 

SPtC 
LABEL 

FRAME 

SPEC 
LAS EL 

HIST 
LABEL 

HIST 
LABEL 

HIST 
LABEL 

MOVE 
LABE:L. 

HOVE 
LABEL 

HOVE 
LABEL 

HOVE 
LAS EL 

COMB 
L.ABE:L 

C<><ll 
LABEL 

COMe 
LABEL 

COMB 
LAB<C 

e S I S A P O 0 O riNITt ELD-IENT AN.B.LYSIS Of STRUCT1.JRI:S P.z<Gt 19 
PROGRAM: SAP2000/FIL.E:: \Mi !ldocumento.,\cunosop2000\ejernplo7. tKO 

1 N P U T C O M P L E: T E 

. ~.-
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PROGRAM SAP2000 - VERSION E6.10 
EDUCATIONAL VERSION - COMMERCIAL USE PROHIBITEO 

B E G l N A N A L Y S I S P H A S E 

MEMORY AVAILABLE FOR DATA {BYTES) 

J O I N T ELEMENT F O R M A T I O N 

NUMBER OF JOINT ELEMENTS FORMED 

NUMBER OF SPRING ELEMENTS FORMED 

F R A M E ELEMENT F O R M A T I O N 

NUMBER OF FRAME ELEMENTS FORMED 

E Q U A T I O N SOLUTION 

TOTAL NUMBER OF EQUILIBRIUM EQUATIONS 
APPROXIMATE "EFFECTIVE" BAND WIDTH 

NUMBER OF EQUATION STORAGE BLOCKS 
~IMUM BLOCK SIZE (NUHBER OF TERMS) 
SIZE OF STIFFNESS FILE {BYTES) 

NUMBER OF EQUATIONS TO SOLVE 
NUMBER OF STATIC LOAD CASES 
NUMBER OF ACCELERATION LOADS 
NUMBER OF NONLINEAR DEFORMATION LOADS 

J O I N T O U T P U T 

1000000 

5 
o 

23 

26 
4 

1 
116 

1048 

26 
1 
3 
o 

GLOBAL F O R C E BALANCE R E L A T 1 V E 

FILE:EJEMPLO?.LOG 

2000/03/18 15:10:46 

15:10:46 

15:10:46 

15:10:47 

15:10:48 

ERRORS 

PERCENT FORCE ANO MOMENT ERROR AT THE ORIGIN, IN GLOBAL COORDINATES 

LOAD 
VERT 

FJ( 

3.51E-14 
FY 

.000000 
FZ 

l. 66E-13 
MX 

.000000 

E L E M E N T J O I N T - F O R C E O U T P U T 

NUMBER OF FRAME ELEMENTS SAVED 

F RAM E ELEMENT O U T P U T 

NUMBER OF FRAME ELEMENTS SAVED 
NUMBER OF FRAME ELEMENTS PRINTED 

ANALYSIS COMPLETE 

23 

23 
23 

MY 
6.77E-14 

MZ 
.000000 

15:10:48 

15:10:49 

2000/03/18 15:10:49 



S A P 2 O O O (R) 

Structural Anoly~i~ Program~ 

Venion E6.10 

Copyright (C) 1976-1997 
COMPUTERS ANO STRUCTURES, INC. 

IU.l rJ.qht~ re~erved 

Th~~ copy o! SAP2000 1~ for the exelu~lve u~e of 

THE: LICENSEE 

Unauthorlzed u~e is 1n violotlon of federal eopyriqht lawa 

It la the reaponsibility of the user to ver1fy all 
results produeed by thi:~ proqrllln 

lB Mar 2000 15:10:46 

PROGRAM SAPZOOO- vt:RSJON E6.10 
EOUCATIONAL VERSION COMME:RCIAL USE PROHIBITED 

FlLE:EJEMPL07.0UT 
PAGE 

1 
O J S P LA e E: M E N T OEGREE: S o r FREE:OOM 

!Al Act1ve oor. equilibrium equatlon ,_, 
Re~troined DOf, reaction eomputed ,., Constrained DOf 

1 1 Null oor 

JOINTS UJ( VY uz RX ., RZ 
1 A A A 
3 TO A A 
5 A A A 
7 TO 14 A ' 17 TO 18 

PROGRAM SAP2000 - VERSION E6.10 
EOUC.A.TIONAL VtRSION COMHERCIAL USE PROHIBITEO 

J O I N T O I S P L A C E M E N T S 

TRANSLATIONS ANO ROTATIONS, IN GLOB11.L COORDINATES 

LOAD vtRT ------------------
JOINT UJ( uz RY 

1 -0.001245 -0.000100 -0.000310 
3 -3. 99E-17 -0.005880 .000000 

• -4.17E-1"1 -0.005610 .000000 
5 0.001245 -0.000100 0.000310 
7 -0.000800 -0.004571 .000000 

' -0.000355 -0.005753 .000000 
9 0.000355 -0.005753 .000000 

10 0.000800 -0.004571 .000000 
11 0.000361 -0.004571 .000000 
12 0.000426 -o. oo5708 • 000000 
13 -0.000361 -0.004571 .oooooo 
1< -o.oo0426 -o. oo5709 • 000000 
¡7 .000000 • 000000 .00000') 
18 .000000 ,000000 . 000000 

PROG~ SAP2000- VERStON E:6.10 
EDUC1<.TIONAL VERSlON COMMtRClAL USE PROHIBlTED 

A P P L I E O L O A O S 

rDRCES ANO Ma-tENTS ACTING ON JOINTS, IN GLOBAL COOROINATES 

LOAD VERT ------------------

JOINT 

• 
11 
12 
13 
14 

rx 
.000000 
.000000 
• 000000 
.000000 
.000000 

rz 
-J.OOOOOO 
-J.OOOOOO 
-3.000000 
-3.000000 
-3.000000 

PROGRAH SAP2000- VERSlON &6.10 

MY 
. 000000 
. 000000 
. 000000 
• 000000 
. 000000 

EOUCATIONAL VERSION COHMtRCIAL USE PROHIBITED 

GLOBAL r o R e t B A L A N C t 

TOTAL FORCE ANO MOMENT AT THE ORIGIN, IN GLOBAL COORDINATES 

LOAD VERi ------------------

APPLIEO 
Rf:ACTNS 

TOTAL 

Fll 
.000000 

1.05E-14 

l.05E-14 

FY 
.000000 
.000000 

.000000 

PROGRAM SAP2000 - VERSION E6.10 

rz 
-15.000000 

15.000000 

-4.97E-14 

MX 
• 000000 
• 000000 

.000000 

FILE:EJtMPL07.0U! 

"'"' , 

riLE: E:JEMPL07 . OU'!' 
PAGE 

3 

fiLE:EJEHPLO?.OVT 
PAGt 

• 

MY 
.000000 

l.04E-13 

l.04E-13 

"' .oooooo 
.000000 

.000000 

FILE:EJEHPLO?.OUT 

., -~~ 
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E:OUCATIONAL VERSION COMMtRCIAL USE PROHIBJTEO PAGE 

' F RAM E E:LE:MtNT J O I N T r o R e E S 

FORCES ANO HOMtNTS ACTING ON ELEHENTS, IN GLOBAL COOROINA't'ES 

ELEM -----------
LOAD VERT ------------------

JOINT "' FY rz MX MY HZ 
J .000000 .000000 -6.000000 .000000 .000000 .000000 

• .000000 .000000 6.000000 .ooooco .000000 .000000 

ELEM " ------------------
LOAD VERT ------------------

JOINT rx !"( rz MX MY HZ 
1 -14.838668 .000000 .000000 .000000 .000000 .000000 
7 14.838668 .000000 .000000 .000000 .000000 • 000000 

ELEM lJ -----------------
LOAD VERT ------------------

JOIN'I: "' !"( rz MX MY HZ 
7 -14.838668 .000000 .000000 .000000 .000000 .000000 

' 14.838668 .000000 .000000 .000000 .000000 .000000 

EL O< " ---------·----
LOAD VERT ------------------

JOINT rx !"( rz MX MY HZ 

' -11.838668 .000000 .000000 .000000 .000000 .000000 
J 11.838668 .000000 .000000 .000000 .000000 .000000 

EL O< " 
.............. _________ 

LOAD VERT ------------------
JOINT rx !"( rz HX HY HZ 

J -11.838668 .000000 .000000 .000000 .000000 .000000 

' 11.838668 .000000 .000000 .000000 .000000 .000000 

EL O< 16 ..................................... 

LOAD VtRT ------------------
JOINT rx rY rz HX HY HZ 

' -14.838668 .000000 .000000 .000000 .000000 .000000 
10 14.838668 .000000 .000000 .000000 .000000 .000000 

PROGRA.M SAP2000 - VERSION t6.10 FILE: EJEMPLO? .OUT 
EOUCATIONAL VERSION C<HiERCIAL USE PROHIBITEO PAGE 

• F RAM t E L E M E N T J O I N T r o R C E S 

FORCES ANO MOMENTS ACTING ON ELE:ME:NTS, IN GLOB.A.l. COORDINA.TES 

EL O< )7 .................................... 

LOAD VERT ------------------
JOINT "' !"( rz "" HY MZ 

10 -14.838668 .000000 .000000 .000000 .000000 .000000 

' 14.838668 .000000 .000000 .000000 .000000 .000000 

ELEM lS -----------------
LOAD VERT ------------------

JOINT rx rY rz "" "' MZ 
1 1!>.000000 .000000 I.!>OGCOO .onoooo . oooooc .000000 

11 ·l!>.OOOOOO .000000 -1.500000 .oooooo .000000 .000000 

ELEH 19 ------------·----
LOAD VERT ------------------

JO HIT rx rY rz "" MY MZ 
11 12.000000 .000000 6' 000000 .000000 . 000000 . 000000 

" -12.000000 .000000 -6.0!JOCOO .000000 . 000000 • 000000 

ELEH 20 ----------~-------
LOA. O VERT ------------------

JOINT rx rY rz HX MY MZ 

" 9.000000 .000000 4.500000 .000000 .000000 .000000 

• -9.000000 .000000 -4.500000 .000000 .000000 .000000 

ELEH 21 -----------
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LOAD VER! ------------------

• JOINT "' " rz HX "' HZ 

' -15.000000 .000000 7.500000 .000000 .000000 .000000 
13 15.000000 .000000 -7.500000 .000000 .000000 .000000 

tLI>I 22 ------------------
LOAD vtRT ------------------

JOINT rx " rz HX HY MZ 
13 -12.000000 .000000 6.000000 . 000000 .000000 .cooooo 
14 12.000000 .000000 -6.000000 • 000000 .000000 .000000 

PROGRAH SAP2000- VERSION E6.10 FILElEJ&HPL07.0UT 
EDUCA'UONAL VERSION - Ca+IERCIAL USE PROHIBITEO PAGE 

7 
F RAM E E L E M E N T JO I N T r o R e t S 

J'ORCES ANO MOMENTS ACTING DN ELE.MENTS, IN GLOB~ COOROINATES 

tLtM 2J ------------------
L.OAD VER! ------------------

JOINT rx " rz HX HY MZ 
14 -9.000000 • 000000 4.500000 • 000000 .000000 .000000 

4 9.000000 .000000 . -4.500000 .000000 .000000 .000000 

tLtM 24 ------------------
LOAD vtRT ------------------

JO!NT FX FY rz "" "' MZ 
.000000 • 000000 5.55E·P . 000000 .000000 .000000 

ll .000000 .000000 ~5.55E:-l1 .000000 .000000 .000000 

tLtM " ------------------
LDI\0 VER! ------------------

JOIN! rx " FZ HX HY MZ 
11 3.000000 .000000 -1.500000 .oooooo .000000 • 000000 

' -3.000000 .000000 1.500000 • 000000 .000000 .000000 
,,. 

tLI>I 26 ------------------
LOAD VERT -------~ ·~---·----

JOINT FX " FZ "" "' "' ' .000000 .000000 -~.500000 .000000 .000000 .000000 
l2 .000000 .000000 l. 500000 .000000 .000000 .000000 

tLtM 27 ------------------
LOAD VERT ------------------

, 
JO HIT rx " rz "" MY MZ 

l2 3.000000 • 000000 ~3.000000 '000000 • 000000 .000000 
J -3.000000 • 000000 3.000000 • 000000 .000000 .000000 

tLtM " ------------------
LOAD vtRT ------------------

JOINT "' FY FZ MX "' MZ 
J 3.000000 .000000 3.000000 .000000 .oooooo .000000 

14 -3.000000 .000000 -3.000000 .000000 .000000 .000000 

PROGRAH SAP2000 - vtRSION E6.10 FILE: EJEMPLO?. OUT 
EOVCATIONAL VERSION - COMMERCIAL USt PROHISITED PAGE 

' f RAM E E L E M E N T JO I N T r o R e t S 

fORCES .'.NO MCMEN!S ACTING DN ELEMENTS, IN GLOBAL COOROINATES 

tLtM 29 ------------------
LOAD VERT ------------------

JOINT "' " FZ "" "' HZ 
14 .000000 .000000 1.!>00000 . 000000 .000000 .000000 

' .000000 .OOOMO ·1.50000i'l . 000000 '000000 .oooooo 

ELtM JO ------------------
LOAD vtRT -·------- ··--·----

JOINT rx FY rz MX "' MZ 
9 ).000000 .000000 l. 500000 .000000 .000000 .000000 

1J -3.000000 .000000 -1.500000 .000000 .000000 .000000 

tLtM 3l ----------------
LOAD vtRT ·-·-------·-------
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JOINT FX F"t rz HX "' HZ , 10 .000000 .000000 ~3.89E~15 .000000 .000000 .000000 
13 .000000 .000000 3.89[•15 .000000 .000000 .000000 

ELEH 33 ------------·----
LOAD Vl:RT ·············-----

JOINT FX F"t rz HX "' HZ 
17 0.161332 .000000 i. 500000 .000000 0.967990 • 000000 

1 -0.161332 .000000 -i. 500000 .000000 ·i. 55E-1i .000000 

I:LEH 34 -·-------
LOAD Vl:RT -~----------------

JOINT FX F"t rz HX "' HZ 
10 -0.161332 .000000 7.500000 .000000 ·0.96i990 .000000 

' 0.161332 .000000 -7.500000 .000000 -2.14E•P .000000 

PROGRAM SAP2000- VE:R.SION E6.10 riLE: t.n:MPL07 .OUT 
EOUCATIONAL VER.SlON Ccx+IERCIAL USE PROHIBITED PAGE 

9 
F RAM E E L E M E N T INTERNAL r oRe E S 

I:LEH -------- LENGTH "' 4.500000 

LOAD VERT ------------------
REL OIST p V2 V) T H2 H) 
o .00000 6.000000 .000000 .000000 .000000 .000000 .000000 
0.50000 6.000000 .000000 .000000 .000000 .000000 .000000 
1.00000 6.000000 .000000 .000000 .000000 .000000 • 000000 

ELEH 12 
---~------------

LOIGTH • 3.000000 

LOAD VERT ------------------
RtL OIST p V2 VJ T H2 HJ 
0.00000 14.838666 .000000 • 000000 .000000 .oooooo .000000 
0.25000 14.83fi6M .000000 .000000 .000000 .000000 .000000 
o. 50000 14.1338669 .000000 .000000 .000000 .000000 .000000 
0.75000 H.S39H8 .ooocoo .000000 .000000 .000000 .oooooo 
1. 00000 14.9396~9 .000000 .oocooo .0('0000 .000000 .000000 

El.r.M 13 ------------------ LENGTH • 3.000000 

LOAD Vl:RT ------------------
REL OIST ' V2 VJ T H2 HJ 
0.00000 14.838666 .000000 .000000 .000000 .000000 .000000 
0.25000 14.638666 .000000 .000000 .000000 .000000 .000000 
0.50000 14.!138668 .000000 .oooooo .oooooo .000000 .000000 
o. '75000 U.938668 .000000 .000000 .cooooo .000000 .000000 
1.00000 14.8386613 .000000 .000000 .000000 .000000 • 000000 

ELEH " ------------------ LENGTH • J. 000000 

LOAD Vl:RT ---~~--~----------

REL OIST p V2 VJ 7 H2 H3 
0.00000 11.638668 .000000 .000000 .000000 .000000 .000000 
0.25000 u. 838668 .000000 .000000 .000000 .000000 • 000000 
0.50000 11.838668 .000000 .000000 .000000 .000000 • 000000 
0.75000 11.838668 .000000 .000000 .000000 .000000 .000000 
1.00000 lt.838668 .000000 .000000 .000000 .000000 • 000000 

"'" lS 
~--·--------------

LE:NGTH • J. 000000 

LOAD Vl:RT ------------------
REL DIST p V2 VJ T H2 H3 
0.00000 11.838668 .000000 .000000 .oooooo .000000 .000000 
0.25000 11.638668 .000000 .000000 .000000 .000000 .000000 
0.50000 11.638668 .oooooo .000000 .000000 .000000 .000000 
0.75000 11.838668 .000000 .000000 .000000 .000000 .oooooo 
1.00000 11.838668 .000000 .000000 .000000 .000000 .000000 

PROGRAH SAP20CO - VtRSION E6. !O fiLE: tJEMPLOI.OUT 
tDUCAT:ONAL VERSION COI+!t~C!AL USt PROHlBITtD PAG~ 

¡o 
r R A M ' t L E: M t N : l N T t ~ N A ' O R :::: E S 

ELEH " ····----------·--- LENGTH • 3.000000 

LOAD VERT ------------------
RtL OIST p V2 VJ T H2 H3 
0.00000 14.638666 .000000 • 000000 .000000 .000000 .000000 
0.25000 14.838668 .000000 .oooooo .000000 .000000 .000000 
o. 50000 14.838668 .000000 .000000 .000000 .000000 .000000 
0.75000 l4.liJB6E9 .ooooco .000000 .000000 .000000 .000000 
l. 00000 14.838669 ,000000 .000000 .oooooc .000000 .000000 

l5J 



ELE>< 17 ---------- LENG'I'H • 3.000000 ,_) LOI\D vt:RT ------------------
RE:L DIST p V1 V3 ' Ml M3 
o.ooooc u. iD966e .000000 .ocoooc .ooooco . 000000 .000000 
0.2SDOO 14.839668 .0000:10 .00000:: .000000 .oooooo .oooooo 
0.50000 14, SJ8669 .oooooc .000000 .000000 .oooooo .000000 
o. 75000 14.838668 . 000000 .000000 .000000 .000000 .000000 
1.00000 14.838668 • 000000 .000000 .000000 .000000 .000000 

ELE>< lB 

___ __. ___________ 
LENGTH • 3.354102 

LOAD vt:RT ------------------
RtL DlS'I p V2 V) T 112 M3 
0.00000 -16.770510 .000000 .000000 . 000000 .000000 .000000 
0.50000 -16.710510 .000000 .000000 .000000 .000000 .oooooo 
1.00000 •16.110510 .oooooo .oooooo .ooooco .000000 .000000 

E:LE:M 19 ----------------- LtNGTH • 3.354102 

LOI\D vt:RT ------------------
RE:L OIST p V2 V3 T 112 M) 
0.00000 -13.416406 .000000 .000000 .000000 .000000 .000000 
0.50000 •13.416406 .000000 .000000 • 000000 .000000 .000000 
1.00000 ·13.416408 .000000 .000000 .000000 .000000 .000000 

ELE>< 20 -.---------------- LENGTH • 3.354102 

LOII.D VERT ------------·-----
REL OIST p V2 V) I 112 M3 
o.ooooo -10.062306 .000000 .000000 • 000000 .000000 .000000 
o.soooo -10.062306 .000000 .000000 .000000 .000000 .oooooo 
1.00000 -10.062306 .oooooo .000000 • 000000 ,000000 .000000 

PROGRAM SAP2000- VERSION E6.10 FILE: EJEMPLO? .OVT 
EDUCATIONAL VERSION COMMERCIAL USE PROHIBITEO PAGE 

11 
r • A M E E l. t. M E N '!" 1 N T E 11 N A L r o A e E S 

ELEM 11 ------------------ LENGTH " 3.~54102 

LOII.O vt:RT --·---------------
REL DIST p V2 V) I 112 M3 
o.ooooo -16.'7'70510 • 000000 .oooooo .oooooo .000000 .000000 
0.50000 -16.7?0510 .oooooo .000000 .000000 .000000 .000000 
1.00000 -16. 7?0510 .000000 .000000 .000000 .000000 .000000 

ELE>< 22 ------------------ LENGTH • 3.35H02 

LOII.D Vt.RT ------------------
REL DIST p Vi V3 112 M3 
o. 00000 -;.3.416408 • 000000 .000000 .000000 .000000 .000000 
0.50000 -13.416406 • 000000 .000000 . 000000 .000000 .000000 
1.00000 ·13. 416408 .000000 .000000 .oooooo .000000 .000000 

ELE>< 23 ------------------ LENGTH • 3.354102 

LOAD VERT ------------------
Rt.L 0!51' p V2 V) T Ml M3 
o. 00000 ·10. Oti2 306 .000000 .000000 .00\100~ .000000 .oooooo 
o. 50000 -i0.062306 .000000 .COOJOO .000000 .000000 .oooooo 
1.00000 ·1C.062306 .000000 .COOOO:J .ocoooo .000000 .000000 

ELtM " ------------------ Lt.NG!H • 1.500000 

LOI\D VERT ·---------·-------
REL OIST p V2 V) T 112 M3 
0.00000 •5.55E-17 .000000 .000000 .000000 .000000 .000000 
0.50000 -5.55E·l? .000000 .000000 .000000 .000000 .000000 
1.00000 -5. 55E-l? .000000 .000000 .000000 .000000 .000000 

ELE>< " --~-------·----·-- LENGTH • 3.35H02 

LOAD VEAT ------------------
Rt.L OIST p V2 VJ 112 MJ 
0.00000 -3.354102 .000000 .000000 .000000 .000000 .000000 
0.~0000 -).)54102 .000000 .000000 • 000000 .000000 .000000 
1.00000 -3.354102 .000000 .000000 .000000 .000000 .000000 

ELE>< 26 ------------------ LENGTH • 3.000000 

LOI\D VERI ------------------
REL OIST p V2 V3 T M2 M) 
0.00000 t. 500000 .000000 .oooooo • 000000 .000000 .000000 
0.50000 1.500000 .000000 • 000000 • 000000 .000000 .000000 
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1.00000 1.500000 .oooooc .000000 .000000 .000000 .000000 

PROGAAH SII.P2000 - vtRSTON E6..10 riLE: EJEMPL07. OVT • EOUCATlONA.L vtRSION CO+ft;¡CIA.L USf. N<0HTP:TED PAGE 
12 

f R A M E E L E M ' N T 1 N T E R N A ' ' o R e < S 

"'"' 27 ------------------ LENGTH • ~.2426H 

LOAD Vl:RT ------------------
REL DIST ' V2 VJ T M2 MJ 
0.00000 -~ .2426H .000000 .000000 .000000 ,000000 .000000 
0.50000 -4 .2~2641 .000000 .000000 .000000 .000000 .000000 
l. 00000 -~. 242641 .000000 .000000 .000000 ,000000 .00000() 

"'"' " ------------------ LEN:;Tk • 4.24264: 

LOAD VERT ------------------
REL DIST ' vz VJ T M2 MJ 
o.ooooo -4.242641 .000000 .000000 .oooooo .000000 .000000 
0.50000 -4.242641 .000000 .000000 .000000 .000000 .oooooo 
1. 00000 -4.242641 .000000 .000000 .000000 .000000 .000000 

<L<M " ---·------------- LENGTH • 3.000000 

LOAD "'" ------------------
RE!.. OIST ' V2 VJ ' M2 MJ 
o. 00000 1.500000 .000000 .000000 .000000 .000000 .000000 
o. 50000 1.500000 .000000 .000000 .000000 .000000 .000000 
l. 00000 1.500000 .000000 .000000 .000000 .000000 .000000 

"'"' JO ---------------- LENGTH • J. 354102 

LOAD "'" ------------------
REL OIST ' V2 VJ T M2 Ml 
0.00000 -3.354102 .000000 .000000 .000000 .000000 .000000 
0.50000 -3.)54102 .000000 .000000 .000000 .oooooo .000000 
l. 00000 -3.354102 .000000 .000000 .000000 ,000000 .000000 

<LEM Jl .................................................. LENG!H • 1.500000 

LOAD "'" ------------------
REL DIST ' V2 VJ T M2 MJ 
0.00000 3.99E-15 .000000 .000000 .000000 .000000 .000000 
0.50000 3.89E-15 .000000 .000000 .000000 .000000 .000000 
l. 00000 3.99E-15 .000000 .000000 .000000 .000000 .000000 

ELE>' JJ ------------------ LENGTH • 6.000000 

LOAD VERT ------------------
REL OIST ' V2 VJ T M2 MJ 
o.ooooo -7.500000 -0.161332 .000000 .000000 .000000 -0.967990 
0.50000 -7.500000 -0.16133: .000000 .oooooo .000000 -0.483995 
1.00000 -7. 500000 -0.161332 .000000 .000000 .000000 4.441:-16 

PROGRAM SAP2000 - vtRSION E6.10 FILE E~PL01.0UT 
EDUCATIONAL VERSrON CCH-lERCIAL USE PROHiaiTED p,r..cE 

1 J 
f R A M E E L E M E N T : N T E ll: N A ' ' o ' e < S 

E!..EY. " ----···-----·--·-- LE~GT~ • ooo::-cc 

LOAO VERT ------------------
REL DIST ' V2 VJ T M2 MJ 
0.00000 -7.500000 0.161)32 .000000 .000000 .000000 o. 967990 
0.50000 -7.500000 0.161332 .000000 .000000 .000000 0.493995 
1.00000 -7.500000 0.161332 .000000 .000000 .000000 -l. 39E-16 
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¡ File c:\Hi:~ documento.s\cuno :.ap 2000\ejarr;plo8.:.2k :.aved J/19/00 15:01:06 in Ton-1!! 

SYSTEM 
OOF•UX,UY,UZ,RX,RY,RZ LENGT~ FORCE•Ton LINES•59 

JOINT 
2 X•-1.5 Y•.5 Z•J 
J X•-1.5 Y•2.5 Z•O 
4 X·-1.5 Y•2.5 Z•J 
6 X•1.5 Y•.5 Z•J 
7 X•1.5 Y•2.5 Z•O 
8 X•l.5 Y•2.5 Z•J 

RtSTRAINT 
ADP.J OOF•Ul,U2,UJ,R1,R2,RJ 
ADD-7 DOF-Ul,U2,UJ,Rl,R2,RJ 

MATERIA:. 
NAMt•STEEL IDES'"S M .... 198142 W•í.6JJHJ 

T•O E•2.038902E•07 u ... J A-.0000117 
NAME•CONC IOES•C M-.2446012 W•2.402616 

T•O E•25Jl051 U•.2 A•.0000099 
NAME•CONC250 IDES•C H-.244 W•2.4 

r-o E·221J51o u-.2 A•.ooooo99 

FRAME SECTI ON 
NAME•FSECl HP.T•STEEL SH .. f'. T•.5, .3 .11•.15 J•2.81?3'7JE-OJ I•.OOJ125, .001125 ,1,5•.125, ,125 
NAME•f'Sl MAT•CONC250 SH•R T•.5, .5 ••.25 J•6.602064E•OJ I•5.20!1JJJE•03,5.208J3JE-03 AS•.208333l, .2083333 

fRAHE 

' J•3. 4 SEC•f'Sl 

• Jw1, e SEC•FS1 

' J•2,6 SEC•FSl 
6 J•4, e SEC•FSl 

J•2. 4 SEC-FSl 
J-6, e SEC•FSl 

LOAD 
NAME•PESOP SW•1 
N-'HI:•vtRT 

TYPE•OISTRIBUTED 
ADD-5 RD-0, 1 
ADD-6 RD-0, l 
ADD-'7 RD-0, 1 
AOI)oo6 RDooO, 1 

NAME•SISMOY 
TYPE•FORCE 

AOI)oo4 UY-20 

NSEc;-2 
NSEG-2 
NSEG-4 
NSEG-4 
NSE.G-4 
NSEG-4 

SPAN 
uz--1,-1 
uz--1,-1 
UZ•-1,•1 
UZ•-1,-1 

ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 

OUTPUT 
rt.tt+-JOINT 
ELEM-JOINT 
ELE:M-JOINT 
ELE:M-JO!NT 
ELEM•f'RAMt 
EL EH- FlW'!t 
ELEM-f'AAME 
ELEH-f'RAME 

LOAD-PESOP 
LOAD-VERT 
LOAD-PESOP 
LOAD-VERT 

LOAD-PE:SOP 
LOAD-vtRT 

TYPE•DISP 
TYPE•DISP 
TYPE•APPL 
TYPE•APP:.. 
TYPE•f'ORCE 
TYPE•FORCE 
TYPE•JOINTF' 
TYPE•JOINTr 

END 

LO.IU:I-PE.SOP 
LO.I\0-vtRT 

1 The follow.ing data i.s not required for analy:~i:~. It 1:~ wr.itten here a.s a backup. 
1 Thi.s data will be u:~ed for graphic:~ and de:.iqn if th1:. file l3 1mported. 
1 lf chanqe:. are made to the analy31S data above, than the- !ollow1n9 data 

:~hould be ch•c'll'ed !or con.!li:~t<llney. 
¡ Ally errors in importinq the follo~oo~lnq d11ta are iqnored w!tho\Jt w11rning. 
SAP2000 V6.10 SUPP~tMf.NTAL DATA 

GRID GLOBAL X~¡~ -1.5 
GRID GLOBAL X ~2~ 1. 5 
GRID GLOBA!.. Y ~3• -2.5 
GRID GLOBAL Y •4• 2.5 
GRIO GLOBAL Z •5• O 
GRID GLOBAL Z •6• 3 
MATERIAL STEEL rY 25310.5 
MATERIAL CONC rYREBAR 42164.19 rYSHE.AR 28122.'78 re 2812.218 fCSHE.AR 2812.219 
MATERIAL CONC250 fYRtBAR 42 rYSHE.AR 21 FC 2.5 FCSHE.AR 2 
FRAMESECTTON FSl SAME RtC50X50 
CONCRtTESECT!OS RtC50X50 COLI..IHN CO'JtR .05 RE:BAfl RR-3-3 
STATICLOAD PE.SOP TYPE PE.AD 
STATICLOAD VE.RT TYPt LJVE 
ST,I,TICLOAD SJSMOY TYPE QUAKE. 

END SUPPLEMESTAL DATA 
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S A P 2 O O O 

Structural Analy~i~ Proqra111~ 

Veuion 6.10 

Copyright (CJ 1976-1991 
COHPUT~RS ANO STRUCTURES, INC. 

All riqht~ re~erved 

Thi~ copy o! SAP2000 1~ for the exclu~1ve use of 

TH~ LICENS~E 

Unauthorized u~e !a in v1olat1on of rederal copyr1qht law~ 

lt 1~ the n~pon~1b1llty ot the u1er to verHy •11 
re~ult~ produced by thi~ program 

19 Mar 2000 13:35:45 

e S I S A P 2 0 0 O rtNITE ELEMENT ANALYSIS Of STRUCTURES P.A.GE 
PROGRAM: SAP2000/ fiLE: \Hi~documento~\cur~oup2000\ej emplo6. EKO 

S Y S T E H O A T A 

STEADY STATE LOAD fREQUENCY 

LENGTH UNITS 
FORCE UNITS 

UP DIRECTIOI'I 

GLOBAL OEGREES Of fREEt:>ao': 

PAGIN.A.TION BY - - - - -
NIJMBER Of LINES PER PAGE 

O.OOOOt•OC 

M 
TON 

INCLUD~ WARNING MESSAGES IN OUTPUT FIL~ 

LINES 
59 

y 

e S I S A P 2 O O O f!NTTE ELE'"lEN7 ANA:..YSlS Of STRUCT'JRES PAGt 
PROGRAH: SAt' 10001 r: LE· \MI !ldoCu!l'ent O!!\ cur :oo:olllp]OOO\e llmlpl 06. EIW 

G E N E R A T E O J O I N T e O O R D N A T E S 

JOINT 
2 
3 

• 
6 
7 

' 

X 
-1.500 
-l. 500 
-l. 500 

1.500 
1.500 
l. 500 

y 

o. 500 
2.500 
2.500 
0.500 
2.500 
2. 500 

z 
J.OOO 
0.000 
J.OOO 
J.OOO 
0.000 
J.COO 

e S S A P 2 O O O r:N!H. E:..E~EN7 A.NA:..Ys:s Of ST?l.'CTURtS PAGE 

P A T 1 

PATTERN 
OEfAULT 

e S I 

R < S T 

JOINT 
3 
7 

e S I 

HA T < 

MAT 
LABEL 

STEEL 
eONe 

CONC2SO 

e S I 

' R N S 

JOINT 

S A P 2 

R A I N T 

R 

Ul 
Ul 

S A P 

I A L 

NIJMBER 
TE:MPS 

S A P 

PROGRAH: SAP2000/ fiLE: \Ml sdocumen to:o\cur sosap<:OOO\eJe"'pl o e, EY.C 

VALUE 

O O O FINITE ELEMENT ANALYSIS Of STRUCTURES PAG~ 

PROGRAM: SAP2000/ ri Lt: \Ml ~documento!!\ cuuosap2000\ej emplo6. EKO 

O A T A 

U2 
uz 

U3 
U3 

Rl 
Rl 

R2 
R2 " R3 

O 0 O fiNITt ELEMENT ANALYS!S Of S~RUCTURtS PAGE 5 
PROGRAH:SAP2000/riLE:\Hladocumento~\cur~osap2000\ajemplo6.EKO 

R O P E R T Y o A T A 

wt.IGHT "' HASS "' OESIGN 
UNlT VOL UNIT VOL COOE: 

O. 7S33E•Ol O. 7961E+OO S 
0.2403E+Ol 0.2H6E•OO e 
o. 2400~+01 0.2HOE•OO e 

o o o FINITE ELEME.NT ANALYSIS or STRUCTURts PAGE 
PROGRAH: SAP2000/ fl LE: \H.l ~doeumirnto~\cur ~o.up2000\ejemplo8, EKO 

1 E M P E R A T U R O E P E N O E N i O A 1 A 

MATERIAL PROPERTI ES 
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""'' LAB!:L 

STEEL 

TE:MP MOOULUS Of ELASTICl'I'Y 
El El E3 

SHEAR MOOULI l 
G12 Gl3 G2J 

0.00 0.20~[•08 0.204t•O~ 0.204E•O~ 0.784t•Oi 0.7B4E•07 C.784E•07 

CONC 0.00 0.25JE•ú7 0.25Jt•Oi 0.253t•Gi G. :OSE•Ol C.l05E•07 O.l05E+07 

CONC<?50 0.00 0.22H:+C7 O.Ul!:.+07 0.221t+07 0.922t+06 0.922E+06 0.922t+06 

C S I S A P 2 O O O r!N! TI: Et.E:MtNT ANAL'!SIS Of STRUCTVRES PAGE 
PRCGRAM: SAP2000/ FILE: \Misd.ocwnentos \cur sosap2000\eje~~~plo8. EKO 

T E M P E R A T U R t O E P E N D E N T O A T A 

THERMAL EXPANSION COEffiCIENTS 

MI\! TEMP COtfriC:ES'l'S or THERMAL t~PANSZON 
LABE:L Al A2 A3 A!2 Al) "'' 
STEEL 0.00 O,ll7t-04 O.ll7t-04 0.117t-04 O.OOOE+OO O.OOOE+OO O.OOOE+OO 

CONC 0.00 0.990t-05 0.990E-05 0.990t-05 O.OOOE+OO O.OOOE+OO O.OOOE+OO 

CONC250 0.00 0.990t-05 0.990t-05 0.990E-05 O.OOOE+OO O.OOOE+OO O.OOOE+OO 

e S 1 S A P 2 O 0 0 fiNITE ELEMENT AN'AL'fSIS Of S!RUCl'TJRES PAGE 
PROGRAM: So8.P2000/ fiLE: \MJ.sdoeumen tos \eursosiJip2000\ejltl!lploB. EKO 

T E M P E R A T U R E D E F E N D t N T D A T A 

MATERIAL PROFERTIES 

MAT 
LABtL 

STEEL 

CONC 

CONC250 

e s ¡ 

TEHP POISSONS RATIO 
Ul2 UlJ 1J23 U14 U24 U34 Ul5 U25 1J35 U45 U16 U26 UJ6 U46 U56 

o.oo 0.3 0.3 0.3 o.o 0.0 0.0 0.0 o.o o.o 0.0 0.0 0.0 0.0 0.0 0.0 

0.00 0.2 0.2 0.2 o. o 0.0 o. o o. o o. o o. o o. o 0.0 0.0 o. o 0.0 0.0 

0.00 0.2 0.2 0.2 o.o 0.0 0.0 o.o o. o 0.0 0.0 o. o 0.0 0.0 o. o 0.0 

S A P 2 O O O fiNITt ELEMENT ANAL'l'SIS OF STRUCTUíU:S FAGE 
PRO(;R.Al'\: SAP2000/f! LE: \MllldOeumentos\cur sosap2000\e) e~nploB, EKO 

MATERIAL PROFER!IES 

MAT 
LABEL 

eONe 

CONC250 

e s ¡ 

TEMP 

o.oo 

o.oo 

YIELD 
rt 

36.00 

36.00 

S A P 2 O O O riNITE ELEHENT ANAL'l'SJS OF STRUeTURES FAGE 10 
PROGRM: SAP2000/ fiLE. \Ml ~doeument os\eurll'onp2000\eje~nploB. EKO 

F R A M E S E e T I O N P R O P E R T Y D A T A F R I S M A T I e 

SECTION 
!.ABEL 

e s 

fSEel 
r51 

S HA PE: 
rm 

S A F 2 O O O 

' R 

OEPTH F'!.ANGE 

o. 500 
0.500 

WIDTH 
TOP 

O. JOO 
o. 500 

fWIGE 
THieK 

TOP 
"'' THieK 

fWIGE 
WIDTH 

BOTTa-1 

riN:TE: ELEMENT ANALYSIS OF STRUCTURES 

fWIGE 
'l'HieK 

BO'l'To-1 

PAGE 11 
FROGRAH. SAP2000/ FIU; · \Mi.1documen to~ \cur sosap2000\e jemploB. EKO 

f R A M E S E e T I O N P R O P E R T Y O A T A P R I S M A T 1 e 

SECTION 
LABEL 

FSEC! 
r51 

e s 1 

AXIAL 'l'ORSIONAL MOHENTS OF INER!IA SHEAR AAEAS 
MEA CONS'l'ANT 133 122 A2 Al 

O.l50E•OO 0.292E-02 O.JlJE-02 O.ll3E-02 O.i25E•OO O.l25E'"00 
0,250E•OO O.SBOE-0~ 0.52lt-02 0.521E-02 0.209E•OO 0.208E+OO 

S A P 2 O O O riNITE ELEMEN'l' ANA.LYSIS or STRUe!URES PAGt 12 
PROGRA.M: SAP.2 000/ FILE: \M1 ~documentos \eursosap2000\ejetnplo8. EKO 

f R A H E S E C T I O N P R O P E R T Y O A T A P R l S M A T t e 

SECTION 
LABtL 

MI\! 
LABEL 

AOOITIONAL 
MASS PER 

LENtTH 

FSECl STEE:L O.OOOE+OO 
FSl CONe250 O.OOOt•OO 

ADOI'I'IONAL 
WEIGHi PER 

LENGTH 

O.OOOE•OO 
O.OOOE•OO 

183 
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e s 1 S A P 2 O O O fiNl!E ELEMENT ANTU.'!SIS Of STRUCTUIU:S PAGE 13 
FROGRIIM: SAP1000/ riLE: \Mi .sdoclll'!en to$\cursosap2000\ ejempl oB. EKO 

f R A M ' E L ' M E N T D A T A 

ELEMENT JOH<':' JOINT ELE:MtN7 El'<D-Off"SET- LENGTHS FUG!D-ENO mJMBER Of 
LABE:.. I:ND-1 END-J LENGTH END-: END-J fACTOR SEQ1ENTS 

2 J 4 3.000 o.ooo 0.000 o.oooo ' 4 1 • 3. 000 o.ooo 0.000 o.oooo 2 
5 2 6 3.000 o.ooo 0.000 0.0000 
6 4 • 3.000 o.ooo 0.000 o.oooo 
1 2 2.000 0.000 o.ooo 0.0000 

• 6 2.000 0.000 0.000 0.0000 

e s 1 S A p ' o o o f!NJTE ELtMENT ANALYSIS Of STRUCTURES PAGE 14 
PROGRA'-1: SAP2 0001 fiLE:: \Ml.sdocumento.!J\cur.so"IP2000\•J •mp! cB, EKO 

r R A M E E L E M E N T D A T A 

ELEMENT SECTION LOCAL COORD PLN PLN PLANE PLANE COORD 
LABEL LABEL PLANE SYSTtM 1ST 2ND JOINTA JOINTB ANGLE 

e s 1 

2 

• 5 
6 
1 

• 

r51 12 
rsl 12 

'" 12 

'" 12 

'" 12 

'" 12 

SAP2000 

o ., •X 
o •Z •X 
o ., •X 
o ., •X 
o •Z •X 
o ., •X 

o o 
o o 
o o 
o o 
o o 
o o 

0.00 
e. o o 
0.00 
0.00 
o. 00 
o.oo 

riNI'I'E ELrMENT ANALYSIS Of STRUCTURES PAGE 15 
PROGRAH: SAP2000/ riLE: \H.i:~docum•nto:~\cur :~o:~ap2000\•j~plo8, El< O 

T O T A L W E I G H T S A N D M A S S E S 

SECTION 
LABEL 

"' 
TOTAl 

wtiGHT MASS 

9.6000 o. 9'?60 

9.6000 0.9760 

e s 1 S A P 2 O O O flNITE ELEMENT ANAlYSIS Of STRUCTURES PAGE 16 
PROGRAM: SAP2000/ FILE: \Mi .!ldOcumentO.!I \cur .!IO.!!ap2000\ej emplo8, EKO 

L O A D e O N O I 1 I O N PESOP 

SELF-wt:IGHT MULTIPLIER FOR ENTIRt: STRUCTURE: "' :J.lOOOE:•Ol 

L O A D C O N O 1 T I O N VER~ 

SELF-wtiGHT MLILTIPLIER fOR ENTIRE STill'CTURE .. O.OOOOE•OO 

DISTRIIlUTEO SPAN LOAOS ON FRAME ELEMENTS 

EL~Ni LOC OISTANCE OISTANCE FORCE FORCE MC»--ENT 
LABEL OOF AT STAAT AT END AT START AT END AT START 

' 02 0.000!:•00 0.100!:+01 -0.100!:•0: -0.100!:•01 
6 02 O.OOOE>•OO 0.100!:•01 -0.100!:•0: -0.100!:•01 , 02 0.000!:•00 O.lOOE•Ol -G.lOOE•Ol -O,lOOE•O~ 

• 02 O.OOOE•OO O.l:lOE•Ol -0 .JOOE•Oi -0.100!:•01 

LO A o e o N o 1 T ¡ O N SISMOi 

StLF-WEIGHT MULTIPLIER FOR ENTJRt STRUCTURE • O.OOOOE•OO 

JOINT FORCES IN LOCAL COORDINATES 

JOINT 
LABEL 

FORCE: fORCE 
2 

F'ORCt 
J 

MCf".ENT MOMENT 

M<JMENT 
AT ENO 

MOMENT 
J 

O.OOOt•OO C.200E•O~ O.OOOE•OO COOt•OO O.QOOE•OO O OOOE•OO 

C S I S A P 2 0 0 0 flNJ"!'E ELEMf:liT ANALYSJ:" Qf !'Til.LI':"!'URE~ PAGt 11 
PROGRAM SAP2000 1fT LE 'Mi .:~doc:·men t o'' c;n ~ !'r:>,llp2 000\ "! J o;,>l! p l o8 , El< O 

O U T P U T S E L E C T I O N 

OISPLACEMtNTS A.'r JOINTS 

LOAD 
I.AOEL 

PE:SOP 
VERT 

MOOES SPEC 
LABEL 

H¡sr 
LABCL 

APPLIED ANO INfERNAL LOADS A7 JOINTS 

LOAD MODES SPE:C HIST 

HOVE 
l..ABEL 

MOVE 

'""" l..Ail!:L 

1 84 



~' l.Ali<L LAs:::. 

PESOP 
VERT 

INTtRNAL roRC&S A'! ELEMENT rRAHt 

LOAD HOOO:S SPEC 
LAS EL LABE:L 

PE.SOP 
vtR! 

JOINT roRC&S Ai E:LEMtNT F'RAME 

LOAD 
LABE:L 

PtsOP 
VERT 

MOOtS SPE:C 
LABEL 

LABEL 

HIST 
LABI:L 

HlST 
LABt¡, 

t.Ai!EL 

HOVE 
LAB<L 

Movt 
LA!IEL 

LAB<L 

COM!l 
LABEL 

e""' 
LABEL 

C S I 1 S A P 2 O O O riNJTE ELEMEN'I' AN'ALYSIS or STRUCTURES PAGE 19 
PROGRAM: SAP2000/ riLE: \Mt !ldocumento!l \cur •o.u.p2000\e]emp1o8, tKO 

I N P U T C O M P L E T E 
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S A P : O O O {R) 

Structural Analy'i' Proqram' 

Veuion E6.10 

Copyriqht {C) 1978-1997 
CGMPUTER.S ANO STRUCTURES, INC, 

All riqht' re,erved 

THt LICENSE:E 

Unauthori~ed u'e 1' in Violat1on o! Pederal copyriqht laws 

It is the re,pon!libil1ty o! the uJer to veri!y all 
re•ult$ produced by thi' progr~ 

19 Har 2000 15:11:40 
PROGRAM SAP2000 - VER.SION E6.10 
EOUCATIONAL VERSION - COMMERCIAL USE PROHIBITED 

FILE;: EJEHPL08.0UT 
PAGE 

l 

O J S P L A C E M E N T O E G R E E S o ' r R E E O O 1" 

!Al Aetl ve oor, equllibrium equatlon 
1-1 Restrained DOf, reaetion computed 
1•1 Constrained oor 
1 l Nuil oor 

JOINTS Ul< VY uz RJ< RY RZ 
2 A A A A A A 
3 

' TO A A A A A A 
1 

' A A A A A A 

PROGRIIM SAP:COO - VER~ION E6.10 
E:OUCATIONAL VERSION - COMMERCIA: USE PROH!~!~En 

J O I N T O l S P L A C E M E N T S 

TRANSLATIONS ANO ROTATIONS, IN GLOBAL COORDINATES 

LOAD PESOP ------------------
JOINT Ul< UY 

2 ~.26E-09 -0.001111 
.000000 .000000 

' 4.62t-07 -0.001171 
6. -4. 26E-09 -0.001171 

.000000 .000000 
-4.62!:-07 -o. 001111 

LOAD VER1 ------------------
JOINT Ul< VY 

2 "7.09E-09 -0.001952 
3 .000000 .oooooa 

I.IOE-07 -0.001952 
•7,09E-09 -0.001952 

.000000 .000000 
~1, 70E-0"7 -0.001952 

LOAO SISMOY ------------------

JOINT 

' 3 

• 6 
1 

' 

ux 
-0.003173 

.000000 
0.000109 

-0.003173 
.000000 

0.000109 

UY 
0.010573 

.000000 
0.0105"75 
0.005352 

.000000 
0.005350 

PROGP.AM SAF2000 - VE:RSlON E:€ .lO 

uz 
-0.001910 

.oooooo 
-2.\lE-05 
-O.OOHlO 

.000000 
-2.llt-05 

uz 
-0.0031"76 

.oooooo 
-2. llE-05 
•0.003;"76 

.000000 
-2.7lt-05 

uz 
0.008"72"7 

.000000 
·1.01E-06 
0.006686 

.oooooo 
1. 01 f.-O¡; 

RJ< 
0.001006 

.000000 
o. 000"78 l 
0.001006 

.000000 
0.000"781 

RJ< 
0.001677 

.000000 
O.OOlJOl 
0.0016'1'7 

.oooooo 
C.OOlJO: 

RJ< 
-0.0041"73 

.oooooo 
-0.004639 
-o. 003634 

.00(1:)00 
-0.00):6'7 

EDUCATIONAL VERS:ON - COMMERCIAL USE PROHIBliE~ 

A P P L I t O L O A O S 

roRCES ANO Met-IENTS ACTING ON JOINTS, IN GLOBAL COOROINATES 

LOAD PESOP ------------------
JOINT "' " rz "" 2 . oooono .000000 -1. 500000 -0.200000 

• 000000 .00000~ -0.900000 .000000 

• .0000()0 .OOOVOJ -1.400000 e 2000:~ 
6 .000000 .000000 -1.500000 -0.200000 
1 .oooooo .000000 -0.900000 .000000 

• .oooooo .ocoooo -2.400000 0.200000 

LOAD VER! ------------------

f!LE:EJEMPL08.0UT 
PAGE 

2 

RY 
4. 68E-05 

.000000 
2.45E•05 

•4.68E-05 
.oooooo 

-2.45E-05 

RY 
7.80E-05 

.000000 
4.08E-05 

-i.SOE-05 
. 000000 

-4.08E-05 

RY 
o. 00052"7 

.000000 
'1. 27E-05 
0.000~27 

.oooooo 
'7.2'1!:-0S 

RZ 
-1.87E-01 

.ocoooo 
-1.64E-0"7 
l. 9"7E-0"7 

. 000000 
l. 64E-0"7 

RZ 
-3, 12E-07 

• 000000 
<. 73[-07 

3.12E:-Ol 
. 000000 

2. "73E:-Ol 

RZ 
-0.001706 

• 000000 
-o.oo;5n 
-o. 001706 

.000000 
-0.0015~7 

f l LE • E:JEMPL06 . OUT 
PACE 

3 

MY MZ 
0.450000 .000000 

. 000000 .000000 
0.4':>000:) .000000 

-0.450000 .000000 
.000000 .000000 

-0.450000 .000000 

1 A¡; 



~\ 
JOJNT 

' • 
' ' 

LOAD SISMOY 

JOINT 

• 

rx rY 
.000000 .000000 
.000000 .000000 
.000000 .000000 
.000000 .000000 

------------------
rx 

.000000 
rY 

20.000000 

PROGRAH SAP2000 • VER.SION E:6.10 

rz 
·2.500000 
-2. 500000 
-2.500000 
-2.500000 

rz 
.000000 

MX 
-o. JJJJJJ 

0.333333 
-o. JJJJJJ 

0.333333 

MX 
.000000 

EDUCATIONAL VtRSION COMMERCI~ USE PROHIBITE:D 

GLOBAL F O R C t B A L A N C t 

"' o. 750000 
o. 750000 

-0.750000 
-0.750000 

MY 
.000000 

MZ 
.000000 
.000000 
• 000000 
.000000 

MZ 
.000000 

flLt:tJDMPLOB.OUT 
PAGE 

• 

TOTAL FORCE ANO MOMENT AT THE ORIGIN, IN GLOBAL COORDINATES 

LOAD PESOP ------------------

APPLU:D 
Rr.ACTNS 

TOTAL 

LOAD 

II.PPLIED 
REACTNS 

TOTII.L 

rx rY 
.000000 .000000 

l. 39t-16 5.09E-H 

1.39t-16 5.09t-H 

VERT ------------------
rx 

.000000 
3.3JE-16 

3.33E·16 

rY 
.000000 

8.33[-14 

e.JJt-14 

LOAD SISMOY ------------------
rx fY 

APPLIEO .000000 20.000000 
RtACTNS ·2.61E·1~ •20.000000 

TOTII.L -2.61E·l4 ·4.8JE-13 

PROGRAM SAP2000 - vtRSION E6.10 

rz 
-9.600000 

9' 600000 

-l.1Bt-15 

rz 
-lO .000000 

10.000000 

.000000 

r: 
• 000000 

4.55E·l5 

4.55E·15 

MX 
-te .000000 

18.000000 

-l.5Jt-U 

HX 
-15.000000 

15.000000 

MX 
-60.000000 

60. 000000 

l. 44E·12 

EDUCATION1U. VERSION - Cct1MERCIII.L USE PROHIBITED 

F R A M E E L E M E N T J O 1 N T FORCE S 

MY 
6.66t-16 

-J.llt-15 

-2.~H:-l5 

"' l.llE-15 
•1. J3E•15 

•2.2ZE•16 

MY 
.000000 

-6.40[-14 

-6.40E-14 

HZ 
.000000 

-l.OH:-13 

-l.OH;-13 

MZ 
.000000 

-l. 70[•13 

•l.70E•13 

"' -30.000000 
30.000000 

8.56E-1J 

FILE:EJEHPLOe.OUT 
PAGE 

' 
FORCES ANO MOMENTS ACTING ON ELEMEN75, IN GLOBAL COORDINA TES 

ELEM 

LOAD PESOP ------------------

JOINT rx rY 
4. 9n:-14 

-4. 97[:-14 
3 0.172089 

-0.172089 

L.OAO vtRT ------------------

JOINT 
3 

• 
rx 

0.?86815 
-0.266815 

fY 
8.22E·H 

·B. 22E-14 

LOAD SISHOY -----------·------

JOIN1 rx rY 
3 ·l. 33E-14 -17.155639 

• l. JJE-14 17.155639 

ELEM ------------------
LOAD PESOP ------------------

JOINT rx fY 
7 -0.172089 1.20E-15 

' 0.172089 ·1.20E•15 

LOAO VERT ------------------
JOINT rx rY 

-0.286815 1.02E-15 
0.286915 ·l.02E-15 

LOAD SISMOY ------------------
JOINT rx fY 

' ·l.28E·14 -2.844361 

' 1.28E-14 2.944361 

ELEM ' ------------------
LOAD PESOP ------------------

rz 
4. 800000 

-3.000000 

r: 
5.000000 

-5.000000 

r: 
O.le6242 

-0.186242 

rz 
4.800000 

-3.000000 

rz 
5.000000 

-5.000000 

rz 
-0.186242 

0.186242 

HX 
-3.000000 

J. 000000 

"' -5. oooooo 
5. 000000 

I1X 
43.562544 

7.904373 

HX 
-3.000000 

3. 000000 

I1X 
-5. oooooo 

5.000000 

I1X 
16.437456 
-7.904373 

MY 
0.16~021 

0.352246 

MY 
0.273369 
o. 597077 

MY 
-0.279363 

0.279363 

MY 
-0.164021 
-o. 352246 

MY 
-0.273369 
-o. 587077 

"' -0.279363 
0.279363 

MZ 
0.000443 

-0.000443 

MZ 
0.000739 

-o. ooo139 

MZ 
4.266542 

-4.266542 

MZ 
-0.000443 

0.000443 

MZ 
-0.000739 

0.0007)9 

HZ 
4.266542 

-4.266542 

187 



JOIN'r 
2 
6 

fX 
0.001570 

•0.001570 

rY 
-2.4lE-15 
2.41E-15 

PROGRAH SAP2000- VERSION E6.10 

rz 
0.900000 
0.900000 

><X 
4.16E-15 

-4.16E-15 

EDUCATIONAL VERSION - COHMtRCIAL USE PROHIBITE:O 

E L E M E N T J O ! N T fORCES 

"' -0.0904iC· 
0.0'10470 

MZ 
-0.001437 
o.oou:n 

fiLE· EJtHPLOB. OUT 
PAGE 

' 

fORCES ANO MOMENTS ACTJN~ ON ELEMENTS, IN GLOBAL COOPDINATE:S 

LOA.D VE:RT ------------------

JOINT 
2 

' 
f1( 

0.002617 
-0.002617 

rY 
-3.20E-15 

3.20E-l5 

LOA.D SISMO'!' ------------------

JOINT 

' ' 
f1( 

-l. 9JE-14 
1.9JE-14 

fY 
0.4'15706 

-0.4'15706 

LOAD PESOP ------------------

JOINT 

• 
' 

f1( 

0.170519 
-0.170519 

fY 
•7.39E-15 

7.39E-15 

LOAD VERT ------------------

JOINT 
4 

' 
rx 

0.284199 
-0.284199 

rY 
-l. 34E-14 
l. 34E-14 

LOAD SISMO'!' ------------------

JOINT rx fY 
4 3.82E-15 2.346655 
8 -3.82E-15 -2.348655 

ELE:M 7 ----------------
LOAD PESOP ------------------

JOINT f1( rY 
2 -0.00:510 -l.94E-16 

0.001570 l.94E·16 

LOAD VER! ------------------
JOINT f1( fY 

2 -o 002617 4.07E-14 
0.002617 -4.07t-14 

LOAD SISMO'!' ------------------
JOINT f1( N 

2 1.29E-14 -0.495106 
-l..29E-14 0.49510!> 

PROGRAH SAP2000- VLRSION E6.10 
LDUCATIONAL VERSION CCll'flERCIAL 

FZ HX 
1.500000 7.2BE-15 
1.500000 -7, 28E-15 

FZ ><X 
1.230496 -1.459090 

-1.230499 1.459060 

FZ MX 
0.900000 1.26E-l4 
0.'100000 -l.26E-l4 

FZ ><X 
1. 500000 2. llE-14 
l. 500000 -2. llE-14 

FZ ><X 
-1.044256 -3.'184296 

1.044256 3.994296 

rz MX 
-0.900000 -7.52E·l5 

2.100000 -3.000!)00 

rz ><X 
-1.500000 -8.60E-15 

3.500000 -5.000000 

" MX 
-:..230498 ).459090 
l. 2 304 98 -3.920071 

USE PROHIBITLO 

f RAM E ELLMEN ! J O l N 1' f O R C E S 

"' "' -0.150784 -0.002395 
0.150784 0.002395 

"' MZ 
-1.9457(7 o. '743559 
-1.8457(7 o. 74355'1 

"' MZ 
-0.261775 -0.001260 

0.261775 0.001260 

"' MZ 
-0.0629~ -0.0020'1'1 

0.436292 o. 00209'1 

"' MZ 
l. 566395 3.522'182 
l. 566385 3. 522982 

MY MZ 
0.090470 0.001437 

-o. oc¡ o no 0.001703 

"' MZ 
o.t507e4 0.002395 

-0.150"194 0.00.!838 

"' MZ 
l. (14 !,.747 -o ,743559 

-1.845747 o. 74 3559 

FILE EJEMPLOS. OUT 
PAGE 

7 

fORCES ANO Heffi:NTS ACTING ON ELE.ME:NTS. !N GLOB.A.L COORDINATES 

Et.EM -----------··-·-·-
LOAD PESOP ------------------

JOIN1' rx rY rz HX "' MZ 

' 0.001570 3.49E·14 -0.900000 5.22E-15 -0.090470 -0.001437 

' -0.001570 -3.49L-14 2.100000 -3.000000 0.090470 -0.001703 

LOAO VERT ------------------
JOINT f1( rY rz ><X "' M1 

' 0.002617 1.92E-l4 ·l.SOOOCO 1. 013E-14 -0.150784 -0.002395 

' -0.002617 -7.92E·l4 3.500000 -5.000000 0.150184 -o. ooz838 

LOAD SISMO'!' ------------------

JOIN1' f1( rY rz ><X "' MZ 
6 l. 33E-14 0.495706 1.230498 -1.459080 1.845741 -0."143559 

' -l.JJL-14 -0.495706 -1.230498 3.92007'7 -l. 845'741 0.743559 

PROGRAH SAP2000 - VERSION L6.10 fiLE: EJtMPL08. OUT 
LDUCATIONAL vtRSION - COHMtRCIAL USE PROHIBITLO PAGE 

··~ 

18!l 



F R .a. M I: I: L t MI: N 'l' IN'l'I:RNAL 

2 -------- LtNG'l'H • 

LOAD PI:SOP ------------------

REL O!ST 
0.00000 
0.50000 
1. 00000 

p 
-4.600000 
-3.900000 
·J.OOOOOO 

Y2 
-0.17206':1 
·O. 1'72099 
·0.1'72069 

LOAD vtRT ------------------

Rr.L OIST 
0.00000 
0.50000 
1.00000 

p 
-5.000000 
-5.000000 
-5.000000 

Y2 
-0.266615 
-0.266615 
-0.266815 

LOAD SISMOY ------------------

REL OlST 
0.00000 
0.50000 
l. 00000 

p 
-0.186242 
-o .1&6242 
-0.166242 

V2 
l.JJE-14 
l.J3E•l4 
1.3JE-l4 

VJ 
-4. 9"1(-14 
•4,<l'l'E:-H 
-4.91(-14 

VJ 
-B.22E-14 
•8.22E-14 
-B.22t-14 

VJ 
1'7.155639 
17.155639 
17.155639 

ELEM •••••••••••••••••• LtNGTH • 

LOAD PESOP ------------------

REL OIST 
o.ooooo 
o.soooo 
l. 00000 

p 
-4.800000 
-3.900000 
-3.000000 

V2 
0.172089 
0.172089 
0,1'?2069 

LO.I\0 vtRT ------------------

REL OIS'l' 
o.ooooo 
0.50000 
1.00000 

p 
-5.000000 
-5.000000 
-5.000000 

Y2 
0.286815 
0.286815 
0.286815 

LOAD SISMOY ------------------

Rr.L OIST 
0.00000 
0.50000 
1.00000 

p 
0.166242 
0.186242 
0.1S6242 

V2 
1.28E-l4 
1.28E-14 
1.28E-14 

VJ 
-1.20E:-l5 
-L20E·l5 
•1.20E-15 

V3 
-1.02[-15 
-l.Ozt-15 
-l.02E-15 

V3 
2.844361 
2.944361 
2.fl406l 

ELE>< 5 •••••••••••••••••• LENGTH • 

LOAD PESOP ------------------

REL OIST 
o.ooooo 
0.25000 

p 
-0.001570 
-0.001570 

V2 
-0.900000 
-0.450000 

PROGRAM SAP2000 - VERSION E6.10 

VJ 
-Z.HE-15 
-2.41E-15 

FORCE$ 

3.000000 

-0. OOOHJ 
-O.C0040 
-o. ooo4o 

T 
-0.000739 
-0.000739 
-o. ooo7 39 

T 
-4.266542 
-4.266542 
-4.266542 

3. 000000 

T 
0.000443 
0.000443 
O.OOO•HJ 

o. 0007 39 
o. 0007 39 
o. 0007 39 

T 
-4.266542 
-4.266542 
-4.266542 

3. 000000 

T 
-4 .16E-15 
-4.16t-15 

M2 
-3.000000 
~3.000000 

•3.000000 

M2 
-5.000000 
-5.000000 
-5.000000 

M2 
4J.5625H 
17.829096 
_.,. 9043"13 

M2 
-3.000000 
-3.000000 
-3.000000 

M2 
~5.oooooo 

-5.000000 
-5.000000 

M2 
16.437~56 

l2.1?09i4 
'?,904373 

M2 
-0.001437 
-0.001437 

MJ 
-0.164021 

O.O<l4112 
0.352246 

MJ 
-0.273369 

0.156854 
0.5970'?7 

MJ 
0.2'79363 
0,279363 
0.2'79363 

MJ 
0.164021 

-0.094112 
-o. 3522H 

H3 
0.273369 

-0.156854 
-o. 587077 

MJ 
0.279363 
0.2'?9363 
0.219363 

M3 
-0.090470 
0.415780 

EDUCATlONAL VERSrDN - COt-fo!ERCJAL USE Pl<OH!SITED 
riLE: E,TF..MPL08. OUT 

PAGf. 
9 

í RAM E E L E M E N T I N T ~ R N A L í O !< ~ ~ S 

REL 01ST 
0.50000 
o. 75000 
1.00000 

p 
-0.001570 
-0.001570 
-0.0015'10 

V2 
s.eot-15 
0.450000 
0.900000 

LOAD VERT ------------------

R~L orsr 
0.00000 
0.25000 
o. 50000 
0.75000 
l. 00000 

-o.ocn:1 
-0.002f:7 
-0.0::>:>6:7 
-0.0026¡7 
-0.002617 

V2 
-1.500000 
-o. 150ooo 
e.66r-:s 
o. 750000 
1.500000 

LOAD SISMOY ------------------

REL OIST 
0.00000 
0.25000 
C.50000 
0.75000 
l. 00000 

p 
1.93E-14 
l.93E-14 
1.9JE-l4 
1.93E-l4 
l. 9JE-l4 

V2 
-1.23049<3 
-1.2 JO~ 98 
-1.23006" 
-1.230498 
-1.230499 

VJ 
-2.41E-15 
-2.41E:-15 
-2.41E-15 

V3 
-J.20E:-15 
-J.20E:-15 
-3.2:E:-i5 
-J.20E-:5 
-J.20E-!5 

VJ 
0.495706 
0.495706 
0.4?5"106 
0.495106 
0.49570f, 

ELEM ••••··~••••••••••• LENGTH • 

LOAD PE:SOP ------------------

REL DIST 
0,00000 
0.25000 
0.50000 

p 
-0.1'10519 
-0.110519 
-0.170519 

Y2 
-0.900000 
-0.450000 
-2.97E-15 

V3 
-7.39E:-15 
-7.39E-15 
-'?.39[-15 

T 
-4.16E:-15 
-4.16E-15 
-4.16t-15 

-•.:>t:t-1:. 
-i.;>é~·l5 

-'1.28E·l5 
-7.28E-15 

M2 
-o .o oH 37 
-o. oo14 37 
-0.001437 

"' -0.002395 
-O.CC2H5 
-O.C023<J:. 
-0.00239S 
-o. 002 395 

M2 
1.459060 0.743559 
1.459060 O.J7P80 
1.4~9080 -4.30E·15 
1.~590€10 -0.311"190 
1.459080 -0."14355~ 

3.000000 

T 
-1.26E-14 
-1.26E•l4 
·l.26E-14 

M2 
-0.001260 
-0.001260 
-0.001260 

M3 
0.5~14530 

o. 415780 
-0.090~70 

M3 
-O.l5o7e4 
o.t:-9~9H 
0.97421€ 
0.692966 

-0.150784 

HJ 
-1.845747 
-o. 922874 

3. &3E•15 
0.922974 
1.845747 

HJ 
-0.261775 

0.24H'75 
0.413225 

189 



o. ?5000 -o .1 ?0519 0.450000 -7.39!:-15 -l. 26t-H -0.001260 0.244475 
l. 00000 -0.170519 0.900000 -?.J9t-15 -1.26E-14 -0.001260 -0.261775 

(~ LOAD VER'! ------------------

RI:L PIS'! ' V2 VJ T "" Hl 
0.00000 -0.284199 -l. 500000 -1. JH-H -2.\lE-14 -0.002099 -0.~36292 

0.25000 -0.284199 -o. 15oooc -l. 34t-H -2.\l(-14 -0.002099 0.401456 
0.50000 -0.284199 -5.1\E-15 -l.JH-14 -2.1lt-H -0.002099 o. 6~9101! 
0.75000 -0.28H99 o. 750000 -l.34E-14 -.:!.11t-H -0.002099 o. 401458 
1.00000 -0.284199 l. 500000 -l.J4E-14 -2.i.1E-14 -0.002099 -o. 4 J6l92 

LOAD SISMOY ------------------

RI:L DIS'! ' V2 VJ T H2 HJ 
0.00000 -3.82E-15 1.044256 2.348655 J. 964296 3. 522982 l. 566385 
0.25000 -J.82t-15 1.044256 2.348655 3.984296 1.1'61Hl 0.1'83192 
o. 50000 -3.82E-15 1.044256 2. 348655 3.984296 -4.44E-16 -4. 44E-16 
0.75000 -3.82E-l5 l.04H56 2.348655 3.98429f. -l. 761491 -o. 783192 
1.00000 -3.62E-l5 1.044156 2. H6655 J.9842Q6 -3.522962 -1' 566395 

PROGRAM SAP2000 - VERSJON E6.10 fiU: EJEMPLOS, O'JT 
EDUCA'!IONAI. VERSION - COI't"'ERCIAL USE PllOHIB!TED PAGE 

lO 

F R A. H E E L E M E N '! ¡ N '! E R N A. L ro Re E S 

ELD1 --·--------------- LENGTH • 2.000000 

LOAD PESOP ------------------
REL PIS'! V2 VJ T H2 HJ 
o.coooo l.94E-l6 o. 900000 0.001510 -0.090470 0.0014)1 4. 8U:-15 
0.25000 l.94E-l6 l. 20000C 0.001570 -o.o9cno o. 000652 -o. 525ooo 
0.50000 i.94E-16 l. 50000:) 0.001510 -o. 090470 -0.000133 -l. 200000 
0.75000 J. 94¡:-¡ 6 1.600000 0.001570 -0.0904"10 -0.0009la -2.025000 
1.00000 ¡. 94~-16 2.100000 0.001570 -0.090470 -o. oonoJ -3.000000 

LOAD VERT ------------------

REI.. PIST ' V2 VJ T H2 HJ 
0.00000 -4.07t-H l. 500000 0.002611' -0.150784 0.002395 6.40E-15 
0.25000 -4.07E-14 2. 000000 0.002617 -0.150784 0.00106? -0.875000 
o. 50000 -4.07E-14 2. 500000 0.00261'7 -0.150784 -0.000222 -2.000000 
0.75000 -4 .07E-l4 3. 000000 0.0026]'? -C'. J 501B4 -0.001530 -3.375000 
l. 00000 -4.07~-14 J. 50000C 0.00261"1 -C.l50794 -0.002939 -5.000000 

LOAD SISMOY ------------------

RO. OIST p V2 VJ T H2 HJ 
;'' ,_ 

0.00000 o. 4951'06 1.230498 -1.29E-l4 -1.8451'47 -o. 743559 -1.459080 
0.25000 o. 4951'06 1.230496 -1.29E-l4 -1.845?47 -o. 743559 -2.074329 
0.50000 o. 4951'06 1.230496 -1.29E-14 -1.845747 -o. 743559 -2. 68951'8 
o. 75000 0.495?06 1.230496 -1.29E-14 -1.845747 -0.743559 -3.304828 
1.00000 o. 495706 1.230496 -1.29~-14 -1.845747 -0.743559 -3.920077 

ELEH ' ~----------------- LENGTH • 2.000000 

LOAD PESOP ------------------
REL DIS'r ' V2 V3 T H2 Hl 
0.00000 -3.49E-14 o. 900000 -0.001570 0.09041'0 -0.001437 -4.36E-15 
0.25000 -3.49E-14 1.200000 -0.001570 0.090470 -0.000652 -0.525000 
0.50000 -3.49E-14 1.500000 -0.001570 0.090470 0.000133 -l. 200000 
o. 75000 •3.49E-14 1.800000 -0.001570 0.090470 0.000918 -2.025000 
1.00000 -3.49E-14 2.100000 -0.001570 0.090470 0.0011'03 -3.000000 

LOAD VER! ------------------

REL DJST p V2 VJ T H2 Hl 
0.00000 -7. 92E-14 1.500000 -0.002617 o. 1501'64 -0.002395 -l. 30E-14 
0.25000 -7 .nt-14 2.000000 -C.0026i7 0.150784 -0.001081 -o. 97 5o o o 
o. 50000 -1,92~-14 2. 500000 -0.002617 0.150.184 0.000222 -2.000000 
o. 75000 •7,92E-l4 3. 0!)0000 -o. 002611 0.150784 o. 001530 -3.375000 
l. 00000 -7, 92E-14 3. 500000 -o. 0026P 0.150794 0.002838 -5.000000 

LOAD SISHOY ------------------

RI:L DIST ' V2 VJ T H2 H3 
0.00000 -0.495706 -1.23008 -l.JJE-14 -1.845747 -0.743559 1.459090 

PROGAAH SAP2000 - VERSION E". lO fiLE E.JEMPL06. OUT 
EDUCATIONA:.. VER!'=!ON COKMERCIAI. liS E PROHJBITEO PAGE 

11 

F R A M E E l. ~ M ' N ' : N T E R N A l. r o R e E S 

RtL DIS'! ' V2 VJ T H2 Hl 
0.25000 -0.4951'06 -1.230498 -l. 3JE-14 -1.645741 -0.743559 2.01'4329 
0.50000 -0.495706 -1.230496 -1. 33E-14 -1.845747 -o. 743559 2. 689576 
0,75000 -o. 495706 -1.230498 -1. JJE-14 -1.6451'47 -o. 743559 3.304628 
l. 00000 -o. 495706 -1.230498 -l. 3JE-14 -1.645747 -0.743559 J. 920077 

1 "n 
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-', ¡ file C:\Hi~ docu~entos\eurso sap 2000\eJ•~plo9.s2~ saved 3/21/00 10:12:33 in Ton-m 

SYSTEM 
OOF•UX,UZ,RY L~NGTH-m rORC~·Ton LINES•59 

JOINT 
1 X•-9 Y•O z-o 
2 X•-9 Y•O 

,_, 
J )( .. -9 Y•O 

,_, 
• x--9 Y•O 

,_, 
' x--9 Y-0 Z•l2 

• X•-9 Y•O Z•l5 
1 x--9 Y•O Z•l8 
12 x--3 Y•O z-o 
1J X•-3 Y•O ,_, 
14 X•-3 Y•O 

,_, 
" x--3 Y•O 

,_, 
" X•-3 Y•O Z•l2 
17 X•-3 Y•O Z•l5 

" x--J Y•O Z•l8 
2J ,_, 

Y•O z-o 

" 
,_, 

Y•O 
,_, 

25 ,_, 
Y•O 

,_, 
26 ,_, ,_, ,_, 
21 ,_, 

Y•O Z•12 
28 

,_, 
Y•O Z•15 

29 
,_, 

Y• O Z•lS 
30 

,_, 
Y•O Z•21 

" 
,_, 

Y•O z-o 

" 
,_, 

Y•O 
,_, 

" 
,_, 

Y•O 
,_, 

" 
,_, 

Y•O 
,_, 

" 
,_, 

Y•O Z•l2 
J9 

,_, 
Y•O z .. ¡s 

" 
,_, 

Y-0 Z•lB 

" 
,_, 

Y•O Z•21 

RESTRAINT 
ADt>-l 
AD~l2 
A0[)o2J 
AD~34 

DOF•Ul, U2, UJ, Rl, RJ 
DOF•Ul, U2, UJ, Rl, Rl 
DOF•Ul, U2, UJ, Rl, RJ 
OOF-Ul, U2, UJ, Rl, RJ 

PATTERN 
NAMt•DHAULT 

MATtRIAL 
NAME•STEE.L IDES•S M-.798142 w-7.833413 

T•O E•2.038902E+O? U•.) A•.0000117 
NAMt•CONC IDES•C H-.2448012 Woo2.402616 

T•O E•2531051 U•.2 A•.0000099 
NAME•OTHER IDES•N H-.2448012 W-2.402616 

T•O E•2531051 U•.2 A•.0000099 

fRAME SECTION 
NAME•FSECl MAT•STEU. SH•R T•.5,.3 A•,l5 J-2.9li3ilt~OJ I•.003125,.001125 AS•.l25,.125 
NAME•FSl MAT•CONC SH•R T•.6, .6 .-,•.36 J .. 1.8252Clt-02 J ... Q108, .0109 AS ... 3, .J 
N.-.HE•FS2 M.llo.T•CONC SH•R T .. J, .4 A·.~ J•.0\51;611B l•J.J3JJ34E-02,5.333JHE·03 "'5•.3333333,.3333333 

FIW<E 
1 J .. l, 2 StC•FSl NSEG-2 ANG--0 
2 J-2,3 SEC .. fSl NStc;...z A.NG-C' 
J J-3, 4 stc-rs: NSEG-2 ANG-0 

• J-4, 5 SEC•FSl NSEG-2 ANG-0 

' J•5, 6 SEC•FSl NSEG-2 ANG-0 

• Joo6, 7 SEC•FSl NSEG-2 ANG-0 
11 Joo12,13 SEC•f"Sl NSEG-2 ANo-O 
12 J-13,14 SEC•FSl NSEG-2 ANG-0 
lJ J•l4,15 SEC•f"Sl NSEG-2 AAG-0 

" J•l5,16 SEC•FSl NSEG-2 .... , 
" J•l6,li stc-rs: NSEG-2 .... o 

" J-17, 19 stc-rs: NSEG-2 A.NG-0 

" J•23,24 stc .. rsl NSEG--2 """"' 22 J-24,25 stc-rsl NSEG--2 .... , 
2J J-25,2~ StC•fSl NSEG-2 AAG-0 

" J-26, 27 stc-rsl NSEG-2 ANG-0 
25 J-:n,2e SEC-F'Sl NSE(j.oo2 ANG-0 
26 J-ze. 29 SEC•FSl NSEG-2 ANG-0 
21 J-29,30 SECoofSl NSEG-2 AAG-0 
JI J-34, 35 SEC-FSl NSEG-2 AAG-0 
J2 J•35,36 SEC-FSl NSEG-2 AAG-0 
JJ J•36, 37 SEC•FSl NSEG-2 .... , 
" J•37, 38 StC•rsl NSEG-2 .... o 
" J•)9, 39 SEC•F'Sl NSEG-2 A.NG-0 

" J .. 39, 40 SEC•FS1 NSEG-2 .... , ,, J•40,41 StC•fSl NSEG•2 ANG-0 

" J•2,13 SEC .. f52 NSEG-4 ANo-O 

" J-3,14 StC•fS2 NSEG-4 ANG-0 
4l J•4,15 SE:Coof52 NSEG-4 ANG-0 .. J-5,·16 stc-rsz NSEG-4 ANG-0 

" J•6,17 SEC-rs2 NSEG-4 ANG-0 .. J-7 ,19 SEC•FS2 NSEG-4 ANG-0 

" J•lJ, 24 SEC•F'S2 NSEG-4 AAG-0 
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52 J"-14,25 stc-rsz NSE:G-4 
53 J-15,26 SEC•fS2 NSEG-4 
54 J•l6, 2'7 SEC•rs2 NSEG-4 

" J•li, 28 SECoofS2 NSEG-4 
56 J•l8,29 SEC•FS2 NSEG-4 

61. J-24, 35 stc-rsz NSEG-4 

" J-25,36 SEC•f52 NSEG-~ 

" J-26, 37 stc-rsz NSEG-.( .. J-27. 38 S&C•F'S2 NSEG-4 

" J-za. J9 SEC•F'S2 NStG-4 

" J-29, 40 stc-rsz NSEG-~ 

" .r-Jo, u StC•FSZ' NStG-4 

LOAD 
NAHE•VERT """l 

TYPE•DISTRIBUTEO SPAN 
ADD-41 Rr:-0, l 
A0~42 RD-0, 1 
ADD-43 RD-0, 1 
ADOo-44 Ro-O, 1 
ADOo-45 RD-0, 1 
ADDoo46 RD-0,1 
ADo-51 RD-0, 1 
ADo-52 RD-0, 1 
ADD-53 ROo-O, 1 
,r..oo-54 Rl)ooQ, 1 
ADD-55 RD-0, 1 
ADD-56 RD-0,1 
ADD-61 RD-0,1 
AOD-62 R.Do-0,1 
ADD-63 RD-0, 1 
ADD-64 RD-0, 1 
ADD-65 RD-0, 1 
ADD-6G Rt:o-0, 1 
ADOo-61 Rl)o.O, 1 

NAME•LATtR.Al. 
TYPE-FORCE: 

AOD-2 ux-5 
ADP.J ux-5 
ADD-4 UX•5 
ADD-5 UX•5 
ADD-6 tJX•lO 
ADD-7 vx-10 

COMBO 
NAME-DCOt'H 

LOAD-VERT Sf•l. 4 
NAME-OCON2 

LOAD-VERT Sf•l. 4 
NAME•OCON) 

uz ... z.-z 
uz--2.-2 
uz--2, -2 
uz--z, -2 
uz--z, -z 
Ut.•-2,-2 
uz--2. -2 
UZ•-2, -2 
uz--2. -z 
uz--2, -2 
uz--2,-2 
uz--2,-2 
uz--2,-2 
UZ•-2,-2 
UZ•-2,-2 
UZ•-2,-2 
UZ•-2,-2 
uz .. -z. -z 
uz--z. -2 

LOAD-VERT SF•1.05 
LOAD-LATERAL Sf•1.4025 

NAHL•OCON4 
LOAD-VERT Sf•l. 05 
LOAD-LATERAL Sf•-1.4025 

NAME:•OCON5 
LOAD-VERT Sfoo. SI 
LOAD-l.ATERAL SF•l.~J 

NAMt•OCON6 
LOAD-VEA':' Sf•.9 
LOAD-LATE~ SF•-l. 4 3 

ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 
ANG-0 

OUTFUT 
EL~JOINT 

tLf.M-JOI NT 
ELE:Mo-JOI N!' 
tLt:M-JOINT 
tLEM-fRAMt 
tl.O+-FRAME: 
ELO+-FRAME 
El.EM-FRAME 

TYPE•DISP 
TYPE•DISP 
TYPE•APPL 
TYPE•APPL 
TYPE•FORCE 
TYPE- <ORCE 
TYPE•JOINTF 
TYPE•,JO!NTF 

LOAD-VER! 
LOAD-LATERAL 
LOAD-VER':' 
LOAD-LATERAL 

l.OAD-VERT 
LOAD-LATERAL 

LOAD-VER! 
LOAC-LATERAL 

<NO 

Toe follow>"lQ dt~tl!l 1!!1 not requlr~o for 11na.!y~i~. It i~ o.ro:ten r~er~> 11' 11 b11ckup. 
1 Thi' d11tl!l wi:l be ut~ed ~or grl!lphic~ a.nd de!!l1gn i! th1~ flle ~!! imported. 
1 If change!! 11re rnaoe to the llnl!l:y.!li!! dat11 above, -::hen th., fo:lowing data 

'hould oe ehecked for con!!istency. 
Any error' in 1tnport1ng the followinQ da.tl!l l!lre ignored without Wl!lming. 

SAP2000 V6.10 SUPPLDKENTAL DATA 
GRIO GLOB"-1. X "'1"' -9 
GRID GLOB.ZU. X ·~· -3 
GRIO GLOB.ZU. X "'3"' J 
GRIO GLOBAL X "'4"' 9 
GRID GLOBAl "'5"' 
GRID GLOBAL "'€"' O 
GRID GLOBAL Z "'7"' 3 
GRIO GLOBAL Z "'8"' 6 
GRID GLOB.ZU. Z "'9"' 9 
GRIO GLOBAL Z "'lO"' 12 
GRIO GLOBAL Z "'11"' 15 
GRID GLOBAL Z "'12"' 18 
GRIO GLOB.ZU. Z "'13"' 21 
GRIO GLOB.ZU. Z "'14"' 24 
GRIO GLOBAL 2. "'15"' 27 

'~ 
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GRID GLOBAL z ~16~ 30 

~· 
CONCRETEGROOP "COLS" 
CONCRETEGROUP "TRABE:S" 
GROUP "COLS" JOINT 1 
GROOP "COLS" JOINT 2 
GROOP "COLS" JOINT J 
GROUP "COLS" JOINT 4 
GROI.IP "COLS" JO!NT 5 
GROVP "COLS" JOINT 6 
GROUP "COLS" JOINT 7 
GROUP "COLS" JOINT l2 
GROUP "COLS" JOJNT lJ 
GROUP "COLS" JOINT " GROUP "COLS" JOINT 15 
GROUP "COLS" JOINT 16 
GROUP "COLS" JOINT 17 
GROUP "COLS" JO!NT 18 
GROUP "COLS" JOINT 23 
GROUP "COl..S" JO!NT ,. 
GROUP "COLS" JO!NT " GROUP "COLS" JO!N'!' 2f. 
GROUP "COLS" JOINT 2' 
GROUP "COLS" JO!~':' " GROUP "COLS" JOINT 29 
GROUP "COLS" JOINT 30 
GROUP "COLS" JOIN'l' 34 
GROUP "CO!.S" JOINT J5 
GROUP "COLS" JOINT J6 
GROUP "COLS" JOINT " GROUP "COLS" JOINT " GROUP "COLS" JOINT 39 
GROUP "COLS" JO!NT 40 
GROUP "COLS" JOINT " GROUP "COLS" fRAME 
GROUP "COLS" fRAME 2 
GROUP "COLS" fRAME 3 
GROUP "COLS" fRAME 4 
GROUP "COLS" rRAME 5 
GROUP "COLS" fRAME 6 
GROUP "COLS" fRAME 11 
GROUP "COLS" fRAME 12 
GROUP "COLS" fRAME 13 
GROUP "COLS" rRAME 14 
GROUP "COLS" fRAME 15 
GROUP "COLS" fRAME l6 
GROUP "COLS" rRAME :?1 
GROL.'P "CO!..S" fRAME 22 
GROUP "COLS" fRA."1"t 23 
GROUP "COLS" fRAME 24 
GROUP "COLS" fRAME 25 
GROUP "COLS" fRAME 26 
GROUP "COLS" rRAME 21 
GROUP "COLS" fRAME 31 
GROUP "COLS" fRAME " 
GROUP "COLS" fRAME 33 
GROUP "COLS" fRAME 34 
GROUP "COLS" fRAME 35 
GROUP "COLS" rRAME 36 
GROUP "COLS" fRAME 3'7 
GROUP "TRABES" JOINT 2 
GROUP "TRABES" JOIN'!' 3 
GROUP "TRABES" JOINT 4 
GROUP "TRABES" JOINT 5 
GROUP "TRABts" JOINT 6 
GROUP "TRABES" JOINT 7 
GROUP "TRABts" JOINT 13 
GROUP "TRABES" JOINT 14 
GROVP "TRABES" JOINT 15 
GRO\IP "TRABES" JOINT 16 
GROUP "TRABES" JOINT 17 
GROUP "TRABES" JOINT 18 
GROUP "TRABES" JOINT 24 
GROUP "TRABES" JOIN':' 25 
GROUP "TRABES" JOINT 26 
GROUP "TRABES" JOINT 27 
GROUP "TRABES" JOINT 28 
GROUP "TRABES" JOINT 29 
GROUP "TRABES" JOINT 30 
GROUP "TRABES" JOJNT 35 
GROUP "TRABES" JOINT 36 
GROUP "TRABES'" JO!NT " GROUP "TRABES" JOINT 38 
GROUP "TRABES" JO!N':' " GROUP "TRA['.tS" JOINT 40 
GROUP "TRABE:S" JO!N':' o 
GROIJP "TRA.BtS" fRAME 41 
GROUP "TRABE:S" fRAAE 42 
GROUP "TRABES" fRAME 43 
GROUP "TRABES" fRAME " GROUP "TRABES" fRAME 45 
GROUP "TRABES" fRAME " GROUP "TRABES" fRAME 51 
GROUP "TRABES" fRAME 52 
GROUP "TRABES'" fRAME 53 
GROUP "TRABES• fRAME 54 

205 



GROUP "TRABE:S~ rRAME 55 
GROUP "TI\ABE:S• rRAMt 56 
GROUP •tRABES" f1IAMt 61 
GROUP •tRABES• f'R.AMt 62 
GROUP "TRABEs~ rRAME 63 
GROUP "TRABEs• rRAME 64 
GROUP •tRABES• rRAME 65 
GROUP •tRABES~ rR.AME 66 
GROUP ~TRABES" rRAHt 67 
MATERIAL STEEL FY 25310.5 
MATERIAL CONC rtREBAR 42184.18 FYSHEAA 28122.78 re 2812.278 rcSHD.R 2912.278 
f'RAMESEC!ION rs1 NAME COL60X60 
rRAMESEC!ION rs2 NAME TR40X100 
CONCRETESECTION COL60X60 COLUHN COVER .06 REBAR RR•3•3 
CONCRETESECTION TR40X100 COLUHN COVER .04572 REBAR RR-J·J 
STATICLOAO VERT TYPE DEAD 
STA!ICLOAD LATERAL TYPE QUAXE 
COMBO DCON1 OESIGN CONCRETE 
COMBO OCON2 OESIGN CONCRETE 
COMBO DCONJ OESIGN CONCRETE 
COMBO DCON4 OESIGN CONCRETE 
COHBO DCON5 OESJGN CONCRETE 
COMBO DCON6 OESIGN CONCRETE 
CONCRETEDESIGN •ACI 318-95" 

END SUPPLEMENTAL DATA 
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SAP2000 
Structural Analy:~i11 Progr4lfts 

Veuion 6.10 
Copy~iqht (C) 1978•19111 

COHPU'l'~RS ANO STRUCTURts, INC. 
All r1qht!' re!l@fVed 

Thlll copy of SAPZOOO 1.!1 !or th9 •~clu.!llVI'I u11e o! 
THE L!CE:NSt~ 

Unauthorited u11e i.!l in violation o! f•deral copyright laws 
It i.!l the respon:~ibility of the u.ser te verify all 

re!!ult.s produced by thi:~ proqram 
21 Mar 2000 09:11:27 

es 1 S A P 2 O O O fiNITE ELD«:NT ANALYSIS Of STRUCTURE.S PAGE 1 
PROGRAH:SAP2000/fiLE:\M1sdocu=•ntos\eursosap2000\ej~plo9.EKO 

S Y S T E M O A T A 

STE:AOY STATE LOAD fRE:QUI:NCY 

LENGTH UNI TS 
fORCE UNITS 

UP OIRECTION 

GLOBAL OI:GFU:ES Of rREEDa-1 

PAGlNAT!ON BY - - - - -
NUMB~R or LINES PER PAGE 
INCLUDE WARNING M!:SSAGES IN OU!PL''l' riLE 

O.OOOOE+OO 

H 
TON 

,, 
ux 
uz 
RY 

LINES 

" y 

es 1 S A P 2 O O O fitHTt tLEMtN'! ANALYSIS Of STRVCTURES PAGE 2 
PROGAAM: SAP2000/fi LE: \Mudoeumentos\eursosap2000\e)emplo9. EKO 

G E N E R A T E O J O I N T C O O R O I N A T t S 

JOINT X y z 
1 _,. 000 c. 000 o. 000 
2 _,. o oc C. OClO J. 000 
J -9.000 o 000 6. 000 
4 -(LOCO o.ooo 9. OO'J 

' -9.000 o.ooo 12.000 

' -9. 000 o .o o o 15.000 
7 -9.000 o. 000 lB. 000 

12 -3.000 o.ooo o. 000 
Il -3.000 o.ooo 3. 000 
14 -3.000 o.ooo 6.000 

" -3.000 o.ooo 9. 000 

" -3.000 o. 000 12.000 

" -J.OOO o. 000 1 !>. 000 
18 -J.OOO Q, 000 le. 000 
2l 3.000 O. ClC'C o. 000 

" 3. o oc o.ooo 3. oco 
" 3. 000 o.ooo 6. 000 

" 3' 000 o. 000 9. 000 

" 3. 000 o.ooo 12.000 

" 3. 000 o.ooo 15.000 
29 3.000 o.ooo 18.000 
JO 3.000 o.ooo 21.000 

" 9. 000 o.ooo o. 000 

" 9.000 o.ooo J. 000 

" 9. 000 o.ooo 6. 000 

" 9. 000 o. 000 9. 000 
]8 9.00~ o. o oc :2. oc o 

" ,.000 o. 000 15.000 
<O 9.000 o. 000 19.000 
41 9.000 o.ooo 2l. 000 

e s r S A P 2 o o o fiNI'I'E ELEMEN'I' ANALYStS OF S'I'RUC'tVRES PAGE 
PROGRAM: SAP2000/ fiLE: \Milldocumentos\eurso!!ap2000\ej•mplo9, EKO 

P A '!' T E R N S 

PA'l"l'ERN 
DtfAULT 

es : 

R E S T 

JOINT 
1 

12 
2l 
]4 

e s 1 

JOINT 

S A P 2 O O O FINITE E~tHtN'l' AN~YS!S Of S!RUCTURES PAGE 4 
PROGRAH: SAP2000/ fiLE: \Mi "documento!l\curMsap2000\ejemplo9, EKO 

R A I N T O A T A 

U! U2 Ul RI Rl 
U! U2 U) RI RJ 
Ul U2 Ul RI Rl 
Ul U2 Ul RI Rl 

S A P 2 o o o riNI!E ELEMtN1' ANALYSIS OF S!RUCTURl:S PAGE ' 
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M A T E 

MAT 
t.ABEL 

S!EEL 
eooe 

OTHER 

e S I 

! A L 

NUMBEFI 
TEMPS 

PROGRAM· SAP2000/ FILE: \Mi sdocum@'nt<::~s\ cur .so.sap2000\ejemplo9. El': O 

PFIOPERTY 

WE!GHT Pf.P 
UNJ T VOL 

0.783JE+Oi 
0.2403E+Ol 
0.2403E+Ol 

O A T A 

MASS rEFI 
UNl T VOL 

0.7981E+OO 
0.244BE+OO 
0.244BE+OO 

m:srGN 
CODE 

S 
e 
N 

S A P 2 0 O riNITE ELD-!ENT AN'ALYSIS Of STRUCTURES PAGt 
PROGRAM: SAP2000/fi LE: \M1 sdocumentos\cur .so.sep2000\ ejW~~plo9. EKO 

T E M P E R A T U R O E P E N O E N ; O A T A 

KA.TERIAL PROPERTIES 

MAT 
LAS EL "'" MODULVS Of ELASTICITY 

El E2 EJ 
SHEAR MOOO'~Ir 

Gl2 G13 

STEEL 0.00 0.204E:+OS 0.204[+08 0.204E:+OS 0.784E+07 0.784E+07 0.784[+07 

eONe 0.00 0.253E+07 0.253E+07 0.253[+07 0.105E•07 Q.l05E+07 O.l05E+07 

OTHER 0.00 0.25JE+07 0.253[+07 0.253E+07 0.105E+07 Q.105E+07 0.105E+07 

e S I S A P 2 O O O riNlrt EL!:MtNT ANA:.YSIS Of STRUCTURES PAGE: 7 
PROGR.AM: SAP2000/ fiLE:· \Ml sdocument.os\cur sosap2000\ej.mpl o9 .EKO 

! E M p E R A T U R E O E P E N O E N T O A T A 

THERMAL EXPANSION COEffiCIENTS 

MAT 
LABEL 

STI:EL 

CONC 

OTHER 

e S I 

TEMP COEffiCIENTS Of' THERHAL EXPA.NSION 
Al Al A3 A12 A13 "'' 

0.00 O.ll7E-04 0.117E-04 0.117E-04 O.OOOE+OO O.OOOE+OO O.OOOE+OO 

0.00 0.990E-05 0.990E-05 0.990E-05 C.OOOE+OO Q.OOOE+OO O.OOOE+OO 

0.00 0.990E-05 0.990E-05 0.990E-05 O.OOOE+OO Q.OOOE+OO O.OOOE+OO 

S A P 2 O O O f'INITE ELE:Ml:NT ANALYSIS Of STRUCTURES PAGE 
PROGRAH:SAP2000/f1Lt:\Misdocumentos\cursosap2000\ejemplo9.EKO 

T E M P E R A T U R E O E P E N D E N T O A T A 

MATERIAL PROPERTIES 

MAT 
r.ABEL 

STEtL 

CONC 

OTHE:R 

C S l 

TEMP POISSONS AATIO 
U12 Ul3 U2J Ul4 U24 UJ4 Ul5 ~25 U35 U45 Vl6 U2~ U3~ U46 U56 

o.oo o.J o.J o.3 o.o o.o o.o o.o o.o o.o o.o o.o o.o o.o o. o o.o 

0.00 0.2 0.2 0.2 0.0 0.0 o.o o.o o. o 0.0 0.0 o.o 0.0 0.0 0.0 o.v 

0.00 0.2 0.2 0.2 0.0 o.o 0.0 0.0 0.0 0.0 o.o o.o 0.0 0.0 0.0 0.0 

SAP2000 fiNITE ELEMENT ANALYSIS OF STRUeTURES PAGE 
PROGRAM: SAP2000/ fiLE; \Mi sdocumen tos\(:u r sosap2000 \@ J enpl o'1. tKO 

MATE:RlAL PROPERTitS 

"'" LAB<L 

CONC 

'"'' 
o.oo 

YIELO 
fY 

36. DO 

C S S A P 2 O O O rtNITE: ELEMtNT ANALYS!S Of S'!RUCTURES PAGE 10 

f R A M 

SEe'!lOtJ 
LA.BEL 

f'SECl 
m 
FS2 

PROGRAM: SAP2000/ rtLt: \M111documentos\CI.f sosap1000\ejempl o9. EKO 

StCTJON 

SKAr>E 
THE 

' ' ' 

PROPERTY 

DEPTH 

0.500 
0.600 
1.000 

rLANGt 
WIDTH 

TOP 

o. 300 
0.600 
0.400 

D A 1 ;:.. P R 1 S M A T l C 

r...ANGt l.'tB fl..ANGE F"...ANGt 
'!H!Ct' TH:Ci' WIO!H '!H!Cr 

TOP BOTTOM BO'!TOM 

e S S A P 2 O O O fiNITE tLEMENT ANA.LYSIS Of STRUCTURES PAGE 11 
PROGRA.'-1: SAP2000/ FIL!:: \Mi sdocumentos\c::ur so.:~ap2000\ej«nplo9. EKO 

F R A M E S E C T I O N P R O P E R T Y D A '! A RISHATIC 

SECTION AXIAL TORSIONA.L MOMENTS OF INERTIA SHEAA AREAS 



IJU!<L AAI:A CONSTAN'!' !33 112 A2 Al 

- fS!:Cl 0.150[+00 0.2a2E~02 Q, JlJE-02 O.llJE-02 0.125E+OO 0.125E>•OO 
rs¡ 0.360E+OO 0.183E:-01 0.108E-Ol O. lOSE-01 O.JOOE+OO O. JOOI:+OO 
FS2 0.400E+OO 0.160E-01 o.JJJt-ot 0.53JE-02 0.33JE+OO O. 333E•OO 

es S A P 2 o o o FINITE ELEMt.NT ANAI.YSIS OF STRUCTURI:S PAGE 12 
PROGRAH:SAP2000/FILE:\Misdoeumentos\cursosap2000\•jemp1o9.EKO 

F R A H E S E C T 1 O N PROPERT r D A T A - P R I S M A T I e 

SECTION MAT ADDITIONAL AODITION'AL 
LABEL LABEL MASS PER wttGHT PER 

LENGTH LENGTH 

FSE:Cl S TE: EL Q,OOOE•OO O.OOOE•OO 
FSl e011e O.OOOE•OO O.OOOE+OO 
FS2 CONC O.OOOE+OO O.OOOE•OO 

es S A p 2 o o o F"INITE tLEMC:NT ANAL YS I S OF STRUCTURES PAGE lJ 
PROGRAM: SAP2000/fiLE: \Mlsdocumentos\cureosap2000\ej~plo9.EKO 

F R A H E E L E M E N T D A T A 

EL EME N! JOINT JOINT ELEMENT END-OFFSET-LENGTHS RIGID-END NUMBER OF 
LABEL EN0-1 tND-J LENGTH E:ND-l E:ND-J fACTOR SE:GHE:NTS 

1 1 ) .000 o. 000 o. 000 0.0000 ' ' 2 J J. 000 o. 000 o. 000 0.0000 ' J J 4 J. 000 o. 000 o. 000 0.0000 2 

• • 5 J.ooo 0.000 o. 000 0.0000 2 
5 5 ' 3.000 0.000 o. 000 0.0000 ' ' ' ' 3.000 o.ooo o. 000 0.0000 2 

11 !2 lJ 3.000 o.ooo o.ooo 0.0000 2 
12 lJ l4 J.OOO 0.000 o.ooo 0.0000 2 
lJ l4 15 3.000 0.000 o. 000 0.0000 ' 14 15 16 3.000 o.ooo o. 000 0.0000 2 
!5 16 n 3.000 0.000 o. 000 0.0000 ' "'~/, 
16 n 18 J.OOO o.ooo o' 000 0.0000 ' 21 " " J.OOO 0.000 o. 000 0.0000 ' \l 

" " " J.OOO 0.000 o. 000 0.0000 ' " " " J.ooo 0.000 o.ooo o.oooo ' ·;: 

" " " 3.000 0.000 o.ooo o.oooo ' " " " 3.000 0.000 0.000 0.0000 ' " " 29 3.000 o. 000 o. 000 0.0000 ' " 29 JO J. ooo o. 000 o. 000 o.oooo ' Jl " 35 J.OOO o. 000 o. 000 o.oooo ' " 35 J6 3.000 o. 000 o.ooo 0.0000 ' JJ 36 ,, J.OOO o. 000 o. 000 0.0000 ' 34 " " J.OOO o. 000 o. 000 0.0000 ' 35 " 39 3. ooo o. 000 o' 000 o.oooo ' 36 39 40 ) . 000 o. 000 o. 000 o.oooo ' " 40 41 3.000 o.ooo 0.000 0.0000 ' ' 4l ' lJ 6 .ooo 0.000 o. 000 0.0000 • 
" J l4 6.000 0.000 o. 000 0.0000 

" 4 15 6.000 0.000 o. 000 o. 0000 .. 5 16 6.000 o.ooo o. 000 o.oooo 
45 ' " 6.000 0.000 0.000 o.oooo .. ' l8 6.000 o.ooo 0.000 0.0000 
51 lJ " 6.000 0.000 0.000 0.0000 

" 14 " 6.000 0.000 o. 000 0.0000 
53 15 16 ¡;' ooo 0.000 o. 000 o. 0000 

" l6 " 6' 000 0.000 o. o oc o.cooo 
55 " '" ".oc o o.oon o. 000 O. JODO 
56 18 " 6.000 O.Q(lO o. o oc 0.0000 

" 14 35 6' 000 0.000 o. ooc o.oooo 

" " 36 6' 000 0.000 o. 000 o.oooo 
63 " " 6.000 0.000 0.000 0.0000 .. " " 6.000 o.ooo 0.000 0.0000 
65 " JO 6.000 o.ooo 0.000 o.oooo 
66 " 40 6.000 o.ooo 0.000 0.0000 

" JO 41 6.000 0.000 0.000 0.0000 

e s 1 S A p 2 o o rtN;TE: E:LrMr.NT AN.A.L'l'S!S or snucrvRr.s PAGE: l4 
PROGRAM: SAP2000/rl :.E: \H~~~~~um~oto1\cur3~~~p2000\elftmplo9.tKO 

f R A M E E L E: M E: N D A T A 

E:LEHEN! SECTION LOCAL COORD PLN PLN PLANE PLAN E COORO 
LABEL LABE:l. PLAN E SYS!EM 1ST 2NO JOIN!A JOIN!B ANGLE 

1 FSl 12 o ., •X o o 0.00 

' FSl 12 o •• •X o o o.oo 
J FSl 12 o ., •X o o o.oo 

• FSl 12 o ., •X o o 0.00 
5 FSl " o •Z •X o o 0.00 

' fSl 12 o •Z •X o o 0.00 
11 FSl 12 o •Z ., o o o. 00 
12 rs1 12 o •• ., o o 0.00 
lJ FSl 12 o •• •X o o o.oo 
14 FSl 12 o ., •X o o o.oo 
15 FSl 12 o ., •X o o o.oo 
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16 rSJ 12 o ., •X o o o.oo 
21 rs1 12 o ., •X o o o.oo 
22 rSJ 12 o ., •X o o 0.00 
2J rs1 12 o ., •X o o 0.00 
24 rs1 12 o ,, •X o o 0.00 
25 rs1 12 o ., ,, o o 0.00 
26 fSl 12 o ,, •x o o o.oo 

" rSJ 12 o ,, 
" o o 0.00 

Jl rs1 12 o ., " o o 0.00 
32 rs1 12 o ., " o o 0.00 
33 FS1 12 o ., •X o o 0.00 
34 rs1 12 o ., •X o o 0.00 
35 rs1 12 o ., •X o o o.oo 
J6 rs1 12 o ., •X o o 0.00 ,, FSl 12 o ., •X o o o. 00 

" rs2 l2 o ., •X o o 0.00 

" rs2 12 o ., •X o o o.oo 
43 FS2 l2 o ., •X o o o.oo .. rs2 12 o ., •X o o 0.00 
45 rs2 12 o ., •X o o 0.00 

" rs2 12 o ., •X o o 0.00 
51 rsz 12 o ., •X o o 0.00 
52 fS2 12 o ., •X o o 0.00 
53 rs2 12 o •Z ., o o 0.00 

" fS2 12 o ., •X o o 0.00 

" FS2 12 o ., •X o o 0.00 

" rsz . ' ' ., •X o c.oo 
6l rs: 12 o ., • X o 0.00 
62 FS2 l2 o ., •X o o 0.00 
63 '" l2 o •Z ., o o 0.00 

" '" l2 o ., ,, o o 0.00 
65 rsz 12 o ., •X o o o.oo 

" fS2 12 o ., •X o o o.oo 

" fS2 12 o ., •X o o 0.00 

e s r S • p 2 o o o ri NI TE ELE'.MENT ANALYSIS Of STRIJCTURES PAGE ¡; 
PROGRAM: SAP2000/riLE:. \Misdocumentos\cursossp2000\ejemplo9.EKO 

i O T A e w E: l G H S • N O M A S S E S 

SECTION WE!GHT MASS 
LABEL 

rSJ 67.4655 6.9740 
fS2 109.5593 11.1629 

TOTAL 177,0241 16.0370 

e S ¡ 
S ' 

p 2 e o o fiNITE. ELLMENT ANALYSIS OF STRUCTURES PAGE " PROGRAM: SAP2000/ n LE:\ Misdocumer.tos\ cursos!lp2000\ej empl o9. EKO 

L O A D C O N D I T ! O N vtR~ 

SELF-WEIGHT MULTIPLIER FOR ENTIRE' STRUCTURE .. O.lOOOE+Ol 

OISTRIBUTE:O SPT\N LOADS ON rAA.HE ELEMENTS 

ELE>IENT LOC DISTANCE DISTANCE rORCE rORCE M<>I0/1 M<><EN! 
l..'Jl<L oor AT STAAT AT END AT START AT END AT START AT ENP 

4l U2 O.OOOE•OO O.lOCE•Ol -0.200E•Ol •O.ZOOt•Ol 

" U2 0.000[+00 O.IOOE•O: -o.zoot•Ol -0.200E•Ol 
43 U2 Q,OOOE+OO O.lOOE•Ol -0.200E•Ol -0.200t•Ol 
44 U2 O.OOOE+OO O.lOOE•Ol -0.200[•01 -0.200[•01 
45 U2 O.OOOE+OO O.lOOE•Ol -0.200E•Ol -0.200[•01 

" U2 O.OOOE•OO O.lOOE•Ol -0.200E•Ol -0.200E+Ol 
51 U2 O.OOOE+OO Q.lOOE•Ol -0.200E•Ol -0.200E•Ol 
52 U2 O.OOOE+OO O.lOOE+Ol -0.200E+Ol -0.200[+01 
53 U2 O.OOOE+OO 0.100[+01 -0.200E•Ol -0.200E•Ol 
54 U2 o.ooor .. oo O.IOOE+Ol -0.200t+Ol -0.200E+01 

" U2 O.OOOE•OO O.lOOE•Ol -0.200t+Ol -0.200t+Ol 

" U2 O.OOOE•OO O.lOOE•Ol -0.200[•01 -0.200[•01 

" "' O.OOOE•OO O.lOOE•Ol -0.200E•O! -C.200E•Ol 
62 U2 0.000[+00 O.lOOE•Ol -0.200[•01 •0.200E•Ol 
63 U2 O.OOOE•OO 0.100[•01 -0.200!:+0: -0.200t•Ol 

" 1.!2 C.OOOE•OO O.lOOE:•Cl -0.200[•01 -0.200[•0: 

" U2 O.OOOE•OO 0.100E:•Ol -0.20CE•O'. -C.200E•O: 
66 uz Q,OOOE+OO O. lOOE+Ol -0.200[•01 -0.200E•Ol 

" U2 O.OOOE+OO 0.100[+01 -0.200E•Ol -0.200t+C1 

L O • D e O N O I ' ¡ O N LATERAL 

SELr-wtiGHT MVLTIPLIER roR ENTJRE STRUCTURE • O.OOOOE•OO 

JOINT fORCf.S IN LOCA.:.. COOR:JINATES 

JOINT fORCE 
L.ABEL 

2 0.~00[•01 

J O.~OOE•Ol 
4 O.~OOE•Ol 

5 O.SOOE•Ol 

fORCE fORCE 
2 

O.OOOE•OO O.OOOE•OO 
O.OOOE•OO O.OOOE+OO 
O.OOOE•OO O.OOOE•OO 
D.OOOE+OO O.OOOE+OO 

MOMEN'l' 

O.OOOE•OO 
O.OOOE•OO 
0.000[+00 
O.OOOE+OO 

MCI-lf.N7 

' 
0.000[+00 
O.OOOE+OO 
O.OOOE•OO 
O.OOOE+OO 

MOMEN':' 
J 

O.OOOE•OO 
O.OOOE•OO 
O.OOOE+OO 
O.OOOE+OO 

··~ 

210 



O.lOOE>O: O.OOOE:•OO O.OOOE•OO O.O'JOE·:~ Q,QOOf:+QO O.OOOE:•OO 

' 0.100E:•02 O.OOOE•CO O.OOOE:·O~ O.OOOE•UC O.QOOE•OC G.OOOE:•CO 

S A p 2 O O O riNITE E:LE:MtN':' AN.AJ.'!SIS Of STRUCTURE:S PAGE: 17 
PROGRAM: SAP2000/FILE:: \Misdocu"'entoe.\cur soup2000\ejemplo9, EKO 

OUTPUT S E L E. C T I O N 

DISPLACEHEN'IS AT JOINTS 

LOAD HOCES SPEC HIST HOVE '""" LA!ltL LABE:L LABEL LABEL t..a.BEL 

VER! 
LATERAL 

APPLIE:D ANO INTERNAL LOADS AT JOINTS 

LOAD HOCts SPEC HIST HOVE '""" LAlltL LA!ltL LABtL LA!ltL LABtL 

VER! 
LATERAL 

INTER.NAL fORCES AT. ELE:MENT fRAME 

LOAD MODES SPEC HIS'! HOVE '""' I.ABEL LABEL I.ABEL LA!ltL LABE:L 

VER! 
LATERAL 

JOINT roRCES AT ELEMENT f"RI\ME 

LOAD MOCts SPEC HIST MOvt COHB 
LABr.L LABtL LABt:L LABtL LA.BtL 

VER! 
LATERAL 

es 1 SAP2000 riNITE O.EMtNT ANJU.YS!S Of STRUCTURES PAGE " PROGRAM: SAP2000/ FILE: \MJ.sdQCUIIUtntOli\CUfliOllap2000\ej empl 09. EKO 

I N P U T C O H P L E T E 
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S A P 2 O O O (Al 
Structural Analy,i• Pr~r.-:o 

Vf'r:oie>l'• E6.10 
COJ~'f\!'lh' H'l l'llfi-lqq¡ 

Cf.t1T1!Tl:RS -'lltl STf(W:TIJRt.C::, TN(. 
!Ul ti<Jht.'J l'"'l>tt'>'ot<1 

thi' r.opy of s~r2000 l~ f~r t~ ~x~lu,lve u'• of 
nrr. LlC.'D!Stl: 

llnlluthonz.-d UM' l' in viol.!ltion of F'to'Óllral <=opyright l.,...:~ 
It 1' th+ r~~~n,:,ibility of tbt< us.r to v~rify all 

ft!:rult,:, ~·roduc-.-1 t'Y th.h pn>qr-
21 Har 2'000 0!1:11:19 

PA~ SAP2000- VEA..~IC»4 [6.10 f'JLE:E:JIMPL09.('.(ff 
fREEOOJof OJSPLAC'EJofENT DEGAEEr> Of 

(A) A<'t 1 Yt< flOf, t<'<fl!ll i t>r i 1m f<q\lltt i ¡;m 

(-) Rt-:<trllinW !X)f', tf'IIC'tior. {·c•putt<o:l 
f•) r:on:!<ttainf'd [-.Jr 
1 1 Null oor 

.m!NTS 
1 

tiX 1JY UZ RX Rl' 

2 TO 
12 
13 TO 
23 
24TO 

" 3~ TO 

' A 

18 A 

30 A 

11 A 

A 

A 

A 

A 
A 
A 
A 
A 
A 
A 
A 

PAGE 1 

P~ SAPLOOO 
J()lNT DI 

- VEASH .... 
S (• L A. <': 

A 
ELlO f'lLE:E • .IEMPL09.•.)(tf PAG.t: 2 
E: M E: N T S 

tli.NlSt.AT1f~S '-NO fi.O'I'.\T1(~, lN (,"U>BA.L <':f)(')RlJUl.\TI:!O 

~ vt~T ---------------·--
,J(J1N'I' 1.11. IJ::. 

] .000000 .oooooo 
2 -9.41E-06 -0.00022~ 

3 1.4JE-05 -(1.00041.\ 
4 3.0?[-05 -0.0(>05(.4 
5 5.38E-05 -0.000615 
6 1.!13E-05 -0.000748 
'1 0.000151 •0.000?80 

12 • 000000 • OOO<X'<l 
1.~ 1.22'[•0(. -0.000400 
14 1.5.1[-()5 -(l.(l(l(li.ll 
1~ ~.I<IE-0'> -0.000'1~1!, 

H 5.H.r-(•~ -o.oo;;·~~ 

11 a.zar-o~ -o.ooU24 
16 O.OOOD!> -O.OOl:i!-'0 
2J .000000 .000000 
14 1.2?E-05 •0.000425 
25 1.86[-05 -0.0007!1] 
1f ·'-43E-05 -0.0010?.1 
2"1 ~ .• 65[-0~ -U.OOl?'lfl 
~·¡. k.f.SE-0'> -{ó.O(ll1f.O 
<'<1 0,{1(1()107 •(o,\1(1}~,:,7 

JO -0.00011<. -0.011 !.,'>': 
.i4 • 00(,()(1(1 • (100000 
1'' ~ .l~f-:·•·, -V.(IO(r~\; 

:lt· l. <I'IE·O:' -(1, 0004'17 
" J. ~IE-0~ -0. OOM·fl"' 
3fl ~.71E-OS •0.000841 
J9 a.1aE-o~ -o.ooo,~4 

40 0.000103 -0.00102"1 
41 -0.0001~2 -0.001060 

LOAD LATERAL --•w·-···---------
,TI.HHT tfX liZ 

1 • 000000 . OOOCIOO 
:• O.OOH<-t; '1.14f-(lC., 

0.00~·~~ 0.000)4~ 
(¡. ()(>'7 ~ l ! 
O.Cl0!<'<7'l 

o. (1()('1 ~~~ 

0.000211 
o. oo·~~::; o. O(•o;·:::: 

1 o.o1o•~~ o.oooz::• 
ll .OOOOQO .000000 
13 0.00.61• -l.OJE-0~ 
1• 0.0063!17 -l.20E-O~ 

1~ o.o011a1 -1.1~E-O~ 

H o.oow~~• -'l.fi::-E-ol. 
n o.OO!,o!lfi<- -1. ~n-o¡. 
Hl O.Ol040í -(,,Q(JE-(11 

PR~'J".f\AM $J.P2~00 - 'll:A$rOH Ei .10 

kY 
-•.54E-05 

fi.!HE-05 
8.6~-0!'1 

9.63E·O~ 

0.000104 
0.000106 
0.0001'7!1 

-1. 4!l.E-01 
LfilE•Of· 
1.60:•0" 
:. ~OE-0!> 
i.'!">C·O~ 

3.9f!E-05 
!>.OJE·O~ 

4.3JE-OG 
.\.9')[-0fi 

-6 .OOE-0~ 
-9.02[-0(, 
-1.1 JE-05 
-: .(IU-~1., 
•L?4E·O~ 

~. 'll f·O!'-

-« .• , tf:-v~. 
-1. 'lf!E-05 
·!<.(.~E-05 

-<I.O"'E-05 
-9.40E-05 
-0.000114 
-O.OCJ02'24 

O,OO.c'OOf. 
0,0(1(15<-f> 

(1, ()(,:::·í ( 
o.ooone. 
O.OOOHt 
9.:'1E-05 
0.00211.1 
O.OOQ2fl1 
0.00019'1 
0.00016) 
O.OOOlli 
9.<>:-r-o~ 
4.~iE-(J~. 

J '~ : H 7 ~ r , ? ~ A ~ i H ! N • S 
TkJIJlSLAT100S A.tW fi.Ot.\Tl0N5, IN G'LOB/..1. (.'CJ()fU'lNAtl:.$ 

,lOHI'! 1r.( IJZ R'C 
2J .000000 .oooooo 0.002104 
24 0.004600 <), tJZL-O'i O. OOO~ilb 
25 0.006382 l.lZE-05 0.000191 
26 0.001'113 1.04E-05 0.000163 
2'1 0.0089J8 a.33.E-Of. O.OOOJ]f. 
2fl 0.0098!>. !!.<15.E-Of. !I.?~E-05 

l9 0.01031!1 4.39E-Of. 4.91E-05 
·'0 0,0}{15.il 4.64[-0(. L HE-05 
.H .000000 .000000 0.0019(11 
:1~ 0.004.,t<.l -'•.OS.t-to:-. 
Jt> (l.006JBO •0.00014'4 
.n 0.00"1161 -O.OOCllt<7 
.l8 0.009~32 -0.000210 
39 0.009642' -0.000220 
40 o.olOJ66 -o.ooOZ2J 
41 O.Ol05.'i2 -0.00022'.' 

PAOCoiW>I SAPZOOO - V!:ASJCW E(;. lO 
A P P L I E O L O A O ~ 

0.\IOO:l<-4 
O.OOO,I(H< 
0.000¿(;(. 
o.ooon.' 
0.000160 
9.2'?E-05 
.l.aJE-0!1 

FORI':t:S MD W.fotENTS .IJ:'t'lN<. ~ JOlNTS, IH GLOBAL CClCIROlJO.'nS 

LQ.\0 VEfi.'I' ------------------
J(!lNT f".( TZ. 

1 .000000 -l.l974U "' .OOüOOC 



~' 

' .000000 -11.4?7'164 
J • 000000 -11.4??~f.4 

• .000000 -JJ .471'~~ 4 

' .oooocw -J:.P1'-i·4 

' .000000 •]].4'7H(.4 

' .OOOQOO -10. HW552 

'' .000000 -l.2'11tl] 
lJ .000000 •ZO .. lil]Ot ,. .000000 •20.JG1104 

" .000000 -20.36ll04 

" . 000000 -20 .. \61104 . 

" . 000000 -:.-o. :1fol 10-1 

" .000000 -l'I.06l6ql 

" . 000000 -1.2'1741.' 

" .000000 -:'O.J~llOt 

25 .('(l(l0fJ0 -lO. 1G1HI4 

"' .000000 -20,J6JHI4 

" .000000 -20 •• lG1104 

" .000000 -20 . .161104 

" .000000 -20 .. lG1104 
30 .000000 -10.180!>52 
34 .000000 -1.297413 

" • 000000 -1 l. 471964 
_,(, • 000000 -11.417964 

" . 000000 -1J.4?H64 

-'' .000000 -lJ.Pi'lf.4 
y¡ .00{1(;00 -lJ.4iH(.4 

" .000000 -n. P1'H·~ 
4l .000000 -10.1fl0552 

LOAD LATERAL ------------------
,JOINT ~ n 

' 5.000000 .000000 

' !>.000000 .000000 

• !>.000000 .000000 

' 5.000000 .oooooo 

' 10.000000 .oooooo 

' 10.000000 .000000 
PRC..."".AAH 5AP2000 - VE~>I~ Eí-.10 
f.~LOI\AL F {) R l' E ~AL A 

(I.!IA3U'l 
& • fi!I.IJ.l'l 
!l.!ofoll.l'< 
!l.k!I,J.I~• 

A.llkJU'< 
!1. llfl.ll39 

.000000 
).(;0[-14 
1.60E-14 
1.60E-H 
l.60E-H 
1.f.OE-H 
1.60[-H 

• 00000[1 
1.(.0[-]4 
l. f.O.E-H 
l.GOE-14 
l.60E-H 
1.60E-H 
1.60!:-14 
8.883139 

.000000 
-8. 883l.l9 
-a.aaJB9 
-fl.llftJU'l 
-fl.llf\Jl ~~ 
-II.H•.llJ'l 
-a.llk,ID'< 
-ll.ti!IJD~ 

"' .oooooo 
.oooooo 
.000000 
.000000 
• 000000 
.000000 

N r; E 
T\'11',.\!.. f'\'>R("t A/l:l'l "''.MDll' AT THE l'lRh',JIO, IN C.Ll.)ML l"C<•Rfl!NA!'t:~ 

L011.L• Vt:RT ------------------

f1 U:: E:.TtMP.L09. OUT PAl';i; !'1 

n n n • ~ ~ 
APM.lt:D .oooooo .oooooo -~os.ozn47 .oooooo U7. 7JS574 .oooooo 
RtAC"rMS 1.09t-14 .000000 405.024747 .000000 -1J7. 7.3SS74 .000000 

Tf.')fAL 1.09!:-H .000000 -!1.6!1E:-1J .000000 3.41-E-13 .000000 
LI.W'l LATERAL ----------

n N n ~ ~ ~ 

APPL!En 40.000000 .000000 .000000 .000000 4!10.000000 .000000 
REAl-rNS -40.000000 .000000 1.07[-14 .000000 -4!10.000000 .000000 

TOTAL -G.J~E-H .000000 1.01'!:-H .000000 4'.:>iE-12 .000000 
PEKIGRAH :\AP2000 - Vl:SL"HON tL 10 fiLE: f:,JtMPU.W.OI.fT PAGE f, 
FRAHE fLEHEN! JO!NT FOR~E~ 

F'Ok(."tS ANO ~TS ACTING (JN O.EMOUS, IN C."LOB-'1. COORDlNA.TF.S 
tl.EH 1 ~····~·•••••••••·~ 
L()IU) VERT -----------------

JOlHT rx rY n - "' MZ 
1 o.eHtos .oooooo 69.!>61426 .000000 1 .. l8E-16 .000000 
2 -0.81660!> .000000 -66.966601 .000000 2.449816 • 000000 

.L(W') LAT.EAAL --------------
JI.UHT rx rr rz >« ~ "' l -8.982460 .oooooo -27.7!>6703 • 000000 6.9.\E-15 .000000 

2 8.982460 .oooooo 27.756703 • 000000 ~:>6. 947381 .000000 
El.EH' 2 ------------------
u:~::. \t'ER'T ------------------
~INT n n r: ~ ~ "' 2.fill'i._4 .OO!lOOO 'ill.'iOOlZ ,1)01)01)!) ).941074 .000000 

J -l.hllS~,4 .000000 -~':...')0'.149h .000000 J. ll'l l5Bd .01)0000 

U~D ~Tt~~ ------------------
=n n n n "" ~ ~ 

2 -5.9541)96 .000000 -17.596670 .000000 -6.9246110 .000000 
.) 5.95.41:196 .000000 17.596670 • 000000 -lO. 94000& .oooooo 

tLDH 1 •••••••••••••••••• 
LOAD vtltT -----------------
=n n n n - ~ MZ 

j 2.1)07400 ,OOtlOOO 4h.'ll!ll6t~ .000000 4. 1:009111 .000000 
4 -: • .o;o~•oo .onr:noc -u.l'lPil1 • OOI}t}Qr, 4, lOl ~ 1!3 ,000001) 

LOAD LATERAL ------------------=n ~ n n ~ ~ HZ 
l -<;.,7~0:1lijJ .01)01)1)() -ll.7Jlilll • 000()01) -1!. ~0741>4 .nnooon 

<:.. 7:2f>~J .noooon 11.' WlJl . 00001)0 -11. ')lill~4 .000000 
ELEH 4 ................................ .. 

~ VERT ------------------
=n ~ n n ~ ~ m 

f 3.01139f· .000000 .l:->.1l?Ofr1 • 000000 4, 4'>~042 , 000000 
5 -3.0173~6 .000000 -32.622262 .000000 4.59.ilH .000000 

PAlX~ SAP2000 - VER!>H.Y<f Ei.lO FILE:: EJD4'PL09.0UT PAGl: 1 
F R A H E E L E M E N T J O J N T F O R C E S 
1'\'lRt.L:.> AHO "'-'MENT'J .e.t""TING t'ltl E!..D':fh"f!l, IN GLOE\AL l'(I'..A.OIW.TI:.; 

LOAD LATtRAL ------------------
=n n n n ~ • ~ 

~ -4.6fitJG4 .ooon,¡o -7.01~9J& .l)lloooo -6.h4J9~o .oooooo 
~ 4.661J64 .oooooo 7,01~916 .oocaryo -7.J~0172 .oooooo 

ELEH 5 ·---··•••--·--•••• 

LOAn VEAT ------------------
J'OJNT f'X N HZ n ~ ~ 

5 3.153406 .000000 .oooooo 23.266:1!11 .oooooo 4. ?0(.837 
6 -J.1.S3406 .000000 .000000 -20.6?1~!'15 .000000 4. 753.1{11 

LOAn LATERAL ------------------
,TOI NT f'X FY HZ " HX ~ 

5 -J.9<'(.H1 .OOOOOV .000000 -.i.L2!'1fl7<i .000000 -!l •. 10Gfl{.!'l 
~ 3.926141 .000000 .000000 .\.22.5(17<1 .00(1{100 -6 •• ?1516 

EJ..lJotl (. ---·--------------
1..4\f.() VERT ------------------

"' 
,., rz "" 

,.,. HZ 

21-3 



6 3.7~902 .oooooo 
7 -:1. 7~0902 • 0000fJ0 

U~ LATEJV.L ·-------------·-·-
JOIHT fX fY 

6 -].589671 .oooooo 
7 l.!>A967) .000000 

ELDf 11 -----------
~ ~T --------
~~~ n n 

12 0.010682 .000000 
13 ·0.0106a2 .000000 

VWl V.Tl:RJU. -----------
J()lNT FX f'! 

1].18192) 
-fi.,SQ)09f! 

N 
•0.79~336 
0.19~336 

n 
112. 73164S 

•UO.U6820 

12 -11.oa~~11 .oooooo J.126oa~ 

lJ 11.08~411 .oooooo -J.12b08l 
M<t'.QW1 Si\PlOOO - vt:k.SH.W E.6. 10 

.oooooo 

.onoooo · 

"" .000000 
.000000 

"" .oooooo 
.oooooo 

HX 
.000000 
.000000 

F k ~ H E E L E H E N T J O 1 N T F O k C E S 

C.:lq'I.H•6 
6.2!1~'21 

"' •l. 7.;037$1 
-3.0:'\663~ 

MY 
-J.06t.-18 

O.OJ20H 

.000000 

.000000 

"' .000000 
• 000000 

"' • 000000 
• 000000 

MY HZ 
-LI:Ibt•\fJ .000000 

-JJ.2<;.J2J2 .000000 
nLt.:r..JDWl.l>9.CAIT 

Fút«';t.s Nm M.MEN'i'S N:Tl.NG (lo; Et.tMDnS. lN GLIJ8AL COOIUllAATES 
Et.EH 12 •••••••••••••••••• 
1.1Wl VDtT ----------

J01NT lA n: 
lJ 0.1H793 .000000 
14 -o. Hn9J .oooooo 

V~ V.TtAAL ••··------------· 
.J<)l NT n: rY 

11 -1LS24494 .000000 
~~ 11.~l44U.( .000000 

t:' .. tM 1 \ ................................... .. 

V~ VERT ------------------
JOlNT n: n 

n 
101.912283 
-99.Jl7457 

rz 

rz 
~~ 0.499246 .oooooo 81.505551 
15 -0.499248 .oooooo -78.910726 

LOAD LATERAL ----------------
J(JlNT FX n 

14 -9.271J17 .000000 
1~ 9.271 )7l .000000 

ELE:M 14 ....... - ....................... ... 

LOAO ~1 ·-----------------
J\)1~ rx rr 

1!1 (l.f.'l:'lSJ ,0000<•0 
H •{),f,Q2J8l .000000 

LQIU'l L.ATEAAL ----------------
J'l)JNT rx fY 

1!> -7.8H389 .000000 
16 1.814369 .oooooo 

E.IJ>I 1 !> -----------------
u:~o VERT -----------------

JIJIHT fX f1 

n 
-o. UJJJ'I 
o.ulJ n 

N 
(.1 • .10<1!>0(, 

-:.6.7D68I 

n: 
-C.!>J9~.H 

0.!119534 

16 O.fi7HJO .000000 41.,:0~'/J'IO 
]1 ·0.!114f..IO .00:1(100 •'\l!,h4:!~( .... 

"" • 000000 
.oooooo 

HX 
.000000 
,00004)0 

HX 
.000000 
.000000 

HX 
.000000 
.000000 

HX 
.00(1()0() 
.000000 

"" .oooooo 
.000000 

"" • 000000 
.00(1(1(1{1 

MY 
o. 080Jl6 
o. 1S4062 

"' -lb.~hiH111 
·16.10Hi70 

"' 0.671851 
0.824892 

"' -13.5979~2 

-14.2\t.ltl~ 

"' O.'ot.'IE!O!I 
1.1067.1~ 

"' -1].4!14626 
-11.9~!141 

HZ 
• 000000 
.000000 

HZ 
.000000 
.000000 

HZ 
.000000 
• 000000 

HZ 
.000000 
,000000 

"' ,00(1000 
.000000 

HZ 
.000000 
.000000 

"' .000000 
l. ~1k'-171< • (\(1(1(1(1() 

PRO..';AAM $AP;>OOO - VEPSJOt..¡ Ef .10 FJLE:EH..H'Pl.O't.(llfi PAGE !t 
F ~ A M E E L E M E N T J O ! N T F O R ~ F ~ 
FORCES lUID H!'MtiTS -'i7TUIG otl ELI:HDITS, ttl r.L<>BFI.L f.(X~tllNA.'n:S 

LOAD IJ.TEKIU. ---------------
JOlN'l n N 

16 -6.251986 .OOOúOO 
li b.251986 .OOOQOú 

E.LDf 1 E> --·------------
~ VEAT ------~--------

J\UNT f"X f1' 

n 
-0.6764H 

0.676U.1 

11 (I,Q0)1.'!tl .000000 2J.2?.'!240 
1tl -0.90.'11.18 .000000 ·1&.6184B 

Lt.'tAr• IJ,TFJVU. ------------------
J~um n: n· 

17 -).)~'11'11 .oooooo -0.4!1.1!1~0 

lfl .'! • .'!S7'1<o7 .000000 0.4&:1i>SU 
ELEM ~1 ................................. .. 
U.Vúl 'I'EIIT ------·---------

J01NT n: n rz 
2) -0.0022)5 .000000 lJO.~lJb~l 

l4 0.0022J5 .000000 -1l7.6.11J797 
L<»...> 1..-'Tt:J!Al. -----------------

JOIH'I' rx n 
l) -11 ,l)d <;.1,1,) . f)IVlO:)O 
2( l i. O~ ',h/ l • QI)Orl~H 

t.t.t::l-1' .• ----------·-------
LOAV nrn ------------------
Mn n n ~ 

24 ·li.097S69 .000'}00 10\l. 7JIJ<A7 
~'O 0.097<;.>19 .000000 ·1 1lL 14 )7¡,~ 

VJAD LA.TEkAl. -----------·------
=n n n n 

l~ ·1l.S26709 .000000 -0.41J)~U 

2~· ll.~·;!f>10<l .0()0:)00 O.H'I'·6 

HX 
.000000 
.000000 

"" .oooooo 
.oouooo 

K< 
.00000(1 
.00(1(1(10 

HX 
.000000 
.00001)0 

Ml< 
.00000() 
,')()li•)l)t"l 

"' .000000 
.01)0000 

"' .oooooo 
.01'0000 

MY 
-9.0JY.ltH 
~9. 120872 

Hl' 
1.260490 
1. 45072~ 

Hl' 
-4. ~4'1!>~:0 
-~-~:.'.lk.•7 

"' l.41:1F.-11 
-0.001>70~ 

"" . ~~E:·14 
-)) .1 )¡,')>j~ 

HY 
-o.o<,!..,oo 
-l).~l7lhij 

"' -lb.04JJ6 
-11). \1)';190 

HZ 
.000000 
.000000 

HZ 
.000000 
.oooooo 

"' .00000(1 
.000000 

"' ,000000 
.000000 

J<: 
.001)!)\)'j 
. 001)00 1J 

"' .000000 
.0()1)000 

"' .000000 
.000000 

PR\X';RAM :•AP::OOOO- VEA:;!ON E( ,J(l fl LE: f;,TDfPL011,()0T 
f A A M E l E M E N T 1 n ! H T F 0 A r E S 
F'I)RI,'f;,::: AAfl W#'rf.'li:; AI'TIN<.· .'t~ f.l,f.HFN":':<, IH <,~!)',)IV.L n• .flf•Jii.D.':'E..4 
t!J>! '•. ••••••••••••w••••n 
I..I'.IAD Vt.RT ------------------

J()lNT n.. N rz "' "' HZ 
¿s -0.4l~>~>l~ .oooooo tl9. 56lb7,:.. .000000 -o. ~~'7409 ,1}()()000 
2h 0.4lb6Zij .OOtJOI)Q -a¡,.qr,J•J<AJ .000001) -0.1)::0.;474 .OOtlOOO 

t..C»>.D LA.TERAL ------------------
JotNT n n ., 

"" HY HZ 
25 -9.2199a7 .oooooo 0.2J620l .oooooc -1J.6099'1<:.. .000000 
26 9.27991J7 .000000 -0.2)1>201 .ooooco -H.2299A7 .oooooo 

tLDI 2 4 ................................... .. 

LOAn V&RT ------------------
,TOIIof7 f'X F1' ,., HX Hl' HZ 

2(. -o. ~'Hin .oootlCIO f'•,'/740!-'1 .OOO(ll•{l -o.~·'"~~!> .00(10(10 
n o .... 74041 .oooooo -i.7.1H!H .0110<.100 •\),flfl~'l46 .000000 

Lf~O LATEJV..L -------------·-··· 
,JOINT f'X F1' ri HX HY "' 26 -1.&~~62~ .oooovo O. b](IOQ& .0000(10 -11.4&~'.12!1 .(100000 

PAr;( JO 

';S 

214 



27 7.61~629 .000000 •0.630088 

E.Lf)f 2!> --------·-----.. -
~ VERT ---·--·----------· 

..TOINT rx n 
27 -0.682415 .000000 
28 0.68241~ .000000 

LQI\D LAn:.AAL ------------
JOINT f'X f"f 

27 -6.152927 .000000 
28 6.152921 .000000 

ELEH 2f .............. _ ................ . 

UW! VERT --·--·-·--------· 
J'OlNT rx f'! 

28 -1.090707 .000000 
29 1.090707 .000000 

PR!JG~Wol SAP2000 - Vl:RSlCM U.lO 

rz 
50.249964 

-47.655139 

rz 
0.12?72!1 

-0.72271!1 

rz 
JO. 9262!-3 

•28.Jll417 

.00('000 

"" .000000 
.000000 

"" .000000 
.000000 

Ml( 

.000000 

.000000 

r k A M E E L E M E N T J' O 1 N T r O R C t S 

"" •1.032169 
-1.0150i6 

Hl' 
-8.980128 
-9.~i8651 

.000000 

"" .000000 
.000000 

H% 
• 000000 
.000000 

M't HZ 
-1.J44551 .000000 
·1.917570 .000000 

nLt:I;.)DWL09 .. Q1T PPI.Gt 11. 

f'l'.lftt:I:S ANO M'MDffS -.r:nNG ~ O.DIENTS, IN Gl.ClBAJ.. COORDlNA.TtS 
LC».D l.AT&AAL ----------

J()lNT n. n 
2a -J .. 107681 .oooooo 

rt 
0.472495 

29 ;1. 3071.~1 . oooooo -o. n:n!l 

tLEM ]i ------------------V)AO VERT ................................ .. 
JOlllT 0: T"Y 

19 l.Hl6S9 .000000 11.4~..0!-41 

Jo -2.7SJ659 .ooooory -~.gss11~ 

u~ LATtl!AL ---------------
JOINT FX rt 

29 -0.1b6062 .000000 
JO O.l66D61 .000001) 

ELCM )1 ................................. .. 
l.(JAO vt:RT ............................. .. 

,JOlNT f'Y. l"'t 

rz 
-0.07601!9 

0.076089 

J~ -ll.~lSOS! .000000 ,:¡¿,2\lllOSJ 
v:. n.a=<}J':.l .rJOoñ'l1 -?e,. 7tlllZI! 

~D 1JIITtKAL --·---------------
JfllNt rx rt 

J~ -ll.all;4h7 .oooooo ~7.6llf;76 

J<. A.Ail14.ó7 .000000 -21.t.ll67fi 
ELD-1 r' ... --......... - .............. .. 
L4)IJ'l vtAT ---------·--

JOINT f?( 17 
.~'> -1.<.58i!\Ei .000000 
·'6 1.65fl75fl .00000(1 

U~ LATE.AAL .............................. .. 
• rt)Jt-/1 rx n 

~5 - : •• <1'< l'•(t;· • ('10(1~1{)(1 

rt 
7l.l91U'4 

-61'1.!>'16!194 

" :· .. 501 ]i4 
.,¡. ~-Q-¡3'Hl2 .00000(': -J1.~¡0Jii4 

PROr~ f>APl'CIClO - YrR.:liON [(..lO 

"" .000000 
.000000 

MX 
.000!)00 
.000000 

MX 
-000000 
-000000 

MX 
.0011000 
.ooc,ooo 

• 01)0000 
.00001)0 

"" .000000 
.OOCtOOO 

MX 
• (;(l(•OCtG 
,(t(H'J(I(l(l 

r R A H E E L E H E N 1 O 1 N 1 f O R ~ [ ~ 

"' -4.Sli6i5 
-5. 405.H.9 

"' -0.19764) 
•O • .l005-42 

·4.'.;0t·l~ 

-16.1>61-400 

Hl' 
•4.0.U1574 
•3.9.\769& 

"' ·7 .01 fll '~1< 

-10.9(.1~0fl 

F\'!Rf.'E.$ A.•m H"KXTf, Ar.JJNG '"' .E.UJ-(OIT:.>, JN t~">Mi. t'f•'lROJNATL:; 

El.D-1 _, .. -------------------
LC'NI VERT ----------------

J':'IJHT n¡ ry 
36 -z.a90010 .oooooo 
Ji 2.890010 .000000 

LOAD LATERAL -----------------
,TOINT f1i f'Y 

f'Z 
59.591635 

-56.996(1]0 

-!->.U5i">.1 
5. 715753 

.00(•000 ll.(,2!l'I(,'J 
• ooooco -11. f-2!1'Wl 

E.1.E)! .14 ..................................... .. 
U\A.O vtAT ............................... .... 

..TO!NT FX 17 
Ji -.l-135530 .000000 
38 J.l35530 .oooooo 

LOAO LATERAL ................................... .. 
..TOIHT FX FY 

37 -4.708618 .oooooo 
38 4.7oa618 .oooooo 

ti.Df -'~ .............................. _ .. ... 
Ulo\n VERT ·-------------

J'OlNT FX FY 
Jlj -J.J4S621 .001)000 
.39 ! • ..14S6H .000001) 

l.(J,JW l.ATt.l-11\L -----------
J01NT F>: f"i 

.Ja -J.6689~o .oooooo 
J9 J.6ó8940 .JOOOOO 

tLDM lb •••••••••••••••••• 
~ VERT -----------------

f'Z 
47.1-90685 

-45.09~60 

rz 
Ei. 904383 

-Ei.904J8J 

-J.?.%..1641 

3. li9!-9S 
•J.l79S95 

"" .000000 
• 000000 

"" • GOClOOO 
.000000 

"" • 000000 
.000000 

I'X 
.000000 
.000000 

HX 
.000000 
.1)00000 

HX 
.000000 
.000000 

"' -4.173410 
-t . .\96639 

MY 
-fl.?10fiZ2 
-9.9t-609 

HY 
-4. 665389 
-4.741202 

HY 
-6.666391 
-7. 4!>9462 

-4, 91ill6S9 
•$, 04810J 

"' -4.9311.38 
-6.075681 

HZ 
.000000 
.000000 

"' .000000 
.000001) 

"' .000000 
• 000000 

-.001)01)0 
.000000 

M;'; 
.000000 
.000000 

H% 
• 000000 
.000000 

MZ 
.{J(i()Q(,(, 

• OOCtOOO 

HZ 
.000000 
.000000 

"' .00000{1 
.0000(10 

"" .000000 
.000000 

H% 
.000000 
.000000 

"' .oooooc: 
.000001.) 

HZ 
.000000 
.000000 

-~ n n n MX "' "' 
J9 -J.S6J9J..I .000000 ZJ.1466~0 .000000 -5.161.317 .000000 
40 l.~6..19.ll .000000 -10.6S18Z.S .000000 -S-~'0481 .000000 

PR(wAV&H ,APZOOO - 'i'ERSH'IN tt .. lO fiLf:~EJEHPL09.01JT Pfl(',[: 13 
FAAHE ELEHENT ,TOJN1 rl)Al'E,; 
F\'IRt"f:.S AHO p.fl"'fENT$ AI."TING ON UEM'Cm$, lN ~"oL'.)lVJ. l'(X\RniNAT&.~ 

U."lo'.,") LATEAAL ------------------
J01N1 n: TI' rz MX M'i HZ 

)9 -1. 744ASO .000000 O.ll0bl)91 .000000 ·1.91~115 .000000 
40 1.7446$0 .COOOIJO -O.AIJ6691 .000000 -J,.Jl94JS .000000 

ELDM J7 •••••••••••••••••• 

~ vtRT ------------------
JOUIT nt f"'t HZ n MX "' 40 -2.7SJ659 .000000 .000000 11.505)11.; • 000000 -J.tJ1J90 

41 ::.7Slf>';CI .00000ry .000000 -ll. 910°,111 • ooo:1oo -S.121l'>Ail 
lih\D LA1Eiil/.l. ------------------

·101 NT n', l"'t HZ rz MX "' 40 o.t6MJI)1 .ooc-ooo .oooooo o. 07ti0ll9 .000000 O.t'i$'17':. 
41 •0,1/iliC(,l J¡OQOOO .000000 -o. 07blll!9 ,I)!)QOr)l) -o.tSS'i90 

El..EM 41 -------------·----
LOAO VERT ------------------
=n n n m n "" MY 

2 -l-79494!0 .000000 .000000 tl.t61:'79 .000000 ·{.. 390890 

215 _. 
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ELlM !16 -----------
LCW'J VERT -------
~1~ ~ " 

18 t-6-~u.n .oooooo 
29 -4.6~4641 .000000 

LClo\D LAT&AAL ------------------
,TOINT f"X n' 

H• ~-0~:> ... ~1 .(l(l()GOO 
2'• -~.0~>:·~31 .oooooo 

ELtH 61 -----------------LOAD VERT ................................ .. 
JlHNT ~ n 

24 -1.83370~ .oooooo 
3~ 1.83370~ .000000 

PR('GWf SAP2000 - VERSH"W E6.10 

n 
!f.!>Q!\.7.'4 
8.26104~ 

rz 
-l.T7'<lflí, 

1.:-?'llftt 

,., 
9.2!14470 
8.511809 

"" .000000 
.000000 

"" • {l(l(JO{!(; 
.000000 

"" .000000 
.000000 

F R A M E E L E K E N T J O r N T FORCE S 

"' "' -9.4H.29~ .000000 
5. 713727 .000000 

"' "' "· 1<.t(l~ ..... .000000 
.l,8fiH:.'• .000000 

HY MZ 
-8.741716 .000000 

6.!113733 .000000 
FJLE:EJDfl>L09.0UT PAGE 17 

l"'RCt.S AHD M1'".11EHTS AC'TUiG Otl El.DQ':NTS, IN GLOB-'L COORDlNATtS 

LOAD LATE~ ------------------JOlNT n n 
24 2.1!9JSh4 .O"JOOIJO 
J~ -2.893564 .000000 

LLD1 6:t ................................ .. 

u:~o VERT ------------------
J1.lHll' f'X n 

25 -0.231262 .000000 
36 0.231262 .000000 

~ LATERAL ------------------
~1~ ~ " 

25 0.268149 .000000 
36 -0.26Ql49 .000000 

E.LD1 (,J ............. - .................. .. 

U.Wl VEAT -----------------
JotNT rx n 

26 -0.24~S11 .ooooon 
J7 O.l4S511 .000000 

U>AO l..a.Tl:AAL ----------------
JOINT f"X n 

26 1.017136 .oooooo 
J7 -1.017136 .000000 

l:1.EM 64 .......................... ----
VJAD VERT ................................. .. 

JOlNT rx n 
21 -o.H00<~1 .ooooon 
111 O.ll 009: . 0'10000 

I.OAD l>.TI:kii.L ------------------
JOlNT lX ri 

n 
-to.nt~.o: 

10.111!>0:' 

FZ 
8.761320 
!:1.0049!19 

FZ 
-5.871207 

!1. 871207 

9.JOG12~ 

rz 
-4. 72SS6S 

4.7255e5 

e.UIIA!!S 
~-~l1J94 

¿1 l.r)J\)(¡7>) ,1)(}()()1)() -l. 7¿p~¡j 
J>i -l.,}!•lh'~ .l)')()o)t)() .\,72~7.¡1¡ 

PRl"•~ :.>AP~OO(•- VERSION Et..]O 

"" .000000 
.oooooo 

"" .000000 
.000000 

"" .000000 
.000000 

"" .000000 
.000000 

10( 

.oonooo 

.000000 

"" .000000 
.000000 

"'· .1)0()1)0() 

.oovo:)() 

f" R A M E E L E K E ~ T J O I N T f" O R C E S 

HY 
26.9!!114\Z 
3J. 6805~18 

HY 
-1.480201 
8.2lllHI 

HY 
16.052910 
19.]7t.lJO 

HY 
-6 • .52411 ') 

9. 01>10211 

HY 
12.720671 
IS.6J213JO 

HY 
-S.II04JJ5 

9. 72<)1161 

HZ 
.000000 
.000000 

"" .oooooo 
.000000 

HZ 
.000000 
.000000 

HZ 
.000000 
• 000000 

HZ 
.000000 
.000000 

HZ 
.000000 
.000000 

MY HZ 
•J.9'Al1lR .000000 

l~. l<tt)hOC • 00!)1)1)0 
f"ILE:EJEJoi'PLO~.(li.JT PAC.E líl 

F'OfK&S ANO M(f1DITS ACTING OH El.D1ENTS, IN C"..Ll'l!V.L l'O(IP.DIHATE.t; 
~ 65 .............................. .. 

LCJAV VERT ------------------
JfJlNT rx n 

ca -o. 211iJil .oooooo 
l9 1'}.~1~1~2 .OMOO,} 

LC>jl,ú LA.TtkAL ------------------
,J,)lNT n ri 

1.9Hí)''l' 
-1.9.40'10 

.01)•11)01) -:.J7¿<l()~ 

• •)•)ÜI)!)(; ~. l7l"'H 

E1.EH I•Í• •••••••••••••••••• 

~~ VERT ------------------
JOJNT f'X f'Y 

:t'l O.EilO:·?-' .00(1(100 
40 -O.S10274 .000000 

~ LAT&RAL ------------------
J{)JN1 r.< n 

;¡•¡ 1.:01<'"1;• .0000(10 
4(1 -l.'•IO'll;· .00(1(!00 

E.LD1 ,,, ---------------·--
L(li\D VfRT ------------------

,r,;JNT n f'{ 

.lú 2 7~H·~<. .000()00 
41 -2. 7~:1to.!>!l • 000000 

u.w;. LATEAAL ------------------
JOIN'1 fX n' 

.lO •0.166062 .000000 
41 o .16606::0 • 000000 

PRO('.AA,K !\AP2000 - VERSH"W E6.10 

rz 
a. t.l',~&40 
9.1H~.~'f 

" -o. 1 .\Of.o:· 
(J. "1 \(\(,(),? 

a.fo!>5711• 
8.9)0561 

rz 
-0.0760&9 

0.07&08'f 

FRAME ELEMfNT JNTERN'AL 
ELEM l ................................ LEHGTH • 

LOAD VERT ------------------
RE.L DI ~~T P V:' 
O.Gú00(l -~·'•.!'>i·l4;• -o.:.;,.((,~. 

0 . .!>0000 -t.fi.2(,40JJ -0.f1]6í.0~ 

1.00000 -M.9f,iot.Ol -O.tiH60.!> 
L(IAfJ LATERAl -----------------
R.El. DI ST p v:· 
o.ooooo 27.756703 &.982460 
0.50000 27.756103 8.982460 
1.00000 27.756103 9.992460 
ELEH 2 .............................. .. 
Ll>II.D VERT ------------------
RO. 01S't ¡• V2 
o.ooooo -sa.sou.u -2.b11S~~ 

O.'r'lOOf! •S7.lOb9tl9 -2.61~~~4 
1.00000 -55. 90'H'ff. -:t.f.ll!>!l~ 

LOAD LATERAL ------------------

V< 

.OúOOOO 

.00000(1 

.000000 

Vl' 
.000000 
.000000 
.000000 

LENGTff • 

Vl 
.000000 
.ooooor, 
.000000 

REL DIST p V2 V3 
o.ooooo n. ~96670 s. 9541196 .ouoooo 
0.!10000 17 • .!>96670 !1.9!>4996 .000000 
].00000 17.5<,~6670 !>.9~4EI96 .000000 
ELD1' 3 --------·-·••• lJ:toJ(>TH • 
U.)t.!) VERT ----------------

"" . onoooo 
,OOQOt)f.' 

"' .i)l)f)()()() 

.OOM¡OO 

HX 
.000000 
.000000 

HX 
.0000(1{, 
• 00()(t00 

HX 
.000000 
• 000000 

"" .000000 
• 000000 

FORCE~ 
3.000(')()(¡ 

T 
.()(1(1(1(1() 

.00000(1 

.000000 

T 
.000000 
.000000 
.000000 

).000000 

T 
. oooono 
.001)::000 
.000000 

T 
.000000 
.000000 
.000000 

).000000 

MY 
-S.l0b409 
10. 20'1~¡'0 

MY 
¡,' <:4bi;2~ 
7.990797 

HY 
•7.081076 

a.f.6287J 

HY 
1.71!1)!'-2 
::0. toi·5:·t~O 

1<1' 
-4. 9f.40~'i 

5.128!>flfl 

HZ 
.000000 
• 000000 

HZ 
.00001)0 
.ooooo::: 

HZ 
.0000()(\ 
. 000000 

HZ 
.000000 
.000000 

HZ 
.000000 
.000000 

HY HZ 
o •. 100542 . 000000 
0.1559~0 .000000 

FILE; E,TDfPL09. OIJT 

H.· Hl' 
.(,(l(J(IQ{o -:. tf<[-: { 
.00(!000 1.2:'4'10(1 
.000000 2.449816 

"" H) 
.000000 •6.9JE-15 
.000000 -1J.41J690 
.000000 -26.947381 

"' H.J 
• 000000 -).941074 
.000000 -o.o~P-Il 

.000000 3.893~Bfo 

"' H3 
.000000 6.9246SO 
.000000 -2.007663 
.000000 -10.940006 

PAC-E 1 'f 

< 
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REL DIST P V2 
0.00000 •4b.988612 ·2.901400 
0.~00 -4~.691200 ·2.801400 
l.OOOOC ·44.)<13181 ·2.801400 
UJAV UTtRAl. ·-----·····-------
RJ:L. lHST t· V2 
O.OOC,JO 11.7Jl9ll ~. 7¿~~aJ 

r,.~.OG00 ll.7\l>ll: ~.H2Holl 
1.00000 1).1,2f<Jl ~ •• 7~'211fl.< 
PRlX<AAM ">AP:'OOO- VER!.liC>N Lt'·.Hl 
F R A M E E L E M t N 1 l N 
ELEM 4 •••••••••••••••••• 
UWI VERT --·---··--------
REL DlST P V2 
0.00000 ·JS.217097 -3.017J9b 
0.50000 -)).91967~ -3.017J96 
1.00000 -JZ.622.<'62 -3.017.\96 
u:v.n LAT&AA.L ------------------
Rf.L fli ST P V2 
O. ()Q(lnf· 7. OH<I~(. L H·Bf4 
0.~00(10 7.0H9.if, L66D!i4 
1.00000 7.0H93b 4.t.tl.l6. 
ELEM ~ •••••••••••••••••• 
.uv.n VEAT --------------
REL DIST P V2 
0.00000 -23.2t>t>:i81 -3.1!>340{. 
0.!'>0000 -21. 96fl9t>8 -:•. H340t. 
1.00000 -20.Pl!>!l~ -3.1!1:•40(, 

LOAD LATERAL ------·----------· 
tltL OlST P V2 
0.00000 l.l.!StP') ).9~1>H7 

o.<;.nono .1 • .:29.P9 .1.911>!47 
].00000 J.22~f17Q J.'l:'t'>J41 

. El..EH 6 ---···"··- ............ .. 
LlV!fl VERT ----•••••••-------
RE!. DIST P V: 
0.00000 •ll.lfl7923 -3.7~0902 
0.~000 -9.8!;0~10 -3.7!>09(12 
1.00000 •9.!193098 -3.7!>0902 
Uv.D LATEAAL ---------·· 
REL DIST P V2 
0.00000 0.19!1.ll6 1.!>8<1f.71 
0.!10000 0.7Q~J36 1.~<~671 

1.000(10 ú."1~1~.l3t. l.">Ei''Pl 
PIKX':P.AM :\AP2000 - VERSION Et:.JO 
F R A H E E L E M t N 1 I N 
f:LEH ] 1 -------.. ---------
Z.O,.fl VEAT --------------
REL DIST P V2 
0.00000 -122.13164~ -0.0106&2 
0.!>0000 ·121.4.14233 -O.Ol0tifl2 
1.00000 •120.136820 -0.0106&2 

LOAO LATrRAL ------------------
RE:L UlST P V2 
0.00000 -.1.12608.! 11.0~4411 

o.soooo -J.l26Q$~ 11.084411 
1.00000 -.1.12WB2 ll.0<-4411 

&LtM 12 ------------------
LOAf> VERT --------------·---
REL DIST P ~¿ 

0.00000 -101.91228.'1 -O.l4479.l 
0.~000 -100.614810 -O.H479.i 
1.00000 •99.3174~7 -O.H479.l 
L(W'¡ LATERAL ----------
REL DIST P V2 
0.00000 •0.~08!1!>2 ll.52H'H 
0.!>0000 ·O.SOflfl!'-2 11. !'>2H't4 
].000(10 -0.~{11111~;· ll.~2H~4 
r.LEH l.l ................................ .. 

LOA!1 vtAT ------------------
RH r•I$1 F \7 
0.00000 -to¡. ~O'ó~l -(1. 4<.'124!< 
o.~OOO(J ·fi0.20fl1 i'l ·0.4'1'12(fl 
1. ooooo -1&. 91 onf, -o. •9~L4a 
u:~.n LATI:AAL ----------------
REL DI S-:' P V:• 
0.00000 0.133.137 9.27137"1 
o. ~oooo o.l.lJ3.n 9.27l.l77 
1.ooooo o.lJ.\l.n <~.2•1n1 

PR'X:.AAM SAP2000 - vtA!.li'.'f# [(.: (' 
F k A M E E L t H E N T t N 
tLCM 14 ................................ .. 

V>AO Vti\T ---·--------------
kt'- t11S"! f• \'! 
0.00000 -61 .. 108~0{. -0.6'12181 
o.soooo -f·O.Oll093 -o.6nl&1 
].00000 •!'>9. 713681 -0.6~12]8] 

U.v.tl LATtAAL ------------
REL DlST P V2 
0.0<1000 0.519534 7.914389 
o.!laooo o.~l~!'-34 7.1143!1Q 
1.ooooo o.~lq~.H 1.a1o&<~ 
r.LEH 15 ................................ .. 

u:v.n VERT ------------------
Rf.L DI 51 P 'V1 
o.ooooo -u.;JIJ'•o -ú.a'lH,:11. 
0.!>0000 ·,j!l.9)9'118 -0.91H.10 
1.00000 -3fl.642565 -0.81.630 
l.MD LATEAAL -----------------
REL DI$1 P V2 
0.00000 0.676443 ~.251986 

0.~0 0.676443 6-2~199(. 
1.00000 0.67t>44.l 6.7~198(; 

tLD'l 16 --·------------· 

V3 
.000000 
.000000 
.000000 

V) 
.000000 
• ()r)QI)l'0 

.0(100()0 

V.l 
.000000 
.000000 
.000000 

V.' 
.ONJO<i(l 
.0()()000 
.000000 

L!.Nv'TH • 

V' 
.000000 
.000000 
.000000 

Vl 
.000()00 
.000000 
.000000 

LENGTH • 

V.l 
.000000 
.000000 
.000000 

"' .oooooo 
.000000 
.rwoooo 

TfANAL 
U:.NGTH -

V3 
.000000 
.000000 
.000000 

V3 
.000000 
.000000 
.000000 

LENGTH • 

V' 
.oooooo 
.000000 
.00<1000 

V' 
.000000 
.000000 
.(J(JQO(I(l 

LENGTH • 

V< 
.000000 
.000000 
.000000 

V' 
.000000 
.000000 
.000000 

Vl 
.000000 
.000000 
• 000000 

VJ 
.oocooo 
.oooooo 
. 000000 

LENI.~TH • 

VJ 
.nooooo 
.000000 
.000000 

V.' 
.000000 
.000000 
.000000 

I.D«.~TH • 

T 
.000000 
.000000 
.000000 

T 
.OI):)t)I)Q 

.t)t)l)()()r, 

.000000 

F O A C" t S 
·'·000000 

T 
.000000 
.000000 
.000000 

T 
.OOOOCJO 
.000000 
.000000 

·'· 000000 

T 
.000000 
.000000 
.000000 

T 
.000000 
.0000?0 
.oooooo 

.-1.000000 

T 
.000000 
.000000 
• 000000 

T 
.000000 
. 000000 
.00(1000 

F~)RC'ES 

3.000000 

T 
.000000 
.000000 
.000000 

T 
.000000 
.000000 
.000000 

3.00(1000 

T 
.000000 
.000000 
.000000 

T 
.000000 
. 000000 
.00000(1 

.l.OOOOOO 

T 
.(1(\Q(,(l{l 

• (h.JQOOO 
.000000 

T 
.000000 
.OOOO<JO 
.000000 

f()~(tS 

.1.00001)0 

T 
.0('0000 
.000000 
.000000 

T 
.000000 
.000000 
.000000 

.1.000000 

T 
.000000 
. 000000 
.000000 

T 
.000000 
.000000 
.000000 

3.000000 

K2 M.l 
.000000 •4.1209111 
.000000 0.090119 
. oooooo 4. 301.2, a 

H.' MJ 
• 01)0000 10.'2074fi-4 
.n>11)(P,1l ~o. 17•>'-lil) 
,{)(l(l(l0(' -El. 'lf.ll ¡¡4 

f!U:: E.rzHPU>«.lX'1 

K! 
• 000000 
• 000000 
• 000000 

"' .oooooo 
. 000000 
• 000000 

H2 
.000000 
.000000 
.000000 

"' .000000 
.1'>00000 
• 000000 

H2 
.000000 
.000000 
.000000 

H.) 

-<t • .CS904! 
0.0670!-: 
4.59Jl4(. 

H.' 
( •• to<o;,:(¡ 

-O •. HfiJ¡>t. 
-1.)4011~ 

H.l 
-4. 706a.n 

0.023212 
4.15.nal 

"' "•· JOt>Sb!f 
-1). 5!l2 ~~.~ 
~6.471~76 

H' 
-4.997 38<> 

0.628967 
6.25~.\21 

M2 H.\ 
.000000 1.730379 
.000000 -0.6~412!1 

.0000(10 -J.OJfi(,J~ 

fiLE: E.TtH'PL09. OUT 

"' .oooooo 
.000000 
.000000 

K! 
.000000 
.000000 
.000000 

"' .000000 
.000000 
.000000 

H2 
.000000 
.000000 
.000000 

K' 
.OOOOO'l 
.000000 
.000000 

H3 
3.06E-18 
0.01602.' 
0.032046 

'" l.G6E-\6 
-Hi.li26ólfi 
•• ,.1.253232 

H' -0.080.116 
O.l.if.87.l 
o •• l-540(.2 

H.' 
16.466911 
-0.817'lJO 

-1fi.JOH7t! 

H.' 
•(!. p;..&">l 

o. 01(.()21 
O.él248~2 

H2 .... 
.000000 13.597~42 

.00(1000 -0.30<112~ 

.000000 •14.2Hlflél 
FI :..t: t.I'D'fPU.I9. 0:11 

"' .000000 
.000000 
.OOJOOO 

H2 
.000000 
.000000 
.000000 

"' .000000 
.000000 
.000000 

,.,. 
.000000 
.000000 
.000000 

"' -0.'.J(.'Iél09 
0.06toH1 
1.1067 .l5 

"' 11. 4flt62t 
-0.2:'(.9!1fl 

•11.9!1!1~41 

H.' 
-1.2U!'11 

0.0670.U 
l •. 171!919 

K3 
9.03!>087 

-0.341&92 
-9.120872 

PAGt 20 

PAGE 21 



LOkD VERT ----------
ltEL DIS'f P V2 
0.00000 -21.273240 -0.903738 
0.50000 -19.97~~7 -0.90171~ 

t.ooooo -1a.~1~41~ -o.90373a 

~ LATEAAL ------------------
RE.L OIST P V2 
o.ooovo 0.49:'18~0 3 •• l~7797 
0.~000 0,4938~0 3.3~7797 

1.00000 0.49)9SO 3.3~7797 

PROGRAH SAP2000 • VERSIOH E~.10 

VJ 
,000000 
.oooooo 
. 000000 

• 000('0(1 
.oooooo 
.000000 

FAAHE ELEHENT INTEANAL 
ELDf 21 ... --... ----·- LEHLo"'TH .,. 
WAD YEJIT 
JU:.L Pl ST P VZ 
0.00000 -H0.43362J 0.0022'3~ 

o.~oo -129.13~210 0.00223~ 
LOOOOO -127.8.HI7\17 0.0(1:.>2.1~ 

L(\IU"J LIITEAAL ·-------------·---

VJ 
.000000 
. 000000 
• 000000 

JU:L niST P ~ V3 
0.00000 2.9920~~ ll.J4~~~3 .000000 
o.~ooo 2.9920~~ 11.04~663 .oooooo 
l.OOOt'IO 2.9920!>~ 1L04!>66.l .000000 
ELDf 22 - .......................... .,. ... .,._ ~"'TH • 
LOIU.l VERT -----------------
IU:L DIST P V2 
0.00000 -1C9.1395.&7 0.097SIJ9 
O,Sl)I)OO -101l.4.C1l1S 0.097~9 
1.00000 -10?.14.'762 O.O'l?~9<1 

U:lACl L.AT.E:PAL ----------------·· 
R.E:L msr P v; 
Q,QO(!(I(t t·.4l.H~f. 1:.~.:-PO .. 
0.:>0000 0.4DJ:>t. ll.:>:'f?O'l 
1.00000 0.413J~6 11.~26109 

VJ 
.000000 
.000000 
.c.ooooo 

V.< 
.00000(1 
.000000 
.000000 

ELEH 23 ..................... __ .,..,..,..,..,..,..,..,..,. ~OTH • 
UW! V&RT -------------
RE.L OIST P VZ 
o.ooooo -99.~267~ o.41662a 
0.~00 -99.29~263 0.416628 
1.00000 ·86.!11178!>0 0.41{.6:.-8 

LOkD LATERAL -----------·------
RE:l.. DlST 1· Vl 
0.00000 -O.lló.!Ol 9 • .!799~P 
0.~0000 -C.2lb7Cl 9.2'f9<ioll~ 

1.00000 -O.ZJ620l 9.2'199fl1 
PR(~ SAP2000- VERSION .E:t:.lO 

V3 
.000000 
.000000 
.000000 

VJ 
.000!)01) 
,000000 
.ouoooo 

FRAHE ELEHENT JNTERNAL 
ELi>f 24 ................................................. ~"TH • 
LOkD VERT --------------
1U:L OIS't P V2 
0.00000 -fi9.77.C059 0.57.C0.C7 
0.50000 -68 • .C7b6.C7 0.574047 
1.00000 -t;7. 179~ .14 o. 574047 

~~ LAT~ ----~-------------
RE.L PI :>T P V:: 
0.0~000 •0.(..'\00!41! 7.!11~(.;>9 

0.~0000 -Q,(,)009fl 7.fll!>629 

VJ 
.000000 
.000000 
.OClOOOO 

V,< 
.OC!OO<~O 
.000000 

1.ooooo -o. t>Jooaa 1 .1!1~(:29 .ooooou 
E.LEH 2~ .,. ............... __ ..,..,..,..,. .... .,. •• LEHt.'TH • 

.I.I:V.I'I VERT -----------
JU:L DIST P VZ 
0.00000 -!>O.:t49964 0.68241~ 

0.~000 -49.9~2~~2 0.692415 
1.00000 -47.6~~1)9 0.61!:2415 

LOAD ~TtRAL ··--·-·-----------
~tL tllST F VZ 
o.ooooo -o. lU7¿fl fi.IS.'I}-?7 
0.':.01)<)!) 
1.000()(1 
ELE>< 

-!~.1~='~4 

-o. nnLfl 
:;'1. ------------------

V.W> VERT ------------------
Rll DJST P '1:2 
0.00000 -30.926:2~3 ],OQ0107 
o. soooo -29. (.;>(4940 l. 090107 
l.Qoooo -:.-a . .l.ll tn 1. OQ0107 
U:IA!i LIITEAAL ·----------------
REL DJST P v;_· 
O.t:OCICIO -O. 412~<1~ l, '076fo1 
o.~oooo -o. P74'JL 1. 'C''1H•: 
I.eo:.\l{ 
PR<.o.':J\A."' 
F R A M 
fL[')I 

-:l.,-:·;'.~ .1. <(:roo: 
:'AP:Ot>O • Vff<::rnN t:i.J(> 
[' f. L f M [ N T 1 N 

U:~_.") VE.I\1 --------------·-·-
A.E:L OJST P V'.: 
o.ooo:JO -11.4!>0~4-1 -2.7~Jf,~9 

0.~1000 -H>.l~.llJO •2,7~.1€.!i'l 

1.00000 -14.1!5571~ -2.751(.:>~ 

U».D LA'!'tRAL ------------------
kt'. [)l~T 1' 
0.00001) 0.07hQij<'J (), li>liOo2 
O. C:.OOOC¡ O.Q~o,l}lj9 O. thl,l)l,: 
l.O(>C>CIO c•.t•i1 Of<'l o.J•:t-ot.;-
E.t.D-! 11 ------------------
LOAn VEIIT ------------------
R.E:l. nr::r '~'' 

0.00000 -92.2"'fl053 0.82~0~>3 
0.~0000 -fll.000640 0.{1250~3 

1.00000 -?9. 70J22& 0.!12!>0!i.l 
LOAD IJ.T~ --------------
REL OJST P V2 
0.00000 -21.(.12(.76 1!.!1!114~7 

o.~oooo -n.f,J:f.7f> 8.1!fi7H1 
l.COJOO -2i.(.J:•p¡. fl.flfli4(.i 

V3 
.000000 
.000000 
.000000 

VJ 
.000000 
.O!lMOO 
. 000(1(10 

Lt.NnTH • 

Vl 
.000000 
.00(1000 
.000000 

V.< 
.000000 
,C>OCN•O 
• (!(!(:('(!~· 

1 t: 11 ~~ A t. 
LDI'.~TH '" 

VJ 
.(•00000 
.000000 
.(1000(>0 

VI 
.0011000 
.01)1)0:)1) 
. (!00000 

L(..N~;TH • 

V,< 
.oooooo 
.000000 
.000000 

VJ 
.000000 
.000000 
.OCOOO(I 

T 
.000000 
.000000 
.(,QQOOO 

T 
.000000 
.000000 
.000000 

f'ORCES 
3.000000 

T 
.000000 
.000000 
.0000()0 

T 
,000000 
.000000 
.000000 

3.000000 

T 
.000000 
.000000 
.000000 

T 
,0(!{)('(¡(.1 

.000000 

.000000 
_l,OOOOOO 

T 
.000000 
.000000 
.000000 

T 
.1)00000 
.000000 
.000000 

r o 11 e E s 
.3.000000 

T 
.000000 
.000000 
.000000 

T 
.000000 
.llOOOOO 
• 0(10000 

.l.OOOOOO 

T 
.000000 
.000000 
.000000 

T 
• 0001)00 
,!)Q;)(li)Q 

.ONlfi(.Q 
J.OCHHIUO 

T 
• 000000 
,(100000 
.000000 

' .00{.(1(1(1 
• (ID{l(• >O 
,(i(l{l:J:I(' 

r <; 11 1_· r :; 
J. 000('0(1 

T 
.000000 
.000000 
.000000 

T 
.OOilOOO 
. 0!)')001) 
,(!{!(J(¡(J(J 

.1.0000(1(1 

1 
• 000000 
• 000000 
• 000000 

T 
• 000000 
• 000000 
,(I(IQ(l(l(l 

M2 
.000000 
.000000 
.000000 

MJ 
-1.260490 

0.095\UI 
1.4!)072~ 

K' H.l 
.oovooo 4.!>49~~!> 

.000000 -0.487141 

.000000 -5.~.l8J1 

f'ILf:: E.JDIPL09. OliT 

"' .000000 
.000000 
.000000 

"' .000000 
.000000 
.000000 

M2 
.000000 
.000000 
.ooooor, 

"' .0000(10 
• 000000 
• 000000 

"' .oooooo 
.000000 
.000000 

HJ 
-1.4(,[-17 
-O,OO.l.,:>J> 
•0.00(.704 

"·' -l.27t:-14 
-16.~694"'4 
-J3.13698fl 

MJ 
o. 055600 

•0.09071j~ 

-o.z.naa 

"' lb.HO)f, 
•C'.fl15?27 

·18.105HO 

'"' o. ~97409 
-o. 027~3.' 
-0.1(;!>2414 

M2 HJ 
.000000 1J.609Q7S 
.oooooo -o. nooo6 
.000000 -14.229987 

r: LE: EJD1PL09. OVT 

M2 
.000000 
.000000 
.000000 

,., 
.000000 
.0000(10 
.000000 

"' .00~000 

.000000 

.000000 

M2 
.oooooo 
.000000 
.00000(1 

"' .000000 
.000000 
.000000 

,., 
.oonooo 
.000000 

MJ 
0.8J9995 

-O.Ol\076 
-0.992146 

"·' 11.49:.-.l:!~ 

-0.241111; 
-ll.96t~G.i 

"'' 1.0321~9 

0.009!>46 
•1.01!>07(> 

M.l 
11. !l!lC\28 

-!). l4Q1!i~ 

-'l. ~,7(1(.52 

"'' 1 • .144552 
-0.291 !>()<1 
•1.927~10 

H.< 
4. "d1P~ 

-0.40fiP 
• ()(,(111:111 -~ .. 40~ •f •• 

PAGE 23 

PAGE 24 

fiLE:E,Tf..MPJ,¡'i'l.l)OT PA•.~.E: 2~ 

"' .000000 
.000000 
.000000 

,., 
.000000 
,l)l)I)Qf¡!) 

.0(1000(1 

"' .000000 
.000000 
• 000{100 

"' . 000000 
• 000000 
.OOOOOG 

HJ 
~.'1.296!1]<1 

0.8.1.1!>70 
'. 9(;40!>9 

"' O.l97h4J 
-u.'l<;.l<CC:.O 
-o. 1no~•' 

"·' •4.40E-l1 
•1.2.l1[>711 
-2.47~1~8 

H3 
t.50E·l~ 

•1J .. l.ll100 
-2t.. (,(.<'40(1 

• 
' 

,, 

.. 
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ELDI J2 ------------ """"" - J.OOOOOO 

"""' VE.RT ----------
1U:L Clif>T p "" VJ T "" HJ 
0,00000 -71.19HIQ 'l.G!-ra?~ .000<100 .(•00000 .ooonoo LOUI~it 

0.~0000 -t>9.fl9t00fi 2.f.~EI75f! .000000 ,000000 • 0000(!0 O.O~OtJ8 

1.0(1000 -611. !>965 ... 4 ?.í.!'ltl75f:j ,000000 .000000 • (.100000 -.'1. ll.i76Qh 

.~ U.~ LATE.AAL ---------------
REL OIST p V"l VJ T "" HJ 
o.ooooo -11.501174 5.993902 .000000 .000000 .000000 7.0181 ... 8 
o.soooo -li.!\01114 5.9 ... '190? .000(.100 .000000 • 000000 -1.97265!1 
].00000 -11.!>0ll7t !>.993902 .oooooo .000000 .000000 -lO. 9f>.lS09 
P~ SAP2'000- 1/ER:.liOH Ef'..lO fi U: f:JEMPL09. OtrT PAlC: U. 
Flt-'HE ELtHEHT 1 H ' t R H • L r o R e t S 
tLtH )) 

------------------ LENI"iTH - 3.000000 

"'""' VERT -----------------
Ril. Ol!;;l 1' V1 VJ ' "' '" 0.00000 -!>9.591635 ? . fl90020 . 000000 .000000 • 000000 4.2711420 
0.!'.0000 -~.2'04213 2. 9900.<0 .000000 .ooouoo • 000000 ~o.or.161o 

1.00000 -~( •• 9'16fl10 2.!190020 ,000000 • 000000 • 000000 ~4. ~966.19 

LC-"'l LATERAL ------------------R&L DIS'J' p V2 VJ T "' H.l 
o.ooooo -11.6.2~!167 ~- 72!>75.) .000000 .oooooo .000000 8.210822 
0.!>0000 -11.629967 ~- 72~75.\ .000000 .000000 .oooooo -o. :t77B09 
1.00000 -11. 62~967 5.12!>753 .000000 .oooooo .000000 -8.~66439 

tLtH ,. --------------- IJ:~«;'J'H ,. 3.000000 

"""' VEA1' -----------------
RU. OI$1 p V2 V.l T H2 H.l 
0.00000 -47.(.'•(1(,(1~ l.l.l~~.w • 000000 .000000 .000{'0(1 •• 6(,~)(1'0 
0.:00000 •H.Y-I.l,:o7J .l' l.l~~-'0 ,000000 .000000 ,000000 -o. OJ7907 
1.00(100 ~4 .... {l'l~flf,() .1. l J~~;IO ,00(11100 .0(10(100 .oooooo ~4.14120~' 

LüM• U.TLAAL ---~-----~~~------
R<l ni:lT p ,., ., T "" Kl 
o.ooooo -t.. 9008J .. 70fl61& .000000 .000000 • 000()00 t>.6HJ9l 
0.!>0000 -6.9043fll 4.70!161!1 . 00000(1 .000000 .000000 -(1 • .19653~ 
1.0000(1 -6.<J04J83 4. 70fi61B .000000 • 000000 .000000 -7. 4!'1Q462 
tLtH 

.)5 ------------------
L.ENl.~H .. ). 000000 

"""" vtRT ------------------
RU tnST p vz VJ ' "' '" 0.00000 -.l5. s~A<~r.h l. J4.St>ll .001)000 ,000000 . 000000 4.. 91lilti~-9 
o. c..oooo -j<(.lht0<,4 J. 14. '.(;~~ .ODO')OO .00000!) . 000001) -0.029712 
1.00000 -J~.4t,,H.4! J .. H~E-21 .00000{1 .OOOCJOO • 000(100 ~~. 04fl;·cu 
[,OAr' I.J\'TERJIJ. ---------~--------
1\EJ. r-Jn p v;· v• T "' KJ 
n.oom;o -l. ]"''Ot,Q', .l.H!I'l4!. • (lQ(HJ{I(l .{1(1(¡(!(•0 .0(10{)00 •. ~.n 11k 

0.!'0000 - t .1"1'1~'1~. '· i·i·fl'l·40 .000000 .000000 .000000 -o.~nn:· 
l,(l(l(J(I(I - i.l1q>;ro_, ,1, (,(,f1'<40 • 000~00 .000(100 .oooooo -(,. (11 ~f.!l2 
PRO:iRAH ~P2000 - VEA$!0N ti. lO fl LE: E,JDfPLO'I,(IUT PA<.':.E " f' 1\ AH E tl...EHEN':' r " TE R H A l f o R ~· ' $ 

ELD1 jf'; --------------- Lf:Jo!V"TH .. .l. 000000 
UW> vtRT ------------------
1\EJ. DfST p V2 ., T H2 "-' 'f 0.00000 -2~.1H·f·"O .1. ~(. i'j_1 i .0(10000 .000{10(1 ,(,()(1000 ~.lf>B!i 

0.~0000 -.?l.'H'l;>n .1. ~( •. l<oJ.t .000000 .000000 . 00{1000 -o .l!t4!>fl.• 
1.00(1(10 -20.(.~1(12"o J. !-f 1•11.1 .000(100 .fJOOOOO . 000000 -~. 'd:l4!l:O 

'-~·-uv.n !.ATfAAL ------------------
Rll nr~:r .,_. V.l ''-' "' 0.0000(> -o. flof.t-'11 1.74HI!'(I .000000 .000000 .000(100 1. 91 Sll ~ 
o. 500(10 -O.t!Ct€.691 ],144!150 .000000 .OCIOOOO .000000 -o. 702lf.O 
l.OOCOC -0.!10(.(.91 l. 1Hfi!>O • 000000 .0~0000 .000000 -J .. il943~ 
EID! " ------------------ LEH'-"l'H .. 3.000000 

"""" VERT ------------------
Rl:l. t:I1ST • V2 VJ ' "' IU 
0.00000 -11.50SJ86 2. 7$3659 • 000000 .1]00000 .oooooo .l.l.l2190 
c.soooo -l0.;?C791.l :!.1Sl659 .000000 .000000 ,001)000 -0.991'1099 
1.00000 -6.'110!>61 2.15!46~'+ • 000000 .000000 .000000 -5.118~flfl 

u:tAD V.1EAA.L ------------------
REJ.. Ol:OT p \.':? ·n r lt! K' 
0.0<1000 -0.01(.(1!1; -(l,}(,(cQ{.2 ,00000(1 .OOCIOOO .000000 -0.(·!'14]75 
0.!>0000 -0.01(.089 -0.166062 .000000 .000000 .000000 -0.40~0fiJ 

1.00000 -0.076069 -O.lH062 • 000000 • 000000 .000000 -0.]5~990 

"-"' ., 
------------------ LEHo'..lH • 6.000000 

WAD VEAT ---------------
REL DIST p V2 VJ T H2 KJ 
0.00000 l. 794949 -a.tf.2279 • 000000 .oooooo .000000 -6. J90ll90 
0.2~0 ] • 794949 -4.010709 .000000 .000000 .0000('0 1.91D!>l 
o.~o 1. 7!-<4949 o. 4106(,0 .000000 • 000000 .000000 ..... 67]2.\fl 
o. 75000 1. 7<1494'1 4.fi6HJO .000000 .000000 .000000 1.708770 
1. 00000 l. "1'14'149 9 . . W.'~I9Q .(10000{1 • 000000 .000000 -1<.9160~1 

U.~ V.Tt:AAL ------------------
REl OI$1 ' .. , Vl r '" Kl 
0.000(10 -1.'17243!> ](J,J600.H • 00(1000 • 000000 .000000 J',l\72061 
0.2!>0CIO -1.9114:15 lO.l600JJ .000000 .000000 .000000 l!i. 6.)2011 
0.!->000(1 -1.'17243!> lO.HOOH .000000 .000000 .0000(10 J .. 191 'h)l 
o. 7~0(1(1 -1.!+12435 10.1600.0 .000000 .000000 .00(1(1()(1 -11.!14110{<'1 
1.00000 -1.'1724.)!> lO.h-00.0 .000000 .ocwooo .000000 -27 .0(1(11.\9 
PRlXiAAH SAP2000 -VER:Jli.'W E6.10 f1LE:EJEHPL09.0UT .""' " F R AH t t L E H E N 1 I H 'J'ERNAL r o R e t S 
tLtH ~2 ------------------

u:N!.o"Tif .. (..000000 

"'""' VtRT --.----------------
MI:L DlST • V2 Vl ' "' MJ 
0.00000 0.19~4.6 -a. no•: a• .000000 .000000 .000000 -1!.014%9 
O.ZSOI"'C o. 19'.-ll·\li -4..~7'1)14 .ooooco .001)')1):) .000()00 ;!.t)JSSM 
0.~0000 0. J 'l!>liiH ~o.on14., .(>CIOOOO .OClfJOOO .000000 ~-4.:'.'-l/4 
O. 'J~OOO O.J'I<o!IH LHHfs2"• .OQOOC!O .00(1000 .00(1(100 :-.HilfsH 
1.00000 Q,l'I~!IH fi.!l4~l'+4 .000000 .000000 .000000 -7 .1FI!IJ 01 
U.iAII LATEAAL ------------------
R&L [;1$1' p ., V.l T "' KJ 
0.00000 -4.767987 ~- !16la:•<~ • 00000(1 ,(,(1(1000 .000000 19.]41470 
0.2~00 -4. 7f.7987 ~.8(;.\8.\9 .000000 • 000000 .000000 )O •. ,!>PJ2 
o.~ooo -t. 7(.191'17 ~.863&Jq .000000 .000()(10 .OClOOOO 1. !>5!'>9~.'1 
o. 7~000 ~<. "1(,7987 ~.fl6.llil.l9 .000000 .000000 .000000 -'J. 2 ·''1806 
l.'JOOOCJ -~. 7(.7'+87 ~- fi(,Jiil i'l .000000 .000000 .000000 -1!;.0.1!>~64 

tLtH ... ···---····--·----- LENGTH • (..000000 

"""" VEAT ------------------
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Rf:L DJST P '11 
0.00000 0.10"""'(· -'•.J"'f,/00 
0.2~000 C.20'~'1Qto -4,/.~<,J.tO 

o. ~{l(l{l 0.2('''"'"'· -0.?<.1 ¡~t;J 
o.r~ooo o.~·o9''"f L14&009 
1.00000 0.2(1<.1<19(; fl.~f1Q~'19 

LI.V\l) LJ.T&AAL -----------------
Rt.l. nr sr P V'.! 
o.ooooo -.l. 938481 4. 717994 
0.2~00 -3.93&491 4.717!194 
0.!>(1000 -.l.9.l94!11 4.117994 
o. 7~00 -.l. 9.1fi4Eil 4. 711894 
1.00000 -3.939491 4.711!1"'4 
ELEM 44 •••••••••••••••••• 
U.W! VEAT ------------------
REL :'11 $1 P V2 
0.00000 0.13(>010 -9 .. l~5!1!12 
0.4'!>(100 O.ll6010 -4.9HH.<' 
o.~oooo o.13t.OlG -O.t11'141 
0.7!>000 0.136010 3.969827 
1.00000 0.136010 8.410397 
PROGRAH SAP2000 - VEASION E6.10 
f R A M E E L E M E N 1 l N 
L4.-...n L\TEAAL ----------
REL DIST P V2 
0.00000 -4.264'18.1 J. '7(1905'7 
0.2::.000 •4.2M'7fl3 3.18'•05'7 
o. ~000 -4.20'1i''1 J. 7fl90~'l 
o. 75000 -4.:•(.4'78.1 ,1. '7fl90~'7 

1.00000 -4.264'7fl.i .l./!190~1 
ELEM 45 ............................... .. 

U'IIUl VERT ---------------
REL DIST P V2 
0.00000 0.597496 -9.493632 
0.2!>000 0.597496 -5.042063 
0.50000 0.597496 -0.,00493 
0.15000 0.59749(. 3.841016 
1.00000 0.59149(. &.292646 
Ll'rAO lATERAL ---··------------
Rf.L nr:;r P ,... 
0.00000 -'7.663524 1.430544 
0.25000 -1.(;63524 2.430544 
0.:.0000 -7.t>b.i524 2.H05H 
0.7!'.000 -l.(,f,.lS~'4 2.BOSH 
1.00000 -7.663524 2.430544 

&LEH 4 6 ------------------
LQAD VERT -----------------
REL nrsr P ,., 
0.00000 -3,150<102 -!1.593098 
0.2~000 •3.7~0<10L -4.l5l.,L8 
o. ~0000 __ ,, 1~'102 0.?'1004;• 
(1.7~(1(•0 ~.1.1'-,{''•(:; ,,.,1:1~~ 

],()0(1(1(1 -~.7~0'•0.· Q,]7,l]fiJ 
LOA!'> LA Tf.AAL ------------------
FIEL I'I ~T F v:' 
O.OO(IOC •f<.4:0J:.-:' 0,'1!f~.13i. 
0.?5c000 ·!LUOJ:'Q O. '7<.153.H· 
o. ~000 -8.4102129 o. 79!>J3(. 
0.7!>000 -fl.tlO.l29 0.79!-l.l3~ 

),00000 -f:l •• 1032"<.1 0,79!>.Ht 
PR(lGAAH SAP2000 - VERSH~ E~.10 

fRAME ELEMENT 1H 

&1..EM ~1 -----------------· 
v:~A.n VEIIT ----------------·-
Rll DJST P V'1 
o.oonoo 1.9<'9Df,(• -í1.<12'051fl 
0.2!>00() 1.'•2~10(.0 -·. 4'7f<'lf,<.l 
o.!>twoo 1.'':-;.c,(.o -c1.ún.~Q" 
0.75000 1.<.1;>90~(1 4.4041'71 
1.00000 1.9290(;0 8.84~7i0 

LOAD LATERAL ------------------
REL DJST P '('"¿ 

0.00000 -2.412518 7.!>42803 
0.25000 -2.412518 7.542803 
0.50000 -2".412!>18 ?.542fl03 
0.7~00 -:!.tl:'~lfl '7.542i<V.l 
1.00000 -?.t1l~lfl 7.!>42~0) 
ELEM !>2 ................................. .. 

.L(~J'J VERT ------------------
RE!.. OI!'lT F v;; 
0.00000 0.550.100 -II.'IH512 
0.25(100 0.550~00 -4.~24!14:.-

0.~000 0.5!>0300 -0.0(13173 
0.7:.000 0.550300 4.3!>919'7 
1.00000 0.550300 8.199167 
LOA.D I.ATE.IVU.. -----------------
REL OJ!'lT p V:: 
O. 00000 -~·. 5Ufl'l{, ~. <'.:-l (.~O 
o.:-5ooo -:.5JHno 5 . .:-:·Jf.S(l 
0.~(10(1[1 -:.-.~.1'~"'(1 < •• :·:·¡(.~.{: 
0,'7'>000 -f.5Jtfo.-:'(' ~ .. :·,:-¡,.~{ 
1.0{\l(i(· -:.·.:~>-•<· ~ .. :·:·¡(~.(· 
f.LEH 5.1 ............................... . 

r..nAO 'IEIIT ------------------
REL OI!;T P v:' 
0.00000 0.40:'\13(; -9.0J2't.41 
0.2!>000 0.4029.10 -4.571072 
0.50000 0.402930 -0.129~.02 

O. '15000 O. 40:''130 L ))2067 
1.00(10{, o. ¡o:·"''' 11. '"Y ..-; 
PRr.'"A\1\M !;AP,?Of•(' • n:R::f'>N Et .. H• 
f R A M E E L E M [ N T f N 
LUA!'• LATERAL ------------------

V.' 
.00()(J00 
'00000(1 
,('()(){10(: 

.oooooo 

.000000 

'{J 
• 000000 
.000000 
.oooooo 
.000000 
.000000 

LENGTH • 

V' 
'000000 
.OOO(J()(l 
.000000 
.000000 
.000000 

TE ANAL 

VJ 
.oooooo 
.000000 
.0(10000 
.000000 
.000000 

LENGTH • 

v:1 
.000000 
.000000 
.000000 
.000000 
• 000000 

V' 
.000000 
.oooooo 
. 000000 
.000000 
• 000000 

l.f:HGTH • 

"' .000000 
.(100000 
.000(100 
.ooú::c•n 
.000000 

VJ 
.OCGOO(l 
.000(100 
.00(1(100 
.000000 
'000000 

T E R N A .L 
.LENC.7TH • 

V' 
.000(10(1 
.000000 
.oooouo 
.oooooo 
.000000 

"' .0000<10 
.oooooo 
. 000000 
.oooooo 
.000000 

LtNGTH " 

n 
.000000 
. 000000 
.000000 
.CIOOOOO 
.000000 

VJ 
,(10(;000 
.oooooo 
. 0(1(,()(10 
. o~.:.c.oo 
. :.c.c,•.oo 

Lf:N,_:TH -

VJ 
.OOOOOG 
.000000 
.000000 
.nooGoo 
.000{;0(1 

T E 1< N ;. L 

V< 

T 
.0(1(10(10 
.000000 
.(1(){1(1(1(, 
.(l(l(l(¡(¡(l 

.OOOOúO 

T 
.000000 
.000000 
. 000000 
.000000 
• 000000 

(,, 000000 

T 
.000000 
.000000 
• 000000 
• 000000 
• 000000 

FORCE S 

T 
• 000000 
• 000000 
• OúClOOO 
• 000000 
• 000000 

6.000000 

T 
• 000000 
.000000 
.000000 
.000000 
.oooooo 

' • 000000 
.oooooo 
.oooooo 
.000000 
.000000 

(;.000000 

T 
.oooooo 
.000000 
• 000000 
,0(1(1(\flO 
.000000 

T 
.000{1()(1 
• 000000 
• 000000 
• 000000 
.0(lQ(I(l0 

fOAl'E$ 
6. 000000 

T 
.(1(1(1(1(10 
• 000000 
• 000000 
.000000 
.0000(10 

T 
• 000000 
.000(100 
.000000 
.00(1000 
.000000 

c.oooooo 

T 
.OMOOO 
.00(1000 
.000000 
.000000 
.000000 

' .00000{1 

.000(100 

.(J(l(l['(""l 

,{l(¡(,(¡(I(J 

• (,(;(lOCG 

~' 000(1()(1 

' .000000 
.000000 
.000000 
.0(10000 
.O(l(o(l(l(i 

T 

"' .00000{1 
.oooooo 
,:l(o(l(l(ll; 

.000000 

.0(10000 

M? 
.000000 
.000000 
• 000000 
.000000 
• 000000 

MJ 
•(1, H.O:>f.O 

J. f,7,\t;]¿ 
5.44'11 w 
~.S54.i'"'4 

-f .. (.)Q8!<<17 

MJ 
15.605104 

8.!1282'63 
1.451421 

-5.1'·25420 
-12. '102262 

M? "' .000000 -<I • .:"(.)(,¡Q81 
• 000(1(1(1 l. 4026(.2 
• 000000 5. 442<15.' 
.000000 2.!120Sfl9 
.000000 ·~.46.\529 

FILE.: EJEKPL09 .OUT 

M2 
.000000 
• 000000 
.000000 
. oooooo 
.0000(10 

"' .000000 
.000000 
.000000 
.000000 
.0(1(1000 

"' .oooooo 
.000000 
.000000 
.000000 
.000000 

"' '000000 
,(100000 
.000000 
,(!(1(1(1(111 
,(1[1(1{1()(1 

MJ 
12. b470.l7 

f,,Q63451 
l. 27<1Hc> 

-4.40:1720 
-10.097.105 

HJ 
-9.750767 
l. 143!>04 
5. 31~421 
2.9449fl4 

-6.147110!1 

M3 
!1.201955 
t. ~56l.l!l 
O.!Jl0.'24 

-2.7:i549l 
•6.381.107 

"-' -6 . .-55J2l 
.1.303149 
L1'1'1?to3 
2. 4 ••o:•t 

-I,Q'i5570 

M:' M.l 
.<lOOO(JO .l.03f<f.3~ 

.000000 1.845631 
• 000000 o. (.52 (.2'7 
.000000 •O,!'J40.ll? 
• 000000 -1. '7 .l3.l8l 

FILE: E..TEHPL09. O(IT 

..:· 
,()(l(l()(l() 

.00000(1 

.000(1(,(1 

.000000 

.000000 

"' .000000 
.000000 
.oooooo 
.0(10(1(1(1 
.000000 

"' .oooooo 
.000(1(l(J 
• OOOOOú 
.000{100 
. 000000 

"' .0(1(1()0(1 
.000000 

"·' -'1.0211414 
J.O;·vH 
4 •• 0!14<.12 
1. l.l.H1.1 
-9.&040~0 

M.< 
22. ~3J904 
11 .. 119100 

0.0054QC 
-11 •. 10fll0~ 
-n.62::'91:-

H< 
-!1.!11501:1 

l .. 10;1~7!1 
4.7!;<1(11) 
].:,5)6Q~ 

-8.314778 

H.< 
15. t·6'104!o 

'). €<.14~7;, 
• (l(l(l(I(J(I o. 0(120'<( . 
. Of•()QO(, -7 , F< 10.•1 '• 
• (•('(·(•(!(.' -1 ,, . f,t.:'f<" ~ • 

K:· M.l 
.ooooon -1:1. '1!1J!>'n 
.000000 1 • .1941!<8 
.00000(1 4,'1]961!< 
, 000000 J. 7(1<'(,'14 
'(,(,(¡fl()(i -;.' (IJ (,~(14 

f! Lf: E.Tf,MPI,l~'¡, OliT 

"' 

PAIZ ~9 

,. 

,, 
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0.00000 -2.49!494 4.3316~8 
0.2'~000 -2'.491494 4.))]6Q8 
0.!>0000 -2.4814~4 t.JJH.'ffl 
0.7~(1 -2.H11.94 t.:Hl(..ílk 
].00000 -~.481494 4.JJ]6Q~ 
E.LD'I !'14 ............................ .. 

u.v.D VE.RT --------------
REL nrsr P ~ 
o.ooooo 0.3184!'19 -9.06!'1894 
0.2~00 O.Jl84~9 •4.624324 
0.~000 O.Jl84!'1Q -0.18?7~4 

0.?~00 0 •• ,1114~~ 4.?~fl!ll~ 

1.00000 O.J184~'f ~.70038!'1 

U.V.O UITEAAL ------------------

.000000 
• 000000 
.000000 
.000000 
• 000000 

<.J:HefH • 

VJ 
.OOO'JOO 
• 000000 
• 000000 
• 000000 
• 000000 

PLL [)J!:'T P V2 VJ 
0.00000 -2.?0?."ifi1 J.(.J2HS .000000 
0.2~00 -2.?02381 J.632148 .000000 
0.50000 -2.?02381 .1.632149 .oooooo 
0.7~00 -2.?02381 3.632148 .000000 
1.00000 -2.?02381 3.632149 .000000 
&LEM " ----·-···•··- LENC.i1H • 
LMD VERT --------
REL nrsr P V2 
0.00000 0.62M·O!'I -t.¡,Qf16(;7Q 
0.2~00 0.62660!'1 -4.64!'1109 
0.!>0000 0.62611>0!'1 -0.20.\!'140 
0.?!>000 0.6.?660S 4.1:\8030 
1.00000 0.{.2f.60S 8.P9!'19!t 
VJAL LATERAL -----------------
REL DlST P V2 
0.00000 -4.769JJ5 2.62J1J7 
0.25000 -4.769335 2.623137 
0.!>0000 -4.76933!'1 2.623137 
0.7!>000 -4.76933!'1 2.623137 
).00000 -4.76933!'1 2.6231)7 
P~ SAP?OOO- VI:RSH'tl [(...10 

V3 
.000000 
.000000 
.000000 
.0(10000 
.000000 

VJ 
.000000 
.000000 
.000000 
.000000 
• 000000 

FRI>.ME t:LEME:NT lNTEf<NAL 
tLCH ~6 ................................... LENGTH • 

LOAD vt:RT ------------------
RtL D1ST ~ V2 
0.00000 •4.6!'14641 ·!i.!>O!'I2.H 
0 • .?!1(100 -4. 6!'14641 -!'!. 06.,664 
0.!>0000 -4.6!'1Ui4l -0.62209~. 
0.7!>000 -4.6!'1464] 3.81947!'1 
1.00000 -4. 6!'14f>fl 11.261045 
LCWJ LATERAL ----------
RE:L DJST P V2 
0.00000 -!'I.OS2S.ll 1.2'7'fl81• 
0.2~..000 -5.052!'1.11 }.?791flf 
0.!'10000 -~>.t'!'I:!'>Jl ],;oiQ]:¡¡, 
0.7'>000 -~>.0~·~·;': J .. '7'1J~f 
1.'1nucw -s.os;·•,J¡ •.• 7•.:· .. 
E.LE.M 1>1 ............................... .. 

L.OAII VI:Rí ------------------
R~ D!$í P V2 
0.00000 1.(:1:1:1'70!'1 -;L;>~.H"lO 

0 . .?~00 l.9JJ70~ -4.9)2900 
o.5oooo l.S.B705 -o. nn;n 
0.7!'1000 J.E<J.\70!'1 4.0702.19 
1.ooooo J.1t1:1nos !L~1J&o•• 

V~LJ LATtRAl.. ------------------
;tU t<lST f' v:: 
1).0'}00fl -~ .~9J'",f>4 10.1 '!.1 <,¡: 
0.~'..0•1'::> -2."1"1'-'>( >·L!:I'··l.' 
(1.!'10000 -;•,fl'•.\'>64 JO.Jll50:· 
0.7!'1000 -2.f!QJS<·f JO.Jl1'>U:-
J.OOOOO -Z.k'IJ5t-t 10.11150;-
l:l.OI 6~· ------------------
LOAD V&kt ------------------
llO. tllSt P V2 
0.00000 0.231.!62 -9.761320 
0.2'.000 0.2Jl26l -4.3197S0 
0.~0000 0.2.'126;? O.l2JIIl'f 
0.75000 tl,2,'l.'f·¡> 4,'>(.J,Ifl'l 
1.00000 0.;>~!;'6:.0 'f,O(H'•;,•, 
PR'.).",RA,Ao! ~!AF; (,Q(J - '•'::F-:.'1'.'"' H .l :' 
F R ~ M [ [ L E M [ N T 1 N 

LOALJ LATt~ ------------------
Rn. DlST t· V l 
0.00000 -C.26f.ll4'l ~-~11¿C7 
0.2SOOO -0.?~814~ 5.871207 
0.50000 -0.268149 !'1.1171207 
0.7!'>0CO •0.268149 ~>.871207 

1.ooooo -o.:..t.8H'f 5.&71207 
ELEM 6J •••••••••••••••••• 
UW'> vt:.RT ------------------
PLL O!$T P V7 
0.(>0000 0.24~·511 -Eo.H-CU~4 

0.25000 0.245S11 -4.01~~&4 
o. !'10000 (1.24!'151 J o. 4:>:•CJ(I!'! 
0,7!'1(100 0.215511 Lfl(o4~>!'15 

l.OOúOO 0.24!'1511 9 .. 1(1(.1:!~ 
LOAD LATtRAL ------------------
RO. tllST ~ V2 
0.00000 -1.017l.Jó 4. 72~5135 
0.2!.000 -1.017136 ... 725585 
0.~000 -1.017136 4.72~~!'1 

0.7!'1000 -1.0)71.\(. 4.7~S~5 

1.00000 -l.Ol"'Dí· 4.72S585 E.I..Df Í·4 _____________ ... ___ _ 

t..OAD VLRT -----------·-----
RO. tllST l' V2 
0.00000 0.210091 -8.2268AS 
O.lSOOO 0.210091 -J.7S7J1~ 

Vl 
.oooooo 
.oooooo 
,000000 
.000000 
.000000 

VJ 
.000000 
.000000 
.Ú()()(>()(l 
.\'0(\(l{J(l 

t.E.N\.~TH • 

·¡_; 
.000000 
.000000 
.00000(; 
.00000{1 
.00000(1 

Vl 
.00')')[)1) 

.00(!()00 

.00000(\ 

.000000 
LEHI.~1H • 

Vl 
.000000 
.000000 
.000000 
.000000 
.000000 

V) 

. 000000 

.000000 

.000000 
• 000000 
.000000 

LEHGTH .. 

V' 
.000000 
.(•00000 
.OfJOO:lO 
.COO{lOO 
.000000 

V3 
.000000 
.000000 
.000000 
,()00000 
.000000 

u:,.-~rH .. 

Vl 
.000000 
.000000 

• 000000 
.000000 
.000000 
.000000 
.000000 

6.000000 

T 
,000000 
,000000 
• 000000 
.000000 
.000000 

T 
• 00(}000 
. 000000 
.000000 
.000000 
.000000 

6.000000 

T 
.000000 
.OOOúOO 
.000000 
•• 100000 
.OOOOO(l 

T 
.000000 
.000000 
• 000000 
.00000(1 
.000000 

FORCES 
1>.000000 

T 
.000000 
• 000000 
• 000000 
.(l00000 
.000000 

T 
,(WOOOO 
.000000 
.0000(1(1 
.OOOC:(l(l 
.0''00-(:(• 

b. 000000 

T 
.ocoooo 
.000000 
• 000000 
.000000 
.000000 

' .(;01)00,) 
. f.'''):'),\ 
,0(,(1(1(1() 
. ooooo:. 
.000000 

(..OOOClOO 

' . 000000 
.000!)00 
, 00000(' 
.(lOOOOO 
,()(,()()()0 

r o t1 -:' E s 

T 
.vooooo 
.000000 
,000000 
.000000 
.00000(1 

6.000000 

T 
.OCH:OC:O 
.000000 
.000(1~0 

• 000000 
,(!0000(· 

T 
.000000 
,000000 
• 000000 
.000000 
.000000 

6.000000 

T 
• 000000 
.000000 

. 000000 
• 000000 
,000000 
• 000000 
• 000000 

"' .000000 
• 000000 
.000000 
.000000 
.000000 

"' .000000 
.000000 
.oooooo 
.000000 
.000000 

K2 
.OO(lOOO 
.oooooo 
.000000 
• 000000 
.000000 

]~.9'H:IS52 

6.!'101005 
0.00.\4~9 

-(,.. 494088 
-12.!1916)4 

"' -8.915176 
1.4~24117 

~- 0~7796 
2.000750 
~1.?196SO 

"' l0.'l06.\23 
!'!. 4~8102 
0.0098110 

-S. 438.Hl 
-10.886!'1(,..\ 

.. , 
•E!.797276 
], 511 S65 
S. U905:' 
2.12:.-19!'1 

-7. S~6::1J? 

M2 '" .000000 7.899121 
.oooooo J.9Sotot1S 
.000000 0.019710 
.000000 -3.914995 
.oooooo -7.84970] 

FJU:EJDtPU"9.~"JUT 

"' .000000 
.000000 
.000000 
.000000 
.000000 

"' .000000 
. 000000 
,(I(I(I()(J() 

.O(IQ(hl(¡ 

.OO{)WJ(l 

H} 

.000000 
. 000000 
• 000000 
.000000 
,000000 

"' .Oí'JOO\!() 
.~C0!l•lC 

• OOCC'<(J:> 
. 0(•000:) 
. ooor.oo 

"' .000000 
.000001) 
.000000 
. 00\lOOO 
. O(>ú()(j(J 

"' .000000 
.000000 
.000000 
.000000 
.000000 

"' ,000000 
.000000 
.(100000 
.000000 
.00000{) 

H2 
.000000 
.000000 
.oooooo 
.000000 
.000000 

H2 
.000000 
.000000 

l<l 
-9.4462'JS 
l. 490379 
S. 74469& 
."i.3H·66J 

-!>. 713727 .. , 
.l. ?Q04!'1i. 
1.~71(.?? 

-o.on1o:· 
-1. 'Jf,<;,Etf<f) 

-l.i<t<H!'I'• 

"' -8.?4l?ll> 
1. f!O!!Sll 
!'!. 6969!'14 
2. 9;'2803 

•C .. 5JJH.1 

KJ 
~h. 1l>lA41~ 

! : J:l1~'\ 
~.•. Hi·O'IJ 
-H.!'InH~ 
-.'.L6A05Qfo 

'" -7.~60201 

2. 1)01>01 
S.47'Wf'' 
J.<lf,~l41 

~1!.21111 !< 

HJ 
16.0')2910 
7.2H.l00 

-1.560710 
-10 . .'67520 
~19.174.130 

HJ 
-i-.~2411~> 

2.B.I4'H!< 
5. ~:nr;n 
J. !'165CJA2 

-9.06202(1 

l<l 
12.720677 

5.6.32)01 
-1.456076 
•8.5H45;i 

-1 S. 6.'2!130 

Hl 
~s.~o.c.)J~ 

J. 207111 S 
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o.~ooo 0.2100~] 0.6!142~4 .000000 .000000 .000000 ~- !1~1611 
o. 7!>000 0.210091 ~.O'f~tl2f .000000 ,(100(100 .000000 1.24~0~;' 

1.00000 0.210091 9.~.l"',94 .000000 ,(){IOOC(r ,000000 -9. "/2'99€.1 
L(IA..": lJIT.tJIAL ------------··--
Rf.L DI!1T p "' VJ 1 "' "' 

~· 
o.ooooo -1.0396"/ll 3. 724"19&. .000000 .000000 .000000 q. 9!19129 
0.25000 -l.OJ<J67fl 3. "124"199 .000000 .000000 .000000 4.310946 
0.!>0000 -1.0396"/fi J. "/24"l<'fi .000000 .000000 .000000 -1.21(.2.'6 
0.7~00 -1.03!16"/fl 3. "12478fl .000000 .000000 .000000 -6.80J4lfl 
1.00000 -1.0;1'16'7(1 ~- 7;>4'7il!l .000000 ,(1(1(1000 ,('000(10 -1 ;>. ·'"060(1 
PAO(".RAI'f !V.P2000 - '/ER:o::;c_.., [(., l0 fTi.E: EJEH:PLO'<.OUT PA(é: .H 
¡.·RAM ' ' ' ' oo: r s ' ; N 

1 ' 
q N A r o' ,. 

' ~~ 

f:LEH f,~ --------·--------- LD/l~TH .. 6, 000000 
UW> VE!I1 ------------------
REL DI:>T p V' VJ 1 "' "' 0.00000 o.:·JS3J2 -&..04!!:•fl7 .000000 .000(100 .0(10000 -~.zoo;;4o~ 

0.2!>000 O.Zlfi.H2 •],.;077HI .000000 .000000 • 000000 3.!>]6.\4!> 
o. !>0000 0.2l9.ll2 o.&Dfi!IZ .000000 .000000 .000000 ~.616"144 

o. 7~00 O.Zl9312 ~.2:!>42Z .000000 .000000 .000000 1.0.H7fl'f 
1.00000 0.2l9.ll2 !>1. 7]{.991 .00000'1 .000000 .000000 -10.20~1~0 

LOA.O LATERAl ------------------
RLL I.llST ,. V2 Vl 1 K2 "' O.OQOOO -l.':ll409r) 2.J72':10~ • 000000 .000000 .0!"10000 "' l46b27 
o .z '>0<)0 -l. "124("'191) ~. P~'i:l4 . 000000 .001)000 .OfJOOOC ~.f.tl7.::7\ 

o.;,oooo •l ''1:!40'1() l. <'1]~04 .oooo:w .(I(I(J(lOO .000000 -0.!1'1209~ 

o. '7 ~000 -l. <i¡4(1'10 :! • • n;>'~04 .000000 .0000(1(1 .00(100(¡ •4.41H4l 
1.00000 •l. 'l<'40Wl :.- .. 1"72904 • 00000(1 ,000000 . 000000 -'7.<i:'i0"1~'7 

ElD! (,(. --···---------···· L..f)l(.lH • (..000000 
lAW vtRT ------------------
ki:L DlST ,. V2 V3 1 "' "' 0.00000 -0.81021.( -8.619940 .000000 .000000 .000000 -"l.08307b 
0.25000 -0.810274 -4.1 '18270 • 000000 .000000 .000000 2.515507 
0.~0000 -0.910274 0.26.i.l00 .000000 .000000 .000000 ~.4!117.1~ 
0.7~00 -o.a10:>14 4. 7049€.'1 .(100000 .000000 .000000 l.?2%0f4 
1 .ooooo •(l,fll02'74 Q,]4(.4.l<l • 000000 . 000000 . 00000(1 -fl. HZf47] 
lJ"IA.."l LI.TEJV..: ------------------
REL r1r:<r p "' V.' T "' H.' 
O. OCrOQ(I -J.:l!O!Ill O. 7 iOW::O .00000(1 . onoooo • 0(10000 1. 71 í<.l!'>~' 
0.2~00 -1. 910'112 o. '7.10~02 .000000 . 000000 • 000000 o. í-2244'1 
o. !>000{) -1. 91{)'f12 o. '730(.02 .000000 . ooooco • 000000 -o.n.H~• 
o. 7!>000 -1.910912 o. 7.,0602 .000000 .000000 .000000 -l. 5{.93~>7 
].00(100 -1.910912 o. 7.30f>02 .000000 .000000 • 000000 -2. H!1260 
ELD< " ...................... U:NI,.';TH"' 6.000000 
1.<W) VERT-
REL OIST p V2 V3 1 H2 "' 0.00000 -2. "1!>36~9 -9.95~7)9 .ooocoo .000000 • 000000 -4.9640~9 

., 
0.?!>0~0 -2.1~J6~q -4.4Hl4P .000000 .0(1(1000 .OQ(l(lO(l 4. 1H19.l40 

'• O. !KIClOO -::-. 7~;11·!1'1 0.07'~2~ .000000 .(1()()(100 .{1{10000 tl.]'79,~{ol~ 

O.?'iOOO -?. 7S.it>~'f 4, Hf<"'fCil .000000 • (¡(l(l{JOO .0\1000(1 4. 110601(· 
J.OOOOO -::-. 75.'\fo~,!J fl.'<lO!>U .000000 .0000(10 .000000 -!>.l2fl!'>fiR 
PJU.X;RAH ~>Af'ZOOI) - VEA...;Hl-1 EG.JO f"JLE.: E.JIMPLO!l.OIJT PAC.t .l!> 
f" R AH E EL E K [N T I N 1 ' R HA S.. f" o .R (.' ' S 
L01ú) LATERAl ------------------
REL DlST ' V2 V3 T H2 HJ 
0.00000 0.166062 0.076089 .000000 .ooooco .000000 O. JOOStl 
0.2S.OOO 0.1660b2: 0.01&089 .000000 .oooooo .000000 o. 186409 
O.!tOOOO 0.166062 0.076089 .000000 • 000000 • 000000 0.07227{. 
o. 7!>000 0.1660~2 0.076089 .000000 • 000000 • 000000 -0.0418!>7 
] .00000 0.166062 0,076099 .000000 • 000000 • 000000 -0.1~~990 
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DISCLAIMER 

CONSIDERABLE TIME. EFFORT ANO EXPENSE HAVE GONE INTO THE 
DEVELOPMENT ANO OOCUMENTATION OF SAP2000. THE PROGRAM HAS 
llEEN TIIOROUGHL Y TESTEO ANO l/SEO. IN USING THE PROGRAM. 
110\\'EVER. TfiE USER ACCEPTS ANO UJ'OERSTANOS THAT NO WARRANTY 
IS EXPI<ESSED OR I~IPLIEO BY TfiE OEVELOPERS OR THE DISTRIBUTORS 
ON TIIE ACCURACY OR THE RELIABILITY OF THE PROGRMI. . 

TIIE USER MUST EXPLICITLY UNDERSTANO THE ASSUMP-TIONS OF THE 
I'I<OGRA~I Ai'iD MUST INDEPENDENTL Y VERIFY THE RESULTS. 

E'¡emplo 1 

Ejemplo2 

Ejemplo3 

E'¡emplo4 

Apéndice A 

ApénáiCOB 

lndice 

Pórtico Bidimensional bajo Carga Estátlea. •••••.••• , • , 1 

Pórtico Bidimensional con Carga de un Espoctro de 
Respuesta ........................... _ ............. 13 

Pórtlco Bidimensional AnáDsls de Historia en el Tiempo .• 20 

Diseño en Acero de un Pórtlco Bidimensional ••••••••• , 32 

Descrfpclón de los la>nos de la Barra de Herramientas .• Al 

JJescrlpc1ón de los Iconos de la Barra Flotante ......... , 81 



4. Edit¡: b ¡eomcoia de la malla '1 snsionc d 006o OK para cerrar la planUib.. 

Sug¡:rc:nci3: f"iMiilJULJ la eJició11 tk la miJ!úz, St puetk hacer dici eon el 
botón dtrtcho dtl mouu robrt ltJr columnlJf para vtrificar Ji lttlJf 
titntn la lonritud apropiada. ÚtlJ er una mlJntra muy práctica de 
obtener infomuui6n robrt culJiquitr nudo o tlementiJ de la 
estructur4. 

Edición de Apoyos 
El )iguieme paso C:l el c:unbio de los apo)O'> de 1:1 escrucrura de la opción por defccro que 
corusponJe a nudos artic.:ul:~dos, a 13 opci.5n de nudos rígidos que tenemos en este caso. 

l. Seleccione el icono Polntcr Tool d.: lJ barra de hcrramiemas nocanfe. 

2. ~l.1tquc un área r~Ctilllgul:lr que ab.ulj•le los ucs nudos en 1;a b..t~ de la cstructW"'. 

Sugerencia: Se pued.t obrtrvar la blJ"a de trUu:lo para "tr d número y 
tipo dt eltmtntos que han si.lo stltcdontJdos. 

3. Seleccione el icono Asslgn Jolnl Restralnts de la. barra de herramientas flotante para 
asignll empotramiento en IOi apo)OS de la estructura. Se pucd<!n asign:1t también oa-u 
car.~cteristicas de los nudos desde el menó Assicn. 

Definición de la Sección Transversal de los Elementos 
1. Seleccione primeramente tedas l.aJ sccciooc:s nnsvcna.Jes que: van a emplearse eq d ¡:ático. 

Desde el menú Define sctecciooe la opción framc Stctions. Ulego impcne los perfiles de 
acero rnostr.Jdos en la ñgura 1·1. 

Nota: Se putd.t stkcclonar md.s de una stcd4n a la w: tú la lista ~cdon 
Sdtctfon. l'llra tilo prtsiont llJ tecla Ctrl mientras st efectúa 112 
stltcción. 

2. Bajo el menú Sc:lect cncnunrJ varias ramas de sdc:c:cicnar nudos y elementos. Pan. este 
problenu son úriles los mOOos de selección Polnttr/\\1ndow c. Intcrsccdnc Une. 

3. Una vc.z sc.leccioo.ados los elementos dd ¡úrico dc:;::;ados, se pcx1rtn asignar las sca:imcs de 
acero axres¡xxuijaues a través del b::x6n Asslcn Frame Scctlons que est1 ubicado en la. bam 
de hemmimw ncwue. 

4 SAY.I:OOO Cuf¡ de Aprmdlujc 

Asignación de Cargas 

• Ckt.lcl': -- •.• ·-· • ... _ 
1 . : 

'. 1 LAAd ""'"'i' ... =--:lr.-_,..C .. "-'"-'''-- 1 Md-l-' 

l. Y F· "r: . ::: .. :=0~·~·==-..... =: C·•'•••LJsS 

'' . ' ' 
1 --------·-.----- -----· 

Figura 1-2 Pla.1tilla con los nombres de In condiciones de carga cstilie~ 

l. El primer pa..so al ingresar las cargas co; definir las condiciones de carga. estJtiu. 
Par3 ello ingrese al m~nú Ddine y selecc.:ion.: 1.1 opo:iJn Stalic Load Ca31CS. 

• OEAD puede usarse para las cargJS verticales por peso propio de las vi¡a.s, 
mmtc:niendo el indicador Selr \\"ei:hl J\luhlplicr con d v;1lor 1, SAP!OOO a.p-eg~ 
el peso propio de las vig.:n. 

2. Defina una condición d..: carga latertl estática llamada EQ pan la carga de sismo 
Asi¡ne esta carga.later.3..1 como una carga dd tipo QUA K E. Esro pemtitirf al 
programa. efectuar autom.iticamenrc las combinaciom:s de ar¡a 1 ser cmplead.u 1 
el m6dulo de diseño del SAP2000. Ademis asigne a.l pu.tmeuo ScltWclcht 
Muitiplicr el valor cero. · 

3. Lu ear¡u vcnicales mosteadas en la fi¡un. 1#1 pueden asigna.nc ala.s vips 
seleccionando todas las vigas utilizando el balón Assi:n framc S pan Loa eh de l.­
barra de herramienfaS notantc. 

4. Las cugas laterales cnjticas necesitan ingrcsa.rsc seleccionando individualmente 
cadl nudo y empleando el botón Assign Jolnt Loads . 

lmpoiU.ntc: Aurrlr~Jt 4t qut tSÚ lJñiUli.tndo l4s ClJfJtll G ra conJid6n d.t 
ca.rra co"npondientt. 
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Ejnllplo 1 Pdnico Bu.iuDcaJioo.&l COQ Catp Edtlca 

Creacló. Jiafragmas de Piso 
Crear diafragmas de piso y especificar la rrw.a del piso sólo en la diraxi6n X soo tlaüeu 
comúnmente: usadas par:~ rcdocir. el tamaño dd p-cblema.. PCI' ca o lado, al Wdir di:lfra¡ma.s d 
eompcxumicnto del modelo se asemeja al de un edificio c:m diafragmas ógiJos. 

l. Repita los siguiaues pasos para cada piso: 

Seleccione lodos los nudos del piso. 

• Entre al menú Asslcn y seleccione h opción Jolnl •.• Constralnts. 

• Seleccione Add Dlaphracm del la c.~ja de opciones. 

t En la pl.a.nlill.a Oiaphncm Constralal ingre.sc un nombre para el diafragma del 
primer piso. En este caso usaremos el nombre OlA J. 

• Seleccione la opción Z-ujs constralnt. Esta opción define un diafragma 
pcrpendicuiJt aJ cje-Z. 

t Presione el b:xón OK. 

• Presione el botón OK para finalizar la operación. 

• Repita estos pasos para los denús pisos usmdo diferentes nombres en cada uno. 

2. La rrusa de tedas Jos pisos es la misma. l.JJcgo sdec:ciooe un nudo en C.lda piso. 

3. Cambie: la.s Wlidades en que se van a lngres.1r los daros a K.ip-in. puesto que la masa indicada 
en la Figura 1-1 estJ d.Jda m esas unidades. 

4. Dd menú Assf&n sclecciooe la opción Joint ... Mns.es 

• Ingrese la mas:~ de cada piso en la dirección del eje coordenado local1 (que en tste 
ea so coincide con la dirección del Eje Global X). 

• T OOos los de mis valores son cero. 

S. Rclcmc las untdades a K.ip-ft. 

Propiedades de los Materiales 
Pcx úhimo. antes de cfecruar el anilisis de la estructln, deberemos verificar que la asignación de las 
propiedades de los materiJ.Ies es la correcta. 

l. Desde el menú Define selcc:cione la opción r.tatcrials. 

2. En la planlilll Matcrials seleccione STEELy prtlione el botón MODifY/SHOW 
MATERIAL 

· F,jcmpZo 1 P6rtico Bidimmsion.al coo Carp E.Wia 

• En la plantilla Maltrial Proptr1J Data vtritique que las~ del nweriaJ 
sean las corrett:~s. Recuerde que los valores son rcpon;ul~i--~bdes con bs 
que se "este tr;,bJ.jando en este momento. 

Efectuando el Análisis 
Una vez que Jos dar~ han sido ingr~dos. es tierJq)O pan c::cncr el modelo Y revisar los rtSuludos. 
J. GC3be el moJdo. 

2. Es:pc.:-ifiquc los pl!tmca-os para elanilisis seleccionando la opción AnaJyte del menú 
Set Options. 

• En b plantilla An2lysls Optlons seleccione Plane Framt A.Dalysls pan reducir el 
tJmaño del problema. y por lanlo reducir el tiempo de c.ilculo. 

• Prc)ione el balón OK para aceplar los c;unbiO$ rcaliudos. 

3. Sc1ctcione la opción Rundel menú Analyze para proceder al anilisis la esD'Uen:rt. 

N01:a: Una 'f! conduú/o ~/análisis Ud. podrti rnúar lot r~:sulstulot 
~omplttos en Lo pantalla anltl M prtsionar el botón OK. &la nrd IU 

primtra vtrificación para ru si uüu altún problt1TIIIItll ~1 moddo. 

Usando los Resultados 

Verificación de los ResuHados 
Una ~z que se ha a:u1iz.ado el modc:lo se debe verificar si los rcsulwb soo COTCCIOI y que sus 
valores son del a-den y magnirud a los espendos. 

Vcri6caci6n dd Mo.Jc:lo: 

1_. Vcri(aquc que el corwue rcxal en la base es i¡ual a la carga lateral total par¡ la condición 
de cu¡a EQ. 

• Seleccione el grupo de elementos del pónico que estln ubicados en el primer nivel 
así como los nudos en la b:tse de la. estructur:t. 

• Desde el menú Assf¡:n selecciooe Croup N ames. 

• Asigne a este grupo de clemcn1os un nombre representAtivo por ejemplo BASE 
SHBR. 

• Seleccione el botón ADD 1\"EW GROUP NAME y presione el botón OK. .. 

• Ea el menú Display seleccione la opción Show Group JolnC Force Swns y elija el 
grupo pre\i.lmcnte creado. 

6 SAPlOOOGub de Ap-clldiujc SAPlOOO Gufa M Aprrdiajr 
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2. Obserllc la deformada de b estructUra y aee una anümción de la misma bajo carsas 
\C:C1icalcs y lata~es pJtaascgurarse de que el.:omportam.icnto del moddo es el esperado. 

• Ingrese al menú Display y seleccione Show Ddonn~d Shapc y seleccione la 
condición de car¡a en la que este interesado. Tambi~n seleccione b. opción \\1re 
Shadow, asC podrt ver la acomctría no-ddormada de la estrUctura al ntismo tiempo. 
Vea las Figun.s 1·3 y 1·-4 para las formas ddormadu de la tstrucrura. Haga click 
con el botón derecho del mousc sobn: cualquier nudo para observarlos 
dcspluamientos y rotaciooes correspundienr:s. 

• Genere una animación de la dcformJJl presionando el blx6n ST ART ANIMA TION 
ubicado en 1:1. pllle inferior de la barrJ de estado (Para esto se necesita que se 
encuenuc activa una ventana conteniendo la deformada de la esttuctW"'}. La 
animación as( creada puede salvarse como una archivo • .A VI pan ,·erse despuls 
desde el menú FUe. (Vea la A )\Ida En·línea bajo el ítem ''Exportan AVl file".) 

Intente esto: Puslou los boronu +y- ubicaJor junto al hot6n Aninult.t 
~.,,a lo que lt ructdt a la d~fonnad4 di lt estructura. 

• Presione el botón STOP ANIMA TIO~ cuando haya tecmioado de obsctvzt la 
animación. 

Si los proccdimientas antes descritas muc:saan que la infmna.ción ingresad¡ aparcntl ser oxrccta. 
podemos entoocc:s av.ltl.LU' hada proccdnrUentos mis avanzados de revisión de tos resutudos. 
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Figuret~ O.formada de la E&tNchl'a p•a C.gu 
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En mdw ocasiones se ck:sea wrific:ar si la c:smxnn se cncuaun dentro de de!enninadollfnUtt:5 
de cxxnpooumiemo, oales como ruogos de esfuerzo especificados por algún códiao de diseño. 
S.l.P2COJ hace todas csus vtrificaciooc:s JliiOITlbiClJlldlte aJando los cletne2Jt01 son diseñados. 
('I.As opdooc.s de diseño del SAP200l JCin disruticbs ron nu.p dcWie en los 5i¡Wcntes 
ejeonplos). 

l. Los elementos estnocrurales pueden discftanc dtsdc al mcnd Da!p J seleccionando la 
opción Start Dcslco>'Cbcck o! Structurc. 

• Los clemeatos del pórtico mostnrln m este momento colores que rcprcsc:ntan c1 
nivel dd esfueno en cada demento. Asimismo en b parte inferior de cad.l rlemcnro 
se muestra un valor nu"máico representativo del nivel de ctfuerto presente en el 
elemento. Un valor 1 por ejemplo significa IOO~k esforzado. 
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Ejemplo 1 P6rt.ic:o Bicb::lltll.siooal coa Cup Eddc::a 

Pan 1ener nús infocmaciOO sobre el diseño de los elementos entre aJ mcnll Dcsfp Y 
seleccione la opción Display Dcslcn tnfo. 

Se puede tunbi~n ver la infomución del diseño de cada elemcnlo, o inclusive asignar 
se<:ciones transversales altemat.ivas. haciendo click con el bolón derecho dc:l mouse sobre UD 

elemento. 

• De la ventana que se muestre se puede sclcccionu ti bocón DETAILS para apreciar 
infonnación deullada de la sección bJjo cada una de las combinaciones de car¡a 
empleadas en el diseño. 

• También se puede rediSC:ñar el elemento desput!s de cambiar sus padmetros de 
diseilo.longirud efectiva. factor K o propiedades ala sección, presionando el 
botón REDESIGN. 

3. Si se ha seleccionado Wl& nueva sección la cual se quiere utilizar c:n el disdl.o final de la 
estructura. únicamente ingrese al menú Dcsi¡:n y seleccione la opción t:pdatc Analysls 
Seclions para reanalizar la estrucrun con las nuevas secciones seleccion:::ils. 

Nota: Puede Jtr rucesan"o el uto del bot6n Refns" Window dL la krra IÚ 
huTDmientils para acn.u21i:ar W información tn la vtntan.a activa 
lutgo de haber efecrutJdo CtJmbiM en lor porámetrot dt éittiio. 

Observando e Imprimiendo ResuHados 
A menudo se no.:::eliLa disponer de una oopia impresa de los rcsullados de los an1lisis obtenidos IXI1 

el SAP2000. Existen difcranc:.s formas de 0CcCJ1erlos: 

1. Se pueden elegir los rcsuhados que nos interesan c:on la opción Genera te Output ubicada en 
la plantilla Analysis Options. El botón Select Out pul Opllons que aparece peimitiri 
seleccion:ar cuantos y cuales de los resultados queremos imprimir. Estos resultados son 
escritos en un archivo de te:s;to con el nUsmo nombre de nuestro archho de datos, pero c:on la 
extensión • .OlJf. 

2. los datos ingresados as( como la mayor parte de los resuludos zencra.dos tambii!n pueden 
verse a partir dc:l menú Display . 

3. Desde el menú File se puede optar por imprimir ya sea Grtficos, Tablas con los Datos 
Ingresados 6 Tablas con los Resultados del An.tlisis y Diseño de elementos. 

Sugtrencia: Si eristen eltmtnlot 6 nut!os seleccion.Gdos al momtniD dt 
ttnero.r lG impresión dt rtsuluulos, único.mtnlt u imprimirá la 
informad6n corresponditnlt a didos tltmtntos. Dt lo contnuio, ltJ 
impresión se ttnerará para todos IDt tltmtnJos 1 nu.dos dtl modelo. 

4. El an.flisis efccruado por el SAP2000 genera dos archivos de salida. El uchivojil~name.EKO 
que incluye toda ).1 información empleada en el análisis; y el archhojit,.namt.Olff. que 
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Ejemplo 1 Pórtico Bidima:uiooal coo Cup Esú1ia . 

tonticnc los resultados del an!lisis ur como los re3ultados C3p<dfic.-=ionadas .. 
el menú Anai)_"Z_e ••• Ser Options. -

Recuerde: b un hutn h4bilo renervr 14 uJiJa primerrzmtnll Cl un 
archivo tÚ luto antes ú envi.Grlo directamenll d la impreSOrrL EslD 
not penniu revisar prnÜJmentt la infonnad6n uttJndo cutdquitr 
editor de tntot, tin ttnu que haur /renlt G enormes piW dt pap.L 

Comentarios Finales 
Como habci poiido cbset' :u. SAP2CXX> es wu pcderos3 hanmienta pan el anfiisiJ cstrucnn.l cp: 
p.w1e uSJtsc: en una gn., 'aried.ld de prcblcmas. Sin ernbJtgo, es muy impcxu:ue cntCJldcr los 
principios de i.ngenicrú s.::he los cuaJes este P'OP"ama ha siLJo creado. 

La mayoría de los trabaj:'h en inga'liaia se inician ecn sencillos antcprayectos pan poitUk:tmeule 
madurar en complejos prO} ectos de an.ílisisldiscrlo. Esro hace que sea muy impcnante &xidir desde 
un inicio lJ.S hC1T3mienw :!p!"opiadas de fcrnu. uJ que no se3 nec:e.sario cambiar de p-ogr.un.u a la 
miud de un frO)t:cto. S.-\PlOOO traL1 de satisfacer l;~ m:l)U p.:ute de l;u necaidadcs que un 
diseñador puede tener dur.1ntc el desarrollo de un proyecto. 

Las caract.aí stic.as que SAP2000 ofrc:ce en el proceso de disci\o incluyen: 

• La capacidad de diiaiJt pc:qucños 6 grandes puycctos sin necesidad de ap-tndcr a usar m 
nuevo progr.uro. 

• La capacidold de diseñar elementos de concreto y acero en un mismo p-ograma.. 

• AlgoriiJTIClS de c.álado rfpidos que pc:rmir.cn al usuario dcdjar ma)U tiempo en la modc1aci6n 
del probletn:l y optimizJción ckl diseño de elementos emum.n.lcs. 

• La habilidad para mo.hficar y mc:jcnt el diseño fácilmente. 

• Existen p-obablemc:ntc unw formas de modelar una esuuctun. como ingcnicra5 Wsun. Siñ 
embargo. pue&: encon0"3f .hiles algunas de bs siguimtes idc.:u : 

• Comience oon un mOOelo b.isico de la c:str\JCUJfa y trate de entenderlo antes de aAidir mfJ 
dc:ul.les. Sed mis sencillo CaTc:gir problemas en el sistema estrucrura1 a.:Jcpudo cuando c:l 
mOOclo es aún simpl:. 

• Asegúrese de que la CSII\ICtln pueda OJnSU'Uirsc: y que se compaurt en la manen en cpe la 
hemos mOOclado Si no puede ser construidJ en es.¡ forma. es ne:cesJrio entender d efecto dd 
proo:so coostructho en el comporumiento final de la estructura.. 

• Dccumcrnc deta.Uaduncnle su cüscño i:nduyauSo infcxmaciOO sot::n: las cxnsidendmes 
asumidas, irc.u que d.:ban scvisarse e induso sebe informJci6n que aún es requcri4L Pare ello 
use el editcx de textos Ustr Comments and Sesslon J...oe que se encucntn dentro "del menú 
File. Este editor de tex1os incoqxndo en el programa. le pc:mútiñ que dichas a.na..teiales y 
comenurios fcrm.::n pmc del modelo. 

SAP'2000 Ciufa de Apt"nadu:jc J 1 
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• Experimente ccn sistanas csttuctllnles alranarhos. SAP2000 ha sido cfudlado pn db::rulr 
d.lculos nunlbicus clpidamcnle. pc:múdcndo unliza:r rna)U tiempo m d mejcramiouo de 
nueszros disei\os. · 

• 1\j( romo hay un tiempo 15ignido pera la revisión ¡en<nl al final de un po¡oao, ao hay rudo 
pa 1~ que no deba haber un tiempo para reviSll' el p-O)Uto desde sus inicios. 

ll SAP200CI Ciub de Apudlu.je 

EJEMPLO 2 

Pórtico Bidimensional con 

Carga de un Espectro de Respüesta 

Descripción 
Ex~<: ejemplo es una axuinuaci(n del Ejemplo l. En c:su secáón rrm mw"' amo inarpcnr .., 
Espectro de Rt:spuc:sta en el anJlisis de un p(ític:o bidimcnsiooaJ. La bo1sc: p.tn definir d Espcaro de 
Respuesu S<rl el espc<rro del c(rl;go UBC94Sl el c:uaJ esu inelwdo m el SAP2000. 

Aspectos Significativos del Modelo y del SAP2000 
• Uso del oomando Htlp pn dxalct insauccimes sotnlas opd<Xl<l del SAP2000. 

• ·ln<n¡laad(n de una corp ¡ro.miente de 111 Espearo de RespoesrL 

• Adcaw la escala del Espcaro de Respuesu poto su wo Cl1 el cfudlo. 



Ej(mplo 2 P6nica Bidi~4.1ioaal coa c:vp de a E.spcaro de Rupuua. 

1 
Definiendo el Espectro de Respuesta 

Un Espearo de J«spoesta es la miúma respuesta de lD1 sistema cxciado m su base par \m 

función acelC"ación-tiempo. Esta función se U(rtu en táminos de la frecuencia nanr.ll de la 
esuuaura y del amatigua.miemo del sistema. El Espcaro de Respuesu del c61j¡o UB~S2 que 
vamos a emplezr C1 t:Sie ejemplo es suminisaaJo coo SAP2000 y no es nc:ces:ario dc:finirlo pcr 
sep:uado. Si hubiese la necrsid:!d de definir un Espc:aro de Respuesta distinto. se puede usar La 
ayudJ en lín~ pJ."""J cb.ener ins:;ucciones que indican p.uo a paso como efe;nw esta tarea 

Ayuda ErHinea 

Recuerde: Fodrd utilir.ar alguno tk los mltodos slguünt~s ptUG o&un~r 
información sobre cuolquitra dt las fundOIVI dtl S.-tP2000 

l. Del mcnü llelp sclc:ccione Search (or IJelp on. 

2. Con el plantilla lndex selo:xiooadl; 

En el Atea 1 escriba 'Define'. Ud. vera en el Arca 2 una lista de todos los tópicos 
disponibles que comiencen con IJ pal.1bn. 'detine'. Uno de esos tópicos es 'Define 
Response Spcctrum Functions', que es el tópico del cual necesitamos obcener J:)'Uda. 
lb¡:a doble clicl.: en 13 linea con b fr:~sc 'Define Respon~ SpcctnJm Functions' 
p:~ra que el programa muestre IJ información coaespondiente. 

3. AJicmaJivamente, seleccione el indicada- •ind para 00scar una pa!ab-a clave m walcsquic:n. 
de los rópiros disponibles en la A)ud.l En-línel.. 

• Si es la primera vez que un la opción Fmd de la Ayuda En-linea del SAP2000, 
apJieceri una plantilla denontinada Find Sdup Winrd. 

t Presione el bor:ón t-.txT para aceptar el airerio p;u-a constn..ür la ~e de daxos de 
búsqueda. 

• Presione el boCón ANISH para construir la base de datos. 

• En el Arca 1 escriba 'Response Spc:ctrum' 

• En el Arca 3 encomrart nuevamente la opción 'Define Response Spectrum 
Functions' la cual puede sc:TeccionJt~..:: para obtener 1~ información de ayuda 
correspondiente. 

N~.>~a: S< puede encontror mayor infonnacüln sobre ti uso tú Id A.Judd 
En-lín~a, ~n lo docum~nUu:ión J~ lYindows. Tambiin pu1d~ 1juuiiu 
el archi.,o n1N/1ELPJ2.1ll..P ubicado tn C:\11'/NDOn·ruiEU'. 

Definiendo á Esp<clro de Respuosta 

l. Si d moddo esta procegido (locked). use el botón Lock!Unlock Modtl para remover la 
protección y poder efcctuJ.r CJmbios en el modelo. 
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Ejemplo l Pdrtico Bidimun:ioul c.oa carp de ue. E.spcaro de Rnp¡cu 

2. Ajuste las unidades a Kip-ft. ~ 

3. Jn¡rese al mend Define y seleccione la opción Response S~ 

4. Presione el botón ADD NEW SPECTRA en la plaiu.ill• Response SpccUL 

5. En U plantilla Response Spccuum Case Oa.~a: 

• 

• 

• 
• 

Especifique el amortiguamiento asociado al EJpcctro de Respuesta colocando en b 
couill:t D::amplng c::l YJior, pJt.t nuestro caso: 0.05 (S~) 

Seleccione UBC9~52 parata dirección Ul, asf como un factor de escala 31.2ftlsccl 
t:lla CJ.iilla S cale Factor. Este factor de escalJ es usado por el Es¡xco-o de 
R:spue)tl debido a que el esp(ctro lJBC9-lS! .esu nomllliudo al v;llor de la 
:~cden..:ión de b guvcdad g 

El resto de los valores por defecto son aceptables . 

Presione el bocón OK pan aceptar los cambios hechos en ambas plantillas . 

Efectuando el Análisis 
Una vez que se han realiz.ado las moditicaciones. es tiempo de analizar el modelÓ y ed!zr 1..··u 
mil;ub. a los resultados del Espectro de R~puesu. 

J. Grabe el mtJddo. 

2. En el menú Analpe seleccione la opción Sel Opdons. 

• M.trqu..:: la casilla DynamJc AnaJysls. 

• , Presione el bocón SET OYNAMIC PARAMETERS y modifique el nWnero de 
modos de vibración a ser consid!!rados en el anilisis en l:t opción ~wnbcr o( 
Mod~. Para nuestro caso 7. El resto de YJiorcs por defecto son aceptables. 

• Presione el bocón OK. en ambas plantillas pan acepu.r los cambios . 

Nou: Se tú be decidir cuanlos modos de ttibración dden eotul4~rr:ru ~n 
d análisis para o&ttn~r usulladoJ aduuados. PtJrD dio hoJ muchos 
crittrios d tomar~~~ cu1nl4, puo para una tslnletura s~ncilla como 
la qut ~ttamos anali:ando putdt considtran~ satisfoctorio un 
numtro t/1 modoJ igual al numtro dt pitol. 

3. Seleccione b opción Run Minirnized del menü Analyzr pan analiw la estructur1.. 

Noca: La opción Run Minimiyd ~~ sumam1nlt úr:il euantfo 1t titntn modtlos 
trantl~s qu~ uqui~rtn maJOf' titmpo para ser anali;.adot. Esto opciJn ptrmút 
ol SAP2000 corrtr 1n un Jtgundo plano, ptrrniti~ndo continuar trab12jtuulo 
con otror programas. OtrtJ rtntaja dt est.G opción tt que nos brinda un botón 
paro. co.ncclsu lo tjteución dtl antilitis tn coso n~usan"o. 
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EJemplo Z P~eo Bidunct1dol:l.&l eotl eu¡1 de _.ti EspcctJo de R.u¡ueu 

Verificación de los Resultados 
1. Verifique si lu formas modales y pcrfOOc.) de vibración son los espendos. 

• Del menú Display seleccione la opci.5a Sbow Modc Shape y c:lija el modo en que 
cm. interesado. Pude umbiin selecciJOar la opción Wirc Shodow pan ver al 
mismo tiempo la rorma no-dcformld..~ de la CSO'Uctura. Observe las Figuras 2-1 a la 
2-4 y note que el número de modo) período de \ibración correspondienle eSiin 
indicados en el tirulo de b ven una. 

Nota.: St puttU aprtciar lot rnodor dt ribrrzd6n tubJtcutnltf prtn'onando 
lot botonts + y -, prózimos al botón START Al\'1,\IA TI O N. 

2. Es úril ver el coruntc en la base producidv por el &n.tlisis del Espectro de Respuesta. 

• Usando el grupo BASE SHEAR que fue definido en el Ejemplo 1 observe el 
cortan le en la base de b esrruc1ura d.:bido al Esp«tro de Respuesta. Se puede 
apreciar que este coname es considc!blemente ma)OC que el debido a la condición 
de carga est1tica. · 

3. Se puede verificar el desplaz.anUento de un nudo debido al Espectro de Respuesta. 

• Del menú Display seleccione Show Ddonn~d Shapc. 

t En la plantilla Deformtd S ha pe s:leccione la condición de carga para el an.t.lisis 
espectral. 

t Presione el botón OK. 

• Haga click con el botón dcr«:ho del mcwc sobre un nudo del rúvcl superior de la 
estructura paca v~r su correspondiente dcspla.zamienlo en la direcció11. global X. 

4. Verifique la panicipación de: la masa de la c:strUCNr1 pan ver si se ha incluido el m la 
solución del problema el número de: modolS suficiente. Para ello se debe revisar el archivo 
de lexlo f¡Jcname.OUT empleando un cditcr de textos como el WordPad de Wmdows. 

• Minimice el programa SAP20CX>. 

• ln.icic el programa WordPa.d o cualquier otro edita de teXtos. 

• En Word.Pad abn el archivo jik~.01Jf. Dalde jiJt~~~Jn~L es d oomlre del 
archivo usado al grabar este ejemplo. 

t Busque la s=ión tiruladl MODAL PARTICIPATING MASS RAllOS axnoac 
muestra en la Figura 2-S. · 

t Bajo la ooiW11!1a CUMULA11VE SUM maxurañ que los Modos de Vilnción 
1 al 7 incluyen el lOO% de la participación de masa. Lo cual significa que los 7 
modos empleados en el an!Jisis fueron suficientes. 

16 SAP2000 Guia ele Ap-codiajc 
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Figutl2·1 Forma Uodal '1 Pwlodode Vlbttd6n 1 Figwa2-2 FOfTIIa J.loda!J Pwiodo de Vlbrad6n 2 

" 1 • ; 

Fl¡un 24 Fonnallod~ y Pñ>do do 'lllnd6n 3 F1¡on 2~ Formallod~ y Pwfodo da Vlbnd6n 4 
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E]C'mplol P6nico BidirD!=Mioaal coa cvp de Wl Etpecuode Respuesta 

H ~ t J. L r A R T I C I f ~ T I N G M l ll ll R A T I O S 

~:.-:.t rtRlOO INtHVIDIAL MOOE lltRCtNTI Cl..f<VLATIVE 11.11 frtRCtllT) 

ux "' "" ux Ui "" 
1 1.]811~0 19.6159 0.0000 o. oaoo 19.U59 o .0000 o.oooo 
2 0.4718]] 11.~761 0.0000 a .oooo 91.2120 o.oooa 0.0000 
) o .2011~6 4.3021 0.0000 O .00:10 t~.5lct a .oooo o.oooq. 

• 0.118~39 2 .1:!29 o.oooa o .cooo tl.f]l] O .OOO.J 0.0000 

' o .lllOla L c::n; 0.0000 o .acoo -n.o~~o O.OOOJ O.OCOD 

' e. :oHn o.tsn o .0000 0.0000 t9.104l o .0000 0.00"0 
1 O.Oii0119 o .:Zf! l 0.0000 O.DCOO liiO .0000 0.0000 O.OOiiO 

Figutl 2-5 B!oqut de Pll1fdp•ci0n del• Mua delarchfvo d• ufld• 

Modificando la Escala del Espectro de Respuesta 
Algunos códigos de disci\o pc:nnicen modificac la csca!a del Espc:ctto de Rt:spuc::sl& de manera que 
el corunle en la base del anJJ.isis espea:n.J SCJ. igual al ea-unte en b base del análisis empleando 
cargas sísmicas estáticas. 

E.1 c:.sce sentido pan d:wlcr eJ nuevo Caaa de escala pan. eJ Espectro de Respuesta tenemos que: 

l. Di -.id ir el Cortante en la Base producido por la Carga Sísmica Esúlica. pe; el Carunte 
en la Base obtenido del Anitisis Espectral. y mu1tip1ic:ar dicho núrr.ero por 32.2 ft/seg1 

para obtener el nuevo factor de escaia del Espectro de Respuesta. 

2. SubSEiruic el nuevo factor de c:sc:ala en el Especu-o de Respuesta. 

3. · Efectuar nuevamente el análisis para obcener las nuevu fuerzas en los elementos bajo la 
acción del Espectro de Respuesta escalado. 

1:! SA.P2000 O·lf~ de Aprcadiujf: 

· · Ejemplo~ rorucoDtoJtm::a•u. .......... - .. --~----...--- _ 

Comentarios Finales 

., o 

Un Wlisis empleando el Espo:lro de ~ anrodua: 1111 ni .. J de canplcjidod 1111)0', ""' 
requiere que el ingeniero ,-critique cuid.ldoumcnle los rr;su!IJ.dos, y tenga rooy presente tu 
consideraciones hechas al aelt' el mo::lelo. Algunos de los aspectos 1 c:oosidaar dLnnlc un milisis 
espectral son: 

• Entcnda cornpletamente el comporumiento est.itic:o del modelo antes de cteauar un 
anáJisis dinj;ni.:o. 

• Tener un conocimitnto cabal y racional de los aspectos involucrados al eSCJiar los 
resultados dd an1lisis dininUco para obc.cner un conantc: en b base similu al que se 
ob1icn~ al cfccruu un anilisis por CJ.tgll sísmicas csliticas. 

• La ventaja de la mayor rapidez del An!lisis Espc:ctral en comparación con el AnQisis de: 
Hisroria en c1 Tiempo es en muchos casos sustancial. En el diseño, el espectro de 
respuesra pu.:de incluso pro\·eer aun ma)orc:s venujas debido a que no se deben efectuar 
verificacion.:s para dLfc:rc:ntes intef\·alos d' tiempo. Sin embargo, es neceurio lente 
presente las limitaciones del An!lisis Espc:clt:tl frente al mJyor refinamiento que se 
obcic:ne aJ ef,ccuar un Análisis de HistoriJ. en el Tiempo. 
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EJEMPLO 3 

Pórtico Bidimensional 

Análisis de Historia en el Tiempo 

Descripción 
ESie ejemplo continua el anJJisis del pórtico bidimensiooal visto en los Ejemplos 1 y 2. 
añadiendo en este caso un.a carga de sismo especificad.a con un acelcrogrum en la base de la 
estructura. El registro de .acderaciones a utilizarse se muestra en b. Figura J.J'y COCTesponde a 
la componente N-S del sismo ocurrido en El Centro en 1940. Los resultados del anllisis de 
his10ria en el tiempo se utilizarfn para ¡enerar un E..otpectra de Respuesta que )ue¡o se 
emplar.f para reanalizar la enrucrura a manera de comparacióa. 

Aspectos Significativos del Modelo y del SAP20oo· 
• Ros¡lucsta de histeria en el tiempo de una cxcitad<n m la b&s<. 

• Grificas de los resultados del Wlisis de Histeria"' el TICillpO. 

• Grificas de un Espcaro de Respuesta • partir de loo resultados de la Hisurla en el TICillpO._ 

• lmpaucim del Espectro de respucsu para su uso"' eiiiD4lisis. 

· E~rñplo) P&tic:o 8u11m:Os1on.u AIWuu a-c ru•uo•• C10 • .... ...,.-. 

r .... Hi ... aryfaQtlioas 1 -· .... -El 

Flgurtl-f Acel~togrtmt dt entudt del Sismo de El Cenflo 1~ ( tll..cl) 

Definición del Concepto Historia en el Tiempo· 
El támino Histaia en c11iempo define 1.11 regimo de acclcnciooc:s del terreno a dcccnninad~ 
interValos de lietnpJ para una excitación sCsmica espcdfica en' W'l& dirección ~ El 
registro es usual.mentc: namaliz.ado y en OXlsecucncia necesiu m.~hiplicarsc pcr la ac:clcnci6n de la 
gn>alad 6 ¡xr algún aro facta- carcspondi""'· · 
l. Desde el menll Define selec:cione Time Hlstory Funcdons. 

2 Seleccione el bo<óa ADD FUNCllON FROM FIU.. 

• Presione el botón Opto FUe y seleccione el archivo ELCENTRO ubicado en el 
subdirectorio EXAMPLLS del direct«?rlo SAP2000. 

• Cambie el oombre de la funcióo a El.CENlRO pua que s.ea fúil de RCQilcxer. 

• El formllo de este archivo es de tres pares de colunmas de datos por ren¡Jón. El 
primer par de datos Ja primera columna de cada p.u es el tiempo y la segurida es la 
aceleración. 

• Ingrese 3 Puntos por UneL 

smooo Gu.fa dt Apn::Giinjr 
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Ejemplo) Pdn.ico Bi~Qialsloaal AdluU 4c Hiaoril ca d ÍICIOpo. 

t Seleccione la opción Time and FunctJoa VaJues (en an:hivo de datos). 

t Presione el bocón OK. 

• Presione el bouSo OK para accpcu los dltos ingreudos. 

l. Del menú Define seleccione la opción Time lllstory Casa pua definir Jos padmctros 
específicos pua el anflisis de ffiscoria en el Ti..:mpo de nucsrro modelo. 

• Seleccione el txxóa ADD NEW WSTORY. 

Pa.u adicionar amMiguuniento al sistem.a presione el botón MODIFY/SHOW 
MODAL DAMPr.-:G. ingrese O OS (5%) pan todos los modos y presione OK. 

• ln¡resc en el ftcm Numbu or Output Time Steps el valor SOO. 

• Ingrese 0.02 (sec) en cll1em Out pul Time Step Slzes. Estos parbnecros nos duin 
10 sc¡undos del registro sísmico para. el an.ilisis de historia en el tiempo. 

• De la. lista. Aoa.Jyds Type seleccione la opción Unear. 

• En el úea. Load As.slcnment : 

t Seleccione ACC DlRI pan el parúnerro Load 

t Seleccione la opción ElCE~lRO para el pa.rirnctro F uneUon 

• P.ua el padmetro Sca.Je Functlon ingre5c la. aceleración de la gravedad que 
es de 386.4 WsecJ si trabaja. en Kip·in o 32.2 fi/scc1 si trabaja en Kip·ft. 

• Para los paámctros Arrival Time y Ande asigne valor cero. 

t Presione el bocón ADD para agregar esta carga al modelo, y presione el 
botón OK para aceptar los datos que acaba de ingresar. 

• Presione el bocón OK en ambas plantillu para aceptar las adiciones al modelo.· 

De esta. manen. banas ingresado toda la infamación que necesitamos para efcauar el AnJllsis de 
1 fistaia en el Tiempo. 

Ncxa: For lo 6eneral et uM bueM i..dea correr el maddo aul4 .-n qu1,. 
hace un cambio 6 a4id6n lmportante al mo4do. Etto permite 
dtltctar t"oru J aho"a litmpo tn el distño finaL 

Ejcatplo l P4rtico Bidimensio&W AIIJ!itis de HiiiOril a d Tiempo. 
.··- •. 

Efectuando el Análisis 
1. Grabe el m<>lclo. 

2. AjuSte los pM.tmetfos parad anilisis sclecciona.ndo Analrzt del mem1 Sct Opdons. 

• Verifique que los pac.fmcrros en Dynamlc Analysls san los mismos del Ejemplo 2 

3. Seleccione en el menú Anal pe la opción Run pua analiut la csauctun. 

Usando los Resultados 

Verificación de los ResuHados 
Una vez que ha o.nido d m:dc:lo se deben verificar que los resultados dxcn.idos scaa del crdcn y 
nugrürud a lo CSf~!rado. 

l. Verifique el Cortance en la Base producido en el Anjlisis de Histocii en elli~mpo. 

• Desde el mcnU Display sc:lccciooe la opción Show Time IUstory Traca. 

t De la plantilla Time llistory Display Dcfinitlon presione el bocón DEFINE 
FUNCTIONS. 

• En la plamilla Time Hlstory Funclions seleccione Add Base Functions y marque 
solamenre b opción Botse Shear X. 

• t Presione OK paca regresar a la plantilla Tlmt Hlstory Display Definlllon. 

• Adic1onc la función Base Shcar X a la lisu Plot F~cllons. 

t Presione el txxóa OISPL\ Y pan. ver una ¡rifica del cocunte en la b&sc en )¡ 
dirección globJI X como función del riempo. Vea la Figw-a 3·2. 

Noca: Tambiin se putde returru la rrdfica dd cottante en la bcue 
seleccionando Add Group Summation Forcts tnluzar de Ad4 Ba1 
Functions y ukccioruJndo d rrupo de ekmelllos BA.SE SIIEAR 
dtfinido tn el E]tmplo l. 

2. Ta.mbifn se puede verificar el de5p1uam.icnlo de un oudo ante una ucita.cióo de Histaia 
en el Tiempo, para ello: 

• Escoja un nudo y desde el mc01l Display seleccione la opeióo Show Time ~lstoey 
Traces. 

ll SAPlOOO Gura de Aprcadiujc SAPlOOO Oufa de Aprcadiajc lJ 
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t Presione el balón DEFINE FlJNcnONS de la plantilla Time Hlslory 
Funcliuns Sdcccione el nombre dd nudo de lllista y presione el botón 
MOD!FY/SIIOW TI! Fl.il'CTION. 

t En la plantill~ Time History Joint Functioo seleccione DISPL para el p:uimetto 
Veclor Typ~ y UX para el pJI.imcuo V retor Direction. 

t Presione el bocón OK para aceptar los cambios. 

• Presione los botones OK p.11a. rc:grcur a la plantilla Time llistory Display 
Dcfinition. 

t Añada el nudo de la list.a Llsl or functions a la lista Plot Functlons y remueva de 
est3 última IJ. función Base Shc:ar X. 

t Presione el bol:ón DISPLAY para \·c:r el desplazamiento del nudo con respecto al 
tiempo. Vea Figura J.). 

• Se puede larnbién definir una función nodal directamente en la plantilla Time 
llistory Display Delinition sin hab.:r seleccionado prc:\·iaf!!ente el nudo. 

t En la plantilla Time Hlstory Display Dc:linition presione el bol:ón DEFINE 
FUNcnONS y en 13 plantilla-Time llistory Funcllons seleccione la opción Add 
Joint Disp~orccs. 

t En la planlilla Tune: History Joint Function ingrese: el nombre del nudo (ID). 

• Seleccione Vector Type y Veclor Dirc:dion. 

t Presione los boc:onc:s OK para regresar ala plantilla Time JUstory Display 
Definltion en donde: encontrará la nueva función no:fJJ en el rccu~dro Llst of 
FW1ctions. 

2-1 SAP'lOOO Cu!a de Aprcodiujc 

Ejc'mplol Póct1C'O Bidmll:nSio~l AniJisis de Hi~toria rad T1rmpo 
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Agur• 3-l Hiftoc'la tn el nempo del Desplazamiento dtl Nivel Superhw -In 

Creación de un Espectro de Respuesta 
Lo primero que se tiene que hacer en CS(e punto es aeac un E.speoro de Resp.iesta a partir de los 
resultados del AnJ.lisis de: Hinori.a en el 1iempo. Los dllos generados de esta fcim¡ dcb::n 
impimirse en :urltivo de: tc:UO pan poder c:dJudJ.rse rn un rcnnato que pueda Str (c:ido pa el 
SAP2000. 

SAP1000 o.ta de Aprtúajr 1 



Gráficas del Espectro de Respuesta 
l. Sclecc::ione un nudo en la base de la csU'Ucnaa. 

2. Dd menll ~splay seleccione la opción Show Re:sponse Sptdrum CUJ"'YeS. Esta opci6a 
.aparece solamente cuando se ha seleccionado un nudo. 

3. En la plantilla Response Spcctrum Genera don cnconuar;i el nombre del nudo que fue 

seleccionado. 

• Bajo el ítem Denne asiJliC el valor X para el parúnetro Vtclor Dirudon. 

• Bajo clltcrn Axes seleccione Period para c1 parfmea-o Abscissa y PSA 
(Seudoacelcración Espectral ) pau el parimetro Ordinate. 

• Bajo el (tcm Options seleccione Arilhmedc tanto para Abscissa como para 
Ordinatr. Para el parJmetro Ordin:.te asigne el factor de escala llg (g=32.2 ft/sec1

) 

es decir. 0.03106 sec1/ft si las unidades en que se a-abaja son ~ip·fi. 

Nota: El factor de ~tctdlJ ~J ustUio p4r4 nonn.aliUJr d Esputro de 
Rtrpuesta. El rtfistro para ti ondürif dt hiJtoria tn ti tiempo qut u 
utiü:,6 para gtntrar ti Esputro de ResputJIJJ ~staba nomuzli:,JJdo ala 
actlua.ción de Id rrav~dD.d (g) por lo que ntctsit.amtu dú·idir d 
esptctro por la miJmlJ canD"dad para obttntr WJlor~s normalizados.. 

Bajo el ítem Ptrlod seleccione para lu frecuencias los par.imeuos Der.uJt y 
Struccural. Estos pat1mc:rros son usados en la generación del Espectro de Respue.stl., 
las frecuencias del tipo Dcrault son una serie de frc:cuencias prcdetermin.tdas que 
son lipicamcnte de interés en las csoucruras: l.:u frecuencias del tipo Structural soa 
las frecuencias naturales de la esoucrura. • 

• Bajo el ítem Damplnc mantenga el valor dclunortiguamiento de O.OS pan. el 
p.u.únetro Dampin¡: Value. Como se ha asurrUJo que la estructura tiene S% de 
amoniguamiento no serJ necesario emplear otros valores para el amortiguamiento 

del sistema. 

• Presione el balón DJSPLA Y cuando se halla terminado. 

4. Ahora Ud. podr.t apreciar la ¡rJfica del Especuo de Respuesta pan el sismo de El 
Ccnb'o para un amoniguamiento de 5%. Ver Figun )-~-

!6 SAP2000GuC.dc:Ap~ncüujc 

Ejemplo] Pc!nico Bidicneasiotlll Anfliili de Hillorb ra d T.cqo. 

• 

Figura 3-4 Espectro de RtspuuU del Anílisis de Hi.a~Dtia en el Tilmpo 

S. En la plantilla Response Sp«trum Curns seleccione la opción Ptfnt TabiH to 
file. E~ra opción generarA un archivo que ric:ne dos colunmas de: dJtos.l..a primera 
d.: ell:u es el período. y b sc¡unda es su correspondicme SeudGacduación (PSA). 

• Gra.bc: el archivo con el nombre RS-ELCEN.TXT 

Ediclon de Tablas. 
El siguiente ~ consiste en hacrr algunas pequeñas mcdificacionc:s a) arcflivo de tc:xto RS· 
B...CEN.TXT p.IJ"3. que tenga tm formaxo que pueda ~r kido pcr el SAP20C'O. Esto se ~ a que 
cuando d ardlh·o original es ac.Jdo se le agrega informJciOO .adar.:u:cria que permite al usuario 
intopet.1r y entr.:ndcr ficilmeme su contatido. Esta información tl.U"l deb:: remcn·erse. 

L Con un edimr de te:ttos como WORDPADo 1\"0TEPADabra el archivo RS· 
ELCDI.TXT. 

• Seleccione lodo c:ltuto que se mucsb'.a resaludo en la Figura 3·' y rcrmhalo. 

• Grabe el archivo RS-ELCEN.TXT como un archivo de tex.to con el mismo nombre. 

2. Ahora que el archivo 1iene un wlo lu columnas con los períodos y sus 
correspondicnlcs Seudoocce1c:r3ciones, podri ser leido directamente por el SAP2000 



Ejemplo) Pdnko BidiDX!!UiorW Anflisii 4c Hirzoria u d í~empa. 

o .• )j~7 
O.C~·j..:J l.lOst-Ol 
o.r.~ss l.::Pt-01 
O.CSJU l.~~OS[-01 

O.C!!Ii l.JO:iSt-01 
c.o¿.:; l.i~~S!-01 

O.O!:i7 l.7Ult-01 

figuu l·S Atchivo de salida con el Espectro de Respuesta generado 

Lectura de los Datos del Espectro 
Aht.n que ~ tienen d;uos ro un fcrm.a~o que el SAP200J pJC:de leer, nca:siwnos inWcar al 
programa la ubiación del archivo así romo la (cxma en que iste contiene la infcnnadát. 

l. Si el modelo esla proccgido presione t:l balón Loe k/ Unlock Modelen la barra de 
hcrramicnlls. Al hacer esto se remueve la procccción sobre el modelo y nos permitiri 
realizar las mcdificaciones. 

2. Del mani Defmt se lecciooe Rapon:st Spcctrum Funcdom. 

3. En la plantilla Response Spe<trum fiD1cdons pr<Sime el bolOO Add Functloa from fUe. 

• Asi¡ne al espectro el nombre RSELCEN 

• Presione el txxón Open FUe y sclc:ccionc el ardtivo RS·ELCEN.TXT en Pick Flle. 

• Mantenga el par, mea-o Numbtr Of Polnts Per Une en el valor 1 puesto que 
únicamente hay un par de datos por renglón pan. definir el Espectro de RcspucslL 

• Seleccione la opción Perlod and Ac:cclcratloo Valuc:s. 

• PreSione el bocón OK para cerrar lu plantillas. 

2! SAP1000 Gu1~ de Aptendiuje 

4. Del mmú Odine sc:lca:ione Response Spectrum Cases. 

5. En L1 plantilla ltosponse Sp«trum praiooe el bol6n ADD NEW SPECTRA. 

• Asi¡ne al par4meuo Modal Dampln: el valor O 05. 

• En el úea Input Response Spcclra seleccione RSELCEN pan. la dirección Ul y 
asígnele el factOJ de escala32.2 ñls~1 • 

• los demás valores por defecto soa aceptables. 

• Pr.:sione d botón OK pan cerrar la.s pl.mtillas. 

Efectuando el Análisis 
Una vez que se han hecho bs modificaciones es tiempo de axret el mcddo y mis.u kls rc:suludas 
obl:enidos. 

l. Grabe: el modelo. 

2. Seleccione Run Mfnlmfzed del menú Analyze pan analizar 1• esuucnuL 



Ejemplo) P6nico BidimcuiORd Aft.ilnb de Hiuori.l ca d TICGlfCI. 
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Revisando los Resultados 
Lo primero que debe hacerse es b. re..;sión c:k la rnb.ima de6W6n en b parte supcicr de la 
csuucnn ~¡ como el conante en b. b.tse tanto ~ el anilisis espectral como pon el an!lisis de 
Jli)IOn.l en el Tiempo. L1 comparacién de estos resultados nos p:mútid ,._.,que un biá1 Ñnci~ 
tJ metodología previamaue d~tl. Al final de esu sección Cllaln[Taff los resuludos dd an.1hsJS 
por c.ups sismkJ..S estJticJs, dd anilisis csp!Ctr..tl y dd an.ili)is de histeria en el tiempo .. 

Oefte1iones de acuerdo al Análisis Espectral 

l. I.A:I ma~ú Display ~leccion~ Display Deformrd Shape. 

En IJ pl.llltilla Deformcd S ha pe sel~.:cione la condición de cMga para el anflisis 
espectral. 

Presione el bocón OK. 

2. ll.lg.t click. con el botón derecho d~l mouse sobre un nudo ubicado en el nivel superior 
pM:il ver su desplazamiento en h dirección del eje glob.tl X. 

Cort.lnle en liBase en el AnJUsis Espectn.l 

U1ando el grupo BASE SHEAR que fue creado en el Ejemplo l. cbscrve los vahres del a:rtante en 
la base de !.1 esuucrura debido al Análisis EspearJI. 

DeOn:ión y Cortante en la Base en el Análisis de Historia ea t:l11cmpo 

J. US.llldo el mt!todo descrito en la frimera parte de esu gW.a ¡ntfiquc: la deflexi6n en el nivel 
superia de la c.sbUctura. 

2. Ahaa renweva ese nudo de b lista Plot Functfons y ea su lugar p1.fiqw la fimciál Base 
Shear X ubicada en Ust or F unctions de la ptantiUa lfutory Display Definltlons. 

Carea Lateral Estática Espectro de instoria ea d . 
R~esto nompo 

·M u Dcflexi6n 1.6S in s.s in S.Sin 

M u Cortante en 12.S Kips 3021Gps 32S Kips 
la Base 

Tabla 3·1 Comparación del01 Resultado. del Anil!tis eSe Car¡u Latatales 

JO SAPlOOO G1Jf.11 de Aprcodlujc 

Comentarios Finales 
Como hat:r.l. po:fido ap-cciar el Antlisis de lústaia en el Tiempo in\'Oiucra tm maya" dempo de 
cómpu1o que el Anilisis cm Espccu"o d!! Respuest.l. IXb: obscrv:li'SC sin cmb.lrgo que ounlxls 
ffittodos de &."!.iJisis trindln rcsuludos similares. En tsll! sentido es surrwncmc importuue que el 
ingmiero er.ticndl bs venujas y Iirrüu.cioocs de ad.1 mélodo pm poda utili~b &: b nunaJ 
más ad~X"W.il )' efccth-a. 
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EJEMPLO 4 

Diseño en Acero de un 

Pórtico Bidimensional 

Descripción 
Este ejemplo eo un introducción al uso de lu po:!erow h<:nmiO!lW que posee el SAP2000 pn d 
diseño de una~ una vez concluido su arálisis csu-~. Se darf étfasis en esU parte a 
módulos de iliscño en acero empleando como ejemplo la tstruaU.rJ analWJa en el Ejempl'? l. 

Aspectos Importante del Modelo y del SAP2000 
• Creación de zaw rígidas en los elemauas. 

• Sel=ión Allomlrla de g¡upos 

• Cambio de popiodadc::s en elementos 

• Designación de c.lemauos por grupos 

• Inclusión del cfo::to P-Dd" en d an.tlisis 

• Vianlincién de los resultAdos 

• Auto Sclca:ión de soa::ioncs 
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Creando el Modelo en el SAP2000 
Es posible emplear el modelo desarr~U.ado cñ el Ejemplo 1 efcc:ruando pc:quci.u modifica~k~les. 

Materiales 
Lo prima.1 que: se ddx hacc:r es ~specificar las ¡::Kopi~des de: los nu!aiales. 

1. V~riñqueque las unidades est.:n en Kip-11'1. 

2. Erurc al mcnU Defme y sc:lca:ionc: la op...;6n Malf:rial.s. 

3. EI.Jja STEEL p;lt:l el parimetro ~1a~.t:riaJ y prQionc: el t:o!6n MODffYISf:IC?W MATERlAL 

..¡_ • Es¡:u:ifiquc: d Esfuerzo de Aucncia ajusundlJ c:l patimetro SI.HI Yidd• Stress fy en 36 Ksi. 

5. Es~ifique el Módulo de Elasticid.ld ¡¡jusundo el padmetro Mudulus of FJastklty E m 

29.500 Ksi. 

6. Presione los bol:ones OK par.& aceptar los cambios y cerrar las plantillas. 

cargas 
1. En er ejemplo 1 se asignó el peso propio de la e:sauc:tLn así como una ~e de car~ 

OX\cenuadas y distribuidas a la condición de carga DEAD. (Vea Fi¡tn 4-2 para La nucva_Usta 
Sta de Lo::uis Case). En este ejemplo asignaremos una c:ondiciOO de carga pan. la ar¡:a vava y 
roa pan el peso p-opio de los elemcltos Es una bJena _p-áctica incluir lN coodid~ ~ ~p 
para d peso p-opio de la c:strucnn ero el fi.; de segwr &: cerca el p-cx:eso de optimiza.c:iál 
estruaunl. U.S cargas soo sc:para.das en car¡a muau. carp viva y carga tran~ de sismo 
de t.J! m.lllaa que el SAP200l pxd.a gcnaar aulClflÚlic:amc:me las axn~ooes.dc: c::ar¡a. , 

• 

• 

• 

Pa.u el caso de carga DEAD especifique el vaJor del multiplicador Sdf Wel&hl 
MuhJpller en cero. 

Agregar..,, condición de carga pan el peso propio y nómbrela SELF, islgnele el 
tipo DEAD como padmetro a Type y ajuste el mulúplic.ador Scll Wel&ht 

Muhlptier en 1. 

Agre¡ar cera condición de carga estitica llamada UVE y asfgnele ellipo lNE como 
parlmctto a Type. 

2. ~ad.llas mismas c:ar¡u oorrespondimleS a la ar¡a DEAD a la tu~dicillll de ar¡a UVE. 
Esto significa que cada viga de la esttUcrura úc::ne cargas id&Lt:icas p.1l'l: carp muc:rta Y ¡iva. 

(Puede revisar el ejemplo 1 para va las inSirUCCionc:s de como ingresar las una cargas). 
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Figura4-2 ·Condiciones de Car¡J Estitiea 

Definiendo un Grupo de Auto-Selección 
La opción de Aulo-Sdccción del SAP2000 c.s un.1 forma ITIJY e(cctiVJ. de di~ar esr.rucnns. Al 
definir un grupo Je sccciooes denomin.&do ¡:-upo de Auto-Selección. el progr;una puede d.iscñll' 
c.Jda demcnlo del pórtico escogiendo de c:nuc lu secciones espocifiCJd.u en oc grupo. Pa ejemplo 
se puede definir un grupo de AUio-Sdo:ci6n dcnomlnado COUJ~L'"S con Unicamcntc perfiles 
Wl4, y ooo grupo llamado BEAM con perfiles W2~. El p-ognnu de csu nunera disda.arl. Lls 
sccciooes tipo COLmfl'S empleando soiJ.'"Tlm1c secciones Wl-1 y W sc:cciones tipo BEA\1 
empleando únicamente secciones tipo WU. 

lD prin!c<o que ddxmas lwxr es definir en pupa de Au1o-Selcccidn que incluya tlnlan-al!< 
secciones tipJ columna. Esencialmente lo que eswno5í haciendo en c:st1 c:upa a darle al p-ogr¡nu 
una lista de sc:a:iones de cnue las cuales puede elegir al momento de diseñar los elc:mcntc6 dd 
p6rtico. El ¡:rograrru pa- su parte selecciood b sa::ción ma.s eficiente de entre ese pupa. 

Una vez: se haya concluido d diseño Jnli.mitar es momento de refinarlo. pan eUo b JNPlS 
BEMI y COLI.JMN smn ~tt~~~pl=dos p:r sca:iones op<irniudas elegidas de a1tte d pupa de 
Auto-Sclccci6n. Es:e po:c::so asignari a las elcmanos secciones que sain anplcadu unto m el 
análisis como en el diseño, esto hará rBJCho mis fícil el cambio de seccimes que necesiten sa 
modificad.u. 

Nota: LJ opcl6n d1 A~W>--~kcd6n fundo M Jo lo 111 p6rdcoJ 4• oetro. 

l. Desde el rnanl Dtanc y sclecciooe La opción Framc Secdons. 

2 lmpcrtc a b plantillt Frame Scctions tedas las scc:ciooes de acero e:om¡rc:ndidu entre 
Wl~>61 y WI4>28J. 

• Seleccione en la caja de di.flogo la opción L\fPORT VWIDE fL.\NGE. 
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• Bu)que y so::leccion(; la sección Wt.h~83. 

M:m1eniendo presion3da la leda SIUFf haga click. con el botón izquierdo del mouse 
sobre Wl -"'61 y presione el bo16n OK. Esta operación permite seleccionar todas las 
secciones Cnue la sección WI.J~t~83 y la sección WI-"Ji61. 

). Bocre do:: plantiUJ. fra.me Scctioru rualquier sc.cción que pu.:Jicn tsUt duplicada.. 

Recuerde: No ~f posibk horrtJr UlllJ sución qu6 tstl ~11 UfO. v~ ~Sta 
manua ti programa augura qu~ todos los ~kmtntos riLnrn adgTUJda 
ucciontt triJitnJts. 

4. Desde 1:~ plamill3 frame Section añada una sección Auto SeJt.ct.. Esta sc::ción se ubic::ari en la 
p:rte inferior de 13 lisu Add. 

l. 

Ciimbio:: el nombre en Auto Stctlon :"lame a COlt.Th!N. 

• De lo~llsu Auto Sclecllons eliJa y remueva usando el balón Reman todas las 
secciones t:J.ccptuando los pcrliles W I.J. Esto significa que lodos los elementos que 
tengan unJ §ección tipo COL UMS s=rin diseñados empleando alguno de los perfiles 
Wl4 d..: cnlle la h~!J Aulo Selections (Vea Figun -l-3). 

=e:::;-----·"' fCatULIN 

Figur1 C-3 Definiendo el grupo dt .luto-Stltcc:iótl COlUUN 

!i. Siguiendo las instrucciooes d3.d.as en los pasos 2 al 4: 

• Impone todas las secciones entre la W24x55 y la W24xl62. 

• Asigne un grupo de Aui~Selc:cción denominado BEAM. con perfiles W24 
únicJ.mente . 

.l6 SAPlCOO Guf.a" Aprmdiujc 

Ejemplo 4 Dhc6o ce1 Acero de uA Pórtico B1d.imet~sior~l. 

6. Ftn~le, selecciones tcxios los elemen1os verticales del p:!rtico y asfg:nde la sccá6n tipo 
COltThCt lu~~o sdecx:iooe uxios 10i ckmcn1os haizcnules y a.dgnele b sc:a:i6n tipo BEA.\l 
(Vea el eJemplo 1 p.lr3. bs inmucciond d.: como asignu so:ciooes ¡los clcmcnlos ckl pórtico). 

Nota: St pu~tk por suputsiO ulucioMr u tUl ucci6n ttpt(/i.ta Unto pu11 
tl JiJtño como para d an:Jliris tn lurar tú tmpltar ltJ optión lÚ 
Auto·Stltcción. Para tilo simplcmtntt Jt nutsita tni:nar d los 
d~mtntos dd p6rtico un.:z stcción tú actro .:zdtcuCJda 1 distñarld ú 
acuudo tJ lo dtscrito tn ti tjtmplo l. Esta sección putdt str JG SttJ 

uno sución definida por tl usuario o bitn una sución tltgida tú 
tntrt los uccionts prcdtltnninad.ar. 

Efectuando el Análisis 
Una vez que se h4ll íngresaJo los d.llos es tiempo de correr el mcdcto y revlsar los resull!dos. 

l. Gra})( el moJelo. 

2. Asigne los pJ.I.imetros para el diseño enuando al menú Analyze y seleccionando la 
opción Set Oplions. 

• 

• 
• 

En la pl.uuilla Analysls Options seleccione el ópo de antrisiJ Planc Fralhe pan. 
reducir ~o:l tamaño de la solución y en cons<cuenci:~ reducir el tiempo de milisis. 

Marqu(; l.:t opción Jncludc P·Delta . 

Presione el botón SET P·DELTA PARA.\fETERS para ajusu.r los parimctros det 
anilisis. 

t Asi~;ne a Maxlmum ltuatlons el valor 10. 

t lnclt•ya las condiciones de carga mueru OEAD y SELF. en la combinaci6n p. 
Dclll, ambas con bctores de car¡;, igual a 1. . 

t lncl11ya la condición de carga UVE con un (actor de carp l. 

Nota.: Losf«torn tú earg.:z G tmplLDrst 4tbtn Jtr loJ cOtTtlporulitnltl d 

las combinadontr dt carga qut Jt ustn tn tl dirtñD dt ID tJtnleturG 
1 qut produ:¡:an los m.iximos t/tctaf tnla misma. Dtben incluirn 
cu!anás ti tftcto 4~ ltJJ c.:zrgas ltutrolts. 

t El r.::slo de valores por ddccto es aceptable. 

• Pre~ionc: los botones OK para aceptar los tlmbios y cernr lu plantillas. 

3. Entre al menú Analyn y seleccione ll opción Run para analiut la csuuaurL. 
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Nou: Debido G qut Istmos tuitn.G4o VJIPOIIÚ lltCIDneiJ M ncdoMI 
específicas para nutslro diseño. d SAP2000 tktfrd 141 propúdlukl 
dt las stcciones m4s convtnitnllt ptJTa ltntrt~r la matri: dt rizüht.l 
tftctuq,r ti análisis tstructurd UM l'tt que se M tftctuado ti prútur 
amilisir 1 diuño, u putdt instruir Al pro1rt:m4 para.rttdi:JU el 
anólisis con las propitd.atks dt lasstccionts MsitlUUÍlJI. 

Diseño de Secciones 
Una vez que se hJ. dc:ctuado el análisis y revisado sus rc:suludol. se p:dr1n cstaNeo:r kas 
p.1t.imcll'OS necesarios p~l el Wsdio en acero de b. estructUra. 

Selección del Código de Diseño 
La infomuciOO resulu.ntc dd a.niJais es cmple.Jda para cfcauar una \'a'ificac:ión de las so:::doncs 
cmpkmdo un c6digo &: diseño. 

l. Desde el menú Options seleccione Prefucnccs. 

2. En la pla.milla Prcfcrcnccs. bajo el ítem Stccl seleccione el códi&o de discfto que desee 
emplcv. En esto.: caso se cmpleari el códi~o AlSC·ASD·89. 

• Emplee el mismo archivo Scction Propcrtles ftle que fue usado para imporu.r las 
scc;cioncs de acero. 

Combinaciones de Carga y Diseño 

Figur1 4-5 Opcionu en el tdenü de Diseño 

Una vc:z que se ha seleccionado el cóiigo a utilizar en el diseño de los elementos se deb:n vaificar 

bs combinacicncs do: carga a emplearse 
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l. Primcnmaue. en el mcn~ Dcsii:Jl asegúrese que W>U la a:ocnsc:ila en d hm SLed Dcsf¡¡n. 
E.slo le in~~ al SAP100l que dcb: cfo.::nwsc un diseño de scccicmcs en acero. 

2. En d m<nÚ llcslp> cl¡j.tlaopcióo Sdcct Dcsip> Comboo. 

• Revise las combinaciones de car¡:a ¡:cner&W b.ajo l.a lista Des.Jrn Combos. 
scle.::cionando las combinaciones y presionando el bocón SHOW. 

• Si e:~istcn roas combinaciones de car¡a que desee incluir en el disd.o, puede 
agrcg.:uiJs uundo pata ello la opción Scl«l Dcsicn Combos del menú Define. 

3. lnick el D1)..iu:iRc\isión de b esau.:wra &.s.dc el malU Dcsf¡pt sclc:c:cion.ando d (1em Stut 
Desi:nlCñet..k o(Siructun:. 

• C.tda uno de los elementos scri discdado cmplundo lt KCción mis cfic:icntc de 
ent:'c lli correspondiaue a su grupo de Aulo-Sclección 

• El SAP!OOO mosttu.i automiticuncnlc el porcentaje dd nivel de esfuerzos niucnte 
en cad.l dcmen1o con n:l.lci6n al mhimo esfuerzo .admisible. 

• Pinl mayor comodidad el programa asignat.i calores 1 cada uno de los elementos, los 
Cullcs rnuesuan d nivel de esfuerzo prese:n1e en cada miembro us3J1dO una escal.a 
grflica de colores/esfuerzos ubicJda en b pan e infcrioc de l.a vcman.a. 

f-;¡;ta: Si dtsta ,triji&fl.r d distiio tk un nümtro lkurminDJo tk 
tl,·mtntos, podrd rtll.li:Drlo simpl~mtnlt con stltccionorlos 1 tjtcidlu 
LI opción Statt!Hsitn/Chuk of Srrucrurt. 

Revisión de los ResuHados y Rediseño 
Una vC:.z crcauaJo el Discñ~visióa es tianpo de verificar si los resultados sm ccrrcaos. 
SAP21XXl trind.l al USUllio una saie de haramicnw pJTJ. ello. 

1. Haga dick con el botón derecho del mousc sobre cualquier elemento para ver los 
rcsuludos de su diseño. El elemento que: hay-a sido seleccionado pupadeui para su ficll 
iden.tificaci6n. 

2. En la plimlilla Slcd Stnss Check lnfornutlon encontrad: un& lista de Jai 
combinacionc, de c.ug;a empkadas p;u;a ,crificar b sección en vMios puntos a lo lar¡o 
del ekmemo. (Vea Figura 4·5) 

• Una de las combinaciones de carza estaR resaluda cuando abra esta plantill&. Esta 
es la combinación que conttol:a el diseño dd elcm~nto. 

• Junto a uda combinación de car¡:a hay oo indicadoc de l.a ubic..ación a lo 11!&0 del 
elememo donde fue dectuada b \·erificación. seguidl pala rel.ación de esfuerzo 
par¡ la interacción de momenlo y cortante. 

smooo Gula de Aprmdiajr 39 



Ejcmplo4 Oiu:6o ea Aeao dcWII P4nico Bi4imcdooal 

Sugerencia: Se put4t cambiar ti númtro M puntos d W largo dtl 
tltmtnlo tn los cuales las /utíJlS tÚ sección son reportadas. Para 
tilo stlrcciont los tltmtn/01 1 tks4t ti mtnú Assl¡;n tlija la opción 
Framt Output Strments ¡HJra cambiar ti mimtro dt Stf"ltnlos. Es 
necesario ejecutar nutvamtnlt ti análisU del motklo par:z obUntr 
los rtsullados. 

3. Seleccionando cualesquiera de las combinaciones de wga y presionando el balón DttaD.s se 
mostruin los resuludos dd análisis p.1u ese elemenao ui como las ecuaciones que gobiernan 
su diseño de 3cuerdo al código empleado. {Ver Figura 4·6) 

4. Al presioolt el botón RcDcslcn se prcsentúi la plantilla E1ement O"erwrlte Assl¡nments. 
En tSI.l pluuilla se puede elegir de ene-e \anas opciones: 

NOla: Si u tjtctútJn cambios tn la planlill4 Eltmtnl Ovtrwritt 
Assitnmtnll tmpltando ti botón RtDttitn, será ntctsario presionar 
ti bot6n Rt/rtth Window dt la barrtJ dt htn-amitnltJS pard rtr los 
usullo.dos Jtl distño actuali:JJdos tn la t~tnltJniJ tJcriva. 

• Seleccionar otra sección para ver el cambio en los c¡fuerzos en el demento. 

Nor.a: En d modo .4ulo·Sdtcci6n. tftiJ steci6n putiÚ tmpltarst para 
ensamblar una nueva matri~ dt ripdt: si st elite la opción "U¡xúJtt 
An.a.lysis Surions••. Esta úldmo 11 lln·ar-4 Dcabo una l't: que u 
tjteule nutramtntt tl DistñoiRtvisiÓIL 

• Clasi[Jcar los elementos por tipo Moment ReslstJn¡: Elemcnt o Bnce. 

• SobreKTibir los faccores de cfiseAo tales como longitud efeah·a y la relación de 
longitud no arriosua~. 

• Elija la opción Ovcrwrlte Allowable Stresscs para sobresaibir los crsfuen.os 
admisibles empleados en el diseño de: la seccióa. 

• Cuando halla tonninado de modificar los pulmetros de dise6o praicae el bo<6o OK. 

Nou.: Al C41ftbúv"' l,ifo,..ci6n ü "'pr.wtiLI R<lHslrn, rl SAP2000 
autonuiticanunu reedtul4r4los tt/utnPJ de diuño U «utrdo a 14 
nueva lnfof71JIUI6n 1 attualittUtf la inforrn4d6n tn la plantilla SUtl · 
Strtlf ChtellnfomJdliOIL Para mtú irutnKciones s.obrt como 
actualizJlr Lu stccionts pan: tl an&isis rejiira.st ala sección .. Rt· 
A.Mliuuulo ·~ 

S. Pan. usar la KCCión elegida en el Re-Disdao en d aiguic:nte an.(]isis estructunl, es ncccs.ario 
entrar al menú Dc:sicn y seleccionar la opción Updatc: Analysls Sectlons. Esta opción -
reemplaza las secciones empleadas inicialmente pan fomur la matriz de rigidez de: la 
cstructwa. por las nuevas secciones d.indc:aos mayor precisión c:n Jos cálculos. 
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6. T&mbiln se pueden observu los r~ulu.do del discllo de manera ¡rifica m la pantallL Pzra 
ello Ln¡resc al meml Dtsl'n y seleccione la opción Display Dcsi¡n Info Los resultados se 
mosu Jrin en fornu. grJfica en la p3.tte in feria derecha de los clcmcntol del pórtico. 

Nota.: LAs secciones tmplttulas tn ti t:MlislJ tsi1'1Uhmd son moaradlu 111 
liJ parlt suptrior ;:quitrda dt cada dtmlniD. Por otrD ptJrrt. toda la 
infonna.ci6n corrtsponditnJt al diuño dt los tltmtntos ts mostriUla 
111 la partt ;n]trior dtrtcha dt los mismos. 

on,...,Dniqn n~uhs 

Figwa C..7 PlanliUa de ulida resullldoa 

7. Se pueden imprimir los resultados del discll.o ingresando aJ menll FUe y s.clcccionando la 
opción Prinl Dcsi¡:n Tables. Para imprircit los resultados de un número limitado de 
clcmcmos. primeramc.nle sclccciónclos y enseguida efectúe la opción Priot Dtsicn Tables. 

Edición de las Propiedades de la Sección 
En IJ. f,gura 4-l podri chervat que las vigas del pórtico tienm c.arp.s cooCCJ.ttadas ubicadas a los 
ler.:io del claro. Si asumimos que dichas car¡as son tran~1dtid.ls pa c..-.us nüemtl'os, emooc:cs 
pOOemos considerar que las \igas tienen sopocte lateral en los puntos de CJT¡a El modelo tal romo 
ha sido creado no loml cn cuenu este hecho. pcr lo que las vigas están sol::redimensionad.u. Para 
disciiJ.r las \igas mis c6cientem~uc se deben cd.iw sus ¡:ropicdades de diseño. 

l. Sclecdooe tedas las vigas de la csaucnn. Para ello puede. usar d medo Jc selección lnttrsedln¡ 
Llnc Sdcct Mode. 

2. Desde el menú Deslcn escoja la opción RcDcnne El~m~at De:slen Data. 

En la plantilla Elem~nt Ov~rwrlte A.s.slgnmcats seleccione el hem Uobractd 
Length RatJo, L22 y asignc1e el nlor 0.33. Esto introduce un sopone lateral a las 
vigas a cadJ 113 dd claro (uriostrarniemo contra el pandeo en c:1 eje locall-2), en 
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lu¡u de la opción por def'cao que torTesponde a clemcnlos uriOSG"'dos solo ca. los 
cxcte!Jl~:i. (Vea Fi¡uu 4-8) 

• Presione el bocón OK lue¡o de ingresar la nueva infocm1ci6n. El SAP2000 
automilicamc:nte c:fc:cruari el Disc:ño'Rc:visi6n del modelo aaualiudo. 

3. Podriaprc:ciar ahora que tu dimensiooc:s de lu scccioaes de las vi&u soa menores. 

Sugerencia: St puttú &onoctrdpt~o M la cstrvctura obttnún.M l4 IUMG 

dt car:ar nodakr de los tltmtntos dtl frupo B . .tSE SHE.-tR. Esta ts 

una manera rápida dt ""si tos cambios efectuados productn un.a 
estructura más l]icitnJt. Tambiln St putdc obltntr ti ptso IDIIll dt la 
tSiruclura tmpltando tlllrchi~o filcnan~.EKO. 

Figun 4-1 Plantilla desobrt-c&c:titwa de parimefJGI de diseño de tlemen~ tipo vi¡• 

Re-Analizando 
El prirnd" anil.isb c:mploó ¡x-opiedadc.s de sccci~ ap-otinwlas pan. ¡c:naa la matriz de ri¡idcz de la 
estructura. Es p.~r ello que el mOOclo se dch: rc.mJ.Iiz:1r .1 nunc:r.1 de un ¡reuso iterativo para 
a..st¡;lD"3lll05 qu~ el análisis toma en cuenta las propicdldcs y Kcdooes ~ de los 
elementos. 



E~lflplo 4 Ou~foo ea Acero .:le Ull P6nh:o Bidimc:adoul 

l. Una vez que se halla Eenninado de modificar las secciones estruCNfl.le:s que se van a 
empk31". ingrese al menú Desi~n y elija la opción Update Analysfs Secrtons.luego 
efectúe nuevamente: el1r1ilisis empleando las úhimas propiedades de sección. 

2. lleve acabo nuevamente el diseño de )0$ elemenlos para ver si hay cambios. 

3. Una vez que se cncuencre satisfecho con las secciones elegidas, ingn:sc al menll Dtslcn y 
eliJl ll opción Replacc Auto w/ Opdmal Sections. Esu opción asi¡nllas secciones 
ddinitivas ya sean las óptimas o bien aquellas seleccionadas por el usuario tanto para el 
anilisis como para el diseño. y rcempl.ua las propiecbdcs de sección preliminares 
tomJdJs de los grupos de auto selección BEA.\f y COLmt~. 

Diseño de acuerdo al LRFD 
La mc1o.Jologia empleada pcr el UU:O es esencialmente la misma que usa el ASO. Sin embargo las 
combinJciones de cargJ así como la ecuaciones de vt:rificacióo de IOi elemc:mos son efectuadas 
empiCJndo el c6digo ~. pot lo que los result.ados e infcmuci(n resulurue es distinta.. Pan 
dccruJ.J el OisdidRe\oisióo de acuerdo al c6d.igo LRFD. c:s naxsario cambiar ~gunos p3dmeaos 
dc cmra.d..l. 

l. Ingrese los nuevos factcrc:s de carga para c:l an.llisis P·Dclt.t. 

2. Sclccciooe de la plant.iUa PrcCcnnces el cóiigo de djsclo mac:uo AISC·l..RFD93. 

3. Rediseñe las secciones de acero. 

Opciones Avanzadas 

Definición de Grupos de Elementos para el Diseño 
Alg>mas v=s puede cncmrnli úril a1a cp:ión al disal~r el"""""' m esttucturu _,¡adas. 
Esta opción pernütc disoiar t.crlos los elem.e:nEos de 1m grupo usando dnicamc:ntc una sc:cciOO. lA 
ventaja de este mbcdo de disoi.o es que reduce d núma'o de secciooes diferentes a cmpleme. Por 
ejemplo se pxden agrupar las coh.mmas o las vigas de das o b'c:S pisas del ¡:ático dentro de un 
mismo grupo de disaio, pcmitiéldooos usar una sola sección pan. dicho conjunto de elemaltas. 

l. Rusi¡ne lu s=iooes dd cipo Aufo.Seleccim a loo clemo:ntn~ dd pático. 

2. Agrupe los clemauos del 3a piso hacia abajo m UD grupo dencminada BOTIOM. 

3. Agrupe los elementos en<n: los pi"" 3 y 5 m un grupo 1L1mado MIDD!.E. 

4. Asigne los elementos rt:SUnte al pupl TOP. 
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S. Efeaúe nuevamente: d an.flisis del mOOdo. 

6. fn d mc=nd Dc:.ign sdc.:cionc la ~00 Sdtct Dtsf:n Croup. fn c:sr.a pazte se le india al 
progr..rru que se diseñe un grupo de elcmauos cmplcmdo ll sccrión más ligaa que s.11isflga 
los requerimientos y esfucn:os .1dmisitles en rodas 10) elcmeniOS. 

• lnciuy3 en la lim. Oesl¡n Groups los grupos de elementos TOP, MIODLE y 
BOTIOM. Al h.Jcer esto indicamos que estos grupos ser in diseñados con la sección 
mJ) efi..:icnte de bs secciones dd grupo Auto-Selc.:ción. 

t'-:o1a.: Si no hay grupor ~n lJJ lüta "D~rign Group lisr'', ctU.fa uno lk los 
''~mentor d~ t.r ~structura ruán dútñados in.düidualmtnlt. 

• Cuando presione el botón OK, El SAP2000 automJticamcnte diseñarJ: lu secciones 
do: acero y mostrad los resultadi)S en la vent;ma acti\'a 

7. Comp.1r.: los rouhados del disalo amaioonc:nte cfccruado con el diseño pa gruplS pan lftr 
como af.:cu e::.!c hecho en las secciones scleccion3dJS. 

Zonas Rígidas 
La csttua1.a"l que hemos venido csrudiando, ha. sido analiuda y disedada oon.sidaanOO que los 
elementos ~ exticndm canplet.UnO'lte ~nudo a nudo, sin toaur a1 cuau.a las dimatsimc:s propias 
de: bs sea:iooes cransvers.!ltS de los elementos. Si bien es ciato que 6ta no c:s l1n.l rru.l1 
cmsideración, el SAP1000 pami1e efecnur análisis aun mis p-ecisos mediame Lt lncroduccióo de: 
zooas rígid.J.s en el modelo. Las zaus rígidas definen un3 rc¡iál a1 la conexiOO. enae viga y 
cotunma, en la cua.IIOi elemcntos no sufren defmna.cimes por flex.ión. Se aenaa a..sí esmcialmalle 
una zooa rigida en la OJnexión. Esu irca puede sa W'l grande como el usuario especifique, pero 
usualmO')te se c:onsidc:n. igual a1 pcrahe del micmlro (o wu. hcci6n del mismo) al que .se esu 
Uegando en ese nudo. 

l. Sel=iooe IOdos los elemcruos del pá1ico. 

2. Del=~ Assfgn sel=ia!e la cp:ión Frame ... End OlrJets. 

• En la plantilla End orrset s.elecciooc la opdóa Update Lenrths Fr0'iri Curnnt 
Connectlvlty. Esu opción hace que el programa calcule automJ.ticamcnte las 
dimensiones de la..s zonas rlgidu a considerarse en cada nudo. 

• lngrc.se el valor 1 para Rl&fd Zoae Factor. Esto sipüfic.a que el tOO~ de la 
'"longitud potencial"' de zooa rígida deberf considerarse en el anflisis. 

• Presione el bJt6a OK. 

3. Si se especifica la cp:ión El<meol Sbr!nk de la planlill& Sd Elemmb, y se obr<rva m 11 
pailc.lla acth'1,. se pcrlt1 apreciar una saie de línc.a.s en c.ad.a nudo que indican la asignaciOO de 
zooas rigidas en los elementos. 



Recuerde: Se nec~til.tl restUl«er la opcl6n ENl Offseb t4114 I'C't que llu 
secciones 4t los elenunlos sun modificod./u. 

N'Oll: Los monuntos 1 corliJntes ulo1 rittU 1 coWmruu ran 4 6tr 
Uttromenle dJferenits en dqudlos cJJSos en los que no Jt &omon tll 

cutnUJ las :OIUIS n'zi.das. Esto st debe a qut la lntrodut:d4n dt l4s 
múm.as reduu la IDntill.ldjltxibk de los eltmtnlos. 

Comentarios Finales 
Lu han.micnLJ.S de diseño del SAP2000 sen muy lh.iles en el d.i~o de c:suuaur.u apcnic:adas.. Sin 
cmbar¡oh.1y algunos puntos que 5C dclxn talcr ¡J'C:SCntcs: 

l. Ase¡úre)t que tocb. la información de dise6o sea conecta.. Los valores por defecto que 
usa el programa no son necesariamente los correctos (p.ej. K y lon¡irudes no 
Arriostr.1das de los elementos). Se puede usar la plantilla Display Deslen Rcsults para 
\'er esta información en los elementos del pónico. Oc manera COO\cniente, es posible 
apredar el anilisis de las secciones al nUsmo tiempo que: la infornución del di~ño. 

2. Verifique que las combinaciones de carga de diseño que el programa ha proporcionado 
sean las correctas y adecuadas para el tipo de esUllctw-a en pmic:ular que: se este 
anahzando. Sin no Jo son, añad.1las combinaciones de car¡a que desea. utilizar en el 

diseño. 
3. Verifique los resuludos del discll.o en puntos claves, para asegurarse que los resultados 

dd diseño guardan relación con los resultados esperados. 

4. Venfique.que los úc1orcs de cug• en el anilisis P·Dclu. son los corrcctos. 

S. Rediseñe la. esuucwu to.ia vez que efc:Clúe cambios en el modelo. Esto permite ver si lu 
secciones empleadas son aún acepublcs. 

6. Emplee ¡rupos de elementos para. determinar el peso tot.al de b ~uuctura.. (Revise el 
Ejemplo 1 para tener instruccion~ de como efectuar este paso.) · 

7. Emplee grupos de clemen1os en el diseño para reducir el núm:ro de las diferentes 
secciones a utilizarse en la csauctuu. 

8. Eluchivofil~name.EKO contiene b información del peso tOlal de cada uno de lu 
secciones (perfiles) empleadas en el diseño. Esr:a información nos permite estimar costos 
de una manera prc:luninlf. 
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Apéndice A- Ollscripclón de los Iconos de la Barra de Herramientas 
Icono Nombre del Comrvl PcmUic 

¡ 
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Apcndicc B 

Apéndice 8- Descripción de Iconos de la Barra de Herramientas Flotante 
Icono Nombre dd ConC'oJI Permite 

[§] 1 Poimer Too! ¡ Sdccciona elementos indhidualmentc o en caju. j 
__ _j~ ------ ________ __¡_ ___________ ---- -- -- -----

~ -1-Sclect All j Selecciona todos los elementos en un grifico_. ___ ~ 

~ l Restare Prc\ious S:!lection ! Restaura elementos previamente seleccionad~~ 

~ -~- Ct;~S~Iection - - - -----~- l1ben todos los elementos sdeccionados. 

(Eil-~ S-el w"tcrs~ur.g lm.c Sclect Modc ( Sclec:~i~~ Íos clemcmos ltuercep~dos.,; una línea. ; 

fi] jR~sh~-~ Elem~~~ -- - - - -r-Mue·v~ ~~;~cntos-;om!ndoios en su parte c~n~~ ;· -~ 
_j · 1 redJmcnsionJios sclecciona.'ldo sus cxttcmos 1 

(J ~-Add-Speciaij~; t-Añ;dc-~ua~~~~~ un-~ujo~- -- - ·- ·-

a· [~-;¡;;;-.;e· Ele;;,rn, i D;buja un demento tipo ft•m<ll definir la ubicación 
------:-' de sus nudos c:~rrcmos. 1 

[tj 1 ~-w Shcll Elc-;c:;~ j -D-i~ia ·;;e~ e:~~;~ ti~~hdJ;jdcf-;¡;¡;-ubiación / 
---~ . ¡ .de sus csqumas. 1 

·a---~ick[;;;_.· Fra:nc-E~I~e~m~cn-t --~~ -¿ibuj.~-~ clc:~~uo tipo fnmc: usando tma malla. 

~-c-~~:~:,-kn~7-~~~~:~:~;-,--'-+~~~::~~~:::::;:t·:~~do:~~jCj 
m Anign Frame Sections AsiJ~;;ca:i~~-y;;.;~ri&l; a ~lc:mencos trame~ 

Ga Assign Shell Sections Asigna secciones y -;a;;rl;J;;-;~~~~(OS shcU. 1 

·-:-,...-·----------11-----------~ m Assign Joinl Load Asigna ~gu concentradu oodales. 

Mi¡na cargu en clemauos tipo framc. 
-----------------; m_ ± __ :-+-A>-sign Fume Span Loading 

ÍJ Assign Shell Unifam Load.in¡ Asigna carguen clema'Ltos tipo shdJ. 

I§) Show Und<formed Shape Muestra la scometña oriJinal d~l~~ 
m Display Static Defarmed Shape Muestr~la ¡eometrla dc:formad.l de i~~ 
~--\------,-,....,...-,----1---~---------·---' m Display Modo Shapcs Muestra formas de modo y periodos de vibraci6c. , 
-;;;;;-f-:--,--~-,:-·-=--+ ---------- ... - ---- ----j If) Display Elemeot forces/Stresses Muestra resultados del anilisis- Fuertu 'J Esfuerzos. \ 
~ ----- --· ---- ---- - ----. 
-~ Set Output T able Modc 
.. _c-_c___ ______________ __L.-----·----- .. -------···-----' 

Muestra tablas con los resulwios del anjlisis . 

S AP'lOOl TutaiaJ M&null B , 



.) 

J 

9.1 COMENTARIOS FINALES 

COMENTARIOS 
FINALES 

CAPÍTULO 
9 

Después de dar una primera visión hasta cierto punto con poca profundidad en algunos 
aspectos ya que se pretende que el presente instructivo inicie al lector interesado de una manera 
clara, rápida y sencilla en el uso de SAP2000 pero a su vez lo motive para que explore y profundice 
en otras opciones que están disponibles en el programa, los comentarios finales tienen por objeto 
eliminar algunas posibilidades de error en los datos proporcionados al programa así como mejorar la 
interpretación de resultados, estos son: 

Verificar la geometría y características de los materiales, para ello se sugiere almacenar 
los datos en un archivo con extensión S2K y revisarlos con algún editor con objeto de 
detectar posibles errores en las características de los materiales y dimensiones de los 
elementos. 

Verificar las condiciones y combinaciones de carga bajo las cuales se realizará el 
análisis del modelo, lo anterior con objeto de detectar posibles omisiones o duplicidad 
de cargas (por ejemplo peso propio). 

Verificar los grados de libertad y las condiciones de apoyo o restricción de los nudos 
especificados en el archivo de datos los cuales deberán ser acordes con el número de 
ecuaciones que se forman y resuelven. 

Una vez realizado el Análisis se deberán de verificar e interpretar los resultados, el 
equilibrio se deberá satisfacer en todo momento, se recomienda que manualmente se 
verifique éste, por lo menos de manera global (suma de fuerzas externas y reacciones), 
sin embargo no está por demás verificar el equilibrio de algunos elementos de la 
estructura de manera aislada (nudos y barras), por ejemplo verificando el equilibrio de 
algún entrepiso (suma de cortantes en las columnas de entrepiso con el cortante externo 
en la misma dirección). 

Se deberá verificar la forma de los diagramas de elementos mecánicos la cual tendrá 
que corresponder con el tipo de cargas, por ejemplo, si en una barra existe carga 
u ni forme el diagrama de cortantes deberá presentar variación lineal y el de momentos 
variación parabólica. 

La configuración deformada que la estructura presente para alguna condición de carga 
deberá ser consistente con las condiciones de apoyo del modelo analizado asi como con 
las características de las fuerzas contenidas en esa condición. 
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Cuando sea posible se tratará de relacionar los resultados obtenidos con el programa 
con los que resulten de la aplicación de algún método aproximado, por ejemplo para 
cargas laterales en un marco se puede utilizar alguno de los métodos aproximados cotA 
el del factor o el de Bowman. . .. 

instructiVo ¡Mn 11 utlhzaclOn del J'I"'Sl''ml SAP 2000 F Mooroy 
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DISCLAIMER 

r--, 
L 

CONSIDERABLE TIME. EFFORT AND EXPENSE HAVE GONE lNTO THE 
llEVELOPMENT ANO DOCU~IENTATION 01' SAP2000. THE PROGRAM IIAS 
IIEEN TIIOROUGHL Y TESTEO AND liSED. IN USING THE PROGRAM, 
IIGII'EVER. TflE USER ACCEPTS AND UI\DERSTANDS TIIAT NO WARRANTY 
'' Uii'I<ESSED OR I~IPLIED BY TIIE DEVELOPERS OR THE DISTRIBUTORS 
m< TIIE ACCURACY OR THE REUABIUTY OF THE PROGRAM .. 

lilE USER MUST EXPLICITLY UNDERSTAND THE ASSUMP-TIONS OF THE 
J•f<(l(;f<A~I AND MUST INOEI'ENDENTLY VERIFY TIJE RESULTS. 

1. 
----. 

Ejemplo 1 . Pórtico Bidimensional bajo Carga Estálica.: ••........• 
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Respuesla ..............••.............•......... · · 

Ejemplo 3 Pórtico Bidimensional Análisis de Hisloria en el Tiempo .. 
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Apéndice A Descripción de los Iconos de la Barra de Herramientas .. 
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Ejemplo 1 Pón1~o IJ•dimensional con Car¡l En.luca 

4 [d¡t~.C Ju gccmctría de la malla y pre~ionr el bocón OK para cerrar la plantilla. 

Sugcrencra: Fu•a/it,ad..a Ú1 edidó11 de la malla, st pul!tk hacerclick con ti 
butón dencho del m o use sobre las columnas para ven"ficar si éstas 
tienen la longilud apropiada Esta es una manera muy práctica de 
obtener in]omJación sobre cualquier nudo o ekmento de la 
estructura. 

Edición de Apoyos 
El !>lgrJi~.ntc= paso ~s el cambio de los apo)os de la emuctura de la opción por defecto que 
corrc=sponJI! a nudos aniculados. a la opcil'•n de nudos rígidos que tenemos en este caso. 

1 5ekccione el icono l'ointerTool d.:. la barra de herramic:mas flmnnte. 

2 l\l..uquc un área r¡;ctJ.Ilgular qu~ ahar4uc los ues nudos en la b • .b~ de la estructura. 

Sugerencia: St putde oburvo.r la barro. d~ ~stado para 11u ~~ númuo y 
tipo de eler.rentos que han sido stleccionados. 

3 Sr.\e::cione el icono As.slgn Joint Restralnls de la barra de herramientas flotante para 
as1gnar empotramtemc en Jos apo)OS de la escructura. Se pueden asignar también otras 
caracuristicas de los nudos desde el rn:!nÚ Assign. 

Definición de la Sección Transversal de los Elementos 
l. S:leu:iroe rr\mo-amc:nte todas las sccr1ones transver.sales que van a emplearse en el pórtico. 

Desde ti menú Define seleccione la op:ión Frame Sections. Luego importe los perfiles de 
2cero r:lostrados en la figura 1-1. 

Nota: Se putth sekcdoncr más de Un.tJ teccMn a la Ytt de la lista Secdon 
Se!ection. Para ello presione la tecla Ctrl mkntras re efectúa 14 
se!uciñn. 

2 Bajo el menú Select encontrar! varias fmn.as de seleccionar nudos y elementos. Pan este 
p10bkma son útiles los mcx:los de selección Polnter/Wlndow e lnlersectlng Une. 

3. Una vez seleccionados las elementos d~t pó:tico dco.:ados, se pOOrán asignar las secciooes de 
acero correspondientes a través del bor:ón As.slgn Frame Secdons que es(j ubicado en la barra 
de hcrr.uniL'fltas fl((ante. 
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EJemplo 1 Pónico Bid•memional ton Car¡~o EuJiica 

Asignación de Cargas 

-· ! 
,...._ 
1 

Define Slatic Load C•se Names 1 

: Load•- ·•· 

lLiad ·: ~ T~t · 

. C~clda. -
1 

1 Add-lood 
:· 

1 0...-Qtload 1 
[•1111tl~$j 1 

~ 
1 C...c.J 1 

jDEAO jou.n :::J 1 i·rrr ;~, .·." . ! 
. . ' . . . ~ 

. ' . . ; 
·- ·-·- ····-- --;----- __ .. 

Figura 1·2 PlantUia con los nombres de lu condiciones de carga eslitica 

.r--

l. El primer paso al ingresar las cargas es definir las condiCIOnes de cuga cst!tica. 
Para ello ingrese al menú Define y sd.:cdonc la opción Stalic [.oad Ca!les. 

DEAD pued.: usarse para las cargas venicales por peso propio de las vigas, 
mamc:nicndo el indicador Self Weight l\IuJtlplicr con el vJior 1, SAP2000 agregar¿ 
el peso propio de las vigas. 

2. D~fina una condición d~ carga latera] estática llamada EQ para la carga de sismo. 
Asigne esta carga laterJ..I como una carga del tipo QUAKE. Esto permitir! al 
programa efectuar autom.iticamente las combinac'looes de carga a ser empleadu pot 
el módulo de diseño del SAP2000. Además asigne al pat!metro Sclr Wclght 
Multlpller el valor cero. 

3. Las cargas verticales mostradas en la Figura 1·1 pueden asignarse a las vigas 
seleccionando todas las vigas utilizando el txx6n Asslgn Frame Span Loads de la 
barra de herramiemas flotante. 

4. Las cargas laterales estáticas ncccsilan ingresarse seleccionl.tldO individualmente 
cada nudo y empleando el bot6n Asslgn Jolnt loads . 

Importante: Asegúrtu de que tsú añadiendo llls cargas a 14 condicl6n tk 
carga corrtspondientt. · 
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EJemplo 1 Pórtlto lluJ,meosioc.a.l con Car¡• EJtttic:a 

Creación de Diafragmas de Piso 
CrCdf d1afragmas de p1so 'J especificar la ma·.a. del piso sólo en la dirección X soo técnicas 
comúnmente usadas para reducir el tamaño del p-oblema. Por ocro lado, al añadir diafragmas el 
C.Jmportam..iento del mcx:lelo !.e asemeja al de un edificio con diafragmas rígidos. 

l. Repita los siguientes pasos para cada piso: 

• Seleccione todos los ~udos del piso. 

Er.tre al menú Asslgn y seleccione 1¡) opción Jolnt ... Constralnts. 

Seleccione Add Dlaphragm del la C<tja de opciones. 

• En la plantilla Diaphragm Cons;ralnt ingrese un nombre para el diafragma del 
primer piso En este case usaremos el nombre DIAl. 

• Sdecc:ione la opción Z-axls constralnt. Esta opción define un diafragma 
perpendicular al eje-Z. 

• Presione el OOtón OK. 

Presione el b:Món CK para finalizar la operación. 

Repita estos pasos para los demás pisos usando diferentes nombres en cada uno. 

2. La rrusa de tOCos los pisos es la rrtisma Luego seleccione un nudo en cada piso. 

3 Cambie ldS ur.idad!!s en q..te se van a ingresar los datos a Kip-in, puesto que la masa indicada 
en la figura 1-1 está dada en esas unidades 

4 Dd menú Asslgn seleccione la opción Joint ... Mas.ses 

Ingrese la masa de cada piso en la dir<!cción del eje coordenado local 1 (que en ~ste 
caso cmncide con la dirección del Eje Global X ). 

Todos los demás valores son cero. 

5 Retome las unidades a Kip-ft. 

Propiedades de los Materiales 
f'or último. antes de cfecruar el análJsis de la es[Iuctunl, deberemos verificar que la asignación de las 
propicd.Jd~ de Jos matcnalcs es la correcta 

l. Dcsd!! el mroú Define ~leccionc La opciór. Materlals. 

2 En la planulla Materlals seleccione STEEL '1 presione el OOtón MODIFY/SHOW 
MAITRIAL 

r-· 
Ejemplo l P&ttco Buluncnsional con Carga EsWiCa 

.-.. 

• En la plantilla Material Propcrty Data verifique que las propiedades del material 
sean las correctas. Recuerde que los valores son reportados en las unidades con las 
que s'e 'este trabajando en este momento. · 

Efectuandó el Análisis 
Una vez que los dato:. han sido ingre:.ados, es tiempo para correr el modelo y revisar los reSultados. 
l. Grabe el moJelo. 

2. Esp!!cifique los parámetros para el análisis seleccionando la opción Analyze del mcml 
Set Options. 

• En la plantilla Analysls Optlons seleccione Planc Frame Analysls para reducir el 
tamaño del problema y por tanto reducir el tiempo de cálculo. 

• Preloione el botón OK para aceptar los cambios realizadru. 

3. Seleccione la opción Rwt del menú Analyze para proceder al anflisis la esuucnn. 
Nota: Una vez: concluido el análisis Ud. podrá re.-iJar lo1 resultados 

completar en la pantalla anter de presionar el botón OK. Esta .s•rd su 
primera verificación para ver ri e.rirte algún problema en el modelo. 

Usando los Resultados 

Verificación de los Resultados 
Una vez que se ha analizado el mo:ielo se debe venticar si los resultados son caTCaos y que sus 
valores son del crd01 '1 magnirud a los esperados. 

Verificación del Mcx:lelo: 

1. Verifique que el conante total en la base es igual a la carga lateral total para la condición 
de carga EQ. 

• Seleccione el grupo de elementos del pónico que están ubicados en el primer nivel 
así como los nudos en la base de la estructura 

• Desd~ el menú As.slgn seleccione Group Name!i. 

Asigne a este grupo d!! elementos un nombre representativo por ejemplo BASE 
SHEAR. 

• S!!leccione el OOtón ADD NEW GROUP NAME y presione el botón OK. ·. 

• En el menú Display seleccione la opción Show Group Jolnt Force Sums y elija el 
grupo previamente creado. 

6 SAP2000 Gula de Aprcndnajc SAP20CO Gub, de Aprendir.ajc 1 
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Ejemplo 1 Pdnico Bid¡men,ionJI coa Cup Estilla 

Observe la deformada de la estiUCtura y cree uua animación de la misma bajo cargas 
\Crticalcs y laterales para aseg:.uarse de que el .:omportarniento del mcxlelo es el esperado. 

lngre¡,e al menú Display y seleccione Show Derormed Shape y seleccione la 
condJción de carga m la que es1e intc1 csado. Tambi~n seleccione líl opción Wlre 
Shadow, así podrá ver la geometría 01>-dcformada de la estructura al mismo tiempo. 
Vea las Figuras 1-3 y 1-4 para las fo1mas deformadas de la emucrura. Haga click 
con el barón derecho del mouse sobrt: cualquier nudo para observar los 
desplazamientos y rotaciooes correspundiemes. 

• Genere Wla animación de la deform:llh. presionando el botón START ANIMA TION 
ubicado en la parte in ferio; de la barr..t de estado (Para es1o se necesila que se 
encuentre activa una ventana conteniendo la deformada de la estructura). La 
animación así creada puede salvarse como una archivo • .A VI para verse despu~s 
desde el menú File. (Vea la A)llda En-línea bajo el ítem "Exportan A VI file".) 

Intente esro: Presione los boton~s +y- ubicados junto al bot6n A.nimale 
y vea lo que lt suc~d~ a ID d~jomrada tk le estructura. 

• Presione ell:xxón STOP ANIMA 110N cuando haya tenninado de observar la 
animación. 

Si los ¡:x-oc.ed.im.ien!os antes d~tos muestran que la infamación ingresada aparenta ser ccuecta, 
¡xxicmos en ronces avanzar hacia procedimientos rnás avanzados de revisión de los resultados. 
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Ejemplo 1 P&tico B1dimensionaJ con Carga EstJ1ica 
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Figur1 1-3 Derorm1da del• Estructufl pan Cargu 
Verticales 

Comportamiento Estructural 

Figure 1--4 DeiOt"mldl del• Ettruetuu pw1 Catgu 
llteulu 

En muc:hu ocasiooes se desea verificar si la c:sttuctLn se enOJCrltra dentro de detcnrdnldos 1fmites 
ck romporumiento, tales como rangos ck esfuerzo especificados pe.- alglln código de diseño. 
SAP2000 hace tc:dal estas verificaciones automáticamente cuando los elementos 1tt1 diseñados. 
(Las opciones de diseño del SAP2000 serán discutidas con ma)Q' dcu.lle en los 5iguimtes 
ejemplos). 

l. Los elementos estructurales pueden djseftane desde al mend Dtslp y seleccionando la 
opción Stut Deslgn/Check of Structure. 

• Los elementos del pórtico mostrarán en este momento colores que rcpresenran el 
nivel d~l esfuerzo en cada elemento. Asimismo en 1:1 parte inferior de cada tlemet~to 
se muestra un valor nUmérico representativo del nivel de esfuerzo prc:senle en el 
elemento. Un valor 1 por ejemplo significa 100% esforzado. 

' 
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Ejemplo 1 Pórtico Bidimeo,lon.al coo Carp EJlJtlca 

• Para tene!' más información sobre el diseño de los elementos entre al menll Deslgn y 
seleccione la opción Display Dcslgn Info. 

2 Se puede también ver la información del d.isef.o de cada elemc:"nto, o inclusive asignar 
secciones transversales alternativas, haciendo click con el botón derecho del mouse sobre un 
elemento. 

De la ventana que se muestre .se puede seleccionar el botón DETAliS para apreciar 
información detallada de la sección bJjo cada una de las combinaciones de carga 
empleadas en el d1seño. 

También se puede rediseñar el elemento después de cambiar sus parámetros de 
diseño. longitud efectiva, facwr K o propiedades a la sección, presionando el 
botón REDESIGN. 

3. Si .se ha selecciOnado una nueva sección la cual se quiere utilizar en el diseño final de la 
estructura. únicamente ingrese al menú Dcsigu y seleccione la opción Update Analysls 
Seclions para re analizar la estrucrura con las nuevas secciones seleccionadas. 

Nota: Puede ser rucesan'o el uso dtl bott.Sn Re./rtsh Window de ú: batTa d4 
hen-amienltls para actualizar la informaci6n en la ~rntat1a acti11a 
luego de haber efecluadiJ cambias en los parámetros de diseño. 

Observando e Imprimiendo ResuHados 
A menudo se necesila disporH:l' de una ropia impresa de los resultados de los análisis ol;(enidos ron 
el SAP2000. Existen difercntes formas de olxenerlos: 

l. Se pueden eleg!I los resultarlos que nos imeresan con la opción Genera te Output ubicada en 
la plantilla Analyals Options. El botón Se1ect Output Optlons que aparece permitirá 
seleccionar cuantos y cuales de los resultados queremos imprimir. Estos resultados .son 
;:scritos en un archivo de texto con el mismo nombre de nuestro archivo de datos, pero con la 
extensión • .O liT. 

2 Los datos ingre~ados asf como la mayor parte de los resultados generados tambitn pueden 
verse a pa.nir del n~enú Display. 

3. Desde el menú File se pued.: optar por imprimir ya sea Gráficos, Tablas con los DaJos 
lngresad~s ó Tablas con Jos Resultados del Análisis y Diseño de elementos. 

Sugerencia: Si eri.Jtm tlemtntos 6 nudos seleccionados al momento de 
generar la impresi6n de resultados, únicamente se imprimirá la 
ir.formacit.Sn correspiJndiente a dichos elementos. De lo contrario, la 
impresión se ¡;en erará para todN los elemenJos y nudM del modelo. 

4 El anáhsis efectuado por el SAP2000 genera dos atchivos de salida. El archivojilename.EKO 
que incluye toda la infonnación empleada en d análisis; y el archivojile!Ulme.OUT, que 

r-. 
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contiene los resultados del an4lisis asf como los resulwlos específicamente seleccionados en 
el menú Anall:'l_e ... Set Options. · 

Recuerde: Es un buen hdbilo generar la 1allda primenzmlnU a un . 
archivo de terto antes de enviarlo direci/Jmente a ú: impresora. Lto. 
nos permite revi.rar previament.~ la informaci6n usando eualquitr 
editor de tertos, sin tentr que hacer frtnlt a tnormts pilas de paptL 

Comentarios Finales 
Como habrá podido observar, SAP2000 es una poderosa hcmmienta pan el an.!liris esauconJ""' 
puede usarse en Wla gran variedad de problemas Sin embargo, es muy impcrtantc entender los 
principios de ingeniería sobre Jos cuales este programa ha sido creado. 

La mayoría' de los trabajos en ingeniería se inician con sencillos ante¡x-oyectos para posteriormente 
madurar en complejos proyectos de análisis/diseño. Esto hace que se:1 muy impcxtante d.xidir desde 
un inicio las herramientas apropiadas de fOilllJ taJ que no sea necesario cambi<tr de fl'ogr¡¡ma.s 1 la 
mitad de un proyecto. SAP2000 trata de satisracer la ma)1Jr p.u-te de las necesidades que un 
diseñador puede tcnerdurant~ el desarrollo de un proyecto. 

Las características que SAP2000 ofrece en el proceso de disdio incluyen; 

La capacidad d( diseñar pequeños 6 grandes proyectos sin necesidad de aprtndtr 1 usar un 
nuevo programa 

• la capacidad de diseñar elementos de coocreto y actro en un mismo programa. 

• AJgorianos de cálculo rápidos que permiten aJ usuario dedicar ma)U tiempo en la m00elad6n 
del problema y optimi.z.aci6n dd diseño de elememos estructura1es. 

• La habilidad para mcdificar y rnejccar el diseño fácilmeme. 

• Existen probablemente tantas formas de modelar una estrUctura romo Ingenieros existen. Sin 
embargo, pÚed<! encontrar útiles algunas de las siguientes ideas: • 

• Comience ron un modelo básico de la estructura y trate de entenderlo antes de al\adir nW 
detnlles Será más sencillo corregir problemas en el sistema estructural adoptado cuando el 
modelo es aún simple. 

• Asegúrese de que la estructura pueda construirse y que se compcnar! en la manen en que la 
hemos modelado Si no puede ser consttuida m esa forma. es necesario entender el efecto del 
proceso constructivo en el componamiento final de la estructura. 

• Documente detalladamente su dJsd\o incluyendo inftnnaeiá1 IOb-e las cmsideraciones 
asumidas, áreas que ddl<l.n revisarse e incluso sche información que aún es requaida. Pare ello 
use el editor de tex:tos User Conunents and Sesston Log que se encumtn dentro'&! menú 
Flle Es1e editor de tcx:tos incorporado en el programa. le permitirt que dichas anwciooes y 
comentarios fonncn p.u-te del modelo. 
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Ejemplo 1 Pórtico Bidimcnsio¡¡,aJ coa Carp EsW.ica 

Expaimaue coo sistana.~ estructurales allemativos. SAP20CXl ha sido diseñado para efectuar 
cálculos nwnéricos r.ipid.lmente, pc:rmitienJo utilizar mayoc tiempo 01 el mejoramimto de 
nucstrJS Wseños. · 

Así como hay un tiempo asignado para la re•flsi6n general al final de un p-0)«10, no hay razón 
por la que no deba hatx:r wt tiempo para revi~ar el proyecto desde sus inicios. 

• 
.. 

.· ·.·· 
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EJEMPLO 2 

Pórtico Bidimensional con 

Carga de un Espectro de Respuesta 

Descripción 
Este ejemplo es una cootinuaci6n del Ejemplo l. En esta s=i6n n.omm cruos CXl!llO lnca¡xnr un 
Espectro de Respuesta en el análisis de un pático bidimensicnal. La OOsc para definir el Espc:cuo de 
Respuesta scri el espectro del código UBC94S2 el cual esta incluido en el SAP200J. 

Aspectos Significativos del Modelo y del SAP2000 
o Uso dd comando Help para cluncr lnsttuocimes sotn laJ opdooeo del SAP2000. 

• ·JncapcnciOO de una cerga provenimte de un Espectro de Respuesta.. 

o Adc:cuar la escala del Espectro de Respoesla para su uso m el di5dlo. 
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Ejemplo 1 Pónico B1dur~ndoo.a.l con car¡a de un EJP(ctrO de Rup.¡esu 

Definiendo el Espectro de Respuesta 
Un Espectro de Respuesta e:; la máxima resp:.~esta de un sistema cxciwlo en su base poc una 
función aceleración-tiempo. Esta función se ex ¡x-esa en términos de la frecuencia natural de la 
escrucn.ua y del amcrtiguamiento dd !'istema.. f.l Espectro d~ Respuesta del cód..igo UBC94S2 que 
v,1mos a emplear m este ej¿mplo es suministrado coo SAP20CXJ y no es necesario dcfinitl!J pcr 
separado St t:ubiese la necesidad de definir un Espectro de Respuesta distinto, se puede usar la 
ayudd en Enea para obtener instrucciones que indican paso a paso como efecrua.r esta tarea. 

Ayuda En-linea 

Recuerde: Podrá u ti litar alguno tú los mllodos siguientes para Obtener 
injonnación sobre cualquitra o'e las funciones del SAP2000 

l. Del me:1ú llelp seleccione Search for llelp on. 

2. Con el plantilla lndcx seleccionada: 

• En e:\ Arca 1 escriba 'Define·. Ud. vt-ra en el Arca 2 una Usta de tcxlos los tópicos 
disponibles que comiencen con la palabra 'define'. Uno de esos tópicos es 'Define 
Response Spcc:trum Functioos·, que es el tópico del cual necesitamos obtener ayuda. 
ibga doble click en la línea con 13 fr:~se 'Define Response Spectrum Functions' 
para que el programa muestre la información correspondiente. 

3 Ahe:nativamente, seleccione el indicada Find para bJscar lUla pa1ab'a clave en cualesquiera 
de los tópicos disponibles en la Ayuda En-linea. 

• Si es la primera vez que usa la opción FUld de la Ayuda En-línea del SAP2000, 
aparecerá una plantilla denominada Find Setup Wlzard. 

• Presione el botón NEXT para aceptar el criterio para construir la base de datos de 
búsqueda. 

• Presione el botón FINISH para construir la base de datos. 

• En el Area 1 escriba 'Response Spectrum' 

En el- Are a 3 enconttará nuevamente la opción 'Define Response Spectrum 
Functions' la cual puede sdcccionar·.t: para obtener la información de ayuda 
correspondic'nte. 

Nota: Se puede encontrar mayor información sobrt el uso tk la Ayuda 
En-linea, en la documentadón de Windows. Tambiin puede ejecutar 
el archivo \11.Vl/ELP32.11LP ubicado en C:\IVINDOIVSIHELP. 

Definiendo el Espectro de Respuesta 

l. St el modelo:> esta prOicgldo {lockc:d), use el botón Lock/Unlock Model para remover la 
protección y pOOer efcctu;n cambios en el modelo. 

1-' SAI'l000 Gu(¡ de Aprc:nd:ujc: 
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Ejemplo 2 Pórnco Bidimension.al coa wg1 de ua &pc:cirade Res~~ -'. 
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2. Ajuste las unidades a Kip-ft. 

3. Ingrese a1 menú Define y sc:leccione la opción Response Spectrum Cut.,·~ 

4. Presione el botón ADD NEW SPECfRA en la planlilla Response Spc:ctra. 

S. En la plantilla Response Spectrum Case Data: 

• Espc:cif1que el amortiguarn.iemo asociado al Espectro de Respuesta colocando en la 
casilla Damping el valor, para nuestro caso: 0.05 (5 %) 

• Seleccione UBC9-IS2 para la dirección Ul, asf como un factor de escala 32.2ftlsc:c1 

en la calilla S cale Factor. Este factor de escala es usado por el Es~ctto de 
Respuc·aa debido a que el espectro UBC9452 esta nonnalizado al valor de la 
aceleración de la gravedad g. · 

• El resto de los valores por defecto son aceptables. 

• Presione el OOtón OK para aceptar los cambios hechos en ambas planlillas. 

Efectuando el Análisis 
Una vez que se han realizado las mOOificaciones, es tiempo de analizar el mOOelÓ y echar una 
mirada a los resultados del Espectro de R!!spuesu. 

1. Grabe el moddo. 

2. En el menú Analyze seleccione la opción Set Options. 

Marqul! la casilla DynamJc Analysls. 

Presione el botón SET DYNAMIC PARAME"ffiRS y modifique el ntlmero de 
modos de vibración a ser considerados en el análisis en la opción ~wnber or 
M ocles. Para nuestro caso 7. El resto d~: valores por defecto son aceptables 

Prestoae d botón OK en ambJ.s plantillas para aceptar los cambtos. 

Nata: St debt decidir cuantos ntodos tk vibración ddtn comiderane tn 
el anáUsís para obttntr rtsullados adtcuados. Para ello hay muchos 
criterios a tomar tn cuenta, pero para una estructura sencilla como 
la que estamos analil.Qndo puede conrú!trarst satisfactorio un 
numero dt modos igual al numero de pisos. 

3. Seleccione la opción RWl Mlnlmized del menú Analyze para analiz.ar la estructura. 

Not.1: La opción Run Minimi1.6d ts sumamente útil cuando lt dtntn modelDt 
grandes que requitrtn mayor tiempo para ttr anali:ados. Esta opción ptrmite 
al St\P2000 co"tr tn un ttfUIIdO plano, ptnnititndo continuar trabajando 
con otros programas. Otra vtnlaja dt esta opción ts qut nos brinda un botón 
para cancelar la tjecución dtl análisis en caso necesario. 
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EJemplo 2 Pónico Bidimo::IUiooal coo carga de un Espcctto de RcJpueSUI 

Verificación de los Resultados 
l. Verifique si las fonnas modales y perrcxlt.:. de vibración son los esperados. 

• Del menú Display 5eleccione la opcijn Show Mode Shape y elija el modo en que 
esta interesado. Pude también seler.:cionar la opción \Vire Shodow para ver al 
mismo tiempo la forma no-defonm.dJ de la estructura Observe las Figuras 2-l a la 
2-4 y nmt" que e:! número de modo)' período de vibración correspondiente están 
indicados en el útulo de la ventana. 

Nota: Se puecú apreciar los modos dt vibración subsecuentes presionando 
los botones+ y -,próximos al botón START ANIMATIO!'/. 

2 Es útil ver el cortante en la base producid:.> por el análisis del Espccuo de Respuesta. 

• Usando el grupo BASE SHEAR que fuedefmido en el Ejemplo 1 observe el 
cor.ante en la base de la estructura d.:bido al Espectro de Respuesta. Se puede 
aprectar que este cortante es consideiablcmente mayor que el debido a la condición 
de carga eJ.tática. 

3. Se puede verificar el desplazamiento de un nudo debido al Espccuo de Respuesta. 

Del menú Display seleccione Sbow Derormed Shape. 

• En la plantilla Dcformed Shape seleccione la condición de carga para el análisis 
cspeclral. · 

• Presione el botón O K. 

• Haga click con el botón derecho del mousc sobre tm nudo del nivel superior de la 
estructura para ver su correspcndiente desplazamiento én la dirección global X. 

4. Verifique !a participación de la masa de 111 estructura para ver si se ha incluido el en la 
solución del problema el mlm::ro de modos suficiente. Para ello se debe revisar el archivo 
de te.(to filename.OIJI' empleando un edita de textos como el WordPad de Wmdows. 

• Minimice el programa SAP2000. 

• Inici~ el programa WordPad o cualquier otro editcr de textos. 

• En WcrdPad abra el archivo fiknam~.our. Doode filentJ~FU es el nombre del 
archivo usado al grabar este ejemplo. 

t Busque la s=ión titulada MODAL PARTICIPA TINO MASS RATIOS como ae 
m1Jestra en la Figura 2·5. · 

• Bajo la columna CUMULATIVH SUM encootrad que los Modos de Vitraclón · 
1 al7 incluyen el lOO% de la participación de masa. lo cual significa que los 7 
modos empleados en el análisis fueron suficientes. 
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lwltfttfiiQJI!.!II83:!:!:ftíp !·lo! ~F O Modc 2 Period 0.4118 sec-.1!1913 

1 

1 

1 
i 

Flgura2·1 Forma Modal y P«lodo de VIbración t Figura2·2 Forma Modal yPerlodod• Vlbtadón 2 

Flgur1 2-3 Form1 Modal y P«lodo de Vlbrtelón 3 Flgtra 2-4 Fonnallodal yPerfodo d• Vltnd6n 4 
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I::JCmplo 2 Pórtico Bidimen.doo.al coa car¡a de un Espectro de Rcsp.¡esta 

H:;. D ~ L P A R T T C I P A T I N G HA !' S R A T I O S 

HOl!t: PE:RIOO ItrDIVIOU).L HOOE IPI:RCIIrrJ CUHlJl.A T IV!: S 1M IPERCI:NT) 

Ú/: UY uz ux U/ uz 

l 1 39975::1 79.6359 o .0000 o. [IQQQ 19.6359 o .0000 0.0000 
2 0.~77913 11.5761 a .ooaa o .0000 91.2120 a.oooo O. DOGO 

0.209126 ~.30~3 0.0000 o. 0000 95.5144 0.0000 o.oaoq. 
• 0.179~39 2 .1229 0.0000 a .(looa 97.6373 0.0000 0.0000 , 0.133iii8 l.407j o .0000 O .GODO 99.0~50 0.0000 o. 0000 

' O.l076J1 o.esn o .0000 o .0000 99.1043 0.0000 O. OOlJD 

' 090~78 0.29:1 0.0000 o .~000 100.0000 0.0000 o. ooao 

F1gurt 2·5 Bloque de Ptrtlclpadón de h Ma11 del archivo de talldt 

Modificando la Escala del Espectro de Respuesta 
Alguno:. cédlgas de diseño perrnitm mcrlificar l;¡ escala del Espectro de Respuesta de manera que 
c:l Cort.lnle en la base del ;111álisis espe:ctral sea igual al cort.lflte en la base del análisis empleando 
cargas sísmicas estáticas. 

En este seutido para obteno- el nuevo faacr de escala para el Espectro de Respuesta tenemos que: 

l. D1vidir el Cortante en la Base producido por la Carga Sísmica Estática por el Cortante 
en la Base obtenido del Análisis Espectral, y multiplicar dicho número por 32.2 ft/seg2 

para obtener el nuevo factor de escala del Espectro de Respuesta. 

2. Substnuir el n~evo factor de escala en el Espectro de Respuesta. 

3. Efecruar nuevamente el análisis para obtener las nuevu fuerzas en los elementos bajo la 
acción del Especrro de Respuesta escalado. 

Id SAP2000 Guh de AprendJZ.aje 

¡· il i 
,.,.. .... 

EJCmplo 2 Póttico Bidimensional con carp de u11 Espectro de ResPuesta ~-J·Nk·1w. 
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Comentarios Finales 
Un análisis empleando el Espectro de Respuesta intro:luce un nivel de complejidad ma~. cp.lC 

requiere que el ingeniao verifique cuidadosamente los resultados, y tenga muy pr~nte las 
consideraciones hechas al crear el modelo Algunos de IC6 aspectos a considerar durante un análisis 
espectral son: 

• . Entender completamente el comportamiento estático del modelo antes de efeétuar un 
análisis dinámico. 

• Tener un conocimiento cabal y racional de los aspectos involucrados al escalar los 
resultados dd análisis dinámico para obtener un conante en 1:1 base similar al que se 
obtien~ al efectuar un análisis por cargilS sísmicas estáticas. 

• La ventaja di! la mayor rapidez del Análisis Espectral en comparación con el Anilisis de 
Histori:l en el Tiempo es en muchos casos sustancial. En el diseño, el espectro de 
respuesta puede incluso proveer aun mayores ventajas debido a que no se deben efectuar 
verificaciones para diferentes intervalos de tiempo. Sin embargo, es neceurio tener 
presente las limitaciones del Análisis Espectral frente al mayor refinamiento que se 
obtiene al efectuar un Análisis de.Historia en el Tiempo. 
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EJEMPLO 3 

Pórtico Bidimensional 

Análisis de Historia en el Tiempo 

Descripción 
Este ejemplo continua el anáJisis del pórtico bidimensioo.aJ visto en los Ejemplos 1 y 2, 
añadiendo en este caso una carga de sismo e::pecificada con un .acelerograma en la baJe de la 
C!tructura El registro de aceleraciones a utilil.arsc se mucsua en la figura 3· 1 y corresponde a 
!J componente N·S del sismo ocurrido en El Centro en 1940. Los resultados del análisis de 
historia en el tiempo se utilizarán para generar un Espectro de Respuesta que luego se 
empleará para reanalizar la esttuctunl. a manera de comparación. 

Aspectos Significativos del Modelo y del SAP2rioo·' · 
o R<spu<sta de histeria "' el tiempo de una excioodm m la base. 

o Grificas de los r<SUitados dclan.üisis de lústeria"' elllempo. 

o Grificas de un Espcaro de R<spuc>taa panirde losraultadas de la Histeria"' el Tiempo.. 

o lmpcrtacim del Espectro de rcspucs~a para su uso en el an4lisis. 

SAMIXXI Ou!a de AprcDdizajc 20 
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Ejemplo 3 Pórtico Bidi~~~~~lonal Annislt de ~~·~a~~ el Tic~ . 
' .. ~ ' '., •• ... - ',,:-,:. :"·,'~ :~ .:1· 

Time Hislory Furiclionsi·- ~ 

.1"' 

\ ;~' .. :>0~:\k' 
• . :: ;~;~tf:'.; 

. ·. ,·.· 

Flgur1 3-t Acel•ogram• de entrldl del Sismo de El Centro 1140 ( ttlsee-') 

Definición del Concepto Historia en el Tiempo 
El t&mino lúsccxia en el Tiempo define un regiszro de acelenciooes del terreno a deurminados 
imavalos de tiempo pant una excitación sísmica específica en·'una dirección dctirminada. Et 
registro es usualmente ncrma.J.izado y en cmsecuencia necesita multiplicarse pcr la acelc::ra.ción de la 
gravedad 6 ¡xr alglln aro fa<toc correspondiente. 

1. Desde el mc:m1 Define seleccione Time Hlstory FunctJons. 

2. Seleccione el botón ADD FUNCTION FROM FILE. 

• Presione el botón Opea FUe y seleccione el archivo ELCE~O ubicado et~ el 
sulxlirectorlo EXAMPLES del directC?rio SAP2000. 

• Cambie el nombre de la función a ELCEN"ffiO para qUe sea fkU de reconoec:r. 

• El forma1o de cs1e archivo es de tres pares de columnu de datos por renglón. El 
primer par de daros la primera columna de cada par es el tiempo y la segw1da es la 
aceleración. 

t lngre5e 3 Pun1os por Unea.. 
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Ejemplo: Pónlco Bi~menslorul Alál•sis de H1stOrÍI ea el Tiempo. 

t Seleccione la opción Time and Functfon Values (en archivo de datos). 

t Presione el bocón OK. 

• Presione el botón OK para aceprar los datos ingresados. 

J Del menú Define seleccione la opción Time Hlstory CaseJ para definir los parám~tros 
específicos para el anilisis de His10ria en el T1cmpo de nucsrro modelo. 

• Seleccione el bocón ADD NEW UISTORY. 

Para adicionar amoctiguamiento al sistema presiooe el botón MODIFY/SHOW 
MODAL DAMPING, ingrese 0.05 (5%) par.i. todos los modos y presione OK. 

I.1grese en elftem Number or Output Time Steps el vaJor 500. 

• Ingrese O 02 (sec) en elite m Output Time Step Slzes. Estos parámetros nos darán 
1 O segundos del registro sísmico para !!1 análisis de historia en el tiempo. 

De la Lista Analysts Typc sele,cionc la opción Linear. 

• En el área Load Asslgnment : 

• 

t Seleccione ACC DIRI para el par!metr~ Load 

t Seleccione la opción ELCEr-fffiO para el par!metro Func:Uon 

t Para 11::1 parámeuo Scale Functlon ingrese la aceleración de la gravedad que 
es de 386.4 in/sec2 si uabaja en IGp-in o 32.2 ft/sec1 si trabaja en K.ip-ft. 

• Para los parámeuos Arrhul Time y Angle asigne valor cero. 

t Presione el botón ADD para as~egar ena carga al modelo, y presione el 
botón OK para aceptar los datos que acaba de ingresar. 

f'rc:s;one el botón OK en ambas plantillas para aceptar las adiciones al modelo. 

De esta m."...era hemos ingresado teda la infcnnad6n que necesitamos para cfecruar el Análisis de 
lli>tocia tto el Ttempo. 

Nma: Por lo g~nual ~s u.na butna idta correr ~1 motklo cak Ytt qu~ se 
hace un cambia ó adici6n importanJt al modtlo. Esto pennilt 
detectar errores y ahorra tiempo en d diseño final 

. ' 

1 

1 

1 

i 
1 

1 

r-, .[--, 

Ejemplo) Pónlco Bidimensio;w Anilisis de 'ru~ en el Tic~. :-

. ·...:. 

. :<. 

Efectuando el Análisis 
l. Grabe el modelo. . , .•. 
2. Ajuste los parámetros para el análisis seleccionando ~nalyze del m~mJ Stt Op~~Ds. · 

• Verifique que los parámetros en Dynanúc Analysb son los mismos del Ej~lnpio 2. 

3. Seleccione en el menú Analyze la opción Run para analizar la estructura. 

Usando los Resultados 

Verificación de Jos ResuHados 
Una vez que ha ccrtido el mOOelo se deben verificar que los resultados c:btnidos sean del adcn y 
rnagnirud a lo esperado. 

l. Verifique el Cortante en la Base producido en el Análisis de Historia en e11i~mpo. 

• Desde el inenú Display seleccione la opción Show Time HJstory Traces. 

t De la plantilla Time History Display Denrütlon presione el bol:ón DEFINE 
FUNCTIONS. 

t En la plantilla Time HJstory Funcllons seleccione Add Base Functions y marque 
solamente la opción Base Shear X. 

t Presione OK para regre5ar a la plantilla Time lUstory Display DeOnJtlon. 

t Adicione la función Base Shear X ala lista Plot Fw:tctlons . 

t Presione el botón OlSPLA Y paril ver una grUica del cortante en la base en la 
dirección global X como función del tiempo. Vea la Figura 3-2. 

Nota: También St puttk glltUGr la grdfica tUl eortantt tn la baJt 
seleccionando Add Group Summation Forces tn lugar de Add Ban 
Functions y seleccionando ti grupo de elementos BASE SI/EAR 
definido en ti Ejemplo l. 

2. Tambi~n se puede verificar el desplazamiento de un nudo ante una excitación de Historia 
en el Tiempo, para ello: 

• Escoja un nudo y desde el mcm1 Display seleccione la opción Show Time ~lstory 
Traces. 
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Ejempi(J) P6r1ico Bidimension.a.l An.ihsiJ de Historia Cll el Tiempo 

t Presione el botón DEFfNE FUNCTIONS de la plantilla Time Hlstory 
Functions Seleccione el nombre tlel nudo de la lista y presione el botón 

~IODD'Y/SIIOW TII RJNCTION 

t En la plantilla Time Hmory Joint Function sc:lc:ccionc: DISPL para el parámetro 
Vector T)·pe y UX para el parámmo Vector Direction. 

t Presione el b01ón OK para acc:pt.u los cambios. 

t Presione Jos bownes OK para re~resar a la plantilla Time llislory Display 

ncnnilion. 

t Añada el nudo de la lista Llst or Functloru a la lista Plot Functions y remueva de 
esta úhima la función Base Shc~r X 

t Presione= el botón DISPLAY para ver el desplazamiento del nudo con respecto al 
tiempo. Vea Figura 3-3 

• Se puede rambién definir una función nodal directamc:nle en la plantilla Time 
llistory Display Definition sm hab.:r seleccionado previarpente el nudo. 

• En la plantilla Time Hlstory Display DeHnitJon presione el botón DEFINE 
FUNCnONS y en la plantilla Time llistory Funetions seleccione la opción Add 
Joint Disps!Forces. 

• En la plantilla Time tlistory Joini Function ingrese el noffibre del nudo (ID). 

• S:leccione Vector Type y Vector Dlrectlon. 

• PreSione los botones OK para regresar a la plantilla Time UJstory Display 
Defir.ition en donde encontrará la nueva función nodal en el recuadro Lfst of 
Func!ions. 

24 SAP2000 Q .. fl de Aprer.diuje 
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Figura 3·2 Cortante en la Base- Kips 

1 
.¡ 

Flgur1 3-3 Hiltorla en el Tiempo del Duplazamlento del Nivel SuFJ:"'or -In 

Creación de un Espectro de Respuesta 
Lo primero que se tiene que haca en este pt.mto es crear un Espectro de Respuesta a partir de las 
resultadas del Análisis de His10ria en el Tiempo Los dalas generados d~ esta (orrnJ. deb:n 
imprimirse en archivo de texto piln\ poder ediucbrse m un ramato que pua1a ser leido pcr el 
SAP2000. 
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Ejempt:;) 3 Pórtico Bidimensional AnJ.Iisi.s de Historia en el T~empo. 

Gráficas del Espectro de Respuesta 
l. Se:=kccione un nudo en la base de la estructura. 

2. Del menú Display seleccione la opción Show Response Spectrwn Curves. Esta opción 
aparece solamente cuando se ha seleccionado un nudo. 

3. En la plantilla Response Spectrwn Geueration encontrará el nombre del nudo que fue 
seleccionado. 

Baje el Ctem Define asigne el valor X para el parámetro Vector Direcdon. 

• Bajo el ítem Axes seleccione Pertacl para el padmetro Abscissa y PSA 
(Se:=udoac~leración Espectral) para el parámetro Ordfnate. 

Bajo el rtem Options seleccione Arithmedc tanto para Abscissa como para 
Ordinat.e Para el parámetro Ordinate asigne el factor de escala 1/g (g=32 2 ftlsec1

) 

es rlc,ir, 0.03106 sec1/ft si las unidades en que se trabaja son kip·ft. 

Nota: Eljaclor de e.teala es usado para noi71UJiiZJJr el Espectro tk 
Respuesta. El registro para el análisis de historüJ tn ti tiempo que se 
utiü~J para generar tl Esputm tk Respuesta estaba normaliuulo a la 
aceleración de la grayedad (g) por lo que necesitamos dividir el 
e.tpeccro por la misma cantidad para obtener valores normalizados. 

• Bajo el Item Perfod seleccione para las frecuencias los padmetros DeCault y 
Structural. Estos parámetros son usados en la generación del Espectro de Respuesta, 
las frecuencias del tipo DdauJt son una serie de frecuencias predeterminadas que 
son típicamente de interés en las estJucturas; las frecuencias del tipo Structural son 
las frecuencias narurales de la estrucrura. 

• Bajo el hem Damplng mantenga el valor del amortiguamiento de 0.05 para el 
parámetro Damplng Value. Corno se ha :tsurnido que la estructura tiene 5% de 
an.oniguamienw no será necesario emplear otros valores para el amortiguamiento 
del sistema. 

• Presione el OO!ón DISPLAY cuando se halla lerminado. 

4. Ahora Ud podrá apreciar la gráfica del Espectro de Respuesta para el sismo de El 
Centro para un amoniguamicnto de 5%. Ver Figura 3·4. 

26 SAP2000 Gula de Aprendizaje 

... 
• 

._,, 
. ~----~ .-

EJemplo 3 Pórtico BidirncaslocaJ Alálisb de Hig:arla e:a ~ 'Íi~ . 

.. :; 
··.· 

• 

Figun 34 Espectro de Respuesta del Análisis de Historie en ell1empo 

S. En la plantilla Response Sptetrum Curns seleccione la opción Prtnt Tables to 
Fllt!. Esta opción generará un archivo que tiene dos columnas d~ d.J.tos. La primer e 
di! ellas es el período, y la segunda es su correspondiente Seudoacelaración (PSA). 

• Grabe el archivo con el nombre RS-ELCEN.TXT 

Edición de Tablas. 
El siguiente paso consiste en hacer algunas pequeñas modificaciooe:s al archivo de texto RS. 
ELCEN.TXT p:tra que tenga un formato que pueda Sc!r leído pcr el SAP2(X)() Esto se d.ebe a que 
cuando el archivo original e:s creado se le agrega informaciérl aclarar:ccia que permite al usuario 
interpretar y cnt..:nder fácilmenle su contenido Esl.l información extr.J debe! remO\'Cfst. 

l. Con un editor de aex.tos como WORDPAD o NOTEPAO abra el archivo RS· 
ELCEN.TXT. 

• Seleccione tcxlo el texto que se muestra resaltado en la FigW"s J.~ y renw¿valo. 

Grabe el archivo RS·ELCEN.TXT como un archivo de texto con el mismo nombre. 

2. Ahora que el archivo tiene tan solo las columnas con los períodos y sus 
correspondientes Scudoacceleraciones, pcxlrá ser lddo directamente por d SAP2000 
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Ejemplo J Pdnico Bidimensional Anilim de lliaori~ u el Tiempo. 

11 

0.0101 J .Oe66t-Ot 
0.0357 J .26$7[-01 
O .OiüO l.1139t-01 
o .o.¡ss J.~Zlit-01 

O.OSüü J .2205[-01 
0.0!;5? J.l~¡j[-01 

O.O~O.<.i J..¡:!6St-Ol 
o .ot;¡;7 J. 74}1[-01 

Figur~ 3·5 Archivo de salida ton el Espectro de Respuesta geneudo 

Lectura de los Datos del Espectro 
Ahcu que se tienen da!os en Wl formato que el SAP2000 puede leer, nc:cesitamos indicar a1 
programa la ubicación del ardüvo así como la forma en que éste contiene la información. 

l. St el modelo esta protegido presione el botón Lock/ Unlock Model en la barra de 
herramientas. Al hacer esto se remueve la protección sobre el modelo y nos pemtitirá 
realizar las modiftcacioncs. 

2. Del ma'lú Deflne selecciale Response Spectrum Functloas. 

J. En la plantilla R<SpOI1S< Sp«trum FIDlcdoos presione el ba6n Add Funcdon 1'rom File. 

• Asigne al espectro e:\ nombre RSELCEN 

Presione el OOtón Open FUe y seleccione el archivo RS-ELCEN.TXT en Pick FUe. 

• Mantenga el parámetto Number Ot Polnts Per Llne co el valor 1 puesto que 
únicamente hay un p:v de datos por renglón para definir el Espectro de Respuesta. 

• Stleccione la opción Perlod and Acct·leratlon Values. 

Presiúne el botón OK para cerrar las plantillas. 
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4. Del menú Define selco:ioo~ ~Spc:drUm Cases.; , ·' _.. . ,: ' · · 

. . . . . . . ................ . 
5. En la plantil~ llesponsc Sp«tnun presione el botón ADD NEW SffiC!RA.' 

• Asigne al parámetto Modal Damplng el valor 0.05. , 

En el área Input Response Spectra seleccione RSELCEN para la .dirección Úl y· 
asígnelc el fae~or de escala 32.2 ftlsec2• • 

• 

• Los demás valores por defetto son aceptables . 

• Presione el botón OK paca cerrar las plantillas. 

Efectuando el Análisis 
Una vez que se hMI hecho las modificaciooes es tiempo de correr el modelo y re..-is.ar Jos resultad<» 
obl:cnidos. 

l. Grabe el modelo. 

2. Sel~ccione Run Mlnlmlzed del menú Analyze para analizar la estructura.. 
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Ejemplo J Pórtico Bidimensional An.tlisis de Historia ene! Tiempo 

Revisando los Resultados 
Lo pnmcro que de:t:c hace:rse: es la reYisión de la máxima denexión m la parte superior de la 
cstrudttra asi como e:l cortante en la base Llnto para el análisis espectral como para el análisis de 
lli!>tO!ta er. el Tiempo. U comparaciál de estm resultados nos pcnnitirá ver que tan bién fundcm. 
IJ mctc:dología pre'IÍ:trncnte descrita. Al final Ce esra sección. encontrará los resultados del análisis 
pur cJrps sísmicas estáticas, del análisis espectral y del análisis de historia en el tiempo .. 

OeNexi.,)(les de acuerdo al Análisis Espectral 

De! mo::nú Display seleccione Display Defonned Shape. 

En la plantilla Dcformed S ha pe seleccione la condición de carga para el análisis 
especual. 

• Presione el botón CK. 

2 Haga click con el botón derecho del mouse sobre un nudo ubicado en el nivel superior 
para ver su dcsplazam.h::nto en la d!rccciün del eje global X. 

Cortante en la Bas."' el Análisis Espeetral 

Usando el grupo BASE SHCAR que fue creado en el Ejemplo 1, observe los valores del cortante en 
la base oc la escrucrura debirlo al Análisis Espc:tral. 

De flexión y Cortante en la Base en el Análisis de Historia en d nempo 

Usando el méuxlo descrim en la primera parte de esta. gula grafique la de0exi6n Cfl el tüvel 
supericr de la esOllcru:ra. 

2. Ahcra remueva ése nudo de la Hsta Plot FlDlctlom y en su lugar grafique la funcit.n Base 
Shear X ubicada en List oC Functions de la plantilla History Display Definltiom:. 

Carga Lateral Estática Espectro de Historia en el 
Respuesta Tiempo 

Max Deflexión 1.6lln l.lln l.81n 

Max Cortan re en 72.l1Gps 302 IGps 32l1Gps 
la Base 

Tabltl·l Companclón da loa Resultados del An!tlt!t de Cargulateraltl 
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Comentarios· Finales.· ,i·. '.';·, 
:·,.¡ .• : 
·'·" 

Como hatd podido a¡nciar el Aná.!Jsis de Historia Cfl el Tiempo involucra un mayor tienlpo de · 
cómputo que el Análisis con Espectro de R~"J>llesla Dd::c observarse sin embargo que arnl::os ,. 
méto:::los de análisis trind.m rcsultad!h similares. En e~tc sentido es sutn.lffiente impooante qUC: el 
ingeniero entienda las ventajas y Jimitacioocs de cada métcxlo para po.:ler utilizarlos de la manera 
más ndl!cuada y efcdiva. 
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EJEMPLO 4 

Diseño en Acero de un 
Pórtico Bidimensional 

Descripción 
Este ejemplo es un intt00ua:i6n al uso de la.!i poderosas hc:rra.mlenlaS que posee el SAP2000 para el 
diseño d¡: una estructura una vr-.z concluido su análisis estruc.tural. Se dará énfasis en esta parte a 
módulos de diseño 01 acero empleando Cl'lmo ejc:mplo la estructura analizada en el Ejemplo l. 

Aspectos Importante del Modelo y del SAP2000 
Crelción de zonas rígida.~ at los dema~tos. 

• Selección Automática de grupos 

Cambio de p-opiedades 01 elemauos 

• Designación de c:lemaJtos por grupos. 

• Inclusión del cfc:ao P-Delta en el análisis 

• Visuali1ación de los resultados 

• Auto Seleccióo de secciones 

• 
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Ejemplo 4 Oi5CIIO eo Actl'o de u11 Pdrtico BldimeDJional 

Creando el Modelo en el SAP2000 
Es posible empkar el modelo desarrollado en el EJemplo J efectuando pequoi.as modificaciones. 

Materiales 
Lo primac'que se debe hacer es especificar las propiedades de los materiales. 

Verifique que las unidad:s estén en Kip-in. 

2 Entn! al mcnü Define y sdeccicoe la op..ión Ma~rlals.. 

3 EliJa JTEEL para el parámetro Material y presione el tx:ltón MOOIFY/SHOW MATERIAL 

4. Es~ifique el Esfuerzo de Auencia ajustando el parámetro St.ed Yield Stress f"y en 36 K..si. 

5. Es~ifique el Módulo de Elasticidad ajustando el parámetro Modulus of Elastlclty E en 
29.500 Ksi. 

6. Presione los OOI:ones OK para aceptar los cambios y cerrar las plantillas. 

cargas 
En ti ejemplo 1 se asignó el peso propio de la estructura así como una serie de cargas 
concentradas y distribuidas a la condición d>! carga DEAD. (Vea Figura 4-2 para la nueva lista 
Sta tic Loads Case). En este ejemplo asign<lfemos una coodiciál de carga para la carga viva y 
ooa para el peso p-opio de los elema.tos. E) una buena práctica incluir una condici61 de carga 
para el peso prcpio de la estmctura coo el fin de seguir de cerca el p-oceso de qrtimizacit.J. 
esU\Icnnl. Las cargas son separad.as en ca~ga muc:na. carga viva y carga transversal de sismo 
de tal manera que el SAP2000 p.lCda genmr automáticamente las combinaciooes de carga. 

Par~ el caso de carda DEAD especifique el valor del multiplicador Sclf Welebt 
Multlpller en cero. 

• Agregill una condición de carga pan el peso propio y nómbrela SELF, IJÍgnele el 
tipo DEAD como parámetro a Type y ajuste el multiplicador Sclf Welghl . 
Mulllpller en l. 

• Ag(egar otra condición de carga estltica llamada UVE y asfgncle el tipo UVE como 
parámeuo a Type. 

2. Ai\atia las mismas cargas com:spondientci a la carga DEAD a la oondkión de carga UVE. 
Esto significa que cada viga de la estruC1\Jra tiene cargas idénticas p:u-a carga muerta y viva. 
(Puede revlsar el ejemplo 1 para ver las inS1rucciones de cano ingresar las una cargas). 
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Ejemplo 4 Disello en Acero de un Pórtico Bidimeosio!W. 

Figura 4-2 ·Condiciones de Carga Estitica 

Definiendo un Grupo de Auto-Selección 
La opción d.: Auto-Selección de:! SAP2000 es una forma muy efectiva de diseñar esuucruru. Al 
definir un grupo de secciones denominado grupo de Auto-Selección, el programa p...Lede diseñar 
cada elemento del pórtico escogiendo de enO'e las secciones especificadas en ese grupo. Pcr ejemplo 
se puede definir WJ grupo de Auto-Selección denominado COLUMNS con únicamente perfiles 
Wl4, y ooo grupo llamado BEAM con perfiles W2-l. El programad~ esu nuno-a diseñar.llas 
secciones tipo COLUMNS empleando solamente secciones Wl4 y las secciones tipo BEAM 
empleando únicamaue secciones tipo W2-t 

lo primero que debemos hacer es definir un grupo de Auto-Selección que incluya &lcamente 
secciones tipo columna. Esencialmente lo que estamos haciendo en esta etapa es darle al p-ograma 
una lista de sea:iones de enu-e las cuaJes puede elegir al momento de diseñar los elc:m:ntos del 
p&tico. El p-ograma por su parte seleccionará la sección mas eficiente de enlre ese grupo. 

Una vez se haya oonchtido el diseño p-eliminar es memento de refinarlo. para eUo los pupas 
BEAM y COLUMN serán re:empla.zados por secciones oplimiuda.s elegidas de entte el grupo de 
Auto-Selección. Este proc.el:O asignará a los elementos secciones que sertn empleadas tanto en el 
análisis como en el diseño, esto hará mucho mis fácil el cambio de secciones que necc.siten ser 
modificarlas. 

Nota: 1..4 opción tú Auto--Sikcd6n ftmdona Jo lo •n p6rlkoJ 41 a~:~ ro. 

l. Desde el menú Define y selecciooe la opción Frmne Secdons. 

2. lmpc.te a la plantilla Fnme Stctions todas las secciones de acero C:anp-endidas entrt 
Wl4x61 yWI4x283. 

• Seleccione en la caja de diálogo la opción IMPORT VWIDE FLANGE. 
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EJ(mplo 4 Ois(~O en Acero de un Pórtico Biditr~ensiolll.l 

Bu~que y seleccione la se;:ción Wl4x283. 

Mantcmendo presionada la tecla SHlFT haga click con el botón izquierdo del mouse 
sobre Wl·h.61 y presione el botón OK. Esta operación permite seleccionar todas las 
secciones cnlie la sección Wlü283 y la sección Wl4x61. 

Borre dl: planciUa Frame Sections OJalquier sección que pudiera estar duplicada. 

Recuerde: No ts posible borrar una .ucclón que este en uso. De estll 
manera d programa asegura que todos los ekmentos tienen asigrwda 
secciones eristenJes. 

Desde la plantllla Frame Sed:ion añada una sección Auto Stlect. Esta sección se ubicará en la 
panc inferior de la lista Add. . 

Cambie el nombre en Auto Sectlon N ame a COLUMN. 

D..: la lista Auto Selectlons elija y remueva usando el botón Remove todas las 
scccior.es ex.ccptuando los perfiles W 14. Esto significa que todos los elementos que 
u:ngíln una sección tipo COLUMN strán dueñados empleando alguno de los perfiles 
Wl4 de cnl!e la lista Auto Selectiom (Vea Figura 4-3). 

Auto Seler:ti~n Ser:dans _ · , · , 

-· -·· - ........... . 

AorttJS~ct.011N~ 

íCI'Ioau~•"""'·• ·' ,.. :;~,~:. · .:~':.' :·:·: 

"•d •; 

~ 

Figurt 4·3 Definiendo el grupo de Auto-Selección COLUMN 

5. -SigWmdo las insttucciones dadas en Jos pa.sos 2 al 4: 

• Impone tcxias las sectiones enue la W24xSS y la W24x162. 

Asigne un grupo ~e Auto-Selección denominado BEAM con perfiles W24 
únicamer.te. 
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6. Fmalmente, selecciones tedas la; elementos verticales del pXtico y asfgri'ete la: s«.d6n .lipa 
COLlTh~. Luego seleccione tcx:los los elementos haizoouJes y a.sri,nele la' Scccióñ'.ti?l: B~L 
(I/ ea el eJemplO·¡ para las instrucciones de como asign31 secciooes a los elémciuOs del pórtiCO).·:~·:~ 

. ..: . ',"IJ).: .,'·}; 
No! a: Se puede por supuesto selecciorwr una seccidn espe(fi.ciJ ~to pai-d ·:P.· 

el diseño como para el análisis en lugar de emplear la o'¡;ción lk ,.!;·: .· .·~·· · · . 
Auto·Selección. Para ello simplemente se necesita asignar a los :' .::·. .· . · ' 
elementos del pórtico una sección de auro adecuada y diseñarla th ·. 
acuerdo a lo descn"to en ti ejemplo l. Esta sección puede ser ya Stá 
una sección definida por el usuario o bien una sección elegida de 
entre los secciones predetenninadas. 

Efectuando el Análisis 
Una vez que se han ingresado los da.r.os es tiempo de cocra el mcdelo y revisar los resultados. 

l. Gra~ el moJeio. 

2. Asigne los pJiámeuos para el diseño enb'ando al menú Analyu y seleccionando la 
opción Set Options. 

• En la pl.mtilln AnalysJs Opllons seleccione el tipo de an!lisis Plane Fraine para 
reducir el !amaño de la solución y en cons~cuencia reducir el ti~mpo de anilisis. 

• Marque la opción Jnclude P·Deha. 

• Presione el botón SET P-OELTA PARAMElERS para ajustar los parfmetros del 
análisis. 

t Asigne a Maximum lteratlons el valor 10. 

t Incluya las condiciones de carga muerta DEAD y SELF, en la combinación p. 
Deh1, ambas con factores de cuga ig'ual a l. 

t Incluya la condición de carga UVE con un factor de carga l. 

Nor.a: Losjaelores de cargad empkant deben nr los torrtspondienUI a 
las r:ombinaclonts de carga que 11 usen en ti diseño dt la estructura 
y que produ:ean.los mtf.rimos efectos tn la mitma. Dtb'" lncluine 
admufs ti efecto de bu cargas laJerales. 

• El n:sto de valores por defecto es acep1able. 

• Presione los botones OK para aceptar los cambios y cerrar lu plantillu. 

3. Entre al menll Analyze y seleccione la opción Run para analizar la estructurL 

... 
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Ejemplo 4 Dlse~o en Acero de un Pórtico Bidunensional 

Sugerencia : Se puede cambiar ti niÍmtro tÚ puntos a lo largo dtl 
elemento en los cuales las fuer..as de sección son reporlatÚJs. Para 
ello seleccione Jos elementos y desde el menú Arsign elija la opci6n 
Frame Output Segments para cambiar el número de segmentos. Es 
necesario ejecutar nuevamente el análisis del modelo para obtener 

los resuiJados. 

..... , ...... -· 

Seleccionando cualesquiera de las combinaciones de carga y presionando el botón DetaDs se 
mostrarán los resultados del análisis para ese elemento así como las ecuaciones que gobiernan 
!;U diseño de: acuer.:io al código emplearlo. (Ver Figura 4·6) 

Al presionu d OOI:ón ReDeslgn se presentará la plantilla EJement Overwrlte Asslgnments. 
En esta ¡-!antilla se puede elegir de entre varias opciones: 

Nota: Si u efectUañ ctJmbios en la pkantiUa Element Overwrite 
Assignmenls empleando el botón ReDesign, será necesario presionar 
el botón Refresh lVindow de la baTTa de herramientas para ver los 
resUltados del diseño actualiz.ados en la ventana activa. 

• Seleccionar otra sección para ver el cambio en los esfuerzos en el elemento. 

Nota: En el modo Auto-Seluci6n, uta seccldn puede emplean e para 
ensamblar UtuJ nutva mDtriz de rigidez si st eligt la opción "UpdJJte 
Analysir Se.:tions". Esto úldma se llevará acabo una vez que se 
ejerute nuev.::mente el Diseño/Revisión. 

C!asifkar los elementos po1 tipo Moment Reslstlng Elemento Brace. 

Sobrescribir los factore5 de diseño tales como longitud dectiva y la relación de 
longitud no arriosuada. 

Elija la opción Overwrlte Allowable Stresses para sobrescribir los esfuerzos 
admisibles empleados en el diseño de la sección. 

• Cuwdo halla laminado de modificar los parlmetros de diseilo prosione el bolóo OK. 

Nora.: Al C<JmbiM 141'1/on:UJcl6n de ÚlpÚintllÚI RrD<sltn. el SA1'2000 
automáticamente ucalcular4los nfuenos tk diseño de acuerdo alts 
nueva injortTUJclón y actuaUz.ará la itiforrnad6n en la plantlUa Steel · 
Stress Check ltiformation. Para mds instrucciones •obre como 
actualitnr las secciones parad análisis refiérase a la secc:l6n "R•~ 
AnaliZDru:ltJ". 

, . 

Pant usar la sección elegidft. en el Re-Disei'to en ~l1igulcnte .andlisis eStructural, es nccc:sari~ 
entrar al menú Deslp¡ y seleccionar la opción Updatc Analysls Sectlon.s. Esta opción 
reemplaza las secciones empleadas inicialmente para formar la matriz. de rigidez de la 
estructun. por las nuevas secciones dándmos mayor precisión en los cálculos. 
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Ejemplo 4 DIKOO tn Acero de un Pórtico S;di:nentio!W 

Una vez que se halla terminado de modificar las secdone5 estructUrales que se van 8 

emplear, ingrese al menú Dcsicn y eliJa la opción Update Analysis Sedions. Luego 
efectúe nuevamente el análisis empleando las últimas propiedades di! sección. 

LlcYe acabo nucvdmcnte el dJSeño de los elementos para ver si hay cambios. 

3. Una ~-ez que se encuentre satisfecho con las secciones elegidas, ingrese al menú Deslgn Y 
elija la opción Replacc Auto w/ Optimal Sections. Esta opción asigna las secciones 
definitivas ya sean las óptimas o bien aquellas seleccionadas por el usuario tanto para el 
análisis como para el diseño, y reemplaza las propiedades de sección preliminarrs 
tomadas de los grupos de auto selección BEAM y COLUMt:J. 

Diseño de acuerdo al LRFD 
La metodología empleada pcr el LRFD es esenciaÍmente la misma que usa el ASO. Sin embargo las 
combinaciooe:i de carga así como la ect.•aciones de verificación de los elemeruos son efectUadas 
empl~do el código LRFD, por lo que los resUltados e infcnnaciOO resulWJ.te es distinta. Para 
efectuar el Diseñtv'Rcvisión de acuerdo al có:iigo LRFD, es necesario cambiar algunos parámerros 
de entrada. . ., _-

l. Ingrese los nuevos factores de carga para el análisis P-Del~-· 

2. SelecciOne de la plantilla Prcfertnces el cód.igo de diseñO eit acero AlSC-l..RFD93. 
' . ··-·.-

3. Red.iseñe las secciones de acero: 

Opciones Avanzauas 
.. 

Definición de Grupos de Elementos pal-a el 'tilseño 
Algunas veces puede encrotr1!tá lltil esta opciát al dJscdor clcmen!OS m estr\ICtU!O.' aporticodas. 
Esta op:ión pÓmite disáiar todos los elementos de tm grupo usando _llnic:::a..rnmte una secciOO. Lo. 
ventaja de este mttodo de disc:ñó es que reduce el número de secciooc:s diferenteS 8 empl~. Pcr 
ejemplo se pueden agrupar las columnas o las vigas de dos o tres pisos del pático dentro de tm 

mismo grupo de diseño, penni!iéndmos usar una sola sección pu-a dic-ho conjunto de elem01tas. 

1. Reasigne las s=i"';, del tipo A111<>Seloé:dát alas el""'""" del ¡Ó:tico. 

2. Agrupe los elema~tos del 3cr piso hacia ahojo en un grupo dena:ninado BaiTOM 

'3. Agrupe lOS elementos en~ los pisos 3 y S en tm grupo llamado MIDDl.E. 

4. ~ Asigne 1~ elementos r~te aJ grupo TOP. 
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Ejemplo 4 O.s.e&o en Acero Je un Pón!eo BulfM.sio~ 

5. Efectúe nuevamcn!e d ~álisis del ~el~. 

:·· 

.•. · .. _.-:_.. 

6 En el menú &ign sekccione la opción StJrct Desfgn Group. En esta parte u: le indica a! 
programa que se diseñe un grupo de elc-tTh:ntOS empleando la sección más liga-l que sllisfaga 
los rcqucrimicn!os y esfuerzos admisibles en todos loo elementos. · 

• Incluya en la lista Deslgn Groups los grupos de elementos TOP, MIDO LE y 
BOITOM. Al hacer este. indicamos que estos grupos serán d1señados con la sección 
más eficLcnle de las secciones dd grupo Auto-Selecciór.. 

No!~ Si no hay grupos tn la lista "Dtsign Group list", cada uno dt los 
elementos de la estroctura serán dúeñados imÍividualmtntt. 

• Cuando presione el botón OK , El SAP2000 au10máticarnente daseñar.f las secciones 
. de acero y mamará los resultados en la ventana activ<l. 

7. Compare los res,ultados del diseño anteriormente efectUado con el dis-eño pcr- gru~ para ver 
como afecu:. es!c hecho en las seccioocs seleccionadas. 

Zonas Rígidas 
La estruaur.1 que hemos venido estudiando, ha sido analizada y di.señad..a consido-ani:lo que los 
elementos se extienden completamente de nudo a nudo, sin tornar en cuenLa.las dimcnsi(lleS propias 
de las secciones transversales de los elementos. Si bien es cierto que ista no es una maJa 
consideración, .::1 SAP2DCX.l pénnite efectuar análisis aun más p-ecisos mediante la introducci6o de 
zonas rígidas en el mcxldo. I .as zooas rígidas defini:n una regitn m la conexiáJ entre \iga y 
columna, en la cual los elementos no sufren defmn.aciooes por flexi-XL. Se genaa a.sf esencialmente 
una zrna rígida m la rooex.ión. Esta área. puede ser tan grande r:omo el usuario tspo:1fique, pero 
usualmmle .se OXJsidera igual al peralte del miemlxo (o una fr;icción del mismo) aJ que se eSta 
llepndo en es-e nudo - • · 

l. Selecciooe todoo los elementos del pá"tico. 

2. Del ~ú Asslgn seleco..iooe la opciOO frame .• , Eod Offsets. 

• En ia plantilla F.nd OfTset seleccione la ~Jón Update Lcncths From Currt~t 
Connectlvlty. Esta Opción·hace que el programa calcule autom.fticamente la~ 
dimensiones de I'!_S T.onas rígidas a considerarse en cada nudo 

• Ingrese el valor 1 para RJg:ld Zont. Factor. Esto significa que el 100% de la 
''longitud potencial" de. zona rfgic!.a debr.r.f consider!!rse en el aná.lisis. 

" Presione (.\ botóo OY... 

3. Sl se especifica b qx:lOO Element Sbrlnk de la plantilla Stt EJe~nts, y se observa en la 
pailtalla activa, se pedo-á apreciar un:t s....-rie de Hneas en cada nudo que indican la asignáción d~ 
zonas rtgid.a.i en Jos eleroaaos. 
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Ejemplo -f Oi•do ca Aeuo de U!l Pdrtieo Bidunerutoaal 

Recuerde: Se necesita restahkcer la opcl6n End Offuts cada vt:z: que las 
secciones de Jos elementos sean modifu:adas. · 

Nota: Los mom_t/Jip~ y cortantes •n laJ vigas y columruu van a ser 
ligeramente di fe re~ u en aqutllos casos en los que no u toman en 
cuenta las z.o11as rígidas. Esto se dtbe a que la Introducción de las 
mismas reduce la Wngitudjle.ribk de los elementos. 

Comentarios Finales 
La'lo herramientaS de diseño dd SAP2(X)() son muy lltilc:s en el diseño de estructuras apcrticadas. Sin 
embargo hay algUJlOS puntos que se deben tener ~esentes: 

l. Asegúrese que 10da la información de diseño sea correcta. Los valores por defecto que 
usa el programa no son necesariamente los correctos (p.ej. K y Longitudes no 
Arriostradas de los elementos). Se pueOe usar la plantilla Display Deslgn Results pan 
ver esta información en los elementos del pónico. De manera conveniente, es posible 
apreciar el análisis de las secciones al mismo Liempo que la información del diseño. 

2 Verir1que que las combinaciones de carga de diseño que el programa ha proporcione.do 
sean las correcth y adecuadas para el Lipa de estructura en panicular que se este 
analizando. Sin no lo son, añada las combinaciones de carga que desea utilizar en el 

diseño · 

3. Ven fique Jos resultados del diseno en puntos claves, para asegurarse que los rerultados 
d~l diseño guardan relación con los resultados esperados. 

4. Veri'f1que.que los factores de carga en el análisis P-Delta son los correctos. 

5. Rediseñe la estruCtura tcxia vez que efectúe cambios en el modelo. Esto pemüte ver si fas 
secciones ~m picadas son aún aceptables. 

6 Emplee grupos de elementos para determinar el peso total de la estructura. (Revise el 
Ejemplo 1 para tener instrucciones de como efectuar este paso.) 

7. Emplee grupos de elementQS en el diseño para reducir el número de las cüferentes 
secciones a utilizarse en la estructura. 

8 El archivofilt!namt".EKO contiene la infonnaci6n del peso total de cada uno de las 
secciones (perfiles) empleadas en el diseño. Esta información nos permi!e estimar costos 
de una nWlCr<!. prdiminar. 
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